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ALASKA COVER LETTER 

 
April 1, 2011 
 
Ms. Anne W. Neville 
SBDD Grant Program Director 
National Telecommunications and Information Administration 
U.S. Department of Commerce 
1401 Constitution Avenue, NW Room 4716 
Washington, DC 20230 
 
Dear Ms. Neville: 
 
It is with highest regard that the collective stakeholders of Connect Alaska offer congratulations to 
the U.S. Department of Commerce’s National Telecommunications & Information Administration 
(NTIA) on the recent release of the National Broadband Map.  This extraordinary milestone 
demonstrates the intense and joint effort of the NTIA, FCC, state governments, industry, and non-
profits like Connected Nation and will serve as a key tool for the American public and policymakers 
resulting in smarter investments and targeted state and local broadband policies and programs.  We 
are proud of the role that Connect Alaska has played in creating such a powerful tool that will surely 
benefit not just Alaskans, but consumers and businesses nationwide. 
 
Therefore, as the State Broadband Designated Entity, in partnership with the Alaska Department of 
Commerce, Community, and Economic Development, please accept this submission from 
Connected Nation on behalf of the state of Alaska’s State Broadband Data and Development 
(SBDD) Grant Program, known as Connect Alaska. 

 
These artifacts should be found to be compliant with the April 1, 2011, deadline for the semi-annual 
data update and in accordance with the terms of the July 1, 2009, Notice of Funds Availability 
(NOFA) and all subsequent clarifications pertaining to delivery of State-Level Mapping of 
Broadband Service Availability.  This packet includes: 
 
Inventory of Deliverables, Connect Alaska: April 1, 2011 
 
NOFA Requirement Data Transfer Model Data Description 
Appendix A:  1(a)(i) BB_Service_CensusBlock Broadband Service Availability of 

Facilities-Based Providers in 
Census Blocks of No Greater 
Than Two Square Miles in Area 

Appendix A:   1(a)(ii) BB_Service_RoadSegment Broadband Service Availability of 
Facilities-Based Providers by Road 
Segment in Census Blocks Larger 
in Area Than Two Square Miles 

Appendix A:   1(b) BB_Service_Wireless Broadband Service Availability of 
Wireless Services Not Provided to 
a Specific Address 
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Appendix A:   3(b) BB_ConnectionPoint_MiddleMile Broadband Service Infrastructure 
Middle-Mile and Backbone 
Interconnection Points 

Appendix A:   4 BB_Service_CAInstitutions  Community Anchor Institutions-
Listing 

Appendix A:   4 n/a Community Anchor Institutions-
Narratives 

VII.A.1(a) n/a Accuracy and Verification Report 
n/a DataPackage.xlsx Worksheets of Contact 

Information, Data Dictionary, and 
Provider Summary Table 

n/a n/a Broadband Provider Roster and 
Participation Status 

 
In addition, this data update submission should be found to be compliant with the additional 
program requirements instituted by the National Telecommunications and Information 
Administration since the time of the October 2010 SBDD data submission for the Connect Alaska 
program.  Specifically, these new requirements are: 

 
SBDD Data Transfer Model 
The submission of the broadband dataset for April 1, 2011, is contained within the SBDD 
Data Transfer Model as released on the Grantee Workspace on January 14, 2011. All efforts 
have been made to comply with formatting, domain, and metadata requirements to include 
as much information on each provider as possible.  
 
Additional Submission Guidance 
This submission also includes the updated DataPackage spreadsheet with enhanced provider 
listings as well as satisfactory outputs from the SBDD_Check toolbox to ensure fewer 
unexpected values with the submitted broadband datasets prior to federal processing for the 
National Broadband Map update. 

 
This April 2011 semi-annual data update under the State Broadband Data and Development Grant 
Program continues to demonstrate our dedication to implementing the joint purposes of the 
Recovery Act and the Broadband Data Improvement Act (BDIA) by gathering comprehensive and 
accurate state-level broadband mapping data, developing state-level broadband maps, aiding in the 
development and maintenance of the National Broadband Map, and undertaking statewide 
initiatives for broadband planning. 
 
Broadband Service Availability — Provider Outreach and Verification 
 
This data update submission under the SBDD includes the participation of approximately 90.91 
percent of the Alaska provider community, or 20 of 22 total providers.  Of the 20 participating 
providers, 9 supplied an update to their network or coverage area(s), while 11 have reported no 
change. A complete roster by provider depicting participation status and contact record is contained 
herein.  Of the 2 providers that are not represented in the attached datasets, 1 has refused to 
participate in the voluntary program and the remaining provider is currently in some form of 
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progress toward data submission but was not able to submit coverage areas at the time of this 
submission.  By the time of the deadline to receive and approve data for this April 2011 submission, 
the provider Alaska Communications Systems (ACS) had refused to participate, but there have been 
recent developments as a result of the Alaska Broadband Task Force and it is expected that ACS will 
participate and be represented in the October 2011 submission.   
 
As the aforementioned roster and attached methodology documentation will attest, it is the 
collective opinion of the Connect Alaska principals that all commercially reasonable efforts were 
made to account for 100 percent of the known Alaska broadband provider community, pursuant to 
this semi-annual data update submission. 
 
Connect Alaska has also continued to perform broadband verification activities through several 
means. In addition to confirmation of service area(s) by each provider, Connect Alaska conducts 
field validation efforts.  To date, 12 (54.55 percent) providers have been validated through field 
verification activities. Additional details on verification activities are contained within the Field 
Validation Narrative. 
  
At the program’s inception, Connect Alaska launched a website to create awareness about the 
initiative. Connectak.org continues to serve a prominent role in the outreach and data collection 
effort.  This program asset provides a way for the general public to participate in the process by 
offering interactive tools for users to test their connection speed, submit broadband inquiries, or 
contact a program representative.   
 
As an indicator of stakeholder penetration, the Connect Alaska website encountered 1,587 unique 
visits during this reporting period (3,397 total to date for the life of the grant awarded on June 1, 
2010).  Additionally, this pronounced Web activity netted 9 broadband inquiries over this same 
reporting period (31 grant inception to date).  The website also provides the BroadbandStat 
application, which allows the consumer to confirm or dispute the coverage represented on the 
broadband inventory map. These consumer-initiated actions are facilitated through the Connect 
Alaska website and the Connect Alaska Interactive Mapping Tool (BroadbandStat) that offer the 
citizens the vehicles to provide information regarding availability in their respective service area, 
either in affirmation or contest of the reported data represented in the Connect Alaska mapping 
artifacts.  Since the initial data collection and release of corresponding maps, feedback in the form of 
broadband inquiries has allowed Connected Nation to identify additional areas that are in need of 
field validation, which is scheduled as soon as possible.  
 
Community Anchor Institutions  
 
Connect Alaska has established an ongoing mechanism for gathering data on the location and 
broadband connectivity of Community Anchor Institutions (CAI), in accordance with the data 
requirements of the SBDD NOFA Technical Appendix.   
 
In conjunction with the Alaska Department of Commerce, Community, and Economic 
Development, outreach was conducted during this data update reporting period by Connect Alaska 
to continue identification of existing, centralized sources for CAI connectivity data.  Connect Alaska 
worked closely with the Alaska State Library to gain access to library connectivity data from its 
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contacts across the state for inclusion during this reporting submission.  Additionally, outreach was 
coordinated to distribute the CAI survey to institutions throughout the state through multiple 
methods including a customized online survey available on the Connect Alaska website.  During this 
reporting period Connect Alaska has developed a number of new relationships with statewide 
associations such as the Division of Community and Regional Affairs, the Alaska Village Council, 
the Alaska Department of Education & Early Development, and the Alaska Regional Development 
Organizations to promote the importance of broadband connectivity at anchor institutions and 
participation in this data collection process.  Connect Alaska will continue to build upon these new 
relationships over the coming months and utilize its contacts throughout the state to collect data and 
raise awareness of this project. 
 
While we continue to document institutions and the related addresses, the connectivity data 
collected in most categories remains incomplete at this time.  Connect Alaska will be implementing a 
number of new processes to increase participation including launching a CAI newsletter to connect 
communities across the state, increasing industry-specific planning to target new community 
contacts, and revising the CAI portion of our website to increase visibility and content.  From our 
work in Alaska, as well as other states, we recognize the great value of this data to future 
collaboration efforts within the state as well as its value to the recently released National Broadband 
Map.  We plan to continue to bring best practices to the Connect Alaska efforts, along with an 
investment of both human and technical resources required to reach our goal of increasing the data 
that is secured and reported as part of this process. 
 
In acquiring both broadband availability and CAI data within the state of Alaska, Connected Nation 
has previously engaged all federally recognized native communities in the area covered by the 
Connect Alaska SBDD grant and reported that outreach as part of past submissions.  Throughout 
the next reporting period Connect Alaska plans to continue to engage directly with Native Alaskan 
communities and will also conduct affirmative outreach with Native Alaskan organizations that are 
active within the area.  Connect Alaska understands the connectivity challenges facing these 
communities, and we have identified a need to include their data as part of our upcoming 
submissions. 
 
 
The Connect Alaska program exists to improve data on the deployment and adoption of broadband 
services and to assist in the extension of broadband technology across all regions of the great state 
of Alaska, as well as the United States through contribution to the National Broadband Map.  We 
look forward to the continuing work ahead. 
 
Respectfully submitted, 
 
 
 
Thomas W. Ferree 
Chief Operating Officer 
Connected Nation, Inc. 
 

dclark
Cueball
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DATA ACQUISITION:  ALASKA COMMUNITY ANCHOR INSTITUTIONS  

In this third reporting period of the SBDD, Connect Alaska, working in close coordination with the 
state of Alaska, has established an ongoing mechanism for gathering data on the location and 
broadband connectivity of Community Anchor Institutions (CAI), in accordance with the data 
requirements of the SBDD NOFA Technical Appendix.  During this reporting period Connect 
Alaska has continued to focus efforts on conducting outreach and raising awareness of this 
important project. 
 
Connect Alaska has continued to identify and process CAI data obtained through an ongoing 
statewide outreach campaign.  Physical address information continues to be augmented through 
manual sourcing and geocoded by Connect Alaska through ESRI ArcGIS software. 
 
Connect Alaska continues to utilize a customized online survey hosted through SurveyMonkey, with 
a landing page on the Connect Alaska website that was developed during the first reporting period.  
This survey, in combination with a customized data gathering spreadsheet, was distributed to a 
targeted list of CAI throughout the state.  Connect Alaska will continue to use these data gathering 
tools for future targeted outreach efforts throughout the coming months leading up to the next 
reporting period.  These materials are customized to fit the CAI categories as defined in the SBDD 
NOFA.   
 
The survey can be accessed at this link using the following password: 
http://connectak.org/mapping/Community_Anchor_Institution_Data_Collection.php 
Password:  CAI_AK_5852 
 
Connect Alaska and the state of Alaska have worked closely during this reporting period to conduct 
research as part of an ongoing process to identify existing, centralized sources for CAI connectivity 
data.  During this reporting period the Alaska State Library provided a database on the connectivity 
of 99 public libraries in the state, and efforts are still ongoing to complete the geocoding of this file.  
Connect Alaska will continue to locate existing connectivity data in the state especially focusing on 
the public safety sector in the coming months. 
 
In tandem with these efforts to identify existing data, Connect Alaska continues to identify key CAI 
contacts among all CAI categories in an effort to distribute and promote the online survey and raise 
awareness of the importance of CAI broadband connectivity.  During this reporting period Connect 
Alaska has coordinated with the Alaska State Library, Alaska Department of Community and 
Regional Affairs, Alaska Division of Rural Affairs, and the Alaska Department of Education and 
Early Development to distribute our survey and identify library, village, and education contacts. 
  
Connect Alaska has an ongoing mission to educate CAI throughout the state on the importance of 
participating in the project.  Participation by these institutions will raise awareness about the 
importance of broadband connectivity and the need to report the requested data for inclusion on the 
National Broadband Map.  During this reporting period Connect Alaska developed a CAI newsletter 
to be distributed quarterly beginning in March 2011.   The newsletter will highlight a CAI in Alaska, 
encourage institutions to share their data, and highlight the National Broadband Map. 
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The greatest challenge with collecting this data continues to be the difficulty in securing CAI 
broadband connectivity data especially for public safety and higher education CAI.  Connect Alaska 
will continue its ongoing work with the state of Alaska and key organization contacts in an effort to 
raise awareness of this project among CAI.  The newly formed Alaska Broadband Task Force will be 
briefed on the current CAI data and provided information so they can assist with outreach and 
promotion over the coming months. 
 
A CAI summary of all processed and submitted data is provided below: 

 

CAI Type Total 
Physical 
Address Lat/Long

Technology 
of 

Transmission
Download 

Speed 
Upload 
Speed 

K-12 Schools 631 570 631 66 309 287
Libraries 126 126 126 45 43 43
Healthcare 70 70 70 2 4 1
Public Safety 309 135 309 0 0 0
Higher Ed Institutions 9 9 9 0 0 0
Other Government 553 199 553 17 14 14
Other Non-Government 347 208 347 2 2 2
Total 2,045 1,317 2,045 132 372 347
 
 
SBDD DATA SUBMISSION METHODOLOGY 

The submission of the broadband dataset for April 1, 2011, is contained within the SBDD Data 
Transfer Model and additional components as released on the Grantee Workspace on January 14, 
2011. Connected Nation has reviewed all literature that relates to the release and use of this data 
transfer model and recognizes that it does not replace or dictate how data is stored, processed, or 
displayed for the state or territory, as it is meant primarily as a means to transfer the broadband data 
from all states and territories and populate the National Broadband Map in a seamless fashion. 
Guidance from the Technical Mapping Guide, as released on the Grantee Workspace on March 24, 
2011, was also followed to ensure the completeness and validity of the submission through 
completion steps and checklists, completing the DataPackage spreadsheet, uploading broadband 
datasets into the Data Transfer Model, and checking the dataset using the SBDD_CheckSubmission 
receipt process.  
 
In addition to the narratives and methodologies contained herein, as well as the DataPackage.xls 
containing contact information, the data dictionary, and a provider summary table, the following 
feature classes are submitted within the SBDD Data Transfer Model for the state of Alaska. 
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Inventory of Deliverables, Connect Alaska: April 1, 2011 
 
NOFA Requirement Data Transfer Model Data Description 
Appendix A:  1(a)(i) BB_Service_CensusBlock Broadband Service Availability of 

Facilities-Based Providers in 
Census Blocks of No Greater 
Than Two Square Miles in Area. 

Appendix A:   1(a)(ii) BB_Service_RoadSegment Broadband Service Availability of 
Facilities-Based Providers by Road 
Segment in Census Blocks Larger 
in Area Than Two Square Miles. 

Appendix A:   1(b) BB_Service_Wireless Broadband Service Availability of 
Wireless Services Not Provided to 
a Specific Address. 

Appendix A:   3(b) BB_ConnectionPoint_MiddleMile Broadband Service Infrastructure 
Middle-Mile and Backbone 
Interconnection Points. 

Appendix A:   4 BB_Service_CAInstitutions  Community Anchor Institutions-
Listing. 

 
The provider data collected by Connected Nation on behalf of the state of Alaska have been 
formatted per the given specifications and uploaded into the appropriate feature classes of the 
SBDD Data Transfer Model. Wireline availability is contained within census blocks and road 
segments, wireless availability is contained as polygons of coverage areas, and middle-mile 
connections and community anchor institutions are contained as point data. All speed data is 
contained at the census block, road segment, or wireless polygon level of availability. All efforts have 
been made to comply with formatting, domain, and metadata requirements to include as much 
information as possible.  
 
Connected Nation has continued outreach to satellite providers on their availability, technology, and 
speed information, but it is not included in this submission dataset.  Additional information is 
necessary to be able to show where service satisfactorily exists in the state, rather than submitting 
the entire boundary of the state as the serviceable area.  Analysis information distributed and 
discussed with the satellite providers, as well as any additional guidance from the Program Office on 
the desired analysis for satellite-serviceable areas, will be implemented for the October 2011 data 
submission.  
 
 
ALASKA FIELD VALIDATION NARRATIVE 

Connected Nation focused a portion of its time on specific validation processes such as: 
 

• conducting random spectrum analysis studies throughout the state using an Avcom PSA-37-
XP spectrum analyzer; 

• conducting mobile speed tests throughout the state using an iPhone, Android (or other 
smart phone) as well as provider-specific aircards (Sprint 3G/4G, Clearwire et al); 
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• identifying pre-selected, provider-submitted wireless transmit tower sites and cross-
referencing data about that tower against the Federal Communications Commission (FCC) 
databases such as Antenna Structure Registration and/or the Universal Licensing System; 

• cross-referencing Federal Registration Number data against available FCC Form 477 data as 
well as the FCC COmmission REgistration System (CORES); 

• validating provider submitted data (for example: latitude/longitude) using a handheld 
Garmin eTrex Summit GPS unit or GPS enabled software such as Microsoft Streets and 
Trips; 

• locating physical wire-line attributes (such as remote terminals, CATV plant, etc.) and 
comparing them against provider submitted data; and  

• conducting on-net and off-net speed tests using the FCC portal at 
http://www.broadband.gov/qualitytest/about/ or using the Ookla Net Metrics enabled 
speed test utility located on each of Connected Nation’s state specific websites. 

 
Additionally, Connected Nation cross-referenced numerous public documents in order to ensure 
that all known broadband providers were located and contacted.  This included searching 
membership logs from the trade associations (WISPA, WCAI, PCIA, etc.), the Cable Television Fact 
Book, Public Utility Commission records, Public Service Commission records, Chamber of 
Commerce, etc. 
 
To date Connected Nation’s staff conducted on-site validation tests in Alaska on the following 
providers:  Ace Tekk Wireless Internet, AlasConnect Inc., Alaska Telephone Company, AT&T, 
Borealis Broadband, Clearwire Corporation, Copper Valley Telephone Cooperative Inc., GCI 
Internet, Ketchikan Public Utilities, Matanuska Telephone Association, SPITwSPOTS LLC, and 
TelAlaska Long Distance Inc. 
 
From program initiation through this reporting period, Connected Nation has completed in-the-
field validation testing against 12 companies (out of a universe of 22 viable providers) totaling 54.55 
percent within the state of Alaska.   
 
 
ACCURACY AND VERIFICATION:  METHODOLOGY - PROVIDER VALIDATION 

Broadband providers maintain their service area data in many different formats, all in varying levels 
of complexity and granularity. In order to ensure that the data required by the NTIA is standardized 
across all providers and that it is as accurate as possible, Connected Nation translates and formats 
the data that providers are able to supply into a GIS shapefile and produces maps for the provider to 
review.  The resulting map(s) and review process allow for providers to see their service area in a 
geographic format – for some providers, this is the first time they have seen maps of their 
broadband service area. Having the mapped service area allows providers to quickly identify any 
issues that appear in the data representation, whether the issue is in the data translation into a GIS 
format or from the original data collection and submission. Often data is provided from various 
sources and through the review and revision process, local engineers who operate the networks and 
work in the field are able to ensure that the tabular data that has been submitted is accurate and 
represents the real-world network extent. Any issues in how the service area is represented on the 
map(s) are remedied by Connected Nation, whether they are additions, removal of service, or any 
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other revisions. Revised maps of service area representations are sent to the provider for review and 
approval; Connected Nation will revise data and return maps as many times as necessary until the 
provider is in agreement that the map represents their service area as accurately as possible. Once 
the review process has been completed and final approval of the data is provided, the data is deemed 
ready for NTIA submission. 
 
Once the data collection has been aggregated a statewide level, static maps of statewide and county-
level availability are produced and made publicly available. In addition, consumers can visit the 
interactive online tool, BroadbandStat, to create customized views of broadband service areas and 
analyze corresponding demographic information. Leveraging broadband service data on various 
platforms allows for public users, providers, and other stakeholders to review, scrutinize, and 
provide feedback on the represented data. This feedback becomes a validation method in itself as 
consumers submit inquiries to Connected Nation either affirming where service is not available or 
identifying areas where broadband service is shown on the map, but in actuality is not available. This 
allows for a follow-up to providers regarding revisions to the data as it is represented; it also allows 
for Connected Nation to identify locations where on-site visits may be necessary to complete field 
validation of available services. Public feedback on all forms of mapping products serves as a 
localized validation method for provider-supplied information and allows Connected Nation to 
resolve inaccuracies as they are identified to ensure that only the highest quality information is 
provided to stakeholders. 
 
Estimates derived from provider-validated data indicate that approximately 13.64 percent of Alaska 
households do not have terrestrial fixed broadband service available, and approximately 8.78 
percent1 of Alaska households have neither mobile nor fixed broadband service available.2   
 
Within rural areas of the state, results derived from provider-validated data indicate that 
approximately 23.85 percent of rural Alaska households do not have terrestrial fixed broadband 
service available, and approximately 15.37 percent3 of rural Alaska households have neither mobile 
nor fixed broadband service available.4   

                                                            
1 In accordance with NTIA’s definition of available broadband service as specified in the SBDD NOFA, this estimate 

includes both terrestrial fixed and mobile broadband service, if the service offers download speeds of at least 768 Kbps 
and upload speeds greater than 200 Kbps. 

2 Due to the nature of the SBDD data collection methodology as defined by the NTIA and based on both census 
block geographic units and street segment data, the estimates of broadband availability derived from provider-validated 
data may include an overstatement of the actual number of households with broadband availability.  Under the census 
block-based data collection method, a provider will typically report broadband availability for an entire census block 
whether its network is present across the whole or only a subset of that census block.  This potential overestimation at 
the census block level can be amplified as the data is aggregated across the entire state. 

3 See footnote 1. 
4 See footnote 2. 
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WIRELESS METHODOLOGY 

 
Broadband Service Availability in Provider’s Service Area 

Wireless Services Not Provided to a Specific Address 
 
Data solicited from a fixed wireless provider to create propagation models include, but are not 
limited to: 

1. The name of the structure 
2. Whether the transmitting device is operational or proposed 
3. The maximum advertised downstream speed, the maximum advertised upstream speed 
4. The typical downstream speed, the typical upstream speed (peak periods for both) 
5. The frequency range of spectrum being used (as prescribed by NTIA) 
6. The primary population center(s) being served (for geopolitical boundary reference) 
7. The physical address of the transmit site (in the event latitude/longitude is unavailable from 

the provider this allows a quick reference point for geocoding) 
8. Latitude in either Degrees, Minutes and Seconds and/or in Decimal Degrees (typically 

received as NAD 27 or NAD 83)  
9. Longitude in either Degrees, Minutes and Seconds and/or in Decimal Degrees (typically 

received as NAD 27 or NAD 83)  
10. Antenna pattern (e.g. omni-directional, 180°, 120°, 90°, etc.) 
11. Azimuth of antenna (e.g. 360° with magnetic declination if known) 
12. Approximate transmit radius (in feet, miles, or kilometers) 
13. Polarity of transmit antenna (Vertical or Horizontal) 
14. Transmit antenna gain (in dBi) 
15. Line loss (applicable only to providers using coax, heliax, waveguide or other forms of 

cabling – excludes power-over-Ethernet devices) 
16. Mechanical and/or Electrical beam tilt (if applicable) 
17. Equipment Manufacturer (allows easy cross-reference against manufacturer’s specification 

sheet) 
18. Power output of the transmitting device (if unknown, FCC standards or manufacturer 

specifications are applied) 
19. AMSL at base of tower site 
20. Antenna centerline AGL (height of antenna above ground level measured at the centerline 

of the actual antenna) 
21. Foliage factors (Evergreens/Deciduous and percent of ground cover) 
22. Ground Clutter (primarily used in rural areas to account for foliage and in metropolitan areas 

to account for types and heights of buildings if known)   
23. Average gain of receive antenna 
24. Receive antenna is estimated at height above average terrain (HAAT) of 6.2 meters/20 feet. 
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25. Federal Registration Numbers (if applicable) which may allow opportunities to cross-
reference and/or obtain additional data from the Federal Communications Commission 
Universal Licensing System and the COmmission REgistration System. 

 
Propagation modeling is an empirical mathematical formulation for the characterization of radio 
wave propagation as a function of frequency, distance, and other conditions. Propagation 
software(s) typically use the Irregular Terrain Model (also known as Longley-Rice) of radio 
propagation for frequencies between 20 MHz and 20 GHz. This model is based on electromagnetic 
theory and statistical analyses of the combination of terrain features and radio measurements, then 
predicting the median attenuation of a radio signal as a function of distance and the variability of the 
signal in time and in space.  For metropolitan areas, the software can typically be adjusted to use the 
Okumura-Hata model which accounts for predicting the behavior of cellular transmissions in areas 
where buildings are the primary obstructions. The resulting product from either model depicts a 
graphical illustration of the theoretical propagation characteristics of a selected frequency range 
based on defined variables (receiver sensitivity of the home/mobile device, foliage factor, and digital 
elevation terrain input). 
 
 
BROADBAND INQUIRIES METHODOLOGY 

Connected Nation collects consumer feedback in the form of broadband inquiries. These inquiries 
represent any type of communication received from the public regarding broadband service. Once 
broadband inquiries are received across the state, this information is overlaid with the broadband 
availability information which was collected through the SBDD program.  This allows for a real-
world comparison of the broadband landscape to the information received from broadband 
inquiries.  Broadband inquiries are able to provide three types of information:  1) Residents who do 
not have broadband but want it.  2)  Residents who have broadband but want a different provider.  
3)  Residents who do not have broadband, but the broadband inventory maps indicate that they do. 
 
Through the collection of broadband inquiries, a visual demand for broadband is presented.  This 
visualization allows Connected Nation the ability to validate broadband availability maps for 
accuracy.  If residents within a region state that they are without broadband, but the broadband 
inventory maps show otherwise, this allows Connected Nation to approach the providers within that 
area in an effort to trim down their coverage to more accurately represent real-world availability on 
the ground.  On the other hand, if there is a region in the territory in which broadband is not 
available, the broadband inquiries allow providers close to that region to see where they can 
successfully expand their broadband networks, leading to a high return on investment.  In short, the 
higher number of inquiries leads to a higher level of certainty in regard to the broadband availability 
maps.  Since the initial data collection and release of corresponding maps, feedback in the form of 
broadband inquiries has allowed Connected Nation to identify additional areas that are in need of 
field validation, which are scheduled as soon as possible. Additional information on field validation 
can be found in the Field Validation Narrative. 
 
The broadband inquiry process has been implemented in each of the Connected Nation state 
programs with successful results. Altogether Connected Nation has received over 16,000 broadband 
inquiries since 2007, allowing the state programs to evaluate each inquiry for broadband demand and 
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data verification.  These inquiries are continuously examined against current broadband availability, 
updated every six months, to determine if previously unserved households have been expanded to 
and can now receive broadband at their residence. This database of broadband inquiries has also 
allowed the Connected Nation state programs to aggregate demand in concentrated areas to show 
providers the exact locations where the population has made it clear that they would purchase 
broadband if it was made available to them. Providers in the states have responded to this process 
and have expanded to areas knowing that their investment will be worthwhile. Data verification 
methods have also proven successful, as the state programs have been able to show those inquiries 
that indicate the broadband service areas are misrepresented on the map to providers, who then 
verify where service cannot reach in regard to that residence(s). The broadband coverage in these 
states has been altered to create a more accurate map based on the inquiries submitted by the public. 
 
During this reporting period, the Connect Alaska project has received a total of 9 inquiries (31 grant 
inception to date).  As more inquiries are submitted to Connect Alaska, a more thorough validation 
of the broadband landscape can be performed, while also allowing providers to see which areas have 
a high demand for broadband adoption. 

 

BROADBANDSTAT METHODOLOGY  

BroadbandStat is an online, interactive mapping tool for viewing, analyzing, and validating 
broadband data. Developed through a partnership with ESRI, the market leader in geographic 
information system (GIS) software, BroadbandStat is a multi-functional, user-friendly way for local 
leaders, policymakers, consumers, and technology providers to devise a plan for the expansion and 
adoption of broadband.  
 
First and foremost, BroadbandStat allows consumers to locate their residence and identify providers 
that offer broadband Internet service to that location. The interactive platform allows for users to 
build and evaluate broadband expansion scenarios using a wealth of data, including education and 
population demographics, broadband availability, and research about the barriers to adoption.  
 
New functionality in BroadbandStat allows the consumer to provide feedback on the broadband 
data displayed on the interactive map.  Through the collection of this feedback, a visual demand for 
broadband is presented.  This visualization allows the Connected Nation state programs the ability 
to validate the broadband availability for accuracy.  If residents within a region state they are without 
broadband, but the interactive map shows otherwise, this allows Connected Nation to approach the 
providers within that area in an effort to trim down their coverage to more accurately represent real-
world availability on the ground.   
 
The Connect Alaska project launched BroadbandStat on September 1, 2010, and has received a total 
of 810 visits to date, of which 432 occurred this reporting period. 
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SPEED TEST METHODOLOGY 

The 412 speed tests that are represented in the Connect Alaska Speed Test Report during this 
reporting period (781 grant inception to date) are the result of a partnership between Connected 
Nation and Ookla Net Metrics. Utilizing this relationship increases the level of confidence in the 
data being collected and provides for a far greater sample size than could be collected by a single 
testing site. 
 
Ookla owns and operates Speedtest.net, as well as develops and deploys speed tests, such as the 
Connect Alaska speed test website, for partners around the world. This network of sites that is 
developed and run on its testing technology provides Ookla with a vast dataset that, due to the 
variability of geographic information collected across the varying speed test sites, is geocoded 
utilizing Geo-IP technology. This technology allows for tests to be geocoded to points of 
aggregation, typically larger nodes across provider networks.  While there are hundreds of thousands 
of tests that have been conducted, the level of aggregation is only sufficient for county-level detail 
due to the test results being located at these larger nodes and not at an absolute location for each 
speed test. 
 
In an effort to validate broadband data from the Connect Alaska project, speed test information is 
collected throughout the state.  Speed tests provide speed information on the path taken through all 
networks (a provider’s network as well as additional networks) a local machine must connect to in 
order to reach the host test.  The benefit of this collection of speed information is two-tiered.  First, 
it allows for a comprehensive dataset of speeds, while also providing Connect Alaska with the 
information on where broadband services are available.  Second, unlike theoretical speed 
information which was received through the data collection process, the use of speed tests provide 
real-world information on the speeds that currently exist within the state of Alaska.   
 
 

 
 



Complete 25
Non-Responsive/Refused 4
In Progress 2

Count of Datasets by Viable Status 31
Total Unique Providers Represented 22

Provider Name Platform Status

NDA 
Execution 

Date Notes
AT&T Corp. Inc. Mobile Wireless Data Added to Statewide Inventory 12/16/2009
Clearwire Corporation Fixed Wireless Data Added to Statewide Inventory 3/3/2010
Copper Valley Telephone Cooperative, Inc. ILEC/CLEC Data Added to Statewide Inventory 1/11/2010
Ketchikan Public Utilities Fiber Data Added to Statewide Inventory 1/8/2010
Ketchikan Public Utilities ILEC/CLEC Data Added to Statewide Inventory 1/8/2010
Matanuska Telephone Association, Inc. ILEC/CLEC Data Added to Statewide Inventory 6/15/2010
SPITwSPOTS LLC Fixed Wireless Data Added to Statewide Inventory
TelAlaska, Inc. ILEC/CLEC Data Added to Statewide Inventory 6/7/2010
Yukon Telephone Company, Inc. Fixed Wireless Data Added to Statewide Inventory 6/23/2010

Kodiak Kenai Cable Company Backhaul
Backhaul Provider Only Processing 
Complete 2/7/2011

Ace Tekk Wireless Internet Fixed Wireless No Update to Provide
Adak Eagle Enterprises, LLC ILEC/CLEC No Update to Provide 12/22/2009
AlasConnect, Inc. Fixed Wireless No Update to Provide
Alaska Telephone Company ILEC/CLEC No Update to Provide 2/26/2010
Alaska Telephone Company Fixed Wireless No Update to Provide 2/26/2010
Borealis Broadband Inc. Fixed Wireless No Update to Provide 2/1/2010
Borealis Broadband Inc. Backhaul No Update to Provide 2/1/2010
Copper Valley Telephone Cooperative, Inc. Mobile Wireless No Update to Provide 1/11/2010
Cordova Telephone Cooperative, Inc. ILEC/CLEC No Update to Provide
Craig Cable TV, Inc. Cable No Update to Provide 7/27/2010
GCI Internet Backhaul No Update to Provide 2/25/2010
GCI Internet Cable No Update to Provide 2/25/2010
GCI Internet Mobile Wireless No Update to Provide 2/25/2010
MCI Communications Services, Inc. Backhaul No Update to Provide 12/14/2009
OTZ Telephone Cooperative, Inc. ILEC/CLEC No Update to Provide

Alaska Communications Systems (ACS) Fixed Wireless Refused to Participate
[FEB-07-11 Jill Lindgren] Spoke with provider, 
they have decided not to participate in this round.

Alaska Communications Systems (ACS) Mobile Wireless Refused to Participate
[FEB-07-11 Jill Lindgren] Spoke with provider, 
they have decided not to participate in this round.

Alaska Communications Systems (ACS) Backhaul Refused to Participate
[FEB-07-11 Jill Lindgren] Spoke with provider, 
they have decided not to participate in this round.

Alaska Communications Systems (ACS) ILEC/CLEC Refused to Participate
[FEB-07-11 Jill Lindgren] Spoke with provider, 
they have decided not to participate in this round.

Atcontact Communications, Inc. Backhaul Other

[MAR-07-11 Brian Dudek]  Provider 
representative indicated that they are only a 
satellite backhaul provider in Alaska.  At the 
present, this transport is not required by the 

Hughes Network Systems, LLC Satellite Other 2/5/2010

[MAR-09-11 Brian Dudek] Satellite data will not 
be submitted due to additional information being 
necessary to show where service is available in 
the state, rather than submitting the entire state 
boundary as serviceable area.

Cordova Telephone Cooperative, Inc. Mobile Wireless Offers Service but Below FCC Definition

TelAlaska, Inc. Mobile Wireless Offers Service but Below FCC Definition 6/7/2010

TelAlaska, Inc. Cable Offers Service but Below FCC Definition 6/7/2010

Broadband Provider Log
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Overview 
 

The following documentation provides an overview of how the third required data set was collected and 

processed for the State Broadband Data and Development Program (SBDDP) in the states of Alabama, 

Idaho, Wisconsin, and Wyoming.   

Although we could separate this draft into state-specific deliverables, the majority of methodology 

remains intentionally consistent among the states.  As one important validation test is comparability 

across states, we find value in this cross-state approach.  This cross-state approach also helps the 

LinkAMERICA team focus on comparable outcomes across the four states, where appropriate.  Our 

intent is not to make the states look and be the same, rather it is to leverage economies of scope and 

scale among the business processes. 

As expected, this document rests heavily on the prior drafts, but has also been updated and expanded. 

Significant changes include additions covering: 

1. Trends in provider inputs  

2. Expansion in retrieval of WISP coverage  

3. Requested modifications based upon NTIA guidance 

a. Inclusion of satellite, changes to service overview table, FRN verification process 

4. Consumer Feedback, Crowd Sourcing and Social Media campaigns. 

5. Development and posting of a Technical Standards document. 

Treatment of the following subjects has been expanded: 

1. Community anchor institutions and survey methodology 

2. Verification and validation 

3. Data production methods 

As anticipated, the SBDD program continues to mature and evolve.  Technical leadership and strong 

guidance has been appreciated.  We continue to focus resources on establishing stable business 

processes to track submissions, verify received and processed data, test for temporal stability and 

provide reporting deliverables consistent with NTIA expectations. 

In our view,  the mapping deliverable reflects (1) a good faith effort, which results in a reasoned 

response to the NOFA, Technical Appendix A,  as well as supplementary program office guidance and 

modifications offered in phone calls, emails, and webinars, (2) a stable foundation for improvement and 

prioritization of both NTIA and state needs and interests , (3) a valid data processing model to support 

online mapping, consumer feedback, provider verification and reporting, and finally, (4) a valid use of 

the evolving data transfer model and its intrinsic validation methods.  More importantly, the resulting 

data and online coverage maps that follow from this work are providing good input and context for the 

Broadband planning teams working across the states we have the pleasure to serve. 
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We close this methodology document with two Appendices.   Appendix One describes Data Collection 

Challenges.  This section describes some of the open issues, challenges and questions we are exploring.  

Our hope is to receive clarification and counsel from NTIA in how best to confront some of these issues, 

which are likely common across states.  Appendix Two describes the confidentiality framework 

explained by NTIA.   

Purpose of This Manual 
This technical document was developed to provide transparency in our data production process.   

Our goal is to illustrate a thoughtful process designed to meet the intent of the submission.  Our hope is 

that we have developed a process that is reasonable, with respect to the data it deals with, as well as 

flexible enough to change with evolving NTIA requirements and lessons learned from the Broadband 

mapping community.  

Data Sources 

Developing the Provider List 

Provider lists for all states were developed at project inception from the following sources: 

 State lists of regulated telecommunications, cable and wireless service providers 

 State and national industry organizations (i.e. cable associations, wireless service provider 

organizations, telecommunications associations) 

 FCC Form 477 respondents 

 Independent web searches 

 Prior comparable mapping/research efforts 

 Interviews with key state staff members and important community influencers 

After the October 1, 2011 “Round 2” submission, we continued our research and added new providers 

to the program as discovered.  As one would expect in a dynamic marketplace, provider identification is 

an ongoing and important component of our work.  Mergers and acquisitions, the use of multiple 

regional DBAs, the lack of any universal identity management attribute, and the generally complex 

parent-subsidiary structure of many telecommunications companies, make provider identification and 

tracking very challenging.   

In early January 2011, we once again initiated an email and telephone outreach campaign to contact all 

known providers. This is an extremely time consuming process, but it is necessary to ensure that the list 

of contact persons remains current, and that providers are aware of data request changes and deadlines 

associated with each round.  Where necessary, we execute new NDAs with providers.  In “Round 3”, this 

effort continued on a daily basis until we reached our final data submission deadline on February 18, 

2011.   After February 18, we continued to work with providers who were not able to meet the deadline.  

In most cases were able to “crash” our process to accommodate this extra data, but late submissions 

continue to create inefficiencies and add costs to the overall program.  In Round 3 only providers who 
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responded in the last two weeks of March were excluded from the final dataset.  Data from those 

providers will be updated this summer and included in our Round 4 submission. 

Once again, as contact is made in each round, we verbally qualify each provider by asking a series of 

questions regarding the type of service and speeds offered.  If the provider does not meet the minimum 

specifications for a Broadband provider (as defined in the NOFA) we make a note of their status and 

remove them from the data submitted to NTIA.1  We continue to reach out to them in future rounds in 

the event that their service is upgraded or expanded. 

Provider Outreach 

To meet the program’s aggressive deadlines and participation goals, LinkAMERICA believes it is critical to 

maintain rapport with providers.  To do this, we continued to reach out to providers with regular project 

communications, including a program newsletter and links to the various state mapping websites.  As 

described above, individual e-mails and/or telephone calls were made to all providers explaining the 

status of the program and requesting their continued support in Round Three. We’ve also had the 

opportunity to support providers in their BTOP / BIP applications in certain cases. Through these 

collective outreach initiatives, and our engagement with various industry associations, we continue to 

enjoy a healthy and appropriate relationship with Broadband service providers. 

NDA 

To provide protection for all parties involved, LinkAMERICA continues to honor the terms of our NDA.  If 

providers did not execute the NDA in Round 1 or 2, they were giving an additional opportunity to do so 

in Round 3. New providers were of course also supplied with a copy of the NDA. 

To facilitate the execution of NDA’s, LinkAMERICA continues to use the DocuSign online document 

management solution.  This system allows providers to review and digitally sign the NDA in a legally 

binding manner, and has been instrumental in achieving rapid approval and execution of NDAs with the 

majority of providers.  In some cases, NDA’s were individually negotiated to address specific provider 

concerns.  In other cases, providers chose to submit data without executing an NDA. 

Provider Survey 

Since two prior rounds of data collection had been completed, the LinkAMERICA team had a solid base 

of coverage and speed information with which to begin Round 3.  This allowed us to provide two 

response options to providers.  The first was for them to review PDF check maps of their coverage and 

speed data – submitting only corrections and additions to the existing dataset.  The second was to allow 

submittal of completely new datasets, either in tabular form or in multiple other digital formats.  For 

those without sophisticated CAD or GIS systems, we continued to allow the submittal of 

printed/scanned maps and other written materials.    

                                                           
1
 As with other Grantees, we struggle with appropriate and consistent classification for service providers like 

Megapath, New Edge Networks, American Fiber.  These providers seem to resell and/or provision within their own 
network opportunistically.  In this submission we begin to bring them into the analysis as a provider type “other”.  
As the inclusion of this category isn’t our primary goal, we are working to process data as we can.  We are similarly 
categorizing and retaining reseller information.  Our datapackage.xls illustrates the categorization of non 
Broadband providers within our provider tracking  and verification systems. 
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Survey Methods 

Once again, we used a secure digital survey process (via our provider portal websites) to collect and 

display information for providers.   The Round 3 survey process was designed to accommodate both 

new and returning providers, and the different types of information they would be submitting.  The 

following is a summary of the process encountered by each group: 

New Providers:  New providers were routed directly to our standard survey where they were provided 

with templates for uploading data in tabular NTIA-compliant formats.   As in Rounds 1 & 2, if providers 

could not supply information in the requested format, alternatives were offered.  These alternatives 

included uploading service-area boundary maps, exchange area maps, CAD drawings or customer 

address lists.  From that information, the LinkAMERICA team developed a geographic representation of 

coverage and was able to build coverage features for each provider.    

Returning Providers:  While many Broadband providers submitted datasets in Rounds 1 & 2, many of 

those submissions did not contain 100% of the requested data.  To help identify gaps, and to make the 

Round 3 submission process as simple as possible, every Round 2 survey was reviewed for 

completeness, as well as accuracy and formatting compliance.  Notes were made regarding gaps, and 

specific instructions were developed for providers in Round 3.  These instructions not only explained 

what data was missing, but also provided directions on how to include that information in the Round 3 

submission.   

Check maps were also developed to show each provider how their service area would be displayed on 

the resulting interactive state map.  Generating these customized documents in each round is an 

extremely time consuming verification process, but it allows us to close many of the gaps that might 

have otherwise persisted. 

Follow Up 

After the release of the Round 3 survey in early January 2011, LinkAMERICA launched an extensive effort 

to encourage responses.  Every known provider was contacted at least twice by telephone or e-mail 

during the months of January and February.  The initial data submission deadline was set for February 

18, but, as previously noted, we continued to accept “straggler” submissions well into March.  

No Response Policy 

As mentioned above, every effort was made to contact each provider who appeared on our initial list.  

However, if no current information could be found on the company (i.e. no website, no valid phone 

number, no contact person identified) they were removed from the list of “known providers”.  We 

believe the vast majority of those we were unable to reach were small wireless providers who have 

simply ceased to exist2. 

                                                           
2
The complete list of known providers and important submission statistics are contained in the datapackage.xls 

file. 
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Summary 

In summary, an intensive 45-60 day provider outreach and data collection process is initiated at the 

beginning of each round.  In Round 3, given the data vintage of December 31, 2010, we began this 

process immediately after the New Year.  The last submissions were accepted in mid-March, 2011.    

While we continue to successfully engage the majority of providers in each round, the amount of 

manpower required to solicit complete and timely responses should not be underestimated.  This 

process is one of the most costly and complex within the entire SBDD program.  

Third Party Data Used 
Beyond the data obtained from providers, we acquired the following commercial data products: 

 American Roamer, Coverage Right Advanced Services. This data served two purposes.  The first 

was to verify the provider list and help find Broadband service providers not on other lists.  The 

second was to verify the reasonableness of the Broadband service provider’s submission. 

 MapInfo ExchangeInfo, Professional.  This data was used in the verification of telephone 

Broadband provider data.  Where a public domain exchange boundary wasn’t available, the 

MapInfo boundary was used for coverage containment tests.  

 Media Prints Cable boundaries.  This data was used in the verification of Cable/HFC Broadband 

provider data.  It was used to research valid providers and discover if that provider was offering 

Internet service.  In very rough terms the contained boundaries were used to test the location of 

some provider data.  

 GeoResults Telecom Research Data.  This data was used to help estimate the Broadband 

services likely provided to certain classes of Community Anchor Institutions (CAI). 

We have included third party data sources, which touch on each of the three major technologies 

analyzed within the SBDD program.  Each of these data sources tie back to a public domain data source, 

which provides a cross-verification mechanism for the commercial data product. 

Although there are a large number of third party licensed data sources available, we remain 

conservative in our acquisition plans.  From our limited analysis we are concerned about the ability to 

cross-verify additional third party licensed sources against public domain data.  Further, we are unsure 

of how we may be able to integrate another data provider’s view of valid Broadband providers within 

the definitions used by the NOFA (eg. Are they using an FRN/DBA identity view or a marketing view?  

Can the provider supply in a 7-10 day window?  Are they facilities based or not?).  This leads us back to a 

statement we made in a ‘lessons learned’ Webinar (April 2010) about exploring a consortia to lower the 

cost of data acquisition and allow multiple entities to peer review the quality and methodologies behind 

licensed data products.3  

Beyond these commercial data sources, we used a number of public domain sources.  These included: 

                                                           
3
 We also suggested forming a technical standards committee and a consistent system for confidence reporting. 
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a. Geographic Data Files  

i. US Census TIGER data4 

b. Sources that helped isolate providers, identity management or provider service areas 

i. NECA Tariff 4 

ii. State produced exchange boundaries  

iii. Carrier produced wirecenter boundaries 

iv. FCC 477 provider filers 

v. FCC Coals reports (321/325) 

vi. FCC FRN API lookup tool 

vii. FCC/FAA Antenna Registration System 

viii. FCC FRN Lookup Tool (plain text search) 

ix. USAC High Cost FCC Filing Appendices 

c. Sources that helped isolate anchor institutions 

i. USAC Grant lookup tool 

ii. USAC High-Cost FCC Filing Appendices 

iii. HRSA data warehouse 

iv. NCES data lookup 

v. State managed lists of schools (K-12), post-secondary institutions and libraries 

List of museums,  conventions, and visitors bureaus from www.onlineatlas.us 

Finally, challenges exist when dealing with the inevitable conflicts between provider-submitted data and 

third party sources (public or commercial).  There is no guarantee third party sources are more accurate 

or timely than the providers’ own reports.   Indeed, some third party sources are based upon different 

standards than those specified in the NOFA, perhaps making them less reliable than information 

collected directly from providers.  At the very minimum, provider data has a lineage and temporal status 

that we can identify.  A concern we have with increasing use of third party data is that we have no way 

to verify its quality or development methodology.  In other words, we may hit a wall in which we can’t 

determine how the commercial source derived its coverage conclusion.  To us this means that third 

party data sources are beneficial, but represent a supplementary view, not an authoritative one, of the 

NOFA defined Broadband market. 

In short, we have chosen to use provider data as the baseline.  We will challenge provider reports when 

third party data shows major anomalies, or when a consistent volume of consumer feedback points to a 

potential error.   

As the program evolves it is also our intention to provide tools that allow end users to evaluate the 

accuracy of the data in their own way.  A confidence score or the presentation of multiple (and 

potentially competing) reports for the same location may be made available. This notion is discussed 

further in the “Validation” section below.   

                                                           
4
 Census data were derived from < http://www2.census.gov/cgi-bin/shapefiles2009/state-files?state=01>, Census 

2000 files.  Roads were derived from the county faces and edges file downloaded at the same location and tiled for 
a full state. 

http://www2.census.gov/cgi-bin/shapefiles2009/state-files?state=01
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Confidentiality and the Use of Licensed Materials 
As a mapping vendor, we are reliant upon the cooperation of Broadband service providers.  In large 

part, what underlies this cooperation is trust that we will not violate the proprietary and confidential 

nature of the data provided to us.   

We are thankful for the confidentiality clarification that NTIA shared with us (included as Appendix Two).  

We intend to use this as a guiding document to help us communicate with providers about what 

information NTIA considers to be confidential.  Our suggestion is that NTIA publish this, or something 

comparable, to ensure a consistent interpretation of the NOFA and how it guides NDAs. 

As some providers are non-responsive to requests for information, or lack resources necessary to put 

data into NTIA compliant formats, we have fallen back to the use of commercial data sources in several 

places.   

For instance, some mobile wireless providers were unable to submit coverage information to us.  In 

these circumstances we have generalized the American Roamer coverage.  For incumbent telephone 

providers we have used commercial wirecenter boundary products to filter Census Blocks that are 

clearly out of their exchange areas.  Finally, licensed data from Georesults were used to derive estimates 

of Broadband connectivity for hospitals within the Anchor Institution category.  The actual value from 

Georesults was not used, but our estimate is modeled from their input data.  We also use the name and 

address as provided by the State data provider, not Georesults.   

Public Engagement:   Crowd Sourcing, Surveys and Social Media 
Crowd sourcing (i.e., an intentional and carefully designed effort to tap into the collective intelligence of 

the public at large to expand our knowledge base) continues to be an important element of our data 

collection and validation process. In addition to the various opportunities, the public has to provide 

input via the online service coverage maps and the related ‘Broadband story’ process, our crowd 

sourcing efforts are grounded in a fairly traditional telephone survey approach, focused on the 

consumer market. In addition, we are currently advancing our crowd sourcing process to include certain 

initiatives centered in two social media outlets – Facebook and Twitter. These initiatives are summarized 

below. 

Consumer Surveys 
Working under contract for the state of Alabama in 2009, our initial consumer survey was performed 

before the NTIA SBDDP grant was in place. Subsequent consumer surveys funded by the SBDDP grant 

were hosted in 2010 for the states of Idaho, Wisconsin and Wyoming. These surveys will be repeated 

after two years to establish and evaluate trends. These primarily telephone based surveys include two 

distinct and carefully scripted tracks: one for internet users and one for non-users. The telephone survey 

approach allows us to reach the non-internet user group as well as the current internet user. A 

secondary online approach is also used to augment input from current internet users. For non-users, the 

surveys help determine why they don’t have or don’t use Broadband. For current Broadband users, the 

survey helps determine the nature of their Broadband access and how they use that connectivity in their 
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daily lives. In addition to our state-specific surveys a nation-wide survey was also hosted to provide a 

broader view of consumer views for comparison purposes. State-specific surveys are, where possible, 

framed to match the state’s regional Broadband planning structure (e.g., the consumer survey in 

Wyoming was designed to produce results relevant to the state’s seven Broadband planning regions). 

The resulting data is helpful on a number of fronts in the SBDDP’s mission to advance the access and 

adoption to Broadband. Survey data provides an important, albeit broad, gauge for assessing coverage 

information obtained by providers. For example, areas with widely available coverage (according to 

provider information), but lower consumer subscription levels (according to survey results), or perhaps 

where survey results suggest Broadband is not available, can be examined in more detail. Survey results 

are also very important to the Broadband planning (and capacity building) components of the SBDDP 

program in that they help inform and formulate Broadband advancement priorities. Survey results also 

help inform Broadband policy discussions on both the local and state levels. Finally, survey results 

provide important information to the service provider community regarding market demand and 

specific internet use in specific communities (i.e., regions).  

The 2010 surveys were launched in July 2010 with a test number of survey calls to confirm (and adjust as 

needed) the structure of the survey and the underlying survey process. The surveys were closed on 

November 30, 2010. Telephone surveys were completely random beginning with the acquisition of a list 

of state-specific, randomly selected landline telephone numbers (e.g., 80,000 random Wyoming 

residence telephone numbers were acquired as the foundation for the Wyoming survey). Mobile phones 

were not included in the initial surveys. Upon evaluation of the survey statistics, an auxiliary survey was 

executed to ensure younger groups (i.e., age 18 – 25) were adequately represented. This secondary step 

is required because of the continued migration (by younger markets) to non-landline based 

communications. This younger market (age 18 – 25) was surveyed by reaching out through social media 

outlets to encourage their participation in an online survey process. 

Survey statistics point to the complexity of the telephone-based survey process. Survey volume achieved 

statistical validity ranging from a 95% confidence level and a + 1.7% margin of error for the statewide 

data in Wisconsin to a 95% confidence level and a + 3% margin of error for Wyoming’s statewide data.  

Most regions in the 3 states have a 95% confidence level with a + 5% margin of error. 

Call volume and disposition is summarized in the chart below 
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TOTAL RECORDS CALLED & % OF STUDY 106,592 100% 22,144 100% 57,445    100% 27,004   100%

NO ANSWER 53,507   50% 11,974 54% 25,886    45% 15,647   58%

TOTAL DEAD NUMBERS 23,962   22% 4,529   20% 14,611    25% 4,822    18%

HARD REFUSALS 9,304    9% 1,728   8% 6,048     11% 1,528    6%

QUALIFIED REFUSAL 643       1% 101     0% 403        1% 139       1%

BUSY 3,652    3% 754     3% 1,903     3% 995       4%

ANSWERING MACHINE 6,385    6% 1,314   6% 3,388     6% 1,683    6%

NON-WORKING NUMBER 5,072    5% 943     4% 2,983     5% 1,147    4%

CLAIMS PREVIOUS INTERVIEW 113       0% 16       0% 68          0% 29        0%

NON-RESIDENTIAL 454       0% 104     0% 239        0% 110       0%

LANGUAGE BARRIER 1,003    1% 223     1% 562        1% 218       1%

OTHER PHONE PROBLEMS - FAX/MODEM 907       1% 205     1% 500        1% 202       1%

PORTED NUMBER 272       0% 68       0% 149        0% 54        0%

BREAK OFF - SCREENER 556       1% 103     0% 301        1% 153       1%

TERM Q3 - UNDER 18 122       0% 22       0% 65          0% 36        0%

99% 100% 99% 99%

TOTAL COMPLETES 5,758    5% 1,080   5% 3,420     6% 1,259    5%

AVG Completion Time (minutes) 16 15.8 15.4 16.1

BROADBAND MARKET RESEARCH - ID, WI, WY - FALL 2010

IDAHO WISCONSIN WYOMINGTOTAL

 

As noted above, the telephone survey process represented in the statistics above was augmented by 

providing online access to the survey. Participation in the online survey was promoted on all of our 

state-specific public web sites and selected social media. 

As a final relevant point with respect to the consumer survey process the length of the survey is 

noteworthy. By survey standards, this was a long survey. As noted above, the survey averaged sixteen 

minutes across the three states. While this clearly contributed to the number of survey call attempts 

that were required to reach the level of statistical validity, it was not insurmountable.  

Social Media 
The phenomenon of social media is widely documented and yet still emerging as an effective access 

point for public engagement. We continue to explore appropriate ways to use a variety of social media 

venues in our SBDDP efforts. All of our efforts are informed by and consistent with relevant state statues 

and guidelines. Different states have different perspectives on if and how the state will participate in the 

use of social media. Some state requirements are well defined and some are still being formed. Where 

appropriate, we use YouTube, LinkedIn, Facebook and Twitter to support our work. YouTube and 

LinkedIn postings are used to promote awareness. As noted above, we were able to promote additional 

input on the consumer surveys through a social media outreach program aimed at our younger market 

segments.  

In addition, we are currently engaged in two specific social media tests (in Alabama) to gauge how 

Facebook and Twitter can be used to drive public input on two important crowd sourced issues: online 

speed tests and input on map accuracy. Based on data obtained through our web site traffic monitoring 

process and readily available social media tracking processes, our most recent results are promising.  For 

example, with a fairly limited ‘following’ a single Facebook post aimed at driving traffic to the online 

speed test, had 282 impressions (i.e., the number of times the post was viewed), which contributed to 

an increase in 71 more visits to the Facebook page generally, and a volume of 60 hits (over a three day 
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period) on the web site page that hosts the speed test. Our normal volume of speed test page hits is in 

the neighborhood of 7 or 8 per day (vs. the average of 20 per day experienced during this test). 

Preliminary data suggests that about half these page hits resulted in a speed test being executed. 

Data Production Process 
To support our objective of transitioning the data development process to our State partners, we 

continue to model and document our data production process.   We find this to be a very beneficial step 

for two purposes.  

First, it helps us understand why (and if) a task is being done, and if it is being done efficiently.  Much of 

this program started so quickly that it was difficult to plan logical integration and hand off points among 

the various workgroups.  Further, we are currently in the process of consolidating much of the process 

data (check-ins, check-outs, metadata) and we can use this process model to efficiently plan a cohesive 

information architecture. 

Second, our process documentation and modeling helps explain why resources are being consumed in a 

particular way.  This helps our State partners plan for in-sourcing specific tasks as their time and 

budgetary constraints allow.  It also helps our LinkAMERICA team better plan and cross-train members 

to deal with the work surge that occurs 30-45 days prior to submission. 

Finally, documenting and modeling our process helps us take advantage of increasing specialization and 

proficiency with certain types of data and management responsibilities.   In this submission, we had 

identified data “czars” responsible for check-in and check-out of data.  That data czar helped to bridge 

the gap among receipt functions, provider feedback, production and DBA.  
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Figure 1--SBDD Business Process Diagram 

 

Data Production Methods 
As raw data were received from the provider community, attention turned to normalizing the disparate 

submission formats5.  The team considered each submission with respect to the following criteria.  

These criteria are important because they perform the basis for our verification and quality assurance 

process.  In other words, we have to appropriately scale our data verification efforts to match the scale 

or ambiguity of the following: 

 Locational certainty 

 Speed certainty 

 Temporal certainty 

 Provider and network ownership certainty 

                                                           
5
 In line with NTIA Best Practices we continue to request and receive a large number of data input formats.  This 

ranges from tabular Block lists to hand drawn maps. 
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The team’s goal was NOT to quantify a particular degree of precision with respect to any of these 

criteria.  Rather, we are working to attribute the above “certainty attributes” to each submission, and 

will continue to implement quality assurance and verification mechanisms that are resource-appropriate 

for each. 

Deriving Broadband Coverage Information 
Broadband Coverage6 was normalized into four formats:  

1. Coverage in Census Blocks (2000) of 2.00 or less square miles 

2. Covered Street Segments (2000) in Census Blocks greater than 2 square miles7 

3. Address Level Coverage (point data) 

4. Wireless Service Areas (SHP file format) 

With each submission, the team went through a series of steps to normalize and categorize the data. 

Since data arrived in many different formats, and at many levels of granularity, the following 

normalization procedures were used:  

1. Determining the nature of service being provisioned (who is providing service and what 

technologies are in use) 

2. Planning an attack strategy for the submission –understanding the data and assigning team 

members to various tasks 

3. Geo-referencing the data; QA the georeferenced data  

4. Geoprocessing the geo-referenced response 

5. Segregating the submission into the correct NOFA-compliant submission formats. 

6. Apply appropriate source metadata8 

                                                           
6 Speed, Anchor institutions and Middle Mile facilities are discussed in later sections. 

7
 To help clarify issues relating to Census block area and vintages in use, our team published a technical paper to 

the Grantee workspace.  Because we were unsure if this standard should be implemented uniformly, this 
document was never distributed to the provider community. 
 
8
 When our team logs a submission into the staging database we record at least two attributes.  One records the 

method used to derive the coverage, the other records the method by which speed was attributed to that object.  
Other attributes carried to NTIA carry source meta values as well. 

https://sbdd-granteeworkspace.pbworks.com/w/file/33293657/Technical%20Reference%20Document%20Final.doc
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Figure 2-Broadband Coverage Process 

Impact of Program Change 

There were four important program changes that impacted how Broadband coverage was developed 

and submitted to NTIA in Round 3. 

The first was the development of a “provider match” submission metric whereby the grantee’s complete 

list of known providers in the state is compared against lists from third party sources.  The provider 

match specification was discussed on a webinar prior to the release of the national map.  Although, to 

this date, there has been no clarification on how this metric is established or exactly how it will be used.  

We have invested significant resources to support an internal process to compare our provider lists with 

several additional sources.  This has been manifest in at least three ways. 

Within our provider verification process we  work to derive a  state level match against third party data 

sources.  As discussed in the early pages of this manual, there is no guarantee that a third party data 

source is any more accurate than submitted data, nor does it necessarily reflect the provider ecosystem 

specified in the NOFA, Technical Appendix A.  We devote significant resources to matching our 

submitted data against three, third party data sources.  In many cases this becomes a judgment call 

trying to match provider names across systems.  It is a difficult and somewhat arbitrary process.  

Nonetheless we do believe it has value because it forces a re-examination of who we believe is an 

appropriate provider within a non-NOFA context. 

The use of a provider match system, as well as the webinar comments (3/17/11) directing grantees to 

estimate, wherever possible, non-participating providers have made us back away from one of our 

fundamental assumptions in data collection.  As discussed in the prior draft of this manual, we had 

developed a certain “hold-out” class of data when a provider’s data wasn’t of sufficient quality to verify, 



SBDD Mapping Methodology Page 18 
 

or we were unable to put it into the data model (eg. address points submitted for a wireless).  In this 

submission, much of this hold-out data has been included.  In some cases this means we are using 

simple polygons to capture a wireless ISPs serving area.  Other times, if we are confident in the 

coverage, but can get little clarification on the submitted speeds or frequencies, we release the 

coverage and note in our internal metadata the source issues with the other attributes.   

Finally, we have used the new provider type classification of ‘other’ to bring some aspect of the 

provider’s data into our submission.  There still seems to be confusion on how to handle provider types 

where a provider offers multiple paths to receiving Broadband for typically business customers.  Rather 

than waiting for certainty on the answer, we bring the provider in and list them as Provider Type 

“other”.  Our sense is Provider Type “other” will continue to expand in the fourth submission as we pull 

in more providers who are facilities-based and reseller.   

Clearly one challenge is the data, but an equally significant challenge is appropriate messaging around 

this “other” provider type category.  We do not want to leave consumers with the impression that they 

can get a high capacity fiber or Microwave link despite the fact that the hospital next to them in the 

same Census block can get this service. 

The final set of changes was a second verification check against reported FRNs.  As NTIA is stressing the 

importance of this attribute, we increased its visibility in our Check Map process.  FRN is now listed on 

both the tabular verification report and the provider PDF map.  Beyond this increased visibility we had 

an analyst verify each FRN in our system against the FCC API9, as well as FCC textual search10.   Because 

the FRN is not an identity management tool, we are unsure if the FRNs we’ve included are those desired 

by NTIA, but we have at the very least, verified the existence of the FRN via the FCC system. 

Trends in Provider Supplied Data 

With this third submission we take note of three important trends.   

First, with larger providers, we are seeing an increase in data stability relative to earlier submissions.  In 

informal discussions, several providers have noted changes and stabilization in internal data processes.  

The firms have invested internal resources in stabilizing this data feed.   

We see this reflected in very stable counts of Census Blocks and road segments.  This does not mean 

that complex problems like segment identification or dispersion in data have been ‘fixed’.  It does mean 

that the format and methods to produce inputs for NTIA are increasingly stable. 

Second we note that several providers have been particularly concerned with an appropriate 

identification of Maximum Advertised speeds.  In some cases this involves identification of very small 

areas (sometimes below the level of a Census block) and appropriate assignment to technology of 

transmission and maximum advertised speed tiers.  In other cases, questions arise regarding maximum 

advertised speeds that could be sold based upon network design, but that are not generally “advertised” 

or otherwise stated to the general public.   

                                                           
9
 http://reboot.fcc.gov/developer/frn-conversions-api 

10
 https://fjallfoss.fcc.gov/coresWeb/simpleSearch.do 
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Third when comparing submission three results relative to submission two it is important to recall the 

inclusion of much new data within the Provider Type “other” category.  This change does not necessarily 

reflect a change in the size of the market, rather it reflects new data coming into the analysis and 

segregated into a distinct category.. 

Coverage Geoprocessing Methods 

The next section discusses how data were geo-referenced and geoprocessed given a particular 

submission format.   

In most cases, in Round 3 we were still not provided with street segment level information for Blocks 

greater than two square miles (large Blocks).  This necessitated subsidiary geoprocessing.  As stated 

before, our first goal was to derive block level coverage.  Then, for Blocks greater than 2.00 square 

miles, we moved to a segment gathering processing.  The segment process will be described in the last 

section.11  

Block Level Coverage Derivation Using Service Point Data 

A number of providers submitted point level customer data.   

In some cases the submissions themselves were not internally consistent.  For example, in the image 

below, unprojected points are shown, while the Census block polygon to which the points are supposed 

to “belong” is highlighted.  In this case, one of the following scenarios has occurred:  block attribution is 

wrong, the points are not in the location to which they are attributed, or different block shapes were 

used than what is assumed. 

 

                                                           
11

 As has been discussed previously, we note inconsistency in how providers are supplying information at the block 
and segment level.  Beyond the temporal differences, we see that providers are computing area differently, as well 
as including or excluding water areas.  This provides an inconsistent measure across providers for the 2.00 sq mile 
cut off.  Our preference would be to provide guidance to service providers within our states, but our concern is 
that we will inconsistently message this with grantees in other states.  We would appreciate consistent guidance 
from FCC/NTIA on this topic. 
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Figure 3-Internal inconsistency in submitted data 

In other circumstances, we found that inconsistent geocoding standards may produce misleading 

results.  The next image shows point level data, and the Blocks are colored based upon the counts of 

points intersecting Blocks.  The challenge this presents is that if geocoding was performed on a different 

dataset than the block boundaries (the road traces are not coincident with block boundaries) and/or 

geocoding was done without an offset, it becomes problematic to assign coverage to a Census block 

based upon only the point locations. 
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Figure 4-Block Coverage 

For this reason, we elected to use a 200-foot buffer to select Census Blocks that intersect our points.   

Block Level Coverage Derivation Using Customer Facing Plant Level Point Data 

In other circumstances, providers submitted point level plant data.  From what we could gather, these 

points tended to be customer-dedicated terminals.  Typically, these providers were high speed 

Broadband producers—which may somewhat strain the definition of Broadband as other providers 

supplying comparable services specifically disclaimed the ability to provide high-capacity Broadband 

services in the required 7-10 day interval.  In these plant point data submissions, we had similar 

concerns to the point level customer data, but two factors tended to make us use a more conservative 

intersection buffer.  First, we tended to have far fewer points to work from, so our concern was 

grabbing too many covered Blocks as the Blocks tended to be much smaller in these urban areas.  

Second, these plant points tended to be dedicated to distinct customers, but it was difficult to know 

which element of the customer’s campus to attach coverage to. 

In the case of the image below, given a small shift to the left, it would be easily possible to gather 1 to 3 

Census Blocks from this point.  Although orthoimagery is helpful in a circumstance such as this, it is still 

indeterminate – specifically in areas where the coverage is attributed.   

Thus, in the circumstance of plant level point data, we used a 100-foot intersection buffer. 
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Figure 5-Plant Point level data 

Coverage Derivation Using Linear Facilities Data 

A number of providers submitted facilities data.  We handled this data in different ways depending upon 

what we believed the facility data represented. 

Most telecommunications networks are divided into two components.  Feeder supplies higher capacity 

nodes (eg. DSLAMs, Fiber Nodes).  Distribution usually supplies customer premises (NIDs, Pedestals, 

Taps, ONTs).  Where we could discern what strand we were provided, we used different methods. 

The next image demonstrates a geo-referenced CAD image as given to us by a Broadband service 

provider.  Note the light and dark green shading.  We would infer that the lighter segments represent 

distribution and the dark green represents the feeder network. 

In the case of a combined strand map, we used a relatively tight buffer of 200 feet to gather covered 

Census Blocks.  Our intersection tolerance is based upon an assumption that our data likely represent a 

situation comparable to customer point level submission in that we have most of the network footprint 

captured. 
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Figure 6-Georeferenced CAD information supplied by Broadband provider 

 

In other circumstances, we were provided engineering information that we inferred to be feeder only.  

This inference was typically based upon the presence of fiber optic equipment only.  In these cases, we 

used a more generous 2,000 meter Census block intersection.  The 2,000 meter criteria was based upon 

an informal survey of population in proximity to the geo-referenced strand data, but it could be varied 

based upon a more complete survey. 

Coverage Derivation Using Covered Street Segment Data 

In some cases we were provided with covered street segment data.  Covered segments tended to come 

from two sources. 

In some circumstances, providers gave us CAD data, which was not drawn in a projected manner.  This is 

relatively common for older engineering data derived from hand drawn records.  This meant that our 

team had geo-registered the image into an approximate position.  In this case, the boundary streets 
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were selected, and an enclosing polygon was derived.  The intersection of this polygon and the Blocks 

within became the geoprocessing method to derive Blocks. 

 

Figure 7-Coverage derived from street segments 

In a second circumstance, street segment data was developed during coverage estimation.  Handling the 

estimated data is discussed below. 

Coverage Derivation Using Serving Area Point Submission Data 

In other cases we worked with a provider to derive service areas based upon point plant data.  In these 

cases we were given a primary serving node and an appropriate road length service boundary. There is 

an important distinction from the plant data discussed above. In this specific case, the data submitted 

was a node that served many locations--such as a Central Office or DSLAM.  This is contrasted with the 

earlier example in which the point represents a node serving only a few customers.   

When trying to derive coverage from Central Office or DSLAM nodes, the team used ESRI Network 

Analyst to derive covered road segments honoring these road engineering parameters. 
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The figure below shows street level coverage derived from Central Office and remote DSLAM point data.  

 

Figure 8-Coverage derived through road paths 

In response to Provider feedback we revised this process to include a larger variety of TIGER road types.  

In Round 1, unimproved roads were not used.  In Rounds 2 and 3 -- particularly to improve estimates in 

areas bordering parks and public lands -- a wider class of TIGER roads was used.12 

The segment level coverage is easily extendable to derivations of Census block level speed.  The figure 

below shows the attributions of block level speed based upon the Maximum Advertised Speed available 

from a DSLAM.  Although the methodology isn’t perfect, it does provide insight into the value of 

granular infrastructure data. 

                                                           
12

Only TIGER features of MTFCC type S1100 and S1200 were excluded from use. 



SBDD Mapping Methodology Page 26 
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Coverage Derivation Using Polygon/Polyline Serving Areas 

Broadband service providers sometimes submitted coverage in terms of served areas.  This was either in 

direct geospatial formats, CAD files, or paper maps.  The image below reflects a carrier’s service area.   

Within that service area, there are variations in technology of transmission and served speeds.  When 

polygons with speed data and technology of transmission were available, we used a spatial intersection 

to gather covered Census Blocks.  In many cases, using covered Census Blocks resulted in a loss of the 

speed variation (sometimes the speed variation was at a level below a Block and did not get picked up 

within a spatial query).. 

 

Figure 9-Coverage derived through serving area polygons 

Although we cannot directly solve the loss of speed granularity due to Block shapes, we honor a 

business rule wherein we always select Blocks from the highest speed areas first, and then allow the 

lower speeds to select from the remaining Blocks.  This is an arbitrary rule, but our feeling was that it 

should be a consistent selection, rather than an unordered selection. 

Street Segment Derivation, Large Blocks 

For those calculated Blocks greater than 2.00 square miles (large Blocks), we provided coverage in terms 

of covered street segments and corresponding geography.   

With respect to segments we had four sources of data: 

1. Covered large Blocks 

2. Tabular street segments and address ranges for large Blocks 
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3. Geographic segments either with street attributes or without. 

4. Service area boundaries 

A number of providers only provided a list of covered large Blocks without corresponding segment 

information beneath the block.  This provided the dichotomy of either selecting all segments in the 

block, or none.  Because we had little information from which to make the selection, we elected to be 

conservative and did NOT pass any covered segments to NTIA from this submission format.  Some 

Broadband providers submitted covered street names and street ranges.  In these cases we performed a 

manual analysis trying to link to specific segment names and address ranges within covered Blocks.  

Sometimes this was a simple process because a provider used a TIGER derived street database.  In other 

cases we could not determine the source of the provider’s street data.  Street and Address matching 

tended to yield a relatively good result (typically between 30% and 100% of possible segments in the 

Block), but was very time consuming.  Where yield rates were low, our result was a shredded segment 

coverage pattern, like the image shown 
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below.13

 

Figure 10-Blue road segments adjacent to peach covered small Blocks 

A number of providers submitted geographic objects. In this case, our manual process was directed 

toward a conflation of data sources.  The goal was to take provider submitted segments and put these 

segments in terms of our TIGER 2009 basemap.  Although there is a trade-off in the accuracy using non-

provider submitted segments, we felt it was more important to have a road set that would edgematch 

our Block features and remain consistent with the Block size standards we used for other providers.  This 

is important for the appearance of the online maps, as well as potential verification work where we are 

attempting to judge a feature based upon its attachment to a covered small Census block.  The figure 

below shows street segment input data. 

                                                           
13

 We continue to hear providers expressing concern that our request for either a geographic object or TIGER Line 
ID is beyond the scope of the NOFA clarification. Therefore, they cannot supply additional information to us. 
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Figure 11-Provider Submitted Street Segment Objects.  The segments don’t edge match the Blocks nor are they continuous. 

The figure following demonstrates the same area after the conflation process.  Blue segments are the 

conflated TIGER roads which will be passed to NTIA. 
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Figure 12-Provider submitted segments in gold, selected TIGER 2009 in blue—Conflation result; in many cases what was a 
continuous segment is made discontinuous because even with a distance buffer the TIGER segment doesn’t always intersect 
the provider segment 

 

The final segment process was used when we were supplied with a Broadband covered area polygon.  In 

this case, we found the segments within covered areas and eliminated those segments inside of Blocks 

less than or equal to 2.00 square miles. 

Because there was more control over the format of the inputs (we knew we had a boundary and were 

working with TIGER segments), this was an automated process that followed this general format: 

1. Select large covered Blocks by provider ID (from updated Large Block table) 
2. Select TIGER 2009 road segments (MTFCC like 'S%') that face (CB = CBLeft2000 or CB = 

CBRight2000) covered large Blocks for provider 
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4. Select segments as distinct records, max speed with corresponding technology, join in 
feature names, export selected records to temporary DBMS table  

5. Join TIGERroads feature class to temporary table on TLID 
6. Select covered segments (Python script)  
7. Select service area polygons for provider 
8. Clip selected facing segments with selected service area 
9. Export clipped segments to staging feature class, keyed by ProviderID 

In this figure, orange represents covered small Blocks; black lines are covered segments in large Census 

Blocks (light blue).  The service area boundary is shown in grey. Based upon feedback from providers, we 

have elected to clip segments at the end of a coverage boundary.14 

 

Figure 13-Output of the Segment Process 

Wireless Coverage Process 

In general, most providers of mobile Broadband submitted coverage information in a NOFA-compliant 

format.  Other than attributions for spectrum and speed, little was done to this coverage.15 

                                                           
14

 An outcome not discussed here is how to handle address ranges on segments.  As NTIA is asking for a Min and 
Max on the segment, deriving theses values for clipped segments is very problematic.  Also the prevalence of 
alphabetic characters in addresses makes the min/max selections very arbitrary.  We are grateful that addresses 
are nullable data elements. 
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In this submission LinkAMERICA made an aggressive effort to bring additional WISP coverage into the 

NTIA dataset.  For the most part, our outreach was with providers who were unable to supply 

sufficiently granular data in the past or those that could only submit wireless address points which is no 

longer a valid submission format. 

In Round 3 fixed wireless providers generally either supplied coverage information or infrastructure 

from which coverage estimates could be derived.  Many allowed us to use their tower locations, 

antenna heights and direction/spread of coverage to derive a line of sight coverage estimate.  In our 

experience, this is a conservative and reasonable derivation of coverage. 

Some wireless providers submitted RF studies.  When this was done, there was a request that the signal 

strength be removed from coverage data.  The request was honored.  

Other fixed providers were able to supply us with hand drawn maps or polygons/polylines drawn in 

Google Earth format.  In these cases we did our best to georeference and verify the coverage areas with 

the WISP. 

When we received coverage information in KML format, like the image below, we accepted the data as 

it was presented to us.   

 
                                                                                                                                                                                           
15

 Some polygon data did exceed the node count threshold.  In these cases, data was rasterized to 100m cells and 
then converted back to polygons.  The polygons were dissolved to multi-part geometry.  This addressed the node 
count concern. 
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As the image above shows, in some cases we have hand-drawn coverage, as well as infrastructure.  

Instead of estimating their coverage using a line of sight or RF study, we elected to stick with the 

provider’s supplied information.  Our decision was guided by two primary factors: 

 If the provider is advertising using this coverage they must have specific confidence in its 

accuracy. 

 If the provider can supply coverage, as well as infrastructure that reasonably supports the 

coverage, there is a very high likelihood in the accuracy of the information.   

The downside, of course, is the polygon shown on the map may not represent our notion of how 

wireless coverage should appear.  

In general we note several interesting trends in the wireless data.  First, we can be successful in 

increasing the amount of WISP coverage when we aggressively pursue WISPs.  This means we have to be 

willing to accept data on their terms and convey it into SBDD formats.  Some of our WISP submissions 

have taken over 12 hours to normalize into SBDD formats.  Second, we have to accept that some WISPs 

will not be able to supply FRNs.  There remains a minority of WISP providers who are not aware of the 

FCC FRN.  Third, there appears to be some variation on how the NOFA coverage definition is met.  In 

other words, there seems to be a disparity on the necessary strength (e.g. -80 dB, -98 db, -120 dB, etc) 

to provide the appropriate quality of service for data services.  Fourth, it was very difficult getting 

providers to identify spectra used for Broadband data services16.  We are unsure if this is a competitive 

concern, or if the same coverage pattern is yielded for multiple frequencies.  Typically, the spectra 

returned were those that a provider was licensed for.  At this point, we have no reliable way to locally 

determine what set of frequencies are used to provide Broadband data services in a local area.   

Service Address Point Process 

A handful of providers have requested that customer level, service address point data be submitted to 

NTIA.  In these circumstances we have done minimal processing to preserve the provider’s intent with 

this deliverable and not bias downstream NTIA use. 

Our verification included checks against commercial or Public Utility/Public Service Commission 

exchange boundary maps.  Points not contained within one mile of a boundary are not submitted to 

NTIA.    

We retain from the provider the provided latitude and longitude, as well as Census block.  For some 

coverage data, if a provider is unable to supply a longitude, latitude or Census block, we fill in these 

attributes.  In those circumstances where we do not have a Census block, but we do have a longitude 

                                                           
16 One provider responded by email, “This mapping program is to provide the coverage area for 

Broadband provided by a company. Not to keep a detailed account of every aspect of a companies (sic) 

network.” 
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and latitude, we accept the given longitude and latitude and use that as the basis for our Census block 

assignment. 

With point data we have tested for comparable geocoding success rates but do not overwrite provider 

information.  From this type of analysis we note the amount (usually little more than 10%) of addresses 

that seem to locate with less than street segment certainty.  Deriving a thematic representation of the 

points on speed also illustrates some of the locational certainty issues in this point level data.   

Coverage Estimation Process 

Although the derivation of Broadband coverage into Census Blocks, street segments, or wireless 

coverage files is, in itself, a bit of an estimation process, there was an explicit estimation process 

required in cases where a Broadband provider either refused to participate in our survey, or provided 

such a threadbare submission that no carrier-based coverage information could be gleaned.   

We typically resorted to three possible estimation paths. 

For Cable (HFC) providers who did not provide any coverage information, we fell back to Media Prints 

data.  Rather than using the entire Census Block group gathered by Media Prints, we used only those 

Census Designated Places carrying the same or similar names to the Media Prints p_com field.  Our 

reasoning was that Cable systems tend to be franchised on a municipal or at least administrative basis 

so the coverage will likely follow a governmental boundary.  As a general rule, cable infrastructure is not 

available in the public domain17 and what could be found was poor in quality and difficult to ascertain 

for validity.  

For DSL providers who did not provide any coverage information, we estimated road-based coverage 

from their Central Offices18.  We only used Central Offices that showed evidence of DSL or fiber-based 

services in the NECA 4 tariff.  Road-based engineering areas were derived via ESRI Network Analyst to 

18kft.  These segments/boundaries were clipped to commercial wirecenter boundary edges.   

For mobile Broadband providers who were non-responsive to our requests, we fell back to American 

Roamer coverage patterns.  We generalized the American Roamer coverage to ½ km in order to protect 

the licensed information. 

For fixed wireless providers who provided no coverage information, we relied on their public websites to 

scrape coverage maps.  When these maps were available, we georeferenced them and tried to use the 

outer polygon boundary to represent their serving area.  In other cases, when only a tower could be 

provided, we used a view shed analysis and estimated coverage at 10mi per tower19.  Because much 

wireless propagation is driven far below the Census Block and much engineering information isn’t 

                                                           
17

 The team tried to use data from the FCC Coals system and 321/325 fillings but this seemed to be a bit non-
uniform in quality. 
18

 Central Office location was derived from MapInfo ExchangeInfo Professional.  Wirecenter boundaries also came 
from this commercial product. 
19

 In some cases we had an approximate radius of coverage but no height.  In this case we used a 50’ height 
estimate and then clipped the coverage to the provided coverage range.  We also clipped wireless coverage to 
honor state boundaries but did not look for providers serving coverage with out of study state facilities. 
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known (frequency in use, polarization of the signal, coverage pattern of antenna(s), local terrain/land 

cover) this was the most complicated group to estimate.   

Speed 

Speed attributes are reported both at the block (typical) and higher levels (maximum advertised and 

subscriber weighted).  We note that in many cases, providers did not supply typical or subscriber-

weighted speeds.  In some cases, it appears--although we cannot verify--that their maximum advertised 

speeds were used to populate typical speed columns. 

We do have limited testing data on reported speeds, but we have been careful to not use our typical 

reported values with carrier-provided information.  If we do not have a speed value from a provider, we 

report an empty value.   

Several service providers claim they do not have data on typical speeds available, but estimate a 20% 

overhead factor between the advertised speed and what may be experienced by an end user. 

We continue to request advertised speed at the block level.  Nevertheless we appear to be getting 

speeds that do not vary over a large geographic area – leading us to believe that providers may still be 

submitting the maximum speed advertised in local media for the entire market.  For the most part, we 

have been unsuccessful in messaging that advertised speed should not correspond to a market area, but 

instead, the maximum speed, which can be provided to a household—what some may describe as a 

‘qualified speed.’20 

In circumstances where a provider supplies a range of speed attributes, we assign NTIA categories based 

upon the midpoint of the range. 

To support NTIA program office requests, we have also modified the structure of the Service Overview 

table.  Even if Maximum Advertised Speed is supplied at the market or county level, we push that speed 

down to the contained Blocks.  The only records that remain in this table, will be those wireline records 

with either a non NULL nominal weighted speed or ARPU value. 

Community Anchor Institutions 
In the first submission, the Community Anchor Institution (CAI) process was referred to in terms of a 

learning curve.  This continues to be an appropriate metaphor.  The mapping team continues to focus on 

data that will support and help inform policy makers and the SBDD planning process. 

In the first submission, the team gathered information on what data was available and what resources 

will be required to engage these categories of important institutions.  In the second submission we 

                                                           
20

 As an example of a response to our request for Block level advertised speeds, we received the following 
comment from one anonymous provider, “This is and of itself does not require anything new of us – just states the 
NTIA supports efforts focused on getting that information on the CB level.”  It would be helpful to have broader 
messaging so that providers understand this new direction.  
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continued to obtain additional connectivity information.  For the Spring 2011 collection, the team began 

a survey process to directly engage these important organizations.    

Our work with CAIs is guided by three principles. 

First, CAIs are important stakeholders within the planning process.  Our goal is to engage participants in 

regional planning that has strong ties into the CAI categories identified by NTIA.  This has a direct benefit 

of engaging an established stakeholder community.   It also allows Broadband planning to tie into 

existing organizational and planning networks.  In each of our states, key relationships with education, 

public safety, libraries, and economic development sectors are being identified and developed. 

Second, we believe that CAIs will likely be one of the primary beneficiaries of targeted Broadband 

funding.  Our belief stems from the sense that many of the benefits of Broadband will extend from these 

community ‘anchor points’.  In other words, it isn’t solely the existence of Broadband at a library that 

provides a benefit.  It is people using applications that work only on a Broadband network to upgrade 

their skills (e.g., online training) and gain access to online content (e.g., job postings, goods and 

services), etc.  The targeted use of a specific application--that can only take place with Broadband 

networks-- is what produces the priority benefit.  Put another way, there seems to be a realization that 

things are less about pure connectivity (for the sake of connectivity) than about connectivity in terms of 

an application (for the sake of the benefit obtained through the application). 

Third, we continue to use a rational and targeted approach to derive information.  This means we will 

utilize our planning teams for as much ground work as possible.  This also means that a goal of our CAI 

process is not an exhaustive Census of anything that could be a CAI; rather, it is the discovery, inventory 

and integration of Broadband planning activities into those CAIs that stand to produce the greatest 

synergies with the SBDD planning process.   

The above implies two significant points.  First, the team’s goal is to document community anchor 

institution connectivity within a broader context of regional and statewide planning objectives.  Second, 

if a particular category of CAI has an independent Broadband planning effort underway, we will 

encourage that organization to take the lead, and we will provide relevant expertise and support as 

warranted.  For example, in one of our states, the public safety community is already engaging in a 

mobile Broadband survey effort.  We have aligned our CAI data collection process with that effort and 

are sharing information and expertise (e.g., hosting a survey) to support their mission.  In another state 

we are attempting to glean connectivity information from a municipal government survey.  There may 

be some downside to this collaborative approach in that we may have to work with data spanning 

different times or we may not have all of the location-specific information we need, but this does 

prevent the same user from receiving multiple inquiries. 

Further, the team continues to rely on the notion of Internet Intensity Zones.  As the Broadband 

coverage information is developed, if we do not have definitive connectivity information from other 

sources (e.g. a phone survey, web survey, listing provided by a facility owner) in this study, those Anchor 

points that fall into an existing area of SBDD Broadband coverage will not be left out or submitted with 

NULL values.  Rather, the adjacent coverage area will be the first estimate of Broadband coverage for 
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the facility.  The use of an estimate allows the site to come into the analysis and learn a bit about the 

accessibility of that facility, but it also frees resources to examine those anchor points that are more 

dispersed and likely under/un-served.  The team will conduct targeted surveys to discover connectivity 

and, more importantly, applications in use at prioritized CAIs.21 

We close this section with a figure that we hope reinforces our CAI process. 

 

Figure 14-Anchor Institution Process 

  

Recall from our first submission analysis, in most cases, CAI points are clustered and on average less 

than 1 ¾ miles away from one another.  Relying on The First Law of Geography22, this likely means that 

the Broadband accessibility is very comparable for CAIs that are close together.  We believe this means 

Broadband accessibility may be less about connectivity than it is about the ability of a CAI to afford, 

successfully adopt and utilize Broadband to support its mission.  Therefore, an important part of where 

SBDD mapping and planning come together understands what Broadband is used for, potential barriers 

to adoption, and how it is an essential component in a planning region’s investment scenario. 

                                                           
21

 We track internally those features with Broadband connectivity defined via an estimate but within the current 
transfer data model we lack a mechanism to propagate that information to NTIA.  Appendix One expands upon our 
thoughts regarding a series of audit fields in the transfer database which would be helpful to inform downstream 
users regarding the source of data or use of estimates. 
22

 http://en.wikipedia.org/wiki/Tobler's_first_law_of_geography.  We are attaching connectivity based upon the 
highest speed wireline provider in that block.  This provides a ceiling for what can be obtained, although the CAI 
may not be purchasing this level of service based upon needs, budget, mission, etc.. 

http://en.wikipedia.org/wiki/Tobler's_first_law_of_geography
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Anchor Institution Survey 
During the third submission period we began a survey process to both verify received connectivity 

information and garner additional connectivity information from CAIs.  As with WISPS we wanted to 

aggressively target and improve this data section. 

The process began with the Round 2 CAI list.  Again, we prioritized schools, libraries and healthcare 

institutions.  A small team made outgoing phone calls to discover relevant contact names.  In Wisconsin, 

we were able to gather about 150 email addresses based upon 440 calls.  There were only 14 refusals. 

While one team worked on improving the contact list, a second team designed and developed a simple 

online survey system called CAVS (Community Anchor Verification Survey).   

 

Figure 15--CAVS Screen 
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Users were invited into the CAVS system by the receipt of a postcard with an organization specific code 

printed on the mailing label.  Beyond the questions shown above, there was a second page to the survey 

dealing with use of Broadband.  Those results are directed to the planning teams. 

The table below summarizes outgoing contact activities by state.  This includes both a post card as well 

as for some organizations in which we had contact information a follow up phone call. 

States 
Post 
Card  Calls 

WI* 2033 75 

ID 1059 259 

WY 345 30 

AL 1640 14 

 

 

As of 3/16, verification23 statistics were as follows: 

State Verified / Total Records Percent Verified 

AL 72/2137 3.3% 

ID 172/1596 10% 

WI24 1187/3945 30% 

WY 169/796 21% 

 

We are keeping the survey open after the Round 3 submission to NTIA and will continue to collect data.  

In Alabama we have also begun to use resources from the planning teams to make outgoing calls and 

better target the surveys. 

Clearly this survey was resource intensive but it did yield an increase in verified, rather than estimated, 

CAI data.  We are unsure if we can sustain it in the next submission, but is has proven to yield new 

information. 

Anchor Institution Trends 
At this point we have focused our CAI attention on schools and libraries, with respect to connectivity.  

We benefit from strong relationships throughout the education sector (K-12 and Post-Secondary).  We 

have also found excellent resources within State librarians in all States. 

                                                           
23

 We say a record is verified when it has been opened by the CAVS test user.  It means at least one field was 
modified. 
24

 In Wisconsin several large school districts supplied files with connectivity information; we performed a bulk 
update in these cases.  We attribute it to the survey as the survey triggered this response. 
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To supplement the education and library information we have formed organizational relationships with 

the major hospital associations within each state.  Our goal with this relationship is to cull information 

from their planning process.  We continue to formalize/advance this relationship.   

As in the prior submission, we are using public domain sources of information for public safety-category 

4.  The vast majority of these locations are estimated with respect to connectivity.  Our hope is that in 

subsequent submissions, we will reduce the size of this category and connectivity information specific to 

root nodes of the public safety network--such as County Emergency Operation Centers.25  At this point 

we have had minimal success gaining this information. 

Because we have a wide ranging population of CAIs in our data set we have a variety of Broadband 

services that don’t always fit NOFA parameters.  Services like PRI or T1 are classified into “other copper,” 

but the bandwidth is estimated based upon the number of channels purchased.  We also had difficulty 

obtaining both the upstream and downstream channel capacities.  In large part, we made the speeds 

symmetrical, but this is an assumption on our part.   

As a final verification step, we attempt to screen the CAI data for duplicate values.  Because many CAI 

are closely clustered together we perform the de-duplication based upon the ANCHORNAME within the 

ZIP code. 

Middle Mile 
Middle Mile information was collected directly from providers via survey or interview.  Middle Mile is a 

“chicken or egg” type of challenge in that it is possible to verify that the infrastructure exists, but 

extremely difficult to know what it is doing without engineering level assistance.  Although most 

providers submitted “something,” there was a significant variance in what that “something” 

represented.   

The purpose of this section is to record some of the comments and questions we have received about 

Middle Mile.  We hope this provides better context for our data submission. 

Within the NOFA, Middle Mile was defined as (a) a service provider’s network elements (or segments) 

or (b) between a service provider’s network and another provider’s network, including the Internet 

backbone. (Collectively, (a) and (b) are “middle-mile and backbone interconnection points.”)26 

Given the existence of the “or” in this definition, providers submitted a variety of information.  Based 

upon the NOFA example, several fixed wireless providers interpreted Middle Mile in terms of the 

connection points from their towers to their own serving backhaul location.  The topology was 

commonly Microwave from their distribution towers to their NOC.  The NOC and towers were listed as 

the Middle Mile points. This seems to be consistent with the first definition clause (a). 

                                                           
25

 Within the public safety category, it is also very difficult to derive precise locations as many CAI are addressed to 
PO boxes. 
26

 From http://broadbandusa.gov/files/BroadbandMappingNOFA(FederalRegisterVersion).pdf at 54, visited March 
28, 2010 

http://broadbandusa.gov/files/BroadbandMappingNOFA(FederalRegisterVersion).pdf
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Telephone, Mobile Wireless, and Cable providers tended to remain either silent on the question, or 

would provide a single location in which Internet peering occurred (clause b).  A number of participants 

explained that the question was quite ambiguous with data traffic moving back and forth over both TDM 

and IP networks--it was unclear where the distinction should be drawn.  As a general rule it seemed like 

many providers listed a single location where Internet Peering occurred. 

A number of providers refused to answer the question on grounds of confidentiality27.  Others would not 

disclose as their Middle Mile points are not owned--another company provides the physical and 

electronic connection to their network.  In other words, the entity providing Broadband is not the entity 

providing Middle Mile. 

Additionally, based upon the new Provider_Type classification of “other,” we have started to integrate 

points provided by Broadband service providers not meeting the NOFA definition.  This includes POP 

locations and aggregation points for public / private networks.28 Within a given submission there were 

two final attributes that tended to concern respondents.  First, speed should be measured in terms of 

only data capacity and what exactly is “data” (e.g., can/should you segregate out voice or video), and is 

the relevant capacity of the physical connection, channelized to a specific virtual circuit on their 

network.   

Finally, a number of other providers were unsure of the height above grade measure (is this their floor, 

the street outside, etc).  We seem to have a combination of height above or below grade, as well as 

heights above mean sea level (AMSL).   

To the extent possible in our timeframe, we verified the location of a sample of Middle Mile points.  

Where we could see infrastructure that appeared to be consistent in location with other provider 

infrastructure, we felt that the location was accurate.  In some cases, the point provided seems sensible 

(is on a road, near other equipment), but using imagery, we couldn’t find a place where this type of 

connection could occur.  This wouldn’t be unforeseen, in that Middle Mile connectivity likely takes place 

in a protected environment much smaller than a standard Central Office installation.  

Mobile Wireless Coverage 
We have received mobile wireless coverage from most mobile Broadband providers in each state.  At 

this point we have cleaned the geometry of the data and attributed it with spectra and FRN as required. 

Provider derived coverage has been reviewed against the commercial licensed product for consistency.  

To a limited extent we also use licensing locations and tower infrastructure to spot-check supplied 

                                                           
27  As received in email 9/30/10, “Due to security concerns and the risk of public disclosure of highly sensitive data, 

whether inadvertent or otherwise, ***REDACT***response to the Middle Mile and backbone interconnection 

request is limited to publicly available information available on {remainder not included}” 

 
28

 As discussed in our readme.txt file, a number of middle mile points were lost in validation due to their location in 
adjacent state.  This will cause a decrease in some providers relative to prior submission. 
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coverage.  This mode of verification remains complex, given the lack of facility-based information with 

mobile wireless. 

Verification 
Almost by definition, data verification is an ongoing and evolving process. Clearly, with each new data 

submission there will be a validation process at hand and at the same time, our team continues to 

expand and improve the efficiency and effectiveness our data verification routines. Consistent with the 

movement toward an fGDB export database and use of a data receipt script, much of our validation 

effort was spent in supporting the ETL processes into the required formats.  In future data submissions 

we will continue our work to stabilize and improve the business process that normalizes provider 

submissions into NOFA formats and expands in more depth on the confidence analysis within the data.  

Verification Standard 

 
Our overall verification standard is focused on the level at which we supply processed data to NTIA.  This 

means that the vast majority of our verification process will be focused on ascertaining coverage for 

Census block’s less than 2 square miles and covered road segments. 

We are learning that Verification has multiple dimensions. 

Provider verification is finding providers who supply Broadband and discriminate out providers not 

meeting Technical Appendix A’s definition of Broadband.  

Identity verification is taking the provider’s categorized in the first step and ensuring that the provider 

either has a valid FRN or is assigned a default FRN.  Identity verification is very complicated because of 

the Technical Appendix A’s mandate to record data at the FRN, Provider Name and DBA level.  Each of 

these attributes could be unique for a single provider going to market under different or the same 

names.  As a result, rolling up each provider into an identity collection that matches either the FCC data 

integration team or a third party Broadband provider’s data view, is very, very time intensive.  Identity 

verification is discussed in the earlier section-- Developing the Provider List. 

Coverage verification is a broad term, but in our definition it boils down to determining if Broadband 

coverage is in the right place.  For a given provider, the question is whether the coverage is assigned to 

appropriate Census Blocks, road segments or area features.  Coverage verification can be further broken 

out into two distinct classes: 

 Technology verification, which is determining if the provider is listed with a technology 

consistent with their marketing information.  It also involves a validation with supplied speeds.   

 Speed verification, which is determining if the speed supplied for that block, road segment, 

point area file or market area is consistent with the technology and the marketing information 

received. 

The final verification dimension is consumer feedback and crowd-source verification.  This is a dynamic 

set of steps we are beginning to implement.  One side of this is responding to consumer concerns.  The 
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second is using the crowd sourced data to validate provider claims and, if appropriate, update the map 

and the underlying data. 

At this stage, our working hypothesis (confirmed by our experience) is that there will not be a single 

dispositive measure to indicate Broadband coverage availability in a Census block or along a segment.  

From prior work, and examining our current provider submissions, we believe that there is too much 

variation below the submitted record to make a single binary yes/no indication.  Rather, there will be a 

series of measures that combine to provide qualitative confidence (a classification scheme) in our 

indication of Broadband availability at the block, segment, or wireless polygon level. We believe such a 

qualitative confidence scheme is both relevant to and supportive of NTIA interests, as well as the 

interests of our end-user community – that is, the states and citizens we serve through this program. 

The intent of this section is to illustrate why we are moving toward a particular verification 

methodology.  Our team is learning as we go along, and will adjust and improve this thinking. But given 

our experience to date, this is where we are heading. As stated above: 

 First, coverage verification is at the level of data submitted to NTIA. 

 Second, coverage verification is enhanced when there is a secondary measure of availability 

(such as infrastructure presence or serving area boundaries) 

 Third, given the limited resources of this effort, the most important coverage verification 

process to implement is the erroneous dispersion of coverage.  These are the “islands” of 

coverage isolated by significant distance from other covered areas.  This is the opposite of the 

Internet Intensity Zone notion discussed in the Community Anchor Institution section.  In other 

words, Broadband Internet likely doesn’t exist far away from other areas with Broadband 

Internet access. 

Before explaining our overall verification thought process, we have several examples, which illustrate 

the complexity of coverage verification. 

The first example is taken from a gentleman who requested a map change in Alabama.  His home is near 

the yellow dot.  The darker grey Blocks are covered Census Blocks.  The black lines are covered road 

segments.  He cannot receive DSL from his incumbent provider, although his neighbors can.  The 

incumbent carrier does have at least one structure in that block from which Broadband services can be 

provided; unfortunately his home is not served.   
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Figure 16--Sub block variation 

Because the SBDD program requires the depiction of coverage at the block level, the above map has 

been correctly generated.  However, from the customer’s point of view, the map is inaccurate.  This 

requires us to explain that the maps are not intended to be a structure-level qualification, at which point 

some consumers question the value of the maps when seeking service information.  Of course, we also 

share this information with the incumbent carrier in the area so they are aware of a potential customer 

market. 

Beyond this type of one-off structure-level qualification, sometimes, as shown below, we have even 

larger gaps in provided coverage.  The image here shows an “outlier” block that could be an error, or it 

could indicate missing Blocks along a major road that should have been filled in.  In this figure, the 

outlier block is highlighted in turquoise. 
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Figure 17--Dispersion in Submitted Data 

 

In this particular case, we are faced with a different verification question.  Based upon the properties of 

the neighbors, we believe this block should likely be covered (coverage interpolation,) but supplied data 

from the incumbent says otherwise.  

The next example, at a somewhat larger scale, shows where an interpolation process requires some 

adjustment.  The figure below shows a town level.  There are some smaller Blocks that are likely covered 

by interpolation logic, but we also do not want to extend coverage beyond a franchise boundary as in 

the areas shown in a box on the bottom of the map. 



SBDD Mapping Methodology Page 47 
 

 

Figure 18-Where do you stop interpolating? 

From what we can gather from some providers, the submitted data—data with consistently high 

degrees of dispersion or coverage holes—tends to come from geocoded billing records.  In this 

paradigm, this means where there are no customers; service is not identified on a map.  The 

interpolation verification question then takes on two dimensions. 

First, if a provider has no customers in an area, how can we know if they would be able to 

provide service in a 7-10 day interval? 

Second, if we use the properties of neighboring Blocks to interpolate coverage, when should we 

stop (e.g., at a franchise boundary, at a certain distance, etc.)? 

We continue to work with providers to get additional information to help us better understand and 

contend with this type of circumstance.  However, we have not been entirely successful at getting 

franchise boundaries that would address much of the issue. 

The final map shows this dispersion problem, but to an even larger degree.  This solitary large block is 

likely the result of a bad geocode, but we don’t know, given the data that has been submitted by the 

provider and the “single customer in a block standard” set by the NOFA clarification. 
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Figure 19-Dispersion in covered Blocks 

Due to the fact that this situation is quite obvious in display, this type of problem is one that we are 

more aggressively trying to resolve.  Where a single block has no neighbor offering comparable coverage 

and is a specified distance beyond an exchange boundary, our approach has been to filter these Blocks 

out.  As of now, this filter is limited to incumbent DSL providers because we have a good source of 

exchange boundaries.   

The exchange boundary dispersion verification method breaks down when examining smaller providers 

who are more likely to CLEC into neighboring territory. In the figure below, the black line represents the 

exchange boundary, while the continuity in the DSLAMs likely points to coverage extending along a road 

into another provider’s territory. 

 

Figure 20--DSL Coverage outside of exchange boundary 
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In sum, the variability in our source data continues to suggest that our dynamic verification process is 

relevant, appropriate and evolving in a manner consistent with the overall program.  And, as noted 

above, we believe the more meaningful outcome of our verification processes will likely be a series of 

qualitative indicators or expressed confidence levels.  Our concern, as with the development of any sort 

of classification process, is how rigid we should make this classification given the variation in our input 

data and the varied perceptions of service providers, map viewers and down-stream data consumers.   

Verification Work Process 

To support our dynamic multi-factor verification process, we have implemented the following steps. 

First, when data is received, an analyst reviews the submission and any immediate questions or 

concerns are sent back to the provider as quickly as possible.  We have found this gatekeeping step very 

helpful in making sure we understand the intent of the submission.   

Second, for all providers who submitted data to us in the second round, they received both a tabular 

data summary and a mapped output.  Prior to releasing the “check maps” to providers, we had a team 

of analysts visually inspect each provider’s coverage area.  The focus on this QC effort has been to 

identify and flag suspect Blocks.  After this in-house review, we solicited a second level of feedback from 

providers and received a number of requested changes and corrections used in the development of the 

April, 2011 Round 3 dataset. 

For those providers who submit only block or segment level coverage (i.e., in those cases where we have 

no infrastructure to test with) we test for coverage containment within known service boundaries.  The 

intent of this validation step is to remove Blocks that are obviously erroneous. 

As mentioned in the sections above, we have implemented a check on dispersed Blocks, but we have 

implemented less with respect to coverage interpolation (holes in coverage). We continue to work on a 

series of mechanical tools to assist with the inspection process but have run into challenges related to 

geographic basemap and timing. 

As our submissions have moved online, we have also begun to benefit from crowd source feedback.  In 

some cases this has helped us identify and fix errors in our underlying data. In other cases, as we have 

shared with NTIA, we have encountered some perceptual issues rooted in how the data are developed 

and modeled to comply with the NOFA.  Depiction of uniform coverage in small Census Blocks continues 

to be a challenge. Despite our best efforts to explain the full block coverage requirement, we continue 

to receive complaints that the coverage shown on the map is not accurate for a particular location 

within that block.  

Consumer and Provider Responses to Deliverables 
Here, we segue from internal verification to external verification.  We view responses to our work 

product as a form of validation and verification.  On the one hand, this gives us the opportunity to fix 

mistakes and then generate QA steps to make sure that the problem does not reoccur.  We also learn 

how to improve what we are doing or better explain what we are doing to a community not always 

familiar with the NOFA and program office framework.  On the other hand, listening and learning from 
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this feedback helps us better target our mapping deliverable to meet the needs of our external 

customers.  In this second case, external feedback not only provides feedback on perceived qualities (or 

lack of quality) in the data, it helps us to learn if we are developing data that is truly helpful to 

downstream users. 

At this point, our external deliverables take three forms: State Broadband Maps, data transfer to NTIA 

used for the National Broadband Map, and text format data requested by outside parties. 

Online Map Experiences 

Now that our State maps are online, we continue to harvest viewer feedback and comments.  Because 

an online map allows someone to zoom in far below the scale of the data, a large number of comments 

reflect sub-census block concerns. While important to the citizens reporting these issues and to our 

Broadband planning teams, this level of data is outside the scope of our core validation process, which 

as noted above, is focused on the level of data submitted to NTIA.  

There are several other themes that our team believes are important to share.  These comments are 

actually quite helpful because they also improve our data processes to better meet the needs of map 

viewers.  For example, we have invested significant time in harvesting more segments from provider 

data.  Because the appearance of segments is so important, we are putting time into ensuring a visually 

appropriate edge match between the roads we harvest and the Blocks/roads we will show online.  On a 

technical level, we also believe that a good segment process will help us understand more about 

dispersion in the data, and what is valid versus what is not valid. 

Perception of Unfair Treatment Across Technologies 

Several Broadband service providers have expressed strong concerns regarding how wireline services 

are displayed, as contrasted to how wireless coverage is displayed.  This is an artifact of the SBDD data 

model. As an example, consider the figure below. 
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Figure 21--Multi Network Coverage portrayal 

In this image, covered Census Blocks are light gold.  Covered road segments are a darker gold and 

wireless coverage is purple.  The concern seems to come down to how a wireline provider’s coverage is 

shown in the large Census Blocks (greater than 2.0 sq mi).  Wireline providers have expressed 

dissatisfaction because their coverage is only tied to road geography, which leads to a visual “hole” in 

their coverage map.  At the same time, they feel that it is unfair that the wireless provider’s coverage is 

shown to be uniform in the same area.  Put another way, if our maps show wireline in terms of Blocks 

and segments, why don’t our maps show wireless the same way? 

Perceptions of COLR Obligations 

Wireline providers have also expressed dissatisfaction because online maps limit the distance of 

coverage from a road segment.  In our current online maps we buffer a wireline carrier’s service 300’.  A 

number of providers have expressed that they are mandated to provide voice coverage (which 

Broadband will accompany) anywhere in the Exchange.  There seem to be many dimensions to this 

argument, but the basic concern comes down to not being able to accurately reflect the scope of their 

COLR obligation within the mixed block/segment view.  Their ability (or lack thereof) to actually 

provision such services for new users within a 7-10 day period adds yet another level of complexity 

when attempting to fairly portray their coverage capabilities. 
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Intentions of Coverage Mapping 

When a viewer of an online map clicks on the map (or zooms to an address), they are provided with a 

pop-up of service provider coverage in the area.  The critical question is this: what is the area to which 

that pop-up window responds to?  In the past, we reported back to the Census block, or buffered road 

segment intersected by the user click.  As far as the map was concerned, once we move off of that road, 

or out of that segment, we have a new area to examine.   

Our sense, given feedback received, is that our provider view should be a bit more tilted toward finding 

providers in a general area, rather than finding providers at a single-click location.  If the goal of the map 

is to get someone to call a provider for service, our bias should be to include all of the potential 

providers in the general area, rather than giving potential customers a method to self-disqualify.  That is, 

we want to cast a wider coverage net, rather than one too narrow.  The problem with this approach is 

that it will create a number of false positive Broadband reports.  As of this date we cannot determine if 

the claims of inaccurate coverage in online maps are due to the looser provider view standard or not.  

We keep this looser standard in place to minimize the likelihood of self-disqualifications. 

National Broadband Map Experiences 

When the National Broadband Map launched, our phones began to ring. 

Responding to a number of provider inquiries as well as emails from citizens provided some insights.  It 

also illustrated that we now bear a second dimension of external verification.  That is, we must be 

prepared to respond to people who are confused by apparent inconsistencies between the State and 

National Broadband Maps29.   

The case below, based upon a call we received, illustrates some interesting intersections between the 

State and NBM. 

In this example a Citizen called inquiring about the difference in results between the National 

Broadband Map and our State of Alabama map.  The issue in question was coverage at his home.  The 

Alabama map showed he had coverage at his home, but the National Broadband Map said he did not. 

In the image below, the green dot represents the geocoded location of his home.  Based upon imagery, 

the geocode is quite accurate.  The olive colored polygon represents a covered Census block less than or 

equal to 2.0 square miles.  The Census block shows coverage by a number of wireline providers. 

The geocoded point is about 170’ from this covered Census block. 

                                                           
29

 We have a similar concern regarding textual data extracts.  We may translate our SBDD submission into covered 
Census Blocks in a way that is different from NTIA.   
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Figure 22-NBM Covered Census block example 

In the next image, covered TIGER road segments are shown in green.  It is important to note how far the 

TIGER road centerlines are from the actual roads in the subdivision.  It appears the geocoded point is 

reflecting more recent and more accurate road centerlines, placing the green dot at the correct location. 

Since the SBDD data is submitted in terms of TIGER 2000 the road on our map shows up about 100-200 

ft away from where that road is located today.   
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As mentioned previously, however, our online maps buffer road segments to 300 feet on either side of 

the road centerline.  In this case then, our state map buffer is large enough to return valid service 

providers for this green dot.  The NBM, on the other hand, does not appear to buffer segments or the 

edges of census Blocks and will not return providers for this location.  Our intent in this example is not 

to criticize the national map; rather, it is to illustrate that we may inadvertently make trade-offs 

between false positives and false negatives, differently. 

This case illustrates several important tensions between the data as we present it to NTIA, map it 

ourselves and because of how it may be viewed within NBM context.  A lack of agreement on how to 

handle these inconsistencies in the source data and differences in mapping approaches may cause 

consumer confusion.  

The issues seem to come down to this 

a) How do you (or can you) handle the impact of time when roads move between TIGER versions 

or between TIGER and other road products?  In this case, online map road traces will not show 

up in the right area. 
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b) Given the inconsistencies between TIGER geometry used in submission and underlying 

roadbases used for geocoding online, how do you (or should you) insulate the viewer from the 

inconsistencies.  There appears to be a strong likelihood that TIGER judges a particular point to 

be in a larger than 2.00 sq mile Census block while that same location could be in a small block 

area in the online view. 

c) How much tolerance should be introduced when returning a list of valid providers?  Is it 

better to error on gathering too many providers or too few? 

d) Since the NBM gathers feedback based upon its representation of coverage, how can/how 

should this crowd sourced feedback influence data presented in a different manner elsewhere? 
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Appendix One  

Data Collection Challenges 
This section summarizes some of the challenges we have experienced with data collection and 

processing.  The team believes it is important to categorize these challenges as they help inform the 

geoprocessing and verification methods used.  It is also our hope that some of the more global issues 

can be discussed and decided within the Grantee community.  

We begin with several global issues and then continue toward more granular challenges. 

Global Data Collection Issues 

Census Block and Road Standards are not clear 

Most carriers submitting Census level information provided 2000 Blocks.  A few provided 2009 or 

alternative (TeleAtlas, possibly) Blocks. Especially with the need to derive segment geographies, we 

would prefer to message the providers a specific Census standard—but we’d like to be consistent with 

other Grantees so as to minimize work from the provider community.  As of now, that standard is 

Census 2000.  If NTIA anticipates using Census 2010 for Fall 2011 collection, it would be helpful to 

message that as soon as possible.    

Also there seem to be several methods by which providers are calculating the area.  So the distinction 

between at 2.00 square miles can be uniform, it would be ideal to articulate an operational area 

calculation definition as early as possible. 

Providers Not Wishing for Block Level Aggregation of Their Data 

Both ***REDACT*** have supplied address point level data.  Both carriers want NTIA to have the point 

level information, and they have asked CostQuest/LinkAMERICA not to aggregate their coverage to 

Blocks.  Other than a verification to make sure that point data were contained within, or fell within 1 

mile of exchange boundaries, the only other processing was normalization into NTIA formats. 

Broadband Providers not Meeting the NOFA  “Provider” Definition 

PBWorks appears to reflect a concern among a number of grantees about what a Broadband Provider is-

-and how that definition impacts mapping. 

If the 7-10 day provisioning rule is to be strictly enforced, it would seem to eliminate a number of 

prominent Broadband providers30.  Further, the need for clarification around a facilities-based provider, 

versus the reseller, has injected even more ambiguity into the mix.  Right now we are unclear on how 

                                                           
30

 By email ***REDACT*** informed us they could not provision in 7-10 days, but they also supply information on 
qualified locations to the address point level.  Therefore, we draw a distinction between an incumbent provider 
owning the facility--which terminates at a customer premise--who cannot turn up service at a qualified location, 
versus a provider not reporting any specific qualified locations in which they cannot turnup service in the 7-10 day 
window.  In the first case we have a sense of where service can be offered and verified.  In the second, we have no 
evidence that a service could exist there until a specific location becomes a customer. 
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strictly to interpret either of these important distinctions, but we are concerned that we are beginning 

to create an NTIA exclusion criteria that is going to confuse downstream consumers of the data.   

Again, we do not want to exclude a service provider, but we believe there needs to be further 

clarification around the 7-10 day ”rule,” the definition of a “reseller,” and better interpretation of 

facility-based providers, versus equipping UNEs, SpA or leased lines. 

We have used the Provider Type of ”Other” to classify a number of providers who offer Broadband 

services, but we do not offer them in a manner consistent with Technical Appendix A definitions. 

To What Extent Should We Begin “Classifying” the Data and Maps? 

The question immediately preceding gets to the intent of a Broadband Provider.  This question gets to 

the intent of the Data and Maps. 

Earlier in this document we discussed the question of what type of bias we should introduce to our 

online map messaging.  In an online environment, do we want to more likely create an overstatement of 

coverage for a provider than an understatement?   In other words, is the larger problem allowing a 

consumer to self-disqualify, versus calling a number of neighboring providers?  There is a related issue 

to this.  Clearly in our maps there is a lot of scatter in data that we believe should be more continuous.  

These are the islands of coverage from an incumbent provider31.  There are a number of processes that 

could be put in place to deal with this type of scatter, but without more information from the service 

provider-- essentially the last mile facilities-- it will be difficult to perform this clean up in an informed 

manner.  On the one hand, we can aesthetically clean the maps up and reduce the scatter, but we have 

little sub-block engineering information upon which to make this decision.  Right now our preference is 

to put out a somewhat aesthetically messier deliverable and work with providers to get better 

information to clean their submission.  If that isn’t forthcoming, we are limited in what can be done 

given the lack of facility level information.  In summary this yields two questions 

1. In our online maps should we error on overstating coverage to prevent consumer self-

disqualification? 

2. In our online maps should we work to clean up a lot of the scatter that we see without having 

facility-based evidence from which to remove it? 

Granular Data Collection Issus 

Non-Uniform Submission Standards  

It is clear among providers that there isn’t a consistent method used to derive Broadband coverage.  

Some providers appear to be using a geocoding approach and then point in polygon or point on segment 

process.  Others may be using GPS locations.  In some cases, it is difficult to infer what reference data 

                                                           
31

 For a provider who sells opportunistically (not within a franchise area) it becomes even more problematic to 
classify their coverage because the points are more related to the type of consumer purchasing the service than a 
bounded offering.  In a matter of speaking, the Provider_Type is more determined by the technology and/or 
location than a type of business.  The core intent of the NOFA and our grant application was centered around the 
7-10 day providers but we believe maintaining information on Provider Type “Other” and  “Reseller” is important 
to assist in validation and market segment analysis as resources are available. 
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was used to georeference plant (is it the carrier’s roadbase?).  This leads to uncertainty regarding the 

input data scale or accuracy of other base layers.  Although we may be trading off absolute accuracy, our 

standard has been to conflate data to TIGER 2000 Blocks and TIGER 2009 roads.  We perform our 

verification against this conflated data product. 

Temporal 

We are unsure of how well the data are temporally consistent.  Some providers gave us their best effort 

to control to December 31, 2010. We note that some providers were clear that the submission was as of 

extract date without any way to move back in time.  They have no means to control for time and cannot 

provide any audit support beyond when the data are released to us.  Some data-especially loop 

qualification data-may change from day to day. It will be very difficult to clarify why something was 

changed from a given point in time. 

Perceived Inaccuracy with Respect to Internal Standards 

The NOFA is clear on submitting a list of Blocks in which a provider delivers Broadband service.  This is a 

different objective than perfectly reflecting service territories.  If a firm’s accuracy standard is a 

reflection of their service area, then the data created under the NOFA will not meet their perception of 

accuracy.  This leads to two other issues:  First, using Census Blocks rather than serving area may 

overstate or understate a particular provider’s Broadband serving area.  This was a significant concern of 

***REDACT*** who specifically required us to submit only address-level qualification data.  The second 

issue this brings up is how or if, there should be some standard on how much of a Census Block needs to 

be covered to call it covered.    

Confidentiality  

Several providers have noted concerns with CPNI-related issues and have stated this as a reason for 

non-participation.  We have also heard expressions of comparable concern regarding identifiable 

responses to Anchor Institution information. 

Unclear on Definitions  

As discussed earlier, several providers claimed confusion on several key terms involved in Middle Mile.  

We note a consistent stream of questions around the interpretation of Maximum Advertised Speed.  

Some providers understand this to be the most common speed package bought within the mass market, 

while others view this as a speed that can be purchased for an additional cost above a mass market 

offering (eg. a Turbo option for an additional fee per month).  Others interpret this as the fastest speed 

that is available for that particular location--in terms of xDSL, a structure qualified speed, for example.   

Perception of Data Use 

There seems to be some hesitancy releasing speed information because no one is sure of how the 

information will be used, or what the speed is intended to reflect.  A number of providers have verbally 

indicated that typical speed will be about (on average) 80% of purchased speed due to overhead.  But 

there are many other factors (such as a user’s home network) that influence speeds measures.  

Providers are concerned about introducing statistics without a clear understanding of how those 

statistics are derived and will then be used.  Also, as advertised speed is pushed down to a block level, 

we sense more trepidation to report speed values.  This quickly begins to touch on parity across network 
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types (why is wireline down at the block when wireless is half the state, etc.).   Finally we are also noting 

a significant increase in speed reported to us.  This may be due to network upgrades or competitive 

concerns to match the theoretical network speed. 

Location Uncertainty In Source Data 

Within this document we have noted concerns about the impact of source data accuracy.  Our 

geoprocessing methodology provided what we believe is a relatively conservative tolerance to account 

for the scale issue in the source data, but we are unsure of how this may impact downstream users.  

Clearly, it also impacts the verification process because we can’t attempt to verify received data beyond 

a scale at which it was developed. 

Covered Segment Process 

Deriving those Broadband covered segments in Census Blocks greater than 2 square miles has proved to 

be a challenge.   Moving from a NOFA specified tabular deliverable to an anticipated geographic 

deliverable also increases the complexity of the effort.   

Change Management Process 

One thing that is becoming clear is that a change management process that is consistent between the 

data provider and NTIA is needed.  In this light, publication of the current data transfer model beyond 

the PBWorks community would also be helpful.  Many providers are designing their data extracts with 

the NOFA in mind and the NOFA structures have been supplemented in the current model. 

Finally, it would be helpful, as early in the next cycle as possible, to know what Census Block vintage we 

are expected to deliver to NTIA.  It would also be very helpful to maintain a stable geographic base for 

the next deliverable so that the basis of verification doesn’t change. 

Record Level Metadata 

It would be helpful to have one or two additional fields in each feature class transmitted to NTIA.  One 

User Defined field could be helpful as an expression of record level confidence.  The second field could 

be used as a Key between the transfer geodatabase and our systems.  Ideally, both fields could be large 

text fields (50 char) so the Grantee can use them to express a variety of attributes. 

Miscellaneous Data Collection Notes 

 We note the following important observations regarding our data submission: 

1. There are Middle Mile plant records for providers who are not present in the Census block, 

segment or wireless area feature classes.  This is due to classification as non-NOFA Broadband 

providers. 

2. In some cases, we have trimmed wireless coverage estimates to honor state boundaries. 

3. We believe some providers are trimming their coverage to honor license area boundaries. 

4. As a departure from past practice, where a provider submitted Middle Mile points out of state, 

we are no longer passing those points to NTIA as they fail the validation script.  We experienced 

validation errors for BroadbandServed=N records in the CAI table.  These records were 

attributed a Technology of Transfer=0.  This cleared validation. 
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5. In tables with mandatory Zip5 (Service Address), if the End_User_Zipcode was not available, we 

have inserted ‘00000’ 

6. We have a significant amount of VDSL, ADSL 2 and ADSL 2+ coverage categorized into the xADSL 

category. 

7. We have left in the data Middle Mile locations with above grade elevations that appear to be 

unreasonable, given review of orthoimagery.  This seems to be confusion between above grade 

request and above sea level readings. 

8. All fGDB have passed validation except in cases where attributed speeds did not agree with 

domains associated with technology of transmission (eg Upstream Speed of 2 with ADSL). 

9. We note a few providers who have speeds seemingly inconsistent with their technology of 

transmission.  This is either very low speeds with optical fiber, or very high speeds with non 

DOCSIS 3.0 systems. 
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Appendix Two 
This appendix contains the confidentiality clarification supplied in a series of emails between CostQuest and NTIA. 

Feature Class Metadata NOFA 
Confidential? 

Online Map Public 
Disclosure 

Exemption 

Last Mile Constraints on accessing and using the data Yes No No None 

  Access constraints: None      

  Use constraints:       

  This data is confidential as defined in the 
NOFA. 

     

            

Middle Mile  Constraints on accessing and using the data Yes No No None 

  Access constraints: None      

  Use constraints:       

  This data is confidential as defined in the 
NOFA. 

     

            

Service Address Constraints on accessing and using the data No No Yes   

  Access constraints: None      

  Use constraints:       

  There are no restrictions on distribution of 
the data by users.  

     

            

CAI Constraints on accessing and using the data No Yes Yes NO 
attributes 
on any 
record in 
this feature 
class are 
considered 
confidential 



SBDD Mapping Methodology Page 62 
 

  Access constraints: None      

  Use constraints:       

  There are no restrictions on distribution of 
the data by users.  

     

            

Census Block Constraints on accessing and using the data No Yes Yes NO 
attributes 
on any 
record in 
this feature 
class are 
considered 
confidential 

  Access constraints: None      

  Use constraints:       

  There are no restrictions on distribution of 
the data by users. 

     

            

Service Overview Constraints on accessing and using the data No Yes Yes The only 
provider 
who may 
not show 
up this 
table is a 
provider 
who has 
provided 
only 
confidential 
data (last 
mile, 
Middle 
Mile, 
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address 
point with 
provider 
name) 

  Access constraints: None      

  Use constraints:       

  There are no restrictions on distribution of 
the data by users. 

     

            

Road Segment Constraints on accessing and using the data No Yes Yes NO 
attributes 
on any 
record in 
this feature 
class are 
considered 
confidential 

  Access constraints: None.      

  Use constraints:       

  There are no restrictions on distribution of 
the data by users. 

     

            

Wireless Constraints on accessing and using the data No Yes Yes NO 
attributes 
on any 
record in 
this feature 
class are 
considered 
confidential 

  Access constraints: None      

  Use constraints:       
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  There are no restrictions on distribution of 
the data by users 
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Connect Arkansas 
Connect Arkansas, a private, non-profit, is implementing a community-based initiative to promote 

internet access and education. The Connect Arkansas Broadband Act was signed into law by 

Governor Beebe on March 28, 2007, to ensure the creation of a competitive broadband, or high 

speed internet, infrastructure that will not only improve personal lives, but also the economic 

capabilities and of all Arkansans. 

To facilitate statewide broadband access, Connect Arkansas, a "delivery platform neutral" entity 

focuses on three major components: Determination of existing broadband infrastructure in Arkansas, 

Education, and Accessibility to computer devices. The first of these components, determining 

existing infrastructure, facilitates the requirements of the SBDD Program adequately. 

Identification of Broadband Providers 
As of March 1st, 2011, Connect Arkansas has identified by DBA name Seventy-eight (78) 

Broadband Providers in the state of Arkansas. These providers are identified as having infrastructure 

in the state and are not identified as being resellers. Of these providers, Seventy-two (72) submitted 

to Connect Arkansas at least partial data to map coverage. Of the remaining six (6) Broadband 

Providers, three (3) have agreed to provide data in the future.  From the Fall 2010 list two (2) 

providers are either no longer in business (Vista Vox) or planning to discontinue providing 

Broadband in the near future (IOCC).  

Data Collection and Processing 
For the Spring 2011 data set all providers were contacted first via mail, then email, and finally with 

telephone calls to the point of contact for each company. Sixteen (16) companies updated coverage 

information as far as speed or coverage area. The other fifty-six (56) participating Broadband 

providers chose to display data as unchanged from the Fall 2010 NTIA Data Submission. 

The format of data collected has been in various formats as listed below: 

ArcGIS Shape files 
Tab delimited files of Address Ranges 
Tab delimited files of Addresses 
Physical maps of coverage 
Tower information for propagation 
 
Shape files were easily formatted to conform with standards in the SBDD Data Model. 

All tab delimited address files were geocoded using the ESRI geocoding engine in ArcGIS. These 

geocoding passes were used against the standard ESRI database, as well as U.S. Census Tigerline 

data, and Arkansas Geographic Information Office's Street Centerline and Address Points. In the 



rural areas of Arkansas the accuracy of geocoding is much lower than in urban areas. To help 

remedy this, Connect Arkansas reviewed the geocoding results with each provider, giving each the 

opportunity to correct any issues. Note: any geocoding results that fell outside of a providers existing 

telephone exchange or know service areas were discarded. From these results, nearest road 

centerlines or census blocks (less than 2 square miles) containing the geocoded points, were 

selected to represent the Broadband Providers Coverage. Note: only two (2) Broadband Providers 

provided data at the address level.  

Any physical maps of coverage (including those submitted in pdf format) were used as a basis to 

manually select line segments from existing road centerlines in the state (based on U.S. Census 

Tigerline data). From these results census blocks (less than 2 square miles) that contained the 

digitized road centerlines were selected along with the road centerlines in areas of larger census 

blocks, to represent the Broadband Providers Coverage. 

Fixed Wireless tower information (including Latitude, Longitude, Frequency, Power, Height) were 

gather and entered in to EDX Signal software to model signal propagation. This software also took 

into consideration terrain elevation as well as ground clutter to accurately model the Broadband 

signal, in most cases to a twenty (20) meter degree of accuracy. These raw propagation models 

were processed in ArcGIS into more organicly smooth shapes to conform with standards in the 

SBDD Data Model. 

The results of the processes above were loaded into the SBDD Data Model and the latest 

CheckSubmission script was run. All resulting failed processes were analyzed and addressed to 

result in No Fails in Census Blocks, Road Segments, or Wireless Coverage data sets. 

Middle Mile information that was received (most Broadband Providers view Middle Mile as 

proprietary information and elected not to submit) as tab delimited text files or as a spread sheet in 

Microsoft Excel. This information was brought into ArcGIS, processed, then formatted to conform 

with standards in the SBDD Data Model and uploaded. 

Community Anchor Institution data is information received from 3rd party sources in regards to 

institutions as outlined in the NOFA. Most of the data collected is from phone surveys to each 

location. In some cases difficulties were presented in finding a suitable technical point of contact to 

collect information. Arkansas Department of Information Systems has agreed to help provide 

information for public schools as well as HITArkansas for Health Systems, in future submissions. 

Only Community Anchor Institutions that could be geolocated were included. Connect Arkansas has 

also decided with this submission to include commercial locations with publically available 

broadband (typically via WiFi). 

Verification Processes 
Connect is currently using several methods to verify data collected. The format of data collected has 

been in various formats as listed below: 

Telephone surveys 
FCC released Form 477 data 
Telephone Exchange Boundaries 
Data collected from feedback on maps.connect-arkansas.org 
Data collected from speed tests on www.connect-arkansas.org 
Speed test data released from Broadband.gov 



General Notes 
The majority of Broadband Providers Submitted Maximum Advertised Speeds at the MSA/RSA level, 

or overall coverage areas which in some cases represent a large portion of land, in some cases 

several counties. At the direction of Andrew MacRae with NTIA, Connect Arkansas has pushed 

these speeds down to the census block and road segment level. Some inaccuracies can be seen in 

the data as actual Maximum Advertised Speeds in some cases vary from zipcode to zipcode in 

some cases. 

All Census Block data is 2000 vintage, and all Road Segments are based on Tigerline 2009.  

Connect continues to identify small providers, in particular fixed wireless providers that do not 

advertise or have a web presence. It is possible that several more of these providers will be 

identified in future data submissions. 

It should be noted that in some cases relating to Cable Companies in Arkansas several of these 

described their Broadband Coverage area as "all streets within XX city limits".  
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1 Overview 
The following describes the Data Gathering, Data Integration, Data Validation and Verification and Quality Control 

processes utilized to create the Broadband Mapping Project’s April 1
st

, 2011 data submission.   

 

To support various levels of technical and program knowledge, this white paper supplies both a high level 

summary and a detailed process review. 

 

2 High Level Review 

2.1 Data Gathering - Providers 

Broadband Service Area, Middle Mile Aggregation Points and Broadband Service Overview 

The collection of Broadband Service areas, Middle Mile Aggregation points and Broadband Service Overview 

information is handled through the following Provider Outreach Process: 

 

 Build and Maintain an Inventory of Broadband Providers through research and State inputs. 

 Update Provider Material that describes the data requirements and logistics for data transfer. 

 Update NDA for use in project, where applicable 

 Maintain multiple protocols for the provider to submit data, including SFTP technology when desired.   

 Conduct one-on-one informational discussions with each provider to communicate the following: 

o Requirements of this project 

o Broadband data required to support the product data model 

o Submission protocols available 

o Capability to validate how the supplied data is aggregated 

 

 Download/receive Provider Data 

 Establish a repeatable process with Provider. Maintain Provider communication, transaction and data 

handling records throughout the project (dates contacted, data received, etc.)  
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2.2 Data Gathering - Community Anchor Institution (CAI) 

The collection of CAI information is handled through the following CAI Collection Process: 

 Collect and maintain inventory of CAIs through Data Mining, research, and State inputs. 

 Maintain web-based CAI portal for institutions to add or confirm attribution, location and enter 

broadband-specific information. 

 Upload web-based data to Core Database for standardization. 

 Perform internal cleansing, such as removing duplicate records, identifying gaps in broadband attribution 
and verifying category.  

 Geocode CAI locations.  

 Translate Core Database data to deliverable ready format.  

 Continue engagement with non-responsive institutions. 

 

2.3 Data Integration Process 

 

The data integration and processing mechanisms currently utilized allow for multiple types of inputs and results in 

a standardized output that meets the NTIA deliverable requirements. This process is flexible to support data model 

changes and project requested enhancements.  

 

 Receive inputs from Providers via submission protocols, upload into Sourcing Database and catalog with 

provider information.  

 Review Provider supplied data for completeness and for potential discrepancies that require resolution 

prior to processing and flag as necessary. 

 Categorize input into data type category (addresses, block lists, paper maps, etc.). 

 Standardize input based on data type within Staging Database. 

 Create Compact Polygons (CP)—(internal methodology for generating area based feature for coverage in 

Staging Database). 

 Apply broadband attribution to CP, Apply metadata to CP 

 Perform quality analysis of the CP against the source supplied to identify any completeness or accuracy 

issues.   

 Request additional information from the provider if elements of coverage are missing or contain 

discrepancies.  This is a second manual quality check to ensure data is complete.   Following completion of 

CP creation, process steps within Data Validation & Verification occur 

o Process coverage area to build the required NTIA data model layers  

 

 Process CAI data input into internal standardized format, as mentioned above under CAI Create Product 

Deliverable based on NTIA and State-level requirements. 

 Following the creation of the product, process steps within Data Validation & Verification occur 
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2.4 Data Validation & Verification 

 

To ensure the data collected and processed is as accurate and comprehensive and possible, provider validation and 

internal verification activities are utilized. Following the initial mapping of providers’ coverage area and 

serviceability claims, additional reviews are performed using the following methods:  

 

 Third-Party Data Verification: Visually and programmatically compare the coverage against third-party 

data.  

Pitney Bowes and American Roamer data are used in cases where a coverage area is questionable.  All 

anomalies identified during this analysis are reviewed with the providers. 

 

 Broadband Provider Validation – Provider Portal Application:  Providers are trained on and requested to 

use a secure interactive web application to review their current coverage area(s) and supporting 

broadband attribution and validate their data or submit change requests to update their data. 

 

All provider change requests go through the Data Integration Process and a review with the provider to 

complete validation. 

 

 Confidence Values:  All Verification, Validation, and manual quality review results are tracked by provider 

/ technology type and stored and maintained within a “Validation” table.  A confidence value is assigned, 

based on internal assessments of the collected information, to highlight the provider coverage areas 

and/or attributions that would benefit from further investigation and/or enhancements. 

 

2.5 Quality Control 

Following collection, processing and analysis of the provider and CAI data, the product is checked manually and 

algorithmically against the NTIA data model.  Some of the items included within these checks are as follows:   

 Format Correctness 

 Table & Field Structure  

 Valid Values 

o Including default values, where applicable 

 Geographic Extent and Topology Errors 

 

Prior to data submission, another quality control script supplied by NTIA is run.  This script, 

SBDD_CheckSubmission.py, creates an output in text form that is required to be submitted along with the final 

deliverable.  All errors must come up clean, unless otherwise specified from NTIA. 
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Exceptions to the script as noted by NTIA on the SBDD Workspace on 03/25/11 at the following link: 
https://sbdd-granteeworkspace.pbworks.com/w/page/38218329/CheckSubmissionExceptions  

- Longitude values for States outside the lower 48 (any table) 

- CAI results for Transtech, MaxAdUp, MaxAdDown if BBService is ‘No’ or ‘Unknown’  

- Overview MaxAdDown, MaxAdUp if 100% of record level data has MaxAdDown or MaxAdUp 

populated 

https://sbdd-granteeworkspace.pbworks.com/w/page/38218329/CheckSubmissionExceptions
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3 Detailed Process Review 
Below is a detailed review of the data collection, integration and quality control points along the broadband data 

gathering and mapping process. 

 

Diagram of overall process: 

 
 

3.1 Provider Outreach 

For the April 2011 data submission, an e-mail notification was sent to all providers with supporting deliverable 

dates.  The Provider Portal web application was released and training webinars held so providers could use this 

application to submit changes to and/or validate their current coverage area(s). 

 

Data was also collected from the providers via e-mail and SFTP, depending on their comfort level to submit data in 

time for the April 1
st

 deadline. 
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In support the data collection effort, providers that did not timely respond to the outreach were contacted by 

phone. 

 

3.2 Outreach Materials 

The original provider packet sent via email to the providers included the following documents and files: 

1) Letter from the State inviting them to participate in the program 

2) Copy of the non-disclosure agreement (NDA) 

3) Copy of the Mapping NOFA from the NTIA 

4) Copy of the NOFA Clarification from the NTIA 

5) Broadband service address example file in CSV format 

6) Word document describing service address example file 

7) Broadband service block example file in CSV format 

8) Word document describing service block example file 

9) Broadband service street example file in CSV format 

10) Word document describing service street example file 

11) Broadband subscriber example file in CSV format 

12) Word document describing subscriber example file 

13) Broadband wireless coverage area sample shapefile 

14) Word document describing wireless coverage area sample shapefile 

15) Instructions for downloading, installing, and using the WinSCP secure FTP application 

 

3.3 Outreach Process 

The provider outreach process is comprised of the following general steps: 

1) Send the provider package and introduction letter to the main point of contact for the provider 

2) Follow up with email and call to verify that the main point of contact is correct. 

3) If necessary, discuss the NDA further and resolve any redlines. 

4) Once the correct primary contact is established, set up a call, if necessary, to learn more about the 

provider’s offerings and direct them to the appropriate outreach materials. 

5) If providers are unable to be contacted (non-responsive) or indicate that they are not interested in 

participating (non-cooperative) mark them as such on the provider tracking sheet. These providers will be 

escalated to the state for further action. 

6) As the providers are collecting the required data, provide instruction on downloading, installing, and using 

the WinSCP secure FTP application, if required. 

7) Arrange with the providers to transfer the data in whatever way they are comfortable. Some providers 

will find regular email acceptable. Others will want to use the secure FTP application. 

8) After data is received and reviewed, it may be necessary to contact a provider for clarification or to 

address incomplete data sets. In the interest of building and maintaining relationships, care is given not to 

push the provider but to work with it to obtain accurate data in the best possible format. 
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3.4 Data Collection 

3.4.1 Data Transfer Procedures 

There are three primary ways data is collected from providers. These are: 

1) Secure FTP using the WinSCP application 

2) Regular email 

3) Mail 

 

3.4.2 Initial Data Review and Quality Assurance 

The initial data review and quality assurance process consists of the following general steps: 

1) Access the data from the secure FTP site or email 

a. If emailed, place copy of original data set in the appropriate provider folder on the secure FTP 

site 

2) Place copy of raw data on local computer in a working directory. 

3) Review data and determine course of action based on type of data received. 

4) Ensure data is complete and contact provider to address any gaps. 

Note: The goal is to get as many providers as possible to provide subscriber address data in the correct format. 

Obviously, this will not be possible with all providers so we will continue to have to process various types of 

provider-supplied data. 
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3.5 Data Ingestion 

3.5.1 Data Ingestion Overview 

The following outlines the process steps taken based on the type of input supplied by the data provider: 

Point Data 

 Subscriber location 

 DSLAM location 

 Central Office location 

 Broadcast Tower location 

Linear Information 

 TIGER street segments 

Polygonal Information 

 Census Blocks 

 Coverage Area 

Overall, the process is geared toward taking the provider data supplied and creating polygon shapes to append to 

the bb_cov feature class. The bb_cov feature class is the interim data set that is then processed using the 

makeDeliverable.py Python scrip to create the MapConnect data layers that will be delivered to the state and, 

ultimately, to the NTIA.  Following are the detailed instructions used in this process.  

 

3.5.2 Point Data 

3.5.2.1 Subscriber Location – Address Data 

In the event that the data provider supplies subscriber address data the following actions occur: 

1) First, convert the address data to a clean Excel spreadsheet in an appropriate address data format. 

a) Usually, this has the following columns: street address (number, pre-directional, pre-modifier, street 

name, street type, post-directional, and post-modifier concatenated together), city, state, ZIP. 

2) Configure the ArcGIS geocoding tool to use the TIGER 2009 streets dataset 

a) In ArcCatalog, create a new Address Locater by right-clicking in the white space of the appropriate 

directory and selecting New>Address Locater from the dropdown menu. 

b) Select “US Streets with Zone” and press OK. 

i) Note: It is likely that multiple Address Locators will have to set up to handle the variety of 

provider address data received. 

c) Navigate to the TIGER Streets 2009 file and press OK. 

d) Fill in the dialog box as seen below: 
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e) Click OK. 

3) Open up ArcMap, and add the Excel spreadsheet with the address information. 

4) Right-click on the Excel spreadsheet and select Geocode Addresses from the dropdown menu. 

5) Select the appropriate address locator by clicking Add…. then OK. 
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6) Fill out the Geocode Addresses dialog box as shown below: 

 

 
 

7) Geocode the list in batch mode using the geocode service set up in Step 2 above, accepting all the default 

parameters. 

8) Review results. 
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9) Adjust geocoding parameters accordingly and repeat batch to resolve issues. 

10) Manually geocode unmatched addresses until target hit rate achieved, generally 90%. 

11) Visually inspect the data as seen below: 
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12) Follow the steps detailed in Subscriber Location – GIS Data below 

 

3.5.2.2 Subscriber Location – XY Data 

If the provider supplies a list of subscriber data with accompanying XY data such as latitude and longitude, the 

steps are as follows: 

1) Refine the format in Excel so that the data can easily be opened using ArcMap. 

a. Remove all font color, highlighting, cell colors and borders, clean up column headers and make 

sure there are no merged cells. 

b. Make sure that XY locations are in decimal degrees. 

i. To convert from degrees, minutes, seconds (39º 26’ 45.67”) to decimal degrees us the 

following formula: DD + (MM/60) + (SS.SSS/3600). 

ii. Note: if XY locations from some other coordinate system are provided, you can use 

those in the process below but you must know what the coordinate system is. 

2) Open up the Excel worksheet in ArcMap. 

3) From the menu bar, select Tools>Add XY Data… 



            

16 

 
 

4) Supply the appropriate fields for the X and Y coordinates, choose the appropriate coordinate system and 

press OK. 

5) Results are an event layer, not a true spatial layer. Export the data by right-clicking the event layer and 

selecting Data>Export Data… from the dropdown menu. 

6) Follow the steps detailed in Subscriber Location – GIS Data below. 

 

3.5.2.3 Subscriber Location – GIS Data 

If the provider supplies subscriber location in GIS format, the only process step is to load that data into the 

appropriate data schema and it will be ready for processing. 

1) First, load the data into the Point Address database schema (please see Appendix D for an example of the 

Point Address database schema.) using an empty feature class in that schema. 

2) In ArcCatalog, right-click on the empty feature class and select Load from the dropdown menu. 

3) Navigate to the provider address GIS data set and then map the attribute fields accordingly, as seen in 

general below: 
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4) Once you have successfully loaded the provider address data into the temporary database with the 

correct schema, you will now append that data to the overall Point Address database. 

5) In ArcToolbox, use the Append command (Data Management Tools>General> Append) to add the 

features into the overall Point Address database, as seen in general below: 
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6) Since the data is already in the Point Address database schema, there is no n need to alter the Field Map 

in the Append tool. 

7) After appending, calculate metadata reflecting geometry source and representation values. 

8) Break provider-specific points into separate county feature classes and perform the following steps per 

county feature class: 

a. Within ArcGIS 

i. Summarize download and upload speeds [first,last] to determine all speeds available for 

county. 

1. This will save as a DBF table. Keep track of location for future reference. 

ii. Buffer county address point featureclass to 150’.     

1. During buffer command, dissolve on “ad_down”; ”ad_up”; ”provider”; “dba”; 

“frn”; “tt”; ‘all metadata fields’; “stctyfips”.    Save as…. 

county_fastestdown_fastestup.  

2. (Example using Qwest data: boulder_40128_20128, where boulder=county;  

40128=ad_down; 20128=ad_up) 

3. Note: these attribute fields are specific to the Point Address database. 

iii. Select the features that represent the lowest speeds 

b. Using XtoolsPro (http://www.xtoolspro.com/)  

i. In the XTools Pro toolbar, select XTools Pro>Layer Operations>Erase Features 

ii. Use the same feature class for Input and Overlay 

iii. Check Use selected features on the Input feature, as seen below. 

http://www.xtoolspro.com/
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iv. Repeat and erase slowest speeds one speed at a time.  Saving each new feature class as 

the next slowest speed, using the same naming convention as above. A general example 

is seen below: 

 

 
 

c. Within ArcGIS 

i. Edit/delete speeds from the attribution table of each feature class, so each remaining 

feature class has only one speed value. 

ii. Merge individual speed feature classes together using the Merge command in 

ArcToolbox (Data Management Tools>General>Merge). The dialog box is seen below:  
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iii. Merge individual county feature classes together using the Merge command in 

ArcToolbox (Data Management Tools>General>Merge).  

iv. Since the county files are all in the same schema, do NOT alter the Field Map portion of 

the command interface. 

v. When all the county files are merged together into one dataset, use the Append 

command in ArcToolbox (Data Management Tools>General>Append) to add the 

features to the bb_cov interim data set. Use the Field Map portion of the Append tool to 

map the appropriate field values to their corresponding fields in the bb_cov feature 

class. 

 

3.5.2.4 DSLAM or Central Office Location – Address Data 

In the event that the provider supplies DSLAM (digital subscriber line access multiplexer) or Central Office address 

data please follow the steps below: 

1) Follow the process for geocoding points in Subscriber Location – Address Data, above. 

2) Follow the steps detailed in DSLAM or Central Office Location – GIS Data below. 

 

3.5.2.5 DSLAM or Central Office Location – XY Data 

In the event that the provider supplies DSLAM (digital subscriber line access multiplexer) or Central Office XY data 

please follow the steps below: 

1) Follow the process for creating points from XY data  in Subscriber Location – XY Data, above. 

2) Follow the steps detailed in DSLAM or Central Office Location – GIS Data below. 

 



            

21 

3.5.2.6 DSLAM or Central Office Location – GIS Data 

In the event that the provider supplies DSLAM (digital subscriber line access multiplexer) or Central Office GIS data 

please follow the steps below: 

1) Buffer the DSLAM/Central Office points feature class 

a) Add the point feature class to ArcMap 

b) Open up ArcToolbox and go to Analysis Tools>Proximity>Buffer 

c) Set the buffer distance to 5 miles 

d) Set the dissolve type to ALL 

e) Name the output feature class 

f) Typical Buffer tool is seen below: 

 

 
 

g) Press OK 

2) Use the resulting buffer feature class to clip the TIGER street layer (as described earlier): 

a) Add TIGER street layer to ArcMap 

b) Open up ArcToolbox and go to Analysis Tools>Extract>Clip 

c) Complete the dialog box as seen below: 
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d) Press OK. 

3) Using ArcCatalog and within the file geodatabase: 

a) Right Click and create a new Feature Dataset  

i) For the Feature Dataset settings: 

(1) Name the feature dataset accordingly 

(2) Select horizontal coordinate system by importing the coordinate system associated with the 

clipped TIGER street layer by selecting Import and navigating to the location of that feature class 

(3) No vertical coordinate system needed 

(4) Leave all x,y,z,m values at default. 

(5) Press Finish 

4) Import previously created street feature class into new Feature Dataset 

5) Right-click Feature Dataset and create new Network Dataset – accept all default setting for the Network 

Dataset 

a) Note: the Network Analyst extension must be turned on 

6) In ArcMap Turn on the Network Analyst Toolbar by going to View>Toolbars>Network Analyst 

7) Add the Network Dataset created in Step 5 to ArcMap 

8) Using Network Analyst Toolbar drop down – create “New Service Area” 

9) Open up the Network Analyst Window by selecting the  button. 
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10) Right click Facilities layer, select Load Locations, and navigate to the DSLAM/Central Office facilities feature 

class. 

 
 

11) Press OK. 

12) Click the Service Area Properties button  

13)  For the following tabs change the following properties: 

a) “Polygon Generation” tab  

i) Select “Merge by break value”  

ii) Also disable the Trim Polygons option 

b) “Analysis Settings” tab – using and converting the specified DSLAM buffer distance from feet to meters – 

input buffer distance value in meters into the “Default Breaks” location 
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i) Generally, 18,000 feet (5486 meters) from DSLAM or Central Office location is used as the buffer 

distance 

 
 

c) Click OK. 

14) On the Network Analyst Toolbar click the “Solve” button  to create service area polygons. 

15) Right-click on the created service are polygon in the layer list, and select Data>Export Data from the dropdown 

list. 

16) Export to a feature class in the file geodatabase you created earlier 

17) In ArcCatalog, create an empty feature class with the schema of the bb_cov feature class and load the feature 

class created in Step 16 into it. 

a) Right-click on the empty feature class, select Load>Load data from the dropdown menu and navigate to 

the location of the service area feature class 

b) Press the Add button, hit Next 

c) Accept the defaults and hit Next 

d) Do NOT attempt to map any fields, as seen below: 
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e) Press Next, then Next again, then Finish. 

18) In ArcToolBox, go to Data Management Tools>General>Append 

19) Append the formerly empty feature class to bb_cov, completing the dialog box as seen below: 
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20) Leave the Schema Type as TEST 

21) Press OK. 

22) In ArcMap, open up bb_cov for editing and manually input associated attribution. 

 

3.5.2.7 Broadcast Tower Location – Address Data 

In the event that the provider supplies wireless broadcast tower location address data please follow the steps 

below: 

1) Follow the process for geocoding points in Subscriber Location – Address Data, above. 

2) Follow the steps detailed in Broadcast Tower Location – GIS Data below. 

 

3.5.2.8 Broadcast Tower Location – XY Data 

In the event that the provider supplies wireless broadcast tower location XY data please follow the steps below: 

1) Follow the process for creating points from XY data  in Subscriber Location – XY Data, above. 

2) Follow the steps detailed in Broadcast Tower Location – GIS Data below. 

 

3.5.2.8.1 Broadcast Tower Location – GIS Data 

In the event that the provider supplies wireless broadcast tower location GIS data please follow the steps below: 

1) Download the required software (Radio Mobile) from the website: 

http://www.cplus.org/rmw/english1.html  

2) Install the software according to the standard directions, found here: 

http://www.cplus.org/rmw/download/download.php?S=1  

3) Open up the application 

4) Load the broadcast tower location and elevation information by selecting File>Unit properties. The 

following dialog box appears: 

 

http://www.cplus.org/rmw/english1.html
http://www.cplus.org/rmw/download/download.php?S=1
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5) Add in the information for all the towers supplied by the WISP data provider, including the elevation. If 

provider does not supply elevation, this information can be obtained from Google Earth. 

a. I f available, use the Import button to import a Google Earth KML of the tower locations. 

6) Go to the National Map Seamless Server (http://seamless.usgs.gov/) and download elevation data 

sufficient to contain the tower locations. 

a. At least the 1/3” NED data is needed. Select this by clicking the Download button in the upper 

right of the web site and checking the box nect to 1/3 “ NED. 

b. Zoom to the area of interest and use the Download tools: 

 
to define the area to download. 

c. Click the Modify Data Request button to request the data in BIL_16INT format, not ESRI GRID, as 

seen below: 

 

http://seamless.usgs.gov/
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d. Download the data and unzip it. 

7) Select File>Map Properties to define the map 

8) Enter in a latitude and longitude in the center of the tower locations 

9) Set the size (in pixels) and the size (in kilometers) of the map 

10) Set the directory path leading to the BIL elevation data just downloaded 

11) The dialog box is seen below: 
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12) Hit Extract. 

13) The elevation data is render as a hill shade, as seen below: 

 

 
 

14) Select File>Network properties from the main menu 

15) Create a new network and enter in the frequency range under the Parameters tab, as seen below: 



            

30 

 
 

16) Leave all the other values as they appear, and select the Systems tab 

17) Create enough systems to cover all the varieties of equipment in the provider network. This will include 

the antenna type, height, and line loss, as seen below: 
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18) Now click on the Membership tab, and assign the individual towers to their respective systems, providing 

the azimuth for non-omnidirectional antennas, as seen below: 
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19) Press OK. 

20) Select Tools>Radio Coverage>Combined Cartesian from the main menu 

21) Complete the dialog box as seen below, providing the Maximum Range from the highest tower beam 

radius supplied by the provider. 

22) Set the Pixel Size at 5 (experiment depending on the area covered to get the right level of granularity) as 

seen below: 
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23) Set the signal range to draw to S-Unit and type 5 in the From (>=) box. 

24) Press Draw. 

 

 
 

25) Save the resulting image as a TIF by selecting File>Save Picture as. 

26) Open ArcMap and load the BIL elevation data you used in Radio Mobile. 

27) Load the TIF image you created and georeference it using the corners of the BIL data. 
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a. The corners of the data can be seen in the TIF image. 

28) Follow the georeferencing directions from the Coverage Area – PDF/JPG/Other Image Format section 

below. 

29) Use the Georeferencing Toolbar to Update the Georeferencing for the TIF data set. 

30) In ArcToolbox, select Data Transformations>From Raster>Raster to Polygon and input the georeferenced 

TIF you just created as seen below: 

 

 

31) Open the resulting polygon feature class up for editing using the Editing toolbar in ArcMap and clean up 

as necessary. 

32) In ArcCatalog, create an empty feature class with the schema of the bb_cov feature class and load the 

feature class created above into it. 

a. Right-click on the empty feature class, select Load>Load data from the dropdown menu and 

navigate to the location of the service area feature class 

b. Press the Add button, hit Next 

c. Accept the defaults and hit Next 

d. Do NOT attempt to map any fields, as seen below: 

 

 
 

e. Press Next, then Next again, then Finish. 

33) In ArcToolBox, go to Data Management Tools>General>Append 

34) Append the formerly empty feature class to bb_cov, completing the dialog box as seen below: 
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35)  Leave the Schema Type as TEST 

36) Press OK. 

37) In ArcMap, open up bb_cov for editing and manually input associated attribution. 

 

3.5.3 Linear Data 

3.5.3.1 TIGER Street Segments – List, Spreadsheet, or GIS Data 

In the event that the provider supplies TIGER street segments in list or spreadsheet format please follow the steps 

below: 

1) Join TIGER road segments  to 2000 census blocks feature class using one of two methods based on how 

the data is provided: 

a) If the TIGER data is provided with a Census Block ID, then join the segments to the Census Block 

geometry based on that ID 

i) Load both data sets into ArcMap 

ii) In the layer list, right-click on the 2000 census block feature class and select Joins and 

Relates>Join 

iii) In the dialog box, select the TIGER road segments data and the proper attribute fields for joining, 

as seen below: 
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iv) Press OK 

b) If the data provided is a list containing TLIDs,  then join to the TIGER line data using the TLID, and use 

a spatial join to associate the TIGER segment with the coterminous block based on the block ID 

i) Load both data sets into ArcMap 

ii) In the layer list, right-click on the 2000 census block feature class and select Joins and 

Relates>Join 

iii) Select “Join data from another layer based on spatial location” from the dropdown menu 

iv) Complete the dialog box as seen below and press OK. 
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2) Export joined records into a temporary feature class. 

3) If joined Census Block geometry is confined to one specific area then dissolve blocks into one record.  If 

joined Census Block geometry is distributed throughout a particular state then dissolve sub-selections of 

census blocks for each county. 

a) Use the County FIPS code to dissolve by county. 

b) In ArcToolbox, select Data Management Tools>Generalization>Dissolve 

c) Complete the Dissolve dialog box as seen below: 
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d) Press OK. 

4) For each dissolved region, open up the feature class for editing using the Editing tool in ArcMap and 

remove unnecessary slivers and other small holes.  For general guidance on editing features in ArcMap, 

see http://webhelp.esri.com/arcgisdesktop/9.3/pdf/Editing_Tutorial.pdf  

5) In ArcCatalog, create an empty feature class with the schema of the bb_cov feature class and load the 

feature class created above into it. 

a) Right-click on the empty feature class, select Load>Load data from the dropdown menu and navigate 

to the location of the service area feature class 

b) Press the Add button, hit Next 

c) Accept the defaults and hit Next 

d) Do NOT attempt to map any fields, as seen below: 

 

http://webhelp.esri.com/arcgisdesktop/9.3/pdf/Editing_Tutorial.pdf
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a) Press Next, then Next again, then Finish. 

6) In ArcToolBox, go to Data Management Tools>General>Append 

7) Append the formerly empty feature class to bb_cov, completing the dialog box as seen below: 
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8)  Leave the Schema Type as TEST 

9) Press OK. 

10) In ArcMap, open up bb_cov for editing and manually input associated attribution if necessary. 

 

3.5.4 Polygonal Data 

3.5.4.1 Coverage Area – PDF/JPG/Other Image Format 

In the event that the provider supplies coverage area data in some image format such as PDF or JPG format please 

follow the steps below: 

1) If in PDF format, open in Adobe Acrobat and Save As… JPG format. 

2) Open up the JPG image in ArcMap. 

3) Add the required basemap vector data for georeferencing. 

a) This will generally be either the CDOT data or TIGER data 

4) Change the coordinate system of the data frame to the desired end coordinate system 

5) Zoom to the general location of the JPG map image 

a) This is the location based on the vector data, not the JPG image itself. For example, if you know that 

the JPG image represents an area around the town of Limon, zoom to the town of Limon in your 

vector data. 

6) Open up the Georeferencing toolbar by selecting View>Toolbars>Georeferencing from the main menu bar. 

7) Using the Georeferencing toolbar, select Fit to Display, results seen below: 

 

 
 

8) Use the Control Point button  to add control points to the map 

9) Use common points in the base data set and the JPG image 

a) For example, find major street intersections, county/city boundaries, etc. 

b) Try to distribute the points more or less in the four corners on the image for the best transformation 

10) Click on the location on the image first, then click on the corresponding location on the vector data base 

map, as in the image below: 
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11) After placing each control point, the image transformation will update automatically.  

12) Repeat until satisfied with the transformation. 

a) Note: The transformation may take up to four points, although sometimes only two are necessary. 

13) When satisfied with the transformation, select Update Georeferencing from the Georeferencing toolbar 

dropdown. 

a) This will create a “world” file (.jgw in the case of JPGs) in the same directory as the image file. 

14) In ArcCatalog, create a new polygon shapefile with the appropriate data schema for a provider coverage 

area, which can be found in Appendix D. 

15) Add the shapefile to ArcMap. 

16) Using the Editor Toolbar, select Start Editing. Set the Task: to “Create New Feature.” 

17) Use the Sketch Tool  to digitize a new coverage polygon using the coverage area outline from the 

georeferenced JPG and add the required attributes manually. 

18) Repeat the above steps for all subscriber speed coverage areas provided. 

19) Follow the steps detailed in Coverage Area – GIS Data below. 

 

3.5.4.2 Coverage Area – KML/KMZ 

In the event that the provider supplies coverage area data in Google Earth KML or KMZ format please follow the 

steps below: 
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1) Use a KML to SHP converter to translate file into an ESRI format 

2) http://arcscripts.esri.com/details.asp?dbid=15603  

3) Download the script and follow the provided instructions for installing it in ArcToolbox. 

4) Double-click on the script in ArcToolbox and navigate to the location of the KML file, as seen below: 

 

 

5) Add the new shapefile to ArcMap. Repeat for all KML files provided. 

6) Follow the steps detailed in Coverage Area – GIS Data below. 

 

3.5.4.3 Coverage Area – CAD Data 

In the event that the provider supplies coverage area data in GIS format please follow the steps below: 

1) Transform the CAD dataset into an ESRI format 

2) http://webhelp.esri.com/arcgisdesktop/9.2/index.cfm?TopicName=Transforming_CAD_datasets 

3) It may be necessary to contact the provider first to determine the coordinate system of the CAD data. 

4) If the CAD data is not in a standard coordinate system, it may be necessary to use ArcMap to 

georeference the CAD data to a known coordinate system first. 

a) To do so, follow the instructions provided above in “Coverage Area – PDF/JPG/Other Image Format.” 

5) In ArcCatalog, create a new polygon shapefile with the appropriate data schema for a provider coverage 

area, which can be found in Appendix D. 

6) Add the shapefile to ArcMap. 

7) Using the Editor Toolbar, select Start Editing. Set the Task: to “Create New Feature.” 

8) Use the Sketch Tool  to digitize a new coverage polygon using the coverage area outline from the 

georeferenced CAD file and add the required attributes manually. 

9) Follow the steps detailed in Coverage Area – GIS Data below. 

 

3.5.4.4 Coverage Area – GIS Data 

In the event that the provider supplies coverage area data in GIS format please follow the steps below: 

http://arcscripts.esri.com/details.asp?dbid=15603
http://webhelp.esri.com/arcgisdesktop/9.2/index.cfm?TopicName=Transforming_CAD_datasets
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1) In ArcCatalog, create an empty feature class with the schema of the bb_cov feature class and load the GIS 

feature class either created above or supplied by the provider into it. 

a) Right-click on the empty feature class, select Load>Load Data from the dropdown menu and navigate 

to the location of the service area feature class 

b) Press the Add button, hit Next 

c) Accept the defaults and hit Next 

d) Do NOT attempt to map any fields, as seen below: 

 

 
 

e) Press Next, then Next again, then Finish. 

2) In ArcToolBox, go to Data Management Tools>General>Append 

3) Append the formerly empty feature class to bb_cov, completing the dialog box as seen below: 
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4) Leave the Schema Type as TEST 

5) Press OK. 

6) In ArcMap, open up bb_cov for editing and manually input associated attribution, if necessary. 

 

3.5.4.5 Compact Polygon From Subscriber Points  

 Geo-code address list using latest state “Composite Locator”  

 

 Verify that your geo-coded file has only one TT (Technology Type).  If not export individual geo-coded 

layers for each Technology Type. 

 

 For each TT check for differences in speed values or speed tiers and create separate layers for each speed 

value/tier. 

 

 Clean your geo-coding results - remove any points that geo-code to accuracy levels below ZIP+4 (ZIP 

centroids, carrier route centroids, etc).  Also, verify that outliers with acceptable accuracy levels are 

legitimate, i.e. fall in correct City and Zip.   

 

 Perform spatial join between county polygons (using stcnyfips field) and the cleaned geo-coded subscriber 

points, in order to carry the county name and stcnty fips. 

 

 Summarize the number of subscribers by county and use the subscriber counts by county to populate the 

Rate Tier table. 
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 Un-join the county data from the geo-code subscribers list. 

 

 Create Compact Polygon using cleaned geo-coded layer or sub-selection of using – XtoolsPro – 

ConvexHull-DetailedHull option.  A sub-selection of geo-coded points will be used in areas where more 

than one polygon will need to be created for one provider’s service area.   

 

 Evaluate output Hull carefully – looking for areas that should not be covered by hull polygon.   

 

o If it is determined that an area or areas should not be represented in coverage area, manually 

reshape hull polygon until coverage area is adequate.   

 

o When not obvious and as a general rule, manually resolve compact polygon when the distance 

between the subscriber points used to define the outer boundary of the compact polygon 

exceeds 5 miles .  When reshaping the hull polygon, snap to the outermost geo-coded points.  

See figure 2 and 3 for an example. 

 

FIGURE 2- Compact Hull: Manual Resolution Required            
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FIGURE 3a- Compact Hull: Manual Resolution Required           FIGURE 3b- Compact Hull: After Manual Resolution        

                       
 

 To attribute the compact polygon - Perform a “Spatial Join” where your Target Feature Class is the 

compact polygon and the Join Feature Class is your geo-coded point layer.  Export compact hull with 

joined attributes and name file appropriately.   

 

 Append attributed compact polygon to BroadBand TT template Feature Class and if required manually 

input any provider attribution that may not have carried over in the append process. 

 

 Intersect compact polygon with county boundaries to create unique records by county and use the state-

county-fips field to populate “stcty_fips” field.  Also use the county name field to populate the 

“BBCov_Name” field.   

 

o Exceptions is where a provider’s coverage is distributed throughout more than one area of any 

given county where the “BBcov_Name” should be populated using an appropriate city or other 

logical name based on geographical location.  

 

 Export/Load into appropriate BB TT model Dataset. 
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3.5.4.6 Census Blocks – List or Spreadsheet 

In the event that the provider supplies census block data in a list or spreadsheet, please follow the steps below: 

1) Ensure block polygons supplied by the provider are 2000 currency 

2) If other currency, convert to 2000 currency before proceeding 

a. To do this, remove the trailing letter (a, b, etc.) from the block ID 

b. You will now have two blocks that equate to one block in the 2000 block geometry 

c. Delete duplicate block IDs, retaining the higher service tier in each case 

3) Prepare the block list in clean Excel format, removing all Excel-only formatting, merged cells, colors, 

borders, etc. 

4) Import the spreadsheet into ArcMap. 

5) Right-click on the 2000 census block feature class in the layer list in ArcMap and select  Joins and 

Relates>Join from the drop down menu. Join the census block list to the 2000 census blocks feature class 

using the block ID and export joined records in a new feature class. The Join dialog box and process can be 

seen above in the TIGER Street Segments – List, Spreadsheet, or GIS Data section. 

6)  Follow the steps in Census Blocks – GIS Data below. 

 

3.5.4.7 Census Blocks – GIS Data 

In the event that the provider supplies census block GIS data please follow the steps below: 

 

1) Ensure that the blocks supplied by the provider are in the required data schema and are complete as far 

as require attribution. 

a. If not, manually enter the required attribution or contact the provider to fill gaps. 

2) If census block geometry is distributed throughout more than one county then select Data Management 

Tools>Generalization>Dissolve in ArcToolbox and dissolve based on County/Provider/TT/Speed Tier so 

that unique records are created for each unique combination. 

a. The dissolve dialog box can be seen above in the TIGER Street Segments – List, Spreadsheet, or 

GIS Data section. 
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Figure 1: Undissolved census block polygons 

 

 
Figure 2: Census block polygons dissolved by county 

 

 

2) For each dissolved region use the Editing toolbar in ArcMap to remove unnecessary slivers and other 

small holes.   

3) In ArcToolbox, select Data Management Tools>General>Merge and merge the processed polygons 

together into single layer. 

4) The merged census blocks will need to have the subscriber’s “frn” field added and populated. 

5) In ArcCatalog, create an empty feature class with the schema of the bb_cov feature class and load the GIS 

feature class either created above or supplied by the provider into it. 

a. Right-click on the empty feature class, select Load>Load Data from the dropdown menu and 

navigate to the location of the service area feature class 
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b. Press the Add button, hit Next 

c. Accept the defaults and hit Next 

d. Do NOT attempt to map any fields, as seen below: 

 
 

e. Press Next, then Next again, then Finish. 

6) In ArcToolBox, go to Data Management Tools>General>Append 

7) Append the formerly empty feature class to bb_cov, completing the dialog box as seen below: 
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8) Leave the Schema Type as TEST 

9) Press OK. 

10) In ArcMap, open up bb_cov for editing and manually input associated attribution, if necessary. 

 

3.6 Metadata Transactions 

Following any updates or changes completed within the file geodatabase (fGDB) stored on the GIS-Analysts staging 

environment, the GIS-Analyst runs transactions to compare that fGDB with the one stored on the Core server to 

ensure metadata on all changes are recorded. 

 

Below outlines the steps taken to run transactions on the updated Core database: 

  

1. Open a command line window and run generateTransactions.py  

a. Usage: generateTransactions.py  [Core fGDB] [Staging Environment fGDB]  

 

b. Example of command line:  

 

<path>generateTransactions.py <path>ST_BB_POLY_SRV_AREAS.gdb <path>ST_BB_POLY_SRV_AREAS.gdb  

 

2. Below is an example of the output screen that will be displayed: 
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3. After process has completed, results can be found in the ST_BB_POLY_SRV_AREAS_HIST.gdb  

a. The transactions scripts records changes at a feature level. 

b. Below is a screen shot supporting the directory structure of the historical fGDB. 
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c. Attribution associated with each added/removed/changed features is tracked, including the 

following additional columns appended to the end of each: 

i. Commit_by 

1. Records the GIS-Analyst that committed the changes to the historical fGDB. 

 

ii. Commit_date 

1. Records the date and time stamp that the changes were committed. 

 

iii. Trans_type 

1. This field reflects the type of change recorded. 

2. Categorized by: 

a.  Adds/Change/Deletes 

 

iv. New_values 

1. Records the new values when a change was completed on a feature.  Example:  

Name or speed change 
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d. MD_Process is also transferred from the edited fGDB to the historical fGDB, which states the 

actions completed by the GIS-Analyst. 
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3.7 Data Processing 

3.7.1 Data Processing Overview 

The following items outline the actions required to process the service provider data further to meet the NTIA 

requirements. 

 Weighted Nominal Speed 

 Middle Mile 

 Broadband Coverage Template 

 

3.7.2 Weighted Nominal Speed 

The weighted nominal speed is populated one of the following two ways: 

3.7.2.1 Subscriber Data Supplied by Provider 

Where the data provider supplies  subscriber speed information , the following formula from the NOFA is used: 

(speed tier-1 in kbps × no. of tier-1 subscribers) + (speed tier-2 in kbps × no. of tier-2 subscribers) + (etc.) 

Total average monthly subscribers 

 

 

Data is initially broken up in the following order: 

1) Stcty_fips 

2) Transmission technology type 

3) Subscriber tiers 

 

3.7.2.2 Value Supplied by Provider 

Some providers will supply their weighted nominal speed.  In these cases, the data supplied will be populated 

instead of using the NOFA formula. 

These obtained or calculated values are used to update the service overview layer. This can be done manually or 

by creating a table with the provider’s FRN and average weighted speed and joining it to the service overview table 

in ArcMap. To Join, right-click on the layer to join to and select Joins and Relates>Join… from the dropdown menu. 

Then navigate to the table to join to and select the join fields from the drop down list. Then open up the source 

table (the table in ArcMap) and right-click on the header of the Average Weighted Speed field and select Calculate 

Field from the drop down menu. Use the value of the average weighted speed from the joined table. 

3.7.3 Middle Mile 

Middle mile information is generally provided in spreadsheet or text file format. The process is to take what is 

supplied by the provider and translate it into the required data schema.  

1) If the data is supplied with address information, follow the process outlined above in Subscriber Location 

– Address Data.  

2) If the data is supplied with associated XY coordinates, follow the process outlined above in Subscriber 

Location – XY Data.  
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3) Once the data is in GIS format, use the Append (Data Management Tools>General>Append) command in 

ArcToolbox to append the data to the overall middle mile dataset. 

4) Set the schema type to NO_TEST and use the Field Map to map the attribute fields from the source to the 

target dataset. 

3.7.4 Broadband Coverage Template 

Below is the description of the fields within the BB_Cov layer, which is the interim data set that is used to create 

the final product deliverable. 

 

Name Alias Description 

objectid OBJECTID Internal Object ID 

shape SHAPE Internal Shape storage 

prov_id PROVIDER_ID Unique numeric identifier for each provider 

prov_name PROVIDER_NAME Unique name for each provider 

dba_name DOING_BUSINESS_AS An alternative "Doing-Business-As" name for the provider 

frn 
FCC_REGISTRATION_NUMBE

R 
Provider FCC Registration Number 

bbcov_name BBCOV_NAME BroadMap Broadband Coverage name 

trans_code TRANSMISSION_CODE 
Unique code for the transmission technology type described by 

this layer 

trans_name TRANSMISSION_NAME Name for the transmissions technology type 

trans_desc TRANSMISSION_DESC Description for the transmissions technology type 

spect_code SPECTRUM_CODE Unique code for the spectrum [WIRELESS ONLY] 

spect_name SPECTRUM_NAME Name for the spectrum [WIRELESS ONLY] 

spect_desc SPECTRUM_DESC Description for the spectrum [WIRELESS ONLY] 

mad_dwn_t MAX_AD_DOWN_TIER 
Maximum advertised downstream speed available within given 

area (speed tier) 

mad_up_t MAX_AD_UP_TIER 
Maximum advertised upstream speed available within given 

area (speed tier) 

typ_dwn_t TYPICAL_DOWN_TIER 
Typical downstream speed available within given area (speed 

tier) 

typ_up_t TYPICAL_UP_TIER Typical upstream speed available within given area (speed tier) 

mad_dwn_k MAX_AD_DOWN_KBPS 
Maximum advertised downstream speed available within given 

area (kbps) 

mad_up_k MAX_AD_UP_KBPS 
Maximum advertised upstream speed available within given 

area (kbps) 
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Name Alias Description 

typ_dwn_k TYPICAL_DOWN_KBPS Typical downstream speed available within given area (kbps) 

typ_up_k TYPICAL_UP_KBPS Typical upstream speed available within given area (kbps) 

subs SUBSCRIBERS 
Total average monthly subscribers for this provider for this 

technology for this coverage polygon 

md_geom MD_GEOMETRY 
Metadata: Comma separated list of source id's from which the 

polygon extent was produced 

md_exists MD_EXISTS 
Metadata: Comma separated list of source id's used in 

understanding and editing the provider data for this polygon 

md_who MD_WHO 
Metadata: Name of the editor who last edited this feature at 

the time in md_when 

md_when MD_WHEN Metadata: Date/timethat this feature was last edited 

md_process MD_PROCESS 
Metadata: Comma separated list of processed used to create 

and/or modify this layer 

stcty_fips STATE_COUNTY_FIPS State/County FIPS code 

rec_id RECORD_ID 

Compound Key formed from 

STCTY_FIPS+"|"+Provider_ID+"|"+Trans_Code+"|"+BBCov_Nam

e 

st_area ST_AREA(SHAPE) Area in square decimal degrees  

st_length ST_LENGTH(SHAPE) Length in decimal degrees  

Provider_Typ

e 
Type of Provider 

Has Subtype (1:Broadband provider as described in the 

NOFA,2:Reseller,3:Unknown), default value = 1  (New 04/11 

Model) 

 

3.7.5 Verification and Validation 

3.7.5.1 Provider Validation – Provider Portal/PDF Map Review 

Following the collection and aggregation of provider data, the aggregated data is validated by the provider to 

ensure it is an accurate representation of their coverage area and supporting broadband information. 

This validation is completed through the Provider Portal web application, which is a secure interactive map that 

displays  the provider’s coverage areas and allows the provider to validate, submit feedback or request changes.  If 

changes are requested, then the features on the portal are updated and an automatic request is sent to the 

provider to complete the validation process. 

 

 Providers that did not use the Provider Portal are asked to validate a PDF map displaying their coverage area(s).  

this is accomplished via e-mail notification.   



            

57 

 

 

 

 

 

3.7.5.2 Provider Verification – 3rd Party Source Review 

After the provider has validated its coverage areas, a 3
rd

 party source comparison and analysis is performed.  

Where anomalies or discrepancies are identified, a ‘SCAN’ point is dropped and descriptive comments are applied 

to be reviewed later with the provider. 

 

During the provider review, the map is displayed along with the ‘SCAN’ points and potential refinement is 

completed based on input from the Provider. 

 

3
rd

 Party Sources Utilized 

3
rd

 Party Source Name Source Type Verification Type 

InfoUSA Consumer and Business 
Listings 

Community Anchor Institutions 
Can also be used for demographic information supporting 
the State websites 

Pitney Bowes (PBBI) Exchange Info Plus 
(Central Office Locations) 

Exchange datasets are used to verify the following 
Transmission Technologies (TT): 
Asymmetric xDSL (10), Symmetric xDSL (20), Other Copper 
Wireline (30), and Optical Carrier/Fiber to the End User 
(50). 
 

Media Prints Cable Boundaries Used to verify the following TT: 
Cable Modem—DOCSIS 3.0 (40) and Cable Modem—Other 
(41) 

American Roamer  Wireless Coverage 
Patterns (EVDO, GPRS, 
WISP, HSPA) 

Used to verify the following TT: 
Terrestrial Fixed Wireless—Unlicensed (70), Terrestrial 
Fixed Wireless—Licensed (71) and Terrestrial Mobile 
Wireless (80) 

ComSearch Wireless Spectrum 
Holdings and Tower Data 

Used to verify the following TT: 
Terrestrial Fixed Wireless—Unlicensed (70), Terrestrial 
Fixed Wireless—Licensed (71) and Terrestrial Mobile 
Wireless (80) 
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3.7.5.3 Assigning Confidence Values 

All  findings and results from the above-mentioned validation and verification activities, plus internal peer quality 

reviews are captured and tracked in a Validation table and form the basis of the confidence value assigned  for 

each provider and then each technology.   

 

The confidence values are as follows:  
0     = Coverage area has not been reviewed 
10   = Extremely Low.   Single Source QC.   
20   = Very Low.  Needs Additional Validation\Verification 
30   = Low.   Even with Validation\Verification, Coverage is still suspect. 
40   = Acceptable, confirm with State prior to shipment.    
50   = Meets requirements to be included in shipment. 
60   = Moderate.  Meets NTIA/State’s standards, representative of Technology Type (TT) 
70   = High.   Accurate representation of coverage based upon TT. 
80   = Very High.  Multiple validation\verification with most 3

rd
 party sources 

90   = Extremely High. Multiple validation\verification sources 
100 = Perfect.  Multiple validation\verification sources, with complete alignment with sources and ground 
truth verification activities 

 

This Validation table is maintained as updates or changes occur for each provider, down to technology type, with 

the overall goal to improve the confidence values and overall map representation. 

 

Example of the Validation table: 
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3.7.6 Community Anchor Institution (CAI) Data 

3.7.6.1 Data Collection 

The CAI data was initially collected from the State to create the baseline inventory.  All location information and 

broadband coverage data supplied was also ingested into the data deliverable. 

Additional collection of CAI information was done via data mining and/or webscraping to build out the inventory 

further.  For example:  Collection of additional CAIs and location information. 

 

The state-agency-provided CAI inventory was comprehensive but the challenge is collecting broadband related 

data; service provider(s), technology and speed data for each CAI.  Availability of the CAI portal has not significantly 

increase submission of this data.  Additional promotion to CAIs to utilize the CAI portal will be needed to increase 

this data for subsequent deliverables. 

 

3.7.6.2 Institution Data 

Institution data is obtained from a variety of sources and almost always provided in Excel spreadsheet format. The 

general process for incorporating this data is below: 

1) If the data is provided in Excel or some similar format: 

a. Clean and standardize the Excel spreadsheet, removing any cell formats, merged cells, etc. 

b. Standardize the address format as defined in the staging CAI database 

c. If the spreadsheet includes X and Y values, such as latitude and longitude, use the Add XY Data 

tool in ArcMap to create a spatial data layer. 

d. If there are only addresses, then follow the geocoding steps outlined above to create spatial data 

points for each of the institutions. 

i. Institutions that do not geocode based on the TIGER 2009 data set will have to be 

manually located using Google Maps, Google Earth, or some other information source. 

2) If the CAI source data is in GIS format, add the Latitude and Longitude fields and use the Calculate 

Geometry tool to populate them, using the WGS 84 coordinate system. 

3) Using ArcCatalog, load the new data into the staging CAI database. 

4) This database is ready for the makeDeliverable.py script to process the information into the final state 

and NTIA deliverables. 
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3.7.6.3 Community Anchor Institution (CAI) Portal Updates 

A web application has been released to allow for further data collection and validation of anchor institution 

location information, broadband coverage, and speed test data. 

 

Information collected from the CAI Portal is then ingested into the overall inventory and will later be compared 

against the provider coverage areas mapped for any potential discrepancies. 
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3.8 Product Extract 

3.8.1 Python Scripts 

The following sections make use of Python scripts. In general, to use a Python scrip, you must have Python 

installed on your computer. To download the latest version of Python, go to http://www.python.org/download/ 

and download the latest stable version. As of August 2010, this was version 2.7. Once this is installed, the general 

way to run a script is to type the following at a command prompt: C:\Python27\python.exe C:\<location of script>. 

Many of the scripts provided have environment variables that must be set before they can be run.  

 

The python code for BroadMap’s product extract has been incorporated into a Hudson CI System, which is detailed 

in the Process Operation and Monitoring section of this document.  This was a process improvement activity so all 

processes can be monitored, controlled and contain historical tracking on each process. 

 

3.8.2 Product Extract Process 

Note: specific Python scripts are called out in red font in the sections below. 

The MapConnect product extract process, makeDeliverable.py, uses the BB_Cov and BROADMAP_POINTS interim 

data sets to create the following layers according to the current specifications: 

 BB_Service_Road_Segment 

- This layer contains all broadband services associated with specific street segments for census 2000 

blocks larger in area than two square miles 

 BB_ServiceCensusBlock 

- Contains all broadband services associated with census blocks of no greater than two square miles. 

 BB_Service_Wireless 

- This layer contains all wireless services not associated with specific addresses. 

 BB_ServiceOverview 

- This layer contains subscriber-weighted nominal speed for each provider's service area at a county 

level and is meant to act as a summarized view.  

 BB_ConnectionPoint_MiddleMile 

-   This layer contains middle-mile and backbone interconnection points 

 BB_Service_CAInstitutions 

- Broadband Service at Community Anchor Institutions (CAI) 

 Community Anchor Institutions consist of schools, libraries, medical and healthcare providers, 

public safety entities, community colleges and other institutions of higher education, and other 

community support organizations and entities. 

 

Due to a NTIA model change for the October 2010 data deliverable, an addition to this code was created to 

support both models in the case a comparison is later desired or a request is made to revert back to the original 

model.  This script name is bdia2ntia.py and creates the following layers in addition to the layers mentioned above, 

rolled up to NATL_Broadband_Map. 

http://www.python.org/download/
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 BB_ConnectionPoint_LastMile 

-   This layer contains last mile infrastructure points, which is only populated if data cannot be provided 

at a more granular level. 

 BB_Service_Address 

- Represents broadband availability for service address points.  Address Point availability refers to 

those individual addresses at which each facilities-based provider of broadband service can provide 

broadband services of minimal characteristics within 7 - 10 business days. 

 State_Boundary 

- State boundary supporting topological validation of point feature classes. 

 NATL_Broadband_Topology 

- Supports basic topology quality checking.  Example:  No CAI’s or Middle Mile points outside of the 

state boundary 

 

The following process flow provides a view of how the Core fGDB is extrapolated to the NTIA final deliverable via 

the makeDeliverable.py script.  Following that, the bdia2ntia.py script is run, which limits what’s placed in the final 

layers based on the NTIA modeling standards. 

 

The product scripts and supporting extract were originally created separately per request, in case data model 

comparisons were to be completed.  

 

3.8.3 Product Statistics 

Following the completion of a product extract, the product statistics script (BDIA_ReleaseNotesStats.py) extracts 

the following information supporting that product deliverable. 

 Provider Statistics 

- Collects all provider information, listing by Provider Name 

- Provides output of FRN 

- Counts the number of features supported within the following layers: 

 Census Block 

 Street Segment 

 Max Upstream 

 Wireless Services 

 Infrastructure Points 

- These updates were made to support the Data Package required to accompany every NTIA product 

deliverable. 

 Community Anchor Institution (CAI) Statistics 

- Breaks CAI down to the 8 categories 

 1:  School: K through 12 

 2:  Library 
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 3:  Medical/Healthcare 

 4:  Public Safety 

 5:  University/College 

 6:  Other Government 

 7:  Other Community non-government 

 None:  Unknown Category 

 In cases where this occurs, further investigation is completed prior to product shipment to 

ensure all CAI’s are categorized accurately 

- Reports out the following counts 

 Total CAIs within that category 

 Total CAIs that contain partial BB coverage  

 Contains any of the following information for given CAI: 

 BB Subscriber, Transmission Technology, Speed Down Speed Up 

 Total CAIs that contain full BB coverage 

 Contains all of the above-mentioned BB information for given CAI. 

The output of this script is two CSV files: AnchorInstitutions.csv and Providers.csv. These files can then be 

inspected to ensure that there are the expected number of CAIs and providers for every release. 

 

3.9 Quality Assurance  

Quality assurance is supported manually and algorithmically on the interim data, BB_Cov file geodatabase, and on 

the final product. For scheduled product releases, a test product extract and subsequent manual and algorithmic 

QC run is completed along with a release review.  The product specifications, project status reports, previous 

product release notes are used as references throughout this review. 

The following parameters are tested using the methodology listed below each: 

 Product Deliverable Format  

- Correct names and format of data deliverables 

 BDIA_QC_SUITES (please see below for details) 

- Correct Projections/Datum 

 Manual interaction with product 

- Metadata Present and Correct 

 Manual interaction with product 

 Table Structure 

- All required tables included 

 BDIA_QC_SUITES 

- Extraneous tables identified 

 BDIA_QC_SUITES 

 Field Structure 

- All fields included 
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 BDIA_QC_SUITES 

- Extraneous fields identified 

 BDIA_QC_SUITES 

- Correct field names, types and widths 

 BDIA_QC_SUITES 

 Field Domains 

- Values in all tables are constrained to the specified values specified 

 This action is accomplished via BDIA_QC_SUITES and manual review of the product 

 This tends to identify project completeness issues as fields with a null value are identified. 

 Geometric Representation 

- Identify if all layers have the correct geometric representation 

 Manual review of the BB_ServiceOverview layer 

 Dependent on NTIA and client requirements 

 Geographic Extent 

- Product includes the necessary Geography associated with Product? 

 Manual Review - ArcGIS 

- Is there extraneous geography included in Product? 

 Manual Review - ArcGIS 

 Completeness 

- Products contain the expected amount of data? 

 Manual review of product stats relative to weekly State reports and defined expectations. 

 Accuracy 

- Product meets the stated accuracy requirements for the deliverable? 

 Sampling procedure to manually review source material to resulting product 

 Provider Validation 

 Verification using 3
rd

 Party Data 

 Verification against reality, where applicable 

 Data Regression 

- Any unexplainable data loss or change? 

 This action is accomplished by comparing results within product statistics script 

(BDIA_ReleaseNotesStats.py) from previous releases, as well as manual review of the product 

 Confidentiality 

- Any unauthorized confidential information included in the delivery? 

 Review of NDAs and delivery expectations 

 Prior Issues Resolved  

- Have expected internal issues been resolved? 

 Manual review of data against previous product release notes 

- Have agreed upon customer issues been resolved? 

 Manual review of data against previous product release notes, status report and client feedback 

 Delivery Medium 
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- Has the product medium been verified? 

 Manual review 

- All files present 

 Manual review of SFTP site to ensure all files are copied correctly, including file/directory size 

- Correct location 

 Manual review – confirmation of SFTP link, username and password 

 

3.9.1 QC Suite 

The BDIA_QC_SUITES consists of four main types of scripts supporting the overall QC process. These scripts are all 

run in concert and are called from the test_runner script and the test_BDIAProductGDB script. 

 

3.9.1.1 Configuration  

These scripts establish the configuration for the test_BDIAProductGDB script which is the core of the QC Suite.  

- update_test_config 

- active_config 

- config_PROCESS01_automated 

- config_PROCESS01_manual 

- set_active_config 

3.9.1.2 Libraries 

These scripts provide additional functionality that is called from with the test_BDIAProductGDB script.  

- bb_unittest_fixture 

- bbcov_structure 

- BC_XmlWriter 

- file_folder 

- search_and_replace 

- unittst_fixture 

- validate_BB_DB 

- validate_BB_GDB 

- xmlrunner_gui 

3.9.1.3 QC Suite 

This is the core script for performing automated QA/QC on the interim and final data deliverables. 

- test_BDIAProductGDB 

3.9.1.4 Other  

These scripts perform other functions detailed below: 

- test_runner – this is the main script that runs all the other QC scripts and imports all the necessary scripts 

and libraries 



            

66 

- which_build – this determines the current build and passes information to the configuration scripts 

 

3.10 Process Operation and Monitoring 

Product Extract, makeDeliverable.py and bdia2ntia.py, is run within BroadMap using a platform called Hudson that 

has been enhanced to support BDIA product extraction, process monitoring, as well as product validation.  The 

same platform can be planned for implementation for the State, if desired. 

 

Below are examples of the product create, product validation, product statistics and monitoring processes which 

are managed within the BroadMap Hudson CI-System.  All of the above-mentioned python scripts, with the 

exception of metadata transactions script, are run via this system. 

 

3.10.1 BDIA Product Create 

 

Below is an example of the main page where the type of product build can be selected. 

 

 
 

Selecting based on the type of process that will be initiated. 
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The Console Output can be reviewed to see the progress of product create.  Following the completion of each 

product creation process, an e-mail notification is automatically sent to the team.   

 

 
 

 

All processes run via the BroadMap Hudson CI-System are stored for historical reporting.  Each process can be 

reviewed, including the Console Output and Build Artifacts from that run. 

 

 
 

3.10.2 Product Validation and Statistics 

 

Once the product creation process is complete, Product Validation and Statistics are then initiated.  These support 

the BDIA_ReleaseNotesStats.py script and the BDIA_QC_SUITES scripts detailed above. 

All statistics and reports are stored for historical review with the capability to place violation criticality on each 

quality control check allowing the identification of errors due to project status/completeness verses project 

correctness.  Example:  Typical Speeds populated. 
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Below is an example of the report provided based on various control points running over a specified time period: 

 
 

Similar to the Product Create process, all results from the process are maintained:  

 
 

Results are then reviewed manually to ensure no errors reported are critical or in violation of the NTIA data model 

or project completion statements.  Any errors of concern are communicated ahead of product delivery and 

included within the product release notes. 

Further detail on the Hudson CI System environment can be found by navigating to the following link: 

http://wiki.hudson-ci.org/display/HUDSON/Meet+Hudson 

 

http://wiki.hudson-ci.org/display/HUDSON/Meet+Hudson
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3.11 Product Extract Data Delivery 

Product delivery for MapConnect Broadband is handled two ways, depending on client requirements: 

1) State Submittal 

a) Data is submitted via SFTP site 

b) Product Release Notes and QC Test Report accompanies the delivery 

2) NTIA Submittal 

a) Directions for using the NTIA State Broadband Data file submission tool 

b) Go to the following WWW web site: https://esupport.fcc.gov/statedata  

c) Enter your username and password as provided to you from the NTIA program administrator. 

 

 
 

d) Click in Upload a file field 

e) Browse to local file for submission using the ‘Browse’ button.  Select file then select ATTACH FILE. 

https://esupport.fcc.gov/statedata
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f) Logout / Receipt using the Logout button in the Top Right of the screen 

g) A receipt of submission is emailed to username e-mail address 

 

 



May 20, 2011 - Final 

State of Arizona  

Government Information Technology Agency 
 

 

 

 

 

 
 

 

 

 

 

Arizona Broadband Assessment Project  

White Paper 
 

 

 

 

 

Submission 3 - April 1, 2011  
 

 

 

 

 

 

 

 

 

 

 

 

         



Arizona Broadband Assessment Project White Paper - Spring 2011                                Page 2 

State of Arizona 

Government Information Technology Agency 

Arizona Broadband Assessment Project White Paper 

 

Submission 3 - April 1, 2011  
 

Table of Contents 
              Page 

Government Information Technology Agency Forward         3 
 

Arizona Broadband Assessment Project Overview          5 
 

AZ BAP White Paper Recommendations           5 
 

Broadband Data Description             7 
 

Broadband Provider Participation            8 
 

Broadband Providers Included            8 

Broadband Providers Identification Strategy          9 

Broadband Providers Engagement Strategy         10 

Non-Disclosure Agreements (NDA)           12 
 

Data Collection and Integration            16 
 

Primary Data Collection            16 

Data Processing Approaches           18 

Data Processing Issues            19 

Data Processing Automation Project          21 

Community Anchor Institutions (CAI)           21 

Project Data Flow and Security           27 
 

Validation               28 
 

Validation Overview            28 

Business Logic Rules            28 

Confidence/Reliability Index Development         29 

Feedback Loop             29 

Statistical Models             30 

3rd Party Publicly Available Data          30 
 

Arizona Broadband Map             32 
 

Arizona Broadband Map Overview          32 

Arizona Broadband Map Details          35 

Arizona Broadband Portal Plans          37 
 

Appendix A - Arizona Broadband Provider Technical Appendix       38 
 

Appendix B - Community Anchor Institution Master Database       48 
 

Appendix C - Arizona Broadband Provider Case Studies        55 
 

Appendix D - Broadband Provider Data Verification Table       58 



Arizona Broadband Assessment Project White Paper - Spring 2011                                Page 3 

 

 
 

 

 
JANICE K. BREWER 
          GOVERNOR 

 

 
 
 
 

C                  AARON V. SANDEEN 
DI                        STATE CIO & DIRECTOR 

      State of Arizona 
    Government Information Technology Agency 

Arizona Broadband Assessment Project White Paper 
 

 

As is widely noted, the ubiquitous availability of Broadband has become as essential to quality 

of life as are the availability of other essential infrastructures of power, water, and transportation. 

There is no longer any doubt regarding the necessity of broadband capacity as a critical 

component for a region‘s economic well-being, job creation, and future prosperity for its citizens. 

Indeed, our increasing reliance on broadband communication for everything from commerce 

and public safety to education and healthcare, and to the efficient operation of government has 

marked this first decade of the 21st Century as the ―Information Age.‖ Accurately knowing the 

conditions of broadband availability, its capacity, and deficits in all parts of our State, especially 

underserved rural areas, is critical information for decision-making and informed policy.  
 

Because the GITA Broadband Team has now spent its first full year developing the Arizona 

Broadband GIS Survey and Assessment data, tools, and deliverables under our National 

Telecommunications and Information Administration (NTIA) Broadband Mapping grants, we can 

now begin to identify the actual availability and deficits in the State, on behalf of Arizona‘s 

broadband stakeholders, with a reasonable degree of accuracy. There is still much to do to 

make the data yet more accurate and useful to stakeholders as the data currently provided by 

service providers currently may overstate actual availability in two dimensions.  
 

First, for wireline services, availability is frequently shown as availability throughout an entire 

service territory and does not show in which streets, census blocks, and neighborhoods where 

physical plant is not actually available to connect users.  
 

Second, as agreed with service providers, download and upload speeds for all types of services 

are reported as maximum advertised speeds. These numbers vary considerably when 

compared to actual speeds experienced by users in most instances. To address these issues, 

so as to provide more accurate data to our stakeholders, we have begun a verification program 

using licensed databases and crowd-source data and speed-test data captured by independent 

third parties. As the amount of this data is accumulated to a statistically significant level, we will 

begin to incorporate it in our broadband maps. We will also continue working with our service 

providers to obtain more granular and accurate service availability data wherever possible. 
 

Finally, as we begin using the Broadband Survey and Assessment data and begin moving into 

our Capacity Building phase supported by a second NTIA grant, as a basis for accelerating the 

build-out of broadband capacity in Arizona, our service provider stakeholders tell us that non-

uniform, inconsistent permitting and rights-of-way reuse policies at all levels of government are 

 



Arizona Broadband Assessment Project White Paper - Spring 2011                                Page 4 

the major source of delays and economic disincentives to building-out more capacity, especially 

in underserved rural areas. We are committed to helping remove or reduce such barriers. 
 

Many State and Federal agencies that control land and right-of-way do not yet appear to be 

committed to the national agenda for accelerating broadband capacity by expediting and 

simplifying their processes and working in a coordinated and uniform way with each other, the 

states, municipalities and the private sector. For example, we have determined that the cost of 

laying fiber-optic conduit along a highway right-of way that is under repair or construction is 

roughly equivalent to the cost of putting the paint stripes on the highway. If such conduit could 

be installed in these circumstances (especially along rural highways), it would yield ―Two 

Highways for the Price of One. Quite a bargain! However, because the Federal Government 

provides the bulk of highway funding it would require rule and policy changes by the USDOT to 

make such a program a reality. Such a program (even if limited to just rural areas) would 

transform the ROI equations for serving rural areas and create profitable new broadband last-

mile markets that now often go un-addressed by both small and major providers.  
 

Other possibilities for accelerating rural build-out and increased broadband speeds are reflected 

in the recent FCC Notice of Inquiry (NOI) regarding broadband rights-of-way policy 

recommendations for economically reusing existing pole, duct, conduit, canal, pipeline, and rail 

rights-of-way for broadband deployments especially for increasing middle-mile capacity. 

Therefore GITA is very supportive of the types of ideas contained in the FCC NOI. 
 

As we expand from just surveying and accessing to creating policy and programs for actually 

accelerating broadband availability, available speeds, performance, and utilization, working with 

other states and the Federal Government to mitigate and resolve these impediments to 

broadband growth (and therefore economic growth and opportunity) will become a major focus 

for our work. This white paper documents in significant detail the methods we have used to 

create the current version of the Arizona Broadband Map, and how the Broadband Survey and 

Assessment data that underlies it was obtained and processed. We would like to thank our core 

team of GITA personnel, as well as the Arizona State Land Department (ASLD) and our 

contractor Data Site Consortium, Inc. (DSCI) for their vision, commitment, and good work. 
 

 

Aaron Sandeen 

Director - GITA & State of Arizona CIO 
 

 
Michael Golden     Galen Updike 

Director, Broadband Planning – GITA Telecommunication Development Manager - GITA 
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Arizona Broadband Assessment Project Overview 
 

The purpose of the Arizona Broadband Assessment Project (AZ BAP) is to identify both the 

availability and speed of broadband services, and the location of broadband infrastructure 

throughout Arizona. This project is provided through the American Recovery and 

Reinvestment Act of 2009 (ARRA) and the Broadband Data Improvement Act (BDIA), and in 

conjunction with the National Telecommunications and Information Administration (NTIA). 
 

The information collected has been processed, verified, and shared with the Federal 

Communications Commission (FCC) and NTIA to develop a national broadband availability 

map, as well as to be used in Arizona to inform policy makers; identify opportunities to install 

new, or improve existing, broadband infrastructure; and to develop a state-level broadband 

availability map. 
 

This white paper describes the data integration and verification processes employed by the 

State of Arizona in preparation of the broadband availability data set submitted to NTIA April 

1, 2011. This data collection, processing, and submittal are to be conducted on a semi-

annual basis over a five-year period. Spring 2011 was the third of ten semi-annual 

submissions by the State of Arizona and attempts to capture and reflect broadband 

availability and conditions in the field as of December 31, 2010. 
 

AZ BAP White Paper Recommendations 
 

The AZ BAP White Paper identifies many issues encountered as the project team developed 

broadband data for submission to NTIA, the FCC, and the state broadband availability map. 

The purpose of this section is to bring attention to several issues and proposed 

recommendations, contained within this white paper, that we believe are important. 
 

Reverse Mapping: What Is It and Why We Use It 
 

 The reverse mapping process for a given provider involves first determining a 

provider‘s outside plant infrastructure, technologies, and locations from which we 

deduce its likely service types and potential speeds. Then, we use engineering tools, 

such as ESRI‘s Network Analyst and Wireless Application Corporation‘s eCoverage, to 

create one or more coverage maps based on well-known propagation physics. These 

steps are followed by reviewing the probable coverage maps/speeds with the provider 

when possible, transforming the maps into ESRI shapefiles and publishing the results. 
 

 We typically deploy the reverse mapping process where a provider 1) does not initially 

provide data, or 2) provider provides sparse data—back of the envelope sketches, etc. 

Most providers respond positively to our request for joint review of the reverse-mapped 

data. Some request rights to use the data on their websites—we always say yes. A 

few do not embrace the data, providing no real feedback as to its validity. See Reverse 

Mapping Role & Processes Section on Page 17. 
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Native American Mapping Efforts Going Forward 
 

 Arizona is home to 21 federally recognized Tribes and over 250,000 Native Americans 

(http://edrp.arid.arizona.edu/tribes.html). In many cases, mapping of these Tribal 

Lands is covered when we map the underlying carriers that serve those areas. Hopi 

Telecommunications Inc. (HTI), Gila River Telecom Inc. (GRTI), San Carlos Apache 

Telecommunications Utility, Inc. (SCATUI), and Saddleback Communications (Salt 

River Pima-Maricopa Indian Community) have not been initial-providers of data. We 

have reverse mapped these four providers, have not obtained meaningful feedback 

from three of these four providers, and have leveraged public-data sources for 

purposes of confirming our reverse mappings. See Native American Mapping Efforts 

Going Forward Section on Page 17 and Appendix C - Arizona Broadband Provider 

Case Studies. 
 

Metrics for Distinguishing Served, Underserved, and Un-Served Areas. 
 

 The Arizona mapping team has concluded that it will utilize the number of broadband 

providers, within defined speed ranges, as its primary basis for categorizing Arizona 

regions as either, served, underserved or un-served. It is possible that other 

characteristics of broadband may be considered as we understand which of those 

characteristics relate to enabling substantial groups of users, such as telemedicine 

and e-learning. See Definition of Unserved and Underserved Communities Section on 

Page 18. 
 

Data Processing Issues 
 

 We are working to improve the geocoding reference sources we use to process 

Provider data by accessing local version of street networks and parcel databases 

where available. TIGER road segments are either not present or missing address 

attributes in many areas of Arizona, especially rural areas. Commercial data sources 

do not allow use to their geometry in our submittals to the NTIA. See Data Processing 

Issues - Improving Address, Census and Road Segment Section on Page 19. 
 

 We are buffering commercially geocoded points to identify nearby TIGER road 

segments, even those without address attributes. This is a reasonable approach as 

there is likely to be service available within a few hundred feet of a current subscriber 

and it is a more realistic representation as we do not miss road segments due to lack 

of address attributes. See Data Processing Issues - Improving Road Segment 

Identification on Page 20. 
 

 We are using buffered middle mile points to improve the definition of broadband 

footprints in rural areas where geocoding rates are very low. See Data Processing 

Issues - Improving Rural Area Broadband Areas Section on Page 20. 

http://edrp.arid.arizona.edu/tribes.html
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Community Anchor Institutions (CAIs) without Building Numbers 
 

 Many western states may also face this issue and it would be useful for us to have an 

option which would allow us to include CAI features that have an accurate x, y coordinate 

and lack good address and building number data. A later section of this white paper 

recommends how x, y locations for CAIs that were developed through GPS or digitizing 

could be retained for inclusion for submission to FCC. See CAIs without Building Numbers 

Section on Page 25. 
 

Broadband Data Description 
 

For the State of Arizona broadband availability data set submitted to NTIA April 1, 2011, the 

summary of the data submission follows: 
 

BB_Service_CensusBlock - 274,391 Census 2000 polygons less than or equal to two 

square miles in area representing the service area of 36 broadband providers. Multiple 

instances of a census block polygon exist where a provider has two or more technology types 

in a block or multiple providers have service in that block. Only the fastest upload and 

download speeds in a census block are reported for a given provider and technology type. 

Some providers supplied a list of census blocks they serve, while others reported their 

service as a list of addresses or as a service polygon (KML or shapefile). Addresses were 

geocoded and then aggregated to Census blocks. Footprint geography was used to select 

the underlying census blocks using a ―centroid in‖ rule. 
 

BB_Service_RoadSegment - 91,890 TIGER 2009 road segments that fall inside Census 

2000 polygons greater than two square miles representing 26 broadband providers. Multiple 

instances of a road segment exist where a provider has two or more technology types on a 

segment or multiple providers have service on the segment. Only the fastest upload and 

download speeds on a segment are reported for a given provider and Technology type. The 

TIGER segments have all been clipped to fit entirely within a census block. The address 

ranges were not interpolated to accommodate any clipping. Some providers supplied a list of 

TIGER road segments they serve by TLID number, while others reported their service as a 

list of address ranges or as a service polygon (KML or shapefile). Address ranges were 

geocoded and then aggregated to Census blocks. Footprint geography was used to select 

the underlying road segments using a ―centroid in‖ rule. 
 

BB_Service_Wireless - 38 wireless service area polygons representing 31 broadband 

providers. Polygons fully or partially overlap where a single provider offers service over two or 

more technology types or spectrums or where multiple providers offer service in an area. 

Only the fastest upload and download speeds are reported for a given provider, spectrum 

and technology type. Some wireless broadband providers supplied a list of census blocks 

they serve, while others reported their service as a list of addresses or as a service polygon 

(KML or shapefile). Addresses were geocoded and then aggregated to Census blocks and 

census blocks were dissolved by technology and spectrum to create service area polygons. 
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Footprint geography was used to select the underlying census blocks using a ―centroid in‖ 

rule. In some cases, the wireless service area was ―reverse engineered‖ from publicly 

available data sources on tower locations, technology types and spectrum information. 
 

BB_Service_MiddleMile - 517 middle mile points representing 19 broadband providers. 

Middle mile points were generated from provider data from Lat/Long (converted to decimal) 

and from Addresses (converted to decimal) both directly from providers. Elevation attributes 

were added by overlaying on a statewide 10-meter Digital Elevation Model. 
 

Broadband Provider Participation 
 

Broadband Providers Included 
 

70 Total Providers (Some both Wireline and Wireless) 
 

37 Unique Wireline Providers (TechID‘s 10-50, Unique FRN‘s) 
 

31 Unique Wireless Providers (Tech ID‘s 60-80, Unique FRN‘s) 
 

4 Unique Providers, Middle Mile Only (Excluding GovNET) 
 

18 Total Middle Mile Providers (Excluding GovNET) 
 

35 unique providers have a census block features in this submittal 
 

They may have submitted just addresses and we converted 
 

They may have submitted census blocks directly 
 

We may have reversed engineered the service area where we selected census blocks 
 

0 providers submitted at the County level 
 

For the State of Arizona broadband availability data set submitted to NTIA on April 1, 2011, 

the summary of provider cooperation as contained in the datapackage.xls (including unique 

Broadband Providers, as well as those with multiple FRNs) was as follows: 
 

 

Provided Data 
Will Provide 

Data 
Will Not Provide 

Data 
Non-Responsive 

Provider 44 0 1 18 

Reseller 5 0 0 0 

Other 2 0 0 0 

N/A 0 0 0 0 

Total=70 51 0 1 18 
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Broadband Providers Identification Strategy 
 

The whole nature of the Arizona Broadband Assessment Project (AZ BAP) revolves around 

data collection from relevant Broadband Providers (BPs), thus the comprehensive 

identification of relevant BPs active in the Arizona market and definition and determination of 

relevancy are the key initial steps in constructing the universe of target BPs for subsequent 

engagement. Additionally, the market will be dynamic over time as BPs go out of business, 

merge, startup or otherwise transition requiring an ongoing strategy and actions for adding to 

and updating the relevant BP universe. 
 

Identify

Relevant

Broadband

Providers

FCC or PSC

Registered or

DOC Listed

Anecdotal

Knowledge

News Stories

and M&A

Community

Feedback

BP Feedback

External Indexes

to Broadband

Providers

AZ BAP Broadband Provider Engagement Process

Coop Entities &

Trade Associations

Create Wiki

Page & Add

to Index of

Providers

Determine

NDA &

Technical Points

of Contact

E-Mail

Communications

Package

Initial

Engagement

Campaign

Relevant

Update Wiki &

Index, Queue

for Follow Up

If Appropriate

Non-Relevant

BP Executes

NDA, State of 

Arizona & DSCI

Countersign

Request

Data Submittal

per Technical

Appendix

Receive

Data Submittal,

Intake &

Transform

No

Yes

Update Wiki

Contact(s)

& Index Page

Non-Relevant

Generate

QA/QC Form &

Verification

Process

Issue

BP Feedback

Package &

Portal Access

No Tech Impediments

Yes

Additional

Follow Up to

Determine &

Resolve Issues

Designate 

Non-Cooperative,

Possibly Escalate

to NTIA

Additional

Follow Up to

Determine &

Resolve Issues

Non-Coop

Escalation to

GITA

Fail

Additional BP

Follow Up to

Determine &

Resolve Issues

Pass

Reverse

Mapping &

Submittal to BP

for Approval

Negotiate

Custom NDA

with GITA

Involvement

Escalation to

GITA

Non-Coop

Yes
Submit Formatted

Data to NTIA

per Schedule

& Utilize for State

Policy as NeededNo

No

Yes

Source: Data Site Consortium 

Inc. (DSCI) 2011 (Rev. V01B)

Federal & IDInsight

Crowdsource

Data Review

Repetitive

Steps on

6 Month Cycle

6 Month Repeat

Legend:

 
 

The process began with reviewing and mining the Federal Communications Commission‘s 

(FCC) Universal Licensing System (ULS) for registered providers with FCC Registration 

Numbers (FRN), Arizona Corporation Commission (ACC) registered ILECs and CLECs, and 

Department of Commerce (DOC) listed telecom firms, as well as external indexes to 

broadband providers (e.g. - top Arizona ISP lists, web lists), extracting relevant details, 

contacts, and reference information. Additionally, membership in coop entities 

(carriers/providers that share infrastructure under a common name) and trade associations 

was reviewed to identify potential providers. The Contractor also acted as a collection point to 

mine team and external anecdotal knowledge of potential BPs, get references and 

intelligence from conversations with, and feedback from BPs, and continually monitor news, 

especially as it relates to merger and acquisition (M&A) activity. After these lists were 

assembled, the identified providers were analyzed to determine which are relevant BPs. 
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DSCI, along with GITA, has periodically reexamined the above sources. Additionally, DSCI 

has reviewed federal and IDInsight crowdsource data, converting and analyzing IP addresses 

as necessary, to identify previously unknown BPs. 
 

DSCI has continued on with selected non-relevant resellers which are capable of providing 

data that can be utilized for verification purposes through their use of a relevant BP‘s 

infrastructure or otherwise have unique middle mile infrastructure or other telecom assets of 

interest to the State. 
 

Over time, DSCI will retire (deem non-relevant) BPs who merge into other named entities or 

go out of business, tracking and documenting the non-relevant providers to provide a 

reference source as to who they are and how the non-relevancy determination was made, as 

well as document the consideration of the widest practical range of potential BPs for the 

project‘s purposes, providing a reference source for team knowledge capture and reference. 
 

Broadband Providers Engagement Strategy 
 

First for relevant Broadband Providers, the appropriate NDA engagement and follow on 

technical contacts need be identified. If a relevant BP has a FCC FRN listing, we extract the 

FRN listed contact and contact vectors as the starting point. If DSCI or GITA team members 

are already familiar with a BP‘s Arizona responsible personnel, we capture and document 

that contact information. Of course, the BP‘s website, business registrations, and other 

common sources are used as needed. 
 

Then DSCI calls the identified contact person(s), provides a brief overview of the project, and 

determines if they would be the appropriate party to engage in NDA consideration, 

negotiation, and approval, or data transfer activities (it is recognized that many companies 

will want to address the NDA before identifying a data contact person). If so, DSCI will 

document the conversation and information obtained to the wiki and proceed to the next step 

providing an E-Mail Communications Package. 
 

If not, the contractor will solicit name(s) and contact info of the appropriate NDA authorized 

parties. If the above process doesn‘t yield needed NDA authorized contact, the contractor will 

research the company website and other sources to identify other possible parties, follow the 

path/chain to determine and reach the appropriate NDA authorized contact, and escalate to 

GITA for assistance if appropriate contact cannot be determined. 
 

During exchanges with a BP‘s appropriate NDA contact, the contractor will solicit name(s) 

and contact info of relevant Technical point of contact for data ask and submittal facilitation 

when appropriate. DSCI offers and describes cooperative technical assistance that could be 

provided in response to specific questions or expressions of concern as to the complexity or 

difficulty of complying with the request for data. DSCI then enters all gathered information 

and a brief log of activities, progress, and issues to the wiki. 
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The E-Mail Communications Package was developed as a collaborative effort between DSCI, 

GITA, and ASLD. It is organized into a cover letter under the signature of the GITA Director 

(State of Arizona CIO), followed by a more detailed and specific letter from DSCI, a copy of 

the standard project NDA, and an Arizona Broadband Provider Technical Appendix (See 

Appendix A). The two letters give the project explanation, value proposition, and call to action 

with the NDA and Technical Appendix yielding expanded and supporting documentation. 
 

DSCI has developed a standard cover e-mail template which is adapted as needed (perhaps 

based on elements from previous conversations) to comprise the body of the cover e-mail for 

transmittal of the E-Mail Communications Package. DSCI then fields any initial e-mail, letter, 

phone, or in-person responses or questions from the provider and moves to the Initial 

Engagement Campaign. 
 

DSCI then telephones the appropriate NDA contact to ensure receipt of the cover e-mail and 

Communications Package, as well as field any initial response or questions, inquire as to 

general receptiveness to NDA and anticipated internal process for review and execution, note 

on the provider‘s wiki page any suggested/committed timeframe(s) for anticipated BP 

response or requested follow up by them, e-mail and/or call periodically consistent with above 

item and project timeframes to keep on BPs ―radar‖ and attempt to keep the process moving 

forward. Again, if the process stalls out at any level, DSCI notifies the Arizona project team 

members and asks for advice and/or assistance. 
 

DSCI directly notifies Contractor project leaders if any specific objections or issues are noted 

by a BP and escalates if the response to those objections or issues requires specialized 

domain knowledge or decisions from a ―higher authority.‖ If there are questions on the NDA 

content or an expressed desire to modify or negotiate the NDA, DSCI escalates to DSCI‘s 

NDA negotiating parties. If the BP proves unresponsive or reluctant over a period of time, 

DSCI notifies the Arizona project team members and asks for advice and/or assistance to 

escalate and follow up. 
 

If the BP indicates a willingness to execute the standard NDA, the data gatherer solicits its 

signature and forwards the signed document to the DSCI‘s legal advisor who in turn forwards 

it to GITA for counter signature. If the BP has questions on the NDA content or an expressed 

desire to modify or negotiate the NDA, the data gatherer escalates to the NDA negotiating 

parties on the DSCI team. The team‘s legal advisor determines the nature of BP questions, 

concerns, and/or issues and seeks to address them within the context of the standard NDA. If 

deemed necessary, the team‘s legal advisor works with the State and BP to reach a mutually 

agreeable modified NDA and proceeds to manage its execution. 
 

Upon conclusion of review and/or negotiations for modification, the DSCI‘s legal advisor 

receives the BP executed standard or modified NDA, provides it to the State for counter 

signature, counter signs on behalf of DSCI, and provides the fully executed version back to 

the BP and GITA, posts a copy to the wiki (notated on the provider‘s wiki page), and updates 

the Index to Providers status page. 
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If the BP seems unable to meet the technical appendix requirements for data submittal, DSCI 

qualifies the apparent difficulties, as well as explores and negotiates cooperative technical 

assistance that could be provided by DSCI in response to issues in complying with the 

request for data. If the BP is only willing/able to submit FCC Form 477 data, lists of facilities, 

raw coverage maps, or other relevant but insufficient data for a full federal submittal, the 

contractor with knowledge and agreement of GITA will offer a reverse mapping option 

whereby available data sources will be mapped to estimated coverage by census blocks and 

delivery speed(s) consistent with the BP‘s technology, presented back to the BP for 

confirmation or feedback leading to iterative adjustments, and resulting in a ―best guess‖ for 

their current delivery footprint. 
 

Non-Disclosure Agreements (NDA) 
 

NDA Overview 
 

Some of the Arizona providers opted-out of the non-disclosure agreement (―NDA‖) process. 

However, the vast majority of the providers chose to participate, by negotiating and signing a 

NDA. Of the providers that chose to opt-out, they fall into two groupings. A first group 

consists of providers that were not sufficiently concerned with misuse of their data to be 

motivated to execute a NDA. All providers within this group provided data as required for the 

submittals to date. A second group consisted of providers that chose to largely boycott the 

mapping process. Members of the second group generally have not provided data. However, 

we have been successful in interfacing with the majority of these providers via our reverse 

mapping processes wherein we obtain relevant data from third parties and present the data 

to each provider for discussion and corrections (see other portions of this report for more 

details regarding reverse mapping). 
 

Confidential Data 
 

The Federal Program Definition of ―Confidential Data,‖ as pertains to Notice of Funds 

Availability (NOFA) NDAs with Broadband Providers, was originally sourced from the 

Mapping NOFA provided in the Federal Registry on July 8, 2009. This definition was 

subsequently clarified, as it pertains to NDA‘s between ―service providers and awardees‖ in 

the BDIA. BDIA §§106(c)(3) and 106(h)(2), 122 Stat. at 4101-2 requirements apply only to 

information submitted by the FCC or a broadband provider to carry out the provisions of the 

BDIA and shall not otherwise limit or affect the rules governing public disclosure of 

information collected by any federal or state entity under any other federal or state law or 

regulation. 
 

Further, the BDIA directed that ―as a condition of grant funding under this Program, awardees 

may not agree to a more restrictive definition of Confidential Information than the definition 

adopted by this Program.‖ Thus, the BDIA controlled conceptually all provider data that may 
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be considered confidential as between the service providers (―Providers‖) and awardees (the 

―States‖ and their agents). However, the BDIA allowed for lesser scopes of confidential data. 
 

General NDA Approach 
 

Because Arizona determined that it would utilize a contractor for the purposes of collecting 

and processing provider mapping data, necessarily the contractor would see and have at 

least temporary custody of the mapping data. Therefore, to be effective, the NDA must bind 

not only the State but also its agent, the contractor. As a result, the State evaluated 

alternatives by which it could efficiently process NDAs that would bind the provider, the State, 

and its agent. The State considered a dual NDA approach, wherein it and the provider signed 

a first NDA, and it and its agent signed a second (mirror) NDA. Though effective in legally 

binding all three parties, this approach received push-back from the provider community and 

portions of the internal reviewing staff at the State. Thus, a second approach was coined in 

which a single 3-way NDA was devised. Under this approach all three signatories signed 

each NDA. The State used this approach as the Arizona Baseline NDA excepting incumbent 

local exchange carriers. 
 

The Arizona Baseline NDA 
 

The Arizona Baseline NDA was drafted for sharing Confidential Information in an 

advantageous manner for both the provider and the State. This Baseline NDA is an 

agreement wherein the provider (―discloser of the information‖) achieves specified safeguards 

and the State (―receiver of the information‖) is allowed specific uses of the information for a 

specified period of two years. Together the discloser and receiver are known as the parties. 

Both the safeguards and the specific uses are framed within a consistent set of duties and 

obligations to which the parties mutually agree as follows: 
 

 

1. Definition of the parties and their respective objectives (these are whereas 

statements). The Baseline NDA was construed between a disclosing party and a 

recipient party, wherein the disclosing party may be an owner of the Confidential 

Information or merely may have a present right-of-use of the information. 
 

2. Definition of the confidential information. Herein, the parties negotiated what 

information is confidential-within the context of the NOFA/BDIA definition. This 

negotiation generally strikes a reasonable compromise between the information 

discloser wants for broad inclusive language and the recipient‘s desired narrow and 

specific language. The definition was constructed as general categories of Confidential 

Information followed by specific instances within those categories. 
 

3. Exceptions to confidential information. Exceptions, described both as general 

categories and specific instances, were negotiated in an effort to adequately 

characterize the confidential information. 
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4. Ownership of the confidential information. The Confidential Information provided by 

a disclosing party was not always owned by that party, but was rightfully possessed 

under an existing license or similar right-of-use of the information. Thus, provisions 

were included for this limitation, in which appropriate descriptions and indemnities 

were devised, and notice was provided to the underlying property owner associated 

with the confidential information. 
 

5. Definition of obligations of confidentiality. Obligations of confidentiality focused to 

acceptable use and unacceptable misuse of the Confidential Information by the 

recipient. Such obligations also covered secondary disclosures by the agent of the 

recipient with appropriate need-to-know requirements and recordkeeping. 
 

6. Exceptions to the obligations of confidentiality. Confidential Information by its 

nature must be confidential to someone or in some respect. Once the Confidential 

Information loses its confidential nature, it generally becomes freely available to all 

comers. Because information that is initially thought to be confidential may not be so, 

the NDA also delineated such exceptions. Thus, the NDA listed specific means under 

which disclosed information is not deemed confidential, such as the Confidential 

Information becoming publicly known by acts of others or discovered by the recipient 

by other means. 
 

7. Definition of what constitutes breach of the agreement. Gravamen of breach of the 

NDA centers on intentional and unintentional disclosure of the information within the 

established term of the agreement. Related considerations included the materiality of a 

disclosure and whether it as volitional. It was important that the types of breach were 

identified in detail. Again, as with the definition of Confidential Information, it was 

helpful to also specify instances that do not constitute breach. 
 

8. Agreement of available remedies for each type of breach. Generally, all breaches 

might require that the breaching party immediately notices the disclosing party of such 

breach. The NDA provided for such notice, should a breach occur, that provided 

sufficient time for the disclosing party to intervene for protecting its rights to the 

confidential information where possible. Further, it was appropriate that the recipient 

agree that certain breaches equate to irreparable harm to the disclosing party, giving 

the disclosing party injunctive rights. 
 

9. Term of the agreement. A term generally entails defining a period required for the 

parties to effectively disclose and utilize the information. Here, the NDA term is 2-

years. At the end of the term, and with a potential extension, the recipient must either 

return or destroy all confidential data and provide an affidavit to the disclosing party 

that it returned or destroyed the information. We anticipate that a second 3-year term 

will be negotiated during which the parties will agree to maintain confidentiality of the 

information. 
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10. Miscellaneous issues. These issues include agreed to law, integration, assignment 

rights, notice addresses, dispute resolution means, and the like.  
 

Qwest and Arizona Local Exchange Carrier Association (ALECA) NDA Variants 
 

When the Contractor initially interfaced with Qwest Communications, one of the Arizona local 

exchange carriers, the Qwest legal department had already formulated an NDA that was to 

their liking and which they desired to make the sole NDA under which they would provide 

mapping data to all states. The Qwest NDA was a two party NDA. In subsequent 

negotiations, each organization attempted to maintain its particular NDA format and content. 

However, as negotiations continued, it became obvious that give-and-take was required. The 

grand compromise largely involved Qwest relenting on its definition of what constituted 

Confidential Data to the NOFA/BDIA definition; and Arizona consented to Qwest‘s 2-party 

NDA framework. Also, in order to bind Arizona‘s agent (Contractor) a second mirror image 

NDA was signed by Qwest and the Contractor. 
 

Once the Qwest NDA was fully executed, conversations with the other Arizona local 

exchange carriers which had been held in abeyance were accelerated. Ultimately, all the 

Arizona local exchange carriers followed through with the dual NDA approach, based on the 

Qwest language, wherein it and each of the other local exchange providers signed a first 

NDA with the State and then signed a second NDA with the State‘s agent, the Contractor. 
 

Wireless Carrier NDA Variant 
 

The wireless carriers, led by Sprint-Nextel, had also developed their standard NDA prior to 

the Arizona NDA team approaching them for securing a mutual NDA. Subsequent 

negotiations resulted in Arizona standardizing on a hybrid between its Baseline NDA and the 

wireless carriers‘ standard NDA. This NDA contained all the elements of the Arizona baseline 

NDA, but with modified wording. It also added specific language allowing the provider a right 

to enjoin wrongful disclosure of its Confidential Data. 
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Data Collection and Integration 
 

Primary Data Collection 
 

Overview 
 

The State‘s contractor Data Site Consortium Inc. (DSCI) solicits and receives the BP data 

submittals, doing intake processing and usability crosschecks. DSCI‘s GIS subcontractor 

TerraSystems Southwest (TSSW) transforms the data to prepare it for federal submittal, 

documents the technical steps performed during that preparation for quality assurance and 

BP feedback, leads the team in collaborative data verification sessions, as well as supports 

further State use of the data in mapping and policy processes. 
 

Reverse Mapping Role & Processes 
 

The use of reverse mapping was key to depicting broadband coverage for: Broadband 

Providers unable to supply coverage area information; Broadband Providers with incomplete 

coverage area information; and Non-responsive Broadband Providers. Regardless of the 

scenario, DSCI and TSSW employed a number of logical methods to derive ―where and 

which‖ broadband services a Broadband Provider likely had available. 
 

Some of the key elements used to initiate reverse mapping included: 

 

 FCC Form 477 data, though dissolving census blocks greater than 2 square miles into 

applicable road segments required special techniques and attention 

 Central Office (CO)/Digital Subscriber Line Access Multiplexer (DSLAM) location 

(wireline) - used in conjunction with distance buffers to best determine "where" outside 

plant infrastructure would reside. We used multiple public information sources to 

discover CO and DSLAM locations. 

 Tower location (wireless) - used propagation models to determine "coverage/reach" 

based on services provided (frequencies, lat/long, terrain). We used an ―E-coverage‖ 

tool from Wireless Applications Corp as well as ―Radio Mobile‘s‖ radio frequency 

coverage tools. 

 Service Book/Offerings - usually determined through publicly available information 

(technology of transmission, speeds, etc.). 

 Tribal boundary information (From FCC) - GIS shapefile used to determine Tribal 

boundaries and census blocks/road segments contained therein. 

 Public Information Sources - from various sources including BPs‘ own websites to 

provide a "picture" of their network, services, and coverage. 
 

Such reverse map estimations of the BP‘s coverage and technology were then presented 

back to the BP for confirmation or feedback leading to iterative adjustments, sometimes via 

collaborative online viewing sessions, and resulting in a ―best guess‖ for their current delivery 
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footprint. BPs without current GIS capabilities were frequently impressed with our techniques 

and interested in internally and externally using the reverse mapping outputs. 
 

Native American Mapping Efforts Going Forward 
 

Arizona is home to 21 federally recognized Tribes and over 250,000 Native Americans 

(http://edrp.arid.arizona.edu/tribes.html). In many cases, mapping of these Tribal Lands is 

covered when we map the underlying Incumbent Local Exchange Carriers (ILECs), cable 

companies, and other broadband providers that serve those areas. Six providers are Native 

American owned and controlled, serving both on- and off-Indian Land areas. Of these 

providers, Hopi Telecommunications Inc. (HTI), the Tohono O‘odham Nation, and Fort 

Mojave Nation have provided mapping data or directly supported reverse mapping efforts, 

are fully cooperative, and we anticipate will continue providing semiannual updates of their 

data. Gila River Telecom Inc. (GRTI), San Carlos Apache Telcom Utility, Inc. (SCATUI), and 

Saddleback Communications (Salt River Pima-Maricopa Indian Community) have not been 

initial-providers of data. Thus, we have reverse mapped these three providers. However, we 

have not obtained meaningful feedback of our mapped data directly from these three 

providers. But, we have leveraged Federal Communications Commission filings and 

crowdsourcing data, as well as like-kind public-data sources for purposes of confirming our 

reverse mappings. See Appendix C - Arizona Broadband Provider Case Studies.  
 

Project WIKI Role 
 

The AZ BAP wiki serves as a collaborative platform and shared workspace under PBWorks 

utilized by all project personnel to capture and track relevant knowledge and project 

deliverables through the entire project lifecycle. Its purpose is to capture knowledge on a near 

real-time basis, organize such knowledge in an accessible manner, inform participants as 

needed, and codify project deliverables, process, and incremental activities for 

documentation and tracking purposes. 
 

Toward that end the wiki includes an Index to Providers page that lists all in-play Providers 

for a given submittal. The Index contains progress status information for each submittal. It 

includes links to (1) the associated Broadband Provider (BP) page that contains relatively 

persistent data and to (2) the more dynamic Quality Assurance/Quality Control (QA/QC) page 

for each BP. The QA/QC page summarizes the data submitted by a given BP for a given 

submittal cycle. The Index to Providers page is refreshed for each six-month period, and 

providers who are no longer in play (due to mergers, acquisitions et al.) are moved to a 

separate ―holding‖ page, called the Not-in-play Providers page, from which they can be 

resurrected should they become active providers at a later date. Copies of the Index to 

Provider pages, the Not-in-play Providers page and the QA/QC pages are saved in the 

Historical Documents folder after each round of data submittals. 
 

The BP page contains semi-persistent data including the DBA Name, the FRN, the contact 

person, a link to the signed NDA if one exists, and usually a link to the BP‘s website. 

http://edrp.arid.arizona.edu/tribes.html
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Comments are used with all wiki BP pages to record interactions between DSCI personnel 

and the BP. The Comments are saved as part of the monthly Backup/Export procedures. 
 

Definition of Unserved and Underserved Communities 
 

Following the Rural Telecommunications Congress (RTC) conference in Mesa in November 
2010, we discussed the definitions of underserved and unserved areas (ignoring satellite 
coverage). Relying on input from former FCC Commissioner Rachelle Chong we tentatively 
agreed to the following definitions: 
 

 Unserved is defined to be an area where there is no Broadband Provider offering a 
minimum of 3 Mbps down and 1 Mbps up. 
 

 Underserved is defined to be an area where there is at least one Broadband Provider 
offering a minimum of 3 Mbps down but there is no Broadband Provider offering a 
minimum of 5 Mbps down and 1 Mbps up.  
 

The FCC target for ubiquitous broadband coverage has been 4 Mbps down and 1 Mbps up. 

Arizona policy makers and stakeholders plan to use a working definition for underserved and 

unserved areas that will resemble the above specifications, but remains subject to change 

going forward.  
 

Standardized BP Naming Conventions 
 

We have developed a standardized BP naming convention for our use in Arizona. Since 

provider names vary considerably depending on the context (e.g., Holding Company names, 

DBA names, abbreviated names, truncated name portions, et al.) we decided to create a list 

of relatively short definitive names that would be familiar to the general public for each BP. In 

a few cases where two names are frequently used, such as T-Mobile and Deutsche Telekom, 

we have opted to use both, placing one name in parentheses. Wherever possible we have 

associated the standardized name with the FRN associated with the latest data set submittal 

from the given BP. We are using the standardized names in the Index to Providers page and 

in the interactive Arizona Broadband Map as ASLD has incorporated these names to the 

State map implementation. 
 

Data Processing Approaches 
 

Census Block: Sources of census block submittals have been either lists or shapefiles of 

addresses passed or served or lists of 2000 census blocks served. 
 

Address lists are geocoded against an ESRI composite address locator using the latest 

available Navteq road centerline file as a primary reference data set with TIGER 2009 as the 

secondary source. Address points falling in census blocks less than or equal to two square 

miles are summarized by census block identifier. One summary table for each technology 

type is created with one record per census block containing only the fastest reported speeds 

in each of the four speed fields (maximum advertised or typical up and down speeds). 
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Road Segment: Sources of road segment submittals have been either lists or shapefiles of 

addresses passed or served, lists of census blocks, or lists of TIGER 2009 road segments 

(by TLID number). 
 

For address lists or shapefiles, an Esri Near analysis is performed on the address points 

falling in census blocks greater than or equal to two square miles. This analysis provides a 

list of the TIGER 2009 segment ID‘s nearest to each address point within a maximum search 

radius of 225‘. The list of TIGER segment ID‘s is summarized by each technology type, 

keeping only the fastest reported upload and download speeds for each segment. The 

TIGER segments are intersected with dissolved polygons representing census blocks greater 

than two square miles, thereby clipping the extent of these segments to the boundary of the 

census block areas.  
 

For lists or shapefiles of census blocks, the blocks greater than or equal to two square miles 

are used to spatially select the underlying TIGER road segments using a ―centroid in‖ 

selection rule. The road segments inherit the technology and speed attributes of the 

overlaying census blocks.  
 

For lists of TIGER line ID‘s, these lists are summarized by technology type, keeping only the 

fastest upload and download speed for each segment and then joined to the TIGER line file 

to extract the geometry and attributes of those segments. 
 

Wireless Polygons: Sources of wireless service area are either lists of addresses served, 

lists of census tract (477 data) or blocks served, or a shapefile or KML file of estimated 

service area boundaries. In some cases, the DSCI team generated these service areas by 

feeding tower locations and various technology and spectrum attributes into an RF 

propagation program. 
 

Middle Mile: Wireline Middle Mile points were generated from provider data from Lat/Long 

and from addresses both directly from providers. Wireless Middle Mile points were derived 

from lat/long coordinates from the provider, through a commercial database from Wireless 

Applications Corp., or from public information. Ownership and backhaul type was derived 

from a combination of public sources and provider information. In either instance, information 

was converted to decimal latitude/longitude coordinates. Elevation attributes were added by 

overlaying on a statewide 10-meter Digital Elevation Model. Census block attributes 

(FULLFIPSID) were added through an overlay process. 
 

Data Processing Issues 
 

Improving Address, Census and Road Segment: TIGER roads are the source of geometry 

for our road segment submittal. TIGER files have a large number of records with no address 

element information, especially in rural areas. For the Spring 2011 delivery we added local 

streets in Cochise County to help improve low match rates from a particular provider in that 

area. In the future we will be transitioning to more local geocoding references (streets and 
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parcels) as they become available. From these local sources we can not only geocode but 

also pull geometry into the NTIA deliverables. We are also working on an application that will 

parse and fix address elements that have obvious errors prior to geocoding. We may also 

use commercial geocoding services where we cannot find a match through other means. We 

do not plan to manually match provider addresses. 
 

Improving Road Segment Identification: For this delivery we have moved from identifying 

road segments strictly by geocoding to TIGER and instead are using geocoded points 

derived from both Navteq and TIGER reference data to find TIGER arcs within 225‘ of these 

points for inclusion in our deliverable. Using only TIGER, we often experience a very low 

geocoding rate and are therefore likely under-reporting broadband availability. Based on an 

analysis of our Fall 2010 technique against this new ―buffer‖ approach, we determined we 

would get an average of about 85% of geocoded points involved in the road selection 

process vs. 40-60% in many cases using only TIGER. One downside to this approach is that 

we likely include roads that are not actually in the Providers‘ databases, but we assume that if 

a road is within 225‘ of one that is serviced, there is a good chance that new road can be 

serviced as well. A second drawback is that we may be selecting road segments that fall in 

census blocks <= 2 square miles. We handle this by intersecting our road networks with 

census block areas > 2 square miles, leaving only the portions or entire road segments that 

fall in the larger census blocks. When we have obtained local, highly accurate and 

maintained road networks and we can get geocoding rates up into the mid 80‘s or higher, we 

will likely return to a geocoding approach for identifying road segments in the larger census 

blocks. 
 

Improving Rural Area Broadband Areas: For very rural areas where even the combined 

Navteq/TIGER geocoding rates are low, we have opted to use buffered middle mile points to 

identify census blocks in the service area. For example, we processed a list of DSLAM 

locations and service radii from the Frontier telecom group, buffered them by a provider-

declared radii distance of 15,000 feet and then selected census blocks that intersected. In the 

Fall 2010 delivery we obtained only a 2% match rate on the Frontier - Navajo Telecomm 

groups submittal and therefore did not include their service in that delivery. For the Spring 

2011 delivery, we used buffered DSLAM to identify census blocks and road segments which 

resulted in a significant increase in the census and road segment matches. In other Frontier 

areas, we kept Census Blocks that geocoded for the Fall 2010 delivery and added those 

census blocks that intersected a DSLAM buffer. We only kept road segments in Census 

Blocks greater than 2 square miles that intersected the DSLAM buffers, as review with local 

experts indicated this was a more reasonable depiction of where service actually was 

provided. 
 

Reporting Multiple Speeds by Census Block or Road Segment: We use a summarize 

function with speed fields set to MAX so that only the fastest up and down speed for any 

given census block or road segment for any given Provider and Technology is reported. For 



Arizona Broadband Assessment Project White Paper - Spring 2011                                Page 21 

example, a census block for a given Provider with three reported speeds (3,2, 3,3, 4,2) would 

get a 4,3 reported. 
 

Errata: 
 

 Provider Name: we get rid of all commas but leave in periods assuming a CSV export 

would be less useful if commas were left in. 
 

 For road segment data, we use a script that gives us the minimum and maximum 

address numbers across the four TIGER address number fields thereby meeting the 

NTIA requirement for these fields. 
 

Data Processing Automation Project 
 

For the September 2011 delivery, DSCI through GIS subcontractor TSSW is developing and 

testing a sophisticated data formatting and validation application that should improve the 

speed and accuracy of the numerous manual steps we now undertake to format and 

evaluate/fix anomalies in provider data submittals. 
 

Community Anchor Institutions (CAI) 
 

CAI Data Sources 
 

Data for the Community Anchor Institutions (CAIs) reside in many different locations 

throughout Arizona and were collected from data custodians and/or data integrators 

throughout the State. This effort has two major components, the identification and geo-

location of the CAI entities and the collection of data related to the status of their broadband 

usage. Both of these components have significant challenges for development and 

maintenance. The State does not currently have any centralized databases that could serve 

as a core basic backbone for CAI data development. Thus a sizeable data collection and 

standardization effort exists. The Arizona Broadband Mapping Project provides impetus for 

one of the first State efforts to consolidate CAI data into one database. 
 

A considerable effort in basic data development working with local government websites and 

one to one contacts has been required to address some basic aspects of the CAI data 

collection. Numerous organizations in Arizona maintain locational information regarding some 

categories of CAI data but these are all of varying formats and currency. In many cases the 

project has had to assist CAI location data custodians in the update of some aspects of the 

basic locational data. The Project also is, in most cases, the first time that CAI managers 

have developed information regarding the level of broadband services for their institutions. 

This poses a host of challenges regarding a large number of existing processes in many 

organizations. Some aspects of these challenges are described in the CAI challenges part of 

this paper. 
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CAI locational and broadband data (for some broadband data items in some categories) was 

collected from the following sources listed below. Each incoming data set is completely 

unique and locational information, addresses and their formats and coordinate locations and 

their formats varied widely. Contributions from the Arizona State Land Department listed 

below constituted both original data creation and supplemental work on certain categories of 

data. Along with these data sources several additional data sources, not listed here, are 

starting to be incorporated into the data set to complete certain categories of data for their 

basic locational information.  
 

Category 1: Public Schools (K - 12) 
 

Arizona Department of Environmental Quality (ADEQ) 

Victor Gass 

Email: Gass.Victor@azdeq.gov 

Phone: (602) 771-4517 
 

State Cartographers Office (SCO) 

Tim Colman 

Email: Tcolman@land.az.gov 

Phone: (602) 542-3249 
 

Arizona Counter Terrorism Information Center (AcTIC) 

Sharon Nicholson 

Email: Snicholson@azdps.gov 

Phone: (602) 644-5830 
 

Arizona Department of Education (ADOE) 

John Eickman 

Email: John.Eickman@azed.gov 
 

Category 2: Libraries 
 

Arizona Counter Terrorism Information Center (AcTIC) 

Sharon Nicholson 

Email: Snicholson@azdps.gov 

Phone: (602) 644-5830 
 

Arizona State Land Department (ASLD) 

Anthony Maslowicz 

Email: amaslowicz@land.az.gov 

Phone: (602) 542-2606 
 

Libraries Consultant 

Malavika Muralidharam 

Email: mala@lib.az.us 

mailto:Gass.Victor@azdeq.gov
mailto:Tcolman@land.az.gov
mailto:Snicholson@azdps.gov
mailto:John.Eickman@azed.gov
mailto:Snicholson@azdps.gov
mailto:amaslowicz@land.az.gov
mailto:mala@lib.az.us
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Phone: (602) 926-3601 
 

Category 3: Medical/Healthcare 
 

Arizona Department of Health Services (ADHS) 

Angela Wills 

Email: WillsA@azdhs.gov 

Phone: (602) 364-0462 
 

Arizona Counter Terrorism Information Center (AcTIC) 

Sharon Nicholson 

Email: Snicholson@azdps.gov 

Phone: (602) 644-5830 
 

Category 4: Public Safety 
 

Arizona State Land Department (ASLD) 

Anthony Maslowicz 

Email: amaslowicz@land.az.gov 

Phone: (602) 542-2606 
 

Arizona Counter Terrorism Information Center (AcTIC) 

Sharon Nicholson 

Email: Snicholson@azdps.gov 

Phone: (602) 644-5830 
 

Category 5: Universities, Colleges and Post-Secondary 
 

Arizona Department of Environmental Quality (ADEQ) 

Victor Gass 

Email: Gass.Victor@azdeq.gov 

Phone: (602) 771-4517 
 

Category 6: Other Government Buildings 
 

Arizona State Land Department (ASLD) 

Anthony Maslowicz 

Email: amaslowicz@land.az.gov 

Phone: (602) 542-2606 
 

Arizona Counter Terrorism Information Center (AcTIC) 

Sharon Nicholson 

Email: Snicholson@azdps.gov 

Phone: (602) 644-5830 

mailto:WillsA@azdhs.gov
mailto:Snicholson@azdps.gov
mailto:amaslowicz@land.az.gov
mailto:Snicholson@azdps.gov
mailto:Gass.Victor@azdeq.gov
mailto:amaslowicz@land.az.gov
mailto:Snicholson@azdps.gov
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Arizona Department of Health Services (ADHS) 

Angela Wills 

Email: WillsA@azdhs.gov 

Phone: (602) 364-0462 
 

Category 7: Other Non-Government Buildings 
 

Arizona State Land Department (ASLD) 

Anthony Maslowicz 

Email: amaslowicz@land.az.gov 

Phone: (602) 542-2606 
 

Arizona Department of Health Services (ADHS) 

Angela Wills 

Email: WillsA@azdhs.gov 

Phone: (602) 364-0462 
 

CAI Process Steps 
 

After the data was collected from multiple sources listed above it was processed with the goal 

of populating the CAI Feature Class within a Geodatabase constructed for delivery to NTIA. 

The NTIA geodatabase specifications were utilized for the target geodatabase which was to 

receive the CAI data and to be transferred to NTIA. In our initial approach incoming data sets 

of various formats were processed into Esri shapefiles for the various CAI categories and 

then loaded in the CAI feature class of geodatabase. Data were received from sources as 

either Excel files or ASCII text files of address locations or as Esri shapefiles which already 

had the locations as X,Y points and usually also contained some form of street addressing as 

well. The formats of all of these incoming files were different. 
 

In general a set of processing steps was applied to the data to eventually convert it into an 

Esri shapefile that was loaded into the final geodatabase. The steps listed below were utilized 

in the processing of Excel and ASCII text files. For incoming shapefiles step one does not 

apply and step four was not necessary. Some datum and projection transformations were 

also performed on the shapefiles to standardize those formats.  

mailto:WillsA@azdhs.gov
mailto:amaslowicz@land.az.gov
mailto:WillsA@azdhs.gov
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General CAI Data Processing Steps 
 

1. Excel Tables or ASCII text files containing names and addresses of Community 

Anchors were obtained from various sources. 
 

2. The data were then brought into Microsoft Access and the ADDRESS field(s) were 

parsed into BLDGNBR, PREDIR, STREETNAME, STREETTYPE, SUFFDIR, CITY 

and ZIP5. Data were then exported out as .dbf files for additional processing 
 

3. The STATECODE field was added with the value set to AZ in ARCGIS as was 

subsequent processing. 
 

4. The Esri Geocoding Software Tool was used to generate WGS84 Latitude/Longitude 

Coordinates in Decimal Degrees using the parsed Address Fields. 
 

5. The resulting file, with (X, Y) data points was converted to a shapefile in Geographic 

Coordinates using Datum WGS84. 
 

6. The resulting shapefile with Point Data was overlaid on the 2010 TIGER/Line Census 

Block shapefile in order to extract the FULLFIPSID information. 
 

7. The CAICAT field was added to enable the data to be sorted based on the 7 

Community Anchor Categories. 
 

8. A unique CAIID value was assigned to each Community Anchor record. 
 

9. The following Broadband attributes were added: BBSERVICE, PublicWiFi, 

TRANSTECH, MAXADDOWN, MAXADUP. 
 

10. This resulted in a set of formatted shapefiles for the various CAI categories which were 

then loaded into the CAI feature class of the geodatabase. 
 

CAI Issues 
 

CAIs without Building Numbers: We had to drop a significant number of CAI data points for 

our April 2011 submission. These data points were located in Rural Areas where they did not 

have an address or Building Number. It is not unusual to have Rural Addresses that lack this 

information. In very rural areas of Arizona, which are often the areas which would most 

benefit from improved broadband services, locations are given by how many feet from an 

intersection or how close a building is to a known landmark (for instance, fire stations are 

notated as ―…four hundred feet from the intersection next to the billboard sign.‖ We often had 

a valid Lat/Long coordinate pair that was not derived from address geocoding. Many CAIs are 

located by heads up digitizing from digital orthophotos or locating by field GPS units. Based 

on the Lat/Long coordinates, rather than an accurate or valid address, we obtained a point on 

the map that was spatially accurate and valid. This data was often provided by state agencies 

that were required to locate offices for their programs. They did not have good address data 
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and sent out staff to GPS the location of required offices. Unfortunately, we had to drop these 

CAIs, which had accurate x, y coordinates, from our submission, because they failed the 

Python QA Script check. Currently, the QA Script flags all records that do not have a Building 

Number as "failed". Arizona is not just rural, but in some places, still frontier. Many western 

states may also face this issue and it would be useful for us to have an option which would 

allow us to include CAI features that have an accurate x, y coordinate and lack good address 

and building number data. One option may be to add a data field that identifies x, y locations 

that were developed through GPS or digitizing and should be retained. These data would 

then still be able to be submitted to FCC and appear on maps and be available for spatial 

analysis and planning for broadband development. 
 

Broadband Provider Requests for CAI Information: All Broadband Providers on State 

contract for telecom services and others known or suspected to be providing broadband 

services to CAIs were sent a request letter and associated spreadsheet to enter data on the 

identified CAIs that they serve. None responded, however future plans include requiring 

those on State contract for telecom services to do so as part of their contract obligations and 

expectations. 
 

Managing the Diversity of CAI Data: We are well on the way to having a good database of 

Arizona CAI locations, but need to deal with additional complexities related to developing 

data for the level of broadband service provided to the CAI locations in our database. We are 

putting together a State work group and are conducting outreach to those CAIs that have 

state agencies to act as data custodians for location and we can communicate and 

coordinate with those data custodians to develop methods for those institutions to self report 

their level of broadband services. In many cases, the databases and maps we are developing 

as part of the AZ Broadband Mapping Project provide incentive for agencies or data 

custodians to obtain information about their facilities. It is much harder to obtain broadband 

service levels from local government agencies due to the distributed nature of their managing 

agencies. 
 

To that end, ASLD has done substantial outreach to local government agencies, throughout 

the state, and has created a comprehensive listing of local government facilities. ASLD has 

been developing a master database and data structure for these local government CAI 

facilities as well as for all other CAI categories. This will help us populate both location and 

broadband service levels, and more readily provide this data to NTIA, as the data becomes 

available to us from data custodians or integrators. A critical benefit of this approach is that 

feature level metadata can be added and fields for controlling data status currency and 

sources can be added. These will be critical in managing large amounts of incoming and 

diverse data and staging the data for update provision and updates of the Arizona Broadband 

Maps community anchor layer. Appendix B shows our initial data structure for the CAI 

management database. The structure is expected to change some as we gain more 

experience with its use and operations.  
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Project Data Flow and Security 
 

Data Site Consortium Inc. (DSCI) provides a secure web browser-based portal supporting the 

Arizona Broadband Mapping Project for use by DSCI personnel, GIS subcontractor 

TerraSystems Southwest (TSSW), the Arizona State Land Department (ASLD), the 

Government Information Technology Agency (GITA), and participating Broadband Providers 

(BP). To submit data the BP user logs in to the portal on the server, which can only be 

accessed by a unique username and password. The BP may use any web browser (Internet 

Explorer, Firefox, Safari or Chrome) to access the portal. After a successful login, the BP can 

―drag and drop‖ files to the browser window for upload. The BP user account is deactivated 

after successful transfer. The data is stored on an encrypted device in a secure facility. After 

data transformation and data examination and correction, along with related processing, the 

data is made available for review and verification by the BP user. The BP user can access 

and review the transformed data (as formatted for federal submittal in GIS readable format) 

and derived data (such as maps in PDF and KML formats) prior to its delivery to NTIA as part 

of DSCI‘s BP feedback process and for verification tasks. 
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Validation 
 

Validation Overview 
 

Receipt of Broadband Provider data sets by DSCI in response to an active submittal request 

or via the private portal as a preferred direct means triggers DSCI staff to perform a ―first 

touch‖ analysis consisting of inspection of the data set(s), noting of specific technical 

characteristics, and determination of whether the data is sufficiently present and formatted for 

subsequent processing. If so, this is noted on the provider wiki page and the responsible 

DSCI staff member records meta information pertaining to the data submittal on the QA/QC 

wiki form for the data submittal. The data set then is processed as necessary to be compliant 

with federal data format requirements, and loaded into the data repository. The received data 

is then scheduled for review in a collaborative verification session with appropriate parties. 

The collaborative verification session identifies any data quality issues and assignments for 

additional verification activities and note anomalies, observations, and planned remedial 

actions to the wiki.  
 

DSCI and TSSW staff reviews all BP data sets in a collaborative real-time shared view 

environment to verify and further qualify the submitted data. Collaborative verification 

sessions look specifically for spatial and technical logic issues present in provider 

submissions as detailed in Appendix D. Additional resources are employed such as 

community anchor institution data, licensed databases, lists of COs and DSLAMs, federal 

and state crowd-sourced data, field verification testing, etc. If the team identifies any 

significant perceived anomalies in coverage and speed, generates appropriate notes and 

documentation, then seeks to resolve by providing feedback to BPs to explain or correct the 

data submittal for the current round or in subsequent rounds. 

 

DSCI staff then prepares a brief Provider Technical Feedback Form for each BP data 

submittal distilling the content of the QA/QC form into a brief and more readable format for 

inclusion in the BP Feedback Package to be issued by GITA. Identified anomalies and issues 

are highlighted and the BP is engaged to consider and help correct them. 
 

Business Logic Rules 
 

Data is submitted in collections called data sets, data files and records. A data file is one 
particular file submitted by a provider (e.g. address-specific data file, census block data file, 
middle-mile data file, etc.) Data files correspond directly to a feature class (GIS) or table 
(SQL). A data set consists of all files submitted by a provider. This corresponds to a feature 
data set (GIS) or database (SQL). The top-down hierarchy is: Data set contains data files 
contains records.  
 
The attributes we validate immediately upon receipt of a data set are: currency of the data, 

evaluated by the date the BP specifies or the date received if the BP does not specify a date 

(the data is then assumed to be current); accuracy of the data, including both content 
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accuracy and spatial accuracy; cleanliness or edited quality of the data (e.g., misspellings, 

typos, transcription errors, missing field values); granularity of the data (e.g., street address, 

street or road segment, census block, census tract); data format (e.g., text file, shapefile, 

spreadsheet); and overall completeness (all BP customers are represented as opposed to a 

subset of customers). 
 

Confidence/Reliability Index Development 
 

As we collect broadband data from a variety of sources we need to assign some kind of 

indicator to the various data sets to indicate how reliable the data is. Such a reliability metric 

is sometimes referred to as our level of confidence in the data. Some other terms that are 

used to describe this metric are data quality and data validity. Another metric that is relevant 

refers to the value of the data. Data may be very reliable but still be of little value to us (e.g., it 

may be out of date). So we need to account for its value as well as its reliability.  
 

The ―Reliability‖ Index measures how reliable the data is (how well does it reflect the ―real‖ 
situation). It is derived mainly from the accuracy, cleanliness, completeness and format of the 
data.  
 

The ―Value‖ Index measures how valuable the data is to the project. The data might be very 
reliable, but it may be old and not very specific. While subjectively assigned, the ―Value‖ 
Index helps to prioritize processing and verification tasks. The ―Value‖ Index is derived from 
the currency, granularity, completeness and format of the data. 
 

Feedback Loop 
 

If DSCI‘s first touch data inspection detects submission issues (omissions, errors, structural 

inconsistencies) to an extent that would prevent subsequent processing and submittal, DSCI 

will designate the data as having a ―Not Passed‖ status and enter information describing the 

deficiencies onto the appropriate wiki pages. DSCI will then work with the provider to address 

the issues for the current submission and/or in subsequent submissions. 
 

In cases where technical issues present a barrier to a successful data submission by the BP, 

the DSCI team employs creative solutions that assist the BP in providing a data product that 

contains the minimum content necessary to transform the data to meet the minimum 

NTIA/FCC specifications. Such solutions include the provision of PDF or KML format maps of 

their service territory upon which providers can mark up their service area, speeds, and 

technologies, and spatial analysis of BP service areas based on the known operating 

characteristics and physical constraints of the technologies employed. 
 

If the DSCI and TSSW team identifies any significant perceived anomalies in coverage and 

speed, it generates appropriate notes and documentation, then seeks to resolve the 

anomalies by providing feedback to BPs to explain or correct the data submittal for the 

current round or in subsequent rounds. When possible such issues will be incorporated into 

the Provider Technical Feedback Form included with the feedback packet. Otherwise, 

identified issues are brought directly, via email, to provider data contacts by the contractor 
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team. GITA relies on the Contractor for the provision of broadband-specific technical 

information and logic that should be incorporated into the data review sessions. 

 

Statistical Models 
 

No statistical models are currently applied to compile and analyze the data.  
 

3rd Party Publicly Available Data 
 

FCC Form 477 Data: The FCC requires all facilities-based providers to submit a Form 477 

data which is then used to produce Local Telephone Competition and Broadband Data for 

analysis and reporting. The associated FCC Registration Number (FRN) is a key data 

identification and indexing element and the underlying data, though significantly limited in the 

desired broadband accuracy and granularity, has proved useful for identifying relevant 

Broadband Providers and as a starting point for some reverse mapping activities. 
 

American Roamer: DSCI licenses American Roamer data for Arizona from Esri which 

provides a substantial view of wireless voice and advanced services coverage patterns. The 

data set has proven of substantial use in cross checking mobile Broadband Providers‘ 

declared coverage and gaps. With the dynamic nature of the mobile industry and advancing 

3G and 4G deployments, American Roamer data will be licensed on an ongoing basis to 

support DSCI verification activities. 
 

Cable Boundaries/Media Maps: DSCI licenses Cable Boundaries data from Esri for Arizona 

for use as a primary verification source for cable wireline providers. It is based on information 

from MediaPrints developed by Direct Group and Warren Communications and updated 

quarterly. Cable Boundaries data provides current information about cable services by area 

and has data variables including primary ownership, subscribers, miles of plant, and digital 

capability. The data are available in a variety of geographies. Though initially useful in 

verification for comparing declared cable broadband coverage, it generally has proved to 

grossly overestimate the BPs broadband service territory and is a coarse tool of limited utility. 
 

TeleAtlas Central Offices & Wire Centers: DSCI licenses TeleAtlas Central Offices & Wire 

Centers from Esri for ILEC and CLEC base facilities identification. Such data is available from 

a variety of sources and tends to remain relatively constant over time. Also, since it doesn‘t 

capture Digital Subscriber Line Access Multiplexer (DSLAM) locations, it must be 

complemented by other means to be useful in verifying wireline LEC coverage and gaps. 
 

Wireless Applications, Corp. SiteSync: PowerSearch manages queries to multiple 

databases including FCC, FAA, licensed microwave, and tower companies to look for 

structures or towers placed in designated areas and often reveals the specific broadband 

providers collocating on those towers. eCoverage projects signal propagation and terrain 

coverage using high-resolution terrain data and Longley-Rice frequency calculations through 

an easy to use downlink coverage and contour generator with easily adjustable parameters 

like antenna, azimuth height, frequency, and power. 
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Federal Crowdsourced Data: The FCC offers an online Consumer Broadband Test 

(http://www.broadband.gov/qualitytest/about/) to give consumers additional information about 

the quality of their broadband connections and to create awareness about the importance of 

broadband quality in accessing content and services over the internet. The FCC 

complements the data collected from the Consumer Broadband Test with the submitted 

street address and other data, aggregating it to several monthly files grouped by State and 

available for secured download. DSCI processes the wireline and wireless results files, 

converting IP addresses to named Broadband Providers, and otherwise prepares the data for 

use in collaborative verification procedures. These data sets have proved extremely useful in 

confirming declared and/or estimated BP coverage and speeds, leading to detection of core 

data anomalies and issues that have largely been corrected with BP participation, thus 

yielding much more accurate and reliable data submittals. 
 

ID Insight Crowdsourced Data: DSCI licenses the BroadBand Scout database from ID 

Insight for all 15 Arizona counties. ID Insight uses proprietary analytic modeling, demographic 

data, and retail Internet order data that include physical and IP addresses, to detail consumer 

access types and transmission speeds keyed to geographic locations which contribute to our 

verification views of BP footprints and coverage gaps. To date, this data source has proved 

complementary to the FCC crowdsourced data and only contributed incremental knowledge 

and detection of data set anomalies in a limited number of cases. However, detailed review of 

IP addresses and BPs has led to the identification of several additional relevant BPs that 

have since been successfully engaged by DSCI. 

http://www.broadband.gov/qualitytest/about/
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Arizona Broadband Map 
 

Arizona Broadband Map Overview 
 

The Arizona Broadband Map (http://broadbandmap.az.gov/map) is an interactive mapping 

application designed for the end-user to find and list Broadband Service Providers at any 

location within Arizona. 
 

 
 

The application allows the end-user to enter a street address to zoom to a location and 

identify the Broadband Service Providers in the immediate vicinity.  

 

http://broadbandmap.az.gov/map
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Several data layers are available for the user to turn on to obtain visual displays of the 

locations of various types of Broadband Services (Fiber, DSL, T1/Tn, Cable, Fixed Wireless, 

and Mobile Wireless). Maximum advertised Broadband download speeds can also be shown 

on the map by various Speed Tiers of download speed. 
 

 
 

The application also allows the end-user to display related map layers like Community 

Anchor Institutions, City Boundaries, Land Ownership and Census Blocks less than 2 square 

miles that have some kind of Broadband Service. 
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Arizona Broadband Map Details 
 

The Arizona Broadband Mapping Application is built upon Esri‘s ArcGIS Server 10.1 

Technology. 
 

A light-weight Adobe Flash based browser application is used on the Client Side to view the 

Broadband Map Services served by the ArcGIS Application Server running on the Server 

Side. The Client Side Adobe Flash based browser is based on the Esri Flex Viewer Template 

2.2 that utilizes the ArcGIS API Library for Flex, designed and coded by Esri.  
 

The application contains 6 widgets to help the end-user locate an address, list the Broadband 

Providers, create Bookmarks, view and manage the map layers, identify the Community 

Anchors and print a hard copy. 
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A Help/About section is provided to include the Disclaimers, Privacy Policies, Information on 

the Map, Contact information and links to take a Speed Test. 
 

The Help/About section also includes an extensive Help component with a comprehensive 

Guided Tour to show the end-user how to use the application.  
 

http://broadbandmap.az.gov/about/help.htm 
 

 
 

The initial version of the map as described above has been developed. Additional 

customization will be added to future versions of the map to contain additional broadband 

status and planning information and greater user capabilities. The Arizona Broadband Map 

will have its main access point from the Arizona State Broadband Portal described in the next 

section.

http://broadbandmap.az.gov/about/help.htm
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Arizona Broadband Portal Plans 
 

GITA is developing an Arizona Broadband Information Portal as a government website. The 

initial release of this portal will be available to the public by June, 2011 at 

http://www.azbroadband.gov/. This website will provide the public with general information 

about Arizona‘s Broadband Planning and Mapping Initiatives funded under our NTIA grants. 

The site will provide links to the sites for the State of Arizona Broadband Map 

(http://broadbandmap.az.gov/map), as well as the NTIA National Broadband Map 

(http://www.broadband.gov/maps/), and will provide a mechanism for users to do speed tests 

on their current broadband services and report the results to us for use speed verification 

efforts. This data will be incorporated into our broadband database and made available on 

our Arizona Broadband map. The site will also provide information about our community -

outreach efforts as well as links to other state and local resources interested in or providing 

support for broadband and economic development in Arizona. Additionally, the site will 

provide information about the sources of data behind the map and how the mapping data is 

processed, the potential residential and commercial uses for the map. 
 

The Arizona Broadband Information portal will also be integrated with social media 

capabilities such as RSS feeds, Twitter, and Facebook supported by experts within our State 

Health Department who have successfully developed outreach programs based on these 

new media capabilities. 
 

Additionally, on pages requiring a secure log-in, the GITA portal will support the reporting of 

Community Anchor Institution connectivity, speeds, costs, and miscellaneous contact 

information, and help us establish their rural broadband deficits in response to a 

comprehensive out-reach campaign GITA will initiate in mid-2011. 

http://www.azbroadband.gov/
http://broadbandmap.az.gov/map
http://www.broadband.gov/maps/
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Appendix A - Arizona Broadband Provider Technical 

Appendix 
 

 

OVERVIEW 
 
This document provides data specifications and delivery options for the Arizona Broadband Mapping 
Project, which is part of the nationwide NTIA Broadband Data and Development Program.  
 
Under the NTIA program, each Broadband Provider (BP) is requested to provide information 
regarding the availability and delivery of broadband services if their company or organization: 

 
- Offers broadband services to end users in Arizona, or could do so within a typical service 

interval without extraordinary effort, or 
- Owns facilities in Arizona that make possible the delivery of broadband services by other 

companies meeting the description above. 
 

Throughout this document, we address how data may be formatted, submitted and securely 
transferred to the State of Arizona. The availability and validity of the data is critical to portray each BP 
accurately.  
 
While we ask every BP to submit as much data as required in the NTIA formats described below, we 
recognize the effort this may require. Ultimately, we seek the data in a format easiest for the BP and 
we‘re glad to provide support in the preparation and submittal of the data. 
 
Provider data may be uploaded to the State of Arizona through a simple, safe and secure channel at 
https://www.azbbmp.com. Each provider will be given a unique username and password that will be 
active only during the submittal process. (Refer to page 9 of this document for additional details) 
 
 

DEFINITIONS 
 
―Broadband service‖ is the provision, on either a commercial or noncommercial basis, of data 
transmission technology that provides data transmission to and from the Internet with advertised 
speeds of at least 768 kilobits per second (kbps) downstream, and greater than 200 kbps upstream, 
to end users. 
 
A ―facilities-based‖ broadband provider offers service connections to end user locations if the 
company or organization: 
 

1. Owns the portion of the physical facility that terminates at the end user location 
2. Obtains unbundled network elements (UNEs), special access lines or other leased facilities 

that terminate at the end user location and supplies or equips them as broadband, or 
3. Supplies or equips a broadband wireless channel to the end user location over licensed or 

unlicensed wireless spectrums including satellite transmission. 
 

An ―end user‖ of broadband service is a residential or business party, institution, or state or local 
government entity that may use broadband Internet service for its own purposes, and that does not 
resell such service to other entities or incorporate such service into retail Internet-access services that 
it provides. (For this purpose, Internet Service Providers ―ISPs‖ are not ―end users.‖) 

https://www.azbbmp.com/
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REQUESTED DATA 
 
The State of Arizona asks that each BP contribute detailed data for both wireline and/or wireless 
coverage areas. In addition to coverage areas, information regarding transmission technology, 
upstream and downstream speed is also requested.  
 
All data submittals should include ―common‖ information, including, 
 

1. Technology of Transmission 
2. Speed (Upstream/Downstream) 
3. FRN (FCC Registration Number) 

  
Technology of Transmission 
 
The technology of transmission refers to the methodology or platform(s) by which a BP services their 
customer. The NTIA has developed a ―model‖ where specific codes depict different technologies: 
 

Code Description 

10 Asymmetric DSL 

20 Symmetric DSL 

30 Other Copper Wireline - T1, NxT1, EOC 

40 Cable Modem - DOCSIS 3.0 

41 Cable Modem - Other 

50 Optical Fiber/Fiber to the End User 

60 Satellite 

70 Terrestrial Fixed Wireless - Unlicensed 

71 Terrestrial Fixed Wireless - Licensed 

80 Terrestrial Mobile Wireless 

90 Electric Power Line 

0 All Other 

 
Speed Tables 
 
Speed of Broadband service(s) should be specified as both maximum advertised upstream and 
downstream speeds as well as ―typical‖ speeds achieved by end users. The NTIA has established a 
set of codes for Upstream and Downstream bandwidth speeds: 
 

Speed Tier Codes Table 

Upload 
Speed 

Tier 
Download 
Speed Tier Description 

2 n/a Greater than 200 Kbps and less than 768 Kbps 

3 3 Greater than or equal to 768 Kbps and less than 1.5 Mbps 

4 4 Greater than or equal to 1.5 Mbps and less than 3 Mbps 

5 5 Greater than or equal to 3 Mbps and less than 6 Mbps 

6 6 Greater than or equal to 6 Mbps and less than 10 Mbps 
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7 7 Greater than or equal to 10 Mbps and less than 25 Mbps 

8 8 Greater than or equal to 25 Mbps and less than 50 Mbps 

9 9 Greater than or equal to 50 Mbps and less than 100 Mbps 

10 10 Greater than or equal to 100 Mbps and less than 1 Gbps 

11 11 Greater than or equal to 1 Gbps 

 
Please note that, for a particular transmission technology, not all speeds are applicable, and 
submitted data will be checked against the NTIA established applicable speeds. 
 
FCC Registration Number (FRN) 
 
We ask that each BP provide their FCC Registration Number(s) (FRN). If any BP has more than one 
FRN, we ask that each data set submitted be tied to one and only one FRN. If in doubt concerning 
your FRN, please visit https://fjallfoss.fcc.gov/coresWeb/simpleSearch.do for verification.  
 
Wireline Broadband Coverage 
 
Wireline coverage area may be reported by any of the following: 
 

1. Individual street address* where broadband service is available to end users. 
2. Road Segments, allowable only for areas where census blocks are greater than 2.0 square 

miles in area, using: 
a. Arizona road centerline data - shapefile format road segments from current local 

sources are preferred, including all NTIA required fields for address ranges (minimum 
and maximum address on the segment), street prefix direction, street names, street 
type, street suffix direction, city, ZIP5 and ZIP4 (if available), with each element in a 
separate field. Alternatively, each segment can be identified in a table (non-GIS format) 
with a beginning and ending address range, street prefix direction, street name, street 
type, street suffix direction, city and ZIP codes in separate fields. Please note that a 
segment identifier (ID) field to your street network segments will not help us as we do 
not have access to that network. 

 
b. US Census TIGER/Line Road Files - shapefile format road segments from the latest 

Census TIGER files (2009 or 2010) including all NTIA required fields for address 
ranges, street prefix direction, street names, street types, street suffix direction, city, 
etc. Alternatively, each segment can be identified in a table (non-GIS format) with a 
TIGER Line ID (TLID) for the 2009 or 2010 version of Census TIGER files. BPs should 
indicate which Census version (2009 or 2010) was used in preparing the submittal. 

 
3. Census block, allowable only for areas where census blocks are less than or equal to 2.0 

square miles in area. 
 

* Please note that in all cases, wireline broadband availability will be aggregated to Census Block 
(for blocks <= 2 sq mi) or Street Segment (for blocks > 2 sq mi) as per the NTIA specifications, 
and in no case will specific addresses be included in the Arizona or federal broadband 
maps. 
 
For those providers who wish to submit FCC Form 477 data, it is imperative that we have 
information that is more granular than census tract data. Any provider offering service 
boundary/areas, please make available in GIS (Geographical Information System/Esri shapefile) 
or Google Earth (KML) format 

https://fjallfoss.fcc.gov/coresWeb/simpleSearch.do
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Data Format 
 
By Address - Defined as broadband service available, including service type and advertised speed, to 
a specific ―end user‖ by physical address. Typical submittal formats include excel spreadsheets, flat 
text files (.csv or .txt), and database tables (Access or SQL). Data should represent the following 
fields: 
 

FRN  Address City State ZIP4 
Technology 

of 
Transmission 

Maximum 
Downstream 

Speed 

Maximum 
Upstream 

Speed 

Typical 
Downstream 

Speed 

Typical 
Upstream 

Speed 

19567460 
123 
Main St  Here AZ 88888 10 6 2 5 2 

19567460 
222 1st 
Ave  There AZ 88800 41 5 2 4 1 

19567460 
445 Elm 
St  Every AZ 87654 50 10 7 9 7 

 
Where possible, include the category of end user by the following: 
 

Code Description 

1 Residential user 

2 Governmental user 

3 Small Business user 

4 Medium or Large Business user 

5 Other 

 
By Census Block - In lieu of reporting address-specific data, BPs may provide list of all census blocks, 
two square miles or less in area, in which broadband service is available to end users, along with 
the same service characteristics address points contain (technology of transmission and maximum 
and typical speeds). 
 
If this option is employed, BPs are encouraged to use geographic information system (GIS) 
compatible software to select a subset of census blocks. Please include the full 15 digit FIPS (Federal 
Information Processing Standards) Census Block ID. These can be identifiers for Census 2000, 2009 
or 2010 Census Blocks; please specify which version was used. GIS formats for these resources can 
be found at the US Census Bureau download site (Census 2000 is included with either 2009 or 2010 
downloads) 
 

 US Census Bureau‘s 2009 TIGER/line files at 
http://www.census.gov/geo/www/tiger/tgrshp2009/tgrshp2009.html 

 US Census Bureau‘s 2010 TIGER/line files at 
http://www.census.gov/geo/www/tiger/tgrshp2010/tgrshp2010.html 
 

Data should represent the following fields: 
 

FRN 
Census Block                        
15-digit FIPS 

Technology 
of 

Transmission 

Maximum 
Downstream 

Speed 

Maximum 
Upstream 

Speed 

Typical 
Downstream 

Speed 

Typical 
Upstream 

Speed 

19567460 40059412001036 10 6 2 5 2 

19567460 40159501003174 41 5 2 4 1 

19567460 40139410001010 50 10 7 9 7 

http://www.census.gov/geo/www/tiger/tgrshp2009/tgrshp2009.html
http://www.census.gov/geo/www/tiger/tgrshp2010/tgrshp2010.html
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By Road Segment - in lieu of reporting address-specific data, BPs may report a list of street segments 
with address ranges in which broadband service is available to end users along with the same service 
characteristics address points (technology of transmission and speed). 
 
If this option is employed, BPs are encouraged to use geographic information system (GIS) 
compatible software to select a subset of road segments (from either of the GIS data sets listed 
below). The basic service information fields (Technology of Transmission, Maximum Advertised 
Downstream/Upstream speed and Typical Downstream/Upstream speed) should then be attached to 
each road segment to characterize the broadband service along each road. 
 
US Census Bureau TIGER/line shapefiles can be accessed at the previously listed sites. Again, 
please report which data set was used in preparing your data. 
 

FRN 
Min 

Address 
Max 

Address 
Prefix Dir 

Street 
name 

Street 
type 

City State ZIP 

19567460 1 100 E Easy Ln Here AZ 88888 

19567460 101 250 E Easy Ln Here AZ 88888 

19567460 301 399 W First St There AZ 87654 

 
 
Wireless Broadband Cover - Fixed, Mobile & Satellite 
 
We would prefer that all information submitted for this requirement is in a geographic data format with 
polygons depicting wireless service areas and associated service characteristics (technology of 
transmission, speed), but may be reported by any of the following: 

 
1. Geographical data format with polygons depicting wireless service areas (Esri shapefile) 
2. Google Earth as either .kml or .kmz 
3. Tower location, including 

a) Latitude and Longitude 
b) Tower height and/or Equipment height 
c) Spectrum Used 
d) Antenna specifications (omnidirectional, sectorized, etc) - if using sectorized, provide direction 

and beam width (60 degrees, 90 degrees, 180 degrees) 

 
Esri Shapefile - include metadata depicting technology of transmission, lat/long, tower height and 
maximum upstream/downstream speeds. 
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Google Earth - include metadata depicting technology of transmission, lat/long, tower height and 
maximum upstream/downstream speeds. 
 

                             
 
 

Tower Location - for BP that do not have coverage data in a geographical/polygon format, a 
description of tower location with lat/long, height, spectrum, speed as follows: 
 

Tower 
Height/Equipment 

(ft) 
FRN Latitude Longitude 

Technology of 
Transmission 

Maximum 
Downstream 

Speed 

Maximum 
Upstream 

Speed 

100/60 0019567460 33.419028 -112.142889 70 5 3 

70/60 0019567460 32.995917 -111.745806 70 5 3 

50/50 0019567460 35.241944 -111.610722 71 6 4 

*include typical upstream/downstream where possible 
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Wireless Spectrum 
 
The NTIA has developed specific codes for wireless spectrum use, as follows: 
 

Code Description 

1 is Cellular spectrum (824-849MHz; 869-894) used to provide service 

2 is 700 MHz spectrum (698-758 MHz; 775-788 MHz; 775-788 MHz) used to provide service 

3 is Broadband Personal Communications Services spectrum (1850-1915 MHz; 1930-1995) used to provide service 

4 is Advanced Wireless Services spectrum (1710-1755 MHz; 2100-2155) used to provide service 

5 is Broadband Radio Service/Educational Broadband Service spectrum (2496-2690 MHz) used to provide service 

6 is Unlicensed (including broadcast television "white spaces" ) spectrum Used to provide service 

7 is Specialized Mobile Radio Service (SMR) (817-824 MHz; 862-869 MHz; 896-901 MHz; 935-940 MHz) 

8 is Wireless Communications Service (WCS) spectrum (2305-2320 MHz; 2345-2360 MHz), 3650-3700 MHz 

9 Satellite (L-band, Big LEO, Little LEO, 2 GHz) 

10 is other licensed spectrum 

 
 
 

Speed Tiers 
 
Wireless speed tiers differ slightly from the aforementioned wireline speed tiers and fixed wireless 
differs from mobile wireless, as follows: 
 

Speed Tier Codes Table Fixed Wireless 

Upload 
Speed 

Tier 
Download 
Speed Tier Description 

3 3 Greater than or equal to 768 Kbps and less than 1.5 Mbps 

4 4 Greater than or equal to 1.5 Mbps and less than 3 Mbps 

5 5 Greater than or equal to 3 Mbps and less than 6 Mbps 

6 6 Greater than or equal to 6 Mbps and less than 10 Mbps 

7 7 Greater than or equal to 10 Mbps and less than 25 Mbps 

8 8 Greater than or equal to 25 Mbps and less than 100 Mbps 

 

Speed Tier Codes Table Mobile Wireless 

Upload 
Speed 

Tier 
Download 
Speed Tier Description 

2 n/a Greater than 200 Kbps and less than 768 Kbps 

3 3 Greater than or equal to 768 Kbps and less than 1.5 Mbps  

4 4 Greater than or equal to 1.5 Mbps and less than 3 Mbps  

5 5 Greater than or equal to 3 Mbps and less than 6 Mbps  

6 6 Greater than or equal to 6 Mbps and less than 10 Mbps  

7 7 Greater than or equal to 10 Mbps and less than 25 Mbps 
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Arizona Broadband Mapping Portal 
www.azbbmp.com 

 
The Arizona Broadband Mapping Portal was exclusively designed for Arizona Broadband Providers 
so that they may securely transmit and receive data throughout the life cycle of NTIA/FCC project.  
 
To establish a secure and simple platform, an HTTPS web interface is coupled with unique 
credentials (username/password) for each broadband provider. There is no need to download any 
software to use the platform. It will work on any Internet browser, including; Internet Explorer, Safari, 
Firefox and Chrome. 
 
Once a provider has received their username and password, they can reach the portal via 
www.azbbmp.com. (https://www.azbbmp.com) 
 

 
 
The user will be prompted for their unique credentials to enter the portal. Credentials will only be 
active during upload and verification timeframes and will be changed for each submittal cycle. 
 

 
 

The portal interface enables the end-user to drag and drop files from their PC to the server. 
(right pane - user, left pane - server) 
 

http://www.azbbmp.com/
http://www.azbbmp.com/
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File transfer progress can be monitored from the bottom pane of the portal interface. 
 

 
 
Once all the files have been transferred to the server, click the ―logout‖ button to complete the 
session. 
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After the files have been successfully uploaded, the user credentials will be deactivated and the files 
will be transferred to an off-net, secure and encrypted Network Attached Storage device. 
 
Additional portal information can be found at: 
http://help.globalscape.com/help/eft6-2/HTTP_S_Transfer_Client.htm 
 
 

Support 
 

Please direct any questions regarding this document, in its entirety, to: 
 

Nolan Straabe 
Data Site Consortium Inc. 

E-mail: nolan@straabe.com,  
Mobile: 602-999-0143 

http://help.globalscape.com/help/eft6-2/HTTP_S_Transfer_Client.htm
mailto:Nolan@straabe.com
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Appendix B - Community Anchor Institution Master Database  
 

Initial Data Structure 
 

This data structure is being used to load in Community Anchor Institution (CAI) records for use as a 

base for developing and enacting improvements in the CAI update process. This database will be 

used as a source of data to update the CAI feature class data within the NTIA geodatabase.  
 

The Community Anchor Master Database is currently an EXCEL Spreadsheet, although it is likely to 

be converted to other file format in the future. It is an evolving structure that will used to house CAI 

data for NTIA transfer and mapping purposes. The current spreadsheet is divided into 4 column 

categories: ―Anchor Name‖, ―ID Code‖, ―Location‖ and ―Broadband‖. These categories represent types 

of data fields relevant to identifying and categorizing the CAI locations, providing locational 

information and information on sources of data. The ―Broadband‖ category provides fields to hold the 

NTIA required information on the Broadband status at the CAI location.  
 

These major data categories are divided into a total of 43 subcategories (43 unique columns of data) 

which represent the current fields in the CAI database. In order to facilitate navigation around the 

spreadsheet, each category has been color-coded. Subcategories that are required by the NTIA are 

asterisked.  
 

 Category: Anchor Name 
This category provides basic address and function information about each Community Anchor 

Institution (CAI) including physical address & phone number, facility function & type, and source data 

information. It also has a field for notes that may apply to a particular circumstance surrounding a CAI 

record. The Anchor Name category is divided into 18 sub-categories and is Color-Coded Green on 

the spreadsheet.  
 

Subcategories 
 

*ANCHORNAME: The name of the CAI currently in occupation of the building or facility - e.g. Pima 

County.  
 

*ADDRESS: The complete physical address of the CAI, down to the 5-digit zip code, where possible - 

e.g. 1631 South 10th Avenue Tucson AZ 85713 
 

*BLDGNBR: The parsed building number from the ADDRESS field - e.g. 1631 
 

*PREDIR: The pre-direction of the street - North, East, South, or West 
 

*STREETNAME: The street name as it appears in the ADDRESS field - e.g. 10th Avenue 
 

*STREETTYPE: The type of street as it appears in the ADDRESS field - Street, Road, etc. 
 

*SUFFDIR: The suffix direction of the street, if applicable - North, East, South, or West 
 

*CITY: The name of the city, town or community where the CAI is located. 
 

COUNTY: The name of the county where the CAI is located. 
 



Arizona Broadband Assessment Project White Paper - Spring 2011                                Page 49 

*STATECODE: The 2-digit state code of the CAI. 
 

*ZIP5: The 5-digit zip code of the CAI. 
 

*ZIP4: The 4-digit zip code extension of the CAI. 
 

ADD_SRC: The source of the address information. The various data sources being used to compile 

the ANCHOR NAME categories have been coded as follows: 
 

 ADOA - Data provided by ADOA 
 

 ADOT = Data provided directly by ADOT 
 

 ASFM = Data provided by Arizona State Fire Marshal’s Office 
 

 AWS = Data obtained directly from the Community Anchor’s website  
 

 CAI = Original Community Anchor Institute data (data that we received at the beginning of  

 the project) 
 

 COGIS = Data provided by a County GIS department in a GIS format (shape or 

 geodatabase)  
 

 CWS = Data acquired from County website 
 

 DC = Data provided through Direct Contact with the CAI (either through E-mail or by  

 telephone) 
 

 GM = Google Maps used to locate facility when all other attempts to locate do not work 
 

 NR= Not recorded - data that was obtained from an unknown source at the beginning of the  

 broadband project (typically from Google and other web searches used when more traditional  

 sources of data were not available).  
 

ADD_DATE: Month & year that the Address Source information was created, credited to, or, in cases 

where records were acquired from the internet, the date that these records were acquired. If the date 

field is blank this means that the address data has not been verified or that the information was never 

recorded by ASLD/SCO. 
 

DESCRIP: Descriptive text field explaining the CAI function performed at a specific address e.g. 

―Wilcox Animal Control”.  
 

PHONE: The telephone number of the CAI, including area code. When multiple phone numbers are 

listed for a CAI, an attempt has been made to use the main switchboard telephone number. In the 

case of emergency services (fire, police), the non-emergency number has been listed. 
 

TYPE: The general category of CAI, useful for sorting records e.g. ―Fire”, “Government Office”, 

“Detention Facility”. 
 

NOTES: A field used to provide additional information with regards to a particular CAI record. e.g. 

“Closed for 2010 Season” or ―2 miles west of I-10 on East Pinal Airpark Road.” 
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    Category: ID CODE 
The purpose of the ID CODE category is to assign a unique Identification code to each CAI for 

internal use and in order to satisfy NTIA submission requirements. For reference purposes, and with 

future updates in mind, an additional field has been included in order to log any unique ID numbers or 

codes used by external data sources. The ID CODE category is divided into 6 sub-categories and is 

Color-Coded Yellow on the spreadsheet.  
 

Subcategories 
 

*CAICAT: A contraction of “Community Anchor Institute Category”. The NTIA have requested that the 

following category code numbers be used: 
 

 1= Schools -Public/Tribal 
 

 2= Libraries 
 

 3= Medical-Health Care 
 

 4= Public Safety 
 

 5= University/College 
 

 6= Other Government 
 

 7= Other Non-Government 
 

PRE_CAICAT: A single-letter code that identifies the level of government of the CAI. Non-government 

entities are coded ‗N‘. 
 

 C= County 
 

 I= City or Town (Incorporated) 
 

 F= Federal 
 

 M= Military 
 

 N= Non-Government  
 

 O=Other 
 

 R=Regional 
 

 S= State 
 

 T= Tribal 
 

 Z= Nothing, No value - used as a temporary place holder 
 

SUB_CAICAT: A 3-letter code used to identify the general type of CAI facility. Letters only are used, 

no numbers or symbols. 



Arizona Broadband Assessment Project White Paper - Spring 2011                                Page 51 

 

 APO= Airport 
 

 ANM= Animal Care, Animal Control or Animal Shelter 
 

 CRT= Court, Municipal, Juvenile, County, etc. 
 

 CTH= City, or Town Hall, County Seat or main County Government Complex. 
 

 CUL= Cultural Facilities: Cultural Centers, Civic Centers, Museums, Visitors Centers,  

Nature Centers, etc. 
 

 ENV= Environmental Facilities: Landfills, Recycling Centers, Waste Tire Yards, Water  

 Treatment Plants, etc. 
 

 FIR= Fire Stations and related facilities, including: Administrative Offices, Training 

 Centers, Equipment Storage Yards, etc. 
 

 HEL: Health related facilities: Clinics, etc. 
 

 LAW= Law Enforcement: Police, Sheriff, Constables, Detention Facilities, etc. 
 

 LIB= Libraries, including Public Libraries, Law Libraries, County Libraries 
 

 MTN: Maintenance Yards & Facilities, including Storage Yards & Warehouses 
 

 MSC= Miscellaneous - facilities that did not fit neatly into any other category. Includes: Rest  

 Areas, Ports of Entry, Laboratories, etc. 
 

 OFC= General government office facilities, not including City/Town Halls or  

County Seats/main County Government Complex‘s. 
 

 REC= Recreation Facilities: Community Centers, Pools & Aquatic Centers, Senior 

 Centers, Youth Centers, Sports Complex‘s, etc. 
 

 WTR= Water/Wastewater related infrastructure: Water Reclamation Plants, Water Treatment  

 Plants, Water Quality Facilities, etc. 
 

CAI_KEY: A 5-digit unique ID number developed internally for tracking purposes. Numbers only are 

used, no symbols or letters. 
 

*CAIID: The CAIID subcategory is created by merging (in sequence as listed) the following 

subcategories to create a 10-digit ID Code: CAICAT, PRE_CAICAT, SUB_CAICAT, CAI_KEY. For 

example, if we examine the CAIID number 6IREC00475 we can see that it is a recreation facility that 

belongs to a city or town. 
 

  CAICAT,  PRE_CAICAT,  SUB_CAICAT,  CAI_KEY 

                                  6               I                     REC               00475 

                          ↗            ↑                  ↑                   ↖ 

                      Other               City or         Recreation             Unique 

               Government           Town             Facility                    ID # 
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EXT_ID: This field is to be populated by any unique ID numbers/codes which are provided by outside 

data sources, in order to easier share and maintain future versions of the database.  
 

         Category: Location 
 

This category contains locational information about each CAI, including latitude & longitude 

coordinates in decimal degrees (Datum: WGS 84) and the date & acquisition method of these 

coordinates. If the lat/longs are derived from geocoding then the type of geocoded output is recorded. 

Any apparent geocoding errors (and fixes for these errors) are also noted. A Full FIPS ID Code is also 

included in this category. The Location category is divided into 8 sub-categories and is Color Coded 

Orange on the spreadsheet.  
 

Subcategories 
 

*LAT: The latitude of the CAI, in decimal degrees, to six decimal places. 
 

*LONG: The longitude of the CAI, in decimal degrees, to six decimal places. 
 

LL_MET: The method used to derive the latitude and longitude of a CAI (geocoding, GPS, field 

measurements, etc). The following code has been adapted from the ADEQ Geocoding Check 

Method. 
 

 DIG= Digitally verified against raster data or other data set  
 

 NON= Non-specific, multiple methods of verification (digital, geocoding, etc.) 
 

 GPS= Global Positioning System - Field Collected 
 

 GEO= Originally geocoded - address matched (location verified by other methods) 
 

LL_DATE: The date that the lat/long coordinates were collected or generated. 
 

GC_TYPE: The type of result returned from geocoding software if the lat/long coordinates were 

derived by this method. 
 

 STREET_ADD= The software geocoded to the street address level 
 

 ZIPCODE= The software geocoded to the centroid of the zip-code 
 

 NONE= The CAI address information was not run through the geocoding  software 
 

GC_ERROR: If the geocoding software generates spatially inaccurate point data then the specific 

error is noted here.  
 

GC_FIX: Any geocoding errors that are corrected are logged in this field, along with the method of 

correction. 
 

*FULLFIPSID: The Full 16 digit Census Block ID that contains the State Code, County Code, Census 

Tract, Census Blocks, Census Block Groups and Group ID. 
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  Category: Broadband 
 

This category provides information on each Community Anchor Institution‘s broadband capabilities 

including whether, or not, they receive a broadband service, broadband upload and download speeds, 

and the kind of transmission technology being used at the location. Contact information about the 

broadband data source is also listed. The Broadband category is divided into 11 sub-categories and is 

Color-Coded Blue on the spreadsheet.  
 

Subcategories 
 

*BBSERVICE: A Yes/No field asking whether a CAI has broadband service or not. 
 

*BB_SRC: The Source of the broadband information for the CAI. 
 

BB_DATE: The date that the broadband information was provided to the project. 
 

BB_TITLE: The title of the person providing the CAI broadband information. 
 

BB_LNAME: The surname of the person providing the CAI broadband information. 
 

BB_FNAME: The first name of the person providing the CAI broadband information. 
 

BB_EMAIL: The e-mail address of the person providing the CAI broadband information. 
 

BB_PHO: The phone number of the person providing the CAI broadband information. 
 

*TRANSTECH: Type of Technology of Transmission: Cable, T1, DSL, etc. Each type of broadband 

service has a 2 digit code. 
 

 Code Technology of Transmission 
 

 10 Asymmetric xDSL- DSL (Asymmetric) 
 

 20 Symmetric xDSL- DSL (Symmetric) 
 

 30 Other Copper Wireline- T1/Tn 
 

 40 Cable Modem- DOCSIS 3.0 Down Cable 
 

 41 Cable Modem- Other Cable 
 

 50 Optical Carrier/Fiber to the End User Fiber 
 

 60 Satellite- Satellite 
 

 70 Terrestrial Fixed Wireless-Unlicensed Fixed Wireless 
 

 71 Terrestrial Fixed Wireless- Licensed Fixed Wireless 
 

 80 Terrestrial Mobile Wireless- Mobile Wireless 
 

 90 Electric Power Line 
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 0 All Other 
 

*MAXADDOWN: Maximum Advertised Download Speed. These are the codes for the Download 

speeds: 
 

Code Speed Tier 
 

3 768 Kbps - 1.5 Mbps  
 

4 1.5 - 3 Mbps 
 

5 3 - 6 Mbps 
 

6 6 - 10 Mbps 
 

7 10 - 25 Mbps 
 

8 25 - 50 Mbps 
 

9 50 - 100 Mbps 
 

10 100Mbps - 1 Gbps 
 

11 > 1 Gbps 
 

*MAXADUP: Maximum Advertised Upload Speed. These are the codes for the Upload speeds: 
 

Code Speed Tier 
 

2 200 - 768 Kbps 
 

3 768 Kbps - 1.5 Mbps  
 

4 1.5 - 3 Mbps 
 

5 3- 6 Mbps 
 

6 6- 10 Mbps 
 

7 10- 25 Mbps 
 

8 25- 50 Mbps 
 

9 50- 100 Mbps 
 

10 100Mbps - 1Gbps 
 

11 > 1 Gbps 
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Appendix C - Arizona Broadband Provider Case Studies  
 

Hopi Telecommunications Inc. (HTI) 
 

Hopi Telecommunications Inc. (HTI) is the ILEC for the Hopi Tribe‘s reservation in 

Northeastern Arizona, having forced out the previous incumbent, funding their purchase with 

RUS loans. HTI is owned by the Hopi Tribe, but has its own Board and profit center goals. 

They have invested heavily in fiber backhaul and DSL upgrades over the past decade and 

can serve much of the reservation, though several villages (Old Oraibi, Moenkopi) remain 

resistant to infrastructure deployment and thus unserved. 
 

HTI proved reluctant to sign a NDA and generally to cooperate with requests for broadband 

data submittal. The DSCI team reverse mapped estimated coverage from FCC 477 data and 

knowledge of the reservations demography, topography, and infrastructure. When we 

presented the reverse mapping estimates and indicated our intent to submit them as part of 

our Spring 2011 submittal as having been derived from public sources and anecdotal 

knowledge, HTI agreed to cooperate in reviewing and improving the data. An hour long 

collaborative viewing session with HTI personnel led to the addition of multiple census blocks 

under 2 square miles deemed to be covered and significant fine tuning of the road segments 

deemed covered in census blocks over 2 square miles. As HTI does not yet have in-house 

GIS capabilities, they developed a keen interest in receiving full GIS output of the adjusted 

coverage estimates for future internal use and are expected to be generally cooperative in 

reviewing and adjusting coverage in subsequent biannual data collection and submittal 

cycles. 
 

Gila River Telecom Inc. (GRTI) 
 

Gila River Telecommunications, Inc. (GRTI) was established in 1988 for the purpose of 

providing the Gila River Indian Community with affordable telephone services. GRTI has 

grown with the vast growth of the community and providing a variety of telecommunication 

services. GRTI has more than 3,600 access lines which includes business and residential 

with service offerings including phone lines, Internet, High Speed (DSL) Internet and data 

lines. GRTI has significant fiber assets as well as an improvement plan with more than 66 

miles of new fiber optic cable. 
 

However, GRTI felt that it was beyond their ability both technically and in terms of required 

staff resources to comply with our requests for broadband coverage data. They do not have a 

customer billing database, as that function is performed by a third party and are otherwise 

limited in technical support areas. The State interceded and brokered several conversations 

that in the end proved fruitless. DSCI proceeded to reverse map their estimated coverage 

based on known Central Office locations, knowledge of some of their fiber placements, and 

other community service indications. 
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The estimated coverage was provided to GRTI prior to the Fall 2010 submittal and again prior 

to the Spring 2011 submittal with significant improvements in our coverage estimation 

modeling as we refined our base information and processes. We operated under the concept 

of prior notification and having told the BP that our data was developed from public sources 

and would be submitted, we carried through and did so. We continue to provide BP feedback 

packages with various versions of the underlying coverage data, encouraging GRTI to 

engage and cooperate more fully on future data collection and submittal cycles. 
 

Valley Telecom Group (VTG) 
 

Valley Telephone Cooperative, Inc. was established in 1962 and provides 

telecommunications services to over 27,000 rural and remote customers in southeastern 

Arizona and southwestern New Mexico. Copper Valley Exchange was purchased from US 

West in 1995 and has approximately 4,500 access lines in rural Arizona. Valley Connections, 

LLC is another operating entity serving customers in non-contiguous rural Arizona areas. 

They have been maintained as three separate Broadband Providers with unique FRNs and 

have a mix of delivery technologies (DSL, wireless, fiber) across the three operating entities. 
 

Though VTG was generally cooperative and their data was included in the Fall 2010 

submittal, there were substantial technical issues both in their submittal and our processing of 

it which led to significant gaps in their reported coverage versus their actual deployments. 

When the national broadband map launched they quickly realized the gaps in the coverage 

and were quite upset at the perceived oversights and wanted to withdraw from future 

cooperation. They strongly believed that accurate data would be good marketing leading 

potential customers to be able to ―find‖ them and that accurate coverage would factor into 

preventing inappropriate grants to competitive providers where their coverage and existing 

competition were sufficient to preclude. In short, they ―got it,‖ but didn‘t have confidence in 

our approach and commitment. 
 

We worked closely with them to turn the situation around, investigating and sharing the 

findings of where the problems had lain in the Fall 2010 submittal and offering various 

approaches to fixing the technical issues on both sides. After several conference calls, the 

kinks were worked out and new data submitted for the three operating entities delivering over 

the three technology types in a variety of data formats (customer lists, census blocks, 

wireless polygons). Several collaborative viewing sessions were hosted by DSCI with the 

VTG team participating where detailed review of operating entities, technology of delivery, 

and declared coverage areas lead to fine tuning the coverage to VTG‘s satisfaction in time for 

inclusion in the Spring 2011 submittal. 
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Casa Grande Internet (CGI) 
 

During our first quarter 2011 efforts, the Arizona mapping team encountered a single 

provider, Casa Grande Internet (CGI), which refused to participate in the broadband mapping 

process. CGI‘s website (http://www.casagrandeinternet.com/) indicates it has been providing 

Internet services in in the Phoenix metropolitan area for over 10 years, during which it has 

acquired several smaller Internet Service Providers (ISPs). Additionally, CGI provides 

computer repair and end-user networking services. 
 

Our mapping status is that we have determined that CGI provides both point-to-point and 

point-multipoint wireless Internet service, but we do not know its current coverage area for 

these services. CGI did not answer our initial inquiries. However, third parties have informed 

us that CGI resells DSL services in limited areas, as well as being a wireless provider. Based 

on multiple inputs the DSCI team received, we constructed a possible mapping of CGI‘s 

offerings and presented a map of estimated coverage to CGI as a starting point for 

subsequent discovery. A co-owner of CGI responded that he did not have available time for 

the query and requested that we not submit any findings in the April 1, 2011 submittal. Thus 

CGI became the only BP of the 71 identified relevant Arizona BPs not included in our Spring 

2011 submittal. 
 

In summary, we know CGI uses multiple technologies that are capable of providing 

broadband services in excess of 1-Mbps and that its coverage areas likely vary with each of 

its deployment technologies. However their specific admonition not to submit the estimated 

coverage data without further interaction and correction to it led us to withhold it from the 

Spring 2011 submittal. We will continue working with the CGI principals for further discovery 

of their broadband offerings with the intent of being able to obtain their cooperation so as to 

be able to include their approved broadband coverage data in the October 1, 2011 submittal.

http://www.casagrandeinternet.com/


Arizona Broadband Assessment Project White Paper - Spring 2011                                Page 58 

Appendix D - Broadband Provider Data Verification Table 
 

 Wireline Cable Mobile Wireless Fixed Wireless Fiber Satellite 

Verification 
Sources 

 ACC ILEC 
boundaries 
 Tele Atlas 
licensed database & 
otherwise known 
COs, Wire Centers, 
DSLAMs & POPs 
 Coverage 
modeling 
 Federal & ID 
Insight 
Crowdsource Data 
 Community 
Anchor Institutions 
 Market 
Knowledge 
 Primary survey 
data (not currently 
being used for data 
verification) 

 Municipal Cable 
license information 
 Cable Boundaries/ 
Media Maps 
licensed database 
 Federal & ID 
Insight 
Crowdsource Data 
 Community 
Anchor Institutions 
 Market 
Knowledge 
 Primary survey 
data (not currently 
being used for data 
verification) 

 American Roamer 
licensed database 
 BP published 
public coverage 
maps 
 Known tower & 
transmission 
locations 
 Federal & ID 
Insight 
Crowdsource Data 
 Community 
Anchor Institutions 
(technology being 
used by few CAIs) 
 Market 
Knowledge 
 Primary survey 
data (not currently 
being used for data 
verification) 
 FCC cellular & 
PCS licensed areas 
(not currently being 
used for data 
verification) 
 Wireless coverage 
modeling from 
propagation models 
(not currently being 
used for data 
verification) 
 Wireless field 
verification testing 
(not currently being 
used for data 
verification) 

 BP published 
public coverage 
maps 
 Known tower & 
transmission 
locations 
 Federal grants & 
loans for WISP 
projects 
 Federal & ID 
Insight 
Crowdsource Data 
 Community 
Anchor Institutions 
(technology being 
used by few CAIs) 
 Market 
Knowledge 
 Primary survey 
data (not currently 
being used for data 
verification) 
 FCC spectrum 
licensed areas (not 
currently being used 
for data verification) 
 Wireless coverage 
modeling from 
propagation models 
(not currently being 
used for data 
verification) 
 Wireless field 
verification testing 
(not currently being 
used for data 
verification) 

 BP public fiber 
maps & on net 
building lists 
 Federal 
Crowdsource Data 
(expect such data in 
few if any instances) 
 Community 
Anchor Institutions 
 Market 
Knowledge 
including known 
FTTx projects in 
specific areas 
 Primary survey 
data (not currently 
being used for data 
verification) 

 Federal & ID 
Insight 
Crowdsource Data 
 Community 
Anchor Institutions 
(expect such data in 
limited instances) 
 Market 
Knowledge 
 Geographic & 
topographic shadow 
modeling (not 
currently being used 
for data verification) 
 Primary survey 
data (not currently 
being used for data 
verification) 
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Coverage 
Anomalies 

 Inconsistencies 
with ACC ILEC 
boundaries 
 Map overlays 
indicate significant 
over or under 
coverage from 
known T-1/T-3 & 
DSL delivery points 
as modeled 
 Map overlays 
show significant 
crowdsource &/or 
CAI data voids or 
outside data points 
from declared 
coverage 

 Map overlays 
indicate significant 
over or under 
coverage from 
Cable Boundaries/ 
Media Maps data 
 Map overlays 
show significant 
crowdsource &/or 
CAI data voids or 
outside data points 
from declared 
coverage 

 Map overlays 
indicate significant 
over or under 
coverage from 
American Roamer 
data &/or coverage 
estimates from 
known transmission 
locations 
 Map overlays 
show significant 
crowdsource &/or 
CAI data voids or 
outside data points 
from declared 
coverage 

 Map overlays 
indicate significant 
over or under 
coverage from 
coverage estimates 
from known 
transmission 
locations 
 Map overlays 
show significant 
crowdsource &/or 
CAI data voids or 
outside data points 
from declared 
coverage 

 Map overlays 
indicate significant 
over or under 
coverage from BP 
fiber maps & on net 
building lists 
 Map overlays 
show significant 
crowdsource &/or 
CAI data voids or 
outside data points 
from declared 
coverage 

 With BP statewide 
shapefile use 
without geographic 
shadow modeling, 
limited coverage 
considerations 

Speed 
Anomalies 

 Use CAI and 
crowdsource data to 
confirm typical and 
maximum speeds in 
expected ranges 

 Use CAI and 
crowdsource data to 
confirm typical and 
maximum speeds in 
expected ranges 
 Monitor expansion 
from DOCSIS 2 to 3 

 Use CAI and 
crowdsource data to 
confirm typical and 
maximum speeds in 
expected ranges 

 Use CAI and 
crowdsource data to 
confirm typical and 
maximum speeds in 
expected ranges 

 Use CAI and 
crowdsource data to 
confirm typical and 
maximum speeds in 
expected ranges 
 Fiber speeds 
readily provisioned 
upward by DWDM 
over time 

 Use CAI and 
crowdsource data to 
confirm typical and 
maximum speeds in 
expected ranges 

Technology 
Anomalies 

 Most likely to be 
―confused‖ with fiber 
delivery overlays 

 Possible to be 
―confused‖ with fiber 
delivery overlays 
claimed to be direct 
customer connected 

 Claimed upgrades 
&/or delivery 
protocols planned 
but not yet in place  

 TBD  Possibly to be 
―confused‖ with 
Wireline or Cable 
delivery overlays 

 Not anticipated 

Threshold of 
Concern/Action 

 TBD  TBD  TBD  TBD  TBD  TBD 

Verification 
Schedule 

 Annually if 
expansion of 
coverage areas or 
increases in speeds 
claimed 

 Annually if 
expansion of 
coverage areas or 
increases in speeds 
claimed 

 Biannually with 
expected dynamic 
expansion of 
coverage areas &/or 
increases in speeds 
claimed 

 Annually if 
expansion of 
coverage areas or 
increases in speeds 
claimed 

 Annually if 
expansion of 
coverage areas or 
increases in speeds 
claimed 

 Review 
crowdsource and 
CAI data annually 
for general trends & 
confirming any 
speed increases 
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California Public Utilities Commission  
State Broadband Data and Development (SBDD) Grant Program 

April 20th, 2011 

Data Processing Methods 

Primary Data Collection 
The California Public Utilities Commission (CPUC) sent out a Data Request to broadband providers to 

initiate the Round 3 data collection.  Potential providers were widely encouraged to submit broadband 

service availability data to the CPUC. We expressed our preference for providers to use a file 

geodatabase format when possible while tabular data was also accepted. To assist providers with the 

process, template files, sample shapefiles, record formats, and data submittal instructions were posted 

on the CPUC Broadband Mapping Website at: 

 http://www.cpuc.ca.gov/PUC/Telco/Information+for+providing+service/BB+Mapping.htm 

The data submittal instructions guide each provider to wireless and/or wireline datasets which are 

separated into sections for those with GIS data (shapefiles/FGDB) and those without GIS data (text/excel 

files). For providers with GIS capabilities, statewide census block and TIGER/Line shapefiles were 

provided on the CPUC website for download and use for their data submission. The square mileage of 

each block was calculated in advance in the sample census block shapefile. Providers could then easily 

determine which blocks in their footprint were less than two square miles and which were two square 

miles or greater and therefore needed to be represented using the road segment shapefile. For 

providers without GIS capabilities, excel spreadsheets were provided incorporating record field formats 

adhering to the NOFA data submittal requirements. 

Community Anchor Institutions (CAI) 
CAI data initially came from the eligible entries of California Teleconnect Fund (CTF) program.  The CTF 

program provides 50% discounts on telecommunications bills for qualifying schools, libraries, 

government-owned and operated hospitals and health clinics, and other community based 

organizations, thus providing a good initial list of CAIs.  The CAI addresses were geocoded to point 

locations and loaded into the file geodatabase.  Technology of transmission and speeds data were 

included and identified either through information received from the Institutions themselves (as in the 

case of libraries) or from those service providers who responded to our request for such information.  To 

provide CAI ID information (as in the case of schools), the California Department of Education search 

engine website (http://www.cde.ca.gov/re/sd/) was utilized. 

http://www.cpuc.ca.gov/PUC/Telco/Information+for+providing+service/BB+Mapping.htm
http://www.cde.ca.gov/re/sd/
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Provider Participation 
A total of 48 providers participated in Round 3 data collection.  These providers comprise over 99.9% of 

the total broadband connections in California reported to the FCC on form 477, which constitutes a very 

complete set of data 

CPUC Initial Data Verification 
After obtaining files submitted by the providers, a data inventory spreadsheet was used to reflect the 

assigned GIS team member and record count. Each file was reviewed against the GIS data model posted 

in the SBDD Network website to see if mandatory fields were filled in, and each field was checked for 

the appropriate range of values. Where possible, team members loaded the submitted data into the 

corresponding geodatabase table to make certain that appropriate field headers were used and that 

each field contained the correct data type. When data was found to be missing or incorrect, the provider 

was contacted and the issue was documented in a separate provider spreadsheet.  Some providers 

submitted nearly perfect data sets while others gave incomplete, unexpected, or incorrect data.  New 

information, correspondence with the providers, and fixes made by the CPUC were also documented in 

each provider spreadsheet.  

Chico GIC Geoprocessing   
 After the initial CPUC review, data was transferred to the Geographical Information Center (GIC) at CSU 

Chico for geocoding, geomatching, propagation of wireless service by antenna, and validation of 

geographic data. In those cases where the CPUC had received street address level data from broadband 

providers, such addresses were assigned a point location, (geocoded) and then geomatched to census 

blocks and street segments.  

Providers who offer wireless service but could not submit a shapefile or geographic representation of 

their service area gave tabular antenna information.  Wireless antenna parameters were used to model 

a service area and shapefiles were created for each provider. The wireless propagation model is based 

on the Longley-Rice, Irregular Terrain propagation model.  Individual unit specifications are used to 

measure performance based on frequency, transmit power, receiver sensitivity, antenna gain, and 

height.  Signal coverage patterns are produced for each individual unit taking into account terrain and 

vegetation features that may hinder signal dispersion. 

CPUC Final Data Verification 
The resulting datasets were delivered from Chico to the CPUC in the SBDD transfer model geodatabase 

for final review and verification. Data sets were checked again and reviewed for unexpected changes 

resulting from the geocoding /geomatching process. Geoprocessed data was visually reviewed using 

ArcGIS to verify service area footprints, and the SBDD check submission Python script was run on each 

dataset to identify unexpected values.  
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Deliverable Data 
The final dataset was delivered to the NTIA/FCC in file geodatabase format with the following feature 

classes: 

BB_ConnectionPoint_LastMile – not required per Clarification to the NOFA. 

BB_ConnectionPoint_MiddleMile – Point between the local “last mile” network and the middle mile 

network which goes on to connect to the internet backbone. This is a confidential dataset.  

BB_Service_Address  –  not included per the CPUC NDA.  

BB_Service_CAInstitutions – Community Anchor Institutions: points geocoded from address lists 

BB_Service_CensusBlock – Broadband availability polygons for areas less than 2 square miles 

BB_Service_Overview – Service overview by County including Subscriber Weighted Nominal Speed 

BB_Service_RoadSegment – Broadband availability line segments for areas 2 square miles and greater 

BB_Service_Wireless – Wireless service area polygons. 

Planned Validation Methods 
The following validation methods will be conducted on Round 3 data. Detailed maps showing submitted 

service area footprints and areas that could not be validated will be distributed to each provider for 

feedback. 

FCC Form 477 
FCC Form 477 collects information about broadband connections to end user locations, wired and 
wireless local telephone services, and interconnected Voice over Internet Protocol (VoIP) services, in 
individual states, at the Census Tract level. A shape file was created for each provider reflecting the 
presumed availability of broadband service at each census tract where the provider reported customers 
to their fixed broadband service.  These layers were used to cross reference ISP data submissions to the 
CPUC. 

ID Insight, BroadBand Scout  
BroadBand Scout is a third party comprehensive and unbiased data specifically designed to show the 
carriers, connectivity, speed and usage details of the national broadband landscape.  ID Insight’s patent-
pending process analyzes hundreds of millions of internet transactions that link a consumer's physical 
address to their internet carrier.  BroadBand Scout data is provided as tabular point locations and 
geomatched to the census block level where less the two square miles in area and to the street segment 
level where census blocks are greater than two square miles in area.  A shape file was created for each 
provider reflecting the presumed availability of broadband service at each census block or street 
segment where Broadband Scout reported online customer transactions. These layers were used to 
cross reference ISP data submissions to the CPUC. 
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TeleAtlas Wire Center  
The Wire Center Premium product is a comprehensive database for mapping and analyzing wire center 
service areas. It forms the backbone of the Tele Atlas® Telecommunication Products line. This product 
lists every Local Exchange Carrier (LEC) landline wire center in the United States.  The term “wire center” 
refers to the location where the telephone company terminates the local lines; this is usually the same 
location as a central office, although a wire center might house one or more central offices. Buffers were 
created at 12,000 feet and 18,000 feet from provided Wire Center point datasets to cross reference ISP 
data submissions to the CPUC. 

TeleAtlas Wire Center Region 
The Wire Center Premium product is a comprehensive database for mapping and analyzing wire center 

service areas. It forms the backbone of the Tele Atlas® Telecommunication Products line. This product 

lists every Local Exchange Carrier (LEC) landline wire center in the United States.  The wire center 

boundary is a representation of the area served by all of the switching equipment housed at that 

physical location. Wire Center Region polygon GIS layers were provided and used for cross referencing 

ISP data submissions to the CPUC. 

FCC Consumer Broadband Test (Non-Mobile App) 
The FCC offers an Online Consumer Broadband Test.  FCC’s Online Consumer Broadband Test collects 

information regarding the location of the client, the engine used to provide the speed test, download 

speed, upload speed, latency, jitter, packet loss, minimum round trip time, maximum round trip time, 

and average round trip time at a specified point location.  A shape file was created to represent each 

location at which speed tests were performed based on geocoded address records.  All point locations 

were then geomatched to the census block level where less the two square miles in area and to street 

segment level where census blocks are greater than two square miles in area.  These layers were used to 

cross reference ISP data submissions to the CPUC where sub-broadband speeds were reported and/or 

where there were no tests performed. 

FCC Consumer Broadband Test (Mobile App) 
The FCC offers a Mobile Consumer Broadband Test for the Apple iPhone and Android mobile platforms. 

The official name of the App is the FCC Broadband Test.  This tool can be downloaded to an Apple or 

Android enabled device by accessing the App Store or App Market on a handheld phone.  FCC’s Mobile 

Consumer Broadband Test collects information regarding the location of the client, the client’s 

operating system, the engine used to provide the speed test (always OOKLA for mobile tests), download 

speed, upload speed, and latency, at a specified point location.  A shape file was created to represent 

each location at which speed tests were performed based on latitude and longitude coordinate pairs.  

All point locations were then geoprocessed to the census block level where less the two square miles in 

area and to street segment level where census blocks are greater than two square miles in area.  These 

layers were used to cross reference ISP data submissions to the CPUC where sub-broadband speeds 

were reported and/or where there were no tests performed. 
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FCC Broadband Dead Zone Reporting Form 
The FCC offers a Broadband Dead Zone Reporting Form for recording address or city level queries 

against the National Broadband Map, that failed to return any providers at the specified location, or 

alternately, where a user may know that no service is provided at a specific address.  FCC’s Broadband 

Dead Zone Form collects information regarding the location of the client, whether the client has internet 

access at their home, what type of internet access the client has at their home, and whether or not the 

client would be interested in purchasing broadband internet if service options were available.  A shape 

file was created to represent each location for which dead zone forms were filled out based on 

geocoded address records.  All point locations were then geomatched to the census block level, where 

less than two square miles in area, and to street segment level, where census blocks are greater than 

two square miles in area. These layers were then used to cross reference ISP data submissions to the 

CPUC where dead zones and/or no services provided were reported. 

California State Map Broadband Service Survey Feedback 
The CPUC offers the Broadband Service Survey within its interactive map. The survey records user 

feedback based on address, city, or zip code level queries against the State’s Broadband Availability.  It 

collects information regarding the location of the client, whether the client is accessing the internet 

from their home, place of business, or any other location, whether or not the client purchases 

broadband service, and if not, why they choose not to purchase broadband service.  A shape file based 

on geocoded address records was created to represent each location for which service surveys were 

submitted where the respondent indicated non-subscription because of no broadband availability.  All 

such point locations were then geomatched to the census block level, where less than two square miles 

in area and to the street segment level, where census blocks are greater than two square miles in area. 

These layers were then used to cross reference ISP data submissions to the CPUC 

Chico GIC Data Validation Processes  
Each individual provider’s submitted and/or created data was validated independently to all applicable 

validation methods. The following fields were added to each individual provider’s data tables, where 

appropriate; FCC_477 (FCC Form 477), BBSCOUT (ID Insight BroadBand Scout), TA_WC_REG (TeleAtlas 

Wire Center Region), WC_VAL_12K (TeleAtlas Wire Center 12,000 foot buffer), WC_VAL_18K (TeleAtlas 

Wire Center 18,000 foot buffer), VAL12k_18k (TeleAtlas Wire Center 12,000 to 18,000 foot buffer ring), 

DEGRAD_FT (TeleAtlas Wire Center distance), (FCC_TST) FCC Consumer Broadband Test Non-Mobile 

App, (FCC_MOBL) FCC Consumer Broadband Test Mobile App, (FCC_DZ) FCC Broadband Dead Zone 

Reporting Form, and (CA_SRVY) State Map Broadband Service Survey Feedback to record validation 

results and to allow symbology of discrepancies based on validation methods for further interaction 

with each provider to refine their data submissions. The final step was a summary statistics report of all 

validation results for all submitted providers. Summary statistics include validity counts and percentages 

for all validation methods, specific to provider and technology. 

 Wireline Census Block Validation 
A spatial selection was performed on Census Block data, either submitted by provider, or created from 

submitted address records through a geocoding/spatial selection process, to derive only those blocks 
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which intersect polygons in a given validation layer.  Counts are recorded as number of unique blocks 

which share geographic area with any given validation layer, compared to the total number of unique 

blocks submitted by, or created for, a given provider.  Percentages are recorded as percentage of the 

total number of unique blocks which share geographic area with any given validation layer, compared to 

the total number of unique blocks submitted by, or created for,  a given provider. 

Wireline Street Segment Validation 
A spatial selection was performed on Street Segment data, either submitted by provider, or created 

from submitted address records through a geocoding/spatial selection process, to derive only those 

segments which intersect polygons in a given validation layer.  Counts are recorded as number of unique 

segments which share geographic area with any given validation layer, compared to the total number of 

unique segments submitted by, or created for, a given provider.  Percentages are recorded as 

percentage of the total number of unique blocks which share geographic area with any given validation 

layer, compared to the total number of unique segments  submitted by, or created for,  a given provider. 

Wireless Validation 
A spatial selection was performed on Wireless Availability data, either submitted by provider, or created 

from antenna location and specification information, to select only those polygons which intersect a 

given validation layer.  Results are recorded as a percentage of the total geographic area of wireless 

coverage sharing geographic area with any given validation layer, compared to the total coverage area 

submitted by, or created for, a given provider. 
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Colorado Broadband Data & Development Program  

April 1, 2011 Data Delivery Report  

 
For details about the Colorado Broadband Data and Development Program (CBDDP), please see our web 

site at www.colorado.gov/oit/broadband or visit the National Broadband Map at 

www.broadbandmap.gov. 

Purpose of this Report 
The report provides details about a specific data set delivered to the NTIA on April 1, 2011 to support 

the National Broadband Map.   The report describes the various processes used to verify this data set 

and the results of those processes.   The report also describes, in general terms, how CBDDP collects and 

validates information about broadband availability in the State of Colorado. 

 

Status of Data Collection 
The Colorado Broadband Data and Development Program continued the data collection effort begun 

with signing a data collection contract on March 22, 2010.  Data has been collected from almost all 

service providers of significant size, but effort will continue to capture data from those not yet reporting.   

 

The following table categorizes all possible broadband service providers in Colorado known to CBDDP, 

and indicates the status of their participation in the program.   The table also shows progress made over 

the first three data deliveries to the National Telephone and Information Administration (NTIA).   See 

the Data Delivery Report at the end of this document for more details on the data. 

 

Service Providers May 21, 2010 October 1, 2010 April 1,2011 

Identified 102 158 161 

Duplicates 0 14 14 

Not a BB Provider 15 24 29 

Working Universe of SP’s 87 120 118 

Multiple Contact Efforts, Have Chosen Not to 
Participate So Far, May Not Be a Provider 5 17 50 

Data Sets Delivered to NTIA  39 59 65* 

Broadband Provider Status Not Yet Known 
43 44 0 

* Data Received but Not Included in Data Set: 1 Provider that Missed the Cutoff, and 2 Satellite Providers that Report 
They Cover the Entire State 

 

 

http://www.colorado.gov/oit/broadband
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The following table describes how many service providers updated their data between the prior and 

current data delivery. 

 

Service Provider Updates April 1, 2011 

New in Data Set 6 

Updated Data 16 

Responded "No Data Change" 37 

Responded Update Not Received 3 

No Response 3 

Data Sets Delivered to NTIA 65 

 

 

The following table shows the number of community anchor institutions that have been identified in the 

state, and how many CAIs for which some broadband information has been collected and included in 

this data set.  In addition, the “Includes Speed Tests” column shows how much of the data in the 

“Collected” column are actual speed tests. 

 

CBDDP is very pleased with the progress that has been made in promoting speed tests among reporting 

CAIs.  As shown below, 42%, or 1,562 of 3,768, of the data collected for CAI’s is from speed tests.  An 

additional 526 CAIs have reported speed tests since October 1.   

 

 

Community Anchor Institutions  October 1, 2010   April 1, 2011 

  Identified Collected  
Includes 
Speed Test   Identified Collected  

Includes 
Speed Test 

Cat. 1 - School K -12 2097 1927 665   2106 1995 904 

Cat. 2 - Library 246 234 0   252 272 10 

Cat. 3 - Medical/Healthcare 694 275 80   709 364 140 

Cat. 4 - Public Safety 1813 548 264   1778 774 299 

Cat. 5 - University/College 102 23 21   54 43 41 

Cat. 6 - Other Government 407 156 6   597 315 165 

Cat. 7 - Other non-Government 0 0 0   7 5 3 

  5359 3163 1036   5503 3768 1562 
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Validation and Verification Processes for the April 2011 Data Set 
 

1.  Automated Validation.  CBDDP has been developing and improving automated validation scripts 

since its first data delivery in May 2010.  CBDDP runs both the scripts it has developed as well as the 

script provided by the NTIA on a monthly basis.  Proof that the data delivery passed the NTIA validation 

script is submitted with the data delivery as required. 

 

In addition to testing everything that the NTIA script tests, CBDDP’s automated script: 

 Verifies that the Geodatabase has metadata, is in the correct projection, and that the feature 

classes are properly named 

 Verifies all columns are properly named and defined 

 Verifies all table value domains are adhered to  

 Captures the required information to accurately complete the Records Count and Provider Table 

tabs for the SDBB Data Package 

 Cross references and creates statistical tables  technology type and valid speed combinations for 

both Service Provider and CAI data 

 Compares FRN to provider name to ensure consistency across the data set 

 Ensures consistency in provider names 

 Identifies possible duplicates among CAIs   

 Tests  all feature classes to ensure they are within the State’s boundaries 

  Creates a statistical table for all features classes including records details, service provider 

information and  attribution frequencies  

 Ensures the data model, business rules and schema are in compliance 

 

2.  Analysis of Changes.  CBDDP has compared the October 1, 2010 and April 1, 2011 data sets for all 

providers.  See the table below which lists only providers with changes.  In instances where coverage 

areas were reduced, 15% of the reduced features for each provider were traced back to the provider’s 

raw data.  No errors were found in that data conversion.  80% of the features added to existing 

providers and new providers were compared to the raw data.  Again, no errors were found in the data 

conversion.  In total, over 80,000 new, additional and reduced features were compared back to the raw 

data during our analysis. 

 

3.  Visual review.   

The coverage areas for new service providers and those with changes to their coverage areas were 

visually reviewed.  No unusual coverage areas were observed.   
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Difference Between October 2010 and April 2011 Deliveries by Feature Type 

      

C
en

su
s 

R
o

ad
s 

W
ir

el
es

s 

M
id

 M
ile

 

To
ta

l 

Company Name Doing Business As 

      

New Providers 
Eschelon Telecom of Colorado, Inc.                                                                                                                                                                        Integra Telecom                                                                                                                                                                                           49491 29683 0 0 79174 

CSC Holdings, LLC                                                                                                                                                                                         Bresnan Communications                                                                                                                                                                                    14115 24550 0 0 38665 

Cogent Communications, Inc.                                                                                                                                                                               Cogent Communications, Inc.                                                                                                                                                                               74 0 0 0 74 

Grand County Internet Services, Inc.                                                                                                                                                                      Grand County Internet Services                                                                                                                                                                            0 0 1 1 2 

Farmers Telephone Company Farmers Telecommunications                                                                                                                                                                                0 0 1 0 1 

Viaero Wireless                                                                                                                                                                                           Viaero Wireless                                                                                                                                                                                           0 0 1 0 1 

Providers with Additional Features 
Level 3 Communications, LLC Level 3 Communications, LLC 0 0 0 173 173 

New Edge Holding Company New Edge Networks, Inc. 148 -8 0 0 140 

Time Warner Cable Time Warner Cable 80 28 0 0 108 

Dubois Telephone Exchange, Inc., DTE   7 72 0 0 79 

tw telecom inc.  tw telecom inc.  24 4 0 0 28 

Strasburg Telephone Company TDS Telecom -1 22 0 0 21 

Sprint Nextel Corporation Sprint   0 0 1 0 1 

T-Mobile USA, Inc. T-Mobile   0 0 1 0 1 

Providers with Less Features 
DIECA Communications, Inc. Covad Communications Company -507 -5318 0 0 -5825 

CenturyTel, Inc. CenturyTel, Inc. 643 -6406 0 0 -5763 

Qwest Corporation Qwest Corporation 753 -3062 0 0 -2309 

Delta County Tele-comm, Inc. TDS Telecom -60 -798 0 0 -858 

Brainstorm Internet Brainstorm Internet 0 0 -3 0 -3 

J.e.d. Enterprises, Inc. J.e.d. Enterprises, Inc. 0 -2 0 0 -2 

 

 

4.  Third Party Data Validation.  Since the October 1, 2010 data delivery, 100% of the service provider 

coverage areas have been compared to third party data sets.   Data sets include American Roamer, 

ComSearch, Pitney Bowes, MediaPrints, and SpectrumView.  In 21 instances, multiple third party data 

sets were used to validate a single service provider/technology type combination.   During the 

comparison, comments are recorded about coverage areas, geometry and attribution provided for the 

technology type, and a confidence level is assigned.   As a result of discrepancies between the data sets 

and data from providers, discussions have been held with six providers.  In all instances, the providers 

confirmed their data was correct.  After the discussions, an additional confidence level is assigned.  Over 

the next few months, the project will contact an additional eight providers to verify their data. 

 

5.  Feedback loop.  All service providers have been given the opportunity to review the geospatial 

representation of their data.   In addition, when updates to data were solicited, providers were 

questioned as to the accuracy of the geospatial display of their coverage areas. Approximately six 

providers have asked questions or provided feedback. 
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6.  Speed Test Analysis.  There are several issues to consider when comparing speed test data to service 

provider advertized maximum speeds.  Many speed tests do not collect the name of the service provider 

being tested.  In areas where more than one service provider offers varying maximum service speeds, it 

is not possible to know who is providing the service to the CAI.  Also, even if a speed test result is 

directly tied to a certain service provider, it is unknown if the customer has chosen to purchase the 

maximum available speed offered by the service provider.   

 

The speed test information CBDDP collects from CAIs requests the name of the service provider.  

Although CBDDP has collected speeds tests from 1,562 CAIs as noted in the table on Page 2, only 446 of 

those tests specifically identified the service provider.   Service providers report data by speed test tier, 

and the following table compares how the speed tier for the CAI speed test compares to the maximum 

advertized speed tier provided by the service provider. 

 

 

CAI Speed Test (Where Service Provider (SP) is Identified) Compared to SP Max. Adv. Down 

  Speed Test Slower  
Speed 
Test 

Equals  
Speed Test Faster 

Total 
Speed 
Tests 

Number of Speed Tiers 
Slower or Faster -6 -5 -4 -3 -2 -1 0 1 2 3 4 5 

 

School K - 12     5 
2
6 

2
7 59 35 24 

1
1 7 2 1 197 

Library             1 1         2 

Healthcare     2 3 4 5 6 2 3 2 1   28 

Public Safety 1 1 1 
1
1 6 37 44 17 7 4 1   130 

University, college   1 1 2 4 6 2 1 1       18 

Other Government 1 1 1 8 3 19 18 13 4 3     71 

Other Non-Government                         0 

              
 

          
 

Totals 2 3 
1
0 

5
0 

4
4 

12
6 106 58 

2
6 

1
6 4 1 446 

Totals 235 106 105 446 

 

 

 

7.  Drive Testing Mobile Coverage Areas.  CBDDP is testing the mobile wireless coverage areas reported 

by the service providers.  The combined coverage areas of all wireless provider data indicates 95.9% of 

the square miles in the state have available speeds of greater than 3 Mbps and less than 6 Mbps, and 

that only 3.9% of the square miles had less than 768 Kbps. 
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CBDDP has developed a drive test plan that will drive over 5,000 miles of roads.    Primary test points are 

selected along major highways.  Secondary points are then tested from one half to one mile away from 

the primary point to confirm the result of the primary point.  Up to four derived points are tested or 

until at least two tests fail with test speeds of less than 768 Kbps.    The tests are all taken via 

commercially available wireless air cards, identical laptops, and at the same FCC speed test site.   Only 

the major national providers are being tested.  The primary points are generally 10 to 15 miles apart, 

and the derived points are clustered around the A points within 2 to 3 miles. 

 

The following table presents the results of drive testing completed through March 3, 2011.  This includes 

five days of testing for two people and covered 2,300 miles.  CBDDP estimates there are approximately 

six days of testing to be complete the planned route.  Test results are shown only for points that fall 

within the coverage area provided by the service providers to CBDDP. 

 

 

MOBILE WIRLESS COVERAGE TESTING 

                    

All Points Tested Including Primary and Derived 

Combined Result for Three Providers Tested 

    Tiers Slower   Same Tier   Tiers Faster   Total Tests 

Number of Speed 
Tiers Slower or 

Faster 

< 
768 
Kbps -3 -2 -1 0 1 2 3   

  302   60 29 111 14 1   517 

Totals 391 111 15 517 

ATT 

    Tiers Slower Same Tier   Tiers Faster   Total 

Number of Speed 
Tiers Slower or 

Faster 

< 
768 
Kbps -3 -2 -1 0 1 2 3   

  79     29 11       119 

Totals 108 11 0 119 

Sprint 

      
Tiers 

Slower   Same Tier   Tiers Faster   Total 

Number of Speed 
Tiers Slower or 

Faster 

< 
768 
Kbps -3 -2 -1 0 1 2 3   

  85   1   100 14 1   201 

Totals 86 100 15 201 

Verizon 

      
Tiers 

Slower   Same Tier   Tiers Faster   Total 
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Number of Speed 
Tiers Slower or 

Faster 

< 
768 
Kbps -3 -2 -1 0 1 2 3   

  138   59           197 

Totals 197 0 0 197 

  
        

  

Primary Points Tested 

Combined Result for Three Providers Tested 

      
Tiers 

Slower   Same Tier   Tiers Faster   Total 

Number of Speed 
Tiers Slower or 

Faster 

< 
768 
Kbps -3 -2 -1 0 1 2 3   

  34   16 9 29 3 1   92 

Totals 59 29 4 92 

ATT 

      
Tiers 

Slower   Same Tier   Tiers Faster   Total 

Number of Speed 
Tiers Slower or 

Faster 

< 
768 
Kbps -3 -2 -1 0 1 2 3   

  10     9 2       21 

Totals 19 2 0 21 

Sprint 

      
Tiers 

Slower   Same Tier   Tiers Faster   Total 

Number of Speed 
Tiers Slower or 

Faster 

< 
768 
Kbps -3 -2 -1 0 1 2 3   

  1   1   27 3 1   33 

Totals 2 27 4 33 

Verizon 

      
Tiers 

Slower   Same Tier   Tiers Faster   Total 

Number of Speed 
Tiers Slower or 

Faster 

< 
768 
Kbps -3 -2 -1 0 1 2 3   

  23   15           38 

Totals 38 0 0 38 
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8.  Demographic Analysis.   

Using the October 1, 2010 data delivered to the NTIA, CBDDP completed an analysis of unserved 

(available broadband less than 768 Kbps downstream) and underserved (available broadband less than 3 

Mbps downstream).  The analysis was broken down by wireline, fixed wireless and mobile wireless.   

Availability analysis was completed at the census block level, and then aggregated to counties.  This 

effort allowed the project team to validate the population numbers presented by the National 

Broadband Map.  CBDDP believes the National Broadband Map accurately reflects served populations 

based on 2009 Census Data. 

 

Planned Data Verification and Analysis 
 

CBDDP has prepared a Survey Plan for residences.  The plan should be implemented in Q2 and Q3 and 

results used to validate, where possible, service provider information about availability.  A business 

survey is also under development. 

 

Summary of Process 

 
CBBDP follows a data collection process outlined on the National Broadband Map in the “Technical 

Overview” of the “About” section at www.broadbandmap.gov.  If you would like a more detailed, 

procedural description of the process, please contact CBDDP via email at COBroadband@state.co.us. 

  

The data gathering process begins by contacting the potential broadband providers.   Although 

participation is voluntary, many providers choose to support this effort.  The success of this program 

rests, in part, on that support, and we appreciate their efforts to participate in this program. 

Broadband providers submit data in a variety of formats, and in a number of cases, CBDDP also conducts 

technical assistance to support the efforts of smaller providers to participate.  For census blocks less 

than two square miles, the entire census block is presumed to have coverage if any service provider 

reports broadband anywhere in the census block.  For census blocks greater than two square miles, 

service is reported along road segments.  Before submitting data to NTIA, CBDDP integrates the data 

from each provider into a single dataset using a Data Model  required by the NTIA.   NTIA and the FCC 

then integrate CBDDP’s dataset along with those from all other states into the single National 

Broadband Map dataset. 

 

An earlier section in this report titled “Data Verification and Analysis”, describes the specific steps that 

CBDDP took, and the results of those steps, to verify the data before transmission to the NTIA.   

 

The CBDDP has implemented the following data collection and ingestion processes which may vary from 

other state programs. 

 

http://www.broadbandmap.gov/
http://www.broadbandmap.gov/about/technical-overview/data-model
http://www.broadbandmap.gov/about/technical-overview/layers-in-the-map
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1.  To spatially represent broadband service where the service provider has given CBDDP address 

specific information, CBDDP implemented the following process starting with the October 2010 data 

delivery.  A 150 foot buffer is drawn around each point.  Any census block touched by the buffered area 

is selected.  For census blocks greater than two square miles, any road segment touched by the buffer is 

selected.  CBDDP has met with the largest service provider in the state that provided address specific 

data, and they agree that the 150 foot buffer process is reasonable and creates an accurate 

representation of their service area. 

 

2.  Based on clarifications from the NTIA, CBDDP did not provide any features in the 

BB_Service_Overview feature class since more granular speed information was provided in the 

BB_Service_CensusBlock, BB_Service_RoadSegment and BB_Service_Address feature classes. 

 

3.  CBDDP is not currently collecting pricing information. 

 

3.  Reference layers include the U.S Census Bureau 2000 census blocks and 2009 Tiger data for roads. 

 

4.  CBDDP made a significant adjustment to the data set starting with the October 2010 data delivery.  

Very few of Colorado’s service providers have reported both their maximum advertized speed and the 

typical speeds a user might encounter.  During an in-person meeting, Qwest stated their advertised 

speeds are the typical speeds and there is no potential for degraded service during peak periods of use 

or distance from central office.  Based on this information from the service provider, CBDDP is using 

Qwest advertised as typical speed. 

 

5.  CBDDP has created an exception table that will record unusual areas or pockets were coverage may 

or may not exist.  The table will be persistent through provider updates, so these exceptions will not 

have to be rediscovered with each update. 

 

6.  CBDDP reports wireless towers in the Middle-Mile where they are being used for backhaul.  When 

service providers have submitted central office locations, they are included in the middle mile.  Qwest 

and Century did not provide such information, and have requested CBDDP not include publicly available 

central office locations in the data set.   

 

7.  CBDDP is utilizing a data collection contractor during the first two years of the program.  Starting 

October 1, 2011, and through the remainder of the program to October 31, 2014, CBDDP will bring this 

process in-house.  CBDDP has worked closely with the contractor, and has developed skills and 

experience in validating the information and working with the data sets.  It is expected this will be a 

seamless transition. 

 

8.  For CAIs, multiple data sources are compared where available.   However, speed test data is reported 

in preference to other types of data such as surveys, reports or speeds for which the CAI is paying.   
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9.  Addresses and names that appear to be duplicates are validated.  CBDDP chooses to report multiple 

CAIs at the same address as distinct entities.  For example, a county sheriff’s office and a 911 call center 

at the same address are reported as two distinct entities.  

 

 

Data Summary and Feature Class Statistical Tables 
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CONNECTICUT PROGRAM OVERVIEW 

 

In response to the Notice of Funds Availability published in the Federal Register on July 

8, 2009 (NOFA), the State of Connecticut Department of Public Utility Control (CT DPUC) 

submitted a grant application for consideration under the National Telecommunications and 

Information Administration’s (NTIA) State Broadband Data and Development Grant Program 

(SBDD), for broadband mapping. The CT DPUC, pursuant to Executive Order 32-A, has been 

designated as the single Connecticut state entity eligible to apply for funds under this program.   

The State has long been committed to regarding broadband delivery and enhanced use 

as a fundamental goal.  The State has developed a planning strategy to marshal the State’s 

resources and stakeholders and establish Connecticut as a leader in broadband usage, in 

addition to being a leader in “e-Government” and other broadband-dependent endeavors. 

 The State entered its SBDD initiative not possessing any data related to broadband 

service, availability, or infrastructure that could readily support the requirements of the Broadband 

Data and Development grant program.  Due to technical considerations, the DPUC has partnered 

with Applied Geographics Inc., to support the data collection and mapping efforts. 

 So far CT has been very successful in acquiring the requested information from the 

broadband service providers, and is utilizing this information on our own http://CT.gov/Broadband  

website as well as providing the needed information up to NTIA to support their national map. 

 

SUBMISSION 3 OVERVIEW 

For submission 3 (s3), roughly 50% of providers stated that their submission 2 (s2) service areas should be 
reused for s3.  The other 50% gave modifications to their data, provided updates to their earlier 
submissions, or delivered entirely new datasets.   

In general, the submission 3 processes followed the same basic approach that was used in submission 2. 
This document summarizes the following: 

• Submission 3 Processing Assumptions 

• Reference Data  

• NTIA Submission Data Model Schema Changes 

SUBMISSION 3 PROCESSING ASSUMPTIONS 

Based on NTIA feedback and information provided in NTIA webinar sessions, the submission 3 data 
processing workflow is based on the following assumptions to meet NTIA submission requirements.  
Many of these are similar to s2. 

1. All census blocks are mapped based on 2000 census blocks.  Any data submitted in 2009 format 
was converted to 2000 for submission.  During processing a ‘hybrid’ census dataset (2000 IDs 
with 2009 line work) was used to take advantage of the improved 2009 line work.  Prior to 

http://ct.gov/Broadband�
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submission to NTIA, all features were mapped back to the 2000 census blocks.  The Reference 
Data section below contains additional details. 

2. For consistent representation the state road reference data used was 2009 Census Tiger Line IDs 
(TLIDs).  Other data sources (non-TLID features, or 2000 TLID features) were mapped to 2009 
TLID features. 

3. Overview was removed completely from submission data due to the fact that all maximum 
advertised up/down speeds are being reported in blocks, roads, and wireless features. IN 
addition, none of the providers were willing to submit detailed pricing information. 

4. Due to our NDA restrictions, address points and last mile points will not be submitted to NTIA. 

5. Some providers did not submit middle mile elevation.  Wherever possible, we went back to 
providers to obtain their middle mile elevation information. 

6. Terrestrial Mobile Wireless and Terrestrial Fixed Wireless (licensed and unlicensed) were treated 
as wireless coverage and were delivered as a shape.  In cases where a provider served the same 
technology and spectrum with different speeds, overlapping areas were removed and the higher 
speed was assigned. 

7. The submission 3 Provider data model is currently based on the NTIA data model as of 1/13/11.   
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SUBMISSION 3: REFERENCE DATA  

This section describes the reference data used in submission 3.   

BLOCK REFERENCE SETUP 

For s3, a hybrid block dataset (2000 IDs with 2009 line work) was used to take advantage of the improved 
2009 geometry.  The data was set up as follows: 

• 2009 BlockID suffix is dropped and the blocks are dissolved (by Block ID) to produce data with 2000 
BlockIDs and 2009 shape geometry 

• Block size (AREA) is calculated combining the 2000 land area (ALAND) and water area (AWATER) 

• AREA is converted from square meters to square miles to calculate square mileage (SMI). 

• If the SMI of a block is less than or equal to 2, then the less than or equal to 2 square mile indicator 
(LE2SMI) is set to true. 

ROAD REFERENCE SETUP 

To take advantage of the 2009 geometry improvements, 2009 Tiger Line IDs (TLID) were used for data 
processing in s3.   Any non-2009 TLID (i.e. 2000 TLID or other) submitted by providers were mapped to the 
2009 reference data.  The data was set up as follows: 

• The GT2SMI (Greater Than 2 Square Mile) indicator is set to True when: 
o The 2009 road segment is completely within a hybrid

• Only minimum and maximum address ranges and a single zip code for each road segment is 
maintained.   

 block that is NOT less than 2 square 
miles 

REFERENCE DATA SOURCES 

The following summarizes block and road reference data sources for submission 3: 

BLOCK REFERENCE DATA:  2009 CENSUS BLOCKS 
The 2009 Census Block data is the most recent geometry provided by the US Census Bureau and has these 
characteristics: 

• The full 2009 Block ID is made up of the following characters: 
o (2) State 
o (3) County 
o (6) Tract 
o (4) Block 
o (1) Suffix - The 2009 Census Block data allocates a one-character alphabetic suffix to the end 

of a 2000 Block ID for all blocks that have been subdivided.   

• Fields of interest include: 
o [BLKIDFP]:: char(17) – Full Block ID 
o  [ALAND] :: double(14) – Land Area 
o  [AWATER] :: double(14) – Water Area 

• The 2009 Census block geometry has been adjusted to correspond with the revised and amended 
2009 Census road data. 
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• This data was downloaded for each state from the following website: 
http://www2.census.gov/cgi-bin/shapefiles2009/national-files 
 

ROAD REFERENCE DATA:  2009 CENSUS TIGER LINES 
The 2009 Census Tiger Line data contains the most recent geometry provided by the Census Bureau.  The 
following is a list of characteristics: 

• The Tiger Line Identification (TLID) system is stored as a double data type, although it contains only 
integer values 

• Fields of interest include: 
o [TLID] :: double(10) -- (Tiger Line ID) 
o [FULLNAME] :: char(100) – (Full Name) 
o [LFROMADD] :: char(12) – (Left From Address) 
o [LTOADD] :: char(12) – (Left To Address) 
o [RFROMADD] :: char(12) – (Right From Address) 
o [RTOADD] :: char(12) – (Right To Address) 
o [ZIPL] :: char(5) – (Zip Left) 
o [ZIPR] :: char(5) – (Zip Right) 
o [ROADFLG] :: char(1) – (Road Flag – Is segment a road?) 

• The 2009 Census Tiger Line road segment geometry was adjusted to correct 2000 segments 
misalignment; street name, type and directional information were concatenated into one database 
column (FULLNAME) and new road segments were added. 

• The Census road data is packaged by county.  Roads that exist as the boundary between counties will 
be duplicated in both county files.  

• This data was downloaded by county as full tiger line data at the following website: 
http://www2.census.gov/cgi-bin/shapefiles2009/national-files 

o Source data was filtered by row were [ROADFLG] = yes to create the reference data set. 

 

SUBMISSION 3: NTIA DATA MODEL SCHEMA CHANGES  

The data model released on January 13, 2011 contained the following changes to the s2 data model: 

• A new field was added to several feature classes called Provider Type 
o Provider Type is “Short Integer” and has domain values of 1, 2, or 3 (1= Broadband Provider, 

2=Reseller, 3=other) 
o Most providers are calculated to be “1” (Broadband Provider).  In some cases (e.g. State of 

Washington Public Utility Districts), providers are considered “Other” (value = 3). 
 

• In the CAI feature class, the field BBService has been modified: 
o In S2 if the information was not known, the field was left blank (null) 
o In S3, if we do not have the information, Null’s must be changed to code U (for Unknown) – 

nulls will not be allowed. 
 

• Three new fields have been added to the CAI feature class.  Wherever possible, these values have 
been populated in the CAI data.   

o PublicWifi (Y, N or U) 
o URL 
o CAIID 

http://www2.census.gov/cgi-bin/shapefiles2009/national-files�
http://www2.census.gov/cgi-bin/shapefiles2009/national-files�
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CONNECTICUT SPECIFIC INFORMATION  

 
 Due to Connecticut’s geography and population, over 99.5% of the census blocks in the state are less 
than two square miles. The need for us to break apart coverage based on blocks versus roads leads to a lot of 
unnecessary confusion as well as creates some distorted pictures when you try to visualize this information on 
a map.  For this reason, all of the maps available on the CT.gov/broadband website are published after we 
convert all of the data to just use blocks.  
 
 In the documentation form NTIA there has been a lot of discussion about making sure that a provider 
uses the same DBA and FRN consistently across all feature classes. We mentioned this to the providers, but 
there was some push back, especially from the national carries. In many of these cases the parent organization 
owns all of the middle mile infrastructure and utilizes one FRN for that. The actual distribution may often 
times be a smaller division of the organization, or may have been an acquired operation, and so the actual 
service will be listed under a different DBA and/or FRN. 

 There is also one provider that has given us two very similar DBA names: “DSL.net, Inc.” and “DSLnet 
Communications, LLC”. Each has a unique FRN. When we asked if we could merge these under one name, the 
company came back and was very adamant that we must keep these as separate and distinct entities. We 
honored that request and the data was submitted to NTIA as provided to us. 

 In regards to the NTIA sub domains concerning technology and speed, Connecticut has a few 
exceptions that we should note: 

• Cablevision has reported to us that they serve an area with both Cable-DOCSIS 3.0 and Cable-Other, 
and that in this region “they advertise a maximum download speed of 101 MBPS (Tier 10)”. We did 
ask the provider to clarify if the Tier 10 speed was for either technology type or only the DOCSIS 3.0 
records? We also asked if there was an “Other” technology that might also deliver 101MBPS. Every 
time we asked, the provider simply responded with their original answer “they advertise a maximum 
download speed of 101 MBPS.” So you will note that Cablevision has records with Technology codes 
of 40 and 41, with download speed tier 10. 

• Verizon New York Inc. reported to us that they provide both fiber to the end user and ADSL 
service to some areas of the state. Most of their service is in fact fiber to the end user, but in 
the other locations they report that there is fiber run most of the way, but not into the 
actual premises. They are advertising this alternative as ADSL, with max advertised 
download speeds in tier 9.   
 
On the NTIA webinar on March 17th

 

, it was recommended that the states generalize their wireless 
data submissions, to include filling or dropping small areas, and reducing the number of vertices. 
Unfortunately due to the extremely late timing of this notice, we were not able to act on these 
recommendations. Many of our providers require in their NDA’s that we process the data and then give 
them at least 10 business days to review and comment on any changes. Instead, we will look into 
adopting these changes in our fall submission. 
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Introduction 
The National Telecommunications and Information Administration (NTIA), a division of the U.S. 
Department of Commerce, through the Broadband Data Improvement Act (BDIA), has sponsored the 
State Broadband Data and Development Grant Program. This Program is designed to fund projects that 
gather comprehensive and accurate state‐level broadband mapping data, develop state‐level broadband 
maps, aid in the development and maintenance of a national broadband map, and fund statewide 
initiatives for broadband planning. 
 
The following white paper describes the data integration and verification processes employed by the 
District of Columbia in preparation of the Broadband Availability data set submitted to NTIA on April 1, 
2011. This data collection is to be conducted on a semi‐annual basis over a five‐year period.  The “Spring 
2011 Technical White Paper” will be the third round of ten semi‐annual submissions by the District of 
Columbia and attempts to reflect conditions in the field as of December 31, 2010 or later. 
 
The paper is divided into seven sections: 
 

Section 1 ‐ Data Description: describes April 1, 2011 deliverables to NTIA; 
 
Section 2 ‐ Provider Participation: summarizes provider cooperation;  
 
Section 3 ‐ Data Collection: describes outreach and collection efforts; 
 
Section 4 ‐ DC geospatial data: describes the role of DC GIS data in broadband data processing;  
 
Section 5 ‐ Data integration and processing: describes data manipulation steps; and 
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Section 6 ‐ Data validation: describes efforts to validate the data received. 
 
Section 7 – Documentation and Submittal: Includes the NTIA final checklist steps.  
 

SECTION 1 ‐ DATA SUBMISSION DESCRIPTION 

The District of Columbia’s spring 2011 submission consists of the following files: 

DC_SBDD_20110401.zip – Consolidates all other files for the purpose of data transfer. 

DC_SBDD_2011_04_01.gdb – An ESRI file based geodatabase that conforms to the data model 
distributed by NTIA.  It contains primary data and metadata. The District provides NTIA with five 
sets data: 

 Community Anchor Institutions – The location of community serving institutions and 
information about their broadband connections – if known. 

 Middle Mile Connections – The locations and attributes of infrastructure that 
interconnects broadband networks.    

 Wireless Broadband Availability – The service territories and attributes of wireless 
broadband providers including terrestrial fixed wireless and satellite.  

 Wireline Broadband Availability – The territories and attributes of wireline broadband 
providers by year 2000 Census Blocks. 

 Metadata – Information about the data sets described above. 

DC_DataPackage_2011_04_01.xls –A report on broadband providers contacted and the status 
of their submissions. 

DC_2011_04_01.txt  – An analysis of DC_SBDD_2011_04_01.gdb known as the “data submission 
receipt.” This file is created by an automated script supplied by NTIA. 

DC_Methodology_2011_04_01.pdf – An electronic version of the following document. 

DC_Readme_2011_04_01.txt – A reduced file with the same information found in the header 
and section 1 of this white paper. 

SECTION 2 ‐ PROVIDER PARTICIPATION 

 The PSC initially identified and contacted perspective 146 broadband providers. 
 Of those, 34 are believed to be providing broadband service in the District and are listed in 

DC_DataPackage_2011_04_01.xls.  
 Of those provided 28 availability data (either wireline and or wireless). 
 Six don’t provide service in District within 10 days. 
 Only  8 provided middle mile data. 
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SECTION 3 ‐ DATA COLLECTION 

Collection of Broadband Availability Data 
The District of Columbia Office of the Chief Technology Officer (“OCTO”) was awarded a grant from NTIA 
to map the availability of broadband services in the District of Columbia (“District”).  OCTO has 
delegated to the District of Columbia Public Service Commission (“PSC”) the responsibility for all 
interaction, including data collection, with the broadband service provider community.  
 

Process Steps 

1. Identifying and Contacting Broadband Providers 

 The work of identifying providers is conducted by the PSC.  The PSC reviewed its own records 

and those of the FCC.  Firm identified as providers were: 

1. All firms in PSC records as providing any kind of telecommunications service in the 

District. 

2. All firms identified by the FCC has having filed a form 477 for broadband service in the 

District. 

3. Satellite providers were also contacted.  

4. The initial identification of providers took place prior to the spring 2010 data call and 

has been refined for each NTIA submission.  The PSC reviewed the list of identified 

providers for fall 2010 and was able to weed out several firms that clearly were not in 

business within the District.  

2. Contacting providers ‐ The PSC requested the assistance and cooperation of all commercial 

broadband service providers that provide service to any residential, business, institutional, or 

government entity located within the District, to provide the PSC with broadband service location 

data.  Beginning in fall 2010 and continued into spring 2011, providers were asked to submit 

information regarding technologies and services that they resell and were not limited to providing 

data only regarding facility‐based services. 

 

Whenever possible, providers are initially contacted by email. The package of material sent by the 

PSC to providers: 

o A letter from the Chairman of the District of Columbia Public Service Commission.  

Sample letters can be found in Appendix 1.  Providers receive one of following three 

letters: 

 A letter to companies that have never submitted mapping data. 

 A letter to companies who submitted mapping data in round two. 

 A letter to companies who submitted round three data before even being asked. 
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o Non‐Disclosure Agreement (NDA) The PSC offers every provider opportunity to enter 

into a NDA between OCTO and the Provider.  The standard OCTO NDA is shown in 

Appendix 2.  The NDA explains how OCTO will handle the submitted data; including 

what portions of the data will be submitted to the NTIA and what derived products will 

become part of the public website on broadband services available within the District 

that is under construction by OCTO.  Key provisions of the District’s standard NDA 

include: 

 OCTO will give the data NTIA for the National Broadband Map. 

 The service territories of individual providers will not be made public by OCTO, 

but OCTO has created a public web site that allows users, including potential 

broadband service subscribers, to enter any valid address in the District of 

Columbia and be referred to all the broadband service providers offering service 

to that location. 

 Form 477 subscriber count data from all companies will be aggregated by OCTO 

at the Census Tract level.  OCTO will use this information to estimate the 

residential broadband adoption rate by Census Tract. Estimated broadband 

service adoption rates will be made public, but the market share of individual 

broadband service providers will not be revealed. 

o Provider submission form ‐ For spring 2011, OCTO and PSC revised the data request 

form.   The form is a Microsoft Excel based questionnaire which is accompanied by a 

glossary. Appendix 3 contains a copy of the form and glossary. The form collects 

information on: 

 The Provider (Includes: business name, DBA name, FRN#, URL, etc.) 

 Transmission Technology 

 Business type (facility based or reseller) 

 Service Territory 

 Maximum advertised and typical upload and download speeds 

 Wireless spectrum 

 Middle mile connection points 

 

3. Handling providers – While we hope that all providers complete our forms, not all do. In practice 

OCTO will accept a variety of submission types and our policy to is work with providers interactively 

via email and phone whenever we or they have questions. 
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SECTION	4	‐	THE	ROLE	OF	DC	GEOSPATIAL	DATA	

DC GIS maintains several datasets that are integral to processing provider submissions. Each dataset and 
how it is employed is described below: 

DC	GIS	Data	Set	
(Click	link	to	view	
and	double	click	
and	zoom)	

Description		 How	the	data	is	used	in	broadband	processing

Imagery		 6”	resolution	2010	
ortho	corrected	
imagery		

GIS analysts superimpose	provider	service	territory	on	
imagery	to	ensure	that	submission	fit	the	ground	in	a	
credible	way.	For	example,	do	we	have	wireline	service	
over	water	or	parks?		

DC	Base	Map	 1”	to	100’	planimetric	
map.	

Used	similarly	to	imagery.

Master	Address	
Repository	

A	precisely	located	
point	for	every	
address	in	the	District	

Used	to	process	address	lists	submitted	by	broadband	
providers.	Also	used	to	locate	and	map	Community	
Anchor	Institutions.	

Planning,	Landuse	
and	Zoning	

Includes	existing	land	
use	in	the	District	

Used	to	ensure that	broadband	providers	who	provide	
high	speed	service	to	business	are	not	shown	as	
providing	service	in	residential	areas.		

Education	
Libraries	
Health	
Public	Safety	
Recreation	

A	variety	of	GIS	layers	
that	include	
Community	Anchor	
Institutions	locations		

Used	to	identify	and	survey	as	many	Community	Anchor	
Institutions	as	possible.		
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SECTION	5	‐	DATA	INTEGRATION		

1. Submission Check‐in  

 Provider data submissions are received in several ways 

  Attachments to emails sent to the PSC. 

  Transfer of data by means of a USB drive. 

  Providers upload the data to a secure OCTO FTP site. 

  Provider mails the data to either PSC or OCTO, if data is received directly by OCTO, a GIS analyst 

will then check‐in the data, make a copy and submit the original to the PSC. 

 Entered into a PSC submission tracking spreadsheet. 

 Scanned for viruses. 

 Given an initial review to ensure that each major component is present.    

 PSC will then contact OCTO that new data has arrived.  The transfer of the data from. 

 

 Feedback from returning providers – PSC and OCTO encourage feedback from returning providers. 

Providers may reference previous submissions and review check plots.  

 

 OCTO Submission Processing Data Attributes 

 After the submission has been checked in by the PSC and received by OCTO, an excel “Provider 

Status” table is created to follow the progress or status of the broadband data that is being 

received.  The first column lists the date the data was received, the second column, the provider 

name, the additional columns are represented by the fields in the data model.  A “yes” or “no” is 

placed in the corresponding row of each provider indicating if that data type is received.  

Processing steps vary based on the type of data submitted [wireless, wire line or middle‐mile] 

and the type of data provided [GIS data, Paper/PDF, data table, etc.].  

 

 Wireline Data Processing ‐ The information that was collected, with regard to the data model 

on Wireline availability is as follows: 

 Provider Name 

 Doing Business As 

 FRN (Federal Registration Number) 

 Census Tract and Block number 

 Technology of Transmission (DSL, Cable, Satellite, etc.)  
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 Maximum Download speed (greater than 768 kbps) 

 Maximum Upload Speed (greater than 200 kbps) 

 Typical Download Speed 

 Typical Upload Speed 

 

 OCTO Submission Processing Geographic 

 Service territory description ‐ In order for a provider to be eligible and have their data 

processed, the Company’s service territory should offer service to new customers within 10 days 

of a service order without extraordinary effort.   Note: A Company can have multiple service 

territories within the District of Columbia, and those territories need not be contiguous.  NTIA 

requires that the service territory be mapped to the nearest Census Block.  Companies have 

several options for describing their service territory: 

 Initially, it is necessary to determine whether the Company meets the definition of a “District‐

wide broadband service provider.”  The Company must “offer broadband service” to the 

“entire District of Columbia.” The following definitions apply: 

o “Broadband service” is the provision to end users of two‐way data transmission to and 

from the Internet with advertised speeds of at least 768 kilobits per second (Kbps) 

downstream and greater than 200 Kpbs upstream. 

o “Offer” means that the Company can provide broadband service to end users (a 

residential, business, institutional or government entity) within 10 business days of a 

service order without an extraordinary commitment of additional resources. C also 

interprets offer to be a commercial service we are not mapping free services such as 

Wifi hotspots at this time. District of Columbia Government free Wifi hotspots are 

included in the Community Anchor Data. 
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o The “entire District of Columbia” means that a wireline company offers service to 

residential, business, institutional, or government end users in every Census Block in the 

District.  This definition expressly excludes parkland, cemeteries, institutional campuses, 

bodies of water, and military bases.  The definition also excludes real estate complexes 

where the landlord, condominium association, or similar entity controls the provision of 

wireline service.  Even if the firm doesn’t offer service in some or all of these areas, it 

can still be a District‐wide provider, which simplifies the submission.  This caused some 

problems with OCTO’s fall 2010 submission where we now believe some service 

territories where overstated. In spring 2011 any firm claiming to be a citywide provide 

received greater scrutiny. In particular providers that service businesses with Ethernet 

of copper where restricted to reporting service in commercial, high density residential, 

and industrial areas as shown on the District’s Existing Land Use Map.   

o If the Company meets the definition of a District‐wide broadband service provider, the 

description of the Company’s service territory is complete.  If the answer was “no,” then 

an option must be selected to describe the Company’s service territory.    Any of the 

following may be attached to the e‐mail to describe the Company’s service territory: 

o A Detailed Map(s) – Submitted maps should delineate the service area boundaries and 

label all DC streets within those boundaries.  The map may be a PDF file.  Geographic 

Information System (GIS) or Computer Aided Design files may be submitted in lieu of a 

map.   

o A List of Census Blocks – The Company may provide a list of Census Blocks in which they 

offer service.  The list should be provided in a Microsoft Excel File or Text File with each 

Census Block listed on a separate row. Excel File 

 

 
 

o A Written Description – The Company may describe one or more polygons.  For 

example, a service territory in part of downtown could be described as “East of 23rd 

Street NW, South of K Street NW, West of 17th Street NW, North of Constitution Ave 

NW. “  Alternatively, the territories can be described by using buffers,  for example, 

“Within 500 feet of 441 4th Street NW Washington DC 20001.”   
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o Address File ‐ If service is only offered to certain addresses, a list of those addresses 

may be submitted.   Address lists (whether for buffering or not) should be submitted in a 

Microsoft Excel table or text file with each address on a separate row. Address lists are 

geocode to the structure using the District’s Master Address Repository. OCTO 

encourages providers to submit all addresses where service can be provided within 10 

days not just the address of current subscribers.     

 

o Form 477 – The Form 477 already includes a list of Census Tracts where the firm has 

existing customers.  Census Blocks nest within Census Tracts.  Optionally, the Company 

may indicate that it wishes to use the Census Tracts already listed within its Form 477, 

minus a list of Census Blocks within those Tracts in which it does not offer service. 

 

 

 Wireless Data Processing‐ If the firm is a wireless broadband (Internet) service provider, the 

following questions were asked in a questionnaire: 

 Is Cellular spectrum (824‐849 MHz; 862‐869 Mhz) used to provide service? (Y/N) 

 Is 700 MHz spectrum (698‐758 MHz; 775‐788 MHz; 805‐806 MHz) used to provide service? (Y/N) 

 Is Broadband Personal Communications Services spectrum (1850‐1915 MHz; 1930‐1995 MHz) 

used to provide service? (Y/N) 

 Is Advanced Wireless Services spectrum (1710‐1755 MHz; 2100‐2155) used to provide service? 

(Y/N) 

 Is Broadband Radio Service/Educational Broadband Service spectrum (2496‐2690 MHz) used to 

provide service? (Y/N)  

 Is Unlicensed (including broadcast television “white spaces”) spectrum used to provide service? 

(Y/N) 

 Is Specialized Mobile Radio Service (SMR) spectrum (817‐824 MHz; 862‐869 MHz; 896‐901 MHz; 

935‐940 MHz) used to provide service? (Y/N) 



10 
 

 Is Wireless Communications Service (WCS) spectrum (2305‐2320 MHz; 2345‐2360 MHz; 3650‐

3700 MHz) used to provide service? (Y/N) 

 Is Satellite (L‐band, Big LEO, Little LEO, 2GHz) spectrum used to provide service? (Y/N) 

 Wireless providers often provided a polygon shapefile of their coverage areas and if they were a 

existing provider they communicated if the coverage information has changed.  For the most the 

majority of the wireless providers provided coverage for the entire District.  

 

 Middle Mile Data Processing ‐ Broadband service providers were also asked for a list of “middle‐

mile and backbone interconnection points” in the District of Columbia.  Interconnection points are 

facilities that provide connectivity between (a) a service provider’s network elements (or segments) 

or (b) between a service provider’s network and another provider’s network, including the Internet 

backbone. (Collectively, (a) and (b) are middle‐mile and backbone interconnection points.   Middle‐

mile and backbone interconnection points typically enable relatively fast data rates, are built to 

handle substantial capacities, and may be service‐quality assured.   Examples might include: points 

of interconnection enabling communications between an incumbent local exchange carrier’s central 

office and the Internet, between a cable aggregation point (headend) and the Internet, or between 

a wireless base station and the provider’s core network elements that connect to other networks, 

including the Internet. 

 
 Providers were asked to fill out an excel spreadsheet asking information based 

on the table shown above. Providers were asked if they had middle mile 
locations within the DC area and to list each location in the table on the 
spreadsheet.  Locations that fell within the DC area were geocoded and a point 
file was created.  
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Data Review and Consultation with Providers 

 If a component of the submission is missing, the OCTO GIS analyst will contact PSC for 

assistance to receive the missing data from the provider. 

 PSC and OCTO will schedule several meetings before final submittal: to review what 

providers has submitted data and who has not; and discuss action points that need to be 

addressed, i.e. which provider needs to be contacted again. Review the process and how it 

can be improved. 

 The excel “Provider Status” table is reviewed at  each meeting and updated several times 

during the process to follow the progress of the each data submission and to ensure that 

attempts have been made to contact the provider. 

 As a result of inquiries from NTIA about DC’s round 2 data, we are spending more time 

talking to providers, particularly those who claim to offer citywide service.  Most providers 

respond openly and are willing to make changes to their submissions when questions are 

raised.  

 The NTIA receipt script is run against each provider submitted dataset separately. Repairs 

and reruns are iterated as may be required. 

 

 Community Anchor Institutions  
As part of the reporting requirements for the grant, OCTO is required to collect a list of 
Community Anchor Institutions (CAI).  The dataset provides information on the broadband 
service available at these institutions.   The dataset 'District of Columbia Community Anchor 
Institutions' consists of schools, libraries, medical and healthcare providers, public safety 
entities, community colleges and other institutions of higher education, and other community 
support organizations and entities within the District.    

 The data was compiled by OCTO from data submitted by various district agencies and/or 
institutions contacted directly via a phone and e‐mail survey. 

 From this list, DC Government is required to collect specific information on broadband 
service usage (technology type, and download/upload speeds) for each identified 
institution.   

 For locations not supported by the District of Columbia, a follow‐up survey with the 
managing agency was conducted to identify the internet service type and service speed. 
The responses were compiled and attributed as defined by the State Broadband Data 
and Development Grant Program. Non‐government Community Anchors: Non‐
government community anchors were contacted individually via a phone and e‐mail 
survey. The survey requested the internet service type and service speed at the 
institution's location(s). The responses were compiled and attributed as defined by the 
State Broadband Data and Development Grant Program. Appendix 4 contains a copy of 
the Community Anchor Survey instrument. 
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 The NTIA receipt script is run against Community Anchor Data separately. Repairs and 
reruns are made as may be required. 

 

SECTION 6 ‐ DATA VALIDATION 

During this stage, data from providers are compared with data from other sources. Discrepancies are 

noted and sent to the contributing provider for comment. Validation techniques vary by the type of data 

submitted [wireless, wire line, or middle‐mile].   The following steps were taken to validate the data 

submitted:   

 

1. Wireless Validation ‐ The District completed drive testing of major wireless providers.  Drive test 

were completed in a single vehicle employing multiple laptops and GPS.  This was accomplished by 

installing computer and GPS hardware and software in a vehicle and testing and mapping upstream 

and downstream transmission speeds.  Some new wireless providers were not tested during the 

second round.  These are noted in the validation field of DC’s data submission.  To this time, DC has 

not shown the drive test data to providers nor discussed our collection techniques with them.  This 

data was collected with public funds and is not covered by NDAs, but DC has not made a decision to 

release it publically at this time.  The good news is all providers who claim to be providing citywide 

wireless service are providing it, and to that end DC will declare all providers who submitted service 

territories to be "valid" in tomorrow's data submittal.  That said, speed of service does drop below 

the definition of broadband, and does very across providers, place, and time.  Appendix 3, describes 

the wireless verification results. DC did not conduct new drive testing for spring 2011. The fall 2010 

drive testing results can be found in Appendix 5.  

 

2. Wireline Validation 

 The District, through PSC, has made extensive use of FCC Form 477 data.  The Form 477 was 

used to: verify that we have contacted the correct providers; compare the technology of 

transmission and speed of transmission between what was reported to the FCC and what was 

submitted by the provider; Compare the geography reported to the FCC in census tracts with 

the areas submitted to the District in census blocks.  Where discrepancies were found, the 

providers were asked for more information.  

 

 The District purchased a database of broadband subscribers from a commercial mailing list 

company InfoUSA.  The dataset is used to crosscheck data coming from providers.  The 

commercial mailing is not definitive, where discrepancies have been found, the providers were 

asked for more information. Appendix 6 contains a sample wireline validation map showing a 

DSL providers submitted service territory and black dots where InfoUSA reported subscribers. 
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 Middle Mile Validation – To date the district has not attempted to validate middle mile data 

other than checking locations against GIS base data to be sure they are plausible.  

 

3. Final Review – Due directly from question we receive following round 2 about DC’s data submission, 

all data, now undergoes a standup review conducted jointly by OCTO and PSC staff. Do service 

territories seem plausible? Do speeds seem realistic? How do speeds compare to other providers 

using similar technologies? What is the total DSL, Cable, Fiber, coverage does that seem plausible?    

 
4. Amalgamation and documentation ‐ Unless a provider's submission is conclusively invalidated 

(which hasn’t happened) and the issue cannot be resolved with the contributing provider, it is 

included in the amalgamation phase. Until this stage, OCTO handles each submission separately. 

During this stage, all successful submissions are appended to the latest version of the NTIA/NSGIC 

geodatabase model, and FCC‐requested transmittal forms are prepared. 

 The data is appended to the NTIA geodatabase model. 

 Quality Review the amalgamated data is given a final quality review by the GIS Analysts 

involved in the broadband grant program. 

 FGDC Compliant metadata is prepared and included in the geodatabase. 

 The NTIA provided script is run for the last time on the data set as a whole. 
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SECTION 7 ‐ DOCUMENTATION AND SUBMITTAL 

Once past the quality review, the data sets are submitted to NTIA/FCC via secure FTP. FCC data package 

documents are included. The checklist provided by NTIA is followed: 

 

Number  Question 

1 
Have you obtained a new clean Transfer Data 
Model? 

2 
Have you followed the instructions for loading 
data into the Transfer Data Model? 

3 
Have you run the receipt process 
(SBDD_CheckSubmission) and resolved all data 
integrity issues? 

4 
Have you included your receipt text file as part of 
the package? 

5  Have you populated the metadata fields? 

6  Have you exported the metadata as .xml files?

7 
Have you obtained a new data_package.xls and 
filled it out appropriately? 

8  Have you included methodological description?

9 
Have you followed the required naming 
conventions of all the files? 

10 

If you are resubmitting any data for the current 
collection, have you (a) deleted your previous 
submission (b) informed the Program Office or 
the FCC of your resubmission and (c) resubmitted 
your entire data package (e.g., the Program Office 
is not accepting an partial submissions)? 
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Appendix 1 
Sample Letters 

From 
DC Public Service Commission 

To 
Perspective Broadband Providers 
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PSC Letter to Companies that Have Never Submitted Mapping Data 

Dear [Virgil: enter name of Priority #2 company’s contact], 

The District of Columbia Office of the Chief Technology Officer (“OCTO”) has been awarded a 
grant from the U. S. Department of Commerce, National Telecommunications and Information 
Administration (“NTIA”) to map the availability of broadband services in the District of 
Columbia (“District”).  Pursuant to a Memorandum of Understanding, OCTO has delegated to 
the District of Columbia Public Service Commission (“Commission”) the responsibility for all 
interaction, including data collection, with the broadband service provider community.  To meet 
the objectives under the NTIA’s State Broadband Data and Development Grant Program to 
create national and state broadband service availability maps, the Commission requests the 
assistance and cooperation of all broadband service providers that enable a residential, business, 
institutional, or government entity located within the District to use broadband Internet services.   
Please note that broadband service providers are requested to submit information 
regarding technologies and services that they resell and are not limited to providing data 
only regarding facility-based services.  

As you know, the Federal Communications Commission requires broadband service providers to 
file on March 1, 2011 the Form 477 to provide broadband service data, as of December 31, 2010, 
for their networks.  In order to enable OCTO to identify any improvements or changes in the 
adoption rates for broadband services within the District, I request that you provide us with a 
copy of the Form 477 for the [Virgil: insert company’s name]  (“Company”) broadband services 
in the District of Columbia (“District”) which you file with the FCC. 

Attached to this email is a copy of OCTO’s “District of Columbia - Mapping Questionnaire – 
Spring 2011 (Round 3)” which should be filled out by your Company and submitted along with 
the copy of the March 1, 2011 Form 477 for the District. 

The requested copy of your Company’s Form 477 for the District and the completed 
“District of Columbia - Mapping Questionnaire – Spring 2011 (Round 3)” should be 
submitted to the Commission by Monday, March 7, 2011.  The March 1, 2011 Form 477 for 
the District and the completed Round 3 Questionnaire should be submitted to the Commission as 
an attachment to an e-mail response to Virgil J. Young, Jr., Senior Telecommunications Analyst, 
at vyoung@psc.dc.gov.  A secure FTP site is available for companies that prefer that method of 
transmittal.  

If the Company does not currently provide broadband Internet services to a residential, business, 
institutional, or government entity located within the District, please inform the Commission of 
such fact in an email response to Mr. Young.  In such a case, there is no need to submit the 
Questionnaire. 
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We are also providing you with a simple Non-Disclosure Agreement (see attachment: “NDA 
Form.doc” (“NDA”)).  The NDA explains how OCTO will handle the submitted data; including 
what portions of the data will be submitted to the NTIA and what derived products will become 
part of OCTO’s website on broadband services available in the District.  At your discretion, to 
restrict the distribution of your Company’s submitted data, review, sign, and return the NDA 
with the submission of the Questionnaire to the Commission.     

Thank you for completing this data request.  We have attempted to make the process minimally 
burdensome, but understand that questions may arise.  Should you have any questions regarding 
this request, please contact my Policy Advisor, Cary B. Hinton, at chinton@psc.dc.gov or 202-
626-9186. 

Thank you for your assistance, 

Betty Ann Kane 
Chairman 

District of Columbia Public Service Commission 

 

Attachments: 

1. District of Columbia ‐ Mapping Questionnaire – Spring 2011 (Round 3) 
2. District of Columbia ‐ Mapping Questionnaire – Definitions 
3. NDA Form 
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PSC Letter co Companies that submitted mapping data in previous rounds. 

Dear [Virgil: insert name of Priority #1 company contact], 

The District of Columbia Public Service Commission (“Commission”) and the District of 
Columbia Office of the Chief Technology Officer (“OCTO”) would like to thank you for the Fall 
2010 (Round 2) submission of broadband service data to map the availability of the [Virgil: 
insert company’s name]  (“Company”) broadband services in the District of Columbia 
(“District”).     

This email concerns the Company’s Spring 2011 (Round 3) submission. In order to meet the 
objectives under the National Telecommunications and Information Administration’s State 
Broadband Data and Development Grant Program to create national and state broadband service 
availability maps, the Commission requests the assistance and cooperation of all broadband 
service providers that enable a residential, business, institutional, or government entity located 
within the District to use broadband Internet services.  Please note that broadband service 
providers are requested to submit information regarding technologies and services that 
they resell and are not limited to providing data only regarding facility-based services.   

 As you know, the Federal Communications Commission requires broadband service providers 
to file on March 1, 2011 the Form 477 to provide broadband service data, as of December 31, 
2010, for their networks.  In order to enable OCTO to identify any improvements or changes in 
the adoption rates for broadband services within the District, I request that you once again 
provide us with a copy of the Form 477 for the District which you file with the FCC. 

Attached to this email is a copy of OCTO’s “District of Columbia - Mapping Questionnaire – 
Spring 2011 (Round 3)” which should be filled out by your Company and submitted along with 
the copy of the March 1, 2011 Form 477 for the District. 

The requested copy of your Company’s Form 477 for the District and the completed 
“District of Columbia - Mapping Questionnaire – Spring 2011 (Round 3)” should be 
submitted to the Commission by Monday, March 7, 2011.  If applicable, the original Non-
Disclosure Agreement with OCTO is still effective and will be honored.  The March 1, 2011 
Form 477 for the District and the completed Round 3 Questionnaire should be submitted to the 
Commission as an attachment to an e-mail response to Virgil J. Young, Jr., Senior 
Telecommunications Analyst, at vyoung@psc.dc.gov.  A secure FTP site is available for 
companies that prefer that method of transmittal.  

Should you have any questions regarding this request, please contact my Policy Advisor, Cary B. 
Hinton, at chinton@psc.dc.gov or 202-626-9186. 

Thank you for your assistance, 
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Betty Ann Kane 
Chairman 
District of Columbia Public Service Commission 
 

Attachments: 

1. District of Columbia - Mapping Questionnaire – Spring 2011 (Round 3) 
2. District of Columbia - Mapping Questionnaire – Definitions 
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PSC Letter co Companies only lacking a Form 477 

Dear [Virgil: insert name of company contact], 

The District of Columbia Public Service Commission (“Commission”) and the District of 
Columbia Office of the Chief Technology Officer (“OCTO”) would like to thank you for the 
recent submission of Round 3 broadband service data to map the availability of the [Virgil: insert 
company’s name]  (“Company”) broadband services in the District of Columbia (“District”).   

As you know, the Federal Communications Commission requires broadband service providers to 
file on March 1, 2011 the Form 477 to provide broadband service data, as of December 31, 2010, 
for their networks.  In order to enable OCTO to identify any improvements or changes in the 
adoption rates for broadband services within the District, I request that you once again provide us 
with a copy of the Form 477 for the District which you file with the FCC. 

The requested copy of your Company’s Form 477 for the District should be submitted to 
the Commission by Friday, March 4, 2011.  As usual, the original Non-Disclosure Agreement 
with OCTO is still effective and will be honored.  The March 1, 2011 Form 477 for the District 
should be submitted to the Commission as an attachment to an e-mail response to Virgil J. 
Young, Jr., Senior Telecommunications Analyst, at vyoung@psc.dc.gov.  A secure FTP site is 
available for companies that prefer that method of transmittal.  

Should you have any questions regarding this request, please contact my Policy Advisor, Cary B. 
Hinton, at chinton@psc.dc.gov or 202-626-9186. 

Thank you for your assistance, 

Betty Ann Kane 
Chairman 
District of Columbia Public Service Commission 
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NON-DISCLOSURE AGREEMENT	

(District of Columbia Broadband Service Mapping)	

This Non-Disclosure Agreement (“Agreement”) is between the Office of the Chief 
Technology Officer of the District of Columbia (“OCTO”) and __________________ 
(“Company”), a corporation having a business address at ____________________ 
__________________________________________________________________. 

RECITALS	

A. Company wishes to disclose and OCTO wishes to receive certain information from 
Company represented by Company to be confidential and commercial / proprietary 
information (hereinafter collectively, “Information”) pertaining to _________________.  
This exchange includes all communication of Information between the parties in any 
form whatsoever, including oral, written and machine readable form, pertaining to the 
above. 

B. OCTO wishes to receive and Company wishes to disclose the Information for the 
sole purpose of participating in national broadband service mapping activities.  OCTO 
will disclose the information only in the following ways:  

To The public: 

- The service territories of individual providers will not be made public, but OCTO 
will create a public web site that allows users, including potential broadband 
service subscribers, to enter any valid address in the District of Columbia and be 
referred to all the broadband service providers offering service to that location.  
 

- Form 477 subscriber count data from all companies will be aggregated by OCTO 
at the Census Tract level.  OCTO will use this information to estimate the 
residential broadband adoption rate by Census Tract. Estimated broadband 
service adoption rates will be made public, but the market share of individual 
broadband service providers will not be revealed. 

 
To the U.S. Department of Commerce, National Telecommunications and Information 
Administration (NTIA): 
 

- The broadband service data required by the NTIA in the Notice of Funds Availability; 
clarification published in the Federal Register; August 7, 2009 (74 FR 40569).     
 

To the Metropolitan Police Department and the District of Columbia Homeland Security and 
Emergency Management Agency: 
 

- Middle-mile connection points will be added to the District’s critical infrastructure data 
base.   This critical infrastructure database is used only for public safety purposes.  
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These data will not be shared outside law enforcement and homeland security 
communities. 

 

AGREEMENTS	

Therefore, OCTO and Company agree as follows: 

1. That the disclosure of Information by Company is in confidence and thus OCTO 
agrees to: 

a. (1) Not disclose the Information to any other person, and (2) use at least the same 
degree of care to maintain the Information confidential as OCTO uses in maintaining as 
confidential its own confidential information, but always at least a reasonable degree of 
care; 

b. Use the Information only for the above purpose; 

c. Restrict disclosure of the Information solely to those employees or contract staff of 
OCTO having a need to know such Information in order to accomplish the purposes 
stated above; The District Government operates an in-house broadband service 
provider known as DC Net, accordingly, the Information expressly will not be shared by 
OCTO with DC Net as an organization or its employees.  

d. Advise each such individual, before he or she receives access to the Information, of 
the obligations of OCTO under this Agreement, and require each such individual to 
maintain those obligations. 

2. This Agreement imposes no obligation on OCTO with respect to any portion of the 
Information received from Company which:  (a) was known to OCTO prior to disclosure 
by Company, (b) is lawfully obtained by OCTO from a third party under no obligation of 
confidentiality, (c) is or becomes generally known or publicly available other than by 
unauthorized disclosure, (d) is independently developed by OCTO or (e) is disclosed by 
Company to a third party without a duty of confidentiality on the third party. 

3. This Agreement imposes no obligation on OCTO with respect to any portion of the 
Information unless such portion is: (a) disclosed in a written document or machine 
readable media marked as “COMMERCIAL / PROPRIETARY INFORMATION” at the 
time of disclosure, or (b) disclosed in any other manner and summarized in a 
memorandum mailed to OCTO within thirty (30) days of the disclosure. Information 
disclosed by Company in a written document or machine readable media and marked  
“COMMERCIAL / PROPRIETARY INFORMATION” includes, but is not limited to, the 
items, if any, set forth in the request for broadband service data from the District of 
Columbia Public Service Commission (“Commission”); attached hereto. The 
Commission’s request for broadband service data is incorporated herein by reference. 
OCTO hereby acknowledges receipt of the items listed in the Commission’s request for 
broadband service data, if any. 
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4. The Information shall remain the sole property of Company. 

5. In the event of a breach or threatened breach or intended breach of this Agreement 
by either party, the other party shall be entitled to preliminary and final injunctions, 
enjoining and restraining such breach or threatened breach or intended breach. 

6. OCTO agrees it will not export, directly or indirectly, any technical data acquired from 
Company or any product utilizing any such data to any country for which the U.S. 
Government or any agency thereof at the time of export requires an export license or 
other governmental approval, without first obtaining such license or approval. 

7. The validity, construction, and performance of this Agreement are governed by the 
laws of the District of Columbia, and suit may be brought in the District to enforce the 
terms of this Agreement. 

8. The rights and obligations of the parties under this Agreement may not be sold, 
assigned or otherwise transferred. 

This Agreement is binding upon OCTO and Company and upon the directors, officers, 
employees and agents of each. This Agreement is effective as of the later date of 
execution and will continue indefinitely.  

Office of the Chief Technology Officer of the District of Columbia 

By 

Name:_______________________________ 

Title:________________________________ 

Date:________________________________ 

(Company)	

By: 

Name:_______________________________ 

Title:________________________________ 

Date:__________________________________ 
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Microsoft Excel 
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Business Type

Districtwide* 

Code Description Yes/No Upload Speed 

(Ex.1) Yes 768 kbps to 1.49 mbps

1
2
3
4
5

Length of time to 
provide service

Typical Speed

* Districtwide Definition :  The Company must be able to “offer broadband service” to the “entire District of Columbia”, (residential, business, 
institutional or government entity within 10 business days of a service order without an extraordinary commitment of additional resources.) 
with advertised speeds of at least 768 kilobits per second (Kbps) downstream and greater than 200 Kpbs upstream .

Maximum Advertised Speed

Download Speed 

1.5 to 2.9 mbps201 to 767 kbps

Upload Speed 

Technology
Transmission 

District of Columbia - Mapping Questionnaire Spring 2011 (Round 3)
This questionnaire has three sheets. Each sheet collects a different type of information.  Tabs at the bottom of the 
workbook allow users to switch among the three sheets.
Date Submitted:<mm/dd/yyyy>

Company Name:

Doing Business As:

FRN #:

Contact Name:

Contact Email:

Contact Address1:

1.1 Provide a URL of the Company's website to which the District should refer potential broadband service subscribers.

Contact Address2:

Contact City, State Zip code:

1.2 Is your Company a facility based provider or a reseller?  Please select the cell next to the technology that you provide and 
choose from the dropdown menu which business type applies.

1.4 Complete the following dropdown table for each Technology of Transmission that your company provides. 
(One row for each Technology of Transmission - click on the cell to view a list of selections per column).

1.5  For each Technology of Transmission that was selected in 1.2 how long does it take to provide service to a customer after 
service has been ordered? (Click on the cell next to each Technology you provide and select the length of time from a drop-down 
list).

Download Speed 

768 kbps to 1.49 mbps10 Asymmetric

41 Cable-Other

Technology

10 Asymmetric
20 Symmetric

50 Optical Carrier

<Company Name>

Technology

40 Cable DOCSIS 3.0

30 Other Wireline
40 Cable DOCSIS 3.0

Length of time to
 provide service

10 Asymmetric
20 Symmetric
30 Other Wireline

1.3  If your company is a resller, who is the facility based provider(s)?

90 Electric Power Line
0 Other

0 Other

41 Cable-Other
50 Optical Carrier

Business Type Technology
60 Satellite
70 Terrestrial Fixed Wireless - Unlicensed
71 Terrestrial Fixed Wireless - Licensed
80 Mobile Wireless

Technology

60 Satellite
70 Terrestrial Fixed Wireless - Unlicensed
71 Terrestrial Fixed Wireless - Licensed
80 Mobile Wireless
90 Electric Power Line
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Proceed to Sheet 3.

<Company Name>
Wireless Spectrum Questions (Wireline only companies may skip this sheet.)

2.1 Is cellular spectrum (824-849 MHz; 862-869) used to provide service? (Y/N)
"Yes" or "No"

2.6. Is Unlicensed (including broadcast television “white spaces”) spectrum used to provide 
broadband service? (Y/N)

2.2 Is 700 MHz spectrum (698-758 MHz; 775-788 MHz; 805-806 MHz) used to provide service? 
"Yes" or "No"

"Yes" or "No"

"Yes" or "No"

2.4. Is Advanced Wireless Services spectrum (1710-1755 MHz; 2100-2155 MHz) used to provide 
broadband service? (Y/N) 

2.3. Is Broadband Personal Communications Services spectrum (1850-1915 MHz; 19301995) 
used to provide service? (Y/N)

"Yes" or "No"

2.5. Is Broadband Radio Service/Educational Broadband Service spectrum (2496-2690 MHz) 
used to provide broadband service? (Y/N)

"Yes" or "No"

2.8. Is Wireless Communications Service (WCS) spectrum (2305-2320 MHz; 2345-2360 MHz; 
3650-3700 MHz) used to provide broadband service? (Y/N) 

2.9. Is Satellite (L-band, Big LEO, Little LEO, 2GHz) spectrum used to provide broadband 
service? (Y/N)

2.7. Is Specialized Mobile Radio Service (SMR) spectrum (817-824 MHz; 862-869 MHz; 896-901 
MHz; 935-940 MHz) used to provide broadband service? (Y/N)

"Yes" or "No"

"Yes" or "No"

"Yes" or "No"
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Counter
 *Serving Facility 

Capacity Code
**Serving Facility 

Type  Code

*** Latitude          
(Optional if address 

provided)

 *** Longitude       
(Optional if address 

provided)

Elevation (in feet 
from grade. 

Negative 
numbers are 
below grade)

Example (1-6) See below (1-4) See below 38° 53' 43.6" N 77° 0' 56.35" W                        15 

* Serving Facility 
Capacity Code 

** Serving Facility
Type Code Description

1 Multiple T1s and less than 40 mbps 1 Fiber
2 Greater than 40 mbps and less than 150 mbps 2 Copper
3 Greater than 150 mbps and less than 600 mbps 3 Hybrid Fiber Coax (HFC)
4 Greater than or equal to 600 mbps and less than 2.4 gbps 4 Wireless
5 Greater than or equal to 2.4 gbps and less than 10 gbps
6 Greater than or equal to 10 gbps

*** Coordinates must be expressed using the WGS 1984 geographic coordinate system.

Data Rate

Facility Address In DC                   
(Street#, Street Name, Street Type, 

Quadrant)

123 Main Street NW

Owned or Leased

Owned/Leased

…add rows as needed
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Appendix 4 
Community Anchor Survey Instrument 

Google Docs 
   



District of Columbia - Community 
Anchor Institutions
The District of Columbia Office of the Chief Technology Officer (“OCTO”) is in the third stage of the State 
Broadband Data and Development Map Program; awarded by the United States Department of Commerce, 
National Telecommunications and Information Administration (“NTIA”) to map the availability of broadband 
services in the DC region. 
 
One of the grant requirements is to list and track the availability of broadband service of Community Anchor 
Institutions (“CAI”): 
 1. Schools  - K through 12 
 2. Libraries 
 3. Medical /healthcare 
 4. Public safety 
 5. University, college, other post secondary 
 6. Other community support – government 
 7. Other community support – nongovernmental 
 
We would appreciate your assistance, as a CAI in the DC region, by filling out the questionnaire below. 
Please provide your response on or before, Friday, February 4, 2011.  
 
If you have any questions, please feel free to contact either Adeola Dokun at (202) 724-2128 or David Lutz 
at (202) 478-5887. Thank you for your cooperation. 

* Required
 

Contact Name *

 

Title *

 

Contact Phone Number: *

 

Contact Email: *

 

Name of Institution *

 

Institution Type *
Select

 

Page 1 of 2District of Columbia - Community Anchor Institutions

4/1/2011https://spreadsheets.google.com/a/dc.gov/viewform?formkey=dE52NVJqUHRDUFV3bjJm...



Address *
Street Address

 

City, State, Zip *

 

Institution Website *

 

Do you currently have broadband (internet) service at this institution? *
 Yes

 No

 

Name of broadband provider *

 

What type of Technology of Transmission does the institution use? *
Select

 

What is the maximum advertised download speed? *
Data transfer speed
Select

 

What is the maximum advertised upload speed? *
Data transfer speed
Select

 

Submit

Powered by Google Docs

Report Abuse - Terms of Service - Additional Terms

Page 2 of 2District of Columbia - Community Anchor Institutions

4/1/2011https://spreadsheets.google.com/a/dc.gov/viewform?formkey=dE52NVJqUHRDUFV3bjJm...
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Mobile Broadband Mapping of Commercial Cellular Networks: District of Columbia 

Executive Summary 

The outdoor downlink and uplink throughput speeds of the commercial cellular networks serving the 

District of Columbia were measured in September 2010, and compared with measurements made in 

September 2009. In addition to the three networks tested in 2009 (Verizon Wireless, Sprint, AT&T), our 

2010 measurements also include Cricket and T-Mobile. 

 

The results of the drive test measurements are shown in the two attached files (2010 results, and 2009 

results), and a qualitative analysis of the results is presented here. A more detailed quantitative analysis 

will be prepared later.  

 

All five of the service providers deliver broadband service (minimum 768 kbps downlink and 200 kbps 

uplink) in some areas of the District. However, there is a wide variation in coverage performance. 

Throughput speeds may be above the “broadband” thresholds in some areas and below the 

“broadband” thresholds in other areas. This variation in performance is shown by the color codes on the 

attached citywide maps. 

 

There is also a significant variation in performance between the cellular service providers. The downlink 

speeds of the AT&T and T-Mobile networks are substantially above the broadband threshold of 768 

kbps, with many areas above 1.5 Mbps. The speeds on AT&T’s network are substantially higher in 2010 

compared to 2009, which we believe is attributed to the 3G upgrade of the AT&T network to HSPA (High 

Speed Packet Access), a more recent version of 3G. Both AT&T and T-Mobile operate network 

infrastructure based on the 3GPP (3rd Generation Partnership Project) set of standards. 

 

The uplink speeds on the AT&T network is by far the highest of any of the commercial service providers. 

We believe this is due to the more advanced version of the 3GPP standard used by AT&T. Uplink speeds 

on AT&T’s network exceed 768 kbps and 1.5 Mbps in all but a few areas of the drive route. 

 

The downlink speeds on Verizon’s network, between 2009 and 2010, appear about the same. The uplink 

performance has improved, with many areas in 2010 above 768 kbps. Many areas in 2009 were above 

200 kbps uplink (but less than 768 kbps). Similarly, Sprint’s downlink performance appears about the 

same between 2009 and 2010, and their uplink performance in 2010 is slightly improved from 2009, but 

not as high as any of the other service providers. 

 

Sprint, via Clearwire, now offers 4G WiMax broadband service in the District. This network was not 

included in our broadband drive tests because the mobility performance of WiMax is poor. Sessions are 

frequently dropped during handoffs and the tool used for drive test measurements is unable to 

accommodate a high dropped session rate. 
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The authors wish to thank Felix Igbedior for his assistance in performing the drive tests with Chris San-

Gaspar. 
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11  Introduction  

As part of the American Recovery and Reinvestment Act (ARRA), the National 
Telecommunications and Information Administration (NTIA) released its State 
Broadband Data and Development Grant Program1

 

 Notice of Funds Availability (NOFA).  
The NTIA then awarded the State of Delaware funding to create a database of 
broadband deployment (Project) in the State of Delaware (State).  GeoDecisions and its 
team partner CBG Communications, Inc. (CBG) have been retained by the State of 
Delaware (collectively referred to as the “State Parties”) to perform a variety of tasks as 
part of the Broadband Data Development process, with the goal being creation of maps 
of the State showing where broadband is available, Providers’ names, and speeds or 
bandwidth provided to citizens, businesses, and anchor institutions throughout the 
State.  

The NOFA requires mapping of facilities-based Providers’ availability of broadband speed 
internet access in the State.  The NTIA, in the NOFA, defined broadband as “Broadband 
service is ‘available’ to an end user at an address if a broadband service provider does, 
or could, within a typical service interval (7 to 10 business days) without an 
extraordinary commitment of resources, provision two-way data transmission to and 
from the Internet with advertised speeds of at least 768 kilobits per second (Kbps) 
downstream and at least 200 Kbps upstream to the end user at an address.” 
 
The following specific project tasks were to be performed and completed by 
GeoDecisions and CBG with oversight by State staff: 
 

• Drafting, negotiation, establishment, and status reporting of all Non-Disclosure 
Agreements (NDAs) with broadband service Providers to support the Delaware 
broadband expansion initiative. 

• Mapping of broadband Providers and service attributes, including technologies 
utilized and advertised speeds available to end users. 

• Support of field verification of broadband mapping (using an approximately 35% 
sampling rate). 

• Development of web-based mapping applications. 
• Project, task, and contract management. 
• Review of Provider marketing materials. 
• Assistance in developing criteria for web-based surveys and speed tests. 
• Quality Control and review of all deliverables. 
• Assistance in the development of a data maintenance document. 
• Identification and assessment of broadband infrastructure (using an 

approximately 35% sampling rate). 
 
 
 

                                                 
1 http://broadbandusa.gov/files/BroadbandMappingNOFA(FederalRegisterVersion).pdf 
 

http://broadbandusa.gov/files/BroadbandMappingNOFA(FederalRegisterVersion).pdf�
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• Participation in weekly status and project meetings with internal staff, 
NTIA, the University of Delaware, the State of Delaware, Providers, and all other 
stakeholders. 

• Submission of weekly status reports. 
 
The Project began with meetings with the State, GeoDecisions, and CBG to map out the 
processes that needed to occur in order to produce an accurate map that included all 
known broadband Providers that were willing to participate in the project.  It should be 
noted that broadband Providers (Providers) were not required to participate in the 
Project but were encouraged to provide data specific to their networks so the State 
would have maps that were as accurate as possible.  Providers that applied for federal 
grant funds for network expansion or upgrades, however, would be eliminated from 
consideration for these grants if they did not cooperate with the State on this project.  
 

1.1 List Compilation 
 
The first task was to compile a list of all known broadband Providers throughout the 
State and contact information for each of these Providers.  Information from FCC 
databases, Internet research, and the State Parties’ overall understanding of the 
broadband industry was utilized to compile the list.   
 

1.2 NDA Negotiation 
 
Contact was then made to each of the Providers to determine whether they had facilities 
in the State that provided broadband to end users.  If so, the Providers were 
encouraged to participate in the project by providing the pertinent data needed to 
create the State’s maps.  Many Providers believe that some of the information required 
from them for participation is confidential and cannot be released to the general public.  
To overcome this obstacle, the State Parties created a Non-Disclosure Agreement (NDA) 
template whereby information deemed confidential by the Providers would not be 
released publically by the State Parties.  The NDA also ensured that all information 
requested from the Providers is available for release to the NTIA as required by the 
NOFA.  Based on the variation among Providers on what information is deemed 
confidential and varying interpretations of the template NDA, negotiations were held 
with many of the Providers to modify the NDA to meet the Providers’ needs while still 
allowing the State Parties to utilize and share the information as required in the NOFA.  
Once the Providers and the State Parties signed an agreed-upon NDA, the data 
gathering process proceeded. 
 

1.3 Data Gathering 
 
As each Provider signed an NDA with the State Parties, they were referred to 
GeoDecisions’ mapping department where they were asked to provide specific data in 
formats that would be compatible with the State’s mapping process.  Although many of 
the Providers had previously provided system data to the Federal Communications 
Commission (FCC), those submissions showed availability at the Census Tract level.  The 
requirements of this Project were for mapping of network availability at the Census Bock 
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level, which is more granular than previously submitted data.  Furthermore, in 
Census Blocks that are larger than 2 square miles, data was gathered at the street 
segment level (eg. From # 1 First Street to #111 First Street).  As Providers supplied 
this data, GeoDecisions created maps of the State showing where each of the Providers’ 
footprint(s) was located, as well as other required attributes such as advertised speeds 
available in these areas and the technologies utilized to provide service to end users. 
 

1.4 Provider Data Submittal 
 

NTIA 3rd

 

 data submission included 20 Broadband providers data, 9 of the providers has 
submitted new data updates; the following is a brief description the data provided: 

1- AT&T Mobility LLC.  
DBA Name: AT&T 
FRN 0004979233 
Date of submission 2/10/2011 
Type of Data Submission • Coverage Shape File 

• Excel Sheet 

Census Blocks N/A 
Road Segments N/A 
Middle Mile infrastructure No 
Technology of Transmission Terrestrial Mobile Wireless 
Data description ATT provided a shape file that showed 

coverage over the three counties of 
Delware state. The excel sheet provided 
contained speed data, Technology of 
transmission & Mobile Spectrum. 

 
2- Cavalier Telephone LLC.  
DBA Name: Cavalier 
FRN 0018547729 
Date of submission 3/18/2011 
Type of Data Submission • Excel Sheet with Block coverage  

• Excel sheet with Middle Mile Address  

Census Blocks 734 
Road Segments 147 
Middle Mile infrastructure 14 
Technology of Transmission Asymmetric xDSL 

Other Copper Wireline 
Data description Two excel sheet, one with blockId and 

coverage information (speed, technology), 
the other excel sheet has an address 
location for Middle Mile Infra-structure. 
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3- Comcast Cable Communications, LLC.  
DBA Name: Comcast 
FRN 0004441663 
Date of submission 2/11/2011 
Type of Data Submission • Excel Sheet of changes of block coverage 

since last submission 
• Excel Sheet of changes of of street 
coverage since last submission 

• Excel Sheet with speed information 
Census Blocks 10836 
Road Segments 1281 
Middle Mile infrastructure No 
Technology of Transmission Cable Modem - Other  

Cable Modem - DOCSIS 3.0 
Data description Three excel sheets, the excell sheets were 

expressing the difference in coverage 
between june 2010 and December 2010. 

 
4- DIECA Communications, Inc.  
DBA Name: Covad Communications Company 
FRN 0003753753 
Date of submission 2/16/2011 
Type of Data Submission • Text file tab delemited with block 

coverage 
• Text File with Subscriber-Weighted 
Nominal Speed 

Census Blocks 8564 
Road Segments No 
Middle Mile infrastructure No 
Technology of Transmission Asymmetric xDSL 

Symmetric xDSL 
Other Copper Wireline 

Data description Two text file tab deleminted. 
 
5- Leap Wireless International, Inc.  
DBA Name: Cricket Communications, Inc. 
FRN 0002963528 
Date of submission 2/11/2011 
Type of Data Submission • Shape file with Coverage, Technology, 

Spectrum, and speed 

Census Blocks N/A 
Road Segments N/A 
Middle Mile infrastructure No 
Technology of Transmission Terrestrial Mobile Wireless 
Data description Coverage Shape file. 
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6- Level 3 Communications, LLC.  
DBA Name: Level 3 Communications, LLC. 
FRN 0003723822 
Date of submission 1/24/2011 
Type of Data Submission • End User Address location text file 

• Middle Mile Address location and X,Y 
coordinate text file. 

Census Blocks 9 
Road Segments No 
Middle Mile infrastructure 12 
Technology of Transmission Optical Carrier/Fiber to the End User 
Data description Two text files; End user text file address 

location with technology and speed 
information, and Middle mile Address 
location with X,Y coordinates, Servicing 
capacity and Type. 

 
7- Medicom Communications Corp.  
DBA Name: Mediacom Delaware LLC. 
FRN 0003572633 
Date of submission 3/17/2011 
Type of Data Submission • Excel sheet with End User Address 

location 

Census Blocks 1713 
Road Segments 224 
Middle Mile infrastructure No 
Technology of Transmission Cable Modem - DOCSIS 3.0 
Data description An excel sheet that has End Users 

Address, also it contain informatio about 
End User Type. 

 
8- T-Mobile USA, Inc.  
DBA Name: T-Mobile. 
FRN 0006945950 
Date of submission 2/18/2011 
Type of Data Submission • Shape file with Coverage Area 

• Text File with technology and Spectrum 
• Excel sheet with Subscriber Weighted 
Nominal Speed. 

• No Middle Mile Notice. 
Census Blocks N/A 
Road Segments N/A 
Middle Mile infrastructure No 
Technology of Transmission Terrestrial Mobile Wireless 
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Data description A shape file that provides Broadband 
coverage with two different speed ranges 
for upload and download, the Technology 
and spectrum were provided by a different 
text file, Nominal speed came from an 
excel sheet. 

 
9- Cellco Partnership and its Affiliated Entities.  
DBA Name: Verizon Wireless. 
FRN 0003290673 
Date of submission 2/18/2011 
Type of Data Submission • Shape file for 4G Coverage 

• Shape File for 3G Coverage 
• Word document with Specturms and 
speed. 

Census Blocks N/A 
Road Segments N/A 
Middle Mile infrastructure No 
Technology of Transmission Terrestrial Mobile Wireless 
Data description The Two shape file provided Coverage 

area for different speed range (4G – 3G), 
a word document gives a discription of the 
speed and the spectrum used. 

 
1.5 Data Processing 

 
The method for processing the data varies depending on the data recived from each 
provider, the following is a breif summary of the steps taken to process the data for 
each provider. 
 
1-AT&T Mobility LLC.  
Processing Mobile 
Coverage Area 

• Apply Repair Geometry on coverage Shape file 
• Load Repaired Shape file into Transfer data model 

using append. 
• Use excel sheet values to calculate technology, 

spectrum and speed.  
• Result is stored in BB_Service_Wirless 

 
2- Cavalier Telephone LLC. 
Processing Census 
Block Coverage 
Area 

• Census block coverge excel sheet exported into dbf 
after adjusting column name (less than 11) 

• Select statement on the dbf file to separate 
Technology coverage 10 blocks & Technology 
Coverage 30 blocks. 

• Template of 2000 Census block < 2SQM joined twice, 
one time with Technology 10 dbf file (create Census 
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block coverage of Asymmetric xDSL), second time 
with Technology Coverage 30 (create Census block 
coverage of Other Copper Wireline). 

• Merge is applied on both Census blocks to create 
Census Block Coverage 

• Census Block Coverage is Loaded to Transfer Data 
model using append. 

• Result is stored in “BB_Service_CensusBlock” 
 

Processing Middle 
Mile infrastrcutre 
Points 

• Middle mile address excel sheet is loaded into 
ArcMap. 

• Excel sheet is Geocoded using “10.0 US Geocode 
Services (ArcGIS Online), Middle Mile location (X,Y) 
acquired 

• Middle mile is loaded to Transfer data model using 
append. 

• Result is stored in “BB_ConnectionPoint_MiddleMile” 
 

Processing Service 
Overview 

• Template County feature class is loaded into ArcMap 
• Maximum Downaload and upload speed is calculated 

in each country 
• Two Overview county layer is produced, one layer per 

technology. 
• County layers are merged. 
• County layer are loaded into Transfer Data model 

using append. 
• Data stored in “BB_Service_Overview” 

 
3- Comcast Cable Communications, LLC. 
Processing Census 
Block Coverage 
Area 

• Excel sheet with Census block difference is added to 
Arcmap and exported into dbf. 

• Select statement to split dbf file into New (added) 
block coverage, & Deleted (removed) block coverage 

• Perform join between previouse submission blocks & 
Deleted dbf to mark deleted block, then perform 
delete. 

• New Template of 2000 block is joined with New 
(added) blocks (match only), result is exported as 
New added blocks. 

• New added blocks is merged with Previouse 
submission modified blocks to come with Current 
coverage. 

• Current Coverage blocks are loaded into Data transfer 
model using append. 

• Result is stored in “BB_Service_CensusBlock” 
 

Processing Service • Template County feature class is loaded into ArcMap 
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Overview • Maximum Downaload, upload speed and Subscriber 
Weighted Nominal speed is calculated in each country 

• Two Overview county layer is produced, one layer per 
technology. 

• County layers are merged. 
• County layer are loaded into Transfer Data model 

using append. 
• Data stored in “BB_Service_Overview” 

 
4- DIECA Communications, Inc.  
Processing Census 
Block Coverage 
Area 

• Load provided text file into excel 
• Export text file into dbf after altering columns names 
• Separate dbf file into 3 technologies dbf files 

(Asymmetric xDSL - Symmetric xDSL -Other Copper 
Wireline) 

• Perform Join 3 times with Template census 2000 
census block (one join per technology) 

• Merge the 3 feature classes into one coverage feature 
class. 

• Load the output feature class into the transfer data 
model. 

• Result is stored in “BB_Service_CensusBlock” 
 

Processing Service 
Overview 

• Template County feature class is loaded into ArcMap 
• Maximum Downaload, and upload speed is calculated 

in New Castle county for each technology. 
• Three Overview county layer is produced, one layer 

per technology. 
• County layers are merged. 
• County layer are loaded into Transfer Data model 

using append. 
• Data stored in “BB_Service_Overview” 

 
5- Leap Wireless International, Inc. (Cricket) 
Processing Mobile 
Coverage Area 

• Apply Repair Geometry on coverage Shape file 
• Load Repaired Shape file into Transfer data model 

using append. 
• calculate technology, spectrum and speed.  
• Result is stored in BB_Service_Wirless 

 
6- Level 3 Communications, LLC.  
Processing End 
User Address 

• Text file loaded into Arcmap 
• Geocoded text file using “10.0 US Geocode Services 

(ArcGIS Online), address  location (X,Y) acquired 
• Format address field to match data model fields. 
• Load point feature into data transfer model using 



 Quality Assurance Document 

Contract No. DTI-08-0013 
 

Page 11 

append. 
• Result is stored into “BB_Service_Address” 

 
Processing Census 
Block Coverage 
Area 

• Select by location End user points that are located 
inside Census block less than 2 SQM, and export the 
result as Points Less than 2SQM 

• Spatial join end user point and Census block 2000. 
• Export Joined blocks as a Block Coverage. 
• Load Block coverage into data transfer model using 

append. 
• Result is stored in “BB_Service_CensusBlock” 

 
Processing Middle 
Mile infrastrcutre 
Points 

• Middle mile address text file is loaded into ArcMap. 
• Text file is Geocoded using “10.0 US Geocode 

Services (ArcGIS Online), Middle Mile location (X,Y) 
acquired 

• Middle mile is loaded to Transfer data model using 
append. 

• Result is stored in “BB_ConnectionPoint_MiddleMile” 
 

Processing Service 
Overview 

• Template County feature class is loaded into ArcMap 
• Maximum Downaload and upload speed is calculated 

in each country 
• Overview county layer is produced 
• County layer is loaded into Transfer Data model using 

append. 
• Data stored in “BB_Service_Overview” 

 
7- Medicom Communications Corp.  
Processing End 
User Address 

• Excel file loaded into Arcmap 
• Geocoded text file using “10.0 US Geocode Services 

(ArcGIS Online), address  location (X,Y) acquired 
• Format address field to match data model fields. 
• Load point feature into data transfer model using 

append. 
• Result is stored into “BB_Service_Address” 

 
Processing Census 
Block Coverage 
Area 

• Select by location End user points that are located 
inside Census block less than 2 SQM, and export the 
result as Points Less than 2SQM 

• Spatial join end user point and Census block 2000. 
• Export Joined blocks as a Block Coverage. 
• Load Block coverage into data transfer model using 

append. 
• Result is stored in “BB_Service_CensusBlock” 

 
Processing Service • Template County feature class is loaded into ArcMap 
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Overview • Maximum Downaload and upload speed is calculated 
in each country 

• Overview county layer is produced 
• County layer is loaded into Transfer Data model using 

append. 
• Data stored in “BB_Service_Overview” 

 
8- T-Mobile USA, Inc.  
Processing Mobile 
Coverage Area 

• Apply Repair Geometry on coverage Shape file 
• Load Repaired Shape file into Transfer data model 

using append. 
• calculate technology, spectrum and speed.  
• Result is stored in “BB_Service_Wirless” 

 
9- Cellco Partnership and its Affiliated Entities. (Verizon Wireless) 
Processing Mobile 
Coverage Area 

• Apply Repair Geometry on coverage on both shape 
file (4G-3G) Shape file 

• Load Repaired Shape files into Transfer data model 
using append. 

• calculate technology, spectrum and speed, for each 
type of coverage.  

• Result is stored in “BB_Service_Wirless” 
 
1.6 Map Creation/Interactive Web Application 

 
An interactive web application was developed to enable the general public to view a 
map of Delaware’s broadband availability in each of its three counties. Users will be able 
to see which forms of broadband exist in each area of the State and can also search for 
Providers by address. This web application is necessary in order to access and employ 
the data collected.  In essence, the data collected is in a static state; this web 
application will move the data into dynamic, usable form.   
 
With the creation of the web application, the State will move forward in meeting the 
requirements of this project’s grant as outlined in the NOFA. The web application was 
created in a manner that honors the guidelines established in each NDA executed with 
each respective Provider. A publically accessible, interactive website is the best means 
by which the citizens/taxpayers can be informed of broadband availability and options. 
The applications serve as a hub of broadband coverage information. The resultant 
functionality is expected to improve service for several user groups. From a citizen 
standpoint, the application will serve as a gateway to access or improve access to 
broadband services. Citizens can use the application to gain knowledge of providers, 
technologies, and access level at their residence or place of business. Planners can use 
the site to aid in infrastructure construction plans to improve broadband access and 
capabilities to their assigned region of the State. The State Legislature will use the 
application to notify politicians of district relevant broadband capabilities and as a 
catalyst in policy making and a various array of legislative actions.   
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1.7 Backlab Verification 

 
As the first version of maps covering each of the State’s Providers was completed, the 
State Parties performed backlab verification of the data gathered and input onto the 
maps.  This backlab verification included researching the Providers’ websites to verify 
that the advertised speeds on the websites were consistent with those documented by 
the Providers as part of their submission to the State.  In addition, the team made 
phone calls to some of the Providers to further verify service availability and speeds 
where necessary to gain the highest level of confidence in the data gathered. 
 

1.8 Provider Review 
 
After the backlab process was completed for each of the Providers, the data was sent 
back to the Providers for their review and acknowledgement of the data as being 
accurate.  This phase of the project also allowed the Providers to update their data if 
changes had occurred since the intiatial gathering of data by the State Parties.  Each of 
the Providers’ data was pulled out from the aggregate data base prior to sending it to 
the Provider for their review.  This ensured that the State Parties maintained the 
agreed-to confidentiality of each of the Providers’ data. 
 

1.9 Field Verification 
 
The final step for the State Parties to verify the accuracy of the data was to perform a 
field verification process.  Prior to beginning field verification activities, The State parties 
developed a field verification guide for use by each member of the field verification 
team.  The guide included systematic instructions and a checklist related to verification 
of each broadband system, technology, and service type.  The guide and checklist were 
drafted, reviewed by all State Parties, and finalized prior to the beginning of field 
verification activities. 
 
To ensure uniformity of the team’s approach to field verification, field team training was 
also held immediately prior to the beginning of field verification activities. 
 
Broadband system coverage was verified by sampling whether services were available at 
various points shown on the Providers’ system coverage maps that were randomly 
chosen from all of the census blocks that are within the Providers’ systems.  Points were 
chosen to represent areas throughout the Providers’ service territory, including system 
boundary edges.  

 
The State Parties team sample looked to provide a sampling of all broadband Providers 
in the State, including large and small Providers across the State, being sure to include 
each of the three counties. 
 

Team members spent a total of 19 days performing Field Verification functions including 
interviews and infrastructure identification at nearly 300 locations.  In addition, the team 
performed approximately 150 speed tests of Cellular based wireless broadband provider 
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networks.  Additionally, team members identified 87 tower locations in the State for 
potential broadband planning activities going forward.  

 
 

1.10 Speed Tests 
  
As part of the field verification process, State residents and businesses were given a 
business card-sized handout that briefly explained the project and pointed them to the 
state-specific speed test website.  The State utilized a project-specific speed test web 
site2

 

 run by Ookla in order to gain information on users’ addresses, satisfaction, and the 
upstream and downstream speeds associated with their broadband connection.  Ookla is 
a company that provides a private web-based reporting portal where customer-specific 
testing can be performed and documented over time.  The results of the speed tests 
performed on the Ookla site are stored and available to the State Parties at any time.   

 
Ookla tracks the end users’ Provider name, technology of connection, downstream and 
upstream speeds, and other parameters such as IP address. 
 
In addition, testing similar to that done by residents and businesses was performed by 
State Party representatives on mobile wireless Providers’ networks.  This again verified 
availability and speeds on each of the five major cellular-based broadband Providers in 
the State. 

 
1.11 Presentation to the NTIA 
 

The data submitted in the State Broadband Data and Development (SBDD) project is 
governed by the Notice of Funds Availability (NOFA) first published in volume 74, 
number 129, on page 32545 of the Federal Register and subsequently clarified in 
volume 74, number 154, on page 40569 of the Federal Register.  According to the 
NOFA, an NDA may be executed with broadband Providers prior to data collection.  The 
NTIA has proposed a National States Geographic Information Council

1.11.1 Broadband Service by Census Block (Less than 2 square 
miles in area) 

 (NSGIC) data 
model as a means to store the collected broadband data. The NSGIC model includes five 
main feature classes as follows: 

 
This feature provides the atomic unit for mapping provider services that, when tied to 
census demographic and socio-economic data, can provide guidance for the build-out and 
adoption of broadband.  The Census Block feature class is generated by different 
methods, depending on the data submitted by the Broadband service Provider. The main 
methods for generating census block data are as follows: 

                                                 
2 http://www.delawarespeedtest.com/ 
 

http://www.delawarespeedtest.com/�
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• Broadband providers submit a list of served Census Blocks.  In this 

case, the blocks are joined to the State’s Census Block data to obtain 
its spatial location.  Finally, the data are loaded into the Geodatabase 
model, and attributes are either transferred or filled in manually. 
 

• Broadband Providers submit a list of end users. In this case, an overlay 
is needed between the submitted geocoded end user points and the 
State of Delaware Census Block feature class to obtain the list of 
Census Blocks. 
 

• Broadband providers submit shape files or drawings with their 
boundary(s) of coverage.  The boundary(s) is intersected by the 
Census Block feature class to obtain Census Block coverage. 
 
 
 
 
 
 

1.11.2 Broadband Service by Census Block ( greater than 2 square 
miles in area) 

 
In order to provide a more granular representation of availability in Census Blocks 
larger than 2 square miles in area, these Census Blocks are described at a street 
segment level of detail. 

   
There are two methods utilized to garner the data needed to generate street 
segment coverage maps.  Depending on the data submitted by the providers, these 
methods can be summarized as follows: 

 
• The broadband Provider submits a list of end user addresses.  The nearest 

road segment is then selected, based on the attributes of the end user 
point. 

 

• The broadband provider submits a shape file or drawing showing their 
coverage area.  In this case, street segments are selected based on the 
intersection of its coverage area and street segment feature class. 

1.11.3 Broadband Service - Wireless 
 

The maps of wireless technologies provide a representation of the expected, 
modeled, or field-verified service areas associated with wireless carriers, their 
service levels, and their utilized spectrums.  The data in this feature class are 
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generated based on a drawing (shape file) submitted by a wireless technology 
service Provider (Terrestrial Mobile Wireless - Terrestrial Fixed wireless [licensed or 
unlicensed] - Satellite), as well as through field verification of wireless data. 

1.11.4 Broadband Service - Overview 
 

This feature provides a coarse view of speeds at a county level so that any regional 
or systematic patterns of service and speed can be assessed and mitigated. 

 
The State of Delaware has three counties.  The maximum downstream and 
upstream speed has been stipulated for each provider, along with the technology 
that they are using to provide these speeds.  Most providers were reluctant to 
provide pricing data, but some have provided data for weighted nominal speed. 

1.11.5 Broadband Connection Points – Middle Mile 
 

The purpose of broadband Connection Points, known as Middle Mile locations or 
points, is to give the locations and elevations of Interconnection points for service 
Providers working in the State of Delaware.  Gathering infrastructure components 
(Middle Miles) helps leverage opportunities for network deployment after assessing 
gaps in broadband availability in the State. 

 
The locations of Middle Mile points were provided by Providers either by their 
geographic coordinates (Latitude & Longitude) or by their street address(s), which 
are geo-coded to their spatial locations.  Intersection between the Middle Mile points 
and Census block layer is needed to obtain Full Block ID (FULLFIPSID).   

 
The above mentioned processes provided the State with the raw data to develop maps of 
the State showing where broadband is available, the maximum advertised levels of 
service, or speed offered to end users, and areas of the State that are unserved or 
underserved.  This information will be updated every 6 months to show changes made by 
Providers that will impact the broadband landscape throughout the State.  This report 
details some of the most pertinent information derived from the project and can be 
utilized to help the State during its Broadband Planning Project currently underway. 
 

 
22  Areas of Delaware Unserved/Underserved by Broadband 

Providers 

One of the main objectives of the NTIA, the State of Delaware, GeoDecisions, and CBG was to 
determine where broadband is not currently available in the State of Delaware.  Having areas 
where broadband is not available to potential end users helps create a phenomenon known as a 
Digital Divide. The Digital Divide is defined as the inability of residents to access broadband and 
Internet services based on economic, educational, or geographic reasons.   
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The NTIA defines an unserved area as: “An area composed of one or more contiguous census 
blocks where at least 90 percent of households in the service area lack access to facilities-based 
terrestrial broadband service, either fixed or mobile, at the minimum broadband transmission 
speed (set forth in the definition of broadband above).  A household has access to broadband 
service if the household can readily subscribe to that service upon request.”   
 
Furthermore, the NTIA defines an Unserved Area as ”A s

 

ervice area is defined as consisting of 
one or more contiguous census blocks, where half the households lack access to minimum 
broadband service, or an area where no land or mobile service offers broadband with at least 3 
Mbps, or areas where less than 40% of households subscribe to any service.”   

To obtain information about where broadband is not available in the State, the State Parties 
performed the above tasks to determine where broadband is available in the State and where it 
is not available to potential end users.  After determining where broadband is not available, the 
State is in the process of utilizing this information to determine what may be done to expand 
existing networks to provide service to these unserved areas or how new Providers may be 
enticed into building networks to serve these parts of the State.  This is being undertaken by 
the State and the University of Delaware as part of their planning activities in the next phase of 
this project. 
 
Although some services delivered by satellite-based Providers meet the requirement for 
broadband of 768 Kbps downstream and 200 Kbps upstream, for the purposes of this report, 
we have not included them when detailing broadband availability.  While any location within the 
State is capable of receiving satellite based service as long as there is a clear unobstructed view 
of the southern sky, the reasoning for not considering satellite-based Internet here is that often 
times realized speeds on satellite-based networks fall significantly below 768 Kbps in the 
forward direction and 200 Kbps in the upstream direction.  That being said, satellite Internet is 
an option for citizens and businesses in the State when other high speed connections are not 
available. 
  
 
The State of Delaware has the 6th

 

 highest population density of the 50 states in the US.  This 
helps the State’s overall broadband availability in that broadband Providers are apt to serve 
high density areas because the cost to build a network is lower on a per-address passed basis.  
In other words, the amount of infrastructure needed to connect a given address to the Internet 
lessens as density increases.  Conversely, the cost of building a network to more rural areas 
increases on a per-address (potential customer) basis to the point of not providing the 
broadband Provider the minimum potential return on their investment that they have 
established.  Large companies have minimum potential customers per mile that must exist or 
they will not build infrastructure to an unserved area.  For instance, a Provider may require 20 
homes or businesses be passed per mile of new infrastructure before they will build it.  In rural 
areas, there may be as few as 1 or 2 homes per mile.  Therefore, the area will not be built out. 

Although the State of Delaware has a relatively small number of areas, and therefore citizens, 
that do not have broadband available to them, this should still be a concern for the State and 
its planning group.  As in other locales, the State will likely find during its planning project that 
broadband is a driving force in many aspects of life today, including economic development, 
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health care, all areas of business and institutional users, education, and 
entertainment to name a few.  Consequently, the State will also likely find that encouraging 
expansion of broadband into the unserved areas of the State will have a positive impact on all 
of these aspects.  Areas of the State that do not have access to broadband are shown on the 
map included as Attachment 1. 
 
In addition to determining which areas of the State do not have access to broadband, 
demographics and socio-economic characteristics can be analyzed in areas of the State that do 
not have broadband availability.  For instance, the State Parties have over-laid age, minority 
status, and income data onto the maps to determine which groups may be most impacted by 
the lack of broadband service in their areas.  This information may prove valuable as the State’s 
planning project moves forward.  In addition, maps including other demographic and socio-
economic characteristics can be created by the State Parties to show other groups that are 
impacted by the lack of broadband availability in areas of the State.  The maps showing each of 
these parameters are included as Attachments 6, 7, and 8. 
 
 
 
 
 
33  Areas of Delaware Served by a Single Broadband Provider 

 
Similar to areas of the State that are unserved or underserved by any broadband Provider, the 
NTIA and the State desired to know what areas of the State are only served by a single 
Provider.   
 
Areas that have a single broadband Provider imply that service is available in these areas but 
that there is no competition.  Therefore, associated benefits that competition may bring, 
including lower pricing, higher speeds, and better customer service, are also not available in 
these areas.  This project did not ask for or document any of these parameters, and therefore, 
other than speed and pricing information included in the Broadband Service Tiers – Residential, 
Business Governmental and Academia section of this report, they are not included in this report.   
 
Similar to the unserved/underserved areas of the State, the State’s high density makes it a 
good business decision for broadband Providers to build out the networks throughout most of 
the State since even with competition, these Providers can make a good return on their 
investment.  As Attachment 2 shows, in addition to the areas of the State with no broadband 
availability, there are only a few small areas in the State that are not served by at least two 
Providers.  Some of the areas served by fewer than two Providers include:  
 

• An area east of Highway 301 and south of DE-896 in New Castles County 
• Augustine State Wildlife Management Area and Silver Run Wildlife Area in New Castle 

County 
• The area east of Highway 9 from Appoquinimink Wildlife Area southeast to Highway 6 

East of Smyrna 
• The area northeast of Smyrna to Highway 9 
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• The Bombay Hook National Wildlife Refuge area 
• Dover Air Force Base 
• The area south of Highway 6 between State Roads 42 and 15 
• The Milford Wildlife Area 
• The Prime Hook National Wildlife Refuge 
• The area north of Highway 54 and south of Road 402 between Highway 30 and Highway 

113 in Sussex County 
 
As a percentage, the areas of the State with fewer than two broadband Providers equates to 
less than 0.5% of the Census Blocks in the State.  Furthermore, the estimated total number of 
households in the State that are not served by a broadband Provider is 2,581 or 0.87% of all 
households.  However, as these areas are utilized by residents of the State and as housing and 
other developments reach these areas, they will not be broadband ready.  The lack of 
broadband availability may hamper expansion into these areas as the need arises in the future. 
 
44    Areas of Delaware Served by Multiple Broadband Providers 

The large majority of the State of Delaware has multiple broadband Providers, serving 
addresses within the area, with over 50% of the State having six or more Providers of 
broadband service.  When including all areas of the State with two or more broadband 
Providers, over 99% of the State’s Census Blocks are offered broadband service by multiple 
Providers.  A map of the State of Delaware with color codes showing the number of Providers is 
included as Attachment 2 to the report. 
 
Having multiple Providers helps promote competition among the Providers in given areas and 
should translate into the highest level of speed the Providers can offer at affordable costs.  
Having multiple Providers in an area also promotes higher customer service standards from 
Providers as they attempt to keep their existing customer base and increase their numbers of 
customers.  
 
55  Types of Technology Used to Provide Broadband in Delaware 

The NTIA classified broadband technologies into 11 categories plus a 12th

 

 category labeled “All 
Other”.  These categories represent both hardline cable networks (cable, phone lines, or fiber 
optic infrastructure connected to the residence or business) and wireless networks (signals are 
transmitted to and from an address or location).  The NTIA further defined each of the 
technologies into more specific categories.  The technologies utilized in Delaware are listed and 
defined below: 

• Asymmetrical xDSL 
DSL is a telephone system-based data communications service that utilizes modulation 
schemes that allow high-speed transmission of data on copper or phone lines.  
Asymetrical xDSL is a design characteristic where return speed is lower than forward 
speed.  This allows for more of the network’s bandwidth capability or throughput to be 
utilized by the forward portion of the network allowing for faster downloads than 
uploads.  This technology is utilized widely by telephone companies in the State to 
provide broadband service to end users. 
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• Other Copper Wireline 

Non-DSL telephone system-based data communications service such as T-1 (1.54 
Mbps).  Other Copper Line technologies tend to be utilized more for business and anchor 
end users, as bandwidths are often gauranteed verses “up to” speeds. 
 

• Cable Modem – DOCSIS 3.0 
A cable modem is a device that converts information from one device (computer) to a 
usable form for another device (cable TV network).  Specifically, information from a 
computer is converted to a useable format for transport on the cable TV network and 
converted back to a format useable by a computer at the receive site modem.  DOCSIS 
3 provides for multiple channels on the cable TV system to be combined and the 
combination used to enable higher data communications speeds or bandwidths.  
DOCSIS 3.0 is widely utilized by cable television network-based Providers throughout the 
State.  Cable TV systems currently utilizing previous versions of DOCSIS will likely 
migrate to DOCSIS 3.0 in the near term to utilize its higher bandwidth capabilities. 
 
 
 
 

• Cable Modem – Other 
Similar to DOCSIS 3.0, except these are all prior versions and revisions of DOCSIS 
including 1.0, 1.1 and 2.0.  These versions offer lower bandwidth or speed than DOCSIS 
3.0.  Only one Provider reported using Cable Modem – Other in the State.  This Provider 
is primarily DOCSIS 3.0 and will likely migrate the remaining areas of the State from 
earlier versions of DOCSIS to DOCSIS 3.0 in the near future. 
 

• Optical Carrier/Fiber to the End User 
A communications network utilizing fiber optics up to or into a household, business, or 
other facility – also called Fiber to the Home (FTTH) or Fiber to the Premise (FTTP).  
Fiber optic cables allow for transmission of modulated light along an optical fiber for 
significant distances.  Fiber optic cables are utilized throughout communications systems 
due to their ability to transmit signals over longer distances with higher bandwidths, 
while having significant reductions in noise and distortion effects compared to other 
wireline and wireless networks.  This technology is replacing other traditional telephone 
technologies throughout more densely populated areas of the State.  The local phone 
company in these areas will likely phase out the traditional phone system over the long 
term. 
 

• Satellite 
Wireless service provided between satellites and the end user.  A dish-shaped antenna, 
similar to those used for satellite TV, is utilized at the end user’s location to receive the 
downstream signal and to transmit the signal upstream.  Satellite is available anywhere 
in the State where a clear view to the southern sky exists.  Trees, buildings, and other 
obstructions are the only obstacles that may keep end users from accessing satellite 
internet. 
 

• Terrestrial Fixed Wireless – Unlicensed 
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Broadband service typically provided in a point-to-point configuration from a central 
tower location, or through a series of towers (hops) as part of a mesh network, to an 
end user location.  The frequencies utilized are not licensed by the FCC and therefore 
are susceptable to interference or competition for bandwidth from other non-licensed 
networks.  The only system to report utilization of Fixed Wireless – Unlicensed is located 
in and around the Rohoboth Beach area of the State.  This is a WiFi-based system that 
requires a subscription and is password protected. 
 

• Terrestrial Fixed Wireless – Licensed 
Broadband service typically provided in a point-to-point configuration from a central 
tower location, or through a series of towers (hops) as part of a mesh network, to an 
end user location.  The frequencies utilized are licensed by the FCC and therefore are 
more immune to interference and competition for bandwidth from other networks. 
 

• Terrestrial Mobile Wireless 
Broadband service typically provided in a point-to-multipoint configuration from multiple 
tower locations, as part of a mesh network, to end user locations.  The mesh 
configuration allows for mobile access to the broadband network.  These networks are 
most commonly known as cellular data networks.  The frequencies utilized are licensed 
by the FCC and therefore are more immune to interference and competition for 
bandwidth from other networks.  Terrestrial mobile based, or cellular, broadband is 
available throughout the State with the exception of a few areas.  These are shown on 
the accompanying maps as unserved areas of the State. 

    

66    AAddvveerrttiisseedd  UUppssttrreeaamm  aanndd  DDoowwnnssttrreeaamm  TTrraannssmmiissssiioonn  SSppeeeeddss    

Broadband Providers often advertise both downstream and upstream speeds as “up to” speeds.  
In other words, a Provider will advertise speeds “up to” 4 Mbps in the downstream direction and 
“up to” 1 Mbps in the upstream direction.  Consumers may believe that those are the speeds 
they will most often realize when utilizing the Provider’s network for internet access.  However, 
in reality, the actual speeds offered on the network may be significantly less than the advertised 
“up to” speeds. 
 
Many broadband networks deployed today utilize a shared bandwidth design whereby the 
network is developed based on customers sharing the total available bandwidth on the network.  
This is an effective way for a Provider to offer fast speeds to large areas while minimizing the 
amount of infrastructure needed and thereby reducing the cost of deployment.  In many cases, 
this design provides speeds sufficient for most subscribers’ needs that are well within the 
definition of broadband.  However, the actual speeds will most often be lower than the 
advertised speeds because of the shared bandwidth design, and in some cases they will fall 
below the threshold stipulated for broadband. 
 
An example of this is – if a network has a total available bandwidth equating to a download 
speed of 10 Mbps and one person is accessing the network, they will realize speeds at or near 
10 Mbps.  However, if 10 people are accessing the same network at the same time, they will 
divide the available network bandwidth among them.  Although the actual results will vary, 
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based on the level of utilization of bandwidth by each of the users, for purposes of 
this example, the result would be approximately 1 Mbps available to each of the 10 people 
accessing the network.  In this example, we assume all 10 users are accessing significant 
amounts of bandwidth that may be required to download music, video, and large files or that 
may be required to watch live video.  In reality, all 10 users will likely be utilizing differing levels 
of bandwidth at any given time.  This phenomenon makes it difficult to evaluate advertised 
speeds within a given system, between systems, and throughout the State and beyond. 
 
The Providers that supplied speed information, as verified during the backlab verification 
process, reported the following ranges of speed by technology: 
 

• Asymmetrical xDSL 
Speeds between 768 Kbps to 10 Mbps in the downstream direction with speeds between 
768 Kbps to 6 Mbps in the upstream direction. 

  
• Other Copper Wireline 

Speeds between 768 Kbps to 25 Mbps in the downstream direction with speeds between 
200 Kbps to 10 Mbps in the upstream direction. 

 
• Cable Modem – DOCSIS 3.0 

Speeds between 10 Mbps to 100 Mbps in the downstream direction with speeds 
between 1.5 Mbps to 25 Mbps in the upstream direction. 

 
• Optical Carrier/Fiber to the End User 

Speeds between 50 Mbps to greater than 1 Gbps in the downstream direction with 
speeds between 10 Mbps to greater than 1 Gbps in the upstream direction. 

 
• Satellite 

Speeds between 768 Kbps to 6 Mbps in the downstream direction with speeds between 
200 Kbps to 1.5 Mbps in the upstream direction. 
 

• Terrestrial Fixed Wireless – Unlicensed 
Speeds between 1.5 Mbps to 3 Mbps in the downstream direction with speeds between 
768 Kbps to 1.5 Mbps in the upstream direction. 

 
• Terrestrial Mobile Wireless 

Speeds between 768 Kbps to 3 Mbps in the downstream direction with speeds between 
200 Kbps to 1.5 Mbps in the upstream direction. 

 
 
77  Samples of Actual Upstream and Downstream Transmission 

Speeds 

Several methods were used to obtain a sampling of the actual broadband transmission speeds 
achieved by residents, businesses, and institutions.  For example, State residents and 
businesses were given a business card-sized handout that briefly explained the Project and 
pointed them to the State-specific speed test and survey website.  The State utilized a Project-
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specific Ookla speed test website3

 

 and survey in order to gain information on users’ 
addresses, satisfaction, and the upstream and downstream speeds associated with their 
broadband connection.  In addition, the State Parties’ team members performed approximately 
150 speed tests, primarily on wireless networks.  The locations of these speed tests are 
included on Attachment 3.  

Another verification method, in addition to utilizing the above-mentioned methodologies for 
verifying system coverage and characteristics, was for team members to enter into discussions 
with residents in the area.  Residents were asked if they knew if a particular Provider’s service 
was available, if they were or had recently been a customer, and if they know what speeds they 
could achieve.  Residents often times did not know what their service level and speeds were but 
did know who the broadband service Provider was.  Questions such as how much they were 
paying for the service led to a better understanding of their service level.  Approximately 1,400 
speed test cards were handed to residents or left behind where nobody was available.  These 
cards encouraged the residents to visit the State speed test and survey website, as listed on the 
card, to assist the State in gathering actual speed data.  Thus far, nearly 650 speed tests have 
been performed by both State Party team members on site and residents and business 
personnel at their locations throughout the State. 
 
It should be noted that there are many variables that can affect speed test results.  Of these, 
the most significant are the performance characteristics of the computer or device being utilized 
by the end user performing the test, the number of computers or devices at a location 
accessing the internet at the same time, the level of throughput being utilized by each, and the 
day and time of day when the tests are performed.  For these reasons, speed tests are best 
analyzed in the aggregate to give a good understanding of typical speeds being realized.  In 
other words, all cellular tests should be averaged to get an accurate understanding of actual 
speeds that can be expected from that given technology.  Furthermore, speeds for a given 
Provider can be averaged to again get a better understanding of the actual speeds available 
from that Provider. 
 
Of the nearly 650 speed tests performed to date, the overall average speeds of all technologies 
and Providers) were approximately 6.8 Mbps downstream and 3.0 Mbps upstream.  Further 
broken down by technology, the average speeds are: 
 
 
 

Technology Downstream Upstream 
All Technologies Combined 6.8 Mbps 3.0 Mbps 
Mobile Wireless 1.5 Mbps 550 Kbps 
Cable Modem – Residential 

     

10.7 Mbps 3.2 Mbps 
Cable Modem – Business class 11.6 Mbps 3.3 Mbps 
DSL 10.3 Mbps 4.4 Mbps 

                                                 
3 http://www.delawarespeedtest.com/ 
 

http://www.delawarespeedtest.com/�
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Fiber To The Premises/Business 23.9 Mbps 14.0 Mbps 

  
 
As described above, these are aggregate numbers that represent an average of these tests 
taken by end users.  Actual speeds at a given location will vary from these speeds.  Overall, the 
speed tests indicate speeds comparable to those advertised by the providers.  For example, 
mobile wireless providers offer speeds between 768 Kbps to 3.0Mbps (some offer a lower 
maximum speed) in the downstream direction.  The speed tests show an average speed of 1.5 
Mbps in the downstream direction.  Cable modem DOCSIS 3.0 is advertised to offer speeds 
between 10 Mbps and 100 Mbps.  The average tested speed was 10.7 Mbps.  This is on the low 
end of what is advertised and may reflect end users with a lower than maximum speed plan.  In 
other words, although speeds up to 50 Mbps may be offered to residential end users, many 
may be signed up for a service with a maximum throughput of 20 Mbps or less, which brings 
the aggregate average speed for cable modem DOCSIS 3.0 down.  Fiber to the premise is 
similar to cable modem DOCSIS 3.0 in that the tested speeds are lower than the advertised 
maximum speeds of between 50 Mbps and 1 Gbps.  These higher end speeds are more costly 
and therefore not likely to be the highest selling tier of service.  Therefore, the speed tests 
done on the lower tiered service will bring the overall aggregated average speed down from the 
advertised “up to” speeds.  DSL service is the only technology that had tested aggregated 
average speeds near the top of the advertised maximum speed range.  In fact, the advertised 
maximum speeds for DSL are between 768 Kbps and 10 Mbps, and the tested speeds for DSL 
came in at 10.3 Mbps.   
 
 
88  Broadband Service Tiers – Residential, Business and Anchor 

Institutions 

One of the goals of the project was to find the maximum downstream and upstream speeds 
offered by the various Providers in the State.  The goal was not necessarily to determine the 
various levels of service or speed being offered up to the maximum by the Providers.  However, 
speed tiers or levels are an important component of determining what services are available to 
end users, as many will not require or be able to afford the fastest available speeds but do want 
or need a higher speed connection than is available via a dial-up connection. 
 
Broadband service is provided in many different speed tiers through the various technologies.  
Most Providers offer more than one level of service or speed whereby end users who need or 
desire faster connectivity can opt for the highest level of service, and end users who only need 
lower levels of service can elect to purchase a slower connection at a reduced cost.  Speed tiers 
differ considerably between Providers and are dependent on the technology utilized to provide 
the service.  For instance, Providers using cable modem DOCSIS3 technology offer maximum 
speeds of between 10 Mbps to 100 Mbps in the downstream direction, while mobile wireless 
Providers in the State offer maximum downstream speeds between 768 Kbps and 3 Mbps. 
 
Making exact comparisons between broadband service Providers is difficult for a variety of 
reasons, the most significant of which is that most Providers offer "up-to" speeds.  As an 
example, an end user on one Provider's network with "up-to" speed of 1.5 Mbps may realize 
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close to that maximum speed at most times.  However, a customer on another 
Provider's network with "up-to" speed of 1.5 Mbps may only realize half of that speed at most 
times.  This makes it difficult to accurately determine which Provider has the speeds that will 
consistently provide the level of service needed by the end user.  Other issues that can make 
shopping for a broadband Provider difficult are introductory pricing, bundled pricing (where 
broadband service must be purchased with another service such as phone or TV), and long-
term contracts.  Introductory pricing may provide a benefit in the short term, while offering less 
competitive pricing in the long term.  Long-term contracts can lock an end user into a plan they 
may not need over the course of the contract term or lock them into a plan that does not fulfill 
their needs in the future.  Additionally, some Providers such as mobile broadband and satellite 
services have established throughput limits, such as 5 gigabits of throughput per month.  After 
a customer hits that level of throughput, they may be charged additional fees or their service 
level is cut back significantly for the remainder of the month (such as is done by some satellite 
based Providers). 
 
Providers are also continually changing their service offerings and pricing.  As end users needs 
for speed continue to increase, Providers continue to offer higher levels of speed with new 
additional features as discussed elsewhere in this report.  Another aspect that must be 
considered by potential end users is installation, equipment, and activation fees.  These can 
vary from $0.00 to over $100.00.  Many Providers that require installation or equipment fees 
run promotions where these fees are waived or reduced for a limited time. 
 
Other add-ons or extras, which may or may not offer value to the end user, that some 
Providers offer as a part of their service are security tools such as anti-spam and anti-virus 
software, home networking, specific web content free such as Disney, ESPN3, and others.  
 
Some examples of available plans and non-introductory, non-bundled pricing as researched on 
Providers’ websites include the following: 
 

Cable Modem Providers (all "up-to" speeds) 
Downstream Speed Upstream Speed Price per Month 

1.0 Mbps 512 Kbps $32.95 
1.5 Mbps 384 Kbps $40.95 
3 Mbps Unadvertised $29.95 
15 Mbps 3 Mbps $59.95 
20 Mbps 4 Mbps $69.95 
50 Mbps 10 Mbps $114.95 

 
 

Fiber To The Premise (FTTP all "up-to" speeds) 
Downstream Speed Upstream Speed Price per Month 

15 Mbps 5 Mbps $54.99 
25 Mbps 25 Mbps $69.99 
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50 Mbps 20 Mbps $144.99 
 
 

Satellite (all "up-to" speeds) 
Downstream Speed Upstream Speed Price per Month 

1.2 Mbps 200 Kbps $69.99 
1.5 Mbps 256 Kbps $109.98 
1.6 Mbps 250 Kbps $79.99 
2.0 Mbps 300 Kbps $119.99 

 
 

Mobile Wireless (all "up-to" speeds) 
Downstream Speed Upstream Speed Price per Month 

1.4 Mbps 200 Kbps $40/50/60* 
1.4 Mbps 800 Kbps $20/35/50/80* 
*Based on monthly throughput, $20 = 1 Gbit allowance, $80 = 10 Gbit allowance  

 
 

DSL (all "up-to" speeds) 
Downstream Speed Upstream Speed Price per Month 

1 Mbps 384 Kbps $19.99 
3 Mbps 768 Kbps $29.99 
7.1 Mbps 768 Kbps $39.99 
8 Mbps Not advertised $39.95 

 
   

Fixed wireless (Not licensed all "up-to" speeds) 
Downstream Speed Upstream Speed Price per Month 

1.5 Mbps (residential) Not advertised $39.99 
1.5 Mbps (business) Not advertised $49.99 

 
As the tables above show, shopping for the plan that meets the specific, consistent needs of an 
end user can be confusing.  Many other options and additional features are offered by Providers 
that are not shown in the examples above, including virus protection, spam filters and pop-up 
blockers, and subscription only websites.  In addition, end users must decide if long-term 
commitments are a concern for them prior to signing up for many types of broadband service 
offerings. 
 
Some Providers such as the cable modem, DSL, and wireless Providers also offer business class 
service.  These services may be identical to residential service with additional add-on services, 
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such as Outlook for e-mail, and may include a higher level of, or faster, service 
response when problems arise. 
 
In addition, some Providers offer faster speeds as business class service at a higher monthly 
cost.  These Providers also will offer business class and residential class services to Anchor 
Institutions.  Some Providers will offer higher speeds on a per site basis, such as fiber optic 
connections, with speeds as high as 1 Gbps symmetrical such as those supplied to the cities of 
Dover and Wilmington and the University of Delaware.   
 
As shown below in the Broadband Availability at Anchor Locations section, Anchor locations’ 
requirements vary significantly based on their size, the number of internet users, and the 
applications being run at the location.  Costs will vary on these services based on speed and 
necessary infrastructure expansions needed to connect the Anchor Institution. 
 

99  Locations of Tower Utilized to Provide Broadband 

 
During the Field Verification portion of the project, the State Parties noted the locations of 
towers that are utilized by cellular Providers and for other radio communications.  
 
These locations have been plotted onto a map for potential future reference.  These locations 
can serve as transmit and receive sites for wireless broadband Providers.  As a potential 
wireless Provider evaluates whether to deploy a network to offer broadband to residents and 
businesses, one of the most significant costs can be construction of a tower that is high enough 
to provide service to the surrounding areas.  These existing towers may have space available 
that can be leveraged for placement of broadband related antennas at a significantly lower cost 
than building new towers and therefore may allow a Provider to deploy a network where one 
may not otherwise exist.  The available space must be at a height on the antenna that will meet 
the needs of a new occupant on the tower.  Furthermore, like any business, the Provider must 
recoup their investment over a set period of time.  Using a lower cost option such as existing 
towers may allow a Provider to offer service at a lower monthly cost to the end user. 
 
The goal during the Field Verification phase of the project was to document all towers passed 
while performing the more pertinent task of verification of broadband availability where the 
Providers indicated service was available.  This process did not identify all towers in the State 
but does provide a useful database that can be built upon over time.  The Towers that were 
located are shown on the map included as Attachment 4. 
 
1100  Wireless Spectrums Utilized to Provide Broadband  

Several wireless frequency spectrums are being utilized by the various wireless Providers to 
offer broadband service.  These include both fixed and mobile wireless Providers.  As part of the 
data request sent to all of the Providers, they were asked to include which frequencies they are 
utilizing to offer broadband service in a wireless format.  The spectrums utilized, as reported by 
the Providers, are as follows: 
 
Cellular Providers are using several spectrum ranges including: 
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• 700 MHz band 
• 698 – 758 MHZ 
• 775 – 788 MHz 
• 805 – 806 MHz 
• 824 – 849 MHz 
• 862 – 869 MHz 
• 1.850 – 1.915 GHz 
• 1.930 – 1.995 GHz 
• 1.710 – 1.755 GHz 
• 2.100 – 2.155 GHz 

 
A fixed wireless Provider is using the WiFi band of 2.4 GHz to provide service on an unlicensed 
network.  It is open to the public but requires a password to utilize the network.  Satellite 
Providers are using licensed frequencies as provided by the FCC in the L-band, Big LEO, Little 
LEO, and 2 GHz spectrums. 
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1111  BBrrooaaddbbaanndd  AAvvaaiillaabbiilliittyy  aatt  AAnncchhoorr  LLooccaattiioonnss  

The NTIA’s NOFA required that “Awardees shall provide NTIA with a list of community anchor 
institutions in their state, along with the associated information described below.”  The 
information gathered includes address data, Provider name, technology, and speeds of 
broadband connection.  The NOFA defined Community Anchor Institutions (“Anchors” or “CAI”) 
in the following manner:  Schools, libraries, medical and healthcare Providers, public safety 
entities, community colleges and other institutions of higher education, and other community 
support organizations and entities. 
 
The State tasked the Institute for Public Administration at the University of Delaware (IPA) with 
performing the tasks of gathering the information needed related to Anchor Institutions. 
 
The IPA first compiled a master list of all Anchors throughout the State.  This list was then 
subdivided into categories of: 
 

• Schools – K-12 (public and private) 
• Libraries 
• Medical/Healthcare facilities (public and private) 
• Public Safety entities (public and private) 
• Universities, colleges and other post-secondary (public and private) 
• Other community support – governmental 
• Other community support – non-governmental 

 
The IPA verified each Anchor’s name, street address, map coordinates, and proper 
categorization into the above groups.  A few of the small municipalities only have Post  
Office boxes on file for addresses and were therefore mapped with the Post Offices’ mailing 
address. 
 
The initial list of known Anchors in the State, as reported in May 2010, totaled 650.  Through 
the process of making follow-up contacts to identify the level of Internet connectivity the 
Anchors were utilizing, a March 2011 adjusted total of 645 Anchors was determined.  The IPA 
has been able to elicit usable responses from 455 of those 645 Anchors.  Of that subset of 455 
respondents, 440 do have broadband connections, while 15 report that they do not have 
broadband.  The remaining 190 Anchors have been non-responsive, to date.  The IPA has 
received information from 95% of all known public/governmental Anchors in the State, with 
private institutions making up the majority of the non-responsive Anchors.  The IPA continues 
to attempt to make contact with the Anchors that have not yet been included in the study. 
 
Of the 455 Anchors that have been responsive to date, nearly 97% report they have some level 
of broadband connectivity to their Internet Service Provider (ISP).  This leaves just over 3% 
that do not have broadband. 
 
The breakdown of all known Anchors is as follows: 

• Schools – K-12 (public and private) 
Total = 266  
With Broadband = 233 
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Without Broadband = 1 
Non-responsive = 32 
 

• Libraries 
Total = 32 
With Broadband = 32 
Without Broadband = 0 
Non-responsive = 0 
 

• Medical/Healthcare facilities (public and private) 
Total = 27 
With Broadband = 13 
Without Broadband = 0  
Non-responsive = 14 
 

• Public Safety entities (public and private) 
Total = 119 
With Broadband = 55 
Without Broadband = 1 
Non-responsive = 63 
 

• Universities, colleges and other post-secondary (public and private) 
Total = 22 
With Broadband = 22 
Without Broadband = 0 
Non-responsive = 0 
 

• Other community support – governmental 
Total = 79 
With Broadband = 58 
Without Broadband = 8 
Non-responsive = 13 
 

• Other community support – non-governmental 
Total = 100 
With Broadband = 26 
Without Broadband = 5 
Non-responsive = 69  

 
The speeds achieved by the Anchors vary considerably overall.  There are also significant 
variances within categories of Anchors.  For example, of the 218 public schools, 175 reported 
the use of Optical Carrier/Fiber with downstream and upstream speeds of 10 Mbps, while 43 
reported the use of Other Copper Wireline with downstream and upstream speeds of 1.5 Mbps.  
Technology usage and speeds among the 15 private schools that responded ranged from Cable 
Modems with downstream speeds of 1.5 - 3 Mbps and upstream speeds of 768 Kbps - 1.5 
Mbps, to Optical Carrier/Fiber with downstream and upstream speeds of 25 Mbps or greater.  
Among the libraries (all of which are on the State network and use Optical Carrier/Fiber), 4  
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reported downstream and upstream speeds in the range of 100 Mbps - 1 Gbps, while the other 
28 reported downstream and upstream speeds in the range of 10 Mbps - 25 Mbps.  The highest 
downstream and upstream speeds of any CAIs (greater than or equal to 1Gbps in both 
directions, using Optical Carrier/Fiber) were reported by the cities of Dover and Wilmington and 
the University of Delaware.  Of all the entities that did indicate they had broadband service, the 
slowest connections were reported by non-governmental community support institutions 
(typically Senior Centers), some of which were using DSL connections with downstream speeds 
as low as 768 Kbps - 1.5 Mbps and Upstream speeds of 200 Kbps or less. 
 
In addition to determining if Anchors have broadband, the data collection effort for March 2011 
addressed whether the Anchor provides public access to WiFi.  In the case of Delaware’s 
libraries, the responses are not fully indicative of the level of available public access to 
broadband.  While all 32 of the libraries do provide public access to broadband, only 11 had the 
capability to provide public WiFi in March 2011.  System-wide availability of public WiFi at 
Delaware libraries was reported as being in the process of implementation, with completion 
expected in May 2011.  In addition to the libraries, several other Anchors had previously 
reported to the IPA that they did provide public access to broadband.  None, however, were 
responsive to the March 2011 update in terms of specifically identifying the on-site availability 
of public WiFi.  By allowing public access to broadband, anchor institutions can help serve 
populations in the State that otherwise may not have broadband access available to them.  
These include people living in unserved areas of the State or who cannot afford access at their 
residence.  IPA plans to focus on these Anchors in its planning activities to determine how such 
facilities best meet the needs of population groups that do not otherwise have access. 
 
1122  CCoonncclluussiioonn  

The State of Delaware, with direction and grant funds from the NTIA, began the process of 
determining the level of broadband availability in the State of Delaware in early 2010.  As 
components of the project, Providers were asked to provide data detailing where they provide 
broadband service, the advertised maximum downstream and upstream speeds, and the 
technology deployed to offer the service.  The data gathered from the Providers was verified 
using multiple methods, including checking the data against websites; field verification and 
speed tests by State Party team members and the general public.  The data was then sent to 
the Providers for one final check for accuracy. 
 
Because, in part, the State has a relatively high population density, broadband providers offer 
service throughout much of the State.  Additionally, in more than 50% of the State more than 
six different Providers offer broadband in the same areas.  Over 99% of the State has 
broadband service availability from at least two Providers.  
 
There are several technology types being utilized in the State to provide broadband to 
residents, businesses, and Anchors.  These vary from telephone-based technologies such as 
asymmetrical DSL and other copper wireline to cable-modem based technologies, optical carrier 
or Fiber-To-The end user, satellite, and fixed and mobile wireless.  Each of the technologies 
brings broadband to end users in different ways and fills various needs such as speed, price, 
reliability and mobility. 
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Determining and documenting speed offerings can be a complicated task.  Most broadband 
providers offer “up to” speeds.  The actual speeds of these networks at a given time may vary 
drastically from the “up to” speed that is advertised.  In addition, Providers often include other 
services such as virus protection, anti-spyware, and others or require a customer to bundle their 
broadband service with other services such as phone or TV to get the best price.  Consumers 
need to weigh all aspects of the Providers’ service prior to signing up for service and potentially 
signing a long-term contract. 
 
As a part of the Project, the State Parties documented existing cellular and other 
communications towers throughout the State.  These locations may provide a potential cost 
reduction for future broadband providers to enter the broadband marketplace.   
 
This may allow the State to encourage build out of existing wireless networks or deployment of 
new networks where broadband service is lacking today. 
 
The Institute for Public Administration at the University of Delaware (IPA) has had contact with 
455 of the 645 known Anchor Institutions in the State.  Of these, only 15 do not have 
broadband service today.  The State should continue to make efforts to contact the Anchors 
that have not responded thus far.  The State should then work with the Anchors during its 
Planning Project to determine if the broadband services available to the Anchors are meeting 
their needs today, as well as being able to meet their anticipated short- and long-term needs in 
the future.   
 
The State can utilize availability documentation gathered during this Project to help direct the 
Planning Project that is currently underway.  During the Planning Project, the State and the 
University of Delaware’s Institute for Public Administration will determine broadband-related 
needs of the general public, businesses, and Anchor Institutions throughout the State in today’s 
environment as well as into the future. 
  
1133  GGlloossssaarryy  ooff  TTeerrmmss  

Access Point (AP) – Transmitter and receiver utilized to create a wireless connection between 
devices.  End users connect wirelessly to the network via an Access Point. 
 
Asymmetrical Speeds – A network system design characteristic where return speed is lower 
than forward speed.  This allows for more of the network’s capability or throughput to be 
utilized by the forward portion of the network allowing for faster downloads than uploads. 
 
Broadband – (as defined in the NTIA’s NOFA) – Data transmission technology that 
provides two-way data transmission to and from the Internet with advertised speeds of at least 
768 kilobits per second (Kbps) downstream and at least 200 Kbps upstream to end users, or 
providing sufficient capacity in a middle mile project to support the provision of broadband 
service to end users within the project area. 
 
BPL (Broadband-Over Powerline) – A network utilizing electrical conductors (a power 
Provider’s lines) as its transport medium.   
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Cable Modem – A device that converts information from one device (computer) to a usable 
form for another device (cable TV network), i.e., Information from a computer is converted to a 
useable format for transport on the cable TV network and converted back to a format useable 
by a computer at the receive site modem. 
 
Community Anchor Institutions – Schools, libraries, medical and healthcare Providers, 
public safety entities, community colleges and other institutions of higher education, and other 
community support organizations and entities. 
 
Digital Divide – The inability of residents to access broadband and Internet services based on 
economic or geographic reasons. 
 
Digital Subscriber Line (DSL) – A telephone system-based data communications service that 
utilizes modulation schemes that allow high-speed transmission of data on copper or phone 
lines. 
 
Downstream, also known as “download” or “forward direction” – Connectivity path 
from a network service Provider, or ISP, to the customer’s location. 
 
Fiber Optic Cable – Cable made from glass that provides the medium for transmission of light 
along a designated path.  Single mode fiber is utilized to transport light over long distances.   
 
Fiber To The Premises (FTTP) – A communications network utilizing fiber optics up to or into 
a household, business or other facility, also called FTTH or Fiber To The Home. 
 
Fixed Wireless – Broadband service typically provided in a point-to-point configuration from a 
central tower location, or through a series of towers (hops) as part of a mesh network, to a 
customer premise location.  
 
Gigabits per Second (Gbps) – One billion bits of information transmitted between devices in 
one second, i.e., 1 Gbps = 1,000,000,000 bits of information transported over a network per 
second. 
 
Internet Protocol (IP) – Internetworking protocol used to transmit data across and between 
switched networks.  Also specifies the formatting and addressing scheme of information 
packets. 
 
ISP – Internet Service Provider – Private company or other organization offering 
connectivity to the Internet. 
 
Kilobits Per Second (Kbps) – One thousand bits of information transmitted between devices 
in one second, i.e., 256 Kbps = 256,000 bits of information transported over a network per 
second. 
 
Megabits per Second (Mbps) – One million bits of information transmitted between devices 
in one second, i.e., 1.5 Mbps = 1,500,000 bits of information transported over a network per 
second. 
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Middle Mile/Backbone/Backhaul – Transmission media utilized to connect APs or network 
nodes within a system to each other and to the main network and to the Internet.  Backhauls 
can consist of fiber optic cables, WiMAX, and other wireless technologies.   
 
Symmetrical Speeds – A system design characteristic allowing equal speeds in the forward 
and return paths of the network. 
 
Upstream – Also known as “upload” or “return direction” – Connectivity from the 
customer back to the network service Provider or ISP. 
 
Voice over IP (VoIP) – Transmission of voice communications as IP packets, allowing for 
transportation of voice over the Internet, LANs and WANs. 
 
Wi-Fi (Wireless Fidelity) – Wireless local area networks based on the IEEE’s (Institute of 
Electrical and Electronics Engineers, Inc.) 802.11 standards.  802.11 refers to a group of 
standards in place today as well as standards that are currently being developed. 
 
WiMAX (Worldwide Interoperability for Microwave Access) – Wireless wide area 
networks based on the IEEE’s 802.16 standards.  Capable of transmission speeds up to 70 Mbps 
over 70 miles with actual speed and coverage far less based on applications and terrain. 

 
 

Version Information 
 

Version 
Num. 

Edit Date Edited By Comments 

0.1 12/07/10 Nielsen, Robinson Draft Document 
1.0 12/10/10 Jensen, Conway Draft Document Revisions 
1.1 04/26/11 Jensen Spring 2011 Updates 
1.2 6/13/11 Tuttle Updated 2011 Anchor Stats 
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FLORIDA COVER LETTER 

April 1, 2011 
 
Ms. Anne W. Neville 
SBDD Grant Program Director 
National Telecommunications and Information Administration 
U.S. Department of Commerce 
1401 Constitution Avenue, NW Room 4716 
Washington, DC 20230 
 
Dear Ms. Neville: 
 
It is with highest regard that the collective stakeholders of Connect Florida offer congratulations to 
the U.S. Department of Commerce’s National Telecommunications & Information Administration 
(NTIA) on the recent release of the National Broadband Map.  This extraordinary milestone 
demonstrates the intense and joint effort of the NTIA, FCC, state governments, industry, and non-
profits like Connected Nation and will serve as a key tool for the American public and policymakers 
resulting in smarter investments and targeted state and local broadband policies and programs.  We 
are proud of the role that Connect Florida has played in creating such a powerful tool that will surely 
benefit not just Floridians, but consumers and businesses nationwide. 
 
Therefore, as the State Broadband Designated Entity, The State of Florida Department of 
Management Services (DMS), in partnership with Connected Nation, is pleased to present this 
submittal of the state of Florida’s State Broadband Data and Development (SBDD) Grant Program, 
known as Connect Florida. 

 
These artifacts should be found to be compliant with the April 1, 2011, deadline for the semi-annual 
data update and in accordance with the terms of the July 1, 2009, Notice of Funds Availability 
(NOFA) and all subsequent clarifications pertaining to delivery of State-Level Mapping of 
Broadband Service Availability.  This packet includes: 
 
Inventory of Deliverables, Connect Florida: April 1, 2011 
 
NOFA Requirement Data Transfer Model Data Description 
Appendix A:  1(a)(i) BB_Service_CensusBlock Broadband Service Availability of 

Facilities-Based Providers in 
Census Blocks of No Greater 
Than Two Square Miles in Area 

Appendix A:   1(a)(ii) BB_Service_RoadSegment Broadband Service Availability of 
Facilities-Based Providers by Road 
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Segment in Census Blocks Larger 
in Area Than Two Square Miles 

Appendix A:   1(b) BB_Service_Wireless Broadband Service Availability of 
Wireless Services Not Provided to 
a Specific Address 

Appendix A:   3(b) BB_ConnectionPoint_MiddleMile Broadband Service Infrastructure 
Middle-Mile and Backbone 
Interconnection Points 

Appendix A:   4 BB_Service_CAInstitutions  Community Anchor Institutions-
Listing 

Appendix A:   4 n/a Community Anchor Institutions-
Narratives 

VII.A.1(a) n/a Accuracy and Verification Report 
n/a DataPackage.xlsx Worksheets of Contact 

Information, Data Dictionary, and 
Provider Summary Table 

n/a n/a Broadband Provider Roster and 
Participation Status 

 
In addition, this data update submission should be found to be compliant with the additional 
program requirements instituted by the National Telecommunications and Information 
Administration since the time of the October 2010 SBDD data submission for the Connect Florida 
program.  Specifically, these new requirements are: 

 
SBDD Data Transfer Model 
The submission of the broadband dataset for April 1, 2011, is contained within the SBDD 
Data Transfer Model as released on the Grantee Workspace on January 14, 2011. All efforts 
have been made to comply with formatting, domain, and metadata requirements to include 
as much information on each provider as possible.  
 
Additional Submission Guidance 
This submission also includes the updated DataPackage spreadsheet with enhanced provider 
listings as well as satisfactory outputs from the SBDD_Check toolbox to ensure fewer 
unexpected values with the submitted broadband datasets prior to federal processing for the 
National Broadband Map update. 

 
It is therefore with great pleasure that the Connect Florida program submits this April 2011 semi-
annual data update under the State Broadband Data and Development Grant Program.  We will 
continue to implement the joint purposes of the Recovery Act and the Broadband Data 
Improvement Act (BDIA) by gathering comprehensive and accurate state-level broadband mapping 
data, developing state-level broadband maps, and aiding in the development and maintenance of the 
National Broadband Map.  
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Broadband Service Availability — Provider Outreach and Verification 
 
This data update submission under the SBDD includes the participation of approximately 55.71% of 
the Florida provider community, or 39 of 70 total providers.  Of the 39 participating providers, 17 
supplied an update to their network or coverage area(s), while 19 have reported no change. The 
remaining 3 represent providers who previously supplied data but were non-responsive in the April 
2011 update effort; therefore their previous dataset is being put forward as part of this compilation. 
A complete roster by provider depicting participation status and contact record is contained herein.  
Of the 31 providers that are not represented in the attached datasets, 12 have either refused to 
participate in the voluntary program or have remained unresponsive to the numerous attempts at 
contact by Connect Florida. The remaining 19 providers are currently in some form of progress 
toward data submission but were not able to either submit or verify coverage areas at the time of 
this submission.    
 
As the aforementioned roster and attached methodology documentation will attest, it is the 
collective opinion of the Connect Florida principals that all commercially reasonable efforts were 
made to account for 100% of the known Florida broadband provider community, pursuant to this 
semi-annual data update submission. 
 
Connect Florida has also continued to perform broadband verification activities through several 
means. In addition to confirmation of service area(s) by each provider, Connect Florida conducts 
field validation efforts.  To date, the October 2010 and this April 2011 data submission, 15 (21.43%) 
providers have been validated through field verification activities. Additional details on verification 
activities are contained within the Field Validation Narrative. 
  
At the program’s inception, Connect Florida launched a website to create awareness about the 
initiative. Connect-Florida.org continues to serve a prominent role in the outreach and data 
collection effort.  This program asset provides a way for the general public to participate in the 
process by offering interactive tools for users to test their connection speed, submit broadband 
inquiries, or contact a program representative.   
 
As an indicator of stakeholder penetration, the Connect Florida website encountered 1,179 unique 
visits during this reporting period (3,235 total to date for the life of the grant awarded on December 
20, 2009).  The website also provides the BroadbandStat application, which allows the consumer to 
confirm or dispute the coverage represented on the broadband inventory map. These consumer-
initiated actions are facilitated through the Connect Florida website and the Connect Florida 
Interactive Mapping Tool (BroadbandStat) that offer the citizens the vehicles to provide information 
regarding availability in their respective service area, either in affirmation or contest of the reported 
data represented in the Connect Florida mapping artifacts.  
 
Community Anchor Institutions  
 
Connect Florida has established an ongoing mechanism for gathering data on the location and 
broadband connectivity of Community Anchor Institutions (CAI), in accordance with the data 
requirements of the SBDD NOFA Technical Appendix.   
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In conjunction with the Florida Department of Management Services, outreach was conducted 
during this data update reporting period by Connect Florida to continue identification of existing, 
centralized sources for CAI connectivity data.  Outreach was coordinated to distribute the CAI 
survey to institutions throughout the state through multiple methods including a customized online 
survey available on the Connect Florida website.  Connect Florida continues to work in coordination 
with statewide associations such as the Florida Department of Education, Florida Hospital 
Association, University of Florida GeoPlan Center, and the Northwest Florida Broadband Authority 
to promote the importance of broadband connectivity at anchor institutions and participation in this 
data collection process.   
 
While we continue to document institutions and the related addresses, the connectivity data 
collected in most categories remains incomplete at this time.  Connect Florida will be implementing 
a number of new processes to increase participation including launching a CAI newsletter to 
connect communities across the state, increasing industry-specific planning to target new community 
contacts, and revising the CAI portion of our website to increase visibility and content.  From our 
work in Connect Florida, as well as other states, we recognize the great value of this data to future 
collaboration efforts within the state and its value to the recently released National Broadband Map.  
We plan to continue to bring best practices to the Connect Florida efforts, along with an investment 
of both human and technical resources required to reach our goal of increasing the data that is 
secured and reported as part of this process. 
 
In acquiring both broadband availability and CAI data within the state of Florida, Connected Nation 
has previously engaged all federally recognized tribal lands in the area covered by the Connect 
Florida SBDD grant and reported that outreach as part of past submissions.  Throughout the next 
reporting period and in coordination with DMS, Connect Florida plans to engage directly with these 
tribal communities and will also conduct affirmative outreach with Native American tribal 
organizations that are active within the area.  Connect Florida understands the connectivity 
challenges facing these tribes, and we have identified a need to include their data as part of our 
upcoming submissions. 
 
The Connect Florida program exists to improve data on the deployment and adoption of broadband 
services and to assist in the extension of broadband technology across all regions of the great state 
of Florida, as well as the United States through contribution to the National Broadband Map.  We 
look forward to the continuing work ahead. 
 
Respectfully submitted, 
      
       Approved for submittal by 
       Bill Price 
Thomas W. Ferree     Broadband Stimulus Program Manager 
Chief Operating Officer    Department of Management Services 
Connected Nation, Inc.    State of Florida 
 
 

dclark
Cueball
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DATA ACQUISITION:  FLORIDA COMMUNITY ANCHOR INSTITUTIONS  

In this third reporting period of the SBDD, Connect Florida, working in close coordination with the 
Florida Department of Management Services, has established an ongoing mechanism for gathering 
data on the location and broadband connectivity of Community Anchor Institutions (CAI), in 
accordance with the data requirements of the SBDD NOFA Technical Appendix.  During this 
reporting period Connect Florida has continued to focus efforts on conducting outreach and raising 
awareness of this important project. 
 
Connect Florida has continued to identify and process CAI data obtained through an ongoing 
statewide outreach campaign.  Physical address information continues to be augmented through 
manual sourcing and geocoded by Connect Florida through ESRI ArcGIS software. 
 
Connect Florida continues to utilize a customized online survey hosted through SurveyMonkey, with 
a landing page on the Connect Florida website that was developed during the first reporting period.  
This survey, in combination with a customized data gathering spreadsheet, was distributed to a 
targeted list of CAI throughout the state.  Connect Florida will continue to use these data gathering 
tools for future targeted outreach efforts throughout the coming months leading up to the next 
reporting period.  These materials are customized to fit the CAI categories as defined in the SBDD 
NOFA.   
 
The survey can be accessed at this link using the following password: 
http://connect-florida.org/mapping/Community_Anchor_Institution_Data_Collection.php 
Password: CAI_FL_7864 
 
Connect Florida has worked diligently during this reporting period to conduct research as part of an 
ongoing process to identify existing, centralized sources for CAI connectivity data.  At this time no 
additional centralized sources have been identified, but efforts continue to locate any data that may 
already exist in the state. 
 
In tandem with these efforts to identify existing data, Connect Florida continues to identify key CAI 
contacts among all CAI categories in an effort to distribute and promote the online survey and raise 
awareness of the importance of CAI broadband connectivity. In addition to survey data Connect 
Florida received connectivity data on approximately 150 hospitals in the state which resulted in a 
significant increase in healthcare data.  Coordination also continued with researchers at Florida State 
University and the University of Florida surrounding their efforts to gather CAI connectivity data. 
   
Connect Florida has an ongoing mission to educate CAI throughout the state on the importance of 
participating in the project.  Participation by these institutions will raise awareness about the 
importance of broadband connectivity and the need to report the requested data for inclusion on the 
National Broadband Map.  To assist with our data collection efforts, Connect Florida is developing a 
CAI newsletter to be distributed quarterly beginning in April 2011.   The newsletter will highlight a 
CAI in Florida, encourage institutions to share their data, and highlight the National Broadband 
Map. 
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The greatest challenge with collecting this data continues to be the difficulty in securing CAI 
broadband connectivity data.  Connect Florida will continue its ongoing work with key organization 
contacts in an effort to raise awareness of this project among CAI.  
 
A CAI summary of all processed and submitted data is provided below: 
 

 
 
SBDD DATA SUBMISSION METHODOLOGY 

The submission of the broadband dataset for April 1, 2011, is contained within the SBDD Data 
Transfer Model and additional components as released on the Grantee Workspace on January 14, 
2011. Connected Nation has reviewed all literature that relates to the release and use of this data 
transfer model and recognizes that it does not replace or dictate how data is stored, processed, or 
displayed for the state or territory, as it is meant primarily as a means to transfer the broadband data 
from all states and territories and populate the National Broadband Map in a seamless fashion. 
Guidance from the Technical Mapping Guide, as released on the Grantee Workspace on March 24, 
2011, was also followed to ensure the completeness and validity of the submission through 
completion steps and checklists, completing the DataPackage spreadsheet, uploading broadband 
datasets into the Data Transfer Model, and checking the dataset using the SBDD_CheckSubmission 
receipt process.  
 
In addition to the narratives and methodologies contained herein, as well as the DataPackage.xls 
containing contact information, the data dictionary, and a provider summary table, the following 
feature classes are submitted within the SBDD Data Transfer Model for the state of Florida. 

CAI Type Total 
Physical 
Address Lat/Long

Technology 
of 

Transmission
Download 

Speed 
Upload 
Speed 

K-12 Schools 4,953 4,953 4,932 184 218 175
Libraries 934 934 929 74 532 92
Healthcare 2,390 2,390 2,389 161 154 151
Public Safety 3,703 3,703 3,697 1,131 1,147 1,139
Higher Ed Institution 488 488 488 38 60 39
Other Government 3,046 3,046 4,044 2,758 2,736 2,720
Other Non-Government 32 32 32 24 20 15
Total 15,546 15,546 16,511 4,370 4,867 4,331
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Inventory of Deliverables, Connect Florida: April 1, 2011 
 
NOFA Requirement Data Transfer Model Data Description 
Appendix A:  1(a)(i) BB_Service_CensusBlock Broadband Service Availability of 

Facilities-Based Providers in 
Census Blocks of No Greater 
Than Two Square Miles in Area. 

Appendix A:   1(a)(ii) BB_Service_RoadSegment Broadband Service Availability of 
Facilities-Based Providers by Road 
Segment in Census Blocks Larger 
in Area Than Two Square Miles. 

Appendix A:   1(b) BB_Service_Wireless Broadband Service Availability of 
Wireless Services Not Provided to 
a Specific Address. 

Appendix A:   3(b) BB_ConnectionPoint_MiddleMile Broadband Service Infrastructure 
Middle-Mile and Backbone 
Interconnection Points. 

Appendix A:   4 BB_Service_CAInstitutions  Community Anchor Institutions-
Listing. 

 
The provider data collected by Connected Nation on behalf of the state of Florida have been 
formatted per the given specifications and uploaded into the appropriate feature classes of the 
SBDD Data Transfer Model. Wireline availability is contained within census blocks and road 
segments, wireless availability is contained as polygons of coverage areas, and middle-mile 
connections and community anchor institutions are contained as point data. All speed data is 
contained at the census block, road segment, or wireless polygon level of availability. All efforts have 
been made to comply with formatting, domain, and metadata requirements to include as much 
information as possible.  
 
Connected Nation has continued outreach to satellite providers on their availability, technology, and 
speed information, but it is not included in this submission dataset.  Additional information is 
necessary to be able to show where service satisfactorily exists in the state, rather than submitting 
the entire boundary of the state as the serviceable area.  Analysis information distributed and 
discussed with the satellite providers, as well as any additional guidance from the Program Office on 
the desired analysis for satellite-serviceable areas, will be implemented for the October 2011 data 
submission.  
 
 
FLORIDA FIELD VALIDATION NARRATIVE 

Connected Nation focused a portion of its time on specific validation processes such as: 
 

• conducting random spectrum analysis studies throughout the state using an Avcom PSA-37-
XP spectrum analyzer; 
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• conducting mobile speed tests throughout the state using an iPhone, Android (or other 
smart phone) as well as provider-specific aircards (Sprint 3G/4G, Clearwire et al); 

• identifying pre-selected, provider-submitted wireless transmit tower sites and cross-
referencing data about that tower against the Federal Communications Commission (FCC) 
databases such as Antenna Structure Registration and/or the Universal Licensing System; 

• cross-referencing Federal Registration Number data against available FCC Form 477 data as 
well as the FCC COmmission REgistration System (CORES); 

• validating provider submitted data (for example: latitude/longitude) using a handheld 
Garmin eTrex Summit GPS unit or GPS enabled software such as Microsoft Streets and 
Trips; 

• locating physical wire-line attributes (such as remote terminals, CATV plant, etc.) and 
comparing them against provider submitted data; and 

• conducting on-net and off-net speed tests using the FCC portal at 
http://www.broadband.gov/qualitytest/about/ or using the Ookla Net Metrics enabled 
speed test utility located on each of Connected Nation’s state specific websites. 

 
Additionally, Connected Nation cross-referenced numerous public documents in order to ensure 
that all known broadband providers were located and contacted.  This included searching 
membership logs from the trade associations (WISPA, WCAI, PCIA, etc.), the Cable Television Fact 
Book, Public Utility Commission records, Public Service Commission records, Chamber of 
Commerce, etc. 
 
To date Connected Nation’s staff conducted on-site validation tests in Florida on the following 
providers:  AT&T Inc., Cellular South Inc., CenturyLink, Clearwire Corporation, Comcast, Frontier 
Communications, MetroPCS, Northeast Florida Telephone Company, Orland Telephone Company, 
PCI Wireless, Sprint, Summit Broadband, T-Mobile USA Inc., tw telecom, and Verizon Florida 
LLC. 
 
During this reporting period, Connected Nation conducted 7 additional on-site validation tests with 
AT&T, T-Mobile, Verizon, and Clearwire. 
 
From program initiation through this reporting period, Connected Nation has completed in-the-
field validation testing against 15 companies (out of a universe of 70 viable providers) totaling 
21.43% within the state of Florida.   
 
 
ACCURACY AND VERIFICATION:  METHODOLOGY - PROVIDER VALIDATION 

Broadband providers maintain their service area data in many different formats, all in varying levels 
of complexity and granularity. In order to ensure that the data required by the NTIA is standardized 
across all providers and that it is as accurate as possible, Connected Nation translates and formats 
the data that providers are able to supply into a GIS shapefile and produces maps for the provider to 
review.  The resulting map(s) and review process allow for providers to see their service area in a 
geographic format – for some providers, this is the first time they have seen maps of their 
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broadband service area. Having the mapped service area allows providers to quickly identify any 
issues that appear in the data representation, whether the issue is in the data translation into a GIS 
format or from the original data collection and submission. Often data is provided from various 
sources and through the review and revision process, local engineers who operate the networks and 
work in the field are able to ensure that the tabular data that has been submitted is accurate and 
represents the real-world network extent. Any issues in how the service area is represented on the 
map(s) are remedied by Connected Nation, whether they are additions, removal of service, or any 
other revisions. Revised maps of service area representations are sent to the provider for review and 
approval; Connected Nation will revise data and return maps as many times as necessary until the 
provider is in agreement that the map represents their service area as accurately as possible. Once 
the review process has been completed and final approval of the data is provided, the data is deemed 
ready for NTIA submission. 
 
Once the data collection has been aggregated a statewide level, static maps of statewide and county-
level availability are produced and made publicly available. In addition, consumers can visit the 
interactive online tool, BroadbandStat, to create customized views of broadband service areas and 
analyze corresponding demographic information. Leveraging broadband service data on various 
platforms allows for public users, providers, and other stakeholders to review, scrutinize, and 
provide feedback on the represented data. This feedback becomes a validation method in itself as 
consumers submit inquiries to Connected Nation either affirming where service is not available or 
identifying areas where broadband service is shown on the map, but in actuality is not available. This 
allows for a follow-up to providers regarding revisions to the data as it is represented; it also allows 
for Connected Nation to identify locations where on-site visits may be necessary to complete field 
validation of available services. Public feedback on all forms of mapping products serves as a 
localized validation method for provider-supplied information and allows Connected Nation to 
resolve inaccuracies as they are identified to ensure that only the highest quality information is 
provided to stakeholders. 
 
Estimates derived from provider-validated data indicate that approximately 2.65% of Florida 
households do not have terrestrial fixed broadband service available, and approximately 0.4%1 of 
Florida households have neither mobile nor fixed broadband service available.2   
 
Within rural areas of the state, results derived from provider-validated data indicate that 
approximately 5.27% of rural Florida households do not have terrestrial fixed broadband service 

                                                            
1 In accordance with NTIA’s definition of available broadband service as specified in the SBDD NOFA, this estimate 

includes both terrestrial fixed and mobile broadband service, if the service offers download speeds of at least 768 Kbps 
and upload speeds greater than 200 Kbps. 

2 Due to the nature of the SBDD data collection methodology as defined by the NTIA and based on both census 
block geographic units and street segment data, the estimates of broadband availability derived from provider-validated 
data may include an overstatement of the actual number of households with broadband availability.  Under the census 
block-based data collection method, a provider will typically report broadband availability for an entire census block 
whether its network is present across the whole or only a subset of that census block.  This potential overestimation at 
the census block level can be amplified as the data is aggregated across the entire state. 
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available, and approximately 0.2%3 of rural Florida households have neither mobile nor fixed 
broadband service available.4   
 
 
WIRELESS METHODOLOGY 

 
Broadband Service Availability in Provider’s Service Area 

Wireless Services Not Provided to a Specific Address 
 
Data solicited from a fixed wireless provider to create propagation models include, but are not 
limited to: 

1. The name of the structure 
2. Whether the transmitting device is operational or proposed 
3. The maximum advertised downstream speed, the maximum advertised upstream speed 
4. The typical downstream speed, the typical upstream speed (peak periods for both) 
5. The frequency range of spectrum being used (as prescribed by NTIA) 
6. The primary population center(s) being served (for geopolitical boundary reference) 
7. The physical address of the transmit site (in the event latitude/longitude is unavailable from 

the provider this allows a quick reference point for geocoding) 
8. Latitude in either Degrees, Minutes and Seconds and/or in Decimal Degrees (typically 

received as NAD 27 or NAD 83)  
9. Longitude in either Degrees, Minutes and Seconds and/or in Decimal Degrees (typically 

received as NAD 27 or NAD 83)  
10. Antenna pattern (e.g. omni-directional, 180°, 120°, 90°, etc.) 
11. Azimuth of antenna (e.g. 360° with magnetic declination if known) 
12. Approximate transmit radius (in feet, miles, or kilometers) 
13. Polarity of transmit antenna (Vertical or Horizontal) 
14. Transmit antenna gain (in dBi) 
15. Line loss (applicable only to providers using coax, heliax, waveguide or other forms of 

cabling – excludes power-over-Ethernet devices) 
16. Mechanical and/or Electrical beam tilt (if applicable) 
17. Equipment Manufacturer (allows easy cross-reference against manufacturer’s specification 

sheet) 
18. Power output of the transmitting device (if unknown, FCC standards or manufacturer 

specifications are applied) 
19. AMSL at base of tower site 
20. Antenna centerline AGL (height of antenna above ground level measured at the centerline 

of the actual antenna) 
                                                            

3 See footnote 1. 
4 See footnote 2. 
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21. Foliage factors (Evergreens/Deciduous and percent of ground cover) 
22. Ground Clutter (primarily used in rural areas to account for foliage and in metropolitan areas 

to account for types and heights of buildings if known)   
23. Average gain of receive antenna 
24. Receive antenna is estimated at height above average terrain (HAAT) of 6.2 meters/20 feet 
25. Federal Registration Numbers (if applicable) which may allow opportunities to cross-

reference and/or obtain additional data from the Federal Communications Commission 
Universal Licensing System and the COmmission REgistration System 

 
Propagation modeling is an empirical mathematical formulation for the characterization of radio 
wave propagation as a function of frequency, distance, and other conditions. Propagation 
software(s) typically use the Irregular Terrain Model (also known as Longley-Rice) of radio 
propagation for frequencies between 20 MHz and 20 GHz. This model is based on electromagnetic 
theory and statistical analyses of the combination of terrain features and radio measurements, then 
predicting the median attenuation of a radio signal as a function of distance and the variability of the 
signal in time and in space.  For metropolitan areas, the software can typically be adjusted to use the 
Okumura-Hata model which accounts for predicting the behavior of cellular transmissions in areas 
where buildings are the primary obstructions. The resulting product from either model depicts a 
graphical illustration of the theoretical propagation characteristics of a selected frequency range 
based on defined variables (receiver sensitivity of the home/mobile device, foliage factor, and digital 
elevation terrain input). 
 
 
BROADBAND INQUIRIES METHODOLOGY 

Connected Nation collects consumer feedback in the form of broadband inquiries. These inquiries 
represent any type of communication received from the public regarding broadband service. Once 
broadband inquiries are received across the state, this information is overlaid with the broadband 
availability information which was collected through the SBDD program.  This allows for a real-
world comparison of the broadband landscape to the information received from broadband 
inquiries.  Broadband inquiries are able to provide three types of information:  1) Residents who do 
not have broadband but want it.  2)  Residents who have broadband but want a different provider.  
3)  Residents who do not have broadband, but the broadband inventory maps indicate that they do. 
 
Through the collection of broadband inquiries, a visual demand for broadband is presented.  This 
visualization allows Connected Nation the ability to validate broadband availability maps for 
accuracy.  If residents within a region state that they are without broadband, but the broadband 
inventory maps show otherwise, this allows Connected Nation to approach the providers within that 
area in an effort to trim down their coverage to more accurately represent real-world availability on 
the ground.  On the other hand, if there is a region in the territory in which broadband is not 
available, the broadband inquiries allow providers close to that region to see where they can 
successfully expand their broadband networks, leading to a high return on investment.  In short, the 
higher number of inquiries leads to a higher level of certainty in regard to the broadband availability 
maps.  Since the initial data collection and release of corresponding maps, feedback in the form of 
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broadband inquiries has allowed Connected Nation to identify additional areas that are in need of 
field validation, which are scheduled as soon as possible. Additional information on field validation 
can be found in the Field Validation Narrative. 
 
The broadband inquiry process has been implemented in each of the Connected Nation state 
programs with successful results. Altogether Connected Nation has received over 16,000 broadband 
inquiries since 2007, allowing the state programs to evaluate each inquiry for broadband demand and 
data verification.  These inquiries are continuously examined against current broadband availability, 
updated every six months, to determine if previously unserved households have been expanded to 
and can now receive broadband at their residence. This database of broadband inquiries has also 
allowed the Connected Nation state programs to aggregate demand in concentrated areas to show 
providers the exact locations where the population has made it clear that they would purchase 
broadband if it was made available to them. Providers in the states have responded to this process 
and have expanded to areas knowing that their investment will be worthwhile. Data verification 
methods have also proven successful, as the state programs have been able to show those inquiries 
that indicate the broadband service areas are misrepresented on the map to providers, who then 
verify where service cannot reach in regard to that residence(s). The broadband coverage in these 
states has been altered to create a more accurate map based on the inquiries submitted by the public. 
 
During this reporting period, the Connect Florida project has received a total of 4 inquiries (15 grant 
inception to date).  As more inquiries are submitted to Connect Florida, a more thorough validation 
of the broadband landscape can be performed, while also allowing providers to see which areas have 
a high demand for broadband adoption. 
 
 
BROADBANDSTAT METHODOLOGY  

BroadbandStat is an online, interactive mapping tool for viewing, analyzing, and validating 
broadband data. Developed through a partnership with ESRI, the market leader in geographic 
information system (GIS) software, BroadbandStat is a multi-functional, user-friendly way for local 
leaders, policymakers, consumers, and technology providers to devise a plan for the expansion and 
adoption of broadband.  
 
First and foremost, BroadbandStat allows consumers to locate their residence and identify providers 
that offer broadband Internet service to that location. The interactive platform allows for users to 
build and evaluate broadband expansion scenarios using a wealth of data, including education and 
population demographics, broadband availability, and research about the barriers to adoption.  
 
New functionality in BroadbandStat allows the consumer to provide feedback on the broadband 
data displayed on the interactive map.  Through the collection of this feedback, a visual demand for 
broadband is presented.  This visualization allows the Connected Nation state programs the ability 
to validate the broadband availability for accuracy.  If residents within a region state they are without 
broadband, but the interactive map shows otherwise, this allows Connected Nation to approach the 
providers within that area in an effort to trim down their coverage to more accurately represent real-
world availability on the ground.   
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The Connect Florida project launched BroadbandStat on May 26, 2010, and has received a total of 
1,146 visits to date, of which 639 occurred this reporting period. 
 
 
SPEED TEST METHODOLOGY 

The 70 speed tests that are represented in the Connect Florida Speed Test Report during this 
reporting period (397 grant inception to date) are the result of a partnership between Connected 
Nation and Ookla Net Metrics. Utilizing this relationship increases the level of confidence in the 
data being collected and provides for a far greater sample size than could be collected by a single 
testing site. 
 
Ookla owns and operates Speedtest.net, as well as develops and deploys speed tests, such as the 
Connect Florida speed test website, for partners around the world. This network of sites that is 
developed and run on its testing technology provides Ookla with a vast dataset that, due to the 
variability of geographic information collected across the varying speed test sites, is geocoded 
utilizing Geo-IP technology. This technology allows for tests to be geocoded to points of 
aggregation, typically larger nodes across provider networks.  While there are hundreds of thousands 
of tests that have been conducted, the level of aggregation is only sufficient for county-level detail 
due to the test results being located at these larger nodes and not at an absolute location for each 
speed test. 
 
In an effort to validate broadband data from the Connect Florida project, speed test information is 
collected throughout the state.  Speed tests provide speed information on the path taken through all 
networks (a provider’s network as well as additional networks) a local machine must connect to in 
order to reach the host test.  The benefit of this collection of speed information is two-tiered.  First, 
it allows for a comprehensive dataset of speeds, while also providing Connect Florida with the 
information on where broadband services are available.  Second, unlike theoretical speed 
information which was received through the data collection process, the use of speed tests provide 
real-world information on the speeds that currently exist within the state of Florida.   
 

 



Complete 53
Non-Responsive/Refused 16
In Progress 28

Count of Datasets by Viable Status 97
Total Unique Providers Represented 70

Provider Name Platform Status
NDA Execution 

Date Notes
airPowered Fixed Wireless Data Added to Statewide Inventory 2/17/2011
AT&T Inc. ILEC/CLEC Data Added to Statewide Inventory 12/16/2009
AT&T Inc. Mobile Wireless Data Added to Statewide Inventory 12/16/2009
Bright House Networks, LLC Cable Data Added to Statewide Inventory 4/26/2010
CenturyLink ILEC/CLEC Data Added to Statewide Inventory 12/4/2009
Clearwire Corporation Mobile Wireless Data Added to Statewide Inventory 3/3/2010
Comcast Cable Communications, LLC Cable Data Added to Statewide Inventory 12/7/2009
ITS Telecommunications Systems Inc. Fiber Data Added to Statewide Inventory 4/28/2010
ITS Telecommunications Systems Inc. ILEC/CLEC Data Added to Statewide Inventory 4/28/2010
Quincy, City of Fiber Data Added to Statewide Inventory
Sprint Nextel Corporation Mobile Wireless Data Added to Statewide Inventory 1/14/2010
T-Mobile USA, Inc. Mobile Wireless Data Added to Statewide Inventory 1/8/2010
TDS Telecommunications Corporation ILEC/CLEC Data Added to Statewide Inventory 1/27/2010
Verizon Florida LLC ILEC/CLEC Data Added to Statewide Inventory 12/14/2009
Verizon Florida LLC Fiber Data Added to Statewide Inventory 12/14/2009
Verizon Florida LLC Mobile Wireless Data Added to Statewide Inventory 12/14/2009

City of Leesburg, Florida Backhaul
Backhaul Provider Only Processing 
Complete

Cogent Communications, Inc. Backhaul
Backhaul Provider Only Processing 
Complete

Covad Communications Backhaul
Backhaul Provider Only Processing 
Complete 1/19/2010

FPL FiberNet LLC Backhaul
Backhaul Provider Only Processing 
Complete 6/3/2010

Level 3 Communications, LLC Backhaul
Backhaul Provider Only Processing 
Complete 12/14/2009

T-Mobile USA, Inc. Backhaul
Backhaul Provider Only Processing 
Complete 1/8/2010

TDS Telecommunications Corporation Backhaul
Backhaul Provider Only Processing 
Complete 1/27/2010

Smart City Fiber Provider Approval Solicited 6/24/2010
Smart City ILEC/CLEC Provider Approval Solicited 6/24/2010
Sago Networks, LLC Fixed Wireless Partial Data Received
Talk America Inc. Backhaul Partial Data Received
The Home Town Network, Inc. Fiber Partial Data Received 5/5/2010
Palm Coast-Flagler Internet, LLC Fixed Wireless Provider Gathering Data
Advanced Cable Communications Cable No Update to Provide 4/16/2010
AT&T Inc. Backhaul No Update to Provide 12/16/2009
Cellular South, Inc. Mobile Wireless No Update to Provide 4/12/2010
CenturyLink Backhaul No Update to Provide 12/4/2009
Cox Communications, Inc Cable No Update to Provide 1/29/2010
Cox Communications, Inc Backhaul No Update to Provide 1/29/2010
DeltaCom, Inc. Backhaul No Update to Provide 2/16/2010
Frontier Communications Corporation ILEC/CLEC No Update to Provide 1/22/2010
GTC, Inc. ILEC/CLEC No Update to Provide 1/28/2010
Home Town Cable TV, LLC Fiber No Update to Provide 4/21/2010
Mediacom Southeast LLC Cable No Update to Provide 1/12/2010
Nextlink Wireless, Inc. Backhaul No Update to Provide 2/12/2010
Northeast Florida Telephone Company Fiber No Update to Provide 4/16/2010
Northeast Florida Telephone Company ILEC/CLEC No Update to Provide 4/16/2010
Orlando Telephone Company, Inc. Cable No Update to Provide
Orlando Telephone Company, Inc. Backhaul No Update to Provide
Orlando Telephone Company, Inc. Fiber No Update to Provide
Qwest Communications Company, LLC Backhaul No Update to Provide 1/4/2010
Sprint Nextel Corporation Backhaul No Update to Provide 1/14/2010
T3 Communications Backhaul No Update to Provide 6/3/2010
The Home Town Network, Inc. Fixed Wireless No Update to Provide 5/5/2010
tw telecom of florida, l.p. Backhaul No Update to Provide 4/22/2010
Velocity Online Backhaul No Update to Provide 4/8/2010
Verizon Florida LLC Backhaul No Update to Provide 12/14/2009
XO Communications, LLC Backhaul No Update to Provide 2/12/2010

Florida LambdaRail LLC Backhaul
No Update Provided - Use Last Submission 
Data 4/29/2010

Frontier Communications Corporation Backhaul
No Update Provided - Use Last Submission 
Data 1/22/2010

Gainesville Regional Utilities Backhaul
No Update Provided - Use Last Submission 
Data

Windstream Communications ILEC/CLEC
No Update Provided - Use Last Submission 
Data 1/19/2010

Windstream Communications Backhaul
No Update Provided - Use Last Submission 
Data 1/19/2010

CommFunction, LLC Fixed Wireless Solicited Initial Data
Desoto Life Fixed Wireless Solicited Initial Data
FiberLight LLC Backhaul Solicited Initial Data 4/19/2010
James Cable LLC Cable Solicited Initial Data 1/11/2010
Marco Island Cable, Inc. Cable Solicited Initial Data
Omnispring LLC Backhaul Solicited Initial Data
PAETEC Communications, Inc. Fixed Wireless Solicited Initial Data
PAETEC Communications, Inc. ILEC/CLEC Solicited Initial Data
PAETEC Communications, Inc. Backhaul Solicited Initial Data
PDMNet Fixed Wireless Solicited Initial Data 4/20/2010

Broadband Provider Log



Rapid Systems Corporation Fixed Wireless Solicited Initial Data
Reliance Globalcom Services, Inc. Backhaul Solicited Initial Data
Sling Broadband Fixed Wireless Solicited Initial Data
Southern Light Backhaul Solicited Initial Data 6/16/2010
The Ultimate Connection, LLC Backhaul Solicited Initial Data

Birch Communications, Inc. ILEC/CLEC Refused to Participate

[JAN-11-11 Jill Lindgren] Provider has chosen 
not to participate.  The main concern was more 
with the fact he does not want to divulge the 
information publicly on his speeds or coverage 
area.

Birch Communications, Inc. Backhaul Refused to Participate

[JAN-11-11 Jill Lindgren] Provider has chosen 
not to participate.  The main concern was more 
with the fact he does not want to divulge the 
information publicly on his speeds or coverage 
area.

CyberStreet Inc. Fixed Wireless Refused to Participate

[APR-14-10 Lindgren] Provider relayed his 
wishes not to participate and requested we not 
call again.

SBB Communications, LLC Fixed Wireless Refused to Participate

[MAR-07-11 Dawn Clark] Per note in Provider 
table, provider requested that we not contact 
them anymore regarding data submission.  
There was no further outreach made to this 
provider.

Break Free Wireless Corporation Fixed Wireless Non-Responsive to Multiple Attempts

In addition to multiple contact attempts made 
between May 25, 2010 and June 24, 2010, two 
attempts were made during this submission 
period.

Brevard Wireless Fixed Wireless Non-Responsive to Multiple Attempts
Nine contact attempts were made between April 
5, 2010 and January 13, 2011.

Cablevision of Marion County LLC Cable Non-Responsive to Multiple Attempts
Six contact attempts were made between April 
7, 2010 and January 13, 2011.

ClearSurf Broadband Fixed Wireless Non-Responsive to Multiple Attempts 5/3/2010

In addition to multiple contact attempts made 
between March 29, 2010 and August 17, 2010, 
two attempts have been made during this 
submission period.

GBS Online Fixed Wireless Non-Responsive to Multiple Attempts

In addition to multiple contact attempts made 
between March 29, 2010 and August 25, 2010, 
seven attempts have been made during this 
submission period.

KissimmeeWeb Fixed Wireless Non-Responsive to Multiple Attempts

In addition to multiple contact attempts made 
between August 21, 2009 and August 12, 2010, 
six attempts have been made during this 
submission period.

Knology of Florida, Inc. Cable Non-Responsive to Multiple Attempts

In addition to multiple contact attempts made 
between March 16, 2010 and August 24, 2010, 
six attempts have been made during this 
submission period.

Knology of Florida, Inc. Backhaul Non-Responsive to Multiple Attempts

In addition to multiple contact attempts made 
between March 16, 2010 and August 24, 2010, 
six attempts have been made during this 
submission period.

TerraNova Net Internet Services Fixed Wireless Non-Responsive to Multiple Attempts
Seven contact attempts were made between 
April 6, 2010 and January 13, 2011.

TerraNova Net Internet Services ILEC/CLEC Non-Responsive to Multiple Attempts
Seven contact attempts were made between 
April 6, 2010 and January 13, 2011.

US Metropolitan Telecom, LLC Fiber Non-Responsive to Multiple Attempts
Thirteen contact attempts were made between 
March 29, 2010 and January 13, 2011.

US Metropolitan Telecom, LLC Backhaul Non-Responsive to Multiple Attempts
Thirteen contact attempts were made between 
March 29, 2010 and January 13, 2011.

Clearwire Corporation Fixed Wireless Other 3/3/2010

[JAN-19-11 Terry Holmes] Clearwire converted 
their fixed wireless system to a mobile network 
as of this reporting period, and it is now reported 
as mobile.  They do not have any remaining 
fixed wireless networks in FL.

CommFunction, LLC ILEC/CLEC Other

[MAR-08-11 Chip Spann] Website indicates 
service offering to business (no mention of 
residential services).  Wireless section of 
website is blank.  Appears they are general 
resellers of DSL.

Covad Communications ILEC/CLEC Other 1/19/2010

[FEB-18-11 Wes Kerr] Provider doesn't offer 
residential DSL, and the last mile data will not 
be included in the data submission.

DISH Network Corporation Satellite Other 1/27/2010

[MAR-09-11 Amanda Bentley] Satellite data will 
not be submitted due to additional information 
being necessary to show where service is 
available in the state, rather than submitting the 
entire state boundary as serviceable area.

Global Crossing Telecommunications, Inc. Backhaul Other

[FEB-17-11 Wes Kerr] Received word from a 
provider representative that they still have a 
Network Security agreement with several 
Federal agencies and cannot provide data at 
this time.

Hughes Network Systems, LLC Satellite Other 2/5/2010

[MAR-09-11 Amanda Bentley] Satellite data will 
not be submitted due to additional information 
being necessary to show where service is 
available in the state, rather than submitting the 
entire state boundary as serviceable area.

WildBlue Communications, Inc. Satellite Other 1/8/2010

[MAR-09-11 Amanda Bentley] Satellite data will 
not be submitted due to additional information 
being necessary to show where service is 
available in the state, rather than submitting the 
entire state boundary as serviceable area.
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1 Overview 
The following describes the Data Gathering, Data Integration, Data Validation and Verification and Quality Control 

processes utilized to create the Broadband Mapping Project’s April 1
st

, 2011 data submission.   

 

To support various levels of technical and program knowledge, this white paper supplies both a high level 

summary and a detailed process review. 

 

2 High Level Review 

2.1 Data Gathering - Providers 

Broadband Service Area, Middle Mile Aggregation Points and Broadband Service Overview 

The collection of Broadband Service areas, Middle Mile Aggregation points and Broadband Service Overview 

information is handled through the following Provider Outreach Process: 

 

 Build and Maintain an Inventory of Broadband Providers through research and State inputs. 

 Update Provider Material that describes the data requirements and logistics for data transfer. 

 Update NDA for use in project, where applicable 

 Maintain multiple protocols for the provider to submit data, including SFTP technology when desired.   

 Conduct one-on-one informational discussions with each provider to communicate the following: 

o Requirements of this project 

o Broadband data required to support the product data model 

o Submission protocols available 

o Capability to validate how the supplied data is aggregated 

 

 Download/receive Provider Data 

 Establish a repeatable process with Provider. Maintain Provider communication, transaction and data 

handling records throughout the project (dates contacted, data received, etc.)  
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2.2 Data Gathering - Community Anchor Institution (CAI) 

The collection of CAI information is handled through the following CAI Collection Process: 

 Collect and maintain inventory of CAIs through Data Mining, research, and State inputs. 

 Maintain web-based CAI portal for institutions to add or confirm attribution, location and enter 

broadband-specific information. 

 Upload web-based data to Core Database for standardization. 

 Perform internal cleansing, such as removing duplicate records, identifying gaps in broadband attribution 
and verifying category.  

 Geocode CAI locations.  

 Translate Core Database data to deliverable ready format.  

 Continue engagement with non-responsive institutions. 

 

2.3 Data Integration Process 

 

The data integration and processing mechanisms currently utilized allow for multiple types of inputs and results in 

a standardized output that meets the NTIA deliverable requirements. This process is flexible to support data model 

changes and project requested enhancements.  

 

 Receive inputs from Providers via submission protocols, upload into Sourcing Database and catalog with 

provider information.  

 Review Provider supplied data for completeness and for potential discrepancies that require resolution 

prior to processing and flag as necessary. 

 Categorize input into data type category (addresses, block lists, paper maps, etc.). 

 Standardize input based on data type within Staging Database. 

 Create Compact Polygons (CP)—(internal methodology for generating area based feature for coverage in 

Staging Database). 

 Apply broadband attribution to CP, Apply metadata to CP 

 Perform quality analysis of the CP against the source supplied to identify any completeness or accuracy 

issues.   

 Request additional information from the provider if elements of coverage are missing or contain 

discrepancies.  This is a second manual quality check to ensure data is complete.   Following completion of 

CP creation, process steps within Data Validation & Verification occur 

o Process coverage area to build the required NTIA data model layers  

 

 Process CAI data input into internal standardized format, as mentioned above under CAI Create Product 

Deliverable based on NTIA and State-level requirements. 

 Following the creation of the product, process steps within Data Validation & Verification occur 
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2.4 Data Validation & Verification 

 

To ensure the data collected and processed is accurate and comprehensive, a holistic approach has been 

developed to further validate and verify the data. Following the initial mapping of providers’ coverage area and 

serviceability claims, the project team uses the following methods:  

 

 Third-Party Data Verification: Visually and programmatically compare the coverage against third-party 

data.  

Pitney Bowes and American Roamer data are used in cases where a coverage area is questionable.  All 

anomalies identified during this analysis are reviewed with the providers. 

 

 Broadband Provider Validation – Provider Portal Application:  Providers were trained on and requested 

to use a secure interactive web application to review their current coverage area(s) and supporting 

broadband attribution and validate their data or submit change requests to update their data. 

 

All provider change requests go through the Data Integration Process and a review with the provider to 

complete validation. 

 

 Confidence Values:  All Verification, Validation, and manual quality reviews are tracked by provider and 

then by technology type, which is then stored and maintained within a “Validation” table.  A confidence 

value is assigned based on the collected information to highlight provider coverage areas that require 

further investigation and enhancements. 

 

2.5 Quality Control 

Following collection, processing and analysis of the provider and CAI data, the product is checked manually and 

algorithmically against the NTIA data model.  Some of the items included within these checks are as follows:   

 Format Correctness 

 Table & Field Structure  

 Valid Values 

o Including default values, where applicable 

 Geographic Extent and Topology Errors 

 

Prior to data submission, another quality control script supplied by NTIA is run.  This script, 

SBDD_CheckSubmission.py, creates an output in text form that is required to be submitted along with the final 

deliverable.  All errors must come up clean, unless otherwise specified from NTIA. 

Exceptions to the script as noted by NTIA on the SBDD Workspace on 03/25/11 at the following link: 
https://sbdd-granteeworkspace.pbworks.com/w/page/38218329/CheckSubmissionExceptions  

https://sbdd-granteeworkspace.pbworks.com/w/page/38218329/CheckSubmissionExceptions
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- Longitude values for States outside the lower 48 (any table) 

- CAI results for Transtech, MaxAdUp, MaxAdDown if BBService is ‘No’ or ‘Unknown’  

- Overview MaxAdDown, MaxAdUp if 100% of record level data has MaxAdDown or MaxAdUp 

populated 



            

8 

 

3 Detailed Process Review 
Below is a detailed review of the data collection, integration and quality control points along the broadband data 

gathering and mapping process. 

 

Diagram of overall process: 

 
 

3.1 Provider Outreach 

For the April 2011 data submission, an e-mail notification was sent to all providers with supporting deliverable 

dates.  The Provider Portal web application was released and training webinars held so providers could use this 

application to submit changes to and/or validate their current coverage area(s). 

 

Data was also collected from the providers via e-mail and SFTP, depending on their comfort level to submit data in 

time for the April 1
st

 deadline. 

 

In support the data collection effort, providers that did not timely respond to the outreach were contacted by 

phone. 
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3.2 Outreach Materials 

The original provider packet sent via email to the providers included the following documents and files: 

1) Letter from the State inviting them to participate in the program 

2) Copy of the non-disclosure agreement (NDA) 

3) Copy of the Mapping NOFA from the NTIA 

4) Copy of the NOFA Clarification from the NTIA 

5) Broadband service address example file in CSV format 

6) Word document describing service address example file 

7) Broadband service block example file in CSV format 

8) Word document describing service block example file 

9) Broadband service street example file in CSV format 

10) Word document describing service street example file 

11) Broadband subscriber example file in CSV format 

12) Word document describing subscriber example file 

13) Broadband wireless coverage area sample shapefile 

14) Word document describing wireless coverage area sample shapefile 

15) Instructions for downloading, installing, and using the WinSCP secure FTP application 

 

3.3 Outreach Process 

The provider outreach process is comprised of the following general steps: 

1) Send the provider package and introduction letter to the main point of contact for the provider 

2) Follow up with email and call to verify that the main point of contact is correct. 

3) If necessary, discuss the NDA further and resolve any redlines. 

4) Once the correct primary contact is established, set up a call, if necessary, to learn more about the 

provider’s offerings and direct them to the appropriate outreach materials. 

5) If providers are unable to be contacted (non-responsive) or indicate that they are not interested in 

participating (non-cooperative) mark them as such on the provider tracking sheet. These providers will be 

escalated to the state for further action. 

6) As the providers are collecting the required data, provide instruction on downloading, installing, and using 

the WinSCP secure FTP application, if required. 

7) Arrange with the providers to transfer the data in whatever way they are comfortable. Some providers 

will find regular email acceptable. Others will want to use the secure FTP application. 

8) After data is received and reviewed, it may be necessary to contact a provider for clarification or to 

address incomplete data sets. In the interest of building and maintaining relationships, care is given not to 

push the provider but to work with it to obtain accurate data in the best possible format. 
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3.4 Data Collection 

3.4.1 Data Transfer Procedures 

There are three primary ways data is collected from providers. These are: 

1) Secure FTP using the WinSCP application 

2) Regular email 

3) Mail 

 

3.4.2 Initial Data Review and Quality Assurance 

The initial data review and quality assurance process consists of the following general steps: 

1) Access the data from the secure FTP site or email 

a. If emailed, place copy of original data set in the appropriate provider folder on the secure FTP 

site 

2) Place copy of raw data on local computer in a working directory. 

3) Review data and determine course of action based on type of data received. 

4) Ensure data is complete and contact provider to address any gaps. 

Note: The goal is to get as many providers as possible to provide subscriber address data in the correct format. 

Obviously, this will not be possible with all providers so we will continue to have to process various types of 

provider-supplied data. 
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3.5 Data Ingestion 

3.5.1 Data Ingestion Overview 

The following outlines the process steps taken based on the type of input supplied by the data provider: 

Point Data 

 Subscriber location 

 DSLAM location 

 Central Office location 

 Broadcast Tower location 

Linear Information 

 TIGER street segments 

Polygonal Information 

 Census Blocks 

 Coverage Area 

Overall, the process is geared toward taking the provider data supplied and creating polygon shapes to append to 

the bb_cov feature class. The bb_cov feature class is the interim data set that is then processed using the 

makeDeliverable.py Python scrip to create the MapConnect data layers that will be delivered to the state and, 

ultimately, to the NTIA.  Following are the detailed instructions used in this process.  

 

3.5.2 Point Data 

3.5.2.1 Subscriber Location – Address Data 

In the event that the data provider supplies subscriber address data the following actions occur: 

1) First, convert the address data to a clean Excel spreadsheet in an appropriate address data format. 

a) Usually, this has the following columns: street address (number, pre-directional, pre-modifier, street 

name, street type, post-directional, and post-modifier concatenated together), city, state, ZIP. 

2) Configure the ArcGIS geocoding tool to use the TIGER 2009 streets dataset 

a) In ArcCatalog, create a new Address Locater by right-clicking in the white space of the appropriate 

directory and selecting New>Address Locater from the dropdown menu. 

b) Select “US Streets with Zone” and press OK. 

i) Note: It is likely that multiple Address Locators will have to set up to handle the variety of 

provider address data received. 

c) Navigate to the TIGER Streets 2009 file and press OK. 

d) Fill in the dialog box as seen below: 
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e) Click OK. 

3) Open up ArcMap, and add the Excel spreadsheet with the address information. 

4) Right-click on the Excel spreadsheet and select Geocode Addresses from the dropdown menu. 

5) Select the appropriate address locator by clicking Add…. then OK. 
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6) Fill out the Geocode Addresses dialog box as shown below: 

 

 
 

7) Geocode the list in batch mode using the geocode service set up in Step 2 above, accepting all the default 

parameters. 

8) Review results. 
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9) Adjust geocoding parameters accordingly and repeat batch to resolve issues. 

10) Manually geocode unmatched addresses until target hit rate achieved, generally 90%. 

11) Visually inspect the data as seen below: 
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12) Follow the steps detailed in Subscriber Location – GIS Data below 

 

3.5.2.2 Subscriber Location – XY Data 

If the provider supplies a list of subscriber data with accompanying XY data such as latitude and longitude, the 

steps are as follows: 

1) Refine the format in Excel so that the data can easily be opened using ArcMap. 

a. Remove all font color, highlighting, cell colors and borders, clean up column headers and make 

sure there are no merged cells. 

b. Make sure that XY locations are in decimal degrees. 

i. To convert from degrees, minutes, seconds (39º 26’ 45.67”) to decimal degrees us the 

following formula: DD + (MM/60) + (SS.SSS/3600). 

ii. Note: if XY locations from some other coordinate system are provided, you can use 

those in the process below but you must know what the coordinate system is. 

2) Open up the Excel worksheet in ArcMap. 

3) From the menu bar, select Tools>Add XY Data… 
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4) Supply the appropriate fields for the X and Y coordinates, choose the appropriate coordinate system and 

press OK. 

5) Results are an event layer, not a true spatial layer. Export the data by right-clicking the event layer and 

selecting Data>Export Data… from the dropdown menu. 

6) Follow the steps detailed in Subscriber Location – GIS Data below. 

 

3.5.2.3 Subscriber Location – GIS Data 

If the provider supplies subscriber location in GIS format, the only process step is to load that data into the 

appropriate data schema and it will be ready for processing. 

1) First, load the data into the Point Address database schema (please see Appendix D for an example of the 

Point Address database schema.) using an empty feature class in that schema. 

2) In ArcCatalog, right-click on the empty feature class and select Load from the dropdown menu. 

3) Navigate to the provider address GIS data set and then map the attribute fields accordingly, as seen in 

general below: 
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4) Once you have successfully loaded the provider address data into the temporary database with the 

correct schema, you will now append that data to the overall Point Address database. 

5) In ArcToolbox, use the Append command (Data Management Tools>General> Append) to add the 

features into the overall Point Address database, as seen in general below: 
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6) Since the data is already in the Point Address database schema, there is no n need to alter the Field Map 

in the Append tool. 

7) After appending, calculate metadata reflecting geometry source and representation values. 

8) Break provider-specific points into separate county feature classes and perform the following steps per 

county feature class: 

a. Within ArcGIS 

i. Summarize download and upload speeds [first,last] to determine all speeds available for 

county. 

1. This will save as a DBF table. Keep track of location for future reference. 

ii. Buffer county address point featureclass to 150’.     

1. During buffer command, dissolve on “ad_down”; ”ad_up”; ”provider”; “dba”; 

“frn”; “tt”; ‘all metadata fields’; “stctyfips”.    Save as…. 

county_fastestdown_fastestup.  

2. (Example using Qwest data: boulder_40128_20128, where boulder=county;  

40128=ad_down; 20128=ad_up) 

3. Note: these attribute fields are specific to the Point Address database. 

iii. Select the features that represent the lowest speeds 

b. Using XtoolsPro (http://www.xtoolspro.com/)  

i. In the XTools Pro toolbar, select XTools Pro>Layer Operations>Erase Features 

ii. Use the same feature class for Input and Overlay 

iii. Check Use selected features on the Input feature, as seen below. 

http://www.xtoolspro.com/
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iv. Repeat and erase slowest speeds one speed at a time.  Saving each new feature class as 

the next slowest speed, using the same naming convention as above. A general example 

is seen below: 

 

 
 

c. Within ArcGIS 

i. Edit/delete speeds from the attribution table of each feature class, so each remaining 

feature class has only one speed value. 

ii. Merge individual speed feature classes together using the Merge command in 

ArcToolbox (Data Management Tools>General>Merge). The dialog box is seen below:  
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iii. Merge individual county feature classes together using the Merge command in 

ArcToolbox (Data Management Tools>General>Merge).  

iv. Since the county files are all in the same schema, do NOT alter the Field Map portion of 

the command interface. 

v. When all the county files are merged together into one dataset, use the Append 

command in ArcToolbox (Data Management Tools>General>Append) to add the 

features to the bb_cov interim data set. Use the Field Map portion of the Append tool to 

map the appropriate field values to their corresponding fields in the bb_cov feature 

class. 

 

3.5.2.4 DSLAM or Central Office Location – Address Data 

In the event that the provider supplies DSLAM (digital subscriber line access multiplexer) or Central Office address 

data please follow the steps below: 

1) Follow the process for geocoding points in Subscriber Location – Address Data, above. 

2) Follow the steps detailed in DSLAM or Central Office Location – GIS Data below. 

 

3.5.2.5 DSLAM or Central Office Location – XY Data 

In the event that the provider supplies DSLAM (digital subscriber line access multiplexer) or Central Office XY data 

please follow the steps below: 

1) Follow the process for creating points from XY data  in Subscriber Location – XY Data, above. 

2) Follow the steps detailed in DSLAM or Central Office Location – GIS Data below. 
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3.5.2.6 DSLAM or Central Office Location – GIS Data 

In the event that the provider supplies DSLAM (digital subscriber line access multiplexer) or Central Office GIS data 

please follow the steps below: 

1) Buffer the DSLAM/Central Office points feature class 

a) Add the point feature class to ArcMap 

b) Open up ArcToolbox and go to Analysis Tools>Proximity>Buffer 

c) Set the buffer distance to 5 miles 

d) Set the dissolve type to ALL 

e) Name the output feature class 

f) Typical Buffer tool is seen below: 

 

 
 

g) Press OK 

2) Use the resulting buffer feature class to clip the TIGER street layer (as described earlier): 

a) Add TIGER street layer to ArcMap 

b) Open up ArcToolbox and go to Analysis Tools>Extract>Clip 

c) Complete the dialog box as seen below: 
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d) Press OK. 

3) Using ArcCatalog and within the file geodatabase: 

a) Right Click and create a new Feature Dataset  

i) For the Feature Dataset settings: 

(1) Name the feature dataset accordingly 

(2) Select horizontal coordinate system by importing the coordinate system associated with the 

clipped TIGER street layer by selecting Import and navigating to the location of that feature class 

(3) No vertical coordinate system needed 

(4) Leave all x,y,z,m values at default. 

(5) Press Finish 

4) Import previously created street feature class into new Feature Dataset 

5) Right-click Feature Dataset and create new Network Dataset – accept all default setting for the Network 

Dataset 

a) Note: the Network Analyst extension must be turned on 

6) In ArcMap Turn on the Network Analyst Toolbar by going to View>Toolbars>Network Analyst 

7) Add the Network Dataset created in Step 5 to ArcMap 

8) Using Network Analyst Toolbar drop down – create “New Service Area” 

9) Open up the Network Analyst Window by selecting the  button. 
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10) Right click Facilities layer, select Load Locations, and navigate to the DSLAM/Central Office facilities feature 

class. 

 
 

11) Press OK. 

12) Click the Service Area Properties button  

13)  For the following tabs change the following properties: 

a) “Polygon Generation” tab  

i) Select “Merge by break value”  

ii) Also disable the Trim Polygons option 

b) “Analysis Settings” tab – using and converting the specified DSLAM buffer distance from feet to meters – 

input buffer distance value in meters into the “Default Breaks” location 
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i) Generally, 18,000 feet (5486 meters) from DSLAM or Central Office location is used as the buffer 

distance 

 
 

c) Click OK. 

14) On the Network Analyst Toolbar click the “Solve” button  to create service area polygons. 

15) Right-click on the created service are polygon in the layer list, and select Data>Export Data from the dropdown 

list. 

16) Export to a feature class in the file geodatabase you created earlier 

17) In ArcCatalog, create an empty feature class with the schema of the bb_cov feature class and load the feature 

class created in Step 16 into it. 

a) Right-click on the empty feature class, select Load>Load data from the dropdown menu and navigate to 

the location of the service area feature class 

b) Press the Add button, hit Next 

c) Accept the defaults and hit Next 

d) Do NOT attempt to map any fields, as seen below: 
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e) Press Next, then Next again, then Finish. 

18) In ArcToolBox, go to Data Management Tools>General>Append 

19) Append the formerly empty feature class to bb_cov, completing the dialog box as seen below: 

 

 
 

20) Leave the Schema Type as TEST 
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21) Press OK. 

22) In ArcMap, open up bb_cov for editing and manually input associated attribution. 

 

3.5.2.7 Broadcast Tower Location – Address Data 

In the event that the provider supplies wireless broadcast tower location address data please follow the steps 

below: 

1) Follow the process for geocoding points in Subscriber Location – Address Data, above. 

2) Follow the steps detailed in Broadcast Tower Location – GIS Data below. 

 

3.5.2.8 Broadcast Tower Location – XY Data 

In the event that the provider supplies wireless broadcast tower location XY data please follow the steps below: 

1) Follow the process for creating points from XY data  in Subscriber Location – XY Data, above. 

2) Follow the steps detailed in Broadcast Tower Location – GIS Data below. 

 

3.5.2.8.1 Broadcast Tower Location – GIS Data 

In the event that the provider supplies wireless broadcast tower location GIS data please follow the steps below: 

1) Download the required software (Radio Mobile) from the website: 

http://www.cplus.org/rmw/english1.html  

2) Install the software according to the standard directions, found here: 

http://www.cplus.org/rmw/download/download.php?S=1  

3) Open up the application 

4) Load the broadcast tower location and elevation information by selecting File>Unit properties. The 

following dialog box appears: 

 

http://www.cplus.org/rmw/english1.html
http://www.cplus.org/rmw/download/download.php?S=1
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5) Add in the information for all the towers supplied by the WISP data provider, including the elevation. If 

provider does not supply elevation, this information can be obtained from Google Earth. 

a. I f available, use the Import button to import a Google Earth KML of the tower locations. 

6) Go to the National Map Seamless Server (http://seamless.usgs.gov/) and download elevation data 

sufficient to contain the tower locations. 

a. At least the 1/3” NED data is needed. Select this by clicking the Download button in the upper 

right of the web site and checking the box nect to 1/3 “ NED. 

b. Zoom to the area of interest and use the Download tools: 

 
to define the area to download. 

c. Click the Modify Data Request button to request the data in BIL_16INT format, not ESRI GRID, as 

seen below: 

 

http://seamless.usgs.gov/
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d. Download the data and unzip it. 

7) Select File>Map Properties to define the map 

8) Enter in a latitude and longitude in the center of the tower locations 

9) Set the size (in pixels) and the size (in kilometers) of the map 

10) Set the directory path leading to the BIL elevation data just downloaded 

11) The dialog box is seen below: 

 
 

12) Hit Extract. 
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13) The elevation data is render as a hill shade, as seen below: 

 

 
 

14) Select File>Network properties from the main menu 

15) Create a new network and enter in the frequency range under the Parameters tab, as seen below: 
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16) Leave all the other values as they appear, and select the Systems tab 

17) Create enough systems to cover all the varieties of equipment in the provider network. This will include 

the antenna type, height, and line loss, as seen below: 
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18) Now click on the Membership tab, and assign the individual towers to their respective systems, providing 

the azimuth for non-omnidirectional antennas, as seen below: 
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19) Press OK. 

20) Select Tools>Radio Coverage>Combined Cartesian from the main menu 

21) Complete the dialog box as seen below, providing the Maximum Range from the highest tower beam 

radius supplied by the provider. 

22) Set the Pixel Size at 5 (experiment depending on the area covered to get the right level of granularity) as 

seen below: 
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23) Set the signal range to draw to S-Unit and type 5 in the From (>=) box. 

24) Press Draw. 

 

 
 

25) Save the resulting image as a TIF by selecting File>Save Picture as. 

26) Open ArcMap and load the BIL elevation data you used in Radio Mobile. 

27) Load the TIF image you created and georeference it using the corners of the BIL data. 

a. The corners of the data can be seen in the TIF image. 
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28) Follow the georeferencing directions from the Coverage Area – PDF/JPG/Other Image Format section 

below. 

29) Use the Georeferencing Toolbar to Update the Georeferencing for the TIF data set. 

30) In ArcToolbox, select Data Transformations>From Raster>Raster to Polygon and input the georeferenced 

TIF you just created as seen below: 

 

 

31) Open the resulting polygon feature class up for editing using the Editing toolbar in ArcMap and clean up 

as necessary. 

32) In ArcCatalog, create an empty feature class with the schema of the bb_cov feature class and load the 

feature class created above into it. 

a. Right-click on the empty feature class, select Load>Load data from the dropdown menu and 

navigate to the location of the service area feature class 

b. Press the Add button, hit Next 

c. Accept the defaults and hit Next 

d. Do NOT attempt to map any fields, as seen below: 

 

 
 

e. Press Next, then Next again, then Finish. 

33) In ArcToolBox, go to Data Management Tools>General>Append 

34) Append the formerly empty feature class to bb_cov, completing the dialog box as seen below: 

 



            

35 

 
 

35)  Leave the Schema Type as TEST 

36) Press OK. 

37) In ArcMap, open up bb_cov for editing and manually input associated attribution. 

 

3.5.3 Linear Data 

3.5.3.1 TIGER Street Segments – List, Spreadsheet, or GIS Data 

In the event that the provider supplies TIGER street segments in list or spreadsheet format please follow the steps 

below: 

1) Join TIGER road segments  to 2000 census blocks feature class using one of two methods based on how 

the data is provided: 

a) If the TIGER data is provided with a Census Block ID, then join the segments to the Census Block 

geometry based on that ID 

i) Load both data sets into ArcMap 

ii) In the layer list, right-click on the 2000 census block feature class and select Joins and 

Relates>Join 

iii) In the dialog box, select the TIGER road segments data and the proper attribute fields for joining, 

as seen below: 
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iv) Press OK 

b) If the data provided is a list containing TLIDs,  then join to the TIGER line data using the TLID, and use 

a spatial join to associate the TIGER segment with the coterminous block based on the block ID 

i) Load both data sets into ArcMap 

ii) In the layer list, right-click on the 2000 census block feature class and select Joins and 

Relates>Join 

iii) Select “Join data from another layer based on spatial location” from the dropdown menu 

iv) Complete the dialog box as seen below and press OK. 
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2) Export joined records into a temporary feature class. 

3) If joined Census Block geometry is confined to one specific area then dissolve blocks into one record.  If 

joined Census Block geometry is distributed throughout a particular state then dissolve sub-selections of 

census blocks for each county. 

a) Use the County FIPS code to dissolve by county. 

b) In ArcToolbox, select Data Management Tools>Generalization>Dissolve 

c) Complete the Dissolve dialog box as seen below: 
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d) Press OK. 

4) For each dissolved region, open up the feature class for editing using the Editing tool in ArcMap and 

remove unnecessary slivers and other small holes.  For general guidance on editing features in ArcMap, 

see http://webhelp.esri.com/arcgisdesktop/9.3/pdf/Editing_Tutorial.pdf  

5) In ArcCatalog, create an empty feature class with the schema of the bb_cov feature class and load the 

feature class created above into it. 

a) Right-click on the empty feature class, select Load>Load data from the dropdown menu and navigate 

to the location of the service area feature class 

b) Press the Add button, hit Next 

c) Accept the defaults and hit Next 

d) Do NOT attempt to map any fields, as seen below: 

 

http://webhelp.esri.com/arcgisdesktop/9.3/pdf/Editing_Tutorial.pdf
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a) Press Next, then Next again, then Finish. 

6) In ArcToolBox, go to Data Management Tools>General>Append 

7) Append the formerly empty feature class to bb_cov, completing the dialog box as seen below: 

 

 
 

8)  Leave the Schema Type as TEST 
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9) Press OK. 

10) In ArcMap, open up bb_cov for editing and manually input associated attribution if necessary. 

 

3.5.4 Polygonal Data 

3.5.4.1 Coverage Area – PDF/JPG/Other Image Format 

In the event that the provider supplies coverage area data in some image format such as PDF or JPG format please 

follow the steps below: 

1) If in PDF format, open in Adobe Acrobat and Save As… JPG format. 

2) Open up the JPG image in ArcMap. 

3) Add the required basemap vector data for georeferencing. 

a) This will generally be either the CDOT data or TIGER data 

4) Change the coordinate system of the data frame to the desired end coordinate system 

5) Zoom to the general location of the JPG map image 

a) This is the location based on the vector data, not the JPG image itself. For example, if you know that 

the JPG image represents an area around the town of Limon, zoom to the town of Limon in your 

vector data. 

6) Open up the Georeferencing toolbar by selecting View>Toolbars>Georeferencing from the main menu bar. 

7) Using the Georeferencing toolbar, select Fit to Display, results seen below: 

 

 
 

8) Use the Control Point button  to add control points to the map 

9) Use common points in the base data set and the JPG image 

a) For example, find major street intersections, county/city boundaries, etc. 

b) Try to distribute the points more or less in the four corners on the image for the best transformation 

10) Click on the location on the image first, then click on the corresponding location on the vector data base 

map, as in the image below: 
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11) After placing each control point, the image transformation will update automatically.  

12) Repeat until satisfied with the transformation. 

a) Note: The transformation may take up to four points, although sometimes only two are necessary. 

13) When satisfied with the transformation, select Update Georeferencing from the Georeferencing toolbar 

dropdown. 

a) This will create a “world” file (.jgw in the case of JPGs) in the same directory as the image file. 

14) In ArcCatalog, create a new polygon shapefile with the appropriate data schema for a provider coverage 

area, which can be found in Appendix D. 

15) Add the shapefile to ArcMap. 

16) Using the Editor Toolbar, select Start Editing. Set the Task: to “Create New Feature.” 

17) Use the Sketch Tool  to digitize a new coverage polygon using the coverage area outline from the 

georeferenced JPG and add the required attributes manually. 

18) Repeat the above steps for all subscriber speed coverage areas provided. 

19) Follow the steps detailed in Coverage Area – GIS Data below. 

 

3.5.4.2 Coverage Area – KML/KMZ 

In the event that the provider supplies coverage area data in Google Earth KML or KMZ format please follow the 

steps below: 

1) Use a KML to SHP converter to translate file into an ESRI format 

2) http://arcscripts.esri.com/details.asp?dbid=15603  

http://arcscripts.esri.com/details.asp?dbid=15603
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3) Download the script and follow the provided instructions for installing it in ArcToolbox. 

4) Double-click on the script in ArcToolbox and navigate to the location of the KML file, as seen below: 

 

 

5) Add the new shapefile to ArcMap. Repeat for all KML files provided. 

6) Follow the steps detailed in Coverage Area – GIS Data below. 

 

3.5.4.3 Coverage Area – CAD Data 

In the event that the provider supplies coverage area data in GIS format please follow the steps below: 

1) Transform the CAD dataset into an ESRI format 

2) http://webhelp.esri.com/arcgisdesktop/9.2/index.cfm?TopicName=Transforming_CAD_datasets 

3) It may be necessary to contact the provider first to determine the coordinate system of the CAD data. 

4) If the CAD data is not in a standard coordinate system, it may be necessary to use ArcMap to 

georeference the CAD data to a known coordinate system first. 

a) To do so, follow the instructions provided above in “Coverage Area – PDF/JPG/Other Image Format.” 

5) In ArcCatalog, create a new polygon shapefile with the appropriate data schema for a provider coverage 

area, which can be found in Appendix D. 

6) Add the shapefile to ArcMap. 

7) Using the Editor Toolbar, select Start Editing. Set the Task: to “Create New Feature.” 

8) Use the Sketch Tool  to digitize a new coverage polygon using the coverage area outline from the 

georeferenced CAD file and add the required attributes manually. 

9) Follow the steps detailed in Coverage Area – GIS Data below. 

 

3.5.4.4 Coverage Area – GIS Data 

In the event that the provider supplies coverage area data in GIS format please follow the steps below: 

1) In ArcCatalog, create an empty feature class with the schema of the bb_cov feature class and load the GIS 

feature class either created above or supplied by the provider into it. 

http://webhelp.esri.com/arcgisdesktop/9.2/index.cfm?TopicName=Transforming_CAD_datasets
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a) Right-click on the empty feature class, select Load>Load Data from the dropdown menu and navigate 

to the location of the service area feature class 

b) Press the Add button, hit Next 

c) Accept the defaults and hit Next 

d) Do NOT attempt to map any fields, as seen below: 

 

 
 

e) Press Next, then Next again, then Finish. 

2) In ArcToolBox, go to Data Management Tools>General>Append 

3) Append the formerly empty feature class to bb_cov, completing the dialog box as seen below: 
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4) Leave the Schema Type as TEST 

5) Press OK. 

6) In ArcMap, open up bb_cov for editing and manually input associated attribution, if necessary. 

 

3.5.4.5 Compact Polygon From Subscriber Points  

 Geo-code address list using latest state “Composite Locator”  

 

 Verify that your geo-coded file has only one TT (Technology Type).  If not export individual geo-coded 

layers for each Technology Type. 

 

 For each TT check for differences in speed values or speed tiers and create separate layers for each speed 

value/tier. 

 

 Clean your geo-coding results - remove any points that geo-code to accuracy levels below ZIP+4 (ZIP 

centroids, carrier route centroids, etc).  Also, verify that outliers with acceptable accuracy levels are 

legitimate, i.e. fall in correct City and Zip.   

 

 Perform spatial join between county polygons (using stcnyfips field) and the cleaned geo-coded subscriber 

points, in order to carry the county name and stcnty fips. 

 

 Summarize the number of subscribers by county and use the subscriber counts by county to populate the 

Rate Tier table. 
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 Un-join the county data from the geo-code subscribers list. 

 

 Create Compact Polygon using cleaned geo-coded layer or sub-selection of using – XtoolsPro – 

ConvexHull-DetailedHull option.  A sub-selection of geo-coded points will be used in areas where more 

than one polygon will need to be created for one provider’s service area.   

 

 Evaluate output Hull carefully – looking for areas that should not be covered by hull polygon.   

 

o If it is determined that an area or areas should not be represented in coverage area, manually 

reshape hull polygon until coverage area is adequate.   

 

o When not obvious and as a general rule, manually resolve compact polygon when the distance 

between the subscriber points used to define the outer boundary of the compact polygon 

exceeds 5 miles .  When reshaping the hull polygon, snap to the outermost geo-coded points.  

See figure 2 and 3 for an example. 

 

FIGURE 2- Compact Hull: Manual Resolution Required            
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FIGURE 3a- Compact Hull: Manual Resolution Required           FIGURE 3b- Compact Hull: After Manual Resolution        

                       
 

 To attribute the compact polygon - Perform a “Spatial Join” where your Target Feature Class is the 

compact polygon and the Join Feature Class is your geo-coded point layer.  Export compact hull with 

joined attributes and name file appropriately.   

 

 Append attributed compact polygon to BroadBand TT template Feature Class and if required manually 

input any provider attribution that may not have carried over in the append process. 

 

 Intersect compact polygon with county boundaries to create unique records by county and use the state-

county-fips field to populate “stcty_fips” field.  Also use the county name field to populate the 

“BBCov_Name” field.   

 

o Exceptions is where a provider’s coverage is distributed throughout more than one area of any 

given county where the “BBcov_Name” should be populated using an appropriate city or other 

logical name based on geographical location.  

 

 Export/Load into appropriate BB TT model Dataset. 

 

3.5.4.6 Census Blocks – List or Spreadsheet 

In the event that the provider supplies census block data in a list or spreadsheet, please follow the steps below: 
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1) Ensure block polygons supplied by the provider are 2000 currency 

2) If other currency, convert to 2000 currency before proceeding 

a. To do this, remove the trailing letter (a, b, etc.) from the block ID 

b. You will now have two blocks that equate to one block in the 2000 block geometry 

c. Delete duplicate block IDs, retaining the higher service tier in each case 

3) Prepare the block list in clean Excel format, removing all Excel-only formatting, merged cells, colors, 

borders, etc. 

4) Import the spreadsheet into ArcMap. 

5) Right-click on the 2000 census block feature class in the layer list in ArcMap and select  Joins and 

Relates>Join from the drop down menu. Join the census block list to the 2000 census blocks feature class 

using the block ID and export joined records in a new feature class. The Join dialog box and process can be 

seen above in the TIGER Street Segments – List, Spreadsheet, or GIS Data section. 

6)  Follow the steps in Census Blocks – GIS Data below. 

 

3.5.4.7 Census Blocks – GIS Data 

In the event that the provider supplies census block GIS data please follow the steps below: 

 

1) Ensure that the blocks supplied by the provider are in the required data schema and are complete as far 

as require attribution. 

a. If not, manually enter the required attribution or contact the provider to fill gaps. 

2) If census block geometry is distributed throughout more than one county then select Data Management 

Tools>Generalization>Dissolve in ArcToolbox and dissolve based on County/Provider/TT/Speed Tier so 

that unique records are created for each unique combination. 

a. The dissolve dialog box can be seen above in the TIGER Street Segments – List, Spreadsheet, or 

GIS Data section. 

 

 
Figure 1: Undissolved census block polygons 
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Figure 2: Census block polygons dissolved by county 

 

 

2) For each dissolved region use the Editing toolbar in ArcMap to remove unnecessary slivers and other 

small holes.   

3) In ArcToolbox, select Data Management Tools>General>Merge and merge the processed polygons 

together into single layer. 

4) The merged census blocks will need to have the subscriber’s “frn” field added and populated. 

5) In ArcCatalog, create an empty feature class with the schema of the bb_cov feature class and load the GIS 

feature class either created above or supplied by the provider into it. 

a. Right-click on the empty feature class, select Load>Load Data from the dropdown menu and 

navigate to the location of the service area feature class 

b. Press the Add button, hit Next 

c. Accept the defaults and hit Next 

d. Do NOT attempt to map any fields, as seen below: 
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e. Press Next, then Next again, then Finish. 

6) In ArcToolBox, go to Data Management Tools>General>Append 

7) Append the formerly empty feature class to bb_cov, completing the dialog box as seen below: 

 

 
 

8) Leave the Schema Type as TEST 
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9) Press OK. 

10) In ArcMap, open up bb_cov for editing and manually input associated attribution, if necessary. 

 

3.6 Metadata Transactions 

Following any updates or changes completed within the file geodatabase (fGDB) stored on the GIS-Analysts staging 

environment, the GIS-Analyst runs transactions to compare that fGDB with the one stored on the Core server to 

ensure metadata on all changes are recorded. 

 

Below outlines the steps taken to run transactions on the updated Core database: 

  

1. Open a command line window and run generateTransactions.py  

a. Usage: generateTransactions.py  [Core fGDB] [Staging Environment fGDB]  

 

b. Example of command line:  

 

<path>generateTransactions.py <path>ST_BB_POLY_SRV_AREAS.gdb <path>ST_BB_POLY_SRV_AREAS.gdb  

 

2. Below is an example of the output screen that will be displayed: 
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3. After process has completed, results can be found in the ST_BB_POLY_SRV_AREAS_HIST.gdb  

a. The transactions scripts records changes at a feature level. 

b. Below is a screen shot supporting the directory structure of the historical fGDB. 

 

 

 
 

 

c. Attribution associated with each added/removed/changed features is tracked, including the 

following additional columns appended to the end of each: 

i. Commit_by 

1. Records the GIS-Analyst that committed the changes to the historical fGDB. 

 

ii. Commit_date 

1. Records the date and time stamp that the changes were committed. 

 

iii. Trans_type 

1. This field reflects the type of change recorded. 

2. Categorized by: 

a.  Adds/Change/Deletes 

 

iv. New_values 
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1. Records the new values when a change was completed on a feature.  Example:  

Name or speed change 

 

d. MD_Process is also transferred from the edited fGDB to the historical fGDB, which states the 

actions completed by the GIS-Analyst. 

 

 



            

53 

3.7 Data Processing 

3.7.1 Data Processing Overview 

The following items outline the actions required to process the service provider data further to meet the NTIA 

requirements. 

 Weighted Nominal Speed 

 Middle Mile 

 Broadband Coverage Template 

 

3.7.2 Weighted Nominal Speed 

The weighted nominal speed is populated one of the following two ways: 

3.7.2.1 Subscriber Data Supplied by Provider 

Where we are supplied with subscriber speed information by the data provider, we use the following formula from 

the NOFA: 

(speed tier-1 in kbps × no. of tier-1 subscribers) + (speed tier-2 in kbps × no. of tier-2 subscribers) + (etc.) 

Total average monthly subscribers 

 

 

Data is initially broken up in the following order: 

1) Stcty_fips 

2) Transmission technology type 

3) Subscriber tiers 

 

3.7.2.2 Value Supplied by Provider 

Some providers will supply their weighted nominal speed.  In these cases, the data supplied will be populated 

instead of using the NOFA formula. 

When these values have been obtained or calculated, they are used to update the service overview layer. This can 

be done manually or by creating a table with the provider’s FRN and average weighted speed and joining it to the 

service overview table in ArcMap. To Join, right-click on the layer you would like to join to and select Joins and 

Relates>Join… from the dropdown menu. Then navigate to the table you want to join and select the join fields 

from the drop down lists. Then open up the source table (the table in ArcMap) and right-click on the header of the 

Average Weighted Speed field and select Calculate Field from the drop down menu. Use the value of the average 

weighted speed from the joined table. 

3.7.3 Middle Mile 

Middle mile information is generally provided in spreadsheet or text file format. The process is to take what is 

supplied by the provider and translate it into the required data schema.  

1) If the data is supplied with address information, follow the process outlined above in Subscriber Location 

– Address Data.  
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2) If the data is supplied with associated XY coordinates, follow the process outlined above in Subscriber 

Location – XY Data.  

3) Once the data is in GIS format, use the Append (Data Management Tools>General>Append) command in 

ArcToolbox to append the data to the overall middle mile dataset. 

4) Set the schema type to NO_TEST and use the Field Map to map the attribute fields from the source to the 

target dataset. 

3.7.4 Broadband Coverage Template 

Below is the description of the fields within the BB_Cov layer, which is the interim data set that is used to create 

the final product deliverable. 

 

Name Alias Description 

objectid OBJECTID Internal Object ID 

shape SHAPE Internal Shape storage 

prov_id PROVIDER_ID Unique numeric identifier for each provider 

prov_name PROVIDER_NAME Unique name for each provider 

dba_name DOING_BUSINESS_AS An alternative "Doing-Business-As" name for the provider 

frn 
FCC_REGISTRATION_NUMBE

R 
Provider FCC Registration Number 

bbcov_name BBCOV_NAME BroadMap Broadband Coverage name 

trans_code TRANSMISSION_CODE 
Unique code for the transmission technology type described by 

this layer 

trans_name TRANSMISSION_NAME Name for the transmissions technology type 

trans_desc TRANSMISSION_DESC Description for the transmissions technology type 

spect_code SPECTRUM_CODE Unique code for the spectrum [WIRELESS ONLY] 

spect_name SPECTRUM_NAME Name for the spectrum [WIRELESS ONLY] 

spect_desc SPECTRUM_DESC Description for the spectrum [WIRELESS ONLY] 

mad_dwn_t MAX_AD_DOWN_TIER 
Maximum advertised downstream speed available within given 

area (speed tier) 

mad_up_t MAX_AD_UP_TIER 
Maximum advertised upstream speed available within given 

area (speed tier) 

typ_dwn_t TYPICAL_DOWN_TIER 
Typical downstream speed available within given area (speed 

tier) 

typ_up_t TYPICAL_UP_TIER Typical upstream speed available within given area (speed tier) 

mad_dwn_k MAX_AD_DOWN_KBPS 
Maximum advertised downstream speed available within given 

area (kbps) 

mad_up_k MAX_AD_UP_KBPS 
Maximum advertised upstream speed available within given 

area (kbps) 
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Name Alias Description 

typ_dwn_k TYPICAL_DOWN_KBPS Typical downstream speed available within given area (kbps) 

typ_up_k TYPICAL_UP_KBPS Typical upstream speed available within given area (kbps) 

subs SUBSCRIBERS 
Total average monthly subscribers for this provider for this 

technology for this coverage polygon 

md_geom MD_GEOMETRY 
Metadata: Comma separated list of source id's from which the 

polygon extent was produced 

md_exists MD_EXISTS 
Metadata: Comma separated list of source id's used in 

understanding and editing the provider data for this polygon 

md_who MD_WHO 
Metadata: Name of the editor who last edited this feature at 

the time in md_when 

md_when MD_WHEN Metadata: Date/timethat this feature was last edited 

md_process MD_PROCESS 
Metadata: Comma separated list of processed used to create 

and/or modify this layer 

stcty_fips STATE_COUNTY_FIPS State/County FIPS code 

rec_id RECORD_ID 

Compound Key formed from 

STCTY_FIPS+"|"+Provider_ID+"|"+Trans_Code+"|"+BBCov_Nam

e 

st_area ST_AREA(SHAPE) Area in square decimal degrees  

st_length ST_LENGTH(SHAPE) Length in decimal degrees  

Provider_Typ

e 
Type of Provider 

Has Subtype (1:Broadband provider as described in the 

NOFA,2:Reseller,3:Unknown), default value = 1  (New 04/11 

Model) 

 

3.7.5 Verification and Validation 

3.7.5.1 Provider Validation – Provider Portal/PDF Map Review 

Following the collection and aggregation of provider data, the data is then validated by the provider to ensure the 

data aggregated is an accurate representation of their coverage area and supporting broadband information. 

This is completed through the Provider Portal web application, which is a secure interactive map displaying their 

coverage areas and allows the user to validate, submit feedback or request changes.  If changes are requested, 

then the features on the portal are then updated and an automatic request is sent to the provider to complete the 

validation effort. 

 

For some providers that did not use the Provider Portal, a PDF was sent displaying their coverage map and 

validation was then completed via e-mail notification.   
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3.7.5.2 Provider Verification – 3rd Party Source Review 

Once the provider has validated their coverage areas, a 3
rd

 party source comparison and analysis is then 

performed.  Where anomalies or discrepancies are identified, a ‘SCAN’ point is dropped and descriptive comments 

applied so they can later be reviewed with the provider. 

 

During the provider review, the map is displayed along with the ‘SCAN’ points and potential refinement is 

completed based on input from the Provider. 

 

3
rd

 Party Sources Utilized 

3
rd

 Party Source Name Source Type Verification Type 

InfoUSA Consumer and Business 
Listings 

Community Anchor Institutions 
Can also be used for demographic information supporting 
the State websites 

Pitney Bowes (PBBI) Exchange Info Plus 
(Central Office Locations) 

Exchange datasets are used to verify the following 
Transmission Technologies (TT): 
Asymmetric xDSL (10), Symmetric xDSL (20), Other Copper 
Wireline (30), and Optical Carrier/Fiber to the End User 
(50). 
 

Media Prints Cable Boundaries Used to verify the following TT: 
Cable Modem—DOCSIS 3.0 (40) and Cable Modem—Other 
(41) 

American Roamer  Wireless Coverage 
Patterns (EVDO, GPRS, 
WISP, HSPA) 

Used to verify the following TT: 
Terrestrial Fixed Wireless—Unlicensed (70), Terrestrial 
Fixed Wireless—Licensed (71) and Terrestrial Mobile 
Wireless (80) 

ComSearch Wireless Spectrum 
Holdings and Tower Data 

Used to verify the following TT: 
Terrestrial Fixed Wireless—Unlicensed (70), Terrestrial 
Fixed Wireless—Licensed (71) and Terrestrial Mobile 
Wireless (80) 
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3.7.5.3 Assigning Confidence Values 

All efforts from the above-mentioned validation and verification activities, plus internal peer quality reviews are 

combined and tracked in a Validation table.  Based on the results of this analysis, a confidence value is assigned for 

each provider and then each technology.   

 

The confidence values are as follows:  
0     = Coverage area has not been reviewed 
10   = Extremely Low.   Single Source QC.   
20   = Very Low.  Needs Additional Validation\Verification 
30   = Low.   Even with Validation\Verification, Coverage is still suspect. 
40   = Acceptable, confirm with State prior to shipment.    
50   = Meets requirements to be included in shipment. 
60   = Moderate.  Meets NTIA/State’s standards, representative of Technology Type (TT) 
70   = High.   Accurate representation of coverage based upon TT. 
80   = Very High.  Multiple validation\verification with most 3

rd
 party sources 

90   = Extremely High. Multiple validation\verification sources 
100 = Perfect.  Multiple validation\verification sources, with complete alignment with sources and ground 
truth verification activities 

 

This Validation table is then maintained as updates or changes occur for each provider, down to technology type, 

with the overall goal to improve the confidence values and overall map representation. 

 

Example of the Validation table: 
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3.7.6 Community Anchor Institution (CAI) Data 

3.7.6.1 Data Collection 

The CAI data was initially collected from the State to create the baseline inventory.  All location information and 

broadband coverage data supplied was also ingested into the data deliverable. 

Additional collection of CAI information was done via data mining and/or webscraping to build out the inventory 

further.  For example:  Collection of additional CAIs, address and broadband data. 

 

The state-agency-provided CAI inventory was comprehensive but the challenge is collecting broadband related 

data; service provider(s), technology and speed data for each CAI.  Availability of the CAI portal has not significantly 

increase submission of this data.  Additional promotion to CAIs to utilize the CAI portal will be needed to increase 

this data for subsequent deliverables. 

 

3.7.6.2 Institution Data 

Institution data is obtained from a variety of sources and almost always provided in Excel spreadsheet format. The 

general process for incorporating this data is below: 

1) If the data is provided in Excel or some similar format: 

a. Clean and standardize the Excel spreadsheet, removing any cell formats, merged cells, etc. 
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b. Standardize the address format as defined in the staging CAI database 

c. If the spreadsheet includes X and Y values, such as latitude and longitude, use the Add XY Data 

tool in ArcMap to create a spatial data layer. 

d. If there are only addresses, then follow the geocoding steps outlined above to create spatial data 

points for each of the institutions. 

i. Institutions that do not geocode based on the TIGER 2009 data set will have to be 

manually located using Google Maps, Google Earth, or some other information source. 

2) If the CAI source data is in GIS format, add the Latitude and Longitude fields and use the Calculate 

Geometry tool to populate them, using the WGS 84 coordinate system. 

3) Using ArcCatalog, load the new data into the staging CAI database. 

4) This database is ready for the makeDeliverable.py script to process the information into the final state 

and NTIA deliverables. 

 

3.7.6.3 Community Anchor Institution (CAI) Portal Updates 

A web application has been released to allow for further data collection and validation of anchor institution 

location information, broadband coverage, and speed test data. 

 

Information collected from the CAI Portal is then ingested into the overall inventory and will later be compared 

against the provider coverage areas mapped for any potential discrepancies. 
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3.8 Product Extract 

3.8.1 Python Scripts 

The following sections make use of Python scripts. In general, to use a Python scrip, you must have Python 

installed on your computer. To download the latest version of Python, go to http://www.python.org/download/ 

and download the latest stable version. As of August 2010, this was version 2.7. Once this is installed, the general 

way to run a script is to type the following at a command prompt: C:\Python27\python.exe C:\<location of script>. 

Many of the scripts provided have environment variables that must be set before they can be run.  

 

The python code for BroadMap’s product extract has been incorporated into a Hudson CI System, which is detailed 

in the Process Operation and Monitoring section of this document.  This was a process improvement activity so all 

processes can be monitored, controlled and contain historical tracking on each process. 

 

3.8.2 Product Extract Process 

Note: specific Python scripts are called out in red font in the sections below. 

The MapConnect product extract process, makeDeliverable.py, uses the BB_Cov and BROADMAP_POINTS interim 

data sets to create the following layers according to the current specifications: 

 BB_Service_Road_Segment 

- This layer contains all broadband services associated with specific street segments for census 2000 

blocks larger in area than two square miles 

 BB_ServiceCensusBlock 

- Contains all broadband services associated with census blocks of no greater than two square miles. 

 BB_Service_Wireless 

- This layer contains all wireless services not associated with specific addresses. 

 BB_ServiceOverview 

- This layer contains subscriber-weighted nominal speed for each provider's service area at a county 

level and is meant to act as a summarized view.  

 BB_ConnectionPoint_MiddleMile 

-   This layer contains middle-mile and backbone interconnection points 

 BB_Service_CAInstitutions 

- Broadband Service at Community Anchor Institutions (CAI) 

 Community Anchor Institutions consist of schools, libraries, medical and healthcare providers, 

public safety entities, community colleges and other institutions of higher education, and other 

community support organizations and entities. 

 

Due to a NTIA model change for the October 2010 data deliverable, an addition to this code was created to 

support both models in the case a comparison is later desired or a request is made to revert back to the original 

model.  This script name is bdia2ntia.py and creates the following layers in addition to the layers mentioned above, 

rolled up to NATL_Broadband_Map. 

 

http://www.python.org/download/
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 BB_ConnectionPoint_LastMile 

-   This layer contains last mile infrastructure points, which is only populated if data cannot be provided 

at a more granular level. 

 BB_Service_Address 

- Represents broadband availability for service address points.  Address Point availability refers to 

those individual addresses at which each facilities-based provider of broadband service can provide 

broadband services of minimal characteristics within 7 - 10 business days. 

 State_Boundary 

- State boundary supporting topological validation of point feature classes. 

 NATL_Broadband_Topology 

- Supports basic topology quality checking.  Example:  No CAI’s or Middle Mile points outside of the 

state boundary 

 

The following process flow provides a view of how the Core fGDB is extrapolated to the NTIA final deliverable via 

the makeDeliverable.py script.  Following that, the bdia2ntia.py script is run, which limits what’s placed in the final 

layers based on the NTIA modeling standards. 

 

The product scripts and supporting extract were originally created separately per request, in case data model 

comparisons were to be completed.  

 

3.8.3 Product Statistics 

Following the completion of a product extract, the product statistics script (BDIA_ReleaseNotesStats.py) extracts 

the following information supporting that product deliverable. 

 Provider Statistics 

- Collects all provider information, listing by Provider Name 

- Provides output of FRN 

- Counts the number of features supported within the following layers: 

 Census Block 

 Street Segment 

 Max Upstream 

 Wireless Services 

 Infrastructure Points 

- These updates were made to support the Data Package required to accompany every NTIA product 

deliverable. 

 Community Anchor Institution (CAI) Statistics 

- Breaks CAI down to the 8 categories 

 1:  School: K through 12 

 2:  Library 

 3:  Medical/Healthcare 

 4:  Public Safety 
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 5:  University/College 

 6:  Other Government 

 7:  Other Community non-government 

 None:  Unknown Category 

 In cases where this occurs, further investigation is completed prior to product shipment to 

ensure all CAI’s are categorized accurately 

- Reports out the following counts 

 Total CAIs within that category 

 Total CAIs that contain partial BB coverage  

 Contains any of the following information for given CAI: 

 BB Subscriber, Transmission Technology, Speed Down Speed Up 

 Total CAIs that contain full BB coverage 

 Contains all of the above-mentioned BB information for given CAI. 

The output of this script is two CSV files: AnchorInstitutions.csv and Providers.csv. These files can then be 

inspected to ensure that there are the expected number of CAIs and providers for every release. 

 

3.9 Quality Assurance  

Quality assurance is supported manually and algorithmically on the interim data, BB_Cov file geodatabase, and on 

the final product. For scheduled product releases, a test product extract and subsequent manual and algorithmic 

QC run is completed along with a release review.  The product specifications, project status reports, previous 

product release notes are used as references throughout this review. 

The following parameters are tested using the methodology listed below each: 

 Product Deliverable Format  

- Correct names and format of data deliverables 

 BDIA_QC_SUITES (please see below for details) 

- Correct Projections/Datum 

 Manual interaction with product 

- Metadata Present and Correct 

 Manual interaction with product 

 Table Structure 

- All required tables included 

 BDIA_QC_SUITES 

- Extraneous tables identified 

 BDIA_QC_SUITES 

 Field Structure 

- All fields included 

 BDIA_QC_SUITES 

- Extraneous fields identified 

 BDIA_QC_SUITES 
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- Correct field names, types and widths 

 BDIA_QC_SUITES 

 Field Domains 

- Values in all tables are constrained to the specified values specified 

 This action is accomplished via BDIA_QC_SUITES and manual review of the product 

 This tends to identify project completeness issues as fields with a null value are identified. 

 Geometric Representation 

- Identify if all layers have the correct geometric representation 

 Manual review of the BB_ServiceOverview layer 

 Dependent on NTIA and client requirements 

 Geographic Extent 

- Product includes the necessary Geography associated with Product? 

 Manual Review - ArcGIS 

- Is there extraneous geography included in Product? 

 Manual Review - ArcGIS 

 Completeness 

- Products contain the expected amount of data? 

 Manual review of product stats relative to weekly State reports and defined expectations. 

 Accuracy 

- Product meets the stated accuracy requirements for the deliverable? 

 Sampling procedure to manually review source material to resulting product 

 Provider Validation 

 Verification using 3
rd

 Party Data 

 Verification against reality, where applicable 

 Data Regression 

- Any unexplainable data loss or change? 

 This action is accomplished by comparing results within product statistics script 

(BDIA_ReleaseNotesStats.py) from previous releases, as well as manual review of the product 

 Confidentiality 

- Any unauthorized confidential information included in the delivery? 

 Review of NDAs and delivery expectations 

 Prior Issues Resolved  

- Have expected internal issues been resolved? 

 Manual review of data against previous product release notes 

- Have agreed upon customer issues been resolved? 

 Manual review of data against previous product release notes, status report and client feedback 

 Delivery Medium 

- Has the product medium been verified? 

 Manual review 

- All files present 

 Manual review of SFTP site to ensure all files are copied correctly, including file/directory size 
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- Correct location 

 Manual review – confirmation of SFTP link, username and password 

 

3.9.1 QC Suite 

The BDIA_QC_SUITES consists of four main types of scripts supporting the overall QC process. These scripts are all 

run in concert and are called from the test_runner script and the test_BDIAProductGDB script. 

 

3.9.1.1 Configuration  

These scripts establish the configuration for the test_BDIAProductGDB script which is the core of the QC Suite.  

- update_test_config 

- active_config 

- config_PROCESS01_automated 

- config_PROCESS01_manual 

- set_active_config 

3.9.1.2 Libraries 

These scripts provide additional functionality that is called from with the test_BDIAProductGDB script.  

- bb_unittest_fixture 

- bbcov_structure 

- BC_XmlWriter 

- file_folder 

- search_and_replace 

- unittst_fixture 

- validate_BB_DB 

- validate_BB_GDB 

- xmlrunner_gui 

3.9.1.3 QC Suite 

This is the core script for performing automated QA/QC on the interim and final data deliverables. 

- test_BDIAProductGDB 

3.9.1.4 Other  

These scripts perform other functions detailed below: 

- test_runner – this is the main script that runs all the other QC scripts and imports all the necessary scripts 

and libraries 

- which_build – this determines the current build and passes information to the configuration scripts 
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3.10 Process Operation and Monitoring 

Product Extract, makeDeliverable.py and bdia2ntia.py, is run within BroadMap using a platform called Hudson that 

has been enhanced to support BDIA product extraction, process monitoring, as well as product validation.  The 

same platform can be planned for implementation for the State, if desired. 

 

Below are examples of the product create, product validation, product statistics and monitoring processes which 

are managed within the BroadMap Hudson CI-System.  All of the above-mentioned python scripts, with the 

exception of metadata transactions script, are run via this system. 

 

3.10.1 BDIA Product Create 

 

Below is an example of the main page where the type of product build can be selected. 

 

 
 

Selecting based on the type of process that will be initiated. 

 

   
 

The Console Output can be reviewed to see the progress of product create.  Following the completion of each 

product creation process, an e-mail notification is automatically sent to the team.   
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All processes run via the BroadMap Hudson CI-System are stored for historical reporting.  Each process can be 

reviewed, including the Console Output and Build Artifacts from that run. 

 

 
 

3.10.2 Product Validation and Statistics 

 

Once the product creation process is complete, Product Validation and Statistics are then initiated.  These support 

the BDIA_ReleaseNotesStats.py script and the BDIA_QC_SUITES scripts detailed above. 

All statistics and reports are stored for historical review with the capability to place violation criticality on each 

quality control check allowing the identification of errors due to project status/completeness verses project 

correctness.  Example:  Typical Speeds populated. 
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Below is an example of the report provided based on various control points running over a specified time period: 

 
 

Similar to the Product Create process, all results from the process are maintained:  

 
 

Results are then reviewed manually to ensure no errors reported are critical or in violation of the NTIA data model 

or project completion statements.  Any errors of concern are communicated ahead of product delivery and 

included within the product release notes. 

Further detail on the Hudson CI System environment can be found by navigating to the following link: 

http://wiki.hudson-ci.org/display/HUDSON/Meet+Hudson 

 

http://wiki.hudson-ci.org/display/HUDSON/Meet+Hudson
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3.11 Product Extract Data Delivery 

Product delivery for MapConnect Broadband is handled two ways, depending on client requirements: 

1) State Submittal 

a) Data is submitted via SFTP site 

b) Product Release Notes and QC Test Report accompanies the delivery 

2) NTIA Submittal 

a) Directions for using the NTIA State Broadband Data file submission tool 

b) Go to the following WWW web site: https://esupport.fcc.gov/statedata  

c) Enter your username and password as provided to you from the NTIA program administrator. 

 

 
 

d) Click in Upload a file field 

e) Browse to local file for submission using the ‘Browse’ button.  Select file then select ATTACH FILE. 

 

https://esupport.fcc.gov/statedata
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f) Logout / Receipt using the Logout button in the Top Right of the screen 

g) A receipt of submission is emailed to username e-mail address 
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1 Overview 
The following describes the Data Gathering, Data Integration, Data Validation and Verification and Quality Control 

processes utilized to create the Broadband Mapping Project’s April 1
st

, 2011 data submission.   

 

To support various levels of technical and program knowledge, this white paper supplies both a high level 

summary and a detailed process review. 

 

2 High Level Review 

2.1 Data Gathering - Providers 

Broadband Service Area, Middle Mile Aggregation Points and Broadband Service Overview 

The collection of Broadband Service areas, Middle Mile Aggregation points and Broadband Service Overview 

information is handled through the following Provider Outreach Process: 

 

 Build and Maintain an Inventory of Broadband Providers through research and State inputs. 

 Update Provider Material that describes the data requirements and logistics for data transfer. 

 Update NDA for use in project, where applicable 

 Maintain multiple protocols for the provider to submit data, including SFTP technology when desired.   

 Conduct one-on-one informational discussions with each provider to communicate the following: 

o Requirements of this project 

o Broadband data required to support the product data model 

o Submission protocols available 

o Capability to validate how the supplied data is aggregated 

 

 Download/receive Provider Data 

 Establish a repeatable process with Provider. Maintain Provider communication, transaction and data 

handling records throughout the project (dates contacted, data received, etc.)  
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2.2 Data Gathering - Community Anchor Institution (CAI) 

The collection of CAI information is handled through the following CAI Collection Process: 

 Collect and maintain inventory of CAIs through Data Mining, research, and State inputs. 

 Maintain web-based CAI portal for institutions to add or confirm attribution, location and enter 

broadband-specific information. 

 Upload web-based data to Core Database for standardization. 

 Perform internal cleansing, such as removing duplicate records, identifying gaps in broadband attribution 
and verifying category.  

 Geocode CAI locations.  

 Translate Core Database data to deliverable ready format.  

 Continue engagement with non-responsive institutions. 

 

2.3 Data Integration Process 

 

The data integration and processing mechanisms currently utilized allow for multiple types of inputs and results in 

a standardized output that meets the NTIA deliverable requirements. This process is flexible to support data model 

changes and project requested enhancements.  

 

 Receive inputs from Providers via submission protocols, upload into Sourcing Database and catalog with 

provider information.  

 Review Provider supplied data for completeness and for potential discrepancies that require resolution 

prior to processing and flag as necessary. 

 Categorize input into data type category (addresses, block lists, paper maps, etc.). 

 Standardize input based on data type within Staging Database. 

 Create Compact Polygons (CP)—(internal methodology for generating area based feature for coverage in 

Staging Database). 

 Apply broadband attribution to CP, Apply metadata to CP 

 Perform quality analysis of the CP against the source supplied to identify any completeness or accuracy 

issues.   

 Request additional information from the provider if elements of coverage are missing or contain 

discrepancies.  This is a second manual quality check to ensure data is complete.   Following completion of 

CP creation, process steps within Data Validation & Verification occur 

o Process coverage area to build the required NTIA data model layers  

 

 Process CAI data input into internal standardized format, as mentioned above under CAI Create Product 

Deliverable based on NTIA and State-level requirements. 

 Following the creation of the product, process steps within Data Validation & Verification occur 
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2.4 Data Validation & Verification 

 

To ensure the data collected and processed is accurate and comprehensive, a holistic approach has been 

developed to further validate and verify the data. Following the initial mapping of providers’ coverage area and 

serviceability claims, the project team uses the following methods:  

 

 Third-Party Data Verification: Visually and programmatically compare the coverage against third-party 

data.  

Pitney Bowes and American Roamer data are used in cases where a coverage area is questionable.  All 

anomalies identified during this analysis are reviewed with the providers. 

 

 Broadband Provider Validation – Provider Portal Application:  Providers were trained on and requested 

to use a secure interactive web application to review their current coverage area(s) and supporting 

broadband attribution and validate their data or submit change requests to update their data. 

 

All provider change requests go through the Data Integration Process and a review with the provider to 

complete validation. 

 

 Confidence Values:  All Verification, Validation, and manual quality reviews are tracked by provider and 

then by technology type, which is then stored and maintained within a “Validation” table.  A confidence 

value is assigned based on the collected information to highlight provider coverage areas that require 

further investigation and enhancements. 

 

2.5 Quality Control 

Following collection, processing and analysis of the provider and CAI data, the product is checked manually and 

algorithmically against the NTIA data model.  Some of the items included within these checks are as follows:   

 Format Correctness 

 Table & Field Structure  

 Valid Values 

o Including default values, where applicable 

 Geographic Extent and Topology Errors 

 

Prior to data submission, another quality control script supplied by NTIA is run.  This script, 

SBDD_CheckSubmission.py, creates an output in text form that is required to be submitted along with the final 

deliverable.  All errors must come up clean, unless otherwise specified from NTIA. 
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Exceptions to the script as noted by NTIA on the SBDD Workspace on 03/25/11 at the following link: 
https://sbdd-granteeworkspace.pbworks.com/w/page/38218329/CheckSubmissionExceptions  

- Longitude values for States outside the lower 48 (any table) 

- CAI results for Transtech, MaxAdUp, MaxAdDown if BBService is ‘No’ or ‘Unknown’  

- Overview MaxAdDown, MaxAdUp if 100% of record level data has MaxAdDown or MaxAdUp 

populated 

https://sbdd-granteeworkspace.pbworks.com/w/page/38218329/CheckSubmissionExceptions
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3 Detailed Process Review 
Below is a detailed review of the data collection, integration and quality control points along the broadband data 

gathering and mapping process. 

 

Diagram of overall process: 

 
 

3.1 Provider Outreach 

For the April 2011 data submission, an e-mail notification was sent to all providers with supporting deliverable 

dates.  The Provider Portal web application was released and training webinars held so providers could use this 

application to submit changes to and/or validate their current coverage area(s). 

 

Data was also collected from the providers via e-mail and SFTP, depending on their comfort level to submit data in 

time for the April 1
st

 deadline. 
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In support the data collection effort, providers that did not timely respond to the outreach were contacted by 

phone. 

 

3.2 Outreach Materials 

The original provider packet sent via email to the providers included the following documents and files: 

1) Letter from the State inviting them to participate in the program 

2) Copy of the non-disclosure agreement (NDA) 

3) Copy of the Mapping NOFA from the NTIA 

4) Copy of the NOFA Clarification from the NTIA 

5) Broadband service address example file in CSV format 

6) Word document describing service address example file 

7) Broadband service block example file in CSV format 

8) Word document describing service block example file 

9) Broadband service street example file in CSV format 

10) Word document describing service street example file 

11) Broadband subscriber example file in CSV format 

12) Word document describing subscriber example file 

13) Broadband wireless coverage area sample shapefile 

14) Word document describing wireless coverage area sample shapefile 

15) Instructions for downloading, installing, and using the WinSCP secure FTP application 

 

3.3 Outreach Process 

The provider outreach process is comprised of the following general steps: 

1) Send the provider package and introduction letter to the main point of contact for the provider 

2) Follow up with email and call to verify that the main point of contact is correct. 

3) If necessary, discuss the NDA further and resolve any redlines. 

4) Once the correct primary contact is established, set up a call, if necessary, to learn more about the 

provider’s offerings and direct them to the appropriate outreach materials. 

5) If providers are unable to be contacted (non-responsive) or indicate that they are not interested in 

participating (non-cooperative) mark them as such on the provider tracking sheet. These providers will be 

escalated to the state for further action. 

6) As the providers are collecting the required data, provide instruction on downloading, installing, and using 

the WinSCP secure FTP application, if required. 

7) Arrange with the providers to transfer the data in whatever way they are comfortable. Some providers 

will find regular email acceptable. Others will want to use the secure FTP application. 

8) After data is received and reviewed, it may be necessary to contact a provider for clarification or to 

address incomplete data sets. In the interest of building and maintaining relationships, care is given not to 

push the provider but to work with it to obtain accurate data in the best possible format. 
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3.4 Data Collection 

3.4.1 Data Transfer Procedures 

There are three primary ways data is collected from providers. These are: 

1) Secure FTP using the WinSCP application 

2) Regular email 

3) Mail 

 

3.4.2 Initial Data Review and Quality Assurance 

The initial data review and quality assurance process consists of the following general steps: 

1) Access the data from the secure FTP site or email 

a. If emailed, place copy of original data set in the appropriate provider folder on the secure FTP 

site 

2) Place copy of raw data on local computer in a working directory. 

3) Review data and determine course of action based on type of data received. 

4) Ensure data is complete and contact provider to address any gaps. 

Note: The goal is to get as many providers as possible to provide subscriber address data in the correct format. 

Obviously, this will not be possible with all providers so we will continue to have to process various types of 

provider-supplied data. 
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3.5 Data Ingestion 

3.5.1 Data Ingestion Overview 

The following outlines the process steps taken based on the type of input supplied by the data provider: 

Point Data 

 Subscriber location 

 DSLAM location 

 Central Office location 

 Broadcast Tower location 

Linear Information 

 TIGER street segments 

Polygonal Information 

 Census Blocks 

 Coverage Area 

Overall, the process is geared toward taking the provider data supplied and creating polygon shapes to append to 

the bb_cov feature class. The bb_cov feature class is the interim data set that is then processed using the 

makeDeliverable.py Python scrip to create the MapConnect data layers that will be delivered to the state and, 

ultimately, to the NTIA.  Following are the detailed instructions used in this process.  

 

3.5.2 Point Data 

3.5.2.1 Subscriber Location – Address Data 

In the event that the data provider supplies subscriber address data the following actions occur: 

1) First, convert the address data to a clean Excel spreadsheet in an appropriate address data format. 

a) Usually, this has the following columns: street address (number, pre-directional, pre-modifier, street 

name, street type, post-directional, and post-modifier concatenated together), city, state, ZIP. 

2) Configure the ArcGIS geocoding tool to use the TIGER 2009 streets dataset 

a) In ArcCatalog, create a new Address Locater by right-clicking in the white space of the appropriate 

directory and selecting New>Address Locater from the dropdown menu. 

b) Select “US Streets with Zone” and press OK. 

i) Note: It is likely that multiple Address Locators will have to set up to handle the variety of 

provider address data received. 

c) Navigate to the TIGER Streets 2009 file and press OK. 

d) Fill in the dialog box as seen below: 
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e) Click OK. 

3) Open up ArcMap, and add the Excel spreadsheet with the address information. 

4) Right-click on the Excel spreadsheet and select Geocode Addresses from the dropdown menu. 

5) Select the appropriate address locator by clicking Add…. then OK. 
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6) Fill out the Geocode Addresses dialog box as shown below: 

 

 
 

7) Geocode the list in batch mode using the geocode service set up in Step 2 above, accepting all the default 

parameters. 

8) Review results. 
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9) Adjust geocoding parameters accordingly and repeat batch to resolve issues. 

10) Manually geocode unmatched addresses until target hit rate achieved, generally 90%. 

11) Visually inspect the data as seen below: 
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12) Follow the steps detailed in Subscriber Location – GIS Data below 

 

3.5.2.2 Subscriber Location – XY Data 

If the provider supplies a list of subscriber data with accompanying XY data such as latitude and longitude, the 

steps are as follows: 

1) Refine the format in Excel so that the data can easily be opened using ArcMap. 

a. Remove all font color, highlighting, cell colors and borders, clean up column headers and make 

sure there are no merged cells. 

b. Make sure that XY locations are in decimal degrees. 

i. To convert from degrees, minutes, seconds (39º 26’ 45.67”) to decimal degrees us the 

following formula: DD + (MM/60) + (SS.SSS/3600). 

ii. Note: if XY locations from some other coordinate system are provided, you can use 

those in the process below but you must know what the coordinate system is. 

2) Open up the Excel worksheet in ArcMap. 

3) From the menu bar, select Tools>Add XY Data… 
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4) Supply the appropriate fields for the X and Y coordinates, choose the appropriate coordinate system and 

press OK. 

5) Results are an event layer, not a true spatial layer. Export the data by right-clicking the event layer and 

selecting Data>Export Data… from the dropdown menu. 

6) Follow the steps detailed in Subscriber Location – GIS Data below. 

 

3.5.2.3 Subscriber Location – GIS Data 

If the provider supplies subscriber location in GIS format, the only process step is to load that data into the 

appropriate data schema and it will be ready for processing. 

1) First, load the data into the Point Address database schema (please see Appendix D for an example of the 

Point Address database schema.) using an empty feature class in that schema. 

2) In ArcCatalog, right-click on the empty feature class and select Load from the dropdown menu. 

3) Navigate to the provider address GIS data set and then map the attribute fields accordingly, as seen in 

general below: 
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4) Once you have successfully loaded the provider address data into the temporary database with the 

correct schema, you will now append that data to the overall Point Address database. 

5) In ArcToolbox, use the Append command (Data Management Tools>General> Append) to add the 

features into the overall Point Address database, as seen in general below: 
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6) Since the data is already in the Point Address database schema, there is no n need to alter the Field Map 

in the Append tool. 

7) After appending, calculate metadata reflecting geometry source and representation values. 

8) Break provider-specific points into separate county feature classes and perform the following steps per 

county feature class: 

a. Within ArcGIS 

i. Summarize download and upload speeds [first,last] to determine all speeds available for 

county. 

1. This will save as a DBF table. Keep track of location for future reference. 

ii. Buffer county address point featureclass to 150’.     

1. During buffer command, dissolve on “ad_down”; ”ad_up”; ”provider”; “dba”; 

“frn”; “tt”; ‘all metadata fields’; “stctyfips”.    Save as…. 

county_fastestdown_fastestup.  

2. (Example using Qwest data: boulder_40128_20128, where boulder=county;  

40128=ad_down; 20128=ad_up) 

3. Note: these attribute fields are specific to the Point Address database. 

iii. Select the features that represent the lowest speeds 

b. Using XtoolsPro (http://www.xtoolspro.com/)  

i. In the XTools Pro toolbar, select XTools Pro>Layer Operations>Erase Features 

ii. Use the same feature class for Input and Overlay 

iii. Check Use selected features on the Input feature, as seen below. 

http://www.xtoolspro.com/
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iv. Repeat and erase slowest speeds one speed at a time.  Saving each new feature class as 

the next slowest speed, using the same naming convention as above. A general example 

is seen below: 

 

 
 

c. Within ArcGIS 

i. Edit/delete speeds from the attribution table of each feature class, so each remaining 

feature class has only one speed value. 

ii. Merge individual speed feature classes together using the Merge command in 

ArcToolbox (Data Management Tools>General>Merge). The dialog box is seen below:  
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iii. Merge individual county feature classes together using the Merge command in 

ArcToolbox (Data Management Tools>General>Merge).  

iv. Since the county files are all in the same schema, do NOT alter the Field Map portion of 

the command interface. 

v. When all the county files are merged together into one dataset, use the Append 

command in ArcToolbox (Data Management Tools>General>Append) to add the 

features to the bb_cov interim data set. Use the Field Map portion of the Append tool to 

map the appropriate field values to their corresponding fields in the bb_cov feature 

class. 

 

3.5.2.4 DSLAM or Central Office Location – Address Data 

In the event that the provider supplies DSLAM (digital subscriber line access multiplexer) or Central Office address 

data please follow the steps below: 

1) Follow the process for geocoding points in Subscriber Location – Address Data, above. 

2) Follow the steps detailed in DSLAM or Central Office Location – GIS Data below. 

 

3.5.2.5 DSLAM or Central Office Location – XY Data 

In the event that the provider supplies DSLAM (digital subscriber line access multiplexer) or Central Office XY data 

please follow the steps below: 

1) Follow the process for creating points from XY data  in Subscriber Location – XY Data, above. 

2) Follow the steps detailed in DSLAM or Central Office Location – GIS Data below. 
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3.5.2.6 DSLAM or Central Office Location – GIS Data 

In the event that the provider supplies DSLAM (digital subscriber line access multiplexer) or Central Office GIS data 

please follow the steps below: 

1) Buffer the DSLAM/Central Office points feature class 

a) Add the point feature class to ArcMap 

b) Open up ArcToolbox and go to Analysis Tools>Proximity>Buffer 

c) Set the buffer distance to 5 miles 

d) Set the dissolve type to ALL 

e) Name the output feature class 

f) Typical Buffer tool is seen below: 

 

 
 

g) Press OK 

2) Use the resulting buffer feature class to clip the TIGER street layer (as described earlier): 

a) Add TIGER street layer to ArcMap 

b) Open up ArcToolbox and go to Analysis Tools>Extract>Clip 

c) Complete the dialog box as seen below: 

 



                                                         

22 

 
 

d) Press OK. 

3) Using ArcCatalog and within the file geodatabase: 

a) Right Click and create a new Feature Dataset  

i) For the Feature Dataset settings: 

(1) Name the feature dataset accordingly 

(2) Select horizontal coordinate system by importing the coordinate system associated with the 

clipped TIGER street layer by selecting Import and navigating to the location of that feature class 

(3) No vertical coordinate system needed 

(4) Leave all x,y,z,m values at default. 

(5) Press Finish 

4) Import previously created street feature class into new Feature Dataset 

5) Right-click Feature Dataset and create new Network Dataset – accept all default setting for the Network 

Dataset 

a) Note: the Network Analyst extension must be turned on 

6) In ArcMap Turn on the Network Analyst Toolbar by going to View>Toolbars>Network Analyst 

7) Add the Network Dataset created in Step 5 to ArcMap 

8) Using Network Analyst Toolbar drop down – create “New Service Area” 

9) Open up the Network Analyst Window by selecting the  button. 
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10) Right click Facilities layer, select Load Locations, and navigate to the DSLAM/Central Office facilities feature 

class. 

 
 

11) Press OK. 

12) Click the Service Area Properties button  

13)  For the following tabs change the following properties: 

a) “Polygon Generation” tab  

i) Select “Merge by break value”  

ii) Also disable the Trim Polygons option 

b) “Analysis Settings” tab – using and converting the specified DSLAM buffer distance from feet to meters – 

input buffer distance value in meters into the “Default Breaks” location 
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i) Generally, 18,000 feet (5486 meters) from DSLAM or Central Office location is used as the buffer 

distance 

 
 

c) Click OK. 

14) On the Network Analyst Toolbar click the “Solve” button  to create service area polygons. 

15) Right-click on the created service are polygon in the layer list, and select Data>Export Data from the dropdown 

list. 

16) Export to a feature class in the file geodatabase you created earlier 

17) In ArcCatalog, create an empty feature class with the schema of the bb_cov feature class and load the feature 

class created in Step 16 into it. 

a) Right-click on the empty feature class, select Load>Load data from the dropdown menu and navigate to 

the location of the service area feature class 

b) Press the Add button, hit Next 

c) Accept the defaults and hit Next 

d) Do NOT attempt to map any fields, as seen below: 
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e) Press Next, then Next again, then Finish. 

18) In ArcToolBox, go to Data Management Tools>General>Append 

19) Append the formerly empty feature class to bb_cov, completing the dialog box as seen below: 
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20) Leave the Schema Type as TEST 

21) Press OK. 

22) In ArcMap, open up bb_cov for editing and manually input associated attribution. 

 

3.5.2.7 Broadcast Tower Location – Address Data 

In the event that the provider supplies wireless broadcast tower location address data please follow the steps 

below: 

1) Follow the process for geocoding points in Subscriber Location – Address Data, above. 

2) Follow the steps detailed in Broadcast Tower Location – GIS Data below. 

 

3.5.2.8 Broadcast Tower Location – XY Data 

In the event that the provider supplies wireless broadcast tower location XY data please follow the steps below: 

1) Follow the process for creating points from XY data  in Subscriber Location – XY Data, above. 

2) Follow the steps detailed in Broadcast Tower Location – GIS Data below. 

 

3.5.2.8.1 Broadcast Tower Location – GIS Data 

In the event that the provider supplies wireless broadcast tower location GIS data please follow the steps below: 

1) Download the required software (Radio Mobile) from the website: 

http://www.cplus.org/rmw/english1.html  

2) Install the software according to the standard directions, found here: 

http://www.cplus.org/rmw/download/download.php?S=1  

3) Open up the application 

4) Load the broadcast tower location and elevation information by selecting File>Unit properties. The 

following dialog box appears: 

 

http://www.cplus.org/rmw/english1.html
http://www.cplus.org/rmw/download/download.php?S=1
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5) Add in the information for all the towers supplied by the WISP data provider, including the elevation. If 

provider does not supply elevation, this information can be obtained from Google Earth. 

a. I f available, use the Import button to import a Google Earth KML of the tower locations. 

6) Go to the National Map Seamless Server (http://seamless.usgs.gov/) and download elevation data 

sufficient to contain the tower locations. 

a. At least the 1/3” NED data is needed. Select this by clicking the Download button in the upper 

right of the web site and checking the box nect to 1/3 “ NED. 

b. Zoom to the area of interest and use the Download tools: 

 
to define the area to download. 

c. Click the Modify Data Request button to request the data in BIL_16INT format, not ESRI GRID, as 

seen below: 

 

http://seamless.usgs.gov/
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d. Download the data and unzip it. 

7) Select File>Map Properties to define the map 

8) Enter in a latitude and longitude in the center of the tower locations 

9) Set the size (in pixels) and the size (in kilometers) of the map 

10) Set the directory path leading to the BIL elevation data just downloaded 

11) The dialog box is seen below: 
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12) Hit Extract. 

13) The elevation data is render as a hill shade, as seen below: 

 

 
 

14) Select File>Network properties from the main menu 

15) Create a new network and enter in the frequency range under the Parameters tab, as seen below: 
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16) Leave all the other values as they appear, and select the Systems tab 

17) Create enough systems to cover all the varieties of equipment in the provider network. This will include 

the antenna type, height, and line loss, as seen below: 
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18) Now click on the Membership tab, and assign the individual towers to their respective systems, providing 

the azimuth for non-omnidirectional antennas, as seen below: 
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19) Press OK. 

20) Select Tools>Radio Coverage>Combined Cartesian from the main menu 

21) Complete the dialog box as seen below, providing the Maximum Range from the highest tower beam 

radius supplied by the provider. 

22) Set the Pixel Size at 5 (experiment depending on the area covered to get the right level of granularity) as 

seen below: 
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23) Set the signal range to draw to S-Unit and type 5 in the From (>=) box. 

24) Press Draw. 

 

 
 

25) Save the resulting image as a TIF by selecting File>Save Picture as. 

26) Open ArcMap and load the BIL elevation data you used in Radio Mobile. 

27) Load the TIF image you created and georeference it using the corners of the BIL data. 

a. The corners of the data can be seen in the TIF image. 
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28) Follow the georeferencing directions from the Coverage Area – PDF/JPG/Other Image Format section 

below. 

29) Use the Georeferencing Toolbar to Update the Georeferencing for the TIF data set. 

30) In ArcToolbox, select Data Transformations>From Raster>Raster to Polygon and input the georeferenced 

TIF you just created as seen below: 

 

 

31) Open the resulting polygon feature class up for editing using the Editing toolbar in ArcMap and clean up 

as necessary. 

32) In ArcCatalog, create an empty feature class with the schema of the bb_cov feature class and load the 

feature class created above into it. 

a. Right-click on the empty feature class, select Load>Load data from the dropdown menu and 

navigate to the location of the service area feature class 

b. Press the Add button, hit Next 

c. Accept the defaults and hit Next 

d. Do NOT attempt to map any fields, as seen below: 

 

 
 

e. Press Next, then Next again, then Finish. 

33) In ArcToolBox, go to Data Management Tools>General>Append 

34) Append the formerly empty feature class to bb_cov, completing the dialog box as seen below: 
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35)  Leave the Schema Type as TEST 

36) Press OK. 

37) In ArcMap, open up bb_cov for editing and manually input associated attribution. 

 

3.5.3 Linear Data 

3.5.3.1 TIGER Street Segments – List, Spreadsheet, or GIS Data 

In the event that the provider supplies TIGER street segments in list or spreadsheet format please follow the steps 

below: 

1) Join TIGER road segments  to 2000 census blocks feature class using one of two methods based on how 

the data is provided: 

a) If the TIGER data is provided with a Census Block ID, then join the segments to the Census Block 

geometry based on that ID 

i) Load both data sets into ArcMap 

ii) In the layer list, right-click on the 2000 census block feature class and select Joins and 

Relates>Join 

iii) In the dialog box, select the TIGER road segments data and the proper attribute fields for joining, 

as seen below: 
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iv) Press OK 

b) If the data provided is a list containing TLIDs,  then join to the TIGER line data using the TLID, and use 

a spatial join to associate the TIGER segment with the coterminous block based on the block ID 

i) Load both data sets into ArcMap 

ii) In the layer list, right-click on the 2000 census block feature class and select Joins and 

Relates>Join 

iii) Select “Join data from another layer based on spatial location” from the dropdown menu 

iv) Complete the dialog box as seen below and press OK. 
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2) Export joined records into a temporary feature class. 

3) If joined Census Block geometry is confined to one specific area then dissolve blocks into one record.  If 

joined Census Block geometry is distributed throughout a particular state then dissolve sub-selections of 

census blocks for each county. 

a) Use the County FIPS code to dissolve by county. 

b) In ArcToolbox, select Data Management Tools>Generalization>Dissolve 

c) Complete the Dissolve dialog box as seen below: 
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d) Press OK. 

4) For each dissolved region, open up the feature class for editing using the Editing tool in ArcMap and 

remove unnecessary slivers and other small holes.  For general guidance on editing features in ArcMap, 

see http://webhelp.esri.com/arcgisdesktop/9.3/pdf/Editing_Tutorial.pdf  

5) In ArcCatalog, create an empty feature class with the schema of the bb_cov feature class and load the 

feature class created above into it. 

a) Right-click on the empty feature class, select Load>Load data from the dropdown menu and navigate 

to the location of the service area feature class 

b) Press the Add button, hit Next 

c) Accept the defaults and hit Next 

d) Do NOT attempt to map any fields, as seen below: 

 

http://webhelp.esri.com/arcgisdesktop/9.3/pdf/Editing_Tutorial.pdf
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a) Press Next, then Next again, then Finish. 

6) In ArcToolBox, go to Data Management Tools>General>Append 

7) Append the formerly empty feature class to bb_cov, completing the dialog box as seen below: 
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8)  Leave the Schema Type as TEST 

9) Press OK. 

10) In ArcMap, open up bb_cov for editing and manually input associated attribution if necessary. 

 

3.5.4 Polygonal Data 

3.5.4.1 Coverage Area – PDF/JPG/Other Image Format 

In the event that the provider supplies coverage area data in some image format such as PDF or JPG format please 

follow the steps below: 

1) If in PDF format, open in Adobe Acrobat and Save As… JPG format. 

2) Open up the JPG image in ArcMap. 

3) Add the required basemap vector data for georeferencing. 

a) This will generally be either the CDOT data or TIGER data 

4) Change the coordinate system of the data frame to the desired end coordinate system 

5) Zoom to the general location of the JPG map image 

a) This is the location based on the vector data, not the JPG image itself. For example, if you know that 

the JPG image represents an area around the town of Limon, zoom to the town of Limon in your 

vector data. 

6) Open up the Georeferencing toolbar by selecting View>Toolbars>Georeferencing from the main menu bar. 

7) Using the Georeferencing toolbar, select Fit to Display, results seen below: 

 

 
 

8) Use the Control Point button  to add control points to the map 

9) Use common points in the base data set and the JPG image 

a) For example, find major street intersections, county/city boundaries, etc. 

b) Try to distribute the points more or less in the four corners on the image for the best transformation 

10) Click on the location on the image first, then click on the corresponding location on the vector data base 

map, as in the image below: 
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11) After placing each control point, the image transformation will update automatically.  

12) Repeat until satisfied with the transformation. 

a) Note: The transformation may take up to four points, although sometimes only two are necessary. 

13) When satisfied with the transformation, select Update Georeferencing from the Georeferencing toolbar 

dropdown. 

a) This will create a “world” file (.jgw in the case of JPGs) in the same directory as the image file. 

14) In ArcCatalog, create a new polygon shapefile with the appropriate data schema for a provider coverage 

area, which can be found in Appendix D. 

15) Add the shapefile to ArcMap. 

16) Using the Editor Toolbar, select Start Editing. Set the Task: to “Create New Feature.” 

17) Use the Sketch Tool  to digitize a new coverage polygon using the coverage area outline from the 

georeferenced JPG and add the required attributes manually. 

18) Repeat the above steps for all subscriber speed coverage areas provided. 

19) Follow the steps detailed in Coverage Area – GIS Data below. 

 

3.5.4.2 Coverage Area – KML/KMZ 

In the event that the provider supplies coverage area data in Google Earth KML or KMZ format please follow the 

steps below: 
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1) Use a KML to SHP converter to translate file into an ESRI format 

2) http://arcscripts.esri.com/details.asp?dbid=15603  

3) Download the script and follow the provided instructions for installing it in ArcToolbox. 

4) Double-click on the script in ArcToolbox and navigate to the location of the KML file, as seen below: 

 

 

5) Add the new shapefile to ArcMap. Repeat for all KML files provided. 

6) Follow the steps detailed in Coverage Area – GIS Data below. 

 

3.5.4.3 Coverage Area – CAD Data 

In the event that the provider supplies coverage area data in GIS format please follow the steps below: 

1) Transform the CAD dataset into an ESRI format 

2) http://webhelp.esri.com/arcgisdesktop/9.2/index.cfm?TopicName=Transforming_CAD_datasets 

3) It may be necessary to contact the provider first to determine the coordinate system of the CAD data. 

4) If the CAD data is not in a standard coordinate system, it may be necessary to use ArcMap to 

georeference the CAD data to a known coordinate system first. 

a) To do so, follow the instructions provided above in “Coverage Area – PDF/JPG/Other Image Format.” 

5) In ArcCatalog, create a new polygon shapefile with the appropriate data schema for a provider coverage 

area, which can be found in Appendix D. 

6) Add the shapefile to ArcMap. 

7) Using the Editor Toolbar, select Start Editing. Set the Task: to “Create New Feature.” 

8) Use the Sketch Tool  to digitize a new coverage polygon using the coverage area outline from the 

georeferenced CAD file and add the required attributes manually. 

9) Follow the steps detailed in Coverage Area – GIS Data below. 

 

3.5.4.4 Coverage Area – GIS Data 

In the event that the provider supplies coverage area data in GIS format please follow the steps below: 

http://arcscripts.esri.com/details.asp?dbid=15603
http://webhelp.esri.com/arcgisdesktop/9.2/index.cfm?TopicName=Transforming_CAD_datasets
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1) In ArcCatalog, create an empty feature class with the schema of the bb_cov feature class and load the GIS 

feature class either created above or supplied by the provider into it. 

a) Right-click on the empty feature class, select Load>Load Data from the dropdown menu and navigate 

to the location of the service area feature class 

b) Press the Add button, hit Next 

c) Accept the defaults and hit Next 

d) Do NOT attempt to map any fields, as seen below: 

 

 
 

e) Press Next, then Next again, then Finish. 

2) In ArcToolBox, go to Data Management Tools>General>Append 

3) Append the formerly empty feature class to bb_cov, completing the dialog box as seen below: 
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4) Leave the Schema Type as TEST 

5) Press OK. 

6) In ArcMap, open up bb_cov for editing and manually input associated attribution, if necessary. 

 

3.5.4.5 Compact Polygon From Subscriber Points  

 Geo-code address list using latest state “Composite Locator”  

 

 Verify that your geo-coded file has only one TT (Technology Type).  If not export individual geo-coded 

layers for each Technology Type. 

 

 For each TT check for differences in speed values or speed tiers and create separate layers for each speed 

value/tier. 

 

 Clean your geo-coding results - remove any points that geo-code to accuracy levels below ZIP+4 (ZIP 

centroids, carrier route centroids, etc).  Also, verify that outliers with acceptable accuracy levels are 

legitimate, i.e. fall in correct City and Zip.   

 

 Perform spatial join between county polygons (using stcnyfips field) and the cleaned geo-coded subscriber 

points, in order to carry the county name and stcnty fips. 

 

 Summarize the number of subscribers by county and use the subscriber counts by county to populate the 

Rate Tier table. 
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 Un-join the county data from the geo-code subscribers list. 

 

 Create Compact Polygon using cleaned geo-coded layer or sub-selection of using – XtoolsPro – 

ConvexHull-DetailedHull option.  A sub-selection of geo-coded points will be used in areas where more 

than one polygon will need to be created for one provider’s service area.   

 

 Evaluate output Hull carefully – looking for areas that should not be covered by hull polygon.   

 

o If it is determined that an area or areas should not be represented in coverage area, manually 

reshape hull polygon until coverage area is adequate.   

 

o When not obvious and as a general rule, manually resolve compact polygon when the distance 

between the subscriber points used to define the outer boundary of the compact polygon 

exceeds 5 miles .  When reshaping the hull polygon, snap to the outermost geo-coded points.  

See figure 2 and 3 for an example. 

 

FIGURE 2- Compact Hull: Manual Resolution Required            
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FIGURE 3a- Compact Hull: Manual Resolution Required           FIGURE 3b- Compact Hull: After Manual Resolution        

                       
 

 To attribute the compact polygon - Perform a “Spatial Join” where your Target Feature Class is the 

compact polygon and the Join Feature Class is your geo-coded point layer.  Export compact hull with 

joined attributes and name file appropriately.   

 

 Append attributed compact polygon to BroadBand TT template Feature Class and if required manually 

input any provider attribution that may not have carried over in the append process. 

 

 Intersect compact polygon with county boundaries to create unique records by county and use the state-

county-fips field to populate “stcty_fips” field.  Also use the county name field to populate the 

“BBCov_Name” field.   

 

o Exceptions is where a provider’s coverage is distributed throughout more than one area of any 

given county where the “BBcov_Name” should be populated using an appropriate city or other 

logical name based on geographical location.  

 

 Export/Load into appropriate BB TT model Dataset. 
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3.5.4.6 Census Blocks – List or Spreadsheet 

In the event that the provider supplies census block data in a list or spreadsheet, please follow the steps below: 

1) Ensure block polygons supplied by the provider are 2000 currency 

2) If other currency, convert to 2000 currency before proceeding 

a. To do this, remove the trailing letter (a, b, etc.) from the block ID 

b. You will now have two blocks that equate to one block in the 2000 block geometry 

c. Delete duplicate block IDs, retaining the higher service tier in each case 

3) Prepare the block list in clean Excel format, removing all Excel-only formatting, merged cells, colors, 

borders, etc. 

4) Import the spreadsheet into ArcMap. 

5) Right-click on the 2000 census block feature class in the layer list in ArcMap and select  Joins and 

Relates>Join from the drop down menu. Join the census block list to the 2000 census blocks feature class 

using the block ID and export joined records in a new feature class. The Join dialog box and process can be 

seen above in the TIGER Street Segments – List, Spreadsheet, or GIS Data section. 

6)  Follow the steps in Census Blocks – GIS Data below. 

 

3.5.4.7 Census Blocks – GIS Data 

In the event that the provider supplies census block GIS data please follow the steps below: 

 

1) Ensure that the blocks supplied by the provider are in the required data schema and are complete as far 

as require attribution. 

a. If not, manually enter the required attribution or contact the provider to fill gaps. 

2) If census block geometry is distributed throughout more than one county then select Data Management 

Tools>Generalization>Dissolve in ArcToolbox and dissolve based on County/Provider/TT/Speed Tier so 

that unique records are created for each unique combination. 

a. The dissolve dialog box can be seen above in the TIGER Street Segments – List, Spreadsheet, or 

GIS Data section. 
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Figure 1: Undissolved census block polygons 

 

 
Figure 2: Census block polygons dissolved by county 

 

 

2) For each dissolved region use the Editing toolbar in ArcMap to remove unnecessary slivers and other 

small holes.   

3) In ArcToolbox, select Data Management Tools>General>Merge and merge the processed polygons 

together into single layer. 

4) The merged census blocks will need to have the subscriber’s “frn” field added and populated. 

5) In ArcCatalog, create an empty feature class with the schema of the bb_cov feature class and load the GIS 

feature class either created above or supplied by the provider into it. 

a. Right-click on the empty feature class, select Load>Load Data from the dropdown menu and 

navigate to the location of the service area feature class 
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b. Press the Add button, hit Next 

c. Accept the defaults and hit Next 

d. Do NOT attempt to map any fields, as seen below: 

 
 

e. Press Next, then Next again, then Finish. 

6) In ArcToolBox, go to Data Management Tools>General>Append 

7) Append the formerly empty feature class to bb_cov, completing the dialog box as seen below: 
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8) Leave the Schema Type as TEST 

9) Press OK. 

10) In ArcMap, open up bb_cov for editing and manually input associated attribution, if necessary. 

 

3.6 Metadata Transactions 

Following any updates or changes completed within the file geodatabase (fGDB) stored on the GIS-Analysts staging 

environment, the GIS-Analyst runs transactions to compare that fGDB with the one stored on the Core server to 

ensure metadata on all changes are recorded. 

 

Below outlines the steps taken to run transactions on the updated Core database: 

  

1. Open a command line window and run generateTransactions.py  

a. Usage: generateTransactions.py  [Core fGDB] [Staging Environment fGDB]  

 

b. Example of command line:  

 

<path>generateTransactions.py <path>ST_BB_POLY_SRV_AREAS.gdb <path>ST_BB_POLY_SRV_AREAS.gdb  

 

2. Below is an example of the output screen that will be displayed: 
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3. After process has completed, results can be found in the ST_BB_POLY_SRV_AREAS_HIST.gdb  

a. The transactions scripts records changes at a feature level. 

b. Below is a screen shot supporting the directory structure of the historical fGDB. 
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c. Attribution associated with each added/removed/changed features is tracked, including the 

following additional columns appended to the end of each: 

i. Commit_by 

1. Records the GIS-Analyst that committed the changes to the historical fGDB. 

 

ii. Commit_date 

1. Records the date and time stamp that the changes were committed. 

 

iii. Trans_type 

1. This field reflects the type of change recorded. 

2. Categorized by: 

a.  Adds/Change/Deletes 

 

iv. New_values 

1. Records the new values when a change was completed on a feature.  Example:  

Name or speed change 
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d. MD_Process is also transferred from the edited fGDB to the historical fGDB, which states the 

actions completed by the GIS-Analyst. 

 

 



                                                         

54 

3.7 Data Processing 

3.7.1 Data Processing Overview 

The following items outline the actions required to process the service provider data further to meet the NTIA 

requirements. 

 Weighted Nominal Speed 

 Middle Mile 

 Broadband Coverage Template 

 

3.7.2 Weighted Nominal Speed 

The weighted nominal speed is populated one of the following two ways: 

3.7.2.1 Subscriber Data Supplied by Provider 

Where we are supplied with subscriber speed information by the data provider, we use the following formula from 

the NOFA: 

(speed tier-1 in kbps × no. of tier-1 subscribers) + (speed tier-2 in kbps × no. of tier-2 subscribers) + (etc.) 

Total average monthly subscribers 

 

 

Data is initially broken up in the following order: 

1) Stcty_fips 

2) Transmission technology type 

3) Subscriber tiers 

 

3.7.2.2 Value Supplied by Provider 

Some providers will supply their weighted nominal speed.  In these cases, the data supplied will be populated 

instead of using the NOFA formula. 

When these values have been obtained or calculated, they are used to update the service overview layer. This can 

be done manually or by creating a table with the provider’s FRN and average weighted speed and joining it to the 

service overview table in ArcMap. To Join, right-click on the layer you would like to join to and select Joins and 

Relates>Join… from the dropdown menu. Then navigate to the table you want to join and select the join fields 

from the drop down lists. Then open up the source table (the table in ArcMap) and right-click on the header of the 

Average Weighted Speed field and select Calculate Field from the drop down menu. Use the value of the average 

weighted speed from the joined table. 

3.7.3 Middle Mile 

Middle mile information is generally provided in spreadsheet or text file format. The process is to take what is 

supplied by the provider and translate it into the required data schema.  

1) If the data is supplied with address information, follow the process outlined above in Subscriber Location 

– Address Data.  
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2) If the data is supplied with associated XY coordinates, follow the process outlined above in Subscriber 

Location – XY Data.  

3) Once the data is in GIS format, use the Append (Data Management Tools>General>Append) command in 

ArcToolbox to append the data to the overall middle mile dataset. 

4) Set the schema type to NO_TEST and use the Field Map to map the attribute fields from the source to the 

target dataset. 

3.7.4 Broadband Coverage Template 

Below is the description of the fields within the BB_Cov layer, which is the interim data set that is used to create 

the final product deliverable. 

 

Name Alias Description 

objectid OBJECTID Internal Object ID 

shape SHAPE Internal Shape storage 

prov_id PROVIDER_ID Unique numeric identifier for each provider 

prov_name PROVIDER_NAME Unique name for each provider 

dba_name DOING_BUSINESS_AS An alternative "Doing-Business-As" name for the provider 

frn 
FCC_REGISTRATION_NUMBE

R 
Provider FCC Registration Number 

bbcov_name BBCOV_NAME BroadMap Broadband Coverage name 

trans_code TRANSMISSION_CODE 
Unique code for the transmission technology type described by 

this layer 

trans_name TRANSMISSION_NAME Name for the transmissions technology type 

trans_desc TRANSMISSION_DESC Description for the transmissions technology type 

spect_code SPECTRUM_CODE Unique code for the spectrum [WIRELESS ONLY] 

spect_name SPECTRUM_NAME Name for the spectrum [WIRELESS ONLY] 

spect_desc SPECTRUM_DESC Description for the spectrum [WIRELESS ONLY] 

mad_dwn_t MAX_AD_DOWN_TIER 
Maximum advertised downstream speed available within given 

area (speed tier) 

mad_up_t MAX_AD_UP_TIER 
Maximum advertised upstream speed available within given 

area (speed tier) 

typ_dwn_t TYPICAL_DOWN_TIER 
Typical downstream speed available within given area (speed 

tier) 

typ_up_t TYPICAL_UP_TIER Typical upstream speed available within given area (speed tier) 

mad_dwn_k MAX_AD_DOWN_KBPS 
Maximum advertised downstream speed available within given 

area (kbps) 
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Name Alias Description 

mad_up_k MAX_AD_UP_KBPS 
Maximum advertised upstream speed available within given 

area (kbps) 

typ_dwn_k TYPICAL_DOWN_KBPS Typical downstream speed available within given area (kbps) 

typ_up_k TYPICAL_UP_KBPS Typical upstream speed available within given area (kbps) 

subs SUBSCRIBERS 
Total average monthly subscribers for this provider for this 

technology for this coverage polygon 

md_geom MD_GEOMETRY 
Metadata: Comma separated list of source id's from which the 

polygon extent was produced 

md_exists MD_EXISTS 
Metadata: Comma separated list of source id's used in 

understanding and editing the provider data for this polygon 

md_who MD_WHO 
Metadata: Name of the editor who last edited this feature at 

the time in md_when 

md_when MD_WHEN Metadata: Date/timethat this feature was last edited 

md_process MD_PROCESS 
Metadata: Comma separated list of processed used to create 

and/or modify this layer 

stcty_fips STATE_COUNTY_FIPS State/County FIPS code 

rec_id RECORD_ID 

Compound Key formed from 

STCTY_FIPS+"|"+Provider_ID+"|"+Trans_Code+"|"+BBCov_Nam

e 

st_area ST_AREA(SHAPE) Area in square decimal degrees  

st_length ST_LENGTH(SHAPE) Length in decimal degrees  

Provider_Typ

e 
Type of Provider 

Has Subtype (1:Broadband provider as described in the 

NOFA,2:Reseller,3:Unknown), default value = 1  (New 04/11 

Model) 

 

3.7.5 Verification and Validation 

3.7.5.1 Provider Validation – Provider Portal/PDF Map Review 

Following the collection and aggregation of provider data, the data is then validated by the provider to ensure the 

data aggregated is an accurate representation of their coverage area and supporting broadband information. 

This is completed through the Provider Portal web application, which is a secure interactive map displaying their 

coverage areas and allows the user to validate, submit feedback or request changes.  If changes are requested, 

then the features on the portal are then updated and an automatic request is sent to the provider to complete the 

validation effort. 
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For some providers that did not use the Provider Portal, a PDF was sent displaying their coverage map and 

validation was then completed via e-mail notification.   

 

 

 

 

 

3.7.5.2 Provider Verification – 3rd Party Source Review 

Once the provider has validated their coverage areas, a 3
rd

 party source comparison and analysis is then 

performed.  Where anomalies or discrepancies are identified, a ‘SCAN’ point is dropped and descriptive comments 

applied so they can later be reviewed with the provider. 

 

During the provider review, the map is displayed along with the ‘SCAN’ points and potential refinement is 

completed based on input from the Provider. 

 

3
rd

 Party Sources Utilized 

3
rd

 Party Source Name Source Type Verification Type 

Pitney Bowes (PBBI) Exchange Info Plus 
(Central Office Locations) 

Exchange datasets are used to verify the following 
Transmission Technologies (TT): 
Asymmetric xDSL (10), Symmetric xDSL (20), Other Copper 
Wireline (30), and Optical Carrier/Fiber to the End User 
(50). 
 

American Roamer  Wireless Coverage 
Patterns (EVDO, GPRS, 
WISP, HSPA) 

Used to verify the following TT: 
Terrestrial Fixed Wireless—Unlicensed (70), Terrestrial 
Fixed Wireless—Licensed (71) and Terrestrial Mobile 
Wireless (80) 

ComSearch Wireless Spectrum 
Holdings and Tower Data 

Used to verify the following TT: 
Terrestrial Fixed Wireless—Unlicensed (70), Terrestrial 
Fixed Wireless—Licensed (71) and Terrestrial Mobile 
Wireless (80) 
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3.7.5.3 Assigning Confidence Values 

All efforts from the above-mentioned validation and verification activities, plus internal peer quality reviews are 

combined and tracked in a Validation table.  Based on the results of this analysis, a confidence value is assigned for 

each provider and then each technology.   

 

The confidence values are as follows:  
0     = Coverage area has not been reviewed 
10   = Extremely Low.   Single Source QC.   
20   = Very Low.  Needs Additional Validation\Verification 
30   = Low.   Even with Validation\Verification, Coverage is still suspect. 
40   = Acceptable, confirm with State prior to shipment.    
50   = Meets requirements to be included in shipment. 
60   = Moderate.  Meets NTIA/State’s standards, representative of Technology Type (TT) 
70   = High.   Accurate representation of coverage based upon TT. 
80   = Very High.  Multiple validation\verification with most 3

rd
 party sources 

90   = Extremely High. Multiple validation\verification sources 
100 = Perfect.  Multiple validation\verification sources, with complete alignment with sources and ground 
truth verification activities 

 

This Validation table is then maintained as updates or changes occur for each provider, down to technology type, 

with the overall goal to improve the confidence values and overall map representation. 

 

Example of the Validation table: 
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3.7.6 Community Anchor Institution (CAI) Data 

3.7.6.1 Data Collection 

The CAI data was initially collected from the State to create the baseline inventory.  All location information and 

broadband coverage data supplied was also ingested into the data deliverable. 

Additional collection of CAI information was done via data mining and/or webscraping to build out the inventory 

further.  For example:  Collection of additional CAIs, address and broadband data. 

 

The state-agency-provided CAI inventory was comprehensive but the challenge is collecting broadband related 

data; service provider(s), technology and speed data for each CAI.  Availability of the CAI portal has not significantly 

increase submission of this data.  Additional promotion to CAIs to utilize the CAI portal will be needed to increase 

this data for subsequent deliverables. 

 

3.7.6.2 Institution Data 

Institution data is obtained from a variety of sources and almost always provided in Excel spreadsheet format. The 

general process for incorporating this data is below: 

1) If the data is provided in Excel or some similar format: 
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a. Clean and standardize the Excel spreadsheet, removing any cell formats, merged cells, etc. 

b. Standardize the address format as defined in the staging CAI database 

c. If the spreadsheet includes X and Y values, such as latitude and longitude, use the Add XY Data 

tool in ArcMap to create a spatial data layer. 

d. If there are only addresses, then follow the geocoding steps outlined above to create spatial data 

points for each of the institutions. 

i. Institutions that do not geocode based on the TIGER 2009 data set will have to be 

manually located using Google Maps, Google Earth, or some other information source. 

2) If the CAI source data is in GIS format, add the Latitude and Longitude fields and use the Calculate 

Geometry tool to populate them, using the WGS 84 coordinate system. 

3) Using ArcCatalog, load the new data into the staging CAI database. 

4) This database is ready for the makeDeliverable.py script to process the information into the final state 

and NTIA deliverables. 

 

3.7.6.3 Community Anchor Institution (CAI) Portal Updates 

A web application has been released to allow for further data collection and validation of anchor institution 

location information, broadband coverage, and speed test data. 

 

Information collected from the CAI Portal is then ingested into the overall inventory and will later be compared 

against the provider coverage areas mapped for any potential discrepancies. 
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3.8 Product Extract 

3.8.1 Python Scripts 

The following sections make use of Python scripts. In general, to use a Python scrip, you must have Python 

installed on your computer. To download the latest version of Python, go to http://www.python.org/download/ 

and download the latest stable version. As of August 2010, this was version 2.7. Once this is installed, the general 

way to run a script is to type the following at a command prompt: C:\Python27\python.exe C:\<location of script>. 

Many of the scripts provided have environment variables that must be set before they can be run.  

 

The python code for BroadMap’s product extract has been incorporated into a Hudson CI System, which is detailed 

in the Process Operation and Monitoring section of this document.  This was a process improvement activity so all 

processes can be monitored, controlled and contain historical tracking on each process. 

 

3.8.2 Product Extract Process 

Note: specific Python scripts are called out in red font in the sections below. 

The MapConnect product extract process, makeDeliverable.py, uses the BB_Cov and BROADMAP_POINTS interim 

data sets to create the following layers according to the current specifications: 

 BB_Service_Road_Segment 

- This layer contains all broadband services associated with specific street segments for census 2000 

blocks larger in area than two square miles 

 BB_ServiceCensusBlock 

- Contains all broadband services associated with census blocks of no greater than two square miles. 

 BB_Service_Wireless 

- This layer contains all wireless services not associated with specific addresses. 

 BB_ServiceOverview 

- This layer contains subscriber-weighted nominal speed for each provider's service area at a county 

level and is meant to act as a summarized view.  

 BB_ConnectionPoint_MiddleMile 

-   This layer contains middle-mile and backbone interconnection points 

 BB_Service_CAInstitutions 

- Broadband Service at Community Anchor Institutions (CAI) 

 Community Anchor Institutions consist of schools, libraries, medical and healthcare providers, 

public safety entities, community colleges and other institutions of higher education, and other 

community support organizations and entities. 

 

Due to a NTIA model change for the October 2010 data deliverable, an addition to this code was created to 

support both models in the case a comparison is later desired or a request is made to revert back to the original 

model.  This script name is bdia2ntia.py and creates the following layers in addition to the layers mentioned above, 

rolled up to NATL_Broadband_Map. 

http://www.python.org/download/
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 BB_ConnectionPoint_LastMile 

-   This layer contains last mile infrastructure points, which is only populated if data cannot be provided 

at a more granular level. 

 BB_Service_Address 

- Represents broadband availability for service address points.  Address Point availability refers to 

those individual addresses at which each facilities-based provider of broadband service can provide 

broadband services of minimal characteristics within 7 - 10 business days. 

 State_Boundary 

- State boundary supporting topological validation of point feature classes. 

 NATL_Broadband_Topology 

- Supports basic topology quality checking.  Example:  No CAI’s or Middle Mile points outside of the 

state boundary 

 

The following process flow provides a view of how the Core fGDB is extrapolated to the NTIA final deliverable via 

the makeDeliverable.py script.  Following that, the bdia2ntia.py script is run, which limits what’s placed in the final 

layers based on the NTIA modeling standards. 

 

The product scripts and supporting extract were originally created separately per request, in case data model 

comparisons were to be completed.  

 

3.8.3 Product Statistics 

Following the completion of a product extract, the product statistics script (BDIA_ReleaseNotesStats.py) extracts 

the following information supporting that product deliverable. 

 Provider Statistics 

- Collects all provider information, listing by Provider Name 

- Provides output of FRN 

- Counts the number of features supported within the following layers: 

 Census Block 

 Street Segment 

 Max Upstream 

 Wireless Services 

 Infrastructure Points 

- These updates were made to support the Data Package required to accompany every NTIA product 

deliverable. 

 Community Anchor Institution (CAI) Statistics 

- Breaks CAI down to the 8 categories 

 1:  School: K through 12 

 2:  Library 

 3:  Medical/Healthcare 
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 4:  Public Safety 

 5:  University/College 

 6:  Other Government 

 7:  Other Community non-government 

 None:  Unknown Category 

 In cases where this occurs, further investigation is completed prior to product shipment to 

ensure all CAI’s are categorized accurately 

- Reports out the following counts 

 Total CAIs within that category 

 Total CAIs that contain partial BB coverage  

 Contains any of the following information for given CAI: 

 BB Subscriber, Transmission Technology, Speed Down Speed Up 

 Total CAIs that contain full BB coverage 

 Contains all of the above-mentioned BB information for given CAI. 

The output of this script is two CSV files: AnchorInstitutions.csv and Providers.csv. These files can then be 

inspected to ensure that there are the expected number of CAIs and providers for every release. 

 

3.9 Quality Assurance  

Quality assurance is supported manually and algorithmically on the interim data, BB_Cov file geodatabase, and on 

the final product. For scheduled product releases, a test product extract and subsequent manual and algorithmic 

QC run is completed along with a release review.  The product specifications, project status reports, previous 

product release notes are used as references throughout this review. 

The following parameters are tested using the methodology listed below each: 

 Product Deliverable Format  

- Correct names and format of data deliverables 

 BDIA_QC_SUITES (please see below for details) 

- Correct Projections/Datum 

 Manual interaction with product 

- Metadata Present and Correct 

 Manual interaction with product 

 Table Structure 

- All required tables included 

 BDIA_QC_SUITES 

- Extraneous tables identified 

 BDIA_QC_SUITES 

 Field Structure 

- All fields included 

 BDIA_QC_SUITES 
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- Extraneous fields identified 

 BDIA_QC_SUITES 

- Correct field names, types and widths 

 BDIA_QC_SUITES 

 Field Domains 

- Values in all tables are constrained to the specified values specified 

 This action is accomplished via BDIA_QC_SUITES and manual review of the product 

 This tends to identify project completeness issues as fields with a null value are identified. 

 Geometric Representation 

- Identify if all layers have the correct geometric representation 

 Manual review of the BB_ServiceOverview layer 

 Dependent on NTIA and client requirements 

 Geographic Extent 

- Product includes the necessary Geography associated with Product? 

 Manual Review - ArcGIS 

- Is there extraneous geography included in Product? 

 Manual Review - ArcGIS 

 Completeness 

- Products contain the expected amount of data? 

 Manual review of product stats relative to weekly State reports and defined expectations. 

 Accuracy 

- Product meets the stated accuracy requirements for the deliverable? 

 Sampling procedure to manually review source material to resulting product 

 Provider Validation 

 Verification using 3
rd

 Party Data 

 Verification against reality, where applicable 

 Data Regression 

- Any unexplainable data loss or change? 

 This action is accomplished by comparing results within product statistics script 

(BDIA_ReleaseNotesStats.py) from previous releases, as well as manual review of the product 

 Confidentiality 

- Any unauthorized confidential information included in the delivery? 

 Review of NDAs and delivery expectations 

 Prior Issues Resolved  

- Have expected internal issues been resolved? 

 Manual review of data against previous product release notes 

- Have agreed upon customer issues been resolved? 

 Manual review of data against previous product release notes, status report and client feedback 

 Delivery Medium 

- Has the product medium been verified? 
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 Manual review 

- All files present 

 Manual review of SFTP site to ensure all files are copied correctly, including file/directory size 

- Correct location 

 Manual review – confirmation of SFTP link, username and password 

 

3.9.1 QC Suite 

The BDIA_QC_SUITES consists of four main types of scripts supporting the overall QC process. These scripts are all 

run in concert and are called from the test_runner script and the test_BDIAProductGDB script. 

 

3.9.1.1 Configuration  

These scripts establish the configuration for the test_BDIAProductGDB script which is the core of the QC Suite.  

- update_test_config 

- active_config 

- config_PROCESS01_automated 

- config_PROCESS01_manual 

- set_active_config 

3.9.1.2 Libraries 

These scripts provide additional functionality that is called from with the test_BDIAProductGDB script.  

- bb_unittest_fixture 

- bbcov_structure 

- BC_XmlWriter 

- file_folder 

- search_and_replace 

- unittst_fixture 

- validate_BB_DB 

- validate_BB_GDB 

- xmlrunner_gui 

3.9.1.3 QC Suite 

This is the core script for performing automated QA/QC on the interim and final data deliverables. 

- test_BDIAProductGDB 

3.9.1.4 Other  

These scripts perform other functions detailed below: 

- test_runner – this is the main script that runs all the other QC scripts and imports all the necessary scripts 

and libraries 

- which_build – this determines the current build and passes information to the configuration scripts 
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3.10 Process Operation and Monitoring 

Product Extract, makeDeliverable.py and bdia2ntia.py, is run within BroadMap using a platform called Hudson that 

has been enhanced to support BDIA product extraction, process monitoring, as well as product validation.  The 

same platform can be planned for implementation for the State, if desired. 

 

Below are examples of the product create, product validation, product statistics and monitoring processes which 

are managed within the BroadMap Hudson CI-System.  All of the above-mentioned python scripts, with the 

exception of metadata transactions script, are run via this system. 

 

3.10.1 BDIA Product Create 

 

Below is an example of the main page where the type of product build can be selected. 

 

 
 

Selecting based on the type of process that will be initiated. 

 

   
 

The Console Output can be reviewed to see the progress of product create.  Following the completion of each 

product creation process, an e-mail notification is automatically sent to the team.   
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All processes run via the BroadMap Hudson CI-System are stored for historical reporting.  Each process can be 

reviewed, including the Console Output and Build Artifacts from that run. 

 

 
 

3.10.2 Product Validation and Statistics 

 

Once the product creation process is complete, Product Validation and Statistics are then initiated.  These support 

the BDIA_ReleaseNotesStats.py script and the BDIA_QC_SUITES scripts detailed above. 

All statistics and reports are stored for historical review with the capability to place violation criticality on each 

quality control check allowing the identification of errors due to project status/completeness verses project 

correctness.  Example:  Typical Speeds populated. 
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Below is an example of the report provided based on various control points running over a specified time period: 

 
 

Similar to the Product Create process, all results from the process are maintained:  

 
 

Results are then reviewed manually to ensure no errors reported are critical or in violation of the NTIA data model 

or project completion statements.  Any errors of concern are communicated ahead of product delivery and 

included within the product release notes. 

Further detail on the Hudson CI System environment can be found by navigating to the following link: 

http://wiki.hudson-ci.org/display/HUDSON/Meet+Hudson 

 

http://wiki.hudson-ci.org/display/HUDSON/Meet+Hudson
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3.11 Product Extract Data Delivery 

Product delivery for MapConnect Broadband is handled two ways, depending on client requirements: 

1) State Submittal 

a) Data is submitted via SFTP site 

b) Product Release Notes and QC Test Report accompanies the delivery 

2) NTIA Submittal 

a) Directions for using the NTIA State Broadband Data file submission tool 

b) Go to the following WWW web site: https://esupport.fcc.gov/statedata  

c) Enter your username and password as provided to you from the NTIA program administrator. 

 

 
 

d) Click in Upload a file field 

e) Browse to local file for submission using the ‘Browse’ button.  Select file then select ATTACH FILE. 

 

https://esupport.fcc.gov/statedata
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f) Logout / Receipt using the Logout button in the Top Right of the screen 

g) A receipt of submission is emailed to username e-mail address 
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Methodology Guidance 
 
The white paper should:  
1. Effectively describe the deliverable data;  
2. Effectively describe the data collection process;  
3. Effectively describe the verification process.  
 
 

1. Data Description Provide a general description / summary of data submission including 
file names and a brief description of each dataset.  
 
Contents of the data submission folder: 

 
1. Final Geodatabase (HI_SBDD_2011_04_01.gdb) 

Description:  This data submission follows FCC/NTIA guidelines including Metadata for the 
project. 
 
The SBDD File Geodatabase contains the following layers: 

BB_Service_Address          12  Records 
BB_Service_Road_Segment 25,539  Records 
BB_Service_CensusBlock 14,980 Records 
BB_Service_CAInstitutions   1,031 Records 
BB_Service_Wireless            9 Records 
BB_Service_Overview            0 Records 
BB_ConnectionPoint_LastMile      110 Records 
BB_ConnectionPoint_MiddleMile        1 Records 

 
2. Submission Receipt (HI_2011_3_29.txt) 

Description: This is the submission receipt from the NTIA receipt tool. 
 

3. Technical Appendix (PDC_Deliverable_Notes_04012011.pdf) 
Description:  This is a PDC document that delineates omissions from the data deliverable 
resulting from the application of NTIA business rules and any other errors encountered in 
the file geodatabase. 
 

4. Data Package (HI_DataPackage_2011_04_01.xlsx) 
Description:  This is the NTIA “datapackage.xls” spreadsheet that is used to document the 
data submission. 
 

5. Whitepaper (HI_WhitePaper_2011_04_01.pdf) 
Description:  This is the methodology guidance document requested by NTIA to document 
the data submission. 
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2. Provider Participation Provide a summary of provider cooperation (datapackage.xls).  
 

The project team has been collecting and processing broadband data from ten (10) providers 
(Oceanic Time Warner Cable, Hawaiian Telcom Communications, Inc., Clearwire Corp., TW 
Telecom Holdings, Inc., Verizon Communications, Inc., Sprint Nextel, AT&T Inc., MOBI PCS, T-
Mobile USA, Inc., and Sandwich Isles Communications, Inc.). These ten (10) providers account for 
the overwhelming majority of actual broadband subscribers in Hawaii. The project team has 
identified an 11th provider as Pacific Light Net, Inc. dba/Wavecom Solutions, but the team has 
not yet received any data from Pacific Light Net, Inc. 
 
Hawaii Department of Commerce and Consumer Affairs (“DCCA”) has encountered challenges in 
fully executing NDAs with providers and subcontracts under the grant.  This has affected the 
signing of certain NDAs with data providers as well as subcontracts dealing with data processing 
and delivery.  Subsequently, throughout this term, DCCA has experienced some delays in 
obtaining necessary information.  However, to-date DCCA has been able to process data 
representing the overwhelming majority of broadband providers in the State of Hawaii. – DCCA 
continues to overcome these challenges through cooperation between the parties and improving 
process expediency.  Seven (7) of the eleven (11) Providers identified have executed 
confidentiality agreements for data sharing. 
 
Hawaiian Telcom Communications, Inc. and Oceanic Time Warner Cable: Last-mile and middle-
mile facility capacity and more specifically backhaul from the facilities has been deemed 
proprietary.  Further, providers maintain that they do not have information documented in a 
form that they would be able to easily provide.  No information regarding this has been shared 
to-date by these providers.  DCCA is working to compel these Providers to furnish more detailed 
information. 

 
New Data from T-Mobile USA, Inc. did not arrive in time to include in the Spring 2011 data 
delivery package and will be included in the next data delivery.  Hawaiian Telcom 
Communications, Inc., Oceanic Time Warner Cable, Clearwire Corp., and Sprint Nextel did not 
provide New Data updates for the Spring 2011 data delivery. 
 
The project team continues to verify these coverage areas and broadband speed claims as well 
as to collect data from other providers as they are identified. 
 
The most recent iteration of updated and verified mapping data was submitted to NTIA on April 
1, 2011 in accordance with the latest FCC/NTIA broadband data model. 

 
3. Data Collection and Integration 

a. Primary Data Collection Describe the data collection process and list any surveys 
distributed to retrieve data.  
Data was obtained by working with Providers (phone conference calls and email) to get 
the latest information at the most detailed level possible.  The team furnished Providers 
with a data request including the latest table specifications via email that included the 
specific information needed for the project.  Two (2) Providers submitted address level 
detail (TW Telecom Holdings, Inc. and MOBI PCS) and one Provider submitted Tax Map 
Key (TMK/Parcel) level detail (Sandwich Isles Communications, Inc.).  All other terrestrial 
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broadband Providers maintained census block level detail.  Wireless providers submitted 
RF propagation polygons illustrating coverage. 
 
Broadband coverage data for Hawaiian Telcom Communications has been extrapolated 
as a three-mile buffer from each Central Office location.  For every other provider, the 
DCCA has obtained census block level information and coverage footprints from the 
wireless providers.  Since the data is being provided at the census block level or via a 
coverage footprint from wireless providers, exact levels of service provided within these 
boundaries has been limited to a single tier of service per census block or wireless 
footprint.  TW Telecom has furnished customer addresses which have been geocoded 
and inserted into the FCC file geodatabase model as appropriate. 
 
The project team is requesting TMK and address level detail from all Providers prior to 
the next data submission.  For wireless providers, the project team is requesting more 
detailed RF propagation maps, tower locations, and greater detail on wireless service 
coverage and technology.  Further, the project team will be analyzing and adjusting 
existing census block data to fit within TMK boundaries in an effort to increase the 
accuracy of the stated data coverage areas for use on the State’s broadband website 
and for planning purposes. 
 

b. Community Anchor Institutions Summarize Community Anchor Institutions by type, 
describe your data collection process, and list any surveys distributed to retrieve 
data.  
The baseline Community Anchor Institutions database has been amended, updated and 
verified.  The Community Anchor Institutions database is composed of 1031 points that 
include: 
 227 Schools – K through 12 
   56 Libraries 
 212 Medical/Healthcare 
   95 Public Safety 
   44 Universities, Colleges, other Post-Secondary 
 397 Other Community Support – Nongovernmental (Hotels) 
 
The data was collected from various State databases (i.e. Schools, Libraries, Public 
Safety), and from InfoUSA data downloads.  Data was verified by personal telephone 
calls and information collected from websites.  No surveys were distributed.  The project 
team plans to include restaurant lounges, malls and coffee shops with advertised free 
Wi-Fi in the next deliverable, as well as, continue with telephone verification to obtain 
more information from CAI’s.  Thus far, all CAI’s contacted have been very cooperative in 
providing information. 

 
4. Validation  

 
a. Overview Provide a general summary of the validation process and methodology 

used. – See Below. 
b. Business Logic Rules Define the business logic related to data validation including a 

clear structure or methodology used. – See Technical Appendix. 
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c. Feedback Loop Describe any outreach to Broadband Providers after you processed 
their data. – Working with Providers on an ongoing basis to rectify data including the 
provision of coverage maps. 

d. Statistical Models List and describe any statistical models used to compile and 
analyze the data. – None used to date. 

e. 3rd Party Publicly Available Data Identify all 3rd party datasets used and describe how 
they were used to validate the data. (3rd party datasets include American Roamer, 
Form 477, Form 325, etc. – Info USA. 

f. Crowd Sourced Data Identify whether or not crowd sourced data was used and how 
the data was used for validation. – Hawaii broadband website Ookla tools and FCC 
Ookla/MLabs speed test results are being collected on a monthly basis. 

 
The project team is implementing the following verification activities: 

• Coverage Verification via Website: DCCA launched a dedicated website 
(hibroadbandmap.org) that contains the latest information on the project as well as a 
speed and line test application and database for consumers to use. Additionally, 
consumers are able to report unserved areas on the website. – December 1, 2010. 

• CAI Verification by Telephone:  DCCA will independently verify access to broadband 
services by Community Anchor Institutions ("CAI") where no data currently exists via 
personal contact by telephone. – April 1, 2011. 

• CAI Verification by External Data Source Comparison: The project team will be collecting 
data from InfoUSA to verify the completeness of the CAI inventory. – April 1, 2011. 

• Provider Verification via Map Products: DCCA will present the data to the individual 
providers in the form of a map product, ask them to verify the results visually, and, if 
necessary, ask them to provide more accurate information if available. – April 1, 2011. 

• Speed Test Verification via Website:  DCCA will announce the speed and line test 
application and website for consumers via press releases and newspaper articles to 
encourage subscriber participation.  The database will be maintained throughout the 
course of the project. – May 1, 2011. 

• Speed Test Verification via FCC Ookla/MLabs:  FCC databases are being collected on a 
monthly basis and integrated into a coverage verification layer that will also appear on 
the website. – April 1, 2011. 

• Provider Verification via Website: Providers will also be able to access the maps of their 
data through a secure portal on the website. – June 1, 2011. 

 
The project team’s status on implementing the following verification activities: 

• Coverage Verification via Website: The dedicated website (hibroadbandmap.org) was 
launched on December 1, 2010 and includes a customized Ookla speed test application 
and database for consumers to use, as well as, ESRI's BBStat application. – In Progress. 

• CAI Verification by Telephone: DCCA has and will continue to verify Community Anchor 
Institution data via telephone. – In Progress. 
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• CAI Verification by External Data Source Comparison: InfoUSA data is being downloaded 
to augment and verify the completeness of the CAI inventory. – In Progress. 

• Provider Verification via Map Products: Maps that illustrate coverage gaps are being 
prepared for provider review. – In Progress. 

• Speed Test Verification via Website: The dedicated website (hibroadbandmap.org) 
launched on December 1, 2010 includes a customized Ookla speed test application and 
database for consumers to use, as well as, ESRI's BBStat application.– In Progress. 

• Speed Test Verification via FCC Ookla/MLabs:  FCC speed test data is also being 
integrated into an independent map layer. – In Progress. 

• Provider Verification via Website: Providers will also be able to access the maps of their 
data through a secure portal on the website. – In Progress. 

Note: These verification activities and direct updates from providers are anticipated to 
continue through the next data delivery date. 
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IOWA COVER LETTER 

 
April 1, 2011 
 
Ms. Anne W. Neville 
SBDD Grant Program Director 
National Telecommunications and Information Administration 
U.S. Department of Commerce 
1401 Constitution Avenue, NW Room 4716 
Washington, DC 20230 
 
Dear Ms. Neville: 
 
It is with highest regard that the collective stakeholders of Connect Iowa offer congratulations to the 
U.S. Department of Commerce’s National Telecommunications & Information Administration 
(NTIA) on the recent release of the National Broadband Map.  This extraordinary milestone 
demonstrates the intense and joint effort of the NTIA, FCC, state governments, industry, and non-
profits like Connected Nation and will serve as a key tool for the American public and policymakers 
resulting in smarter investments and targeted state and local broadband policies and programs.  We 
are proud of the role that Connect Iowa has played in creating such a powerful tool that will surely 
benefit not just Iowans, but consumers and businesses nationwide. 
 
Therefore, Connected Nation as the State Broadband Designated Entity, in partnership with the 
Iowa Utilities Board, is pleased to present this submittal of the state of Iowa’s State Broadband Data 
and Development (SBDD) Grant Program, known as Connect Iowa. 

 
These artifacts should be found to be compliant with the April 1, 2011, deadline for the semi-annual 
data update and in accordance with the terms of the July 1, 2009, Notice of Funds Availability 
(NOFA) and all subsequent clarifications pertaining to delivery of State-Level Mapping of 
Broadband Service Availability.  This packet includes: 
 
Inventory of Deliverables, Connect Iowa: April 1, 2011 
 
NOFA Requirement Data Transfer Model Data Description 
Appendix A:  1(a)(i) BB_Service_CensusBlock Broadband Service Availability of 

Facilities-Based Providers in 
Census Blocks of No Greater 
Than Two Square Miles in Area 

Appendix A:   1(a)(ii) BB_Service_RoadSegment Broadband Service Availability of 
Facilities-Based Providers by Road 
Segment in Census Blocks Larger 
in Area Than Two Square Miles 
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Appendix A:   1(b) BB_Service_Wireless Broadband Service Availability of 
Wireless Services Not Provided to 
a Specific Address 

Appendix A:   3(b) BB_ConnectionPoint_MiddleMile Broadband Service Infrastructure 
Middle-Mile and Backbone 
Interconnection Points 

Appendix A:   4 BB_Service_CAInstitutions  Community Anchor Institutions-
Listing 

Appendix A:   4 n/a Community Anchor Institutions-
Narratives 

VII.A.1(a) n/a Accuracy and Verification Report 
n/a DataPackage.xlsx Worksheets of Contact 

Information, Data Dictionary, and 
Provider Summary Table 

n/a n/a Broadband Provider Roster and 
Participation Status 

 
In addition, this data update submission should be found to be compliant with the additional 
program requirements instituted by the National Telecommunications and Information 
Administration since the time of the October 2010 SBDD data submission for the Connect Iowa 
program.  Specifically, these new requirements are: 

 
SBDD Data Transfer Model 
The submission of the broadband dataset for April 1, 2011, is contained within the SBDD 
Data Transfer Model as released on the Grantee Workspace on January 14, 2011. All efforts 
have been made to comply with formatting, domain, and metadata requirements to include 
as much information on each provider as possible.  
 
Additional Submission Guidance 
This submission also includes the updated DataPackage spreadsheet with enhanced provider 
listings as well as satisfactory outputs from the SBDD_Check toolbox to ensure fewer 
unexpected values with the submitted broadband datasets prior to federal processing for the 
National Broadband Map update. 

 
It is therefore with great pleasure that the Connect Iowa program submits this April 2011 semi-
annual data update under the State Broadband Data and Development Grant Program.  We will 
continue to implement the joint purposes of the Recovery Act and the Broadband Data 
Improvement Act (BDIA) by gathering comprehensive and accurate state-level broadband mapping 
data, developing state-level broadband maps, aiding in the development and maintenance of the  
National Broadband Map, and undertaking statewide initiatives for broadband planning. 
 
Broadband Service Availability — Provider Outreach and Verification 
 
This data update submission under the SBDD includes the participation of approximately 94.66% of 
the Iowa provider community, or 195 of 206 total providers.  Of the 195 participating providers, 50 
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supplied an update to their network or coverage area(s), while 142 have reported no change. The 
remaining 3 represent providers who previously supplied data but were non-responsive in the April 
2011 update effort; therefore their previous dataset is being put forward as part of this compilation.  
A complete roster by provider depicting participation status and contact record is contained herein.  
Of the 11 providers that are not represented in the attached datasets, 6 have either refused to 
participate in the voluntary program or have remained unresponsive to the numerous attempts at 
contact by Connect Iowa. The remaining 5 providers are currently in some form of progress toward 
data submission but were not able to either submit or verify coverage areas at the time of this 
submission.    
 
As the aforementioned roster and attached methodology documentation will attest, it is the 
collective opinion of the Connect Iowa principals that all commercially reasonable efforts were 
made to account for 100% of the known Iowa broadband provider community, pursuant to this 
semi-annual data update submission. 
 
Connect Iowa has also continued to perform broadband verification activities through several 
means. In addition to confirmation of service area(s) by each provider, Connect Iowa conducts field 
validation efforts.  To date, 59 (28.64%) providers have been validated through field verification 
activities. Additional details on verification activities are contained within the Field Validation 
Narrative. 
  
At the program’s inception, Connect Iowa launched a website to create awareness about the 
initiative. Connectiowa.org continues to serve a prominent role in the outreach and data collection 
effort.  This program asset provides a way for the general public to participate in the process by 
offering interactive tools for users to test their connection speed, submit broadband inquiries, or 
contact a program representative.   
 
As an indicator of stakeholder penetration, the Connect Iowa website encountered 3,366 unique 
visits during this reporting period (14,777 total to date for the life of the grant awarded on January 1, 
2010).  Additionally, this pronounced Web activity netted 59 broadband inquiries over this same 
reporting period (174 grant inception to date).  The website also provides the BroadbandStat 
application, which allows the consumer to confirm or dispute the coverage represented on the 
broadband inventory map. These consumer-initiated actions are facilitated through the Connect 
Iowa website and the Connect Iowa Interactive Mapping Tool (BroadbandStat) that offer the 
citizens the vehicles to provide information regarding availability in their respective service area, 
either in affirmation or contest of the reported data represented in the Connect Iowa mapping 
artifacts.  Since the initial data collection and release of corresponding maps, feedback in the form of 
broadband inquiries has allowed Connected Nation to identify additional areas that are in need of 
field validation, which is scheduled as soon as possible.  
 
Community Anchor Institutions  
 
Connect Iowa has established an ongoing mechanism for gathering data on the location and 
broadband connectivity of Community Anchor Institutions (CAI), in accordance with the data 
requirements of the SBDD NOFA Technical Appendix.   
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In conjunction with the Iowa Utilities Board, outreach was conducted during this data update 
reporting period by Connect Iowa to continue identification of existing, centralized sources for CAI 
connectivity data.  Outreach was coordinated to distribute the CAI survey to institutions throughout 
the state through multiple methods including a customized online survey available on the Connect 
Iowa website.  Connect Iowa continues to work in close coordination with statewide associations 
such as the Iowa League of Cities, Iowa Association of Counties, and the State Library of Iowa to 
promote the importance of broadband connectivity at anchor institutions and participation in this 
data collection process.  
  
While we continue to document institutions and the related addresses, the connectivity data 
collected in most categories remains incomplete at this time.  Connect Iowa will be implementing a 
number of new processes to increase participation including launching a CAI newsletter to connect 
communities across the state, increasing industry-specific planning to target new community 
contacts, and revising the CAI portion of our website to increase visibility and content.  From our 
work in Connect Iowa, as well as other states, we recognize the great value of this data to future 
collaboration efforts within the state and its value to the recently released National Broadband Map.  
We plan to continue to bring best practices to the Connect Iowa efforts, along with an investment 
of both human and technical resources required to reach our goal of increasing the data that is 
secured and reported as part of this process. 
 
In acquiring both broadband availability and CAI data within the state of Iowa, Connected Nation 
has previously engaged the one federally recognized tribal land in the area covered by the Connect 
Iowa SBDD grant and reported the outreach to the Sac & Fox Tribe of the Mississippi as part of 
past submissions.  Throughout the next reporting period Connect Iowa plans to engage directly with 
this tribal community and will also conduct affirmative outreach within the area.  Connect Iowa 
understands the connectivity challenges facing this tribe, and we have identified a need to include its 
data as part of our upcoming submissions. 
 
The Connect Iowa program exists to improve data on the deployment and adoption of broadband 
services and to assist in the extension of broadband technology across all regions of the great state 
of Iowa, as well as the United States through contribution to the National Broadband Map.  We 
look forward to the continuing work ahead. 
 
 
 
Respectfully submitted, 
 
 
 
Thomas W. Ferree 
Chief Operating Officer 
Connected Nation, Inc. 

dclark
Cueball
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DATA ACQUISITION:  IOWA COMMUNITY ANCHOR INSTITUTIONS  

In this third reporting period of the SBDD, Connect Iowa, working in close coordination with the 
Iowa Utilities Board, has established an ongoing mechanism for gathering data on the location and 
broadband connectivity of Community Anchor Institutions (CAI), in accordance with the data 
requirements of the SBDD NOFA Technical Appendix.  During this reporting period Connect 
Iowa has continued to focus efforts on conducting outreach and raising awareness of this important 
project. 
 
Connect Iowa has continued to identify and process CAI data obtained through an ongoing 
statewide outreach campaign.  Physical address information continues to be augmented through 
manual sourcing and geocoded by Connect Iowa through ESRI ArcGIS software. 
 
Connect Iowa continues to utilize a customized online survey hosted through SurveyMonkey, with a 
landing page on the Connect Iowa website that was developed during the first reporting period.  
This survey, in combination with a customized data gathering spreadsheet, was distributed to a 
targeted list of CAI throughout the state.  Connect Iowa will continue to use these data gathering 
tools for future targeted outreach efforts throughout the coming months leading up to the next 
reporting period.  These materials are customized to fit the CAI categories as defined in the SBDD 
NOFA.   
 
The survey can be accessed at this link using the following password: 
http://connectiowa.org/mapping/Community_Anchor_Institution_Data_Collection.php 
Password: CAI_IA_3654 
 
Connect Iowa and the Iowa Utilities Board have worked closely during this reporting period to 
conduct research as part of an ongoing process to identify existing, centralized sources for CAI 
connectivity data.  Locating centralized connectivity data in the state remains a challenge but 
outreach continues to sources who may have possession of this data and Connect Iowa is seeing 
progress toward securing and reporting this data during the coming months. 
 
In tandem with these efforts to identify existing data, Connect Iowa continues to identify key CAI 
contacts among all CAI categories in an effort to distribute and promote the online survey and raise 
awareness of the importance of CAI broadband connectivity. Survey response during this reporting 
period has been slow but increased coordination will be occurring in the coming months with 
associations throughout the state including the State Library of Iowa, Iowa Hospital Association, 
Iowa Department of Education, Iowa League of Cities, and the Iowa State Association of Counties.  
Connect Iowa is confident that survey results will increase over the coming months as updates 
surrounding the project are provided to these associations and their members.  
  
Connect Iowa has an ongoing mission to educate CAI throughout the state on the importance of 
participating in the project.  Participation by these institutions will raise awareness about the 
importance of broadband connectivity and the need to report the requested data for inclusion on the 
National Broadband Map.  To assist with our data collection efforts, Connect Iowa is developing a 
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CAI newsletter to be distributed quarterly beginning in April 2011.   The newsletter will highlight a 
CAI in Iowa, encourage institutions to share their data, and highlight the National Broadband Map. 
 
The greatest challenge with collecting this data continues to be the difficulty in securing CAI 
broadband connectivity data. Connect Iowa will continue its ongoing work with the Iowa Utilities 
Board and key organization contacts in an effort to raise awareness of this project among CAI.  An 
update on our current data will be provided to the Iowa Broadband Deployment Governance 
Board, and participation by its members to assist with promoting our survey will be encouraged.  
Leading up to the next reporting period, Connect Iowa will be specifically focusing on contacts in 
the education and healthcare sectors in an effort to increase data in these categories. 
 
A CAI summary of all processed and submitted data is provided below: 
 

CAI Type Total 
Physical 
Address Lat/Long

Technology 
of 

Transmission
Download 

Speed 
Upload 
Speed 

K-12 Schools 1,865 1,865 1,865 122 122 124
Libraries 588 588 588 316 405 233
Healthcare 149 149 149 41 40 39
Public Safety 1,222 1,222 1,221 78 70 72
Higher Ed Institutions 77 77 77 30 30 30
Other Government 700 700 700 315 260 294
Other Non-Government 3 3 3 3 3 3
Total 4,604 4,604 4,603 905 930 795
 
 
SBDD DATA SUBMISSION METHODOLOGY 

The submission of the broadband dataset for April 1, 2011, is contained within the SBDD Data 
Transfer Model and additional components as released on the Grantee Workspace on January 14, 
2011. Connected Nation has reviewed all literature that relates to the release and use of this data 
transfer model and recognizes that it does not replace or dictate how data is stored, processed, or 
displayed for the state or territory, as it is meant primarily as a means to transfer the broadband data 
from all states and territories and populate the National Broadband Map in a seamless fashion. 
Guidance from the Technical Mapping Guide, as released on the Grantee Workspace on March 24, 
2011, was also followed to ensure the completeness and validity of the submission through 
completion steps and checklists, completing the DataPackage spreadsheet, uploading broadband 
datasets into the Data Transfer Model, and checking the dataset using the SBDD_CheckSubmission 
receipt process.  
 
In addition to the narratives and methodologies contained herein, as well as the DataPackage.xls 
containing contact information, the data dictionary, and a provider summary table, the following 
feature classes are submitted within the SBDD Data Transfer Model for the state of Iowa. 
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Inventory of Deliverables, Connect Iowa: April 1, 2011 
 
NOFA Requirement Data Transfer Model Data Description 
Appendix A:  1(a)(i) BB_Service_CensusBlock Broadband Service Availability of 

Facilities-Based Providers in 
Census Blocks of No Greater 
Than Two Square Miles in Area. 

Appendix A:   1(a)(ii) BB_Service_RoadSegment Broadband Service Availability of 
Facilities-Based Providers by Road 
Segment in Census Blocks Larger 
in Area Than Two Square Miles. 

Appendix A:   1(b) BB_Service_Wireless Broadband Service Availability of 
Wireless Services Not Provided to 
a Specific Address. 

Appendix A:   3(b) BB_ConnectionPoint_MiddleMile Broadband Service Infrastructure 
Middle-Mile and Backbone 
Interconnection Points. 

Appendix A:   4 BB_Service_CAInstitutions  Community Anchor Institutions-
Listing. 

 
The provider data collected by Connected Nation on behalf of the state of Iowa have been 
formatted per the given specifications and uploaded into the appropriate feature classes of the 
SBDD Data Transfer Model. Wireline availability is contained within census blocks and road 
segments, wireless availability is contained as polygons of coverage areas, and middle-mile 
connections and community anchor institutions are contained as point data. All speed data is 
contained at the census block, road segment, or wireless polygon level of availability. All efforts have 
been made to comply with formatting, domain, and metadata requirements to include as much 
information as possible.  
 
Connected Nation has continued outreach to satellite providers on their availability, technology, and 
speed information, but it is not included in this submission dataset.  Additional information is 
necessary to be able to show where service satisfactorily exists in the state, rather than submitting 
the entire boundary of the state as the serviceable area.  Analysis information distributed and 
discussed with the satellite providers, as well as any additional guidance from the Program Office on 
the desired analysis for satellite-serviceable areas, will be implemented for the October 2011 data 
submission.  
 
 
IOWA FIELD VALIDATION NARRATIVE 

Connected Nation focused a portion of its time on specific validation processes such as: 
 

• conducting random spectrum analysis studies throughout the state using an Avcom PSA-37-
XP spectrum analyzer; 
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• conducting mobile speed tests throughout the state using an iPhone, Android (or other 
smart phone) as well as provider-specific aircards (Sprint 3G/4G, Clearwire et al); 

• identifying pre-selected, provider-submitted wireless transmit tower sites and cross-
referencing data about that tower against the Federal Communications Commission (FCC) 
databases such as Antenna Structure Registration and/or the Universal Licensing System; 

• cross-referencing Federal Registration Number data against available FCC Form 477 data as 
well as the FCC COmmission REgistration System (CORES); 

• validating provider submitted data (for example: latitude/longitude) using a handheld 
Garmin eTrex Summit GPS unit or GPS enabled software such as Microsoft Streets and 
Trips; 

• locating physical wire-line attributes (such as remote terminals, CATV plant, etc.) and 
comparing them against provider submitted data; and 

• conducting on-net and off-net speed tests using the FCC portal at 
http://www.broadband.gov/qualitytest/about/ or using the Ookla Net Metrics enabled 
speed test utility located on each of Connected Nation’s state specific websites. 

 
Additionally, Connected Nation cross-referenced numerous public documents in order to ensure 
that all known broadband providers were located and contacted.  This included searching 
membership logs from the trade associations (WISPA, WCAI, PCIA, etc.), the Cable Television Fact 
Book, Public Utility Commission records, Public Service Commission records, Chamber of 
Commerce, etc. 
 
To date Connected Nation’s staff conducted on-site validation tests in Iowa on the following 
providers:  AT&T Inc., Brooklyn Mutual Telecommunications Cooperative, Cable ONE Inc., Cedar 
Falls Utilities, Chat Mobility, Circle Computer Resources, Citizens Mutual Telephone Cooperative, 
Cloudburst_9, Community Cable Television Agency of O’Brien County, Cramer, IT, Danville 
Mutual Telephone Company, Dynamic Broadband, East Buchanan Telephone Cooperative, Evertek 
Enterprises, Farmers & Merchants Mutual Telephone Company, Farmers Cooperative Telephone 
Company-Dysart, Farmers Mutual Telephone Company-Jesup, Farmers Telephone Company-Essex, 
FiberComm LC, Frontier Communications Corporation, Grand River Mutual Telephone 
Corporation, Grundy Center Municipal Utilities, Heartland Net, Hot Spots, I-35 Telephone 
Company, Internet Consulting Services LLC, Iowa Telecom, Kalona Cooperative Telephone 
Company, KDSC Inc., LaPorte City Telephone Company, Lenox Municipal Utilities, Long Lines, 
Mahaska Communications Group, Mediacom Iowa LLC, Mediapolis Telephone Company, 
MidlandsNet LLC, Minburn Communications, Mutual Telephone Company, Mutual Telephone 
Company of Morning Sun Iowa, NetConx, Northern Iowa Telephone Company, Panora 
Communications Cooperative, Partner Communications Cooperative, Prairie iNet, Premier 
Communications, Qwest Corporations, Sharon Telephone Company, SpeedNet LLC, Sprint, T-
Mobile USA, Traer Municipal Utilities, Van Buren Telephone Company Inc., Verizon 
Communications Inc., Villisca Farmers Telephone Company, Walnut Telephone Company, 
Wellman Cooperative Telephone Association, West Liberty Telephone Company, Western Iowa 
Telephone Association, and Woolstock Mutual Telephone. 
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During this reporting period, Connected Nation conducted 4 additional on-site validation tests with 
Citizens Mutual Telephone, Farmers Mutual Cooperative Telephone Company, Northern Iowa 
Telephone Company, and MidlandsNet LLC. 
 
From program initiation through this reporting period, Connected Nation has completed in-the-
field validation testing against 59 companies (out of a universe of 206 viable providers) totaling 
28.64% within the state of Iowa.  
 
 
ACCURACY AND VERIFICATION:  METHODOLOGY - PROVIDER VALIDATION 

Broadband providers maintain their service area data in many different formats, all in varying levels 
of complexity and granularity. In order to ensure that the data required by the NTIA is standardized 
across all providers and that it is as accurate as possible, Connected Nation translates and formats 
the data that providers are able to supply into a GIS shapefile and produces maps for the provider to 
review.  The resulting map(s) and review process allow for providers to see their service area in a 
geographic format – for some providers, this is the first time they have seen maps of their 
broadband service area. Having the mapped service area allows providers to quickly identify any 
issues that appear in the data representation, whether the issue is in the data translation into a GIS 
format or from the original data collection and submission. Often data is provided from various 
sources and through the review and revision process, local engineers who operate the networks and 
work in the field are able to ensure that the tabular data that has been submitted is accurate and 
represents the real-world network extent. Any issues in how the service area is represented on the 
map(s) are remedied by Connected Nation, whether they are additions, removal of service, or any 
other revisions. Revised maps of service area representations are sent to the provider for review and 
approval; Connected Nation will revise data and return maps as many times as necessary until the 
provider is in agreement that the map represents their service area as accurately as possible. Once 
the review process has been completed and final approval of the data is provided, the data is deemed 
ready for NTIA submission. 
 
Once the data collection has been aggregated a statewide level, static maps of statewide and county-
level availability are produced and made publicly available. In addition, consumers can visit the 
interactive online tool, BroadbandStat, to create customized views of broadband service areas and 
analyze corresponding demographic information. Leveraging broadband service data on various 
platforms allows for public users, providers, and other stakeholders to review, scrutinize, and 
provide feedback on the represented data. This feedback becomes a validation method in itself as 
consumers submit inquiries to Connected Nation either affirming where service is not available or 
identifying areas where broadband service is shown on the map, but in actuality is not available. This 
allows for a follow-up to providers regarding revisions to the data as it is represented; it also allows 
for Connected Nation to identify locations where on-site visits may be necessary to complete field 
validation of available services. Public feedback on all forms of mapping products serves as a 
localized validation method for provider-supplied information and allows Connected Nation to 
resolve inaccuracies as they are identified to ensure that only the highest quality information is 
provided to stakeholders. 
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Estimates derived from provider-validated data indicate that approximately 3.17% of Iowa 
households do not have terrestrial fixed broadband service available, and approximately 0.04%1 of 
Iowa households have neither mobile nor fixed broadband service available.2   
 
Within rural areas of the state, results derived from provider-validated data indicate that 
approximately 5.58% of rural Iowa households do not have terrestrial fixed broadband service 
available, and approximately 0.06%3 of rural Iowa households have neither mobile nor fixed 
broadband service available.4   
 
 
WIRELESS METHODOLOGY 

 
Broadband Service Availability in Provider’s Service Area 

Wireless Services Not Provided to a Specific Address 
 
Data solicited from a fixed wireless provider to create propagation models include, but are not 
limited to: 

1. The name of the structure 
2. Whether the transmitting device is operational or proposed 
3. The maximum advertised downstream speed, the maximum advertised upstream speed 
4. The typical downstream speed, the typical upstream speed (peak periods for both) 
5. The frequency range of spectrum being used (as prescribed by NTIA) 
6. The primary population center(s) being served (for geopolitical boundary reference) 
7. The physical address of the transmit site (in the event latitude/longitude is unavailable from 

the provider this allows a quick reference point for geocoding) 
8. Latitude in either Degrees, Minutes and Seconds and/or in Decimal Degrees (typically 

received as NAD 27 or NAD 83)  
9. Longitude in either Degrees, Minutes and Seconds and/or in Decimal Degrees (typically 

received as NAD 27 or NAD 83)  
10. Antenna pattern (e.g. omni-directional, 180°, 120°, 90°, etc.) 
11. Azimuth of antenna (e.g. 360° with magnetic declination if known) 
12. Approximate transmit radius (in feet, miles, or kilometers) 

                                                            
1 In accordance with NTIA’s definition of available broadband service as specified in the SBDD NOFA, this estimate 

includes both terrestrial fixed and mobile broadband service, if the service offers download speeds of at least 768 Kbps 
and upload speeds greater than 200 Kbps. 

2 Due to the nature of the SBDD data collection methodology as defined by the NTIA and based on both census 
block geographic units and street segment data, the estimates of broadband availability derived from provider-validated 
data may include an overstatement of the actual number of households with broadband availability.  Under the census 
block-based data collection method, a provider will typically report broadband availability for an entire census block 
whether its network is present across the whole or only a subset of that census block.  This potential overestimation at 
the census block level can be amplified as the data is aggregated across the entire state. 

3 See footnote 1. 
4 See footnote 2. 
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13. Polarity of transmit antenna (Vertical or Horizontal) 
14. Transmit antenna gain (in dBi) 
15. Line loss (applicable only to providers using coax, heliax, waveguide or other forms of 

cabling – excludes power-over-Ethernet devices) 
16. Mechanical and/or Electrical beam tilt (if applicable) 
17. Equipment Manufacturer (allows easy cross-reference against manufacturer’s specification 

sheet) 
18. Power output of the transmitting device (if unknown, FCC standards or manufacturer 

specifications are applied) 
19. AMSL at base of tower site 
20. Antenna centerline AGL (height of antenna above ground level measured at the centerline 

of the actual antenna) 
21. Foliage factors (Evergreens/Deciduous and percent of ground cover) 
22. Ground Clutter (primarily used in rural areas to account for foliage and in metropolitan areas 

to account for types and heights of buildings if known)   
23. Average gain of receive antenna 
24. Receive antenna is estimated at height above average terrain (HAAT) of 6.2 meters/20 feet 
25. Federal Registration Numbers (if applicable) which may allow opportunities to cross-

reference and/or obtain additional data from the Federal Communications Commission 
Universal Licensing System and the COmmission REgistration System 

 
Propagation modeling is an empirical mathematical formulation for the characterization of radio 
wave propagation as a function of frequency, distance, and other conditions. Propagation 
software(s) typically use the Irregular Terrain Model (also known as Longley-Rice) of radio 
propagation for frequencies between 20 MHz and 20 GHz. This model is based on electromagnetic 
theory and statistical analyses of the combination of terrain features and radio measurements, then 
predicting the median attenuation of a radio signal as a function of distance and the variability of the 
signal in time and in space.  For metropolitan areas, the software can typically be adjusted to use the 
Okumura-Hata model which accounts for predicting the behavior of cellular transmissions in areas 
where buildings are the primary obstructions. The resulting product from either model depicts a 
graphical illustration of the theoretical propagation characteristics of a selected frequency range 
based on defined variables (receiver sensitivity of the home/mobile device, foliage factor, and digital 
elevation terrain input). 
 
 
BROADBAND INQUIRIES METHODOLOGY 

Connected Nation collects consumer feedback in the form of broadband inquiries. These inquiries 
represent any type of communication received from the public regarding broadband service. Once 
broadband inquiries are received across the state, this information is overlaid with the broadband 
availability information which was collected through the SBDD program.  This allows for a real-
world comparison of the broadband landscape to the information received from broadband 
inquiries.  Broadband inquiries are able to provide three types of information:  1) Residents who do 
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not have broadband but want it.  2)  Residents who have broadband but want a different provider.  
3)  Residents who do not have broadband, but the broadband inventory maps indicate that they do. 
 
Through the collection of broadband inquiries, a visual demand for broadband is presented.  This 
visualization allows Connected Nation the ability to validate broadband availability maps for 
accuracy.  If residents within a region state that they are without broadband, but the broadband 
inventory maps show otherwise, this allows Connected Nation to approach the providers within that 
area in an effort to trim down their coverage to more accurately represent real-world availability on 
the ground.  On the other hand, if there is a region in the territory in which broadband is not 
available, the broadband inquiries allow providers close to that region to see where they can 
successfully expand their broadband networks, leading to a high return on investment.  In short, the 
higher number of inquiries leads to a higher level of certainty in regard to the broadband availability 
maps.  Since the initial data collection and release of corresponding maps, feedback in the form of 
broadband inquiries has allowed Connected Nation to identify additional areas that are in need of 
field validation, which are scheduled as soon as possible. Additional information on field validation 
can be found in the Field Validation Narrative. 
 
The broadband inquiry process has been implemented in each of the Connected Nation state 
programs with successful results. Altogether Connected Nation has received over 16,000 broadband 
inquiries since 2007, allowing the state programs to evaluate each inquiry for broadband demand and 
data verification.  These inquiries are continuously examined against current broadband availability, 
updated every six months, to determine if previously unserved households have been expanded to 
and can now receive broadband at their residence. This database of broadband inquiries has also 
allowed the Connected Nation state programs to aggregate demand in concentrated areas to show 
providers the exact locations where the population has made it clear that they would purchase 
broadband if it was made available to them. Providers in the states have responded to this process 
and have expanded to areas knowing that their investment will be worthwhile. Data verification 
methods have also proven successful, as the state programs have been able to show those inquiries 
that indicate the broadband service areas are misrepresented on the map to providers, who then 
verify where service cannot reach in regard to that residence(s). The broadband coverage in these 
states has been altered to create a more accurate map based on the inquiries submitted by the public. 
 
During this reporting period, the Connect Iowa project has received a total of 59 inquiries (174 grant 
inception to date).  As more inquiries are submitted to Connect Iowa, a more thorough validation of 
the broadband landscape can be performed, while also allowing providers to see which areas have a 
high demand for broadband adoption. 

 

BROADBANDSTAT METHODOLOGY  

BroadbandStat is an online, interactive mapping tool for viewing, analyzing, and validating 
broadband data. Developed through a partnership with ESRI, the market leader in geographic 
information system (GIS) software, BroadbandStat is a multi-functional, user-friendly way for local 
leaders, policymakers, consumers, and technology providers to devise a plan for the expansion and 
adoption of broadband.  



 
 

                                          Connect Iowa – Narratives and Methodologies 
 

 

 
April 1, 2011                   Page 15 
 

First and foremost, BroadbandStat allows consumers to locate their residence and identify providers 
that offer broadband Internet service to that location. The interactive platform allows for users to 
build and evaluate broadband expansion scenarios using a wealth of data, including education and 
population demographics, broadband availability, and research about the barriers to adoption.  
 
New functionality in BroadbandStat allows the consumers to provide feedback on the broadband 
data displayed on the interactive map.  Through the collection of this feedback, a visual demand for 
broadband is presented.  This visualization allows the Connected Nation state programs the ability 
to validate the broadband availability for accuracy.  If residents within a region state they are without 
broadband, but the interactive map shows otherwise, this allows Connected Nation to approach the 
providers within that area in an effort to trim down their coverage to more accurately represent real-
world availability on the ground.   
 
The Connect Iowa project launched BroadbandStat on June 18, 2010, and has received a total of 
5,200 visits to date, of which 1,002 occurred this reporting period. 
 
 
SPEED TEST METHODOLOGY 

The 784 speed tests that are represented in the Connect Iowa Speed Test Report during this 
reporting period (3,187 grant inception to date) are the result of a partnership between Connected 
Nation and Ookla Net Metrics. Utilizing this relationship increases the level of confidence in the 
data being collected and provides for a far greater sample size than could be collected by a single 
testing site. 
 
Ookla owns and operates Speedtest.net, as well as develops and deploys speed tests, such as the 
Connect Iowa speed test website, for partners around the world. This network of sites that is 
developed and run on its testing technology provides Ookla with a vast dataset that, due to the 
variability of geographic information collected across the varying speed test sites, is geocoded 
utilizing Geo-IP technology. This technology allows for tests to be geocoded to points of 
aggregation, typically larger nodes across provider networks.  While there are hundreds of thousands 
of tests that have been conducted, the level of aggregation is only sufficient for county-level detail 
due to the test results being located at these larger nodes and not at an absolute location for each 
speed test. 
 
In an effort to validate broadband data from the Connect Iowa project, speed test information is 
collected throughout the state.  Speed tests provide speed information on the path taken through all 
networks (a provider’s network as well as additional networks) a local machine must connect to in 
order to reach the host test.  The benefit of this collection of speed information is two-tiered.  First, 
it allows for a comprehensive dataset of speeds, while also providing Connect Iowa with the 
information on where broadband services are available.  Second, unlike theoretical speed 
information which was received through the data collection process, the use of speed tests provide 
real-world information on the speeds that currently exist within the state of Iowa.   



Complete 337
Non-Responsive/Refused 10
In Progress 18

Count of Datasets by Viable Status 365
Total Unique Providers Represented 206

Provider Name Platform Status

NDA 
Execution 

Date Notes
Ace Telephone Association ILEC/CLEC Data Added to Statewide Inventory 3/8/2010
AT&T Inc. Mobile Wireless Data Added to Statewide Inventory 12/16/2009
Ayrshire Farmers Mutual Telephone Company ILEC/CLEC Data Added to Statewide Inventory 2/17/2010
Bernard Telephone Company, Inc. Fixed Wireless Data Added to Statewide Inventory 5/19/2010
BitWind Communications, LLC Fixed Wireless Data Added to Statewide Inventory
Brooklyn Mutual Telecommunications Cooperative ILEC/CLEC Data Added to Statewide Inventory 4/21/2010
Cable ONE Inc. Cable Data Added to Statewide Inventory 12/7/2009
CenturyLink ILEC/CLEC Data Added to Statewide Inventory 12/4/2009
Clear Lake Independent Telephone Company Fiber Data Added to Statewide Inventory 5/6/2020
Colo Telephone Company Fiber Data Added to Statewide Inventory 1/28/2010
Eastlight, LLC Fixed Wireless Data Added to Statewide Inventory
Evertek Enterprises Fixed Wireless Data Added to Statewide Inventory 2/3/2010
Farmers Mutual Cooperative Telephone Company - Harlan ILEC/CLEC Data Added to Statewide Inventory 2/5/2010
Farmers Mutual Cooperative Telephone Company - Harlan Fiber Data Added to Statewide Inventory 2/5/2010
Farmers Mutual Telephone Company - Nora Springs Fiber Data Added to Statewide Inventory 1/26/2010
Farmers Mutual Telephone Company - Nora Springs Cable Data Added to Statewide Inventory 1/26/2010
Goldfield Access Network, L.C. ILEC/CLEC Data Added to Statewide Inventory 1/22/2010
Grand River Mutual Telephone Corporation ILEC/CLEC Data Added to Statewide Inventory 2/5/2010
Grand River Mutual Telephone Corporation ILEC/CLEC Data Added to Statewide Inventory 2/5/2010
Grundy Center Municipal Utilities Fixed Wireless Data Added to Statewide Inventory
Grundy Center Municipal Utilities Cable Data Added to Statewide Inventory
I-35 Telephone Company Fiber Data Added to Statewide Inventory 2/2/2010
Kalona Cooperative Telephone Company Fiber Data Added to Statewide Inventory 1/20/2010
Leap Wireless International, Inc. Mobile Wireless Data Added to Statewide Inventory 4/6/2010
Lehigh Valley Cooperative Telephone Association Fiber Data Added to Statewide Inventory 4/16/2010
Loganet Fixed Wireless Data Added to Statewide Inventory
Martelle Cooperative Telephone Association ILEC/CLEC Data Added to Statewide Inventory 5/5/2010
Massena Telephone Company ILEC/CLEC Data Added to Statewide Inventory 6/18/2010
MidIowa Net ILEC/CLEC Data Added to Statewide Inventory
MidIowa Net Fixed Wireless Data Added to Statewide Inventory
Midwest Broadband LLC Fixed Wireless Data Added to Statewide Inventory 7/6/2010
Minburn Communications Fiber Data Added to Statewide Inventory 4/7/2010
Minburn Communications ILEC/CLEC Data Added to Statewide Inventory 4/7/2010
Minburn Communications ILEC/CLEC Data Added to Statewide Inventory 4/7/2010
Minburn Communications Fiber Data Added to Statewide Inventory 4/7/2010
Monarc Technologies Fiber Data Added to Statewide Inventory 2/16/2011
Mutual Telephone Company Fiber Data Added to Statewide Inventory 1/25/2010
NetConx Fixed Wireless Data Added to Statewide Inventory 4/6/2010
New Ulm Telecom, Inc. ILEC/CLEC Data Added to Statewide Inventory 3/10/2010
Northwest Telephone Cooperative Association ILEC/CLEC Data Added to Statewide Inventory 2/17/2010
Preston Telephone Company ILEC/CLEC Data Added to Statewide Inventory 2/5/2010
Qwest Corporation ILEC/CLEC Data Added to Statewide Inventory 1/4/2010
South Slope Cooperative Telephone Company Fiber Data Added to Statewide Inventory 2/2/2010
SpeedNet, LLC Fixed Wireless Data Added to Statewide Inventory
Spencer Municipal Utilities Cable Data Added to Statewide Inventory 2/18/2010
Spencer Municipal Utilities Fiber Data Added to Statewide Inventory 2/18/2010
Sprint Nextel Corporation Mobile Wireless Data Added to Statewide Inventory 1/14/2010
T-Mobile USA, Inc. Mobile Wireless Data Added to Statewide Inventory 1/8/2010
United States Cellular Corporation Mobile Wireless Data Added to Statewide Inventory 2/15/2011
Van Horne Cooperative Telephone Company Fiber Data Added to Statewide Inventory 5/18/2010
Verizon Communications, Inc. Mobile Wireless Data Added to Statewide Inventory 12/14/2009
Walnut Telephone Company Cable Data Added to Statewide Inventory 4/14/2010
Walnut Telephone Company Fiber Data Added to Statewide Inventory 4/14/2010
Walnut Telephone Company ILEC/CLEC Data Added to Statewide Inventory 4/14/2010
Webster-Calhoun Cooperative Telephone Association Fiber Data Added to Statewide Inventory 5/21/2010
West Iowa Telephone Company ILEC/CLEC Data Added to Statewide Inventory 1/27/2010
West Liberty Telephone Company Fiber Data Added to Statewide Inventory 1/25/2010
Woolstock Mutual Telephone Fixed Wireless Data Added to Statewide Inventory 5/19/2010
CenturyLink Backhaul Backhaul Provider Only Processing Complete 12/4/2009
Cogent Communications, Inc. Backhaul Backhaul Provider Only Processing Complete
Level 3 Communications, LLC Backhaul Backhaul Provider Only Processing Complete 12/14/2009
Mediacom Iowa, LLC Backhaul Backhaul Provider Only Processing Complete 1/12/2010
McLeodUSA Telecommunications Services, Inc. ILEC/CLEC Provider Approval Solicited
Ace Telephone Association Backhaul Partial Data Received 3/8/2010
Community Digital Wireless, LLC Backhaul Partial Data Received 5/6/2010
Schaller Telephone Company ILEC/CLEC Partial Data Received
East Buchanan Telephone Cooperative Fixed Wireless Provider Gathering Data 4/30/2010
360networks Backhaul No Update to Provide 1/19/2010
Algona Municipal Utilities Cable No Update to Provide 2/9/2010
Algona Municipal Utilities Fiber No Update to Provide 2/9/2010
Alliance Communications Cooperative, Inc ILEC/CLEC No Update to Provide 1/28/2010
Alliance Communications Cooperative, Inc Backhaul No Update to Provide 1/28/2010
Alliance Communications Cooperative, Inc Fiber No Update to Provide 1/28/2010
Alpine Communications, LC ILEC/CLEC No Update to Provide 2/24/2010
Alpine Communications, LC Fiber No Update to Provide 2/24/2010
Alta Municipal Utilities Cable No Update to Provide 5/18/2010
Andrew Telephone Company ILEC/CLEC No Update to Provide 1/19/2010
Arcadia Telephone Cooperative ILEC/CLEC No Update to Provide 5/6/2010
AT&T Inc. Backhaul No Update to Provide 12/16/2009
Aventure Communications Fixed Wireless No Update to Provide 4/8/2010
Aventure Communications Backhaul No Update to Provide 4/8/2010
Ayrshire Farmers Mutual Telephone Company Fixed Wireless No Update to Provide 2/17/2010
Baldwin Nashville Telephone Company, Inc. ILEC/CLEC No Update to Provide 2/3/2010
Bellevue Municipal Utilities Fiber No Update to Provide 5/20/2010
Bernard Telephone Company, Inc. ILEC/CLEC No Update to Provide 5/19/2010
Bernard Telephone Company, Inc. Backhaul No Update to Provide 5/19/2010
BEVCOMM ILEC/CLEC No Update to Provide 6/16/2010

Broadband Provider Log



Board of Water Electric & Communication Trustees of the City of 
Muscatine ILEC/CLEC No Update to Provide 5/14/2010
Board of Water Electric & Communication Trustees of the City of 
Muscatine Cable No Update to Provide 5/14/2010
Board of Water Electric & Communication Trustees of the City of 
Muscatine Fiber No Update to Provide 5/14/2010
Butler-Bremer Communications ILEC/CLEC No Update to Provide 4/20/2010
Butler-Bremer Communications Cable No Update to Provide 4/20/2010
Butler-Bremer Communications Fiber No Update to Provide 4/20/2010
Cascade Communications Company ILEC/CLEC No Update to Provide 1/23/2010
Cascade Communications Company Fiber No Update to Provide 1/23/2010
Casey Mutual Telephone Company ILEC/CLEC No Update to Provide 5/3/2010
Casey Mutual Telephone Company Backhaul No Update to Provide 5/3/2010
Cedar Falls Utilities Fiber No Update to Provide 6/16/2010
Cedar Falls Utilities Cable No Update to Provide 6/16/2010
Center Junction Telephone Company ILEC/CLEC No Update to Provide 3/12/2010
Central Scott Telephone Company, Inc. ILEC/CLEC No Update to Provide 4/22/2010
Central Scott Telephone Company, Inc. Fixed Wireless No Update to Provide 4/22/2010
Chat Mobility Mobile Wireless No Update to Provide 1/19/2010
Circle Computer Resources Fixed Wireless No Update to Provide 7/6/2010
Citizens Mutual Telephone Cooperative ILEC/CLEC No Update to Provide 2/26/2010
Citizens Mutual Telephone Cooperative Fiber No Update to Provide 2/26/2010
City of Hawarden Cable No Update to Provide 5/20/2010
Clarence Telephone Company, Inc. Fiber No Update to Provide
Clear Lake Independent Telephone Company ILEC/CLEC No Update to Provide 5/6/2020
CML Telephone Cooperative, Association of Meriden, Iowa Fiber No Update to Provide 1/25/2010
Comelec Services, Inc. Fixed Wireless No Update to Provide 5/7/2010
Communications 1 Network, Inc. Fiber No Update to Provide 4/14/2010
Community Cable Television Agency of O'Brien County Cable No Update to Provide 5/5/2010
Community Cable Television Agency of O'Brien County Fixed Wireless No Update to Provide 5/5/2010
Community Digital Wireless, LLC Fixed Wireless No Update to Provide 5/6/2010
Complete Communication Services Cable No Update to Provide 6/17/2010
Complete Communication Services Fiber No Update to Provide 6/17/2010
Coon Rapids Municipal Utilities Cable No Update to Provide 4/22/2010
Coon Valley Co-op Telephone Association, Inc. ILEC/CLEC No Update to Provide
Coon Valley Co-op Telephone Association, Inc. Fixed Wireless No Update to Provide
Cooperative Telephone Company ILEC/CLEC No Update to Provide 2/2/2010
Cooperative Telephone Company Fixed Wireless No Update to Provide 2/2/2010
Cooperative Telephone Exchange Fiber No Update to Provide 2/2/2010
Cooperative Telephone Exchange Backhaul No Update to Provide 2/2/2010
Corn Belt Telephone Company ILEC/CLEC No Update to Provide 2/15/2010
Corn Belt Telephone Company Fiber No Update to Provide 2/15/2010
Corn Belt Telephone Company Fixed Wireless No Update to Provide 2/15/2010
Cox Communications, Inc Cable No Update to Provide 1/29/2010
Cramer IT Consulting, Inc Fixed Wireless No Update to Provide 1/20/2010
Cumberland Telephone Company ILEC/CLEC No Update to Provide 4/27/2010
Cumberland Telephone Company Fixed Wireless No Update to Provide 4/27/2010
Danville Mutual Telephone Company ILEC/CLEC No Update to Provide
Dixon Telephone Company Cable No Update to Provide 5/5/2010
Dumont Telephone Company ILEC/CLEC No Update to Provide 2/25/2010
Dumont Telephone Company Fiber No Update to Provide 2/25/2010
Dunkerton Telephone Cooperative ILEC/CLEC No Update to Provide 4/15/2010
East Buchanan Telephone Cooperative ILEC/CLEC No Update to Provide 4/30/2010
Ellsworth Cooperative Telephone Association ILEC/CLEC No Update to Provide 1/25/2010
Evertek Enterprises Cable No Update to Provide 2/3/2010
Evertek Enterprises Fiber No Update to Provide 2/3/2010
F&B Communications, Inc. ILEC/CLEC No Update to Provide 2/19/2010
F&B Communications, Inc. Fixed Wireless No Update to Provide 2/19/2010
Farmers & Merchants Mutual Telephone Company Fiber No Update to Provide 5/7/2010
Farmers & Merchants Mutual Telephone Company Fixed Wireless No Update to Provide 5/7/2010
Farmers Cooperative Telephone Company-Dysart ILEC/CLEC No Update to Provide 3/12/2010
Farmers Mutual Cooperative Telephone Company - Harlan Cable No Update to Provide 2/5/2010
Farmers Mutual Cooperative Telephone Company - Harlan Fixed Wireless No Update to Provide 2/5/2010
Farmers Mutual Cooperative Telephone Company-Moulton Fiber No Update to Provide 5/21/2010
Farmers Mutual Telephone Company - Nora Springs ILEC/CLEC No Update to Provide 1/26/2010
Farmers Mutual Telephone Company - Nora Springs Fixed Wireless No Update to Provide 1/26/2010
Farmers Mutual Telephone Company of Stanton, Iowa ILEC/CLEC No Update to Provide 4/9/2010
Farmers Mutual Telephone Company of Stanton, Iowa Cable No Update to Provide 4/9/2010
Farmers Mutual Telephone Company of Stanton, Iowa Backhaul No Update to Provide 4/9/2010
Farmers Mutual Telephone Company-Jesup ILEC/CLEC No Update to Provide 4/20/2010
Farmers Telephone Company-Essex ILEC/CLEC No Update to Provide 1/27/2010
Farmers Telephone Company-Essex Fixed Wireless No Update to Provide 1/27/2010
FiberComm L.C. ILEC/CLEC No Update to Provide 2/15/2010
FiberComm L.C. Fixed Wireless No Update to Provide 2/15/2010
FiberComm L.C. Backhaul No Update to Provide 2/15/2010
Fibernet Communications, LLC Backhaul No Update to Provide 3/9/2010
Frontier Communications Corporation ILEC/CLEC No Update to Provide 1/22/2010
Frontier Communications Corporation Backhaul No Update to Provide 1/22/2010
Goldfield Access Network, L.C. ILEC/CLEC No Update to Provide 1/22/2010
Grand Mound Cooperative Telephone Association ILEC/CLEC No Update to Provide
Grand Mound Cooperative Telephone Association Fiber No Update to Provide
Grand Mound Cooperative Telephone Association Fixed Wireless No Update to Provide
Grand River Mutual Telephone Corporation Fixed Wireless No Update to Provide 2/5/2010
Griswold Cooperative Telephone Company ILEC/CLEC No Update to Provide 4/21/2010
Harlan Municipal Utilities Cable No Update to Provide 5/5/2010
Harmony Telephone Company Fiber No Update to Provide 1/12/2010
Hawkeye Telephone Company ILEC/CLEC No Update to Provide 2/12/2010
Heart of Iowa Communications Cooperative ILEC/CLEC No Update to Provide 1/7/2010
Heart of Iowa Communications Cooperative Fiber No Update to Provide 1/7/2010
Heart of Iowa Communications Cooperative Backhaul No Update to Provide 1/7/2010
Hickory Tech Corporation ILEC/CLEC No Update to Provide 2/2/2010
Hospers Telephone Exchange, Inc. ILEC/CLEC No Update to Provide 1/11/2010
Hospers Telephone Exchange, Inc. Cable No Update to Provide 1/11/2010
Hubbard Cooperative Telephone Association and Cable ILEC/CLEC No Update to Provide 5/14/2010
Huxley Communications Cooperative Backhaul No Update to Provide 1/25/2010
Huxley Communications Cooperative ILEC/CLEC No Update to Provide 1/25/2010
Huxley Communications Cooperative Fiber No Update to Provide 1/25/2010
I-35 Telephone Company ILEC/CLEC No Update to Provide 2/2/2010
I-35 Telephone Company Fixed Wireless No Update to Provide 2/2/2010
IAMO Telephone Company ILEC/CLEC No Update to Provide 1/25/2010
IAMO Telephone Company Fixed Wireless No Update to Provide 1/25/2010
ImOn Communications, LLC Backhaul No Update to Provide
ImOn Communications, LLC Cable No Update to Provide
ImOn Communications, LLC Fiber No Update to Provide
Independence Telecommunications Utility Cable No Update to Provide 4/9/2010



Internet Consulting Services, LLC Fixed Wireless No Update to Provide 5/19/2010
Iowa Connect, Inc. Fixed Wireless No Update to Provide 5/12/2010
Iowa Network Services Backhaul No Update to Provide 3/5/2010
Jefferson Telephone Company Fiber No Update to Provide 1/22/2010
Jefferson Telephone Company ILEC/CLEC No Update to Provide 1/22/2010
Kalnet Fixed Wireless No Update to Provide 5/21/2010
Kalona Cooperative Telephone Company ILEC/CLEC No Update to Provide 1/20/2010
KDSC, Inc. Fixed Wireless No Update to Provide 5/18/2010
KeyOn Communications, Inc. Fixed Wireless No Update to Provide 10/15/2009
KeyOn Communications, Inc. ILEC/CLEC No Update to Provide 10/15/2009
Keystone Farmers Cooperative Telephone Company ILEC/CLEC No Update to Provide 4/12/2010
Killduff Telephone Company ILEC/CLEC No Update to Provide
La Motte Telephone Company, Inc. Fixed Wireless No Update to Provide 2/16/2010
La Motte Telephone Company, Inc. ILEC/CLEC No Update to Provide 2/16/2010
LaPorte City Telephone Co ILEC/CLEC No Update to Provide 2/22/2010
Laurens Municipal Communications Utility Cable No Update to Provide 6/2/2010
Lenox Municipal Utilities Cable No Update to Provide 4/20/2010
LISCO Wireless Fiber No Update to Provide 1/28/2010
LISCO Wireless ILEC/CLEC No Update to Provide 1/28/2010
LISCO Wireless Backhaul No Update to Provide 1/28/2010
Lone Rock Cooperative Telephone Company ILEC/CLEC No Update to Provide 2/15/2010
Long Lines ILEC/CLEC No Update to Provide 5/4/2010
Long Lines Cable No Update to Provide 5/4/2010
Long Lines Backhaul No Update to Provide 5/4/2010
Long Lines Backhaul No Update to Provide 5/4/2010
Long Lines Backhaul No Update to Provide 5/4/2010
Long Lines Backhaul No Update to Provide 5/4/2010
Long Lines Backhaul No Update to Provide 5/4/2010
Long Lines Backhaul No Update to Provide 5/4/2010
Lost Nation-Elwood Telephone Company Fiber No Update to Provide 4/13/2010
Lynnville Telephone Company, Inc. ILEC/CLEC No Update to Provide
Mabel Cooperative Telephone Company ILEC/CLEC No Update to Provide 4/8/2010
Mahaska Communication Group Fiber No Update to Provide 5/10/2010
Mahaska Communication Group Fixed Wireless No Update to Provide 5/10/2010
Manning Municipal Communication & Television System Utility Cable No Update to Provide 4/22/2010
Manning Municipal Communication & Television System Utility Fixed Wireless No Update to Provide 4/22/2010
Marne & Elk Horn Telephone Company ILEC/CLEC No Update to Provide 2/11/2010
Marne & Elk Horn Telephone Company Fixed Wireless No Update to Provide 2/11/2010
Marne & Elk Horn Telephone Company Backhaul No Update to Provide 2/11/2010
Martelle Cooperative Telephone Association Cable No Update to Provide 5/5/2010
Massena Telephone Company Backhaul No Update to Provide 6/18/2010
Mediacom Iowa, LLC Cable No Update to Provide 1/12/2010
Mediapolis Telephone Company ILEC/CLEC No Update to Provide 4/14/2010
Miles Cooperative Telephone Association ILEC/CLEC No Update to Provide 5/17/2010
Milford Cable TV Inc. Cable No Update to Provide 4/21/2010
Minerva Valley Telephone Cablevision, Inc. ILEC/CLEC No Update to Provide 4/7/2010
Modern Cooperative Telephone Company Inc. ILEC/CLEC No Update to Provide
Mutual Telephone Company ILEC/CLEC No Update to Provide 1/25/2010
Mutual Telephone Company of Morning Sun, Iowa ILEC/CLEC No Update to Provide 5/5/2010
Mutual Telephone Company of Morning Sun, Iowa ILEC/CLEC No Update to Provide 5/5/2010
Nexgen Integrated Communications LLC Fiber No Update to Provide
Nexgen Integrated Communications LLC ILEC/CLEC No Update to Provide
North English Cooperative Telephone Company ILEC/CLEC No Update to Provide 5/12/2010
Northeast Iowa Telephone Company Backhaul No Update to Provide 4/13/2010
Northeast Iowa Telephone Company Fixed Wireless No Update to Provide 4/13/2010
Northeast Iowa Telephone Company ILEC/CLEC No Update to Provide 4/13/2010
Northern Iowa Telephone Company ILEC/CLEC No Update to Provide 1/25/2010
Northwest Telephone Cooperative Association Backhaul No Update to Provide 2/17/2010
Northwest Telephone Cooperative Association Fixed Wireless No Update to Provide 2/17/2010
Ogden Telephone Company Backhaul No Update to Provide 3/17/2010
Ogden Telephone Company ILEC/CLEC No Update to Provide 3/17/2010
Olin Telephone Company, Inc. ILEC/CLEC No Update to Provide 2/23/2010
Onslow Cooperative Telephone Association ILEC/CLEC No Update to Provide 2/3/2010
Oran Mutual Telephone Company ILEC/CLEC No Update to Provide 2/8/2010
Osage Municipal Communications Utility Fixed Wireless No Update to Provide 5/18/2010
Osage Municipal Communications Utility Cable No Update to Provide 5/18/2010
Palmer Mutual Telephone Company ILEC/CLEC No Update to Provide 1/21/2010
Palo Cooperative Telephone Association ILEC/CLEC No Update to Provide 5/19/2010
Panora Communications Cooperative Cable No Update to Provide 1/29/2010
Panora Communications Cooperative Fiber No Update to Provide 1/29/2010
Panora Communications Cooperative Fixed Wireless No Update to Provide 1/29/2010
Panora Communications Cooperative ILEC/CLEC No Update to Provide 1/29/2010
Panora Communications Cooperative Cable No Update to Provide 1/29/2010
Panora Communications Cooperative Fiber No Update to Provide 1/29/2010
Panora Communications Cooperative Fixed Wireless No Update to Provide 1/29/2010
Partner Communications Cooperative ILEC/CLEC No Update to Provide 5/15/2010
Partner Communications Cooperative Cable No Update to Provide 5/15/2010
Prairie iNet Fixed Wireless No Update to Provide 3/16/2010
Prairieburg Telephone Company, Inc ILEC/CLEC No Update to Provide 3/25/2010
Prairieburg Telephone Company, Inc Fixed Wireless No Update to Provide 3/25/2010
Premier Communications Cable No Update to Provide 1/25/2010
Qwest Corporation Backhaul No Update to Provide 1/4/2010
Radcliffe Telephone Company, Inc. Backhaul No Update to Provide 4/26/2010
Radcliffe Telephone Company, Inc. Fiber No Update to Provide 4/26/2010
Readlyn Telephone Company ILEC/CLEC No Update to Provide 2/23/2010
Readlyn Telephone Company Fiber No Update to Provide 2/23/2010
Reasnor Telephone Company, LLC ILEC/CLEC No Update to Provide
RingTel Communications ILEC/CLEC No Update to Provide 2/17/2010
River Valley Telecommunications Coop ILEC/CLEC No Update to Provide 3/23/2010
River Valley Telecommunications Coop Fiber No Update to Provide 3/23/2010
River Valley Telecommunications Coop Fixed Wireless No Update to Provide 3/23/2010
Rockwell Cooperative Telephone Association ILEC/CLEC No Update to Provide 5/12/2010
Rockwell Cooperative Telephone Association Fiber No Update to Provide 5/12/2010
Rockwell Cooperative Telephone Association Backhaul No Update to Provide 5/12/2010
Royal Telephone Company Fiber No Update to Provide 2/12/2010
Sac County Mutual Telephone Co. Backhaul No Update to Provide 2/15/2010
Sac County Mutual Telephone Co. ILEC/CLEC No Update to Provide 2/15/2010
Scranton Telephone Company ILEC/CLEC No Update to Provide 2/1/2010
Scranton Telephone Company Backhaul No Update to Provide 2/1/2010
Searsboro Telephone Company ILEC/CLEC No Update to Provide
Sharon Telephone Company Backhaul No Update to Provide 5/20/2010
Sharon Telephone Company Fiber No Update to Provide 5/20/2010
Sharon Telephone Company Fixed Wireless No Update to Provide 5/20/2010
Sharon Telephone Company ILEC/CLEC No Update to Provide 5/20/2010
Sioux Valley Wireless Fixed Wireless No Update to Provide 6/7/2010



South Slope Cooperative Telephone Company ILEC/CLEC No Update to Provide 2/2/2010
Spencer Municipal Utilities Backhaul No Update to Provide 2/18/2010
Spring Grove Cooperative Telephone Co Fiber No Update to Provide
Springville Cooperative Telephone Association, Inc. ILEC/CLEC No Update to Provide 2/15/2010
Sprint Nextel Corporation Backhaul No Update to Provide 1/14/2010
Sully Telephone Association Inc ILEC/CLEC No Update to Provide 4/28/2010
Sully Telephone Association Inc Fiber No Update to Provide 4/28/2010
Superior Telephone Cooperative ILEC/CLEC No Update to Provide 5/24/2010
Swisher Telephone Company Fiber No Update to Provide 2/2/2010
Templeton Telephone Company ILEC/CLEC No Update to Provide 3/12/2010
Templeton Telephone Company Backhaul No Update to Provide 3/12/2010
Terril Telephone Cooperative ILEC/CLEC No Update to Provide 2/12/2010
Titonka Telephone Company Backhaul No Update to Provide 5/4/2010
Titonka Telephone Company ILEC/CLEC No Update to Provide 5/4/2010
Traer Municipal Utilities Fixed Wireless No Update to Provide 4/14/2010
USA Communications ILEC/CLEC No Update to Provide 1/27/2010
USA Communications Fiber No Update to Provide 1/27/2010
USA Communications Cable No Update to Provide 1/27/2010
Van Buren Telephone Co Inc ILEC/CLEC No Update to Provide 1/26/2010
Van Horne Cooperative Telephone Company ILEC/CLEC No Update to Provide 5/18/2010
Van Horne Cooperative Telephone Company Backhaul No Update to Provide 5/18/2010
Villisca Farmers Telephone Company ILEC/CLEC No Update to Provide 5/20/2010
Walnut Telephone Company Backhaul No Update to Provide 4/14/2010
Walnut Telephone Company Fixed Wireless No Update to Provide 4/14/2010
Webb-Dickens Telephone Corporation Fiber No Update to Provide 1/25/2010
Wellman Cooperative Telephone Association ILEC/CLEC No Update to Provide 5/19/2010
Wellman Cooperative Telephone Association Fixed Wireless No Update to Provide 5/19/2010
West Iowa Telephone Company Cable No Update to Provide 1/27/2010
West Liberty Telephone Company Backhaul No Update to Provide 1/25/2010
West Liberty Telephone Company ILEC/CLEC No Update to Provide 1/25/2010
West Liberty Telephone Company Fixed Wireless No Update to Provide 1/25/2010
Western Iowa Networks ILEC/CLEC No Update to Provide 2/22/2010
Western Iowa Networks Fiber No Update to Provide 2/22/2010
Western Iowa Networks Fixed Wireless No Update to Provide 2/22/2010
Western Iowa Telephone Association ILEC/CLEC No Update to Provide 4/22/2010
Winnebago Cooperative Telecom Association Backhaul No Update to Provide 1/22/2010
Winnebago Cooperative Telecom Association ILEC/CLEC No Update to Provide 1/22/2010
Winnebago Cooperative Telecom Association Fiber No Update to Provide 1/22/2010
Winnebago Cooperative Telecom Association Fixed Wireless No Update to Provide 1/22/2010
Woolstock Mutual Telephone ILEC/CLEC No Update to Provide 5/19/2010
WTC Communications, Inc. ILEC/CLEC No Update to Provide 3/22/2010
WTC Communications, Inc. Cable No Update to Provide 3/22/2010
WTC Communications, Inc. Fixed Wireless No Update to Provide 3/22/2010
Wyoming Mutual Telephone Company ILEC/CLEC No Update to Provide 2/19/2010

Atkins Telephone Company ILEC/CLEC
No Update Provided - Use Last Submission 
Data 5/14/2010

Atkins Telephone Company Fiber
No Update Provided - Use Last Submission 
Data 5/14/2010

Fenton Co-Op Telephone Company ILEC/CLEC
No Update Provided - Use Last Submission 
Data 4/16/2010

Iowa Telecom ILEC/CLEC
No Update Provided - Use Last Submission 
Data 6/18/2010

Amberwave Communications Fixed Wireless Refused to Participate

[JAN-27-11 Jill Lindgren] Received e-mail from 
provider that they will not participate in this 
round due to a company re-organization

Eastlight, LLC Fiber Refused to Participate

[FEB-16-11 Jill Lindgren] Provider indicated they 
do not want to share info on fiber platform at this 
time.

Netconnect Fixed Wireless Refused to Participate

[JAN-25-11 Jill Lindgren] Received e-mail from 
provider that they refuse to participate in the 
mapping project.

Coon Creek Telecommunications Corp. ILEC/CLEC Non-Responsive to Multiple Attempts

In addition to multiple contact attempts made 
between January 28, 2010 and August 31, 2010,
six attempts were made during this submission 
period.

Knology of the Plains, Inc. Cable Non-Responsive to Multiple Attempts

In addition to multiple contact attempts made 
between August 18, 2009 and August 24, 2010, 
six attempts were made during this submission 
period.

Knology of the Plains, Inc. Backhaul Non-Responsive to Multiple Attempts

In addition to multiple contact attempts made 
between August 18, 2009 and August 24, 2010, 
six attempts were made during this submission 
period.

Mechanicsville Telephone Company ILEC/CLEC Non-Responsive to Multiple Attempts

In addition to multiple contact attempts made 
between January 28, 2010 and August 5, 2010, 
two attempts were made during this submission 
period.

Mechanicsville Telephone Company Cable Non-Responsive to Multiple Attempts

In addition to multiple contact attempts made 
between January 28, 2010 and August 5, 2010, 
two attempts were made during this submission 
period.

RuralWaves Wireless Internet Fixed Wireless Non-Responsive to Multiple Attempts

In addition to multiple contact attempts made 
between February 19, 2010 and August 5, 2010, 
two attempts were made during this submission 
period.

RuralWaves Wireless Internet ILEC/CLEC Non-Responsive to Multiple Attempts

In addition to multiple contact attempts made 
between February 19, 2010 and August 5, 2010, 
two attempts were made during this submission 
period.

Coon Creek Telecommunications Corp. Fixed Wireless Other

[MAR-08-11 Matthew Brunt] This provider offers 
SDSL and ADSL.  They do not offer fixed 
wireless Internet access.

DISH Network Corporation Satellite Other 1/27/2010

[MAR-09-11 Matthew Brunt] Satellite data will 
not be submitted due to additional information 
being necessary to show where service is 
available in the state, rather than submitting the 
entire state boundary as serviceable area.

Farmers Mutual Telephone Company-Jesup Cable Other 4/20/2010
[FEB-02-11 Jill Lindgren] Provider stated there 
are no broadband services on cable platform.

Global Crossing Telecommunications, Inc. Backhaul Other

[FEB-17-11 Wes Kerr] Received word from a 
provider representative that they still have a 
Network Security agreement with several 
Federal agencies and cannot provide data at 
this time.



Harlan Municipal Utilities ILEC/CLEC Other 5/5/2010
[MAR-09-11 Ashley Littell] Provider does not 
offer DSL service.

Harlan Municipal Utilities Fiber Other 5/5/2010
[MAR-09-11 Ashley Littell] Provider does not 
offer fiber service.

Hughes Network Systems, LLC Satellite Other 2/5/2010

[MAR-09-11 Matthew Brunt] Satellite data will 
not be submitted due to additional information 
being necessary to show where service is 
available in the state, rather than submitting the 
entire state boundary as serviceable area.

Long Lines Fiber Other 5/4/2010
[MAR-08-11 Matthew Brunt] Provider does not 
offer fiber service.

Marne & Elk Horn Telephone Company Fiber Other 2/11/2010

[FEB-02-11 Layne Wagner] I called the provider 
and confirmed that the company does not offer 
FTTH at this time.

SpeedNet, LLC Backhaul Other

[JAN-21-11 Layne Wagner] I spoke with the 
provider and he stated that they do not provide 
backhaul to anyone other than themselves.

USA Communications Backhaul Other 1/27/2010

[MAR-07-11 Matthew Brunt] Previously 
submitted middle mile data was not located 
within the state of Iowa.

Webster-Calhoun Cooperative Telephone Association ILEC/CLEC Other 5/21/2010

[JAN-14-11 Layne Wagner] Received notice 
from provider that the company is 100% FTTH 
in all exchanges. 

WildBlue Communications, Inc. Satellite Other 1/8/2010

[MAR-09-11 Matthew Brunt] Satellite data will 
not be submitted due to additional information 
being necessary to show where service is 
available in the state, rather than submitting the 
entire state boundary as serviceable area.

Board of Water Electric & Communication Trustees of the City of 
Muscatine Fixed Wireless Offers Service but Below FCC Definition 5/14/2010

[MAR-08-11 Matthew Brunt] Speeds were too 
slow to qualify as broadband.

Sharon Telephone Company Mobile Wireless Offers Service but Below FCC Definition 5/20/2010

[FEB-16-11 Layne Wagner]  I received the data 
from the provider and determined that the 
mobile wireless data does not meet the FCC 
definition of broadband.
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Overview 
 

The following documentation provides an overview of how the third required data set was collected and 

processed for the State Broadband Data and Development Program (SBDDP) in the states of Alabama, 

Idaho, Wisconsin, and Wyoming.   

Although we could separate this draft into state-specific deliverables, the majority of methodology 

remains intentionally consistent among the states.  As one important validation test is comparability 

across states, we find value in this cross-state approach.  This cross-state approach also helps the 

LinkAMERICA team focus on comparable outcomes across the four states, where appropriate.  Our 

intent is not to make the states look and be the same, rather it is to leverage economies of scope and 

scale among the business processes. 

As expected, this document rests heavily on the prior drafts, but has also been updated and expanded. 

Significant changes include additions covering: 

1. Trends in provider inputs  

2. Expansion in retrieval of WISP coverage  

3. Requested modifications based upon NTIA guidance 

a. Inclusion of satellite, changes to service overview table, FRN verification process 

4. Consumer Feedback, Crowd Sourcing and Social Media campaigns. 

5. Development and posting of a Technical Standards document. 

Treatment of the following subjects has been expanded: 

1. Community anchor institutions and survey methodology 

2. Verification and validation 

3. Data production methods 

As anticipated, the SBDD program continues to mature and evolve.  Technical leadership and strong 

guidance has been appreciated.  We continue to focus resources on establishing stable business 

processes to track submissions, verify received and processed data, test for temporal stability and 

provide reporting deliverables consistent with NTIA expectations. 

In our view,  the mapping deliverable reflects (1) a good faith effort, which results in a reasoned 

response to the NOFA, Technical Appendix A,  as well as supplementary program office guidance and 

modifications offered in phone calls, emails, and webinars, (2) a stable foundation for improvement and 

prioritization of both NTIA and state needs and interests , (3) a valid data processing model to support 

online mapping, consumer feedback, provider verification and reporting, and finally, (4) a valid use of 

the evolving data transfer model and its intrinsic validation methods.  More importantly, the resulting 

data and online coverage maps that follow from this work are providing good input and context for the 

Broadband planning teams working across the states we have the pleasure to serve. 
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We close this methodology document with two Appendices.   Appendix One describes Data Collection 

Challenges.  This section describes some of the open issues, challenges and questions we are exploring.  

Our hope is to receive clarification and counsel from NTIA in how best to confront some of these issues, 

which are likely common across states.  Appendix Two describes the confidentiality framework 

explained by NTIA.   

Purpose of This Manual 
This technical document was developed to provide transparency in our data production process.   

Our goal is to illustrate a thoughtful process designed to meet the intent of the submission.  Our hope is 

that we have developed a process that is reasonable, with respect to the data it deals with, as well as 

flexible enough to change with evolving NTIA requirements and lessons learned from the Broadband 

mapping community.  

Data Sources 

Developing the Provider List 

Provider lists for all states were developed at project inception from the following sources: 

 State lists of regulated telecommunications, cable and wireless service providers 

 State and national industry organizations (i.e. cable associations, wireless service provider 

organizations, telecommunications associations) 

 FCC Form 477 respondents 

 Independent web searches 

 Prior comparable mapping/research efforts 

 Interviews with key state staff members and important community influencers 

After the October 1, 2011 “Round 2” submission, we continued our research and added new providers 

to the program as discovered.  As one would expect in a dynamic marketplace, provider identification is 

an ongoing and important component of our work.  Mergers and acquisitions, the use of multiple 

regional DBAs, the lack of any universal identity management attribute, and the generally complex 

parent-subsidiary structure of many telecommunications companies, make provider identification and 

tracking very challenging.   

In early January 2011, we once again initiated an email and telephone outreach campaign to contact all 

known providers. This is an extremely time consuming process, but it is necessary to ensure that the list 

of contact persons remains current, and that providers are aware of data request changes and deadlines 

associated with each round.  Where necessary, we execute new NDAs with providers.  In “Round 3”, this 

effort continued on a daily basis until we reached our final data submission deadline on February 18, 

2011.   After February 18, we continued to work with providers who were not able to meet the deadline.  

In most cases were able to “crash” our process to accommodate this extra data, but late submissions 

continue to create inefficiencies and add costs to the overall program.  In Round 3 only providers who 
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responded in the last two weeks of March were excluded from the final dataset.  Data from those 

providers will be updated this summer and included in our Round 4 submission. 

Once again, as contact is made in each round, we verbally qualify each provider by asking a series of 

questions regarding the type of service and speeds offered.  If the provider does not meet the minimum 

specifications for a Broadband provider (as defined in the NOFA) we make a note of their status and 

remove them from the data submitted to NTIA.1  We continue to reach out to them in future rounds in 

the event that their service is upgraded or expanded. 

Provider Outreach 

To meet the program’s aggressive deadlines and participation goals, LinkAMERICA believes it is critical to 

maintain rapport with providers.  To do this, we continued to reach out to providers with regular project 

communications, including a program newsletter and links to the various state mapping websites.  As 

described above, individual e-mails and/or telephone calls were made to all providers explaining the 

status of the program and requesting their continued support in Round Three. We’ve also had the 

opportunity to support providers in their BTOP / BIP applications in certain cases. Through these 

collective outreach initiatives, and our engagement with various industry associations, we continue to 

enjoy a healthy and appropriate relationship with Broadband service providers. 

NDA 

To provide protection for all parties involved, LinkAMERICA continues to honor the terms of our NDA.  If 

providers did not execute the NDA in Round 1 or 2, they were giving an additional opportunity to do so 

in Round 3. New providers were of course also supplied with a copy of the NDA. 

To facilitate the execution of NDA’s, LinkAMERICA continues to use the DocuSign online document 

management solution.  This system allows providers to review and digitally sign the NDA in a legally 

binding manner, and has been instrumental in achieving rapid approval and execution of NDAs with the 

majority of providers.  In some cases, NDA’s were individually negotiated to address specific provider 

concerns.  In other cases, providers chose to submit data without executing an NDA. 

Provider Survey 

Since two prior rounds of data collection had been completed, the LinkAMERICA team had a solid base 

of coverage and speed information with which to begin Round 3.  This allowed us to provide two 

response options to providers.  The first was for them to review PDF check maps of their coverage and 

speed data – submitting only corrections and additions to the existing dataset.  The second was to allow 

submittal of completely new datasets, either in tabular form or in multiple other digital formats.  For 

those without sophisticated CAD or GIS systems, we continued to allow the submittal of 

printed/scanned maps and other written materials.    

                                                           
1
 As with other Grantees, we struggle with appropriate and consistent classification for service providers like 

Megapath, New Edge Networks, American Fiber.  These providers seem to resell and/or provision within their own 
network opportunistically.  In this submission we begin to bring them into the analysis as a provider type “other”.  
As the inclusion of this category isn’t our primary goal, we are working to process data as we can.  We are similarly 
categorizing and retaining reseller information.  Our datapackage.xls illustrates the categorization of non 
Broadband providers within our provider tracking  and verification systems. 
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Survey Methods 

Once again, we used a secure digital survey process (via our provider portal websites) to collect and 

display information for providers.   The Round 3 survey process was designed to accommodate both 

new and returning providers, and the different types of information they would be submitting.  The 

following is a summary of the process encountered by each group: 

New Providers:  New providers were routed directly to our standard survey where they were provided 

with templates for uploading data in tabular NTIA-compliant formats.   As in Rounds 1 & 2, if providers 

could not supply information in the requested format, alternatives were offered.  These alternatives 

included uploading service-area boundary maps, exchange area maps, CAD drawings or customer 

address lists.  From that information, the LinkAMERICA team developed a geographic representation of 

coverage and was able to build coverage features for each provider.    

Returning Providers:  While many Broadband providers submitted datasets in Rounds 1 & 2, many of 

those submissions did not contain 100% of the requested data.  To help identify gaps, and to make the 

Round 3 submission process as simple as possible, every Round 2 survey was reviewed for 

completeness, as well as accuracy and formatting compliance.  Notes were made regarding gaps, and 

specific instructions were developed for providers in Round 3.  These instructions not only explained 

what data was missing, but also provided directions on how to include that information in the Round 3 

submission.   

Check maps were also developed to show each provider how their service area would be displayed on 

the resulting interactive state map.  Generating these customized documents in each round is an 

extremely time consuming verification process, but it allows us to close many of the gaps that might 

have otherwise persisted. 

Follow Up 

After the release of the Round 3 survey in early January 2011, LinkAMERICA launched an extensive effort 

to encourage responses.  Every known provider was contacted at least twice by telephone or e-mail 

during the months of January and February.  The initial data submission deadline was set for February 

18, but, as previously noted, we continued to accept “straggler” submissions well into March.  

No Response Policy 

As mentioned above, every effort was made to contact each provider who appeared on our initial list.  

However, if no current information could be found on the company (i.e. no website, no valid phone 

number, no contact person identified) they were removed from the list of “known providers”.  We 

believe the vast majority of those we were unable to reach were small wireless providers who have 

simply ceased to exist2. 

                                                           
2
The complete list of known providers and important submission statistics are contained in the datapackage.xls 

file. 
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Summary 

In summary, an intensive 45-60 day provider outreach and data collection process is initiated at the 

beginning of each round.  In Round 3, given the data vintage of December 31, 2010, we began this 

process immediately after the New Year.  The last submissions were accepted in mid-March, 2011.    

While we continue to successfully engage the majority of providers in each round, the amount of 

manpower required to solicit complete and timely responses should not be underestimated.  This 

process is one of the most costly and complex within the entire SBDD program.  

Third Party Data Used 
Beyond the data obtained from providers, we acquired the following commercial data products: 

 American Roamer, Coverage Right Advanced Services. This data served two purposes.  The first 

was to verify the provider list and help find Broadband service providers not on other lists.  The 

second was to verify the reasonableness of the Broadband service provider’s submission. 

 MapInfo ExchangeInfo, Professional.  This data was used in the verification of telephone 

Broadband provider data.  Where a public domain exchange boundary wasn’t available, the 

MapInfo boundary was used for coverage containment tests.  

 Media Prints Cable boundaries.  This data was used in the verification of Cable/HFC Broadband 

provider data.  It was used to research valid providers and discover if that provider was offering 

Internet service.  In very rough terms the contained boundaries were used to test the location of 

some provider data.  

 GeoResults Telecom Research Data.  This data was used to help estimate the Broadband 

services likely provided to certain classes of Community Anchor Institutions (CAI). 

We have included third party data sources, which touch on each of the three major technologies 

analyzed within the SBDD program.  Each of these data sources tie back to a public domain data source, 

which provides a cross-verification mechanism for the commercial data product. 

Although there are a large number of third party licensed data sources available, we remain 

conservative in our acquisition plans.  From our limited analysis we are concerned about the ability to 

cross-verify additional third party licensed sources against public domain data.  Further, we are unsure 

of how we may be able to integrate another data provider’s view of valid Broadband providers within 

the definitions used by the NOFA (eg. Are they using an FRN/DBA identity view or a marketing view?  

Can the provider supply in a 7-10 day window?  Are they facilities based or not?).  This leads us back to a 

statement we made in a ‘lessons learned’ Webinar (April 2010) about exploring a consortia to lower the 

cost of data acquisition and allow multiple entities to peer review the quality and methodologies behind 

licensed data products.3  

Beyond these commercial data sources, we used a number of public domain sources.  These included: 

                                                           
3
 We also suggested forming a technical standards committee and a consistent system for confidence reporting. 
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a. Geographic Data Files  

i. US Census TIGER data4 

b. Sources that helped isolate providers, identity management or provider service areas 

i. NECA Tariff 4 

ii. State produced exchange boundaries  

iii. Carrier produced wirecenter boundaries 

iv. FCC 477 provider filers 

v. FCC Coals reports (321/325) 

vi. FCC FRN API lookup tool 

vii. FCC/FAA Antenna Registration System 

viii. FCC FRN Lookup Tool (plain text search) 

ix. USAC High Cost FCC Filing Appendices 

c. Sources that helped isolate anchor institutions 

i. USAC Grant lookup tool 

ii. USAC High-Cost FCC Filing Appendices 

iii. HRSA data warehouse 

iv. NCES data lookup 

v. State managed lists of schools (K-12), post-secondary institutions and libraries 

List of museums,  conventions, and visitors bureaus from www.onlineatlas.us 

Finally, challenges exist when dealing with the inevitable conflicts between provider-submitted data and 

third party sources (public or commercial).  There is no guarantee third party sources are more accurate 

or timely than the providers’ own reports.   Indeed, some third party sources are based upon different 

standards than those specified in the NOFA, perhaps making them less reliable than information 

collected directly from providers.  At the very minimum, provider data has a lineage and temporal status 

that we can identify.  A concern we have with increasing use of third party data is that we have no way 

to verify its quality or development methodology.  In other words, we may hit a wall in which we can’t 

determine how the commercial source derived its coverage conclusion.  To us this means that third 

party data sources are beneficial, but represent a supplementary view, not an authoritative one, of the 

NOFA defined Broadband market. 

In short, we have chosen to use provider data as the baseline.  We will challenge provider reports when 

third party data shows major anomalies, or when a consistent volume of consumer feedback points to a 

potential error.   

As the program evolves it is also our intention to provide tools that allow end users to evaluate the 

accuracy of the data in their own way.  A confidence score or the presentation of multiple (and 

potentially competing) reports for the same location may be made available. This notion is discussed 

further in the “Validation” section below.   

                                                           
4
 Census data were derived from < http://www2.census.gov/cgi-bin/shapefiles2009/state-files?state=01>, Census 

2000 files.  Roads were derived from the county faces and edges file downloaded at the same location and tiled for 
a full state. 

http://www2.census.gov/cgi-bin/shapefiles2009/state-files?state=01
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Confidentiality and the Use of Licensed Materials 
As a mapping vendor, we are reliant upon the cooperation of Broadband service providers.  In large 

part, what underlies this cooperation is trust that we will not violate the proprietary and confidential 

nature of the data provided to us.   

We are thankful for the confidentiality clarification that NTIA shared with us (included as Appendix Two).  

We intend to use this as a guiding document to help us communicate with providers about what 

information NTIA considers to be confidential.  Our suggestion is that NTIA publish this, or something 

comparable, to ensure a consistent interpretation of the NOFA and how it guides NDAs. 

As some providers are non-responsive to requests for information, or lack resources necessary to put 

data into NTIA compliant formats, we have fallen back to the use of commercial data sources in several 

places.   

For instance, some mobile wireless providers were unable to submit coverage information to us.  In 

these circumstances we have generalized the American Roamer coverage.  For incumbent telephone 

providers we have used commercial wirecenter boundary products to filter Census Blocks that are 

clearly out of their exchange areas.  Finally, licensed data from Georesults were used to derive estimates 

of Broadband connectivity for hospitals within the Anchor Institution category.  The actual value from 

Georesults was not used, but our estimate is modeled from their input data.  We also use the name and 

address as provided by the State data provider, not Georesults.   

Public Engagement:   Crowd Sourcing, Surveys and Social Media 
Crowd sourcing (i.e., an intentional and carefully designed effort to tap into the collective intelligence of 

the public at large to expand our knowledge base) continues to be an important element of our data 

collection and validation process. In addition to the various opportunities, the public has to provide 

input via the online service coverage maps and the related ‘Broadband story’ process, our crowd 

sourcing efforts are grounded in a fairly traditional telephone survey approach, focused on the 

consumer market. In addition, we are currently advancing our crowd sourcing process to include certain 

initiatives centered in two social media outlets – Facebook and Twitter. These initiatives are summarized 

below. 

Consumer Surveys 
Working under contract for the state of Alabama in 2009, our initial consumer survey was performed 

before the NTIA SBDDP grant was in place. Subsequent consumer surveys funded by the SBDDP grant 

were hosted in 2010 for the states of Idaho, Wisconsin and Wyoming. These surveys will be repeated 

after two years to establish and evaluate trends. These primarily telephone based surveys include two 

distinct and carefully scripted tracks: one for internet users and one for non-users. The telephone survey 

approach allows us to reach the non-internet user group as well as the current internet user. A 

secondary online approach is also used to augment input from current internet users. For non-users, the 

surveys help determine why they don’t have or don’t use Broadband. For current Broadband users, the 

survey helps determine the nature of their Broadband access and how they use that connectivity in their 
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daily lives. In addition to our state-specific surveys a nation-wide survey was also hosted to provide a 

broader view of consumer views for comparison purposes. State-specific surveys are, where possible, 

framed to match the state’s regional Broadband planning structure (e.g., the consumer survey in 

Wyoming was designed to produce results relevant to the state’s seven Broadband planning regions). 

The resulting data is helpful on a number of fronts in the SBDDP’s mission to advance the access and 

adoption to Broadband. Survey data provides an important, albeit broad, gauge for assessing coverage 

information obtained by providers. For example, areas with widely available coverage (according to 

provider information), but lower consumer subscription levels (according to survey results), or perhaps 

where survey results suggest Broadband is not available, can be examined in more detail. Survey results 

are also very important to the Broadband planning (and capacity building) components of the SBDDP 

program in that they help inform and formulate Broadband advancement priorities. Survey results also 

help inform Broadband policy discussions on both the local and state levels. Finally, survey results 

provide important information to the service provider community regarding market demand and 

specific internet use in specific communities (i.e., regions).  

The 2010 surveys were launched in July 2010 with a test number of survey calls to confirm (and adjust as 

needed) the structure of the survey and the underlying survey process. The surveys were closed on 

November 30, 2010. Telephone surveys were completely random beginning with the acquisition of a list 

of state-specific, randomly selected landline telephone numbers (e.g., 80,000 random Wyoming 

residence telephone numbers were acquired as the foundation for the Wyoming survey). Mobile phones 

were not included in the initial surveys. Upon evaluation of the survey statistics, an auxiliary survey was 

executed to ensure younger groups (i.e., age 18 – 25) were adequately represented. This secondary step 

is required because of the continued migration (by younger markets) to non-landline based 

communications. This younger market (age 18 – 25) was surveyed by reaching out through social media 

outlets to encourage their participation in an online survey process. 

Survey statistics point to the complexity of the telephone-based survey process. Survey volume achieved 

statistical validity ranging from a 95% confidence level and a + 1.7% margin of error for the statewide 

data in Wisconsin to a 95% confidence level and a + 3% margin of error for Wyoming’s statewide data.  

Most regions in the 3 states have a 95% confidence level with a + 5% margin of error. 

Call volume and disposition is summarized in the chart below 
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TOTAL RECORDS CALLED & % OF STUDY 106,592 100% 22,144 100% 57,445    100% 27,004   100%

NO ANSWER 53,507   50% 11,974 54% 25,886    45% 15,647   58%

TOTAL DEAD NUMBERS 23,962   22% 4,529   20% 14,611    25% 4,822    18%

HARD REFUSALS 9,304    9% 1,728   8% 6,048     11% 1,528    6%

QUALIFIED REFUSAL 643       1% 101     0% 403        1% 139       1%

BUSY 3,652    3% 754     3% 1,903     3% 995       4%

ANSWERING MACHINE 6,385    6% 1,314   6% 3,388     6% 1,683    6%

NON-WORKING NUMBER 5,072    5% 943     4% 2,983     5% 1,147    4%

CLAIMS PREVIOUS INTERVIEW 113       0% 16       0% 68          0% 29        0%

NON-RESIDENTIAL 454       0% 104     0% 239        0% 110       0%

LANGUAGE BARRIER 1,003    1% 223     1% 562        1% 218       1%

OTHER PHONE PROBLEMS - FAX/MODEM 907       1% 205     1% 500        1% 202       1%

PORTED NUMBER 272       0% 68       0% 149        0% 54        0%

BREAK OFF - SCREENER 556       1% 103     0% 301        1% 153       1%

TERM Q3 - UNDER 18 122       0% 22       0% 65          0% 36        0%

99% 100% 99% 99%

TOTAL COMPLETES 5,758    5% 1,080   5% 3,420     6% 1,259    5%

AVG Completion Time (minutes) 16 15.8 15.4 16.1

BROADBAND MARKET RESEARCH - ID, WI, WY - FALL 2010

IDAHO WISCONSIN WYOMINGTOTAL

 

As noted above, the telephone survey process represented in the statistics above was augmented by 

providing online access to the survey. Participation in the online survey was promoted on all of our 

state-specific public web sites and selected social media. 

As a final relevant point with respect to the consumer survey process the length of the survey is 

noteworthy. By survey standards, this was a long survey. As noted above, the survey averaged sixteen 

minutes across the three states. While this clearly contributed to the number of survey call attempts 

that were required to reach the level of statistical validity, it was not insurmountable.  

Social Media 
The phenomenon of social media is widely documented and yet still emerging as an effective access 

point for public engagement. We continue to explore appropriate ways to use a variety of social media 

venues in our SBDDP efforts. All of our efforts are informed by and consistent with relevant state statues 

and guidelines. Different states have different perspectives on if and how the state will participate in the 

use of social media. Some state requirements are well defined and some are still being formed. Where 

appropriate, we use YouTube, LinkedIn, Facebook and Twitter to support our work. YouTube and 

LinkedIn postings are used to promote awareness. As noted above, we were able to promote additional 

input on the consumer surveys through a social media outreach program aimed at our younger market 

segments.  

In addition, we are currently engaged in two specific social media tests (in Alabama) to gauge how 

Facebook and Twitter can be used to drive public input on two important crowd sourced issues: online 

speed tests and input on map accuracy. Based on data obtained through our web site traffic monitoring 

process and readily available social media tracking processes, our most recent results are promising.  For 

example, with a fairly limited ‘following’ a single Facebook post aimed at driving traffic to the online 

speed test, had 282 impressions (i.e., the number of times the post was viewed), which contributed to 

an increase in 71 more visits to the Facebook page generally, and a volume of 60 hits (over a three day 
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period) on the web site page that hosts the speed test. Our normal volume of speed test page hits is in 

the neighborhood of 7 or 8 per day (vs. the average of 20 per day experienced during this test). 

Preliminary data suggests that about half these page hits resulted in a speed test being executed. 

Data Production Process 
To support our objective of transitioning the data development process to our State partners, we 

continue to model and document our data production process.   We find this to be a very beneficial step 

for two purposes.  

First, it helps us understand why (and if) a task is being done, and if it is being done efficiently.  Much of 

this program started so quickly that it was difficult to plan logical integration and hand off points among 

the various workgroups.  Further, we are currently in the process of consolidating much of the process 

data (check-ins, check-outs, metadata) and we can use this process model to efficiently plan a cohesive 

information architecture. 

Second, our process documentation and modeling helps explain why resources are being consumed in a 

particular way.  This helps our State partners plan for in-sourcing specific tasks as their time and 

budgetary constraints allow.  It also helps our LinkAMERICA team better plan and cross-train members 

to deal with the work surge that occurs 30-45 days prior to submission. 

Finally, documenting and modeling our process helps us take advantage of increasing specialization and 

proficiency with certain types of data and management responsibilities.   In this submission, we had 

identified data “czars” responsible for check-in and check-out of data.  That data czar helped to bridge 

the gap among receipt functions, provider feedback, production and DBA.  
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Figure 1--SBDD Business Process Diagram 

 

Data Production Methods 
As raw data were received from the provider community, attention turned to normalizing the disparate 

submission formats5.  The team considered each submission with respect to the following criteria.  

These criteria are important because they perform the basis for our verification and quality assurance 

process.  In other words, we have to appropriately scale our data verification efforts to match the scale 

or ambiguity of the following: 

 Locational certainty 

 Speed certainty 

 Temporal certainty 

 Provider and network ownership certainty 

                                                           
5
 In line with NTIA Best Practices we continue to request and receive a large number of data input formats.  This 

ranges from tabular Block lists to hand drawn maps. 
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The team’s goal was NOT to quantify a particular degree of precision with respect to any of these 

criteria.  Rather, we are working to attribute the above “certainty attributes” to each submission, and 

will continue to implement quality assurance and verification mechanisms that are resource-appropriate 

for each. 

Deriving Broadband Coverage Information 
Broadband Coverage6 was normalized into four formats:  

1. Coverage in Census Blocks (2000) of 2.00 or less square miles 

2. Covered Street Segments (2000) in Census Blocks greater than 2 square miles7 

3. Address Level Coverage (point data) 

4. Wireless Service Areas (SHP file format) 

With each submission, the team went through a series of steps to normalize and categorize the data. 

Since data arrived in many different formats, and at many levels of granularity, the following 

normalization procedures were used:  

1. Determining the nature of service being provisioned (who is providing service and what 

technologies are in use) 

2. Planning an attack strategy for the submission –understanding the data and assigning team 

members to various tasks 

3. Geo-referencing the data; QA the georeferenced data  

4. Geoprocessing the geo-referenced response 

5. Segregating the submission into the correct NOFA-compliant submission formats. 

6. Apply appropriate source metadata8 

                                                           
6 Speed, Anchor institutions and Middle Mile facilities are discussed in later sections. 

7
 To help clarify issues relating to Census block area and vintages in use, our team published a technical paper to 

the Grantee workspace.  Because we were unsure if this standard should be implemented uniformly, this 
document was never distributed to the provider community. 
 
8
 When our team logs a submission into the staging database we record at least two attributes.  One records the 

method used to derive the coverage, the other records the method by which speed was attributed to that object.  
Other attributes carried to NTIA carry source meta values as well. 

https://sbdd-granteeworkspace.pbworks.com/w/file/33293657/Technical%20Reference%20Document%20Final.doc
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Figure 2-Broadband Coverage Process 

Impact of Program Change 

There were four important program changes that impacted how Broadband coverage was developed 

and submitted to NTIA in Round 3. 

The first was the development of a “provider match” submission metric whereby the grantee’s complete 

list of known providers in the state is compared against lists from third party sources.  The provider 

match specification was discussed on a webinar prior to the release of the national map.  Although, to 

this date, there has been no clarification on how this metric is established or exactly how it will be used.  

We have invested significant resources to support an internal process to compare our provider lists with 

several additional sources.  This has been manifest in at least three ways. 

Within our provider verification process we  work to derive a  state level match against third party data 

sources.  As discussed in the early pages of this manual, there is no guarantee that a third party data 

source is any more accurate than submitted data, nor does it necessarily reflect the provider ecosystem 

specified in the NOFA, Technical Appendix A.  We devote significant resources to matching our 

submitted data against three, third party data sources.  In many cases this becomes a judgment call 

trying to match provider names across systems.  It is a difficult and somewhat arbitrary process.  

Nonetheless we do believe it has value because it forces a re-examination of who we believe is an 

appropriate provider within a non-NOFA context. 

The use of a provider match system, as well as the webinar comments (3/17/11) directing grantees to 

estimate, wherever possible, non-participating providers have made us back away from one of our 

fundamental assumptions in data collection.  As discussed in the prior draft of this manual, we had 

developed a certain “hold-out” class of data when a provider’s data wasn’t of sufficient quality to verify, 
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or we were unable to put it into the data model (eg. address points submitted for a wireless).  In this 

submission, much of this hold-out data has been included.  In some cases this means we are using 

simple polygons to capture a wireless ISPs serving area.  Other times, if we are confident in the 

coverage, but can get little clarification on the submitted speeds or frequencies, we release the 

coverage and note in our internal metadata the source issues with the other attributes.   

Finally, we have used the new provider type classification of ‘other’ to bring some aspect of the 

provider’s data into our submission.  There still seems to be confusion on how to handle provider types 

where a provider offers multiple paths to receiving Broadband for typically business customers.  Rather 

than waiting for certainty on the answer, we bring the provider in and list them as Provider Type 

“other”.  Our sense is Provider Type “other” will continue to expand in the fourth submission as we pull 

in more providers who are facilities-based and reseller.   

Clearly one challenge is the data, but an equally significant challenge is appropriate messaging around 

this “other” provider type category.  We do not want to leave consumers with the impression that they 

can get a high capacity fiber or Microwave link despite the fact that the hospital next to them in the 

same Census block can get this service. 

The final set of changes was a second verification check against reported FRNs.  As NTIA is stressing the 

importance of this attribute, we increased its visibility in our Check Map process.  FRN is now listed on 

both the tabular verification report and the provider PDF map.  Beyond this increased visibility we had 

an analyst verify each FRN in our system against the FCC API9, as well as FCC textual search10.   Because 

the FRN is not an identity management tool, we are unsure if the FRNs we’ve included are those desired 

by NTIA, but we have at the very least, verified the existence of the FRN via the FCC system. 

Trends in Provider Supplied Data 

With this third submission we take note of three important trends.   

First, with larger providers, we are seeing an increase in data stability relative to earlier submissions.  In 

informal discussions, several providers have noted changes and stabilization in internal data processes.  

The firms have invested internal resources in stabilizing this data feed.   

We see this reflected in very stable counts of Census Blocks and road segments.  This does not mean 

that complex problems like segment identification or dispersion in data have been ‘fixed’.  It does mean 

that the format and methods to produce inputs for NTIA are increasingly stable. 

Second we note that several providers have been particularly concerned with an appropriate 

identification of Maximum Advertised speeds.  In some cases this involves identification of very small 

areas (sometimes below the level of a Census block) and appropriate assignment to technology of 

transmission and maximum advertised speed tiers.  In other cases, questions arise regarding maximum 

advertised speeds that could be sold based upon network design, but that are not generally “advertised” 

or otherwise stated to the general public.   

                                                           
9
 http://reboot.fcc.gov/developer/frn-conversions-api 

10
 https://fjallfoss.fcc.gov/coresWeb/simpleSearch.do 
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Third when comparing submission three results relative to submission two it is important to recall the 

inclusion of much new data within the Provider Type “other” category.  This change does not necessarily 

reflect a change in the size of the market, rather it reflects new data coming into the analysis and 

segregated into a distinct category.. 

Coverage Geoprocessing Methods 

The next section discusses how data were geo-referenced and geoprocessed given a particular 

submission format.   

In most cases, in Round 3 we were still not provided with street segment level information for Blocks 

greater than two square miles (large Blocks).  This necessitated subsidiary geoprocessing.  As stated 

before, our first goal was to derive block level coverage.  Then, for Blocks greater than 2.00 square 

miles, we moved to a segment gathering processing.  The segment process will be described in the last 

section.11  

Block Level Coverage Derivation Using Service Point Data 

A number of providers submitted point level customer data.   

In some cases the submissions themselves were not internally consistent.  For example, in the image 

below, unprojected points are shown, while the Census block polygon to which the points are supposed 

to “belong” is highlighted.  In this case, one of the following scenarios has occurred:  block attribution is 

wrong, the points are not in the location to which they are attributed, or different block shapes were 

used than what is assumed. 

 

                                                           
11

 As has been discussed previously, we note inconsistency in how providers are supplying information at the block 
and segment level.  Beyond the temporal differences, we see that providers are computing area differently, as well 
as including or excluding water areas.  This provides an inconsistent measure across providers for the 2.00 sq mile 
cut off.  Our preference would be to provide guidance to service providers within our states, but our concern is 
that we will inconsistently message this with grantees in other states.  We would appreciate consistent guidance 
from FCC/NTIA on this topic. 
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Figure 3-Internal inconsistency in submitted data 

In other circumstances, we found that inconsistent geocoding standards may produce misleading 

results.  The next image shows point level data, and the Blocks are colored based upon the counts of 

points intersecting Blocks.  The challenge this presents is that if geocoding was performed on a different 

dataset than the block boundaries (the road traces are not coincident with block boundaries) and/or 

geocoding was done without an offset, it becomes problematic to assign coverage to a Census block 

based upon only the point locations. 
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Figure 4-Block Coverage 

For this reason, we elected to use a 200-foot buffer to select Census Blocks that intersect our points.   

Block Level Coverage Derivation Using Customer Facing Plant Level Point Data 

In other circumstances, providers submitted point level plant data.  From what we could gather, these 

points tended to be customer-dedicated terminals.  Typically, these providers were high speed 

Broadband producers—which may somewhat strain the definition of Broadband as other providers 

supplying comparable services specifically disclaimed the ability to provide high-capacity Broadband 

services in the required 7-10 day interval.  In these plant point data submissions, we had similar 

concerns to the point level customer data, but two factors tended to make us use a more conservative 

intersection buffer.  First, we tended to have far fewer points to work from, so our concern was 

grabbing too many covered Blocks as the Blocks tended to be much smaller in these urban areas.  

Second, these plant points tended to be dedicated to distinct customers, but it was difficult to know 

which element of the customer’s campus to attach coverage to. 

In the case of the image below, given a small shift to the left, it would be easily possible to gather 1 to 3 

Census Blocks from this point.  Although orthoimagery is helpful in a circumstance such as this, it is still 

indeterminate – specifically in areas where the coverage is attributed.   

Thus, in the circumstance of plant level point data, we used a 100-foot intersection buffer. 
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Figure 5-Plant Point level data 

Coverage Derivation Using Linear Facilities Data 

A number of providers submitted facilities data.  We handled this data in different ways depending upon 

what we believed the facility data represented. 

Most telecommunications networks are divided into two components.  Feeder supplies higher capacity 

nodes (eg. DSLAMs, Fiber Nodes).  Distribution usually supplies customer premises (NIDs, Pedestals, 

Taps, ONTs).  Where we could discern what strand we were provided, we used different methods. 

The next image demonstrates a geo-referenced CAD image as given to us by a Broadband service 

provider.  Note the light and dark green shading.  We would infer that the lighter segments represent 

distribution and the dark green represents the feeder network. 

In the case of a combined strand map, we used a relatively tight buffer of 200 feet to gather covered 

Census Blocks.  Our intersection tolerance is based upon an assumption that our data likely represent a 

situation comparable to customer point level submission in that we have most of the network footprint 

captured. 
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Figure 6-Georeferenced CAD information supplied by Broadband provider 

 

In other circumstances, we were provided engineering information that we inferred to be feeder only.  

This inference was typically based upon the presence of fiber optic equipment only.  In these cases, we 

used a more generous 2,000 meter Census block intersection.  The 2,000 meter criteria was based upon 

an informal survey of population in proximity to the geo-referenced strand data, but it could be varied 

based upon a more complete survey. 

Coverage Derivation Using Covered Street Segment Data 

In some cases we were provided with covered street segment data.  Covered segments tended to come 

from two sources. 

In some circumstances, providers gave us CAD data, which was not drawn in a projected manner.  This is 

relatively common for older engineering data derived from hand drawn records.  This meant that our 

team had geo-registered the image into an approximate position.  In this case, the boundary streets 
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were selected, and an enclosing polygon was derived.  The intersection of this polygon and the Blocks 

within became the geoprocessing method to derive Blocks. 

 

Figure 7-Coverage derived from street segments 

In a second circumstance, street segment data was developed during coverage estimation.  Handling the 

estimated data is discussed below. 

Coverage Derivation Using Serving Area Point Submission Data 

In other cases we worked with a provider to derive service areas based upon point plant data.  In these 

cases we were given a primary serving node and an appropriate road length service boundary. There is 

an important distinction from the plant data discussed above. In this specific case, the data submitted 

was a node that served many locations--such as a Central Office or DSLAM.  This is contrasted with the 

earlier example in which the point represents a node serving only a few customers.   

When trying to derive coverage from Central Office or DSLAM nodes, the team used ESRI Network 

Analyst to derive covered road segments honoring these road engineering parameters. 



SBDD Mapping Methodology Page 25 
 

The figure below shows street level coverage derived from Central Office and remote DSLAM point data.  

 

Figure 8-Coverage derived through road paths 

In response to Provider feedback we revised this process to include a larger variety of TIGER road types.  

In Round 1, unimproved roads were not used.  In Rounds 2 and 3 -- particularly to improve estimates in 

areas bordering parks and public lands -- a wider class of TIGER roads was used.12 

The segment level coverage is easily extendable to derivations of Census block level speed.  The figure 

below shows the attributions of block level speed based upon the Maximum Advertised Speed available 

from a DSLAM.  Although the methodology isn’t perfect, it does provide insight into the value of 

granular infrastructure data. 

                                                           
12

Only TIGER features of MTFCC type S1100 and S1200 were excluded from use. 
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Coverage Derivation Using Polygon/Polyline Serving Areas 

Broadband service providers sometimes submitted coverage in terms of served areas.  This was either in 

direct geospatial formats, CAD files, or paper maps.  The image below reflects a carrier’s service area.   

Within that service area, there are variations in technology of transmission and served speeds.  When 

polygons with speed data and technology of transmission were available, we used a spatial intersection 

to gather covered Census Blocks.  In many cases, using covered Census Blocks resulted in a loss of the 

speed variation (sometimes the speed variation was at a level below a Block and did not get picked up 

within a spatial query).. 

 

Figure 9-Coverage derived through serving area polygons 

Although we cannot directly solve the loss of speed granularity due to Block shapes, we honor a 

business rule wherein we always select Blocks from the highest speed areas first, and then allow the 

lower speeds to select from the remaining Blocks.  This is an arbitrary rule, but our feeling was that it 

should be a consistent selection, rather than an unordered selection. 

Street Segment Derivation, Large Blocks 

For those calculated Blocks greater than 2.00 square miles (large Blocks), we provided coverage in terms 

of covered street segments and corresponding geography.   

With respect to segments we had four sources of data: 

1. Covered large Blocks 

2. Tabular street segments and address ranges for large Blocks 
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3. Geographic segments either with street attributes or without. 

4. Service area boundaries 

A number of providers only provided a list of covered large Blocks without corresponding segment 

information beneath the block.  This provided the dichotomy of either selecting all segments in the 

block, or none.  Because we had little information from which to make the selection, we elected to be 

conservative and did NOT pass any covered segments to NTIA from this submission format.  Some 

Broadband providers submitted covered street names and street ranges.  In these cases we performed a 

manual analysis trying to link to specific segment names and address ranges within covered Blocks.  

Sometimes this was a simple process because a provider used a TIGER derived street database.  In other 

cases we could not determine the source of the provider’s street data.  Street and Address matching 

tended to yield a relatively good result (typically between 30% and 100% of possible segments in the 

Block), but was very time consuming.  Where yield rates were low, our result was a shredded segment 

coverage pattern, like the image shown 
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below.13

 

Figure 10-Blue road segments adjacent to peach covered small Blocks 

A number of providers submitted geographic objects. In this case, our manual process was directed 

toward a conflation of data sources.  The goal was to take provider submitted segments and put these 

segments in terms of our TIGER 2009 basemap.  Although there is a trade-off in the accuracy using non-

provider submitted segments, we felt it was more important to have a road set that would edgematch 

our Block features and remain consistent with the Block size standards we used for other providers.  This 

is important for the appearance of the online maps, as well as potential verification work where we are 

attempting to judge a feature based upon its attachment to a covered small Census block.  The figure 

below shows street segment input data. 

                                                           
13

 We continue to hear providers expressing concern that our request for either a geographic object or TIGER Line 
ID is beyond the scope of the NOFA clarification. Therefore, they cannot supply additional information to us. 
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Figure 11-Provider Submitted Street Segment Objects.  The segments don’t edge match the Blocks nor are they continuous. 

The figure following demonstrates the same area after the conflation process.  Blue segments are the 

conflated TIGER roads which will be passed to NTIA. 
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Figure 12-Provider submitted segments in gold, selected TIGER 2009 in blue—Conflation result; in many cases what was a 
continuous segment is made discontinuous because even with a distance buffer the TIGER segment doesn’t always intersect 
the provider segment 

 

The final segment process was used when we were supplied with a Broadband covered area polygon.  In 

this case, we found the segments within covered areas and eliminated those segments inside of Blocks 

less than or equal to 2.00 square miles. 

Because there was more control over the format of the inputs (we knew we had a boundary and were 

working with TIGER segments), this was an automated process that followed this general format: 

1. Select large covered Blocks by provider ID (from updated Large Block table) 
2. Select TIGER 2009 road segments (MTFCC like 'S%') that face (CB = CBLeft2000 or CB = 

CBRight2000) covered large Blocks for provider 
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4. Select segments as distinct records, max speed with corresponding technology, join in 
feature names, export selected records to temporary DBMS table  

5. Join TIGERroads feature class to temporary table on TLID 
6. Select covered segments (Python script)  
7. Select service area polygons for provider 
8. Clip selected facing segments with selected service area 
9. Export clipped segments to staging feature class, keyed by ProviderID 

In this figure, orange represents covered small Blocks; black lines are covered segments in large Census 

Blocks (light blue).  The service area boundary is shown in grey. Based upon feedback from providers, we 

have elected to clip segments at the end of a coverage boundary.14 

 

Figure 13-Output of the Segment Process 

Wireless Coverage Process 

In general, most providers of mobile Broadband submitted coverage information in a NOFA-compliant 

format.  Other than attributions for spectrum and speed, little was done to this coverage.15 

                                                           
14

 An outcome not discussed here is how to handle address ranges on segments.  As NTIA is asking for a Min and 
Max on the segment, deriving theses values for clipped segments is very problematic.  Also the prevalence of 
alphabetic characters in addresses makes the min/max selections very arbitrary.  We are grateful that addresses 
are nullable data elements. 
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In this submission LinkAMERICA made an aggressive effort to bring additional WISP coverage into the 

NTIA dataset.  For the most part, our outreach was with providers who were unable to supply 

sufficiently granular data in the past or those that could only submit wireless address points which is no 

longer a valid submission format. 

In Round 3 fixed wireless providers generally either supplied coverage information or infrastructure 

from which coverage estimates could be derived.  Many allowed us to use their tower locations, 

antenna heights and direction/spread of coverage to derive a line of sight coverage estimate.  In our 

experience, this is a conservative and reasonable derivation of coverage. 

Some wireless providers submitted RF studies.  When this was done, there was a request that the signal 

strength be removed from coverage data.  The request was honored.  

Other fixed providers were able to supply us with hand drawn maps or polygons/polylines drawn in 

Google Earth format.  In these cases we did our best to georeference and verify the coverage areas with 

the WISP. 

When we received coverage information in KML format, like the image below, we accepted the data as 

it was presented to us.   

 
                                                                                                                                                                                           
15

 Some polygon data did exceed the node count threshold.  In these cases, data was rasterized to 100m cells and 
then converted back to polygons.  The polygons were dissolved to multi-part geometry.  This addressed the node 
count concern. 
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As the image above shows, in some cases we have hand-drawn coverage, as well as infrastructure.  

Instead of estimating their coverage using a line of sight or RF study, we elected to stick with the 

provider’s supplied information.  Our decision was guided by two primary factors: 

 If the provider is advertising using this coverage they must have specific confidence in its 

accuracy. 

 If the provider can supply coverage, as well as infrastructure that reasonably supports the 

coverage, there is a very high likelihood in the accuracy of the information.   

The downside, of course, is the polygon shown on the map may not represent our notion of how 

wireless coverage should appear.  

In general we note several interesting trends in the wireless data.  First, we can be successful in 

increasing the amount of WISP coverage when we aggressively pursue WISPs.  This means we have to be 

willing to accept data on their terms and convey it into SBDD formats.  Some of our WISP submissions 

have taken over 12 hours to normalize into SBDD formats.  Second, we have to accept that some WISPs 

will not be able to supply FRNs.  There remains a minority of WISP providers who are not aware of the 

FCC FRN.  Third, there appears to be some variation on how the NOFA coverage definition is met.  In 

other words, there seems to be a disparity on the necessary strength (e.g. -80 dB, -98 db, -120 dB, etc) 

to provide the appropriate quality of service for data services.  Fourth, it was very difficult getting 

providers to identify spectra used for Broadband data services16.  We are unsure if this is a competitive 

concern, or if the same coverage pattern is yielded for multiple frequencies.  Typically, the spectra 

returned were those that a provider was licensed for.  At this point, we have no reliable way to locally 

determine what set of frequencies are used to provide Broadband data services in a local area.   

Service Address Point Process 

A handful of providers have requested that customer level, service address point data be submitted to 

NTIA.  In these circumstances we have done minimal processing to preserve the provider’s intent with 

this deliverable and not bias downstream NTIA use. 

Our verification included checks against commercial or Public Utility/Public Service Commission 

exchange boundary maps.  Points not contained within one mile of a boundary are not submitted to 

NTIA.    

We retain from the provider the provided latitude and longitude, as well as Census block.  For some 

coverage data, if a provider is unable to supply a longitude, latitude or Census block, we fill in these 

attributes.  In those circumstances where we do not have a Census block, but we do have a longitude 

                                                           
16 One provider responded by email, “This mapping program is to provide the coverage area for 

Broadband provided by a company. Not to keep a detailed account of every aspect of a companies (sic) 

network.” 
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and latitude, we accept the given longitude and latitude and use that as the basis for our Census block 

assignment. 

With point data we have tested for comparable geocoding success rates but do not overwrite provider 

information.  From this type of analysis we note the amount (usually little more than 10%) of addresses 

that seem to locate with less than street segment certainty.  Deriving a thematic representation of the 

points on speed also illustrates some of the locational certainty issues in this point level data.   

Coverage Estimation Process 

Although the derivation of Broadband coverage into Census Blocks, street segments, or wireless 

coverage files is, in itself, a bit of an estimation process, there was an explicit estimation process 

required in cases where a Broadband provider either refused to participate in our survey, or provided 

such a threadbare submission that no carrier-based coverage information could be gleaned.   

We typically resorted to three possible estimation paths. 

For Cable (HFC) providers who did not provide any coverage information, we fell back to Media Prints 

data.  Rather than using the entire Census Block group gathered by Media Prints, we used only those 

Census Designated Places carrying the same or similar names to the Media Prints p_com field.  Our 

reasoning was that Cable systems tend to be franchised on a municipal or at least administrative basis 

so the coverage will likely follow a governmental boundary.  As a general rule, cable infrastructure is not 

available in the public domain17 and what could be found was poor in quality and difficult to ascertain 

for validity.  

For DSL providers who did not provide any coverage information, we estimated road-based coverage 

from their Central Offices18.  We only used Central Offices that showed evidence of DSL or fiber-based 

services in the NECA 4 tariff.  Road-based engineering areas were derived via ESRI Network Analyst to 

18kft.  These segments/boundaries were clipped to commercial wirecenter boundary edges.   

For mobile Broadband providers who were non-responsive to our requests, we fell back to American 

Roamer coverage patterns.  We generalized the American Roamer coverage to ½ km in order to protect 

the licensed information. 

For fixed wireless providers who provided no coverage information, we relied on their public websites to 

scrape coverage maps.  When these maps were available, we georeferenced them and tried to use the 

outer polygon boundary to represent their serving area.  In other cases, when only a tower could be 

provided, we used a view shed analysis and estimated coverage at 10mi per tower19.  Because much 

wireless propagation is driven far below the Census Block and much engineering information isn’t 

                                                           
17

 The team tried to use data from the FCC Coals system and 321/325 fillings but this seemed to be a bit non-
uniform in quality. 
18

 Central Office location was derived from MapInfo ExchangeInfo Professional.  Wirecenter boundaries also came 
from this commercial product. 
19

 In some cases we had an approximate radius of coverage but no height.  In this case we used a 50’ height 
estimate and then clipped the coverage to the provided coverage range.  We also clipped wireless coverage to 
honor state boundaries but did not look for providers serving coverage with out of study state facilities. 
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known (frequency in use, polarization of the signal, coverage pattern of antenna(s), local terrain/land 

cover) this was the most complicated group to estimate.   

Speed 

Speed attributes are reported both at the block (typical) and higher levels (maximum advertised and 

subscriber weighted).  We note that in many cases, providers did not supply typical or subscriber-

weighted speeds.  In some cases, it appears--although we cannot verify--that their maximum advertised 

speeds were used to populate typical speed columns. 

We do have limited testing data on reported speeds, but we have been careful to not use our typical 

reported values with carrier-provided information.  If we do not have a speed value from a provider, we 

report an empty value.   

Several service providers claim they do not have data on typical speeds available, but estimate a 20% 

overhead factor between the advertised speed and what may be experienced by an end user. 

We continue to request advertised speed at the block level.  Nevertheless we appear to be getting 

speeds that do not vary over a large geographic area – leading us to believe that providers may still be 

submitting the maximum speed advertised in local media for the entire market.  For the most part, we 

have been unsuccessful in messaging that advertised speed should not correspond to a market area, but 

instead, the maximum speed, which can be provided to a household—what some may describe as a 

‘qualified speed.’20 

In circumstances where a provider supplies a range of speed attributes, we assign NTIA categories based 

upon the midpoint of the range. 

To support NTIA program office requests, we have also modified the structure of the Service Overview 

table.  Even if Maximum Advertised Speed is supplied at the market or county level, we push that speed 

down to the contained Blocks.  The only records that remain in this table, will be those wireline records 

with either a non NULL nominal weighted speed or ARPU value. 

Community Anchor Institutions 
In the first submission, the Community Anchor Institution (CAI) process was referred to in terms of a 

learning curve.  This continues to be an appropriate metaphor.  The mapping team continues to focus on 

data that will support and help inform policy makers and the SBDD planning process. 

In the first submission, the team gathered information on what data was available and what resources 

will be required to engage these categories of important institutions.  In the second submission we 

                                                           
20

 As an example of a response to our request for Block level advertised speeds, we received the following 
comment from one anonymous provider, “This is and of itself does not require anything new of us – just states the 
NTIA supports efforts focused on getting that information on the CB level.”  It would be helpful to have broader 
messaging so that providers understand this new direction.  
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continued to obtain additional connectivity information.  For the Spring 2011 collection, the team began 

a survey process to directly engage these important organizations.    

Our work with CAIs is guided by three principles. 

First, CAIs are important stakeholders within the planning process.  Our goal is to engage participants in 

regional planning that has strong ties into the CAI categories identified by NTIA.  This has a direct benefit 

of engaging an established stakeholder community.   It also allows Broadband planning to tie into 

existing organizational and planning networks.  In each of our states, key relationships with education, 

public safety, libraries, and economic development sectors are being identified and developed. 

Second, we believe that CAIs will likely be one of the primary beneficiaries of targeted Broadband 

funding.  Our belief stems from the sense that many of the benefits of Broadband will extend from these 

community ‘anchor points’.  In other words, it isn’t solely the existence of Broadband at a library that 

provides a benefit.  It is people using applications that work only on a Broadband network to upgrade 

their skills (e.g., online training) and gain access to online content (e.g., job postings, goods and 

services), etc.  The targeted use of a specific application--that can only take place with Broadband 

networks-- is what produces the priority benefit.  Put another way, there seems to be a realization that 

things are less about pure connectivity (for the sake of connectivity) than about connectivity in terms of 

an application (for the sake of the benefit obtained through the application). 

Third, we continue to use a rational and targeted approach to derive information.  This means we will 

utilize our planning teams for as much ground work as possible.  This also means that a goal of our CAI 

process is not an exhaustive Census of anything that could be a CAI; rather, it is the discovery, inventory 

and integration of Broadband planning activities into those CAIs that stand to produce the greatest 

synergies with the SBDD planning process.   

The above implies two significant points.  First, the team’s goal is to document community anchor 

institution connectivity within a broader context of regional and statewide planning objectives.  Second, 

if a particular category of CAI has an independent Broadband planning effort underway, we will 

encourage that organization to take the lead, and we will provide relevant expertise and support as 

warranted.  For example, in one of our states, the public safety community is already engaging in a 

mobile Broadband survey effort.  We have aligned our CAI data collection process with that effort and 

are sharing information and expertise (e.g., hosting a survey) to support their mission.  In another state 

we are attempting to glean connectivity information from a municipal government survey.  There may 

be some downside to this collaborative approach in that we may have to work with data spanning 

different times or we may not have all of the location-specific information we need, but this does 

prevent the same user from receiving multiple inquiries. 

Further, the team continues to rely on the notion of Internet Intensity Zones.  As the Broadband 

coverage information is developed, if we do not have definitive connectivity information from other 

sources (e.g. a phone survey, web survey, listing provided by a facility owner) in this study, those Anchor 

points that fall into an existing area of SBDD Broadband coverage will not be left out or submitted with 

NULL values.  Rather, the adjacent coverage area will be the first estimate of Broadband coverage for 
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the facility.  The use of an estimate allows the site to come into the analysis and learn a bit about the 

accessibility of that facility, but it also frees resources to examine those anchor points that are more 

dispersed and likely under/un-served.  The team will conduct targeted surveys to discover connectivity 

and, more importantly, applications in use at prioritized CAIs.21 

We close this section with a figure that we hope reinforces our CAI process. 

 

Figure 14-Anchor Institution Process 

  

Recall from our first submission analysis, in most cases, CAI points are clustered and on average less 

than 1 ¾ miles away from one another.  Relying on The First Law of Geography22, this likely means that 

the Broadband accessibility is very comparable for CAIs that are close together.  We believe this means 

Broadband accessibility may be less about connectivity than it is about the ability of a CAI to afford, 

successfully adopt and utilize Broadband to support its mission.  Therefore, an important part of where 

SBDD mapping and planning come together understands what Broadband is used for, potential barriers 

to adoption, and how it is an essential component in a planning region’s investment scenario. 

                                                           
21

 We track internally those features with Broadband connectivity defined via an estimate but within the current 
transfer data model we lack a mechanism to propagate that information to NTIA.  Appendix One expands upon our 
thoughts regarding a series of audit fields in the transfer database which would be helpful to inform downstream 
users regarding the source of data or use of estimates. 
22

 http://en.wikipedia.org/wiki/Tobler's_first_law_of_geography.  We are attaching connectivity based upon the 
highest speed wireline provider in that block.  This provides a ceiling for what can be obtained, although the CAI 
may not be purchasing this level of service based upon needs, budget, mission, etc.. 

http://en.wikipedia.org/wiki/Tobler's_first_law_of_geography
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Anchor Institution Survey 
During the third submission period we began a survey process to both verify received connectivity 

information and garner additional connectivity information from CAIs.  As with WISPS we wanted to 

aggressively target and improve this data section. 

The process began with the Round 2 CAI list.  Again, we prioritized schools, libraries and healthcare 

institutions.  A small team made outgoing phone calls to discover relevant contact names.  In Wisconsin, 

we were able to gather about 150 email addresses based upon 440 calls.  There were only 14 refusals. 

While one team worked on improving the contact list, a second team designed and developed a simple 

online survey system called CAVS (Community Anchor Verification Survey).   

 

Figure 15--CAVS Screen 
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Users were invited into the CAVS system by the receipt of a postcard with an organization specific code 

printed on the mailing label.  Beyond the questions shown above, there was a second page to the survey 

dealing with use of Broadband.  Those results are directed to the planning teams. 

The table below summarizes outgoing contact activities by state.  This includes both a post card as well 

as for some organizations in which we had contact information a follow up phone call. 

States 
Post 
Card  Calls 

WI* 2033 75 

ID 1059 259 

WY 345 30 

AL 1640 14 

 

 

As of 3/16, verification23 statistics were as follows: 

State Verified / Total Records Percent Verified 

AL 72/2137 3.3% 

ID 172/1596 10% 

WI24 1187/3945 30% 

WY 169/796 21% 

 

We are keeping the survey open after the Round 3 submission to NTIA and will continue to collect data.  

In Alabama we have also begun to use resources from the planning teams to make outgoing calls and 

better target the surveys. 

Clearly this survey was resource intensive but it did yield an increase in verified, rather than estimated, 

CAI data.  We are unsure if we can sustain it in the next submission, but is has proven to yield new 

information. 

Anchor Institution Trends 
At this point we have focused our CAI attention on schools and libraries, with respect to connectivity.  

We benefit from strong relationships throughout the education sector (K-12 and Post-Secondary).  We 

have also found excellent resources within State librarians in all States. 

                                                           
23

 We say a record is verified when it has been opened by the CAVS test user.  It means at least one field was 
modified. 
24

 In Wisconsin several large school districts supplied files with connectivity information; we performed a bulk 
update in these cases.  We attribute it to the survey as the survey triggered this response. 
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To supplement the education and library information we have formed organizational relationships with 

the major hospital associations within each state.  Our goal with this relationship is to cull information 

from their planning process.  We continue to formalize/advance this relationship.   

As in the prior submission, we are using public domain sources of information for public safety-category 

4.  The vast majority of these locations are estimated with respect to connectivity.  Our hope is that in 

subsequent submissions, we will reduce the size of this category and connectivity information specific to 

root nodes of the public safety network--such as County Emergency Operation Centers.25  At this point 

we have had minimal success gaining this information. 

Because we have a wide ranging population of CAIs in our data set we have a variety of Broadband 

services that don’t always fit NOFA parameters.  Services like PRI or T1 are classified into “other copper,” 

but the bandwidth is estimated based upon the number of channels purchased.  We also had difficulty 

obtaining both the upstream and downstream channel capacities.  In large part, we made the speeds 

symmetrical, but this is an assumption on our part.   

As a final verification step, we attempt to screen the CAI data for duplicate values.  Because many CAI 

are closely clustered together we perform the de-duplication based upon the ANCHORNAME within the 

ZIP code. 

Middle Mile 
Middle Mile information was collected directly from providers via survey or interview.  Middle Mile is a 

“chicken or egg” type of challenge in that it is possible to verify that the infrastructure exists, but 

extremely difficult to know what it is doing without engineering level assistance.  Although most 

providers submitted “something,” there was a significant variance in what that “something” 

represented.   

The purpose of this section is to record some of the comments and questions we have received about 

Middle Mile.  We hope this provides better context for our data submission. 

Within the NOFA, Middle Mile was defined as (a) a service provider’s network elements (or segments) 

or (b) between a service provider’s network and another provider’s network, including the Internet 

backbone. (Collectively, (a) and (b) are “middle-mile and backbone interconnection points.”)26 

Given the existence of the “or” in this definition, providers submitted a variety of information.  Based 

upon the NOFA example, several fixed wireless providers interpreted Middle Mile in terms of the 

connection points from their towers to their own serving backhaul location.  The topology was 

commonly Microwave from their distribution towers to their NOC.  The NOC and towers were listed as 

the Middle Mile points. This seems to be consistent with the first definition clause (a). 

                                                           
25

 Within the public safety category, it is also very difficult to derive precise locations as many CAI are addressed to 
PO boxes. 
26

 From http://broadbandusa.gov/files/BroadbandMappingNOFA(FederalRegisterVersion).pdf at 54, visited March 
28, 2010 

http://broadbandusa.gov/files/BroadbandMappingNOFA(FederalRegisterVersion).pdf
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Telephone, Mobile Wireless, and Cable providers tended to remain either silent on the question, or 

would provide a single location in which Internet peering occurred (clause b).  A number of participants 

explained that the question was quite ambiguous with data traffic moving back and forth over both TDM 

and IP networks--it was unclear where the distinction should be drawn.  As a general rule it seemed like 

many providers listed a single location where Internet Peering occurred. 

A number of providers refused to answer the question on grounds of confidentiality27.  Others would not 

disclose as their Middle Mile points are not owned--another company provides the physical and 

electronic connection to their network.  In other words, the entity providing Broadband is not the entity 

providing Middle Mile. 

Additionally, based upon the new Provider_Type classification of “other,” we have started to integrate 

points provided by Broadband service providers not meeting the NOFA definition.  This includes POP 

locations and aggregation points for public / private networks.28 Within a given submission there were 

two final attributes that tended to concern respondents.  First, speed should be measured in terms of 

only data capacity and what exactly is “data” (e.g., can/should you segregate out voice or video), and is 

the relevant capacity of the physical connection, channelized to a specific virtual circuit on their 

network.   

Finally, a number of other providers were unsure of the height above grade measure (is this their floor, 

the street outside, etc).  We seem to have a combination of height above or below grade, as well as 

heights above mean sea level (AMSL).   

To the extent possible in our timeframe, we verified the location of a sample of Middle Mile points.  

Where we could see infrastructure that appeared to be consistent in location with other provider 

infrastructure, we felt that the location was accurate.  In some cases, the point provided seems sensible 

(is on a road, near other equipment), but using imagery, we couldn’t find a place where this type of 

connection could occur.  This wouldn’t be unforeseen, in that Middle Mile connectivity likely takes place 

in a protected environment much smaller than a standard Central Office installation.  

Mobile Wireless Coverage 
We have received mobile wireless coverage from most mobile Broadband providers in each state.  At 

this point we have cleaned the geometry of the data and attributed it with spectra and FRN as required. 

Provider derived coverage has been reviewed against the commercial licensed product for consistency.  

To a limited extent we also use licensing locations and tower infrastructure to spot-check supplied 

                                                           
27  As received in email 9/30/10, “Due to security concerns and the risk of public disclosure of highly sensitive data, 

whether inadvertent or otherwise, ***REDACT***response to the Middle Mile and backbone interconnection 

request is limited to publicly available information available on {remainder not included}” 

 
28

 As discussed in our readme.txt file, a number of middle mile points were lost in validation due to their location in 
adjacent state.  This will cause a decrease in some providers relative to prior submission. 
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coverage.  This mode of verification remains complex, given the lack of facility-based information with 

mobile wireless. 

Verification 
Almost by definition, data verification is an ongoing and evolving process. Clearly, with each new data 

submission there will be a validation process at hand and at the same time, our team continues to 

expand and improve the efficiency and effectiveness our data verification routines. Consistent with the 

movement toward an fGDB export database and use of a data receipt script, much of our validation 

effort was spent in supporting the ETL processes into the required formats.  In future data submissions 

we will continue our work to stabilize and improve the business process that normalizes provider 

submissions into NOFA formats and expands in more depth on the confidence analysis within the data.  

Verification Standard 

 
Our overall verification standard is focused on the level at which we supply processed data to NTIA.  This 

means that the vast majority of our verification process will be focused on ascertaining coverage for 

Census block’s less than 2 square miles and covered road segments. 

We are learning that Verification has multiple dimensions. 

Provider verification is finding providers who supply Broadband and discriminate out providers not 

meeting Technical Appendix A’s definition of Broadband.  

Identity verification is taking the provider’s categorized in the first step and ensuring that the provider 

either has a valid FRN or is assigned a default FRN.  Identity verification is very complicated because of 

the Technical Appendix A’s mandate to record data at the FRN, Provider Name and DBA level.  Each of 

these attributes could be unique for a single provider going to market under different or the same 

names.  As a result, rolling up each provider into an identity collection that matches either the FCC data 

integration team or a third party Broadband provider’s data view, is very, very time intensive.  Identity 

verification is discussed in the earlier section-- Developing the Provider List. 

Coverage verification is a broad term, but in our definition it boils down to determining if Broadband 

coverage is in the right place.  For a given provider, the question is whether the coverage is assigned to 

appropriate Census Blocks, road segments or area features.  Coverage verification can be further broken 

out into two distinct classes: 

 Technology verification, which is determining if the provider is listed with a technology 

consistent with their marketing information.  It also involves a validation with supplied speeds.   

 Speed verification, which is determining if the speed supplied for that block, road segment, 

point area file or market area is consistent with the technology and the marketing information 

received. 

The final verification dimension is consumer feedback and crowd-source verification.  This is a dynamic 

set of steps we are beginning to implement.  One side of this is responding to consumer concerns.  The 
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second is using the crowd sourced data to validate provider claims and, if appropriate, update the map 

and the underlying data. 

At this stage, our working hypothesis (confirmed by our experience) is that there will not be a single 

dispositive measure to indicate Broadband coverage availability in a Census block or along a segment.  

From prior work, and examining our current provider submissions, we believe that there is too much 

variation below the submitted record to make a single binary yes/no indication.  Rather, there will be a 

series of measures that combine to provide qualitative confidence (a classification scheme) in our 

indication of Broadband availability at the block, segment, or wireless polygon level. We believe such a 

qualitative confidence scheme is both relevant to and supportive of NTIA interests, as well as the 

interests of our end-user community – that is, the states and citizens we serve through this program. 

The intent of this section is to illustrate why we are moving toward a particular verification 

methodology.  Our team is learning as we go along, and will adjust and improve this thinking. But given 

our experience to date, this is where we are heading. As stated above: 

 First, coverage verification is at the level of data submitted to NTIA. 

 Second, coverage verification is enhanced when there is a secondary measure of availability 

(such as infrastructure presence or serving area boundaries) 

 Third, given the limited resources of this effort, the most important coverage verification 

process to implement is the erroneous dispersion of coverage.  These are the “islands” of 

coverage isolated by significant distance from other covered areas.  This is the opposite of the 

Internet Intensity Zone notion discussed in the Community Anchor Institution section.  In other 

words, Broadband Internet likely doesn’t exist far away from other areas with Broadband 

Internet access. 

Before explaining our overall verification thought process, we have several examples, which illustrate 

the complexity of coverage verification. 

The first example is taken from a gentleman who requested a map change in Alabama.  His home is near 

the yellow dot.  The darker grey Blocks are covered Census Blocks.  The black lines are covered road 

segments.  He cannot receive DSL from his incumbent provider, although his neighbors can.  The 

incumbent carrier does have at least one structure in that block from which Broadband services can be 

provided; unfortunately his home is not served.   
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Figure 16--Sub block variation 

Because the SBDD program requires the depiction of coverage at the block level, the above map has 

been correctly generated.  However, from the customer’s point of view, the map is inaccurate.  This 

requires us to explain that the maps are not intended to be a structure-level qualification, at which point 

some consumers question the value of the maps when seeking service information.  Of course, we also 

share this information with the incumbent carrier in the area so they are aware of a potential customer 

market. 

Beyond this type of one-off structure-level qualification, sometimes, as shown below, we have even 

larger gaps in provided coverage.  The image here shows an “outlier” block that could be an error, or it 

could indicate missing Blocks along a major road that should have been filled in.  In this figure, the 

outlier block is highlighted in turquoise. 
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Figure 17--Dispersion in Submitted Data 

 

In this particular case, we are faced with a different verification question.  Based upon the properties of 

the neighbors, we believe this block should likely be covered (coverage interpolation,) but supplied data 

from the incumbent says otherwise.  

The next example, at a somewhat larger scale, shows where an interpolation process requires some 

adjustment.  The figure below shows a town level.  There are some smaller Blocks that are likely covered 

by interpolation logic, but we also do not want to extend coverage beyond a franchise boundary as in 

the areas shown in a box on the bottom of the map. 
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Figure 18-Where do you stop interpolating? 

From what we can gather from some providers, the submitted data—data with consistently high 

degrees of dispersion or coverage holes—tends to come from geocoded billing records.  In this 

paradigm, this means where there are no customers; service is not identified on a map.  The 

interpolation verification question then takes on two dimensions. 

First, if a provider has no customers in an area, how can we know if they would be able to 

provide service in a 7-10 day interval? 

Second, if we use the properties of neighboring Blocks to interpolate coverage, when should we 

stop (e.g., at a franchise boundary, at a certain distance, etc.)? 

We continue to work with providers to get additional information to help us better understand and 

contend with this type of circumstance.  However, we have not been entirely successful at getting 

franchise boundaries that would address much of the issue. 

The final map shows this dispersion problem, but to an even larger degree.  This solitary large block is 

likely the result of a bad geocode, but we don’t know, given the data that has been submitted by the 

provider and the “single customer in a block standard” set by the NOFA clarification. 
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Figure 19-Dispersion in covered Blocks 

Due to the fact that this situation is quite obvious in display, this type of problem is one that we are 

more aggressively trying to resolve.  Where a single block has no neighbor offering comparable coverage 

and is a specified distance beyond an exchange boundary, our approach has been to filter these Blocks 

out.  As of now, this filter is limited to incumbent DSL providers because we have a good source of 

exchange boundaries.   

The exchange boundary dispersion verification method breaks down when examining smaller providers 

who are more likely to CLEC into neighboring territory. In the figure below, the black line represents the 

exchange boundary, while the continuity in the DSLAMs likely points to coverage extending along a road 

into another provider’s territory. 

 

Figure 20--DSL Coverage outside of exchange boundary 
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In sum, the variability in our source data continues to suggest that our dynamic verification process is 

relevant, appropriate and evolving in a manner consistent with the overall program.  And, as noted 

above, we believe the more meaningful outcome of our verification processes will likely be a series of 

qualitative indicators or expressed confidence levels.  Our concern, as with the development of any sort 

of classification process, is how rigid we should make this classification given the variation in our input 

data and the varied perceptions of service providers, map viewers and down-stream data consumers.   

Verification Work Process 

To support our dynamic multi-factor verification process, we have implemented the following steps. 

First, when data is received, an analyst reviews the submission and any immediate questions or 

concerns are sent back to the provider as quickly as possible.  We have found this gatekeeping step very 

helpful in making sure we understand the intent of the submission.   

Second, for all providers who submitted data to us in the second round, they received both a tabular 

data summary and a mapped output.  Prior to releasing the “check maps” to providers, we had a team 

of analysts visually inspect each provider’s coverage area.  The focus on this QC effort has been to 

identify and flag suspect Blocks.  After this in-house review, we solicited a second level of feedback from 

providers and received a number of requested changes and corrections used in the development of the 

April, 2011 Round 3 dataset. 

For those providers who submit only block or segment level coverage (i.e., in those cases where we have 

no infrastructure to test with) we test for coverage containment within known service boundaries.  The 

intent of this validation step is to remove Blocks that are obviously erroneous. 

As mentioned in the sections above, we have implemented a check on dispersed Blocks, but we have 

implemented less with respect to coverage interpolation (holes in coverage). We continue to work on a 

series of mechanical tools to assist with the inspection process but have run into challenges related to 

geographic basemap and timing. 

As our submissions have moved online, we have also begun to benefit from crowd source feedback.  In 

some cases this has helped us identify and fix errors in our underlying data. In other cases, as we have 

shared with NTIA, we have encountered some perceptual issues rooted in how the data are developed 

and modeled to comply with the NOFA.  Depiction of uniform coverage in small Census Blocks continues 

to be a challenge. Despite our best efforts to explain the full block coverage requirement, we continue 

to receive complaints that the coverage shown on the map is not accurate for a particular location 

within that block.  

Consumer and Provider Responses to Deliverables 
Here, we segue from internal verification to external verification.  We view responses to our work 

product as a form of validation and verification.  On the one hand, this gives us the opportunity to fix 

mistakes and then generate QA steps to make sure that the problem does not reoccur.  We also learn 

how to improve what we are doing or better explain what we are doing to a community not always 

familiar with the NOFA and program office framework.  On the other hand, listening and learning from 
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this feedback helps us better target our mapping deliverable to meet the needs of our external 

customers.  In this second case, external feedback not only provides feedback on perceived qualities (or 

lack of quality) in the data, it helps us to learn if we are developing data that is truly helpful to 

downstream users. 

At this point, our external deliverables take three forms: State Broadband Maps, data transfer to NTIA 

used for the National Broadband Map, and text format data requested by outside parties. 

Online Map Experiences 

Now that our State maps are online, we continue to harvest viewer feedback and comments.  Because 

an online map allows someone to zoom in far below the scale of the data, a large number of comments 

reflect sub-census block concerns. While important to the citizens reporting these issues and to our 

Broadband planning teams, this level of data is outside the scope of our core validation process, which 

as noted above, is focused on the level of data submitted to NTIA.  

There are several other themes that our team believes are important to share.  These comments are 

actually quite helpful because they also improve our data processes to better meet the needs of map 

viewers.  For example, we have invested significant time in harvesting more segments from provider 

data.  Because the appearance of segments is so important, we are putting time into ensuring a visually 

appropriate edge match between the roads we harvest and the Blocks/roads we will show online.  On a 

technical level, we also believe that a good segment process will help us understand more about 

dispersion in the data, and what is valid versus what is not valid. 

Perception of Unfair Treatment Across Technologies 

Several Broadband service providers have expressed strong concerns regarding how wireline services 

are displayed, as contrasted to how wireless coverage is displayed.  This is an artifact of the SBDD data 

model. As an example, consider the figure below. 
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Figure 21--Multi Network Coverage portrayal 

In this image, covered Census Blocks are light gold.  Covered road segments are a darker gold and 

wireless coverage is purple.  The concern seems to come down to how a wireline provider’s coverage is 

shown in the large Census Blocks (greater than 2.0 sq mi).  Wireline providers have expressed 

dissatisfaction because their coverage is only tied to road geography, which leads to a visual “hole” in 

their coverage map.  At the same time, they feel that it is unfair that the wireless provider’s coverage is 

shown to be uniform in the same area.  Put another way, if our maps show wireline in terms of Blocks 

and segments, why don’t our maps show wireless the same way? 

Perceptions of COLR Obligations 

Wireline providers have also expressed dissatisfaction because online maps limit the distance of 

coverage from a road segment.  In our current online maps we buffer a wireline carrier’s service 300’.  A 

number of providers have expressed that they are mandated to provide voice coverage (which 

Broadband will accompany) anywhere in the Exchange.  There seem to be many dimensions to this 

argument, but the basic concern comes down to not being able to accurately reflect the scope of their 

COLR obligation within the mixed block/segment view.  Their ability (or lack thereof) to actually 

provision such services for new users within a 7-10 day period adds yet another level of complexity 

when attempting to fairly portray their coverage capabilities. 
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Intentions of Coverage Mapping 

When a viewer of an online map clicks on the map (or zooms to an address), they are provided with a 

pop-up of service provider coverage in the area.  The critical question is this: what is the area to which 

that pop-up window responds to?  In the past, we reported back to the Census block, or buffered road 

segment intersected by the user click.  As far as the map was concerned, once we move off of that road, 

or out of that segment, we have a new area to examine.   

Our sense, given feedback received, is that our provider view should be a bit more tilted toward finding 

providers in a general area, rather than finding providers at a single-click location.  If the goal of the map 

is to get someone to call a provider for service, our bias should be to include all of the potential 

providers in the general area, rather than giving potential customers a method to self-disqualify.  That is, 

we want to cast a wider coverage net, rather than one too narrow.  The problem with this approach is 

that it will create a number of false positive Broadband reports.  As of this date we cannot determine if 

the claims of inaccurate coverage in online maps are due to the looser provider view standard or not.  

We keep this looser standard in place to minimize the likelihood of self-disqualifications. 

National Broadband Map Experiences 

When the National Broadband Map launched, our phones began to ring. 

Responding to a number of provider inquiries as well as emails from citizens provided some insights.  It 

also illustrated that we now bear a second dimension of external verification.  That is, we must be 

prepared to respond to people who are confused by apparent inconsistencies between the State and 

National Broadband Maps29.   

The case below, based upon a call we received, illustrates some interesting intersections between the 

State and NBM. 

In this example a Citizen called inquiring about the difference in results between the National 

Broadband Map and our State of Alabama map.  The issue in question was coverage at his home.  The 

Alabama map showed he had coverage at his home, but the National Broadband Map said he did not. 

In the image below, the green dot represents the geocoded location of his home.  Based upon imagery, 

the geocode is quite accurate.  The olive colored polygon represents a covered Census block less than or 

equal to 2.0 square miles.  The Census block shows coverage by a number of wireline providers. 

The geocoded point is about 170’ from this covered Census block. 

                                                           
29

 We have a similar concern regarding textual data extracts.  We may translate our SBDD submission into covered 
Census Blocks in a way that is different from NTIA.   
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Figure 22-NBM Covered Census block example 

In the next image, covered TIGER road segments are shown in green.  It is important to note how far the 

TIGER road centerlines are from the actual roads in the subdivision.  It appears the geocoded point is 

reflecting more recent and more accurate road centerlines, placing the green dot at the correct location. 

Since the SBDD data is submitted in terms of TIGER 2000 the road on our map shows up about 100-200 

ft away from where that road is located today.   



SBDD Mapping Methodology Page 54 
 

 

As mentioned previously, however, our online maps buffer road segments to 300 feet on either side of 

the road centerline.  In this case then, our state map buffer is large enough to return valid service 

providers for this green dot.  The NBM, on the other hand, does not appear to buffer segments or the 

edges of census Blocks and will not return providers for this location.  Our intent in this example is not 

to criticize the national map; rather, it is to illustrate that we may inadvertently make trade-offs 

between false positives and false negatives, differently. 

This case illustrates several important tensions between the data as we present it to NTIA, map it 

ourselves and because of how it may be viewed within NBM context.  A lack of agreement on how to 

handle these inconsistencies in the source data and differences in mapping approaches may cause 

consumer confusion.  

The issues seem to come down to this 

a) How do you (or can you) handle the impact of time when roads move between TIGER versions 

or between TIGER and other road products?  In this case, online map road traces will not show 

up in the right area. 
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b) Given the inconsistencies between TIGER geometry used in submission and underlying 

roadbases used for geocoding online, how do you (or should you) insulate the viewer from the 

inconsistencies.  There appears to be a strong likelihood that TIGER judges a particular point to 

be in a larger than 2.00 sq mile Census block while that same location could be in a small block 

area in the online view. 

c) How much tolerance should be introduced when returning a list of valid providers?  Is it 

better to error on gathering too many providers or too few? 

d) Since the NBM gathers feedback based upon its representation of coverage, how can/how 

should this crowd sourced feedback influence data presented in a different manner elsewhere? 
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Appendix One  

Data Collection Challenges 
This section summarizes some of the challenges we have experienced with data collection and 

processing.  The team believes it is important to categorize these challenges as they help inform the 

geoprocessing and verification methods used.  It is also our hope that some of the more global issues 

can be discussed and decided within the Grantee community.  

We begin with several global issues and then continue toward more granular challenges. 

Global Data Collection Issues 

Census Block and Road Standards are not clear 

Most carriers submitting Census level information provided 2000 Blocks.  A few provided 2009 or 

alternative (TeleAtlas, possibly) Blocks. Especially with the need to derive segment geographies, we 

would prefer to message the providers a specific Census standard—but we’d like to be consistent with 

other Grantees so as to minimize work from the provider community.  As of now, that standard is 

Census 2000.  If NTIA anticipates using Census 2010 for Fall 2011 collection, it would be helpful to 

message that as soon as possible.    

Also there seem to be several methods by which providers are calculating the area.  So the distinction 

between at 2.00 square miles can be uniform, it would be ideal to articulate an operational area 

calculation definition as early as possible. 

Providers Not Wishing for Block Level Aggregation of Their Data 

Both ***REDACT*** have supplied address point level data.  Both carriers want NTIA to have the point 

level information, and they have asked CostQuest/LinkAMERICA not to aggregate their coverage to 

Blocks.  Other than a verification to make sure that point data were contained within, or fell within 1 

mile of exchange boundaries, the only other processing was normalization into NTIA formats. 

Broadband Providers not Meeting the NOFA  “Provider” Definition 

PBWorks appears to reflect a concern among a number of grantees about what a Broadband Provider is-

-and how that definition impacts mapping. 

If the 7-10 day provisioning rule is to be strictly enforced, it would seem to eliminate a number of 

prominent Broadband providers30.  Further, the need for clarification around a facilities-based provider, 

versus the reseller, has injected even more ambiguity into the mix.  Right now we are unclear on how 

                                                           
30

 By email ***REDACT*** informed us they could not provision in 7-10 days, but they also supply information on 
qualified locations to the address point level.  Therefore, we draw a distinction between an incumbent provider 
owning the facility--which terminates at a customer premise--who cannot turn up service at a qualified location, 
versus a provider not reporting any specific qualified locations in which they cannot turnup service in the 7-10 day 
window.  In the first case we have a sense of where service can be offered and verified.  In the second, we have no 
evidence that a service could exist there until a specific location becomes a customer. 
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strictly to interpret either of these important distinctions, but we are concerned that we are beginning 

to create an NTIA exclusion criteria that is going to confuse downstream consumers of the data.   

Again, we do not want to exclude a service provider, but we believe there needs to be further 

clarification around the 7-10 day ”rule,” the definition of a “reseller,” and better interpretation of 

facility-based providers, versus equipping UNEs, SpA or leased lines. 

We have used the Provider Type of ”Other” to classify a number of providers who offer Broadband 

services, but we do not offer them in a manner consistent with Technical Appendix A definitions. 

To What Extent Should We Begin “Classifying” the Data and Maps? 

The question immediately preceding gets to the intent of a Broadband Provider.  This question gets to 

the intent of the Data and Maps. 

Earlier in this document we discussed the question of what type of bias we should introduce to our 

online map messaging.  In an online environment, do we want to more likely create an overstatement of 

coverage for a provider than an understatement?   In other words, is the larger problem allowing a 

consumer to self-disqualify, versus calling a number of neighboring providers?  There is a related issue 

to this.  Clearly in our maps there is a lot of scatter in data that we believe should be more continuous.  

These are the islands of coverage from an incumbent provider31.  There are a number of processes that 

could be put in place to deal with this type of scatter, but without more information from the service 

provider-- essentially the last mile facilities-- it will be difficult to perform this clean up in an informed 

manner.  On the one hand, we can aesthetically clean the maps up and reduce the scatter, but we have 

little sub-block engineering information upon which to make this decision.  Right now our preference is 

to put out a somewhat aesthetically messier deliverable and work with providers to get better 

information to clean their submission.  If that isn’t forthcoming, we are limited in what can be done 

given the lack of facility level information.  In summary this yields two questions 

1. In our online maps should we error on overstating coverage to prevent consumer self-

disqualification? 

2. In our online maps should we work to clean up a lot of the scatter that we see without having 

facility-based evidence from which to remove it? 

Granular Data Collection Issus 

Non-Uniform Submission Standards  

It is clear among providers that there isn’t a consistent method used to derive Broadband coverage.  

Some providers appear to be using a geocoding approach and then point in polygon or point on segment 

process.  Others may be using GPS locations.  In some cases, it is difficult to infer what reference data 

                                                           
31

 For a provider who sells opportunistically (not within a franchise area) it becomes even more problematic to 
classify their coverage because the points are more related to the type of consumer purchasing the service than a 
bounded offering.  In a matter of speaking, the Provider_Type is more determined by the technology and/or 
location than a type of business.  The core intent of the NOFA and our grant application was centered around the 
7-10 day providers but we believe maintaining information on Provider Type “Other” and  “Reseller” is important 
to assist in validation and market segment analysis as resources are available. 



SBDD Mapping Methodology Page 58 
 

was used to georeference plant (is it the carrier’s roadbase?).  This leads to uncertainty regarding the 

input data scale or accuracy of other base layers.  Although we may be trading off absolute accuracy, our 

standard has been to conflate data to TIGER 2000 Blocks and TIGER 2009 roads.  We perform our 

verification against this conflated data product. 

Temporal 

We are unsure of how well the data are temporally consistent.  Some providers gave us their best effort 

to control to December 31, 2010. We note that some providers were clear that the submission was as of 

extract date without any way to move back in time.  They have no means to control for time and cannot 

provide any audit support beyond when the data are released to us.  Some data-especially loop 

qualification data-may change from day to day. It will be very difficult to clarify why something was 

changed from a given point in time. 

Perceived Inaccuracy with Respect to Internal Standards 

The NOFA is clear on submitting a list of Blocks in which a provider delivers Broadband service.  This is a 

different objective than perfectly reflecting service territories.  If a firm’s accuracy standard is a 

reflection of their service area, then the data created under the NOFA will not meet their perception of 

accuracy.  This leads to two other issues:  First, using Census Blocks rather than serving area may 

overstate or understate a particular provider’s Broadband serving area.  This was a significant concern of 

***REDACT*** who specifically required us to submit only address-level qualification data.  The second 

issue this brings up is how or if, there should be some standard on how much of a Census Block needs to 

be covered to call it covered.    

Confidentiality  

Several providers have noted concerns with CPNI-related issues and have stated this as a reason for 

non-participation.  We have also heard expressions of comparable concern regarding identifiable 

responses to Anchor Institution information. 

Unclear on Definitions  

As discussed earlier, several providers claimed confusion on several key terms involved in Middle Mile.  

We note a consistent stream of questions around the interpretation of Maximum Advertised Speed.  

Some providers understand this to be the most common speed package bought within the mass market, 

while others view this as a speed that can be purchased for an additional cost above a mass market 

offering (eg. a Turbo option for an additional fee per month).  Others interpret this as the fastest speed 

that is available for that particular location--in terms of xDSL, a structure qualified speed, for example.   

Perception of Data Use 

There seems to be some hesitancy releasing speed information because no one is sure of how the 

information will be used, or what the speed is intended to reflect.  A number of providers have verbally 

indicated that typical speed will be about (on average) 80% of purchased speed due to overhead.  But 

there are many other factors (such as a user’s home network) that influence speeds measures.  

Providers are concerned about introducing statistics without a clear understanding of how those 

statistics are derived and will then be used.  Also, as advertised speed is pushed down to a block level, 

we sense more trepidation to report speed values.  This quickly begins to touch on parity across network 
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types (why is wireline down at the block when wireless is half the state, etc.).   Finally we are also noting 

a significant increase in speed reported to us.  This may be due to network upgrades or competitive 

concerns to match the theoretical network speed. 

Location Uncertainty In Source Data 

Within this document we have noted concerns about the impact of source data accuracy.  Our 

geoprocessing methodology provided what we believe is a relatively conservative tolerance to account 

for the scale issue in the source data, but we are unsure of how this may impact downstream users.  

Clearly, it also impacts the verification process because we can’t attempt to verify received data beyond 

a scale at which it was developed. 

Covered Segment Process 

Deriving those Broadband covered segments in Census Blocks greater than 2 square miles has proved to 

be a challenge.   Moving from a NOFA specified tabular deliverable to an anticipated geographic 

deliverable also increases the complexity of the effort.   

Change Management Process 

One thing that is becoming clear is that a change management process that is consistent between the 

data provider and NTIA is needed.  In this light, publication of the current data transfer model beyond 

the PBWorks community would also be helpful.  Many providers are designing their data extracts with 

the NOFA in mind and the NOFA structures have been supplemented in the current model. 

Finally, it would be helpful, as early in the next cycle as possible, to know what Census Block vintage we 

are expected to deliver to NTIA.  It would also be very helpful to maintain a stable geographic base for 

the next deliverable so that the basis of verification doesn’t change. 

Record Level Metadata 

It would be helpful to have one or two additional fields in each feature class transmitted to NTIA.  One 

User Defined field could be helpful as an expression of record level confidence.  The second field could 

be used as a Key between the transfer geodatabase and our systems.  Ideally, both fields could be large 

text fields (50 char) so the Grantee can use them to express a variety of attributes. 

Miscellaneous Data Collection Notes 

 We note the following important observations regarding our data submission: 

1. There are Middle Mile plant records for providers who are not present in the Census block, 

segment or wireless area feature classes.  This is due to classification as non-NOFA Broadband 

providers. 

2. In some cases, we have trimmed wireless coverage estimates to honor state boundaries. 

3. We believe some providers are trimming their coverage to honor license area boundaries. 

4. As a departure from past practice, where a provider submitted Middle Mile points out of state, 

we are no longer passing those points to NTIA as they fail the validation script.  We experienced 

validation errors for BroadbandServed=N records in the CAI table.  These records were 

attributed a Technology of Transfer=0.  This cleared validation. 
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5. In tables with mandatory Zip5 (Service Address), if the End_User_Zipcode was not available, we 

have inserted ‘00000’ 

6. We have a significant amount of VDSL, ADSL 2 and ADSL 2+ coverage categorized into the xADSL 

category. 

7. We have left in the data Middle Mile locations with above grade elevations that appear to be 

unreasonable, given review of orthoimagery.  This seems to be confusion between above grade 

request and above sea level readings. 

8. All fGDB have passed validation except in cases where attributed speeds did not agree with 

domains associated with technology of transmission (eg Upstream Speed of 2 with ADSL). 

9. We note a few providers who have speeds seemingly inconsistent with their technology of 

transmission.  This is either very low speeds with optical fiber, or very high speeds with non 

DOCSIS 3.0 systems. 
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Appendix Two 
This appendix contains the confidentiality clarification supplied in a series of emails between CostQuest and NTIA. 

Feature Class Metadata NOFA 
Confidential? 

Online Map Public 
Disclosure 

Exemption 

Last Mile Constraints on accessing and using the data Yes No No None 

  Access constraints: None      

  Use constraints:       

  This data is confidential as defined in the 
NOFA. 

     

            

Middle Mile  Constraints on accessing and using the data Yes No No None 

  Access constraints: None      

  Use constraints:       

  This data is confidential as defined in the 
NOFA. 

     

            

Service Address Constraints on accessing and using the data No No Yes   

  Access constraints: None      

  Use constraints:       

  There are no restrictions on distribution of 
the data by users.  

     

            

CAI Constraints on accessing and using the data No Yes Yes NO 
attributes 
on any 
record in 
this feature 
class are 
considered 
confidential 
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  Access constraints: None      

  Use constraints:       

  There are no restrictions on distribution of 
the data by users.  

     

            

Census Block Constraints on accessing and using the data No Yes Yes NO 
attributes 
on any 
record in 
this feature 
class are 
considered 
confidential 

  Access constraints: None      

  Use constraints:       

  There are no restrictions on distribution of 
the data by users. 

     

            

Service Overview Constraints on accessing and using the data No Yes Yes The only 
provider 
who may 
not show 
up this 
table is a 
provider 
who has 
provided 
only 
confidential 
data (last 
mile, 
Middle 
Mile, 
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address 
point with 
provider 
name) 

  Access constraints: None      

  Use constraints:       

  There are no restrictions on distribution of 
the data by users. 

     

            

Road Segment Constraints on accessing and using the data No Yes Yes NO 
attributes 
on any 
record in 
this feature 
class are 
considered 
confidential 

  Access constraints: None.      

  Use constraints:       

  There are no restrictions on distribution of 
the data by users. 

     

            

Wireless Constraints on accessing and using the data No Yes Yes NO 
attributes 
on any 
record in 
this feature 
class are 
considered 
confidential 

  Access constraints: None      

  Use constraints:       
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  There are no restrictions on distribution of 
the data by users 
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COVER LETTER 
 
 
April 2011   
 
 
Ms. Anne W. Neville 
SBDD Grant Program Director 
National Telecommunications and Information Administration 
U.S. Department of Commerce 
1401 Constitution Avenue, NW Room 4716 
Washington, DC  20230 
 
Dear Ms. Neville: 
 
Please accept this submission from the Partnership for a Connected Illinois (PCI), the Designated 
Entity for Illinois.  
 
These artifacts should be found to be compliant with the April 1, 2011, deadline for the semi-annual 
data update and in accordance with the terms of the July 1, 2009, Notice of Funds Availability 
(NOFA) and all subsequent clarifications. 
 
This cycle, PCI assumed full responsibility for the data-collection activities from broadband 
providers in the State. Assuming this role is vital to achieve the State’s goals with regard to 
improving broadband access and adoption – and which are in turn central objectives of the 
Partnership for a Connected Illinois. All facets of this data-collection transition, and the activities 
that flowed from it, are included in the narrative that follows. 
 
If you have any questions about this Data Narrative, please do not hesitate to contact me, at 217-
816-4151. 
 
Respectfully submitted, 
 

 
 
Drew Clark 
Executive Director 
Partnership for a Connected Illinois, Inc. 
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THE TRANSITION IN ACTIVITIES FROM CONNECTED NATION TO PARTNERSHIP 

FOR A CONNECTED ILLINOIS 
 
During the data submission cycle ending on April 1, 2011, the Partnership for a Connected Illinois 
(PCI) took major steps in its three-fold mission to collect and publish broadband data, to ensure 
broadband access throughout the State, and to maximize broadband’s impact. This data narrative, of 
course, focuses on the data-collection and publication activities of PCI. 
 
In these efforts, PCI assumed full responsibility for the data-collection activities from broadband 
providers in the State. Assuming this role is vital to achieve the State’s goals with regard to 
improving broadband access and adoption – the other two core missions of PCI. In 2010, PCI had 
worked together with a subcontractor, Connected Nation, in performing this function for the data-
collection cycles that ended on March 31, 2010, and on October 8, 2010. As part of the transition 
from Connected Nation to PCI, in 2011 PCI established its own Non-Disclosure Agreements 
(NDAs) with broadband providers for confidential information. PCI also collected updated 
information from providers throughout the State. The NDA used by PCI did not differ from the 
NDA used by Connected Nation. However, Connected Nation was not willing to provide PCI with 
the confidential information that Connected Nation collected on behalf of the Partnership for a 
Connected Illinois. Therefore, PCI had to obtain NDAs in its own name with providers. 
 
However, our subcontractor Connected Nation did provide PCI with the non-confidential 
broadband provider information at the Census block level on November 30, 2010. As a result of 
obtaining this data, PCI undertook to re-build and re-launch the broadbandillinois.org web site. PCI 
did this in approximately six weeks’ time, or on February 17, 2011. This consumer-friendly interface 
allows for residents of the State to intuitively access the information collected by PCI – and provides 
the ability to “crowdsource” the collection of price information, actual speed data, and to let 
consumers verify the data provided by broadband providers. Further information about the 
broadbandillinois.org web site will be discussed later in this data narrative. 

PROVIDER OUTREACH BY PCI 
 
Beginning on February 2, 2011, all providers were sent requests to reestablish a Non-Disclosure 
Agreement between PCI and the provider. Since PCI would now be collecting the data in-house 
without the assistance of Connected Nation, it was necessary to start this process from the 
beginning. Of the 164 providers included in the data package, PCI has managed to execute an NDA 
with 90 of these organizations during this two-month span. As part of the same request, every 
provider was asked whether or not they had new data, as of December 31, 2010, that they would be 
including in our April 1, 2011, submission. Similar requests were sent on February 16, March 2, and 
March 9. As providers responded, they were no longer included as part of these mass requests. 
Multiple phone calls were made to those providers who did not respond to the e-mail 
communications. 
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The entire process was tracked on Salesforce, PCI’s project management tool. When an NDA was 
established with a provider, the date that NDA was established was recorded on Salesforce. A field 
in Salesforce was also populated as to whether or not the provider would be submitting new data for 
this Cycle 3 submission. If a provider responded with no change to the data, PCI removed priority 
from that provider and refocused attention on those providers who reported that there was a change 
to their data as of December 31, 2010. PCI wanted to establish the NDAs by focusing on those 
providers with new data to submit. 
 
Of these 90 providers with whom PCI entered into an NDA , 33 also provided changes to their data 
in the form of new towers, speed changes, etc. Additionally, two new providers were added to the 
dataset: Cornbelt Communications and Wireless Data Net. Two other providers, Hughes Network 
Systems, LLC & WildBlue Communications, Inc. provided satellite data. That satellite information 
was not included as part of the geodatabase. A total of 37 providers established NDAs with 
Connected Nation for previous submissions and an additional 30 providers provided data to 
Connected Nation in a previous cycle of data submission. However, these providers were 
unresponsive to multiple attempts in February and March. These providers will receive much 
attention for the Cycle 4 submission by PCI. The table below summarizes the status of NDA’s 
among providers included in this submission. 
 

Total number of providers included in this submission 164 

NDA executed with PCI in this cycle 90 

NDA executed and data provided with Connected Nation in previous cycle, 
unresponsive in this cycle 

37 

Data acquired in previous cycles from Connected Nation without NDA, unresponsive 
in this cycle. 

30 

Provider reported no update to data, and no NDA was executed 5 

New provider included for this submission 2 

 
Throughout the month of March, the PCI data team formatted data as it was received. A cutoff date 
of March 21, 2011, was established for the acquisition of new data to include in this submission. A 
total of nine providers provided data after this date. That will be included in the next submission.   
 
The table below summarizes the status of data among providers. 
 

Total number of providers included in this submission 164 

Data acquired in previous cycles from Connected Nation, unresponsive in this cycle.  67 

Provider reported no update to coverage area. 53 

Provider reported and provided an update to coverage area that was included in this 
cycle. 

33 

Provider reported and provided an update to coverage area after cutoff date for data 
included in this cycle. 

9 

Provider reported and provided satellite data. It was not submitted due to additional 
information being necessary to show where service is available in the State, rather than 
submitting the entire State boundary as serviceable area. 

2 
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DATA ACQUISITION:  ILLINOIS COMMUNITY ANCHOR INSTITUTIONS 
 

PCI has established an ongoing procedure for gathering data on the physical location and broadband 
connectivity of  Community Anchor Institutions (CAIs) in accordance with the data requirements of  
the SBDD NOFA Technical Appendix. 

As with the October 8, 2010, submittal, PCI identified existing, centralized sources for CAI 
connectivity data. With the assistance of  Southern Illinois University, PCI geocoded each submitted 
data point by using ESRI software and Google batch geocoding programs. 

Both carrier and price information were requested, and the speed test became a required item for 
completion of  the survey. For the CAI survey, we utilized the speed test(s) currently being 
administered on the Federal Communications Commission web site. 

The total number of  CAIs stands at 26,559. Notwithstanding this relatively high number, PCI has 
made an effort to refine the survey process to identify priority CAIs within each category, and to 
collect connectivity data for these locations. 

As an example, of  the 26,869 locations submitted in October, there were 14,000 Category 3 
Healthcare locations which were geocoded, yet had no connectivity data. Many of  these were for 
actual practitioners as opposed to clinics, or what might be considered institutions. PCI will 
reevaluate the necessity of  including these in our Cycle 4 submission.  While we have elected to 
include this larger number for the October filing, we have also identified 1,358 priority Healthcare 
locations, which include hospitals, clinics and other significant facilities.  

Smaller adjustments in Categories 4 and 5 have resulted in a total of  12,051 CAI institutions within 
the PCI priority list. 

Category 6 also requires some explanation. Data for the 1,449 Governmental locations had been 
submitted as a set of  existing connectivity data with a 100% response rate. These numbers have 
been included again in the October filing.  This data was provided by the Illinois Century Network 
in a previous round, and PCI has continued to include the ICN data in all subsequent submissions. 
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Category 

Total 
Number 

of CAIs in 
March 

2011  

Connectivi
ty Data 

Points in 
March 

2011  

% of CAIs 
with 

Connectivi
ty Data in 

March 
2011  

Total 
Number of 

CAIs in 
October 

Submission 

Connectivi
ty Data 

Points in 
October 

2010 

% of CAIs 
with 

Connectivi
ty Data in 

October 
2010 

School - K through 12 5,604 1,417 25.29% 
                       

5,651 
                     

1,165  20.62% 

Library 1,444 713 49.38% 
                       

1,505  
                          

633  42.06% 

Medical/healthcare 15,267 138 0.90% 
                    

15,358  
                             

96  0.63% 

Public safety 2,339 433 18.12% 
                       

2,360  
                          

384  16.27% 

University, college, other   266 111 29.47% 
                            

307  
                          

116  37.79% 
Other community support - 
gov  1,449 1,449 100.00% 

                       
1,454  

                     
1,454  100.00% 

 
Other community support - 
non-gov 230 

                                
27    

                                
11.74%    234 

                             
19  8.12% 

Totals 26,599 
                      

4,288  16.12% 26,869 
                     

3,867  14.39% 
 
Outreach for this submission included survey development, web site database research and 
teleconferences. Together with the Illinois Department of  Commerce and Economic Opportunity 
(DCEO), we have engaged in a process of  working with CAIs on an organized basis. Other state 
agencies and organizations have included the Illinois Commerce Commission, Illinois Board of  
Education, and the Illinois State Police. Additional Agencies and organizations have been referenced 
throughout this presentation. 

PCI has worked with a number of  organizations in gathering data for the October submission in 
addition to those already identified in the March filing. We are encouraged that relationships with 
these organizations will continue to develop and facilitate our electronic data collection efforts in 
future filings. These organizations are listed below: 
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K-12 Illinois Association of Regional School Superintendents, Illinois State Board of 
Education 

Libraries Illinois Library Association 

Healthcare Illinois Critical Access Hospital Network, Illinois Rural HealthNet, Illinois 
Healthcare Association 

Public Safety Existing Database 

Colleges & Universities Illinois Community Colleges Board 

Other Government Existing Database 

Other Non-Government Man-Tra-Con 

 

For Category 1, K-12, we have been working with Gil Morrison of  the Illinois Association of  
Regional School Superintendents. A cover letter and link was sent to each of  the Regional 
Superintendents with instructions to disseminate to the Technical Director for each their respective 
School Districts. From there, the Technical Director distributed the survey to each school location.  
PCI also worked with Kathy Barnhart of  the Illinois State Board of  Education in distributing the 
survey.  Kathy distributed the survey to the fifteen Learning Technology Centers in the State of  
Illinois who then distributed the survey to the various school districts.   

PCI had an existing database of  email contacts for Category 2, Libraries in Illinois. We worked with 
the Illinois Library Association and found that generally the libraries were receptive to taking the 
survey, given need for broadband in the library sciences. 

In Category 3, Healthcare, PCI worked with Pat Schou of  the Illinois Critical Access Hospital 
Network and Alan Kraus of  the Illinois Rural Health Network. Both organizations were referenced 
in our cover letter, and the survey was sent from PCI’s email database.  David Voepel, of  the Illinois 
Health Care Association, also assisted in distributing the survey to Category 3 institutions which 
included long-term care facilities, nursing homes, and rehab facilities.  The data that has been 
acquired through these two methods have been added to the database of  community anchor 
institution data included in this submission. 

For Category 4, Public Safety, surveys were also sent via the PCI database. As with the Libraries, the 
response from this category was favorable. 

PCI worked with Elaine Johnson at the Illinois Community Colleges Board for Category 5, 
Universities and Colleges. A cover letter and link was sent to over 40 Community Colleges, with a 
very positive response. The remaining Category 5 surveys we sent via email. 

For Category 6, Community Support-Government, the survey was distributed electronically via 
PCI’s existing database. 

For Category 7, Community Support-Non Government, PCI worked with Kathy Lively at Man-Tra- 
Con to disseminate the survey to Illinois WorkNet Centers. The remaining surveys were sent via our 
exiting email database. 

In addition to the web sites included in our March submission, PCI utilized the following web sites 
to assemble relevant datasets: 
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 Illinois High School Association    Illinois State Police 
  Illinois Elementary School Association  911 Fire Police Medical Web 

Illinois Sheriffs’ Association    Illinois Workforce Partnership 
National Public Safety Information Bureau American Hospital Association 
National Center for Education Statistics  United States Fires Administration 

 

Working with both organizations and regional outreach initiatives, PCI considers its CAI electronic 
survey effort to be a process of  continually improving our existing database, methodology, and 
results obtained. Our goal is to collect and display CAI broadband data most relevant to the needs 
of  Illinois residents. 

SBDD DATA TRANSFER MODEL METHODOLOGY 
 
The submission of the broadband dataset for April 1, 2011 is contained within the SBDD Data 
Transfer Model. PCI has reviewed all literature that relates to the release and use of this data transfer 
model and recognizes that it does not replace or dictate how data is stored, processed, or displayed 
for the state, as it is meant primarily as a means to transfer the broadband data from all states and 
territories and populate the National Broadband Map in a seamless fashion. 
 
Broadband service providers submitted coverage in terms of the areas that they served, either in 
direct geospatial formats, CAD files, or as paper maps. The submitted polygons were overlaid on the 
census block polygons and those blocks touching were selected and used. The proper speed tier 
categories were assigned as necessary. The carriers who submitted in this fashion has consistent 
speed categories over these blocks so further segmentation was not required. 
 
In addition to the narratives and methodologies contained herein, as well as the DataPackage.xls 
containing contact information, the data dictionary, and a provider summary table, the following 
feature classes are submitted within the SBDD Data Transfer Model for the state of Illinois. 
 
Inventory of Deliverables, Partnership for a Connected Illinois: April 1, 2011: 

 

NOFA Requirement Data Transfer Model Data Description 
Appendix A:  1(a)(i) BB_Service_CensusBlock Broadband Service Availability of 

Facilities-Based Providers in Census 
Blocks of No Greater Than Two 
Square Miles in Area 

Appendix A:   1(a)(ii) BB_Service_RoadSegment Broadband Service Availability of 
Facilities-Based Providers by Road 
Segment in Census Blocks Larger in 
Area Than Two Square Miles 

Appendix A:   1(b) BB_Service_Wireless Broadband Service Availability of 
Wireless Services Not Provided to a 
Specific Address 
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Appendix A:   3(b) BB_ConnectionPoint_MiddleMile Broadband Service Infrastructure 
Middle-Mile and Backbone 
Interconnection Points 

Appendix A:   4 BB_Service_CAInstitutions Community Anchor Institutions-
Listing 

 
The provider data collected by PCI on behalf of the State of Illinois have been formatted per the 
given specifications and uploaded into the appropriate feature classes of the SBDD Data Transfer 
Model. Wireline availability is contained within census blocks and road segments. Wireless 
availability is contained as polygons of coverage areas. Middle-mile connections and community 
anchor institutions are contained as point data. The subscriber weighted nominal speed (if available) 
is contained within the overview feature class. All speed data is contained at the census block, road 
segment, or wireless polygon level of availability. All efforts have been made to comply with 
formatting, domain, and metadata requirements to include as much information as possible. 
 
All carrier coverage data that was unchanged since the October 8, 2010, submission was validated by 
Connected Nation using the validation methods below. 
 

ILLINOIS FIELD VALIDATION NARRATIVE (CONNECTED NATION) 
 
John Determan (Sr. WiMAX Engineering Consultant), Layne Wagner (Technical Engineering 
Analyst) and Chip Spann (Director of Engineering and Technical Services) were tasked with field 
verification and data validation for some of the 166 viable broadband providers that contributed 
data to the Partnership for a Connected Illinois broadband inventory map.  After analyzing the mix 
(40 ILECs, 20 cable modem providers, 12 FTTx providers, 97 fixed wireless operators, 32 backhaul 
providers and 6 mobile wireless companies), 13 broadband providers were randomly selected for 
field validation activities. Upon the conclusion of testing at 28 test locations, the current data 
validation completion rate of 7.83% was achieved through July 28, 2010. 
     
The results of the testing techniques affirmed that (i) 100% spectrum frequencies (as tested by an 
Avcom PSA-37XP spectrum analyzer) were accurate; (ii) 96.4% of the physical coordinates (tested 
using either a GPS enabled version of Microsoft Streets & Trips or a Garmin eTrex Summit GPS 
unit) were correct and, in cases where a discrepancy was discovered, they were presented to the 
appropriate provider and further verified/validated by the provider; and (iii) 100% of the mobile 
broadband speeds tested achieved the criteria as established for broadband (minimum of 768 kbps X 
200 kbps).  Mobile testing was conducted using a 3G smart phone and/or a 3G aircard. 
 
As part of its verification testing, Connected Nation regularly completes random spectrum analysis 
studies throughout the state, cross-references antenna structure registration numbers and federal 
registration numbers against Federal Communications Commission databases, and strives not only 
to personally meet with participating broadband providers but to encourage them (whenever 
possible) to accompany Connected Nation engineers on these randomly selected test locations. 
 
To date, these tests have included in-field validation for AT&T Mobility, Illinois Valley Cellular, XO 
– Nextlink, Clearwire, KeyOn Wireless, Heartland, Egyptian Telephone, Banicon, Comcast, 
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Geneseo, Volo Broadband, SparkPlug Wireless and Cellular Properties.  The compilation of tests on 
these companies covers fixed and mobile wireless, WiMAX, backhaul, DSL, and cable modem 
technologies representing a cross-cut from all applicable technology platforms (excluding satellite 
and broadband over power line). 
 

ACCURACY AND VERIFICATION:  METHODOLOGY - PROVIDER VALIDATION 

(CONNECTED NATION) 
 
Broadband providers maintain their service area data in many different formats, all in varying levels 
of complexity and granularity. In order to ensure that the data required by the NTIA is standardized 
across all providers and that it is as accurate as possible, Connected Nation translates and formats 
the data that providers are able to supply into a GIS shapefile and produces maps for the provider to 
review.  The resulting map(s) and review process allow for providers to see their service area in a 
geographic format – for some providers, this is the first time they have seen maps of their 
broadband service area. Having the mapped service area allows providers to quickly identify any 
issues that appear in the data representation, whether the issue is in the data translation into a GIS 
format or from the original data collection and submission. Often data is provided from various 
sources and through the review and revision process, local engineers who operate the networks and 
work in the field are able to ensure that the tabular data that has been submitted is accurate and 
represents the real-world network extent. Any issues in how the service area is represented on the 
map(s) are remedied by Connected Nation, whether they are additions, removal of service, or any 
other revisions. Revised maps of service area representations are sent to the provider for review and 
approval; Connected Nation will revise data and return maps as many times as necessary until the 
provider is in agreement that the map represents their service area as accurately as possible. Once 
the review process has been completed and final approval of the data is provided, the data is deemed 
ready for NTIA submission. 
 
Once the data collection has been aggregated to a statewide level, static maps of statewide and 
county-level availability are produced and made publicly available. In addition, consumers can visit 
the interactive online tool, BroadbandStat, to create customized views of broadband service areas 
and analyze corresponding demographic information. Leveraging broadband service data on various 
platforms allows for public users, providers, and other stakeholders to review, scrutinize, and 
provide feedback on the represented data. This feedback becomes a validation method in itself as 
consumers submit inquiries to Connected Nation either affirming where service is not available or 
identifying areas where broadband service is shown on the map, but in actuality is not available. This 
allows for a follow-up to providers regarding revisions to the data as it is represented; it also allows 
for Connected Nation to identify locations where on-site visits may be necessary to complete field 
validation of available services. Public feedback on all forms of mapping products serves as a 
localized validation method for provider-supplied information and allows Connected Nation to 
resolve inaccuracies as they are identified to ensure that only the highest quality information is 
provided to stakeholders. 
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WIRELESS METHODOLOGY 
 
In addition to the wireless approach deployed in 2010, for this cycle, many fixed wireless providers 
allowed us to use their tower locations, antenna heights and direction/spread of coverage to derive 
coverage areas. With the provided tower information, professionally prepared radio frequency 
coverage studies were conducted and converted to shape file format. These studies have proven to 
be very accurate and represent service areas where the maximum advertised speeds can be delivered. 
These studies take in to account full consideration for terrain and tree clutter data. 
 
We do note two interesting trends in the wireless data. First, there appears to be some variation on 
how the NOFA coverage definition is met. In other words, there seems to be a disparity on the 
necessary strength (e.g. -80 dB, -98 db, -120 dB, etc) to provide the appropriate quality of service for 
data services and still be able to deliver the maximum advertised speeds. 
 

METADATA 
 
Metadata, which literally means data about data, represent PCI’s attempt to document procedures, 
coding, and overall methodology used in managing broadband supply data.  Both short and long 
terms goals of developing PCI’s metadata are to improve communication on Geographic 
Information Systems (GIS) data management issues for both internal and external partners.  PCI’s 
metadata is organized and structured around Federal Geographic Data Committee (FGDC) 
standards associated with key information impacting the following issues: 
 

 What GIS data layers are managed by an organization? 

 How is data coded or classified in assisting outside partners or organization use the GIS data 
developed? 

 When was the data developed and how often is it updated? 

 Who developed the data layers and who should be contacted if anyone has questions? 
 

The net result of developing PCI’s metadata connects to the idea of communication and standards. 
When applied correctly over time PCI’s metadata will assist in educating other users on essential 
questions needed when applying GIS data.  In addition, it will assist PCI internally as metadata will 
help the organization identify and document critical developing issues shaping data development. 
Any new employee or organization will be pointed to metadata files when asking questions relating 
to methodology, attribute codes, dates of data edits or updates, and follow-up contact information 
within PCI’s data team. 
 

METHODOLOGY FOR THE BROADBANDILLINOIS.ORG WEB SITE 
 
As mentioned above, on February 17, 2011, the Partnership for a Connected Illinois launched its 
new web site, featuring an easy graphical interface for accessing PCI data about broadband providers 
with a single mouse click or touch on a smart phone. In this first, initial version, the web site offers a 
broadband location finder with detailed service provider information and assessments of internet 
speeds, as well as locations of community broadband providers. 
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Clicking on the home page map opens a side panel with broadband providers. Expanded results also 
show the libraries, schools, and public building in the area with broadband. As the State-designated 
entity under the NTIA’s State Broadband Data and Development, PCI provides, on 
http://broadbandillinois.org, the same data that it submits to the NTIA for inclusion in the national 
broadband map. Additionally, PCI has begun to collect actual speed and price information, using the 
new web site. 
 
PCI built the web site is built around open and transparent data-sharing tools. As with the national 
broadband map, PCI aims to encourages user feedback as a means of helping to improve and 
promote broadband in Illinois. For example, the site's "Get It" section encourages citizens to get 
involved with Broadband Illinois eTeams. These community leadership groups are working to help 
connect rural residents and others throughout Illinois. The site’s "Use It" is beginning to assemble 
materials that pertain to broadband adoption. 

THE APPLICATION PROGRAMMING INTERFACE FOR BROADBAND ILLINOIS DATA 
 
PCI’s web site is built around an open source Application Program Interface. This free tool allows 
software developers to build upon, and add to, the data on http://broadbandillinois.org. Below is 
the documentation for the PCI’s API, which is available at http://developer.broadbandillinois.org. 
 
Using Your API Key 
http://developer.broadbandillinois.org/providers.xml?api_key=XXX&param1=value1… 
 
Download documentation as XML file: 
http://developer.broadbandillinois.org/docs.xml 
 
API Query: Provider Query 
 
Input 
URL: http://developer.broadbandillinois.org/providers.xml 
 
Input Parameters 
 

Parameter 
Name 

Parameter 
Type Description 

api_key string The API key of the user requesting the data. Must match an 
existing API key of an approved, active user. 

area_key string For a known area search, the specific area being searched. 
This must be used in conjunction with an area_kind 
parameter. Each area_kind has a different requirement for 
specification. 

http://broadbandillinois.org/
http://broadbandillinois.org/
http://developer.broadbandillinois.org/
http://developer.broadbandillinois.org/docs.xml
http://developer.broadbandillinois.org/providers.xml
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Parameter 
Name 

Parameter 
Type Description 

 congressional_district The two digit district number 
(include leading zero, like "07") 

 county The three digit county FIPS number (with 
leading zeroes, ie Cook County is "031") 

 county_subdivision The five digit COUSUBFP 
number (Chicago is 14000) 

 tract The four or six digit tract number 
 block_group Two digit state code + three digit county 

code + four or six digit tract code + one digit block 
group number 

 zip_code The 5 digit zip code 

area_kind string For a known area search, the type of area being searched. 
Must be used in conjunction with the area_key parameter. 

 congressional_district A congressional district (2000 
boundaries) 

 county County 
 county_subdivision A subdivision of a county 
 tract A US census tract 
 block_group A US census block group 
 zip_code A Postal Service Zip Code 

lat float Latitude of the query. Must be used in conjunction with lon. 

lon float Longitude of the query. Must be used in conjunction with lat. 

radius float Radius of the area being searched, in meters. This parameter 
is optional, if not set, the value 0.1 will be used. This 
parameter is only valid in a lat/lon query. 

wkt string A WKT (Well Known Text) Polygon or Multipolygon in 
projection 4326 that will act as the boundary for the search. 

 
Response 
 
<providers> 
<provider> 
..... 
</provider> 
</providers> 
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Field Name 
Field 
Type Source Description 

blockid integer Broadband Identifier for the census block 
containing the search point. The 
2000 census data is used. 

blocksubgr integer Broadband Identifier for the census block 
subgroup containing the search 
point. If there is no subgroup, the 
value will be "nil". 

county_name string Broadband The name of the county 
containing the search point. 

countyfips integer Broadband The FIPS identifier for the 
county containing the search 
point. 

dbaname string Broadband, 
Wireless 

The provider's Doing Business 
As (DBA) legal designation. 

frn string Broadband, 
Wireless 

FCC Registration Number of the 
provider. 

fullfipsid integer Broadband The full FIPS id containing the 
searchpoint, containing the state, 
county, tract, and block ids, in 
that order, for example: 
170010001001007, made up of 
statefips: 17, countyfips: 001, 
tract: 000100, and block: 007. 

max_speed_down string Broadband, 
Wireless 

The text value corresponding to 
maxadown. 

max_speed_up string Broadband, 
Wireless 

The text value corresponding to 
the maxadup code. 

maxaddown integer Broadband, 
Wireless 

A code representing the 
maximum download speed of the 
connection. 

 1 Less than or equal to 
200 kbps. 

 2 Greater than 200 kbps 
and less than 768 kbps. 
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Field Name 
Field 
Type Source Description 

 3 Greater than or equal to 
768 kbps and less than 1.5 
mbps. 

 4 Greater than or equal to 
1.5 mbps and less than 3 
mbps. 

 5 Greater than or equal to 
3 mbps and less than 6 
mbps 

 6 Greater than or equal to 
6 mbps and less than 10 
mbps. 

 7 Greater than or equal to 
10 mbps and less than 25 
mbps. 

 8 Greater than or equal to 
25 mbps and less than 50 
mbps. 

 9 Greater than or equal to 
50 mbps and less than 
100 mbps. 

 10 Greater than or equal 
to 100 mbps and less than 
1 gbps. 

 11 Greater than or equal 
to 1 gbps. 

maxadup integer Broadband, 
Wireless 

A code representing the 
maximum upload speed of the 
connection. See "maxadown" for 
the list of possible values. 

provname string Broadband, 
Wireless 

The name of the provider. 

reseller boolean Broadband Field value is 1 if the provider is a 
reseller, 0 if it is not. 

spectrum integer Wireless A code for the wireless spectrum 
used by the provider. 

 1 Cellular spectrum (824-
849 MHz; 869-894) used 
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Field Name 
Field 
Type Source Description 

to provide service 
 2 700 MHz spectrum 

(698-758 MHz; 775-788 
MHz; 775-788 MHz) used 
to provide service 

 3 Broadband Personal 
Communications Services 
spectrum (1850-1915 
MHz; 1930-1995) used to 
provide service 

 4 Advanced Wireless 
Services spectrum (1710-
1755 MHz; 2100-2155) 
used to provide service 

 5 Broadband Radio 
Service/Educational 
Broadband Service 
spectrum (2496-2690 
MHz) used to provide 
service 

 6 Unlicensed (including 
broadcast television 
\"white spaces\") 
spectrum used to provide 
service 

 7 Specialized Mobile 
Radio Service (SMR) 
(817-824 MHz; 862-869 
MHz; 896-901 MHz; 935-
940 MHz) 

 8 Wireless 
Communications Service 
(WCS) spectrum (2305-
2320 MHz; 2345-2360 
MHz), 3650-3700 MHz 

 9 Satellite (L-band, Big 
LEO, Little LEO, 2 GHz) 

 -9 Unknown 

spectrum_name string Wireless The text description of the 
spectrum code for this provider. 
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Field Name 
Field 
Type Source Description 

state_abbr string Broadband, 
Wireless 

The postal abbreviation of the 
state containing the search point. 

state_name string Broadband, 
Wireless 

The name of the state containing 
the search point. 

statefips integer Broadband, 
Wireless 

FIPS identifier for the state 
containing the search point. 

the_geom WKT 
String 

Broadband The geomentric data for this 
provider, in WKT string format. 

tract integer Broadband Identifier for the census tract 
containing the search point. The 
2000 census data is used. 

transmission_technology_type string Broadband, 
Wireless 

The text description 
corresponding to the transtech 
value. 

transtech integer Broadband, 
Wireless 

Enumerated type defining the 
type of technology used by the 
provider. 

 0 All Other 
 10 Asymmetric xDSL 
 20 Symmetric xDSL 
 30 Other Copper Wireline 
 40 Cable Modem - 

DOCSIS 3.0 
 41 Cable Modem - Other 
 50 Optical Carrier / Fiber 

to the End User 
 60 Satellite 
 70 Terrestrial Fixed 

Wireless - Licensed 
 80 Terrestrial Mobile 

Wireless 
 90 Electric Power Line 
 -9999 Unknown / Did 

Not Provide 

typical_speed_down string Broadband, 
Wireless 

The text value corresponding to 
the typicdown code. 
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Field Name 
Field 
Type Source Description 

typical_speed_up string Broadband, 
Wireless 

The text value corresponding to 
the typicdown code. 

typicdown integer Broadband, 
Wireless 

A code representing the typical 
download speed of the 
connection. See "maxadown" for 
the list of possible values. 

typicup integer Broadband, 
Wireless 

A code representing the typical 
upload speed of the connection. 
See "maxadown" for the list of 
possible values. 

 
API Query: Report Query 
 
Input 
URL: http://developer.broadbandillinois.org/report.xml 
 
Input Parameters 
 

Parameter 
Name 

Parameter 
Type Description 

api_key string The API key of the user requesting the data. Must match an 
existing API key of an approved, active user. 

area_key string For a known area search, the specific area being searched. This 
must be used in conjunction with an area_kind parameter. Each 
area_kind has a different requirement for specification. 

 congressional_district The two digit district number 
(include leading zero, like "07") 

 county The three digit county FIPS number (with 
leading zeroes, ie Cook County is "031") 

 county_subdivision The five digit COUSUBFP number 
(Chicago is 14000) 

 tract The four or six digit tract number 
 block_group Two digit state code + three digit county 

code + four or six digit tract code + one digit block 
group number 

 zip_code The 5 digit zip code 

http://developer.broadbandillinois.org/report.xml
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Parameter 
Name 

Parameter 
Type Description 

area_kind string For a known area search, the type of area being searched. Must 
be used in conjunction with the area_key parameter. 

 congressional_district A congressional district (2000 
boundaries) 

 county County 
 county_subdivision A subdivision of a county 
 tract A US census tract 
 block_group A US census block group 
 zip_code A Postal Service Zip Code 

lat float Latitude of the query. Must be used in conjunction with lon. 

lon float Longitude of the query. Must be used in conjunction with lat. 

radius float Radius of the area being searched, in meters. This parameter is 
optional, if not set, the value 0.1 will be used. This parameter is 
only valid in a lat/lon query. 

wkt string A WKT (Well Known Text) Polygon or Multipolygon in 
projection 4326 that will act as the boundary for the search. 

 
Response 
 
<providers> 
<provider or anchors (for CAI aggregation)> 
..... 
</provider or anchors (for CAI aggregation)> 
</providers> 
 

Field Name 
Field 
Type Source Description 

dbaname string provide
r only 

The provider's Doing Business As (DBA) 
legal designation. 

download_speed neste
d 
field 

CAI 
only 

Measured download speed for CAI sources. 
Nested fields as in max_upload_speed. 

frn String provide
r only 

FCC Registration Number of the provider. 
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Field Name 
Field 
Type Source Description 

jitter neste
d 
field 

CAI 
only 

Measured jitter for CAI sources. Nested 
fields as in max_upload_speed. 

latency neste
d 
field 

CAI 
only 

Measured latency for CAI sources. Nested 
fields as in max_upload_speed. 

max_download_speed neste
d 
field 

provide
r and 
CAI 

The maximum download bandwidth. Nested 
fields as in max_upload_speed. 

max_upload_speed neste
d 
field 

provide
r and 
CAI 

The maximum upload bandwidth 

high intege
r 

The code 
correspondi
ng to the 
highest 
record for 
this carrier. 
Codes are as 
in 
maxadown 

high_text string The text 
description 
of the code 
for high. 

low intege
r 

The code 
correspondi
ng to the 
lowest 
record for 
this carrier. 
Codes are as 
in 
maxadown 

low_text string The text 
description 
of the code 
for low. 
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Field Name 
Field 
Type Source Description 

median intege
r 

The code 
correspondi
ng to the 
median 
record for 
this carrier. 
Codes are as 
in 
maxadown 

median_te
xt 

string The text 
description 
of the code 
for median. 

 

record_count intege
r 

provide
r and 
CAI 

The number of individual records making up 
the aggregate data. Note that the data for 
broadband providers has been pre-split into 
census block sized chunks, which results in 
high number of individual records for large 
areas. 

spectrum intege
r 

provide
r only 

A code for the wireless spectrum used by 
the provider. 

 1 Cellular spectrum (824-849 MHz; 
869-894) used to provide service 

 2 700 MHz spectrum (698-758 MHz; 
775-788 MHz; 775-788 MHz) used 
to provide service 

 3 Broadband Personal 
Communications Services spectrum 
(1850-1915 MHz; 1930-1995) used 
to provide service 

 4 Advanced Wireless Services 
spectrum (1710-1755 MHz; 2100-
2155) used to provide service 

 5 Broadband Radio 
Service/Educational Broadband 
Service spectrum (2496-2690 MHz) 
used to provide service 

 6 Unlicensed (including broadcast 
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Field Name 
Field 
Type Source Description 

television \"white spaces\") 
spectrum used to provide service 

 7 Specialized Mobile Radio Service 
(SMR) (817-824 MHz; 862-869 
MHz; 896-901 MHz; 935-940 MHz) 

 8 Wireless Communications Service 
(WCS) spectrum (2305-2320 MHz; 
2345-2360 MHz), 3650-3700 MHz 

 9 Satellite (L-band, Big LEO, Little 
LEO, 2 GHz) 

 -9 Unknown 

spectrum_text string provide
r only 

The text description of the spectrum code 
for this provider. 

transmission_technology_t
ype 

string provide
r only 

The text description corresponding to the 
transtech value. 

transtech intege
r 

provide
r only 

Enumerated type defining the type of 
technology used by the provider. 

 0 All Other 
 10 Asymmetric xDSL 
 20 Symmetric xDSL 
 30 Other Copper Wireline 
 40 Cable Modem - DOCSIS 3.0 
 41 Cable Modem - Other 
 50 Optical Carrier / Fiber to the 

End User 
 60 Satellite 
 70 Terrestrial Fixed Wireless - 

Licensed 
 80 Terrestrial Mobile Wireless 
 90 Electric Power Line 
 -9999 Unknown / Did Not Provide 

typical_download_speed neste
d 
field 

provide
r only 

The typical download bandwidth. Nested 
fields as in max_upload_speed. 

typical_upload_speed neste
d 
field 

provide
r only 

The typical upload bandwidth. Nested fields 
as in max_upload_speed. 
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Field Name 
Field 
Type Source Description 

upload_speed neste
d 
field 

CAI 
only 

Measured upload speed for CAI sources. 
Nested fields as in max_upload_speed. 

 
API Query: Community Anchor Institutions 
 
Input 
URL: http://developer.broadbandillinois.org//community_anchors 
 
Input Parameters 
 

Parameter 
Name 

Parameter 
Type Description 

api_key string The API key of the user requesting the data. Must match an 
existing API key of an approved, active user. 

area_key string For a known area search, the specific area being searched. 
This must be used in conjunction with an area_kind 
parameter. Each area_kind has a different requirement for 
specification. 

 congressional_district The two digit district number 
(include leading zero, like "07") 

 county The three digit county FIPS number (with 
leading zeroes, ie Cook County is "031") 

 county_subdivision The five digit COUSUBFP 
number (Chicago is 14000) 

 tract The four or six digit tract number 
 block_group Two digit state code + three digit 

county code + four or six digit tract code + one digit 
block group number 

 zip_code The 5 digit zip code 

area_kind string For a known area search, the type of area being searched. 
Must be used in conjunction with the area_key parameter. 

 congressional_district A congressional district (2000 
boundaries) 

 county County 
 county_subdivision A subdivision of a county 
 tract A US census tract 
 block_group A US census block group 
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Parameter 
Name 

Parameter 
Type Description 

 zip_code A Postal Service Zip Code 

lat float Latitude of the query. Must be used in conjunction with lon. 

lon float Longitude of the query. Must be used in conjunction with lat. 

max_responses integer If this value is an integer greater than zero, the number of 
responses will be limited to that value. There is no guarantee 
that a particular potential response will be in that group. 

priority_only string If this value is a truthy string ("1", "t", "true", "yes", "y"), 
then the output will be limited to CAI institutions labelled 
priority only 

radius float Radius of the area being searched, in meters. This parameter 
is optional, if not set, the value 0.1 will be used. This 
parameter is only valid in a lat/lon query. 

wkt string A WKT (Well Known Text) Polygon or Multipolygon in 
projection 4326 that will act as the boundary for the search. 

 
Response 
 
<community_anchor_institutions> 
<community_anchor_institution> 
..... 
</community_anchor_institution> 
</community_anchor_institutions> 
 

Field Name 
Field 
Type Description 

ad_down integer Synonym for maxaddown 

ad_down_text string Synonym for max_speed_down 

ad_up integer Synonym for maxadup 

ad_up_text string Synonym for max_speed_up 

additional_bandwidth boolean If true, the user was dissatisfied with their service, 
and desires additional bandwidth 
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Field Name 
Field 
Type Description 

additional_connections boolean If true, the user was dissatisfied with their service, 
and desires additional connections 

affordable_rates boolean If true, the user was dissatisfied with their service 
and wants more affordable rates 

alternative_carrier boolean If true, the user was dissatisfied with their service, 
and wants to use a different carrier 

alternative_technology boolean If true, the user was dissatisfied with their service, 
and desires a different technology 

broadband_adoption boolean If true, the internet speed of the CAI has met the 
NTIA's definition of broadband. 

carrier_derived boolean If true, the carrier name has been derived from 
the IP address 

city string City where institution is located 

contact_email string Email address of contact at the anchor institution 

contact_name string Name of contact at the anchor institution 

county string The county where the institution is located 

district string For K-12 schools, the school district name, 
otherwise blank. 

download_speed integer Actual download speed derived from user tests 

e_team boolean If true, the institution is interested in becoming 
an E-Team member. 

email string General email address of the institution 

improved_service boolean If true, the user was dissatisfied with their service, 
and wants better customer service 

institution_type integer The type of institution 

institution_type_text string The text value corresponding to the institution 
type 
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Field Name 
Field 
Type Description 

ip_address string The ip address of the CAI 

jitter integer Jitter measurement for user tests 

last_mile string The provider of the last mile of infrastructure 

latency integer Latency time from user tests 

latlon wkt 
string 

The geographic location of the institution 

max_speed_down string Text description corresponding to maxaddown 

max_speed_up text Text description corresponding to maxadup 

maxaddown integer A code representing the maximum download 
speed of the advertised connection. 

 1 Less than or equal to 200 kbps. 
 2 Greater than 200 kbps and less than 768 

kbps. 
 3 Greater than or equal to 768 kbps and 

less than 1.5 mbps. 
 4 Greater than or equal to 1.5 mbps and 

less than 3 mbps. 
 5 Greater than or equal to 3 mbps and 

less than 6 mbps 
 6 Greater than or equal to 6 mbps and 

less than 10 mbps. 
 7 Greater than or equal to 10 mbps and 

less than 25 mbps. 
 8 Greater than or equal to 25 mbps and 

less than 50 mbps. 
 9 Greater than or equal to 50 mbps and 

less than 100 mbps. 
 10 Greater than or equal to 100 mbps and 

less than 1 gbps. 
 11 Greater than or equal to 1 gbps. 

maxadup string A code representing the maximum download 
speed of the advertised connection. Keys as in 
maxaddown 

organization string Community Anchor Institution names 
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Field Name 
Field 
Type Description 

priority_institution boolean If true, the institution is a priority to contact 

provider string The name of the institution's broadband provider 

rate float Monthly charge from the carrier 

response_date date The date the institution's record was added to the 
system. 

response_method string The survey site used for the institution's 
response. 

service_comments string Any additional comments from the user about 
their service 

service_satisfactory boolean If true, the user finds their current service 
satisfactory 

short_time_frame boolean If true, the user was dissatisfied with their service, 
and wants a shorter time frame to extend their 
service 

speed_derived boolean If true, speed was derived from the IP address 

state string State where institution is located 

street_address string Street address of institution 

technology_comments string Additional comments, if any 

transmission_technology_type string Text value corresponding to transtech 

transtech integer Enumerated type defining the type of technology 
used by the provider. 

 0 All Other 
 10 Asymmetric xDSL 
 20 Symmetric xDSL 
 30 Other Copper Wireline 
 40 Cable Modem - DOCSIS 3.0 
 41 Cable Modem - Other 
 50 Optical Carrier / Fiber to the End 

User 
 60 Satellite 
 70 Terrestrial Fixed Wireless - Licensed 
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Field Name 
Field 
Type Description 

 80 Terrestrial Mobile Wireless 
 90 Electric Power Line 
 -9999 Unknown / Did Not Provide 

upload_speed integer Actual upload speed derived from user tests 

zip string Zip code where institution is located 

 
API Query: Geometries Query 
 
Input 
 
URL: http://developer.broadbandillinois.org/geometries/(area_kind)/(area_key).xml 
 
Input Parameters 
 

Parameter 
Name 

Parameter 
Type Description 

api_key string The API key of the user requesting the data. Must match an 
existing API key of an approved, active user. 

area_key string The specific area being requested. This must be used in 
conjunction with an area_kind parameter. Each area_kind has a 
different requirement for specification. 

 congressional_district The two digit district number 
(include leading zero, like "07") 

 county The three digit county FIPS number (with 
leading zeroes, ie Cook County is "031") 

 county_subdivision The five digit COUSUBFP number 
(Chicago is 14000) 

 tract The four or six digit tract number 
 block_group Two digit state code + three digit county 

code + four or six digit tract code + one digit block 
group number 

 zip_code The 5 digit zip code 
 census_block The full FIPS id for the census block 

area_kind string The type of area being requested. Must be used in conjunction 
with the area_key parameter. 

 congressional_district A congressional district (2000 
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Parameter 
Name 

Parameter 
Type Description 

boundaries) 
 county County 
 county_subdivision A subdivision of a county 
 tract A US census tract 
 block_group A US census block group 
 zip_code A Postal Service Zip Code 
 census_block A US census block 

 
Response 
 
<named_area> 
..... 
</named_area> 
 

Field Name Field Type Description 

area_key string The specific area. 

area_kind string The type of area. 

kml string The KML representation of the area geometry. 

 
BROADBANDSTAT METHODOLOGY  
 
BroadbandStat is an online, interactive mapping tool for viewing, analyzing, and validating 
broadband data. Developed through a partnership with ESRI, the market leader in geographic 
information system (GIS) software, BroadbandStat is a multi-functional way for local leaders, 
policymakers, consumers, and technology providers to devise a plan for the expansion and adoption 
of broadband. Connected Nation launched BroadbandStat at http://connectillinois.org on February 
24, 2010. The Partnership for a Connected Illinois is in the process of re-launching BroadbandStat 
on http://broadbandillinois.org.  

CONCLUSION 
 
The transition from the data-submission process by Connected Nation to the work engaged in by 
the Partnership for a Connected Illinois for the data-submission cycle ending April 1, 2011, 
occasioned a large degree of work on the data-collection mission of PCI. Building upon the strong 
foundation established in this data cycle, PCI’s efforts will increasingly incorporate “best practices” 
for data-submission in future cycles. 

http://connectillinois.org/
http://broadbandillinois.org/


INDIANA 
Round 3 (Spring 2011) 

Data Submission to NTIA 
April 1, 2011 

 
 
Data Description 
 

File Name Contents Description 

IN_SBDD_20110401.ZIP This Delivery Package 
A zip file containing all of the files 
described below 

IN_SBDD_2011_04_01.gdb Data Transfer Model 

Current NTIA approved data model with 
the assembled data properly loaded 
into the data transfer model 

IN_DataPackage.2010_10_01.xls Data Package 

A formatted file containing associated 
documentation about Indiana's 
submission 

IN_2011_04_01.txt 

Data Submission 

Receipt 
File containing the results of the 
submission check tool 

IN_ Methodology 

_2011_04_01.pdf 

Methodology White 

Paper Documentation about our process 

IN_ Readme_2011_04_01.pdf Readme Doc 
A document that contains added notes 
about the delivery 

 

Provider Participation 
107 Internet Providers 

 68 Wireless Providers 

 39 Wireline Providers 
 
47 Data Sets Received 

 22 Wireline Providers 

 25 Wireless Providers 
 
Indiana Utility Regulatory Commission (IURC) Data 

 61 Data Sets (with FRN) 
 
 

 
 

Chris
Note
Should be 2011_04_01.xls



Data Collection 
We continue to collect data from these sources, including:  

 The Indiana Utility Regulatory Commission (broadband data)  

 Office of Utility Consumer Counselor (broadband data)  

 The Indiana Business Research Center (demographic data)  

 Indiana Department of Local Government Finance (residential versus commercial status 
by address)  

 Indiana Counties (point addresses, land parcels, road centerlines with address ranges, 
and administrative boundaries, aggregated and integrated into the IndianaMap)  

 Indiana Department of Natural Resources (state forests and parks)  

 Indiana Department of Homeland Security (locations of emergency medical service 
(EMS) stations, fire stations, and hospitals)  

 Department of Education (school locations)  

 Indiana Libraries (point of connectivity for low income/unemployed consumers—
provide vital speed information for respective geographical locations)  

 Commission for Higher Education (locations of colleges and universities)  

 Broadband service providers, and others  
 

This information is processed according to the current data submission model offered by the 

National States Geographic Information Council and to be able to perform spatial comparisons, 

logic rules and other checks.  

We also add emphasis to the collection of speed information using the “crowd sourcing” web-

based application already implemented.  

Indiana Broadband Service Questionnaire 

http://www.in.gov/iot/BroadbandQuestionnaire.htm 

http://in-polis-app21.ads.iu.edu/BroadbandService/default.aspx 

We also support small service providers (and those with smaller information technology teams) 

in the area of data submission. We recognize the challenge that some providers have in 

submitting data in the formats and specifications required.   We have successfully contacted all 

of the wireless service providers and hosted their annual meeting in January of this year. 

Data Integration 
When data is received from a service provider, it is loaded into either Excel or Access depending 
on the number of records and file size. This table is then joined with a copy of the Census block 
*.dbf file from our census block shapefile. After the data has been joined, it is exported as a 
new*.dbf. The original Census block *.dbf is renamed to preserve the original integrity and the 
newly exported *.dbf is renamed to the same name as the shapefile. The shapefile is then 

http://www.in.gov/iot/BroadbandQuestionnaire.htm
http://in-polis-app21.ads.iu.edu/BroadbandService/default.aspx


loaded into ArcMap and a Feature Class is generated. The number of records is then validated 
against the number of records that were originally imported into either Excel or Access. 
 

Data Loading  
A final integration check occurs when the data is loaded into the data model. This includes the 
logic checks for values. 
 

Validation  
We validate the collected data for completeness, currency, and accuracy using a variety of 

methods that include:  

 “Boots on the ground” inspection. We visually inspect the existence of physical 
features, where feasible, to verify that service could exist in a specific location.  

 Inspection of high-resolution orthophotography. High-resolution orthophotography is 
used to verify the existence and location of wireless towers. Where recent six-inch 
resolution orthophotography exists (cities and counties), it can also be used to verify the 
existence of residence connection boxes.  

 Comparing source documents that duplicate geographies or content. We recognize 
that within the above list of data sources, some information is duplicated. In these 
cases, discrepancies will be noted for follow-up using other verification methods listed 
here.  

 Collecting end-user data. We work with The Polis Center at Indiana University Purdue 
University Indianapolis to create a Google Map-based, user-friendly web application 
hosted on the IndianaMap portal to collect information from end-users about their 
location, broadband service provider, and speed (as captured from a speed test).  

o Indiana Broadband Service Questionnaire 
 http://www.in.gov/iot/BroadbandQuestionnaire.htm 
 http://in-polis-app21.ads.iu.edu/BroadbandService/default.aspx 

 The information collected from this website is valuable for data 
verification. The Polis Center works with communities in Indiana 
and beyond to develop and apply knowledge, to build 
collaborations and to find innovative solutions to common 
problems. The center excels in community-based research and 
advanced information technologies, especially geographic 
information systems (GIS).  

 Using service providers’ websites, especially those that contain service area 
information. Many service providers have websites that give service area information 
(often address by address) to assist consumers. We use these websites in conjunction 
with “boots on the ground” and the other methods listed here to verify the data.  

 

 

http://www.in.gov/iot/BroadbandQuestionnaire.htm
http://in-polis-app21.ads.iu.edu/BroadbandService/default.aspx


Data Display  

We are currently displaying the mapping results as additional geospatial layers added to the 

220-plus layers already on the IndianaMap (www.indianamap.org), through the Indiana State 

Library, and the Indiana Business Research Center (IBRC). We are expanding the availability of 

the data by adding a new web-based information tool that will provide information about 

broadband service availability at a user-specified location. In addition, we propose to further 

integrate the broadband map data with economic data available from IBRC 

(www.stats.indiana.edu). 

Address Level Data Collection  

We continue to collect address level data. Indeed, as described above, Indiana is well on the 

way to creating address level reference data to facilitate the collection of address level 

broadband service availability, not just in census blocks larger than two square miles, but 

statewide. These data will be invaluable as the lowest common denominator to allow the 

construction of any geography in support of broadband map display and analysis. This expands 

the options for how to depict speed across multiple geographies, and facilitates the inquiry of 

service data at a given x,y.  

We have committed to the acquisition of new orthophotography imagery to serve as the 
foundation for all other geospatial data, including centerlines and address level data. We 
currently have about $1.5 million committed by partners that include USGS, Indiana 
Department of Homeland Security, Indiana Department of Transportation, Indiana Department 
of Environmental Management, and others. We anticipate contributions from most of the 
Metropolitan Planning Organizations in Indiana and from many Indiana cities and counties.  
 

Efforts in Process 
 Community Anchor Institutions.  We identified community anchor institutions by cross 

referencing a statewide land parcel dataset with a data set from the Indiana Local 
Government Finance office containing, among other information, institution name, 
location by address, and use category.  The results of this analysis are included in this 
delivery for all records containing name, location, and category at a minimum.  These 
data, however, do not have sufficient broadband service information.  Therefore, we are 
currently working with a third party to survey the institutions to complete the attributes 
defined in the NOFA for these institutions.  We anticipate that this additional data will 
be included in the fall 2011 submission. 

 IURC data replacement.  Per our approved project methodology, we began this project 
by taking advantage of public data that existing in Indiana about broadband service.  
While we recognized that these data were not granular enough geographically to satisfy 
the long term goals of this project, they were nonetheless informative and could provide 
value until more granular data was obtained from the service providers and verified.  
We still have some of this original data in our submission because we have not received 

file:///C:/Users/jsparks/AppData/Local/Microsoft/Windows/Temporary%20Internet%20Files/Content.Outlook/1IGY2KQ0/www.indianamap.org
http://www.stats.indiana.edu/


data from all of those service providers originally identified.  It is a high priority objective 
over the next 6 months to replace all original data with new more granular data or to 
verify that we can delete whatever original data remains.  
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KANSAS COVER LETTER 

 
April 1, 2011 
 
Ms. Anne W. Neville 
SBDD Grant Program Director 
National Telecommunications and Information Administration 
U.S. Department of Commerce 
1401 Constitution Avenue, NW Room 4716 
Washington, DC 20230 
 
Dear Ms. Neville: 
 
It is with highest regard that the collective stakeholders of Connect Kansas offer congratulations to 
the U.S. Department of Commerce’s National Telecommunications & Information Administration 
(NTIA) on the recent release of the National Broadband Map.  This extraordinary milestone 
demonstrates the intense and joint effort of the NTIA, FCC, state governments, industry, and non-
profits like Connected Nation and will serve as a key tool for the American public and policymakers 
resulting in smarter investments and targeted state and local broadband policies and programs.  We 
are proud of the role that Connect Kansas has played in creating such a powerful tool that will surely 
benefit not just Kansans, but consumers and businesses nationwide. 
 
Therefore, Connected Nation as the State Broadband Designated Entity, in partnership with the 
Kansas Department of Commerce (KDOC), is pleased to present this submittal of the state of 
Kansas State Broadband Data and Development (SBDD) Grant Program, known as Connect 
Kansas.  

 
These artifacts should be found to be compliant with the April 1, 2011, deadline for the semi-annual 
data update and in accordance with the terms of the July 1, 2009, Notice of Funds Availability 
(NOFA) and all subsequent clarifications pertaining to delivery of State-Level Mapping of 
Broadband Service Availability.  This packet includes: 
 
Inventory of Deliverables, Connect Kansas: April 1, 2011 
 
NOFA Requirement Data Transfer Model Data Description 
Appendix A:  1(a)(i) BB_Service_CensusBlock Broadband Service Availability of 

Facilities-Based Providers in 
Census Blocks of No Greater 
Than Two Square Miles in Area 

Appendix A:   1(a)(ii) BB_Service_RoadSegment Broadband Service Availability of 
Facilities-Based Providers by Road 
Segment in Census Blocks Larger 
in Area Than Two Square Miles 



                                                                                                               
                                                                                       Connect Kansas – Narratives and Methodologies  

 
 

 
April 1, 2011   4 
 

Appendix A:   1(b) BB_Service_Wireless Broadband Service Availability of 
Wireless Services Not Provided to 
a Specific Address 

Appendix A:   3(b) BB_ConnectionPoint_MiddleMile Broadband Service Infrastructure 
Middle-Mile and Backbone 
Interconnection Points 

Appendix A:   4 BB_Service_CAInstitutions  Community Anchor Institutions-
Listing 

Appendix A:   4 n/a Community Anchor Institutions-
Narratives 

VII.A.1(a) n/a Accuracy and Verification Report 
n/a DataPackage.xlsx Worksheets of Contact 

Information, Data Dictionary, and 
Provider Summary Table 

n/a n/a Broadband Provider Roster and 
Participation Status 

 
In addition, this data update submission should be found to be compliant with the additional 
program requirements instituted by the National Telecommunications and Information 
Administration since the time of the October 2010 SBDD data submission for the Connect Kansas 
program.  Specifically, these new requirements are: 

 
SBDD Data Transfer Model 
The submission of the broadband dataset for April 1, 2011, is contained within the SBDD 
Data Transfer Model as released on the Grantee Workspace on January 14, 2011. All efforts 
have been made to comply with formatting, domain, and metadata requirements to include 
as much information on each provider as possible.  
 
Additional Submission Guidance 
This submission also includes the updated DataPackage spreadsheet with enhanced provider 
listings as well as satisfactory outputs from the SBDD_Check toolbox to ensure fewer 
unexpected values with the submitted broadband datasets prior to federal processing for the 
National Broadband Map update. 

 
It is therefore with great pleasure that the Connect Kansas program submits this April 2011 semi-
annual data update under the State Broadband Data and Development Grant Program.  We will 
continue to implement the joint purposes of the Recovery Act and the Broadband Data 
Improvement Act (BDIA) by gathering comprehensive and accurate state-level broadband mapping 
data, developing state-level broadband maps, aiding in the development and maintenance of the  
National Broadband Map, and undertaking statewide initiatives for broadband planning. 
 
Broadband Service Availability — Provider Outreach and Verification 
 
This data update submission under the SBDD includes the participation of 86% of the Kansas 
provider community, or 86 of 100 total providers.  Of the 86 participating providers, 47 supplied an 
update to their network or coverage area(s), while 38 have reported no change. The remaining 
provider previously supplied data but was non-responsive in the April 2011 update effort; therefore 



                                                                                                               
                                                                                       Connect Kansas – Narratives and Methodologies  

 
 

 
April 1, 2011   5 
 

its previous dataset is being put forward as part of this compilation. A complete roster by provider 
depicting participation status and contact record is contained herein.  Of the 14 providers that are 
not represented in the attached datasets, 9 have either refused to participate in the voluntary 
program or have remained unresponsive to the numerous attempts at contact by Connect Kansas. 
The remaining 5 providers are currently in some form of progress toward data submission but were 
not able to either submit or verify coverage areas at the time of this submission.    
 
As the aforementioned roster and attached methodology documentation will attest, it is the 
collective opinion of the Connect Kansas principals that all commercially reasonable efforts were 
made to account for 100% of the known Kansas broadband provider community, pursuant to this 
semi-annual data update submission. 
 
Connect Kansas has also continued to perform broadband verification activities through several 
means. In addition to confirmation of service area(s) by each provider, Connect Kansas conducts 
field validation efforts; between the October 2010 and this April 2011 data submission, 53 (53%) 
providers have been validated through field verification activities. Additional details on verification 
activities are contained within the Field Validation Narrative. 
  
At the program’s inception, Connect Kansas launched a website to create awareness about the 
initiative. Connectkansas.org continues to serve a prominent role in the outreach and data collection 
effort.  This program asset provides a way for the general public to participate in the process by 
offering interactive tools for users to test their connection speed, submit broadband inquiries, or 
contact a program representative.   
 
As an indicator of stakeholder penetration, the Connect Kansas website encountered 5,236 unique 
visits during this reporting period and 11,499 total to date for the life of the grant (awarded on 
November 1, 2009).  Additionally, this pronounced Web activity netted 39 broadband inquiries over 
this same reporting period (393 grant inception to date).  The website also provides the 
BroadbandStat application, which allows the consumer to confirm or dispute the coverage 
represented on the broadband inventory map. These consumer-initiated actions are facilitated 
through the Connect Kansas website and the Connect Kansas Interactive Mapping Tool 
(BroadbandStat) that offer the citizens the vehicles to provide information regarding availability in 
their respective service area, either in affirmation or contest of the reported data represented in the 
Connect Kansas mapping artifacts.  Since the initial data collection and release of corresponding 
maps, feedback in the form of broadband inquiries has allowed Connected Nation to identify 
additional areas that are in need of field validation, which is scheduled as soon as possible.  
 
Community Anchor Institutions  
 
Connect Kansas has established an ongoing mechanism for gathering data on the location and 
broadband connectivity of Community Anchor Institutions (CAI), in accordance with the data 
requirements of the SBDD NOFA Technical Appendix.   
 
In conjunction with the state of Kansas, outreach was conducted during this data update reporting 
period by Connect Kansas to continue identification of existing, centralized sources for CAI 
connectivity data.  Outreach was coordinated to distribute the CAI survey to institutions throughout 
the state through multiple methods including a customized online survey available on the Connect 
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Kansas website.  Connect Kansas continues to work diligently in the state to identify statewide 
associations and to work closely with organizations such as the Kansas State Library, Kansas 
Department of Education, and the State Office of the Adjutant General to promote the importance 
of broadband connectivity at anchor institutions and participation in this data collection process.   
 
While we continue to document institutions and the related addresses, the connectivity data 
collected in most categories remains incomplete at this time.  Connect Kansas will be implementing 
a number of new processes to increase participation including launching a CAI newsletter to 
connect communities across the state, increasing industry-specific planning to target new community 
contacts, and revising the CAI portion of our website to increase visibility and content.  
Additionally, Connect Kansas will continue to work collaboratively with the Kansas Broadband 
Advisory Task Force to identify opportunities to gather and promote CAI data.  From our work in 
Kansas, as well as other states, we recognize the great value of this data to future collaboration 
efforts within the state and its value to the recently released National Broadband Map.  We plan to 
continue to bring best practices to the Connect Kansas efforts, along with an investment of both 
human and technical resources required to reach our goal of increasing the data that is secured and 
reported as part of this process. 
 
In acquiring both broadband availability and CAI data within the state of Kansas, Connected Nation 
has previously engaged all federally recognized tribal lands in the area covered by the Connect 
Kansas SBDD grant and reported that outreach as part of past submissions.  Throughout the next 
reporting period Connect Kansas plans to engage directly with these tribal communities and will also 
conduct affirmative outreach with Native American tribal organizations that are active within the 
area.  Connect Kansas understands the connectivity challenges facing these tribes, and we have 
identified a need to include their data as part of our upcoming submissions. 
 
 
The Connect Kansas program exists to improve data on the deployment and adoption of broadband 
services and to assist in the extension of broadband technology across all regions of the great state 
of Kansas, as well as the United States through contribution to the National Broadband Map.  We 
look forward to the continuing work ahead. 
 
Respectfully submitted, 
 
 
 
 
Thomas W. Ferree 
Chief Operating Officer 
Connected Nation, Inc. 
 
 
 

 

dclark
Cueball
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DATA ACQUISITION:  KANSAS COMMUNITY ANCHOR INSTITUTIONS  

In this third reporting period of the SBDD, Connect Kansas, working in close coordination with the 
Kansas Department of Commerce, has established an ongoing mechanism for gathering data on the 
location and broadband connectivity of Community Anchor Institutions (CAI), in accordance with 
the data requirements of the SBDD NOFA Technical Appendix.  During this reporting period 
Connect Kansas has continued to focus efforts on conducting outreach and raising awareness of this 
important project. 
 
Connect Kansas has continued to identify and process CAI data obtained through an ongoing 
statewide outreach campaign.  Physical address information continues to be augmented through 
manual sourcing and geocoded by Connect Kansas through ESRI ArcGIS software. 
 
Connect Kansas continues to utilize a customized online survey hosted through SurveyMonkey, 
with a landing page on the Connect Kansas website that was developed during the first reporting 
period.  This survey, in combination with a customized data gathering spreadsheet, was distributed 
to a targeted list of CAI throughout the state.  Connect Kansas will continue to use these data 
gathering tools for future targeted outreach efforts throughout the coming months leading up to the 
next reporting period.  These materials are customized to fit the CAI categories as defined in the 
SBDD NOFA.   
 
The survey can be accessed at this link (no password required): 
http://www.connectkansas.org/mapping/Community_Anchor_Institution_Data_Collection.php 
 
Connect Kansas and the Kansas Department of Commerce have worked closely during this 
reporting period to conduct research as part of an ongoing process to identify existing, centralized 
sources for CAI connectivity data.  The Kansas State Library is currently compiling data from its 
own internal sources on hundreds of libraries in the state.  Connect Kansas will be submitting this 
data in the next reporting period. 
 
In tandem with these efforts to identify existing data, Connect Kansas continues to identify key CAI 
contacts among all CAI categories in an effort to distribute and promote the online survey and raise 
awareness of the importance of CAI broadband connectivity.  
 
Connect Kansas continues to utilize the extensive database of contact information that was provided 
by the Kansas Department of Education (KanEd) to distribute surveys to schools and hospitals 
throughout the state.  Additionally, Connect Kansas will once again be working with the Kansas 
Adjutant General to distribute surveys to key public safety contacts throughout the state in the 
coming months.  Connect Kansas expects another increase in this data for the upcoming reporting 
period. 
  
Connect Kansas has an ongoing mission to educate CAI throughout the state on the importance of 
participating in the project.  Participation by these institutions will raise awareness about the 
importance of broadband connectivity and the need to report the requested data for inclusion on the 
National Broadband Map.  To assist with our data collection efforts, Connect Kansas is developing 
a CAI newsletter to be distributed quarterly beginning in April 2011.   The newsletter will highlight a 
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CAI in Kansas, encourage institutions to share their data, and highlight the National Broadband 
Map. 
 
The greatest challenge with collecting this data continues to be the difficulty in securing CAI 
broadband connectivity data.  Connect Kansas will continue its ongoing work with the Kansas 
Department of Commerce and key organization contacts in an effort to raise awareness of this 
project among CAI.  An update on our current data will be provided to the Kansas Broadband 
Advisory Task Force and participation by its members to assist with promoting our survey will be 
encouraged.  Leading up to the next reporting period, Connect Kansas will be specifically focusing 
on leveraging our relationship with the Kansas Adjutant General’s office to secure additional public 
safety data, continuing to utilize data from the Kansas Department of Education, and focusing on 
securing data from governmental entities. 
 
A CAI summary of all processed and submitted data is provided below: 
 

CAI Type Total 
Physical 
Address Lat/Long

Technology 
of 

Transmission
Download 

Speed 
Upload 
Speed 

K-12 Schools 2,175 2,174 2,175 885 1,998 1,999
Libraries 438 438 438 220 330 261
Healthcare 245 245 244 132 197 196
Public Safety 1,698 1,684 1,696 302 112 107
Higher Ed Institutions 103 103 102 76 101 100
Other Government 520 519 520 265 267 266
Other Non-Government 3 3 3 3 3 3
Total 5,182 5,166 5,178 1,883 3,008 2,932

 

 
SBDD DATA SUBMISSION METHODOLOGY 

The submission of the broadband dataset for April 1, 2011, is contained within the SBDD Data 
Transfer Model and additional components as released on the Grantee Workspace on January 14, 
2011. Connected Nation has reviewed all literature that relates to the release and use of this data 
transfer model and recognizes that it does not replace or dictate how data is stored, processed, or 
displayed for the state or territory, as it is meant primarily as a means to transfer the broadband data 
from all states and territories and populate the National Broadband Map in a seamless fashion. 
Guidance from the Technical Mapping Guide, as released on the Grantee Workspace on March 24, 
2011, was also followed to ensure the completeness and validity of the submission through 
completion steps and checklists, completing the DataPackage spreadsheet, uploading broadband 
datasets into the Data Transfer Model, and checking the dataset using the SBDD_CheckSubmission 
receipt process.  
 
In addition to the narratives and methodologies contained herein, as well as the DataPackage.xls 
containing contact information, the data dictionary, and a provider summary table, the following 
feature classes are submitted within the SBDD Data Transfer Model for the state of Kansas. 
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 Inventory of Deliverables, Connect Kansas: April 1, 2011 
 
NOFA Requirement Data Transfer Model Data Description 
Appendix A:  1(a)(i) BB_Service_CensusBlock Broadband Service Availability of 

Facilities-Based Providers in 
Census Blocks of No Greater 
Than Two Square Miles in Area. 

Appendix A:   1(a)(ii) BB_Service_RoadSegment Broadband Service Availability of 
Facilities-Based Providers by Road 
Segment in Census Blocks Larger 
in Area Than Two Square Miles. 

Appendix A:   1(b) BB_Service_Wireless Broadband Service Availability of 
Wireless Services Not Provided to 
a Specific Address. 

Appendix A:   3(b) BB_ConnectionPoint_MiddleMile Broadband Service Infrastructure 
Middle-Mile and Backbone 
Interconnection Points. 

Appendix A:   4 BB_Service_CAInstitutions  Community Anchor Institutions-
Listing. 

 
The provider data collected by Connected Nation on behalf of the state of Kansas have been 
formatted per the given specifications and uploaded into the appropriate feature classes of the 
SBDD Data Transfer Model. Wireline availability is contained within census blocks and road 
segments, wireless availability is contained as polygons of coverage areas, and middle-mile 
connections and community anchor institutions are contained as point data. All speed data is 
contained at the census block, road segment, or wireless polygon level of availability. All efforts have 
been made to comply with formatting, domain, and metadata requirements to include as much 
information as possible.  
 
Connected Nation has continued outreach to satellite providers on their availability, technology, and 
speed information, but it is not included in this submission dataset.  Additional information is 
necessary to be able to show where service satisfactorily exists in the state, rather than submitting 
the entire boundary of the state as the serviceable area.  Analysis information distributed and 
discussed with the satellite providers, as well as any additional guidance from the Program Office on 
the desired analysis for satellite-serviceable areas, will be implemented for the October 2011 data 
submission.  
 

 
KANSAS FIELD VALIDATION NARRATIVE 

Connected Nation focused a portion of its time on specific validation processes such as: 
 

• conducting random spectrum analysis studies throughout the state using an Avcom PSA-37-
XP spectrum analyzer; 

• conducting mobile speed tests throughout the state using an iPhone, Android (or other 
smart phone) as well as provider-specific aircards (Sprint 3G/4G, Clearwire et al); 
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• identifying pre-selected, provider-submitted wireless transmit tower sites and cross-
referencing data about that tower against the Federal Communications Commission (FCC) 
databases such as Antenna Structure Registration and/or the Universal Licensing System; 

• cross-referencing Federal Registration Number data against available FCC Form 477 data as 
well as the FCC COmmission REgistration System (CORES); 

• validating provider-submitted data (for example: latitude/longitude) using a handheld 
Garmin eTrex Summit GPS unit or GPS enabled software such as Microsoft Streets and 
Trips; 

• locating physical wire-line attributes (such as remote terminals, CATV plant, etc.) and 
comparing them against provider submitted data; and  

• conducting on-net and off-net speed tests using the FCC portal at 
http://www.broadband.gov/qualitytest/about/ or using the Ookla Net Metrics enabled 
speed test utility located on each of Connected Nation’s state specific websites. 

 
Additionally, Connected Nation cross-referenced numerous public documents in order to ensure 
that all known broadband providers were located and contacted.  This included searching 
membership logs from the trade associations (WISPA, WCAI, PCIA, etc.), the Cable Television Fact 
Book, Public Utility Commission records, Public Service Commission records, Chamber of 
Commerce, etc. 
 
To date, Connected Nation has conducted field validation on 53 (53%) of the viable providers in 
Kansas.  Field validation tests have been conducted on Allegiance Communications, AT&T, Benson 
Telephone Service, BroadBand Wireless Internet (BBWI), Cable ONE Inc., CenturyLink, Clearwire 
Corporation, Columbus Telephone Company, Cox Communications Inc., Craw-Kan Telephone 
Cooperative Inc., CTC Wireless Internet, Cyber Lodge Wireless, Eagle Communications Inc., 
Elkhart Telephone Company Inc., Fairpoint Communications Inc., Golden Belt Telephone 
Association Inc., H&B Cable Service Inc., Haviland Telephone Company, IdeaTek Systems Inc., 
J.B.N. Telephone Company, Kanokla Telephone, Kansas Broadband Internet Inc., LaHarpe 
Telephone Company Inc., Madison Telephone Company LLC, Mediacom Communications 
Corporations, Mercury Wireless, Mid-Kansas Cable Services, Midwest Connections Inc., Mobil1.net, 
Moundridge Telephone Company Inc., Pioneer Telephone Association, Pixius Communications 
LLC, Rainbow Telecommunications Associations Inc., Rural Telephone Service Company Inc., S&A 
Telephone Company Inc., S&T Telephone Cooperative Association, SKT Inc., South Central 
Telephone Association, Sprint, St. Joe Wireless, Sumner Communications, Sunflower Broadband 
(Knology), The Computer Generation, Totah Communications Inc., Tri-County Telephone 
Association Inc., Tri-Rivers, United Telephone Association, U.S. Cellular, Valnet LLC, Verizon 
Communications Inc., Wamego Telecommunications Company Inc., Wave Wireless, Wheat State 
Telephone Inc., and Wheatland Electric Cooperative Inc. 
 
 
ACCURACY AND VERIFICATION:  METHODOLOGY - PROVIDER VALIDATION 

Broadband providers maintain their service area data in many different formats, all in varying levels 
of complexity and granularity. In order to ensure that the data required by the NTIA is standardized 
across all providers and that it is as accurate as possible, Connected Nation translates and formats 
the data that providers are able to supply into a GIS shapefile and produces maps for the provider to 
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review.  The resulting map(s) and review process allow for providers to see their service area in a 
geographic format – for some providers, this is the first time they have seen maps of their 
broadband service area. Having the mapped service area allows providers to quickly identify any 
issues that appear in the data representation, whether the issue is in the data translation into a GIS 
format or from the original data collection and submission. Often data is provided from various 
sources and through the review and revision process, local engineers who operate the networks and 
work in the field are able to ensure that the tabular data that has been submitted is accurate and 
represents the real-world network extent. Any issues in how the service area is represented on the 
map(s) are remedied by Connected Nation, whether they are additions, removal of service, or any 
other revisions. Revised maps of service area representations are sent to the provider for review and 
approval; Connected Nation will revise data and return maps as many times as necessary until the 
provider is in agreement that the map represents their service area as accurately as possible. Once 
the review process has been completed and final approval of the data is provided, the data is deemed 
ready for NTIA submission. 
 
Once the data collection has been aggregated to a statewide level, static maps of statewide and 
county-level availability are produced and made publicly available. In addition, consumers can visit 
the interactive online tool, BroadbandStat, to create customized views of broadband service areas 
and analyze corresponding demographic information. Leveraging broadband service data on various 
platforms allows for public users, providers, and other stakeholders to review, scrutinize, and 
provide feedback on the represented data. This feedback becomes a validation method in itself as 
consumers submit inquiries to Connected Nation either affirming where service is not available or 
identifying areas where broadband service is shown on the map, but in actuality is not available. This 
allows for a follow-up to providers regarding revisions to the data as it is represented; it also allows 
for Connected Nation to identify locations where on-site visits may be necessary to complete field 
validation of available services. Public feedback on all forms of mapping products serves as a 
localized validation method for provider-supplied information and allows Connected Nation to 
resolve inaccuracies as they are identified to ensure that only the highest quality information is 
provided to stakeholders. 
 
Estimates derived from provider-validated data indicate that approximately 2.29% of Kansas 
households do not have terrestrial fixed broadband service available, and approximately 0.12%1 of 
Kansas households have neither mobile nor fixed broadband service available.2   
 
Within rural areas of the state, results derived from provider-validated data indicate that 
approximately 4.85% of rural Kansas households do not have terrestrial fixed broadband service 

                                                            
1 In accordance with NTIA’s definition of available broadband service as specified in the SBDD NOFA, this estimate 

includes both terrestrial fixed and mobile broadband service, if the service offers download speeds of at least 768 Kbps 
and upload speeds greater than 200 Kbps. 

2 Due to the nature of the SBDD data collection methodology as defined by the NTIA and based on both census 
block geographic units and street segment data, the estimates of broadband availability derived from provider-validated 
data may include an overstatement of the actual number of households with broadband availability.  Under the census 
block-based data collection method, a provider will typically report broadband availability for an entire census block 
whether its network is present across the whole or only a subset of that census block.  This potential overestimation at 
the census block level can be amplified as the data is aggregated across the entire state. 
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available, and approximately 0.28%3 of rural Kansas households have neither mobile nor fixed 
broadband service available.4   
 

WIRELESS METHODOLOGY 

 
Broadband Service Availability in Provider’s Service Area 

Wireless Services Not Provided to a Specific Address 
 
Data solicited from a fixed wireless provider to create propagation models include, but are not 
limited to: 

1. The name of the structure 
2. Whether the transmitting device is operational or proposed 
3. The maximum advertised downstream speed, the maximum advertised upstream speed 
4. The typical downstream speed, the typical upstream speed (peak periods for both) 
5. The frequency range of spectrum being used (as prescribed by NTIA) 
6. The primary population center(s) being served (for geopolitical boundary reference) 
7. The physical address of the transmit site (in the event latitude/longitude is unavailable from 

the provider this allows a quick reference point for geocoding) 
8. Latitude in either Degrees, Minutes and Seconds and/or in Decimal Degrees (typically 

received as NAD 27 or NAD 83)  
9. Longitude in either Degrees, Minutes and Seconds and/or in Decimal Degrees (typically 

received as NAD 27 or NAD 83)  
10. Antenna pattern (e.g. omni-directional, 180°, 120°, 90°, etc.) 
11. Azimuth of antenna (e.g 360° with magnetic declination if known) 
12. Approximate transmit radius (in feet, miles, or kilometers) 
13. Polarity of transmit antenna (Vertical or Horizontal) 
14. Transmit antenna gain (in dBi) 
15. Line loss (applicable only to providers using coax, heliax, waveguide or other forms of 

cabling – excludes power-over-Ethernet devices) 
16. Mechanical and/or Electrical beam tilt (if applicable) 
17. Equipment Manufacturer (allows easy cross-reference against manufacturer’s specification 

sheet) 
18. Power output of the transmitting device (if unknown, FCC standards or manufacturer 

specifications are applied) 
19. AMSL at base of tower site 
20. Antenna centerline AGL (height of antenna above ground level measured at the centerline 

of the actual antenna) 
21. Foliage factors (Evergreens/Deciduous and percent of ground cover) 

                                                            
3 See footnote 1. 
4 See footnote 2. 
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22. Ground Clutter (primarily used in rural areas to account for foliage and in metropolitan areas 
to account for types and heights of buildings if known)   

23. Average gain of receive antenna 
24. Receive antenna is estimated at height above average terrain (HAAT) of 6.2 meters/20 feet 
25. Federal Registration Numbers (if applicable) which may allow opportunities to cross-

reference and/or obtain additional data from the Federal Communications Commission 
Universal Licensing System and the COmmission REgistration System 

 
Propagation modeling is an empirical mathematical formulation for the characterization of radio 
wave propagation as a function of frequency, distance, and other conditions. Propagation 
software(s) typically use the Irregular Terrain Model (also known as Longley-Rice) of radio 
propagation for frequencies between 20 MHz and 20 GHz. This model is based on electromagnetic 
theory and statistical analyses of the combination of terrain features and radio measurements, then 
predicting the median attenuation of a radio signal as a function of distance and the variability of the 
signal in time and in space.  For metropolitan areas, the software can typically be adjusted to use the 
Okumura-Hata model which accounts for predicting the behavior of cellular transmissions in areas 
where buildings are the primary obstructions. The resulting product from either model depicts a 
graphical illustration of the theoretical propagation characteristics of a selected frequency range 
based on defined variables (receiver sensitivity of the home/mobile device, foliage factor, and digital 
elevation terrain input). 
 
 
BROADBAND INQUIRIES METHODOLOGY 

Connected Nation collects consumer feedback in the form of broadband inquiries. These inquiries 
represent any type of communication received from the public regarding broadband service. Once 
broadband inquiries are received across the state, this information is overlaid with the broadband 
availability information which was collected through the SBDD program.  This allows for a real-
world comparison of the broadband landscape to the information received from broadband 
inquiries.  Broadband inquiries are able to provide three types of information:  1) Residents who do 
not have broadband but want it.  2)  Residents who have broadband but want a different provider.  
3)  Residents who do not have broadband, but the broadband inventory maps indicate that they do. 
 
Through the collection of broadband inquiries, a visual demand for broadband is presented.  This 
visualization allows Connected Nation the ability to validate broadband availability maps for 
accuracy.  If residents within a region state that they are without broadband, but the broadband 
inventory maps show otherwise, this allows Connected Nation to approach the providers within that 
area in an effort to trim down their coverage to more accurately represent real-world availability on 
the ground.  On the other hand, if there is a region in the territory in which broadband is not 
available, the broadband inquiries allow providers close to that region to see where they can 
successfully expand their broadband networks, leading to a high return on investment.  In short, the 
higher number of inquiries leads to a higher level of certainty in regard to the broadband availability 
maps.  Since the initial data collection and release of corresponding maps, feedback in the form of 
broadband inquiries has allowed Connected Nation to identify additional areas that are in need of 
field validation, which are scheduled as soon as possible. Additional information on field validation 
can be found in the Field Validation Narrative. 
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The broadband inquiry process has been implemented in each of the Connected Nation state 
programs with successful results. Altogether Connected Nation has received over 16,000 broadband 
inquiries since 2007, allowing the state programs to evaluate each inquiry for broadband demand and 
data verification.  These inquiries are continuously examined against current broadband availability, 
updated every six months, to determine if previously unserved households have been expanded to 
and can now receive broadband at their residence. This database of broadband inquiries has also 
allowed the Connected Nation state programs to aggregate demand in concentrated areas to show 
providers the exact locations where the population has made it clear that they would purchase 
broadband if it was made available to them. Providers in the states have responded to this process 
and have expanded to areas knowing that their investment will be worthwhile. Data verification 
methods have also proven successful, as the state programs have been able to show those inquiries 
that indicate the broadband service areas are misrepresented on the map to providers, who then 
verify where service cannot reach in regard to that residence(s). The broadband coverage in these 
states has been altered to create a more accurate map based on the inquiries submitted by the public. 
 
During this reporting period, the Connect Kansas project has received a total of 39 inquiries (393 
grant inception to date).  As more inquiries are submitted to Connect Kansas, a more thorough 
validation of the broadband landscape can be performed, while also allowing providers to see which 
areas have a high demand for broadband adoption. 
 
 
BROADBAND INVENTORY MAPS 

The Broadband Inventory Maps are printer-friendly maps that include broadband coverage, cities, 
and towns, county boundaries, and detailed road information across the state of Kansas. The 
accuracy of these maps is critical to the future of broadband infrastructure planning in Kansas. The 
purpose of the maps is two-fold: 
 

• Data Verification – Broadband providers and the public should use the map to ensure the 
current service area is accurately reflected. 

 
•  Broadband Expansion Plans – Broadband providers can use the inventory maps and 

unserved household density maps to learn where there are currently unserved areas that 
are densely populated. These maps can aid providers in identifying potential areas of 
expansion that could yield a high return on investment. 

 
To date, the Connect Kansas Broadband Inventory Maps have received a total of 9,358 downloads. 
Of those 9,358 downloads, the Statewide Broadband Inventory Maps received 902 downloads, the 
County Broadband Inventory Maps received 6,116 downloads, and the census block level data 
received 1,907downloads. 

 

BROADBANDSTAT METHODOLOGY  

BroadbandStat is an online, interactive mapping tool for viewing, analyzing, and validating 
broadband data. Developed through a partnership with ESRI, the market leader in geographic 
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information system (GIS) software, BroadbandStat is a multi-functional, user-friendly way for local 
leaders, policymakers, consumers, and technology providers to devise a plan for the expansion and 
adoption of broadband.  
 
First and foremost, BroadbandStat allows consumers to locate their residence and identify providers 
that offer broadband Internet service to that location. The interactive platform allows for users to 
build and evaluate broadband expansion scenarios using a wealth of data, including education and 
population demographics, broadband availability, and research about the barriers to adoption.  
 
New functionality in BroadbandStat allows the consumers to provide feedback on the broadband 
data displayed on the interactive map.  Through the collection of this feedback, a visual demand for 
broadband is presented.  This visualization allows the Connected Nation state programs the ability 
to validate the broadband availability for accuracy.  If residents within a region state they are without 
broadband, but the interactive map shows otherwise, this allows Connected Nation to approach the 
providers within that area in an effort to trim down their coverage to more accurately represent real-
world availability on the ground.   
 
The Connect Kansas project launched BroadbandStat on September 23, 2010, and has received a 
total of 950 visits to date, of which 932 occurred this reporting period. 
 
 
SPEED TEST METHODOLOGY 

The 909 speed tests that are represented in the Connect Kansas Speed Test Report during this 
reporting period (2,014 grant inception to date) are the result of a partnership between Connected 
Nation and Ookla Net Metrics. Utilizing this relationship increases the level of confidence in the 
data being collected and provides for a far greater sample size than could be collected by a single 
testing site. 
 
Ookla owns and operates Speedtest.net, as well as develops and deploys speed tests, such as the 
Connect Kansas speed test website, for partners around the world. This network of sites that is 
developed and run on its testing technology provides Ookla with a vast dataset that, due to the 
variability of geographic information collected across the varying speed test sites, is geocoded 
utilizing Geo-IP technology. This technology allows for tests to be geocoded to points of 
aggregation, typically larger nodes across provider networks.  While there are hundreds of thousands 
of tests that have been conducted, the level of aggregation is only sufficient for county-level detail 
due to the test results being located at these larger nodes and not at an absolute location for each 
speed test. 
 
In an effort to validate broadband data from the Connect Kansas project, speed test information is 
collected throughout the state.  Speed tests provide speed information on the path taken through all 
networks (a provider’s network as well as additional networks) a local machine must connect to in 
order to reach the host test.  The benefit of this collection of speed information is two-tiered.  First, 
it allows for a comprehensive dataset of speeds, while also providing Connect Kansas with the 
information on where broadband services are available.  Second, unlike theoretical speed 
information which was received through the data collection process, the use of speed tests provide 
real-world information on the speeds that currently exist within the state of Kansas.  



Complete 142
Non-Responsive/Refused 12
In Progress 17

Count of Datasets by Viable Status 171
Total Unique Providers Represented 100

Provider Name Platform Status NDA Execution Date Notes
Allegiance Communications Cable Data Added to Statewide Inventory 2/4/2010
AT&T Communications of Texas, Inc. Mobile Wireless Data Added to Statewide Inventory 12/16/2009
AT&T Communications of Texas, Inc. ILEC/CLEC Data Added to Statewide Inventory 12/16/2009
Atwood Cable Systems, Inc. Cable Data Added to Statewide Inventory
Benkelman Telephone Company Fiber Data Added to Statewide Inventory 1/12/2010
Blue Valley Tele-Communications, Inc. Cable Data Added to Statewide Inventory 11/17/2009
Blue Valley Tele-Communications, Inc. ILEC/CLEC Data Added to Statewide Inventory 11/17/2009
Blue Valley Tele-Communications, Inc. Fiber Data Added to Statewide Inventory 11/17/2009
Cable ONE, Inc. Cable Data Added to Statewide Inventory 12/7/2009
CenturyLink ILEC/CLEC Data Added to Statewide Inventory 12/4/2009
Cequel Communications, LLC Cable Data Added to Statewide Inventory 12/15/2009
City of Chanute Fiber Data Added to Statewide Inventory
Clearwire Corporation Mobile Wireless Data Added to Statewide Inventory
Comcast Cable Communications, LLC Cable Data Added to Statewide Inventory 12/7/2009
Craw-Kan Telephone Cooperative, Inc. Fixed Wireless Data Added to Statewide Inventory 12/7/2009
Craw-Kan Telephone Cooperative, Inc. Fiber Data Added to Statewide Inventory 12/7/2009
Cunningham Communications, Inc. Fiber Data Added to Statewide Inventory 9/8/2009
Eagle Communications, Inc. Fixed Wireless Data Added to Statewide Inventory
Eagle Communications, Inc. Cable Data Added to Statewide Inventory
Eagle Communications, Inc. Fiber Data Added to Statewide Inventory
Golden Belt Telephone Association, Inc. Fiber Data Added to Statewide Inventory
Golden Belt Telephone Association, Inc. Cable Data Added to Statewide Inventory
H & B Cable Service, Inc. ILEC/CLEC Data Added to Statewide Inventory 10/13/2009
H & B Cable Service, Inc. Fiber Data Added to Statewide Inventory 10/13/2009
H & B Cable Service, Inc. Fixed Wireless Data Added to Statewide Inventory 10/13/2009
Home Communications, Inc. ILEC/CLEC Data Added to Statewide Inventory 11/5/2009
Home Communications, Inc. Fiber Data Added to Statewide Inventory 11/5/2009
KanOkla Telephone Association, Inc. Fixed Wireless Data Added to Statewide Inventory 12/18/2009
Knology of Kansas Cable Data Added to Statewide Inventory
Knology of Kansas Fixed Wireless Data Added to Statewide Inventory
Leap Wireless International, Inc. Mobile Wireless Data Added to Statewide Inventory 4/6/2010
Mercury Wireless Fixed Wireless Data Added to Statewide Inventory 3/25/2010
Moundridge Telephone Company, Inc. ILEC/CLEC Data Added to Statewide Inventory 10/7/2009
Mutual Telephone Company Fixed Wireless Data Added to Statewide Inventory 12/9/2009
North Central Kansas Community Network Fixed Wireless Data Added to Statewide Inventory
Peoples Telecommunications, LLC ILEC/CLEC Data Added to Statewide Inventory 12/1/2009
Pioneer Telephone Association, Inc. Cable Data Added to Statewide Inventory 12/7/2009
Rural Telephone Service Company, Inc. Fixed Wireless Data Added to Statewide Inventory 11/16/2009
Rural Telephone Service Company, Inc. ILEC/CLEC Data Added to Statewide Inventory 11/16/2009
Rural Telephone Service Company, Inc. Fiber Data Added to Statewide Inventory 11/16/2009
South Central Telephone Association ILEC/CLEC Data Added to Statewide Inventory 12/17/2009
South Central Telephone Association Fiber Data Added to Statewide Inventory 12/17/2009
Sprint Nextel Corporation Mobile Wireless Data Added to Statewide Inventory 1/14/2010
St. Joe Wireless Fixed Wireless Data Added to Statewide Inventory
Stelera Wireless, LLC Mobile Wireless Data Added to Statewide Inventory
Sumner Cable TV, Inc. Fixed Wireless Data Added to Statewide Inventory
Sumner Cable TV, Inc. Cable Data Added to Statewide Inventory
SWKO, Inc. Fixed Wireless Data Added to Statewide Inventory 2/18/2011
T-Mobile USA, Inc. Mobile Wireless Data Added to Statewide Inventory 1/8/2010
Time Warner Cable LLC. Cable Data Added to Statewide Inventory 12/21/2009
Tri-County Telephone Association, Inc. ILEC/CLEC Data Added to Statewide Inventory 12/1/2009
Tri-County Telephone Association, Inc. Fiber Data Added to Statewide Inventory 12/1/2009
Tri-County Telephone Association, Inc. Fixed Wireless Data Added to Statewide Inventory 12/1/2009
United States Cellular Corporation Mobile Wireless Data Added to Statewide Inventory 2/15/2011
Valnet Telecommunications, LLC Fixed Wireless Data Added to Statewide Inventory
Verizon Communications, Inc. Mobile Wireless Data Added to Statewide Inventory 12/14/2009
Wamego Telecommunications Company, Inc. ILEC/CLEC Data Added to Statewide Inventory 9/29/2009
Wheatland Broadband Services Fixed Wireless Data Added to Statewide Inventory 6/17/2010
Wilson Telephone Company, Inc. Fiber Data Added to Statewide Inventory 9/29/2009

Zito Midwest, LLC Cable Data Added to Statewide Inventory 2/17/2011
[JAN-19-11 Daryl Coffey] Zito 
Midwest purchased Galaxy Cable.

CenturyLink Backhaul Backhaul Provider Only Processing Complete 12/4/2009
City of Chanute Backhaul Backhaul Provider Only Processing Complete
Cogent Communications, Inc. Backhaul Backhaul Provider Only Processing Complete
Level 3 Communications, LLC Backhaul Backhaul Provider Only Processing Complete 12/14/2009
MCC Missouri LLC Backhaul Backhaul Provider Only Processing Complete 1/12/2010
Zayo Group, LLC Backhaul Backhaul Provider Only Processing Complete
McLeodUSA Telecommunications Services, Inc. ILEC/CLEC Provider Approval Solicited
Ace Computers Fixed Wireless Provider Gathering Data
City of Coffeyville Fixed Wireless Provider Gathering Data
JMZ CORPORATION Fixed Wireless Provider Gathering Data
Knology of Kansas Fiber Provider Gathering Data
Midwest Connections, Inc. Fixed Wireless Provider Gathering Data
Benkelman Telephone Company ILEC/CLEC No Update to Provide 1/12/2010
Benson Tel Service Inc. Fixed Wireless No Update to Provide 12/15/2009
Blue Valley Tele-Communications, Inc. Fixed Wireless No Update to Provide 11/17/2009

Broadband Provider Log



Cequel Communications, LLC Backhaul No Update to Provide 12/15/2009
Columbus Telephone Company Fiber No Update to Provide 10/2/2009
CoxComm Inc. Cable No Update to Provide 1/29/2010
CoxComm Inc. Backhaul No Update to Provide 1/29/2010
Craw-Kan Telephone Cooperative, Inc. ILEC/CLEC No Update to Provide 12/7/2009
CTC Wireless Internet Backhaul No Update to Provide 11/20/2009
Cunningham Communications, Inc. Cable No Update to Provide 9/8/2009
Cunningham Communications, Inc. ILEC/CLEC No Update to Provide 9/8/2009
Cyber Lodge Internet Services, Inc. Fixed Wireless No Update to Provide 1/6/2010
Diller Telephone Company ILEC/CLEC No Update to Provide
Eagle Communications, Inc. Backhaul No Update to Provide
Elkhart Telephone Company, Inc. Fiber No Update to Provide 3/23/2010
Elkhart Telephone Company, Inc. Fixed Wireless No Update to Provide 3/23/2010
Elkhart Telephone Company, Inc. Backhaul No Update to Provide 3/23/2010
Fairpoint Communications, Inc. ILEC/CLEC No Update to Provide 1/22/2010
Fairpoint Communications, Inc. Fixed Wireless No Update to Provide 1/22/2010
Golden Belt Telephone Association, Inc. ILEC/CLEC No Update to Provide
Golden Belt Telephone Association, Inc. Fixed Wireless No Update to Provide
Gorham Telephone Company, Inc. ILEC/CLEC No Update to Provide 9/30/2009
Gorham Telephone Company, Inc. Fiber No Update to Provide 9/30/2009
H & B Cable Service, Inc. Cable No Update to Provide 10/13/2009
Haviland Telephone Company, Inc. ILEC/CLEC No Update to Provide 12/3/2009
Haviland Telephone Company, Inc. Fixed Wireless No Update to Provide 12/3/2009
Home Communications, Inc. Cable No Update to Provide 11/5/2009
IdeaTek Systems, Inc. Fiber No Update to Provide 3/4/2010
JBN Telephone Company, Inc. Fixed Wireless No Update to Provide 12/14/2009
JBN Telephone Company, Inc. ILEC/CLEC No Update to Provide 12/14/2009
KanOkla Telephone Association, Inc. ILEC/CLEC No Update to Provide 12/18/2009
Kansas Broadband Internet, Inc. Fixed Wireless No Update to Provide 1/15/2010
Kansas Data Internet, Inc. Fixed Wireless No Update to Provide
KeyOn Communications, Inc. Fixed Wireless No Update to Provide 10/15/2009
LaHarpe Telephone Company, Inc. Fiber No Update to Provide 9/28/2009
Lawrence Freenet Fixed Wireless No Update to Provide 10/5/2009
Madison Telephone Company, LLC ILEC/CLEC No Update to Provide 11/17/2009
MCC Missouri LLC Cable No Update to Provide 1/12/2010
Mokan Dial, Inc. ILEC/CLEC No Update to Provide 12/2/2009
Mutual Telephone Company Fiber No Update to Provide 12/9/2009
Mutual Telephone Company Backhaul No Update to Provide 12/9/2009
Nautilus Net Fixed Wireless No Update to Provide
Pioneer Telephone Association, Inc. ILEC/CLEC No Update to Provide 12/7/2009
Pixius Communications LLC Fixed Wireless No Update to Provide
Rainbow Telecommunications Association, Inc. ILEC/CLEC No Update to Provide 12/9/2009
Rainbow Telecommunications Association, Inc. Cable No Update to Provide 12/9/2009
Rainbow Telecommunications Association, Inc. Fiber No Update to Provide 12/9/2009
Rainbow Telecommunications Association, Inc. Fixed Wireless No Update to Provide 12/9/2009
Rebeltec Communications LLC Fixed Wireless No Update to Provide
S & A Telephone Company, Inc. ILEC/CLEC No Update to Provide 11/20/2009
S&T Telephone Cooperative Association ILEC/CLEC No Update to Provide 8/28/2009
S&T Telephone Cooperative Association Fiber No Update to Provide 8/28/2009
S&T Telephone Cooperative Association Fixed Wireless No Update to Provide 8/28/2009
South Central Telephone Association Backhaul No Update to Provide 12/17/2009
Southern Kansas Telephone Company, Inc. ILEC/CLEC No Update to Provide 12/31/2009
Southern Kansas Telephone Company, Inc. Cable No Update to Provide 12/31/2009
Southern Kansas Telephone Company, Inc. Fiber No Update to Provide 12/31/2009
Sprint Nextel Corporation Backhaul No Update to Provide 1/14/2010
Superior iNET Fixed Wireless No Update to Provide 1/29/2010
The Computer Generation, Inc. Fixed Wireless No Update to Provide 1/8/2010
Totah Communications, Inc. ILEC/CLEC No Update to Provide 9/8/2009
Tri-Rivers Internet Fixed Wireless No Update to Provide
Twin Valley Telephone, Inc. ILEC/CLEC No Update to Provide 10/12/2009
Twin Valley Telephone, Inc. Fiber No Update to Provide 10/12/2009
Twin Valley Telephone, Inc. Fixed Wireless No Update to Provide 10/12/2009
TwinMounds Fixed Wireless No Update to Provide
United Communications Association, Inc. ILEC/CLEC No Update to Provide 11/23/2009
United Communications Association, Inc. Cable No Update to Provide 11/23/2009
United Communications Association, Inc. Fixed Wireless No Update to Provide 11/23/2009
United Communications Association, Inc. Mobile Wireless No Update to Provide 11/23/2009
Wamego Telecommunications Company, Inc. Fiber No Update to Provide 9/29/2009
Wave Wireless Fixed Wireless No Update to Provide 2/19/2010
Wheat State Telephone, Inc. Fiber No Update to Provide 12/7/2009
Wheat State Telephone, Inc. ILEC/CLEC No Update to Provide 12/7/2009
Wilson Telephone Company, Inc. ILEC/CLEC No Update to Provide 9/29/2009
Haug Communications, Inc. Fixed Wireless No Update Provided - Use Last Submission Data 12/4/2009

arcplasma.com Fixed Wireless Refused to Participate

[JAN-18-11 James Tull] While 
attempting to solicit data in 
accordance with the NOFA, a 
company representative stated that 
they had no interest in participating 
and preferred that we not contact 
them anymore.

Southeast Nebraska Communications ILEC/CLEC Refused to Participate

[FEB-15-11 J Determan] While 
soliciting data in accordance with the 
NOFA, provider representative stated 
that there are still only five lines 
available in Kansas. They see no 
benefit in involvement.

Davin Wireless Fixed Wireless Non-Responsive to Multiple Attempts

In addition to multiple contact 
attempts between July 30, 2009 and 
March 24, 2010, nine attempts were 
made during this submission period.



Granby Telephone Co. ILEC/CLEC Non-Responsive to Multiple Attempts

Identified provider on October 26, 
2010.  Since then, five contact 
attempts were made.

SCI Cable, Inc. Cable Non-Responsive to Multiple Attempts

In addition to multiple contact 
attempts made between January 7, 
2010 and August 5, 2010, four 
attempts were made during this 
submission period.

SureWest Communications Cable Non-Responsive to Multiple Attempts

In addition to multiple contact 
attempts made between September 
8, 2009 and March 25, 2010, five 
attempts were made during this 
submission period.

SureWest Communications Fiber Non-Responsive to Multiple Attempts

In addition to multiple contact 
attempts made between September 
8, 2009 and March 25, 2010, five 
attempts were made during this 
submission period.

SureWest Communications Backhaul Non-Responsive to Multiple Attempts

In addition to multiple contact 
attempts made between September 
8, 2009 and March 25, 2010, five 
attempts were made during this 
submission period.

SureWest Communications ILEC/CLEC Non-Responsive to Multiple Attempts

In addition to multiple contact 
attempts made between September 
8, 2009 and March 25, 2010, four 
attempts were made during this 
submission period.

SwiftLink Communications Fixed Wireless Non-Responsive to Multiple Attempts

Provider was identified on October 
28, 2010.  Since then, five contact 
attempts were made.

Windjammer Communications, LLC Cable Non-Responsive to Multiple Attempts 11/16/2009

Provider was identified on October 
28, 2010.  Since then, five contact 
attempts were made.

WISP-Router, Inc. Fixed Wireless Non-Responsive to Multiple Attempts

In addition to multiple contact 
attempts made between July 30, 
2009 and August 17, 2010, four 
attempts were made during this 
submission period.

Columbus Telephone Company ILEC/CLEC Other 10/2/2009

[JAN-21-11 James Tull] In collecting 
data in accordance with the NOFA, a 
company representative advised that 
Columbus Telephone is strictly a 
FTTH provider and that they offer no 
DSL services (and have not for many 
years).

DISH Network Corporation Satellite Other 1/27/2010

[MAR-09-11 Brian Dudek] Satellite 
data will not be submitted due to 
additional information being 
necessary to show where service is 
available in the state, rather than 
submitting the entire state boundary 
as serviceable area.

Elkhart Telephone Company, Inc. ILEC/CLEC Other 3/23/2010

[FEB-24-11 John Determan]  Entire 
exchange FTTH.  Provider is an 
ILEC, not a DSL provider.

Elkhart Telephone Company, Inc. Cable Other 3/23/2010

[FEB-24-11 John Determan] No 
cable modem operation.  Cable 
delivers cable TV service only. 

Fairpoint Communications, Inc. Fiber Other 1/22/2010

[MAR-08-11 Wes Kerr] This provider 
doesn't offer fiber service and never 
has provided any fiber data.

Hughes Network Systems, LLC Satellite Other 2/5/2010

[MAR-09-11 Brian Dudek] Satellite 
data will not be submitted due to 
additional information being 
necessary to show where service is 
available in the state, rather than 
submitting the entire state boundary 
as serviceable area.

Madison Telephone Company, LLC Fiber Other 11/17/2009
[MAR-23-11 Dawn Clark] Provider 
will not offer fiber until summer 2011.

Rebeltec Communications LLC Cable Other
[MAR-02-11 Brian Dudek] Provider 
offers cable service in Colorado only.

S & A Telephone Company, Inc. Fiber Other 11/20/2009

[MAR-02-11 Brian Dudek]  They 
currently do not offer fiber, but plans 
are in place to replace their copper 
network soon.

Southern Kansas Telephone Company, Inc. Mobile Wireless Other 12/31/2009

[FEB-18-11 Brian  Dudek] Changed 
status as provider does not offer any 
mobile wireless services.

WildBlue Communications, Inc. Satellite Other 1/8/2010

[MAR-09-11 Brian Dudek] Satellite 
data will not be submitted due to 
additional information being 
necessary to show where service is 
available in the state, rather than 
submitting the entire state boundary 
as serviceable area.

Elkhart Telephone Company, Inc. Mobile Wireless Offers Service but Below FCC Definition 3/23/2010
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Introduction 
The following sections of this document provide an overview of the process used for the SBDD Broadband 

Mapping data development for the Commonwealth of Kentucky. The following narrative is depicted in Appendix 

A, Commonwealth of Kentucky SBDD Process Workflow, and Appendix B, State Broadband Data Validation 

Workflow, included at the end of this document. 

Broadband Provider Outreach 
The following outreach procedure provides the framework for communicating with Broadband Service Providers 

(Providers). The primary goals of the outreach approach documented herein are to:  

 Promote Provider understanding and acceptance of the Broadband Mapping process, results and benefits 

 Clarify NTIA Broadband Mapping requirements 

 Facilitate data confidentiality agreements as required 

 Minimize the submittal of invalid data 

 Enhance provider  understanding of the semi-annual update process   

 Work with Providers to evaluate submittal options to facilitate data submittals  

Data Submission Guidelines 
Guidelines for the Providers submission of of Broadband Mapping Data are documented in the “Data Submission 

Guidelines”. These Guidelines define technical requirements, submission, specifications, and coordination and 

documentation activities. 

Kentucky Broadband Providers Website 
A URL was deployed (http://www.bakergis.com/kyBroadbandProvider/) to communicate and distribute NTIA 

NOFA requirements to providers along with outreach and data submittal materials including: 

 NTIA NOFA and subsequent clarification 

 Outreach letters to providers 

 Non-Disclosure Agreement 

 Quick Start Guides 

 Data Submission Guidelines 

 Data Transmittal Letter 

 Broadband Data Submittal Templates 

 TIGER Data 

 Data Submittal Assistance Contact Information 

Outreach Delivery Vehicles 
 A State Broadband Mapping Initiative Call for Data letter from the Kentucky Commonwealth Office of 

Technology (COT) was emailed to all Broadband Service Providers in the Commonwealth. This initial 

provider contact letter described the program and the role of Michael baker Jr., Inc. (Baker) acting on behalf 

of the COT for Broadband Data Collection and Mapping. 

http://www.bakergis.com/kyBroadbandProvider/
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 Baker distributed a follow-up letter to all Providers describing the data submittal requirements and material 

and help available to aid with the data submittals. 

 Submittal assistance was provided to providers that needed help with data submittals. 

 Presentations were conducted with various broadband provider associations to present the data submittal 

requirements and answer questions. 

 Email communication and electronic transfer of data was encouraged to facilitate a faster delivery of data 

and information. 

 A URL was deployed and promoted to distribute outreach material and information concerning the 

Broadband Mapping Project. 

 A secure FTP URL was provided for submittal of broadband data by providers. 

Broadband Outreach Tracker Application 
The Tracker application (Figure 1) was utilized to collect all correspondence with Providers and feedback on the 

effectiveness of the outreach activities by tracking items such as:  

 The number and content of incoming e-mails and letters submitted from the Providers 

 The number and source of comments, questions, and suggestions made by Providers 

 The number and source of comments, questions, and suggestions made by attendees at Provider meetings 

and conference calls 

 Provider contact information and data submittal status. 
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Figure 1 Broadband Outreach Tracker 

Provider Submittal Validation 
When a data submittal is received from a broadband service provider it is updated in the Broadband Outreach 

Tracker and run through an initial validation process to assure that it meets the submittal guidelines.  

Validation Checklist 
The following items are part of this initial data validation process: 

 Verify the provider Transmittal Letter is complete and matches submitted data 

 Verify the file naming conventions 

 Verify each file is machine readable 

 Verify data is in the correct GIS or Tabular format/file type 

 Verify there are no duplicate records 

 Verify each field is populated and no empty or NULL values are present for mandatory fields 

 Verify all ID (record number points) are unique within the submittal 

 Verify all attribute data is formatted according to the submittal guidelines 

 Verify topology for all geospatial submissions 

 Verify Metadata for all submissions 

 Verify the required contact information is included 

 Verify adherence to Data Submittal Guidelines (see http://www.bakergis.com/kyBroadbandProvider/ to 
access Data Submittal Guidelines) 
Broadband Service Availability (at least one) 

 Individual Street Addresses (Sec 3.1 & 4.1) 

 Census Blocks < 2 sq mi (3.3 & 4.3) 

 Street Segments for Census Blocks > 2 sq mi (3.2 & 4.2) 

 Service Overview (Sec 3.4 & 4.4) 

 Polygonal Boundary Area(s) (Sec 3.8 & 4.8) 

http://www.bakergis.com/kyBroadbandProvider/
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Middle-mile Points (Sec 3.5 & 4.5) 

Community Anchor Institutions (Sec 3.7 & 4.7) 

Last Mile Connection Points (Sec 3.6 & 4.6) 

WISP Antennas (Sec 4.9) 

Data Usability Determination 
The validation results are evaluated by the outreach and aggregation persons to determine the usability of the 

data. If the data meets the submission specifications, it is forwarded on for data aggregation. If it is determined 

to be unusable, it is returned to the Broadband Service Provider for resolution. If the data can be manipulated to 

get it into a usable format, it is manipulated as required, and then forwarded on for data aggregation. 

SBDD Data Development 
Data from the Broadband Service Providers may be submitted in various formats as defined in the Data 

Submittal Guidelines, or in some cases unspecified formats may be accepted to help facilitate provider 

participation. Depending on the format of the submitted data, it is processed through one of the following 

processes to upgrade it to the NTIA SDBB data standards. 

Spatial Data  
After validation and any required manipulation of any spatial data submitted by the Broadband Service 

Providers, it is georeferenced and simply loaded into the appropriate NTIA geodatabase feature class.  

Address Data Geocoding 
If not already in the standard address point template, the provider tabular address data is first loaded into that 

template. The data is then exported to a geodatabase table using the ArcGIS Conversion Tools. ArcGIS geocoding 

tools are then utilized geospatially locate the address points for the tabular records. Interactive address 

rematching is performed against two additional street centerline datasets as needed to increase geocoding 

matching results. The NTIA deliverable is the geocoded address point geodatabase table. The geocoded address 

points are also subsequently aggregated to the census block or road segment feature class for public web map 

display. 

Census Block Aggregation 
If not already in the standard census block template, the provider tabular census block data is first loaded into 

that template. The data is then exported to a geodatabase table using the ArcGIS Conversion Tools. The Provider 

tabular census block records are then joined to the geodatabase 2000 U.S. Census Block. This join is performed 

as many times as necessary for multiple Trans Tech values for each Provider/Census Block combination. The 

NTIA deliverable is the census block geodatabase table.  

If the list of census blocks contains blocks > 2 sq. miles then these blocks are used to select all the 2000 U.S. 

Census TIGER centerlines that intersect those blocks.  The Census Block record data is aggregated to each Road 

Segment within the Census Block.  This process is performed as many times as necessary for multiple Trans Tech 

values for each Provider/Census Block combination. 
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Road Segment Aggregation 
If not already in the standard road segment template, the provider road segment data is first loaded into that 

template. The data is then exported to a geodatabase table using the ArcGIS Conversion Tools. If the provider 

submittal included graphic centerline segments, these are migrated into the delivery geodatabase along with 

the linked attribute records. If the provider submittal was tabular road segment records only, they are then 

joined to the geodatabase 2000 U.S. Census TIGER centerline feature class. This join is performed as many times 

as necessary for multiple Trans Tech values for each Provider/Road Segment combination. The NTIA deliverable 

is the road segment geodatabase table.  

If the provider road segment data lie within census blocks <= 2 sq. miles then the road segment data is 

aggregated to the census block.  This process is performed as many times as necessary for multiple Trans Tech 

values for each Provider/Road Segment combination. The NTIA deliverable is the road segment geodatabase 

table. 

Overview Data Aggregation 
Provider Service Availability Areas submitted for entire county areas are loaded into the NTIA geodatabase 

Overview table. If not already in the standard template, the provider data is first loaded into that template. The 

data is then exported to a geodatabase table using the ArcGIS Conversion Tools. The Provider Overview records 

are then joined to the geodatabase 2000 U.S. Census County feature class. This join is performed as many times 

as necessary for multiple Trans Tech values for each Provider/County Area combination. 

Polygonal Boundary Aggregation/Integration 
Broadband Service Providers submitting polygonal service area data is handled in two ways. Wireline Provider 

data is aggregated to the census block feature class for areas where census blocks <= 2 sq. mi., or road segment 

feature class for areas where census blocks > 2 sq. mi. Wireless Provider Service Availability Areas submitted by 

polygonal area are simply loaded into the NTIA geodatabase Poly_Bndry feature class.  

Wireline Provider 

The polygonal data is georeferenced and loaded into the Poly_Bndry feature class. The polygon is then 

attributed, manually if necessary. Depending on the area, census blocks < or => 2 sq. mi., a selection set of either 

census blocks or road segments that intersect the polygon boundary is created. The attributed polygon 

boundary is then joined with census blocks or road segments table to attribute accordingly. This join is 

performed as many times as necessary for multiple Trans Tech values for each Provider/County Area 

combination.  The NTIA deliverable is the census block or road segment geodatabase table. 

Wireless Provider 

The polygonal data is georeferenced and loaded into the Poly_Bndry feature class. The polygon is then 

attributed, manually if necessary. Multiple Poly_Bndry records are created for multiple Trans Tech values for 

each Provider. The NTIA deliverable is the polygon boundary geodatabase table. 
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Middle/Last Mile Data Integration 
If not already in the standard template, the data is first loaded into that template. The data is then exported to a 

geodatabase table using the ArcGIS Conversion Tools. The point features are geo-located utilizing the lat/long 

information provided.  The NTIA deliverable is the middle or last mile geodatabase table. 

Community Anchor Institution Integration 
Broadband Service Providers provided some Community Anchor Institution (CAI) data with the data submittals. 

But the majority of the data was collected from existing GIS Layers maintained by the COT on their KYGEONET 

public website. Some of the data was collected by outreaching to CAIs through state agencies and their contacts, 

and having CAIs complete an online survey at http://www.bakerbb.com/ky_institution_survey/. 

Provider CAIs 

If not already in the standard template, the data is first loaded into that template. The data is then exported to a 

geodatabase table using the ArcGIS Conversion Tools. The point features are geo-located utilizing the lat/long 

information provided. Address data is used to geocode locations only when Lat/Long data is not provided. 

Commonwealth CAIs 

CAI shapefiles were downloaded from the KYGEONET website. The shapefiles were then exported to the NTIA 

geodatabase CAI feature class. Various sources for obtaining broadband information for the CAIs were utilized. 

Various state agencies provided some of the information, i.e.; Council on Post Secondary Education (CPE) 

provided tabular broadband information for schools and libraries, COT provided tabular broadband information 

for health departments. A CAI data survey website was also deployed and the URL distributed by various state 

agencies to the CAI contacts. Data from all of these sources were then aggregated into the CAI geodatabase 

table for the NTIA deliverable. 

Provider Validation 
After data development, service availability maps are generated and submitted to the providers to validate their 

mapping results.  This provides a “sign off” on the interpretation of the submitted data and extends the 

outreach efforts by providing a visual representation of the data to be delivered to the State and the NTIA. 

Types of Provider Maps 
Provider maps (Figure 2) generally consist of the following types. 

Outreach Maps 

Often time’s providers will send data which does not contain all the information needed for a NTIA compliant 

dataset.  In such cases, as an aid to the outreach communication, it may be necessary to produce a map to help 

the provider locate their service area or verify data they have provided.  These maps may take many forms, but 

generally are of two types: 

 General Location Maps – these maps are often produced when the provider does not have a list of address 

or other standard submittal data and needs help defining their service area.  A typical map will show 

counties, major roads, and towns of the general area the provider has stated as their service area.  The 

intent of the map is to give the provider a way to markup or delineate their service area.  If a provider has 

not provided required attribute information such as Technology of Transmission, Speed Data, etc. then it 

http://www.bakerbb.com/ky_institution_survey/
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may be necessary to add a visual clue to this data like an information stamp on the map that they can easily 

fill out.  If the provider sends the map back with a service area boundary, this can then be digitized and sent 

back to the provider for verification. 

 Verification of Provider Supplied Boundaries – these maps are produced when the provider has sent service 

area boundary information which is confusing or otherwise unclear.  Often these are produced when 

providers send CAD maps, hand drawn maps that need digitization, or lists of zip codes or counties served.  

A typical map will place the interpreted boundary over a location map so the provider can verify the service 

area.  As with the General Location Map, information stamps or other visual clues may be placed on the 

map. 

Initial Verification Maps 

Once the provider data has been processed and the census block and road segment feature classes created, an 

Initial Verification Map is produced to give the provider a visual representation of their service area by census 

block.  These maps enable the provider to verify their service area and make changes if necessary.  Initial 

Verification Maps are produced using a set of standards and produced at the highest resolution necessary to 

convey the map information to the provider.  Initial Verification Maps are also produced for Wireless Polygon 

areas. 

Detailed Verification Maps 

Providers who have questions about their service areas may request additional information to help clarify issues.  

In these cases it may be necessary to create a Detailed Verification Map to highlight the areas in question.  

Detailed Verification Maps provide the same information as Initial Verification Maps only at a higher resolution.  

Several maps may be needed to accurately portray an area in question. 

Revised Maps 

Revised maps take two forms: 

 Initial or Detailed Verification Maps which have been annotated or marked-up by the provider 

 Outreach produced Initial or Detailed Verification Maps incorporating provider changes 
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Figure 2  Provider Map 

Data Validation 
A critical component of the project is the validation of the data submitted by the broadband service providers. 

Data from various sources, as described in more detail in the following sections, is utilized to develop a level of 

confidence in the data received from the broadband providers.  

Validation Data Set Collection and Development 
This validation process employs data sets developed or acquired from different sources as described in the 

following sections.  
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Provider Feedback Loop:  Maps of completed Provider service areas and data are furnished back to the 

Providers for confirmation of the processed/aggregated information. Feedback is integrated into the each 

Provider’s dataset.  

Strategic Networks Group (SNG) Wireline Market Intelligence Data:  Data is extracted from internal and 

commercial databases defining geographic service areas of telephone and cable companies and locations of 

central office (CO) switches and areas upgraded with fiber.  The geographic areas are overlaid with Census 

demographic data on housing unit counts and density. The areas are then modified based on standard business 

practices for conducting service build-out and offering broadband service relative to housing density and other 

variables, such as distance from CO and other infrastructure elements, type of cable franchise (e.g., Census Place 

vs. Unincorporated County)  This represents the first pass conservative estimate of coverage.   

The above methods and data sources are supplemented by other data sources and methodologies, including:  1) 

connectivity data points acquired from InfoUSA that include ISP and type of connection (e.g., DSL, cable modem, 

dial-up, wireless, fiber) providing Internet service to specific geo-coded (i.e., by Latitude and Longitude) 

residential addresses;  2) web-based and telephone research, including address-level service-availability queries 

of web sites operated by service providers and independent entities.  This multi-sourced SNG dataset is used as 

a validation source for provider service area coverage, Technology of Transmission, and Speed. 

American Roamer Wireless Market Intelligence Data:  Commercially available dataset used as an independent 

source to verify information submitted by Providers of wireless broadband service. This dataset is used as a 

validation source for provider service area coverage. 

Strategic Networks Group (SNG) Targeted Online Surveys: Questionnaires (e-mail/web based) have been sent 

directly to businesses and households, including over-sampling in rural area and those where the above 

conservative estimate indicates are “unserved” and “underserved” areas. In addition to collecting broadband 

supply data on type of access, speeds, price, etc. questionnaires gather broadband service demand and usage 

data from businesses, organizations, and households.  Survey responses include geographic coordinates that 

allow mapping and cross-reference to census blocks or street segments. This dataset is used as a validation 

source for provider service area coverage, Technology of Transmission, and Speed. 

Online Public Survey and Speed Test: A Broadband Mapping Public Survey Site is deployed. Site visitors are 

requested to provide data on broadband availability, technology, service type (e.g., speed tier) service provider 

name; monthly prices paid and measured downstream and upstream speeds. In addition to State promotion via 

press releases to the general public, the State Council on Post Secondary Education (CPE) also promoting 

participation on this survey to the faculty and student population. This dataset is used as a validation source for 

provider service area coverage, Technology of Transmission, and Speed. 

Prior Broadband Mapping: Statewide coverage areas for Cable, DSL, and Fixed Wireless providers that were 

aggregated as part of a previous broadband mapping effort for the Commonwealth of Kentucky are used to 

validate against Provider submitted data.  In addition to the service areas, the DSL and Fixed Wireless layers 

contain general speed information that can be compared against Provider submitted data. 

FCC Speed Test: The FCC speed test data includes the IP addresses for each specific speed test conducted. This IP 

address is queried against a web search engine to determine the Provider assigned to that address and is used 

as a validation source for provider service coverage and typical speeds. 
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Field Data Acquisition: Broadband technicians visited a sampling of census block locations to gather broadband 

data to be used for validation. The following criteria were taken into account when developing the census block 

sampling dataset: 

 urban vs. rural census block characteristic 

 censes block grouping 

 land vs. water census block characteristic 

The overarching mission of the Federal broadband stimulus program is to expand Broadband service to areas 

that are currently unserved and underserved. Also, the market intelligence validation sources typically represent 

some rural, but more urban areas. Thus, our field data collection efforts were targeted more towards the rural 

areas; split 90% rural, 10% urban.   

Additionally, a study by Penn State University (Glasmeier 2002) notes that a large number of census block 

groups typically fit within any given cable or telephone company service areas. Therefore, our field sample was 

also based on selection of one census block per block group. The selected census block also had greater than 

50% land area, versus water.  There are a total of 3, 158 census block groups statewide. Using a statistical 

sample size calculator based upon the number of block groups in the state and +/- 4% margin of error at a 95% 

confidence level, the sample size is 529 census block locations (Figure 3).   

For the 529 census blocks that were visited, 2455 individual wired/wireless data elements were recorded and 

3024 pictures were taken at those locations. This field collected dataset is used as a validation source primarily 

for wireline and wireless technology of transmission and middle mile, and for wireless speed. 

 

Figure 3  Field Verification Sampling Locations 
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For each census block in the sample set, broadband technicians collected data using Panasonic Toughbook 

computers, loaded with MapPoint mapping software, and a customized Microsoft Access data collection form 

with the ability to automatically import GPS coordinates. The sample census blocks were pre-loaded and directly 

accessible from MapPoint.  Two types of data collection were conducted; infrastructure observation and 

wireless speed testing; and the results were recorded and linked to the corresponding field location coordinates 

within the designated sample census block.  The information collected by the field broadband technicians 

includes: 

Wireline: 

 GPS coordinates 

 circuit infrastructure feeding the area (copper, fiber, cable) 

 collect site pictures 

Wireless: 

 GPS coordinates 

 internet speed test 

This field collected dataset is used as a validation source primarily for wireline and wireless technology of 

transmission and middle mile, and for wireless speed. 

Independent 3rd Party Validation:  Murray State University coordinated the efforts of resources at the University 

of Louisville and the Kentucky Community and Technical College System (validation team) to validate the 

collection methods and collected data associated with the collection of broadband availability data. This 

validation data developed from this effort was subsequently integrated into the Statistical Evaluation and 

Assessment System (SEAS) to verify the data submitted by the broadband providers. 

The validation team review included: 

a. Validating the list of providers being used by the mapping vendor to make sure all providers are included. 

b. Validating the list of state-provided and Census Tiger Data to identify the location of health facilities, 

schools, libraries, hospitals, universities, public buildings, etc. 

c. Reviewing provider outreach methodology being used by the mapping vendor. 

d. Reviewing submission options, the Non-Disclosure Agreement and the timeframe for submission. 

e. Identifying Business Intelligence data sources to validate provider information.  

f. Reviewing mapping vendor’s website used to collect comment/survey forms from visitors to validate the 

broadband coverage in their area.   

g. Observing the data collection and data entry process and the ongoing steps in the development of the final 

products.   

Once data was collected, the validation team provided a review that included: 

a. Cross checking of data for accuracy  

b. Statistically representative and significant samples to validate data, especially in rural and potentially 

underserved. 
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Limited field census and telephone surveys were also used to validate data in situations where the data cross 
checks and statistical samples are not able to validate data provided by the mapping vendor. Faculty and 
students from campuses of the Kentucky Community and Technical and College System (KCTCS) conducted the 
field census work to validate local adoption rates.  KCTCS has 16 colleges and over 60 campuses to provide state-
wide coverage for field census work.   

The work performed, and being performed by the validation team can be summarized in four areas: (1) Audit, 
(2) Selective Surveys, (3) Reconcile Survey and Provider Data, and (4) Field Test to Resolve Discrepancies. 

Audit – At the beginning of the project it was decided that the best way to obtain quality data was to make sure 
that the initial data collection was of the highest quality that it could be.  The validation team concentration its 
initial efforts in working with the mapping vendor to get the best quality data and also the largest quantity of 
data that could be obtained.  Mapping vendor processes were reviewed and suggested improvements provided.  
Web sites and documents that were to be used for data collection were evaluated and improvements 
suggested.  Provider lists were reviewed and additional vendors or potential vendors were identified by the 
validation team.  Once data collection began, the validation team also worked with the mapping team to 
increase the amount of data collected.  KCTCS provided web survey sites to students and faculty across the state 
to increase participation.  Once the data was collected the validation team worked to identify data anomalies 
and locations where additional data collection was required. 

Selective Surveys – The data audits identified locations where there was insufficient data to make valid 
conclusions about broadband availability.  The validation team used a call center to place selective surveys in the 
targeted areas within the state.  In many cases the insufficient data was the result of the failure of vendors to 
provide data to the mapping vendor.  The selective surveys provide validation of the availability of broadband or 
the absence of broadband within a specific area.  This information allows the mapping vendor to concentrate 
their efforts to obtain the required data from the appropriate vendor. The call center efforts reached almost 
10,000 new households that had not been sampled by other methods.  The data indicated that 68.8% had 
computers, 64.7% has access to the Internet, and 56.7% has broadband access.  The new data points were 
located in rural areas of the state and were focused on areas that had been underrepresented in prior data 
collection efforts. 

Reconcile Survey and Provider Data – The mapping vendor survey data (from web surveys), the provider data, 
and the selective surveys done by the validation team provide an additional reconciliation of the data.  While the 
importance of knowing where broadband is available is critical, it is just as important to know where broadband 
is not available.  The comparison of the various data sources allow for a high confidence in identifying where 
broadband is available.  Additionally, the data reported on the web surveys and the phone surveys identify 
pockets of citizens of the Commonwealth that don’t have access to broadband. The validation team used the 
data reported by the providers, the data collected by the mapping vendor, and the validation survey data to 
identify areas of interest for the field data collection efforts.  The focus of the field data collection efforts are 
areas with no reported service, areas where individuals report no availability, and areas where only mobile 
wireless has been reported as being available for broadband service. 

Field Test to Resolve Discrepancies – The reported territory covered by wired broadband infrastructure is 

reliable.  However, the reported territory covered by wireless broadband infrastructure (especially mobile 

wireless) is less reliable.  Many factors can impact the availability of the wireless signal.  We simply have to think 

about our cell phone usage and the frequency of dropped calls or no service availability.  It is relatively easy for a 

vendor to say they provide service to an entire geographic area.  The validation team developed software to 

check on the level of mobile wireless availability and to make sure it is at broadband speeds.  The validation 

team drove mobile devices around the state collecting signal strength and doing periodic speed test to validate 
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the availability of broadband.  The initial focus was on areas reported to have no service and areas that only 

have mobile broadband reported. Test data was collected to validate the data collection process and identify 

required equipment.   

Provider Data Validation Process 
Provider Feedback Loop:  Feedback received from the providers is visually inspected and integrated directly into 

the mapping GIS database. 

Service Area Validation Data: The SNG wireline service area data is tabular and contains a separate record for 

each provider/technology of transmission combination with an associated census block or TIGER road segment, 

depending on the whether the size of the census block area (=/< or > 2 sq. mi.). This data is exported into an 

ArcGIS data format. The American Roamer and Prior Mapping service area data is already in and ArcGIS data 

format.  The validation data is then joined to the Provider service area data by census block or TIGER road 

segment ID. Any database records in the Provider or Validation tables that cannot be joined are output to a 

separate layer that indicates the areas of discrepancy between the two datasets. The joined tables are then 

queried to detect any speed discrepancies which are also output to a separate discrepancy layer. 

Online Surveys, Field and Independent 3rd Party Validation Data: The Public and Targeted Business/Household 

survey, field and independent 3rd party validation data are also collected in tabular database format, and 

represent a specific lat/long spatial location for each record.  This data is exported into ArcGIS data format, 

joined to the provider data, queried to validate pertinent attribution. Again, records not joined and or with 

detected attribution discrepancies are output to separate GIS layers. 

Topology: The ArcGIS Validate Topology Tool is used to flag any topology issues in the broadband data. Flagged 

issues are reviewed to identify false positives and update true errors as required.  

SBDD Check Submission: The NTIA-provided SBDD Check Submission tool is utilized to validate that the 

deliverable broadband data is consistent with the business logic rules set forth by the NTIA and a passing receipt 

is provided with the data submittal to NTIA. 

Stakeholder Feedback:  The state broadband mapping website includes a feedback function. Comments received 

from stakeholders are reviewed and used to validate provider data submissions. 

 Validation and Confidence Level Reporting 

To facilitate validation and confidence level reporting, Baker deployed a validation application called Statistical 

Evaluation and Assessment System (SEAS) which automatically compares the multiple independent validation 

datasets against the broadband service provider supplied information.  The SEAS uses statistical methodologies 

to report the confidence level in the spatial and attribute accuracy of the information.  Appendix B shows the 

validation workflow. 

The SEAS comparison is a three-part validation process: 

1. Comparison of the collected validation source against the aggregated broadband provider data. 

2. Match percentage calculation for each provider reported in the DataPackage.xls, “Provider Table” tab, 

“Comments” column. 

3.  Confidence score calculation displayed on the state broadband website.  
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Figure 4  Statistical Evaluation and Assessment System (SEAS) 

After completing all validation data source collections, SEAS is used to automatically compare the multiple 

validation datasets against the aggregated broadband data which came from the providers. Through the SEAS 

accumulation table, it produces a match percentage per broadband service record based upon the number of 

matches that record has against each validation source. The matched percentage for each record is the result of 

the total count of the matched validations for the record divided by the total validation source being compared 

against the record.  A validation confidence rating/score is then assigned on a scale of 1 to 5 based upon the 

percentage of validation source matches as per the following score results: 

 1 Star   = 0% - 19% Match 

 2 Stars = 20% - 39% Match 

 3 Stars = 40% - 59% Match 

 4 Stars = 60% = 79% Match 

 5 Stars = 80% - 100% Match 

 “No Analytics” = No validation source available for that provider 
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The Commonwealth’s public broadband mapping website (www.bakerbb.com/kybroadbandmapping/) is 

updated with the confidence level results at the record level based upon the queried geographic location and 

the following is an example of this representation. 

 
Provider Name Transmission 

Technology 

Max Download 

Speed 

Max Upload Speed  Confidence Score 

AT&T Mobility Mobile Wireless Greater than or e… Greater than or e… 

 
Verizon Asymmetric xDSL Greater than or e… Greater than or e… NO ANALYTICS 

Comcast Cable Modem – 

Other 

Greater than or e… Greater than or e… 

 

  

The matched percentage for the records for each provider are summarized and then divided by the total count 

of the records to create the final matched percentage for the specific provider. These percentages are included 

in DataPackage.xls on the Provider Table tab in the Comments column. 

Future Validation 
Audit of Wireless Broadband Availability Reporting:  Wireless coverage will be evaluated using a contour 

calculation tool, with key inputs being transmitter location and, where available, data on spectrum power levels 

and other relevant transmission factors provided by carriers and/or supplemented by data available from public 

web sites and other sources.  Data will then be input to a contour calculation tool to provide estimates of fixed 

wireless broadband coverage areas. This dataset is used as a source to determine gaps in provider wireless 

service area coverage.  The Prior Mapping data is also used as a validation source for gap analysis. 

 

 

 

http://www.bakerbb.com/kybroadbandmapping/
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Introduction 
The following sections of this document provide an overview of the process used for the SBDD Broadband 
Mapping data development for the State of Louisiana. The following narrative is depicted in Appendix A, State of 
Louisiana SBDD Process Workflow, and Appendix B, State Broadband Data Validation Workflow, included at the 
end of this document. 

Broadband Provider Outreach 
The following outreach provides the framework for communicating with Broadband Service Providers 
(Providers). The primary goals of the outreach approach documented herein are to:  

• Promote Provider understanding and acceptance of the Broadband Mapping process, results and benefits 

• Clarify NTIA Broadband Mapping requirements 

• Facilitate data confidentiality agreements as required 

• Minimize the submittal of invalid data 

• Enhance provider  understanding of the semi-annual update process   

• Work with Providers to evaluate submittal options to facilitate data submittals  

Data Submission Guidelines 
Guidelines for the Providers submission of of Broadband Mapping Data are documented in the “Data Submission 
Guidelines”. These Guidelines 

Louisiana Broadband Providers Website 

define technical requirements, submission, specifications, and coordination and 
documentation activities. 

A URL was deployed (http://broadband.louisiana.gov/providers.asp) to communicate and distribute NTIA NOFA 
requirements to providers along with outreach and data submittal materials including: 

• NTIA NOFA and subsequent clarification 

• Outreach letters to providers 

• Non-Disclosure Agreement 

• Quick Start Guides 

• Data Submission Guidelines 

• Data Transmittal Letter 

• Broadband Data Submittal Templates 

• TIGER Data 

• Data Submittal Assistance Contact Information 

Outreach Delivery Vehicles 
• A State Broadband Mapping Initiative Call for Data letter from the State Office of Information Technology 

(OIT) was emailed to all Broadband Service Providers in the State. This initial provider contact letter 
described the program and the role of Michael baker Jr., Inc. (Baker) acting on behalf of the OIT for 
Broadband Data Collection and Mapping. 
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• Baker distributed a follow-up letter to all Providers describing the data submittal requirements and material 
and help available to aid with the data submittals. 

• Submittal assistance was provided to providers that needed help with data submittals. 

• Presentations were conducted with various broadband provider associations to present the data submittal 
requirements and answer questions. 

• Email communication and electronic transfer of data was encouraged to facilitate a faster delivery of data 
and information. 

• A URL was deployed and promoted to distribute outreach material and information concerning the 
Broadband Mapping Project. 

• A secure FTP URL was provided for submittal of broadband data by providers. 

Broadband Outreach Tracker Application 
The Tracker application (Figure 1) was utilized to collect all correspondence with Providers and feedback on the 
effectiveness of the outreach activities by tracking items such as:  

• The number and content of incoming e-mails and letters submitted from the Providers 

• The number and source of comments, questions, and suggestions made by Providers 

• The number and source of comments, questions, and suggestions made by attendees at Provider meetings 
and conference calls 

• Provider contact information and data submittal status. 
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Figure 1 Broadband Outreach Tracker 

Provider Submittal Validation 
When a data submittal is received from a broadband service provider it is updated in the Broadband Outreach 
Tracker and run through an initial validation process to assure that it meets the submittal guidelines.  

Validation Checklist 
The following items are part of this initial data validation process: 

• Verify the provider Transmittal Letter is complete and matches submitted data 

• Verify the file naming conventions 

• Verify each file is machine readable 

• Verify data is in the correct GIS or Tabular format/file type 

• Verify there are no duplicate records 

• Verify each field is populated and no empty or NULL values are present for mandatory fields 

• Verify all ID (record number points) are unique within the submittal 

• Verify all attribute data is formatted according to the submittal guidelines 

• Verify topology for all geospatial submissions 

• Verify Metadata for all submissions 

• Verify the required contact information is included 

• Verify adherence to Data Submittal Guidelines (see http://broadband.louisiana.gov/providers.asp to 
access Data Submittal Guidelines) 
Broadband Service Availability (at least one) 
- Individual Street Addresses (Sec 3.1 & 4.1) 
- Census Blocks < 2 sq mi (3.3 & 4.3) 
- Street Segments for Census Blocks > 2 sq mi (3.2 & 4.2) 
- Service Overview (Sec 3.4 & 4.4) 
- Polygonal Boundary Area(s) (Sec 3.8 & 4.8) 

http://broadband.louisiana.gov/providers.asp�
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Middle-mile Points (Sec 3.5 & 4.5) 
Community Anchor Institutions (Sec 3.7 & 4.7) 
Last Mile Connection Points (Sec 3.6 & 4.6) 
WISP Antennas (Sec 4.9) 

Data Usability Determination 
The validation results are evaluated by the outreach and aggregation persons to determine the usability of the 
data. If the data meets the submission specifications, it is forwarded on for data aggregation. If it is determined 
to be unusable, it is returned to the Broadband Service Provider for resolution. If the data can be manipulated to 
get it into a usable format, it is manipulated as required, and then forwarded on for data aggregation. 

SBDD Data Development 
Data from the Broadband Service Providers may be submitted in various formats as defined in the Data 
Submittal Guidelines, or in some cases unspecified formats may be accepted to help facilitate provider 
participation. Depending on the format of the submitted data, it is processed through one of the following 
processes to upgrade it to the NTIA SDBB data standards. 

Spatial Data  
After validation and any required manipulation of any spatial data submitted by the Broadband Service 
Providers, it is georeferenced and simply loaded into the appropriate NTIA geodatabase feature class.  

Address Data Geocoding 
If not already in the standard address point template, the provider tabular address data is first loaded into that 
template. The data is then exported to a geodatabase table using the ArcGIS Conversion Tools. ArcGIS geocoding 
tools are then utilized geospatially locate the address points for the tabular records. Interactive address 
rematching is performed against two additional street centerline datasets as needed to increase geocoding 
matching results. The NTIA deliverable is the geocoded address point geodatabase table. The geocoded address 
points are also subsequently aggregated to the census block or road segment feature class for public web map 
display. 

Census Block Aggregation 
If not already in the standard census block template, the provider tabular census block data is first loaded into 
that template. The data is then exported to a geodatabase table using the ArcGIS Conversion Tools. The Provider 
tabular census block records are then joined to the geodatabase 2000 U.S. Census Block. This join is performed 
as many times as necessary for multiple Trans Tech values for each Provider/Census Block combination. The 
NTIA deliverable is the census block geodatabase table.  

If the list of census blocks contains blocks > 2 sq. miles then these blocks are used to select all the 2000 U.S. 
Census TIGER centerlines that intersect those blocks.  The Census Block record data is aggregated to each Road 
Segment within the Census Block.  This process is performed as many times as necessary for multiple Trans Tech 
values for each Provider/Census Block combination. 
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Road Segment Aggregation 
If not already in the standard road segment template, the provider road segment data is first loaded into that 
template. The data is then exported to a geodatabase table using the ArcGIS Conversion Tools. If the provider 
submittal included graphic centerline segments, these are migrated into the delivery geodatabase along with 
the linked attribute records. If the provider submittal was tabular road segment records only, they are then 
joined to the geodatabase 2000 U.S. Census TIGER centerline feature class. This join is performed as many times 
as necessary for multiple Trans Tech values for each Provider/Road Segment combination. The NTIA deliverable 
is the road segment geodatabase table.  

If the provider road segment data lie within census blocks <= 2 sq. miles then the road segment data is 
aggregated to the census block.  This process is performed as many times as necessary for multiple Trans Tech 
values for each Provider/Road Segment combination. The NTIA deliverable is the road segment geodatabase 
table. 

Overview Data Aggregation 
Provider Service Availability Areas submitted for entire county areas are loaded into the NTIA geodatabase 
Overview table. If not already in the standard template, the provider data is first loaded into that template. The 
data is then exported to a geodatabase table using the ArcGIS Conversion Tools. The Provider Overview records 
are then joined to the geodatabase 2000 U.S. Census County feature class. This join is performed as many times 
as necessary for multiple Trans Tech values for each Provider/County Area combination. 

Polygonal Boundary Aggregation/Integration 
Broadband Service Providers submitting polygonal service area data is handled in two ways. Wireline Provider 
data is aggregated to the census block feature class for areas where census blocks <= 2 sq. mi., or road segment 
feature class for areas where census blocks > 2 sq. mi. Wireless Provider Service Availability Areas submitted by 
polygonal area are simply loaded into the NTIA geodatabase Poly_Bndry feature class.  

Wireline Provider 
The polygonal data is georeferenced and loaded into the Poly_Bndry feature class. The polygon is then 
attributed, manually if necessary. Depending on the area, census blocks < or => 2 sq. mi., a selection set of either 
census blocks or road segments that intersect the polygon boundary is created. The attributed polygon 
boundary is then joined with census blocks or road segments table to attribute accordingly. This join is 
performed as many times as necessary for multiple Trans Tech values for each Provider/County Area 
combination.  The NTIA deliverable is the census block or road segment geodatabase table. 

Wireless Provider 
The polygonal data is georeferenced and loaded into the Poly_Bndry feature class. The polygon is then 
attributed, manually if necessary. Multiple Poly_Bndry records are created for multiple Trans Tech values for 
each Provider. The NTIA deliverable is the polygon boundary geodatabase table. 
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Middle/Last Mile Data Integration 
If not already in the standard template, the data is first loaded into that template. The data is then exported to a 
geodatabase table using the ArcGIS Conversion Tools. The point features are geo-located utilizing the lat/long 
information provided.  The NTIA deliverable is the middle or last mile geodatabase table. 

Community Anchor Institution Integration 
Broadband Service Providers provided some Community Anchor Institution (CAI) data with the data submittals. 
But the majority of the data was collected from existing GIS Layers from previous studies and commercial data 
packages. 

Provider CAIs 
If not already in the standard template, the data is first loaded into that template. The data is then exported to a 
geodatabase table using the ArcGIS Conversion Tools. The point features are geo-located utilizing the lat/long 
information provided. Address data is used to geocode locations only when Lat/Long data is not provided. 

State CAIs 
CAI shapefiles were downloaded from the commercial data packages. The shapefiles were then exported to the 
NTIA geodatabase CAI feature class. Various sources for obtaining broadband information for the CAIs were 
utilized including previous broadband studies.  

Provider Validation 
After data development, service availability maps are generated and submitted to the providers to validate their 
mapping results.  This provides a “sign off” on the interpretation of the submitted data and extends the 
outreach efforts by providing a visual representation of the data to be delivered to the State and the NTIA. 

Types of Provider Maps 
Provider maps (Figure 2) generally consist of the following types. 

Outreach Maps 
Often time’s providers will send data which does not contain all the information needed for a NTIA compliant 
dataset.  In such cases, as an aid to the outreach communication, it may be necessary to produce a map to help 
the provider locate their service area or verify data they have provided.  These maps may take many forms, but 
generally are of two types: 

• General Location Maps – these maps are often produced when the provider does not have a list of address 
or other standard submittal data and needs help defining their service area.  A typical map will show 
counties, major roads, and towns of the general area the provider has stated as their service area.  The 
intent of the map is to give the provider a way to markup or delineate their service area.  If a provider has 
not provided required attribute information such as Technology of Transmission, Speed Data, etc. then it 
may be necessary to add a visual clue to this data like an information stamp on the map that they can easily 
fill out.  If the provider sends the map back with a service area boundary, this can then be digitized and sent 
back to the provider for verification. 

• Verification of Provider Supplied Boundaries – these maps are produced when the provider has sent service 
area boundary information which is confusing or otherwise unclear.  Often these are produced when 
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providers send CAD maps, hand drawn maps that need digitization, or lists of zip codes or counties served.  
A typical map will place the interpreted boundary over a location map so the provider can verify the service 
area.  As with the General Location Map, information stamps or other visual clues may be placed on the 
map. 

Initial Verification Maps 

Once the provider data has been processed and the census block and road segment feature classes created, an 
Initial Verification Map is produced to give the provider a visual representation of their service area by census 
block.  These maps enable the provider to verify their service area and make changes if necessary.  Initial 
Verification Maps are produced using a set of standards and produced at the highest resolution necessary to 
convey the map information to the provider.  Initial Verification Maps are also produced for Wireless Polygon 
areas. 

Detailed Verification Maps 

Providers who have questions about their service areas may request additional information to help clarify issues.  
In these cases it may be necessary to create a Detailed Verification Map to highlight the areas in question.  
Detailed Verification Maps provide the same information as Initial Verification Maps only at a higher resolution.  
Several maps may be needed to accurately portray an area in question. 

Revised Maps 

Revised maps take two forms: 

• Initial or Detailed Verification Maps which have been annotated or marked-up by the provider 

• Outreach produced Initial or Detailed Verification Maps incorporating provider changes 
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Figure 2  Provider Map 

Data Validation 
A critical component of the project is the validation of the data submitted by the broadband service providers. 
Data from various sources, as described in more detail in the following sections, is utilized to develop a level of 
confidence in the data received from the broadband providers.  

Validation Data Set Collection and Development 
This validation process employs data sets developed or acquired from different sources as described in the 
following sections.  
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Provider Feedback Loop:  Maps of completed Provider service areas and data are furnished back to the 
Providers for confirmation of the processed/aggregated information. Feedback is integrated into the each 
Provider’s dataset.  

Strategic Networks Group (SNG) Wireline Market Intelligence Data

The above methods and data sources are supplemented by other data sources and methodologies, including:  1) 
connectivity data points acquired from InfoUSA that include ISP and type of connection (e.g., DSL, cable modem, 
dial-up, wireless, fiber) providing Internet service to specific geo-coded (i.e., by Latitude and Longitude) 
residential addresses;  2) web-based and telephone research, including address-level service-availability queries 
of web sites operated by service providers and independent entities.  This multi-sourced SNG dataset is used as 
a validation source for provider service area coverage, Technology of Transmission, and Speed. 

:  Data is extracted from internal and 
commercial databases defining geographic service areas of telephone and cable companies and locations of 
central office (CO) switches and areas upgraded with fiber.  The geographic areas are overlaid with Census 
demographic data on housing unit counts and density. The areas are then modified based on standard business 
practices for conducting service build-out and offering broadband service relative to housing density and other 
variables, such as distance from CO and other infrastructure elements, type of cable franchise (e.g., Census Place 
vs. Unincorporated County)  This represents the first pass conservative estimate of coverage.   

American Roamer Wireless Market Intelligence Data:  Commercially available dataset used as an independent 
source to verify information submitted by Providers of wireless broadband service. This dataset is used as a 
validation source for provider service area coverage. 

Strategic Networks Group (SNG) Targeted Online Surveys: Questionnaires (e-mail/web based) have been sent 
directly to businesses and households, including over-sampling in rural area and those where the above 
conservative estimate indicates are “unserved” and “underserved” areas. In addition to collecting broadband 
supply data on type of access, speeds, price, etc. questionnaires gather broadband service demand and usage 
data from businesses, organizations, and households.  Survey responses include geographic coordinates that 
allow mapping and cross-reference to census blocks or street segments. This dataset is used as a validation 
source for provider service area coverage, Technology of Transmission, and Speed. 

Online Public Survey and Speed Test: A Broadband Mapping Public Survey Site is deployed. Site visitors are 
requested to provide data on broadband availability, technology, service type (e.g., speed tier) service provider 
name; monthly prices paid and measured downstream and upstream speeds.  

Prior Broadband Mapping: Statewide coverage areas for Cable, DSL, and Fixed Wireless providers that were 
aggregated as part of a previous broadband mapping effort for the State of Louisiana are used to validate 
against Provider submitted data.  In addition to the service areas, the DSL and Fixed Wireless layers contain 
general speed information that can be compared against Provider submitted data. 

FCC Speed Test: The FCC speed test data includes the IP addresses for each specific speed test conducted. This IP 
address is queried against a web search engine to determine the Provider assigned to that address and is used 
as a validation source for provider service coverage and typical speeds. 
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Field Data Acquisition

• urban vs. rural census block characteristic 

: Broadband technicians visited a sampling of census block locations to gather broadband 
data to be used for validation. The following criteria were taken into account when developing the census block 
sampling dataset: 

• censes block grouping 
• land vs. water census block characteristic 

The overarching mission of the Federal broadband stimulus program is to expand Broadband service to areas 
that are currently unserved and underserved. Also, the market intelligence validation sources typically represent 
some rural, but more urban areas. Thus, our field data collection efforts were targeted more towards the rural 
areas; split 90% rural, 10% urban.   

Additionally, a study by Penn State University (Glasmeier 2002) notes that a large number of census block 
groups typically fit within any given cable or telephone company service areas. Therefore, our field sample was 
also based on selection of one census block per block group. The selected census block also had greater than 
50% land area, versus water.  There are a total of 3, 512 census block groups statewide. Using a statistical 
sample size calculator based upon the number of block groups in the state and +/- 4% margin of error at a 95% 
confidence level, the sample size is 557 census block locations (Figure 3).   

For the 557 census blocks that were visited, 3257 individual wired/wireless data elements were recorded and 
3410 pictures were taken at those locations. This field collected dataset is used as a validation source primarily 
for wireline and wireless technology of transmission and middle mile, and for wireless speed. 

 

Figure 3  Field Verification Sampling Locations 
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For each census block in the sample set, broadband technicians collected data using Panasonic Toughbook 
computers, loaded with MapPoint mapping software, and a customized Microsoft Access data collection form 
with the ability to automatically import GPS coordinates. The sample census blocks were pre-loaded and directly 
accessible from MapPoint.  Two types of data collection were conducted; infrastructure observation and 
wireless speed testing; and the results were recorded and linked to the corresponding field location coordinates 
within the designated sample census block.  The information collected by the field broadband technicians 
includes: 

Wireline: 

• GPS coordinates 

• circuit infrastructure feeding the area (copper, fiber, cable) 

• collect site pictures 

Wireless: 

• GPS coordinates 

• internet speed test 

This field collected dataset is used as a validation source primarily for wireline and wireless technology of 
transmission and middle mile, and for wireless speed. 

Provider Data Validation Process 
Provider Feedback Loop:  Feedback received from the providers is visually inspected and integrated directly into 
the mapping GIS database. 

Service Area Validation Data: The SNG wireline service area data is tabular and contains a separate record for 
each provider/technology of transmission combination with an associated census block or TIGER road segment, 
depending on the whether the size of the census block area (=/< or > 2 sq. mi.). This data is exported into an 
ArcGIS data format. The American Roamer and Prior Mapping service area data is already in and ArcGIS data 
format.  The validation data is then joined to the Provider service area data by census block or TIGER road 
segment ID. Any database records in the Provider or Validation tables that cannot be joined are output to a 
separate layer that indicates the areas of discrepancy between the two datasets. The joined tables are then 
queried to detect any speed discrepancies which are also output to a separate discrepancy layer. 

Online Surveys and Field Validation Data: The Public and Targeted Business/Household survey and field  
validation data are also collected in tabular database format, and represent a specific lat/long spatial location 
for each record.  This data is exported into ArcGIS data format, joined to the provider data, queried to validate 
pertinent attribution. Again, records not joined and or with detected attribution discrepancies are output to 
separate GIS layers. 

Topology: The ArcGIS Validate Topology Tool is used to flag any topology issues in the broadband data. Flagged 
issues are reviewed to identify false positives and update true errors as required.  
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SBDD Check Submission: The NTIA-provided SBDD Check Submission tool is utilized to validate that the 
deliverable broadband data is consistent with the business logic rules set forth by the NTIA and a passing receipt 
is provided with the data submittal to NTIA. 

Stakeholder Feedback

 Validation and Confidence Level Reporting 

:  The state broadband mapping website includes a feedback function. Comments received 
from stakeholders are reviewed and used to validate provider data submissions. 

To facilitate validation and confidence level reporting, Baker deployed a validation application called Statistical 
Evaluation and Assessment System (SEAS) which automatically compares the multiple independent validation 
datasets against the broadband service provider supplied information.  The SEAS uses statistical methodologies 
to report the confidence level in the spatial and attribute accuracy of the information.  Appendix B shows the 
validation workflow. 

The SEAS comparison is a three-part validation process: 
1. Comparison of the collected validation source against the aggregated broadband provider data. 
2. Match percentage calculation for each provider reported in the DataPackage.xls, “Provider Table” tab, 

“Comments” column. 
3.  Confidence score calculation displayed on the state broadband website.  
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Figure 4  Statistical Evaluation and Assessment System (SEAS) 

After completing all validation data source collections, SEAS is used to automatically compare the multiple 
validation datasets against the aggregated broadband data which came from the providers. Through the SEAS 
accumulation table, it produces a match percentage per broadband service record based upon the number of 
matches that record has against each validation source. The matched percentage for each record is the result of 
the total count of the matched validations for the record divided by the total validation source being compared 
against the record.  A validation confidence rating/score is then assigned on a scale of 1 to 5 based upon the 
percentage of validation source matches as per the following score results: 

• 1 Star   = 0% - 19% Match 

• 2 Stars = 20% - 39% Match 

• 3 Stars = 40% - 59% Match 

• 4 Stars = 60% = 79% Match 

• 5 Stars = 80% - 100% Match 

• “No Analytics” = No validation source available for that provider 

 

 

 

The State’s public broadband mapping website (http://broadband.louisiana.gov/providers.asp) is updated with 
the confidence level results at the record level based upon the queried geographic location and the following is 
an example of this representation. 

 
Provider Name Transmission 

Technology 
Max Download 
Speed 

Max Upload Speed  Confidence Score 

AT&T Mobility Mobile Wireless Greater than or e… Greater than or e… 
 

Verizon Asymmetric xDSL Greater than or e… Greater than or e… NO ANALYTICS 
Comcast Cable Modem – 

Other 
Greater than or e… Greater than or e… 

 

  
The matched percentage for the records for each provider are summarized and then divided by the total count 
of the records to create the final matched percentage for the specific provider. These percentages are included 
in DataPackage.xls on the Provider Table tab in the Comments column. 

Future Validation 
Audit of Wireless Broadband Availability Reporting:  Wireless coverage will be evaluated using a contour 
calculation tool, with key inputs being transmitter location and, where available, data on spectrum power levels 
and other relevant transmission factors provided by carriers and/or supplemented by data available from public 
web sites and other sources.  Data will then be input to a contour calculation tool to provide estimates of fixed 
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wireless broadband coverage areas. This dataset is used as a source to determine gaps in provider wireless 
service area coverage.  The Prior Mapping data is also used as a validation source for gap analysis. 
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Methodologies Used to Create and Validate Broadband Datasets  
For the April 1, 2011 SBDD Submission 

 
 
EXECUTIVE SUMMARY 
 
Broadband data for Massachusetts was collected, integrated and verified by the Massachusetts 
Broadband Institute (MBI), a division of the Massachusetts Technology Collaborative (MTC). 
This data was prepared for the National Telecommunications and Information Administration 
(NTIA) as part of the State Broadband Data and Development (SBDD) grant program and will 
be displayed the National Broadband Map. This data will continue to be verified and updated to 
improve the quality and accuracy of the information to support MBI activities including adoption 
studies and last mile deployment planning. 
 
About the MBI 
The MBI is the central broadband entity for the Commonwealth of Massachusetts, created on 
August 4, 2008 when Governor Deval Patrick signed Chapter 231 of the Acts of 2008, An Act 
Establishing and Funding the Massachusetts Broadband Institute (the “Broadband Act”). The 
mission of the MBI is to extend affordable, robust high-speed Internet access to all homes, 
businesses, schools, libraries, medical facilities, government offices and other public places 
across our state.   
 
The Broadband Act gives the MBI the authority to invest up to $40 million of state bond funds 
into broadband infrastructure. This bonding authority is structured as an “incentive fund” 
intended to stimulate private industry investments that will complement the MBI’s public 
investments. The MBI is investing its funds in long-lived infrastructure assets, such as conduit, 
fiber-optic cable, and wireless towers, which will lower the cost of entry for broadband providers 
and make it economically feasible for such firms to provide broadband access service to 
currently unserved residential, business and institutional customers. For more information about 
the MBI and its programs and activities, visit the web site at www.massbroadband.org. 
 
Data Summary 
Data was acquired from 30 providers of residential and business broadband services in 
Massachusetts. Data transmission technologies in the datasets include asymmetric and symmetric 
DSL, other copper wireline, DOCSIS 3.0 and other cable, fiber optic, unlicensed fixed wireless, 
3G and 4G mobile wireless and satellite technologies. This information was integrated and 
submitted to the NTIA in the following four datasets.   
 
Dataset # Providers # Records 
BB_Service_CensusBlock 17 269,170 
BB_Service_RoadSegment 10 10,917 
BB_Service_Wireless 12 20 
BB_ConnectionPoint_MiddleMile 15 546 

 

http://www.massbroadband.org/�
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Information on broadband services at community anchor institutions (CAIs) were collected by 
phone, email and web surveys. Approximately 25% of the CAIs participated in the survey, of 
which 63% subscribe to broadband services. 
 
Dataset # Institutions # Records 
BB_Service_CAInstitution 4,291 4,382 

 
 
DATA DEVELOPMENT – GENERAL 
 
Data development was performed using ESRI ArcGIS 9.3 software.     
 
Data Integration 
Data were received from broadband service providers in varying formats and levels of detail.  No 
two datasets were alike, which required a significant amount of manual review and editing to 
integrate the information into a common format.  Although Excel and Shapefile templates were 
provided, very few datasets were received in the template formats and attributes were not always 
provided using the standardized coded values requested.  In addition, attribute field names were 
inconsistent between datasets, contained spaces and special characters or were missing 
altogether.  These differences prevented the use of automated data integration models to format 
and import data into standardized feature class templates.   
 
All attributes were standardized so that the provider name, doing-business-as name and FCC 
registration numbers were consistent throughout the datasets and that attributes complied with 
valid value list (e.g., for technology of transmission, spectrums used, maximum advertised and 
typical speeds, etc.). 
 
Geocoding 
Unless otherwise specified, address data was geocoded using street addresses and zip codes from 
NAVTEQ 2008 Q4 streets data, which was developed though a partnership between NAVTEQ 
and the Massachusetts Office of Geographic Information (MassGIS) for increased geocoding 
accuracy and success rates for State 911 data. 
 
Data transfer model loading 
The final datasets for each provider were appended and loaded into the SBDD transfer schema.  
Geometry and topology checks were performed a final time and the data were checked for 
conformance with SBDD business rules.   
 
 
DATA DEVELOPMENT – WIRELINE AVAILABILITY 
 
This section describes the methods used to create the following datasets representing wireline 
broadband availability (e.g., cable, xDSL, other copper wireline, fiber optic and other 
unclassified wireline services) by census block and/or road segment: 
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 BB_Service_CensusBlock and  
 BB_Service_RoadSegment 
 
The various wireline broadband availability data formats received include: 
 
1. Non-geographically referenced CAD files containing cable or fiber strands;  
2. Geographically referenced Shapefiles containing census block polygons or road segments;  
3. Excel spreadsheets or delimited text files containing census block IDs 
4. Excel spreadsheets or delimited text files containing individual street addresses;  
5. Excel spreadsheets or delimited text files containing street address ranges 
6. Written or verbal narratives of service areas; and 
7. Excel spreadsheets containing maximum advertised speeds by US Census Bureau core based 

statistical area (CBSA) and rural statistical area (RSA). 
 
For areas where census blocks are less than or equal to 2 square miles in area, a template 
containing polygon geography for the appropriate census block vintage was used (2009 was the 
default census block vintage for data not tied to a census block ID).  Otherwise, a template 
containing line geography from 2009 TIGER/Line roads that intersect 2000 vintage census 
blocks greater than 2 square miles in area.  Associated attribute information included provider 
identification, technology of transmission and upload and download speeds.   
 
The integration methods used, and described below, varied according to the source data format.   
 
1. Integrating CAD strands:  Cable strands submitted in CAD format were georeferenced to 

street centerlines and a 200 foot buffer was created from the strands.  2009 census blocks and 
2009 TIGER/Line road segments (in census blocks greater than 2 square miles in area) that 
intersected the 200 foot buffer were classified as served and associated attribute information 
from tabular datasets or narratives were populated accordingly. 

 
2. Integrating census block and road segment polygons:  Data provided in Shapefile format 

required minor formatting of attribute field names and values to match the common schema. 

(a) The census block vintage was determined by reviewing ID values and attributes were 
imported into the census block template.  

(b) If vector data was provided from a source other than TIGER/Line roads, a spatial 
intersection with a 200 foot buffer was performed to transfer attributes to the corresponding 
TIGER/Line road segments. 

 
3. Integrating tabular data containing census block IDs:  Tabular information relating to census 

blocks referenced three different versions (or vintages) of census block data from 2000, 2008 
and 2009 and were joined to the corresponding polygon geometry using the 15 or 16 
character FIPS IDs.  Prior to integrating the individual provider information into a single 
combined dataset, the 2008 and 2009 census block data were summarized and joined to the 
2000 census block polygons using the first 15 characters of the FIPS ID for each unique 
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transmission technology type while retaining the maximum advertised and typical speeds and 
other associated validation and data processing attributes. 

 
4. Integrating tabular data containing individual street addresses:  Tabular data containing 

individual street addresses, generally representing subscriber addresses, were geocoded using 
NAVTEQ 2008 Q4 streets data to generate point locations. 2009 census blocks and 2009 
TIGER/Line road segments (in census blocks greater than 2 square miles in area) that 
intersect a 200 foot buffer of the points were classified as served.  Associated attributes were 
also imported. 

 
5. Integrating tabular data containing street address ranges:  (a) If tabular data was based on 

2009 TIGER/Line roads and included a TIGER line ID, the TIGER line ID was concatenated 
with the address fields to create a unique ID and linked to corresponding TIGER/Line 
geography.  Associated attributes were also imported. 

 (b) If tabular data was not based on TIGER/Line roads or did not have a means for creating a 
unique ID to link to the TIGER/Line data, the minimum, mean and maximum left and right 
street addresses were geocoded using NAVTEQ 2008 Q4 streets data to generate point 
locations.  As with the individual street address methodology above, 2009 census blocks and 
2009 TIGER/Line road segments (in census blocks greater than 2 square miles in area) that 
intersect a 200 foot buffer of the points were classified as served.  Associated attributes were 
also imported. 

 
6. Integrating narrative data:  (a) Location information provided in narrative form, such as the 

names of streets served or unserved, were incorporated by classifying the qualifying road 
segments as served.  A spatial intersection was then performed to classify any census blocks 
with area less than 2 square miles as served. 

(b) Attribute information provided in narrative form generally applied to all records or an 
easily identifiable subset of records in a dataset and the standardized values were assigned to 
the appropriate field in batch. 

 
7. Integrating spreadsheets containing speed by CBSA/RSA:  The tabular data was joined to 

corresponding CBSA/RSA polygon geometry using the CBSA/RSA ID. Maximum 
advertised download and upload speed values were transferred to census block and road 
segment availability records from the CBSA/RSA polygon they are located within. 

 
Data standardization 
For the many datasets based on census blocks from 2008 or 2009, the attributes were 
summarized by the 15 digit 2000 census block ID.  Maximum advertised and typical speed 
information were retained for each unique provider and technology combination for each 2000 
census block ID and imported into a template containing 2000 vintage census block geography.  
Records with download speeds below 768 kbps (i.e., that don’t qualify as broadband service) 
were removed from the final dataset. 
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DATA DEVELOPMENT – WIRELESS AVAILABILITY 
 
This section describes the methods used to create the following dataset representing wireless 
broadband availability (e.g., fixed and mobile wireless and satellite services) by service area: 
 
 BB_Service_Wireless  
 
The various wireless broadband availability data formats received include: 
 
1. Geographically referenced Shapefiles or MapInfo files containing service area polygons;  
2. Geographically referenced KML raster files depicting service areas;  
3. Non-geographically referenced PDF files depicting service area polygons;  
4. Hard copy maps with hand-drawn service areas; 
5. Excel spreadsheets containing street addresses; and 
6. Emails and technical documents containing tower and signal specifications. 
 
Associated attribute information included provider identification, technology of transmission, 
wireless spectrums used and upload and download speeds.  In some cases, attributes were 
provided in a separate tabular or narrative form or had to be acquired from the provider’s web 
site.  If providers offered more than one spectrum, a separate polygon was created for each 
unique provider and spectrum combination. 
 
Data integration methods used, and described below, varied according to the source data format.   
 
1. Integrating service area polygons:  Data provided in vector format required minor processing 

to fix geometry errors and create separate polygons for unique provider and spectrum 
combinations.  Attribute field names and values were created, formatted and/or populated 
from tabular or narrative form to match the standardized template format. 

 
2. Integrating service area raster images:  Propagation model outputs provided as KML raster 

images were imported into the GIS system; however, the geographic reference information 
was not able to be preserved.  The imported raster images were georeferenced in the GIS by 
matching the intersections of propagation area boundaries and roads in Google Earth.  Once 
georeferenced, the raster images were converted to polygons, then tagged with and 
aggregated by the associated tower ID and spectrum information to create service areas 
polygons for each propagation model.  Additional associated attribute values were populated 
from information provided in narrative form. 

 
3. Integrating static PDF maps:  The PDF maps containing wireless access points and service 

area buffers were georeferenced using known locations, such as road intersections.  Point 
data were created from the georeferenced map and service area buffers were recreated.  
Individual service areas were tagged with spectrum information and aggregated into a single 
service area for the provider and spectrum combination.  Additional associated attribute 
values were populated from information provided in narrative form and the resulting service 
area boundaries received confidence score of 1. 
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4. Integrating hard copy maps:  Hard copy maps containing shaded service areas were 

reproduced by digitizing boundaries based on known map locations, such as road 
intersections.  Associated attribute values were populated from information provided in 
narrative form and the resulting service area boundaries received confidence score of 1. 

 
5. Using tabular data containing street addresses:  Tabular data containing individual street 

addresses, representing subscriber addresses or addresses where service was determine not to 
be available, were geocoded using NAVTEQ 2008 Q4 streets data to generate point 
locations. These locations were compared to service areas and propagation models to verify 
boundaries. 

 
6. Modeling with tower and signal specifications:  Wireless tower and signal specifications 

(e.g., latitude, longitude, cell site height, cell site frequency and effective radiated power) 
were used as input parameters in SPLAT! radio frequency signal propagation, loss, and 
terrain analysis software. Service area boundaries were derived from the received power 
contours in the resulting propagation models. Additional associated attribute values were 
populated from information provided in narrative form. 

 
Data standardization 
Service area datasets for each provider were clipped to the state boundary and self-intersecting 
lines were fixed prior to loading into the SBDD transfer schema.     
 
 
DATA VERIFICATION – WIRELINE AND WIRELESS AVAILABILITY 
 
This section describes the methods used to verify the following datasets representing wireline 
broadband availability (e.g., cable, xDSL, other copper wireline, fiber optic and other 
unclassified wireline services) by census block and/or road segment and wireless broadband 
availability (e.g., fixed and mobile wireless and satellite services) by service area: 
 
 BB_Service_CensusBlock,  
 BB_Service_RoadSegment and 
 BB_Service_Wireless 
 
Verification of availability data received from providers is essential to determining the accuracy 
and completeness of the resulting broadband availability maps and is an ongoing process.  
Methodologies continue to be developed and implemented for data verification and are 
incorporated into a confidence ranking process.  The data verification and confidence ranking 
methods are described below. 
 
The data verification process employs, or will employ (designated by an asterisk *), the 
following methods, which supply input for the confidence ranking methodology.  
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1. Cable service area modeling:  Cable strand data for incumbent cable providers were acquired 
as georeferenced MapInfo files from the MA Department of Telecommunications and Cable 
(DTC) in 93% of the 305 cable-served towns.  The strands were imported and a 200 foot 
buffer was created to approximate the distance from the cable that a structure can receive 
service without excessive cost or delay.  The 200 foot distance was selected based on 
observed distances between poles and the acceptable distances of structures from cable as 
defined in cable license agreements.  Census blocks and road segments acquired from 
providers that intersected the resulting service area buffers for that provider were given an 
increased confidence score.   

 
2. DSL service area modeling:  DSL service areas were modeled from known DSL-equipped 

central office locations, which were geocoded using NAVTEQ 2008 Q4 streets data and 
refined using aerial photography, street views and bird’s-eye views from Google Maps and 
Bing Maps.  A linear network was developed, using a comprehensive roads dataset 
maintained by the MA Department of Transportation (MassDOT), that encompassed all 
roadways within 17,800 linear feet of the central office location.  A 200 foot buffer of the 
network was created to define a maximum service distance of 18,000 feet from the central 
office to the service location, based on input from industry experts, with the same 200 foot 
distance from pole to structure that was used in the cable model.  The resulting service area 
buffers were cropped at town boundaries except where central offices were known to serve 
neighboring towns.  Census blocks and road segments acquired from providers that 
intersected the estimated service areas for that provider were given an increased confidence 
score.   

  
3. Infrastructure field surveys:  Targeted field work has been performed to located broadband 

infrastructure, such as DSL-equipped remote terminals (RTs).  As with the central offices, 
locations were mapped using address and landmark information acquired in the field by 
geocoding with NAVTEQ 2008 Q4 streets data and refining with aerial photography, street 
views and bird’s-eye views from Google Maps and Bing Maps.  Although many DSL-
equipped RTs have been located in the field, they have not yet been incorporated into the 
DSL service area model yet due to the difficulty of predicting the directional nature of 
services provided from those locations.  However, the locations are valuable for visual 
review areas of DSL coverage claimed by providers that fall outside of modeled service areas 
to evaluate the likelihood of service from a given RT location.  These visual reviews are 
performed by team consisting of a GIS expert and a DSL technology expert and confidence 
scores modified accordingly. 

 
4. Public surveys:  Broadband subscription information is collected through web-based 

broadband surveys from the public and from community anchor institutions (see 
www.massbroadband.org/mapping/survey.html).  The surveys are publicized through 
targeted events and publications and MBI email notifications.  Information collected includes 
location, provider name, transmission technology, price, and speed for homes, businesses, 
and institutions throughout the state.  At this time, the survey data is only used to verify 
availability by provider name and transmission technology.  Census blocks and road 
segments acquired from providers that are within 200 feet of survey locations are given an 

http://www.massbroadband.org/mapping/survey.html�
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increased confidence score.  As with the service area models, the 200 foot distance represents 
the distance at which service can be provided without excessive cost or delay.  In the future, 
speed test results will be summarized by census block to verify typical speed information 
received from providers as well.   
 
Responses to the public survey are geocoded through Google Maps and visually refined by 
the user if desired.  Responses to the community anchor institution surveys are linked to 
existing point locations maintained by the Massachusetts Office of Geographic Information 
(MassGIS) or affiliated agency.  Community anchor institutions that have changed addresses 
or are not already in the MassGIS datasets are geocoded using NAVTEQ 2008 Q4 streets 
data and refined using a combination of institution web sites and aerial photography, street 
views and bird’s-eye views from Google Maps and Bing Maps. 
 
At this time, responses from the FCC’s consumer broadband test are not used for data 
verification, but will be evaluated for inclusion in future data verification phases. 

 
5. Provider web site information:  If information acquired by providers – including availability 

and speed – appeared to be questionable, a search was performed on the provider’s web site 
to confirm it.  This was type of verification was only performed when uncertainties arose 
during visual review of the data.  In the future, this type of review may be incorporated into a 
more structured approach to validate locations that are geographically dispersed throughout a 
provider’s service area.  

 
6. * Community cable and DSL feedback:  In collaboration with Regional Planning Agencies 

(RPAs), availability maps will be generated and distributed to carefully selected community 
representatives, such as local broadband committee members or town officials, with local 
knowledge of cable and/or DSL services in their town.  The community representatives will 
review and mark-up hard copy maps to identify services areas that extend too far or not far 
enough and to provide the location or address of the last known service location along a road.  
This will initially be implemented through a pilot project for the member communities of two 
Regional Planning Agencies.  The pilot project will allow evaluation and refinement of the 
process before being rolled out statewide, with a focus on low confidence areas.  Confidence 
scores will be modified based on feedback from the community representatives. 

 
7. * Wireless drive studies:  In coordination with local colleges, teams of student volunteers 

will be trained by an experienced field engineer to perform wireless drive studies.  The 
students will drive pre-defined routes with intermittent stops to collect wireless signal 
location and quality information using Android phones operating QoS Solutions’ QMapper 
and QPerf software (see www.qos-solutions.com).  An initial pilot study will be performed, 
in the same two RPA regions as the community cable and DSL feedback projects, to test and 
refine the survey methodologies before they are rolled out statewide.  Confidence scores will 
be modified based on results of the wireless drive studies. 

 

http://www.qos-solutions.com/�
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Confidence Ranking 
As availability data is verified, the verification status is documented in each individual census 
block or road segment record or subdivision of a wireless service area.  The records are also 
assigned numeric values from 1 to 5 that represent the level of confidence in the likelihood that 
service is available at that location.  When service availability for a given provider and 
technology is verified by an alternate source, the confidence value for that location is increased 
by one, up to a maximum score of 5.  A value of 1 represents the lowest confidence in provider 
data and no corroborating information from alternate sources.  A value of 5 represents 3 or more 
corroborating sources or confirmation through field work.  Data of all confidence levels are 
included in the availability datasets; however, locations that are deemed to be inaccurate as a 
result of the data verification process may have their confidence value reduced and may be 
tagged as not part of the service area. 
 
General guidelines of the confidence ranking process are as follows: 
 
 Initial rankings:  Data records submitted by providers are given an initial confidence ranking 

of “1” or “2” depending on the level of ambiguity in the submission method.  For example, 
availability information provided by census block ID, street address or spatial object is given 
a confidence ranking of 2.  Whereas, availability information provided as hand-drawn or 
narrative estimates may be given a confidence ranking of 1. 

 
 Verification from alternate datasets:  If availability at a given location is corroborated by an 

alternate dataset (such as the cable or DSL models, broadband survey responses, cable or 
DSL service area feedback from community representatives, or wireless drive study data 
interpolation), the verified location receives a 1 point increase in the confidence score for 
each corroborating dataset, with a minimum score of 3 and a maximum score of 5.   

 
 Field confirmation:  If availability at a given location is confirmed by known service 

locations identified through field work, it is given a confidence score of 5.  Confirmed field 
locations include known infrastructure, such as DSL-equipped remote terminals, or known 
service availability acquired in wireless drive studies. 

 
Provider Feedback Loop 
All providers that submitted data received a written data submission report that described the 
format and completeness of the datasets they provided.  This report included requests for 
additional information or alternate formats in the next submission and other data clarifications or 
corrections needed.  Additional feedback was provided by phone or email conversations as 
needed.  In certain cases, hard copy or PDF maps of estimated services were provided for 
verification and/or modification.  In the future, all providers will receive maps and/or vector data 
for review and verification of census blocks, street segments or wireless service areas.  
Information on conflicting alternate data sources may also be provided for comment or 
challenge.  This process will be standardized and formalized through the development of a web-
based provider data portal.  
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DATA DEVELOPMENT – MIDDLE MILE INTERCONNECTION FACILITIES 
 
This section describes the methods used to create the following dataset representing the location, 
technology and capacity of facilities that connect a service provider’s network to another 
provider’s network or the Internet: 
 
 BB_ConnectionPoint_MiddleMile 
 
Tabular data – including provider identification and facility ownership, capacity and type – were 
received from providers by street address or latitude and longitude.  Latitude and longitude 
values were used to create point geometry when possible.  Otherwise, street address data was 
geocoded using NAVTEQ 2008 Q4 streets data.   
 
The MBI did not have alternate data sources for the verification of these datasets. 
 
Data standardization 
Facility ownership, capacity and type values were standardized to comply with valid value lists.  
Due to the field type of double used to store latitude and longitude, values with trailing 0’s did 
not meet the 6 digit business rule.  However, to preserve the accuracy of the data, these values 
were not modified to contain 6 digits.  Latitude and longitude values received from providers 
with less than 6 digits were also not modified to prevent misrepresenting the data as more 
accurate than it really was. 
 
 
DATA DEVELOPMENT – COMMUNITY ANCHOR INSTITUTION SERVICE SUBSCRIPTIONS 
 
This section describes the methods used to create the following dataset representing the location 
and broadband service subscription of community anchor institutions throughout the state: 
 
 BB_Service_CAInstitutions 
 
The community anchor institution datasets deemed most relevant to broadband issues in 
Massachusetts were:  
 
 K-12 schools 
 Colleges and universities 
 Public libraries 
 Hospitals 

 Community health centers 
 Police and sheriffs 
 Career centers 
 Town halls

 
Existing spatial datasets containing community anchor institution names and locations were 
acquired from state and regional agencies.  The attributes were standardized and imported into a 
template dataset.  Missing attributes (e.g., zip codes) were acquired through web searches (e.g., 
on institution web sites or from the US Postal Service).  
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Initial data requests were made to state and regional agencies and/or associations to acquire any 
existing compilations of information on broadband service information at affiliated anchor 
institutions. Complete or almost complete datasets for career centers, state police and county 
sheriffs were acquired from the MA Executive Office of Labor and Workforce Development 
(EOLWD) and MA Executive Office of Public Safety and Security (EOPSS).   
 
For the remainder of the anchor institutions, a campaign was implemented to acquire information 
through phone, email and web-based surveys from individuals associated with individual anchor 
institutions that were knowledgeable about its broadband services. Requests were also made 
through targeted outreach at events and in publications targeted at anchor institutions to increase 
awareness of broadband issues and participation the broadband survey. Agencies and 
organizations that assisted in this effort included the MA Department of Secondary and 
Elementary Education (ESE), MA Board of Library Commissioners (MBLC), MA Chiefs of 
Police Association (MCOPA), Massachusetts Municipal Association (MMA) and MA 
Department of Revenue (DOR), Mass League of Community Health Centers (MLCHC) and a 
CIO group for public and community colleges. 
 
Data standardization 
Survey questions were developed to request information that easily understood and acquired by 
anchor institution staff.  As a result, survey results required additional formatting to standardize 
the information in accordance with SBDD valid values.  This information included broadband 
subscription status, transmission technology and maximum advertised speeds were collected and 
standardized to comply with valid value lists.  In addition, street addresses for new anchor 
institutions that were not in the original GIS datasets were geocoded using NAVTEQ 2008 Q4 
streets data and refined using visual references such as Google satellite photography and street 
view imagery.     
 
In some cases, standardized transmission technology attribute values were used by the MBI to 
track uncertain technology categories.  These were converted in the final datasets, as shown 
below, to comply with SBDD valid values.   
 

MBI Technology Values SBDD Technology Values 
1: Unknown 0: Other 
42: Cable - DOCSIS Unknown 41: Cable - DOCSIS Other 
72: Fixed Wireless - Unknown 70: Fixed Wireless - Unlicensed 

 
In some cases, transmission technology was corrected to reflect the service known to be offered 
by the specified provider. Advertised speeds lower than the NTIA’s definition of broadband were 
removed from the dataset. For anchor institutions that did not provide broadband information, 
the broadband service field was set to unknown (BBSERVICE = U).  
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BROADBAND CHALLENGES IN MASSACHUSETTS 
 
Broadband access differs significantly between the eastern, central and western parts of the state 
as well as the cape and islands. The majority of “unserved” and “underserved” communities are 
in western Massachusetts, which represents approximately 1/3 of the land mass in the state. 
Barriers to broadband access and deployment in this region are primarily due to topography, 
vegetation and population density. Western Massachusetts, as well as Cape Cod, currently lacks 
the middle mile infrastructure needed to encourage private sector development of last mile 
service. 
 
Wireline broadband availability in Massachusetts, particularly in western Massachusetts, is 
overstated in the current broadband datasets. This is due, in part, to generalizations resulting 
from census block size and population distribution in rural areas. The MBI is also working with 
communities to incorporate local knowledge of service availability in our feedback to broadband 
service providers and flagging census blocks and road segments requiring additional verification. 
 
Wireless broadband availability in Massachusetts is also overstated. The reliability of 
propagation modeling has been identified as a concern in establishing wireless broadband 
availability. Although topography is factored into propagation models, vegetation is also a 
significant barrier to wireless in Massachusetts and makes it difficult to determine if service is 
really available at a location. In addition, at least one fixed wireless provider is not able to accept 
new customers within its service area due to limited capacity. Responses to the MBI survey also 
indicate that typical mobile wireless speeds do not always qualify as broadband.  
 
Information provided by the community anchor institutions also requires additional review and 
modification. Respondents had difficulty selecting the correct transmission technology (e.g., the 
provider name frequently did not correspond to the technology) and often did not know the 
advertised speed of their service.  
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Submission Summary 
 
The staff of the Eastern Shore Regional GIS Cooperative (ESRGC) at Salisbury University in 
Salisbury, Maryland, in its role as primary technical lead for the Maryland Broadband Mapping 
Initiative, contacted 96 facilities-based broadband service providers (BSPs), received data from 
47 providers which represent 47 different companies.  An overall summary of the data 
submission can be described as: 
 
 96 potential facilities-based broadband service providers were contacted 
 37 BSPs did not respond 
 9 BSPs responded but did not provide data 
 47 BSPs responded and provided data 
 3 BSPs responded and agreed to provide data but have not as of April 1, 2011 
 
Of those that provided data, 
 
 22 provided only addresses 

4 provided only census block information 
 8 provided census blocks and road segments 
 13 provided wireless coverage areas 
 
 In addition, 9 of the 47 responsive BSPs provided middle mile infrastructure points 
 
Since our last submission, we lost two participants as Cavalier Telephone LLC was acquired by 
PAETEC Communications, Inc. and Cequel III Communications (dba SuddenLink) divested itself 
of broadband infrastructure, which was purchased by Shenandoah Telecommunications (dba 
Shentel Coverged Services).  On the other hand, we have eight newly-participating providers 
since Fall 2010:  Allied Telecom Group, LLC, Atlantech Online, Inc., Atlantic Broadband (Penn), 
LLC, Believe Wireless, LLC., Bloosurf, LLC, PAETEC Communications, Inc, One Communications, 
and Zayo Bandwidth, LLC. 
 

Data Processing 
 
For a specific discussion of the data processing steps for any particular BSP, please see the 
individual dataset report for each BSP below.  In general, the data processing used to create the 
Spring 2011 data submission depended on the type of data provided by the BSP. 
 
Census Blocks 
 
To process the served census blocks, one first geocodes the provider-submitted address table 
(if applicable) to an address locator based upon the Maryland PropertyView dataset.  Second, 
any unmatched addresses are geocoded to the Maryland iMap street centerline address 
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locator.  The matched addresses are then merged.  Fourth, the address points are spatially 
joined to the Year 2000 census blocks.  Then, divide the address points into the different 
technologies of transmission.  Sixth, select those address points that are within the census 
blocks that are greater than 2 mi2, exporting them as a separate feature class.  Seventh, switch 
the selected set (thus creating all the address points in blocks that are less than 2 mi2), and 
select those blocks. Eighth, import the provider-submitted table of served census blocks and 
merge with the address-created blocks (if applicable). Finally, export the results. 
 
Road Segments 
 
To process the served road segments that are within census blocks that are greater than 2 mi2, 
we import the table of road segment address ranges provided by the BSP.  We then take the TO 
address values and the FROM address values on both the left and the right side of the segment 
and concatenate those address numbers with the street name, type, and direction, thus 
creating a maximum of 4 point addresses per road segment.  Those point addresses are then 
address matched against both the TIGER line file and the Maryland iMap geocoding service.  
We can then find the street segments in TIGER that are adjacent to the located points.  Finally, 
we select those TIGER lines that intersect the census blocks that are greater than 2 mi2.  The 
result can be loaded into the SBDD Transfer data model.   
 
Service Addresses 
 
The process for creating the service addresses is the same as the census blocks (above), except 
that the addresses that fall within the census blocks that are greater than 2 mi2 are kept as the 
key feature class.  
 
Middle Mile Infrastructure  
 
Processing the middle mile infrastructure is relatively trivial, in that the providers submit 
geographic coordinates with the middle mile attributes.   
 
Community Anchor Institutions 
 
The Community Anchor Institution points submitted for the Spring 2011 data collection effort 
are the result of a combination of three distinct strategies: municipal-level data collection 
efforts, state-level data collection efforts and data purchase.  First, municipal-level data 
collection efforts involved e-mails and telephone calls to each of the 24 county GIS and/or IT 
departments. An email was created and sent detailing out the project and the request for 
broadband information for specific facilities. Many counties did not have this information 
readily compiled or available but were willing to assemble a GIS dataset or spreadsheet for the 
initiative.   Other counties were only able to provide a list of community anchor institutions 
without the broadband information.  Several counties were not able to provide any data.  
Several counties did not have a list of facilities so we provided them a spreadsheet with the 
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community anchor facilities and drop-down lists for easy compilation of the broadband data.  
For counties that were unresponsive to the email or could not provide the information, IT 
managers or directors were contacted.  Data was received from 14 counties with a response 
rate of 58% (see table below).   
 

Jurisdiction Data Provided? 

Allegany County Yes 

Anne Arundel County Yes 

Baltimore County Yes 

Baltimore City Yes 

Calvert County No 

Caroline County No 

Carroll County Yes 

Cecil County Yes 

Charles County No 

Dorchester County Yes 

Frederick County No 

Garrett County Yes 

Harford County Yes 

Howard County Yes 

Kent County No 

Montgomery County Yes 

Prince George’s County No 

Queen Anne’s County Yes 

St. Mary’s County Yes 

Somerset County Yes 

Talbot County No 

Washington County Yes 

Wicomico County No 

Worcester County No 

 
Second, a spreadsheet of State agencies from the State of Maryland website was created.  
Individual spreadsheets were created for each agency facilities.  Emails were then sent to IT 
managers or directors with the spreadsheet attached.  Follow-up emails and phone calls were 
placed.  A positive response was received from the Maryland State Department of Education 
(MSDE), which collected broadband information from each school as one part of the agency’s 
own survey, and the Maryland State Highway Administration. In total, 4,963 CAIs were 
collected from local and state sources. 
 
In the November 2010 broadband data submission, facilities without broadband information 
were not included because the data model did not allow a nullable or unknown attribute for 
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the BBService field.  The updated data model now allows an attribute of unknown for the 
BBService field.  Our efforts for the current submission involved combining and/or making 
facilities spatial that were previously obtained from municipal and state entities but not 
submitted to the NTIA because they did not have the associated broadband information.   
 
Our third and final strategy for collecting CAI data is via purchase.  In order to support the 
NTIA’s and FCC’s increased focus of telemedicine and medical uses of broadband service, we 
felt it was appropriate to significantly enhance our knowledge of medical-related community 
anchor institutions.  Thus, we purchased healthcare data from DirectMail.com.  They provided 
us a list of all companies in Maryland with SIC codes beginning with 80 (medical). The list 
contained 22,839 records and the cost for this data was $1,544.84.  After removing duplicates, 
we entered a total of 21,996 healthcare facilities into the data model. 
  
Overall, we submitted 923% more data than our previous submission, increasing the total 
number of records in the Maryland Community Anchor database from 2,636 to 26,959 records. 
 
 

Data Verification 
 
The ESRGC, in partnership with the Center for GIS at Towson University and as a subcontract to 
the SBDD grantee in Maryland, the Maryland Broadband Cooperative, conducted a number of 
verification and validation tests on the provider-submitted broadband availability data.  In the 
event that inconsistencies or errors were found, no changes were made to the provider-
submitted data during this data delivery round.  We had expected to have the confidence to 
begin modifying provider-submitted data as a result of our testing/research during this round of 
data submissions.  However, upon further deliberation, we are hesitant to make changes to the 
data submissions of providers without the specific guidance/direction of the NTIA as to the 
validity and appropriateness of our verification regime. 
 
A maximum of fourteen data checks were conducted on each of the provider-submitted 
broadband availability data, listed below.  Different versions of data verification tests were 
conducted on submissions from wireline broadband providers versus wireless providers, 
because of the differing submission geometry.  Each check will be explained in detail below 
 

1) Maximum down/upload speeds reported by provider 
2) Typical down/upload speeds reported by provider 
3) Typical down/upload speed from 2010 speed test 
4) Speed tests match reported typical speeds or are within 1 speed tier 
5) Census blocks/coverage areas verified by 2010 FCC and MBBMI speed tests 
6) Census blocks/coverage area reported to project, but no tract reported directly to 

FCC 
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7) Tracts reported directly to FCC, but no census blocks/coverage area reported to 
project 

8) Census blocks/coverage areas versus unserved area locations reported 
9) Total number of unserved area locations reported per provider 
10) Of census blocks reported as served, how many have zero population based on 2000 

census data?  
11) Web search verification 
12) Census blocks that are outside Cable Franchise Boundary 
13) Census blocks that are outside DSL boundary 
14) Wireless broadband presence and speed systematic field sampling 

 
 
Maximum down/upload speeds reported by provider 
 
Facilities-based BSPs are required to provide the maximum downstream and upstream speeds 
by the NTIA and the NoFA of August 2009.  These speeds are dependent upon the technology of 
transmission the BSP uses to deliver broadband service.  Speeds are reported in ordinal 
categories, or tiers, as defined by the NoFA.   They are: 
 

Downstream 
Speed Tier 

Upstream 
Speed Tier 

Corresponding Speed 

-- 1 Less than or equal to 200 kbps 
-- 2 Greater than 200 kbps and less than 768 kbps 
3 3 Greater than or equal to 768 kbps and less than 1.5 mbps 
4 4 Greater than or equal to 1.5 mbps and less than 3 mbps 
5 5 Greater than or equal to 3 mbps and less than 6 mbps 
6 6 Greater than or equal to 6 mbps and less than 10 mbps 
7 7 Greater than or equal to 10 mbps and less than 25 mbps 
8 8 Greater than or equal to 25 mbps and less than 50 mbps 
9 9 Greater than or equal to 50 mbps and less than 100 mbps 

10 10 Greater than or equal to 100 mbps and less than 1 gbps 
11 11 Greater than or equal to 1 gbps 

 
 
For this data check, the maximum downstream/upstream speeds reported from each provider 
are summarized in a table.  These speeds are summarized for census blocks, wireless coverage 
areas, road segments, and service address points 
 
For the data submission, 47 providers (100%) reported maximum downstream/upstream 
speeds for census blocks, although 3 providers’ reporting of maximum downstream/upstream 
speeds is incomplete.  The lowest maximum downstream speed Greater than or equal to 768 
kbps and less than 1.5 mbps, reported by 9 providers. The highest maximum downstream 
speed was greater than or equal to 1 gbps, reported by 4 providers.  The most frequent 
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maximum downstream speed was greater than or equal to 50 mbps and less than 100 mbps, 
reported by 4 providers. 
 
 
Typical down/upload speeds reported by provider 
 
BSPs are required to provide the typical downstream and upstream speeds by the NTIA and the 
NoFA of August 2009.  Typical speeds are, per the NoFA, intended to be “the data transfer 
throughput rate that most subscribers to service at the maximum advertised downstream 
speed can achieve consistently during expected periods of heavy network usage.”  These 
speeds are dependent upon the technology of transmission the BSP uses to deliver broadband 
service.  Speeds are reported in ordinal categories, or tiers, as defined by the NoFA (see table 
above). 
 
For this data check, the typical downstream/upstream speeds reported from each provider are 
summarized in a table.  These speeds are summarized for census blocks, wireless coverage 
areas, road segments, and service address points 
 
For the data submission, 20 providers (43%) reported typical downstream/upstream speeds.  
The lowest typical downstream speed was greater than 200 kbps and less than 768 kbps, 
reported by 1 provider.  The highest typical downstream speed was greater than or equal to 1 
gbps, reported by 1 provider, Level 3 Communications, LLC.  The most frequent typical 
downstream speed of the census blocks was Greater than or equal to 3 mbps and less than 6 
mbps, reported by 4 providers. 
 
 
Typical down/upload speed from 2010 speed test 
 
Beginning in April 2010, the MBBMI team and the FCC (nearly simultaneously) began collecting 
speed test information from broadband consumers in the state of Maryland.  This speed test 
information included the downstream and upstream speed in kbps, the signal latency, the 
street address of the tester, the type of connection location (home, work, etc), the connection 
technology (cable/DSL, fiber optic, satellite/dial-up, or unknown – MBBMI test only), the IP 
address of the test machine, and the corresponding BSP.  The MBBMI contracted with a 
company named Ookla to create their test; the FCC used both Ookla and an alternative method 
developed by a company named MLab. 
 
From mid-April 2010 until December 31, 2010, 6,820 speed tests were collected by MBBMI and 
10,584 PC-based speed tests were collected by the FCC (the FCC also collected mobile speed 
tests, see below).  Of these, 1,057 MLab-based FCC speed tests were eliminated (to insure 
consistent speed test results and 686 were removed because they did not include a valid 
address.  The FCC and the MBBMI speed tests were then combined and geocoded using their 
street address.  A total of 12,540 of speed tests were used in verification processing. 
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The speed tests associated with each reporting BSP were extracted from the geocoded set.  The 
downstream and upstream speeds were classified according to the NTIA’s speed tiers (see table 
above) and the number of tests in each tier were counted.  A table of those results in included 
in each data validation/verification report. 
 
For the state of Maryland as a whole, the speed test results are: 
 

Speed Tier 
Number of 

Downstream 
Tests 

Number of 
Upstream 

Tests 

1 211 780 
2 799 2,658 
3 987 778 
4 1,396 1,994 
5 1,132 4,206 
6 1,481 996 
7 4,975 1,185 
8 1,279 71 
9 252 -- 

10 35 -- 

 
 
Speed tests match reported typical speeds or are within 1 speed tier 
 
For the 20 providers that submitted typical speeds for their data, a comparison was conducted 
between the mode (the most frequent value) of the typical download speed tier from the 
provider area and the FCC/Ookla speed tests. In instances where the most frequent download 
speed tier from the speed tests matched, or was within one tier of, the typical download speed 
tier from the provider, the response to this statement is affirmative (7 providers). When the 
response to this statement is negative (10 providers), there is question about the typical 
download speeds that have been submitted by the provider. 
 
 
Census blocks/coverage areas verified by 2010 FCC and MBBMI speed tests 
 
Using the location of speed tests submitted through the FCC or the MBBMI speed test tools, the 
team sought to compare the location of broadband availability submitted by BSPs and the 
location of actual broadband service reported by speed test takers.  
 
For this verification test on wireline provider census block submissions, the following statistics 
are reported: 

1) Confirmation of census block served 
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The number of census blocks reported by the BSP as served that also contains a 
corresponding speed test 

2) Census blocks served, not reported by provider 
The number of census blocks that contain a BSP-related speed test that were not 
reported by the BSP as served 

3) Total number of served census blocks reported by provider 
The total number of unique census blocks reported as served by the BSP 

4) % of served census blocks confirmed by speed test 
The number of confirmed served census blocks divided by the total number of 
served census blocks 

 
For the state of Maryland, the maximum number of census blocks shown to be served by speed 
test data but not reported by a BSP is 62 ( for Comcast Cable Communications, LLC , 0.13% of 
their total reported blocks).  The minimum percentage of served census blocks confirmed by 
speed test was 0% (3 providers).  The maximum percentage was 100% (Hotwire 
Communications, Ltd and Tata Communications (America) Inc.).  On average, 1.18% of served 
census blocks were verified using speed tests. 
 
For this verification test on wireless provider coverage area submissions, the following statistics 
are reported: 

1) Confirmation of coverage area served 

 The number/percentage of computer-based speed tests that fall within the BSP’s 
reported coverage area(s). 

 The number/percentage of mobile speed tests that fall within the BSP’s reported 
coverage area(s). 

2) Area served, not reported by provider 

 The number/percentage of computer-based speed tests that fall outside the BSP’s 
reported coverage area(s). 

 The number/percentage of mobile speed tests that fall outside the BSP’s reported 
coverage area(s). 

 
For the wireless providers in the state of Maryland, one-half (7 of 14) had computer-based 
speed tests submitted by users.  The maximum number of computer-based speed tests shown 
to fall within the reported coverage area of a BSP is 88 (for Verizon Wireless, 100% of their 
computer-based speed tests).  Other BSPs that has 100% of their computer-based speed tests 
fall within their reported coverage area were Believe Wireless, Cricket Communications, 
HughesNet, and Freedom Wireless.  The minimum percentage of computer-based speed tests 
shown to fall within the reported coverage area of a BSP was 70.7% (Sprint Nextel, 41 of 58 
tests fell inside).   On average, 95.5% of computer-based speed tests fell within the BSP’s 
reported coverage area.   
 
Regarding the number of mobile speed tests that fall within the reported coverage area of a 
BSP, 50% (7 of 14) of the wireless BSPs had tests and the maximum number came from Sprint 
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Nextel customers, with 3,316 tests within their reported coverage area.  Three wireless BSPs 
had 100% of their mobile speed tests fall within their reported coverage area:  Believe Wireless, 
Clearwire, and Cricket Communications.  Sprint Nextel was also the BSP with the smallest 
percentage of tests falling within their reported coverage area – 93.9%.  On average, 98.3% of 
mobile speed tests fell within the BSPs reported coverage areas. 
 
 
Census blocks/coverage area reported to project, but no census tract directly reported to FCC 
Census tracts directly reported to FCC, but no census blocks/coverage areas reported to 
project 
 
Another source of data validation was the FCC’s Form 477 data as of December 2009.  This 
dataset is collected semi-annually by the FCC from BSPs, both facility-based and not facility-
based.  The BSPs report the number of residential and business subscribers to their broadband 
service per census tract.  For comparison, the average census tract in Maryland contains 67 
census blocks.  While the Form 477 data is much coarser than the SBDD-reported data, it still 
should align spatially. 
 
Therefore, as another verification check, we test the number of census blocks that are reported 
by wireline BSPs that have no corresponding reported census tract in the BSP’s Form 477 data.  
Similarly, we test the number of tracts from the wireline BSP’s Form 477 data that do not have 
corresponded census blocks reported in this initiative. 
 
For the state of Maryland, the maximum number of census blocks that were reported as served 
but had no corresponding Form 477 census tract was 47,949 from Atlantech Online, Inc.  On 
average, 2,423 census blocks (from 23 providers) had no corresponding census tract.  The 
maximum number of census tracts that had no corresponded reported census blocks was 187 
from DSLnet Communications, LLC.  On average, 22 census tracts (from 23 providers) had no 
corresponding census blocks. 
 
For wireless BSPs, we tested the number of census tracts that either intersect or do not 
intersect each reported coverage area.  Because it is not possible to tell what portion of the 
Form 477 reported census tract may receive the wireless service, a simple intersect between 
served tracts and coverage areas is the only test available from these data sources.  For those 
wireless BSPs reporting to the FCC on Form 477 (8 of 14), 100% of the served census tracts 
intersected the reported coverage areas. 
 
 
Census blocks/coverage areas versus unserved area locations reported 
Total number of unserved area locations reported per provider  
 
At the MBBMI website (www.mdbroadbandmap.org) and at the FCC website 
(www.broadband.gov), residents and business owners have the opportunity to report unserved 

http://www.mdbroadbandmap.org/
http://www.broadband.gov/
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areas.  These are locations, specifically addresses, at which the potential broadband customer 
cannot access broadband service.  Those unserved area reports are taken in by the MBBMI 
team, geocoded according to their address, and are examined for their spatial coincidence with 
BSP availability coverages. For each wireline provider, the number of census blocks reported as 
served that contain a unserved area report are calculated, as well as the total number of 
unserved area reports within a BSPs availability area. For each wireless BSP, the 
number/percentage of unserved area reports from both the FCC and the MBBMI that fall within 
and outside the reported coverage area are calculated. 
 
It is important to note that, at the present time, these unserved area reports are unverified.  It 
is possible that broadband service may be available either at the address (but the person 
reporting the unserved area location was unaware of service availability), or not available at the 
address because of some unique configuration problem at that address specifically.  It is also 
entirely possible that portions of a census block may be served but other portions may not. 
 
For the state of Maryland, the maximum number of a wireline BSP’s available census blocks 
that contain an unserved area location report is 91 (Verizon Communications, Inc.).  The 
minimum number is 0 (17 providers).  The maximum number of unserved area location reports 
in a wireline BSP’s available area is 136 (Atlantech Online, Inc.) The following wireline providers 
have only 1 unserved area location report in their areas:  Antietam Cable Television, Inc  and 
Atlantic Broadband (Penn), LLC. 
 
For the state of Maryland, the maximum percentage of unserved area locations reported from 
the FCC within a wireless BSP’s reported coverage area is 100% (202 of 202), true for each of 
the satellite wireless providers (HughesNet, StarBand, and Wildblue).  The maximum 
percentage of unserved area locations reported from the FCC within a non-satellite wireless 
BSP’s reported coverage area is AT&T Wireless at 95.5% (193 of 202).  The average percentage 
of unserved area locations (reported from the FCC) that fall within a wireless BSP’s reported 
coverage area is 46.2% (93 of 202).  For those unserved area locations reported by the MBBMI, 
the maximum percentage of unserved area locations within a wireless BSP’s reported coverage 
area is 100% (58 of 58), true for each of the satellite wireless providers (HughesNet, StarBand, 
and Wildblue).  The maximum percentage of unserved area locations reported from the MBBMI 
within a non-satellite wireless BSP’s reported coverage area is AT&T Wireless  at 94.8% (55 of 
58).  The average percentage of unserved area locations (reported from the MBBMI) that fall 
within a wireless BSP’s reported coverage area is 41.9% (24 of 58).   
 
 
Of census blocks reported as served, how many have zero population based on 2000 census 
data?  
 
One expectation of the broadband availability data is that there should not be broadband 
available within census blocks that have no people to purchase broadband.  Therefore, for each 
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BSP, the number of served census blocks that have 0 population as reported in the 2000 census 
were tallied and compared to the total number of the provider’s served census blocks.  
 
This is a particularly weak verification test for several reasons.  First, the population data is not 
current and has likely changed significantly in the last 10 years.  Second, areas that are 
completely commercial with no residents may still need and want broadband availability.  
Finally, BSPs may be anticipating future development and making service available where there 
are not yet any residents. 
 
For the state of Maryland, the maximum number of zero population census blocks that were 
reported as served was 10,740 (Atlantech Online, Inc.).  The minimum number was 1 (Tata 
Communications (America) Inc and Shenandoah Telecommunications).  The average number of 
zero population census blocks that were reported as served was 1246.  As a percentage, the 
maximum percentage of zero population census blocks reported as served was 100% (Tata 
Communications (America) Inc, Cogent Communications Group, and Shenandoah 
Telecommunications).  The minimum percentage of zero population census blocks was 0 
(Hotwire Communications, Ltd., Neon Optica, Inc, and Zayo Bandwidth LLC ).  The average 
percentage was 29%. 
 
 
Web search verification 
 
Some broadband service providers publish service availability query tools on their corporate 
websites.  The MBBMI team took the opportunity to test the broadband availability areas 
submitted by the BSPs against the BSP’s web-based service availability tools.  A systematic 
sampling grid was created for the entire state of Maryland.  A sample point was placed every 
4000 meters, then the nearest property address (within at most 1000 m) was chosen.  This 
yielded a grid of 1,472 sample points. In Baltimore City, an additional 24 sample points were 
added (approximately every 2000 meters) in order to have reasonable sampling density within 
the small area of the City.  This brought the total sample points to 1,496. 
 
For each BSP that had a web-based service availability query tool (13 providers), the sample 
point grid addresses were used to verify the availability of service (or lack thereof) compared to 
both the reported service area, the area just outside the stated service area, and a random 
selection of grid points across the state.  The following combinations of reported service vs. 
queried service were tallied: 
 

1) A census block/coverage area was reported as served and the sample was returned 
as served 

2) A census block/coverage area was reported as served but the sample was returned 
as unserved 

3) A census block was not reported as served (or the location was outside the wireless 
coverage area) and the sample was returned as not served 
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4) A census block was not reported as served (or the location was outside the wireless 
coverage area) but the sample was returned as served 

 
The total number of sample points in categories 2 and 4 are reported as error (of commission 
and of omission, respectively). 
 
For Comcast and Verizon, all 1,496 sample points were used as those two BSPs offer broadband 
service in all areas of the state. 
 
For the nine wireline BSPs in the state of Maryland that have a Internet-based availability tool, 
the maximum omission error rate was 24.1% reported by Armstrong Cable  The minimum 
omission error rate was 0% and was reported by Charter Communications and Starpower.  The 
average omission error rate was 9.3%.  The maximum commission error rate was 35.7% 
reported by Verizon Maryland.  The minimum commission error rate was 0% and was reported 
by 3 providers.  The average commission error rate was 5.8%.  The maximum total error rate 
was 38.5% reported by Verizon Maryland  The minimum total error rate was 0% reported by 
Starpower Communications, LLC.  The average total error rate was 15.1%. 
 
For wireless BSPs in the state of Maryland, only two offer Internet-based service availability 
search tools, Clearwire and Cricket Communications.  Of those, Clearwire had the highest rate 
of omission error (5.4%; 19 of the 354 addresses tested were not reported to the MBBMI as 
within the coverage area, but were reported by the provider’s website as served) and 
commission error (0.6%; 2 of 354 addresses tested were reported as served, but the website 
reported as not served). 
 
 
Census blocks that are outside Cable Franchise Boundary 
 
For those BSPs that provide broadband service via cable modem technology, they are 
(supposedly) constrained to a service area defined by a local (or several local) cable franchise 
boundar(ies).  The MBBMI team obtained the spatial extent of the cable franchise boundaries 
within the state of Maryland from the Maryland Broadband Cooperative.  With these cable 
franchise boundary areas, a test can be performed to count the number of census blocks that 
fall outside of a cable franchise boundary area.  This may indicate an error, although it is 
possible that a) the cable franchise boundaries are not up-to-date or b) the BSP offers 
broadband service beyond the area in which they offer cable television service. 
 
In Maryland, 11 providers are eligible for this test.  The maximum number of blocks that fall 
outside the cable franchise boundaries is 5,755 reported by Comcast Cable Communications, 
LLC.  This represents 11.9% of their total number of served blocks.  The minimum number of 
“outside” blocks is 0 reported by Hotwire.  The average number of blocks that fall outside the 
cable franchise boundary is 792. 
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Census blocks that are outside DSL boundary 
 
For those BSPs that provide broadband service via digital subscriber line (DSL) technology, the 
general area of DSL availability is tracked by several industry groups.  The MBBMI team 
obtained the spatial extent of the DSL availability areas within the state of Maryland from the 
Maryland Broadband Cooperative.  With these DSL availability areas, a test can be performed to 
count the number of census blocks that fall outside of the DSL availability area.  This may 
indicate an error, although it is possible that the DSL availability boundaries are not up-to-date 
or correct.  There was no metadata concerning currentness or quality included in the DSL 
availability areas.   
 
In Maryland, 8 providers are eligible for this test.  The maximum number of blocks that fall 
outside the DSL availability areas is 9,939 reported by Verizon Maryland Inc.  This represents 
17.4% of their total number of served blocks.  The minimum number of “outside” blocks is 3 
reported by MegaPath.  The average number of blocks that fall outside the DSL availability area 
is 3,030. 
 
 
Wireless broadband presence and speed systematic field sampling 
 
For the wireless coverage areas, many of the other data checks and tests are not appropriate to 
use.  In the summer of 2010, the MBBMI embarked on a wireless coverage area verification 
project.  For each of the 1,472 systematic sampling grid points (see above), a research team 
visited the sample address with four phones, one each for Sprint, Verizon Wireless, AT&T, and 
T-Mobile.  A software package developed by QOS was purchased and used to test a) broadband 
availability, b) downstream and upstream speeds, and c) the GPS location of the test.  If the 
QOS software malfunctioned, the FCC’s mobile speed test was used to record the availability 
and speed with the location being recorded manually. 
 
After the field sampling was completed, 1,466 grid points with valid samples were used to 
conduct this test; 6 of the original sample locations were located within large, secure facilities 
(ie. military bases) and were thus inaccessible.  Of those, the following combinations of 
reported service vs. sampled service were tallied: 
 

1) A sample point was in an area reported as served and the sample was returned as 
served 

2) A sample point was in an area reported as served but the sample was returned as 
unserved 

3) A sample point was not in an area reported as served and the sample was returned 
as not served 

4) A sample point was not in an area reported as served but the sample was returned 
as served 
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The total number of sample points in categories 2 and 4 are reported as error (of commission 
and of omission, respectively). 
 
For the state of Maryland, T-Mobile had the maximum number of samples that were reported 
as omitted (sampled as served but not within the coverage area) was 278 and the error rate 
was 61.5% (278 of 452 samples that had registered service).  AT&T Wireless had the minimum 
number of samples that were reported as omitted (14 or 1.3%).  The average omission error 
rate was 22.0%.  AT&T Wireless had the maximum number of samples that were reported as 
committed (sampled as not served but within the coverage area) at 364.  The commission error 
rate was 24.8% (1,466 were tested).  Verizon Wireless had the minimum number of samples 
that were reported as committed (153 or 10.4%).  The average commission error rate was 
14.7%.    The average total error rate was 24.5%. 
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Individual Provider Data Summaries  
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Allied Telecom Group, LLC 
DBA: Allied Telecom Group, LLC 
 
Data Characteristics 
 
Date of Original Submission:       3/7/2011 
Date of Update Submission:       N/A 
Currency of Data:        December 2010 
FRN:           0002154367 
Type of data submitted:        Census Block Table 
Census Block Count:                      44834   
Total Matched Address Points Count:     N/A 
Unmatched Address Points:       N/A 
Number of Technology of Transmission Types:    3 
Provided Max Advertised Download Speed:     Complete 
Provided Max Advertised Upload Speed:      Complete 
Provided Max Typical Download Speed:      Complete 
Provided Max Typical Upload Speed:      Complete 
Provided Middle Mile:        No 
Provided Road Segments for census blocks greater than 2 sq miles: No 
 
Data Processing 

 
Census Block Process: 

 Join the census block table to the 2000 census blocks based on the BLK2000 field  
o Export results for each technology of transmission 
o Load exported results into the NTIA data model  

 Result: BB_Service_CensusBlock 
 
Speed Domains: 

 Maximum Advertized and Typical Speeds changed 
o Technology of Transmission 20 – all speeds changed to tier 8 to fit domain 
o Technology of Transmission 30 - all speeds changed to tier 8 to fit domain 

 
Data Verification 
 
Maximum down/upload speeds reported by provider: 
Census Blocks 

Max Download Category Count % of Blocks 
 

Max Upload Category Count % of Blocks 

6 44834 33% 
 

5 44834 33% 

8 89668   
 

8 89668 67% 
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Typical down/upload speeds reported by provider:  
Census Blocks 

Typical Download Category Count % of Blocks 
 

Typical Upload Category Count % of Blocks 

5 44834 33% 
 

5 44834 33% 

8 89668 67% 
 

8 89668 67% 
 
Typical down/upload speed from 2010 computer based speed test: N/A 
 
Speed tests match reported typical speeds or are within 1 speed tier:   N/A 
 
 %/# of census blocks verified by 2010 computer based speed tests: N/A 
 
Form477 Verification: 
Number of census blocks reported to project, but no tract reported to FCC: N/A 
Number of tracts reported to FCC, but no census blocks reported to project: N/A 
 
Unserved areas: 
Number of census blocks with unserved areas reported via broadband.maryland.gov: 7 
Total number of unserved areas reported per provider via broadband.maryland.gov: 12 
 
Number of census blocks with unserved areas reported via mdbroadbandmap.org: 18 
Total number of unserved areas reported per provider via mdbroadbandmap.org: 25 
 
Of census blocks reported as served, how many have zero population based on 2000 census 
data?  8907/44834 (20%) 
 
Web Search Verification: N/A 
 
Census blocks that are outside DSL boundary:  11293/44834 (25%) 
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Antietam Cable Television, Inc. 

DBA Name: Antietam Cable Television, Inc 
 
Data Characteristics 
 
Date of Original Submission:       7/29/2010 
Date of Update Submission:       2/21/2010  
Currency of Data:        December 2010 
FRN:           0002154367 
Type of data submitted:        Address Table 
Census Block Count:                      1805   
Total Matched Address Points Count:     574 
Unmatched Address Points:       99 
Number of Technology of Transmission Types:    1 
Provided Max Advertised Download Speed:     Complete 
Provided Max Advertised Upload Speed:      Complete 
Provided Max Typical Download Speed:      No  
Provided Max Typical Upload Speed:      No  
Provided Middle Mile:        No 
Provided Road Segments for census blocks greater than 2 sq miles: No 
 
Data Processing 
 
Address Table Process: 

 Geocode address table to Maryland Property View address locator 
o Number matched: 21083 
o Number unmatched: 801 

 Unmatched address are geocoded to Maryland street centerline address locator 
o Number matched: 702 
o Number unmatched: 99 

 Merge matched addresses 

 Spatially join address points to 2000 census blocks 

 Select by location the address points that are completely within a greater than two 
square mile census block 

o Export as address points to be loaded into the NTIA data model 
 Result: BB_Service_Address 

o Switch the selection and export as points to create census blocks 
Census Block Process: 

 Join the switched selection (BB_Service_Address) address points to the 2000 census 
blocks based on the BLK2000 field  

o Export results  
o Load exported results into the NTIA data model  
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 Result: BB_Service_CensusBlock 
 
Data Verification 
 
Maximum down/upload speeds reported by provider:  
Census Blocks 

Max Download Category Count % of Blocks 
 

Max Upload Category Count % of Blocks 

8 1805 100% 
 

2 1805 100% 
Addresses 

Max Download Category Count % of Points 
 

Max Upload Category Count % of Points 

8 574 100% 
 

2 574 100% 
 
Typical down/upload speeds reported by provider:  N/A 
 
Typical down/upload speed from 2010 computer based speed test:  

Speed Test Download Tier Count % of Tests 
 

Speed Test Upload Tier Count % of Tests 

0 1 1% 
 

1 3 3% 

3 3 3% 
 

2 17 18% 

4 16 17% 
 

3 60 64% 

5 53 56% 
 

4 12 13% 

6 1 1% 
 

5 1 1% 

7 3 3% 
 

6 1 1% 

8 1 1% 
    9 6 6% 
    10 10 11% 
     

Speed tests match reported typical download speeds or are within 1 speed tier:  N/A 
 
%/# of census blocks verified by 2010 computer based speed tests:  

Confirmation of census block served 52 

Census blocks served, not reported by provider 4 

Total number of served census blocks reported by provider 1805 

% of served census blocks confirmed by speed test 0.0288% 
 
Form 477Verification: 
Number of census blocks reported to project, but no tract reported to FCC: 1 
Number of tracts reported to FCC, but no census blocks reported to project: 0 
 
Unserved areas: 
Number of census blocks with unserved areas reported via broadband.maryland.gov: 0 
Total number of unserved areas reported per provider via broadband.maryland.gov: 0 
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Number of census blocks with unserved areas reported via mdbroadbandmap.org: 0 
Total number of unserved areas reported per provider via mdbroadbandmap.org: 0 
 
Of census blocks reported as served, how many have zero population based on 2000 census 
data? 102/1805 (6%) 
 
Web Search Verification: 41/1805 (2%) of census blocks were confirmed using online search 
feature of given provider. 

Antietam Web Search Verification Table Count Percentage 

Total # of sample points 1496   

Number of sample points with results 123 8% 

Result is yes and census block is in served area  41 33% 

Result is yes but not in a census block reported as served    21 17% 

Result is no and census block is in served area 5 4% 

Result is no and census block not served area 56 46% 
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Armstrong Holdings, Inc. 
DBA Name: Armstrong Utilities, Inc. 
 
Data Characteristics 
Date of Original Submission:       3/31/2010 
Date of Update Submission:       N/A 
Currency of Data:        December 2010 
FRN:           0003765617 
Type of data submitted:        Census Block Table 
Census Block Count:                      1191   
Total Matched Address Points Count:     N/A 
Unmatched Address Points:       N/A 
Number of Technology of Transmission Types:    1 
Provided Max Advertised Download Speed:     Complete 
Provided Max Advertised Upload Speed:      Complete 
Provided Max Typical Download Speed:      No  
Provided Max Typical Upload Speed:      No  
Provided Middle Mile:        No 
Provided Road Segments for census blocks greater than 2 sq miles: Yes 
 
Data Processing 
Census Block Process: 

 Join the provided census block table to the 2000 census blocks based on the BLK2000 
field  

o Export results  
o Load exported results into the NTIA data model  

 Result: BB_Service_CensusBlock 
 
Data Verification 
Maximum down/upload speeds reported by provider:  
Census Blocks 

Max Download Category Count % of Blocks 
 

Max Upload Category Count % of Blocks 

7 1191 100% 
 

5 1191 100% 
 
Typical down/upload speeds reported by provider: N/A 
 
Typical down/upload speed from 2010 computer based speed test:  

Speed Test Download Tier Count % of Tests 
 

Speed Test Upload Tier Count % of Tests 

0 5 14% 
 

1 1 3% 

3 1 3% 
 

2 6 17% 

5 4 11% 
 

3 2 6% 

6 18 50% 
 

4 26 72% 
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7 8 22% 
 

6 1 3% 
 
Speed tests match reported typical download speeds or are within 1 speed tier:  N/A 
 
%/# of census blocks verified by 2010 computer based speed tests:  

Confirmation of census block served 52 

Census blocks served, not reported by provider 4 

Total number of served census blocks reported by provider 1191 

% of served census blocks confirmed by speed test 4.37% 
 
Form 477Verification: 
Number of census blocks reported to project, but no tract reported to FCC: 43 
Number of tracts reported to FCC, but no census blocks reported to project: 1 
 
Unserved areas: 
Number of census blocks with unserved areas reported via broadband.maryland.gov: 5 
Total number of unserved areas reported per provider via broadband.maryland.gov: 5 
 
Number or census blocks with unserved areas reported via mdbroadbandmap.org: 2 
Total number of unserved areas reported per provider via mdbroadbandmap.org: 2 
 
Of census blocks reported as served, how many have zero population based on 2000 census 
data?  182/1191 (15.3%) 
 
Web Search Verification: 46/1191 (3.9%) of census blocks were confirmed using online search 
feature of given provider 

Armstrong WebSearch Verification Table Count Percentage 

Total # of sample points 1496   

Number of sample points with results 166 11% 

Result is yes and census block is in served area  46 28% 

Result is yes but not in a census block reported as served    40 24% 

Result is no and census block is in served area 0 0% 

Result is no and census block not served area 80 48% 
 
Census blocks that are outside Cable Franchise Boundary: 638/1191 (54%) 
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AT&T Mobility LLC  
DBA Name: AT&T Mobility LLC  
 
Data Characteristics 
 
Date of Original Submission:       3/9/2010 
Date of Update Submission:       2/1/2011 
Currency of Data:        December 2010 
FRN:           0004979233 
Type of data submitted:        Coverage Area 
Census Block Count:                      N/A   
Total Matched Address Points Count:     N/A 
Unmatched Address Points:       N/A 
Number of Technology of Transmission Types:    1 
Provided Max Advertised Download Speed:     Complete 
Provided Max Advertised Upload Speed:      Complete 
Provided Max Typical Download Speed:      No  
Provided Max Typical Upload Speed:      No  
Provided Middle Mile:        No 
Provided Road Segments for census blocks greater than 2 sq miles: No 
 
Data Processing 
 
Coverage Area Process: 

 Repair Geometry on delivered coverage area 

 Remove coverage areas less than 0.125 square miles 

 Remove coverage area “holes” less than 0.125 square miles 

 Simplify Polygon of coverage area 

 Load coverage area into the NTIA data model 
o Result: BB_Service_Wireless 

 
Data Verification 
 
Maximum down/upload speeds reported by provider:  
Coverage Area 

Max Download Category Count % of Area 
 

Max Upload Category Count % of Area 

4 2 100% 
 

3 2 100% 
 
Typical down/upload speeds reported by provider: N/A 
 
Typical down/upload speed from 2010 mobile speed test:  

Speed Test Download Tier Count % of Tests 
 

Speed Test Upload Tier Count % of Tests 
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0 161 29% 
 

1 327 58% 

3 181 32% 
 

2 164 29% 

4 192 34% 
 

3 50 9% 

5 27 5% 
 

4 17 3% 

    
7 2 0% 

    
8 1 0% 

 
Speed tests match reported typical download speeds or are within 1 speed tier:  N/A 
 
#/% of mobile speed tests verifying coverage area:  
Number of mobile speed tests reported inside coverage area: 560/561 (99.8%) 
Number of mobile speed tests reported outside coverage area: 1/561 (0.2%) 
 
Form 477Verification: 
#/% of tracts reported as served to FCC that overlaps with coverage area: 342/342 (100.0%) 
#/% of tracts reported as served to FCC but do not intersect coverage area: 0 
 
Unserved areas: 
Number of unserved areas reported within coverage area via broadband.maryland.gov:  
193/202 (95.5%) 
Number of unserved areas reported within coverage area via mdbroadbandmap.org:  
55/58 (94.8%) 
 
Of census blocks reported as served, how many have zero population based on 2000 census 
data? N/A 
 
Web Search Verification: N/A  
 
Wireless Verification: 

ATT Wireless Verification Table Count Percentage 

Total # of sample points 1466   

Number of sample points with results 1079 73.6% 

Verified served AND BSP says served   (yes,yes) 1065 98.7% 

Verified served AND BSP says unserved   (yes,no) 14 1.3% 

Verified unserved AND BSP says served   (no,yes) 364 24.8% 

Verified unserved AND BSP says unserved   (no,no) 24 1.6% 
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Atlantech Online, Inc. 
DBA: Atlantech Online, Inc. 
 
Data Characteristics 
 
Date of Original Submission:       3/7/2011 
Date of Update Submission:       N/A 
Currency of Data:        December 2010 
FRN:           0018854935 
Type of data submitted:        LATA/Zip Codes 
Census Block Count:                      53222   
Total Matched Address Points Count:     N/A 
Unmatched Address Points:       N/A 
Number of Technology of Transmission Types:    2 
Provided Max Advertised Download Speed:     Complete 
Provided Max Advertised Upload Speed:      Complete 
Provided Max Typical Download Speed:      No 
Provided Max Typical Upload Speed:      No 
Provided Middle Mile:        No 
Provided Road Segments for census blocks greater than 2 sq miles: No 
 
Data Processing 

 
Census Block Process: 

 Select the 2000 census blocks that intersect LATA boundary and zip codes 

 Add fields and load results into the NTIA data model  
o Result: BB_Service_CensusBlock 

 
Data Verification 
 
Maximum down/upload speeds reported by provider: 
Census Blocks 

Max Download Category Count % of Blocks 
 

Max Upload Category Count % of Blocks 

10 2308 4% 
 

10 2308 4% 

4 53222 96% 
 

4 53222 96% 
 
Typical down/upload speeds reported by provider: N/A 
 
Typical down/upload speed from 2010 computer based speed test:  

Speed Test Download Tier Count % of Tests 
 

Speed Test Upload Tier Count % of Tests 

9 1 100% 
 

2 1 100% 
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Speed tests match reported typical speeds or are within 1 speed tier:   N/A 
 
 %/# of census blocks verified by 2010 computer based speed tests:  

Confirmation of census block served 1 

Census blocks served, not reported by provider 0 

Total number of served census blocks reported by provider 53222 

% of served census blocks confirmed by speed test 0.00% 
 
Form477 Verification: 
Number of census blocks reported to project, but no tract reported to FCC: 47949 
Number of tracts reported to FCC, but no census blocks reported to project: 5 
 
Unserved areas: 
Number of census blocks with unserved areas reported via broadband.maryland.gov: 84 
Total number of unserved areas reported per provider via broadband.maryland.gov: 136 
 
Number of census blocks with unserved areas reported via mdbroadbandmap.org: 23 
Total number of unserved areas reported per provider via mdbroadbandmap.org: 30 
 
Of census blocks reported as served, how many have zero population based on 2000 census 
data?  10740/53222 (20%) 
 
Web Search Verification: N/A 
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Atlantic Broadband (Penn), LLC 
DBA Name: Atlantic BroadBand 
 
Data Characteristics 
Date of Original Submission:       3/26/2011 
Date of Update Submission:       N/A 
Currency of Data:        December 2010 
FRN:           0009596883 
Type of data submitted:        Address Table 
Census Block Count:                      3098   
Total Matched Address Points Count:     63284 
Unmatched Address Points:       4664 
Number of Technology of Transmission Types:    1 
Provided Max Advertised Download Speed:     Complete 
Provided Max Advertised Upload Speed:      Complete 
Provided Max Typical Download Speed:      No  
Provided Max Typical Upload Speed:      No  
Provided Middle Mile:        No 
Provided Road Segments for census blocks greater than 2 sq miles: No 
 
Data Processing 
Address Table Process: 

 Geocode address table to Maryland Property View address locator 
o Number matched: 60669 
o Number unmatched: 7279 

 Unmatched address are geocoded to Maryland street centerline address locator 
o Number matched: 2615 
o Number unmatched: 4664 

 Merge matched addresses 

 Spatially join address points to 2000 census blocks 

 Select by location the address points that are completely within a greater than two 
square mile census block 

o Export as address points to be loaded into the NTIA data model 
 Result: BB_Service_Address 

o Switch the selection and export as points to create census blocks 
Census Block Process: 

 Join the switched selection (BB_Service_Address) address points to the 2000 census 
blocks based on the BLK2000 field  

o Export results Load exported results into the NTIA data model  
 Result: BB_Service_CensusBlock 

 
Data Verification 
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Maximum down/upload speeds reported by provider:  
Census Blocks 

Max Download Category Count % of Blocks 
 

Max Upload Category Count % of Blocks 

7 3098 100% 
 

3 2925 94% 

    
4 173 6% 

Addresses 

Max Download Category Count % of Points 
 

Max Upload Category Count % of Points 

7 3704 100% 
 

3 3501 95% 

    
4 203 5% 

 
Typical down/upload speeds reported by provider:  
Census Blocks 

Typical Download Category Count % of Blocks 
 

Typical Upload Category Count % of Blocks 

7 3098 100% 
 

3 3098 100% 
 
Addresses 

Typical Download Category Count % of Points 
 

Typical Upload Category Count % of Points 

7 3704 100% 
 

3 3704 100% 
 
Typical down/upload speed from 2010 computer based speed test:  

Speed Test Download Tier Count % of Tests 
 

Speed Test Upload Tier Count % of Tests 

0 3 4% 
 

1 1 1% 

3 4 5% 
 

2 75 97% 

4 9 12% 
 

3 1 1% 

5 42 55% 
    6 18 23% 
    7 1 1% 
     

Speed tests match reported typical download speeds or are within 1 speed tier:  No 
 
%/# of census blocks verified by 2010 computer based speed tests:  

Confirmation of census block served 48 

Census blocks served, not reported by provider 7 

Total number of served census blocks reported by provider 3098 

% of served census blocks confirmed by speed test 1.55% 
 
Form 477Verification: 
Number of census blocks reported to project, but no tract reported to FCC: 138 
Number of tracts reported to FCC, but no census blocks reported to project: 0 
 
Unserved areas: 
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Number of census blocks with unserved areas reported via broadband.maryland.gov: 1 
Total number of unserved areas reported per provider via broadband.maryland.gov: 1 
 
Number or census blocks with unserved areas reported via mdbroadbandmap.org: 2 
Total number of unserved areas reported per provider via mdbroadbandmap.org: 2 
 
Of census blocks reported as served, how many have zero population based on 2000 census 
data?  277/3098 (8.9%) 
 
Web Search Verification: 87/3098 (3%) of census blocks were confirmed using online search 
feature of given provider 

Atlantic WebSearch Verification Table Count Percentage 

Total # of sample points 1496   

Number of sample points with results 1496 100% 

Result is yes and census block is in served area  87 6% 

Result is yes but not in a census block reported as served    116 8% 

Result is no and census block is in served area 2 0% 

Result is no and census block not served area 1289 86% 
 
Census blocks that are outside Cable Franchise Boundary: 842/3098 (27%) 
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Bay Country Communications, Inc. 
DBA Name: Bay Country Communications, Inc. 
 
Data Characteristics 
 
Date of Original Submission:       8/9/2010 
Date of Update Submission:       N/A 
Currency of Data:        December 2010 
FRN:           0020136552 
Type of data submitted:        Census Block Table 
Census Block Count:                          846 
Total Matched Address Points Count:     N/A 
Unmatched Address Points:       N/A 
Number of Technology of Transmission Types:    1 
Provided Max Advertised Download Speed:     Complete 
Provided Max Advertised Upload Speed:      Complete 
Provided Max Typical Download Speed:      Complete 
Provided Max Typical Upload Speed:      Complete 
Provided Middle Mile:        No 
Provided Road Segments for census blocks greater than 2 sq miles: No 
 
Data Processing 
 
Census Block Process: 

 Join the provided census block table to the 2000 census blocks based on the BLK2000 
field  

o Export results  
o Load exported results into the NTIA data model  

 Result: BB_Service_CensusBlock 
 
Data Verification 
 
Maximum down/upload speeds reported by provider:  
Census Blocks 

Max Download Category Count % of Blocks 
 

Max Upload Category Count % of Blocks 

7 846 100% 
 

7 846 100% 

    Typical down/upload speeds reported by provider: 
Census Blocks 

Typical Download Category Count % of Blocks 
 

Typical Upload Category Count % of Blocks 

4 846 100% 
 

2 846 100% 
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Typical down/upload speed from 2010 computer based speed test:  

Speed Test Download Tier Count % of Tests 
 

Speed Test Upload Tier Count % of Tests 

3 1 50% 
 

2 1 50% 

4 1 50% 
 

3 1 50% 
 
Speed tests match reported typical download speeds or are within 1 speed tier: Yes 
 
%/# of census blocks verified by 2010 computer based speed tests:  

Confirmation of census block served 0 

Census blocks served, not reported by provider 2 

Total number of served census blocks reported by provider 846 

% of served census blocks confirmed by speed test 0.00% 
 
Form 477 Verification: 
Number of census blocks reported to project, but no tract reported to FCC: N/A 
Number of tracts reported to FCC, but no census blocks reported to project: N/A 
 
Unserved areas: 
Number of census blocks with unserved areas reported via broadband.maryland.gov: 0 
Total number of unserved areas reported per provider via broadband.maryland.gov: 0 
 
Number of census blocks with unserved areas reported via mdbroadbandmap.org: 0 
Total number of unserved areas reported per provider via mdbroadbandmap.org: 0 
 
Of census blocks reported as served, how many have zero population based on 2000 census 
data?  243/846 (29%) 
 
Web Search Verification: N/A 
 
Census blocks that are outside Cable Franchise Boundary: 144/846 (17%) 
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Believe Wireless, LLC. 
DBA: Believe Wireless Broadband  
 
Data Characteristics 
 
Date of Original Submission:       3/1/2011 
Date of Update Submission:       N/A 
Currency of Data:        December 2010 
FRN:           9999 
Type of data submitted:        Map 
Census Block Count:                      N/A  
Total Matched Address Points Count:     N/A 
Unmatched Address Points:       N/A 
Number of Technology of Transmission Types:    1 
Provided Max Advertised Download Speed:     Complete 
Provided Max Advertised Upload Speed:      Complete 
Provided Max Typical Download Speed:      Complete 
Provided Max Typical Upload Speed:      Complete 
Provided Middle Mile:        No 
Provided Road Segments for census blocks greater than 2 sq miles: No 
 
Data Processing 
 
Coverage Area Process: 

 Technology of transmission and spectrum not provided 
o Technology of transmission selected by comparing similar providers and 

choosing the most likely option 
o Spectrum selected by comparing similar providers providers and choosing the 

most likely option 

 Use raster analysis to extract coverage area from map 

 Repair Geometry on coverage area 

 Remove coverage areas less than 0.125 square miles 

 Remove coverage area “holes” less than 0.125 square miles 

 Simplify Polygon of coverage area 

 Load coverage area into the NTIA data model 
o Result: BB_Service_Wireless 

 
Data Verification 
 
Maximum down/upload speeds reported by provider:  
Coverage Area 

Max Download Category Count % of Area 
 

Max Upload Category Count % of Area 
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11 1 100% 
 

11 1 100% 
 
Typical down/upload speeds reported by provider: 
Coverage Area  

Typical Download Category Count % of Area 
 

Typical Upload Category Count % of Area 

6 1 100% 
 

6 1 100% 
 
 
Typical down/upload speed from 2010 mobile speed test:  
 

Speed Test Download Tier Count % of Tests 
 

Speed Test Upload Tier Count % of Tests 

0 3 75% 
 

1 2 50% 

3 1 25% 
 

2 2 50% 
 
Speed tests match reported typical download speeds or are within 1 speed tier: No 
 
#/% of mobile speed tests verifying coverage area:  
Number of mobile speed tests reported inside coverage area: 4/4 (100%) 
Number of mobile speed tests reported outside coverage area: 0/4 (0%) 
 
Typical down/upload speed from 2010 computer based speed test: 

Speed Test Download Tier Count % of Tests 
 

Speed Test Upload Tier Count % of Tests 

3 2 13% 
 

2 12 80% 

4 2 13% 
 

3 2 13% 

5 11 73% 
 

4 1 7% 
 
Speed tests match reported typical speeds or are within 1 speed tier:   Yes 
 
#/% of computer based speed tests verifying coverage area 
Number of computer based speed tests reported inside coverage area: 15/15 (100.00%) 
Number of computer based speed tests reported outside coverage area: 0/15 (0.00%) 
 
Form 477Verification: 
#/% of tracts reported as served to FCC that overlaps with coverage area: N/A 
#/% of tracts reported as served to FCC but do not intersect coverage area: N/A 
 
Unserved areas: 
Number of unserved areas reported within coverage area via broadband.maryland.gov:  
14/202 (6.9%) 
Number of unserved areas reported within coverage area via mdbroadbandmap.org:  
2/58 (3.5%) 
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Of census blocks reported as served, how many have zero population based on 2000 census 
data? N/A 
 
Web Search Verification: N/A 
 
Wireless Verification: N/A 
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Bloosurf 
DBA: Bloosurf  
 
Data Characteristics 
 
Date of Original Submission:       2/28/2011 
Date of Update Submission:       N/A 
Currency of Data:        December 2010 
FRN:           0019496462 
Type of data submitted:        Map 
Census Block Count:                      N/A  
Total Matched Address Points Count:     N/A 
Unmatched Address Points:       N/A 
Number of Technology of Transmission Types:    1 
Provided Max Advertised Download Speed:     Complete 
Provided Max Advertised Upload Speed:      Complete 
Provided Max Typical Download Speed:      No 
Provided Max Typical Upload Speed:      No 
Provided Middle Mile:        No 
Provided Road Segments for census blocks greater than 2 sq miles: No 
 
Data Processing 
 
Coverage Area Process: 

 Digitize coverage area from map 

 Repair Geometry on coverage area 

 Remove coverage areas less than 0.125 square miles 

 Remove coverage area “holes” less than 0.125 square miles 

 Simplify Polygon of coverage area 

 Load coverage area into the NTIA data model 
o Result: BB_Service_Wireless 

 
Data Verification 
 
Maximum down/upload speeds reported by provider:  
Coverage Area 

Max Download Category Count % of Area 
 

Max Upload Category Count % of Area 

5 1 100% 
 

3 1 100% 
 
Typical down/upload speeds reported by provider: N/A 
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Typical down/upload speed from 2010 mobile speed test:  
 

Speed Test Download Tier Count % of Tests 
 

Speed Test Upload Tier Count % of Tests 

0 28 88% 
 

1 4 13% 

3 3 9% 
 

2 27 84% 

4 1 3% 
 

4 1 3% 
 
Speed tests match reported typical speeds or are within 1 speed tier:   N/A 
 
#/% of mobile speed tests verifying coverage area:  
Number of mobile speed tests reported inside coverage area: N/A 
Number of mobile speed tests reported outside coverage area: N/A 
 
Form 477Verification: 
#/% of tracts reported as served to FCC that overlaps with coverage area: N/A 
#/% of tracts reported as served to FCC but do not intersect coverage area: N/A 
 
Unserved areas: 
Number of unserved areas reported within coverage area via broadband.maryland.gov:  
3/202 (1.5%) 
Number of unserved areas reported within coverage area via mdbroadbandmap.org: 
0/58 (0.0%) 
 
Of census blocks reported as served, how many have zero population based on 2000 census 
data? N/A 
 
Web Search Verification: N/A 
 
Wireless Verification: N/A 
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Broadstripe, LLC 
DBA Name: Broadstripe, LLC 
 
Data Characteristics 
 
Date of Original Submission:       4/14/2010 
Date of Update Submission:       N/A 
Currency of Data:        December 2010 
FRN:           0003773843 
Type of data submitted:        Address Table 
Census Block Count:                      2717   
Total Matched Address Points Count:     104258 
Unmatched Address Points:       231 
Number of Technology of Transmission Types:    1 
Provided Max Advertised Download Speed:     Complete 
Provided Max Advertised Upload Speed:      Complete 
Provided Max Typical Download Speed:      No  
Provided Max Typical Upload Speed:      No  
Provided Middle Mile:        No 
Provided Road Segments for census blocks greater than 2 sq miles: No 
 
Data Processing 
 
Address Table Process: 

 Geocode address table to Maryland Property View address locator 
o Number matched: 103428 
o Number unmatched: 1061 

 Unmatched address are geocoded to Maryland street centerline address locator 
o Number matched: 830 
o Number unmatched: 231 

 Merge matched addresses 

 Spatially join address points to 2000 census blocks 

 Select by location the address points that are completely within a greater than two 
square mile census block 

o Export as address points to be loaded into the NTIA data model 
 Result: BB_Service_Address 

o Switch the selection and export as points to create census blocks 
Census Block Process: 

 Join the switched selection (BB_Service_Address) address points to the 2000 census 
blocks based on the BLK2000 field  

o Export results Load exported results into the NTIA data model  
 Result: BB_Service_CensusBlock 
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Data Verification 
 
Maximum down/upload speeds reported by provider:  
Census Blocks 

Max Download Category Count % of Blocks 
 

Max Upload Category Count % of Blocks 

7 2717 100% 
 

4 2717 100% 
Address Points 

Max Download Category Count % of Points 
 

Max Upload Category Count % of Points 

7 1183 100% 
 

4 1183 100% 
 
Typical down/upload speeds reported by provider: N/A 
 
Typical down/upload speed from 2010 computer based speed test:  
 

Speed Test Download Tier Count % of Tests 
 

Speed Test Upload Tier Count % of Tests 

3.00 3 7% 
 

1.00 3 7% 

4.00 1 2% 
 

2.00 4 9% 

5.00 8 19% 
 

3.00 5 12% 

6.00 13 30% 
 

4.00 31 72% 

7.00 18 42% 
     

Speed tests match reported typical download speeds or are within 1 speed tier:  N/A 
 
%/# of census blocks verified by 2010 computer based speed tests:  

Confirmation of census block served 27 

Census blocks served, not reported by provider 1 

Total number of served census blocks reported by provider 2717 

% of served census blocks confirmed by speed test 0.9937% 
 
Form477 Verification: 
Number of census blocks reported to project, but no tract reported to FCC: 13 
Number of tracts reported to FCC, but no census blocks reported to project: 1 
 
Unserved areas: 
Number of census blocks with unserved areas reported via broadband.maryland.gov: 0 
Total number of unserved areas reported per provider via broadband.maryland.gov: 0 
 
Number of census blocks with unserved areas reported via mdbroadbandmap.org: 0 
Total number of unserved areas reported per provider via mdbroadbandmap.org: 0 
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Of census blocks reported as served, how many have zero population based on 2000 census 
data? 187/2721 (7%) 
 
Web Search Verification:  17/2721 (1%) of census blocks were confirmed using online search 
feature of given provider 

Broadstripe Web Search Verification Table Count Percentage 

Total # of sample points 1496   

Number of sample points with results 85 6% 

Result is yes and census block is in served area  17 20% 

Result is yes but not in a census block reported as served    15 18% 

Result is no and census block is in served area 0 0% 

Result is no and census block not served area 53 62% 
 
Census blocks that are outside Cable Franchise Boundary: 151/2721 (6%) 
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Broadview Networks Holdings, Inc. 
DBA Name: Broadview Networks Holdings, Inc. 
 
Data Characteristics 
 
Date of Original Submission:       2/24/2010 
Date of Update Submission:       7/27/2010 
Currency of Data:        December 2010 
FRN:           0010296853 
Type of data submitted:        Address Table 
Census Block Count:                     590   
Total Matched Address Points Count:     797 
Unmatched Address Points:       14 
Number of Technology of Transmission Types:    3 
Provided Max Advertised Download Speed:     Incomplete 
Provided Max Advertised Upload Speed:      Complete 
Provided Max Typical Download Speed:      No  
Provided Max Typical Upload Speed:      No  
Provided Middle Mile:        No 
Provided Road Segments for census blocks greater than 2 sq miles: No 
 
Data Processing 
 
Address Table Process: 

 Geocode address table to Maryland Property View address locator 
o Number matched: 789 
o Number unmatched: 22 

 Unmatched address are geocoded to Maryland street centerline address locator 
o Number matched: 8 
o Number unmatched: 14 

 Merge matched addresses 

 Spatially join address points to 2000 census blocks 

 Separate and export the address points according to technology of transmission  

 Select by location the address points that are completely within a greater than two 
square mile census block 

o Export as address points to be loaded into the NTIA data model 
 Result: BB_Service_Address 

o Switch the selection and export as points to create census blocks 
Census Block Process: 

 Join the switched selection (BB_Service_Address) address points to the 2000 census 
blocks based on the BLK2000 field  

o Export results for each technology of transmission 
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o Load exported results into the NTIA data model  
 Result: BB_Service_CensusBlock 

Speed Domains: 

 9 Symmetric DSL blocks with Maximum Advertised Upstream < tier 3 
o Maximum Advertised Upstream calculated to 3 

 3 Other Copper Wireline with Maximum Advertised Downstream < tier 3 
o Maximum Advertised Downstream calculated to 3 

 2 Other Copper Wireline with Maximum Advertised Upstream < tier 2 
o Maximum Advertised Upstream calculated to 2 

 
Data Verification 
 
Maximum down/upload speeds reported by provider:  
Census blocks 

Max Download Category Count % of Blocks 
 

Max Upload Category Count % of Blocks 

2 3 1% 
 

1 4 1% 

3 7 1% 
 

2 84 14% 

4 470 83% 
 

3 19 3% 

5 75 13% 
 

4 439 71% 

6 9 2% 
 

5 63 10% 

    
6 8 1% 

Address Points 

Max Download Category Count % of Points 
 

Max Upload Category Count % of Points 

4 4 67% 
 

3 1 14% 

5 2 33% 
 

4 4 57% 

    
5 2 29% 

 
Typical down/upload speeds reported by provider: N/A 
 
Typical down/upload speed from 2010 computer based speed test:  

Speed Test Download Tier Count % of Tests 
 

Speed Test Upload Tier Count % of Tests 

3 1 100% 
 

3 1 100% 
 
Speed tests match reported typical download speeds or are within 1 speed tier:  N/A 
 
%/# of census blocks verified by 2010 computer based speed tests:  

Confirmation of census block served 1 

Census blocks served, not reported by provider 0 

Total number of served census blocks reported by provider 590 

% of served census blocks confirmed by speed test 0.17% 
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Form 477Verification: 
Number of census blocks reported to project, but no tract reported to FCC: 65 
Number of tracts reported to FCC, but no census blocks reported to project: 71 
 
Unserved areas: 
Number of census blocks with unserved areas reported via broadband.maryland.gov: 2 
Total number of unserved areas reported per provider via broadband.maryland.gov: 2 
 
Number of census blocks with unserved areas reported via mdbroadbandmap.org: 2 
Total number of unserved areas reported per provider via mdbroadbandmap.org: 2 
 
Of census blocks reported as served, how many have zero population based on 2000 census 
data?  204/590 (35%) 
 
Web Search Verification: N/A 
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Brookwood Ventures LLC 
DBA Name: Brookwood Ventures LLC 
 
Data Characteristics 
 
Date of Original Submission:       3/12/2010 
Date of Update Submission:       N/A 
Currency of Data:        March 2010 
FRN:           0010296853 
Type of data submitted:        Coverage Area 
Census Block Count:                      N/A   
Total Matched Address Points Count:     N/A 
Unmatched Address Points:       N/A 
Number of Technology of Transmission Types:    1 
Provided Max Advertised Download Speed:     Complete 
Provided Max Advertised Upload Speed:      Complete 
Provided Max Typical Download Speed:      No  
Provided Max Typical Upload Speed:      No  
Provided Middle Mile:        No 
Provided Road Segments for census blocks greater than 2 sq miles: No 
 
Data Processing 
 
Coverage Area Process: 

 Repair Geometry on delivered coverage area 

 Perform Topology on coverage area 
o Rule: Coverage area should not overlap 
o Load coverage area into the NTIA data model 

 Result: BB_Service_Wireless 
 
Data Verification 
 
Maximum down/upload speeds reported by provider:  

Max Download Category Count % of Area 
 

Max Upload Category Count % of Area 

5 1 100% 
 

3 1 100% 
 
Typical down/upload speeds reported by provider: N/A 
 
Typical down/upload speed from 2010 mobile speed test: N/A 
 
Speed tests match reported typical download speeds or are within 1 speed tier:  N/A 
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#/% of mobile speed tests verifying coverage area: 
Number of mobile speed tests reported inside coverage area: N/A 
Number of mobile speed tests reported outside coverage area: N/A 
 
Form 477 Verification: 
#/% of tracts reported as served to FCC that overlaps with coverage area: 2/2 
#/% of tracts reported as served to FCC but do not intersect coverage area: 0/2 
 
Unserved areas: 
Number of unserved areas reported within coverage area via broadband.maryland.gov:  
0/202 (0%) 
Number of unserved areas reported within coverage area via mdbroadbandmap.org: 
0/58 (0%) 
 
Of census blocks reported as served, how many have zero population based on 2000 census 
data? N/A 
 
Web Search Verification: N/A 
 
Wireless Verification: N/A 
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Cellco Partnership and its Affiliated Entities 
DBA Name: Verizon Wireless  
 
Data Characteristics 
 
Date of Original Submission:       3/8/2010 
Date of Update Submission:       1/31/2011 
Currency of Data:        December 2010 
FRN:           0003290673 
Type of data submitted:        Coverage Area 
Census Block Count:                     N/A   
Total Matched Address Points Count:     N/A 
Unmatched Address Points:       N/A 
Number of Technology of Transmission Types:    1 
Provided Max Advertised Download Speed:     Complete 
Provided Max Advertised Upload Speed:      Complete 
Provided Max Typical Download Speed:      Complete 
Provided Max Typical Upload Speed:      Complete 
Provided Middle Mile:        No 
Provided Road Segments for census blocks greater than 2 sq miles: No 
 
Data Processing 
 
Coverage Area Process: 

 Repair Geometry on delivered coverage area 

 Remove coverage areas less than 0.125 square miles 

 Remove coverage area “holes” less than 0.125 square miles 

 Simplify Polygon of coverage area 

 Load coverage area into the NTIA data model 
o Result: BB_Service_Wireless 

 
Data Verification 
Maximum down/upload speeds reported by provider:  

Max Download Category Count % of Area 
 

Max Upload Category Count % of Area 

5 3 100% 
 

4 3 100% 

6 1 100% 
 

5 1 100% 
 
Typical down/upload speeds reported by provider: 

Typical Download Category Count % of Area 
 

Typical Upload Category Count % of Area 

2 3 100% 
 

2 3 100% 

6 1 100% 
 

5 1 100% 
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Typical down/upload speed from 2010 mobile speed test:  
 

Speed Test Download Tier Count % of Tests 
 

Speed Test Upload Tier Count % of Tests 

0 1078 50% 
 

1 442 21% 

3 600 28% 
 

2 1382 64% 

4 459 21% 
 

3 273 13% 

5 3 0% 
 

4 21 1% 

6 1 0% 
 

5 2 0% 

7 2 0% 
 

6 2 0% 

    
7 6 0% 

    
8 15 1% 

 
Speed tests match reported typical download speeds or are within 1 speed tier:  No 
 
#/% of mobile speed tests verifying coverage area:  
Number of mobile speed tests reported inside coverage area: 2055/2143 (95.9%) 
Number of mobile speed tests reported outside coverage area: 88/2143 (4.1%) 
 
Typical down/upload speed from 2010 computer based speed test: 
 

Speed Test Download Tier Count % of Tests 
 

Speed Test Upload Tier Count % of Tests 

0 47 53% 
 

1 19 22% 

3 29 33% 
 

2 67 76% 

4 12 14% 
 

3 1 1% 

    
4 1 1% 

 
Speed tests match reported typical download speeds or are within 1 speed tier: No 
 
#/% of computer based speed tests verifying coverage area: 
Number of computer based speed tests reported inside coverage area: 88/88 (100.00%) 
Number of computer based speed tests reported outside coverage area: 0/88 (0.00%) 
 
Form 477 Verification: 
#/% of tracts reported as served to FCC that overlaps with coverage area: N/A 
#/% of tracts reported as served to FCC but do not intersect coverage area: N/A 
 
Unserved areas: 
Number of unserved areas reported within coverage area via broadband.maryland.gov:  
173/202 (85.6%) 
Number of unserved areas reported within coverage area via mdbroadbandmap.org: 
51/58 (87.9%) 
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Web Search Verification: N/A 
 
Of census blocks reported as served, how many have zero population based on 2000 census 
data? N/A 
 
Wireless Verification:  

Verizon Wireless Verification Table Count Percentage 

Total # of sample points 1466   

Number of sample points with results 1152 78.6% 

Verified served AND BSP says served   (yes,yes) 1058 91.8% 

Verified served AND BSP says unserved   (yes,no) 94 8.2% 

Verified unserved AND BSP says served   (no,yes) 153 10.4% 

Verified unserved AND BSP says unserved   (no,no) 161 11.0% 
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Charter Communications Inc 
DBA Name: Charter Communications Inc 
 
Data Characteristics 
 
Date of Original Submission:       3/31/2010 
Date of Update Submission:       2/17/2011 
Currency of Data:        January 2011 
FRN:           0017179383 
Type of data submitted:        Census Block Table 
Census Block Count:                      268   
Total Matched Address Points Count:     N/A 
Unmatched Address Points:       N/A 
Number of Technology of Transmission Types:    2 
Provided Max Advertised Download Speed:     Complete 
Provided Max Advertised Upload Speed:      Complete 
Provided Max Typical Download Speed:      Complete 
Provided Max Typical Upload Speed:      Complete 
Provided Middle Mile:        No 
Provided Road Segments for census blocks greater than 2 sq miles: Yes 
 
Data Processing 
 
Census Block Process: 

 Join the switched selection (BB_Service_Address) address points to the 2000 census 
blocks based on the BLK2000 field  

o Export results  
o Load exported results into the NTIA data model  

 Result: BB_Service_CensusBlock 
 
Data Verification 
 
Maximum down/upload speeds reported by provider:  
Census Blocks 

Max Download Category Count % of Blocks 
 

Max Upload Category Count % of Blocks 

6 268 100% 
 

3 268 100% 
 
Road Segments 

Max Download Category Count 
% of Road 
Segments 

 
Max Upload Category Count 

% of Road 
Segments 

6 280 100% 
 

3 280 100% 
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Typical down/upload speeds reported by provider: 
Road Segments 
Typical Download 
Category Count % of Road Segments 

 

Typical Upload 
Category Count % of Road Segments 

6 280 100% 
 

3 280 100% 
 
Typical down/upload speed from 2010 computer based speed test:  

Speed Test Download Tier Count % of Tests 
 

Speed Test Upload Tier Count % of Tests 

7 4 100% 
 

3 4 100% 
 
Speed tests match reported typical download speeds or are within 1 speed tier:   Yes 
 
%/# of census blocks verified by 2010 computer based speed tests:  

Confirmation of census block served 1 

Census blocks served, not reported by provider 1 

Total number of served census blocks reported by provider 268 

% of served census blocks confirmed by speed test 0.3731% 
 
Form477 Verification: 
Number of census blocks reported to project, but no tract reported to FCC: 0 
Number of tracts reported to FCC, but no census blocks reported to project: 0 
 
Unserved areas: 
Number of census blocks with unserved areas reported via broadband.maryland.gov: 0 
Total number of unserved areas reported per provider via broadband.maryland.gov: 0 
 
Number of census blocks with unserved areas reported via mdbroadbandmap.org: 0 
Total number of unserved areas reported per provider via mdbroadbandmap.org: 0 
 
Of census blocks reported as served, how many have zero population based on 2000 census 
data?  100/268(37%) 
 
Web Search Verification: 2/268 (0.8%) of census blocks were confirmed using online search 
feature of given provider 

Charter Web Search Verification Table Count Percentage 

Total # of sample points 1496   

Number of sample points with results 55 4% 

Result is yes and census block is in served area  2 4% 

Result is yes but not in a census block reported as served    0 0% 

Result is no and census block is in served area 3 5% 

Result is no and census block not served area 50 91% 
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Census blocks that are outside Cable Franchise Boundary: 110/268 (41%) 
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Clearwire Corporation 
DBA Name: Clearwire Corporation 
 
Data Characteristics 
 
Date of Original Submission:       3/5/2010 
Date of Update Submission:       2/24/2011 
Currency of Data:        December 2010 
FRN:           0017775628 
Type of data submitted:        Coverage Area 
Census Block Count:                      N/A   
Total Matched Address Points Count:     N/A 
Unmatched Address Points:       N/A 
Number of Technology of Transmission Types:    1 
Provided Max Advertised Download Speed:     Complete 
Provided Max Advertised Upload Speed:      Complete 
Provided Max Typical Download Speed:      Complete 
Provided Max Typical Upload Speed:      Complete 
Provided Middle Mile:        No 
Provided Road Segments for census blocks greater than 2 sq miles: No 
 
Data Processing 
 
Coverage Area Process: 

 Repair Geometry on delivered coverage area 

 Remove coverage areas less than 0.125 square miles 

 Remove coverage area “holes” less than 0.125 square miles 

 Simplify Polygon of coverage area 

 Load coverage area into the NTIA data model 
o Result: BB_Service_Wireless 

 
Data Verification 
 
Maximum down/upload speeds reported by provider:  

Max Download Category Count % of Area 
 

Max Upload Category Count % of Area 

6 1 100% 
 

4 1 100% 
 
Typical down/upload speeds reported by provider: 

Typical Download Category Count % of Area 
 

Typical Upload Category Count % of Area 

6 1 100% 
 

4 1 100% 
  
 



Maryland Broadband Mapping Initiative:  Verification/Validation Report 

April 1, 2011 

 

Salisbury University  www.mdbroadbandmap.org  
Page 55  

  

 
Typical down/upload speed from 2010 mobile speed test:  

Speed Test Download Tier Count % of Tests 
 

Speed Test Upload Tier Count % of Tests 

3 2 67% 
 

2 1 33% 

4 1 33% 
 

3 2 67% 
 
Speed tests match reported typical download speeds or are within 1 speed tier:   No 
 
#/% of mobile speed tests verifying coverage area:  
Number of mobile speed tests reported inside coverage area: 3/3 (100.0%) 
Number of mobile speed tests reported outside coverage area: 0/3 (0.0%) 
 
Typical down/upload speed from 2010 computer based speed test: 

Speed Test Download Tier Count % of Tests 
 

Speed Test Upload Tier Count % of Tests 

0 3 6% 
 

2 17 33% 

3 10 20% 
 

3 34 67% 

4 5 10% 
 

      

5 24 47% 
    6 8 16% 
    7 1 2% 
     

Speed tests match reported typical download speeds or are within 1 speed tier: Yes 
 
#/% of computer based speed tests verifying coverage area: 
Number of computer based speed tests reported inside coverage area: 50/51 (98.04%) 
Number of computer based speed tests reported outside coverage area: 1/51 (1.96%) 
 
Form 477Verification: 
#/% of tracts reported as served to FCC that overlaps with coverage area: N/A 
#/% of tracts reported as served to FCC but do not intersect coverage area: N/A 
 
Unserved areas: 
Number of unserved areas reported within coverage area via broadband.maryland.gov:  
28/202 (13.9%) 
Number of unserved areas reported within coverage area via mdbroadbandmap.org:  
3/58 (5.2%) 
 
Of census blocks reported as served, how many have zero population based on 2000 census 
data? N/A 
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Web Search Verification:  

Clearwire Web Search Verification Table Count Percentage 

Total # of sample points 1496   

Number of sample points with results 354 24% 

Result is yes and coverage area is in served area  128 36% 

Result is yes but not in a coverage area reported as served    19 5% 

Result is no and coverage area is in served area 2 1% 

Result is no and coverage area is not in served area 205 58% 
 
Wireless Verification: N/A 
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Cogent Communications Group 
DBA Name: Cogent Communications Group 
 
Data Characteristics 
 
Date of Original Submission:       2/1/2010 
Date of Update Submission:       N/A 
Currency of Data:        January 2011 
FRN:           0019066034 
Type of data submitted:        Address Table 
Census Block Count:                     3   
Total Matched Address Points Count:     3 
Unmatched Address Points:       3 
Number of Technology of Transmission Types:    1 
Provided Max Advertised Download Speed:     Complete 
Provided Max Advertised Upload Speed:      Complete 
Provided Max Typical Download Speed:      No  
Provided Max Typical Upload Speed:      No  
Provided Middle Mile:        Yes 
Provided Road Segments for census blocks greater than 2 sq miles: No 
 
Data Processing 
 
Address Table Process: 

 Geocode address table to Maryland Property View address locator 
o Number matched: 3 
o Number unmatched: 3 

 Spatially join address points to 2000 census blocks 

 Select by location the address points that are completely within a greater than two 
square mile census block 

o Export as address points to be joined to census blocks 
Census Block Process: 

 Join the address points to the 2000 census blocks based on the BLK2000 field  
o Export results  
o Load exported results into the NTIA data model  

 Result: BB_Service_CensusBlock 
 
Data Verification 
 
Maximum down/upload speeds reported by provider:  
Census Blocks 

Max Download Category Count % of Blocks 
 

Max Upload Category Count % of Blocks 
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11 3 100% 
 

11 3 100% 
 
Typical down/upload speeds reported by provider: N/A 
 
Typical down/upload speed from 2010 computer based speed test: N/A 

  Speed tests match reported typical download speeds or are within 1 speed tier:  N/A 
 
%/# of census blocks verified by 2010 computer based speed tests: N/A 
 
Form477 Verification: 
Number of census blocks reported to project, but no tract reported to FCC: 0 
Number of tracts reported to FCC, but no census blocks reported to project: 3 
 
Unserved areas: 
Number of census blocks with unserved areas reported via broadband.maryland.gov: 0 
Total number of unserved areas reported per provider via broadband.maryland.gov: 0 
 
Number of census blocks with unserved areas reported via mdbroadbandmap.org: 0 
Total number of unserved areas reported per provider via mdbroadbandmap.org: 0 
 
Of census blocks reported as served, how many have zero population based on 2000 census 
data? 3/3 (100%) 
 
Web Search Verification: N/A 
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Comcast Corporation 
DBA Name: Comcast Cable Communications, LLC 
 
Data Characteristics 
 
Date of Original Submission:       1/19/2010 
Date of Update Submission:       3/7/2011 
Currency of Data:        December 2010 
FRN:           0004441663 
Type of data submitted:        Census Block Table 
Census Block Count:                     48360   
Total Matched Address Points Count:     N/A 
Unmatched Address Points:       N/A 
Number of Technology of Transmission Types:    2 
Provided Max Advertised Download Speed:     Complete 
Provided Max Advertised Upload Speed:      Complete 
Provided Max Typical Download Speed:      Partial  
Provided Max Typical Upload Speed:      Partial  
Provided Middle Mile:        Yes 
Provided Road Segments for census blocks greater than 2 sq miles: Yes 
 
Data Processing 
 
Census Block Process: 

 Join the census block table to the 2000 census blocks based on the BLK2000 field  
o Export results for each technology of transmission 
o Load exported results into the NTIA data model  

 Result: BB_Service_CensusBlock 
 
Data Verification 
 
Maximum down/upload speeds reported by provider:  
Census blocks 

Max Download Category Count % of Blocks 
 

Max Upload Category Count % of Blocks 

9 48360 100% 
 

7 48360 100% 
 
Typical down/upload speeds reported by provider:  

Typical Download Category Count % of Blocks 

6 48183 100% 
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Typical down/upload speed from 2010 computer based speed test: 

Speed Test Download Tier Count % of Tests   Speed Test Upload Tier Count % of Tests 

0 36 1%   1 23 1% 

3 66 2%   2 95 3% 

4 76 2%   3 172 5% 

5 236 7%   4 663 20% 

6 405 13%   5 2169 67% 

7 2210 68%   6 105 3% 

8 185 6%   7 8 0% 

9 17 1% 
    10 4 0% 
      

Speed tests match reported typical download speeds or are within 1 speed tier:  Yes 
 
%/# of census blocks verified by 2010 computer based speed tests:  

Confirmation of census block served 1612 

Census blocks served, not reported by provider 62 

Total number of served census blocks reported by provider 48360 

% of served census blocks confirmed by speed test 3.33% 
 
Form477 Verification: 
Number of census blocks reported to project, but no tract reported to FCC: 46 
Number of tracts reported to FCC, but no census blocks reported to project: 1 
 
Unserved areas: 
Number of census blocks with unserved areas reported via broadband.maryland.gov: 75 
Total number of unserved areas reported per provider via broadband.maryland.gov: 115 
 
Number of census blocks with unserved areas reported via mdbroadbandmap.org: 17 
Total number of unserved areas reported per provider via mdbroadbandmap.org: 23 
 
Of census blocks reported as served, how many have zero population based on 2000 census 
data?  4019/48360 (8%) 
 
Web Search Verification:  
440/48360 (1%) of census blocks were confirmed using online search feature of given provider 

Comcast WebSearch Verification Table Count Percentage 

Total # of sample points 1496   

Number of sample points with results 835 56% 

Result is yes and census block is in served area  440 53% 

Result is yes but not in a census block reported as served    63 8% 
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Result is no and census block is in served area 137 16% 

Result is no and census block not served area 194 23% 
 
Census blocks that are outside Cable Franchise Boundary: 5755/48360 (12%) 
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DIECA Communications, Inc. 
DBA: Covad Communication Company 
 
Data Characteristics 
 
Date of Original Submission:       2/1/2010 
Date of Update Submission:       3/11/2011 
Currency of Data:        December 2010 
FRN:           0003753753 
Type of data submitted:        Census Block Table 
Census Block Count:                      42147   
Total Matched Address Points Count:     N/A 
Unmatched Address Points:       N/A 
Number of Technology of Transmission Types:    3 
Provided Max Advertised Download Speed:     Complete 
Provided Max Advertised Upload Speed:      Complete 
Provided Max Typical Download Speed:      Complete 
Provided Max Typical Upload Speed:      Complete 
Provided Middle Mile:        Yes 
Provided Road Segments for census blocks greater than 2 sq miles: Yes 
 
Data Processing 

 
Census Block Process: 

 Join the census block table to the 2000 census blocks based on the BLK2000 field  
o Export results for each technology of transmission 
o Load exported results into the NTIA data model  

 Result: BB_Service_CensusBlock 
 
Data Verification 
 
Maximum down/upload speeds reported by provider: 
Census Blocks 

Max Download Category Count % of Blocks 
 

Max Upload Category Count % of Blocks 

3 6513 7% 
 

                                      7 48360 49% 

4 17323 18% 
    5 43778 44% 
    6 19125 19% 
    7 11949 12% 
     

 
 

      



Maryland Broadband Mapping Initiative:  Verification/Validation Report 

April 1, 2011 

 

Salisbury University  www.mdbroadbandmap.org  
Page 63  

  

 
Road Segments 

Max Download Category Count 
% of Road 
Segments 

 
Max Upload Category Count 

% of Road 
Segments 

3 52 2% 
 

2 154 4% 

4 218 6% 
 

3 385 11% 

5 2850 83% 
 

4 83 2% 

6 236 7% 
 

5 2786 81% 

7 91 3% 
 

7 39 1% 
 
 
Typical down/upload speeds reported by provider: 
Census Blocks 

Typical Download Category Count % of Blocks 
 

Typical Upload Category Count % of Blocks 
3 11541 12% 

 
2 27629 28% 

4 14278 14% 
 

3 8181 8% 
5 60920 62% 

 
4 12295 12% 

7 11949 12% 
 

5 41795 42% 

   
  7 8788 9% 

 
Road Segments 

Typical Download Category Count 
% of Road 
Segments 

 

Typical Upload 
Category Count 

% of Road 
Segments 

3 187 5% 
 

2 487 14% 
4 147 4% 

 
3 52 2% 

5 3022 88% 
 

4 83 2% 
7 91 3% 

 
5 2786 81% 

    
7 39 1% 

 
Typical down/upload speed from 2010 computer based speed test:  

Speed Test Download Tier Count % of Tests   Speed Test Upload Tier Count % of Tests 

0 5 8%   1 11 18% 

3 11 18%   2 18 30% 

4 8 13%   4 1 2% 

5 4 7%         

6 2 3%         
 
Speed tests match reported typical speeds or are within 1 speed tier:   No 
 
 %/# of census blocks verified by 2010 computer based speed tests:  

Confirmation of census block served 16 

Census blocks served, not reported by provider 0 



Maryland Broadband Mapping Initiative:  Verification/Validation Report 

April 1, 2011 

 

Salisbury University  www.mdbroadbandmap.org  
Page 64  

  

Total number of served census blocks reported by provider 42147 

% of served census blocks confirmed by speed test 0.04% 
 
Form477 Verification: 
Number of census blocks reported to project, but no tract reported to FCC: 3803 
Number of tracts reported to FCC, but no census blocks reported to project: 0 
 
Unserved areas: 
Number of census blocks with unserved areas reported via broadband.maryland.gov: 44 
Total number of unserved areas reported per provider via broadband.maryland.gov: 52 
 
Number of census blocks with unserved areas reported via mdbroadbandmap.org: 5 
Total number of unserved areas reported per provider via mdbroadbandmap.org: 6 
 
Of census blocks reported as served, how many have zero population based on 2000 census 
data?  7908/42147 (19%) 
 
Web Search Verification: N/A 
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DSLnet Communications, LLC 
DBA Name: DSLnet Communications, LLC 
 
Data Characteristics 
 
Date of Original Submission:       3/11/2010 
Date of Update Submission:       N/A 
Currency of Data:        December 2010 
FRN:           0004324857 
Type of data submitted:        Address Table 
Census Block Count:                      422   
Total Matched Address Points Count:     855 
Unmatched Address Points:       28 
Number of Technology of Transmission Types:    3 
Provided Max Advertised Download Speed:     Complete 
Provided Max Advertised Upload Speed:      Complete 
Provided Max Typical Download Speed:      No 
Provided Max Typical Upload Speed:      No 
Provided Middle Mile:        No 
Provided Road Segments for census blocks greater than 2 sq miles: No 
 
Data Processing 
 
Address Table Process: 

 Geocode address table to Maryland Property View address locator 
o Number matched: 826 
o Number unmatched: 57 

 Unmatched address are geocoded to Maryland street centerline address locator 
o Number matched: 29 
o Number unmatched: 28 

 Merge matched addresses 

 Spatially join address points to 2000 census blocks 

 Separate and export the address points according to technology of transmission  

 Select by location the address points that are completely within a greater than two 
square mile census block 

o Export as address points to be loaded into the NTIA data model 
 Result: BB_Service_Address 

o Switch the selection and export as points to create census blocks 
Census Block Process: 

 Join the switched selection (BB_Service_Address) address points to the 2000 census 
blocks based on the BLK2000 field  

o Export results for each technology of transmission 
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o Load exported results into the NTIA data model  
 Result: BB_Service_CensusBlock 

 
Data Verification 
 
Maximum down/upload speeds reported by provider:  
Census blocks 

Max Download Category Count % of Blocks 
 

Max Upload Category Count % of Blocks 

3 102 24% 
 

2 1 0% 

4 315 75% 
 

3 102 24% 

5 4 1% 
 

4 315 75% 

8 1 0% 
 

5 3 1% 

    
8 1 0% 

Address points 

Max Download Category Count % of Points 
 

Max Upload Category Count % of Points 

3 2 12% 
 

1 2 12% 

5 15 88% 
 

2 15 88% 
 
Typical down/upload speeds reported by provider: N/A 
 
Typical down/upload speed from 2010 computer based speed test: N/A 
 
Speed tests match reported typical speeds or are within 1 speed tier:  N/A 
 
%/# of census blocks verified by 2010 computer based speed tests: N/A 
 
Form477 Verification: 
Number of census blocks reported to project, but no tract reported to FCC: N/A 
Number of tracts reported to FCC, but no census blocks reported to project: N/A 
 
Unserved areas: 
Number of census blocks with unserved areas reported via broadband.maryland.gov: 0 
Total number of unserved areas reported per provider via broadband.maryland.gov: 0 
 
Number of census blocks with unserved areas reported via mdbroadbandmap.org: 0 
Total number of unserved areas reported per provider via mdbroadbandmap.org: 0 
 
Of census blocks reported as served, how many have zero population based on 2000 census 
data? 137/422 (32.5%) 
 
Web Search Verification: N/A 
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Census blocks that are outside DSL boundary:  20/422 (5%) 
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DSLnet, Inc  
DBA: DSLnet, Inc 
 
Data Characteristics 
 
Date of Original Submission:       3/11/2010 
Date of Update Submission:       N/A 
Currency of Data:        December 2010 
FRN:           0015321136 
Type of data submitted:        Census Blocks Table 
Census Block Count:                     32   
Total Matched Address Points Count:     64 
Unmatched Address Points:       1 
Number of Technology of Transmission Types:    2 
Provided Max Advertised Download Speed:     Complete 
Provided Max Advertised Upload Speed:      Complete 
Provided Max Typical Download Speed:      No  
Provided Max Typical Upload Speed:      No  
Provided Middle Mile:        No 
Provided Road Segments for census blocks greater than 2 sq miles: No 
 
Data Processing 
 
Address Table Process: 

 Geocode address table to Maryland Property View address locator 
o Number matched: 63 
o Number unmatched: 2 

 Unmatched address are geocoded to Maryland street centerline address locator 
o Number matched: 1 
o Number unmatched: 1 

 Merge matched addresses 

 Spatially join address points to 2000 census blocks 

 Separate and export the address points according to technology of transmission  

 Select by location the address points that are completely within a greater than two 
square mile census block 

o Export as address points to be loaded into the NTIA data model 
 Result: BB_Service_Address 

o Switch the selection and export as points to create census blocks 
Census Block Process: 

 Join the switched selection (BB_Service_Address)address points to the 2000 census 
blocks based on the BLK2000 field  

o Export results for each technology of transmission 
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o Load exported results into the NTIA data model  
 Result: BB_Service_CensusBlock 

 
Data Verification 
 
Maximum down/upload speeds reported by provider: 
Census Blocks 

Max Download Category Count % of Blocks 
 

Max Upload Category Count % of Blocks 

3 14 44% 
 

2 1 3% 

4 17 53% 
 

3 13 41% 

8 1 3% 
 

4 17 53% 

      
 

8 1 3% 
 
Typical down/upload speeds reported by provider: N/A 
 
Typical down/upload speed from 2010 computer based speed test: N/A 
 
Speed tests match reported typical download speeds or are within 1 speed tier:  N/A 
 
%/# of census blocks verified by 2010 computer based speed tests: N/A 
 
Form477 Verification: 
Number of census blocks reported to project, but no tract reported to FCC: 1 
Number of tracts reported to FCC, but no census blocks reported to project: 197 
 
Unserved areas: 
Number of census blocks with unserved areas reported via broadband.maryland.gov: 0 
Total number of unserved areas reported per provider via broadband.maryland.gov: 0 
 
Number of census blocks with unserved areas reported via mdbroadbandmap.org: 0 
Total number of unserved areas reported per provider via mdbroadbandmap.org: 0 
 
Of census blocks reported as served, how many have zero population based on 2000 census 
data? 13/32 (41%) 
 
Web Search Verification: N/A 
 
Census blocks that are outside DSL boundary:  5/32 (16%) 
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Easton Utilities Commission 
DBA Name: Easton Utilities Commission 
 
Data Characteristics 
 
Date of Original Submission:       2/5/2010 
Date of Update Submission:       N/A 
Currency of Data:        December 2010 
FRN:           0003793726 
Type of data submitted:        Address Table 
Census Block Count:                      373   
Total Matched Address Points Count:     4688 
Unmatched Address Points:       3 
Number of Technology of Transmission Types:    1 
Provided Max Advertised Download Speed:     Complete 
Provided Max Advertised Upload Speed:      Complete 
Provided Max Typical Download Speed:      No  
Provided Max Typical Upload Speed:      No  
Provided Middle Mile:        No 
Provided Road Segments for census blocks greater than 2 sq miles: No 
 
Data Processing 
 
Address Table Process: 

 Geocode address table to Maryland Property View address locator 
o Number matched: 4554 
o Number unmatched: 137 

 Unmatched address are geocoded to Maryland street centerline address locator 
o Number matched: 134 
o Number unmatched: 3 

 Merge matched addresses 

 Spatially join address points to 2000 census blocks 

 Select by location the address points that are completely within a greater than two 
square mile census block 

o Export as address points to be loaded into the NTIA data model 
 Result: BB_Service_Address 

o Switch the selection and export as points to create census blocks 
Census Block Process: 

 Join the switched selection (BB_Service_Address) address points to the 2000 census 
blocks based on the BLK2000 field  

o Load exported results into the NTIA data model  
 Result: BB_Service_CensusBlock 
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Data Verification 
 
Maximum down/upload speeds reported by provider:  
Census Blocks 

Max Download Category Count % of Blocks 
 

Max Upload Category Count % of Blocks 

3 199 53% 
 

2 350 94% 

5 174 47% 
 

3 20 5% 

    
4 3 1% 

 
Typical down/upload speeds reported by provider: N/A 
 
Typical down/upload speed from 2010 computer based speed test:  

Speed Test Download Tier Count % of Tests   Speed Test Upload Tier Count % of Tests 

0 4 8%   1 10 19% 

3 8 15%   2 38 73% 

4 7 13%   3 3 6% 

5 30 58%   5 1 2% 

6 1 2% 
    8 1 2% 
    10 1 2% 
     

Speed tests match reported typical download speeds or are within 1 speed tier:  N/A 
 
%/# of census blocks verified by 2010 computer based speed tests:  

Confirmation of census block served 13 

Census blocks served, not reported by provider 1 

Total number of served census blocks reported by provider 373 

% of served census blocks confirmed by speed test 3.49% 
 
Form477 Verification: 
Number of census blocks reported to project, but no tract reported to FCC: 7 
Number of tracts reported to FCC, but no census blocks reported to project: 0 
 
Unserved areas: 
Number of census blocks with unserved areas reported via broadband.maryland.gov: 0 
Total number of unserved areas reported per provider via broadband.maryland.gov: 0 
 
Number of census blocks with unserved areas reported via mdbroadbandmap.org: 0 
Total number of unserved areas reported per provider via mdbroadbandmap.org: 0 
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Of census blocks reported as served, how many have zero population based on 2000 census 
data?  34/373 (9%) 
 
Web Search Verification: N/A 
 
Census blocks that are outside Cable Franchise Boundary: 3/373 (1%) 
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FiberLight LLC 
DBA Name:  FiberLight LLC 
 
Data Characteristics 
 
Date of Original Submission:       March 2010 
Date of Update Submission:       N/A 
Currency of Data:        March 2010 
FRN:           0014117139 
Type of data submitted:        Census Block Table 
Census Block Count:                      574   
Total Matched Address Points Count:     N/A 
Unmatched Address Points:       N/A 
Number of Technology of Transmission Types:    1 
Provided Max Advertised Download Speed:     Complete 
Provided Max Advertised Upload Speed:      Complete 
Provided Max Typical Download Speed:      No  
Provided Max Typical Upload Speed:      No  
Provided Middle Mile:        No 
Provided Road Segments for census blocks greater than 2 sq miles: No 
 
Data Processing 
 
Census Block Process: 

 Join census block table to the 2000 census blocks based on the BLK2000 field  
o Export results  
o Load exported results into the NTIA data model  

 Result: BB_Service_CensusBlock 
 
Data Verification 
 
Maximum down/upload speeds reported by provider:  

Max Download Category Count % of Blocks 
 

Max Upload Category Count % of Blocks 

10 574 100% 
 

10 574 100% 
 
Typical down/upload speeds reported by provider: N/A 
 
Typical down/upload speed from 2010 computer based speed test: N/A 
 
Speed tests match reported typical download speeds or are within 1 speed tier:  N/A 
 
%/# of census blocks verified by 2010 computer based speed tests: N/A 
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Form477 Verification: 
Number of census blocks reported to project, but no tract reported to FCC: N/A 
Number of tracts reported to FCC, but no census blocks reported to project: N/A 
 
Unserved areas: 
Number of census blocks with unserved areas reported via broadband.maryland.gov: 0 
Total number of unserved areas reported per provider via broadband.maryland.gov: 0 
 
Number of census blocks with unserved areas reported via mdbroadbandmap.org: 0 
Total number of unserved areas reported per provider via mdbroadbandmap.org: 0 
 
Of census blocks reported as served, how many have zero population based on 2000 census 
data? 323/574 (56%) 
 
Web Search Verification: N/A 
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Freedom Wireless Broadband, LLC 
DBA Name: Freedom Wireless Broadband, LLC 
 
Data Characteristics 
 
Date of Original Submission:       1/28/2010 
Date of Update Submission:       2/25/2011 
Currency of Data:        December 2010 
FRN:           0018643155 
Type of data submitted:        Coverage Area 
Census Block Count:         N/A   
Total Matched Address Points Count:     N/A 
Unmatched Address Points:       N/A 
Number of Technology of Transmission Types:    1 
Provided Max Advertised Download Speed:     Complete 
Provided Max Advertised Upload Speed:      Complete 
Provided Max Typical Download Speed:      No  
Provided Max Typical Upload Speed:      No  
Provided Middle Mile:        No 
Provided Road Segments for census blocks greater than 2 sq miles: No 
 
Data Processing 
 
Coverage Area Process: 

 Repair Geometry on delivered coverage area 

 Simplify Polygon of coverage area 

 Load coverage area into the NTIA data model 
o Result: BB_Service_Wireless 

 
Data Verification 
Maximum down/upload speeds reported by provider:  

Max Download Category Count % of Blocks 
 

Max Upload Category Count % of Blocks 

4 1 100% 
 

4 1 100% 
 
Typical down/upload speeds reported by provider: N/A 
 
Typical down/upload speed from 2010 mobile speed test: N/A 
 
Speed tests match reported typical download speeds or are within 1 speed tier:  N/A 
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#/% of mobile speed tests verifying coverage area:  
Number of mobile speed tests reported inside coverage area: N/A 
Number of mobile speed tests reported outside coverage area: N/A 
 
Typical down/upload speed from 2010 computer based speed test: 
 

Speed Test Download Tier Count % of Tests   Speed Test Upload Tier Count % of Tests 

4 2 100%   4 2 100% 
 
Speed tests match reported typical download speeds or are within 1 speed tier: N/A 
 
#/% of computer based speed tests verifying coverage area: 
Number of computer based speed tests reported inside coverage area: 2/2 (100.00%) 
Number of computer based speed tests reported outside coverage area: 0 
 
Form 477 Verification: 
#/% of tracts reported as served to FCC that overlaps with coverage area: 13/13 
#/% of tracts reported as served to FCC but do not intersect coverage area: 0/13 
 
Unserved areas: 
Number of unserved areas reported within coverage area via broadband.maryland.gov:  
3/202 (1.49%) 
Number of unserved areas reported within coverage area via mdbroadbandmap.org: 
0/58 (0.0%) 
 
Of census blocks reported as served, how many have zero population based on 2000 census 
data?  N/A 
 
Web Search Verification: N/A 
 
Wireless Verification: N/A 
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Gans Communications, LP 
DBA: MetroCast Communications 
 
Data Characteristics 
 
Date of Original Submission:       3/5/2010 
Date of Update Submission:       N/A 
Currency of Data:        December 2010 
FRN:           0016642761 
Type of data submitted:        Census Block Table 
Census Block Count:                      1821  
Total Matched Address Points Count:     N/A 
Unmatched Address Points:       N/A 
Number of Technology of Transmission Types:    1 
Provided Max Advertised Download Speed:     Complete 
Provided Max Advertised Upload Speed:      Complete 
Provided Max Typical Download Speed:      Complete 
Provided Max Typical Upload Speed:      Complete 
Provided Middle Mile:        No 
Provided Road Segments for census blocks greater than 2 sq miles: Yes 
 
Data Processing 
 
Census Block Process: 

 Join the census block table to the 2000 census blocks based on the BLK2000 field  
o Export results (for each technology of transmission) 
o Load exported results into the NTIA data model  

 Result: BB_Service_CensusBlock 
 
Data Verification 
 
Maximum down/upload speeds reported by provider:  
Census blocks 

Max Download Category Count % of Area 
 

Max Upload Category Count % of Area 

7 1821 100% 
 

4 1821 100% 
 
Road Segments 

Max Download Category Count % of Area 
 

Max Upload Category Count % of Area 

7 1567 100% 
 

4 1567 100% 
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Typical down/upload speeds reported by provider: 
Census blocks 

Typical Download Category Count % of Area 
 

Typical Upload Category Count % of Area 

6 1821 100% 
 

2 1821 100% 
 
Road segments 

Typical Download Category Count % of Area 
 

Typical Upload Category Count % of Area 

7 1567 100% 
 

2 1567 100% 
 
Typical down/upload speed from 2010 computer based speed test:  

Speed Test Download Tier Count % of Tests   Speed Test Upload Tier Count % of Tests 

3 8 13% 
 

1 1 2% 

4 2 3% 
 

2 54 90% 

5 7 12% 
 

3 3 5% 

6 40 67% 
 

4 1 2% 

7 2 3% 
 

5 1 2% 

8 1 2% 
     

Speed tests match reported typical download speeds or are within 1 speed tier:  Yes 
 
%/# of census blocks verified by 2010 computer based speed tests:  

Confirmation of census block served 27 

Census blocks served, not reported by provider 9 

Total number of served census blocks reported by provider 1821 

% of served census blocks confirmed by speed test 1.4827% 
 
Form477 Verification: 
Number of census blocks reported to project, but no tract reported to FCC: N/A 
Number of tracts reported to FCC, but no census blocks reported to project: N/A 
 
Unserved areas: 
Number of census blocks with unserved areas reported via broadband.maryland.gov: 2 
Total number of unserved areas reported per provider via broadband.maryland.gov: 2 
 
Number of census blocks with unserved areas reported via mdbroadbandmap.org: 3 
Total number of unserved areas reported per provider via mdbroadbandmap.org: 3 
 
Of census blocks reported as served, how many have zero population based on 2000 census 
data?  469/1821 (26%) 
 



Maryland Broadband Mapping Initiative:  Verification/Validation Report 

April 1, 2011 

 

Salisbury University  www.mdbroadbandmap.org  
Page 79  

  

Web Search Verification: 36/1821 (2%) of census blocks were confirmed using online search 
feature of given provider 

MetroCast Web Search Verification Table Count Percentage 

Total # of sample points 1496   

Number of sample points with results 107 7% 

Result is yes and census block is in served area  36 34% 

Result is yes but not in a census block reported as served    20 19% 

Result is no and census block is in served area 1 1% 

Result is no and census block not served area 50 47% 
 
Census blocks that are outside Cable Franchise Boundary: 1041/1821 (57%) 
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HNS License Sub, LLC 
DBA: Hughes Communications, Inc.  
 
Data Characteristics 
 
Date of Original Submission:       2/2/2010 
Date of Update Submission:       N/A 
Currency of Data:        July 2010 
FRN:           0018483073 
Type of data submitted:        Coverage Area 
Census Block Count:                      N/A   
Total Matched Address Points Count:     N/A  
Unmatched Address Points:       N/A 
Number of Technology of Transmission Types:    1 
Provided Max Advertised Download Speed:     Complete 
Provided Max Advertised Upload Speed:      Complete 
Provided Max Typical Download Speed:      Complete 
Provided Max Typical Upload Speed:      Complete 
Provided Middle Mile:        No 
Provided Road Segments for census blocks greater than 2 sq miles: No 
 
Data Processing 
 
Coverage Area Process: 

 Repair Geometry on delivered coverage area 

 Perform Topology on coverage area 
o Rule: Coverage area should not overlap 
o Load coverage area into the NTIA data model 

 Result: BB_Service_Wireless 
 
Data Verification 
 
Maximum down/upload speeds reported by provider:  

Max Download Category Count % of Area 
 

Max Upload Category Count % of Area 

5 1 100% 
 

2 1 100% 
 
Typical down/upload speeds reported by provider: 

Typical Download Category Count % of Area 
 

Typical Upload Category Count % of Area 

3 1 100% 
 

2 1 100% 
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Typical down/upload speed from 2010 computer based speed test: 
 

Speed Test Download Tier Count % of Tests   Speed Test Upload Tier Count 

0 9 15%   1 18 

3 32 53%   2 24 

6 6 10%   3 2 

7 9 15%   4 3 

8 3 5%   5 4 

9 1 2%   6 6 

   
  7 3 

 
Speed tests match reported typical download speeds or are within 1 speed tier:  Yes 
 
#/% of computer based speed tests verifying coverage area: 
Number of computer based speed tests reported inside coverage area: 60/60 (100.00%) 
Number of computer based speed tests reported outside coverage area: 0 
 
Form477 Verification: 
#/% of tracts reported as served to FCC that overlaps with coverage area: 295/295 
#/% of tracts reported as served to FCC but do not intersect coverage area: 0/295 
 
Unserved areas: 
Number of unserved areas reported within coverage area via broadband.maryland.gov:  
202/202 (100.0%) 
Number of unserved areas reported within coverage area via mdbroadbandmap.org: 
295/295 (100.0%) 
 
Of census blocks reported as served, how many have zero population based on 2000 census 
data? N/A 
 
Web Search Verification: N/A 
 
Wireless Verification: N/A 
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Hotwire Communications, Ltd 
DBA Name: Hotwire Communications, Ltd 
 
Data Characteristics 
 
Date of Original Submission:       2/19/2010 
Date of Update Submission:       7/15/2010 
Currency of Data:        December 2010 
FRN:           0009846494 
Type of data submitted:        Addresses 
Census Block Count:                      1  
Total Matched Address Points Count:     1 
Unmatched Address Points:       0 
Number of Technology of Transmission Types:    1 
Provided Max Advertised Download Speed:     Complete 
Provided Max Advertised Upload Speed:      Complete 
Provided Max Typical Download Speed:      No  
Provided Max Typical Upload Speed:      No  
Provided Middle Mile:        No 
Provided Road Segments for census blocks greater than 2 sq miles: No 
 
Data Processing 
 
Address Table Process: 

 Geocode address table to Maryland Property View address locator 
o Number matched: 1 
o Number unmatched: 0 

 Spatially join address points to 2000 census blocks 

 Select by location the address points that are completely within a greater than two 
square mile census block 

o Export as address points to be loaded into the NTIA data model 
 Result: BB_Service_Address 

o Switch the selection and export as points to create census blocks 
Census Block Process: 

 Join the switched selection (BB_Service_Address) address points to the 2000 census 
blocks based on the BLK2000 field  

o Load exported results into the NTIA data model  
 Result: BB_Service_CensusBlock 
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Data Verification 
Maximum down/upload speeds reported by provider:  
Census Blocks 

Max Download Category Count % of Blocks 
 

Max Upload Category Count % of Blocks 

5 1 100% 
 

3 1 100% 
 
Typical down/upload speeds reported by provider: N/A 
 
Typical down/upload speed from 2010 computer based speed test:  

Speed Test Download Tier Count % of Tests   Speed Test Upload Tier Count % of Tests 

0 2 100%   2 2 100% 
 
Speed tests match reported typical download speeds or are within 1 speed tier:  N/A 
 
%/# of census blocks verified by 2010 computer based speed tests:  

Confirmation of census block served 0 

Census blocks served, not reported by provider 1 

Total number of served census blocks reported by provider 1 

% of served census blocks confirmed by speed test 0.0000% 
 
Form477 Verification: 
Number of census blocks reported to project, but no tract reported to FCC: 1 
Number of tracts reported to FCC, but no census blocks reported to project: 1 
 
Unserved areas: 
Number of census blocks with unserved areas reported via broadband.maryland.gov: 0 
Total number of unserved areas reported per provider via broadband.maryland.gov: 0 
 
Number of census blocks with unserved areas reported via mdbroadbandmap.org: 0 
Total number of unserved areas reported per provider via mdbroadbandmap.org: 0 
 
Of census blocks reported as served, how many have zero population based on 2000 census 
data?  0/1 (0%) 
 
Web Search Verification: N/A 
 
Census blocks that are outside Cable Franchise Boundary: 0/1 (0%) 
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Leap Wireless International, Inc 
DBA: Cricket Communications  
 
Data Characteristics 
 
Date of Original Submission:       3/17/2010 
Date of Update Submission:       3/5/2011 
Currency of Data:        December 2010 
FRN:           0002963528 
Type of data submitted:        Coverage Area 
Census Block Count:                      N/A  
Total Matched Address Points Count:     N/A 
Unmatched Address Points:       N/A 
Number of Technology of Transmission Types:    1 
Provided Max Advertised Download Speed:     Complete 
Provided Max Advertised Upload Speed:      Complete 
Provided Max Typical Download Speed:      No 
Provided Max Typical Upload Speed:      No 
Provided Middle Mile:        No 
Provided Road Segments for census blocks greater than 2 sq miles: No 
 
Data Processing 
 
Coverage Area Process: 

 Repair Geometry on delivered coverage area 

 Remove coverage areas less than 0.125 square miles 

 Remove coverage area “holes” less than 0.125 square miles 

 Simplify Polygon of coverage area 

 Load coverage area into the NTIA data model 
o Result: BB_Service_Wireless 

 
Speed Domains: 

 Typical Download Speed was < speed tier 3 
o Calculated speed to speed tier 3 

 
Data Verification 
 
Maximum down/upload speeds reported by provider:  

Max Download Category Count % of Area 
 

Max Upload Category Count % of Area 

3 1 100% 
 

2 1 100% 
 
Typical down/upload speeds reported by provider: N/A 
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Typical down/upload speed from 2010 mobile speed test:  
 

Speed Test Download Tier Count % of Tests 
 

Speed Test Upload Tier Count % of Tests 

0 121 99% 
 

1 23 19% 

3 1 1% 
 

2 77 63% 

    
3 22 18% 

 
Speed tests match reported typical speeds or are within 1 speed tier:   N/A 
 
#/% of mobile speed tests verifying coverage area:  
Number of mobile speed tests reported inside coverage area: 122/122 (100.0%) 
Number of mobile speed tests reported outside coverage area: 0/122 (0.0%) 
 
Typical down/upload speed from 2010 computer based speed test: 
 

Speed Test Download Tier Count % of Tests 
 

Speed Test Upload Tier Count % of Tests 

0 14 78% 
 

1 2 11% 

3 3 17% 
 

2 15 83% 

4 1 6% 
 

4 1 6% 
 
Speed tests match reported typical download speeds or are within 1 speed tier: N/A 
 
#/% of computer based speed tests verifying coverage area  
Number of computer based speed tests reported inside coverage area: 18/18 (100.00%) 
Number of computer based speed tests reported outside coverage area: 0/18 (0.00%) 
 
Form 477Verification: 
#/% of tracts reported as served to FCC that overlaps with coverage area: N/A 
#/% of tracts reported as served to FCC but do not intersect coverage area: N/A 
 
Unserved areas: 
Number of unserved areas reported within coverage area via broadband.maryland.gov:  
71/202 (35.2%) 
Number of unserved areas reported within coverage area via mdbroadbandmap.org:  
11/58 (19%) 
 
Of census blocks reported as served, how many have zero population based on 2000 census 
data? N/A 
 
 



Maryland Broadband Mapping Initiative:  Verification/Validation Report 

April 1, 2011 

 

Salisbury University  www.mdbroadbandmap.org  
Page 86  

  

Web Search Verification:  

Cricket WebSearch Verification Table Count Percentage 

Total # of sample points 1496   

Number of sample points with results 635 42% 

Result is yes and coverage area is in served area  449 71% 

Result is yes but not in a coverage area reported as served    9 1% 

Result is no and coverage area is in served area 1 0% 

Result is no and coverage area is not in served area 176 28% 
 
Wireless Verification: N/A 
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Level 3 Communications, LLC 
DBA Name: Level 3 Communications, LLC 
 
Data Characteristics 
 
Date of Original Submission:       1/18/2010 
Date of Update Submission:       1/25/2011 
Currency of Data:        January 2011 
FRN:           0003723822 
Type of data submitted:        Address Table 
Census Block Count:                      129   
Total Matched Address Points Count:     174 
Unmatched Address Points:       5 
Number of Technology of Transmission Types:    1 
Provided Max Advertised Download Speed:     Complete 
Provided Max Advertised Upload Speed:      Complete 
Provided Max Typical Download Speed:      Complete 
Provided Max Typical Upload Speed:      Complete 
Provided Middle Mile:        Yes 
Provided Road Segments for census blocks greater than 2 sq miles: No 
 
Data Processing 
 
Address Table Process: 

 Geocode address table to Maryland Property View address locator 
o Number matched: 172 
o Number unmatched: 7 

 Unmatched address are geocoded to Maryland street centerline address locator 
o Number matched: 2 
o Number unmatched: 5 

 Merge matched addresses 

 Spatially join address points to 2000 census blocks 
Census Block Process: 

 Join the switched selection (BB_Service_Address) address points to the 2000 census 
blocks based on the BLK2000 field  

o Export results  
o Load exported results into the NTIA data model  

 Result: BB_Service_CensusBlock 
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Data Verification 
Maximum down/upload speeds reported by provider:  
Census Blocks 

Max Download Category Count % of Blocks 
 

Max Upload Category Count % of Blocks 

11 129 100% 
 

11 129 100% 
 
Typical down/upload speeds reported by provider: 
Census Blocks 

Typical Download Category Count % of Blocks 
 

Typical Upload Category Count % of Blocks 

11 129 100% 
 

11 129 100% 
 
Typical down/upload speed from 2010 computer based speed test:  

Speed Test Download Tier Count % of Tests   Speed Test Upload Tier Count % of Tests 

0 1 25%   2 1 25% 

3 1 25%   3 1 25% 

8 2 50%   4 1 25% 

        5 1 25% 
 
Speed tests match reported typical download speeds or are within 1 speed tier:  No 
 
%/# of census blocks verified by 2010 computer based speed tests:  

Confirmation of census block served 1 

Census blocks served, not reported by provider 1 

Total number of served census blocks reported by provider 129 

% of served census blocks confirmed by speed test 0.7752% 
 
Form477 Verification: 
Number of census blocks reported to project, but no tract reported to FCC: 62 
Number of tracts reported to FCC, but no census blocks reported to project: 57 
 
Unserved areas: 
Number of census blocks with unserved areas reported via broadband.maryland.gov: 1 
Total number of unserved areas reported per provider via broadband.maryland.gov: 2 
 
Number of census blocks with unserved areas reported via mdbroadbandmap.org: 0 
Total number of unserved areas reported per provider via mdbroadbandmap.org: 0 
 
Of census blocks reported as served, how many have zero population based on 2000 census 
data? 59/129 (46%) 
 
Web Search Verification: N/A 
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MegaPath, Inc. 
DBA Name: MegaPath 
 
Data Characteristics 
 
Date of Original Submission:       3/11/2010 
Date of Update Submission:       N/A 
Currency of Data:        March 2011 
FRN:           0018105601 
Type of data submitted:        Address Table 
Census Block Count:                      88   
Total Matched Address Points Count:     93 
Unmatched Address Points:       6 
Number of Technology of Transmission Types:    2 
Provided Max Advertised Download Speed:     Incomplete 
Provided Max Advertised Upload Speed:      Incomplete 
Provided Max Typical Download Speed:      No 
Provided Max Typical Upload Speed:      No 
Provided Middle Mile:        No 
Provided Road Segments for census blocks greater than 2 sq miles: No 
 
Data Processing 
 
Address Table Process: 

 Geocode address table to Maryland Property View address locator 
o Number matched: 90 
o Number unmatched: 9 

 Unmatched address are geocoded to Maryland street centerline address locator 
o Number matched: 3 
o Number unmatched: 6 

 Merge matched addresses 

 Spatially join address points to 2000 census blocks 

 Separate and export the address points according to technology of transmission  

 Select by location the address points that are completely within a greater than two 
square mile census block 

o Export as address points to be loaded into the NTIA data model 
 Result: BB_Service_Address 

o Switch the selection and export as points to create census blocks 
Census Block Process: 

 Join the switched selection (BB_Service_Address) address points to the 2000 census 
blocks based on the BLK2000 field  

o Export results for each technology of transmission 
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o Load exported results into the NTIA data model  
 Result: BB_Service_CensusBlock 

 
Data Verification 
 
Maximum down/upload speeds reported by provider:  
Census Blocks 

Max Download Category Count % of Area 
 

Max Upload Category Count % of Area 

3 68 82% 
 

2 59 77% 

4 14 17% 
 

3 16 21% 

5 1 1% 
 

4 2 3% 
 
Typical down/upload speeds reported by provider: N/A 
 
Typical down/upload speed from 2010 computer based speed test: 

Speed Test Download Tier Count % of Tests   Speed Test Upload Tier Count % of Tests 

1 1 50%   2 1 50% 

10 1 50%   5 1 50% 
 
Speed tests match reported typical speeds or are within 1 speed tier:  N/A 
 
%/# of census blocks verified by 2010 computer based speed tests:  

Confirmation of census block served 0 

Census blocks served, not reported by provider 2 

Total number of served census blocks reported by provider 88 

% of served census blocks confirmed by speed test 0.00% 
 
Form477 Verification: 
Number of census blocks reported to project, but no tract reported to FCC: N/A 
Number of tracts reported to FCC, but no census blocks reported to project: N/A 
 
Unserved areas: 
Number of census blocks with unserved areas reported via broadband.maryland.gov: 1 
Total number of unserved areas reported per provider via broadband.maryland.gov: 2 
 
Number of census blocks with unserved areas reported via mdbroadbandmap.org: 0 
Total number of unserved areas reported per provider via mdbroadbandmap.org: 0 
 
Of census blocks reported as served, how many have zero population based on 2000 census 
data? 26/88 (30%) 
 
Web Search Verification: N/A 
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Census blocks that are outside DSL boundary:  3/88 (3%) 
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Mountain Communications, LLC 
DBA:  ProCom 
 
Data Characteristics 
Date of Original Submission:       May 2010 
Date of Update Submission:       N/A 
Currency of Data:        May 2010 
FRN:           0008039323 
Type of data submitted:        Census Block Table 
Census Block Count:                      148   
Total Matched Address Points Count:     N/A 
Unmatched Address Points:       N/A 
Number of Technology of Transmission Types:    1 
Provided Max Advertised Download Speed:     Incomplete 
Provided Max Advertised Upload Speed:      Incomplete 
Provided Max Typical Download Speed:      No  
Provided Max Typical Upload Speed:      No  
Provided Middle Mile:        No 
Provided Road Segments for census blocks greater than 2 sq miles: Yes 
 
Data Processing 
Census Block Process: 

 Join the census block table to the 2000 census blocks based on the BLK2000 field  
o Export results (for each technology of transmission) 
o Load exported results into the NTIA data model  

 Result: BB_Service_CensusBlock 
 
Data Verification 
Maximum down/upload speeds reported by provider:  

Max Download Category Count % of Blocks 
 

Max Upload Category Count % of Blocks 

10 3 100% 
 

10 3 100% 
 
Typical down/upload speeds reported by provider: N/A 
 
Typical down/upload speed from 2010 computer based speed test: N/A 
 
Speed tests match reported typical download speeds or are within 1 speed tier:  N/A 
 
%/# of census blocks verified by 2010 computer based speed tests: N/A 
 
Form477 Verification: 
Number of census blocks reported to project, but no tract reported to FCC: N/A 
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Number of tracts reported to FCC, but no census blocks reported to project: N/A 
 
Unserved areas: 
Number of census blocks with unserved areas reported via broadband.maryland.gov: 0 
Total number of unserved areas reported per provider via broadband.maryland.gov: 0 
 
Number of census blocks with unserved areas reported via mdbroadbandmap.org: 0 
Total number of unserved areas reported per provider via mdbroadbandmap.org: 0 
 
Of census blocks reported as served, how many have zero population based on 2000 census 
data?  46/148 (31%) 
 
Web Search Verification: N/A 
 
Wireless Verification: N/A 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



Maryland Broadband Mapping Initiative:  Verification/Validation Report 

April 1, 2011 

 

Salisbury University  www.mdbroadbandmap.org  
Page 94  

  

Neon Connect, Inc 
DBA: Sidera Networks 
 
Data Characteristics 
 
Date of Original Submission:       3/5/2010 
Date of Update Submission:       3/1/2011 
Currency of Data:        December 2010 
FRN:           0005052741 
Type of data submitted:        Address Table 
Census Block Count:                     1   
Total Matched Address Points Count:     2 
Unmatched Address Points:       0 
Number of Technology of Transmission Types:    1 
Provided Max Advertised Download Speed:     Complete 
Provided Max Advertised Upload Speed:      Complete 
Provided Max Typical Download Speed:      Complete 
Provided Max Typical Upload Speed:      Complete 
Provided Middle Mile:        Yes 
Provided Road Segments for census blocks greater than 2 sq miles: No 
 
Data Processing 
 
Address Table Process: 

 Geocode address table to Maryland Property View address locator 
o Number matched: 2 
o Number unmatched: 0 

 Spatially join address points to 2000 census blocks 

 Select by location the address points that are completely within a greater than two 
square mile census block 

o Export as address points to be loaded into the NTIA data model 
 Result: BB_Service_Address 

o Switch the selection and export as points to create census blocks 
Census Block Process: 

 Join the switched selection (BB_Service_Address) address points to the 2000 census 
blocks based on the BLK2000 field  

o Export results  
o Load exported results into the NTIA data model  

 Result: BB_Service_CensusBlock 
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Data Verification 
Maximum down/upload speeds reported by provider:  

Max Download Category Count % of Blocks 
 

Max Upload Category Count % of Blocks 

7 1 100% 
 

7 1 100% 
 
Typical down/upload speeds reported by provider: 

Typical Download Category Count % of Blocks 
 

Typical Upload Category Count % of Blocks 

7 1 100% 
 

7 1 100% 
 
Typical down/upload speed from 2010 computer based speed test: N/A 
 
Speed tests match reported typical download speeds or are within 1 speed tier: N/A 
 
%/# of census blocks verified by 2010 computer based speed tests: N/A 
 
Form477 Verification: 
Number of census blocks reported to project, but no tract reported to FCC: N/A 
Number of tracts reported to FCC, but no census blocks reported to project: N/A 
 
Unserved areas: 
Number of census blocks with unserved areas reported via broadband.maryland.gov: 0 
Total number of unserved areas reported per provider via broadband.maryland.gov: 0 
 
Number of census blocks with unserved areas reported via mdbroadbandmap.org: 0 
Total number of unserved areas reported per provider via mdbroadbandmap.org: 0 
 
Of census blocks reported as served, how many have zero population based on 2000 census 
data?  0/1 (0%) 
 
Web Search Verification: N/A 
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New Edge Holding Company 
DBA Name: New Edge Network, Inc 
 
Data Characteristics 
Date of Original Submission:       1/22/2010 
Date of Update Submission:       3/2/2011 
Currency of Data:        January 2011 
FRN:           0003720471 
Type of data submitted:        Address Table 
Census Block Count:                      219  
Total Matched Address Points Count:     371 
Unmatched Address Points:       3 
Number of Technology of Transmission Types:    2 
Provided Max Advertised Download Speed:     Complete 
Provided Max Advertised Upload Speed:      Complete 
Provided Max Typical Download Speed:      Complete 
Provided Max Typical Upload Speed:      Complete 
Provided Middle Mile:        No 
Provided Road Segments for census blocks greater than 2 sq miles: No 
 
Data Processing 
 
Address Table Process: 

 Geocode address table to Maryland Property View address locator 
o Number matched: 335 
o Number unmatched: 19 

 Unmatched address are geocoded to Maryland street centerline address locator 
o Number matched: 16 
o Number unmatched: 3 

 Merge matched addresses 

 Spatially join address points to 2000 census blocks 

 Separate and export the address points according to technology of transmission Select 
by location the address points that are completely within a greater than two square mile 
census block 

o Export as address points to be loaded into the NTIA data model 
 Result: BB_Service_Address 

o Switch the selection and export as points to create census blocks 
Census Block Process: 

 Join the switched selection (BB_Service_Address) address points to the 2000 census 
blocks based on the BLK2000 field  

o Export results (for each technology of transmission) 
o Load exported results into the NTIA data model  
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 Result: BB_Service_CensusBlock 
Data Verification 
 
Maximum down/upload speeds reported by provider:  

Max Download Category Count % of Blocks 
 

Max Upload Category Count % of Blocks 

3 90 28% 
 

2 198 62% 

4 205 65% 
 

3 75 24% 

5 17 5% 
 

4 43 14% 

6 4 1% 
 

7 1 0% 

7 1 0% 
     

Typical down/upload speeds reported by provider: 

Typical Download Category Count % of Blocks 
 

Typical Upload Category Count % of Blocks 

3 90 28% 
 

2 198 62% 

4 205 65% 
 

3 75 24% 

5 17 5% 
 

4 43 14% 

6 4 1% 
 

7 1 0% 

7 1 0% 
     

Typical down/upload speed from 2010 computer based speed test: N/A 
 
Speed tests match reported typical download speeds or are within 1 speed tier:  N/A 
 
%/# of census blocks verified by 2010 computer based speed tests: N/A 
 
Form477 Verification: 
Number of census blocks reported to project, but no tract reported to FCC: 106 
Number of tracts reported to FCC, but no census blocks reported to project: 48 
 
Unserved areas: 
Number of census blocks with unserved areas reported via broadband.maryland.gov: 0 
Total number of unserved areas reported per provider via broadband.maryland.gov: 0 
 
Number of census blocks with unserved areas reported via mdbroadbandmap.org: 0 
Total number of unserved areas reported per provider via mdbroadbandmap.org: 0 
 
Of census blocks reported as served, how many have zero population based on 2000 census 
data? 96/219 (44%) 
 
Web Search Verification: N/A 
 
Census blocks that are outside DSL boundary:  51/219 (23%) 
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One Communications 
DBA: One Communications 
 
Data Characteristics 
 
Date of Original Submission:       3/8/2011 
Date of Update Submission:       N/A 
Currency of Data:        December 2010 
FRN:           0015337702 
Type of data submitted:        Address Table 
Census Block Count:                     119   
Total Matched Address Points Count:     131 
Unmatched Address Points:       3 
Number of Technology of Transmission Types:    1 
Provided Max Advertised Download Speed:     Complete 
Provided Max Advertised Upload Speed:      Complete 
Provided Max Typical Download Speed:      No 
Provided Max Typical Upload Speed:      No 
Provided Middle Mile:        No 
Provided Road Segments for census blocks greater than 2 sq miles: No 
 
Data Processing 
 
Address Table Process: 

 Geocode address table to Maryland Property View address locator 
o Number matched: 128 
o Number unmatched: 6 

 Unmatched addresses are geocoded to Maryland street centerline address locator 
o Number matched: 3 
o Number unmatched: 3   

 Spatially join address points to 2000 census blocks 

 Select by location the address points that are completely within a greater than two 
square mile census block 

o Export as address points to be loaded into the NTIA data model 
 Result: BB_Service_Address 

o Switch the selection and export as points to create census blocks 
Census Block Process: 

 Join the switched selection (BB_Service_Address) address points to the 2000 census 
blocks based on the BLK2000 field  

o Export results  
o Load exported results into the NTIA data model  

 Result: BB_Service_CensusBlock 
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Data Verification 
Maximum down/upload speeds reported by provider:  
Census Blocks 

Max Download Category Count % of Blocks 
 

Max Upload Category Count % of Blocks 

4 81 68% 
 

4 81 68% 

5 31 26% 
 

5 31 26% 

6 6 5% 
 

6 6 5% 

7 1 1% 
 

7 1 1% 
Addresses 

Max Download Category Count % of Addresses 
 

Max Upload Category Count % of Addresses 

5 2 100% 
 

5 2 100% 
 
Typical down/upload speeds reported by provider: N/A 
 
Typical down/upload speed from 2010 computer based speed test:  

Speed Test Download Tier Count % of Tests   Speed Test Upload Tier Count % of Tests 

0 1 100% 
 

3 1 100% 
 
Speed tests match reported typical download speeds or are within 1 speed tier: N/A 
 
%/# of census blocks verified by 2010 computer based speed tests: 

Confirmation of census block served 0 

Census blocks served, not reported by provider 1 

Total number of served census blocks reported by provider 119 

% of served census blocks confirmed by speed test 0.00% 
 
Form477 Verification: 
Number of census blocks reported to project, but no tract reported to FCC: N/A 
Number of tracts reported to FCC, but no census blocks reported to project: N/A 
 
Unserved areas: 
Number of census blocks with unserved areas reported via broadband.maryland.gov: 0 
Total number of unserved areas reported per provider via broadband.maryland.gov: 0 
 
Number of census blocks with unserved areas reported via mdbroadbandmap.org: 0 
Total number of unserved areas reported per provider via mdbroadbandmap.org: 0 
 
Of census blocks reported as served, how many have zero population based on 2000 census 
data?  44/119 (37%) 
 
Web Search Verification: N/A 
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PAETEC Communications, Inc. 
DBA Name: PAETEC Communications, Inc. 
 
Data Characteristics 
 
Date of Original Submission:       2/28/2011 
Date of Update Submission:       N/A 
Currency of Data:        December 2010 
FRN:           0011017795 
Type of data submitted:        Address Table 
Census Block Count:                     284   
Total Matched Address Points Count:     371 
Unmatched Address Points:       6 
Number of Technology of Transmission Types:    2 
Provided Max Advertised Download Speed:     Complete 
Provided Max Advertised Upload Speed:      Complete 
Provided Max Typical Download Speed:      Complete 
Provided Max Typical Upload Speed:      Complete 
Provided Middle Mile:        Yes 
Provided Road Segments for census blocks greater than 2 sq miles: No 
 
Data Processing 
 
Address Table Process: 

 Geocode address table to Maryland Property View address locator 
o Number matched: 360 
o Number unmatched: 17 

 Unmatched address are geocoded to Maryland street centerline address locator 
o Number matched: 11 
o Number unmatched: 6 

 Merge matched addresses 

 Spatially join address points to 2000 census blocks 

 Select by location the address points that are completely within a greater than two 
square mile census block 

o Export as address points to be loaded into the NTIA data model 
 Result: BB_Service_Address 

o Switch the selection and export as points to create census blocks 
Census Block Process: 

 Join the switched selection (BB_Service_Address) address points to the 2000 census 
blocks based on the BLK2000 field  

o Export results  
o Load exported results into the NTIA data model  
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 Result: BB_Service_CensusBlock 
 
Data Verification 
Maximum down/upload speeds reported by provider:  
Census Blocks 

Max Download Category Count % of Blocks 
 

Max Upload Category Count % of Blocks 

11 250 83% 
 

11 250 83% 

9 53 17% 
 

9 53 17% 
 
Typical down/upload speeds reported by provider:  
Census Blocks 

Typical Download Category Count % of Blocks 
 

Typical Upload Category Count % of Blocks 

3 89 29% 
 

3 89 29% 

4 214 71% 
 

4 214 71% 
 
 
Typical down/upload speed from 2010 computer based speed test:  

Speed Test Download Tier Count % of Tests   Speed Test Upload Tier Count % of Tests 

0 15 75% 
 

1 15 75% 

3 3 15% 
 

3 3 15% 

5 2 10% 
 

4 1 5% 

    
5 1 5% 

 
Speed tests match reported typical download speeds or are within 1 speed tier:  No 
 
%/# of census blocks verified by 2010 computer based speed tests:  

Confirmation of census block served 2 

Census blocks served, not reported by provider 4 

Total number of served census blocks reported by provider 284 

% of served census blocks confirmed by speed test 0.70% 
 
Form477 Verification: 
Number of census blocks reported to project, but no tract reported to FCC: 22 
Number of tracts reported to FCC, but no census blocks reported to project: 99 
 
Unserved areas: 
Number of census blocks with unserved areas reported via broadband.maryland.gov: 2 
Total number of unserved areas reported per provider via broadband.maryland.gov: 2 
 
Number of census blocks with unserved areas reported via mdbroadbandmap.org: 0 
Total number of unserved areas reported per provider via mdbroadbandmap.org: 0 
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Of census blocks reported as served, how many have zero population based on 2000 census 
data?  106/284 (37%) 
 
Web Search Verification: N/A 
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QCOL, Inc. 
DBA Name: QCOL 
 
Data Characteristics 
 
Date of Original Submission:       May 2010 
Date of Update Submission:       N/A 
Currency of Data:        December 2010 
FRN:           0019663095 
Type of data submitted:        Census Block Table 
Census Block Count:                      248   
Total Matched Address Points Count:     N/A 
Unmatched Address Points:       N/A 
Number of Technology of Transmission Types:    2 
Provided Max Advertised Download Speed:     Complete 
Provided Max Advertised Upload Speed:      Complete 
Provided Max Typical Download Speed:      No  
Provided Max Typical Upload Speed:      No  
Provided Middle Mile:        No 
Provided Road Segments for census blocks greater than 2 sq miles: Yes 
 
Data Processing 
 
Census Block Process: 

 Join the switched selection (BB_Service_Address) address points to the 2000 census 
blocks based on the BLK2000 field  

o Export results for each technology of transmission 
o Load exported results into the NTIA data model  

 Result: BB_Service_CensusBlock 
 
Data Verification 
 
Maximum down/upload speeds reported by provider:  
Census Blocks 

Max Download Category Count % of Blocks 
 

Max Upload Category Count % of Blocks 

10 28 13% 
 

10 275 59% 

6 193 87% 
 

6 192 41% 
 
Typical down/upload speeds reported by provider: N/A 
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Typical down/upload speed from 2010 computer based speed test:  

Speed Test Download Tier Count % of Tests   Speed Test Upload Tier Count % of Tests 

2 1 100%   3 1 100% 
 
Speed tests match reported typical download speeds or are within 1 speed tier:  N/A 
 
%/# of census blocks verified by 2010 computer based speed tests:  

Confirmation of census block served 0 

Census blocks served, not reported by provider 1 

Total number of served census blocks reported by provider 248 

% of served census blocks confirmed by speed test 0.00% 
 
Form477 Verification: 
Number of census blocks reported to project, but no tract reported to FCC: N/A 
Number of tracts reported to FCC, but no census blocks reported to project: N/A 
 
Unserved areas: 
Number of census blocks with unserved areas reported via broadband.maryland.gov: 4 
Total number of unserved areas reported per provider via broadband.maryland.gov: 5 
 
Number of census blocks with unserved areas reported via mdbroadbandmap.org: 0 
Total number of unserved areas reported per provider via mdbroadbandmap.org: 0 
 
Of census blocks reported as served, how many have zero population based on 2000 census 
data?  70/248 (28%) 
 
Web Search Verification: N/A 
 
Census blocks that are outside Cable Franchise Boundary: 28/248 (11%) 
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Shenandoah Telecommunications 
DBA: Shentel Converged Services, Inc 
 
Data Characteristics 
 
Date of Original Submission:       May 2010 
Date of Update Submission:       N/A 
Currency of Data:        May 2010 
FRN:           0013962170 
Type of data submitted:        Addresses 
Census Block Count:                      1   
Total Matched Address Points Count:     1 
Unmatched Address Points:       1 
Number of Technology of Transmission Types:    1 
Provided Max Advertised Download Speed:     Complete 
Provided Max Advertised Upload Speed:      Complete 
Provided Max Typical Download Speed:      No  
Provided Max Typical Upload Speed:      No  
Provided Middle Mile:        No 
Provided Road Segments for census blocks greater than 2 sq miles: No 
 
Data Processing 
 
Address Table Process: 

 Geocode address table to Maryland Property View address locator 
o Number matched: 1 
o Number unmatched: 1 

 Unmatched address are geocoded to Maryland street centerline address locator 
o Number matched: 0 
o Number unmatched: 1 

 Merge matched addresses 

 Spatially join address points to 2000 census blocks 

 Select by location the address points that are completely within a greater than two 
square mile census block 

o Export as address points to be loaded into the NTIA data model 
 Result: BB_Service_Address 

o Switch the selection and export as points to create census blocks 
Census Block Process: 

 Join the switched selection (BB_Service_Address) address points to the 2000 census 
blocks based on the BLK2000 field  

o Load exported results into the NTIA data model  
 Result: BB_Service_CensusBlock 
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Data Verification 
 
Maximum down/upload speeds reported by provider:  

Max Download Category Count % of Blocks 
 

Max Upload Category Count % of Blocks 

5 1 100% 
 

3 1 100% 
 
Typical down/upload speeds reported by provider: N/A 
 
Typical down/upload speed from 2010 computer based speed test: N/A 
 
Speed tests match reported typical download speeds or are within 1 speed tier:  N/A 
 
%/# of census blocks verified by 2010 computer based speed tests: N/A 
 
Form477 Verification: 
Number of census blocks reported to project, but no tract reported to FCC: 1 
Number of tracts reported to FCC, but no census blocks reported to project: 1 
 
Unserved areas: 
Number of census blocks with unserved areas reported via broadband.maryland.gov: 0 
Total number of unserved areas reported per provider via broadband.maryland.gov: 0 
 
Number of census blocks with unserved areas reported via mdbroadbandmap.org: 0 
Total number of unserved areas reported per provider via mdbroadbandmap.org: 0 
 
Of census blocks reported as served, how many have zero population based on 2000 census 
data? 1/1 (100%) 
 
Web Search Verification: N/A 
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Sprint Nextel Corporation 
DBA Name: Sprint Nextel Corporation 
 
Data Characteristics 
 
Date of Original Submission:       2/18/2010 
Date of Update Submission:       2/16/2011 
Currency of Data:        December 2010 
FRN:           0003774593 
Type of data submitted:        Coverage Area 
Census Block Count:                     N/A   
Total Matched Address Points Count:     N/A 
Unmatched Address Points:       N/A 
Number of Technology of Transmission Types:    1 
Provided Max Advertised Download Speed:     Complete 
Provided Max Advertised Upload Speed:      Complete 
Provided Max Typical Download Speed:      Complete 
Provided Max Typical Upload Speed:      Complete 
Provided Middle Mile:        Yes 
Provided Road Segments for census blocks greater than 2 sq miles: No 
 
Data Processing 
 
Coverage Area Process: 

 Repair Geometry on delivered coverage area 

 Remove coverage areas less than 0.125 square miles 

 Remove coverage area “holes” less than 0.125 square miles 

 Simplify Polygon of coverage area 

 Load coverage area into the NTIA data model 
o Result: BB_Service_Wireless 

 
Data Verification 
 
Maximum down/upload speeds reported by provider:  

Max Download Category Count % of Area 
 

Max Upload Category Count % of Area 

3 1 100% 
 

2 1 100% 

5 1 100% 
 

3 1 100% 
 
Typical down/upload speeds reported by provider:  

Typical Download Category Count % of Area 
 

Typical Upload Category Count % of Area 

3 1 100% 
 

2 1 100% 

5 1 100% 
 

3 1 100% 
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Typical down/upload speed from 2010 mobile speed test: 

Speed Test Download Tier Count % of Tests 
 

Speed Test Upload Tier Count % of Tests 

0 1437 41% 
 

1 842 24% 

3 644 18% 
 

2 1622 46% 

4 664 19% 
 

3 1029 29% 

5 756 21% 
 

4 15 0% 

6 31 1% 
 

5 7 0% 

    
6 3 0% 

    
7 4 0% 

    
8 10 0% 

  
Speed tests match reported typical download speeds or are within 1 speed tier:  No 
 
#/% of mobile speed tests verifying coverage area:  
Number of mobile speed tests reported inside coverage area: 3316/3532 (93.9%) 
Number of mobile speed tests reported outside coverage area: 216/3532 (6.1%) 
 
Typical down/upload speed from 2010 computer based speed test: 
 

Speed Test Download Tier Count % of Tests 
 

Speed Test Upload Tier Count % of Tests 

0 37 64% 
 

1 16 28% 

3 12 21% 
 

2 34 59% 

4 6 10% 
 

3 4 7% 

5 1 2% 
 

4 1 2% 

7 2 3% 
 

5 2 3% 

    
6 1 2% 

 
Speed tests match reported typical download speeds or are within 1 speed tier: No 
 
#/% of computer based speed tests verifying coverage area: 
Number of computer based speed tests reported inside coverage area: 41/58 (70.69%) 
Number of computer based speed tests reported outside coverage area: 17/58 (29.31%) 
 
Form 477Verification: 
#/% of tracts reported as served to FCC that overlaps with coverage area: 71/71 
#/% of tracts reported as served to FCC but do not intersect coverage area: 0/71 
 
Unserved areas: 
Number of unserved areas reported within coverage area via broadband.maryland.gov:  
159/202 (78.7%) 
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Number of unserved areas reported within coverage area via mdbroadbandmap.org: 
41/58 (70.7%) 
Of census blocks reported as served, how many have zero population based on 2000 census 
data? N/A 
 
Web Search Verification: N/A 
 
Wireless Verification:  

Sprint Wireless Verification Table Count Percentage 

Total # of sample points 1466   

Number of sample points with results 1122 76.5% 

Verified served AND BSP says served   (yes,yes) 932 83.1% 

Verified served AND BSP says unserved   (yes,no) 190 16.9% 

Verified unserved AND BSP says served   (no,yes) 166 11.3% 

Verified unserved AND BSP says unserved   (no,no) 178 12.1% 
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StarBand Communications Inc. 
DBA Name: StarBand Communications Inc. 
 
Data Characteristics 
Date of Original Submission:       1/26/2010 
Date of Update Submission:       N/A 
Currency of Data:        January 2011 
FRN:           0005087457 
Type of data submitted:        Coverage 
Census Block Count:                      N/A   
Total Matched Address Points Count:     N/A 
Unmatched Address Points:       N/A 
Number of Technology of Transmission Types:    1 
Provided Max Advertised Download Speed:     Complete 
Provided Max Advertised Upload Speed:      Complete 
Provided Max Typical Download Speed:      Complete 
Provided Max Typical Upload Speed:      Complete 
Provided Middle Mile:        No 
Provided Road Segments for census blocks greater than 2 sq miles: No 
 
Data Processing 
Coverage Area Process: 

 Repair Geometry on delivered coverage area 

 Perform Topology on coverage area 
o Rule: Coverage area should not overlap 
o Load coverage area into the NTIA data model 

 Result: BB_Service_Wireless 
Speed Domains: 

 Typical Upstream speed < 2 
o Calculated Typical Upstream speed to 2 

 
Data Verification 
Maximum down/upload speeds reported by provider:  

Max Download Category Count % of Area 
 

Max Upload Category Count % of Area 

3 1 100% 
 

2 1 100% 
 
Typical down/upload speeds reported by provider: 

Typical Download Category Count % of Area 
 

Typical Upload Category Count % of Area 

3 1 100% 
 

2 1 100% 
 
Typical down/upload speed from 2010 mobile speed test: N/A 
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Speed tests match reported typical speeds or are within 1 speed tier:  N/A 
 
# of mobile speed tests verifying coverage area:  
Number of mobile speed tests reported inside coverage area: N/A 
Number of mobile speed tests reported outside coverage area: N/A 
 
Form 477Verification: 
#/% of tracts reported as served to FCC that overlaps with coverage area: 34/34 (100.0%) 
#/% of tracts reported as served to FCC but do not intersect coverage area: 0 
 
Unserved areas: 
Number of unserved areas reported within coverage area via broadband.maryland.gov:  
202/202 (100.0%) 
Number of unserved areas reported within coverage area via broadband.maryland.gov:  
58/58 (100.0%) 
 
Of census blocks reported as served, how many have zero population based on 2000 census 
data? N/A 
 
Web Search Verification: N/A 
 
Wireless Verification: N/A 
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Starpower Communications, LLC 
DBA Name: RCN & RCN Business Solutions 
 
Data Characteristics 
 
Date of Original Submission:       3/5/2010 
Date of Update Submission:       3/1/2011 
Currency of Data:        December 2010 
FRN:           0003735016 
Type of data submitted:        Address Table 
Census Block Count:                     1291   
Total Matched Address Points Count:     7774 
Unmatched Address Points:       57 
Number of Technology of Transmission Types:    1 
Provided Max Advertised Download Speed:     Complete 
Provided Max Advertised Upload Speed:      Complete 
Provided Max Typical Download Speed:      Complete 
Provided Max Typical Upload Speed:      Complete 
Provided Middle Mile:        Yes 
Provided Road Segments for census blocks greater than 2 sq miles: Yes 
 
Data Processing 
 
Address Table Process: 

 Geocode address table to Maryland Property View address locator 
o Number matched: 7750 
o Number unmatched: 81 

 Unmatched address are geocoded to Maryland street centerline address locator 
o Number matched: 24 
o Number unmatched: 57 

 Merge matched addresses 

 Spatially join address points to 2000 census blocks 

 Select by location the address points that are completely within a greater than two 
square mile census block 

o Export as address points to be loaded into the NTIA data model 
 Result: BB_Service_Address 

o Switch the selection and export as points to create census blocks 
Census Block Process: 

 Join the switched selection (BB_Service_Address) address points to the 2000 census 
blocks based on the BLK2000 field  

o Export results  
o Load exported results into the NTIA data model  
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 Result: BB_Service_CensusBlock 
 
Data Verification 
Maximum down/upload speeds reported by provider:  
Census Blocks 

Max Download Category Count % of Blocks 
 

Max Upload Category Count % of Blocks 

4 135 10% 
 

2 378 29% 

5 243 19% 
 

3 553 43% 

6 5 0% 
 

4 360 28% 

7 908 70% 
     

Typical down/upload speeds reported by provider:  
Census Blocks 

Typical Download Category Count % of Blocks 
 

Typical Upload Category Count % of Blocks 

4 135 10% 
 

2 378 29% 

5 243 19% 
 

3 553 43% 

6 5 0% 
 

4 360 28% 

7 908 70% 
     

Typical down/upload speed from 2010 computer based speed test:  

Speed Test Download Tier Count % of Tests   Speed Test Upload Tier Count % of Tests 

4 8 7%   2 81 69% 

5 29 25%   3 3 3% 

6 42 36%   4 34 29% 

7 38 32%         

10 1 1%     
   

Speed tests match reported typical download speeds or are within 1 speed tier:  Yes 
 
%/# of census blocks verified by 2010 computer based speed tests:  

Confirmation of census block served 62 

Census blocks served, not reported by provider 2 

Total number of served census blocks reported by provider 1291 

% of served census blocks confirmed by speed test 4.8025% 
 
Form477 Verification: 
Number of census blocks reported to project, but no tract reported to FCC: 2 
Number of tracts reported to FCC, but no census blocks reported to project: 5 
 
Unserved areas: 
Number of census blocks with unserved areas reported via broadband.maryland.gov: 1 
Total number of unserved areas reported per provider via broadband.maryland.gov: 2 
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Number of census blocks with unserved areas reported via mdbroadbandmap.org: 0 
Total number of unserved areas reported per provider via mdbroadbandmap.org: 0 
 
Of census blocks reported as served, how many have zero population based on 2000 census 
data?  38/1291 (3%) 
 
Web Search Verification: 4/1291 (0.3%) of census blocks were confirmed using online search 
feature of given provider 

Starpower WebSearch Verification Table Count Percentage 

Total # of sample points 1496   

Number of sample points with results 55 4% 

Result is yes and census block is in served area  4 7% 

Result is yes but not in a census block reported as served    0 0% 

Result is no and census block is in served area 0 0% 

Result is no and census block not served area 51 93% 
 
Census blocks that are outside Cable Franchise Boundary: 1/1291 (0.01%) 
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Tata Communications (America) Inc. 
DBA Name:  Tata Communications (America) Inc. 
 
Data Characteristics 
 
Date of Original Submission:       2/1/2010 
Date of Update Submission:       8/26/2010 
Currency of Data:        August 2010 
FRN:           0009480302 
Type of data submitted:        Address Table 
Census Block Count:                      1   
Total Matched Address Points Count:     1 
Unmatched Address Points:       0 
Number of Technology of Transmission Types:    1 
Provided Max Advertised Download Speed:     Complete 
Provided Max Advertised Upload Speed:      Complete 
Provided Max Typical Download Speed:      No  
Provided Max Typical Upload Speed:      No  
Provided Middle Mile:        No 
Provided Road Segments for census blocks greater than 2 sq miles: No 
 
Data Processing 
 
Address Table Process: 

 Geocode address table to Maryland Property View address locator 
o Number matched: 1 
o Number unmatched: 0 

 Spatially join address points to 2000 census blocks 

 Select by location the address points that are completely within a greater than two 
square mile census block 

o Export as address points to be loaded into the NTIA data model 
 Result: BB_Service_Address 

o Switch the selection and export as points to create census blocks 
Census Block Process: 

 Join the switched selection (BB_Service_Address) address points to the 2000 census 
blocks based on the BLK2000 field  

o Export results  
o Load exported results into the NTIA data model  

 Result: BB_Service_CensusBlock 
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Data Verification 
 
Maximum down/upload speeds reported by provider:  
Census Blocks 

Max Download Category Count % of Blocks 
 

Max Upload Category Count % of Blocks 

4 1 100% 
 

4 1 100% 
 
Typical down/upload speeds reported by provider: N/A 
 
Typical down/upload speed from 2010 computer based speed test:  

Speed Test Download Tier Count % of Tests 
 

Speed Test Upload Tier Count % of Tests 

0 1 100% 
 

2 1 100% 
 
Speed tests match reported typical downloaded speeds or are within 1 speed tier:  N/A 
 
%/# of census blocks verified by 2010 computer based speed tests:  

Confirmation of census block served 0 

Census blocks served, not reported by provider 1 

Total number of served census blocks reported by provider 1 

% of served census blocks confirmed by speed test 0.00% 
 
Form477 Verification: 
Number of census blocks reported to project, but no tract reported to FCC: 1 
Number of tracts reported to FCC, but no census blocks reported to project: 1 
 
Unserved areas: 
Number of census blocks with unserved areas reported via broadband.maryland.gov: 0 
Total number of unserved areas reported per provider via broadband.maryland.gov: 0 
 
Number of census blocks with unserved areas reported via mdbroadbandmap.org: 0 
Total number of unserved areas reported per provider via mdbroadbandmap.org: 0 
 
Of census blocks reported as served, how many have zero population based on 2000 census 
data?  1/1 (100%) 
 
Web Search Verification: N/A 
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T-Mobile USA, Inc. 
DBA Name: T-Mobile USA, Inc. 
 
Data Characteristics 
 
Date of Original Submission:       2/25/2010 
Date of Update Submission:       3/11/2011 
Currency of Data:        December 2010 
FRN:           0006945950 
Type of data submitted:        Coverage Area 
Census Block Count:                      N/A   
Total Matched Address Points Count:     N/A 
Unmatched Address Points:       N/A 
Number of Technology of Transmission Types:    1 
Provided Max Advertised Download Speed:     Complete 
Provided Max Advertised Upload Speed:      Complete 
Provided Max Typical Download Speed:      No 
Provided Max Typical Upload Speed:      No 
Provided Middle Mile:        Yes 
Provided Road Segments for census blocks greater than 2 sq miles: No 
 
Data Processing 
 
Coverage Area Process: 

 Repair Geometry on delivered coverage area 

 Remove coverage areas less than 0.125 square miles 

 Remove coverage area “holes” less than 0.125 square miles 

 Simplify Polygon of coverage area 

 Load coverage area into the NTIA data model 
o Result: BB_Service_Wireless 

 
Data Verification 
Maximum down/upload speeds reported by provider:  

Max Download Category Count % of Area 
 

Max Upload Category Count % of Area 

4 1 100% 
 

2 1 100% 

6 1 100% 
 

4 1 100% 
 
Typical down/upload speeds reported by provider: N/A 
  
Typical down/upload speed from 2010 mobile speed test:  

Speed Test Download Tier Count % of Tests 
 

Speed Test Upload Tier Count % of Tests 

0 1933 59% 
 

1 302 9% 
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3 770 23% 
 

2 1559 47% 

5 548 17% 
 

3 1341 41% 

6 49 1% 
 

4 83 3% 

    
5 5 0% 

    
6 1 0% 

    
7 5 0% 

    
8 4 0% 

 
Speed tests match reported typical speeds or are within 1 speed tier:  N/A 
 
#/% of computer based speed tests verifying coverage area:  
Number of mobile speed tests reported inside coverage area: 3258/3300 (98.7%) 
Number of mobile speed tests reported outside coverage area: 42/3300 (1.3%) 
 
Form477 Verification: 
#/% of tracts reported as served to FCC that overlaps with coverage area: N/A 
#/% of tracts reported as served to FCC but do not intersect coverage area: N/A 
 
Unserved areas: 
Number of unserved areas reported within coverage area via broadband.maryland.gov:  
52/202 (25.7%) 
Number of unserved areas reported within coverage area via mdbroadbandmap.org:  
3/58 (5.2%) 
 
Of census blocks reported as served, how many have zero population based on 2000 census 
data? N/A 
 
Web Search Verification: N/A 
 
Wireless Verification: 

TMobile Wireless Verification Table Count Percentage 

Total # of sample points 1466   

Number of sample points with results 452 30.8% 

Verified served AND BSP says served   (yes,yes) 174 38.5% 

Verified served AND BSP says unserved   (yes,no) 278 61.5% 

Verified unserved AND BSP says served   (no,yes) 180 12.3% 

Verified unserved AND BSP says unserved   (no,no) 834 56.9% 
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TWTelecom of Maryland, LLC 
DBA Name:  TWTelecom of Maryland, LLC 
 
Data Characteristics 
 
Date of Original Submission:       1/30/2010 
Date of Update Submission:       3/10/2011 
Currency of Data:        March 2011 
FRN:           0017348202 
Type of data submitted:        Address table 
Census Block Count:                      52   
Total Matched Address Points Count:     78 
Unmatched Address Points:       0 
Number of Technology of Transmission Types:    1 
Provided Max Advertised Download Speed:     Complete 
Provided Max Advertised Upload Speed:      Complete 
Provided Max Typical Download Speed:      No  
Provided Max Typical Upload Speed:      No  
Provided Middle Mile:        Yes 
Provided Road Segments for census blocks greater than 2 sq miles: No 
 
Data Processing 
 
Address Table Process: 

 Geocode address table to Maryland Property View address locator 
o Number matched: 78 
o Number unmatched: 1 

 Unmatched address are geocoded to Maryland street centerline address locator 
o Number matched: 1 
o Number unmatched: 0 

 Merge matched addresses 

 Spatially join address points to 2000 census blocks 

 Separate and export the address points according to technology of transmission  

 Select by location the address points that are completely within a greater than two 
square mile census block 

o Export as address points to be loaded into the NTIA data model 
 Result: BB_Service_Address 

o Switch the selection and export as points to create census blocks 
Census Block Process: 

 Join the switched selection (BB_Service_Address) address points to the 2000 census 
blocks based on the BLK2000 field  

o Export results for each technology of transmission 
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o Load exported results into the NTIA data model  
 Result: BB_Service_CensusBlock 

 
Data Verification 
 
Maximum down/upload speeds reported by provider:  

Max Download Category Count % of Blocks 
 

Max Upload Category Count % of Blocks 

3 13 23% 
 

3 13 23% 

4 16 29% 
 

4 16 29% 

5 5 9% 
 

5 5 9% 

6 3 5% 
 

6 3 5% 

7 9 16% 
 

7 9 16% 

8 3 5% 
 

8 3 5% 

9 2 4% 
 

9 2 4% 

10 2 4% 
 

10 2 4% 

11 3 5% 
 

11 3 5% 

 
Typical down/upload speeds reported by provider: N/A 
 
Typical down/upload speed from 2010 computer based speed test: N/A 
 
Speed tests match reported typical download speeds or are within 1 speed tier:  N/A 
 
%/# of census blocks verified by 2010 computer based speed tests: N/A 
 
Form477 Verification: 
Number of census blocks reported to project, but no tract reported to FCC: 15 
Number of tracts reported to FCC, but no census blocks reported to project: 13 
 
Unserved areas: 
Number of census blocks with unserved areas reported via broadband.maryland.gov: 0 
Total number of unserved areas reported per provider via broadband.maryland.gov: 0 
 
Number of census blocks with unserved areas reported via mdbroadbandmap.org: 0 
Total number of unserved areas reported per provider via mdbroadbandmap.org: 0 
 
Of census blocks reported as served, how many have zero population based on 2000 census 
data? 28/52 (54%) 
 
Web Search Verification: N/A 
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Vector Data Systems LLC 
DBA Name: Vector Data Systems LLC 
 
Data Characteristics 
Date of Original Submission:       February 2010 
Date of Update Submission:       2/28/2011 
Currency of Data:        December 2010 
FRN:           0017306663 
Type of data submitted:        Coverage Area 
Census Block Count:                      N/A   
Total Matched Address Points Count:     N/A 
Unmatched Address Points:       N/A 
Number of Technology of Transmission Types:    1 
Provided Max Advertised Download Speed:     Complete 
Provided Max Advertised Upload Speed:      Complete 
Provided Max Typical Download Speed:      Complete 
Provided Max Typical Upload Speed:      Complete 
Provided Middle Mile:        No 
Provided Road Segments for census blocks greater than 2 sq miles: No 
 
Data Processing 
Coverage Area Process: 

 Repair Geometry on delivered coverage area 

 Remove coverage areas less than 0.125 square miles 

 Remove coverage area “holes” less than 0.125 square miles 

 Simplify Polygon of coverage area 

 Load coverage area into the NTIA data model 
o Result: BB_Service_Wireless 

 
Data Verification 
Maximum down/upload speeds reported by provider:  

Max Download Category Count % of Area 
 

Max Upload Category Count % of Area 

5 1 100% 
 

5 1 100% 
 
Typical down/upload speeds reported by provider: 

Typical Download Category Count % of Area 
 

Typical Upload Category Count % of Area 

6 1 100% 
 

4 1 100% 
 
Typical down/upload speed from 2010 mobile speed test: N/A 
 
Speed tests match reported typical download speeds or are within 1 speed tier:  N/A 
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#/% of mobile speed tests verifying coverage area:  
Number of mobile speed tests reported inside coverage area: N/A 
Number of mobile speed tests reported outside coverage area: N/A 
 
Form 477Verification: 
#/% of tracts reported as served to FCC that overlaps with coverage area: 5/5 (100.0%) 
#/% of tracts reported as served to FCC but do not intersect coverage area: 0 
 
Unserved areas: 
Number of unserved areas reported within coverage area via broadband.maryland.gov:  
4/202 (2.0%) 
Number of unserved areas reported within coverage area via mdbroadbandmap.org:  
0/58 (0.0%) 
 
Of census blocks reported as served, how many have zero population based on 2000 census 
data? N/A 
 
Web Search Verification: N/A 
 
Wireless Verification: N/A 
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Verizon Communications Inc 
DBA:  Verizon Maryland Inc 
 
Data Characteristics 
Date of Original Submission:       2/15/2010 
Date of Update Submission:       2/10/2011 
Currency of Data:        December 2010 
FRN:           0002166825 
Type of data submitted:        Census Block Table 
Census Block Count:                      57200   
Total Matched Address Points Count:     N/A 
Unmatched Address Points:       N/A 
Number of Technology of Transmission Types:    2 
Provided Max Advertised Download Speed:     Complete 
Provided Max Advertised Upload Speed:      Complete 
Provided Max Typical Download Speed:      No  
Provided Max Typical Upload Speed:      No  
Provided Middle Mile:        Yes 
Provided Road Segments for census blocks greater than 2 sq miles: Yes 
 
Data Processing 
 
Census Block Process: 

 Join the switched selection (BB_Service_Address)  address points to the 2000 census 
blocks based on the BLK2000 field  

o Export results for each technology of transmission 
o Load exported results into the NTIA data model  

 Result: BB_Service_CensusBlock 
 
Data Verification 
 
Maximum down/upload speeds reported by provider:  
Census blocks 

Max Download Category Count % of Blocks 
 

Max Upload Category Count % of Blocks 

5 742 1% 
 

3 12256 17% 

6 11515 16% 
 

7 59229 83% 

9 59229 83% 
    Road segments 

Max Download Category Count % of Segments 
 

Max Upload Category Count % of Segments 

5 173 3% 
 

3 1726 33% 

6 1553 30% 
 

7 3464 67% 

9 3464 67% 
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Typical down/upload speeds reported by provider: N/A 
 
Typical down/upload speed from 2010 computer based speed test:  

Speed Test Download Tier Count % of Tests 
 

Speed Test Upload Tier Count % of Tests 

0 414 8% 
 

1 449 9% 

3 565 11% 
 

2 1590 31% 

4 958 19% 
 

3 53 1% 

5 283 6% 
 

4 717 14% 

6 545 11% 
 

5 1126 22% 

7 1902 37% 
 

6 524 10% 

8 420 8% 
 

7 646 13% 

9 24 0.5% 
 

8 18 0.4% 

10 12 0.2% 
     

Speed tests match reported typical download speeds or are within 1 speed tier:  N/A 
 
%/# of census blocks verified by 2010 computer based speed tests:  

Confirmation of census block served 1924 

Census blocks served, not reported by provider 49 

Total number of served census blocks reported by provider 57200 

% of served census blocks confirmed by speed test 3.7% 
 
Form 477 Verification: 
Number of census blocks reported to project, but no tract reported to FCC: 3382 
Number of tracts reported to FCC, but no census blocks reported to project: 1 
 
Unserved areas: 
Number of census blocks with unserved areas reported via broadband.maryland.gov: 91 
Total number of unserved areas reported per provider via broadband.maryland.gov: 111 
 
Number of census blocks with unserved areas reported via mdbroadbandmap.org: 26 
Total number of unserved areas reported per provider via mdbroadbandmap.org: 28 
 
Of census blocks reported as served, how many have zero population based on 2000 census 
data?  6572/57200 (12%) 
 
Web Search Verification: 479/57200 (1%) of census blocks were confirmed using online search 
feature of given provider 

VerizonMD Web Search Verification Table Count Percentage 

Total # of sample points 1496   

Number of sample points with results 1435 96% 
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Result is yes and census block is in served area  479 33% 

Result is yes but not in a census block reported as served    39 3% 

Result is no and census block is in served area 513 36% 

Result is no and census block not served area 402 28% 
 
Census blocks that are outside DSL boundary:  15088/57200 (26.4%) 
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Wildblue Communications, Inc 
DBA Name: Wildblue Communications, Inc 
 
Data Characteristics 
 
Date of Original Submission:       4/21/2010 
Date of Update Submission:       7/22/2010 
Currency of Data:        December 2010 
FRN:           0007843766 
Type of data submitted:        Coverage Area 
Census Block Count:                      N/A   
Total Matched Address Points Count:     N/A 
Unmatched Address Points:       N/A 
Number of Technology of Transmission Types:    1 
Provided Max Advertised Download Speed:     Complete 
Provided Max Advertised Upload Speed:      Complete 
Provided Max Typical Download Speed:      Complete 
Provided Max Typical Upload Speed:      Complete 
Provided Middle Mile:        No 
Provided Road Segments for census blocks greater than 2 sq miles: No 
 
Data Processing 
Coverage Area Process: 

 Repair Geometry on delivered coverage area 

 Perform Topology on coverage area 
o Rule: Coverage area should not overlap 
o Load coverage area into the NTIA data model 

 Result: BB_Service_Wireless 
Speed Domains: 

 Typical Downstream Speed < 3  
o Calculated Typical Downstream Speed to 3 

 Typical Upstream Speed < 2 
o Calculated Typical Upstream Speed to 2 

 
Data Verification 
Maximum down/upload speeds reported by provider:  

Max Download Category Count % of Area 
 

Max Upload Category Count % of Area 

4 1 100% 
 

2 1 100% 
 
Typical down/upload speeds reported by provider: 

Typical Download Category Count % of Area 
 

Typical Upload Category Count % of Area 

3 1 100% 
 

2 1 100% 
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Typical down/upload speed from 2010 mobile speed test: N/A 
 
Speed tests match reported typical download speeds or are within 1 speed tier:  N/A 
 
#/% of mobile speed tests verifying coverage area:  
Number of mobile speed tests reported inside coverage area: N/A 
Number of mobile speed tests reported outside coverage area: N/A 
 
Form 477Verification: 
#/% of tracts reported as served to FCC that overlaps with coverage area: 214/14 (100.0%) 
#/% of tracts reported as served to FCC but do not intersect coverage area: 0 
 
Unserved areas: 
Number of unserved areas reported within coverage area via broadband.maryland.gov:  
202/202 (100.0%) 
Number of unserved areas reported within coverage area via mdbroadbandmap.org:  
58/58 (100.0%) 
 
Of census blocks reported as served, how many have zero population based on 2000 census 
data? N/A 
 
Web Search Verification: N/A 
 
Wireless Verification: N/A 
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XO Holdings, Inc 
DBA Name: XO Communications, LLC       
 
Data Characteristics 
 
Date of Original Submission:       2/1/2010 
Date of Update Submission:       N/A 
Currency of Data:        December 2010 
FRN:           0006275945 
Type of data submitted:        Addresses 
Census Block Count:                      344   
Total Matched Address Points Count:     363 
Unmatched Address Points:       136 
Number of Technology of Transmission Types:    3 
Provided Max Advertised Download Speed:     Complete 
Provided Max Advertised Upload Speed:      Complete 
Provided Max Typical Download Speed:      No  
Provided Max Typical Upload Speed:      No  
Provided Middle Mile:        No 
Provided Road Segments for census blocks greater than 2 sq miles: No 
 
Data Processing 
 
Address Table Process: 

 Geocode address table to Maryland Property View address locator 
o Number matched: 346 
o Number unmatched: 144 

 Unmatched address are geocoded to Maryland street centerline address locator 
o Number matched: 17 
o Number unmatched: 136 

 Merge matched addresses 

 Spatially join address points to 2000 census blocks 

 Separate and export the address points according to technology of transmission  

 Select by location the address points that are completely within a greater than two 
square mile census block 

o Export as address points to be loaded into the NTIA data model 
 Result: BB_Service_Address 

o Switch the selection and export as points to create census blocks 
Census Block Process: 

 Join the switched selection (BB_Service_Address)  address points to the 2000 census 
blocks based on the BLK2000 field  

o Export results for each technology of transmission 
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o Load exported results into the NTIA data model  
 Result: BB_Service_CensusBlock 

Speed Domains: 

 Symmetric Maximum Downstream Speed < 2 
o Calculated Symmetric Maximum Downstream to 2 

 Symmetric Maximum Upstream Speed < 2 
o Calculated Symmetric Maximum Upstream to 2 

 
Data Verification 
 
Maximum down/upload speeds reported by provider:  
Census Blocks 

Max Download Category Count % of Blocks 
 

Max Upload Category Count % of Blocks 

3 60 17% 
 

2 7 2% 

4 191 56% 
 

3 58 17% 

5 44 13% 
 

4 186 54% 

6 13 4% 
 

5 44 13% 

7 29 8% 
 

6 13 4% 

8 7 2% 
 

7 29 8% 

    
8 7 2% 

 
Typical down/upload speeds reported by provider:  N/A 
 
Typical down/upload speed from 2010 computer based speed test:  

Speed Test Download Tier Count % of Tests 
 

Speed Test Upload Tier Count % of Tests 

3 1 33% 
 

3 1 33% 

4 1 33% 
 

4 1 33% 

5 1 33% 
 

5 1 33% 
 
Speed tests match reported typical download speeds or are within 1 speed tier:  N/A 
 
%/# of census blocks verified by 2010 computer based speed tests:  

Confirmation of census block served 0 

Census blocks served, not reported by provider 3 

Total number of served census blocks reported by provider 344 

% of served census blocks confirmed by speed test 0.00% 
 
Form477 Verification: 
Number of census blocks reported to project, but no tract reported to FCC: 34 
Number of tracts reported to FCC, but no census blocks reported to project: 19 
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Unserved areas: 
Number of census blocks with unserved areas reported via broadband.maryland.gov: 4 
Total number of unserved areas reported per provider via broadband.maryland.gov: 4 
 
Number of census blocks with unserved areas reported via mdbroadbandmap.org: 1 
Total number of unserved areas reported per provider via mdbroadbandmap.org: 1 
 
Of census blocks reported as served, how many have zero population based on 2000 census 
data?  132/344 (38%) 
 
Web Search Verification: N/A 
 
Census blocks that are outside DSL boundary:  1/344 (0.3%) 
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Zayo Bandwidth LLC 
DBA Name: Zayo Bandwidth LLC 
 
Data Characteristics 
 
Date of Original Submission:       1/13/2011 
Date of Update Submission:       N/A 
Currency of Data:        December 2010 
FRN:           0019133826 
Type of data submitted:        Address Table 
Census Block Count:                      2   
Total Matched Address Points Count:     2 
Unmatched Address Points:       0 
Number of Technology of Transmission Types:    1 
Provided Max Advertised Download Speed:     Complete 
Provided Max Advertised Upload Speed:      Complete 
Provided Max Typical Download Speed:      Complete  
Provided Max Typical Upload Speed:      Complete  
Provided Middle Mile:        No 
Provided Road Segments for census blocks greater than 2 sq miles: No 
 
Data Processing 
 
Address Table Process: 

 Geocode address table to Maryland Property View address locator 
o Number matched: 2 
o Number unmatched: 0 

 Spatially join address points to 2000 census blocks 
Census Block Process: 

 Join the address points to the 2000 census blocks based on the BLK2000 field  
o Export results Load exported results into the NTIA data model  

 Result: BB_Service_CensusBlock 
 
Data Verification 
 
Maximum down/upload speeds reported by provider:  

Max Download Category Count % of Blocks 
 

Max Upload Category Count % of Blocks 

7 1 50% 
 

7 1 50% 

8 1 50% 
 

8 1 50% 
 
Typical down/upload speeds reported by provider:  

Typical Download Category Count % of Blocks 
 

Typical Upload Category Count % of Blocks 
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7 1 50% 
 

7 1 50% 

8 1 50% 
 

8 1 50% 
 
 
Typical down/upload speed from 2010 computer based speed test: N/A 
 
Speed tests match reported typical download speeds or are within 1 speed tier:  N/A 
 
%/# of census blocks verified by 2010 computer based speed tests: N/A 
 
Form477 Verification: 
Number of census blocks reported to project, but no tract reported to FCC: 2 
Number of tracts reported to FCC, but no census blocks reported to project: 1 
 
Unserved areas: 
Number of census blocks with unserved areas reported via broadband.maryland.gov: 0 
Total number of unserved areas reported per provider via broadband.maryland.gov: 0 
 
Number of census blocks with unserved areas reported via mdbroadbandmap.org: 0 
Total number of unserved areas reported per provider via mdbroadbandmap.org: 0 
 
Of census blocks reported as served, how many have zero population based on 2000 census 
data? 0/2 (0%) 
 
Web Search Verification: N/A  
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1 Introduction 
As an NTIA State Broadband Data and Development (SBDD) grant recipient, the State of 
Maine is undertaking a statewide project to inventory and map broadband services for 
inclusion in both national and state broadband maps.  The SBDD grantee project team for 
Maine consists of the ConnectME Authority (ConnectME), the Maine Office of GIS 
(MEGIS), and the James W. Sewall Company (Sewall).  The team is collecting broadband 
service availability data, including speeds and types of technology, as well as information on 
Community Anchor Institution (CAI) locations across the entire state.  The collected service 
data undergoes geospatial processing and verification steps before it is loaded into Maine’s 
broadband geodatabase.   This geodatabase is used to satisfy NTIA’s bi-annual submission 
requirements as well as support the ConnectME Authority’s statewide initiatives and 
programs. 
 
This whitepaper describes the deliverable datasets, the data collection process and the 
verification process. 
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2 Data Description 
The Maine team is providing spatial data representing provider coverage in the state as well 
as information on validation and verification processes.  Files provided are as follows: 
 
Filename Description 

ME_SBDD_2011_04_01.gdb Folder containing SBDD transfer file geodatabase 

ME_DataPackage_2011_04_01.xls DataPackage.xls file 

ME_2011_04_01.txt Data Submission Receipt file 

ME_Methodology_2011_04_01.pdf Methodology Paper file 

ReadMe_ME_2011_04_01.txt ReadMe file 
 

3 Provider Participation 
There were fifty-three potential providers identified in Maine, of which three were later 
found not to serve any addresses in Maine and were therefore not included in this analysis. 
 
The Maine team has utilized data from 62% of the companies operating in the state and will 
receive data from another 18% in the future for a combined total of 80% cooperation.  One 
firm (2%) would not provide data, and another 18% were simply not responsive to our 
attempts to communicate. 
 

Company Response Number 
% of Total 
Companies 

Will provide data 9 18% 
Will not provide data 1 2% 
Provided data 31 62% 
Non-responsive    9   18% 
 TOTAL 50 100% 

 
The fifty companies are those providing internet services to residential and business 
customers (78%), reselling internet service (16%), both providing directly and reselling (2%), 
and providing middle mile and internet backhaul services only (4%). 
 
Of the service providers, 72% have provided data, 13% were non-responsive, 13% will 
provide data in the future, and 2% refused to provide data without compensation. 
 
No resellers have provided data as of April 2011, except for the company that resells as well 
as offering its own service.  50% of the resellers have stated that they will provide data in the 
future, and the other 50% were non-responsive.   
 
Information on the providers is included on the ‘ProviderTable’ spreadsheet in the file 
datapackage.xls included with this delivery. 
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4 Data Collection and Integration 

4.1 Provider Outreach and Data Gathering 
Mapping broadband coverages across the State begins by identifying potential providers and 
contacting them to determine service capabilities and level of participation.  If a provider 
offers broadband level Internet service in Maine, the provider will be invited to participate in 
the project.  After executing a non-disclosure agreement (NDA), the provider submits data 
showing where services are offered, technology of transmission used, and maximum 
advertised downstream and upstream speeds.  The project team has developed a step by step 
process that has been captured by the high-level workflow shown in Figure 1.  Starting with 
contacting a service provider, the workflow allows a user to determine whether a provider 
should be included and if so what types of service are offered. 

 
Figure 1 - Provider Outreach and Data Gathering Workflow 
 
The task of reaching out to the provider community and gathering service data has five main 
tasks: Research Service Providers, Execute NDA, Gather Provider Data, Assess Provider 
Data, and Categorize Data for Production. 

4.1.1 Research Service Providers 
The Maine project team has established a service provider contact database, which contains 
contact information for all of the potential broadband service providers in the state.  The 
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initial set of providers was obtained from state and industry lists as well as Internet research.  
Ongoing management of the list is required because new providers begin offering services 
that qualify as broadband and changes occur to existing provider companies through mergers 
or acquisitions.   
 
Sewall initially contacts each provider by phone and introduces the project.  One purpose for 
the initial contact is to identify the individual at the provider company with whom the team 
should be working.  In some instances, especially for larger companies it may take multiple 
attempts before the appropriate person is reached. 
 
Another purpose is to determine if the company’s services meet the requirements for 
inclusion in the project.  If a company offers broadband level service in Maine then the next 
step is to determine the type(s) of service being offered, whether the service offerings are as 
an end-user provider or as a middle mile/back haul provider, and whether the company owns 
facilities or re-sells services using another carrier’s network.  Data from back haul carriers 
and resellers are included in the project. 
 
A third purpose behind the initial contact is to confirm that the provider wants to participate 
in project and is willing to submit data that represents its service offerings and coverages.  
Provider companies who elect to participate are invited to execute an NDA to protect those 
data items considered to be confidential or proprietary.  If a provider company does not want 
to participate, Sewall may look for assistance from the ConnectME Authority and the NTIA 
SBDD project team to encourage participation. 

4.1.2 Execute Non-Disclosure Agreement (NDA) 
The process of executing an NDA starts with sending a letter of introduction along with an 
NDA template and a copy of a ConnectME Protective Order.  Appendix A contains a sample 
letter.  The NDA template was drafted by the Maine law firm, Rudman & Winchell, based on 
confidentiality guidelines presented by NTIA and can be found in Appendix B.  A copy of 
the ConnectME Protective Order signed on 21 December 2009 at the request of many of the 
service providers is in Appendix C. 
 
Changes to the NDA template are negotiated with individual companies as needed.  Once 
finalized, the NDA is signed by the provider company, Sewall, and the ConnectME 
Authority before the data gathering process begins. 

4.1.3 Gather Provider Data 
More often than not after an NDA has been executed, a different individual at a provider 
company is identified as the primary contact for data submittals.  Once the contact is 
confirmed, a data submittal information sheet prepared by the project team is sent to the 
contact.  The data submittal sheet identifies the data items desired and has definitions from 
the SBDD NOFA.  The items requested include: 

� FRN or provider FCC Registration Number 

� Location and extents of service coverage 

� Technology of service 
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� Speeds of service including maximum advertised downstream & upstream speeds and 
typical downstream & upstream speeds 

� Tower and transmitter locations and transmission attributes (for fixed wireless 
service) 

� Middle mile and back haul connection points 

� Customer service locations (for wired and fixed wireless service) 

� Failed service locations (for wired and fixed wireless service) 

� Service to Community Anchor Institutions 
 
After sending the data submittal information Sewall follows up with the provider contact to 
review the requested data items and discuss potential formats for submitting data.  The team 
is cognizant of the wide range of environments operated by the provider companies and 
recognizes the need to accommodate submissions in many different formats including tabular 
(CSV, Excel, DBF), GIS (ESRI shapefile, ESRI geodatabase, MapInfo, Google KML/KMZ, 
CAD (AutoCAD, Microstation), and hardcopy.  The team also understands that many of the 
smaller providers in Maine are handicapped by a lack of resources in trying to comply with 
the project’s data submission requirements.  Some of the issues facing these providers 
include small staff sizes, lack of mapping technical expertise, and proprietary digital systems.  
Sewall lends technical assistance and expertise as needed. 
 
A file transfer site is currently used for providers to submit data.  The site utilizes HyperText 
Transmission Protocol, Secure (https), with password protected user accounts and separate 
folders for each provider.   

4.1.4 Assess Provider Data 
After data has been submitted by a provider, Sewall catalogues it and assesses the data files 
to see if all of the requested items were provided and what data types were received.  Sewall 
also verifies the locations and spatial definitions for the data items and checks for missing 
attribute information. Any questions generated are sent to the provider for clarification.  It is 
common for the initial submission to need multiple iterations of data exchanges and feedback 
before the submission is completed. 
 
Once an initial set of broadband service data is in place, follow-up rounds of data gathering 
will incorporate modifications to existing service coverages, service types, or service speeds.  
Later submittals by a provider could consist of an entire set of data records or may only 
contain updates since the previous submission.  Sewall’s integration processes are equipped 
with GIS and database tools to fold newer versions of provider records into the existing 
baseline.  The team anticipates that further development and refinement of these processes 
and tools will be made as more update submissions are received. 

4.1.5 Categorize Data for Production 
When data from a provider has been received and assessed, production processes are needed 
to integrate the data into the project database.  Section 4 of this paper describes the various 
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workflows to turn the submitted data into the SBDD data transfer model features and 
attributes. 
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4.2 Community Anchor Outreach and Data Gathering 
Community Anchor Institutions (CAI), as defined by NTIA NOFA category codes, consist of 
the following:  
 
Category 1: School – K through 12 
Category 2: Library 
Category 3: Medical/Healthcare 
Category 4: Public Safety 
Category 5: University, College, Other post secondary 
Category 6: Other community support – government 
Category 7: Other community support – non-governmental 
 
The three primary steps with the CAI are data gathering, data processing and attribution.   

4.2.1 Data Gathering 
Several data sources were utilized to represent all CAI categories across the state.  

State of Maine, Office of Geographic Information Sy stems (MEGIS)  

ARMORIES 
CEMA (County Emergency Management Agency) 
COLLEGES 
FIRE 
HOSPITAL 
HAS (Hospital Service Areas) 
MEAIR (Airports) 
POLICE 
REDCROSS 
RESCUE 
SCHLIB (Schools & Libraries) 

NAVTEQ-NAVSTREETS (Points of Interest) 

NAVTEQ-COMMSVC  
NAVTEQ-EDUINSTS 
NAVTEQ-HOSPITAL 
NAVTEQ-TRANSHUBS 

State of Maine – State Facilities 

State Facilities File  

Maine Department of Health & Human Services (DHHS) – Maine Care Services 

Hospitals 
Clinics/Rehab/Nursing 
Schools 
Pharmacies 
Home Care 
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Counseling/Psychologists 
Shared Living 
Mental Health 
School Departments 
Health related businesses 

Maine School and Library Network (MSLN) 

K-12 schools 
Public libraries 

Maine’s Research & Education Network (MaineREN) 

Universities & colleges 

Service Provider Data 

CAI data submitted by provider companies 

4.2.2 Data Processing 
The data processing task involved an in-depth cleaning and sorting of all CAI source records.  
Data is initially sorted as spatial (e.g., GIS layer) and non-spatial (e.g., table) data. The 
spatial data consisted of points and generally needed minimal formatting before loading into 
a personal geodatabase.  The non-spatial data required some initial format revisions to 
prepare the data for geocoding to generate spatial geometry.  The following descriptions 
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associated with Figure 2 below outline the overall workflow and processes involved.  
Figure 2 - Community Anchor Internal Workflow 
 
(1) Data Gathering 
Data gathering involves acquiring source data involving the seven categories defined by 
NTIA NOFA.  Data may originate from several sources including state, county, town, 
outreach programs, service providers and more.  Records are documented for metadata and 
given a level of confidence reflecting the data source, spatial accuracy and processing 
enhancements. 
 
(2) Data Processing 
The data processing phase separates the data sources into two types: flat file (non-spatial) and 
spatial.  A flat file refers to data or a table that contains 1 record per line, generally in the 
format of an .xls spreadsheet or .dbf table.  Without spatial coordinate values to translate to 
points, this type of data must be geocoded in ArcGIS.  Spatial data contains pre-defined 
coordinate values or is already in a format containing spatial geometry with a defined 
projection and can be imported directly. 
 
(3) Non-Spatial Data Source Formatting 
Non-spatial data files are scrubbed to ensure that all necessary fields are present and are 
formatted to run through the geocoding process.   
 
(3.1) Geocode Addresses/Load to Geodatabase 
Using the geocoding tool in ArcGIS, an address locator file must first be setup. The address 
locator file maps out the ConnectME street centerline fields and is used as a reference for the 
non-spatial data during the geocoding process.  The non-spatial data is saved as a .csv file.  
Shown below is a typical record formatted to geocode. 
 

Name Address1 City State Zip 
Healthworks 10 Bangor  Bangor ME 04401 

 
In this example, the geocoding process will reference or match this address record to the 
ConnectME street address locator and place a point at this location in the map layer. All 
records in the source file are processed at once.  Points are generated, based on how matching 
parameters or set.  Points are then loaded into personal geodatabase for final scrubbing and 
quality acceptance. 

Name Address1 City State Latitude Longitude 
Healthworks 10 Bangor St Bangor ME 46.1252 -67.8422 

 
(4) Spatial Data Source Formatting 
Spatial data sources are received as flat files with spatial coordinate values or reside in a GIS 
layer as points.  Each source type is processed differently. 
 
Flat files with coordinate values: 

� Prepare field name formats 

� Prepare coordinate values in decimal degrees 



  SBDD Process Documentation 
  April 2011 Delivery 

 Page 13 of 73 last revised 2011.03.31 

� Add X,Y data into ArcGIS, generating the point locations on the fly 

� Output to personal geodatabase for final scrubbing and quality acceptance 
 
Point files: 

� Export file to shapefile format if necessary 

� Project file to state coordinate system (UTM NAD83 Zone19 Meters) for 
compatibility with other data layers 

� Output to personal geodatabase for final scrubbing and quality acceptance 
 
(4.1) Load Spatial Data to Geodatabase 
All spatial data types (point files) are loaded into a personal geodatabase for final scrubbing 
and quality acceptance. 
 
(5) Data Analysis and Quality Control 
A final analysis is completed on all points loaded in the personal geodatabase to identify any 
issues.  The table below indicates the primary types of issues, the means to detect them, and 
the resulting solution. 
 

Issue   ⇒⇒⇒⇒ Identification   ⇒⇒⇒⇒ Result 
Duplicate Points Selection by location/imagery review Delete incorrect record 
Unmatched geocoded records Google Maps review Matched  record 
Inaccurate CAI locations Imagery review Modify point location 
Unsuitable CAI - Delete record 

 
(6) Data Categorizing 
Once the CAI records have gone through the data analysis and quality control, the records are 
given a category value of 1 to 7, as discussed in the introduction.  
 
(7) Data Attribution 
CAI attributes are the most difficult to acquire at the data gathering stage and are typically 
acquired through additional steps, including contacting each CAI. The required attributes are: 

� Broadband Service  

� Technology of Transmission  

� Advertised Downstream and Upstream Speeds  
 
The project team has completed the initial round of contacting each CAI to collect the above 
information. The task was completed by assembling a call center group assigned to 
contacting each CAI to establish a primary contact and address verification followed by 
exercising an on-line survey aimed to provide feedback to the items listed above.  Completed 
surveys were compiled through the use of SurveyMonkey.com and final survey output (.csv) 
was prepped and values were loaded into the CAI database to populate attributes.  
 
Additional sources and surveys have been utilized to populate the database including MSLN 
(Maine School and Library Network), NCES (National Center for Education Statistics), the 
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Maine Fiber Company as part of its Three-Ring Binder project, and state agency listings 
provided by the chief technical officer.  The project team will continue to compile CAI data 
utilizing all the above resources and research additional data sources and methodologies to 
populate these attributes. 
 
(8) Load Data to SDE for Final SBDD Export 
CAI data is loaded from the personal geodatabase to the SDE environment for final export to 
SBDD format. 

4.3 Data Analysis and Conversion 
Data is analyzed and converted with different processes, depending on its type and 
characteristics. 

4.3.1 Fixed Wired Transmission 
Fixed wired service provider companies in the state of Maine range from small to large 
businesses and utilize several distinct types of technology to deploy broadband service.  In 
order to accommodate the varied inputs, Sewall has developed a flexible and comprehensive 
workflow to incorporate provider information into a state broadband map developed by 
Sewall in conjunction with the ConnectME Authority. 
 
The ConnectME model depicts broadband service provider coverage at the street segment 
level.  The model uses a street centerline as the spatial component of the coverage, and a 
related table stores provider specific information for street segments.  Sewall developed 
production tools to accommodate the incorporation of service provider data into this 
ConnectME model and instill quality control into the process. 
 
The steps in the process for analyzing and converting Fixed Wired Transmission data are 
outlined in Figure 3 and described below.  
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Figure 3 - Data Flow for Fixed Wired Transmission Providers 
 
(1) Wired Service Provider Data 
The data bin is the storage location for wired broadband service provider data gathered by 
Sewall. 
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(2) Data Sort 
The data sort phase immediately follows the data collection process.  Analysts sort the wired 
data by provider and by data characteristics.  The wired data can consist of address data, 
predefined coverage data, flat file coverage data and unreferenced maps.  Individual 
workflows have been developed by Sewall for the various data formats. 
 
(3) Address Data 
The address data bin is reserved for service provider data that is at the address level.  
Examples of address data formats received are spreadsheet and text file format. 
 
(3.1) Load Address Data to Geodatabase 
Address data is formatted to meet the ArcGIS geocoder standards and loaded into the 
geodatabase for processing.  The formatting of the address data will include ensuring fields 
with the full street address and town name are populated in the dataset. 
 
(3.2) Geocode Process 
Formatted address data is geocoded using the ConnectME street centerline dataset.  The 
address locator style used in this process is the ArcGIS US Streets with Zone. For this 
process, the city fields of the ConnectME street dataset are utilized in the zone component of 
the locator. 
 
(3.3) QC Geocode Result 
Analysts review the address data geocode result for the following: 

� Overall geocode hit rate 

� Town geocode hit rates 

� Data anomalies 
If address data fails any of these checks the data will not pass QC acceptance. 
 
(3.4) Manual Correction of Data 
Address data that has not passed the QC acceptance is evaluated for corrections necessary for 
the data to pass QC acceptance.  Corrections to town names and updates to street names are 
commonly required to match the naming conventions in the ConnectME roads dataset. 
 
(3.5) Geocode Process Tool 
Sewall has developed an ArcGIS tool named Geocode Process Tool that translates the 
accepted geocoded address data into tabular address range records related to the 
accompanying ConnectME street centerlines.  This tool is shown in Figure 4 below. 
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Figure 4 - Geocode Process Tool 
Data Layers:(1) Geocoding Results - geocoded layer of address data (2) Roads Layer - ConnectME roads data 
layer (3) Provider Table - table of provider specific information (4) Service Table - broadband service output 
table where the service provider street address ranges are stored. 
Service Attributes:  The first six values are necessary to populate fields in the deliverable.  Source is used to 
designate that the records created are from the Geocode Process Tool. 
 
In ArcMap the user specifies which layers in the map correspond with the data layer inputs 
for the tool as well as the service provider service attributes that correspond with the geocode 
address point layer.  Once the information is set the user clicks ‘Start’ and the process begins. 
 
Each geocoded address point within the geocode layer has as an attribute the street segment 
that the address was geocoded to.  Using this street link, the tool can locate all of the 
geocoded address points assigned to a given street segment and build a modified street range 
of broadband service for the street segment.  The tool then creates a record in the Broadband 
Service table that contains a link to the street segment in the ConnectME street feature class 
and populates the record with the derived broadband service street segment range and 
specified service provider information.  This process is repeated for each unique street 
segment listed in the geocoded address point layer. 
 
(4) GIS Polygon Data 
The GIS polygon data bin is for service provider data that represents a coverage area of 
broadband availability and is delivered in a GIS format. 
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(4.1) QC Polygon Data 
Datasets from the GIS polygon data bin are reviewed by an analyst.  The QC routine ensures 
that the data has spatial integrity and includes the necessary attribution for inclusion to the 
state broadband project. 
 
(4.2) Polygon Cover Tool 
Sewall has developed an ArcGIS tool named Polygon Cover that converts service provider 
coverage area polygons into street segment related tabular records.  Each tabular record 
created by the tool incorporates the service provider broadband specification information as 
well as modified street ranges representing provider street coverage. 
 
This tool was initially created by Sewall for use on the fixed wireless viewshed datasets but 
was incorporated into the wired workflow for service providers that provided polygon 
regions of service coverage. 

 
Figure 5 - Polygon Cover Tool 
Data Layers:  (1) Roads Layer - ConnectME street centerline data layer with address ranges (2) Viewshed 
Layer - viewshed layer used in delineating visible polygons for clipping road segments.  For wired providers 
this would be the polygon layer that depicts a provider’s coverage area. (3) Provider Table - internal 
processing flag (4) Visible Roads (out) - output feature class that stores the clipped road segment geometry 
(5) Service Table (out) - output table that the extracted address ranges populate. 
Service Attributes:  The first seven values are necessary to populate fields in the deliverable.   
Require GRIDCODE = 1:  Toggle is unchecked when running a wired broadband provider dataset that is 
represented as a coverage area. 
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In ArcMap the user specifies which layers in the map correspond with the data layer inputs 
for the tool as well as setting the service attributes for the service provider polygon layer.  
While running the Polygon Cover tool for fixed wired service regions analysts ensure the 
Require GRIDCODE = 1 toggle is unchecked.  Since this tool was initially created for use 
with a viewshed polygon output, the tool will not run on a non-viewshed layer unless this 
toggle is unchecked.  Once the information is set the user clicks ‘Start’ and the process 
begins. 
 
The tool selects street segments from the input Roads layer that intersect the input polygon 
coverage and exports the street segments to a separate working file.  These streets are then 
clipped to the polygon coverage.  Next the tool runs a length ratio process that assigns each 
street segment a fractional value based on the clipped and original lengths.  The tool then 
populates modified street range attributes based on the length ratio of a segment and the 
original street range of a segment.  These modified street range values represent the 
broadband service street range of the provider.  For each street segment the tool also creates a 
record in the Broadband Service table that contains a link to the original street segment in the 
ConnectME street feature class and populates the record with the modified broadband service 
street segment range and specified service provider information. 
 
(5) GIS Street Data 
The GIS street data bin is for wired broadband provider data at the street segment level that is 
delivered in a GIS format. 
 
(6) GIS Block Data 
The GIS block data bin is for provider data that is delivered at the census block level in a GIS 
format. 
 
(7) Flat File Block Data 
Census block service data delivered in a flat file format is stored in the flat file block data 
bin.  Examples of flat file data are spreadsheets, text files and database files. 
 
(7.1) Join Census Block Spatial Data 
Flat file block provider coverage information is joined to a spatial census block layer using 
the full census block id value.  Blocks with provider information joined are exported creating 
a spatial representation of the provider’s census block broadband coverage. 
 
(8) Flat File Street Data 
The flat file street data bin is where provider data is stored when Sewall receives street level 
information in a format that cannot be associated spatially.  Examples of files types delivered 
in a flat file format are spreadsheet, database and text file. 
 
(9) Unreferenced Map Data 
Provider data that cannot be referenced in ArcGIS are stored in the unreferenced map data 
bin.  Examples of this type include paper maps and PDF documents. 
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(10) Census Block GIS Data 
This data is Census 2000 block data in GIS format for the state of Maine that has been 
downloaded from the US Census website.  
 
(11) Load Layers to GDB 
Provider GIS data is loaded into the Sewall SDE geodatabase.  A feature class is created for 
each provider’s dataset.  Sewall workflow tracking attributes are added to the feature classes. 
 
(12) QC Data 
Datasets are sent to a Sewall analyst for QC.  The QC routine is to ensure that the data 
includes the necessary information for inclusion to the state broadband project.  Provider data 
is cross-referenced with information on broadband availability that has been gathered from 
other sources.  The QC of datasets with spatial data includes additional QC routines to ensure 
spatial integrity.   
 
(13) Request more information on data source 
Broadband provider data that does not meet the QC acceptance criteria Sewall initiates a 
request order to the provider for additional information.  This request includes a detailed 
listing of the deficiencies found in the data as well as inquiries regarding spatial inaccuracies 
and anomalies discovered in the analysis. 
 
(14) Infill Process 
Sewall developed a tool named Infill to interact with the ConnectME street segments and 
populate related tabular records for fixed wired service provider availability.  The Infill Tool 
allows a user to configure a specific set of service provider parameters, select ConnectME 
street segments, and then view and edit the related broadband availability information in the 
Broadband Services table that corresponds with the configured attributes.  This tool is used to 
input fixed wired broadband availability data that Sewall received as census block, street or 
unreferenced map data.  The majority of fixed wired service provider datasets utilize the 
Infill Tool for processing.  A screenshot of the configuration dialog box is shown as Figure 6 
below. 
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Figure 6 - Infill Tool Configuration 
Data Layers: (1) Roads Layer: ConnectME roads data layer (2) Provider Table: Internal processing flag (3) 
Service Table: Broadband Service output table where the service provider street address ranges are stored. 
Service Attributes: These fields are necessary to populate fields in the deliverable. 
 
The first time a user uses the Infill tool in an ArcMap session, the ‘Infill Config’ screen 
appears.  The user enters the input data layers and the attributes for the service provider 
dataset that the tool will utilize during processing. 
 
Once the Infill Config screen has been set a user selects one or more ConnectME road 
segments.  Using the unique primary key values of the selected streets and the specified 
provider name and technology of transmission the tool searches the Broadband Services table 
for existing matching tabular records.  If matches are found from this search, the tool reports 
the information in the Infill window.  For selected street segments where no match was found 
in the Broadband Services table, the tool populates the Infill window with street segment 
road name and street range attributes representing potential broadband service ranges for the 
provider on the selected streets.  These street range attributes can be updated in the Infill 
window based on provider sources.  This Infill tool window is shown as Figure 7.  
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Figure 7 - Infill Tool 
Data Layers: (1) Roads Layer: ConnectME roads data layer (2) Service Table: Broadband Service output table 
where the service provider street address ranges are stored  
Config: Opens the Infill Config window (Figure 6)  
Service Attributes: These fields are necessary to populate fields in the deliverable. 
Source: Internal flag for source of service availability 
Update: Updates selected tabular records SOURCE field to the value entered in the Source field 
Tabular Record Attributes: (1) RDNAME: Name of ConnectME road segment (2) Op: Operation being 
performed {INSERT-new tabular record, UPDATE-update existing tabular record, DELETE-delete tabular 
record} (3) L_FROM: “Left from” broadband address range of ConnectME road segment (4) L_TO: “Left to” 
broadband address value of ConnectME road segment (5) R_FROM: “Right from” broadband address value of 
ConnectME road segment (6) R_TO: “Right to” broadband address value of ConnectME road segment 
(7) Range: Reports either “full” or “partial” and is a comparison for each tabular record of the broadband 
provider street range to the accompanying ConnectME street range (8) SOURCE: Internal process flag. 
 
Once the user has reviewed the values, pressing ‘OK’ will perform the operations listed in 
the Op field. 
 
(15) ConnectME Street Data 
The ConnectME street data bin contains the street centerline dataset used in the geocode and 
street relate processes.  The Maine Office of GIS E-911 street centerline file was used to 
create the base street segments and gives the project the most accurate street centerline file 
for the State of Maine.  The NAVTEQ street centerline dataset NAVSTREETS was utilized 
to infill street segments in areas where gaps were assessed in the MEGIS E-911 file. 
 
(16) Relate Process 
Through the use of Sewall developed tools the data gathered for fixed wired broadband 
service providers gets stored in the Broadband Services table as availability street ranges 
associated with street centerline segments.  Each record in the Broadband Services table is 
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associated by a foreign key/primary key relationship with a street segment in the ConnectME 
street centerline dataset.  This relationship allows for clean and easy access to street level 
availability of service providers.   
 
(17) Broadband Services Table 
The Broadband Services geodatabase table was developed by Sewall to store broadband 
service provider information and street range coverage.  NTIA requirements and formats 
were utilized when creating the fields to ensure the records stored in the Broadband Service 
table are compatible with the SBDD data model. 
 
(18) Intelligent Street Centerlines 
The output from the fixed wired workflow is a comprehensive intelligent street centerline 
network comprised of street centerlines and related service availability tabular records. 

4.3.2 Fixed Wireless Transmission 
The initial stage of mapping terrestrial fixed wireless service territories depends on the 
quality of the data received.  To process any service footprint of a particular transmitter, the 
initial resources acquired during the data collection phase of the project are critical.   
 
Terrestrial Fixed Wireless technology is clouded by many variables that determine the 
overall performance of each transmitter signal.  Inaccurate data pertaining to location, height 
of a transmitter, horizontal and vertical limitations, signal range and many more factors 
present potential obstacles to producing an accurate representation of any transmitter’s 
service footprint.  Some of these factors have not been considered during the mapping 
process due to lack of data needed for modeling them.  For example, while a 10-meter DEM 
is used to represent the surface terrain, we have not incorporated obstructions on the surface 
such as trees and other man-made obstacles that could influence a transmitter’s propagation 
model. 
 
The data collection process and subsequent conversion workflow is designed to 
accommodate a variety of data sources received from the service providers and production 
tools have been developed to build efficiencies and quality control into the workflow.  When 
received by the service providers, supplemental data is used throughout the conversion 
workflow to help verify the mapping results.  However, a larger scale verification process is 
described in Section 5. 
 
The data conversion process for fixed wireless transmission is represented by Figure 8 and 
described below. 
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Figure 8 - Fixed Wireless Internal Conversion Workflow 
 
(1) Fixed Wireless Service Provider Data 
Service provider data gathered during the data collection phase. Data is cataloged in separate 
folders by provider and managed according to task and technology of transmission. 
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(2) Data Sort 
The data sort phase of production immediately follows the data collection process. During 
this task, a thorough review of the service provider data determines the type of data received.  
Fixed wireless data generally consists of three types: transmitter coordinates and attributes, 
pre-defined polygons and attributes, and supplemental data. Each type of data follows unique 
internal processing steps. 
 
(3) Transmitter Coordinates and Processing 
Transmitter coordinate data is essentially the raw data necessary to generate a viewshed for 
each transmitter.  In order to be processed, the transmitter source data must have certain 
required fields such as latitude and longitude, spot (ground elevation), equipment height at 
the transmitting and receiving ends, horizontal and vertical limitations, and range of 
transmission.  The content of the transmitter data is carefully reviewed for completeness and 
overall consistency prior to the next step.  Once completed, the data is imported into ArcGIS 
for continued processing and quality control. 
 
(3B) Load Transmitter Data into Personal Geodatabase 
Using the newly scrubbed .csv file, transmitter points are created in ArcGIS and the 
transmitter location points are displayed.  A final comparison against supplemental data is 
performed to ensure the transmitter locations are in the correct locations.  Supplemental data 
includes such layers as imagery, political boundaries, and road centerlines. 
 
(3C) Run Tower Cover Tool 
This tool was designed and developed by Sewall to batch process 1 or more transmitter point 
viewsheds.  A screenshot of the tool is shown below as Figure 9. 

 
Figure 9 - Tower Cover Tool (Viewshed Production) 
Tower Points: The data layer containing records of all transmitters that need a viewshed 
generated.  Originally received from ISP and pre-processed by Sewall for format 
compatibility.  
DEM:  10-meter digital elevation model obtained from MEGIS as the primary surface model 
for generating the viewshed 
Visible Polygons (out): Visible polygons (only) output to an SDE layer 
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Output location:  Location of output to personal geodatabase workspace to be used for 
additional processing. 
 
(3D) Fixed Wireless Coverage Polygons 
The Tower Cover Tool generates raster data sets depicting the visible and non-visible 
surfaces representing each transmitter.  As a final output, the tool extracts the visible 
components of the raster data and outputs to polygon vector layers stored in the SDE 
environment as supplemental reference data.  
 
(3E) Run Sewall Polygon Cover Tool 
This tool was designed and developed by Sewall to facilitate several production steps.  
 

 
Figure 10 - Polygon Cover Tool 
Data Layers: (1) Roads Layer - ConnectME Street data layer with address ranges ( 
2)Viewshed Layer - viewshed layer used toe delineate visible polygons for clipping road 
segments (3)Provider Table - internal processing flag (4) Visible Roads (out) - output feature 
class that stores the clipped road segment geometry (5) Service Table (out) - output table that 
the extracted address ranges populate.  
Service Attributes: These fields are populated, if data is available, to meet NTIA NOFA 
requirements. 
 
(3F) Fixed Wireless Visible Road Segments 
The Polygon Cover Tool clips road segments that are within visible polygon viewsheds and 
writes them out to a polyline vector layer stored in the SDE environment as supplemental 
reference data. 
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(3G) Fixed Wireless Geo-Processing Clean-up 
The fixed wireless polygons or propagation models generated for each provider step through 
several geo-processing routines to check for and eliminate the following conditions: 

� Single pixels less than 0.125 square miles  

� Holes inside the polygons less than 0.125 square miles  
 
In each case, all identified polygons are removed and dissolved to create multipart polygons 
by provider, technology, speed and spectrum.  Each provider’s propagation model differs in 
size and complexity due to the number of transmitters and their individual parameters that 
determine each view shed.  Because the geometries are manipulated through many geo-
processing procedures, multiple cycles of validation are run to ensure the geometries are in 
tact and repair routines are run if necessary.  Once all propagation models meet internal 
quality control standards, the geometry is loaded to SDE and stored for final export to the 
SBDD deliverable format. 
 
(4) Viewshed Polygons and Processing 
Although not as common, another source of data received from the service providers is a 
polygon dataset that has already been generated to represent visible service territory of 
transmitters. Service providers or third party vendors will frequently run their own 
propagation models to be used for broadband mapping.  Polygon formats include ESRI 
shapefiles, MapInfo files, Google .kml files, and raster files.  Each format requires a 
thorough review to determine the subsequent processing steps. 
 
(4A) Review Polygon Data 
Although each format listed is unique, the data eventually runs through the Polygon Cover 
tool so that the address ranges within the polygons can be clipped out.  Each format is 
carefully inspected for content, spatial characteristics and accuracy.  The general workflow 
for each format is as follows: 

� Shapefile:  Review content > Edits > Project > QC >  Load for processing > Run 
Sewall Polygon Cover Tool 

� MapInfo:  Review content > Translate to ESRI shapefile > Edits > Project > QC >  
Load for processing > Run Sewall Polygon Cover Tool 

� Google .kml:  Review content > Translate to ESRI shapefile > Edits > Project > QC > 
Load for processing > Run Sewall Polygon Cover Tool 

� Raster:  Review content > Translate raster to polygon > Edits > Project > QC > Load 
for processing > Run Sewall Polygon Cover Tool 

 
(5) Supplemental Data 
Supplemental data received by service providers is generally used for verification to support 
internal processing results. It is not used as a data source to generate transmitter locations or 
viewsheds.  Supplementary data includes, but is not limited to, failed service locations, 
customer service locations, hard copy plots, PDF files, and other digital reference files.  In 
most circumstances, the data can be used for cross-referencing. 
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(5A) Review Supplemental Data 
Each format is unique and so are the processing steps that are necessary to prepare the data 
for use.  

� Failed Service Locations:  Provides an excellent source for cross-referencing to 
viewshed polygons (visible and non-visible) but must have complete address in order 
to geocode location of address. 

� Customer Service Locations:  Provides an excellent source for cross-referencing to 
the viewshed polygons (visible and non-visible) but must have a complete address in 
order to geocode location of address. 

� Hard copy plots:  May be used for verification purposes if the content of the material 
is applicable.   

� PDF files: May be used for verification purposes if the data content is applicable.  

� Other data sources:  All sources are reviewed for potential use. 
 
(5B)  Support Verification Tasks 
Supplemental data sources are reviewed to determine if they hold any value to the project 
workflow. Value added data will be stored and utilized as needed to support internal 
processing. 
 
(5C) Store Data 
Data received from service providers that does not have any given value to the project is 
organized and stored under the service provider folder. 
 
(5D) Process Data for Verification Tasks 
Supplemental data sources are scrubbed for compatibility and processed. 
 
(6) Quality Control Acceptance 
Quality control procedures are implemented at each of the three production stages depending 
on the data (transmitter coordinates, viewshed polygons, or supplemental data). Because the 
service provider data is received in numerous formats, styles, and content, much of the initial 
QC is completed during the data collection stage. When data is received from a service 
provider, an initial review is done to determine what is received and what is outstanding.  
This cycle of communication with the providers continues until all the necessary data is 
either received or clearly understood that it will not be received.  Throughout the data 
collection process, Sewall keeps an inventory of receivables. 
 
(6A)  Contact Data Source for Additional Information 
During the data collection phase of the project, questions or clarifications may have been 
overlooked, or items may present road blocks at some point later during the processing.  If an 
internal quality review does not resolve an issue, the service provider is contacted for 
additional information or clarification. 
 
(7) Fixed Wireless Broadband Services Table (Relate Process) 
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The Polygon Cover Tool has two outputs; both generated using the visible polygons created 
by the Tower Cover Tool:  (1) road segments, and (2) calculated address ranges.  While the 
visible road segments are not part of the NTIA deliverable, they are stored as a reference file 
named CONNECTME.FW_VISIBLE_ROAD_SEGMENTS. 
 
(8) Intelligent Street Centerlines 
The output from the fixed wireless workflow is a comprehensive intelligent street centerline 
network comprised of street centerlines and related service availability tabular records. 

4.3.3 Mobile/Satellite Transmission 
Wireless broadband technology consists of all facilities-based providers of wireless 
broadband service that is not address specific.  For the State of Maine, this includes terrestrial 
mobile wireless and satellite broadband service.  Mapping mobile wireless and satellite 
coverage requires less processing than other technologies that are address-based, such as 
wired and fixed wireless service. Data consists of polygons generated by the providers or 
third party vendors, representing areas where broadband service is offered. As shown in the 
workflow below, the data received from providers is sorted, processed and loaded into a 
geodatabase.  Minimal steps are required to process this data, but established internal 
workflows are taken to ensure that proper protocols and quality assurance are met. The 
primary steps of the internal workflow are shown in Figure 11 and described below. 



  SBDD Process Documentation 
  April 2011 Delivery 

 Page 30 of 73 last revised 2011.03.31 

 
Figure 11 - Wireless Internal Conversion Data Workflow 
 
(1) Data Sort 
Upon receiving data from a mobile or satellite service provider, Sewall initially sorts and 
stores the data by technology - terrestrial or satellite. 
 
(2) Terrestrial Mobile Wireless Data Sources (Review) 
After the data is sorted, an initial data analysis is performed to determine if the data received 
appears to be intact spatially and is accompanied by the proper attribution required for 
adherence to the SBDD data model. Follow-up with the service provider continues until all 
necessary information is acquired.  
 
(2.1) Process Mobile Wireless Polygons in ArcGIS 
After determining that the data has value, the polygons are projected into the proper 
coordinate system to complement the internal workflow.  Depending on the source data, 
additional data processing routines may be necessary before loading the data into the 
geodatabase. 
 
(2.2) Load Mobile Wireless data into Personal Geodatabase 
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Although the primary quality control procedures are completed during the verification 
process, initial acceptance testing to ensure the data is spatially valid is performed by cross-
referencing to additional data sources such as aerial imagery or information taken from the 
service provider website. Discrepancies are documented for use in subsequent verification 
processes.  Once quality checks are complete, the data is loaded into a personal geodatabase  
 
(3) Satellite Data Sources (Review) 
When all the spatial and attribute information is received, the satellite data follows the same 
internal workflow as mobile wireless data (Steps 2, 2.1 and 2.2).  
 
(4) Load Data to SDE for final SBDD Export 
Mobile wireless and satellite data is loaded to SDE environment for final export to SBDD 
format. 

4.3.4 Middle Mile Locations 
Middle Mile and Internet Backhaul Connection Points are defined by NTIA as 
“interconnection points that typically enable relatively fast data rates, are built to handle 
substantial capacities, and may be service-quality assured.”  At this stage of the mapping, 
middle mile data has been the most difficult to obtain from service providers during the data 
collection process. Service provider networks can include as little as one middle mile 
location such as a backhaul connection point or as many as dozens, operating as 
interconnection points within a fixed wireless network reaching out to end users.  
Furthermore, some service providers may offer middle mile connection points only as a 
service, such as a splice into a fiber line to support a lateral to a central office or business. 
 
Regardless of the technical framework, all middle mile locations that meet the NTIA 
definition are captured in a point feature class with additional attribution including the 
ownership of the facility, serving facility capacity and serving facility type.   
 
The outline of workflow is shown as Figure 12.  The description of each step follows. 
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Figure 12 - Middle Mile Internal Data Conversion Workflow 
 
(1) Data Sort 
The initial data sort separates the data and distinguishes formats more compatible to the 
database model, such as middle-mile coordinate values listed in a spreadsheet or ESRI 
shapefiles.  Data received in compatible formats require minimal processing steps. 
Supplemental data sources generally require additional processing steps.  Examples may 
include the conversion of .kml files to ESRI shapefiles or polyline files that require points to 
be added at splice or lateral connections. 
 
(2) Middle Mile Coordinate Data Sources Review 
Sewall reviews the data to ensure that the information is a valid input.  If so, the data is 
reformatted and loaded into in ArcGIS.  Sources deemed as invalid are stored, or the service 
provider is contacted for additional information if necessary. 
 
(2.1) Generate Middle Mile Points in ArcGIS 
Points are loaded into ArcGIS.  Sewall analysts run acceptance procedures to verify data 
translation to ArcGIS and spatial accuracy and completeness using supplemental data sources 
provided such as addresses, imagery or descriptive information about the point locations. In 
addition to the point geometry, all attribution carried over in the translation is confirmed.  
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Conflicts or questions are referred back to the service provider for further clarification if 
necessary. 
 
(2.2) Load Middle Mile Data into Personal Geodatabase 
Middle-Mile data is loaded to a personal geodatabase.  Additional data received by the 
service providers or revisions will cycle through the same process and be stored in the 
personal geodatabase prior to loading to the SDE environment for final export. 
 
(3) Middle-Mile Supplemental Data Sources (Review) 
Supplemental data sources may involve additional processing during this step in order to 
proceed. Some of the more common supplemental data sources include, but are not limited 
to, the following: 

� Google .kml files 

� .jpg images showing middle-mile locations 

� AutoCAD point or polyline files 

� e-mails with descriptions of locations 

� Other miscellaneous information 
 
Once the data has been fully reviewed and normalized, the remaining steps follow the same 
internal workflow as coordinate data sources (Steps 2.1 and 2.2). 
 
(4) Load Data to SDE for final SBDD Export 
Middle mile data is loaded from the personal geodatabase to the SDE environment for final 
export to SBDD format. 

4.3.5 Service Overview 
Broadband service providers that participate in the state broadband mapping project have 
been asked to provide broadband service territory footprints at the address, street, census 
block or county level. The service overview dataset contains the information that has been 
delivered at the county level. 
 
The workflow developed by Sewall integrates the gathered data from broadband service 
providers into a consistent spatial format that is stored in a geodatabase designed to be 
compatible with the SBDD deliverable. 
 
The service overview workflow is described below and depicted in Figure 13. 
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Figure 13 - Service Overview Workflow 
 
(1) Service Overview Data 
The Service overview data bin is the storage location for service overview specific 
broadband service provider data gathered by Sewall.  Sewall specifies what information is 
necessary for this deliverable and what formats are acceptable when contacting each provider 
during the data gathering phase of the project. 
 
(2) Data Sort 
The service overview data is sorted into categories by data type. 
 
(3) GIS Service Overview Data 
The GIS data bin is used to store provider data that has been delivered to Sewall with service 
overview attribution and is in the requested GIS format. 
 
(3.1) Attribute Transfer 
Attributes contained in the GIS data are sent through an attribute transfer process that 
populates county data from the MEGIS County data.  This step ensures that there is one 
consistent spatial dataset utilized as a basemap in the service overview. 
 
(4) Flat File Service Overview Data 
The flat file data bin is used to store provider data that has been delivered to Sewall with 
service overview information in a flat file format.   
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(4.1) Join 
Using county name information provided in the flat files the MEGIS county data is joined to 
the flat files.  The joined dataset is exported and stored in the GIS service Overview data bin. 
 
(5) MEGIS County Data 
The shapefile cnty24p.shp was downloaded from the MEGIS website (megis.maine.gov) and 
utilized for county spatial representation of the service overview dataset during the 
workflow. 
 
(6) Load to Geodatabase 
Once the service overview data has been processed, the data is reviewed for content and 
accuracy and then loaded to the ConnectME production database. 
 
(7) Service Overview 
The output of the service overview workflow is a polygon dataset that is compatible with the 
SBDD data model. 
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5 Validation 
The verification process is used to ensure that the data delivered is in fact valid and current.  
Methods used by the Maine teams to validate coverage areas include field tests of mobile 
devices, responses to surveys sent to residents and businesses, comparison with third-party 
datasets both private and governmental, and results compiled from a speed test website 
established specifically for this purpose. 
 
Once the data has been collected, processed and verified, the results are statistically analyzed 
and plotted atop the original provider data coverages in GIS.  Any ‘holes’ or inconsistencies 
in the data from the service provider are reported to the provider in a feedback loop to ensure 
all parties involved are aware of the potential issues with the broadband service in an area. 

5.1 Field Tests for Mobile Coverage 
Mobile coverage consists of data from providers who offer mobile broadband services to 
consumers through devices such as smartphones or mobile laptop aircards.  Common 
providers of this type of broadband service in Maine are AT&T, Verizon Wireless, and 
Sprint. 
 
In order to verify the existence of wired and fixed wireless coverage in an area, direct access 
to the provider’s service is needed.  Logistically this would be difficult because transmission 
receivers, accounts and other equipment would have been required for each of the providers.  
Instead, the project team opted to gather information through other means, so field tests were 
only conducted to validate mobile coverage. 
 
Mobile coverage data is received by Sewall from the service providers in the form of GIS 
polygon files.  After these files have been reviewed and properly projected (see Section 4.3 
for details), they can be analyzed in the verification process.  The mobile coverage file is 
compared against the State of Maine boundary file in a GIS application in order to assess the 
size and location of the coverage area with respect to the State. 

5.1.1 Methodology 
The methodology developed by the ConnectME Authority to verify mobile coverage in 
Maine is to select a series of points throughout a provider’s coverage and have field crews 
run tests at these predetermined locations.  A minimum of 37 points per coverage area are 
needed in order for the statistical analysis on the field data to be valid. 
 
To select the points for field verification, a 28-square-mile grid was created in GIS and 
layered with the provider’s coverage area, the E911 road layer and the state boundaries.  One 
point was placed per grid block within the provider’s coverage network.  Each point was 
placed on a road, usually at road intersections for ease of access by the field crew.  Once all 
the points were placed, the points were divided into groups for distribution to field crew 
personnel.  
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The points were assigned attributes of point ID, latitude and longitude.  The attribute table 
was then exported to an Excel file for further editing.  The columns: field connect, upload 
speed, download speed and notes were added to the spreadsheet.  The field connect column 
holds values to describe whether the field crew was able to log on to the provider’s network., 
speeds collected from the state website at that location are stored in the upload speed and 
download speed columns.  The spreadsheet was loaded onto the field laptops for data entry.   
 
Crews utilized Microsoft Streets & Trips to assist in navigating to each of the field points 
across the state.  The software, which was loaded on each of the field laptops, has a GPS 
component that could track and direct field crews.  The spreadsheet used for data entry was 
also loaded into the software so the points could be plotted based on given coordinates. The 
field crews could properly identify each of the points based on the Point Name attribute. 
 
The program turned each of the points into a “stop.”  The start and ending points of the trip 
were also added, allowing the software to calculate an optimized route to reduce driving time 
and mileage.  After optimization, the software also provided driving directions, which were 
saved and loaded onto the field laptops. 
 
Mobile broadband aircards from each of the mobile service providers were purchased 
outright directly from the providers.  This eliminated the need for a service contract so that 
the aircards can be deactivated after the verification process without a contract cancellation 
fee.  Service providers activated the mobile aircards with a month-to-month data package of 
5GB. 
 
Aircards from each of the providers were then loaded onto the field crew laptops.  The 
software from the aircards was installed, aircard functionality was checked, and any updates 
were installed prior to crews leaving the office. 
 
Each time verification tasks are performed, the points are visited by a field crews who are 
equipped with a field laptop enabled with the mobile broadband aircard of the corresponding 
service provider and proper navigation information.  The field crews drive to each of the 
points, log onto the service provider’s network and navigate via Internet Explorer to an 
internet speed test website created by the James W. Sewall Company specifically for the 
ConnectME Broadband Mapping Project.   
 
For each test point, the point number, service provider and date are entered into the internet 
speed test website (e.g., Test_745_verizon_20100521) and a test is executed.  Results are 
recorded both in the speed test database (automatically) and in the spreadsheet.  Once all of 
the points are completed, crews return to the office and spreadsheets are combined.  Data 
columns are filled in with corresponding broadband upload and download speeds for sites 
with connectivity.   
 
Data points are then plotted on maps to view where broadband coverage is full strength or 
where it is lacking.  If there are large ‘holes’ in the coverage areas, the points are revisited to 
ensure that readings were accurate and not subject to user or equipment error. 
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The merged field spreadsheets are then handed off to a statistician for the statistical analysis 
of the data. 

5.1.2 Statistical Analysis 
Large data sets are often expressed best in terms of summary statistics.  It is often easier to 
look at commonly defined statistics (stats) to get a quick overview of what the data describes, 
than to look at all the raw data. 
 
In analyzing this data, we chose statistics using the following criteria: 

� Commonly used and understood 

� Fit the data (data type) in question 

� Had practical application to the reader in understanding what the data was describing 
 
We believe that the statistics presented can be beneficial in several ways: 

� Description/Summary:  they consolidate many data observations into a few summary 
stats that can be quickly compared 

� Quantification:  they describe which portion of the data falls within or outside of the 
limits of acceptable criteria 

� Reliability/Prediction:  in some cases, they attest to the reliability of the data 
collection 

 
The following statistics were used: 

� Number of samples (n):  number of data points in the sample 

� Average (xbar):  arithmetic mean or the mean value of a set of integers, terms, or 
quantities, expressed as their sum divided by their number.  

� Standard Deviation (sd):  used as a measure of the dispersion or variation in a 
distribution, equal to the square root of the arithmetic mean of the squares of the 
deviations from the arithmetic mean. 

� Percentages (%):  a proportion or share in relation to a whole; a part; a fraction or 
ratio with 100 understood as the denominator (e.g., 0.98 equals a percentage of 98). 

� Hypothesis testing:  statistical process used when trying to determine if it is 
reasonable to conclude that the entire population possesses a certain characteristic by 
the analysis of a sample. 

 
Explanation of choices made: 

� Quantitative statistics were only applied on sample data that fell within the published 
service area of the provider in question.  This was possible because the area was 
“bounded” by the geographic area described in the “service area.”  Outside the 
service area there is no bound (limit), so these same statistics would not be reliable as 
used with our methodology. 
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� Assumed a normal distribution because this is the most common and typical 
distribution type for this type of data, and we had no evidence to counter this 
assumption.  

� Chose sample statistics because we were not dealing with the whole population 
(almost unlimited sample points possible). 

� Chose hypothesis testing because we wanted to have the most valid predictor of the 
population parameters given the variability of our sample data. 

� Chose student’s T-distribution when sample size was equal to or less than 30 (n=<30) 
and Z-test when populations were above 30 (n>30). 

� Used one-tailed tests because we were interested in the area above the curve from a 
single lower parameter (criteria of minimum speed). 

 
Data was sorted to yield only those sample points that fell within the published service area 
of the provider in question. 
 
Then the following information was calculated: 

� n = number of total sample points 

� Degrees of Freedom (df) = n-1 

� Selection of  t-distribution (df < 30) or standard normal curve (df >= 30)  

� Percent of points where connection was established 

� Percent of points where both tested upload and download speeds were equal to or 
greater than (=>) broadband speeds (200 and 768 kb/sec respectively).  

� Percent of points where either the upload or download speed was equal to or greater 
than (=>) broadband speed, but not both. 

� Percent of points where neither the tested upload or download speeds was equal to or 
greater than (=>) broadband speeds.  

 
Using all data points within the designated service provider coverage that registered an 
upload speed during the test, the following were calculated: 

� Average # of points where a connection was made that had an upload speed equal or 
greater than broadband minimums. 

� Average upload speed (xbar/upload) 

� Standard deviation of the sample (SD/upload) 

� Statistical prediction of percent of points that would meet minimum 3G upload speed 
in subsequent samplings (using one-tailed t-test or z-score, depending on df) – see 
schematic below 
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Using all data points within the designated service provider coverage that registered a 
download speed during the test, the following were calculated: 

� Average # of points where a connection was made that had a download speed equal 
or greater than broadband minimums. 

� Average download speed (xbar/download) 

� Standard deviation of the sample (SD/download) 

� Statistical prediction of percent of points that would meet minimum 3G upload speed 
in subsequent samplings (using one-tailed t-test or z-score, depending on df) – see 
schematic above. 

5.2 Surveys  
The project team is surveying residents and businesses in Maine utilizing a questionnaire 
about their current internet connections.  The ConnectME Authority has opted begin the 
verification of residential broadband service with a pilot survey. 

5.2.1 Pilot Residential Survey 
According to the 2000 Census, there are approximately 518,000 households in Maine, of 
which 10,000 were included with the pilot survey.  Residential addresses were purchased 
from InfoUSA for the mailing as 2,500 addresses in each of four geographic areas:  Maine 
North, Maine South, Maine East, and Maine West.  Addresses were selected at random by 
InfoUSA from the provided GIS polygons constituting adjacent census blocks in each area 
containing approximately 5000 households. 
 
The survey questionnaire is comprised of 10 questions and takes about two minutes to 
complete.  A copy is included in Appendix E.   
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The survey identifies the consumer by the physical address, which is geocoded against a 
street centerline file in GIS to create a point file.  The data associated with each address (e.g., 
transmission type and provider) is analyzed by layering the consumer information with the 
coverage data provided by the service provider.  Sewall can analyze the layers to verify if 
each service provider does cover the areas represented by the data it submitted. In addition, if 
an area shown to have no service by a provider appears in the consumer survey, the provider 
in question can be contacted to confirm and provide updated coverage information. 
 
There is also an online version of the survey that people can access by navigating to a link 
indicated on the delivered hardcopy of the questionnaire.  The electronic version, once 
completed, directs the person to the ConnectME internet speed test website, which reports 
the upload and download speeds of the user’s internet connection.  The speeds are recorded 
in a database that tracks entered physical address and speed test results for future analysis 
(see Section 5.4.1 for further details). 
 
The logistics for a statewide survey are being addressed. Sewall expects to begin 
implementation by July 2011. 

5.3 Third Party Data 
The Maine team has acquired data from American Roamer and from the FCC.  These 
datasets will be used to validate the mapped coverage for each provider through spatial 
analysis. 

5.3.1 American Roamer data 
Maine acquired the American Roamer data, which includes coverages for Sprint, Verizon 
Wireless, AT&T and T-Mobile.  The data consists of polygon shapefiles, which Sewall could 
overlay with the coverages received from the providers.  For each provider, the area in 
common and the area covered only by one dataset were determined from geospatial analysis.  
Differences will be forwarded to each provider for analysis and refinement of the service 
territory. 

5.3.2 FCC Form 477 aggregate data 
The FCC has provided SBDD grantees and their teams access to the FCC Form 477 
aggregate data.  This data contains information on service providers in Maine at an aggregate 
or granularity higher than the SBDD data, but is useful for checking the list of providers and 
their locations at Census Track level. 
 
The project team has recently developed a tool that compares the records in the Form 477 
aggregate data to the provider data in the SBDD project database.  The tool lists out by 
Census Track each provider that includes the tract in the Form 477 filing. Each provider that 
has service data that falls within the tract is considered a match.  Using this data, the team has 
been able to find potential providers that were not previously included in the study, as well 
using the tract locations as a cross-reference to where each provider has service.  The team 
has plans to further enhance the tool to provide a set of results centric to each provider. 
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5.4 Crowd Sourced Data 

5.4.1 Speed test results 
For the SBDD project, the ConnectME Authority has implemented an online speed test tool.  
The website was developed by Ookla Net Metrics and was brought online on January 13, 
2010.  To date, over 12,200 tests have been recorded.  The speed test stores downstream and 
upstream speeds as well as the user’s address and ISP.  The results from the speed test tool 
are scrubbed and geocoded.  The information will be used to help verify service coverages 
and service speeds for wired, fixed wireless, and satellite providers. 

5.4.2 FCC Consumer Broadband Test (CBT) data 
The Consumer Broadband Test data provided by the FCC consists of three datasets: Speed 
Test records, Mobile Broadband Speed Test records, and Broadband Dead Zone Report 
records.  The project team plans to incorporate the FCC speed test records along with those 
records captured by the ConnectME speed test tool.  However, the name of the service 
provider is not included with data, so a method for mapping the IP address in these records to 
the appropriate provider must be developed. 
 
The dead zone reports are used to identify locations reported to be without coverage.  The 
addresses from these records are geocoded and then are cross-referenced with service 
provider coverages in the areas. 

5.5 Service Locations / Failed Service Locations 
Service providers are encouraged to submit service locations and/or failed service locations 
to help validate extents of service coverage.  The service addresses and failed service 
addresses are geocoded and the data is analyzed with the coverage data submitted by the 
service provider.  This validation step will continue throughout the project as the team 
continues to receive these locations as part of the providers’ data submittals. 
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5.6 Feedback Loop 
Once broadband service territories are mapped, Sewall generates maps for each provider 
company representing the status of data at the time of the mapping.  This gives each service 
provider the opportunity to validate its broadband service footprint and provide feedback to 
the Sewall project team.  Figure 14 below represents a fixed wired validation map where a 
provider company’s broadband service (DSL) foot print is symbolized in red.  Depending on 
the size of a service footprint and map density, additional information, such as road names, 
may be represented.  

Figure 14 - Fixed Wired Validation Map 
 
Sewall forwards the maps of the service territory, along with any anomalies noted from the 
third-party and crowd-sourced data analysis to each service provider.  Sewall communicates 
regularly with each provider to ensure that the mapping is as comprehensive and correct as 
possible. 
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6 Data Delivery 
Service provider data that has been processed to the Sewall production model needs to be 
transferred to the SBDD data model for delivery.  In order to accomplish this Sewall has 
developed a process by which the Sewall production datasets are exported to the current 
SBDD data model structure. 
 
The Sewall production model was designed with the NTIA delivery model in mind and, in as 
many cases as possible, the production model utilizes the NTIA delivery defined attribute 
definitions and domain values.  Through the use of this design philosophy, Sewall has 
mitigated the pitfalls for exporting to the SBDD data model.   
 
To facilitate the transfer of data stored in the Sewall production model to the SBDD model 
for delivery Sewall has developed an ArcCatalog tool named State Broadband Data Export.  
This tool reads a source geodatabase set of features and writes to a destination geodatabase 
set of features.  A screenshot of the tool dialog box is shown in Figure 15. 

 
Figure 15 - State Broadband Data Export Tool 
Source database: Sewall production geodatabase location. 
Source Data Tables:  (1) Providers - Geodatabase table with list of provider specific information  (2) Roads - 
ConnectME street centerline feature class  (3) Census Block - Census 2000 block geodatabase feature class 
(4) Broadband Services - Geodatabase table containing broadband provider characteristics and street ranges 
linked to ConnectME street centerline segments  (5) Middle Mile - Geodatabase point feature class containing 
broadband service provider middle mile locations ( 6) Community Anchors - Geodatabase point feature class 
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containing community anchor institution locations  (7) Area Availability - Geodatabase polygon feature class 
containing mobile wireless and satellite broadband provider coverage  (8)Weighted Speed - Geodatabase 
polygon feature class service overview data  (9) State Boundary - Geodatabase polygon feature class 
portraying the Maine state boundary. 
Destination State Broadband database: SBDD geodatabase location. 
State Broadband Data Tables:  These are the required SBDD deliverables. 
 
On launching the ArcCatalog tool, the user selects the source and destination geodatabases 
for the transfer process.  The source geodatabase is the Sewall internal production model, and 
the destination geodatabase is the empty SBDD model.  Next the user matches the items 
listed in the Source Data Tables section to the production model features.  Once complete, 
the user checks which deliverables the tool will export in the State Broadband Data Tables 
section.  Clicking ‘Start’ will begin the export process. 
 
The road segment and census block exports are performed simultaneously in the State 
Broadband Data Export Tool with road segments being reported in census blocks greater 
than 2 square miles and census blocks being reported in areas up to 2 square miles.  The tool 
reads the service provider data stored in the Sewall production geodatabase and performs an 
analysis through which the deliverables are extracted.  The analysis process by which the tool 
extracts the road segments and census block data is outlined in the whitepaper entitled 
“Misalignment between 2000 Census Blocks & Maine E911 Streets:  Technical Whitepaper,” 
dated 1 September 2010.  This paper is included in Appendix D. 
 
Middle mile and community anchor institution data are stored as point features in the Sewall 
production model and are extracted utilizing a standard export routine.  The datasets are 
reprojected from the production UTM projection to the SBDD WGS84 projection and 
LAT/LON attributes are populated.  Once complete, the points are loaded into the destination 
feature classes of the SBDD geodatabase. 
 
Wireless, service overview and state boundary data are stored as polygon features in the 
Sewall production model and a standard export routine extracts these to the SBDD features.  
The datasets are reprojected from the production UTM projection to the SBDD WGS84 
projection as features are loaded. 
 
During the export process features with front-end business rule violations get reported.  The 
report is than reviewed by a Sewall analyst, and necessary corrections are made to the base 
datasets.  This reporting mechanism ensures the data delivered in the SBDD geodatabase is 
as complete and accurate as the provided data sources allow. 
 
Once the SBDD transfer file geodatabase has been created and its content validated, the 
geodatabase files are included in the data submittal zip file along with the other submittal 
files including ‘datapackage.xls,’ schema modifications report, data verification summaries, 
and this technical whitepaper. 
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Appendix A - Sample Letter to Service Providers 
 



  SBDD Process Documentation 
  April 2011 Delivery 

 Page 47 of 73 last revised 2011.03.31 

   
 
 
 
 
[date] 

Sewall 
P.O. Box 433 

136 Center St. 
Old Town, ME 04468 

207-827-4456 
[address] 
[address] 
[address] 
[address] 
 
Dear Mr. [name]: 
 
The National Telecommunications and Information Administration (NTIA) of the U. S. Department of 
Commerce has been charged by Congress under the American Recovery and Reinvestment Act of 2009 and the 
Broadband Data Improvement Act (BDIA) to develop and maintain a comprehensive, interactive, and 
searchable nationwide inventory map of existing broadband service capability and availability in the United 
States that depicts the geographic extent to which broadband service is deployed and available from a 
commercial or public provider throughout each state (the Program). 
 
The ConnectME Authority (the Authority) is responsible for developing and maintaining these data for the State 
of Maine and for serving as the conduit for this information to the NTIA. The Authority has contracted with 
James W. Sewall Company of Old Town, Maine, to undertake the initial mapping and to consult with the 
Authority on how best to update and maintain these data going forward.  
 
We are writing to insure that you are familiar with this Program and to invite your collaboration in teaming with 
us in this important, statewide initiative. (See the URL’s provided at the end of this letter for further 
information.) Indeed, your organization’s collaboration is essential to the Program’s success, and we thank you 
in advance for your participation. 
 
To comply with the Program, the NTIA requires each state to provide structured data that includes: 

• the availability of broadband service at the address level; 

• advertised and “expected actual” speeds of broadband service; 

• the technology used to deliver broadband service; 

• location and capability of critical broadband related infrastructure (this data will not be publicly 
displayed on the national broadband map); 

• the spectrum used by wireless broadband service providers. 
 
We expect that the publicly searchable national broadband map and database will contain: 

• geographic areas in which broadband service is available; 

• the technologies used to provide broadband service in such areas; 

• the speed at which broadband service is available in such areas; 

• broadband service availability at public schools, libraries, hospitals, colleges, and all public buildings 
used by the state or municipalities. 

• other economic or demographic data that may enable Federal efforts to provide usable and searchable 
data on a variety of issues pertinent to the public interest. 
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We recognize that some of the data we will ask you to provide is proprietary. Consequently, we include a 
Protective Order authorized by the ConnectME Authority and an accompanying non-disclosure agreement 
(NDA) for your review and execution. Please note, however, that the NTIA requires that this NDA may not 
restrict the Authority from providing all data collected to the NTIA or restrict the NTIA’s use of such data as 
contemplated under this Program, including sharing such data with the FCC or other federal agencies. 
Furthermore, the NTIA prohibits the Authority or Sewall from agreeing to a more restrictive definition of 
Confidential Information than that adopted by the NTIA. Currently, as required under the BDIA, the NTIA 
identifies Confidential Information as any information, including trade secrets, or commercial or financial 
information, submitted under the Program that: 

• identifies the location, type and technical specification of infrastructure owned, leased or used by a 
specific broadband service provider; or 

• explicitly identifies a broadband service provider in relation to its specific service area or at a specific 
service location. 

 
Confidential Information will not be made publicly available pursuant to the limits set forth in the BDIA except 
as required by applicable law or judicial or administrative action or proceeding, including Freedom of 
Information Act requirements. From the BDIA (§ 106(h)): “Notwithstanding any provision of Federal or State 
law to the contrary, an eligible entity shall treat any matter that is a trade secret, commercial or financial 
information, or privileged or confidential, as a record not subject to public disclosure except as otherwise 
mutually agreed to by the broadband service provider and the eligible entity.”  Sewall was chosen to lead this 
task in part because of its long history of handling confidential information for a variety of industries. Finally, 
should your organization apply for a Broadband Technology Opportunities Program (BTOP) grant to support 
the deployment of broadband infrastructure in unserved and underserved areas, enhance broadband capacity at 
public computer centers or to encourage sustainable adoption of broadband service, the NTIA requires that you 
participate in this mapping Program.  
 
The NTIA has set a very aggressive Program schedule, with many deliverables due by November 2009 and all 
initial deliverables due in March 2010. Consequently, a representative from the Sewall team will be contacting 
you soon to discuss any questions you may have and to facilitate completion of the NDA and your participation. 
If we should be in communication with others in your organization concerning either the NDA or the data 
transfers, please inform the Sewall representative as soon as possible. Thank you again and we look forward to 
working with you. 
 
Sincerely, 

 

 
 
 
 
 
 

Phillip W. Lindley, Executive Director 
ConnectME Authority 

James H. Page, CEO 
James W. Sewall Company 

 
URLs for: 
www.maine.gov/connectme  www.ntia.doc.gov/press/2009/BTOP_mappingtotals_090909.html 
www.sewall.com 
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Appendix B - ConnectME Authority Protective Order 
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STATE OF MAINE December 21, 2009 
 
CONNECTME AUTHORITY PROTECTIVE ORDER 
 (Proprietary Business Information)  
_____________________________________________________________________________ 
 
Pursuant to 35-A M.R.S.A. § 9207(1) and Rule Chapter 101, § 4, the ConnectME Authority (Authority) may 
designate information as confidential to protect the legitimate competitive or proprietary interests of 
communications service providers and mobile communications service providers.  The Authority may designate 
information as confidential only to the minimum extent necessary to protect such legitimate competitive or 
proprietary interests.  Information designated as confidential is not a public record under 1 M.R.S.A. § 402(3). 
 
The Authority is currently conducting a Broadband Mapping and Inventory Project with the services of a 
private contractor, James Sewall Company (Sewall).  Sewall is required to obtain data from service providers 
(Provider) by the Authority and the National Telecommunications and Information Administration (NTIA) 
pursuant to the Broadband Data Improvement Act (BDIA) and the NTIA Notice of Funds Availability (NOFA).  
The NTIA requires that the Authority agree to comply with confidentiality requirements in section 106(h)(2) of 
the BDIA. 
 
It is anticipated that providers submitting data to Sewall or the Authority may have a need to provide 
information considered to be confidential, in that the information provided may involve commercially sensitive 
and/or proprietary information regarding information that identifies (i) the location, type, and technical 
specifications of infrastructure owned, leased, or used by providers or (ii) explicitly identifies providers in 
relation to their specific service area or at a specific service location (collectively, the “Confidential 
Information”).  The Authority has determined that such Confidential Information is generally not disclosed 
publicly, and that the public disclosure of such Confidential Information without restriction would cause 
competitive harm to the applicant or provider.  
 
Accordingly, the following terms shall apply unless and until modified by the Authority or a court of competent 
jurisdiction:   
 
 1.   Data submitted to Sewall or the Authority falling within the above definition of Confidential 
Information, as well as any data submitted to Sewall or the Authority pursuant to the Non-Disclosure 
Agreement set forth in Attachment A , (collectively, “Designated Confidential Information”) shall be deemed to 
be competitively sensitive and/or proprietary in nature and such Designated Confidential Information shall be 
and remain exempt from public disclosure pursuant to the terms of this Protective Order and the articles 
referenced therein.   
  
 2.   All Designated Confidential Information shall be and remain exempt from public disclosure 
pursuant to the terms of this Protective Order, unless removed from the coverage of this Protective Order as 
provided below or otherwise by a court of competent jurisdiction.  No persons provided access to any 
Designated Confidential Information by reason of this Protective Order shall use such information for any 
purpose other than the purposes designated by the Authority.  Every person provided access to Designated 
Confidential Information shall use his or her best efforts to keep the Designated Confidential Information secure 
and shall not publicly disclose it or accord public access to it to any person not authorized by the terms of this 
Protective Order. 
 
 3.   Any person or the Authority may challenge the designation of any document or other 
information as Designated Confidential Information.  The Authority will provide reasonable prior notice to the 
applicant or provider and an opportunity for hearing prior to ruling on any such challenge.  In considering any 
such challenge, the usual burdens of proof and production shall apply and no additional presumption shall be 
given as a result of the prior acceptance by the Authority of material as Designated Confidential Information.  
In the event the Authority should rule over the objections of the person providing the Designated Confidential 
Information that any information should no longer be subject to the terms of this Protective Order, such 
information shall not be publicly disclosed until the later of five (5) business days after the Authority so orders 
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or, if the person files within such five day period an appeal or request for stay of such order, the date upon 
which such appeal or request for stay is decided; provided, however, that said periods may be extended in 
accordance with any stay ordered by the Authority or a reviewing court.  Upon the entry of a final unappealed 
decision by the Authority or a reviewing court granting public disclosure, the terms of this Protective Order 
shall cease to bind any person with respect to the information that the order granting disclosure shall have 
expressly and clearly removed from the coverage of this Protective Order. 
 
 4.   Any person provided access to Designated Confidential Information shall review and be 
bound by the terms of this Protective Order.  Prior to obtaining access to any Designated Confidential 
Information, such person shall sign an acknowledgment of his or her obligation to abide by the terms of this 
Protective Order in the Non-Disclosure Agreement (NDA) attached hereto as Attachment A.   
 
 5.   Unless modified by the Authority or a court of competent jurisdiction, access to Designated 
Confidential Information shall be limited to Authority Staff, Sewall, any independent consultants or experts 
retained by the Authority, the National Telecommunications and Information Administration, and those 
designated persons, who have signed the NDA. 
 
 6.   No copies of Designated Confidential Information shall be circulated to persons other than 
those authorized under paragraph 5 of this Protective Order.  Persons authorized under paragraph 5 hereof also 
may take such notes as may be necessary.  Such notes shall be treated as Designated Confidential Information. 
 
 7.   The restrictions upon, and obligations accruing to, persons who become subject to the terms 
of this Protective Order shall not apply to any Designated Confidential Information submitted in accordance 
with this Protective Order if the Authority rules, after reasonable notice to the applicant or provider and an 
opportunity for hearing, that such Designated Confidential Information was publicly known at the time it was 
furnished or has since become publicly known.  
 
 8.   Where reference to Designated Confidential Information is required in any Authority 
document, such reference shall be by citation of title or attachment number only or by some other non-
confidential description to the extent possible. 
 
 9.   Designated Confidential Information furnished to the Authority pursuant to this Protective 
Order shall remain in the possession of the Authority, under seal, and subject to the terms of this Protective 
Order, until the Authority or a court of competent jurisdiction shall otherwise order. 
 
 10.   The terms of this Protective Order may be modified on motion of any person or on the 
Authority’s own motion upon reasonable prior notice to the applicant or provider and an opportunity for 
hearing. 
 
 
BY ORDER OF THE CONNECTME AUTHORITY 
 

 
____________________________ 
Phillip Lindley, Executive Director 
 
 
ATTACHMENT A  [Non-Disclosure Agreement] 
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Appendix C - Template for Non-Disclosure 
Agreement 
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NON-DISCLOSURE AGREEMENT 
 
THIS AGREEMENT is made this ________ day of _________________, 20___, by and 
between __________________________________________________, a 
________________________________ having a principal place of business at 
______________________________________________________ (“PROVIDER”) and 
ConnectME Authority, a body corporate and politic and a public instrumentality of the State 
of Maine established pursuant to 35-A M.R.S.A. § 9203 (the “AUTHORITY”) and James W. 
Sewall Company, a corporation organized under the laws of the State of Maine and having a 
principal place of business at 136 Center Street, Old Town, Maine  04419 (“SEWALL”) 
(AUTHORITY and SEWALL individually or collectively referred to as “RECIPIENTS”) 
(PROVIDER AND RECIPIENTS collectively referred to as the “Parties”). 
 
Recitals 
 
 WHEREAS, the National Telecommunications and Information Administration (the 
“NTIA”) of the United States Department of Commerce has been charged by Congress under 
the America Recovery and Reinvestment Act of 2009 (the “ARRA”) and the Broadband Data 
Improvement Act (the “BDIA”) to develop and maintain a comprehensive, interactive, and 
searchable nationwide inventory map of existing broadband service capability and 
availability in the United States that depicts the geographic extent to which broadband 
service is deployed and available from a commercial or public provider throughout each state 
(the “Data”); and 
 
WHEREAS, the AUTHORITY is responsible for developing and maintaining the Data for 
the State of Maine and for serving as a conduit for the Data to the NTIA; and 
 
WHEREAS, SEWALL is contracted by the AUTHORITY to undertake the initial mapping 
and to consult with the AUTHORITY on how best to update and maintain the Data going 
forward; and 
 
WHEREAS, the PROVIDER has trade secrets and commercial or financial information 
relating to the location, type, and technical specifications of infrastructure owned, leased, or 
used by PROVIDER, which is included in the Data (the “PROVIDER Information”); and 
 
WHEREAS, the PROVIDER has agreed to provide PROVIDER Information to SEWALL 
and/or the AUTHORITY pursuant to the requirements of the ARRA and the BDIA for use by 
the NTIA. 
 
NOW THEREFORE, for and in consideration of the mutual promises and covenants 
contained herein, and for other good and valuable consideration, the receipt and sufficiency 
of which is hereby acknowledged, the Parties agree as follows: 
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 1. As requested in writing by PROVIDER, RECIPIENTS agree to hold in 
absolute and strict confidence and shall not disclose or reveal in any manner or form to any 
entity other than the NTIA any PROVIDER Information identified as confidential that 
identifies (i) the location, type, and technical specifications of infrastructure owned, leased, 
or used by PROVIDER or (ii) explicitly identifies PROVIDER in relation to its specific 
service area or at a specific service location (collectively, the “Confidential Information”), 
whether such disclosure was made orally, in writing, or in any other form, without prior 
written permission from PROVIDER.   
 
Notwithstanding the foregoing, Confidential Information shall not include the following: 
 
(a)  information that now is or hereinafter becomes publicly known or available otherwise 
than through unauthorized disclosure by RECIPIENTS; 
(b)  information that was in RECIPIENTS’ possession at the time of disclosure and was not 
acquired, directly or indirectly, from PROVIDER; 
(c)  information that RECIPIENTS received in good faith from a third party who is not under 
a similar restriction of confidentiality and having a right to disclose the Confidential 
Information; or 
(d)  information that is required to be disclosed pursuant to applicable law or judicial or 
administrative action or proceeding, including the Freedom of Information Act requirements. 
 
 2. RECIPIENTS agree not to use for any purpose the Confidential Information 
except as provided for under the ARRA and the BDIA, without prior written permission from 
PROVIDER.  
 
 3. This Agreement shall be governed by the laws of the State of Maine and 
applicable federal law, except for the State of Maine’s conflict-of-laws provisions, as 
applicable.  The Parties to this Agreement each specifically consent to jurisdiction in Maine 
in connection with any dispute between the Parties arising out of this Agreement or 
pertaining to the subject matter hereof, with venue being in a court of competent jurisdiction 
located in Penobscot or Kennebec County, Maine, United States of America. 
 
 4. This Agreement shall inure to the benefit of and be binding on the Parties and 
their respective successors and assigns. 
  
 5. This Agreement constitutes the complete and exclusive agreement of the 
Parties hereto with respect to the matters set forth herein.  The terms of this Agreement may 
not be modified or amended except by an instrument in writing signed by each of the Parties 
hereto.  
 
 6. This Agreement shall be construed without regard to any presumption or other 
rule requiring construction against the drafting Party. 
 
 7. This Agreement may be executed in counterparts and each Party hereto may 
execute each such counterpart, each of which when executed and delivered shall be deemed 
to be an original and both of which counterparts taken together shall constitute but one and 
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the same instrument.  This Agreement shall become binding when all counterparts taken 
together shall have been executed and delivered by all Parties.  Execution and delivery of this 
Agreement may be made by facsimile transmission, and each Party agrees that the delivery 
of the Agreement by facsimile shall have the same force and effect as delivery of original 
signatures and that each Party may use such facsimile signatures as evidence of the execution 
and delivery of the Agreement by all Parties to the same extent that an original signature 
could be used. 
 
IN WITNESS WHEREOF, the Parties have executed this Agreement the day and year first 
above written.   
 
 
WITNESSED BY: PROVIDER 
 
 
___________________________________ By:
 ___________________________________ 
 Title:
 ___________________________________ 
 
 
 ConnectME Authority 
 
 
___________________________________ By:
 ___________________________________ 
 Title:
 ___________________________________ 
 
 
 James W. Sewall Company 
 
 
___________________________________ By:
 ___________________________________ 
 Title:
 ___________________________________ 
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Appendix D - White Paper:  Maine-SBDD Census 
Block-Street Segment Misalignment 
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Misalignment between 2000 Census Blocks & Maine E91 1 Streets 

 
Technical Whitepaper 

 
1 September 2010 

Introduction 

Importing broadband service provider data into the State Broadband Data Development 
(SBDD) Map Data Transfer Model at the census block versus street segment level has 
created challenges for the grantees.  For the State of Maine one of the challenges involves the 
spatial misalignment between the 2000 Census Block polygon geometries and Maine’s street 
centerline dataset.   
 
In order to better understand the challenge that Maine is encountering it is necessary to 
review how the State is collecting and maintaining broadband service provider data.   
 
As a result of Maine’s geographic population distribution, mapping broadband service at a 
census block level does not satisfy the State’s requirements for statewide broadband tracking 
and development.  Instead of utilizing the hybrid census block-street centerline model 
outlined in the SBDD NOFA, the State is collecting service provider coverages at a street 
level for wired and fixed wired technologies.  The State has developed a relational model to 
best represent the one-to-many relationship between a street segment and its broadband 
service provider coverages. 
 
The street segment data that the State is utilizing is based primarily on the State’s E911 street 
centerline GIS layer with additional street coverage added from a 3rd party dataset for those 
towns not yet participating in the E911 project.  For information on the broadband service 
providers, a database table was developed based on the required attribution descriptions 
outlined in the NOFA. 
 
Now that the existing data structure has been presented the challenge of importing this data 
into the transfer model can be discussed along with the State’s proposed solution for 
addressing misalignment and helping minimize its impact on the broadband data processing. 
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The Challenge 

Year 2000 Census Block geometry is spatially misaligned with the Maine’s street centerlines. 
 

 
 
As shown in the above screen capture the typical misalignment between these two datasets is 
between 50 and 100 feet. 
 
Since Maine is storing all broadband service providers’ information as records associated 
with street centerlines this misalignment causes considerable challenges when trying to 
accurately export this information into the new SBDD data transfer model.  The 
misalignment is great enough that utilizing basic intersect methodology is not enough to 
provide NTIA with a highly accurate representation of broadband coverage in Maine. 
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Example: Basic Intersect 
 

 
 
The above screen capture shows an example of a 2000 Census Block that is greater than 2 
square miles and Provider ‘A’ street coverage data that is to be reported. 
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Performing an intersect between the greater than 2 square mile census block and the street 
network for Provider ‘A’ results in the highlighted streets being reported.   
 

 
 
It is clear from the screen capture that several extra streets where selected and a few streets 
were missed by using the intersection method. 
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Proposed Technical Solution 

The solution to this challenge is a multi-step process that needs to be run on each street 
segment with intelligent analysis employed to minimize errant representation of broadband 
service in census blocks greater that 2 square miles. 
 
The first step is to create mid points of the street centerlines for Provider ‘A’. 
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The next step is to create a buffer around the mid points using a distance to compensate for 
the misalignment in the census blocks.  The distance found to have the best return for this 
process was determined to be 100 feet. 
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Selecting the buffered mid points that intersect the greater than 2 square miles census block 
returns the following results: 
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The selected buffered mid points relate back to the following street selection: 
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Compare this selection to the original intersection process selection: 
 

 
 
The result of the mid point buffering process is a much better representation of streets 
contained within the greater than 2 square miles census block.  A large number of the 
erroneous streets initially marked as included in the census block have been dropped 
providing a much improved report. 
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Taking a look at the left hand side of the map there is a street that intersects the census block 
but is not reported in the mid point buffering process.  A closer look reveals why. 
 

 
 
The street in question is relatively long in length and has a midpoint that is located outside of 
the greater than 2 square miles census block resulting in it not being reported. 
 
Building onto what has been performed already an additional automation check can locate 
and incorporate these long streets into the dataset. 
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The Proposed Solution: Additional Intelligence 

The first step in this additional iteration is to select streets that have not been flagged as being 
contained within a census block greater than 2 square miles and are longer than 500 feet.  
Then create points that are offset 200 feet from each end of the selected streets. 
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Next these 200 feet offset points are buffered 100 feet: 
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Then by selecting the buffers that intersect the greater than 2 square miles census block and 
selecting the associated streets, the process results in the following: 
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The Results 

The screen capture below shows the streets reported using the two step process in 
comparison to the basic intersect method of reporting street segments. 
 

 
 
The following table shows the results of the processes for Provider ‘A’ for this particular 
census block: 
 

Method 
Missed 
Streets 

Extra 
Streets %Error 

Basic Intersect Process 2 11 35.14 
MID Point Process 1 2 8.11 
MID and END Point 
Process 0 2 5.41 

 
The proposed solution gives a much better representation of the data set and minimizes the 
errors induced by using a basic intersection process. 
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Summary 

The SBDD data submission requirements involving census blocks and street segments have 
created a challenge for the grantees to accurately represent broadband service provider 
information.  In particular the State of Maine has a significant offset between the 2000 
Census Block geometries and the corresponding street centerlines that the State is utilizing to 
map broadband availability data.  A basic spatial intersect method has proven to be highly 
inaccurate in identifying street centerline data in census blocks greater than 2 square miles. 
 
Through it analysis, the State has found that using a two step process using mid-point and 
offset end point buffering provides improved results for street centerlines in the greater than 
2 square mile census blocks.  The State expects this methodology to improve the accuracy of 
street segment determination by approximately 50% for these regions.  Unless instructed 
otherwise by the NTIA project team, the State intends to utilize this two step process to 
develop the SBDD deliverables for street centerlines in census blocks greater than 2 square 
miles. 
 
In addition, it is the hope of Maine’s project team that the spatial misalignment between 
census block geometries and the E911 street centerlines will be remedied by the 2010 Census 
data as a result of the work done under the Boundary and Annexation Survey (BAS).  Maine 
is one of the states that participated in the 2010 BAS with the Census Bureau to better align 
the census boundary data with the State’s E911 street data.  
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Appendix E – Residential Survey Letter 
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MICHIGAN COVER LETTER 

 
April 1, 2011 
 
Ms. Anne W. Neville 
SBDD Grant Program Director 
National Telecommunications and Information Administration 
U.S. Department of Commerce 
1401 Constitution Avenue, NW Room 4716 
Washington, DC 20230 
 
Dear Ms. Neville: 
 
It is with highest regard that the collective stakeholders of Connect Michigan offer congratulations 
to the U.S. Department of Commerce’s National Telecommunications & Information 
Administration (NTIA) on the recent release of the National Broadband Map.  This extraordinary 
milestone demonstrates the intense and joint effort of the NTIA, Federal Communications 
Commission (FCC), state governments, industry, and non-profits like Connected Nation and will 
serve as a key tool for the American public and policymakers resulting in smarter investments and 
targeted state and local broadband policies and programs.  We are proud of the role that Connect 
Michigan has played in creating such a powerful tool that will surely benefit not just Michiganders 
but consumers and businesses nationwide. 
 
Therefore, as the State Broadband Designated Entity, in partnership with the Michigan Public 
Service Commission, we are pleased to present this submittal of the state of Michigan’s State 
Broadband Data and Development (SBDD) Grant Program, known as Connect Michigan. 

 
These artifacts should be found to be compliant with the April 1, 2011, deadline for the semi-annual 
data update and in accordance with the terms of the July 1, 2009, Notice of Funds Availability 
(NOFA) and all subsequent clarifications pertaining to delivery of State-Level Mapping of 
Broadband Service Availability.  This packet includes: 
 
Inventory of Deliverables, Connect Michigan: April 1, 2011 
 
NOFA Requirement Data Transfer Model Data Description 
Appendix A:  1(a)(i) BB_Service_CensusBlock Broadband Service Availability of 

Facilities-Based Providers in 
Census Blocks of No Greater 
Than Two Square Miles in Area 

Appendix A:   1(a)(ii) BB_Service_RoadSegment Broadband Service Availability of 
Facilities-Based Providers by Road 
Segment in Census Blocks Larger 
in Area Than Two Square Miles 
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Appendix A:   1(b) BB_Service_Wireless Broadband Service Availability of 
Wireless Services Not Provided to 
a Specific Address 

Appendix A:   3(b) BB_ConnectionPoint_MiddleMile Broadband Service Infrastructure 
Middle-Mile and Backbone 
Interconnection Points 

Appendix A:   4 BB_Service_CAInstitutions  Community Anchor Institutions-
Listing 

Appendix A:   4 n/a Community Anchor Institutions-
Narratives 

VII.A.1(a) n/a Accuracy and Verification Report 
n/a DataPackage.xlsx Worksheets of Contact 

Information, Data Dictionary, and 
Provider Summary Table 

n/a n/a Broadband Provider Roster and 
Participation Status 

 
In addition, this data update submission should be found to be compliant with the additional 
program requirements instituted by the National Telecommunications and Information 
Administration since the time of the October 2010 SBDD data submission for the Connect 
Michigan program.  Specifically, these new requirements are: 

 
SBDD Data Transfer Model 
The submission of the broadband dataset for April 1, 2011, is contained within the SBDD 
Data Transfer Model as released on the Grantee Workspace on January 14, 2011. All efforts 
have been made to comply with formatting, domain, and metadata requirements to include 
as much information on each provider as possible.  
 
Additional Submission Guidance 
This submission also includes the updated DataPackage spreadsheet with enhanced provider 
listings as well as satisfactory outputs from the SBDD_Check toolbox to ensure fewer 
unexpected values with the submitted broadband datasets prior to federal processing for the 
National Broadband Map update. 

 
It is therefore with great pleasure that the Connect Michigan program submits this April 2011 semi-
annual data update under the State Broadband Data and Development Grant Program.  We will 
continue to implement the joint purposes of the Recovery Act and the Broadband Data 
Improvement Act (BDIA) by gathering comprehensive and accurate state-level broadband mapping 
data, developing state-level broadband maps, aiding in the development and maintenance of the  
National Broadband Map, and undertaking statewide initiatives for broadband planning. 
 
Broadband Service Availability — Provider Outreach and Verification 
 
This data update submission under the SBDD includes the participation of approximately 85.48% of 
the Michigan provider community, or 106 of 124 total providers.  Of the 106 participating 
providers, 49 supplied an update to their network or coverage area(s), while 47 have reported no 
change. The remaining 10 represent providers who previously supplied data but were non-
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responsive in the April 2011 update effort or could not verify coverage areas at the time of this 
submission; therefore their previous dataset is being put forward as part of this compilation. A 
complete roster by provider depicting participation status and contact record is contained herein.  
Of the 18 providers that are not represented in the attached datasets, 5 have either refused to 
participate in the voluntary program or have remained unresponsive to the numerous attempts at 
contact by Connect Michigan. The remaining 13 providers are currently in some form of progress 
toward data submission but were not able to either submit or verify coverage areas at the time of 
this submission.    
 
As the aforementioned roster and attached methodology documentation will attest, it is the 
collective opinion of the Connect Michigan principals that all commercially reasonable efforts were 
made to account for 100% of the known Michigan broadband provider community, pursuant to this 
semi-annual data update submission. 
 
Connect Michigan has also continued to perform broadband verification activities through several 
means. In addition to confirmation of service area(s) by each provider, Connect Michigan conducts 
field validation efforts.  To date, 43 (34.68%) providers have been validated through field 
verification activities. Additional details on verification activities are contained within the Field 
Validation Narrative. 
  
At the program’s inception, Connect Michigan launched a website to create awareness about the 
initiative. Connectmi.org continues to serve a prominent role in the outreach and data collection 
effort.  This program asset provides a way for the general public to participate in the process by 
offering interactive tools for users to test their connection speed, submit broadband inquiries, or 
contact a program representative.   
 
As an indicator of stakeholder penetration, the Connect Michigan website encountered 4,804 unique 
visits during this reporting period (15,523 total to date for the life of the grant awarded on 
December 20, 2009).  Additionally, this pronounced Web activity netted 257 broadband inquiries 
over this same reporting period (1,021 grant inception to date).  The website also provides the 
BroadbandStat application, which allows the consumer to confirm or dispute the coverage 
represented on the broadband inventory map. These consumer-initiated actions are facilitated 
through the Connect Michigan website and the Connect Michigan Interactive Mapping Tool 
(BroadbandStat) that offer the citizens the vehicles to provide information regarding availability in 
their respective service area, either in affirmation or contest of the reported data represented in the 
Connect Michigan mapping artifacts.  Since the initial data collection and release of corresponding 
maps, feedback in the form of broadband inquiries has allowed Connect Michigan to identify 
additional areas that are in need of field validation, which is scheduled as soon as possible.  
 
Community Anchor Institutions  
 
Connect Michigan has established an ongoing mechanism for gathering data on the location and 
broadband connectivity of Community Anchor Institutions (CAI) in accordance with the data 
requirements of the SBDD NOFA Technical Appendix.   
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In conjunction with the Michigan Public Service Commission, research and outreach was conducted 
during this data update reporting period by Connect Michigan to continue identification of existing, 
centralized sources for CAI connectivity data.  Outreach was coordinated to distribute the CAI 
survey to institutions throughout the state through multiple methods including a customized online 
survey available on the Connect Michigan website.  Connect Michigan continues to work in close 
coordination with statewide associations such as the Michigan State Police, Michigan Townships 
Association, and Michigan Municipal League to promote the importance of broadband connectivity 
at anchor institutions and participation in this data collection process.   
 
While we continue to document institutions and the related addresses, the connectivity data 
collected in most categories remains incomplete at this time.  Connect Michigan will be 
implementing a number of new processes to increase participation including launching a CAI 
newsletter to connect communities across the state, increasing industry-specific planning with our 
state partner to target new community contacts, and revising the CAI portion of our website to 
increase visibility and content.  From our work in Connect Michigan, as well as other states, we 
recognize the great value of this data to future collaboration efforts within the state and its value to 
the recently released National Broadband Map.  We plan to continue to bring best practices to the 
Connect Michigan efforts, along with an investment of both human and technical resources required 
to reach our goal of increasing the data that is secured and reported as part of this process. 
 
In acquiring both broadband availability and CAI data within the state of Michigan, Connect 
Michigan has previously engaged all federally recognized tribal lands in the area covered by the 
Connect Michigan SBDD grant and reported that outreach as part of past submissions. Following 
the last submission, Connect Michigan met with the Native American Institute, which facilitated an 
opportunity for outreach and awareness at a United Tribes of Michigan Meeting. Throughout the 
next reporting period Connect Michigan plans to engage directly with these tribal communities and 
will also conduct affirmative outreach with Native American tribal organizations that are active 
within the area.  Connect Michigan understands the connectivity challenges facing these tribes, and 
we have identified a need to include their data as part of our upcoming submissions. 
 
 
The Connect Michigan program exists to improve data on the deployment and adoption of 
broadband services and to assist in the extension of broadband technology across all regions of the 
great state of Michigan, as well as the United States through contribution to the National Broadband 
Map.  We look forward to the continuing work ahead. 
 
 
Respectfully submitted, 
 
 
 
Thomas W. Ferree 
Chief Operating Officer 
Connected Nation, Inc. 

dclark
Cueball
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DATA ACQUISITION:  MICHIGAN COMMUNITY ANCHOR INSTITUTIONS  

In this third reporting period of the SBDD, Connect Michigan, working in close coordination with 
Michigan Public Service Commission, has established an ongoing mechanism for gathering data on 
the location and broadband connectivity of Community Anchor Institutions (CAI), in accordance 
with the data requirements of the SBDD NOFA Technical Appendix.  During this reporting period 
Connect Michigan has continued to focus efforts on conducting outreach and raising awareness of 
this important project. 
 
Connect Michigan has continued to identify and process CAI data obtained through an ongoing 
statewide outreach campaign.  Physical address information continues to be augmented through 
manual sourcing and geocoded by Connect Michigan through ESRI ArcGIS software. 
 
Connect Michigan continues to utilize a customized online survey hosted through SurveyMonkey, 
with a landing page on the Connect Michigan website that was developed during the first reporting 
period.  This survey, in combination with a customized data gathering spreadsheet, was distributed 
to a targeted list of CAI throughout the state.  Connect Michigan will continue to use these data 
gathering tools for future targeted outreach efforts throughout the coming months leading up to the 
next reporting period.  These materials are customized to fit the CAI categories as defined in the 
SBDD NOFA.   
 
The survey can be accessed at this link using the following password: 
http://connectmi.org/mapping/Community_Anchor_Institution_Data_Collection.php 
Password:  CAI_MI_9124 
 
Connect Michigan and the Michigan Public Service Commission have worked closely together 
during this reporting period to conduct research as part of an ongoing process to identify existing, 
centralized sources for CAI connectivity data.  Locating centralized data sources in Michigan 
continues to be a challenge, but efforts continue to be made to ensure all potential sources are being 
explored in the state. 
 
In tandem with these efforts to identify existing data, Connect Michigan continues to identify key 
CAI contacts among all CAI categories in an effort to distribute and promote the online survey and 
raise awareness of the importance of CAI broadband connectivity.  
 
Survey results during this reporting period have been slow, therefore targeted planning will occur 
during the coming months with key institution contacts to ensure that CAI throughout the state are 
aware of the importance of participating in this process and reporting data for their institutions. 
  
Connect Michigan has an ongoing mission to educate CAI throughout the state on the importance 
of participating in the project.  Participation by these institutions will raise awareness about the 
importance of broadband connectivity and the need to report the requested data for inclusion on the 
National Broadband Map.  To assist with our data collection efforts, Connect Michigan is 
developing a CAI newsletter to be distributed quarterly beginning in April 2011.   The newsletter will 
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highlight a CAI in Michigan, encourage institutions to share their data, and highlight the National 
Broadband Map. 
  
The greatest challenge with collecting this data continues to be the difficulty in securing CAI 
broadband connectivity data.  Connect Michigan will continue its ongoing work with the Michigan 
Public Service Commission and key organization contacts in an effort to raise awareness of this 
project among CAI.  Coordination with statewide contacts such as the Michigan Department of 
Education, Michigan State Police, and State Library of Michigan will be key in the coming months to 
increase survey results.  These institutions have been very helpful with past outreach attempts, and 
Connect Michigan will continue to rely upon them to assist with our efforts in the state. 
 
A CAI summary of all processed and submitted data is provided below: 
 

CAI Type Total 
Physical 
Address Lat/Long

Technology 
of 

Transmission
Downloa
d Speed 

Upload 
Speed

K-12 Schools 4,553 4,553 4,553 229 218 218
Libraries 2,286 2,286 2,285 830 851 31
Healthcare 262 262 262 2 2 2
Public Safety 959 959 958 18 17 17
Higher Ed Institutions 148 148 148 27 26 26
Other Government 85 85 85 21 18 18
Other Non-Government 515 515 515 49 2 2
Total 8,808 8,808 8,806 1,176 1,134 314

 
 
SBDD DATA SUBMISSION METHODOLOGY 

The submission of the broadband dataset for April 1, 2011, is contained within the SBDD Data 
Transfer Model and additional components as released on the Grantee Workspace on January 14, 
2011. Connected Nation has reviewed all literature that relates to the release and use of this data 
transfer model and recognizes that it does not replace or dictate how data is stored, processed, or 
displayed for the state or territory, as it is meant primarily as a means to transfer the broadband data 
from all states and territories and populate the National Broadband Map in a seamless fashion. 
Guidance from the Technical Mapping Guide, as released on the Grantee Workspace on March 24, 
2011, was also followed to ensure the completeness and validity of the submission through 
completion steps and checklists, completing the DataPackage spreadsheet, uploading broadband 
datasets into the Data Transfer Model, and checking the dataset using the SBDD_CheckSubmission 
receipt process.  
 
In addition to the narratives and methodologies contained herein, as well as the DataPackage.xls 
containing contact information, the data dictionary, and a provider summary table, the following 
feature classes are submitted within the SBDD Data Transfer Model for the state of Michigan. 



 
                                                            Connect Michigan – Narratives and Methodologies 

 

 
April 1, 2011                                                                                                                                                  9 

 

Inventory of Deliverables, Connect Michigan: April 1, 2011 
 
NOFA Requirement Data Transfer Model Data Description 
Appendix A:  1(a)(i) BB_Service_CensusBlock Broadband Service Availability of 

Facilities-Based Providers in 
Census Blocks of No Greater 
Than Two Square Miles in Area. 

Appendix A:   1(a)(ii) BB_Service_RoadSegment Broadband Service Availability of 
Facilities-Based Providers by Road 
Segment in Census Blocks Larger 
in Area Than Two Square Miles. 

Appendix A:   1(b) BB_Service_Wireless Broadband Service Availability of 
Wireless Services Not Provided to 
a Specific Address. 

Appendix A:   3(b) BB_ConnectionPoint_MiddleMile Broadband Service Infrastructure 
Middle-Mile and Backbone 
Interconnection Points. 

Appendix A:   4 BB_Service_CAInstitutions  Community Anchor Institutions-
Listing. 

 
The provider data collected by Connected Nation on behalf of the state of Michigan have been 
formatted per the given specifications and uploaded into the appropriate feature classes of the 
SBDD Data Transfer Model. Wireline availability is contained within census blocks and road 
segments, wireless availability is contained as polygons of coverage areas, and middle-mile 
connections and community anchor institutions are contained as point data. All speed data is 
contained at the census block, road segment, or wireless polygon level of availability. All efforts have 
been made to comply with formatting, domain, and metadata requirements to include as much 
information as possible.  
 
Connected Nation has continued outreach to satellite providers on their availability, technology, and 
speed information, but it is not included in this submission dataset.  Additional information is 
necessary to be able to show where service satisfactorily exists in the state, rather than submitting 
the entire boundary of the state as the serviceable area.  Analysis information distributed and 
discussed with the satellite providers, as well as any additional guidance from the Program Office on 
the desired analysis for satellite-serviceable areas, will be implemented for the October 2011 data 
submission.  
 
 
MICHIGAN FIELD VALIDATION NARRATIVE 

Connected Nation focused a portion of its time on specific validation processes such as: 
 

• conducting random spectrum analysis studies throughout the state using an Avcom PSA-37-
XP spectrum analyzer; 

• conducting mobile speed tests throughout the state using an iPhone, Android (or other 
smart phone) as well as provider-specific aircards (Sprint 3G/4G, Clearwire et al); 
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• identifying pre-selected, provider-submitted wireless transmit tower sites and cross-
referencing data about that tower against the Federal Communications Commission (FCC) 
databases such as Antenna Structure Registration and/or the Universal Licensing System; 

• cross-referencing Federal Registration Number data against available FCC Form 477 data as 
well as the FCC COmmission REgistration System (CORES); 

• validating provider submitted data (for example: latitude/longitude) using a handheld 
Garmin eTrex Summit GPS unit or GPS enabled software such as Microsoft Streets and 
Trips; 

• locating physical wire-line attributes (such as remote terminals, CATV plant, etc.) and 
comparing them against provider submitted data; and 

• conducting on-net and off-net speed tests using the FCC portal at 
http://www.broadband.gov/qualitytest/about/ or using the Ookla Net Metrics enabled 
speed test utility located on each of Connected Nation’s state specific websites. 

 
Additionally, Connected Nation cross-referenced numerous public documents in order to ensure 
that all known broadband providers were located and contacted.  This included searching 
membership logs from the trade associations (WISPA, WCAI, PCIA, etc.), the Cable Television Fact 
Book, Public Utility Commission records, Public Service Commission records, Chamber of 
Commerce, etc. 
 
To date Connected Nation’s staff conducted on-site validation tests in Michigan on the following 
providers:  2125 Cable Company LLC, ACD Net, Ace Telephone Company of Michigan Inc., Agri-
Valley Communications Inc., Allendale Telephone Company, AT&T, Azulstar Inc., Bloomingdale 
Communications Inc., Boardman River Communications LLC., CenturyLink, Charter 
Communications, Cherry Capital Connection LLC, Clearwire Corporation, COLI Inc., Comcast 
Cable Communications LLC, Custom Software Inc., D&P Communications Inc., Frontier 
Communications Corporation, Hidden Lake Wireless Inc., I-2000 Inc., KEPS Technologies Inc., 
Leap Wireless International Inc., Merit Network, MetaLINK Technologies Inc., Michwave 
Technologies Inc., Microtech Services Inc., Mutual Data Services, Ogden Communications Inc., 
Parish Communications, Pasty.Net Inc.,  Peninsula Telephone Company, Pigeon Telephone, Sister 
Lakes Cable TV, SpeedNet LLC, Sprint, Talk America Inc., TDS Telecommunications Corporation, 
T-Mobile, Town & Country CATV, Verizon North Inc., Waldron Telephone Company, Winn 
Telephone Company, and Wyandotte Municipal Services. 
 
During this reporting period, Connected Nation conducted 29 additional on-site validation tests  
with Merit Network, Clearwire, MicroTech Services, Mutual Data Services, AT&T, Charter, Chain 
of Lakes Internet Inc. (COLI), Leap Wireless, SpeedNet, Sprint, T-Mobile, and Verizon. 
 
From program initiation through this reporting period, Connected Nation has completed in-the-
field validation testing against 43 companies (out of a universe of 124 viable providers) totaling 
34.68% within the state of Michigan.   
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ACCURACY AND VERIFICATION:  METHODOLOGY - PROVIDER VALIDATION 

Broadband providers maintain their service area data in many different formats, all in varying levels 
of complexity and granularity. In order to ensure that the data required by the NTIA is standardized 
across all providers and that it is as accurate as possible, Connected Nation translates and formats 
the data that providers are able to supply into a GIS shapefile and produces maps for the provider to 
review.  The resulting map(s) and review process allow for providers to see their service area in a 
geographic format – for some providers, this is the first time they have seen maps of their 
broadband service area. Having the mapped service area allows providers to quickly identify any 
issues that appear in the data representation, whether the issue is in the data translation into a GIS 
format or from the original data collection and submission. Often data is provided from various 
sources and through the review and revision process, local engineers who operate the networks and 
work in the field are able to ensure that the tabular data that has been submitted is accurate and 
represents the real-world network extent. Any issues in how the service area is represented on the 
map(s) are remedied by Connected Nation, whether they are additions, removal of service, or any 
other revisions. Revised maps of service area representations are sent to the provider for review and 
approval; Connected Nation will revise data and return maps as many times as necessary until the 
provider is in agreement that the map represents their service area as accurately as possible. Once 
the review process has been completed and final approval of the data is provided, the data is deemed 
ready for NTIA submission. 
 
Once the data collection has been aggregated a statewide level, static maps of statewide and county-
level availability are produced and made publicly available. In addition, consumers can visit the 
interactive online tool, BroadbandStat, to create customized views of broadband service areas and 
analyze corresponding demographic information. Leveraging broadband service data on various 
platforms allows for public users, providers, and other stakeholders to review, scrutinize, and 
provide feedback on the represented data. This feedback becomes a validation method in itself as 
consumers submit inquiries to Connected Nation either affirming where service is not available or 
identifying areas where broadband service is shown on the map, but in actuality is not available. This 
allows for a follow-up to providers regarding revisions to the data as it is represented; it also allows 
for Connected Nation to identify locations where on-site visits may be necessary to complete field 
validation of available services. Public feedback on all forms of mapping products serves as a 
localized validation method for provider-supplied information and allows Connected Nation to 
resolve inaccuracies as they are identified to ensure that only the highest quality information is 
provided to stakeholders. 
 
Estimates derived from provider-validated data indicate that approximately 2.32% of Michigan 
households do not have terrestrial fixed broadband service available, and approximately 0.22%1 of 
Michigan households have neither mobile nor fixed broadband service available.2   

                                                 
1 In accordance with NTIA’s definition of available broadband service as specified in the SBDD NOFA, this estimate 

includes both terrestrial fixed and mobile broadband service, if the service offers download speeds of at least 768 Kbps 
and upload speeds greater than 200 Kbps. 

2 Due to the nature of the SBDD data collection methodology as defined by the NTIA and based on both census 
block geographic units and street segment data, the estimates of broadband availability derived from provider-validated 
data may include an overstatement of the actual number of households with broadband availability.  Under the census 
block-based data collection method, a provider will typically report broadband availability for an entire census block 
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Within rural areas of the state, results derived from provider-validated data indicate that 
approximately 4.71% of rural Michigan households do not have terrestrial fixed broadband service 
available, and approximately 0.45%3 of rural Michigan households have neither mobile nor fixed 
broadband service available.4   
 
 
WIRELESS METHODOLOGY 

 
Broadband Service Availability in Provider’s Service Area 

Wireless Services Not Provided to a Specific Address 
 
Data solicited from a fixed wireless provider to create propagation models include, but are not 
limited to: 

1. The name of the structure 
2. Whether the transmitting device is operational or proposed 
3. The maximum advertised downstream speed, the maximum advertised upstream speed 
4. The typical downstream speed, the typical upstream speed (peak periods for both) 
5. The frequency range of spectrum being used (as prescribed by NTIA) 
6. The primary population center(s) being served (for geopolitical boundary reference) 
7. The physical address of the transmit site (in the event latitude/longitude is unavailable from 

the provider this allows a quick reference point for geocoding) 
8. Latitude in either Degrees, Minutes and Seconds and/or in Decimal Degrees (typically 

received as NAD 27 or NAD 83)  
9. Longitude in either Degrees, Minutes and Seconds and/or in Decimal Degrees (typically 

received as NAD 27 or NAD 83)  
10. Antenna pattern (e.g. omni-directional, 180°, 120°, 90°, etc.) 
11. Azimuth of antenna (e.g. 360° with magnetic declination if known) 
12. Approximate transmit radius (in feet, miles, or kilometers) 
13. Polarity of transmit antenna (Vertical or Horizontal) 
14. Transmit antenna gain (in dBi) 
15. Line loss (applicable only to providers using coax, heliax, waveguide or other forms of 

cabling – excludes power-over-Ethernet devices) 
16. Mechanical and/or Electrical beam tilt (if applicable) 
17. Equipment Manufacturer (allows easy cross-reference against manufacturer’s specification 

sheet) 
18. Power output of the transmitting device (if unknown, FCC standards or manufacturer 

specifications are applied) 

                                                                                                                                                             
whether its network is present across the whole or only a subset of that census block.  This potential overestimation at 
the census block level can be amplified as the data is aggregated across the entire state. 

3 See footnote 1. 
4 See footnote 2. 
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19. AMSL at base of tower site 
20. Antenna centerline AGL (height of antenna above ground level measured at the centerline 

of the actual antenna) 
21. Foliage factors (Evergreens/Deciduous and percent of ground cover) 
22. Ground Clutter (primarily used in rural areas to account for foliage and in metropolitan areas 

to account for types and heights of buildings if known)   
23. Average gain of receive antenna 
24. Receive antenna is estimated at height above average terrain (HAAT) of 6.2 meters/20 feet 
25. Federal Registration Numbers (if applicable) which may allow opportunities to cross-

reference and/or obtain additional data from the Federal Communications Commission 
Universal Licensing System and the COmmission REgistration System 

 
Propagation modeling is an empirical mathematical formulation for the characterization of radio 
wave propagation as a function of frequency, distance, and other conditions. Propagation 
software(s) typically use the Irregular Terrain Model (also known as Longley-Rice) of radio 
propagation for frequencies between 20 MHz and 20 GHz. This model is based on electromagnetic 
theory and statistical analyses of the combination of terrain features and radio measurements, then 
predicting the median attenuation of a radio signal as a function of distance and the variability of the 
signal in time and in space.  For metropolitan areas, the software can typically be adjusted to use the 
Okumura-Hata model which accounts for predicting the behavior of cellular transmissions in areas 
where buildings are the primary obstructions. The resulting product from either model depicts a 
graphical illustration of the theoretical propagation characteristics of a selected frequency range 
based on defined variables (receiver sensitivity of the home/mobile device, foliage factor, and digital 
elevation terrain input). 
 
 
BROADBAND INQUIRIES METHODOLOGY 

Connected Nation collects consumer feedback in the form of broadband inquiries. These inquiries 
represent any type of communication received from the public regarding broadband service. Once 
broadband inquiries are received across the state, this information is overlaid with the broadband 
availability information which was collected through the SBDD program.  This allows for a real-
world comparison of the broadband landscape to the information received from broadband 
inquiries.  Broadband inquiries are able to provide three types of information:  1) Residents who do 
not have broadband but want it.  2)  Residents who have broadband but want a different provider.  
3)  Residents who do not have broadband, but the broadband inventory maps indicate that they do. 
 
Through the collection of broadband inquiries, a visual demand for broadband is presented.  This 
visualization allows Connected Nation the ability to validate broadband availability maps for 
accuracy.  If residents within a region state that they are without broadband, but the broadband 
inventory maps show otherwise, this allows Connected Nation to approach the providers within that 
area in an effort to trim down their coverage to more accurately represent real-world availability on 
the ground.  On the other hand, if there is a region in the territory in which broadband is not 
available, the broadband inquiries allow providers close to that region to see where they can 
successfully expand their broadband networks, leading to a high return on investment.  In short, the 
higher number of inquiries leads to a higher level of certainty in regard to the broadband availability 
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maps.  Since the initial data collection and release of corresponding maps, feedback in the form of 
broadband inquiries has allowed Connected Nation to identify additional areas that are in need of 
field validation, which are scheduled as soon as possible. Additional information on field validation 
can be found in the Field Validation Narrative. 
 
The broadband inquiry process has been implemented in each of the Connected Nation state 
programs with successful results. Altogether Connected Nation has received over 16,000 broadband 
inquiries since 2007, allowing the state programs to evaluate each inquiry for broadband demand and 
data verification.  These inquiries are continuously examined against current broadband availability, 
updated every six months, to determine if previously unserved households have been expanded to 
and can now receive broadband at their residence. This database of broadband inquiries has also 
allowed the Connected Nation state programs to aggregate demand in concentrated areas to show 
providers the exact locations where the population has made it clear that they would purchase 
broadband if it was made available to them. Providers in the states have responded to this process 
and have expanded to areas knowing that their investment will be worthwhile. Data verification 
methods have also proven successful, as the state programs have been able to show those inquiries 
that indicate the broadband service areas are misrepresented on the map to providers, who then 
verify where service cannot reach in regard to that residence(s). The broadband coverage in these 
states has been altered to create a more accurate map based on the inquiries submitted by the public. 
 
During this reporting period, the Connect Michigan project has received a total of 257 inquiries 
(1,021 grant inception to date).  As more inquiries are submitted to Connect Michigan, a more 
thorough validation of the broadband landscape can be performed, while also allowing providers to 
see which areas have a high demand for broadband adoption. 
 
 
BROADBANDSTAT METHODOLOGY  

BroadbandStat is an online, interactive mapping tool for viewing, analyzing, and validating 
broadband data. Developed through a partnership with ESRI, the market leader in geographic 
information system (GIS) software, BroadbandStat is a multi-functional, user-friendly way for local 
leaders, policymakers, consumers, and technology providers to devise a plan for the expansion and 
adoption of broadband.  
 
First and foremost, BroadbandStat allows consumers to locate their residence and identify providers 
that offer broadband Internet service to that location. The interactive platform allows for users to 
build and evaluate broadband expansion scenarios using a wealth of data, including education and 
population demographics, broadband availability, and research about the barriers to adoption.  
 
New functionality in BroadbandStat allows the consumer to provide feedback on the broadband 
data displayed on the interactive map.  Through the collection of this feedback, a visual demand for 
broadband is presented.  This visualization allows the Connected Nation state programs the ability 
to validate the broadband availability for accuracy.  If residents within a region state they are without 
broadband, but the interactive map shows otherwise, this allows Connected Nation to approach the 
providers within that area in an effort to trim down their coverage to more accurately represent real-
world availability on the ground.   
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The Connect Michigan project launched BroadbandStat on May 20, 2010, and has received a total of 
4,791 visits to date, of which 1,598 occurred this reporting period. 
 
 
SPEED TEST METHODOLOGY 

The 1,764 speed tests that are represented in the Connect Michigan Speed Test Report during this 
reporting period (4,055 grant inception to date) are the result of a partnership between Connected 
Nation and Ookla Net Metrics. Utilizing this relationship increases the level of confidence in the 
data being collected and provides for a far greater sample size than could be collected by a single 
testing site. 
 
Ookla owns and operates Speedtest.net, as well as develops and deploys speed tests, such as the 
Connect Michigan speed test website, for partners around the world. This network of sites that is 
developed and run on its testing technology provides Ookla with a vast dataset that, due to the 
variability of geographic information collected across the varying speed test sites, is geocoded 
utilizing Geo-IP technology. This technology allows for tests to be geocoded to points of 
aggregation, typically larger nodes across provider networks.  While there are hundreds of thousands 
of tests that have been conducted, the level of aggregation is only sufficient for county-level detail 
due to the test results being located at these larger nodes and not at an absolute location for each 
speed test. 
 
In an effort to validate broadband data from the Connect Michigan project, speed test information 
is collected throughout the state.  Speed tests provide speed information on the path taken through 
all networks (a provider’s network as well as additional networks) a local machine must connect to in 
order to reach the host test.  The benefit of this collection of speed information is two-tiered.  First, 
it allows for a comprehensive dataset of speeds, while also providing Connect Michigan with the 
information on where broadband services are available.  Second, unlike theoretical speed 
information which was received through the data collection process, the use of speed tests provide 
real-world information on the speeds that currently exist within the state of Michigan.   
 
 
 
 
 



Complete 151
Non-Responsive/Refused 5
In Progress 23

Count of Datasets by Viable Status 179
Total Unique Providers Represented 124

Provider Name Platform Status
NDA Execution 

Date Notes
Ace Telephone Company of Michigan Inc. ILEC/CLEC Data Added to Statewide Inventory 1/12/2010
Agri-Valley Communications, Inc. Mobile Wireless Data Added to Statewide Inventory 1/22/2010
Air Advantage, LLC Fixed Wireless Data Added to Statewide Inventory 3/15/2010
AT&T Inc. ILEC/CLEC Data Added to Statewide Inventory 12/16/2009
AT&T Inc. Mobile Wireless Data Added to Statewide Inventory 12/16/2009
Baraga Telephone Company ILEC/CLEC Data Added to Statewide Inventory 1/14/2010
Barry County Telephone Company Fixed Wireless Data Added to Statewide Inventory
Bright House Networks, LLC Cable Data Added to Statewide Inventory 4/26/2010
Buckeye Cablevision, Inc. Cable Data Added to Statewide Inventory 4/12/2010
Camp Communication Services, Inc. Fixed Wireless Data Added to Statewide Inventory
CenturyLink ILEC/CLEC Data Added to Statewide Inventory 12/4/2009
Charter Communications Cable Data Added to Statewide Inventory 12/15/2009
Cherry Capital Connection, LLC Fixed Wireless Data Added to Statewide Inventory 12/28/2009
Clearwire Corporation Mobile Wireless Data Added to Statewide Inventory
CMS Inter.net LLC   Fixed Wireless Data Added to Statewide Inventory 3/11/2010
Comcast Cable Communications, LLC Cable Data Added to Statewide Inventory 12/7/2009
Crystal Automation Systems, Inc Fixed Wireless Data Added to Statewide Inventory 6/25/2010
DMCI Broadband, LLC Fixed Wireless Data Added to Statewide Inventory 2/3/2010
Drenthe Telephone Company ILEC/CLEC Data Added to Statewide Inventory 2/4/2010
Endless Journey, Inc. Fixed Wireless Data Added to Statewide Inventory
FNW, LLC Fixed Wireless Data Added to Statewide Inventory 2/12/2010
Frontier Communications Corporation ILEC/CLEC Data Added to Statewide Inventory 1/22/2010
Hiawatha Communications, Inc. ILEC/CLEC Data Added to Statewide Inventory 2/2/2010
Hiawatha Communications, Inc. Fiber Data Added to Statewide Inventory 2/2/2010
Hiawatha Communications, Inc. ILEC/CLEC Data Added to Statewide Inventory 2/2/2010
I-2000, Inc. ILEC/CLEC Data Added to Statewide Inventory 3/7/2011
Iron Bay Computer & Design Fixed Wireless Data Added to Statewide Inventory 1/14/2010
Leap Wireless International, Inc. Mobile Wireless Data Added to Statewide Inventory 4/5/2010
Lighthouse Computers, Inc. Fixed Wireless Data Added to Statewide Inventory 2/17/2011
Michwave Technologies, Inc. Fixed Wireless Data Added to Statewide Inventory 3/12/2010
Ogden Communications Inc. ILEC/CLEC Data Added to Statewide Inventory 1/19/2010
Parish Communications Cable Data Added to Statewide Inventory 7/1/2010
Pasty.Net, Inc. Fixed Wireless Data Added to Statewide Inventory 1/6/2010
Sand Creek Communications Company ILEC/CLEC Data Added to Statewide Inventory 3/2/2010
Sister Lakes Cable TV Cable Data Added to Statewide Inventory
Small Business Solutions Group L.L.C. Fixed Wireless Data Added to Statewide Inventory 7/20/2010
Sprint Nextel Corporation Mobile Wireless Data Added to Statewide Inventory 1/14/2010
Summit Digital Holdings, Inc. Cable Data Added to Statewide Inventory
T-Mobile USA, Inc. Mobile Wireless Data Added to Statewide Inventory 1/8/2010
TDS Telecommunications Corporation ILEC/CLEC Data Added to Statewide Inventory 1/27/2010
The Computer Care Company, Inc. Fixed Wireless Data Added to Statewide Inventory 3/8/2011
Time Warner Cable LLC. Cable Data Added to Statewide Inventory 12/21/2009
Tucker Communications, Inc Fixed Wireless Data Added to Statewide Inventory 2/17/2011
United States Cellular Corporation Mobile Wireless Data Added to Statewide Inventory 2/15/2011
Verizon North Inc. Mobile Wireless Data Added to Statewide Inventory 12/14/2009
Westphalia Telephone Company ILEC/CLEC Data Added to Statewide Inventory 1/20/2010
DIECA Communications, Inc. Backhaul Backhaul Provider Only Processing Complete 1/19/2010
Great Lakes Comnet, Inc. Backhaul Backhaul Provider Only Processing Complete
Level 3 Communications, LLC Backhaul Backhaul Provider Only Processing Complete 12/14/2009
Peninsula Fiber Network, LLC Backhaul Backhaul Provider Only Processing Complete 1/14/2010
T-Mobile USA, Inc. Backhaul Backhaul Provider Only Processing Complete 1/8/2010
TDS Telecommunications Corporation Backhaul Backhaul Provider Only Processing Complete 1/27/2010
US Signal Backhaul Backhaul Provider Only Processing Complete 2/25/2010
Zayo Bandwidth, LLC Backhaul Backhaul Provider Only Processing Complete

I-2000, Inc. Fixed Wireless
Approval for Update Not Received - Use Last 
Submission Data 3/7/2011

McLeodUSA Telecommunications Services, Inc. ILEC/CLEC Provider Approval Solicited
2125 Cable Company, LLC Cable No Update to Provide 3/22/2010
Agri-Valley Communications, Inc. ILEC/CLEC No Update to Provide 1/22/2010
Agri-Valley Communications, Inc. Fixed Wireless No Update to Provide 1/22/2010
Agri-Valley Communications, Inc. Backhaul No Update to Provide 1/22/2010
Allband Communications Cooperative Fiber No Update to Provide 2/2/2010
Allendale Telephone Company Fiber No Update to Provide 2/4/2010
Allendale Telephone Company ILEC/CLEC No Update to Provide 2/4/2010
AT&T Inc. Backhaul No Update to Provide 12/16/2009
Azulstar, Inc. Fixed Wireless No Update to Provide 1/27/2010
Baraga Telephone Company Fiber No Update to Provide 1/14/2010
Barry County Telephone Company ILEC/CLEC No Update to Provide
Barry County Telephone Company Fiber No Update to Provide
BigTube Wireless Fixed Wireless No Update to Provide 6/17/2010
Blanchard Telephone Association, Inc. ILEC/CLEC No Update to Provide 6/17/2010
Blanchard Telephone Association, Inc. Backhaul No Update to Provide 6/17/2010
Bloomingdale Communications, Inc., Fixed Wireless No Update to Provide 1/25/2010
Bloomingdale Communications, Inc., ILEC/CLEC No Update to Provide 1/25/2010
Bloomingdale Communications, Inc., Fiber No Update to Provide 1/25/2010
Borderland Communications, LLC ILEC/CLEC No Update to Provide 1/22/2010
Borderland Communications, LLC Backhaul No Update to Provide 1/22/2010
Broadstripe LLC Cable No Update to Provide 3/5/2010
Cable America Michigan, LLC Cable No Update to Provide 3/9/2011
Carr Telephone Company ILEC/CLEC No Update to Provide 1/15/2010
CCI Systems Cable No Update to Provide 6/29/2010

Broadband Provider Log



CenturyLink Backhaul No Update to Provide 12/4/2009
Charter Communications Backhaul No Update to Provide 12/15/2009
City of Norway Cable No Update to Provide
Climax Telephone Company Backhaul No Update to Provide 1/14/2010
Climax Telephone Company ILEC/CLEC No Update to Provide 1/14/2010
Cogent Communications, Inc. Backhaul No Update to Provide
Coldwater Board of Public Utilities Cable No Update to Provide 3/1/2010
Crystal Automation Systems, Inc Backhaul No Update to Provide 6/25/2010
D & P  Communications, Inc. Cable No Update to Provide 3/8/2011
D & P  Communications, Inc. Fiber No Update to Provide 3/8/2011
Farmers Mutual Telephone Company ILEC/CLEC No Update to Provide 10/26/2010
Fourway Computer Products, Inc. Fixed Wireless No Update to Provide
Frontier Communications Corporation Backhaul No Update to Provide 1/22/2010
Hiawatha Communications, Inc. ILEC/CLEC No Update to Provide 2/2/2010
Hiawatha Communications, Inc. ILEC/CLEC No Update to Provide 2/2/2010
Hidden Lake Wireless, Inc. Fixed Wireless No Update to Provide 3/12/2010
Interlink Computers Technology, Inc. Fixed Wireless No Update to Provide 3/12/2010
Iron River Cooperative TV Antenna Corp Cable No Update to Provide 7/27/2010
ISP Management, Inc. Fixed Wireless No Update to Provide 3/22/2010
Kaltelco, LLC ILEC/CLEC No Update to Provide 3/5/2010
LigTel Communications Fixed Wireless No Update to Provide 3/31/2010
Mercury Network Corporation Fixed Wireless No Update to Provide 3/9/2011
Mercury Network Corporation Backhaul No Update to Provide 3/9/2011
Merit Network, Inc Backhaul No Update to Provide 6/21/2010
MetaLINK Technologies, Inc. Fixed Wireless No Update to Provide 3/22/2010
Michigan Cable Partners Inc. Cable No Update to Provide 6/18/2010
Michigan Online Group, Inc. ILEC/CLEC No Update to Provide
Michigan Online Group, Inc. Backhaul No Update to Provide
Michigan Online Group, Inc. Fiber No Update to Provide
Newaygo County Advanced Technology Services Fixed Wireless No Update to Provide
Northside TV Corporation Cable No Update to Provide
Ogden Communications Inc. Fixed Wireless No Update to Provide 1/19/2010
One Communications Corporation Backhaul No Update to Provide 3/18/2010
Sand Creek Communications Company Backhaul No Update to Provide 3/2/2010
SpeedNet, LLC Fixed Wireless No Update to Provide 1/7/2010
SpeedNet, LLC Backhaul No Update to Provide 1/7/2010
Springcom Inc. Cable No Update to Provide 2/25/2010
Springcom Inc. ILEC/CLEC No Update to Provide 2/25/2010
Sprint Nextel Corporation Backhaul No Update to Provide 1/14/2010
Summit Digital Holdings, Inc. Fixed Wireless No Update to Provide
T2 Communications, LLC Fiber No Update to Provide 3/10/2010
T2 Communications, LLC Backhaul No Update to Provide 3/10/2010
Talk America Inc. ILEC/CLEC No Update to Provide
Talk America Inc. Backhaul No Update to Provide
The Computer Care Company, Inc. ILEC/CLEC No Update to Provide 3/8/2011
The Computer Care Company, Inc. Backhaul No Update to Provide 3/8/2011
The Iserv Company, LLC ILEC/CLEC No Update to Provide 6/21/2010
The Iserv Company, LLC Fiber No Update to Provide 6/21/2010
The Iserv Company, LLC ILEC/CLEC No Update to Provide 6/21/2010
The Iserv Company, LLC Backhaul No Update to Provide 6/21/2010
Town & Country Cable and Telecommunications, LLC Cable No Update to Provide 6/18/2010
Upper Peninsula Telephone Company ILEC/CLEC No Update to Provide 1/11/2010
Verizon North Inc. Backhaul No Update to Provide 12/14/2009
Waldron Telephone Company Fixed Wireless No Update to Provide 1/12/2010
Waldron Telephone Company ILEC/CLEC No Update to Provide 1/12/2010
Winn Telephone Company ILEC/CLEC No Update to Provide 6/28/2010
Winn Telephone Company Fiber No Update to Provide 6/28/2010
Winn Telephone Company Fixed Wireless No Update to Provide 6/28/2010
Wyandotte Municipal Services Cable No Update to Provide 3/23/2010
XO Communications, LLC Backhaul No Update to Provide 2/12/2010

Boardman River Communications, LLC Cable
No Update Provided - Use Last Submission 
Data 2/10/2010

COLI, Inc. Fixed Wireless
No Update Provided - Use Last Submission 
Data

CSInet Internet Access Corp. Fixed Wireless
No Update Provided - Use Last Submission 
Data 3/31/2010

Custom Software Inc. ILEC/CLEC
No Update Provided - Use Last Submission 
Data 2/3/2010

Great Lakes Internet, Inc. Fixed Wireless
No Update Provided - Use Last Submission 
Data 3/11/2010

Ideal Wireless, Inc. Fixed Wireless
No Update Provided - Use Last Submission 
Data

Invisalink Wireless Enterprises LLC Fixed Wireless
No Update Provided - Use Last Submission 
Data 4/13/2010

KEPS Technologies, Inc. ILEC/CLEC
No Update Provided - Use Last Submission 
Data

KEPS Technologies, Inc. Fixed Wireless
No Update Provided - Use Last Submission 
Data

Lennon Telephone Company ILEC/CLEC
No Update Provided - Use Last Submission 
Data 1/25/2010

Lennon Telephone Company Cable
No Update Provided - Use Last Submission 
Data 1/25/2010

Nodin Communications, LLC Fixed Wireless
No Update Provided - Use Last Submission 
Data 4/22/2010

Arialink Telecom LLC Fiber Solicited Initial Data
Arialink Telecom LLC Fixed Wireless Solicited Initial Data
Arialink Telecom LLC ILEC/CLEC Solicited Initial Data
Banyan OnLine Services, LLC. Fixed Wireless Solicited Initial Data
Boardman River Communications, LLC Fixed Wireless Solicited Initial Data 2/10/2010
Endless Journey, Inc. ILEC/CLEC Solicited Initial Data
Great Lakes Satellite Group Fixed Wireless Solicited Initial Data
Lewiston Communications Cable Solicited Initial Data
M55 WiFi Wireless Internet Service Fixed Wireless Solicited Initial Data
Microtech Services, Inc. Fixed Wireless Solicited Initial Data
Mutual Data Servics, Inc. Fixed Wireless Solicited Initial Data
Sky Web Network, Inc Fixed Wireless Solicited Initial Data
SkyWay USA, LLC Satellite Solicited Initial Data
Tri-County Wireless, Inc. Fixed Wireless Solicited Initial Data



West Michigan Broadband Fixed Wireless Solicited Initial Data

M3 Wireless Fixed Wireless Refused to Participate

[JAN-10-11 Terry Holmes] Spoke with company 
representative who advised that they do not want to 
participate in the mapping program.

WideOpenWest Michigan, LLC Cable Refused to Participate

[MAR-11-10 Terry Holmes] Received voice message 
from company executive stating, "I spoke with my 
counterparts and we will not share information as 
requested by CN, so you will not be receiving information 
from WOW."  Subsequent attempts to contact this 
provider have resulted in no response.

Reliable Internet, LLC Fixed Wireless Non-Responsive to Multiple Attempts

[JAN-14-10 Terry Holmes] Left voicemail messages and 
sent e-mails to this provider multiple times over the past 
year and have not received one response.  They have 
an active website and the owner's name is identified on 
the voicemail leading me to believe the company is 
active, though I have never been able to talk with 
anyone at this company.

Rural Communications, Inc. Fixed Wireless Non-Responsive to Multiple Attempts

In addition to multiple contact attempts made between 
January 26, 2010 and September 8, 2010, seven 
attempts have been made during this submission period.

Wireless Technology Solutions Fixed Wireless Non-Responsive to Multiple Attempts

In addition to multiple contact attempts made between 
December 30, 2009 and July 28, 2010, seven attempts 
have been made during this submission period.

DIECA Communications, Inc. ILEC/CLEC Other 1/19/2010

[FEB-18-11 Sarah Finne] Provider does not offer 
residential DSL.  They submitted business data, so we 
will only submit their backhaul data to NTIA.

DISH Network Corporation Satellite Other 1/27/2010

[MAR-09-11 Sarah Finne] Satellite data will not be 
submitted due to additional information being necessary 
to show where service is available in the state, rather 
than submitting the entire state boundary as serviceable 
area.

Global Crossing Telecommunications, Inc. Backhaul Other

[FEB-17-11 Wes Kerr] Received word from a provider 
representative that they still have a Network Security 
agreement with several Federal agencies and cannot 
provide data at this time.

Hughes Network Systems, LLC Satellite Other 2/5/2010

[MAR-09-11 Sarah Finne] Satellite data will not be 
submitted due to additional information being necessary 
to show where service is available in the state, rather 
than submitting the entire state boundary as serviceable 
area.

Michigan Online Group, Inc. Fiber Other
[MAR-10-11 Dawn Clark] Per Sarah Finne they don't 
offer fiber under Michigan Online Group.

Time Warner Cable LLC. Backhaul Other 12/21/2009
[MAR-24-11 Dawn Clark] Provider does not offer 
backhaul in the state.

WildBlue Communications, Inc. Satellite Other 1/8/2010

[MAR-09-11 Sarah Finne] Satellite data will not be 
submitted due to additional information being necessary 
to show where service is available in the state, rather 
than submitting the entire state boundary as serviceable 
area.
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MINNESOTA COVER LETTER 

 
April 1, 2011 
 
Ms. Anne W. Neville 
SBDD Grant Program Director 
National Telecommunications and Information Administration 
U.S. Department of Commerce 
1401 Constitution Avenue, NW Room 4716 
Washington, DC 20230 
 
Dear Ms. Neville: 
 
It is with highest regard that the collective stakeholders of Connect Minnesota offer congratulations 
to the U.S. Department of Commerce’s National Telecommunications & Information 
Administration (NTIA) on the recent release of the National Broadband Map.  This extraordinary 
milestone demonstrates the intense and joint effort of the NTIA, FCC, state governments, industry, 
and non-profits like Connected Nation and will serve as a key tool for the American public and 
policymakers resulting in smarter investments and targeted state and local broadband policies and 
programs.  We are proud of the role that Connect Minnesota has played in creating such a powerful 
tool that will surely benefit not just Minnesotans, but consumers and businesses nationwide. 
 
Therefore, Connected Nation as the State Broadband Designated Entity, in partnership with the 
Minnesota Department of Commerce, is pleased to present this submittal of the state of Minnesota’s 
State Broadband Data and Development (SBDD) Grant Program, known as Connect Minnesota. 

 
These artifacts should be found to be compliant with the April 1, 2011, deadline for the semi-annual 
data update and in accordance with the terms of the July 1, 2009, Notice of Funds Availability 
(NOFA) and all subsequent clarifications pertaining to delivery of State-Level Mapping of 
Broadband Service Availability.  This packet includes: 
 
Inventory of Deliverables, Connect Minnesota: April 1, 2011 
 
NOFA Requirement Data Transfer Model Data Description 
Appendix A:  1(a)(i) BB_Service_CensusBlock Broadband Service Availability of 

Facilities-Based Providers in 
Census Blocks of No Greater 
Than Two Square Miles in Area 

Appendix A:   1(a)(ii) BB_Service_RoadSegment Broadband Service Availability of 
Facilities-Based Providers by Road 
Segment in Census Blocks Larger 
in Area Than Two Square Miles 

Appendix A:   1(b) BB_Service_Wireless Broadband Service Availability of 
Wireless Services Not Provided to 
a Specific Address 
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Appendix A:   3(b) BB_ConnectionPoint_MiddleMile Broadband Service Infrastructure 
Middle-Mile and Backbone 
Interconnection Points 

Appendix A:   4 BB_Service_CAInstitutions  Community Anchor Institutions-
Listing 

Appendix A:   4 n/a Community Anchor Institutions-
Narratives 

VII.A.1(a) n/a Accuracy and Verification Report 
n/a DataPackage.xlsx Worksheets of Contact 

Information, Data Dictionary, and 
Provider Summary Table 

n/a n/a Broadband Provider Roster and 
Participation Status 

 
In addition, this data update submission should be found to be compliant with the additional 
program requirements instituted by the National Telecommunications and Information 
Administration since the time of the October 2010 SBDD data submission for the Connect 
Minnesota program.  Specifically, these new requirements are: 

 
SBDD Data Transfer Model 
The submission of the broadband dataset for April 1, 2011, is contained within the SBDD 
Data Transfer Model as released on the Grantee Workspace on January 14, 2011. All efforts 
have been made to comply with formatting, domain, and metadata requirements to include 
as much information on each provider as possible.  
 
Additional Submission Guidance 
This submission also includes the updated DataPackage spreadsheet with enhanced provider 
listings as well as satisfactory outputs from the SBDD_Check toolbox to ensure fewer 
unexpected values with the submitted broadband datasets prior to federal processing for the 
National Broadband Map update. 

 
It is therefore with great pleasure that the Connect Minnesota program submits this April 2011 
semi-annual data update under the State Broadband Data and Development Grant Program.  We 
will continue to implement the joint purposes of the Recovery Act and the Broadband Data 
Improvement Act (BDIA) by gathering comprehensive and accurate state-level broadband mapping 
data, developing state-level broadband maps, aiding in the development and maintenance of the  
National Broadband Map, and undertaking statewide initiatives for broadband planning. 
 
Broadband Service Availability — Provider Outreach and Verification 
 
This data update submission under the SBDD includes the participation of approximately 89.92% of 
the Minnesota provider community, or 107 of 119 total providers.  Of the 107 participating 
providers, 50 supplied an update to their network or coverage area(s), while 54 have reported no 
change. The remaining 3 represent providers who previously supplied data but were non-responsive 
in the April 2011 update effort; therefore their previous dataset is being put forward as part of this 
compilation. A complete roster by provider depicting participation status and contact record is 
contained herein.  Of the 12 providers that are not represented in the attached datasets, 8 have 
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either refused to participate in the voluntary program or have remained unresponsive to the 
numerous attempts at contact by Connect Minnesota. The remaining 4 providers are currently in 
some form of progress toward data submission but were not able to either submit or verify coverage 
areas at the time of this submission.    
 
As the aforementioned roster and attached methodology documentation will attest, it is the 
collective opinion of the Connect Minnesota principals that all commercially reasonable efforts were 
made to account for 100% of the known Minnesota broadband provider community, pursuant to 
this semi-annual data update submission. 
 
Connect Minnesota has also continued to perform broadband verification activities through several 
means. In addition to confirmation of service area(s) by each provider, Connect Minnesota conducts 
field validation efforts.  To date, 52 (43.70%) providers have been validated through field 
verification activities. Additional details on verification activities are contained within the Field 
Validation Narrative. 
  
At the program’s inception, Connect Minnesota launched a website to create awareness about the 
initiative. Connectmn.org continues to serve a prominent role in the outreach and data collection 
effort.  This program asset provides a way for the general public to participate in the process by 
offering interactive tools for users to test their connection speed, submit broadband inquiries, or 
contact a program representative.  
 
As an indicator of stakeholder penetration, the Connect Minnesota website encountered 4,098 
unique visits during this reporting period (10,841total to date for the life of the grant awarded on 
December 20, 2009).  Additionally, this pronounced Web activity netted 39 broadband inquiries 
over this same reporting period (102 grant inception to date).  The website also provides the 
BroadbandStat application, which allows the consumer to confirm or dispute the coverage 
represented on the broadband inventory map. These consumer-initiated actions are facilitated 
through the Connect Minnesota website and the Connect Minnesota Interactive Mapping Tool 
(BroadbandStat) that offer the citizens the vehicles to provide information regarding availability in 
their respective service area, either in affirmation or contest of the reported data represented in the 
Connect Minnesota mapping artifacts.  Since the initial data collection and release of corresponding 
maps, feedback in the form of broadband inquiries has allowed Connected Nation to identify 
additional areas that are in need of field validation, which is scheduled as soon as possible.  
 
Community Anchor Institutions  
 
Connect Minnesota has established an ongoing mechanism for gathering data on the location and 
broadband connectivity of Community Anchor Institutions (CAI), in accordance with the data 
requirements of the SBDD NOFA Technical Appendix.   
 
In conjunction with the Minnesota Department of Commerce, outreach was conducted during this 
data update reporting period by Connect Minnesota to continue identification of existing, 
centralized sources for CAI connectivity data.  Connect Minnesota worked closely with the 
Minnesota Office of Enterprise Technology to gain access to data from its state network for 
inclusion during this reporting submission.  Additionally, outreach was coordinated to distribute the 
CAI survey to institutions throughout the state through multiple methods including a customized 
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online survey available on the Connect Minnesota website.  During this reporting period Connect 
Minnesota has developed a number of new relationships with statewide associations such as the 
Minnesota League of Cities, Minnesota Private College Council, and Minnesota Department of 
Education to promote the importance of broadband connectivity at anchor institutions and 
participation in this data collection process.  Connect Minnesota will continue to build upon these 
new relationships over the coming months and utilize their contacts throughout the state to collect 
data and raise awareness of this project. 
 
While we continue to document institutions and the related addresses, the connectivity data 
collected in most categories remains incomplete at this time.  Connect Minnesota will be 
implementing a number of new processes to increase participation including launching a CAI 
newsletter to connect communities across the state, increased industry-specific planning to target 
new community contacts, and revising the CAI portion of our website to increase visibility and 
content.  From our work in Minnesota, as well as other states, we recognize the great value of this 
data to future collaboration efforts within the state and its value to the recently released National 
Broadband Map.  We plan to continue to bring best practices to the Connect Minnesota efforts, 
along with an investment of both human and technical resources required to reach our goal of 
increasing the data that is secured and reported as part of this process. 
 
In acquiring both broadband availability and CAI data within the state of Minnesota, Connected 
Nation has previously engaged all of the eleven (11) federally recognized tribal lands in the area 
covered by the Connect Minnesota SBDD grant and reported that outreach as part of past 
submissions. Throughout the next reporting period Connect Minnesota plans to engage directly with 
these tribal communities and will also conduct affirmative outreach with Native American tribal 
organizations that are active within the area.  Connect Minnesota understands the connectivity 
challenges facing these tribes, and we have identified a need to include their data as part of our 
upcoming submissions. 
 
The Connect Minnesota program exists to improve data on the deployment and adoption of 
broadband services and to assist in the extension of broadband technology across all regions of the 
great state of Minnesota, as well as the United States through contribution to the National 
Broadband Map.  We look forward to the continuing work ahead. 
 
Respectfully submitted, 
 
 
 
Thomas W. Ferree 
Chief Operating Officer 
Connected Nation, Inc. 
 

dclark
Cueball
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DATA ACQUISITION:  MINNESOTA COMMUNITY ANCHOR INSTITUTIONS  

In this third reporting period of the SBDD, Connect Minnesota, working in close coordination with 
the Minnesota Department of Commerce, has established an ongoing mechanism for gathering data 
on the location and broadband connectivity of Community Anchor Institutions (CAI), in 
accordance with the data requirements of the SBDD NOFA Technical Appendix.  During this 
reporting period Connect Minnesota has continued to focus efforts on conducting outreach and 
raising awareness of this important project. 
 
Connect Minnesota has continued to identify and process CAI data obtained through an ongoing 
statewide outreach campaign.  Physical address information continues to be augmented through 
manual sourcing and geocoded by Connect Minnesota through ESRI ArcGIS software. 
 
Connect Minnesota continues to utilize a customized online survey hosted through SurveyMonkey, 
with a landing page on the Connect Minnesota website that was developed during the first reporting 
period.  This survey, in combination with a customized data gathering spreadsheet, was distributed 
to a targeted list of CAI throughout the state.  Connect Minnesota will continue to use these data 
gathering tools for future targeted outreach efforts throughout the coming months leading up to the 
next reporting period.  These materials are customized to fit the CAI categories as defined in the 
SBDD NOFA.   
 
The survey can be accessed at this link using the following password: 
http://connectmn.org/mapping/Community_Anchor_Institution_Data_Collection.php 
Password:  CAI_MN_7611 
 
Connect Minnesota and the Minnesota Department of Commerce have worked closely during this 
reporting period to conduct research as part of an ongoing process to identify existing, centralized 
sources for CAI connectivity data.  The Minnesota Office of Enterprise Technology (OET) has 
provided Connect Minnesota a file of approximately 1,000 CAI that utilize its state-owned network.  
These CAI include education, healthcare, public safety, higher education, and government sectors 
and provide full connectivity data for each institution.  Additional information on the names and 
addresses of these institutions is still being extracted from the OET database, and Connect 
Minnesota should be reporting this data in the next reporting submission. 
 
In tandem with these efforts to identify existing data, Connect Minnesota continues to identify key 
CAI contacts among all CAI categories in an effort to distribute and promote the online survey and 
raise awareness of the importance of CAI broadband connectivity.  
 
During this last reporting period outreach has occurred to introduce the CAI project to key contacts 
at the Minnesota Department of Education, Minnesota Library Association, Minnesota Hospital 
Association, Minnesota Department of Public Safety, Minnesota Private College Council, 
Association of Minnesota Counties, and the League of Minnesota Cities.  This outreach has resulted 
in many new contacts in the state and Connect Minnesota is encouraged that survey results will 
increase in all sectors within the coming months. 
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Connect Minnesota has an ongoing mission to educate CAI throughout the state on the importance 
of participating in the project.  Participation by these institutions will raise awareness about the 
importance of broadband connectivity and the need to report the requested data for inclusion on the 
National Broadband Map.  To assist with our data collection efforts, Connect Minnesota is 
developing a CAI newsletter to be distributed quarterly beginning in April 2011.  The newsletter will 
highlight a CAI in Minnesota, encourage institutions to share their data, and highlight the National 
Broadband Map. 
 
The greatest challenge with collecting this data continues to be the difficulty in securing CAI 
broadband connectivity data.  Connect Minnesota will continue its ongoing work with the 
Minnesota Department of Commerce and key organization contacts in an effort to raise awareness 
of this project among CAI.  Additionally, the Minnesota Broadband Advisory Task Force will be 
briefed at an upcoming meeting on the CAI project and will be made aware of the challenges we 
have faced in the state with collecting this data.  The Task Force members will be provided 
information regarding how they can assist with outreach and promotion over the coming months. 
 
A CAI summary of all processed and submitted data is provided below: 
 

CAI Type Total 
Physical 
Address Lat/Long

Technology 
of 

Transmission
Download 

Speed 
Upload 
Speed

K-12 Schools 3,624 3,624 3,624 0 0 0
Libraries 1,708 1,708 1,706 10 10 10
Healthcare 180 180 180 58 57 57
Public Safety 1,544 1,544 1,544 4 4 4
Higher Ed Institutions 138 138 138 0 0 0
Other Government 117 117 116 26 26 26
Other Non-Government 1 1 1 0 0 0
Total 7,312 7,312 7,309 98 97 97
 
 

SBDD DATA SUBMISSION METHODOLOGY 

The submission of the broadband dataset for April 1, 2011, is contained within the SBDD Data 
Transfer Model and additional components as released on the Grantee Workspace on January 14, 
2011. Connected Nation has reviewed all literature that relates to the release and use of this data 
transfer model and recognizes that it does not replace or dictate how data is stored, processed, or 
displayed for the state or territory, as it is meant primarily as a means to transfer the broadband data 
from all states and territories and populate the National Broadband Map in a seamless fashion. 
Guidance from the Technical Mapping Guide, as released on the Grantee Workspace on March 24, 
2011, was also followed to ensure the completeness and validity of the submission through 
completion steps and checklists, completing the DataPackage spreadsheet, uploading broadband 
datasets into the Data Transfer Model, and checking the dataset using the SBDD_CheckSubmission 
receipt process.  
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In addition to the narratives and methodologies contained herein, as well as the DataPackage.xls 
containing contact information, the data dictionary, and a provider summary table, the following 
feature classes are submitted within the SBDD Data Transfer Model for the state of Minnesota. 
 
Inventory of Deliverables, Connect Minnesota: April 1, 2011 
 
NOFA Requirement Data Transfer Model Data Description 
Appendix A:  1(a)(i) BB_Service_CensusBlock Broadband Service Availability of 

Facilities-Based Providers in 
Census Blocks of No Greater 
Than Two Square Miles in Area. 

Appendix A:   1(a)(ii) BB_Service_RoadSegment Broadband Service Availability of 
Facilities-Based Providers by Road 
Segment in Census Blocks Larger 
in Area Than Two Square Miles. 

Appendix A:   1(b) BB_Service_Wireless Broadband Service Availability of 
Wireless Services Not Provided to 
a Specific Address. 

Appendix A:   3(b) BB_ConnectionPoint_MiddleMile Broadband Service Infrastructure 
Middle-Mile and Backbone 
Interconnection Points. 

Appendix A:   4 BB_Service_CAInstitutions  Community Anchor Institutions-
Listing. 

 
The provider data collected by Connected Nation on behalf of the state of Minnesota have been 
formatted per the given specifications and uploaded into the appropriate feature classes of the 
SBDD Data Transfer Model. Wireline availability is contained within census blocks and road 
segments, wireless availability is contained as polygons of coverage areas, and middle-mile 
connections and community anchor institutions are contained as point data. All speed data is 
contained at the census block, road segment, or wireless polygon level of availability. All efforts have 
been made to comply with formatting, domain, and metadata requirements to include as much 
information as possible.  
 
Connected Nation has continued outreach to satellite providers on their availability, technology, and 
speed information, but it is not included in this submission dataset.  Additional information is 
necessary to be able to show where service satisfactorily exists in the state, rather than submitting 
the entire boundary of the state as the serviceable area.  Analysis information distributed and 
discussed with the satellite providers, as well as any additional guidance from the Program Office on 
the desired analysis for satellite-serviceable areas, will be implemented for the October 2011 data 
submission.  
 
 
MINNESOTA FIELD VALIDATION NARRATIVE 

Connected Nation focused a portion of its time on specific validation processes such as: 
 

• conducting random spectrum analysis studies throughout the state using an Avcom PSA-37-
XP spectrum analyzer; 
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• conducting mobile speed tests throughout the state using an iPhone, Android (or other 
smart phone) as well as provider-specific aircards (Sprint 3G/4G, Clearwire et al); 

• identifying pre-selected, provider-submitted wireless transmit tower sites and cross-
referencing data about that tower against the Federal Communications Commission (FCC) 
databases such as Antenna Structure Registration and/or the Universal Licensing System; 

• cross-referencing Federal Registration Number data against available FCC Form 477 data as 
well as the FCC COmmission REgistration System (CORES); 

• validating provider submitted data (for example: latitude/longitude) using a handheld 
Garmin eTrex Summit GPS unit or GPS enabled software such as Microsoft Streets and 
Trips; 

• locating physical wire-line attributes (such as remote terminals, CATV plant, etc.) and 
comparing them against provider submitted data; and  

• conducting on-net and off-net speed tests using the FCC portal at 
http://www.broadband.gov/qualitytest/about/ or using the Ookla Net Metrics enabled 
speed test utility located on each of Connected Nation’s state specific websites. 

 
Additionally, Connected Nation cross-referenced numerous public documents in order to ensure 
that all known broadband providers were located and contacted.  This included searching 
membership logs from the trade associations (WISPA, WCAI, PCIA, etc.), the Cable Television Fact 
Book, Public Utility Commission records, Public Service Commission records, Chamber of 
Commerce, etc. 
 
To date Connected Nation’s staff conducted on-site validation tests in Minnesota on the following 
providers:  Albany Mutual Telephone Association, Alliance Communications, Arvig 
Communications Systems, AT&T, Barnesville Municipal Telephone, Bradco-WISP Inc., 
CenturyLink, Charter Communications, Chaska Net, CitiScape Communications, Clear Choice, 
Clearwire Corporation, Comcast Cable Communications LLC, CTC Telecom, diversiCOM, 
Enterpoint, Evertek Enterprises LLC., Farmers Mutual Telephone, Frontier Communications 
Corporation, Garden Valley Telephone Company, Gardonville Cooperative Telephone Association, 
Genesis Wireless, Halsted Telephone, Harmony Telephone Company, Info Link Wireless Inc., 
Invisimax, Jaguar Communications, Lakedale LINK, Loretel Systems Inc., Mabel Cooperative 
Telephone Company, Maple Leaf Networks, Midcontinent Communications, Min-Kota Wireless, 
Minnesota Valley Telephone Company, Minnesota Valley TV Improvement Corporation, Otter tail 
Telecom, Polar Telcom Inc., Qwest Corporation, Red River Telephone Association, Ridge Runner 
Internet Services Inc., River Valley Telecommunications Cooperative, Scott Rice 
Telecommunications Cooperative, Sioux Valley Wireless, Sleepy Eye Telephone Company, Spring 
Grove Cooperative Telephone Company, T-Mobile USA, U.S. Internet Corporation, US Cable 
Corporation, VAL-ED Joint Venture, Verizon Communications, and Winnebago Cooperative 
Telephone Association. 
 
During this reporting period, Connected Nation conducted 21 additional on-site validation tests  
with Alliance Communications, AT&T, Clear Choice, CTC Telecom, Enterpoint, Farmers Mutual 
Telephone, Halsted Telephone, Invisimax, and Sprint. 
 
From program initiation through this reporting period, Connected Nation has completed in-the-
field validation testing against 52 companies (out of a universe of 119 viable providers) totaling 
43.70% within the state of Minnesota.   
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ACCURACY AND VERIFICATION:  METHODOLOGY - PROVIDER VALIDATION 

Broadband providers maintain their service area data in many different formats, all in varying levels 
of complexity and granularity. In order to ensure that the data required by the NTIA is standardized 
across all providers and that it is as accurate as possible, Connected Nation translates and formats 
the data that providers are able to supply into a GIS shapefile and produces maps for the provider to 
review.  The resulting map(s) and review process allow for providers to see their service area in a 
geographic format – for some providers, this is the first time they have seen maps of their 
broadband service area. Having the mapped service area allows providers to quickly identify any 
issues that appear in the data representation, whether the issue is in the data translation into a GIS 
format or from the original data collection and submission. Often data is provided from various 
sources and through the review and revision process, local engineers who operate the networks and 
work in the field are able to ensure that the tabular data that has been submitted is accurate and 
represents the real-world network extent. Any issues in how the service area is represented on the 
map(s) are remedied by Connected Nation, whether they are additions, removal of service, or any 
other revisions. Revised maps of service area representations are sent to the provider for review and 
approval; Connected Nation will revise data and return maps as many times as necessary until the 
provider is in agreement that the map represents their service area as accurately as possible. Once 
the review process has been completed and final approval of the data is provided, the data is deemed 
ready for NTIA submission. 
 
Once the data collection has been aggregated a statewide level, static maps of statewide and county-
level availability are produced and made publicly available. In addition, consumers can visit the 
interactive online tool, BroadbandStat, to create customized views of broadband service areas and 
analyze corresponding demographic information. Leveraging broadband service data on various 
platforms allows for public users, providers, and other stakeholders to review, scrutinize, and 
provide feedback on the represented data. This feedback becomes a validation method in itself as 
consumers submit inquiries to Connected Nation either affirming where service is not available or 
identifying areas where broadband service is shown on the map, but in actuality is not available. This 
allows for a follow-up to providers regarding revisions to the data as it is represented; it also allows 
for Connected Nation to identify locations where on-site visits may be necessary to complete field 
validation of available services. Public feedback on all forms of mapping products serves as a 
localized validation method for provider-supplied information and allows Connected Nation to 
resolve inaccuracies as they are identified to ensure that only the highest quality information is 
provided to stakeholders. 
 
Estimates derived from provider-validated data indicate that approximately 3.02% of Minnesota 
households do not have terrestrial fixed broadband service available, and approximately 0.27%1 of 
Minnesota households have neither mobile nor fixed broadband service available.2   

                                                 
1 In accordance with NTIA’s definition of available broadband service as specified in the SBDD NOFA, this estimate 

includes both terrestrial fixed and mobile broadband service, if the service offers download speeds of at least 768 Kbps 
and upload speeds greater than 200 Kbps. 

2 Due to the nature of the SBDD data collection methodology as defined by the NTIA and based on both census 
block geographic units and street segment data, the estimates of broadband availability derived from provider-validated 
data may include an overstatement of the actual number of households with broadband availability.  Under the census 
block-based data collection method, a provider will typically report broadband availability for an entire census block 
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Within rural areas of the state, results derived from provider-validated data indicate that 
approximately 6.58% of rural Minnesota households do not have terrestrial fixed broadband service 
available, and approximately 0.53%3 of rural Minnesota households have neither mobile nor fixed 
broadband service available.4   
 
 
WIRELESS METHODOLOGY 

 
Broadband Service Availability in Provider’s Service Area 

Wireless Services Not Provided to a Specific Address 
 
Data solicited from a fixed wireless provider to create propagation models include, but are not 
limited to: 

1. The name of the structure 
2. Whether the transmitting device is operational or proposed 
3. The maximum advertised downstream speed, the maximum advertised upstream speed 
4. The typical downstream speed, the typical upstream speed (peak periods for both) 
5. The frequency range of spectrum being used (as prescribed by NTIA) 
6. The primary population center(s) being served (for geopolitical boundary reference) 
7. The physical address of the transmit site (in the event latitude/longitude is unavailable from 

the provider this allows a quick reference point for geocoding) 
8. Latitude in either Degrees, Minutes and Seconds and/or in Decimal Degrees (typically 

received as NAD 27 or NAD 83)  
9. Longitude in either Degrees, Minutes and Seconds and/or in Decimal Degrees (typically 

received as NAD 27 or NAD 83)  
10. Antenna pattern (e.g. omni-directional, 180°, 120°, 90°, etc.) 
11. Azimuth of antenna (e.g. 360° with magnetic declination if known) 
12. Approximate transmit radius (in feet, miles, or kilometers) 
13. Polarity of transmit antenna (Vertical or Horizontal) 
14. Transmit antenna gain (in dBi) 
15. Line loss (applicable only to providers using coax, heliax, waveguide or other forms of 

cabling – excludes power-over-Ethernet devices) 
16. Mechanical and/or Electrical beam tilt (if applicable) 
17. Equipment Manufacturer (allows easy cross-reference against manufacturer’s specification 

sheet) 
18. Power output of the transmitting device (if unknown, FCC standards or manufacturer 

specifications are applied) 
19. AMSL at base of tower site 

                                                                                                                                                             
whether its network is present across the whole or only a subset of that census block.  This potential overestimation at 
the census block level can be amplified as the data is aggregated across the entire state. 

3 See footnote 1. 
4 See footnote 2. 
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20. Antenna centerline AGL (height of antenna above ground level measured at the centerline 
of the actual antenna) 

21. Foliage factors (Evergreens/Deciduous and percent of ground cover) 
22. Ground Clutter (primarily used in rural areas to account for foliage and in metropolitan areas 

to account for types and heights of buildings if known)   
23. Average gain of receive antenna 
24. Receive antenna is estimated at height above average terrain (HAAT) of 6.2 meters/20 feet 
25. Federal Registration Numbers (if applicable) which may allow opportunities to cross-

reference and/or obtain additional data from the Federal Communications Commission 
Universal Licensing System and the COmmission REgistration System 

 
Propagation modeling is an empirical mathematical formulation for the characterization of radio 
wave propagation as a function of frequency, distance, and other conditions. Propagation 
software(s) typically use the Irregular Terrain Model (also known as Longley-Rice) of radio 
propagation for frequencies between 20 MHz and 20 GHz. This model is based on electromagnetic 
theory and statistical analyses of the combination of terrain features and radio measurements, then 
predicting the median attenuation of a radio signal as a function of distance and the variability of the 
signal in time and in space.  For metropolitan areas, the software can typically be adjusted to use the 
Okumura-Hata model which accounts for predicting the behavior of cellular transmissions in areas 
where buildings are the primary obstructions. The resulting product from either model depicts a 
graphical illustration of the theoretical propagation characteristics of a selected frequency range 
based on defined variables (receiver sensitivity of the home/mobile device, foliage factor, and digital 
elevation terrain input). 
 
 
BROADBAND INQUIRIES METHODOLOGY 

Connected Nation collects consumer feedback in the form of broadband inquiries. These inquiries 
represent any type of communication received from the public regarding broadband service. Once 
broadband inquiries are received across the state, this information is overlaid with the broadband 
availability information which was collected through the SBDD program.  This allows for a real-
world comparison of the broadband landscape to the information received from broadband 
inquiries.  Broadband inquiries are able to provide three types of information:  1) Residents who do 
not have broadband but want it.  2)  Residents who have broadband but want a different provider.  
3)  Residents who do not have broadband, but the broadband inventory maps indicate that they do. 
 
Through the collection of broadband inquiries, a visual demand for broadband is presented.  This 
visualization allows Connected Nation the ability to validate broadband availability maps for 
accuracy.  If residents within a region state that they are without broadband, but the broadband 
inventory maps show otherwise, this allows Connected Nation to approach the providers within that 
area in an effort to trim down their coverage to more accurately represent real-world availability on 
the ground.  On the other hand, if there is a region in the territory in which broadband is not 
available, the broadband inquiries allow providers close to that region to see where they can 
successfully expand their broadband networks, leading to a high return on investment.  In short, the 
higher number of inquiries leads to a higher level of certainty in regard to the broadband availability 
maps.  Since the initial data collection and release of corresponding maps, feedback in the form of 
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broadband inquiries has allowed Connected Nation to identify additional areas that are in need of 
field validation, which are scheduled as soon as possible. Additional information on field validation 
can be found in the Field Validation Narrative. 
 
The broadband inquiry process has been implemented in each of the Connected Nation state 
programs with successful results. Altogether Connected Nation has received over 16,000 broadband 
inquiries since 2007, allowing the state programs to evaluate each inquiry for broadband demand and 
data verification.  These inquiries are continuously examined against current broadband availability, 
updated every six months, to determine if previously unserved households have been expanded to 
and can now receive broadband at their residence. This database of broadband inquiries has also 
allowed the Connected Nation state programs to aggregate demand in concentrated areas to show 
providers the exact locations where the population has made it clear that they would purchase 
broadband if it was made available to them. Providers in the states have responded to this process 
and have expanded to areas knowing that their investment will be worthwhile. Data verification 
methods have also proven successful, as the state programs have been able to show those inquiries 
that indicate the broadband service areas are misrepresented on the map to providers, who then 
verify where service cannot reach in regard to that residence(s). The broadband coverage in these 
states has been altered to create a more accurate map based on the inquiries submitted by the public. 
 
During this reporting period, the Connect Minnesota project has received a total of 39 inquiries (102 
grant inception to date).  As more inquiries are submitted to Connect Minnesota, a more thorough 
validation of the broadband landscape can be performed, while also allowing providers to see which 
areas have a high demand for broadband adoption. 
 
 
BROADBANDSTAT METHODOLOGY  

BroadbandStat is an online, interactive mapping tool for viewing, analyzing, and validating 
broadband data. Developed through a partnership with ESRI, the market leader in geographic 
information system (GIS) software, BroadbandStat is a multi-functional, user-friendly way for local 
leaders, policymakers, consumers, and technology providers to devise a plan for the expansion and 
adoption of broadband.  
 
First and foremost, BroadbandStat allows consumers to locate their residence and identify providers 
that offer broadband Internet service to that location. The interactive platform allows for users to 
build and evaluate broadband expansion scenarios using a wealth of data, including education and 
population demographics, broadband availability, and research about the barriers to adoption.  
 
New functionality in BroadbandStat allows the consumer to provide feedback on the broadband 
data displayed on the interactive map.  Through the collection of this feedback, a visual demand for 
broadband is presented.  This visualization allows the Connected Nation state programs the ability 
to validate the broadband availability for accuracy.  If residents within a region state they are without 
broadband, but the interactive map shows otherwise, this allows Connected Nation to approach the 
providers within that area in an effort to trim down their coverage to more accurately represent real-
world availability on the ground.   
 
The Connect Minnesota project launched BroadbandStat on May 21, 2010, and has received a total 
of 2,332 visits to date, of which 923 occurred this reporting period. 
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SPEED TEST METHODOLOGY 

The 2,846 speed tests that are represented in the Connect Minnesota Speed Test Report during this 
reporting period (5,920 grant inception to date) are the result of a partnership between Connected 
Nation and Ookla Net Metrics. Utilizing this relationship increases the level of confidence in the 
data being collected and provides for a far greater sample size than could be collected by a single 
testing site. 
 
Ookla owns and operates Speedtest.net, as well as develops and deploys speed tests, such as the 
Connect Minnesota speed test website, for partners around the world. This network of sites that is 
developed and run on its testing technology provides Ookla with a vast dataset that, due to the 
variability of geographic information collected across the varying speed test sites, is geocoded 
utilizing Geo-IP technology. This technology allows for tests to be geocoded to points of 
aggregation, typically larger nodes across provider networks.  While there are hundreds of thousands 
of tests that have been conducted, the level of aggregation is only sufficient for county-level detail 
due to the test results being located at these larger nodes and not at an absolute location for each 
speed test. 
 
In an effort to validate broadband data from the Connect Minnesota project, speed test information 
is collected throughout the state.  Speed tests provide speed information on the path taken through 
all networks (a provider’s network as well as additional networks) a local machine must connect to in 
order to reach the host test.  The benefit of this collection of speed information is two-tiered.  First, 
it allows for a comprehensive dataset of speeds, while also providing Connect Minnesota with the 
information on where broadband services are available.  Second, unlike theoretical speed 
information which was received through the data collection process, the use of speed tests provide 
real-world information on the speeds that currently exist within the state of Minnesota.   
 
 
 
 
 



Complete 166
Non-Responsive/Refused 9
In Progress 14

Count of Datasets by Viable Status 189
Total Unique Providers Represented 119

Provider Name Platform Status
NDA Execution 

Date Notes
Ace Telephone Association ILEC/CLEC Data Added to Statewide Inventory 8/3/2010
Alliance Communications ILEC/CLEC Data Added to Statewide Inventory
Alliance Communications Fiber Data Added to Statewide Inventory
Arvig Communications Systems Fixed Wireless Data Added to Statewide Inventory 2/2/2011
Arvig Communications Systems Fiber Data Added to Statewide Inventory 2/2/2011
Arvig Communications Systems ILEC/CLEC Data Added to Statewide Inventory 2/2/2011
AT&T Corp, Inc. Mobile Wireless Data Added to Statewide Inventory 12/16/2009
Barnesville Municipal Telephone ILEC/CLEC Data Added to Statewide Inventory 3/4/2010
Blue Earth Valley Telephone Company ILEC/CLEC Data Added to Statewide Inventory 6/16/2010
Bradco-Wisp, Inc. Fixed Wireless Data Added to Statewide Inventory
Cable ONE Inc. Cable Data Added to Statewide Inventory 12/7/2009
CenturyLink ILEC/CLEC Data Added to Statewide Inventory 12/4/2009
Charter Communications, Inc. Cable Data Added to Statewide Inventory 12/15/2009
Christensen Communications Company ILEC/CLEC Data Added to Statewide Inventory 2/2/2010
CitEscape Wireless Internet, LLC Fixed Wireless Data Added to Statewide Inventory 1/25/2010
Clear Choice Communications Fixed Wireless Data Added to Statewide Inventory
Clearwire Corporation Mobile Wireless Data Added to Statewide Inventory 3/3/2010
Clearwire Corporation Fixed Wireless Data Added to Statewide Inventory 3/3/2010
Comcast Cable Communications, LLC Cable Data Added to Statewide Inventory 12/7/2009
Consolidated Telephone Company Fiber Data Added to Statewide Inventory
Consolidated Telephone Company ILEC/CLEC Data Added to Statewide Inventory
diversiCOM Fiber Data Added to Statewide Inventory 4/20/2010
diversiCOM ILEC/CLEC Data Added to Statewide Inventory 4/20/2010
Frontier Communications of Minnesota, Inc. ILEC/CLEC Data Added to Statewide Inventory 1/22/2010
FTTH Communications Fiber Data Added to Statewide Inventory
Hiawatha Broadband Comunications, Inc. Fiber Data Added to Statewide Inventory 3/8/2010
Info Link Wireless, Inc. Fixed Wireless Data Added to Statewide Inventory 4/19/2010
Interstate Telecommunications Cooperative, Inc. ILEC/CLEC Data Added to Statewide Inventory 2/10/2010
Interstate Telecommunications Cooperative, Inc. Fiber Data Added to Statewide Inventory 2/10/2010
InvisiMax, Inc. Fixed Wireless Data Added to Statewide Inventory
Lonsdale Telephone Co., Inc. Fiber Data Added to Statewide Inventory
Manchester-Hartland Telephone Company Fiber Data Added to Statewide Inventory 4/14/2010
Minnesota Valley TV Improvement Corporation Fixed Wireless Data Added to Statewide Inventory 4/13/2010
New Ulm Telecom Inc. ILEC/CLEC Data Added to Statewide Inventory 2/25/2010
NorthfieldWiFi LLC Fixed Wireless Data Added to Statewide Inventory 2/4/2011
Park Region Mutual Telephone Company Fiber Data Added to Statewide Inventory 3/18/2010
Park Region Mutual Telephone Company ILEC/CLEC Data Added to Statewide Inventory 3/18/2010
Paul Bunyan Rural Telephone Cooperative Fiber Data Added to Statewide Inventory 6/24/2010
Paul Bunyan Rural Telephone Cooperative ILEC/CLEC Data Added to Statewide Inventory 6/24/2010
Polar Telcom, Inc. ILEC/CLEC Data Added to Statewide Inventory 2/11/2010
Qwest Corporation ILEC/CLEC Data Added to Statewide Inventory 1/4/2010
Red River Rural Telephone Association Fiber Data Added to Statewide Inventory 3/17/2010
Red River Rural Telephone Association ILEC/CLEC Data Added to Statewide Inventory 3/17/2010
Red River Rural Telephone Association Fixed Wireless Data Added to Statewide Inventory 3/17/2010
Savage Communications Inc. Cable Data Added to Statewide Inventory 2/19/2010
Scott Rice Telephone Co. Fiber Data Added to Statewide Inventory 2/15/2010
Scott Rice Telephone Co. ILEC/CLEC Data Added to Statewide Inventory 2/15/2010
Sprint Nextel Corporation Mobile Wireless Data Added to Statewide Inventory 1/14/2010
Starpoint Communications, Inc. Fixed Wireless Data Added to Statewide Inventory 2/18/2011
T-Mobile USA, Inc. Mobile Wireless Data Added to Statewide Inventory 1/8/2010
TDS Telecommunications Corporation ILEC/CLEC Data Added to Statewide Inventory 1/27/2010
TDS Telecommunications Corporation Fiber Data Added to Statewide Inventory 1/27/2010
Upsala Cooperative Telephone Association ILEC/CLEC Data Added to Statewide Inventory
Upsala Cooperative Telephone Association Fiber Data Added to Statewide Inventory
US Internet of Minnetoka Fixed Wireless Data Added to Statewide Inventory
VAL-ED Joint Venture, LLP Fixed Wireless Data Added to Statewide Inventory 4/21/2010
Verizon Communications, Inc. Mobile Wireless Data Added to Statewide Inventory 12/14/2009
Western Telephone Company ILEC/CLEC Data Added to Statewide Inventory 4/14/2010
Wolverton Telephone Company ILEC/CLEC Data Added to Statewide Inventory 6/22/2010
Woodstock Telephone Company ILEC/CLEC Data Added to Statewide Inventory 2/18/2010
Woodstock Telephone Company Fiber Data Added to Statewide Inventory 2/18/2010
CenturyLink Backhaul Backhaul Provider Only Processing Complete 12/4/2009
Cogent Communications, Inc. Backhaul Backhaul Provider Only Processing Complete
Level 3 Communications, LLC Backhaul Backhaul Provider Only Processing Complete 12/14/2009
Mediacom Minnesota LLC Backhaul Backhaul Provider Only Processing Complete 1/12/2010
Savage Communications Inc. Backhaul Backhaul Provider Only Processing Complete 2/19/2010
T-Mobile USA, Inc. Backhaul Backhaul Provider Only Processing Complete 1/8/2010
Zayo Group, LLC Backhaul Backhaul Provider Only Processing Complete
McLeodUSA Telecommunications Services, Inc. ILEC/CLEC Provider Approval Solicited

Broadband Provider Log



360networks Backhaul No Update to Provide 1/19/2010
Ace Telephone Association Backhaul No Update to Provide 8/3/2010
Albany Mutual Telephone Association ILEC/CLEC No Update to Provide 3/4/2010
Albany Mutual Telephone Association Fiber No Update to Provide 3/4/2010
Alliance Communications Backhaul No Update to Provide
Arrowhead Communications ILEC/CLEC No Update to Provide 4/14/2010
AT&T Corp, Inc. Backhaul No Update to Provide 12/16/2009
Benton Cooperative Telephone Company Cable No Update to Provide 6/16/2010
Benton Cooperative Telephone Company Fiber No Update to Provide 6/16/2010
Benton Cooperative Telephone Company ILEC/CLEC No Update to Provide 6/16/2010
Benton Cooperative Telephone Company Mobile Wireless No Update to Provide 6/16/2010
Blue Earth Valley Telephone Company Cable No Update to Provide 6/16/2010
Blue Earth Valley Telephone Company Fiber No Update to Provide 6/16/2010
Broadband Corp Fixed Wireless No Update to Provide 5/11/2010
Christensen Communications Company Backhaul No Update to Provide 2/2/2010
City of Windom Fiber No Update to Provide
Clara City Telephone Company ILEC/CLEC No Update to Provide 2/5/2010
Consolidated Telephone Company Fixed Wireless No Update to Provide
Crosslake Telephone Company Fiber No Update to Provide 6/16/2010
Crosslake Telephone Company ILEC/CLEC No Update to Provide 6/16/2010
Crosslake Telephone Company Cable No Update to Provide 6/16/2010
DIECA Communications, Inc. Backhaul No Update to Provide 1/19/2010
diversiCOM Fixed Wireless No Update to Provide 4/20/2010
diversiCOM Cable No Update to Provide 4/20/2010
Eagle Valley Telephone Company ILEC/CLEC No Update to Provide 4/14/2010
Emily Cooperative Telephone Company ILEC/CLEC No Update to Provide 6/24/2010
Emily Cooperative Telephone Company Fiber No Update to Provide 6/24/2010
Enterpoint Wireless Fixed Wireless No Update to Provide
Evertek Enterprises, Inc. Fixed Wireless No Update to Provide 6/17/2010
Farmers Mutual Telephone Company Fixed Wireless No Update to Provide 4/1/2010
Farmers Mutual Telephone Company Fiber No Update to Provide 4/1/2010
Federated Telephone Cooperative Fixed Wireless No Update to Provide 4/1/2010
Federated Telephone Cooperative Fiber No Update to Provide 4/1/2010
Felton Telephone Company ILEC/CLEC No Update to Provide 4/14/2010
Frontier Communications of Minnesota, Inc. Backhaul No Update to Provide 1/22/2010
Garden Valley Telephone Company Fiber No Update to Provide 2/17/2010
Garden Valley Telephone Company ILEC/CLEC No Update to Provide 2/17/2010
Gardonville Cooperative Telephone Association ILEC/CLEC No Update to Provide 2/23/2010
Gardonville Cooperative Telephone Association Fixed Wireless No Update to Provide 2/23/2010
Gardonville Cooperative Telephone Association Fiber No Update to Provide 2/23/2010
Genesis Wireless Fixed Wireless No Update to Provide
Granada Telephone Company ILEC/CLEC No Update to Provide 4/14/2010
Halstad Telephone Company ILEC/CLEC No Update to Provide 6/16/2010
Halstad Telephone Company Fixed Wireless No Update to Provide 6/16/2010
Harmony Telephone Company Fiber No Update to Provide 1/12/2010
Hiawatha Broadband Comunications, Inc. Cable No Update to Provide 3/8/2010
Hickory Tech Corporation ILEC/CLEC No Update to Provide
HomeTown Solutions LLC Fiber No Update to Provide 4/1/2010
Hutchinson Telecommunications, Inc. ILEC/CLEC No Update to Provide 4/14/2010
Hutchinson Telecommunications, Inc. Fixed Wireless No Update to Provide 4/14/2010
Jaguar Communications Cable No Update to Provide 4/12/2010
Jaguar Communications Fiber No Update to Provide 4/12/2010
Jaguar Communications Fixed Wireless No Update to Provide 4/12/2010
Jaguar Communications ILEC/CLEC No Update to Provide 4/12/2010
Johnson Telephone Company ILEC/CLEC No Update to Provide
Kasson & Mantorville Telephone Company ILEC/CLEC No Update to Provide 6/30/2010
Lonsdale Telephone Co., Inc. ILEC/CLEC No Update to Provide
Loretel Systems, Inc. ILEC/CLEC No Update to Provide 4/14/2010
Mabel Cooperative Telephone Company ILEC/CLEC No Update to Provide 4/7/2010
Manchester-Hartland Telephone Company ILEC/CLEC No Update to Provide 4/14/2010
Mediacom Minnesota LLC Cable No Update to Provide 1/12/2010
Midcontinent Communications Cable No Update to Provide 12/9/2009
Midcontinent Communications Backhaul No Update to Provide 12/9/2009
Minnesota Valley Telephone Company ILEC/CLEC No Update to Provide 4/29/2010
Pine Island Telephone Company ILEC/CLEC No Update to Provide 4/14/2010
Qwest Corporation Backhaul No Update to Provide 1/4/2010
River Valley Telecommunications Coop Fixed Wireless No Update to Provide 4/28/2010
Rothsay Telephone Company Inc. ILEC/CLEC No Update to Provide 2/18/2010
Runestone Telecom Association Fiber No Update to Provide 4/14/2010
Runestone Telecom Association ILEC/CLEC No Update to Provide 4/14/2010
Sacred Heart Telephone Company ILEC/CLEC No Update to Provide 2/5/2010
Sheehan Gas Fixed Wireless No Update to Provide
Sioux Valley Wireless Fixed Wireless No Update to Provide 4/21/2010
Sjoberg's Inc. Cable No Update to Provide 12/21/2009
Sleepy Eye Telephone Company ILEC/CLEC No Update to Provide 4/14/2010
Southern Cablevision, Inc. Cable No Update to Provide 3/30/2010
Spring Grove Cooperative Telephone Co. Fiber No Update to Provide 1/12/2010
Sprint Nextel Corporation Backhaul No Update to Provide 1/14/2010
Starbuck Telephone Company ILEC/CLEC No Update to Provide 2/5/2010
TDS Telecommunications Corporation Backhaul No Update to Provide 1/27/2010
tw telecom of minnesota llc Backhaul No Update to Provide 4/20/2010
US Cable Corporation Cable No Update to Provide 5/20/2010
VAL-ED Joint Venture, LLP ILEC/CLEC No Update to Provide 4/21/2010
Verizon Communications, Inc. Backhaul No Update to Provide 12/14/2009
West Central Telephone Association ILEC/CLEC No Update to Provide 2/18/2010



West Central Telephone Association Fiber No Update to Provide 2/18/2010
Wikstrom Telephone Company ILEC/CLEC No Update to Provide 4/12/2010
Wikstrom Telephone Company Fixed Wireless No Update to Provide 4/12/2010
Winnebago Cooperative Telecom Association Backhaul No Update to Provide 6/17/2010
Winnebago Cooperative Telecom Association Fiber No Update to Provide 6/17/2010
Winnebago Cooperative Telecom Association Fixed Wireless No Update to Provide 6/17/2010
Winnebago Cooperative Telecom Association ILEC/CLEC No Update to Provide 6/17/2010
XO Communications, LLC Backhaul No Update to Provide 2/12/2010
Zumbrota Telephone Company ILEC/CLEC No Update to Provide 2/5/2010
EN-TEL Communications, LLC ILEC/CLEC No Update Provided - Use Last Submission Data
Lakedale LINK ILEC/CLEC No Update Provided - Use Last Submission Data
Lakedale LINK Fixed Wireless No Update Provided - Use Last Submission Data
Lakedale Telephone ILEC/CLEC No Update Provided - Use Last Submission Data
Knology of the Plains, Inc. Cable Solicited Initial Data
Knology of the Plains, Inc. Backhaul Solicited Initial Data
Reliance Globalcom Services, Inc. Backhaul Solicited Initial Data

A Better Wireless, NISP, LLC Fixed Wireless Non-Responsive to Multiple Attempts

[FEB-16-11 John Determan] While 
attempting to solicit data in 
accordance with the NOFA and the 
Clarification, A Better Wireless has 
not responded to our multiple 
inquiries.  We have completed 
validation work in the area, 
provided results from interactive 
map, asked for input and still no 
response.  We will continue to 
attempt to gain A Better Wireless's 
participation in Minnesota's 
broadband mapping project.

Chaska Net Fixed Wireless Non-Responsive to Multiple Attempts

[FEB-16-11 John Determan] While 
attempting to solicit data in 
accordance with the NOFA and the 
Clarification, ChaskaNet has not 
responded our multiple inquiries.  
We have created the dataset 
during validation work in the area, 
provided it for approval, and still 
have received no response.  We 
will continue to attempt to gain 
Chaska Net's participation in 
Minnesota's broadband mapping 
project.

City of Detroit Lakes Fixed Wireless Non-Responsive to Multiple Attempts 5/10/2010

In addition to multiple contact 
attempts made between April 7, 
2010 and August 4, 2010, nine 
attempts have been made during 
this submission period.

Fibernet Monticello Fiber Non-Responsive to Multiple Attempts

[FEB-24-11 John Determan] While 
attempting to solicit data in 
accordance with the NOFA and the 
Clarification Fibernet Monticello 
has not responded our multiple 
inquiries.  We have created the 
dataset during validation work in 
the area, provided it for approval 
and still received no response.  We 
will continue to attempt to gain 
Fibernet Monticello's participation 
in Minnesota's broadband mapping 
project.

Ideaone Telecom Group, LLC Fixed Wireless Non-Responsive to Multiple Attempts

[FEB-16-11 John Determan] While 
attempting to solicit data in 
accordance with the NOFA and the 
Clarification, Ideaone has not 
responded to our multiple inquiries. 
We will continue to attempt to gain 
Ideaone's participation in 
Minnesota's broadband mapping 
project.

Ideaone Telecom Group, LLC ILEC/CLEC Non-Responsive to Multiple Attempts

[FEB-16-11 John Determan] While 
attempting to solicit data in 
accordance with the NOFA and the 
Clarification, Ideaone has not 
responded our multiple inquiries. 
We will continue to attempt to gain 
Ideaone's participation in 
Minnesota's broadband mapping 
project.



Maple Leaf Networks Fixed Wireless Non-Responsive to Multiple Attempts

[JAN-14-11 John Determan] While 
attempting to solicit data in 
accordance with the NOFA and the 
Clarification, Maple Leaf Networks 
has not responded our multiple 
inquiries.  We have created 90% of 
dataset during validation work in 
the area, provided for approval, but 
still no response.  We will continue 
to attempt to gain Maple Leaf 
Networks' participation in 
Minnesota's broadband mapping 
project.

Nextera Communications ILEC/CLEC Non-Responsive to Multiple Attempts

[FEB-18-11 John Determan] While 
attempting to solicit data in 
accordance with the NOFA, Ridge 
Runner has not responded to our 
multiple inquiries by USPS, e-mail, 
or telephone.

Ridge Runner Internet Services Inc. Fixed Wireless Non-Responsive to Multiple Attempts

[FEB-15-11 John Determan] While 
attempting to solicit data in 
accordance with the NOFA and the 
Clarification, Ridge Runner has not 
responded to our multiple inquiries 
by USPS, e-mail or telephone.

Ace Telephone Association Fiber Other 8/3/2010

[JAN-20-11 John Determan] 
Provider clairified corrections and 
the entire coverage is Fiber to the 
Node and DSL to subscribers.  
Was previously displayed as FTTH.  

Arvig Communications Systems Cable Other 2/2/2011

[JAN-21-11 John Determan]  Cable 
properties are reported under Arvig 
Communications' Subsidiary 
Company Home Telephone, dba 
Southern Cablevision.

Christensen Communications Company Fiber Other 2/2/2010

[FEB-15-11 John Determan] Fiber 
is B2B and backhaul only.  Created 
Backhaul DCU.

DIECA Communications, Inc. ILEC/CLEC Other 1/19/2010

[FEB-18-11 Wes Kerr] Provider 
doesn't offer residential DSL, and 
the last mile data will not be 
included in the data submission.

DISH Network Corporation Satellite Other 1/27/2010

[MAR-9-11 Brian Dudek] Satellite 
data will not be submitted due to 
additional information being 
necessary to show where service is 
available in the state, rather than 
submitting the entire state 
boundary as serviceable area.

Farmers Mutual Telephone Company ILEC/CLEC Other 4/1/2010

[JAN-27-11 John Determan]  There 
is no DSL currently in coverage.  
All has been transferred to fiber.

Global Crossing Telecommunications, Inc. Backhaul Other

[FEB-17-11 Wes Kerr] Received 
word from a provider representative 
that they still have a Network 
Security agreement with several 
Federal agencies and cannot 
provide data at this time.

Hughes Network Systems, LLC Satellite Other 2/5/2010

[MAR-9-11 Brian Dudek] Satellite 
data will not be submitted due to 
additional information being 
necessary to show where service is 
available in the state, rather than 
submitting the entire state 
boundary as serviceable area.

West Central Telephone Association Fixed Wireless Other 2/18/2010

[FEB-22-11 John Determan] 
Created new provider entry as 
Clear Choice Communications (a 
partnership between West Central 
Telephone and CTC Telcom) is a 
separate company.

WildBlue Communications, Inc. Satellite Other 1/8/2010

[MAR-09-11 Brian Dudek] Satellite 
data will not be submitted due to 
additional information being 
necessary to show where service is 
available in the state, rather than 
submitting the entire state 
boundary as serviceable area.



Hiawatha Broadband Comunications, Inc. Mobile Wireless Offers Service but Below FCC Definition 3/8/2010
Park Region Mutual Telephone Company Fixed Wireless Offers Service but Below FCC Definition 3/18/2010
Starpoint Communications, Inc. ILEC/CLEC Inactive - No Longer in Business 2/18/2011
Interstate Telecommunications Cooperative, Inc. Satellite Not a Broadband Provider 2/10/2010
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11  Introduction 

This document provides background for the data collection and processing phases of the Missouri 
Broadband Data and Development Project. It covers the initial processing of data to meet specific 
requirements defined by the National Telecommunications and Information Administration (NTIA), 
governed by the Notice of Funds Availability (NOFA) first published in volume 74, number 129, at 
page 32545 of the Federal Register and subsequently clarified in volume 74, number 154, at page 
40569 of the Federal Register. It also covers the quality control aspects of the project, including both 
back lab and field verification. 
 
22  Non-Disclosure Agreement Development Process 

The parties to the NDA process include the State of Missouri, the University of Missouri, GeoDecisions, 
and CBG Communications.  Each of the above parties, along with the individual broadband service 
provider, was a signatory of each NDA. 
 
A standard NDA was developed using an initial template provided by CBG which then adjusted based 
on previously signed agreements provided by AT&T.  This template was then reviewed and 
standardized for Missouri state contracting language as edited with inputs from all state parties.  This 
NDA was then vetted with representatives from the Missouri broadband provider community in order 
to develop a data sharing document that reflected the concerns of both the state and industry. 
 
The state drafted, signed, and distributed an initial letter to providers; including data collection 
guidelines and a draft of the standard NDA (see Attachment A).  This letter was initially sent to 129 
providers initially in late March 2010. Mailing of this agreement has now been sent to 237 different 
entities within the state. Eighty-three of these entities were found to be resellers. Currently we have 
91 providers cooperating with the mapping program. 
 
 
33  IIddeennttiiffyyiinngg  PPrroovviiddeerrss 

The state parties used multiple methodologies to: a) identify broadband providers potentially offering 
service in the State of Missouri, and b) to acquire / build contact information for each of the 
providers. 
 
Identification of providers began by accessing the FCC’s Form 477 publically available data. 
This data provides the Holding Company Name, the FCC Registration number (FRN), and the filing 
company name of all broadband providers in the state that completed the Form 477. We began with 
this information and performed research tasks, including internet research of each of the companies 
to obtain a high level contact within the company, as well as their phone and e-mail contact 
information. If some of this information was not obtainable via Internet research, CBG made initial 
contact with the company, primarily through phone, to further explore the most pertinent contact. 
 
In addition, we performed research of various websites to determine if there are providers that had 
not filed a Form 477 with the FCC that should be included in the data collection process. We 
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researched these companies again for the best contact information through various public records 
including, but not limited to, Missouri Public Service Commission databases, State 
Telecommunications Industry Association memberships, FCC Cable TV Community Unit and Physical 
System ID databases, FCC telephone company databases, business licenses, state and local tax 
records, etc., as well as various state, local and other departments and agencies, including Division of 
Corporations, Division of Revenue, Local Franchise Authorities, Chambers of Commerce, etc. 
 
We also continue to identify additional potential providers during our verification processes which 
include: internet searches, field discoveries (i.e. comprised of business names advertised 
(signage/trucks etc.), labeled infrastructure observed), CAI calling, and residential surveys/interviews. 
 
As new providers were identified, the contact information was given to MU for delivery of initial 
contact letters to identified providers. These documents were mailed out by MU via e-mail, in order to 
expedite the process, and through the USPS as a formal notification.  Based on input from providers 
in other states, these documents were sent by the State in order to show the importance that the 
State places on the project. All correspondence with the providers, including clarification on the NDA 
or Data Request, data formatting issues, and data submission by the providers, was then handled by 
GeoDecisions and CBG personnel unless the provider required interaction with state personnel (ie. 
Negotiation of NDA). 
 
Due to the initial timeframe for completion (May 31, 2010) for Missouri’s first version of the statewide 
map of broadband provision, the providers were requested to return the signed NDAs within five (5) 
business days of receipt and submit their data, in as usable a format as possible, by April 15, 2010.  
 
Currently the state parties continue to perform follow-up with providers on an as-needed basis. This 
includes making contact with a provider if we did not hear from them after sending out the NDA or a 
new Data Request, following up to receive initial data sets, clarification regarding data sets, etc. 
Contact with the providers included phone calls, voicemail, and e-mail. In the case where a provider 
did not respond after numerous attempts, we also followed up with USPS mail. 
 
A spreadsheet was utilized to keep track of all contact information that was developed and contacts 
that were made to ensure the accuracy of each provider’s pertinent contacts for the statewide 
project. These contacts continue to be updated and maintained. 
 
44  Requested Data Format 

The overarching goal of the data collection was to satisfy the requirements of the State 
Broadband Data and Development (SBDD) grant program, which is governed by the Notice of 
Funds Availability (NOFA) first published in volume 74, number 129, at page 32545 of the 
Federal Register and subsequently clarified in volume 74, number 154, at page 40569 of the Federal 
Register. Both the NOFA and subsequent discussions with the NTIA have indicated that time is of the 
essence, and strict deadlines are in place for the delivery of data to the NTIA. As such, timely, 
accurate data collection was of primary concern. GeoDecisions and CBG requested that broadband 
providers submit data in a timely manner in whatever format the information was currently available 
to eliminate the lag that can be expected with the providers attempting to meet NOFA formatting 
compliance themselves; however, it was determined that many national providers, having gone 
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through this process in other states, could deliver NOFA compliant data as part of their data 
submittal. 
 
To assist in the NDA execution process and to further facilitate the timely delivery of data from the 
providers, GeoDecisions and CBG reviewed the State’s NOFA cover letter that provides background on 
the project and provides the contacts to project team members from the State, GeoDecisions, and 
CBG. The cover letter stressed the incredibly short project timelines and specified the need to collect 
this data on an ongoing basis. 
 
In addition to the cover letter, GeoDecisions and CBG developed a separate attachment to the NDAs. 
The Data Collection Guidelines was reviewed by the State, which provided further background and 
project goals associated with the State Broadband Data and Development project. The document also 
specified the guidelines to which the project would abide. The Data Collection Guidelines educated 
providers of the intended use of the data that they would be submitting. The intended uses included 
delivery of NOFA-compliant data to the NTIA, data dictionary, the intention of GeoDecisions and the 
State to generate static maps, as well as the creation of a Missouri-specific interactive mapping 
website. Finally, the Data Collection Guidelines

 

 specified the data and format required by the NOFA 
that was required of the State for delivery to the NTIA. 

GeoDecisions also developed a provider data request spreadsheet template document that was 
distributed upon request and allowed the providers to enter NOFA compliant data as they chose to do 
so. It included sample data as reference for data entry.  GeoDecisions, under the guidance of the 
State, also developed a preliminary Missouri-centric web site that displayed census blocks, census 
tracts, counties, and major roads in order to assist providers in correlating their service areas to 
census blocks.  Providers could access this site and zoom, pan and print census block maps as 
needed.  This capability is to be subsequently followed up with the development of web-applications 
wherein Providers can log-in and update their data via a web interface if they choose to do so.  These 
web sites will also be the forum for their review of service extents, types, etc prior to submission of 
the Missouri map in the future. 
 
Spatial data was requested from the providers in the following hierarchy of data format preferences. 
Those preferences were: 
 
1) Shapefiles or Geodatabase (personal or file) 
2) CAD files with embedded attributes included 
3) Text-based data (MS Access, spreadsheets, comma-delimited files, etc.) 
4) Paper maps 
5) Any method in which the provider could readily submit the required data 
 
55  Data Processing 

Because of the variety of ways providers could submit their data, one of the major challenges of this 
project was to consolidate and integrate this data into a common model.  For each provider, the work 
was divided into three main steps: 
 

1. Capture the supplied data into a provider-specific staging geodatabase 
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2. Process and QA features in the provider's staging geodatabase 
3. Move the data from the provider's staging geodatabase into the final deliverable 

geodatabase model. 
 
The first step was the most involved and time consuming.  A number of different processes were 
developed for loading the staging geodatabase, depending on how the data was supplied (2000 or 
2009 census blocks; 2000 or 2009 TIGER roads).  Regardless of the type of data provided, the base-
level data - the census blocks, the TIGER street segments, and the county boundaries - all came from 
a single source, so were therefore consistent across all providers.  Multiple processes were developed 
depending on the type of submitted data.  Each process was extensively defined on a process 
checklist to ensure accuracy and consistency.  A description of the different processes used to load 
data into the provider specific staging geodatabase follows: 
 

If a provider supplied their availability area as a boundary or multiple boundaries drawn on a paper 
map or image file, those area(s) were geo-referenced and digitized into a shape file.  If the boundary 
was provided as a CAD drawing or arose from another GIS system, it was converted to a shape file 
format.  Some wireless providers defined their area of availability as their wireless coverage area.  
This may be a supplied boundary, but it may also have been defined using the location of the wireless 
tower, the angle of coverage, and the coverage distance.  This would result in a sector of a circle, 
which was used as the availability area. 

Availability Area 

 
Once a shape file of the boundary was created, interpreted, and available, all census blocks 
intersecting that boundary were collected.  Those census blocks less than two square miles were 
assembled into one feature class.  For census blocks greater than two square miles, all street 
segments that overlapped both the census blocks and the availability area were collected into another 
feature class.  Along with the availability area, the providers also supplied the technology of 
transmission and the speed information.  These attributes were assigned to the census blocks and 
street segments, as well as information on the provider itself:  Name, DBA, and FRN. 
 

Some providers submitted a list of census blocks for their area of availability, along with technology of 
transmission and speed information specified for each census block.  In these cases, the census block 
boundaries were selected for each specified census block.  If the census block was less than two 
square miles, it was added to the census block feature class and the technology of transmission and 
speed information were assigned from the provided list.  If the census block was greater than two 
square miles, all street segments that overlapped it were added to the street segment feature class 
and the technology of transmission and speed information were assigned from the census block in the 
list. 

Census Blocks 

 
The 2000 census block dataset was used for our data processing, however a few providers submitted 
lists using other vintage census blocks.  The newer vintage (2009) census blocks were derived from 
2000 census blocks, however in areas that experienced significant population growth, a census block 
may have been split, possibly multiple times, and each resulting piece has the same census block id 
as the original but a unique alphabetic suffix appended to the end.  When a provider specified a 2009 
census block that had subsequently been split from the 2000 version, all of the associated census 
blocks were coded for that provider.  Thus the true coverage of the census blocks were maintained 
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and consistent with the provider's list but represented in the 2000 block structure.  We are now 
processing all of the older (2000 and 2009 vintage census blocks) into a 2010 representation so that 
the mapping on the Missouri Broadband mapping web portal will be a single version of geography.  
 

If a list of addresses was provided as the availability area, the first step was to geocode, or obtain the 
coordinates of these addresses.  When successful, this resulted in a point for each address located.  
The census blocks intersecting all the points were collected. If the block was greater than two square 
miles it was treated separately.  If a census block contained address locations with different 
technologies of transmission, the census block was duplicated, and a distinct technology of 
transmission assigned to each copy of the census block.  For different locations in a census block with 
the same technology of transmission, the maximum value for each speed was obtained and that 
maximum assigned to the census block. 

Address Information 

 
If the geocoded point lay within a census block greater than two square miles, the nearest street 
segment was located and the technology of transmission and speed assigned to that segment.  As 
with census blocks, if there were several locations with different technologies of transmission along 
the same street segment, the street segment was duplicated and each segment assigned a different 
technology of transmission.  The speed assigned to that segment was the maximum speed for all 
locations along the segment sharing that segment's technology of transmission. 
 

In most cases, wireless providers supplied a boundary, either in electronic format or as paper maps.  
These were converted to a shape file either by digitizing or by performing a data conversion as 
appropriate.  Other providers supplied tower locations, the angle of coverage, and the distance.  The 
wireless boundary was constructed from this.  Finally, some providers defined their wireless boundary 
using an exchange boundary or as an aggregate of their customers.  Although these boundaries may 
not accurately represent the wireless availability area, they were initially included in the dataset in 
order for the providers to submit feedback and more accurately specify boundaries of availability for 
future iterations. 

Wireless Boundary 

 

If middle mile points were supplied on a hardcopy or image file map, the point was digitized.  Usually 
these points were provided with latitude and longitude, so it was a simple matter to add them to the 
feature class.  The elevation data was not always supplied due to the provider not having this 
information available, but when it was, it was often given as feet above sea level.  The model 
requires elevation to be feet above (or below) grade.  In these cases, a digital terrain model was used 
to obtain the ground elevation at the middle mile structure location, which was subtracted from the 
height above sea level to obtain the height above grade. 

Middle Mile Points 

 
The above processes were used to capture the provider-supplied data into provider specific individual 
staging geodatabases using a common NSGIC data model.  Once this was completed, the data could 
be updated or modified and Quality Checked using the same processes regardless of how it was 
originally submitted.  One such process was the creation of the overview areas.  The census blocks 
and street segments for a provider were collected and grouped by technology of transmission.  
County boundaries that overlapped each of these groups were then collected.  The technology of 
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transmission of all census blocks and street segments for the group was assigned to the county.   
Discontinued per NTIA’s request is assignment of maximum speed within the group to the county. 
 
At this point the dataset for a particular provider was complete.  An extensive Quality Check (QC) 
checklist was used to examine the dataset, verify consistency, and that it matched the data submitted 
by the provider.  Once the dataset was successfully checked for quality, the features were appended 
into final database model along with all data from other completed providers.  Both the Validate 
Topology and Validate Features ESRI tools were run, any corrections were made, and if necessary 
rerun.  As individual provider data sets were appended into the master database and again when all 
data sets were appended, the NTIA supplied ‘SBDD Check Submission’ tool was run against the data.  
Any errors detected were corrected and the tool re-run.  A final manual QC review was performed to 
ensure the all provider data is present and consistent followed by a final run of the SBDD Check 
Submission tool against the master data model if any corrections / changes were made. 
 

This process obtained and compiled cable strand maps, as well as maps of service / coverage areas 
obtained from the service provider’s public offices directly or from their Web sites and advertising 
materials if no other authoritative source was available for the provider.  Websites were initially 
collected and inventoried through the use of a ‘surveymonkey’ instrument.  This has now moved to 
the use of an Excel spreadsheet to standardize and assemble the database from webcrawling 
activities. All files and maps discovered through webcrawling were either screen-captured or imported 
(from CAD) to create a digital representation or image of the service / coverage area(s).   These 
digital representations were then georeferenced to a base map of the state of Missouri.  The spatial 
transformation methodology used was determined by the image type, confidence in a real 
representation, and scale of source materials.  In addition maps of telephone company exchange 
areas and cable franchise areas from their respective associations were digitized and attributed to 
provide reference as well. These files are held as elements of independent validation to be compared 
with GeoDecisions / CGB that are created from provider sources. 

Public Data Sources 

 

The University of Missouri (UM) was lead on the development of the Community Anchor Institution 
database. Many elements of the Community Anchor Points were initially compiled by the UM in 
coordination with the Department of Public Safety (SEMA and OHS) providing a starting point for this 
data collection. The list of Anchor Institutions inventoried and monitored in this project include: 
Police, Fire, Hospitals, EOC, PSAPs, Municipal Courthouses, Libraries, K-12, Higher Education, 
Extension Offices, Correctional Facilities, Government Buildings, Community Centers, County 
Courthouses, and Armories. 

Community Anchor Institutions 

 
The community anchor attribute information was gathered by the University through phone calling, 
site visits by UM students and staff, and data requests to respective state agencies / associations.  In 
this way these efforts were coordinated with and through state agencies / associations with 
jurisdiction over these sites. For example, the State Fire Marshall’s Office sent out a memo under their 
letterhead informing their constituency of the inventory and assessment so that the student callers 
and those conducting site visits would be received positively. We also contacted the State Health 
Department, ITSD, and MOREnet and requested broadband information for their facilities.  UM also 
used their ongoing local data review, validation, and verification processes in partnership with 
Regional Planning Councils, Regional Homeland Security Oversight Committees, and associated local 
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governments to assemble and verify data for some counties within Missouri.  This process of data 
development had already been deployed in some areas of Missouri in association with the 
development and review of public safety structure-based information and has proven to work well.  
 
The data received from these agencies was cross-checked with our CAI geodatabase and the 
information was added or updated.  The information that they were able to provide included facility 
name, if they had broadband service, technology used, and speeds.   
 
Website information for the CAIs was collected by calling and asking if they had a website or by 
searching the internet.  Public WiFi for the CAIs were collected by calling and asking if it was available 
or not. 
 
Unique ID’s (CAI ID) of certain types of CAIs, including K-12 schools, libraries, and higher education 
schools, were collected and added to the database.  The National Center for Education Statistics 
(NCES) provided the codes for the schools and higher education facilities through a website provided 
by the PO office, http://nces.ed.gov/ccd/bat & http://nces.ed.gov/ipeds/datacenter.   The library ID’s 
were found at http://harvester.census.gov/imls/data/pls/index.asp.   
  
 
66  Data Accuracy – Back Lab Verification Methods 

Throughout the project, GeoDecisions and CBG performed numerous verification tasks to determine 
the level of accuracy of the information gathered from the broadband providers in the State.  The 
initial verification methods were called back lab verification tasks by the NTIA. Unlike the field 
verification processes (described below), these tasks were performed in a lab or office setting.  Each 
of the following GeoDecisions/CBG back lab processes was utilized to validate the data collected from 
some or all of the providers: 
 
After the data from a given provider was captured into the geodatabase, the mapped data was then 
compared against information gleaned from various sources. The FCC had documentation that was 
used such as the Form 320 (Basic Signal Leakage Performance Report), which is filled out by cable 
television providers on an annual basis, and Cable TV Community Unit and Physical System 
databases. These information databases provided high-level information of geographic areas served 
by cable TV and other broadband providers. This information alerted our team to areas not included 
in gathered data from a broadband provider. 
 
Additional sources of information utilized during the back lab verification process included franchise 
and exchange boundaries, cable strand maps, media prints, as well as business and taxation licenses. 
These sources varied in value to the project, depending on the level of information gathered and 
maintained by local franchising authorities and state agencies such as the PSC. Telecommunications 
associations were also queried for information regarding providers and system boundaries or areas of 
the state where specific providers offer service. 
 
The above processes primarily relate to wireline broadband providers.  For wireless broadband 
providers, we compared information gathered from the providers against FCC and FAA tower 
databases and private tower databases, as needed.   

http://nces.ed.gov/ccd/bat�
http://nces.ed.gov/ipeds/datacenter�
http://harvester.census.gov/imls/data/pls/index.asp�
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Independent Validation and Assessment:

 

 The UM also performed similar verification tasks as 
listed above to determine the level of accuracy and confidence in the information delivered by 
GeoDecisions/CBG as assembled from the broadband providers in the State.  Again, these verification 
methods were called back lab verification tasks by the NTIA as these tasks were performed in a lab or 
office setting.   

In addition to the above, the UM back lab processes took the assembled public sourced data for all 
providers (where this type of information could be found) and intersected it with the supplied 
GeoDecisions / CBG provider service areas. As well, Ookla site data, survey data, and 
presence/absence data assembled were also used to assess these data.  From these data, additional 
analyses were performed to create measures of agreement, confidence indexes, spatial confidence 
indexes, and to visualize patterns of service and gaps in service.   
 
These gaps and patterns of service are currently being examined to determine common threads for 
the State of Missouri across socio-economic, demographic, land cover, density of CAI, and other 
measurable elements of this mapping. We hope to use these data to inform the Regional Technology 
Planning Teams of opportunities and impediments. 
 
The results of the independent assessment and validation were then combined with findings from 
GeoDecisions/CBG to form a report that then was delivered back to the provider to initiate the 
‘provider feedback’ element (Section 19) of the assessment and to validate/verify the assessments of 
these data and their extents by both UM and GeoDecisions/CBG with the respective provider. 
  
77  Development/Implementation of a field verification guide           

and checklist 

Prior to beginning field verification activities, CBG Communications, Inc. (CBG) developed a field 
verification guide for use by each member of the field verification team.  The guide included 
systematic instructions and a checklist related to verification of each broadband system and service 
type.  The guide and checklist were drafted, reviewed and finalized prior to the beginning of field 
verification activities. 
 
88  Field verification team training  

To ensure uniformity of the team’s approach to field verification, field team training was held 
immediately prior to the beginning of field verification activities.  Training was conducted for CBG, 
GeoDecisions, and University students and staff. The training covered all field verification activities, 
including: 
 

• Use of the guide, instructions and checklist 
• Understanding of each system and service types 
• Understanding of coverage characteristics 
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• Understanding of service attributes, including system technology type, upstream and 
downstream connection speeds, and other attributes required (by the NTIA) to be 
documented and verified 

• Use of the equipment needed for field verification activities  
• Proper documentation of field verification activities 

 
The office tutorial lasted ½ day.  An additional field-based ½ day session was utilized for actual 
demonstration of field verification activities. 
 
99  Team Assignments  

Two person teams were utilized the next 2 days after office and field training in order to work 
together and become more comfortable with the process.  Eventually, field verification team members 
were expected to perform field verification activities on their own, with the exception of University 
student teams, who continued to participate in pairs of two for safety and security reasons.  The 
State was divided into five (5) large areas encompassing Northwest, Northeast, Southwest, Southeast 
and Central Missouri.  The contractor assembled ten (10) team members, and assigned two for each 
area. The UM team assembled eight (8) team members to form four (4) teams, and assigned them to 
certain counties and particular census blocks within those counties. As well, two (2) of these teams 
conducted the surveys and interaction at the Missouri State Fair discussed in Section 13. 
 
Each team member was provided an official-looking ID card and a letter of certification on Missouri 
State letterhead in order to mitigate findings early-on that residents were suspicious of individuals 
asking them unsolicited questions.  These two items proved very effective in minimizing these 
concerns. 
 
1100  Verifying Coverage 

Broadband system coverage was verified by sampling whether services were available at various 
locations shown on the providers’ system coverage maps randomly chosen from all of the census 
blocks that are at the ends of the providers’ systems.  The random sample was developed separately 
by the UM and contractor teams. 
 
The contractor team verified by looking for a mixture of large and small providers across the state, 
being sure to hit each of the 19 Regions which would form the basis for the Regional Planning 
Technology Teams.  Efforts were made to locate and verify all providers that had submitted data.  
Verifying the large providers, especially, in each of these regions was a priority.  Each contractor team 
member collected field gathered data in an MS Access database.  The data included:  Lat/Lon of 
verification point, provider name, technology type, speed test results if available, customer comments 
and notes from team member.  All data was compiled and used to not only validate provider 
submitted data as mapped, but for providing feedback to the providers.    
 
As a cross check, the UM team sampled a selection of counties, looking for more detailed coverage in 
a subset of the state’s counties.  
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1111  Ookla Speed Test Web Site 

As part of the field verification process, State residents and businesses were given a card briefly 
explaining the project and directed them to the State’s designed speed test website.  This project 
specific Ookla speed test web site was set up to collect information on providers, users, as well as the 
upstream and downstream speeds associated with their broadband connection.    
 
 

 
Figure 1: Depiction of Ookla Speed Test Site 

 
 
1122  Equipment Utilized for Field Verification Activities 

Each team member carried the following equipment in order to perform field verification activities for 
the various types of services: 

a. Laptop with Wi-Fi capability and provider GIS data installed 
b. Cellular 3G/4G and WiMAX aircards (independent card for each provider) for use with laptop 
c. Binoculars 
d. GPS for verifying and documenting exact locations 
e. Hardcopy forms and electronic database for documenting verification data 
f. Cell phone with 3G or 4G used in lieu of laptop for certain types of wireless broadband 

services 
g. Digital recorder for aural field notes, as needed 
h. Identification documents (business cards, State or other ID badges, letter from the State 

acknowledging that the team member is part of the verification team, for those with 
questions) 

i. Car chargers and/or DC to AC Inverters for equipment chargers  
j. Census block maps (boundary details shown) and other maps as needed 



Missouri Broadband Data and Development 

Data Collection and Processing 
 
 

Page 11 

k. Postcards advertising the Ookla web site for distribution, as shown below 

 

 
Figure 2: Postcards Distributed to Residents 

 
1133  Other Verification Methods 

In addition to utilizing the above mentioned equipment and the methodologies listed below for 
verifying coverage and characteristics, team members entered into discussions with residents in the 
various areas.  Residents were asked questions such as: Do they currently have broadband service, 
who their provider is, if they know what speeds they could achieve and if they know of other 
provider’s service available in the area.  This information was confirmed by multiple residents before 
being considered accurate.  Residents often times did not know what their service level and speeds 
are.   Questions such as how much were they paying for the service led to a better understanding of 
their service level.  Residents are encouraged to visit the Ookla speed test site to assist in gathering 
actual speed data.   
 
Missouri State Fair: In order to collect a large amount of information from Missouri residents for the 
Broadband Project, the Broadband Mapping Team decided to visit the Missouri State Fair in Sedalia, 
Missouri. The 2010 Missouri State Fair had an estimated attendance of over 330,000 people, 
therefore with such a high attendance this event would be useful for data collecting. The Broadband 
Mapping Team (BB Team) had two locations at the fair; one was in the Mizzou Central Building in the 
MO-AG Theater organized by the College of Agriculture, Food and Natural Resources. Inside the MO-
AG Theater was the main location for the BB Team where an informational slide show continuously 
played and signage was displayed throughout the booth area. This was the survey location where 
Missouri residents would be asked to fill out a form about their internet service. A total of 582 surveys 
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were completed and able to be geocoded to be used as verification and validation for UMs 
independent assessments. 
 
The other location was on the lawn outside of the MO-AG Theater, where a Mizzou Tent was 
assembled daily and tables were set displaying a large Missouri map divided into four quadrants. Each 
of the four quadrants represented different regions of Missouri, northwest, northeast, southwest and 
southeast. At this station, Missouri residents were able to physically place a colored pin on their home 
location.  The color would vary depending on if the person had broadband availability in their area. A 
total of 880 pins were placed denoting presence or absence of broadband. 
 
At both areas, the broadband speed test cards for the Missouri Ookla site were handed out to 
residents after filling out a survey or placing a pin on one of the four maps. We also distributed 
drinking cups, refrigerator magnets, and pens with the State Broadband speedtest site on them. Thus 
far, over 1050 speed tests have been performed on the site. 
 
1144  Verifying Wireline Broadband Coverage Characteristics 

Using the specified random sampling technique, field team members searched for the physical 
endpoints of cable systems, telephone/DSL and fiber optic infrastructure and noted when additional 
infrastructure was not seen moving outward from the core either in an aerial (overhead) or 
underground manner.  These areas were targeted for discussions with residents and to perform 
speed tests.  Observations and findings were documented accordingly. 
 
1155  Wireless Broadband Coverage 

Verification team members reviewed the provider’s information and looked for network availability 
near the antenna site or in the middle of the provider’s service area to confirm network and test 
equipment compatibility.  Using the specified random sampling technique, the team member tested 
with pertinent gear to determine when service could and couldn’t be achieved by the laptop, cell 
phone, or other wireless broadband-enabled device.  These locations were documented accordingly.  
 
From the University of Missouri, an aircard team was sent out into the field to verify wireless 
broadband coverage by the top five wireless providers. These providers are AT&T, Sprint, T-Mobile, 
Verizon and US Cellular. Wireless broadband USB devices were purchased from each provider to test 
signal strength, upload and download speeds in different locations.  
 
Boone County was the pilot county the team visited to conduct a more intense test of the submitted 
wireless broadband coverage for these providers. The process we used is still developing as it is a 
new aspect of the project and will continue to be refined as we continue to analyze wireless 
coverage. The current process to test aircards is as follows:  

• Randomly select a road that preferably branches off a primary road that we are confident has 
wireless broadband coverage.   

• Choose a starting point on the road selected and test each aircard from every provider at ½ 
mile increments to see how signal strength and speeds vary.  
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• At the same time, aerial imagery is used to place a point exactly where the team is located in 
the field to collect the information for each provider into ArcMap.  

For each point collected the team collects, signal strength, upload and download speeds, location 
(road intersections or home address if the team is parked in front of residence), lat/long, and notes 
describing any technical difficulties the team may run into.  
 
1166  Upstream and Downstream Connection Speeds for Wireline  

Providers 

The field verification team member: 
 

a. For cable modem – Upstream and downstream connection speeds were verified using the 
Ookla speed test at locations within the providers’ coverage area using the specified 
random sampling technique.  An already installed cable modem connection was utilized, as 
available.  These included both preselected points with arrangements made for testing 
(such as at local libraries or at public facilities utilizing cable modem service) and at 
randomly chosen business and homeowner locations where the business or homeowner 
consented to test the service.  Findings were documented accordingly on electronic or 
paper forms.  In addition, the speed test was documented via the Ookla site. 

b. For DSL connection speed testing –The same procedures were used as for cable modem 
testing. Findings were documented accordingly on paper or electronic forms. 

c. For fiber optic connection speeds – For services to homes and small businesses the same 
procedures were used as above for cable modem and DSL.  For higher speed services to 
larger businesses, institutional network connections, enterprise/wide area network 
connections, etc., the team member worked with the business or institutions’ IT group to 
perform connection speed testing.  If actual testing could not be performed, team 
members attempted to gain existing end user documentation tests and performance 
documentation related to speeds of the network.  Findings were documented accordingly 
on paper or electronic reports. 

 

1177  Wireless Broadband Service Connection Speed Testing 

For cellular broadband 3G and 4G testing – A provider specific air card was needed in order to enable 
the laptop to access the Ookla speed test to determine the speed of connection.  Some service 
providers provided air cards to conduct this testing.  All teams also used both personal and corporate 
cards to assist in the testing.  The speed of connection was tested at randomly selected points 
beginning close to the providers’ tower/antenna infrastructure, at a mid-point and then at the ends of 
the verified coverage area.  Findings were documented accordingly on paper or electronic reports. 
Documentation was uploaded daily by the team members to ensure timely and uniform oversight and 
modifications of the processes.  
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1188  Coordination of Contractor and State Parties’ Field Verification 

The state and contractor utilized the process in the diagrams below to coordinate field verification 
activities: 
 

 
 

Figure 3: Field Verification Coordination Process 

1199  PPrroovviiddeerr  FFeeeeddbbaacckk  RReeppoorrttiinngg 

Upon completion of the provider submitted data, feedback information was supplied to each of the 91 
providers that had submitted data.  This feedback was presented in the form of a detailed Data 
Review Report in MS Word format, all provider attribute data exported into MS Excel format and 
multiple Overview, Wired and Wireless GIS exported image files in pdf format.  This information 
would allow each provider to review our feedback and findings, as well as their submitted data as 
depicted in the GIS data model, both in a graphical and tabular form. 
 
The Data Review Report detailed the usability and completeness of their submitted data as well as an 
estimate of our confidence in their submitted data based on field verification efforts and back lab 
verification steps as detailed above. The report also requested feedback on the accuracy of how we 
characterized their availability areas, technologies, speeds etc.  Based on the provider’s feedback, the 
data was adjusted and refined accordingly. 
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Field verification and back lab verification processes and procedures were utilized, as available and as 
needed, to ensure the highest level of confidence that the information gleaned from the providers 
was as accurate as possible. During this process, GeoDecisions and CBG contacted providers when we 
found instances that appeared to conflict with the information they initially provided and worked with 
the providers to adjust the maps accordingly. 
 

2200  SSttaattiissttiiccss 

File Type Number of Records 
Total Records in all Files 485,303 
Census Block < 2 sq. miles 326,023 
Address-Level Not Required 
Street Segment 151,121 
Wireless Shape File 35 
BB Service Overview 521 
Community Anchor Institution 6,928 
Middle Mile 674 
State Boundary 1 
Metadata Provided for Geospatial Data YES 
Number of ISP's Provided in Submission 91 
 
 

Providers Completed 91 
Pending Additional Data 10 
Non-Responsive/Refused 28 
Researching 21 
Non-Facilities Based 83 
Out of Business 4 

TOTAL 237 
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Provider Name Status FRN 
NDA Execution 

Date Notes/Comments 
Adams Networks Data Included in Missouri State Submission 11616356 5/18/2010 No updates submitted in third data call response. 
Alma Communications Company Data Included in Missouri State Submission 7196207 5/18/2010 No updates submitted in third data call response. 
Holway Telephone Company  Data Included in Missouri State Submission 4746863 4/5/2010 No updates submitted in third data call response. 
KLM Telephone Company Data Included in Missouri State Submission 3772274 4/5/2010 No updates submitted in third data call response. 
N. W. Communications Data Included in Missouri State Submission 3772290 4/5/2010 No updates submitted in third data call response. 
American Fiber Systems, Inc. Data Included in Missouri State Submission 6651202 4/27/2010 No response to third data call. 
AT&T Corp. Data Included in Missouri State Submission 4496774 4/7/2010 No updates submitted in third data call response. 
AT&T Mobility, LLC. Data Included in Missouri State Submission 4979233 4/7/2010 Third data call updates included. 
AT&T Southwest Data Included in Missouri State Submission 16657918 4/7/2010 Third data call updates included. 
Bay's Internet Data Included in Missouri State Submission 18912576 Not Req'd by Provider Third data call updates included. 
Big River Telephone, LLC Data Included in Missouri State Submission 18520320 Not Req'd by Provider No updates submitted in third data call response. 
Cable One, Inc. Data Included in Missouri State Submission 3474327 4/5/2010 Third data call updates included. 
Cable America Missouri, LLC Data Included in Missouri State Submission 15466766 6/10/2010 Third data call updates included. 
Carthage Water & Electric Data Included in Missouri State Submission 7147143 Not Req'd by Provider No response to third data call. 
Suddenlink Communications - Cebridge Data Included in Missouri State Submission 14367650 6/12/2010 Third data call updates included. 
Suddenlink Communications - Friendship Cable Data Included in Missouri State Submission 4999025 6/12/2010 Third data call updates included. 
Suddenlink Communications - Cequel III Communications II Data Included in Missouri State Submission 9725870 6/12/2010 Third data call updates included. 
CenturyLink Data Included in Missouri State Submission 18626853 4/20/2010 Third data call updates included. 
Chariton Valley Telephone Corporation Data Included in Missouri State Submission 2549392 5/26/2010 Third data call updates included. 
Chariton Valley Telecom Corporation Data Included in Missouri State Submission 8437147 5/26/2010 Third data call updates included. 
Charter Communications Data Included in Missouri State Submission 17179383 6/10/2010 Third data call updates included. 
Citizens Telephone Company of Higginsville Missouri Data Included in Missouri State Submission 2504298 4/5/2010 No updates submitted in third data call response. 
LiNKCity Data Included in Missouri State Submission 16051450 Not Req'd by Provider No updates submitted in third data call response. 
City Utilities Springfield (SpringNet) Data Included in Missouri State Submission 4759411 3/23/2011 Third data call updates included. 
Cogent Communications, Inc.  Data Included in Missouri State Submission 19898303 Not Req'd by Provider No updates submitted in third data call response. 
Comcast Data Included in Missouri State Submission 4441663 5/27/2010 No response to third data call. 
Covad Communications Company Data Included in Missouri State Submission 3753753 5/18/2010 Third data call updates included. 
Craw-Kan Telephone Data Included in Missouri State Submission 2334225 4/5/2010 No response to third data call. 
T-Mobile Data Included in Missouri State Submission 6945950 5/4/2010 Third data call updates included. 
Ellington Telephone Company Data Included in Missouri State Submission 3741956 4/5/2010 Third data call updates included. 
FairPoint Communications Missouri, Inc. Data Included in Missouri State Submission 14710388 9/1/2010 Third data call updates included. 
Farber Telephone Company Data Included in Missouri State Submission 3748043 4/5/2010 Third data call updates included. 
BPS Telephone Company Data Included in Missouri State Submission 3730835 4/5/2010 Third data call updates included. 
BPS Networks Data Included in Missouri State Submission 16026965 4/5/2010 Third data call updates included. 
Fidelity Cablevision, Inc Data Included in Missouri State Submission 13326 4/5/2010 Third data call updates included. 
Fidelity Communications Services I, Inc. Data Included in Missouri State Submission 4351722 4/5/2010 No updates submitted in third data call response. 
Fidelity Telephone Company Data Included in Missouri State Submission 2550309 4/5/2010 Third data call updates included. 
Granby Telephone Company Data Included in Missouri State Submission 5061189 4/5/2010 No response to third data call. 
Grand River Mutual Telephone Corp. Data Included in Missouri State Submission 2505519 4/7/2010 No response to third data call. 
Green Hills Technologies Data Included in Missouri State Submission 3736246 4/5/2010 Third data call updates included. 
Green Hills Telephone ILEC Data Included in Missouri State Submission 3736238 4/5/2010 Third data call updates included. 
Green Hills Telecommunications Services Data Included in Missouri State Submission 3736253 4/5/2010 Third data call updates included. 
Hughes Network Systems, LLC Data Included in Missouri State Submission 17434911 Not Req'd by Provider No updates submitted in third data call response. 
KTIS (Kingdom Telephone Company) Data Included in Missouri State Submission 2212314 4/5/2010 No updates submitted in third data call response. 
Cricket Communications, Inc. (Leap Wireless International) Data Included in Missouri State Submission 2963528 4/20/2010 Third data call updates included. 
Le-Ru Telephone Co. Data Included in Missouri State Submission 2490472 4/7/2010 No response to third data call. 
Level 3 Communications, LLC Data Included in Missouri State Submission 3723822 4/27/2010 Third data call updates included. 
LTO Communications, LLC Data Included in Missouri State Submission 19008036 Not Req'd by Provider No response to third data call. 
Mark Twain Communications Company Data Included in Missouri State Submission 2531879 4/5/2010 No updates submitted in third data call response. 
Mark Twain Rural Telephone Co Data Included in Missouri State Submission 2549228 4/5/2010 No updates submitted in third data call response. 
McDonald County Telephone Co Data Included in Missouri State Submission 2504058 4/5/2010 Third data call updates included. 
MCC Missouri LLC (Mediacom) Data Included in Missouri State Submission 5184247 9/1/2010 No updates submitted in third data call response. 
Mid States Services, LLC. Data Included in Missouri State Submission 18511303 5/26/2010 No response to third data call. 
New Florence Telephone Company, Inc. Data Included in Missouri State Submission 4374047 4/5/2010 No response to third data call. 
Northeast Missouri Rural Telephone Company Data Included in Missouri State Submission 4337044 4/20/2010 No response to third data call. 
Northwest Missouri Cellular Data Included in Missouri State Submission 2534618 Not Req'd by Provider No response to third data call. 
Oregon Farmers Mutual Telephone Company Data Included in Missouri State Submission 3733847 4/5/2010 No response to third data call. 
New Wave Communications Data Included in Missouri State Submission 1202938 Not Req'd by Provider Third data call updates included. 
Iland Internet Services Data Included in Missouri State Submission 17606898 Not Req'd by Provider No response to third data call. 
Mid Missouri Telephone Co. Data Included in Missouri State Submission 2509040 4/5/2010 No response to third data call. 
Ozark Computers Data Included in Missouri State Submission 18658179 Not Req'd by Provider No response to third data call. 
Peace Valley Telephone Co., Inc. Data Included in Missouri State Submission 18539742 4/5/2010 No updates submitted in third data call response. 
Poplar Bluff, City of Data Included in Missouri State Submission 2514529 Not Req'd by Provider No response to third data call. 
Radio Wire, Inc. Data Included in Missouri State Submission 18912626 Not Req'd by Provider Third data call updates included. 
Midwest Data Center & Rock Port Data Included in Missouri State Submission 4362505 4/7/2010 No updates submitted in third data call response. 
Goodman Telephone Company, Inc. Data Included in Missouri State Submission 4269775 4/12/2010 No updates submitted in third data call response. 
Ozark Telephone Company Data Included in Missouri State Submission 4269817 4/12/2010 No updates submitted in third data call response. 
Seneca Telephone Company Data Included in Missouri State Submission 4269809 4/12/2010 No updates submitted in third data call response. 
Sho-Me Technologies, LLC Data Included in Missouri State Submission 8875890 Not Req'd by Provider Third data call updates included. 
Sprint Nextel Corporation Data Included in Missouri State Submission 3774593 6/11/2010 Third data call updates included. 
StarBand Communications Inc. Data Included in Missouri State Submission 5087457 4/5/2010 No updates submitted in third data call response. 
Steelville Telephone Exchange Inc Data Included in Missouri State Submission 2549665 4/5/2010 No response to third data call. 
Miller Telephone Company Data Included in Missouri State Submission 4269528 4/5/2010 No response to third data call. 
TDS Telecommunications Corporation - Stoutland Data Included in Missouri State Submission 2502243 4/26/2010 Third data call updates included. 
TDS Telecommunications Corporation - New London Data Included in Missouri State Submission 2529733 4/26/2010 Third data call updates included. 
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TDS Telecommunications Corporation – Orchard Farm Data Included in Missouri State Submission 3767340 4/26/2010 Third data call updates included. 
Time Warner Cable Data Included in Missouri State Submission 13430244 6/21/2010 No response to third data call. 
Total  Wireless Communications Data Included in Missouri State Submission 18726729 Not Req'd by Provider No response to third data call. 
Townes Tele-Comm, Inc. - Choctaw Telephone Company Data Included in Missouri State Submission 4928792 Not Req'd by Provider Third data call updates included. 
Townes Tele-Comm, Inc. - MoKan Dial, Inc. Data Included in Missouri State Submission 4928750 Not Req'd by Provider Third data call updates included. 
tw telecom Data Included in Missouri State Submission 17348061 4/27/2010 Third data call updates included. 
United Services, Inc. (United Sky Wireless) Data Included in Missouri State Submission 16087876 4/5/2010 No updates submitted in third data call response. 
Verizon Wireless - Cellco Partnership Data Included in Missouri State Submission 3290673 5/26/2010 Third data call updates included. 
WildBlue Communications, Inc. Data Included in Missouri State Submission 7843766 5/4/2010 No updates submitted in third data call response. 
Windjammer Communications LLC Data Included in Missouri State Submission 17915182 Not Req'd by Provider No response to third data call. 
Windstream Corporation Data Included in Missouri State Submission 14400220 6/10/2010 Third data call updates included. 
YHTI Data Included in Missouri State Submission 14205504 4/5/2010 Third data call updates included. 
Lathrop Telephone Company Data Included in Missouri State Submission 3737376 4/7/2010 No response to third data call. 
Missouri Network Alliance, LLC Data Included in Missouri State Submission 15540669 Not Req'd by Provider No updates submitted in third data call response. 
NPG Cable, Inc. (St. Joseph Cablevision) Data Included in Missouri State Submission 2508687 Not Req'd by Provider  Third data call updates included. 
United States Cellular Corporation Data Included in Missouri State Submission 4372322 8/21/2010 No response to third data call. 
Ritter Cable Corporation NDA Fully Executed 14054449 4/20/2010 No source data received to date. 
ExOp of Missouri Inc. NDA Fully Executed 4969697 9/1/2010 No source data received to date. 
IAMO Telephone Company NDA Fully Executed 14067565 4/7/2010 No source data received to date. 
SureWest Kansas, LLC - Everest Midwest LLC NDA Fully Executed 4069035 4/12/2010 No source data received to date. 
KEI Internet Service Data Not Submitted By Provider  Not Req'd by Provider No source data received to date. 
Tower Internet Data Not Submitted By Provider  Not Req'd by Provider No source data received to date. 
US Cable of Coastal-Texas, L.P. Data Not Submitted By Provider  Not Req'd by Provider No source data received to date. 
Wisper ISP, INC Provider Too Busy w/ Other Projects to Submit 16278970 Not Req'd by Provider No source data received to date. 
AccuBak Data Systems, Inc. Data Compiled But Not Submitted By Provider 18543744 Not Req'd by Provider Provider having trouble seeing the benefit to submitting data. 
Socket Telecom, LLC Working Toward Signed NDA 8515595 NA Reseller. Becoming facilities based provider (in the next 6 mo’s.) 
Telecommunications Management, LLC, - New Wave Comm Non-Responsive 9232554  NDA Sent 
True Broadband Networks Non-Responsive   No answer at phone numbers and e-mails kick-back 
Mo-Ark Communications – (Wasp Wireless) Non-Responsive 4376919  NDA Sent 
CorpraNet Non-Responsive   NDA Sent 
Cox Communications Non-Responsive   NDA Sent 
HAUG Communications, Inc. Non-Responsive 4711735  NDA Sent 
Enventis Telecom Inc. Non-Responsive 8394322  NDA Sent 
Dexter Broadband Non-Responsive  NA Phones disconnected and e-mails are unanswered 
St Joe Wireless Non-Responsive 2545929  Attempting to make initial contact. 
ProTronics Technologies, Inc. Non-Responsive 10790061   
KC Web Wireless Non-Responsive  NA Attempting to make initial contact. 
Crystal Broadband Non-Responsive    
First Cable of MO (Mississippi Valley) Non-Responsive     
Galactic Broadband Non-Responsive   No contact information found 
SES Americom Non-Responsive   Attempting to make initial contact. 
Verizon Business Global LLC dba Verizon Business Non-Responsive 10856284  Submitted data with wireless company only. 
Access US Non-Responsive     
Aero-Surf Wireless Internet Non-Responsive     
Boycom Cablevision, Inc. Non-Responsive 7630791    
Momentum Non-Responsive     
Mid Missouri Broadband & Cable LLC Non-Responsive     
TA Highspeed Non-Responsive     
NuVox, Inc. Researching - Purchased By Windstream 4319414 6/10/2010 No source data received to date. 
Stouffer Communications Researching - Included as Granby Telephone 5061189    
CenturyTel Fiber Co. II, LLC dba LightCore, a CenturyTel Co Included in other CenturyLink submission 8612293 4/20/2010  
Falcon Cablevision Researching – Purchased By Charter Comm  NA Data included in Charter submission. 
New Cingular Wireless Services, Inc. Researching – Purchased by AT&T 3766532 4/7/2010 Included in AT&T submissions 
Fidelity Communication Services II, Inc. Researching To Determine If Broadband Provider 5918503 4/5/2010 Researching inclusion with other Fidelity Provider submissions. 
Fidelity Networks, Inc. Researching To Determine If Broadband Provider 4312963 4/5/2010 Researching inclusion with other Fidelity Provider submissions. 
Excel Telecommunications – SureWest Researching To Determine If Broadband Provider  4/12/2010   
TDS Metrocom Researching To Determine If Broadband Provider  4/26/2010 Researching inclusion with other TDS Provider submissions. 
TDS Missouri Researching To Determine If Broadband Provider  4/26/2010 Researching inclusion with other TDS Provider submissions. 
Telephone and Data Systems Researching To Determine If Broadband Provider  4/26/2010 Researching inclusion with other TDS Provider submissions. 
Aurora Communications, Inc. Researching To Determine If Broadband Provider 15696180 4/5/2010 Researching inclusion with other YHTI Provider submissions. 
Almega Cable Researching To Determine If Broadband Provider  Not Req'd by Provider   
Broadview Networks Holdings, Inc. Researching To Determine If Broadband Provider 10296853   
Longview Cable and Data LLC Researching To Determine If Broadband Provider 13948609  Sold systems off 
Iowa Telecommunications Services, Inc. Researching To Determine If Broadband Provider 3911385    
Broadwing Communications, LLC Researching To Determine If Broadband Provider 8599706 4/27/2010 Researching inclusion with other Level 3 Provider submission 
WilTel Communications, LLC. Researching To Determine If Broadband Provider 3716511 4/27/2010 Researching inclusion with other Level 3 Provider submission 
AT&T Services, Inc. Researching To Determine If Broadband Provider 8644056 4/7/2010 Researching inclusion with other AT&T Provider submission. 
Suddenlink Communications - Cequel Communications Researching To Determine If Broadband Provider 15784663 6/12/2010   
Vaughn's Computer Central Researching To Determine If Broadband Provider 19846674   
St Louis Broadband Refused to participate at this time     
Birch Telecom of Missouri, Inc. Refused to Participate 3732294 NA Refuse to sign NDA or participate 
Ionex Communications, Inc. Refused to Participate 5027453 NA Refuse to sign NDA or participate - Birch Communications 
Pixius Communications Refused to Participate 10480176 NA Refuse to sign NDA or participate at this time 
Poplar Bluff Internet, Inc (SEMO) Refused to Participate 13662408 NA Refuse to sign NDA or participate at this time 
Semo Communications Inc. Refused to Participate 3788775 NA Poplar Bluff Internet - refuse to sign NDA or participate at this time 
Board of Municipal Utilities Not Facilities Based 16073389  Discontinued offering service 
McLeodUSA Telecommunications Services, Inc. (PaeTec) Not Facilities Based 3716073 NA   
XO Communications, LLC Not Facilities Based 6275945 NA   
Telnet Worldwide Not Facilities Based  NA   
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Terre Star Not Facilities Based  NA   
TMC Communications Not Facilities Based  NA   
TracFone Not Facilities Based  NA   
Sofnet Not Facilities Based  NA   
Clear Communications, Inc. Not Facilities Based   Equipment seller 
Superfone Inc. Not Facilities Based 8402202    
Tritel Not Facilities Based  NA   
Missouri Broadband Not Facilities Based  NA   
Mobilcom Pittsburg, Inc. Not Facilities Based 2324465 NA   
PneumaTek Not Facilities Based  NA  
City of Newburg Not Facilities Based  NA   
Qwest Communications Company, LLC Not Facilities Based 3605953 NA   
South Holt Cablevision Not Facilities Based  NA Offer Internet through Oregon Farmers Mutual Telephone Co 
ADC Not Facilities Based  NA   
Adva Optical Networking North America, Inc. Not Facilities Based  NA   
AFL Communications Not Facilities Based  NA   
Aircell Not Facilities Based  NA   
Airdis Telecom Not Facilities Based  NA   
Airespring, Inc. Not Facilities Based 6875322 NA   
ANPI Not Facilities Based  NA   
Arch Communications Not Facilities Based  NA   
Atlantis Holdings LLC Not Facilities Based 18587402 NA   
Bluegrass Cellular Not Facilities Based  NA   
Boost Mobile Not Facilities Based  NA   
Broadband National Not Facilities Based  NA   
BullsEye Telecom, Inc. Not Facilities Based 4350930 NA   
Cellular one Not Facilities Based  NA   
CHR Solutions Not Facilities Based  NA   
Charles Industries Not Facilities Based  NA   
Chillicothe Municipal Utilities Not Facilities Based 4192225 NA   
City of Newburg Not Facilities Based  NA   
Cooperative Communications, Inc. Not Facilities Based  NA   
Curt's Custom Cable Not Facilities Based  NA   
DeSoto ISP Not Facilities Based  NA   
Digital Landing Not Facilities Based  NA   
DirecTV Not Facilities Based  NA   
DSL,net, Inc. (Megapath) Not Facilities Based 4324851 NA   
Earthlink Not Facilities Based  NA   
Extel Not Facilities Based  NA   
Freedom Communications Not Facilities Based  NA   
GlobalNet Not Facilities Based  NA   
Golden State Cellular Not Facilities Based  NA   
Granite Telecommunications Not Facilities Based  NA   
Illinois Valley Cellular Not Facilities Based  NA   
Innovative Systems Not Facilities Based  NA   
Interglobe Communications, Inc. Not Facilities Based 5156229 NA   
Inter-Linc Not Facilities Based  NA   
Jitterbug  Not Facilities Based  NA   
LightEdge Solutions, Inc. Not Facilities Based 15546443 NA   
Logix Communications Not Facilities Based  NA   
Metropolitan Telecommunications Holding Company Not Facilities Based 9806019 NA   
Mid America Computer Corporation Not Facilities Based  NA   
Mohave Wireless Not Facilities Based  NA   
Netlogic, Inc. Not Facilities Based 6825954 NA   
New Edge Holding Company Not Facilities Based 3720471 NA   
Nex-Tech Wireless  Not Facilities Based  NA   
Nortel Solutions Not Facilities Based  NA   
Open Range Not Facilities Based  NA   
OFS Not Facilities Based  NA   
Pacific Wireless Not Facilities Based  NA   
Preferred Long Distance Not Facilities Based  NA   
Protel Not Facilities Based  NA   
Ralls Technologies, LLC Not Facilities Based 18539916 NA  Becoming facilities based in the near future 
SkyTerra Communications Not Facilities Based  NA   
SkyWay USA Not Facilities Based  NA   
Spirit Telecom Not Facilities Based  NA   
Stutler Technologies Corp Not Facilities Based  NA   
Tablerock Net Not Facilities Based  NA   
TCO Network, Inc. Not Facilities Based  NA   
TCS Telecom, Inc. Not Facilities Based  NA   
Telefonica Data Corp SA Not Facilities Based 18547828 NA   
Tellabs Not Facilities Based  NA   
Toast.Net Not Facilities Based  NA   
Tranquility Internet Not Facilities Based  NA   
Video Direct Not Facilities Based  NA   
Vonage Not Facilities Based  NA   
Zayo Group, LLC Not Facilities Based 15331689 NA   
Zone Telecom, Inc. Not Facilities Based  NA   
WestLink Not Facilities Based  NA   
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Longview Cable and Data, LLC. Out of Business 13948609 NA Sold off Assets  
Worldcom Broadband Solutions Out of Business  NA   
Global Crossing Telecommunications, Inc. Out of Business 2850519 NA   
Sikeston Board of Municipal Utilities  Out of Business 16073389 NA   
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Figure 4: Standard NDA pg 1 
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Figure 5: Standard NDA pg 2 
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Figure 6: Standard NDA pg 3 
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1 Overview 
The following describes the Data Gathering, Data Integration, Data Validation and Verification and Quality Control 

processes utilized to create the Broadband Mapping Project’s April 1
st

, 2011 data submission.   

 

To support various levels of technical and program knowledge, this white paper supplies both a high level 

summary and a detailed process review. 

 

2 High Level Review 

2.1 Data Gathering - Providers 

Broadband Service Area, Middle Mile Aggregation Points and Broadband Service Overview 

The collection of Broadband Service areas, Middle Mile Aggregation points and Broadband Service Overview 

information is handled through the following Provider Outreach Process: 

 

 Build and Maintain an Inventory of Broadband Providers through research and State inputs. 

 Update Provider Material that describes the data requirements and logistics for data transfer. 

 Update NDA for use in project, where applicable 

 Maintain multiple protocols for the provider to submit data, including SFTP technology when desired.   

 Conduct one-on-one informational discussions with each provider to communicate the following: 

o Requirements of this project 

o Broadband data required to support the product data model 

o Submission protocols available 

o Capability to validate how the supplied data is aggregated 

 

 Download/receive Provider Data 

 Establish a repeatable process with Provider. Maintain Provider communication, transaction and data 

handling records throughout the project (dates contacted, data received, etc.)  
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2.2 Data Gathering - Community Anchor Institution (CAI) 

The collection of CAI information is handled through the following CAI Collection Process: 

 Collect and maintain inventory of CAIs through Data Mining, research, and State inputs. 

 Maintain web-based CAI portal for institutions to add or confirm attribution, location and enter 

broadband-specific information. 

 Upload web-based data to Core Database for standardization. 

 Perform internal cleansing, such as removing duplicate records, identifying gaps in broadband attribution 
and verifying category.  

 Geocode CAI locations.  

 Translate Core Database data to deliverable ready format.  

 Continue engagement with non-responsive institutions. 

 

2.3 Data Integration Process 

 

The data integration and processing mechanisms currently utilized allow for multiple types of inputs and results in 

a standardized output that meets the NTIA deliverable requirements. This process is flexible to support data model 

changes and project requested enhancements.  

 

 Receive inputs from Providers via submission protocols, upload into Sourcing Database and catalog with 

provider information.  

 Review Provider supplied data for completeness and for potential discrepancies that require resolution 

prior to processing and flag as necessary. 

 Categorize input into data type category (addresses, block lists, paper maps, etc.). 

 Standardize input based on data type within Staging Database. 

 Create Compact Polygons (CP)—(internal methodology for generating area based feature for coverage in 

Staging Database). 

 Apply broadband attribution to CP, Apply metadata to CP 

 Perform quality analysis of the CP against the source supplied to identify any completeness or accuracy 

issues.   

 Request additional information from the provider if elements of coverage are missing or contain 

discrepancies.  This is a second manual quality check to ensure data is complete.   Following completion of 

CP creation, process steps within Data Validation & Verification occur 

o Process coverage area to build the required NTIA data model layers  

 

 Process CAI data input into internal standardized format, as mentioned above under CAI Create Product 

Deliverable based on NTIA and State-level requirements. 

 Following the creation of the product, process steps within Data Validation & Verification occur 
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2.4 Data Validation & Verification 

 

To ensure the data collected and processed is accurate and comprehensive, a holistic approach has been 

developed to further validate and verify the data. Following the initial mapping of providers’ coverage area and 

serviceability claims, the project team uses the following methods:  

 

 Third-Party Data Verification: Visually and programmatically compare the coverage against third-party 

data.  

Pitney Bowes and American Roamer data are used in cases where a coverage area is questionable.  All 

anomalies identified during this analysis are reviewed with the providers. 

 

 Broadband Provider Validation – Provider Portal Application:  Providers were trained on and requested 

to use a secure interactive web application to review their current coverage area(s) and supporting 

broadband attribution and validate their data or submit change requests to update their data. 

 

All provider change requests go through the Data Integration Process and a review with the provider to 

complete validation. 

 

 Confidence Values:  All Verification, Validation, and manual quality reviews are tracked by provider and 

then by technology type, which is then stored and maintained within a “Validation” table.  A confidence 

value is assigned based on the collected information to highlight provider coverage areas that require 

further investigation and enhancements. 

 

2.5 Quality Control 

Following collection, processing and analysis of the provider and CAI data, the product is checked manually and 

algorithmically against the NTIA data model.  Some of the items included within these checks are as follows:   

 Format Correctness 

 Table & Field Structure  

 Valid Values 

o Including default values, where applicable 

 Geographic Extent and Topology Errors 

 

Prior to data submission, another quality control script supplied by NTIA is run.  This script, 

SBDD_CheckSubmission.py, creates an output in text form that is required to be submitted along with the final 

deliverable.  All errors must come up clean, unless otherwise specified from NTIA. 

Exceptions to the script as noted by NTIA on the SBDD Workspace on 03/25/11 at the following link: 
https://sbdd-granteeworkspace.pbworks.com/w/page/38218329/CheckSubmissionExceptions  

https://sbdd-granteeworkspace.pbworks.com/w/page/38218329/CheckSubmissionExceptions
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- Longitude values for States outside the lower 48 (any table) 

- CAI results for Transtech, MaxAdUp, MaxAdDown if BBService is ‘No’ or ‘Unknown’  

- Overview MaxAdDown, MaxAdUp if 100% of record level data has MaxAdDown or MaxAdUp 

populated 



                                                    

8 

 

3 Detailed Process Review 
Below is a detailed review of the data collection, integration and quality control points along the broadband data 

gathering and mapping process. 

 

Diagram of overall process: 

 
 

3.1 Provider Outreach 

For the April 2011 data submission, an e-mail notification was sent to all providers with supporting deliverable 

dates.  The Provider Portal web application was released and training webinars held so providers could use this 

application to submit changes to and/or validate their current coverage area(s). 

 

Data was also collected from the providers via e-mail and SFTP, depending on their comfort level to submit data in 

time for the April 1
st

 deadline. 

 

In support the data collection effort, providers that did not timely respond to the outreach were contacted by 

phone. 
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3.2 Outreach Materials 

The original provider packet sent via email to the providers included the following documents and files: 

1) Letter from the State inviting them to participate in the program 

2) Copy of the non-disclosure agreement (NDA) 

3) Copy of the Mapping NOFA from the NTIA 

4) Copy of the NOFA Clarification from the NTIA 

5) Broadband service address example file in CSV format 

6) Word document describing service address example file 

7) Broadband service block example file in CSV format 

8) Word document describing service block example file 

9) Broadband service street example file in CSV format 

10) Word document describing service street example file 

11) Broadband subscriber example file in CSV format 

12) Word document describing subscriber example file 

13) Broadband wireless coverage area sample shapefile 

14) Word document describing wireless coverage area sample shapefile 

15) Instructions for downloading, installing, and using the WinSCP secure FTP application 

 

3.3 Outreach Process 

The provider outreach process is comprised of the following general steps: 

1) Send the provider package and introduction letter to the main point of contact for the provider 

2) Follow up with email and call to verify that the main point of contact is correct. 

3) If necessary, discuss the NDA further and resolve any redlines. 

4) Once the correct primary contact is established, set up a call, if necessary, to learn more about the 

provider’s offerings and direct them to the appropriate outreach materials. 

5) If providers are unable to be contacted (non-responsive) or indicate that they are not interested in 

participating (non-cooperative) mark them as such on the provider tracking sheet. These providers will be 

escalated to the state for further action. 

6) As the providers are collecting the required data, provide instruction on downloading, installing, and using 

the WinSCP secure FTP application, if required. 

7) Arrange with the providers to transfer the data in whatever way they are comfortable. Some providers 

will find regular email acceptable. Others will want to use the secure FTP application. 

8) After data is received and reviewed, it may be necessary to contact a provider for clarification or to 

address incomplete data sets. In the interest of building and maintaining relationships, care is given not to 

push the provider but to work with it to obtain accurate data in the best possible format. 
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3.4 Data Collection 

3.4.1 Data Transfer Procedures 

There are three primary ways data is collected from providers. These are: 

1) Secure FTP using the WinSCP application 

2) Regular email 

3) Mail 

 

3.4.2 Initial Data Review and Quality Assurance 

The initial data review and quality assurance process consists of the following general steps: 

1) Access the data from the secure FTP site or email 

a. If emailed, place copy of original data set in the appropriate provider folder on the secure FTP 

site 

2) Place copy of raw data on local computer in a working directory. 

3) Review data and determine course of action based on type of data received. 

4) Ensure data is complete and contact provider to address any gaps. 

Note: The goal is to get as many providers as possible to provide subscriber address data in the correct format. 

Obviously, this will not be possible with all providers so we will continue to have to process various types of 

provider-supplied data. 
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3.5 Data Ingestion 

3.5.1 Data Ingestion Overview 

The following outlines the process steps taken based on the type of input supplied by the data provider: 

Point Data 

 Subscriber location 

 DSLAM location 

 Central Office location 

 Broadcast Tower location 

Linear Information 

 TIGER street segments 

Polygonal Information 

 Census Blocks 

 Coverage Area 

Overall, the process is geared toward taking the provider data supplied and creating polygon shapes to append to 

the bb_cov feature class. The bb_cov feature class is the interim data set that is then processed using the 

makeDeliverable.py Python scrip to create the MapConnect data layers that will be delivered to the state and, 

ultimately, to the NTIA.  Following are the detailed instructions used in this process.  

 

3.5.2 Point Data 

3.5.2.1 Subscriber Location – Address Data 

In the event that the data provider supplies subscriber address data the following actions occur: 

1) First, convert the address data to a clean Excel spreadsheet in an appropriate address data format. 

a) Usually, this has the following columns: street address (number, pre-directional, pre-modifier, street 

name, street type, post-directional, and post-modifier concatenated together), city, state, ZIP. 

2) Configure the ArcGIS geocoding tool to use the TIGER 2009 streets dataset 

a) In ArcCatalog, create a new Address Locater by right-clicking in the white space of the appropriate 

directory and selecting New>Address Locater from the dropdown menu. 

b) Select “US Streets with Zone” and press OK. 

i) Note: It is likely that multiple Address Locators will have to set up to handle the variety of 

provider address data received. 

c) Navigate to the TIGER Streets 2009 file and press OK. 

d) Fill in the dialog box as seen below: 
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e) Click OK. 

3) Open up ArcMap, and add the Excel spreadsheet with the address information. 

4) Right-click on the Excel spreadsheet and select Geocode Addresses from the dropdown menu. 

5) Select the appropriate address locator by clicking Add…. then OK. 
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6) Fill out the Geocode Addresses dialog box as shown below: 

 

 
 

7) Geocode the list in batch mode using the geocode service set up in Step 2 above, accepting all the default 

parameters. 

8) Review results. 
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9) Adjust geocoding parameters accordingly and repeat batch to resolve issues. 

10) Manually geocode unmatched addresses until target hit rate achieved, generally 90%. 

11) Visually inspect the data as seen below: 
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12) Follow the steps detailed in Subscriber Location – GIS Data below 

 

3.5.2.2 Subscriber Location – XY Data 

If the provider supplies a list of subscriber data with accompanying XY data such as latitude and longitude, the 

steps are as follows: 

1) Refine the format in Excel so that the data can easily be opened using ArcMap. 

a. Remove all font color, highlighting, cell colors and borders, clean up column headers and make 

sure there are no merged cells. 

b. Make sure that XY locations are in decimal degrees. 

i. To convert from degrees, minutes, seconds (39º 26’ 45.67”) to decimal degrees us the 

following formula: DD + (MM/60) + (SS.SSS/3600). 

ii. Note: if XY locations from some other coordinate system are provided, you can use 

those in the process below but you must know what the coordinate system is. 

2) Open up the Excel worksheet in ArcMap. 

3) From the menu bar, select Tools>Add XY Data… 
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4) Supply the appropriate fields for the X and Y coordinates, choose the appropriate coordinate system and 

press OK. 

5) Results are an event layer, not a true spatial layer. Export the data by right-clicking the event layer and 

selecting Data>Export Data… from the dropdown menu. 

6) Follow the steps detailed in Subscriber Location – GIS Data below. 

 

3.5.2.3 Subscriber Location – GIS Data 

If the provider supplies subscriber location in GIS format, the only process step is to load that data into the 

appropriate data schema and it will be ready for processing. 

1) First, load the data into the Point Address database schema (please see Appendix D for an example of the 

Point Address database schema.) using an empty feature class in that schema. 

2) In ArcCatalog, right-click on the empty feature class and select Load from the dropdown menu. 

3) Navigate to the provider address GIS data set and then map the attribute fields accordingly, as seen in 

general below: 
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4) Once you have successfully loaded the provider address data into the temporary database with the 

correct schema, you will now append that data to the overall Point Address database. 

5) In ArcToolbox, use the Append command (Data Management Tools>General> Append) to add the 

features into the overall Point Address database, as seen in general below: 
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6) Since the data is already in the Point Address database schema, there is no n need to alter the Field Map 

in the Append tool. 

7) After appending, calculate metadata reflecting geometry source and representation values. 

8) Break provider-specific points into separate county feature classes and perform the following steps per 

county feature class: 

a. Within ArcGIS 

i. Summarize download and upload speeds [first,last] to determine all speeds available for 

county. 

1. This will save as a DBF table. Keep track of location for future reference. 

ii. Buffer county address point featureclass to 150’.     

1. During buffer command, dissolve on “ad_down”; ”ad_up”; ”provider”; “dba”; 

“frn”; “tt”; ‘all metadata fields’; “stctyfips”.    Save as…. 

county_fastestdown_fastestup.  

2. (Example using Qwest data: boulder_40128_20128, where boulder=county;  

40128=ad_down; 20128=ad_up) 

3. Note: these attribute fields are specific to the Point Address database. 

iii. Select the features that represent the lowest speeds 

b. Using XtoolsPro (http://www.xtoolspro.com/)  

i. In the XTools Pro toolbar, select XTools Pro>Layer Operations>Erase Features 

ii. Use the same feature class for Input and Overlay 

iii. Check Use selected features on the Input feature, as seen below. 

http://www.xtoolspro.com/
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iv. Repeat and erase slowest speeds one speed at a time.  Saving each new feature class as 

the next slowest speed, using the same naming convention as above. A general example 

is seen below: 

 

 
 

c. Within ArcGIS 

i. Edit/delete speeds from the attribution table of each feature class, so each remaining 

feature class has only one speed value. 

ii. Merge individual speed feature classes together using the Merge command in 

ArcToolbox (Data Management Tools>General>Merge). The dialog box is seen below:  
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iii. Merge individual county feature classes together using the Merge command in 

ArcToolbox (Data Management Tools>General>Merge).  

iv. Since the county files are all in the same schema, do NOT alter the Field Map portion of 

the command interface. 

v. When all the county files are merged together into one dataset, use the Append 

command in ArcToolbox (Data Management Tools>General>Append) to add the 

features to the bb_cov interim data set. Use the Field Map portion of the Append tool to 

map the appropriate field values to their corresponding fields in the bb_cov feature 

class. 

 

3.5.2.4 DSLAM or Central Office Location – Address Data 

In the event that the provider supplies DSLAM (digital subscriber line access multiplexer) or Central Office address 

data please follow the steps below: 

1) Follow the process for geocoding points in Subscriber Location – Address Data, above. 

2) Follow the steps detailed in DSLAM or Central Office Location – GIS Data below. 

 

3.5.2.5 DSLAM or Central Office Location – XY Data 

In the event that the provider supplies DSLAM (digital subscriber line access multiplexer) or Central Office XY data 

please follow the steps below: 

1) Follow the process for creating points from XY data  in Subscriber Location – XY Data, above. 

2) Follow the steps detailed in DSLAM or Central Office Location – GIS Data below. 
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3.5.2.6 DSLAM or Central Office Location – GIS Data 

In the event that the provider supplies DSLAM (digital subscriber line access multiplexer) or Central Office GIS data 

please follow the steps below: 

1) Buffer the DSLAM/Central Office points feature class 

a) Add the point feature class to ArcMap 

b) Open up ArcToolbox and go to Analysis Tools>Proximity>Buffer 

c) Set the buffer distance to 5 miles 

d) Set the dissolve type to ALL 

e) Name the output feature class 

f) Typical Buffer tool is seen below: 

 

 
 

g) Press OK 

2) Use the resulting buffer feature class to clip the TIGER street layer (as described earlier): 

a) Add TIGER street layer to ArcMap 

b) Open up ArcToolbox and go to Analysis Tools>Extract>Clip 

c) Complete the dialog box as seen below: 
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d) Press OK. 

3) Using ArcCatalog and within the file geodatabase: 

a) Right Click and create a new Feature Dataset  

i) For the Feature Dataset settings: 

(1) Name the feature dataset accordingly 

(2) Select horizontal coordinate system by importing the coordinate system associated with the 

clipped TIGER street layer by selecting Import and navigating to the location of that feature class 

(3) No vertical coordinate system needed 

(4) Leave all x,y,z,m values at default. 

(5) Press Finish 

4) Import previously created street feature class into new Feature Dataset 

5) Right-click Feature Dataset and create new Network Dataset – accept all default setting for the Network 

Dataset 

a) Note: the Network Analyst extension must be turned on 

6) In ArcMap Turn on the Network Analyst Toolbar by going to View>Toolbars>Network Analyst 

7) Add the Network Dataset created in Step 5 to ArcMap 

8) Using Network Analyst Toolbar drop down – create “New Service Area” 

9) Open up the Network Analyst Window by selecting the  button. 

 



                                                    

23 

 
 

10) Right click Facilities layer, select Load Locations, and navigate to the DSLAM/Central Office facilities feature 

class. 

 
 

11) Press OK. 

12) Click the Service Area Properties button  

13)  For the following tabs change the following properties: 

a) “Polygon Generation” tab  

i) Select “Merge by break value”  

ii) Also disable the Trim Polygons option 

b) “Analysis Settings” tab – using and converting the specified DSLAM buffer distance from feet to meters – 

input buffer distance value in meters into the “Default Breaks” location 
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i) Generally, 18,000 feet (5486 meters) from DSLAM or Central Office location is used as the buffer 

distance 

 
 

c) Click OK. 

14) On the Network Analyst Toolbar click the “Solve” button  to create service area polygons. 

15) Right-click on the created service are polygon in the layer list, and select Data>Export Data from the dropdown 

list. 

16) Export to a feature class in the file geodatabase you created earlier 

17) In ArcCatalog, create an empty feature class with the schema of the bb_cov feature class and load the feature 

class created in Step 16 into it. 

a) Right-click on the empty feature class, select Load>Load data from the dropdown menu and navigate to 

the location of the service area feature class 

b) Press the Add button, hit Next 

c) Accept the defaults and hit Next 

d) Do NOT attempt to map any fields, as seen below: 
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e) Press Next, then Next again, then Finish. 

18) In ArcToolBox, go to Data Management Tools>General>Append 

19) Append the formerly empty feature class to bb_cov, completing the dialog box as seen below: 

 

 
 

20) Leave the Schema Type as TEST 
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21) Press OK. 

22) In ArcMap, open up bb_cov for editing and manually input associated attribution. 

 

3.5.2.7 Broadcast Tower Location – Address Data 

In the event that the provider supplies wireless broadcast tower location address data please follow the steps 

below: 

1) Follow the process for geocoding points in Subscriber Location – Address Data, above. 

2) Follow the steps detailed in Broadcast Tower Location – GIS Data below. 

 

3.5.2.8 Broadcast Tower Location – XY Data 

In the event that the provider supplies wireless broadcast tower location XY data please follow the steps below: 

1) Follow the process for creating points from XY data  in Subscriber Location – XY Data, above. 

2) Follow the steps detailed in Broadcast Tower Location – GIS Data below. 

 

3.5.2.8.1 Broadcast Tower Location – GIS Data 

In the event that the provider supplies wireless broadcast tower location GIS data please follow the steps below: 

1) Download the required software (Radio Mobile) from the website: 

http://www.cplus.org/rmw/english1.html  

2) Install the software according to the standard directions, found here: 

http://www.cplus.org/rmw/download/download.php?S=1  

3) Open up the application 

4) Load the broadcast tower location and elevation information by selecting File>Unit properties. The 

following dialog box appears: 

 

http://www.cplus.org/rmw/english1.html
http://www.cplus.org/rmw/download/download.php?S=1
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5) Add in the information for all the towers supplied by the WISP data provider, including the elevation. If 

provider does not supply elevation, this information can be obtained from Google Earth. 

a. I f available, use the Import button to import a Google Earth KML of the tower locations. 

6) Go to the National Map Seamless Server (http://seamless.usgs.gov/) and download elevation data 

sufficient to contain the tower locations. 

a. At least the 1/3” NED data is needed. Select this by clicking the Download button in the upper 

right of the web site and checking the box nect to 1/3 “ NED. 

b. Zoom to the area of interest and use the Download tools: 

 
to define the area to download. 

c. Click the Modify Data Request button to request the data in BIL_16INT format, not ESRI GRID, as 

seen below: 

 

http://seamless.usgs.gov/
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d. Download the data and unzip it. 

7) Select File>Map Properties to define the map 

8) Enter in a latitude and longitude in the center of the tower locations 

9) Set the size (in pixels) and the size (in kilometers) of the map 

10) Set the directory path leading to the BIL elevation data just downloaded 

11) The dialog box is seen below: 

 
 

12) Hit Extract. 
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13) The elevation data is render as a hill shade, as seen below: 

 

 
 

14) Select File>Network properties from the main menu 

15) Create a new network and enter in the frequency range under the Parameters tab, as seen below: 
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16) Leave all the other values as they appear, and select the Systems tab 

17) Create enough systems to cover all the varieties of equipment in the provider network. This will include 

the antenna type, height, and line loss, as seen below: 
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18) Now click on the Membership tab, and assign the individual towers to their respective systems, providing 

the azimuth for non-omnidirectional antennas, as seen below: 
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19) Press OK. 

20) Select Tools>Radio Coverage>Combined Cartesian from the main menu 

21) Complete the dialog box as seen below, providing the Maximum Range from the highest tower beam 

radius supplied by the provider. 

22) Set the Pixel Size at 5 (experiment depending on the area covered to get the right level of granularity) as 

seen below: 
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23) Set the signal range to draw to S-Unit and type 5 in the From (>=) box. 

24) Press Draw. 

 

 
 

25) Save the resulting image as a TIF by selecting File>Save Picture as. 

26) Open ArcMap and load the BIL elevation data you used in Radio Mobile. 

27) Load the TIF image you created and georeference it using the corners of the BIL data. 

a. The corners of the data can be seen in the TIF image. 
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28) Follow the georeferencing directions from the Coverage Area – PDF/JPG/Other Image Format section 

below. 

29) Use the Georeferencing Toolbar to Update the Georeferencing for the TIF data set. 

30) In ArcToolbox, select Data Transformations>From Raster>Raster to Polygon and input the georeferenced 

TIF you just created as seen below: 

 

 

31) Open the resulting polygon feature class up for editing using the Editing toolbar in ArcMap and clean up 

as necessary. 

32) In ArcCatalog, create an empty feature class with the schema of the bb_cov feature class and load the 

feature class created above into it. 

a. Right-click on the empty feature class, select Load>Load data from the dropdown menu and 

navigate to the location of the service area feature class 

b. Press the Add button, hit Next 

c. Accept the defaults and hit Next 

d. Do NOT attempt to map any fields, as seen below: 

 

 
 

e. Press Next, then Next again, then Finish. 

33) In ArcToolBox, go to Data Management Tools>General>Append 

34) Append the formerly empty feature class to bb_cov, completing the dialog box as seen below: 
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35)  Leave the Schema Type as TEST 

36) Press OK. 

37) In ArcMap, open up bb_cov for editing and manually input associated attribution. 

 

3.5.3 Linear Data 

3.5.3.1 TIGER Street Segments – List, Spreadsheet, or GIS Data 

In the event that the provider supplies TIGER street segments in list or spreadsheet format please follow the steps 

below: 

1) Join TIGER road segments  to 2000 census blocks feature class using one of two methods based on how 

the data is provided: 

a) If the TIGER data is provided with a Census Block ID, then join the segments to the Census Block 

geometry based on that ID 

i) Load both data sets into ArcMap 

ii) In the layer list, right-click on the 2000 census block feature class and select Joins and 

Relates>Join 

iii) In the dialog box, select the TIGER road segments data and the proper attribute fields for joining, 

as seen below: 
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iv) Press OK 

b) If the data provided is a list containing TLIDs,  then join to the TIGER line data using the TLID, and use 

a spatial join to associate the TIGER segment with the coterminous block based on the block ID 

i) Load both data sets into ArcMap 

ii) In the layer list, right-click on the 2000 census block feature class and select Joins and 

Relates>Join 

iii) Select “Join data from another layer based on spatial location” from the dropdown menu 

iv) Complete the dialog box as seen below and press OK. 
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2) Export joined records into a temporary feature class. 

3) If joined Census Block geometry is confined to one specific area then dissolve blocks into one record.  If 

joined Census Block geometry is distributed throughout a particular state then dissolve sub-selections of 

census blocks for each county. 

a) Use the County FIPS code to dissolve by county. 

b) In ArcToolbox, select Data Management Tools>Generalization>Dissolve 

c) Complete the Dissolve dialog box as seen below: 
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d) Press OK. 

4) For each dissolved region, open up the feature class for editing using the Editing tool in ArcMap and 

remove unnecessary slivers and other small holes.  For general guidance on editing features in ArcMap, 

see http://webhelp.esri.com/arcgisdesktop/9.3/pdf/Editing_Tutorial.pdf  

5) In ArcCatalog, create an empty feature class with the schema of the bb_cov feature class and load the 

feature class created above into it. 

a) Right-click on the empty feature class, select Load>Load data from the dropdown menu and navigate 

to the location of the service area feature class 

b) Press the Add button, hit Next 

c) Accept the defaults and hit Next 

d) Do NOT attempt to map any fields, as seen below: 

 

http://webhelp.esri.com/arcgisdesktop/9.3/pdf/Editing_Tutorial.pdf
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a) Press Next, then Next again, then Finish. 

6) In ArcToolBox, go to Data Management Tools>General>Append 

7) Append the formerly empty feature class to bb_cov, completing the dialog box as seen below: 

 

 
 

8)  Leave the Schema Type as TEST 
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9) Press OK. 

10) In ArcMap, open up bb_cov for editing and manually input associated attribution if necessary. 

 

3.5.4 Polygonal Data 

3.5.4.1 Coverage Area – PDF/JPG/Other Image Format 

In the event that the provider supplies coverage area data in some image format such as PDF or JPG format please 

follow the steps below: 

1) If in PDF format, open in Adobe Acrobat and Save As… JPG format. 

2) Open up the JPG image in ArcMap. 

3) Add the required basemap vector data for georeferencing. 

a) This will generally be either the CDOT data or TIGER data 

4) Change the coordinate system of the data frame to the desired end coordinate system 

5) Zoom to the general location of the JPG map image 

a) This is the location based on the vector data, not the JPG image itself. For example, if you know that 

the JPG image represents an area around the town of Limon, zoom to the town of Limon in your 

vector data. 

6) Open up the Georeferencing toolbar by selecting View>Toolbars>Georeferencing from the main menu bar. 

7) Using the Georeferencing toolbar, select Fit to Display, results seen below: 

 

 
 

8) Use the Control Point button  to add control points to the map 

9) Use common points in the base data set and the JPG image 

a) For example, find major street intersections, county/city boundaries, etc. 

b) Try to distribute the points more or less in the four corners on the image for the best transformation 

10) Click on the location on the image first, then click on the corresponding location on the vector data base 

map, as in the image below: 
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11) After placing each control point, the image transformation will update automatically.  

12) Repeat until satisfied with the transformation. 

a) Note: The transformation may take up to four points, although sometimes only two are necessary. 

13) When satisfied with the transformation, select Update Georeferencing from the Georeferencing toolbar 

dropdown. 

a) This will create a “world” file (.jgw in the case of JPGs) in the same directory as the image file. 

14) In ArcCatalog, create a new polygon shapefile with the appropriate data schema for a provider coverage 

area, which can be found in Appendix D. 

15) Add the shapefile to ArcMap. 

16) Using the Editor Toolbar, select Start Editing. Set the Task: to “Create New Feature.” 

17) Use the Sketch Tool  to digitize a new coverage polygon using the coverage area outline from the 

georeferenced JPG and add the required attributes manually. 

18) Repeat the above steps for all subscriber speed coverage areas provided. 

19) Follow the steps detailed in Coverage Area – GIS Data below. 

 

3.5.4.2 Coverage Area – KML/KMZ 

In the event that the provider supplies coverage area data in Google Earth KML or KMZ format please follow the 

steps below: 

1) Use a KML to SHP converter to translate file into an ESRI format 
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2) http://arcscripts.esri.com/details.asp?dbid=15603  

3) Download the script and follow the provided instructions for installing it in ArcToolbox. 

4) Double-click on the script in ArcToolbox and navigate to the location of the KML file, as seen below: 

 

 

5) Add the new shapefile to ArcMap. Repeat for all KML files provided. 

6) Follow the steps detailed in Coverage Area – GIS Data below. 

 

3.5.4.3 Coverage Area – CAD Data 

In the event that the provider supplies coverage area data in GIS format please follow the steps below: 

1) Transform the CAD dataset into an ESRI format 

2) http://webhelp.esri.com/arcgisdesktop/9.2/index.cfm?TopicName=Transforming_CAD_datasets 

3) It may be necessary to contact the provider first to determine the coordinate system of the CAD data. 

4) If the CAD data is not in a standard coordinate system, it may be necessary to use ArcMap to 

georeference the CAD data to a known coordinate system first. 

a) To do so, follow the instructions provided above in “Coverage Area – PDF/JPG/Other Image Format.” 

5) In ArcCatalog, create a new polygon shapefile with the appropriate data schema for a provider coverage 

area, which can be found in Appendix D. 

6) Add the shapefile to ArcMap. 

7) Using the Editor Toolbar, select Start Editing. Set the Task: to “Create New Feature.” 

8) Use the Sketch Tool  to digitize a new coverage polygon using the coverage area outline from the 

georeferenced CAD file and add the required attributes manually. 

9) Follow the steps detailed in Coverage Area – GIS Data below. 

 

3.5.4.4 Coverage Area – GIS Data 

In the event that the provider supplies coverage area data in GIS format please follow the steps below: 

1) In ArcCatalog, create an empty feature class with the schema of the bb_cov feature class and load the GIS 

feature class either created above or supplied by the provider into it. 

http://arcscripts.esri.com/details.asp?dbid=15603
http://webhelp.esri.com/arcgisdesktop/9.2/index.cfm?TopicName=Transforming_CAD_datasets
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a) Right-click on the empty feature class, select Load>Load Data from the dropdown menu and navigate 

to the location of the service area feature class 

b) Press the Add button, hit Next 

c) Accept the defaults and hit Next 

d) Do NOT attempt to map any fields, as seen below: 

 

 
 

e) Press Next, then Next again, then Finish. 

2) In ArcToolBox, go to Data Management Tools>General>Append 

3) Append the formerly empty feature class to bb_cov, completing the dialog box as seen below: 
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4) Leave the Schema Type as TEST 

5) Press OK. 

6) In ArcMap, open up bb_cov for editing and manually input associated attribution, if necessary. 

 

3.5.4.5 Compact Polygon From Subscriber Points  

 Geo-code address list using latest state “Composite Locator”  

 

 Verify that your geo-coded file has only one TT (Technology Type).  If not export individual geo-coded 

layers for each Technology Type. 

 

 For each TT check for differences in speed values or speed tiers and create separate layers for each speed 

value/tier. 

 

 Clean your geo-coding results - remove any points that geo-code to accuracy levels below ZIP+4 (ZIP 

centroids, carrier route centroids, etc).  Also, verify that outliers with acceptable accuracy levels are 

legitimate, i.e. fall in correct City and Zip.   

 

 Perform spatial join between county polygons (using stcnyfips field) and the cleaned geo-coded subscriber 

points, in order to carry the county name and stcnty fips. 

 

 Summarize the number of subscribers by county and use the subscriber counts by county to populate the 

Rate Tier table. 
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 Un-join the county data from the geo-code subscribers list. 

 

 Create Compact Polygon using cleaned geo-coded layer or sub-selection of using – XtoolsPro – 

ConvexHull-DetailedHull option.  A sub-selection of geo-coded points will be used in areas where more 

than one polygon will need to be created for one provider’s service area.   

 

 Evaluate output Hull carefully – looking for areas that should not be covered by hull polygon.   

 

o If it is determined that an area or areas should not be represented in coverage area, manually 

reshape hull polygon until coverage area is adequate.   

 

o When not obvious and as a general rule, manually resolve compact polygon when the distance 

between the subscriber points used to define the outer boundary of the compact polygon 

exceeds 5 miles .  When reshaping the hull polygon, snap to the outermost geo-coded points.  

See figure 2 and 3 for an example. 

 

FIGURE 2- Compact Hull: Manual Resolution Required            
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FIGURE 3a- Compact Hull: Manual Resolution Required           FIGURE 3b- Compact Hull: After Manual Resolution        

                       
 

 To attribute the compact polygon - Perform a “Spatial Join” where your Target Feature Class is the 

compact polygon and the Join Feature Class is your geo-coded point layer.  Export compact hull with 

joined attributes and name file appropriately.   

 

 Append attributed compact polygon to BroadBand TT template Feature Class and if required manually 

input any provider attribution that may not have carried over in the append process. 

 

 Intersect compact polygon with county boundaries to create unique records by county and use the state-

county-fips field to populate “stcty_fips” field.  Also use the county name field to populate the 

“BBCov_Name” field.   

 

o Exceptions is where a provider’s coverage is distributed throughout more than one area of any 

given county where the “BBcov_Name” should be populated using an appropriate city or other 

logical name based on geographical location.  

 

 Export/Load into appropriate BB TT model Dataset. 
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3.5.4.6 Census Blocks – List or Spreadsheet 

In the event that the provider supplies census block data in a list or spreadsheet, please follow the steps below: 

1) Ensure block polygons supplied by the provider are 2000 currency 

2) If other currency, convert to 2000 currency before proceeding 

a. To do this, remove the trailing letter (a, b, etc.) from the block ID 

b. You will now have two blocks that equate to one block in the 2000 block geometry 

c. Delete duplicate block IDs, retaining the higher service tier in each case 

3) Prepare the block list in clean Excel format, removing all Excel-only formatting, merged cells, colors, 

borders, etc. 

4) Import the spreadsheet into ArcMap. 

5) Right-click on the 2000 census block feature class in the layer list in ArcMap and select  Joins and 

Relates>Join from the drop down menu. Join the census block list to the 2000 census blocks feature class 

using the block ID and export joined records in a new feature class. The Join dialog box and process can be 

seen above in the TIGER Street Segments – List, Spreadsheet, or GIS Data section. 

6)  Follow the steps in Census Blocks – GIS Data below. 

 

3.5.4.7 Census Blocks – GIS Data 

In the event that the provider supplies census block GIS data please follow the steps below: 

 

1) Ensure that the blocks supplied by the provider are in the required data schema and are complete as far 

as require attribution. 

a. If not, manually enter the required attribution or contact the provider to fill gaps. 

2) If census block geometry is distributed throughout more than one county then select Data Management 

Tools>Generalization>Dissolve in ArcToolbox and dissolve based on County/Provider/TT/Speed Tier so 

that unique records are created for each unique combination. 

a. The dissolve dialog box can be seen above in the TIGER Street Segments – List, Spreadsheet, or 

GIS Data section. 
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Figure 1: Undissolved census block polygons 

 

 
Figure 2: Census block polygons dissolved by county 

 

 

2) For each dissolved region use the Editing toolbar in ArcMap to remove unnecessary slivers and other 

small holes.   

3) In ArcToolbox, select Data Management Tools>General>Merge and merge the processed polygons 

together into single layer. 

4) The merged census blocks will need to have the subscriber’s “frn” field added and populated. 

5) In ArcCatalog, create an empty feature class with the schema of the bb_cov feature class and load the GIS 

feature class either created above or supplied by the provider into it. 

a. Right-click on the empty feature class, select Load>Load Data from the dropdown menu and 

navigate to the location of the service area feature class 
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b. Press the Add button, hit Next 

c. Accept the defaults and hit Next 

d. Do NOT attempt to map any fields, as seen below: 

 
 

e. Press Next, then Next again, then Finish. 

6) In ArcToolBox, go to Data Management Tools>General>Append 

7) Append the formerly empty feature class to bb_cov, completing the dialog box as seen below: 
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8) Leave the Schema Type as TEST 

9) Press OK. 

10) In ArcMap, open up bb_cov for editing and manually input associated attribution, if necessary. 

 

3.6 Metadata Transactions 

Following any updates or changes completed within the file geodatabase (fGDB) stored on the GIS-Analysts staging 

environment, the GIS-Analyst runs transactions to compare that fGDB with the one stored on the Core server to 

ensure metadata on all changes are recorded. 

 

Below outlines the steps taken to run transactions on the updated Core database: 

  

1. Open a command line window and run generateTransactions.py  

a. Usage: generateTransactions.py  [Core fGDB] [Staging Environment fGDB]  

 

b. Example of command line:  

 

<path>generateTransactions.py <path>ST_BB_POLY_SRV_AREAS.gdb <path>ST_BB_POLY_SRV_AREAS.gdb  

 

2. Below is an example of the output screen that will be displayed: 
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3. After process has completed, results can be found in the ST_BB_POLY_SRV_AREAS_HIST.gdb  

a. The transactions scripts records changes at a feature level. 

b. Below is a screen shot supporting the directory structure of the historical fGDB. 
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c. Attribution associated with each added/removed/changed features is tracked, including the 

following additional columns appended to the end of each: 

i. Commit_by 

1. Records the GIS-Analyst that committed the changes to the historical fGDB. 

 

ii. Commit_date 

1. Records the date and time stamp that the changes were committed. 

 

iii. Trans_type 

1. This field reflects the type of change recorded. 

2. Categorized by: 

a.  Adds/Change/Deletes 

 

iv. New_values 

1. Records the new values when a change was completed on a feature.  Example:  

Name or speed change 

 

d. MD_Process is also transferred from the edited fGDB to the historical fGDB, which states the 

actions completed by the GIS-Analyst. 
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3.7 Data Processing 

3.7.1 Data Processing Overview 

The following items outline the actions required to process the service provider data further to meet the NTIA 

requirements. 

 Weighted Nominal Speed 

 Middle Mile 

 Broadband Coverage Template 

 

3.7.2 Weighted Nominal Speed 

The weighted nominal speed is populated one of the following two ways: 

3.7.2.1 Subscriber Data Supplied by Provider 

Where we are supplied with subscriber speed information by the data provider, we use the following formula from 

the NOFA: 

(speed tier-1 in kbps × no. of tier-1 subscribers) + (speed tier-2 in kbps × no. of tier-2 subscribers) + (etc.) 

Total average monthly subscribers 

 

 

Data is initially broken up in the following order: 

1) Stcty_fips 

2) Transmission technology type 

3) Subscriber tiers 

 

3.7.2.2 Value Supplied by Provider 

Some providers will supply their weighted nominal speed.  In these cases, the data supplied will be populated 

instead of using the NOFA formula. 

When these values have been obtained or calculated, they are used to update the service overview layer. This can 

be done manually or by creating a table with the provider’s FRN and average weighted speed and joining it to the 

service overview table in ArcMap. To Join, right-click on the layer you would like to join to and select Joins and 

Relates>Join… from the dropdown menu. Then navigate to the table you want to join and select the join fields 

from the drop down lists. Then open up the source table (the table in ArcMap) and right-click on the header of the 

Average Weighted Speed field and select Calculate Field from the drop down menu. Use the value of the average 

weighted speed from the joined table. 

3.7.3 Middle Mile 

Middle mile information is generally provided in spreadsheet or text file format. The process is to take what is 

supplied by the provider and translate it into the required data schema.  

1) If the data is supplied with address information, follow the process outlined above in Subscriber Location 

– Address Data.  
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2) If the data is supplied with associated XY coordinates, follow the process outlined above in Subscriber 

Location – XY Data.  

3) Once the data is in GIS format, use the Append (Data Management Tools>General>Append) command in 

ArcToolbox to append the data to the overall middle mile dataset. 

4) Set the schema type to NO_TEST and use the Field Map to map the attribute fields from the source to the 

target dataset. 

3.7.4 Broadband Coverage Template 

Below is the description of the fields within the BB_Cov layer, which is the interim data set that is used to create 

the final product deliverable. 

 

Name Alias Description 

objectid OBJECTID Internal Object ID 

shape SHAPE Internal Shape storage 

prov_id PROVIDER_ID Unique numeric identifier for each provider 

prov_name PROVIDER_NAME Unique name for each provider 

dba_name DOING_BUSINESS_AS An alternative "Doing-Business-As" name for the provider 

frn 
FCC_REGISTRATION_NUMBE

R 
Provider FCC Registration Number 

bbcov_name BBCOV_NAME BroadMap Broadband Coverage name 

trans_code TRANSMISSION_CODE 
Unique code for the transmission technology type described by 

this layer 

trans_name TRANSMISSION_NAME Name for the transmissions technology type 

trans_desc TRANSMISSION_DESC Description for the transmissions technology type 

spect_code SPECTRUM_CODE Unique code for the spectrum [WIRELESS ONLY] 

spect_name SPECTRUM_NAME Name for the spectrum [WIRELESS ONLY] 

spect_desc SPECTRUM_DESC Description for the spectrum [WIRELESS ONLY] 

mad_dwn_t MAX_AD_DOWN_TIER 
Maximum advertised downstream speed available within given 

area (speed tier) 

mad_up_t MAX_AD_UP_TIER 
Maximum advertised upstream speed available within given 

area (speed tier) 

typ_dwn_t TYPICAL_DOWN_TIER 
Typical downstream speed available within given area (speed 

tier) 

typ_up_t TYPICAL_UP_TIER Typical upstream speed available within given area (speed tier) 

mad_dwn_k MAX_AD_DOWN_KBPS 
Maximum advertised downstream speed available within given 

area (kbps) 

mad_up_k MAX_AD_UP_KBPS Maximum advertised upstream speed available within given 
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Name Alias Description 

area (kbps) 

typ_dwn_k TYPICAL_DOWN_KBPS Typical downstream speed available within given area (kbps) 

typ_up_k TYPICAL_UP_KBPS Typical upstream speed available within given area (kbps) 

subs SUBSCRIBERS 
Total average monthly subscribers for this provider for this 

technology for this coverage polygon 

md_geom MD_GEOMETRY 
Metadata: Comma separated list of source id's from which the 

polygon extent was produced 

md_exists MD_EXISTS 
Metadata: Comma separated list of source id's used in 

understanding and editing the provider data for this polygon 

md_who MD_WHO 
Metadata: Name of the editor who last edited this feature at 

the time in md_when 

md_when MD_WHEN Metadata: Date/timethat this feature was last edited 

md_process MD_PROCESS 
Metadata: Comma separated list of processed used to create 

and/or modify this layer 

stcty_fips STATE_COUNTY_FIPS State/County FIPS code 

rec_id RECORD_ID 

Compound Key formed from 

STCTY_FIPS+"|"+Provider_ID+"|"+Trans_Code+"|"+BBCov_Nam

e 

st_area ST_AREA(SHAPE) Area in square decimal degrees  

st_length ST_LENGTH(SHAPE) Length in decimal degrees  

Provider_Typ

e 
Type of Provider 

Has Subtype (1:Broadband provider as described in the 

NOFA,2:Reseller,3:Unknown), default value = 1  (New 04/11 

Model) 

 

3.7.5 Verification and Validation 

3.7.5.1 Provider Validation – Provider Portal/PDF Map Review 

Following the collection and aggregation of provider data, the data is then validated by the provider to ensure the 

data aggregated is an accurate representation of their coverage area and supporting broadband information. 

This is completed through the Provider Portal web application, which is a secure interactive map displaying their 

coverage areas and allows the user to validate, submit feedback or request changes.  If changes are requested, 

then the features on the portal are then updated and an automatic request is sent to the provider to complete the 

validation effort. 
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For some providers that did not use the Provider Portal, a PDF was sent displaying their coverage map and 

validation was then completed via e-mail notification.   

 

 

 

 

 

3.7.5.2 Provider Verification – 3rd Party Source Review 

Once the provider has validated their coverage areas, a 3
rd

 party source comparison and analysis is then 

performed.  Where anomalies or discrepancies are identified, a ‘SCAN’ point is dropped and descriptive comments 

applied so they can later be reviewed with the provider. 

 

During the provider review, the map is displayed along with the ‘SCAN’ points and potential refinement is 

completed based on input from the Provider. 

 

3
rd

 Party Sources Utilized 

3
rd

 Party Source Name Source Type Verification Type 

Pitney Bowes (PBBI) Exchange Info Plus 
(Central Office Locations) 

Exchange datasets are used to verify the following 
Transmission Technologies (TT): 
Asymmetric xDSL (10), Symmetric xDSL (20), Other Copper 
Wireline (30), and Optical Carrier/Fiber to the End User 
(50). 
 

American Roamer  Wireless Coverage 
Patterns (EVDO, GPRS, 
WISP, HSPA) 

Used to verify the following TT: 
Terrestrial Fixed Wireless—Unlicensed (70), Terrestrial 
Fixed Wireless—Licensed (71) and Terrestrial Mobile 
Wireless (80) 

ComSearch Wireless Spectrum 
Holdings and Tower Data 

Used to verify the following TT: 
Terrestrial Fixed Wireless—Unlicensed (70), Terrestrial 
Fixed Wireless—Licensed (71) and Terrestrial Mobile 
Wireless (80) 
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3.7.5.3 Assigning Confidence Values 

All efforts from the above-mentioned validation and verification activities, plus internal peer quality reviews are 

combined and tracked in a Validation table.  Based on the results of this analysis, a confidence value is assigned for 

each provider and then each technology.   

 

The confidence values are as follows:  
0     = Coverage area has not been reviewed 
10   = Extremely Low.   Single Source QC.   
20   = Very Low.  Needs Additional Validation\Verification 
30   = Low.   Even with Validation\Verification, Coverage is still suspect. 
40   = Acceptable, confirm with State prior to shipment.    
50   = Meets requirements to be included in shipment. 
60   = Moderate.  Meets NTIA/State’s standards, representative of Technology Type (TT) 
70   = High.   Accurate representation of coverage based upon TT. 
80   = Very High.  Multiple validation\verification with most 3

rd
 party sources 

90   = Extremely High. Multiple validation\verification sources 
100 = Perfect.  Multiple validation\verification sources, with complete alignment with sources and ground 
truth verification activities 

 

This Validation table is then maintained as updates or changes occur for each provider, down to technology type, 

with the overall goal to improve the confidence values and overall map representation. 

 

Example of the Validation table: 
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3.7.6 Community Anchor Institution (CAI) Data 

3.7.6.1 Data Collection 

The CAI data was initially collected from the State to create the baseline inventory.  All location information and 

broadband coverage data supplied was also ingested into the data deliverable. 

Additional collection of CAI information was done via data mining and/or webscraping to build out the inventory 

further.  For example:  Collection of additional CAIs, address and broadband data. 

 

The state-agency-provided CAI inventory was comprehensive but the challenge is collecting broadband related 

data; service provider(s), technology and speed data for each CAI.  Availability of the CAI portal has not significantly 

increase submission of this data.  Additional promotion to CAIs to utilize the CAI portal will be needed to increase 

this data for subsequent deliverables. 

 

3.7.6.2 Institution Data 

Institution data is obtained from a variety of sources and almost always provided in Excel spreadsheet format. The 

general process for incorporating this data is below: 

1) If the data is provided in Excel or some similar format: 



                                                    

60 

a. Clean and standardize the Excel spreadsheet, removing any cell formats, merged cells, etc. 

b. Standardize the address format as defined in the staging CAI database 

c. If the spreadsheet includes X and Y values, such as latitude and longitude, use the Add XY Data 

tool in ArcMap to create a spatial data layer. 

d. If there are only addresses, then follow the geocoding steps outlined above to create spatial data 

points for each of the institutions. 

i. Institutions that do not geocode based on the TIGER 2009 data set will have to be 

manually located using Google Maps, Google Earth, or some other information source. 

2) If the CAI source data is in GIS format, add the Latitude and Longitude fields and use the Calculate 

Geometry tool to populate them, using the WGS 84 coordinate system. 

3) Using ArcCatalog, load the new data into the staging CAI database. 

4) This database is ready for the makeDeliverable.py script to process the information into the final state 

and NTIA deliverables. 

 

3.7.6.3 Community Anchor Institution (CAI) Portal Updates 

A web application has been released to allow for further data collection and validation of anchor institution 

location information, broadband coverage, and speed test data. 

 

Information collected from the CAI Portal is then ingested into the overall inventory and will later be compared 

against the provider coverage areas mapped for any potential discrepancies. 
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3.8 Product Extract 

3.8.1 Python Scripts 

The following sections make use of Python scripts. In general, to use a Python scrip, you must have Python 

installed on your computer. To download the latest version of Python, go to http://www.python.org/download/ 

and download the latest stable version. As of August 2010, this was version 2.7. Once this is installed, the general 

way to run a script is to type the following at a command prompt: C:\Python27\python.exe C:\<location of script>. 

Many of the scripts provided have environment variables that must be set before they can be run.  

 

The python code for BroadMap’s product extract has been incorporated into a Hudson CI System, which is detailed 

in the Process Operation and Monitoring section of this document.  This was a process improvement activity so all 

processes can be monitored, controlled and contain historical tracking on each process. 

 

3.8.2 Product Extract Process 

Note: specific Python scripts are called out in red font in the sections below. 

The MapConnect product extract process, makeDeliverable.py, uses the BB_Cov and BROADMAP_POINTS interim 

data sets to create the following layers according to the current specifications: 

 BB_Service_Road_Segment 

- This layer contains all broadband services associated with specific street segments for census 2000 

blocks larger in area than two square miles 

 BB_ServiceCensusBlock 

- Contains all broadband services associated with census blocks of no greater than two square miles. 

 BB_Service_Wireless 

- This layer contains all wireless services not associated with specific addresses. 

 BB_ServiceOverview 

- This layer contains subscriber-weighted nominal speed for each provider's service area at a county 

level and is meant to act as a summarized view.  

 BB_ConnectionPoint_MiddleMile 

-   This layer contains middle-mile and backbone interconnection points 

 BB_Service_CAInstitutions 

- Broadband Service at Community Anchor Institutions (CAI) 

 Community Anchor Institutions consist of schools, libraries, medical and healthcare providers, 

public safety entities, community colleges and other institutions of higher education, and other 

community support organizations and entities. 

 

Due to a NTIA model change for the October 2010 data deliverable, an addition to this code was created to 

support both models in the case a comparison is later desired or a request is made to revert back to the original 

model.  This script name is bdia2ntia.py and creates the following layers in addition to the layers mentioned above, 

rolled up to NATL_Broadband_Map. 

 

http://www.python.org/download/
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 BB_ConnectionPoint_LastMile 

-   This layer contains last mile infrastructure points, which is only populated if data cannot be provided 

at a more granular level. 

 BB_Service_Address 

- Represents broadband availability for service address points.  Address Point availability refers to 

those individual addresses at which each facilities-based provider of broadband service can provide 

broadband services of minimal characteristics within 7 - 10 business days. 

 State_Boundary 

- State boundary supporting topological validation of point feature classes. 

 NATL_Broadband_Topology 

- Supports basic topology quality checking.  Example:  No CAI’s or Middle Mile points outside of the 

state boundary 

 

The following process flow provides a view of how the Core fGDB is extrapolated to the NTIA final deliverable via 

the makeDeliverable.py script.  Following that, the bdia2ntia.py script is run, which limits what’s placed in the final 

layers based on the NTIA modeling standards. 

 

The product scripts and supporting extract were originally created separately per request, in case data model 

comparisons were to be completed.  

 

3.8.3 Product Statistics 

Following the completion of a product extract, the product statistics script (BDIA_ReleaseNotesStats.py) extracts 

the following information supporting that product deliverable. 

 Provider Statistics 

- Collects all provider information, listing by Provider Name 

- Provides output of FRN 

- Counts the number of features supported within the following layers: 

 Census Block 

 Street Segment 

 Max Upstream 

 Wireless Services 

 Infrastructure Points 

- These updates were made to support the Data Package required to accompany every NTIA product 

deliverable. 

 Community Anchor Institution (CAI) Statistics 

- Breaks CAI down to the 8 categories 

 1:  School: K through 12 

 2:  Library 

 3:  Medical/Healthcare 

 4:  Public Safety 
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 5:  University/College 

 6:  Other Government 

 7:  Other Community non-government 

 None:  Unknown Category 

 In cases where this occurs, further investigation is completed prior to product shipment to 

ensure all CAI’s are categorized accurately 

- Reports out the following counts 

 Total CAIs within that category 

 Total CAIs that contain partial BB coverage  

 Contains any of the following information for given CAI: 

 BB Subscriber, Transmission Technology, Speed Down Speed Up 

 Total CAIs that contain full BB coverage 

 Contains all of the above-mentioned BB information for given CAI. 

The output of this script is two CSV files: AnchorInstitutions.csv and Providers.csv. These files can then be 

inspected to ensure that there are the expected number of CAIs and providers for every release. 

 

3.9 Quality Assurance  

Quality assurance is supported manually and algorithmically on the interim data, BB_Cov file geodatabase, and on 

the final product. For scheduled product releases, a test product extract and subsequent manual and algorithmic 

QC run is completed along with a release review.  The product specifications, project status reports, previous 

product release notes are used as references throughout this review. 

The following parameters are tested using the methodology listed below each: 

 Product Deliverable Format  

- Correct names and format of data deliverables 

 BDIA_QC_SUITES (please see below for details) 

- Correct Projections/Datum 

 Manual interaction with product 

- Metadata Present and Correct 

 Manual interaction with product 

 Table Structure 

- All required tables included 

 BDIA_QC_SUITES 

- Extraneous tables identified 

 BDIA_QC_SUITES 

 Field Structure 

- All fields included 

 BDIA_QC_SUITES 

- Extraneous fields identified 

 BDIA_QC_SUITES 
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- Correct field names, types and widths 

 BDIA_QC_SUITES 

 Field Domains 

- Values in all tables are constrained to the specified values specified 

 This action is accomplished via BDIA_QC_SUITES and manual review of the product 

 This tends to identify project completeness issues as fields with a null value are identified. 

 Geometric Representation 

- Identify if all layers have the correct geometric representation 

 Manual review of the BB_ServiceOverview layer 

 Dependent on NTIA and client requirements 

 Geographic Extent 

- Product includes the necessary Geography associated with Product? 

 Manual Review - ArcGIS 

- Is there extraneous geography included in Product? 

 Manual Review - ArcGIS 

 Completeness 

- Products contain the expected amount of data? 

 Manual review of product stats relative to weekly State reports and defined expectations. 

 Accuracy 

- Product meets the stated accuracy requirements for the deliverable? 

 Sampling procedure to manually review source material to resulting product 

 Provider Validation 

 Verification using 3
rd

 Party Data 

 Verification against reality, where applicable 

 Data Regression 

- Any unexplainable data loss or change? 

 This action is accomplished by comparing results within product statistics script 

(BDIA_ReleaseNotesStats.py) from previous releases, as well as manual review of the product 

 Confidentiality 

- Any unauthorized confidential information included in the delivery? 

 Review of NDAs and delivery expectations 

 Prior Issues Resolved  

- Have expected internal issues been resolved? 

 Manual review of data against previous product release notes 

- Have agreed upon customer issues been resolved? 

 Manual review of data against previous product release notes, status report and client feedback 

 Delivery Medium 

- Has the product medium been verified? 

 Manual review 

- All files present 

 Manual review of SFTP site to ensure all files are copied correctly, including file/directory size 
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- Correct location 

 Manual review – confirmation of SFTP link, username and password 

 

3.9.1 QC Suite 

The BDIA_QC_SUITES consists of four main types of scripts supporting the overall QC process. These scripts are all 

run in concert and are called from the test_runner script and the test_BDIAProductGDB script. 

 

3.9.1.1 Configuration  

These scripts establish the configuration for the test_BDIAProductGDB script which is the core of the QC Suite.  

- update_test_config 

- active_config 

- config_PROCESS01_automated 

- config_PROCESS01_manual 

- set_active_config 

3.9.1.2 Libraries 

These scripts provide additional functionality that is called from with the test_BDIAProductGDB script.  

- bb_unittest_fixture 

- bbcov_structure 

- BC_XmlWriter 

- file_folder 

- search_and_replace 

- unittst_fixture 

- validate_BB_DB 

- validate_BB_GDB 

- xmlrunner_gui 

3.9.1.3 QC Suite 

This is the core script for performing automated QA/QC on the interim and final data deliverables. 

- test_BDIAProductGDB 

3.9.1.4 Other  

These scripts perform other functions detailed below: 

- test_runner – this is the main script that runs all the other QC scripts and imports all the necessary scripts 

and libraries 

- which_build – this determines the current build and passes information to the configuration scripts 
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3.10 Process Operation and Monitoring 

Product Extract, makeDeliverable.py and bdia2ntia.py, is run within BroadMap using a platform called Hudson that 

has been enhanced to support BDIA product extraction, process monitoring, as well as product validation.  The 

same platform can be planned for implementation for the State, if desired. 

 

Below are examples of the product create, product validation, product statistics and monitoring processes which 

are managed within the BroadMap Hudson CI-System.  All of the above-mentioned python scripts, with the 

exception of metadata transactions script, are run via this system. 

 

3.10.1 BDIA Product Create 

 

Below is an example of the main page where the type of product build can be selected. 

 

 
 

Selecting based on the type of process that will be initiated. 

 

   
 

The Console Output can be reviewed to see the progress of product create.  Following the completion of each 

product creation process, an e-mail notification is automatically sent to the team.   
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All processes run via the BroadMap Hudson CI-System are stored for historical reporting.  Each process can be 

reviewed, including the Console Output and Build Artifacts from that run. 

 

 
 

3.10.2 Product Validation and Statistics 

 

Once the product creation process is complete, Product Validation and Statistics are then initiated.  These support 

the BDIA_ReleaseNotesStats.py script and the BDIA_QC_SUITES scripts detailed above. 

All statistics and reports are stored for historical review with the capability to place violation criticality on each 

quality control check allowing the identification of errors due to project status/completeness verses project 

correctness.  Example:  Typical Speeds populated. 
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Below is an example of the report provided based on various control points running over a specified time period: 

 
 

Similar to the Product Create process, all results from the process are maintained:  

 
 

Results are then reviewed manually to ensure no errors reported are critical or in violation of the NTIA data model 

or project completion statements.  Any errors of concern are communicated ahead of product delivery and 

included within the product release notes. 

Further detail on the Hudson CI System environment can be found by navigating to the following link: 

http://wiki.hudson-ci.org/display/HUDSON/Meet+Hudson 

 

http://wiki.hudson-ci.org/display/HUDSON/Meet+Hudson
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3.11 Product Extract Data Delivery 

Product delivery for MapConnect Broadband is handled two ways, depending on client requirements: 

1) State Submittal 

a) Data is submitted via SFTP site 

b) Product Release Notes and QC Test Report accompanies the delivery 

2) NTIA Submittal 

a) Directions for using the NTIA State Broadband Data file submission tool 

b) Go to the following WWW web site: https://esupport.fcc.gov/statedata  

c) Enter your username and password as provided to you from the NTIA program administrator. 

 

 
 

d) Click in Upload a file field 

e) Browse to local file for submission using the ‘Browse’ button.  Select file then select ATTACH FILE. 

 

https://esupport.fcc.gov/statedata
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f) Logout / Receipt using the Logout button in the Top Right of the screen 

g) A receipt of submission is emailed to username e-mail address 
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1 Overview 
The following describes the Data Gathering, Data Integration, Data Validation and Verification and Quality Control 

processes utilized to create the Broadband Mapping Project’s April 1
st

, 2011 data submission.   

 

To support various levels of technical and program knowledge, this white paper supplies both a high level 

summary and a detailed process review. 

 

2 High Level Review 

2.1 Data Gathering - Providers 

Broadband Service Area, Middle Mile Aggregation Points and Broadband Service Overview 

The collection of Broadband Service areas, Middle Mile Aggregation points and Broadband Service Overview 

information is handled through the following Provider Outreach Process: 

 

 Build and Maintain an Inventory of Broadband Providers through research and State inputs. 

 Update Provider Material that describes the data requirements and logistics for data transfer. 

 Update NDA for use in project, where applicable 

 Maintain multiple protocols for the provider to submit data, including SFTP technology when desired.   

 Conduct one-on-one informational discussions with each provider to communicate the following: 

o Requirements of this project 

o Broadband data required to support the product data model 

o Submission protocols available 

o Capability to validate how the supplied data is aggregated 

 

 Download/receive Provider Data 

 Establish a repeatable process with Provider. Maintain Provider communication, transaction and data 

handling records throughout the project (dates contacted, data received, etc.)  
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2.2 Data Gathering - Community Anchor Institution (CAI) 

The collection of CAI information is handled through the following CAI Collection Process: 

 Collect and maintain inventory of CAIs through Data Mining, research, and State inputs. 

 Maintain web-based CAI portal for institutions to add or confirm attribution, location and enter 

broadband-specific information. 

 Upload web-based data to Core Database for standardization. 

 Perform internal cleansing, such as removing duplicate records, identifying gaps in broadband attribution 
and verifying category.  

 Geocode CAI locations.  

 Translate Core Database data to deliverable ready format.  

 Continue engagement with non-responsive institutions. 

 

2.3 Data Integration Process 

 

The data integration and processing mechanisms currently utilized allow for multiple types of inputs and results in 

a standardized output that meets the NTIA deliverable requirements. This process is flexible to support data model 

changes and project requested enhancements.  

 

 Receive inputs from Providers via submission protocols, upload into Sourcing Database and catalog with 

provider information.  

 Review Provider supplied data for completeness and for potential discrepancies that require resolution 

prior to processing and flag as necessary. 

 Categorize input into data type category (addresses, block lists, paper maps, etc.). 

 Standardize input based on data type within Staging Database. 

 Create Compact Polygons (CP)—(internal methodology for generating area based feature for coverage in 

Staging Database). 

 Apply broadband attribution to CP, Apply metadata to CP 

 Perform quality analysis of the CP against the source supplied to identify any completeness or accuracy 

issues.   

 Request additional information from the provider if elements of coverage are missing or contain 

discrepancies.  This is a second manual quality check to ensure data is complete.   Following completion of 

CP creation, process steps within Data Validation & Verification occur 

o Process coverage area to build the required NTIA data model layers  

 

 Process CAI data input into internal standardized format, as mentioned above under CAI Create Product 

Deliverable based on NTIA and State-level requirements. 
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 Following the creation of the product, process steps within Data Validation & Verification occur 

 

2.4 Data Validation & Verification 

 

To ensure the data collected and processed is as accurate and comprehensive and possible, provider validation and 

internal verification activities are utilized. Following the initial mapping of providers’ coverage area and 

serviceability claims, additional reviews are performed using the following methods:  

 

 Third-Party Data Verification: Visually and programmatically compare the coverage against third-party 

data.  

Pitney Bowes and American Roamer data are used in cases where a coverage area is questionable.  All 

anomalies identified during this analysis are reviewed with the providers. 

 

 Broadband Provider Validation – Provider Portal Application:  Providers are trained on and requested to 

use a secure interactive web application to review their current coverage area(s) and supporting 

broadband attribution and validate their data or submit change requests to update their data. 

 

All provider change requests go through the Data Integration Process and a review with the provider to 

complete validation. 

 

 Confidence Values:  All Verification, Validation, and manual quality review results are tracked by provider 

/ technology type and stored and maintained within a “Validation” table.  A confidence value is assigned, 

based on internal assessments of the collected information, to highlight the provider coverage areas 

and/or attributions that would benefit from further investigation and/or enhancements. 

 

2.5 Quality Control 

Following collection, processing and analysis of the provider and CAI data, the product is checked manually and 

algorithmically against the NTIA data model.  Some of the items included within these checks are as follows:   

 Format Correctness 

 Table & Field Structure  

 Valid Values 

o Including default values, where applicable 

 Geographic Extent and Topology Errors 
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Prior to data submission, another quality control script supplied by NTIA is run.  This script, 

SBDD_CheckSubmission.py, creates an output in text form that is required to be submitted along with the final 

deliverable.  All errors must come up clean, unless otherwise specified from NTIA. 

Exceptions to the script as noted by NTIA on the SBDD Workspace on 03/25/11 at the following link: 
https://sbdd-granteeworkspace.pbworks.com/w/page/38218329/CheckSubmissionExceptions  

- Longitude values for States outside the lower 48 (any table) 

- CAI results for Transtech, MaxAdUp, MaxAdDown if BBService is ‘No’ or ‘Unknown’  

- Overview MaxAdDown, MaxAdUp if 100% of record level data has MaxAdDown or MaxAdUp 

populated 

https://sbdd-granteeworkspace.pbworks.com/w/page/38218329/CheckSubmissionExceptions
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3 Detailed Process Review 
Below is a detailed review of the data collection, integration and quality control points along the broadband data 

gathering and mapping process. 

 

Diagram of overall process: 

 
 

3.1 Provider Outreach 

For the April 2011 data submission, an e-mail notification was sent to all providers with supporting deliverable 

dates.  The Provider Portal web application was released and training webinars held so providers could use this 

application to submit changes to and/or validate their current coverage area(s). 

 

Data was also collected from the providers via e-mail and SFTP, depending on their comfort level to submit data in 

time for the April 1
st

 deadline. 
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In support the data collection effort, providers that did not timely respond to the outreach were contacted by 

phone. 

 

3.2 Outreach Materials 

The original provider packet sent via email to the providers included the following documents and files: 

1) Letter from the State inviting them to participate in the program 

2) Copy of the non-disclosure agreement (NDA) 

3) Copy of the Mapping NOFA from the NTIA 

4) Copy of the NOFA Clarification from the NTIA 

5) Broadband service address example file in CSV format 

6) Word document describing service address example file 

7) Broadband service block example file in CSV format 

8) Word document describing service block example file 

9) Broadband service street example file in CSV format 

10) Word document describing service street example file 

11) Broadband subscriber example file in CSV format 

12) Word document describing subscriber example file 

13) Broadband wireless coverage area sample shapefile 

14) Word document describing wireless coverage area sample shapefile 

15) Instructions for downloading, installing, and using the WinSCP secure FTP application 

 

3.3 Outreach Process 

The provider outreach process is comprised of the following general steps: 

1) Send the provider package and introduction letter to the main point of contact for the provider 

2) Follow up with email and call to verify that the main point of contact is correct. 

3) If necessary, discuss the NDA further and resolve any redlines. 

4) Once the correct primary contact is established, set up a call, if necessary, to learn more about the 

provider’s offerings and direct them to the appropriate outreach materials. 

5) If providers are unable to be contacted (non-responsive) or indicate that they are not interested in 

participating (non-cooperative) mark them as such on the provider tracking sheet. These providers will be 

escalated to the state for further action. 

6) As the providers are collecting the required data, provide instruction on downloading, installing, and using 

the WinSCP secure FTP application, if required. 

7) Arrange with the providers to transfer the data in whatever way they are comfortable. Some providers 

will find regular email acceptable. Others will want to use the secure FTP application. 
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8) After data is received and reviewed, it may be necessary to contact a provider for clarification or to 

address incomplete data sets. In the interest of building and maintaining relationships, care is given not to 

push the provider but to work with it to obtain accurate data in the best possible format. 

 

 

3.4 Data Collection 

3.4.1 Data Transfer Procedures 

There are three primary ways data is collected from providers. These are: 

1) Secure FTP using the WinSCP application 

2) Regular email 

3) Mail 

 

3.4.2 Initial Data Review and Quality Assurance 

The initial data review and quality assurance process consists of the following general steps: 

1) Access the data from the secure FTP site or email 

a. If emailed, place copy of original data set in the appropriate provider folder on the secure FTP 

site 

2) Place copy of raw data on local computer in a working directory. 

3) Review data and determine course of action based on type of data received. 

4) Ensure data is complete and contact provider to address any gaps. 

Note: The goal is to get as many providers as possible to provide subscriber address data in the correct format. 

Obviously, this will not be possible with all providers so we will continue to have to process various types of 

provider-supplied data. 
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3.5 Data Ingestion 

3.5.1 Data Ingestion Overview 

The following outlines the process steps taken based on the type of input supplied by the data provider: 

Point Data 

 Subscriber location 

 DSLAM location 

 Central Office location 

 Broadcast Tower location 

Linear Information 

 TIGER street segments 

Polygonal Information 

 Census Blocks 

 Coverage Area 

Overall, the process is geared toward taking the provider data supplied and creating polygon shapes to append to 

the bb_cov feature class. The bb_cov feature class is the interim data set that is then processed using the 

makeDeliverable.py Python scrip to create the MapConnect data layers that will be delivered to the state and, 

ultimately, to the NTIA.  Following are the detailed instructions used in this process.  

 

3.5.2 Point Data 

3.5.2.1 Subscriber Location – Address Data 

In the event that the data provider supplies subscriber address data the following actions occur: 

1) First, convert the address data to a clean Excel spreadsheet in an appropriate address data format. 

a) Usually, this has the following columns: street address (number, pre-directional, pre-modifier, street 

name, street type, post-directional, and post-modifier concatenated together), city, state, ZIP. 

2) Configure the ArcGIS geocoding tool to use the TIGER 2009 streets dataset 

a) In ArcCatalog, create a new Address Locater by right-clicking in the white space of the appropriate 

directory and selecting New>Address Locater from the dropdown menu. 

b) Select “US Streets with Zone” and press OK. 

i) Note: It is likely that multiple Address Locators will have to set up to handle the variety of 

provider address data received. 

c) Navigate to the TIGER Streets 2009 file and press OK. 

d) Fill in the dialog box as seen below: 
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e) Click OK. 

3) Open up ArcMap, and add the Excel spreadsheet with the address information. 

4) Right-click on the Excel spreadsheet and select Geocode Addresses from the dropdown menu. 

5) Select the appropriate address locator by clicking Add…. then OK. 
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6) Fill out the Geocode Addresses dialog box as shown below: 

 

 
 

7) Geocode the list in batch mode using the geocode service set up in Step 2 above, accepting all the default 

parameters. 

8) Review results. 
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9) Adjust geocoding parameters accordingly and repeat batch to resolve issues. 

10) Manually geocode unmatched addresses until target hit rate achieved, generally 90%. 

11) Visually inspect the data as seen below: 
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12) Follow the steps detailed in Subscriber Location – GIS Data below 

 

3.5.2.2 Subscriber Location – XY Data 

If the provider supplies a list of subscriber data with accompanying XY data such as latitude and longitude, the 

steps are as follows: 

1) Refine the format in Excel so that the data can easily be opened using ArcMap. 

a. Remove all font color, highlighting, cell colors and borders, clean up column headers and make 

sure there are no merged cells. 

b. Make sure that XY locations are in decimal degrees. 

i. To convert from degrees, minutes, seconds (39º 26’ 45.67”) to decimal degrees us the 

following formula: DD + (MM/60) + (SS.SSS/3600). 

ii. Note: if XY locations from some other coordinate system are provided, you can use 

those in the process below but you must know what the coordinate system is. 

2) Open up the Excel worksheet in ArcMap. 

3) From the menu bar, select Tools>Add XY Data… 
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4) Supply the appropriate fields for the X and Y coordinates, choose the appropriate coordinate system and 

press OK. 

5) Results are an event layer, not a true spatial layer. Export the data by right-clicking the event layer and 

selecting Data>Export Data… from the dropdown menu. 

6) Follow the steps detailed in Subscriber Location – GIS Data below. 

 

3.5.2.3 Subscriber Location – GIS Data 

If the provider supplies subscriber location in GIS format, the only process step is to load that data into the 

appropriate data schema and it will be ready for processing. 

1) First, load the data into the Point Address database schema (please see Appendix D for an example of the 

Point Address database schema.) using an empty feature class in that schema. 

2) In ArcCatalog, right-click on the empty feature class and select Load from the dropdown menu. 

3) Navigate to the provider address GIS data set and then map the attribute fields accordingly, as seen in 

general below: 
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4) Once you have successfully loaded the provider address data into the temporary database with the 

correct schema, you will now append that data to the overall Point Address database. 

5) In ArcToolbox, use the Append command (Data Management Tools>General> Append) to add the 

features into the overall Point Address database, as seen in general below: 
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6) Since the data is already in the Point Address database schema, there is no n need to alter the Field Map 

in the Append tool. 

7) After appending, calculate metadata reflecting geometry source and representation values. 

8) Break provider-specific points into separate county feature classes and perform the following steps per 

county feature class: 

a. Within ArcGIS 

i. Summarize download and upload speeds [first,last] to determine all speeds available for 

county. 

1. This will save as a DBF table. Keep track of location for future reference. 

ii. Buffer county address point featureclass to 150’.     

1. During buffer command, dissolve on “ad_down”; ”ad_up”; ”provider”; “dba”; 

“frn”; “tt”; ‘all metadata fields’; “stctyfips”.    Save as…. 

county_fastestdown_fastestup.  

2. (Example using Qwest data: boulder_40128_20128, where boulder=county;  

40128=ad_down; 20128=ad_up) 

3. Note: these attribute fields are specific to the Point Address database. 

iii. Select the features that represent the lowest speeds 

b. Using XtoolsPro (http://www.xtoolspro.com/)  

i. In the XTools Pro toolbar, select XTools Pro>Layer Operations>Erase Features 

ii. Use the same feature class for Input and Overlay 

iii. Check Use selected features on the Input feature, as seen below. 

http://www.xtoolspro.com/
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iv. Repeat and erase slowest speeds one speed at a time.  Saving each new feature class as 

the next slowest speed, using the same naming convention as above. A general example 

is seen below: 

 

 
 

c. Within ArcGIS 

i. Edit/delete speeds from the attribution table of each feature class, so each remaining 

feature class has only one speed value. 

ii. Merge individual speed feature classes together using the Merge command in 

ArcToolbox (Data Management Tools>General>Merge). The dialog box is seen below:  
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iii. Merge individual county feature classes together using the Merge command in 

ArcToolbox (Data Management Tools>General>Merge).  

iv. Since the county files are all in the same schema, do NOT alter the Field Map portion of 

the command interface. 

v. When all the county files are merged together into one dataset, use the Append 

command in ArcToolbox (Data Management Tools>General>Append) to add the 

features to the bb_cov interim data set. Use the Field Map portion of the Append tool to 

map the appropriate field values to their corresponding fields in the bb_cov feature 

class. 

 

3.5.2.4 DSLAM or Central Office Location – Address Data 

In the event that the provider supplies DSLAM (digital subscriber line access multiplexer) or Central Office address 

data please follow the steps below: 

1) Follow the process for geocoding points in Subscriber Location – Address Data, above. 

2) Follow the steps detailed in DSLAM or Central Office Location – GIS Data below. 

 

3.5.2.5 DSLAM or Central Office Location – XY Data 

In the event that the provider supplies DSLAM (digital subscriber line access multiplexer) or Central Office XY data 

please follow the steps below: 

1) Follow the process for creating points from XY data  in Subscriber Location – XY Data, above. 

2) Follow the steps detailed in DSLAM or Central Office Location – GIS Data below. 
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3.5.2.6 DSLAM or Central Office Location – GIS Data 

In the event that the provider supplies DSLAM (digital subscriber line access multiplexer) or Central Office GIS data 

please follow the steps below: 

1) Buffer the DSLAM/Central Office points feature class 

a) Add the point feature class to ArcMap 

b) Open up ArcToolbox and go to Analysis Tools>Proximity>Buffer 

c) Set the buffer distance to 5 miles 

d) Set the dissolve type to ALL 

e) Name the output feature class 

f) Typical Buffer tool is seen below: 

 

 
 

g) Press OK 

2) Use the resulting buffer feature class to clip the TIGER street layer (as described earlier): 

a) Add TIGER street layer to ArcMap 

b) Open up ArcToolbox and go to Analysis Tools>Extract>Clip 

c) Complete the dialog box as seen below: 
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d) Press OK. 

3) Using ArcCatalog and within the file geodatabase: 

a) Right Click and create a new Feature Dataset  

i) For the Feature Dataset settings: 

(1) Name the feature dataset accordingly 

(2) Select horizontal coordinate system by importing the coordinate system associated with the 

clipped TIGER street layer by selecting Import and navigating to the location of that feature class 

(3) No vertical coordinate system needed 

(4) Leave all x,y,z,m values at default. 

(5) Press Finish 

4) Import previously created street feature class into new Feature Dataset 

5) Right-click Feature Dataset and create new Network Dataset – accept all default setting for the Network 

Dataset 

a) Note: the Network Analyst extension must be turned on 

6) In ArcMap Turn on the Network Analyst Toolbar by going to View>Toolbars>Network Analyst 

7) Add the Network Dataset created in Step 5 to ArcMap 

8) Using Network Analyst Toolbar drop down – create “New Service Area” 

9) Open up the Network Analyst Window by selecting the  button. 
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10) Right click Facilities layer, select Load Locations, and navigate to the DSLAM/Central Office facilities feature 

class. 

 
 

11) Press OK. 

12) Click the Service Area Properties button  

13)  For the following tabs change the following properties: 

a) “Polygon Generation” tab  

i) Select “Merge by break value”  

ii) Also disable the Trim Polygons option 
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b) “Analysis Settings” tab – using and converting the specified DSLAM buffer distance from feet to meters – 

input buffer distance value in meters into the “Default Breaks” location 

i) Generally, 18,000 feet (5486 meters) from DSLAM or Central Office location is used as the buffer 

distance 

 
 

c) Click OK. 

14) On the Network Analyst Toolbar click the “Solve” button  to create service area polygons. 

15) Right-click on the created service are polygon in the layer list, and select Data>Export Data from the dropdown 

list. 

16) Export to a feature class in the file geodatabase you created earlier 

17) In ArcCatalog, create an empty feature class with the schema of the bb_cov feature class and load the feature 

class created in Step 16 into it. 

a) Right-click on the empty feature class, select Load>Load data from the dropdown menu and navigate to 

the location of the service area feature class 

b) Press the Add button, hit Next 

c) Accept the defaults and hit Next 

d) Do NOT attempt to map any fields, as seen below: 
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e) Press Next, then Next again, then Finish. 

18) In ArcToolBox, go to Data Management Tools>General>Append 

19) Append the formerly empty feature class to bb_cov, completing the dialog box as seen below: 
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20) Leave the Schema Type as TEST 

21) Press OK. 

22) In ArcMap, open up bb_cov for editing and manually input associated attribution. 

 

3.5.2.7 Broadcast Tower Location – Address Data 

In the event that the provider supplies wireless broadcast tower location address data please follow the steps 

below: 

1) Follow the process for geocoding points in Subscriber Location – Address Data, above. 

2) Follow the steps detailed in Broadcast Tower Location – GIS Data below. 

 

3.5.2.8 Broadcast Tower Location – XY Data 

In the event that the provider supplies wireless broadcast tower location XY data please follow the steps below: 

1) Follow the process for creating points from XY data  in Subscriber Location – XY Data, above. 

2) Follow the steps detailed in Broadcast Tower Location – GIS Data below. 

 

3.5.2.8.1 Broadcast Tower Location – GIS Data 

In the event that the provider supplies wireless broadcast tower location GIS data please follow the steps below: 

1) Download the required software (Radio Mobile) from the website: 

http://www.cplus.org/rmw/english1.html  

2) Install the software according to the standard directions, found here: 

http://www.cplus.org/rmw/download/download.php?S=1  

3) Open up the application 

4) Load the broadcast tower location and elevation information by selecting File>Unit properties. The 

following dialog box appears: 

 

http://www.cplus.org/rmw/english1.html
http://www.cplus.org/rmw/download/download.php?S=1
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5) Add in the information for all the towers supplied by the WISP data provider, including the elevation. If 

provider does not supply elevation, this information can be obtained from Google Earth. 

a. I f available, use the Import button to import a Google Earth KML of the tower locations. 

6) Go to the National Map Seamless Server (http://seamless.usgs.gov/) and download elevation data 

sufficient to contain the tower locations. 

a. At least the 1/3” NED data is needed. Select this by clicking the Download button in the upper 

right of the web site and checking the box nect to 1/3 “ NED. 

b. Zoom to the area of interest and use the Download tools: 

 
to define the area to download. 

c. Click the Modify Data Request button to request the data in BIL_16INT format, not ESRI GRID, as 

seen below: 

 

http://seamless.usgs.gov/
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d. Download the data and unzip it. 

7) Select File>Map Properties to define the map 

8) Enter in a latitude and longitude in the center of the tower locations 

9) Set the size (in pixels) and the size (in kilometers) of the map 

10) Set the directory path leading to the BIL elevation data just downloaded 

11) The dialog box is seen below: 
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12) Hit Extract. 

13) The elevation data is render as a hill shade, as seen below: 

 

 
 

14) Select File>Network properties from the main menu 

15) Create a new network and enter in the frequency range under the Parameters tab, as seen below: 
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16) Leave all the other values as they appear, and select the Systems tab 

17) Create enough systems to cover all the varieties of equipment in the provider network. This will include 

the antenna type, height, and line loss, as seen below: 
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18) Now click on the Membership tab, and assign the individual towers to their respective systems, providing 

the azimuth for non-omnidirectional antennas, as seen below: 
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19) Press OK. 

20) Select Tools>Radio Coverage>Combined Cartesian from the main menu 

21) Complete the dialog box as seen below, providing the Maximum Range from the highest tower beam 

radius supplied by the provider. 

22) Set the Pixel Size at 5 (experiment depending on the area covered to get the right level of granularity) as 

seen below: 
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23) Set the signal range to draw to S-Unit and type 5 in the From (>=) box. 

24) Press Draw. 

 

 
 

25) Save the resulting image as a TIF by selecting File>Save Picture as. 

26) Open ArcMap and load the BIL elevation data you used in Radio Mobile. 
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27) Load the TIF image you created and georeference it using the corners of the BIL data. 

a. The corners of the data can be seen in the TIF image. 

28) Follow the georeferencing directions from the Coverage Area – PDF/JPG/Other Image Format section 

below. 

29) Use the Georeferencing Toolbar to Update the Georeferencing for the TIF data set. 

30) In ArcToolbox, select Data Transformations>From Raster>Raster to Polygon and input the georeferenced 

TIF you just created as seen below: 

 

 

31) Open the resulting polygon feature class up for editing using the Editing toolbar in ArcMap and clean up 

as necessary. 

32) In ArcCatalog, create an empty feature class with the schema of the bb_cov feature class and load the 

feature class created above into it. 

a. Right-click on the empty feature class, select Load>Load data from the dropdown menu and 

navigate to the location of the service area feature class 

b. Press the Add button, hit Next 

c. Accept the defaults and hit Next 

d. Do NOT attempt to map any fields, as seen below: 

 

 
 

e. Press Next, then Next again, then Finish. 

33) In ArcToolBox, go to Data Management Tools>General>Append 
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34) Append the formerly empty feature class to bb_cov, completing the dialog box as seen below: 

 

 
 

35)  Leave the Schema Type as TEST 

36) Press OK. 

37) In ArcMap, open up bb_cov for editing and manually input associated attribution. 

 

3.5.3 Linear Data 

3.5.3.1 TIGER Street Segments – List, Spreadsheet, or GIS Data 

In the event that the provider supplies TIGER street segments in list or spreadsheet format please follow the steps 

below: 

1) Join TIGER road segments  to 2000 census blocks feature class using one of two methods based on how 

the data is provided: 

a) If the TIGER data is provided with a Census Block ID, then join the segments to the Census Block 

geometry based on that ID 

i) Load both data sets into ArcMap 

ii) In the layer list, right-click on the 2000 census block feature class and select Joins and 

Relates>Join 

iii) In the dialog box, select the TIGER road segments data and the proper attribute fields for joining, 

as seen below: 
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iv) Press OK 

b) If the data provided is a list containing TLIDs,  then join to the TIGER line data using the TLID, and use 

a spatial join to associate the TIGER segment with the coterminous block based on the block ID 

i) Load both data sets into ArcMap 

ii) In the layer list, right-click on the 2000 census block feature class and select Joins and 

Relates>Join 

iii) Select “Join data from another layer based on spatial location” from the dropdown menu 

iv) Complete the dialog box as seen below and press OK. 
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2) Export joined records into a temporary feature class. 

3) If joined Census Block geometry is confined to one specific area then dissolve blocks into one record.  If 

joined Census Block geometry is distributed throughout a particular state then dissolve sub-selections of 

census blocks for each county. 

a) Use the County FIPS code to dissolve by county. 

b) In ArcToolbox, select Data Management Tools>Generalization>Dissolve 

c) Complete the Dissolve dialog box as seen below: 
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d) Press OK. 

4) For each dissolved region, open up the feature class for editing using the Editing tool in ArcMap and 

remove unnecessary slivers and other small holes.  For general guidance on editing features in ArcMap, 

see http://webhelp.esri.com/arcgisdesktop/9.3/pdf/Editing_Tutorial.pdf  

5) In ArcCatalog, create an empty feature class with the schema of the bb_cov feature class and load the 

feature class created above into it. 

a) Right-click on the empty feature class, select Load>Load data from the dropdown menu and navigate 

to the location of the service area feature class 

b) Press the Add button, hit Next 

c) Accept the defaults and hit Next 

d) Do NOT attempt to map any fields, as seen below: 

 

http://webhelp.esri.com/arcgisdesktop/9.3/pdf/Editing_Tutorial.pdf
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a) Press Next, then Next again, then Finish. 

6) In ArcToolBox, go to Data Management Tools>General>Append 

7) Append the formerly empty feature class to bb_cov, completing the dialog box as seen below: 
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8)  Leave the Schema Type as TEST 

9) Press OK. 

10) In ArcMap, open up bb_cov for editing and manually input associated attribution if necessary. 

 

3.5.4 Polygonal Data 

3.5.4.1 Coverage Area – PDF/JPG/Other Image Format 

In the event that the provider supplies coverage area data in some image format such as PDF or JPG format please 

follow the steps below: 

1) If in PDF format, open in Adobe Acrobat and Save As… JPG format. 

2) Open up the JPG image in ArcMap. 

3) Add the required basemap vector data for georeferencing. 

a) This will generally be either the CDOT data or TIGER data 

4) Change the coordinate system of the data frame to the desired end coordinate system 

5) Zoom to the general location of the JPG map image 

a) This is the location based on the vector data, not the JPG image itself. For example, if you know that 

the JPG image represents an area around the town of Limon, zoom to the town of Limon in your 

vector data. 

6) Open up the Georeferencing toolbar by selecting View>Toolbars>Georeferencing from the main menu bar. 

7) Using the Georeferencing toolbar, select Fit to Display, results seen below: 

 

 
 

8) Use the Control Point button  to add control points to the map 

9) Use common points in the base data set and the JPG image 

a) For example, find major street intersections, county/city boundaries, etc. 

b) Try to distribute the points more or less in the four corners on the image for the best transformation 
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10) Click on the location on the image first, then click on the corresponding location on the vector data base 

map, as in the image below: 

 

 
 

11) After placing each control point, the image transformation will update automatically.  

12) Repeat until satisfied with the transformation. 

a) Note: The transformation may take up to four points, although sometimes only two are necessary. 

13) When satisfied with the transformation, select Update Georeferencing from the Georeferencing toolbar 

dropdown. 

a) This will create a “world” file (.jgw in the case of JPGs) in the same directory as the image file. 

14) In ArcCatalog, create a new polygon shapefile with the appropriate data schema for a provider coverage 

area, which can be found in Appendix D. 

15) Add the shapefile to ArcMap. 

16) Using the Editor Toolbar, select Start Editing. Set the Task: to “Create New Feature.” 

17) Use the Sketch Tool  to digitize a new coverage polygon using the coverage area outline from the 

georeferenced JPG and add the required attributes manually. 

18) Repeat the above steps for all subscriber speed coverage areas provided. 

19) Follow the steps detailed in Coverage Area – GIS Data below. 
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3.5.4.2 Coverage Area – KML/KMZ 

In the event that the provider supplies coverage area data in Google Earth KML or KMZ format please follow the 

steps below: 

1) Use a KML to SHP converter to translate file into an ESRI format 

2) http://arcscripts.esri.com/details.asp?dbid=15603  

3) Download the script and follow the provided instructions for installing it in ArcToolbox. 

4) Double-click on the script in ArcToolbox and navigate to the location of the KML file, as seen below: 

 

 

5) Add the new shapefile to ArcMap. Repeat for all KML files provided. 

6) Follow the steps detailed in Coverage Area – GIS Data below. 

 

3.5.4.3 Coverage Area – CAD Data 

In the event that the provider supplies coverage area data in GIS format please follow the steps below: 

1) Transform the CAD dataset into an ESRI format 

2) http://webhelp.esri.com/arcgisdesktop/9.2/index.cfm?TopicName=Transforming_CAD_datasets 

3) It may be necessary to contact the provider first to determine the coordinate system of the CAD data. 

4) If the CAD data is not in a standard coordinate system, it may be necessary to use ArcMap to 

georeference the CAD data to a known coordinate system first. 

a) To do so, follow the instructions provided above in “Coverage Area – PDF/JPG/Other Image Format.” 

5) In ArcCatalog, create a new polygon shapefile with the appropriate data schema for a provider coverage 

area, which can be found in Appendix D. 

6) Add the shapefile to ArcMap. 

7) Using the Editor Toolbar, select Start Editing. Set the Task: to “Create New Feature.” 

8) Use the Sketch Tool  to digitize a new coverage polygon using the coverage area outline from the 

georeferenced CAD file and add the required attributes manually. 

9) Follow the steps detailed in Coverage Area – GIS Data below. 

http://arcscripts.esri.com/details.asp?dbid=15603
http://webhelp.esri.com/arcgisdesktop/9.2/index.cfm?TopicName=Transforming_CAD_datasets
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3.5.4.4 Coverage Area – GIS Data 

In the event that the provider supplies coverage area data in GIS format please follow the steps below: 

1) In ArcCatalog, create an empty feature class with the schema of the bb_cov feature class and load the GIS 

feature class either created above or supplied by the provider into it. 

a) Right-click on the empty feature class, select Load>Load Data from the dropdown menu and navigate 

to the location of the service area feature class 

b) Press the Add button, hit Next 

c) Accept the defaults and hit Next 

d) Do NOT attempt to map any fields, as seen below: 

 

 
 

e) Press Next, then Next again, then Finish. 

2) In ArcToolBox, go to Data Management Tools>General>Append 

3) Append the formerly empty feature class to bb_cov, completing the dialog box as seen below: 
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4) Leave the Schema Type as TEST 

5) Press OK. 

6) In ArcMap, open up bb_cov for editing and manually input associated attribution, if necessary. 

 

3.5.4.5 Compact Polygon From Subscriber Points  

 Geo-code address list using latest state “Composite Locator”  

 

 Verify that your geo-coded file has only one TT (Technology Type).  If not export individual geo-coded 

layers for each Technology Type. 

 

 For each TT check for differences in speed values or speed tiers and create separate layers for each speed 

value/tier. 

 

 Clean your geo-coding results - remove any points that geo-code to accuracy levels below ZIP+4 (ZIP 

centroids, carrier route centroids, etc).  Also, verify that outliers with acceptable accuracy levels are 

legitimate, i.e. fall in correct City and Zip.   

 

 Perform spatial join between county polygons (using stcnyfips field) and the cleaned geo-coded subscriber 

points, in order to carry the county name and stcnty fips. 
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 Summarize the number of subscribers by county and use the subscriber counts by county to populate the 

Rate Tier table. 

 

 Un-join the county data from the geo-code subscribers list. 

 

 Create Compact Polygon using cleaned geo-coded layer or sub-selection of using – XtoolsPro – 

ConvexHull-DetailedHull option.  A sub-selection of geo-coded points will be used in areas where more 

than one polygon will need to be created for one provider’s service area.   

 

 Evaluate output Hull carefully – looking for areas that should not be covered by hull polygon.   

 

o If it is determined that an area or areas should not be represented in coverage area, manually 

reshape hull polygon until coverage area is adequate.   

 

o When not obvious and as a general rule, manually resolve compact polygon when the distance 

between the subscriber points used to define the outer boundary of the compact polygon 

exceeds 5 miles .  When reshaping the hull polygon, snap to the outermost geo-coded points.  

See figure 2 and 3 for an example. 

 

FIGURE 2- Compact Hull: Manual Resolution Required            
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FIGURE 3a- Compact Hull: Manual Resolution Required           FIGURE 3b- Compact Hull: After Manual Resolution        

                       
 

 To attribute the compact polygon - Perform a “Spatial Join” where your Target Feature Class is the 

compact polygon and the Join Feature Class is your geo-coded point layer.  Export compact hull with 

joined attributes and name file appropriately.   

 

 Append attributed compact polygon to BroadBand TT template Feature Class and if required manually 

input any provider attribution that may not have carried over in the append process. 

 

 Intersect compact polygon with county boundaries to create unique records by county and use the state-

county-fips field to populate “stcty_fips” field.  Also use the county name field to populate the 

“BBCov_Name” field.   

 

o Exceptions is where a provider’s coverage is distributed throughout more than one area of any 

given county where the “BBcov_Name” should be populated using an appropriate city or other 

logical name based on geographical location.  

 

 Export/Load into appropriate BB TT model Dataset. 
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3.5.4.6 Census Blocks – List or Spreadsheet 

In the event that the provider supplies census block data in a list or spreadsheet, please follow the steps below: 

1) Ensure block polygons supplied by the provider are 2000 currency 

2) If other currency, convert to 2000 currency before proceeding 

a. To do this, remove the trailing letter (a, b, etc.) from the block ID 

b. You will now have two blocks that equate to one block in the 2000 block geometry 

c. Delete duplicate block IDs, retaining the higher service tier in each case 

3) Prepare the block list in clean Excel format, removing all Excel-only formatting, merged cells, colors, 

borders, etc. 

4) Import the spreadsheet into ArcMap. 

5) Right-click on the 2000 census block feature class in the layer list in ArcMap and select  Joins and 

Relates>Join from the drop down menu. Join the census block list to the 2000 census blocks feature class 

using the block ID and export joined records in a new feature class. The Join dialog box and process can be 

seen above in the TIGER Street Segments – List, Spreadsheet, or GIS Data section. 

6)  Follow the steps in Census Blocks – GIS Data below. 

 

3.5.4.7 Census Blocks – GIS Data 

In the event that the provider supplies census block GIS data please follow the steps below: 

 

1) Ensure that the blocks supplied by the provider are in the required data schema and are complete as far 

as require attribution. 

a. If not, manually enter the required attribution or contact the provider to fill gaps. 

2) If census block geometry is distributed throughout more than one county then select Data Management 

Tools>Generalization>Dissolve in ArcToolbox and dissolve based on County/Provider/TT/Speed Tier so 

that unique records are created for each unique combination. 

a. The dissolve dialog box can be seen above in the TIGER Street Segments – List, Spreadsheet, or 

GIS Data section. 
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Figure 1: Undissolved census block polygons 

 

 
Figure 2: Census block polygons dissolved by county 

 

 

2) For each dissolved region use the Editing toolbar in ArcMap to remove unnecessary slivers and other 

small holes.   

3) In ArcToolbox, select Data Management Tools>General>Merge and merge the processed polygons 

together into single layer. 

4) The merged census blocks will need to have the subscriber’s “frn” field added and populated. 

5) In ArcCatalog, create an empty feature class with the schema of the bb_cov feature class and load the GIS 

feature class either created above or supplied by the provider into it. 
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a. Right-click on the empty feature class, select Load>Load Data from the dropdown menu and 

navigate to the location of the service area feature class 

b. Press the Add button, hit Next 

c. Accept the defaults and hit Next 

d. Do NOT attempt to map any fields, as seen below: 

 
 

e. Press Next, then Next again, then Finish. 

6) In ArcToolBox, go to Data Management Tools>General>Append 

7) Append the formerly empty feature class to bb_cov, completing the dialog box as seen below: 
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8) Leave the Schema Type as TEST 

9) Press OK. 

10) In ArcMap, open up bb_cov for editing and manually input associated attribution, if necessary. 

 

3.6 Metadata Transactions 

Following any updates or changes completed within the file geodatabase (fGDB) stored on the GIS-Analysts staging 

environment, the GIS-Analyst runs transactions to compare that fGDB with the one stored on the Core server to 

ensure metadata on all changes are recorded. 

 

Below outlines the steps taken to run transactions on the updated Core database: 

  

1. Open a command line window and run generateTransactions.py  

a. Usage: generateTransactions.py  [Core fGDB] [Staging Environment fGDB]  

 

b. Example of command line:  

 

<path>generateTransactions.py <path>ST_BB_POLY_SRV_AREAS.gdb <path>ST_BB_POLY_SRV_AREAS.gdb  

 

2. Below is an example of the output screen that will be displayed: 



            

51 

 

 
 

 

3. After process has completed, results can be found in the ST_BB_POLY_SRV_AREAS_HIST.gdb  

a. The transactions scripts records changes at a feature level. 

b. Below is a screen shot supporting the directory structure of the historical fGDB. 
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c. Attribution associated with each added/removed/changed features is tracked, including the 

following additional columns appended to the end of each: 

i. Commit_by 

1. Records the GIS-Analyst that committed the changes to the historical fGDB. 

 

ii. Commit_date 

1. Records the date and time stamp that the changes were committed. 

 

iii. Trans_type 

1. This field reflects the type of change recorded. 

2. Categorized by: 

a.  Adds/Change/Deletes 

 

iv. New_values 

1. Records the new values when a change was completed on a feature.  Example:  

Name or speed change 
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d. MD_Process is also transferred from the edited fGDB to the historical fGDB, which states the 

actions completed by the GIS-Analyst. 
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3.7 Data Processing 

3.7.1 Data Processing Overview 

The following items outline the actions required to process the service provider data further to meet the NTIA 

requirements. 

 Weighted Nominal Speed 

 Middle Mile 

 Broadband Coverage Template 

 

3.7.2 Weighted Nominal Speed 

The weighted nominal speed is populated one of the following two ways: 

3.7.2.1 Subscriber Data Supplied by Provider 

Where the data provider supplies  subscriber speed information , the following formula from the NOFA is used: 

(speed tier-1 in kbps × no. of tier-1 subscribers) + (speed tier-2 in kbps × no. of tier-2 subscribers) + (etc.) 

Total average monthly subscribers 

 

 

Data is initially broken up in the following order: 

1) Stcty_fips 

2) Transmission technology type 

3) Subscriber tiers 

 

3.7.2.2 Value Supplied by Provider 

Some providers will supply their weighted nominal speed.  In these cases, the data supplied will be populated 

instead of using the NOFA formula. 

These obtained or calculated values are used to update the service overview layer. This can be done manually or 

by creating a table with the provider’s FRN and average weighted speed and joining it to the service overview table 

in ArcMap. To Join, right-click on the layer to join to and select Joins and Relates>Join… from the dropdown menu. 

Then navigate to the table to join to and select the join fields from the drop down list. Then open up the source 

table (the table in ArcMap) and right-click on the header of the Average Weighted Speed field and select Calculate 

Field from the drop down menu. Use the value of the average weighted speed from the joined table. 

3.7.3 Middle Mile 

Middle mile information is generally provided in spreadsheet or text file format. The process is to take what is 

supplied by the provider and translate it into the required data schema.  

1) If the data is supplied with address information, follow the process outlined above in Subscriber Location 

– Address Data.  

2) If the data is supplied with associated XY coordinates, follow the process outlined above in Subscriber 

Location – XY Data.  
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3) Once the data is in GIS format, use the Append (Data Management Tools>General>Append) command in 

ArcToolbox to append the data to the overall middle mile dataset. 

4) Set the schema type to NO_TEST and use the Field Map to map the attribute fields from the source to the 

target dataset. 

3.7.4 Broadband Coverage Template 

Below is the description of the fields within the BB_Cov layer, which is the interim data set that is used to create 

the final product deliverable. 

 

Name Alias Description 

objectid OBJECTID Internal Object ID 

shape SHAPE Internal Shape storage 

prov_id PROVIDER_ID Unique numeric identifier for each provider 

prov_name PROVIDER_NAME Unique name for each provider 

dba_name DOING_BUSINESS_AS An alternative "Doing-Business-As" name for the provider 

frn 
FCC_REGISTRATION_NUMBE

R 
Provider FCC Registration Number 

bbcov_name BBCOV_NAME BroadMap Broadband Coverage name 

trans_code TRANSMISSION_CODE 
Unique code for the transmission technology type described by 

this layer 

trans_name TRANSMISSION_NAME Name for the transmissions technology type 

trans_desc TRANSMISSION_DESC Description for the transmissions technology type 

spect_code SPECTRUM_CODE Unique code for the spectrum [WIRELESS ONLY] 

spect_name SPECTRUM_NAME Name for the spectrum [WIRELESS ONLY] 

spect_desc SPECTRUM_DESC Description for the spectrum [WIRELESS ONLY] 

mad_dwn_t MAX_AD_DOWN_TIER 
Maximum advertised downstream speed available within given 

area (speed tier) 

mad_up_t MAX_AD_UP_TIER 
Maximum advertised upstream speed available within given 

area (speed tier) 

typ_dwn_t TYPICAL_DOWN_TIER 
Typical downstream speed available within given area (speed 

tier) 

typ_up_t TYPICAL_UP_TIER Typical upstream speed available within given area (speed tier) 

mad_dwn_k MAX_AD_DOWN_KBPS 
Maximum advertised downstream speed available within given 

area (kbps) 

mad_up_k MAX_AD_UP_KBPS 
Maximum advertised upstream speed available within given 

area (kbps) 
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Name Alias Description 

typ_dwn_k TYPICAL_DOWN_KBPS Typical downstream speed available within given area (kbps) 

typ_up_k TYPICAL_UP_KBPS Typical upstream speed available within given area (kbps) 

subs SUBSCRIBERS 
Total average monthly subscribers for this provider for this 

technology for this coverage polygon 

md_geom MD_GEOMETRY 
Metadata: Comma separated list of source id's from which the 

polygon extent was produced 

md_exists MD_EXISTS 
Metadata: Comma separated list of source id's used in 

understanding and editing the provider data for this polygon 

md_who MD_WHO 
Metadata: Name of the editor who last edited this feature at 

the time in md_when 

md_when MD_WHEN Metadata: Date/timethat this feature was last edited 

md_process MD_PROCESS 
Metadata: Comma separated list of processed used to create 

and/or modify this layer 

stcty_fips STATE_COUNTY_FIPS State/County FIPS code 

rec_id RECORD_ID 

Compound Key formed from 

STCTY_FIPS+"|"+Provider_ID+"|"+Trans_Code+"|"+BBCov_Nam

e 

st_area ST_AREA(SHAPE) Area in square decimal degrees  

st_length ST_LENGTH(SHAPE) Length in decimal degrees  

Provider_Typ

e 
Type of Provider 

Has Subtype (1:Broadband provider as described in the 

NOFA,2:Reseller,3:Unknown), default value = 1  (New 04/11 

Model) 

 

3.7.5 Verification and Validation 

3.7.5.1 Provider Validation – Provider Portal/PDF Map Review 

Following the collection and aggregation of provider data, the aggregated data is validated by the provider to 

ensure it is an accurate representation of their coverage area and supporting broadband information. 

This validation is completed through the Provider Portal web application, which is a secure interactive map that 

displays  the provider’s coverage areas and allows the provider to validate, submit feedback or request changes.  If 

changes are requested, then the features on the portal are updated and an automatic request is sent to the 

provider to complete the validation process. 
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 Providers that did not use the Provider Portal are asked to validate a PDF map displaying their coverage area(s).  

this is accomplished via e-mail notification.   

 

 

 

 

 

3.7.5.2 Provider Verification – 3rd Party Source Review 

After the provider has validated its coverage areas, a 3
rd

 party source comparison and analysis is performed.  

Where anomalies or discrepancies are identified, a ‘SCAN’ point is dropped and descriptive comments are applied 

to be reviewed later with the provider. 

 

During the provider review, the map is displayed along with the ‘SCAN’ points and potential refinement is 

completed based on input from the Provider. 

 

3
rd

 Party Sources Utilized 

3
rd

 Party Source Name Source Type Verification Type 

InfoUSA Consumer and Business 
Listings 

Community Anchor Institutions 
Can also be used for demographic information supporting 
the State websites 

Pitney Bowes (PBBI) Exchange Info Plus 
(Central Office Locations) 

Exchange datasets are used to verify the following 
Transmission Technologies (TT): 
Asymmetric xDSL (10), Symmetric xDSL (20), Other Copper 
Wireline (30), and Optical Carrier/Fiber to the End User 
(50). 
 

Media Prints Cable Boundaries Used to verify the following TT: 
Cable Modem—DOCSIS 3.0 (40) and Cable Modem—Other 
(41) 

American Roamer  Wireless Coverage 
Patterns (EVDO, GPRS, 
WISP, HSPA) 

Used to verify the following TT: 
Terrestrial Fixed Wireless—Unlicensed (70), Terrestrial 
Fixed Wireless—Licensed (71) and Terrestrial Mobile 
Wireless (80) 

ComSearch Wireless Spectrum 
Holdings and Tower Data 

Used to verify the following TT: 
Terrestrial Fixed Wireless—Unlicensed (70), Terrestrial 
Fixed Wireless—Licensed (71) and Terrestrial Mobile 
Wireless (80) 
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3.7.5.3 Assigning Confidence Values 

All  findings and results from the above-mentioned validation and verification activities, plus internal peer quality 

reviews are captured and tracked in a Validation table and form the basis of the confidence value assigned  for 

each provider and then each technology.   

 

The confidence values are as follows:  
0     = Coverage area has not been reviewed 
10   = Extremely Low.   Single Source QC.   
20   = Very Low.  Needs Additional Validation\Verification 
30   = Low.   Even with Validation\Verification, Coverage is still suspect. 
40   = Acceptable, confirm with State prior to shipment.    
50   = Meets requirements to be included in shipment. 
60   = Moderate.  Meets NTIA/State’s standards, representative of Technology Type (TT) 
70   = High.   Accurate representation of coverage based upon TT. 
80   = Very High.  Multiple validation\verification with most 3

rd
 party sources 

90   = Extremely High. Multiple validation\verification sources 
100 = Perfect.  Multiple validation\verification sources, with complete alignment with sources and ground 
truth verification activities 

 

This Validation table is maintained as updates or changes occur for each provider, down to technology type, with 

the overall goal to improve the confidence values and overall map representation. 

 

Example of the Validation table: 
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3.7.6 Community Anchor Institution (CAI) Data 

3.7.6.1 Data Collection 

The CAI data was initially collected from the State to create the baseline inventory.  All location information and 

broadband coverage data supplied was also ingested into the data deliverable. 

Additional collection of CAI information was done via data mining and/or webscraping to build out the inventory 

further.  For example:  Collection of additional CAIs and location information. 

 

The state-agency-provided CAI inventory was comprehensive but the challenge is collecting broadband related 

data; service provider(s), technology and speed data for each CAI.  Availability of the CAI portal has not significantly 

increase submission of this data.  Additional promotion to CAIs to utilize the CAI portal will be needed to increase 

this data for subsequent deliverables. 

 

3.7.6.2 Institution Data 

Institution data is obtained from a variety of sources and almost always provided in Excel spreadsheet format. The 

general process for incorporating this data is below: 

1) If the data is provided in Excel or some similar format: 

a. Clean and standardize the Excel spreadsheet, removing any cell formats, merged cells, etc. 

b. Standardize the address format as defined in the staging CAI database 

c. If the spreadsheet includes X and Y values, such as latitude and longitude, use the Add XY Data 

tool in ArcMap to create a spatial data layer. 

d. If there are only addresses, then follow the geocoding steps outlined above to create spatial data 

points for each of the institutions. 

i. Institutions that do not geocode based on the TIGER 2009 data set will have to be 

manually located using Google Maps, Google Earth, or some other information source. 

2) If the CAI source data is in GIS format, add the Latitude and Longitude fields and use the Calculate 

Geometry tool to populate them, using the WGS 84 coordinate system. 

3) Using ArcCatalog, load the new data into the staging CAI database. 

4) This database is ready for the makeDeliverable.py script to process the information into the final state 

and NTIA deliverables. 
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3.7.6.3 Community Anchor Institution (CAI) Portal Updates 

A web application has been released to allow for further data collection and validation of anchor institution 

location information, broadband coverage, and speed test data. 

 

Information collected from the CAI Portal is then ingested into the overall inventory and will later be compared 

against the provider coverage areas mapped for any potential discrepancies. 
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3.8 Product Extract 

3.8.1 Python Scripts 

The following sections make use of Python scripts. In general, to use a Python scrip, you must have Python 

installed on your computer. To download the latest version of Python, go to http://www.python.org/download/ 

and download the latest stable version. As of August 2010, this was version 2.7. Once this is installed, the general 

way to run a script is to type the following at a command prompt: C:\Python27\python.exe C:\<location of script>. 

Many of the scripts provided have environment variables that must be set before they can be run.  

 

The python code for BroadMap’s product extract has been incorporated into a Hudson CI System, which is detailed 

in the Process Operation and Monitoring section of this document.  This was a process improvement activity so all 

processes can be monitored, controlled and contain historical tracking on each process. 

 

3.8.2 Product Extract Process 

Note: specific Python scripts are called out in red font in the sections below. 

The MapConnect product extract process, makeDeliverable.py, uses the BB_Cov and BROADMAP_POINTS interim 

data sets to create the following layers according to the current specifications: 

 BB_Service_Road_Segment 

- This layer contains all broadband services associated with specific street segments for census 2000 

blocks larger in area than two square miles 

 BB_ServiceCensusBlock 

- Contains all broadband services associated with census blocks of no greater than two square miles. 

 BB_Service_Wireless 

- This layer contains all wireless services not associated with specific addresses. 

 BB_ServiceOverview 

- This layer contains subscriber-weighted nominal speed for each provider's service area at a county 

level and is meant to act as a summarized view.  

 BB_ConnectionPoint_MiddleMile 

-   This layer contains middle-mile and backbone interconnection points 

 BB_Service_CAInstitutions 

- Broadband Service at Community Anchor Institutions (CAI) 

 Community Anchor Institutions consist of schools, libraries, medical and healthcare providers, 

public safety entities, community colleges and other institutions of higher education, and other 

community support organizations and entities. 

 

Due to a NTIA model change for the October 2010 data deliverable, an addition to this code was created to 

support both models in the case a comparison is later desired or a request is made to revert back to the original 

http://www.python.org/download/
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model.  This script name is bdia2ntia.py and creates the following layers in addition to the layers mentioned above, 

rolled up to NATL_Broadband_Map. 

 

 BB_ConnectionPoint_LastMile 

-   This layer contains last mile infrastructure points, which is only populated if data cannot be provided 

at a more granular level. 

 BB_Service_Address 

- Represents broadband availability for service address points.  Address Point availability refers to 

those individual addresses at which each facilities-based provider of broadband service can provide 

broadband services of minimal characteristics within 7 - 10 business days. 

 State_Boundary 

- State boundary supporting topological validation of point feature classes. 

 NATL_Broadband_Topology 

- Supports basic topology quality checking.  Example:  No CAI’s or Middle Mile points outside of the 

state boundary 

 

The following process flow provides a view of how the Core fGDB is extrapolated to the NTIA final deliverable via 

the makeDeliverable.py script.  Following that, the bdia2ntia.py script is run, which limits what’s placed in the final 

layers based on the NTIA modeling standards. 

 

The product scripts and supporting extract were originally created separately per request, in case data model 

comparisons were to be completed.  

 

3.8.3 Product Statistics 

Following the completion of a product extract, the product statistics script (BDIA_ReleaseNotesStats.py) extracts 

the following information supporting that product deliverable. 

 Provider Statistics 

- Collects all provider information, listing by Provider Name 

- Provides output of FRN 

- Counts the number of features supported within the following layers: 

 Census Block 

 Street Segment 

 Max Upstream 

 Wireless Services 

 Infrastructure Points 

- These updates were made to support the Data Package required to accompany every NTIA product 

deliverable. 

 Community Anchor Institution (CAI) Statistics 

- Breaks CAI down to the 8 categories 
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 1:  School: K through 12 

 2:  Library 

 3:  Medical/Healthcare 

 4:  Public Safety 

 5:  University/College 

 6:  Other Government 

 7:  Other Community non-government 

 None:  Unknown Category 

 In cases where this occurs, further investigation is completed prior to product shipment to 

ensure all CAI’s are categorized accurately 

- Reports out the following counts 

 Total CAIs within that category 

 Total CAIs that contain partial BB coverage  

 Contains any of the following information for given CAI: 

 BB Subscriber, Transmission Technology, Speed Down Speed Up 

 Total CAIs that contain full BB coverage 

 Contains all of the above-mentioned BB information for given CAI. 

The output of this script is two CSV files: AnchorInstitutions.csv and Providers.csv. These files can then be 

inspected to ensure that there are the expected number of CAIs and providers for every release. 

 

3.9 Quality Assurance  

Quality assurance is supported manually and algorithmically on the interim data, BB_Cov file geodatabase, and on 

the final product. For scheduled product releases, a test product extract and subsequent manual and algorithmic 

QC run is completed along with a release review.  The product specifications, project status reports, previous 

product release notes are used as references throughout this review. 

The following parameters are tested using the methodology listed below each: 

 Product Deliverable Format  

- Correct names and format of data deliverables 

 BDIA_QC_SUITES (please see below for details) 

- Correct Projections/Datum 

 Manual interaction with product 

- Metadata Present and Correct 

 Manual interaction with product 

 Table Structure 

- All required tables included 

 BDIA_QC_SUITES 

- Extraneous tables identified 
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 BDIA_QC_SUITES 

 Field Structure 

- All fields included 

 BDIA_QC_SUITES 

- Extraneous fields identified 

 BDIA_QC_SUITES 

- Correct field names, types and widths 

 BDIA_QC_SUITES 

 Field Domains 

- Values in all tables are constrained to the specified values specified 

 This action is accomplished via BDIA_QC_SUITES and manual review of the product 

 This tends to identify project completeness issues as fields with a null value are identified. 

 Geometric Representation 

- Identify if all layers have the correct geometric representation 

 Manual review of the BB_ServiceOverview layer 

 Dependent on NTIA and client requirements 

 Geographic Extent 

- Product includes the necessary Geography associated with Product? 

 Manual Review - ArcGIS 

- Is there extraneous geography included in Product? 

 Manual Review - ArcGIS 

 Completeness 

- Products contain the expected amount of data? 

 Manual review of product stats relative to weekly State reports and defined expectations. 

 Accuracy 

- Product meets the stated accuracy requirements for the deliverable? 

 Sampling procedure to manually review source material to resulting product 

 Provider Validation 

 Verification using 3
rd

 Party Data 

 Verification against reality, where applicable 

 Data Regression 

- Any unexplainable data loss or change? 

 This action is accomplished by comparing results within product statistics script 

(BDIA_ReleaseNotesStats.py) from previous releases, as well as manual review of the product 

 Confidentiality 

- Any unauthorized confidential information included in the delivery? 

 Review of NDAs and delivery expectations 

 Prior Issues Resolved  

- Have expected internal issues been resolved? 
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 Manual review of data against previous product release notes 

- Have agreed upon customer issues been resolved? 

 Manual review of data against previous product release notes, status report and client feedback 

 Delivery Medium 

- Has the product medium been verified? 

 Manual review 

- All files present 

 Manual review of SFTP site to ensure all files are copied correctly, including file/directory size 

- Correct location 

 Manual review – confirmation of SFTP link, username and password 

 

3.9.1 QC Suite 

The BDIA_QC_SUITES consists of four main types of scripts supporting the overall QC process. These scripts are all 

run in concert and are called from the test_runner script and the test_BDIAProductGDB script. 

 

3.9.1.1 Configuration  

These scripts establish the configuration for the test_BDIAProductGDB script which is the core of the QC Suite.  

- update_test_config 

- active_config 

- config_PROCESS01_automated 

- config_PROCESS01_manual 

- set_active_config 

3.9.1.2 Libraries 

These scripts provide additional functionality that is called from with the test_BDIAProductGDB script.  

- bb_unittest_fixture 

- bbcov_structure 

- BC_XmlWriter 

- file_folder 

- search_and_replace 

- unittst_fixture 

- validate_BB_DB 

- validate_BB_GDB 

- xmlrunner_gui 

3.9.1.3 QC Suite 

This is the core script for performing automated QA/QC on the interim and final data deliverables. 

- test_BDIAProductGDB 
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3.9.1.4 Other  

These scripts perform other functions detailed below: 

- test_runner – this is the main script that runs all the other QC scripts and imports all the necessary scripts 

and libraries 

- which_build – this determines the current build and passes information to the configuration scripts 

 

3.10 Process Operation and Monitoring 

Product Extract, makeDeliverable.py and bdia2ntia.py, is run within BroadMap using a platform called Hudson that 

has been enhanced to support BDIA product extraction, process monitoring, as well as product validation.  The 

same platform can be planned for implementation for the State, if desired. 

 

Below are examples of the product create, product validation, product statistics and monitoring processes which 

are managed within the BroadMap Hudson CI-System.  All of the above-mentioned python scripts, with the 

exception of metadata transactions script, are run via this system. 

 

3.10.1 BDIA Product Create 

 

Below is an example of the main page where the type of product build can be selected. 

 

 
 

Selecting based on the type of process that will be initiated. 
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The Console Output can be reviewed to see the progress of product create.  Following the completion of each 

product creation process, an e-mail notification is automatically sent to the team.   

 

 
 

 

All processes run via the BroadMap Hudson CI-System are stored for historical reporting.  Each process can be 

reviewed, including the Console Output and Build Artifacts from that run. 
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3.10.2 Product Validation and Statistics 

 

Once the product creation process is complete, Product Validation and Statistics are then initiated.  These support 

the BDIA_ReleaseNotesStats.py script and the BDIA_QC_SUITES scripts detailed above. 

All statistics and reports are stored for historical review with the capability to place violation criticality on each 

quality control check allowing the identification of errors due to project status/completeness verses project 

correctness.  Example:  Typical Speeds populated. 
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Below is an example of the report provided based on various control points running over a specified time period: 

 
 

Similar to the Product Create process, all results from the process are maintained:  

 
 

Results are then reviewed manually to ensure no errors reported are critical or in violation of the NTIA data model 

or project completion statements.  Any errors of concern are communicated ahead of product delivery and 

included within the product release notes. 

Further detail on the Hudson CI System environment can be found by navigating to the following link: 

http://wiki.hudson-ci.org/display/HUDSON/Meet+Hudson 

 

http://wiki.hudson-ci.org/display/HUDSON/Meet+Hudson
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3.11 Product Extract Data Delivery 

Product delivery for MapConnect Broadband is handled two ways, depending on client requirements: 

1) State Submittal 

a) Data is submitted via SFTP site 

b) Product Release Notes and QC Test Report accompanies the delivery 

2) NTIA Submittal 

a) Directions for using the NTIA State Broadband Data file submission tool 

b) Go to the following WWW web site: https://esupport.fcc.gov/statedata  

c) Enter your username and password as provided to you from the NTIA program administrator. 

 

 
 

d) Click in Upload a file field 

https://esupport.fcc.gov/statedata
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e) Browse to local file for submission using the ‘Browse’ button.  Select file then select ATTACH FILE. 

 

 
 

f) Logout / Receipt using the Logout button in the Top Right of the screen 

g) A receipt of submission is emailed to username e-mail address 
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Executive Summary 
 
The following report describes methods and issues related to the April 1, 2011 deliverables to 
NTIA for Broadband Mapping in Montana. This data submission is compliant with all guidance 
and specifications provided by NTIA as of March 24th, 2011. As per NTIA guidance we are 
using the Jan 13th, 2011 version of the Broadband data model and the March 14th, 2011 version 
of the validation script.  
 
Montana has developed a very robust operational data model, components of which are 
described in this report, to support our broadband mapping efforts. We feel our operational 
model can support any reasonable modifications to NTIA requirements or the NSGIC data 
model. Since this deliverable format is derived from our operational data model, we anticipate 
some modifications will be required.  We are able to take best practices recommendations from 
the NTIA and incorporate those into the final deliverable without major modifications of our 
work flow and operating rules. 
 
Our mapping process starts with infrastructure points (central offices, remote terminals, wireless 
towers and antenna locations, middle mile and backhaul), cable franchise areas, and anchor 
institution addresses.  When providers have not supplied detailed information of their service 
areas that can be mapped at the census block level, coverage models are derived dynamically 
from this infrastructure based on geoprocessing techniques specific to each broadband 
technology. Examples of geoprocessing techniques include developing propagation models using 
the Longley-Rice model for wireless coverage and using infrastructure points in conjunction with 
the road network to predict the area served for DSL coverage.  
 
We have developed a system to quantify “validated” data for the purpose of determining what is 
suitable for delivery to NTIA.   The operational data model maintains reliability and validity 
codes, together with completeness checks to track which data elements are complete or still in 
process of refinement.  Infrastructure is compared to public data, independent measurements, and 
telecommunications provider submittals at varying levels of geography.  As more data is 
obtained from providers and systematically checked against infrastructure points, the reliability 
and validity progress from 1 (not validated or reliable) to 10 (validated and reliable).  
Completeness is primarily dependent on provider input, and can be supplemented in many 
instances with independent measurements. The process is iterative.   Five of the providers 
included in this data set submitted infrastructure data at the address level. The remainder have 
submitted at a coarser geographic scale, most often by census tract, small scale paper or digital 
map, or generalized town location.  Our validation methods provides the ability to use general 
information and iteratively cross check and improve the coverage models as more accurate data 
is obtained.  
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Reliability, Validity and Completeness  
 

Reliability codes apply to the source data points and polygons and assess the authority of the 
source we obtained the data from and the level or coarseness of the geography (address or town).  
Validity codes are determined from cross checks of data sources and the number of independent 
sources of verification.  These are as simple as comparing speed test locations against DSL 
modeled polygons, or as complex as geospatial analysis operations such as a kernel density 
function cluster analysis.  Completeness is determined by public sources, independent 
measurements or provider submittals and checks on the domain classes required for the final 
NTIA deliverables such as Technology of Transmission domains, Speed Test domains and 
serving facility and wireless spectrum facility types and categories.  The categories for these, and 
the subsequent records in our operational geodatabase tables grow and change as new data is 
obtained. We are maintaining these as feature level metadata tied to points and polygons 
maintained by analysts and technicians in a wiki table and coding them to the geodatabase.  In 
this way the unique situations that arise can be cataloged and maintained with some level of 
flexibility while contributing to the final indices in a controlled fashion.  

Reliability Codes 

The two factors incorporated in reliability codes include the level of geography that was used as 
a source or provided as a clarification of location and the authority of the source for the 
information. We are also considering clusters of point information from independent 
measurements and sources to be higher in reliability than individual point information. 

Generally, the coarser the source geography the lower the resultant score. Everything besides an 
address or street intersection, latitude/longitude location, or location provided in a georeferenced 
digital source is assigned a reliability score less than 5. This applies to source data coming (e.g. a 
central office located in a city instead of an address) and review comments on a previously 
mapped location (e.g. “That location is wrong, I know it is on the south side of town”). 

We have incorporated the reliability code into our last point of aggregation (LPA) and provider 
coverage geodatabase files, and into some of the publicly available data (PAD) geodatabases. 
We are also carrying a short text field (50 characters) with a descriptive rationale for the score. 
This will allow us to focus more on the lower scores that need to be confirmed, and ignore the 
high confidence data scored as 9’s and 10’s. 

Reliability Codes 

Code Description Detailed Description 

0 Not assigned • Not yet assigned  

1 Level 1 • Checked but unverified  

2 Level 2 • County  
• Presence by other coarse geography (e.g. administrative region)  
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3 Level 3 
• City  
• Census tracts  
• Cable Plus (area likely to have been annexed into an incorporated town or CDP)  

4 Level 4 
• Cable - incorporated  
• Zipcodes  
• Census blocks  

5 Level 5 
• GeoTel unverified  
• Confirmed by provider or anchor institution key advisor but to geography coarser 

than address or intersection  

6 Level 6 • Qwest/Midcontinent or other web site random testing check  
• Speed test from individual average residential  

7 Level 7 

• From anchor institution key advisor Webex  
• GeoTel verified address only with no 3rd party confirmation from public sources  

o Building unverified  
• Speed test from anchor institution  

8 Level 8 

• From provider  
• FCC ULS or ARS  
• Geotel verified address and possibly verified by 3rd party source (Google 

Streetview)  
o Another provider's sign is on building (usually Qwest)  

• Geotel possibly verified by 3rd party source (NAIP, Google Streetview)  
• From state authoritative public data source (e.g. DCN or SummitNet)  

o Address or building unverified  
• Speed test from cluster of average residential  

9 Level 9 

• From provider with authoritative confirmation  
• Geotel verified address and verified by 3rd party source (NAIP, Google Streetview) 

o Provider sign on building  
o Tower or dish visible  

• From provider or anchor institution check of our data * Root Wireless  
10 Level 10 • From 2+ authoritative confirmations  

 

Validity Codes 

We include validity codes in the last point of aggregation infrastructure data which drives 
creation of the DSL models.  We also include validity codes in each of the final technology of 
transmission deliverables for polygons and point feature classes.  The scales of validity vary by 
each major type and function. 

Infrastructure Validity Codes 

The purpose of this validity code is twofold: 

1. To determine which infrastructure points are turned into DSL model coverages  
2. To use as a reference in other coverage validity checks  
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Infrastructure Validity Codes 

Code Description  Detailed Description
0 Level 0 • Not yet assigned 
1 Level 1 • Not yet assigned 
2 Level 2 • Not yet assigned 

3 Level 3 • Checked against MT PSC Report or DSLReports at the town level  
• Checked against SummitNet anchor institution data  

4 Level 4 • Checked against two or more independent public sources at the town level  
• Checked against provider public data (e.g. Qwest ICONN) at the town level  

5 Level 5 • Not yet assigned 

6 Level 6 • Confirmation of DSL or cable from authoritative public data to broader geography 
than address not confirmed by provider  

7 Level 7 • Authoritative public data at address level (e.g. Geotel) not confirmed by provider  

8 Level 8 • Provider submission at the census tract level  
• Provider website independent address checks (Qwest, Verizon)  

9 Level 9 • Provider submission at the census block level  
10 Level 10 • Provider submission at the address level  
 

 

Final Technology of Transmission Validity Codes 

The purpose of this validity code is twofold: 

1.  To determine which elements are loaded in the spreadsheet provider submission 
packages in their review  

2. To determine which provider coverages are chosen for submittal with one of the  NTIA 
deliverables (April 15, June 24) 
 

Final Technology of Transmission Validity Codes 

Code Description Detailed Description 

0 
Not 
assigned • Not yet assigned  

1 Level 1 • Unassigned at this time 
2 Level 2 • Unassigned at this time 

3 Level 3 • Checked against MT PSC Report or DSLReports at the town level  
• Checked against SummitNet anchor institution data  

4 Level 4 • Checked against two or more independent public sources at the town level  
• Checked against provider public data (e.g. Qwest ICONN) at the town level  

5 Level 5 • Confirmation of DSL or cable from authoritative public data  

6 Level 6 • Provider website independent address checks (Qwest, Verizon)  
• Provider submission at the census tract level  
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7 Level 7 
• Provider submission at the census block level  
• Provider submission at the census block level confirmed by Speed test cluster OR 

RootWireless  
8 Level 8 • Provider submission at the address level  

9 Level 9 • Provider submission at the address level confirmed by Speed test cluster OR 
RootWireless  

10 Level 10 • Provider submission at the address level confirmed by Speed test cluster OR 
RootWireless  

 
 
State Specific Issues 
 
The most notable issue specific to Montana is the lack of non-disclosure agreements (NDAs) 
with the providers. To date no provider has agreed to sign a NDA in Montana due to open 
records laws in the State. However, the vast majority of broadband providers in the State have 
elected to cooperate with the project and have provided at least some information about their 
coverage areas. Where providers have not provided data, or not provided adequate data we have 
used a variety of methods including modeling, field mapping, and use of public sources to 
develop map data. 
 

Detailed Processing Steps 
 

BROADBAND COVERAGE (BB_SERVICE_CENSUSBLOCK AND 

BB_SERVICE_ROAD_SEGMENT) 

 
LOGICAL CONSISTENCY REPORT  
Data submitted by broadband providers was accepted as is when it was provided as a broadband 
coverage or at a census block level.  Provider coverage submitted at a coarser geographic scale 
was supplemented with public data, independent measurements and GIS modeling techniques.  
When independent measurements were available for typical broadband speeds and modeled 
location of infrastructure, some provider data was overridden or supplemented. 

COMPLETENESS REPORT  
All data was submitted by broadband providers was mapped in complete form, except where 
independent measurements were used to supplement provider submittals.  Several providers did 
not participate in the broadband mapping process, including some that were suspected to be 
providers. 

PROCESS DESCRIPTION  
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Process final broadband coverage from provider submissions. 

Broadband providers that chose to submit coverage data did so in a wide variety of formats, 
levels of completeness, and at varying geographic scales including: narrative descriptions, analog 
and digital coverage maps, CAD files, GIS shapefiles and geodatabases, KMZ and KML files, 
FCC 477 reports, and data spreadsheets.  All data formats were accommodated and processed 
whenever possible.   

If data was submitted by a provider in a format that did not allow mapping at the census block 
level of geography, providers were sent standardized maps that included census blocks and a 
data spreadsheet in an attempt to standardize the inputs and increase the geographic granularity 
of the provider data submission. 

Although each provider had individual characteristics and nuances in their data submissions, 
several data patterns can be described generalizing the provider submissions. 

FCC FORM 477 REPORT OR SIMILAR FORMAT: 

Broadband providers are required to submit FCC Form 477 reports twice a year to the FCC; 
recently 477 submissions have been done using a structured web site maintained by the FCC.  
The 477 reports require broadband providers to submit a list of census tracts with the number of 
subscribers based on maximum advertised downstream and upstream speed tiers.    Several 
providers submitted their actual FCC 477 report or a modified version in analog or digital 
format.   

HOW THEY WERE HANDLED:   

FCC Form 477 reports were entered into a standardized format that included the census tract ID 
code, maximum advertised downstream and upstream speed tier code, and number of subscribers 
if available.  Since the FCC 477 reports requires providers to submit data for all speed tiers 
within a census tract, only the highest maximum advertised speed for any given census tract was 
entered into the standardized spreadsheet in order to be compliant with the definition of 
broadband service.  The spreadsheets were then joined to a census tract feature class template 
that included the attribute fields from the NTIA schema.  The resulting feature class was a 
geographical representation of the FCC 477 report including the technology of transmission and 
speed information.  This feature class was used in conjunction with validated LPA data to run the 
DSL or Cable geoprocessing models respectively.  The resulting census block selection from the 
DSL or Cable models were added to a standardized review map and returned to the provider for 
confirmation.      When providers returned additional data at a finer level of geographic detail 
they were processed as census block or coverage provider data as described below.  For those 
that did not respond, the final submission was our best modeled estimates of their coverage at the 
census block level for DSL and/or Cable technologies.  Providers that submitted FCC 477 data 
for fiber to the end user or fixed wireless could not be mapped and were not included in the final 
broadband map unless they provided additional data. 

PROVIDERS SUBMITTING CENSUS BLOCK COVERAGE: 
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Census blocks submitted by providers representing their broadband coverage area come in a 
wide range of formats including: analog and digital maps, CAD files, GIS shapefiles and 
geodatabases, tabular lists, and spreadsheets.    

HOW THEY WERE HANDLED: 

All census block submittals were loaded into a census block feature class template that included 
all of the attribute fields from the NTIA schema.  Census 2000 geography was used as required 
by NTIA.  Domain codes were entered in the appropriate attribute field for technology of 
transmission, maximum advertised downstream speed, and maximum advertised upstream speed.  
If a provider did not identify the technology of transmission for any given census block or 
blocks, they were contacted by phone or email in order to obtain this information.  In instances 
where speed information was not included in the data submission providers were contacted and 
asked to supply this data; in cases where the provider refused to give either the downstream, 
upstream, or both speeds, the lowest domain code was entered in the applicable attribute field.  
Standardized confirmation maps were created for each provider by type of technology and sent 
to the provider for review. Once processing was completed for a provider’s census block 
submission, they were run through an ESRI geoprocessing model that performed several quality 
control-quality assurance tests and selected census blocks less than or equal to two square miles 
and road segments that intersected with census blocks greater than two square miles.   

PROVIDERS SUBMITTING COVERAGE DATA: 

Provider submitted coverage data were differentiated from the other types of geographic data 
submissions coarser than a census block since they represented the full and explicit range of 
broadband coverage.  Similar to the other types of data submissions, coverage data also came in 
a wide range for formats including: analog and digital maps, CAD files, GIS shapefiles and 
geodatabases.  Coverage data was submitted by several providers or was available on several 
providers’ websites.  

HOW THEY WERE HANDLED: 

All coverage data was loaded into a coverage template feature class schema that included all of 
the attribute fields from the NTIA schema.  The method of data loading was driven by the format 
in which it was received.  Providers who supplied GIS shapefiles or feature classes could 
generally be loaded into the coverage template feature class schema using the simple data loader 
while CAD data had to be exported to GIS format prior to being loaded into the coverage 
template.  Coverage data supplied as digital or analog maps required georectification and 
digitizing prior to loading into the coverage template feature class.  Domain codes were entered 
in the appropriate attribute field for technology of transmission, maximum advertised 
downstream speed, maximum advertised upstream speed, and spectrum.  If a provider did not 
identify the technology of transmission for any given coverage area, they were contacted by 
phone or email in order to obtain this information.  When speed information was not included in 
the data submission, providers were contacted and asked to supply this data; in cases where the 
provider refused to give either the downstream, upstream, or both speeds, the lowest domain 
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code was entered in the applicable attribute field.  If a provider did not specify the type and 
spectrum used for fixed wireless the default values for unlicensed were used.  Standardized 
confirmation maps were created for each provider by type of technology and sent to the provider 
for review. Once processing was completed for a providers census block submission, they were 
run through an ESRI geoprocessing model that performed several quality control-quality 
assurance tests and selected census blocks less than or equal to two square miles whose centroid 
was within the coverage area and road segments that intersected with census blocks greater than 
two square miles were clipped to the coverage area. Providers who submitted customer locations 
typically fell into four categories.  Some were submitted as AutoCAD files where the points 
could be transferred to the GIS, then spatially joined to the census blocks they were located 
within. Others submitted maps in image format that were georectified in the same manner as 
other images, then census blocks were selected by an operator viewing the customer point 
images underlying the census blocks.  When customer lists were submitted, they were loaded in 
a database and geocoded using ESRI Business Analyst USA Geocoding engine based on 
TeleAtlas road features.  The geocoded points were subsequently treated identically to customer 
locations submitted in GIS or CAD format, and spatially joined to the census block template file. 

OTHER LEVELS OF COARSE GEOGRAPHIC SUBMISSION: 

This category had a wide range of submissions.  The most common was as telephone exchange 
areas or equivalent, wire centers, zip codes, counties or general references to towns or cities.  
The problem with these submissions was that often a given polygon overlapped a census block 
or multiple blocks, and in most cases, they were much larger geographic entities than a census 
block.    

HOW THEY WERE HANDLED: 

Operational rules established early in the project did not allow provider coverage data that 
significantly over-represent provider coverage. Those providers that submitted coverage area by 
geographic features coarser than a census block that crossed county lines were not able to be 
processed.  No interpolated data was used to calculate this data, if the data was not submitted by 
a provider in a format capable of processing the data was not calculated for that provider.  Some 
providers who submitted broader geography initially that also were represented in the last point 
of aggregation infrastructure point file were sent estimated census block coverage maps and 
spreadsheets, and provided a second submission with finer level geography.  Providers 
submitting town locations for DSL or Cable were handled differently, and used as validation for 
central offices from the last point of aggregation table, and subsequently to run the DSL 
modeling routine or validate a cable or cable plus areas.  In instances where no infrastructure was 
identified with a reliable location (no verified street address or visual location), if it was a small 
town, typically smaller than 3 miles in width or length, then the DSL model was applied. 

Final processing was the same regardless of the source process to derive provider coverage to the 
census block level.  All technology of transmission types except fixed and mobile wireless was 
handled in a similar fashion. Outstanding questions remain to NTIA about fixed wireless, as to 
whether that technology fit in table 1(A) or in 1(B).  No answer has been forthcoming, so we 
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chose to include those in table 1(B).  For DSL, Cable, Copper Wire and Fiber to the End User, 
the census block coverages were split into two categories, those less than 2 square miles, and 
those greater or equal to 2 square miles. 

Those less than 2 square miles in area were left intact as census blocks.  The census block 
coverage files greater than or equal to 2 square miles were intersected with the Tiger 2009 road 
files, splitting the Tiger road files at the census block boundary.  A subsequent spatial join 
allowed the transfer of the data attributes in the census blocks greater than or equal to 2 square 
miles to be transferred to the Tiger road segments intersecting the census block coverage.   

Based on comments made by NTIA in several of the webinar sessions, the preference was to use 
2000 census topology and 2009 Tiger road files.  The final NTIA NSGIC  geodatabase that was 
recommended by NTIA as a preferred delivery format had parsed street attribute fields in the 
geodatabase schema.  The Tiger 2000 roads had parsed street segment database fields for 
address, prefix, suffix, etc.  The Tiger 2009 road data carried these as one field labeled 
"FULLNAME".  The state does not plan to geocode using Tiger 2009 files, so it was not 
practical to do the large amount of manual work to parse the FULLNAME address field into 
individual components.  

PROCESS DESCRIPTION  
Solicit census block level broadband coverage areas from providers who initially submitted more 
generalized geographic coverage. 

Several providers initially sent coverage at a broader level of geography than required, typically 
census tracts,  telephone exchange areas, or zip codes.  With public and commercial data on 
infrastructure, DSL and Cable models were prepared for each of these providers with best 
estimates of their coverage down to the finer granularity of a census block, along with the 
standardized spreadsheets with the details on each census block in the model.  A dynamic web 
based map service was also made available to assist them in identifying census blocks and tracts 
with a Google map backdrop.  Several providers subsequently used these tools and other analysis 
to submit more detailed coverage and data attributes in a second submittal. 

PROCESS DESCRIPTION  
Model Cable coverage (technology of transmission codes 40 & 41). 

An ESRI geoprocessing model was created to generate coverage areas for Cable  providers who 
did not submit census block or coverage data (i.e., census tract providers).   

The most authoritative GIS layer available from the state with incorporated areas and city 
boundaries was used as a surrogate to model cable broadband coverage.  Municipalities and 
towns were sporadic in their digital update of these maps, since annexations and other boundary 
modifications were ongoing and difficult to maintain in real time updates.  To compensate, likely 
areas contiguous to these city boundaries were added, labeled "Cable-Plus" in the operational 
data model.  These additional polygons were determined using operator interpretation, road 
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density, structures points from Info USA in ESRI Business Analyst, and in some instances NAIP 
imagery.  In general areas were added that were immediately contiguous to existing city or town 
boundaries that represented likely areas where cable service existed. 

Cable broadband providers primarily work under the structure of franchise agreements with 
municipalities.  Phone calls were made to the largest cities in the state in order to obtain that 
respective city's cable franchise agreement. They were all either unknown or a text agreement 
without maps.   

The full set of potential cable areas were then passed through validation sources to determine if 
cable was provided.  This included public sources, such as the Warren Communications Cable 
Fact book (http://www.warren-news.com/factbook.htm). 

The second and most authoritative form of validation was data received from cable providers at 
the census tract, block, or coverage level of geography.  A spatial join geoprocessing operation 
was performed on these datasets with the full set of potential cable coverage areas in order to 
further validate areas with cable coverage.  

The third source of validation came from the public speed test site maintained throughout the 
project.  Whenever user submitted speed tests identified cable modem broadband service near or 
adjacent to existing estimated cable areas, the cable-plus boundaries were expanded using the 
same method of digitizing outlined above. 

It was not possible to differentiate between technology of transmission codes 40 and 41 using 
this indirect mapping method.  The only authoritative way to determine this information was 
from data submitted by a provider.  In all cases where the provider did not indicate the type of 
cable modem technology being used, the code for Cable Modem-Other (41) was assumed. 

PROCESS DESCRIPTION  
Model DSL coverage (technology of transmission codes 10 & 20). 

An ESRI geoprocessing model was created to generate coverage areas for DSL providers who 
did not submit census block or coverage data (i.e., census tract providers).  This model is based 
on typical DSL technology which can provide service up to 18,000 feet from a central office or 
remote terminal, unless otherwise specified by a provider.  Since DSL lines are typically buried 
alongside roadways, underneath roadbeds, or strung on aerial telephone lines which tend to run 
alongside a road,  a GIS dataset of a state’s road network could be used as a surrogate to model 
DSL areas.  Commercial (GeoTel) and publicly available data sources representing last points of 
aggregation (LPA) for DSL were collected including central offices and remote terminals.  Each 
LPA was validated based on publicly available data, provider data, and independent 
measurements; LPAs were used in a DSL model only if they were supplied directly from a 
provider or could be verified by two or more sources.  The actual geoprocessing model used the 
validated central office and remote terminal locations to generate a raster cost surface based on 
all of the available roads radiating out 18,000 feet from each active LPA point.  The raster 
coverage was converted to a polygon feature class and a small back-buffer was applied to 
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achieve the final DSL coverage polygon representing a provider’s maximum possible DSL 
coverage area.  The DSL coverage areas were then used to select intersecting census blocks and  

Remote terminals were provided or publicly available for only a small number of providers, 
therefore this method may tend to underestimate the full DSL coverage.   

It was not possible to differentiate between ADSL or SDSL based on the LPA data; the only 
authoritative way to determine this was from data submitted by a provider.  In all cases where the 
provider did not indicate which type of DSL service was being provided, the technology code 
was assigned to 10 "Asymmetric xDSL". 

PROCESS DESCRIPTION  
Public broadband data research. 

Provider presence maps were developed for central office locations and incumbent local 
exchange carrier  locations for all assumed providers in the state.  These were identified through 
a commercial spatial database purchased from GeoTel Inc., and supplemented by other public 
data sources such as the State's Public Service Commission and DSLReports.com.   These were 
intended to be "talking maps" and general intelligence on where providers have infrastructure for 
subsequent phone and written communications with providers.  These maps were compared to 
counties served by provider in the state’s telecommunications association directory.  

Web site research, review of materials submitted to the state by providers, and public websites, 
such as the FCC were researched for each provider. 

PROCESS DESCRIPTION  
Solicit census block level broadband coverage areas from providers who initially submitted more 
generalized geographic coverage. 

Several providers initially sent coverage at a broader level of geography than required, typically 
census tracts,  telephone exchange areas, or zip codes.  With public and commercial data on 
infrastructure, DSL and Cable models were prepared for each of these providers with best 
estimates of their coverage down to the finer granularity of a census block, along with the 
standardized spreadsheets with the details on each census block in the model.  A dynamic web 
based map service was also made available to assist them in identifying census blocks and tracts 
with a Google map backdrop.  Several providers subsequently used these tools and other analysis 
to submit more detailed coverage and data attributes in a second submittal. 

COMMUNITY ANCHOR INSTITUTIONS (CAI) 
 
LOGICAL CONSISTENCY REPORT  
All institutions on the initial draft spreadsheets used for the first two submittals were geocoded 
using ESRI Business Analyst Desktop with the USA Geocoding engine using TeleAtlas 
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premium road features.  This was judged to be the best available geocoding source for batch 
processing of addresses.  No commercial source is 100% accurate in a primarily rural state such 
as this with low population numbers compared to other states and no large cities or metropolitan 
statistical areas.  In every round of geocoding we used conservative matching criteria, and 
maintained and stored the type of match (building match, address match, or zip code match), 
along with a record of those not matching and not able to geocode. 
 
COMPLETENESS REPORT  
All geocoding is dependent on accurate road locations and complete and accurate street segment 
attribution.  The GIS road layers available from the state were not judged as complete as the 
premium commercial sources.  The Tiger 2009 road files, while spatially comparable to the 
commercial sources, have a large percentage of null values in the database attribution and street 
segment address ranges necessary for accurate geocoding.  As in most parts of the country, 
geocoding is more accurate in urban settings than in rural routes.  Complicating the process in a 
rural state for anchor institutions are the situation where some anchor institutions, such as public 
safety anchors are often staffed by volunteer staff and a post office box is the only valid address, 
and the physical address is wherever the public safety equipment is parked or stored at any given 
point in time. 
 
PROCESS DESCRIPTION  
Acquire lists of community anchor institutions. 
 
Lists were obtained from the state and affiliated processional organizations for anchor 
institutions to be included in the broadband mapping in each of the community anchor institution 
community code categories.   These were sorted and cross referenced and an initial round of 
elimination of duplication was accomplished. 
PROCESS DATE 2010-06-15 
 
PROCESS DESCRIPTION  
Create and publish and process user speed test web site. 
 
Created a public facing web site allowing anchor institutions to complete a brief survey and run a 
speed test on their connection using the Ookla speed test.  The speed test site allowed a user to 
enter their location as an address on a simple Google map driven interface, and subsequently 
choose to move the location if it did not geocode to their satisfaction.  Users were asked to select 
their technology of transmission from a list, enter their provider as a free text field, complete an 
optional questionnaire, and run a standard speed test on their connection.  Behind the scenes, the 
date and time, and IP address of the user were captured.   
All speed tests were geocoded, and the IP address was looked up in batch mode in the WHOIS 
database returning one or two providers registered with WHOIS.   All speed tests registered 
between March 3, 2010 and February 14, 2011 were cleaned and analyzed against provider 
submissions and models. 
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A final provider assignment was assigned by examining the WHOIS fields, and the provider 
submitted by users.   
 
There was considerable variation in the technology of transmission reported by users taking the 
speed tests.  A final connection field was created and in most cases, the user selection was 
carried into this field.  If a provider had only one confirmed technology of transmission, than all 
technologies listed by users were standardized to that, otherwise the user selection was carried.  
The state chose to not use the speed test data for an authoritative determination of the question if 
the institution subscribes to broadband service at the location.  This was due to variability in user 
responses, the anonymity of the user submission and the lack of a practical mechanism for 
authoritative user identification.  In future maintenance updates, the intent is to use the speed 
tests for anchor institutions in aggregate generalized analysis. 
 
PROCESS DESCRIPTION  
Geocode addresses and attribute anchor institutions. 
 
 All institutions on the initial draft spreadsheet were geocoded using ESRI Business Analyst 
Desktop with the USA Geocoding engine using TeleAtlas premium road features.  This was 
judged to be the best available geocoding source for batch processing of addresses.  No 
commercial source is 100% accurate in a primarily rural state such as this with low population 
numbers compared to other states and no large cities or metropolitan statistical areas.   All 
geocoding is dependent on accurate road locations and complete and accurate street segment 
attribution.  The GIS road layers available from the state were not judged as complete as the 
premium commercial sources.  The Tiger 2009 road files, while spatially comparable to the 
commercial sources, have a large percentage of null values in the database attribution and street 
segment address ranges necessary for accurate geocoding.  As in most parts of the country, 
geocoding is more accurate in urban settings than in rural routes.  Complicating the process in a 
rural state for anchor institutions are the situation where some anchor institutions, such as public 
safety anchors are often staffed by volunteer staff and a post office box is the only valid address, 
and the physical address is wherever the public safety equipment is parked or stored at any given 
point in time. 
 
PROCESS DESCRIPTION  
Assign community anchor institution category codes. 
 
Category codes were assigned based on the original source list and from keywords in the name 
of the institution and independent research.  Technology of transmission and advertised speeds 
were obtained when possible, which initially was entirely based on the anchor institutions 
maintained by the state for consortiums providing state service contracts.  Two iterations were 
accomplished with these state maintained lists, and all available attributes were obtained with 
assistance of the state analysts. 
 
PROCESS DESCRIPTION  
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Cross reference anchor institutions against public data, research data attribution and delete 
duplicates. 
 
After initial data collection, analysts worked on researching, calling and improving the addresses 
for those below an 80% match criteria.  Many on the 70 percent matching range were fairly 
accurately located.  The difference between a 70% and 80% match typically occurred when an 
address lacked a prefix or suffix cardinal direction on a street that had two cardinal directions 
(example 101 1st Street, on a street segment with 101 N. 1st Street and 101 S. 1st Street).  
Analysts were also able to obtain physical addresses for some lists supplied by the state with 
only a P.O. Box. 
 
PROCESS DESCRIPTION  
Final geocode addresses with corrections. 
 
The lists with updated and corrected addresses were re-geocoded for the final mapping effort, 
and any anchor with any level of geocoding was included on the final map.  The operational 
database identifies the type of match, so future maintenance cycles can be prioritized and 
targeted to those matching only zip codes or with address changes. 
PROCESS DATE 2010-06-15 
 
PROCESS DESCRIPTION  
Overlay all remaining anchor institution points via spatial join on broadband coverages unioned 
and dissolved by concatenated provider/technology of transmission combinations. 
 
Geocoded anchor institutions were spatially joined to unioned and dissolved concatenated 
provider/.technology of transmission combination broadband coverages.  This provided some 
level of validation that an anchor at least was located within an area of available broadband 
coverage. 
 
PROCESS DESCRIPTION  
Populate technology of transmission, availability of broadband service, and maximum advertised 
download and upload speeds. 
 
From the results of the previous step some attribution of database attributes for attributes with 
null values was accomplished.  This step was rule based.  The attribute of whether an anchor 
institution subscribes to broadband service could only authoritatively be answered yes, if the 
information was provided by the state, or a confirmation from an anchor speed test could be 
matched.  Those anchors that were located within an area covered by a DSL, cable, other copper 
or fixed wireless were also assumed to have the ability to subscribe to broadband coverage and 
were also estimated to be subscribers.  Assigning the technology of transmission and the 
advertised speeds (which required identifying a provider for the anchor institution) was only 
possible on a subset of all coverage in those areas where only one provider/technology of 
transmission was present.  This allowed a few hundred more anchors to be identified, but 
typically only occurred in rural settings.  Most urban settings had multiple providers.  In addition 
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many providers submitted multiple technology options, so identifying one provider/technology 
of transmission combination was not possible even if there was only one provider possible for 
the anchor institution. 
It is likely that in some instances in the rural settings and small towns an anchor institution may 
rely on mobile wireless broadband.  This is common in public safety mobile equipment such as 
vehicles, but likely less common in anchor facilities.  For the purpose of assigning attribution to 
anchor institutions with remaining null attributes, we took a conservative approach and did not 
overlay anchor institutions on mobile wireless coverages to assign attributes. 
 
 
PROCESS DESCRIPTION  
Maximum advertised downstream and upstream speeds were not available or collected for any of 
the CAIs.   
 
A new domain value of “U” for Unknown was added to the data model for the current 
submission, and all values formerly coded as 0, were changed to “U”. 
PROCESS DATE 2011-03-01 
 
 
PROCESS DESCRIPTION  
A new optional attribute was requested by NTIA for the current submittal requesting knowledge 
about the presence or absence of WIFI at the CAI location.   
 
This was not researched and attributed by the state in the current submission.  All records were 
set to “Unknown” for the attribute, Public Wi-Fi. 
 
 
PROCESS DESCRIPTION  
In the first two submission processes for geocoding we used conservative matching criteria, and 
maintained and stored the type of match (building match, address match, or zip code match), 
along with a record of those not matching and not able to geocode.  The current submission was 
completed by state analysts, and new additions to the list were not geocoded.  The additions of 
new anchor institutions in this submission were assigned their latitude and longitude geographic 
location based on their location used in the Montana Structures Framework. 

 
PROCESS DESCRIPTION  
 
A new optional attribute was requested by NTIA for the current submittal requesting a CAI 
unique identification number for K-12 schools, libraries and colleges and universities.  The 
following steps were completed for this request. 
 
1. Added CAIID for the Library category using a combination of the FSCSKEY and 
FSCS_SEQ number attributes from  http://harvester.census.gov/imls/data/pls/index.asp.   Added 
49 records using the Montana Structures Framework to assign their geographic location. 

http://harvester.census.gov/imls/data/pls/index.asp�
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2. Added CAIID for the University, college, other post-secondary category using the NCES 
IPEDS ID  from http://nces.ed.gov/ipeds/datacenter/.  Added 10 records using the Montana 
Structures Framework to assign their geographic location. 
3. Added CAIID for the School – K through 12 category using the NCES ID CCD ID from   
http://nces.ed.gov/ccd/bat/ .  Added 118 schools using information from the OPI Schools 
http://www.publiclibraries.com/montana.htm list, the NCES Schools List and the Montana 
Structures Framework.   NOTE: NTIA asked that each school be given a unique ID but in the 
CAI table, many schools at the same address were combined.  These were not separated for this 
round of the NTIA submittal.  

 
PROCESS DESCRIPTION  
A new optional attribute was requested by NTIA for the current submittal requesting a URL for 
each anchor institution.   
 
Assigned URLS to CAI records: for the University, college, other post-secondary category  
assigned the actual URL for that institution; for the Library category added a standard URL  
(http://www.publiclibraries.com/montana.htm); for the School – K through 12 category added 
the OPI URL (http://opi.mt.gov/Resources/Directory/Index.html); and for other institutions, 
added an appropriate URL for the type of CAI. 
 
 

WIRELESS SERVICE COVERAGE (BB_Service_Wireless ) 

 
 

LOGICAL CONSISTENCY REPORT  
Data submitted by broadband providers was accepted as is when it was provided as a broadband 
coverage or at a census block level.  Provider coverage submitted at a coarser geographic scale 
was supplemented with public data, independent measurements and GIS modeling techniques.  
When independent measurements were available for typical broadband speeds and modeled 
location of infrastructure, some provider data was overridden or supplemented. 
 
COMPLETENESS REPORT  
All data submitted by broadband providers was mapped in complete form, except where 
independent measurements were used to supplement provider submittals.  Several providers did 
not participate in the broadband mapping process, including some that were suspected to be 
providers. 
 
PROCESS DESCRIPTION  
Public broadband data research. 
 
Two forms of wireless coverage were provided in this table, fixed point to point wireless and 
mobile wireless.  Outstanding questions remain to NTIA about fixed wireless, as to whether that 

http://nces.ed.gov/ipeds/datacenter/�
http://nces.ed.gov/ccd/bat/�
http://www.publiclibraries.com/montana.htm�
http://www.publiclibraries.com/montana.htm�
http://opi.mt.gov/Resources/Directory/Index.html�
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technology fit in table 1(A) or in 1(B).  No answer has been forthcoming, so we chose to apply 
those in table 1(B).   No public data was located on fixed wireless infrastructure points, except 
notification of availability on provider's web pages, and in some instances, specific towns, 
recreation or commercial locations where wireless service was provided.  No modeling was 
attempted on fixed wireless coverage.  All coverage came directly from providers or was mapped 
from locations provided on a provider web page.  We did not attempt any propagation modeling 
on fixed wireless, since that can be influenced by local structures and vegetation in the vicinity.  
A few providers did provide coverages that appeared to be derived from propagation modeling. 
Most of the public data research focused on mobile wireless providers using cellular service 
spectrums.  The Federal Communications Commission (FCC) Universal Licensing System 
(ULS) is the consolidated database and application filing system for most Wireless Radio 
Services. ULS supports electronic filing and provides public access to licensing information, 
weekly Public Notices, FCC rulemakings, processing utilities, a telecommunications glossary, 
and much more." The FCC ULS Advanced Licensing Search was queried for all FCC licenses 
filed in the state; a relational database was built from the results. Information from the database 
was extracted in order to perform the cellular tower propagation modeling for wireless 
broadband. 
The FCC ALS and ULS reporting systems were the source for most of the tower locations.  
Towers were required to be licensed when they meet specific published criteria.  These included 
some variables that could be modeled with GIS statewide, such as varying proximity to airports 
and heliports, combined with specific local level criteria not easily obtained or modeled 
statewide such as the grade construction within proximity of these, and any structure over 200 ft 
in height.  A number of cell towers providing broadband were likely not located in the FCC 
database.  None of the mobile wireless providers were willing to provide infrastructure such as 
tower locations and parameters, and the coverages provided were very generalized. 
The mobile wireless coverage in the state is in transition.  There were currently no GSM mobile 
wireless providers meeting the NOFA criteria for being a provider.  There is some GSM 
infrastructure in the state maintained for wholesale arrangements and roaming users with GSM 
technology.   

 
PROCESS DESCRIPTION  
Create and publish user speed test web site. 
 
A public facing website was created in the spring of 2010 asking internet users in the state to 
complete a brief survey regarding their internet connection and run a speed test on their 
connection using the Ookla speed test.  The speed test site asked that a user enter their location 
as an address on a Google map interface.  If the address did not geocode to their satisfaction, the 
user could choose to move the place mark to their desired location.  Next, users were asked to 
select their technology of transmission from a list, enter their provider in a free form text field, 
complete an optional questionnaire, and run a standard speed test on their connection.  The date 
and time, and IP address of the user were captured during the speed test.   
 
All speed tests were geocoded, and the IP address was looked up in batch mode in the WHOIS 
database returning one or two providers registered with WHOIS.   All speed tests registered 
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between March 3, 2010 and May 14, 2010 were cleaned and analyzed against provider 
submissions and models for the first and second data submissions.  For the current (third) 
submission, all the data between March 3, 2010 and February 15, 2011 was standardized and 
used.  
 
For the first two submissions a final provider assignment was assigned by examining the WHOIS 
fields, and the provider submitted by users.  Consistent rules were not always possible, but 
generally when two WHOIS records were returned, the second more specific WHOIS provider 
was selected. In some instances, where the WHOIS providers were backhaul or other and were 
not providers meeting the NOFA criteria, the user submitted provider designation was cleaned 
and standardized and assigned as the final provider.  For the current submission a rule based 
database program was built by the Montana Dept. of Administration to automate the final 
provider assignment. 
 
There was considerable variation between the user reported technology of transmission (TOT) 
and the known technologies for any given provider.  Records were divided on unique provider/ 
TOT combinations for the first and second submissions, which limited the record count in many 
instances.  For the current submission the records were divided only by provider, not taking TOT 
into consideration.  
 
For the first two submissions, the speed test records were used in two ways for the final 
processing. 
 
1) As an independent measurement to validate the presence/absence of a provider coverage for 
DSL and/or Cable technologies. 
In the first submission a few providers were identified as DSL broadband providers based 
primarily on speed tests.  In these instances, DSL models were executed for both providers based 
on verified central office locations.  Some Speed tests with an identified technology of 
transmission of Cable Modem were used to expand “likely” cable areas which were typically 
adjacent to incorporated and urban areas.  These “cable-plus” areas were created to supplement 
submissions from Cable Modem providers who did not provide detailed coverage or census 
blocks.  No new DSL providers or Cable providers were identified using speed tests in the 
current submission. 
 
2) As an independent measurement for typical upload and download speeds. 
Once data were cleaned and final provider and technology of transmission assigned, these fields 
were concatenated.  In the first two submissions, if the remaining records exceeded 10 for the 
combination of provider and technology, and the speed test was successfully completed (values > 
0) the average value and standard deviation of the download speed were calculated.  Any values 
exceeding 1 standard deviation were removed as outliers, and the mean of the remaining records 
within 1 standard deviation was calculated for the download and upload speed. This value was 
reported for each provider/technology of transmission record as the typical speeds for that 
provider.  In some instances the typical speed was lower than that required to meet the definition 
of broadband by NTIA, but that did not preclude the records from being included in the 
broadband map in the first two submissions as it did in the current submission. 
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For the current submission, these procedures were modified and all records were re-run.  The 
steps of the current processing are provided below.  The primary procedural change was to drop 
the validation of the presence/absence of provider coverage for DSL and/or Cable technologies, 
since providers had been validated in the first two submissions and potential new providers 
identified through additional speed tests were determined to not meet the NOFA criteria for 
being considered a broadband provider.  The use of the speed test data for determining typical 
speeds was implemented with similar rules as the first two submissions with the exception of the 
use of the technology of transfer, and raising the minimum number of speed tests to 15, after 
removing outliers, to be used in typical speed calculations.  Procedurally, the process was also 
automated with a Python script to improve processing performance and minimize quality 
control/quality assurance testing.   
 
Typical upload and download speeds for all providers with less than 15 processed speed test 
records were coded as null values.  In addition, based on telephone communication with NTIA 
on March 9, 2011, all typical speeds less than minimum NOFA upload of download speed 
criteria were also ignored and reported as null.  Based on a related request in the same 
communication, the typical speeds greater than the advertised speeds were ignored and reported 
as null.  Subsequently on March 17, in the NTIA grantee webinar, the NTIA staff indicated that 
typical speeds would not be compared to advertised speeds.  This rule change was not received 
in time to implement in the workflow for the current submission, and will be implemented in the 
fourth submission in the fall, 2011.  We anticipate other significant modifications in the use of 
the speed test data for the next submission, since many of the records older than one year will not 
be used in future calculations. 
 
Processing steps for the current submission are provided below: 
1. Speed test records were imported into a SQL Server data file, adding fields Final Provider 

and IPGroup to the initial records. 
2. IPGroup attribute was set by extracting the left three nodes of the IP Address of the speed 

test (e.g. 161.7.1.236 had 161.7.1) moved to the IPGroup attribute. 
3. An IPGroup to Final Provider cross reference table was created to determine the final 

provider from the unique three part IPGroup (e.g. 161.7.1 is known to be the State of 
Montana).  

4. Each IPGroup was reviewed with the data in the who is 1 provider, who is 2 provider and 
then the user specified provider to determine the most authoritative final provider from the 
official list of providers.  None of the WHOIS or user submitted fields were absolutely 
authoritative in all instances, so expert opinion by technicians knowledgable of the providers 
was used in some instances to assign the IPGroups, and subsequently the  Final Provider 
attribute. 

5. Run a python script to remove outliers and calculate summary statistics for each Final 
Provider assignment.  The rationale for removing outliers was to mitigate the many variables 
that effect a typical speeed test, such as the time of day, others on the network, etc.  The 
script implemented the following work flow rules: 

a. Use all records for each unique FinalProv attribute value with D_kbps greater than 0 or  
U_kbps greater than 0 , then: 

b. Calculate a mean for the unique provider group for each D_kbps and U_kbps. 
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c. Calculate a standard deviation for the unique provider group for each D_kbps and U_kbps.  
Each speed attribute was calculated independently of the other. 

d. Subtract the outliers (if any) higher or lower than one standard deviation from the mean. 
e. Calculate the median value of the remaining non-outliers for each provider D_kbps and 

U_kbps respectively. 
f. Create a summary table with the final calculated assignment of FinalProv, D_kbps and 

U_kbps. 
6. Post process the summary table in the following sub steps: 
a. Join the summary tables by provider for the upload and download speeds into one summary 

file including the number of records or frequencies for up and down speeds for each provider 
after removing the outliers, and the mean up and down speeds in kilobits per second for each 
provider. 

b. Select "FreqDown" < 15 AND "FreqUp" < 15 then delete the resulting selection set from the 
joined table.  The FreqDown/Up fields counted the number of speed test records for a 
provider after the outliers more or less than one standard deviation from the mean value were 
removed from consideration. 

c. Select "D2_kbps" <= 768 kbps AND "U2_kbps" <= 200 kbps. then delete the resulting 
selection set from the joined table.   

7. Import the remaining valid mean values for each provider into the appropriate broadband 
coverage feature classes. 

8. Select any typical speeds greater than advertised speeds either up or down, and make the 
resulting records null in the final broadband coverage feature classes (as per NTIA request 
3/9/2011). 

 
PROCESS DESCRIPTION  
Creation, processing and maintenance of last point of aggregation for infrastructure. 
 
Any fixed or mobile wireless antenna or tower location submitted by a provider, or obtained 
from the FCC that was used in the final processing for wireless broadband coverage was 
maintained in the operational database for last point of aggregation, and subsequently transferred 
to Table 3 backhaul and middle mile points. 
 
PROCESS DESCRIPTION  
Solicit broadband coverage areas, infrastructure, advertised and typical speeds and components 
of subscriber weighted nominal speed from providers. 
 
Requests were made via email and phone calls to every broadband provider to provide coverage, 
technology of transmission, advertised and typical download and upload speed at the census 
block level. 
 
All data types were accepted as submittals and a large variety of data were submitted, including 
narrative descriptions, coverage maps as JPG or PDF images, CAD files, GIS shapefiles, KMZ 
and KML files, FCC form 477 reports , and data spreadsheets.     
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Providers that submitted actual broadband coverage data or census block representation of 
coverage along with the components necessary to complete the data attribution were not 
contacted for a follow up.  The providers who did not submit data based on initial queries were 
sent a standardized spreadsheet to map their coverage and optionally infrastructure, and 
subsequently a final notice email. 
 
PROCESS DESCRIPTION  
Fixed Wireless.   
 
Providers submitted coverage data in a wide variety of formats, levels of completeness, and at 
varying geographic scales. All types of data was accommodated and processed whenever 
possible. An open structure process for submittals was allowed, accepting any data, and 
attempting to work with the provider when questions arose. If data was submitted by a provider 
in a format that did not allow a direct coverage to be mapped, such as a coarse level of 
geography such as a census tract, or county, feedback was provided to the providers in the form 
of standardized spreadsheets in an attempt to standardize the inputs, and increase the geographic 
granularity of the provider data submission. Although each provider had individual 
characteristics and nuances in their data submissions, some data patterns can be described 
generalizing the typical types of submissions. In general, for fixed wireless to be mapped it was 
necessary to receive data from a provider, since there were no public sources available on point 
to point wireless tower locations in public form, except as depicted on providers web pages in a 
few instances.  
 
FCC FORM 477 REPORT OR SIMILAR FORMAT:  
Geographically, these were lists of census tracts of coverage, accompanied by additional 
documentation on technology of transmission, speed tiers, and number of customers. Providers 
submit these twice a year to the FCC and recent submissions have been done using a structured 
web site maintained by the FCC. A few providers submitted printouts that appeared to be from 
this web format and were typically complete and standardized. More providers submitted 
spreadsheets roughly in the F477 format, but with modified and generalized data.  
 
HOW THEY WERE HANDLED:  
If the providers identified specific coverage areas as census blocks, or direct coverage area, or as 
infrastructure tower locations, they were processed and mapped. Providers identifying census 
blocks were processed by dissolving the census blocks into single coverage polygons by speed 
tier. Providers identifying a direct coverage area were converted directly to GIS polygon files 
and attributed. Providers submitting tower locations were mapped as circular polygons centered 
on the tower with a radius averaging 10 miles measured as Euclidian (straight line) distance from 
the tower. Providers that specified variable radius were mapped as circles at the radius they 
submitted.  
 
PROVIDERS SUBMITTING CENSUS BLOCK COVERAGE:  
A few providers submitted coverage as census blocks, either through a tabular listing of census 
blocks or spreadsheet, or in map format. It was common that a provider where public data 
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indicated multiple technologies of transmission only submitted some of the technologies of 
transmission.  
 
HOW THEY WERE HANDLED:  
These were loaded directly into the master Census 2000 block coverage by provider and 
attributed with available data submitted by the provider. In instances where some data attributes 
were missing, such as advertised or typical speed tiers, or subscriber data, the data attributes 
were left blank or null. Providers identifying census blocks were processed by dissolving the 
census blocks into single coverage polygons by speed tier. A visual inspection of independent 
speed test data overlaying the provider submitted block coverage was completed, but no action 
was taken to override a provider's submittal.  
 
PROVIDERS SUBMITTING ACTUAL COVERAGE MAPS:  
Coverage maps were submitted by several providers, or coverages were derived from public 
sources or from other indirect indicators of coverage such as customer point maps or tabular lists 
in text or spreadsheet format. These were differentiated from the other types of geographic 
submission coarser than a census block since they represented the full and explicit range of 
coverage.  
 
HOW THEY WERE HANDLED:  
Coverage maps were treated as explicit coverage and all census blocks intersecting any portion 
of a coverage were selected and attributed with the provider coverage by technology of 
transmission, and all related attributes were transferred to the census block representation. The 
method of creating the coverage varied by source. Providers who supplied broadband coverage 
as a GIS polygon or CAD feature were converted to polygons. Some providers, including non-
responsive providers who did not submit anything to the project, had published coverage maps of 
various forms on their web sites or submitted an image in jpg, tiff, pdf or other graphic format. 
These were geogeorectified to base map layers, typically roads, but sometimes other features 
such as state or county boundaries or towns, and subsequently converted to polygon features. 
Then they were intersected and transferred to census block feature classes like the digital GIS 
submissions. Providers who submitted customer locations typically fell into four categories. 
Some were submitted as AutoCAD files where the points could be transferred to the GIS, then 
spatially joined to the census blocks they were located within. Others submitted maps in image 
format that were georectified in the same manner as other images, then census blocks were 
selected by an operator viewing the customer point images underlying the census blocks. When 
customer lists were submitted, they were loaded in a database and geocoded using ESRI 
Business Analyst USA Geocoding engine based on TeleAtlas road features. The geocoded points 
were subsequently treated identically to customer locations submitted in GIS or CAD format, 
and spatially joined to the census block template file. A visual inspection of independent speed 
test data overlaying the provider submitted block coverage was completed, but no action was 
taken to override a provider's submittal.  
 
OTHER LEVELS OF COARSE GEOGRAPHIC SUBMISSION:  
This category had a wide range of submissions. The most common was as telephone exchange 
areas or equivalent, wire centers, zip codes, counties or general references to towns or cities. The 
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problem with these submissions was that often a given polygon overlapped a census block or 
multiple blocks, and in most cases, they were much larger geographic entities than a census 
block.  
 
HOW THEY WERE HANDLED:  
Our operating rules established early in the project did not allow final provider coverage to 
significantly over represent provider coverage. Those providers that submitted coverage area by 
coarse geographic features and did not specifically identify coverage as a coverage layer or 
census blocks were not able to be processed. No interpolated data was used to calculate these 
data, if the data was not provided by a provider in a format capable of processing; the data was 
not calculated for that provider. 

 
PROCESS DESCRIPTION  
Mobile Wireless Verizon. 
   
Where cell tower locations for specific providers could be consistently identified, propagation 
models of wireless coverage were developed for mobile wireless.  SoftWright's Terrain Analysis 
Package software with the Longley-Rice algorithm for model development was used to develop 
the models. The models were constrained in a 25 radius of the tower. Output grid size was .5 
kilometers. Areas that had coverage with signal strength above 40 dbu was classified as having 
broadband availability. All propagation data meeting the above criteria were merged into a single 
geodatabase. Non- contiguous areas of less than .5 kilometers were removed from the coverage 
to climate scatter that was deemed to be an artifact of data processing limitations.   Verizon 
Wireless was the only provider where this method was possible to apply. A mobile wireless 
coverage was not provided by Verizon for the June, 2010 submission.  In August, 2010 Verizon 
provided a coverage that used an estimated one-quarter mile raster resolution, and the digital 
elevation model TetraTech used for this analysis and propagation modeling was based on 30 
meter resolution. As a result individual TetraTech's coverage for Verizon shows a slightly more 
spotty pattern where influenced by local topographic characteristics. Due to some missing or 
unidentifiable towers, we anticipate that coverage may exist in some areas that were not 
indicated as coverage. Feedback from Verizon is needed to resolve differences, and is scheduled 
for the 2011 updates.  As a result, in the September, 2010 update we submitted the actual 
coverage provided by Verizon, replacing the TetraTech model submitted in June.  Provider 
submittals did not differentiate download or upload speeds by tower location, only statewide. 
The typical upload and download speeds for Verizon were reported based on the mean upload 
and download point samples from several hundred thousand speed test samples, averaged 
statewide. Since tower identification numbers are rotated by providers, it was not possible, 
without provider data input, to validate 3G speed availability on a tower by tower basis. CDMA 
technology does allow a switch from 2G to 3G via software, so it is more likely that most if not 
all CDMA towers in the state can theoretically provide broadband coverage.  An adequate 
number of speed tests were received for Verizon wireless, but the RootWireless data was more 
robust and hundreds of thousands of sample points were available, so the public speed test 
submittals were not used for this provider. All mobile wireless coverage were processed as single 
coverage files. All polygons had the same data attributes carried in all polygons.  For the third 



Montana Broadband Mapping 
March 24, 2011 Methodology Report 

 
Tetra Tech EC Inc.    3/24/2011 
 
  24 

submission, April 2011 Verizon submitted a new and slightly revised wireless coverage map that 
was used for the submittal.   
 
PROCESS DESCRIPTION  
Mobile Wireless Alltel.  
 
Alltel did not provide a mobile wireless coverage in any form for Montana.   We did not have 
independent measurements for this provider that could reliably be used. Rootwireless drove 
several thousand miles on state and federal highways in the state and provided ongoing point 
samples from several handsets with speed tests every 2 min and signal strength every 10 seconds 
during operation. Provider submittals did not differentiate download or upload speeds by tower 
location, only statewide. The typical upload and download speeds for Verizon were reported 
based on the mean upload and download point samples from several hundred thousand speed test 
samples, averaged statewide. Since tower identification numbers are rotated by providers, it was 
not possible, without provider data input, to validate 3G speed availability on a tower by tower 
basis. CDMA technology does allow a switch from 2G to 3G via software, so it is more likely 
that most if not all CDMA towers in the state can theoretically provide broadband coverage.  For 
the first and second and third submissions, June and September, 2010 and April, 2011, a coarse, 
generalized map available in Alltel retail outlets and on their web site was used as a base for their 
mobile wireless coverage.  The image was georectified and used in heads up digitizing to select 
6th code watersheds obtained from the Montana State Library, that matched the Alltel coarse map 
coverage as closely as possible.  With the coarse nature of the small scale Alltel map, we 
determined that an established map layer with appropriate sized polygons that could be mapped 
in a consistent and repeatable manner would be the best way to depict Alltel mobile wireless 
coverage.  The minimum number of speed tests from the public speed test site was not achieved 
for mobile wireless to allow independent typical speed measurements for Alltel, so those remain 
null values in Montana. All mobile wireless coverage were processed as single coverage files. 
All polygons in the two mobile provider coverage in the state had the same data attributes carried 
in all polygons.   
 
PROCESS DESCRIPTION  
Satellite 
 
The parameters below show the satellite wireless models for MT.   A few satellites are use the 
same azimuth and altitude, so they only need to be run once and subsequently copied and 
renamed for different providers.  There was one coverage for WildBlue and Starband, and four 
coverage for Hughes/DirectTV.  The Anik-F2 satellite appears to be shared by Hughes and 
WildBlue coverage, and was listed under both. 
 
The process included running  a hillshade with the parameters shown below, selecting the 
"Model shadows" parameter.  This was reclassed into 3 classes 0,1,Max value.  Then the 
Majority filter model in Spatial Analyst Generalization was run with a 4x4 neighborhood grid to 
filter out the smallest isolated shadow pixels.  A conditional selection of the class 0 (shadow 
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values) was made for the final grid.  This was run through a raster to polygon conversion and 
added to the master coverage template from geodatabase.   
 
Provider Satellite Azimuth Altitude Operator 
     
Hughes / DirectTV     
 Anik-E2 141.6 33.7 Telesat Canada Ltd. 
 Anik-F2 181.8 36.13 Telesat Canada Ltd. 
 Spaceway-1 170.6 35.68 Direct TV, Inc. 
 Spaceway-3 160.1 34.17 Hughes Network Systems 
WildBlue     
 Anik-F2 181.8 36.13 Telesat Canada Ltd. 
 Wildblue 1 181.8 36.1 Wildblue Communications 
Starband     
 Echostar 9 195.1 35.03 Echostar Technologies, LLC 
 
PROCESS DESCRIPTION  
Quality assurance testing. A separate analyst checked each provider submission. Due to the 
variety of provider submissions, the analyst originally doing the work and the analyst checking 
discussed the interpretations when the criteria were subject to interpretation. Coverage, 
technology of transmission, and speed tier were checked completely for each provider. 
 

SPEEDTEST DATA PROCESSING 
 
PROCESS DESCRIPTION  
Create and publish and process user speed test web site. 

A public facing website was created in the spring of 2010 asking internet users in the state to 
complete a brief survey regarding their internet connection and run a speed test on their 
connection using the Ookla speed test.  The speed test site asked that a user enter their location 
as an address on a Google map interface.  If the address did not geocode to their satisfaction, the 
user could choose to move the place mark to their desired location.  Next, users were asked to 
select their technology of transmission from a list, enter their provider in a free form text field, 
complete an optional questionnaire, and run a standard speed test on their connection.  The date 
and time, and IP address of the user were captured during the speed test.   

All speed tests were geocoded, and the IP address was looked up in batch mode in the WHOIS 
database returning one or two providers registered with WHOIS.   All speed tests registered 
between March 3, 2010 and May 14, 2010 were cleaned and analyzed against provider 
submissions and models for the first and second data submissions.  For the current (third) 
submission, all the data between March 3, 2010 and February 15, 2011 was standardized and 
used. 
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For the first two submissions a final provider assignment was assigned by examining the WHOIS 
fields, and the provider submitted by users.  Consistent rules were not always possible, but 
generally when two WHOIS records were returned, the second more specific WHOIS provider 
was selected. In some instances, where the WHOIS providers were backhaul or other and were 
not providers meeting the NOFA criteria, the user submitted provider designation was cleaned 
and standardized and assigned as the final provider.  For the current submission a rule based 
database program was built by the Montana Dept. of Administration to automate the final 
provider assignment. 

There was considerable variation between the user reported technology of transmission (TOT) 
and the known technologies for any given provider.  Records were divided on unique provider/ 
TOT combinations for the first and second submissions, which limited the record count in many 
instances.  For the current submission the records were divided only by provider, not taking TOT 
into consideration.  

For the first two submissions, the speed test records were used in two ways for the final 
processing. 

1) As an independent measurement to validate the presence/absence of a provider coverage for 
DSL and/or Cable technologies. 

In the first submission a few providers were identified as DSL broadband providers based 
primarily on speed tests.  In these instances, DSL models were executed for both providers based 
on verified central office locations.  Some Speed tests with an identified technology of 
transmission of Cable Modem were used to expand “likely” cable areas which were typically 
adjacent to incorporated and urban areas.  These “cable-plus” areas were created to supplement 
submissions from Cable Modem providers who did not provide detailed coverage or census 
blocks.  No new DSL providers or Cable providers were identified using speed tests in the 
current submission. 

2) As an independent measurement for typical upload and download speeds. 

Once data were cleaned and final provider and technology of transmission assigned, these fields 
were concatenated.  In the first two submissions, if the remaining records exceeded 10 for the 
combination of provider and technology, and the speed test was successfully completed (values > 
0) the average value and standard deviation of the download speed were calculated.  Any values 
exceeding 1 standard deviation were removed as outliers, and the mean of the remaining records 
within 1 standard deviation was calculated for the download and upload speed. This value was 
reported for each provider/technology of transmission record as the typical speeds for that 
provider.  In some instances the typical speed was lower than that required to meet the definition 
of broadband by NTIA, but that did not preclude the records from being included in the 
broadband map in the first two submissions as it did in the current submission. 

For the current submission, these procedures were modified and all records were re-run.  The 
steps of the current processing are provided below.  The primary procedural change was to drop 
the validation of the presence/absence of provider coverage for DSL and/or Cable technologies, 
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since providers had been validated in the first two submissions and potential new providers 
identified through additional speed tests were determined to not meet the NOFA criteria for 
being considered a broadband provider.  The use of the speed test data for determining typical 
speeds was implemented with similar rules as the first two submissions with the exception of the 
use of the technology of transfer, and raising the minimum number of speed tests to 15, after 
removing outliers, to be used in typical speed calculations.  Procedurally, the process was also 
automated with a Python script to improve processing performance and minimize quality 
control/quality assurance testing.   

Typical upload and download speeds for all providers with less than 15 processed speed test 
records were coded as null values.  In addition, based on telephone communication with NTIA 
on March 9, 2011, all typical speeds less than minimum NOFA upload of download speed 
criteria were also ignored and reported as null.  Based on a related request in the same 
communication, the typical speeds greater than the advertised speeds were ignored and reported 
as null.  Subsequently on March 17, in the NTIA grantee webinar, the NTIA staff indicated that 
typical speeds would not be compared to advertised speeds.  This rule change was not received 
in time to implement in the workflow for the current submission, and will be implemented in the 
fourth submission in the fall, 2011.  We anticipate other significant modifications in the use of 
the speed test data for the next submission, since many of the records older than one year will not 
be used in future calculations. 

Processing steps for the current submission are provided below: 

1. Speed test records were imported into a SQL Server data file, adding fields Final Provider 
and IPGroup to the initial records. 

2. IPGroup attribute was set by extracting the left three nodes of the IP Address of the speed 
test (e.g. 161.7.1.236 had 161.7.1) moved to the IPGroup attribute. 

3. An IPGroup to Final Provider cross reference table was created to determine the final 
provider from the unique three part IPGroup (e.g. 161.7.1 is known to be the State of 
Montana).  

4. Each IPGroup was reviewed with the data in the who is 1 provider, who is 2 provider and 
then the user specified provider to determine the most authoritative final provider from the 
official list of providers.  None of the WHOIS or user submitted fields were absolutely 
authoritative in all instances, so expert opinion by technicians knowledgable of the providers 
was used in some instances to assign the IPGroups, and subsequently the  Final Provider 
attribute. 

5. Run a python script to remove outliers and calculate summary statistics for each Final 
Provider assignment.  The rationale for removing outliers was to mitigate the many variables 
that effect a typical speeed test, such as the time of day, others on the network, etc.  The 
script implemented the following work flow rules: 



Montana Broadband Mapping 
March 24, 2011 Methodology Report 

 
Tetra Tech EC Inc.    3/24/2011 
 
  28 

a. Use all records for each unique FinalProv attribute value with D_kbps greater 
than 0 or  U_kbps greater than 0 , then: 

b. Calculate a mean for the unique provider group for each D_kbps and U_kbps. 

c. Calculate a standard deviation for the unique provider group for each D_kbps and 
U_kbps.  Each speed attribute was calculated independently of the other. 

d. Subtract the outliers (if any) higher or lower than one standard deviation from the 
mean. 

e. Calculate the median value of the remaining non-outliers for each provider 
D_kbps and U_kbps respectively. 

f. Create a summary table with the final calculated assignment of FinalProv, D_kbps 
and U_kbps. 

6. Post process the summary table in the following sub steps: 

a. Join the summary tables by provider for the upload and download speeds into one 
summary file including the number of records or frequencies for up and down 
speeds for each provider after removing the outliers, and the mean up and down 
speeds in kilobits per second for each provider. 

b. Select "FreqDown" < 15 AND "FreqUp" < 15 then delete the resulting selection 
set from the joined table.  The FreqDown/Up fields counted the number of speed 
test records for a provider after the outliers more or less than one standard 
deviation from the mean value were removed from consideration. 

c. Select "D2_kbps" <= 768 kbps AND "U2_kbps" <= 200 kbps. then delete the 
resulting selection set from the joined table.   

7. Import the remaining valid mean values for each provider into the appropriate broadband 
coverage feature classes. 

8. Select any typical speeds greater than advertised speeds either up or down, and make the 
resulting records null in the final broadband coverage feature classes (as per NTIA request 
3/9/2011). 

 
Quality Assurance Testing 
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A separate analyst checked each provider submission.  Due to the variety of provider 
submissions, the analyst originally doing the work and the analyst checking discussed the 
interpretations when the criteria were subject to interpretation. 

Coverage, technology of transmission, and speed tier were checked completely for each 
provider.  

Many of the models and block, tract and coverage level processes were completed with ESRI 
Modelbuilder and Python scripts, and these methods were tested for quality assurance in the 
preliminary mapping stages and in the initial sample data submissions to NTIA. 

All providers who submitted geographic coverage coarser than a census block were provided a 
data checking package to assess for accuracy and completeness.  Any comments received from 
providers were processed. 

1. QA/QC Checks prior to Individual Data Processing (i.e., block or coverage geoprocessing 
model).  [Automated Modelbuilder tools and follow-up by an analyst] 

a. Check for inconsistencies within the Provider Name, DBA Name, FRN 
b. Check for duplicate census blocks or coverage areas 
c. Check the Provider Name, DBA Name, FRN against the “Official Provider 

Table” 
 

2. For each provider after initial data processing is completed [Review by an analyst that did 
not process the original data] 

a. Review correspondence log 
i. Review recent correspondence, since previous NTIA submission 

ii. Note changes/additions/comments on coverage area, technologies, speeds, 
infrastructure, subscriber weighted nominal speeds (SWNS) 

b. Review wiki data processing page (current metadata)    
i. Note changes/additions/comments on coverage area, technologies, speeds, 

infrastructure, SWNS 
c. Review individual Provider Wiki page (historic metadata)     

i. Note changes/additions/comments on coverage area, technologies, speeds, 
infrastructure, SWNS 

d. Check Provider Data Folder 2011_03          
i. Review recent data submissions, since previous NTIA submission 

e. Check Working Data Folder 2011_03  
i. Review current update feature class geography 

ii. Review coverage with provider’s submissions 
iii. Review technology of transmissions (TOTs) with provider’s 

submissions      
iv. Review Max Adv Speeds: Down/Up with provider’s submissions        
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3. For each provider after final data processing is completed [Review by an analyst that did not 
process the original data] 

a. Check PROVCOV_Master geodatabase:Provider Blocks feature class and/or 
Provider Coverage feature class 

i. Review geography 
ii. Review TOTS 

iii. Review Max Adv Speeds: Down/Up 
 

4. Check Infrastructure feature class [Review by an analyst that did not process the original 
data] 

a. Review recent submissions, since previous NTIA submission 
 

5. Check SWNS feature class [Review by an analyst that did not process the original data] 
a. Determine if provider submission is valid 

 
6. For each provider after speed tests are processed [Review by an analyst that did not process 

the original data] 
a. Check PROVCOV_Master geodatabase  for Typical Speeds: Down/Up        

 

7. QA/QC Checks and Reports on the Final NTIA Deliverable [Automated Modelbuilder tools 
and follow-up by an analyst] 

a. Check the Provider Name, DBA Name, FRN against the “Official Provider 
Table” for each NTIA feature class (i.e., BB_Service_CensusBlock, 
BB_Service_RoadSegment, BB_Service_Wireless, etc.).   
NTIA_Provider_Name_DBA_FRN_Errors_Sample.xls, looks at each NTIA 
feature class (i.e., census blocks, road segments, wireless, etc…) and checks to 
see if there is an identical match in the “Official Provider Table.”  If an identical 
match does not exist for that Provider Name, DBA Name, FRN concatenation it is 
written to a geodatabase table along with the NTIA feature class where the “error” 
occurred.  When an “error” does occur it then has to be checked by an analyst and 
corrected if necessary. 

b. Change Detection Report – This geoprocessing model compares and reports any 
changes in the Census Block, Road Segment, and Wireless feature classes for the 
current and previous versions of the NTIA SBDD Transfer database. The user 
needs to supply the feature classes for each NTIA version as well as the name of 
the final change detection table.  NTIA_Change_Detection_Example.xls, 
compares and reports any changes (limited to Provider Name, DBA Name, FRN, 
TOT combinations) in the Census Block, Road Segment, and Wireless feature 
classes for the current and previous versions of the NTIA SBDD Transfer 
database.  If the final change detection table has no records, then no changes were 
detected between the two databases.  If a Provider Name, DBA Name, FRN, TOT 
combination does not have a “pair” in either direction (the current or previous 
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NTIA database) then it is written to a geodatabase table along with the NTIA 
feature class and version where the “error” occurred.  This report does not change 
any data in either database but rather acts as a flag, requiring an analyst to check 
if the “error” is valid.   

c. Check for duplicate census blocks or road segments or wireless coverage areas. 
d. Check for duplicate anchor institution points. 

 
8. Review Final NTIA deliverables [Review by an analyst that did not process the original data] 

a. Review BB_ConnectionPoint_MiddleMile 
b. Review BB_Service_CAInstitutions 
c. Review BB_Service_Census Block 
d. Review BB_Service_Overview 
e. Review BB_Service_RoadSegment 
f. Review BB_Service_Wireless      

 

9. Run the NTIA Check submission tool and python tool to confirm that all possible records 
passed the NTIA data checks.  The only items that failed in the checking process were those 
where inconsistencies in the final NTIA NSGIC data model did not agree with the final 
documentation and rules established by NTIA and FCC in the final webinar and 
documentation presented March 17, 2011.  These exceptions were documented along with 
the submission. 
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Executive Summary 
 

The e-NC Authority 
The e-NC Authority, created by the N.C. General Assembly under Session Law 2003-425, is dedicated to 
growing local-level wealth and creating jobs and educational opportunity through increased broadband 
deployment. Mandated as the primary Internet policy and planning body for the state, e-NC works with 
citizens, broadband service providers, local and state government and partners across the state. Its 
responsibilities include: 

• Serving as the Broadband Authority for the state, with a focus on rural and urban-distressed 
areas; 

• Conducting research to help guide the state in economic development decision-making; 
• Mapping of broadband infrastructure in North Carolina per the requirements of the National 

Telecommunications & Information Administration (NTIA); 
• Providing Technical Assistance to communities and organizations; 
• Responding to citizen inquiries; 
• Facilitating local-level programs on technology-based economic development (i.e. the e-NC 

Business & Technology Telecenters); and  
• Serving as a grant-making and monitoring organization. 

 

e-NC finds and advocates for solutions to ensure that all North Carolina citizens and businesses increase 
broadband adoption and usage and have equal access to affordable, high-speed broadband. e-NC also 
promotes the benefits of broadband investments around commerce, education, healthcare, agriculture 
and government services to demonstrate greater economic opportunities. e-NC serves as a resource and 
manager for various statewide broadband initiatives and accomplishes its work through public-private 
partnerships, targeted research and direct outreach and education. Currently, the e-NC Authority is 
implementing a five-year project under the NTIA of the U.S. Department of Commerce.  

North Carolina's SBDD Grant 
The e-NC Authority (through its fiscal agent, the Rural Economic Development Center), is the recipient of 
the NTIA’s State Broadband Data and Development Grant for North Carolina. The SBDD grant program 
enables North Carolina to collect comprehensive and accurate state-level broadband availability data 
and to display a state-level broadband map (http://e-ncbroadband.org/), with these efforts aimed at 
aiding in the development and maintenance of the national broadband map. The e-NC Authority is 
currently using provider data for its map, but is also evaluating other data collection methodologies 
including Web crawling techniques and collecting broadband consumer data at the local level.  In 
addition, e-NC uses radio wave propagation prediction modeling (using GIS) to reflect wireless coverage 
in North Carolina. Initial broadband planning funds for the project were used to conduct the 2010 
Citizen Survey on broadband usage in North Carolina and the 2010 e-Strategy Survey of businesses, 
organizations, and households looking at broadband usage and benefits among industry sectors. In 
addition to the data collection, validation and display work; and the initial broadband planning surveys, 
the SBDD funding allows e-NC to undertake the following additional programs: state broadband capacity 

http://e-ncbroadband.org/�
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building, a technical assistance program, a Lifeline Online pilot to improve computer ownership and 
Internet usage (LITE-UP), and funding to partner with the NC Center for Geographic Information and 
Analysis on address file improvements for the state, with all these efforts continuing through October 
2014.  

Spring 2011 Broadband Data Collection and Mapping Process 
 

Data Collection 
The official data request letter was sent to all 112 identified providers of broadband service on January 
26, 2011, via e-mail and hardcopy mailed letter.  Attachments were included explaining the SBDD 
mapping project effort, the e-NC Authority’s role in the endeavor, and all parameters requested 
information.  Providers were asked to reply to the request on or before February 28, 2011. 
 
Excel and geodatabase templates were shared with providers, along with PDF format instructions 
summarizing all NTIA requirements and information relevant to each type of provider (mobile wireless, 
fixed wireless, and wireline).  Technical assistance was provided to any organization who requested it. 
 
A secure server hosted by MCNC is configured with an open source, browser-based direct file upload 
system called eGroupware.  Providers were sent a log-in name and password for this upload system 
once they contacted either Samantha Jackson or Stephanie Jane Edwards to communicate that their 
data was ready for submission. A confirmation e-mail went to Stephanie Jane once data has been 
uploaded. 
 
Reminder e-mails were sent to unresponsive providers with usernames and passwords for data upload.  
An official reminder e-mail was sent out in mid-March to providers of broadband service that were 
unresponsive to the data request.  Phone calls were placed during the weeks of March 14th and 21st

 

 to 
organizations that had not yet responded to the data request or reminders.  These phone calls and some 
background research allowed for e-NC to determine the companies that have gone out of business and 
those that refused to submit data. The number of known broadband service providers operating in 
North Carolina is now at 102. 

Integration of Provider Data into NTIA Statewide Geodatabase 
For ease of data integration, a front-end Excel format template was offered to all providers, containing 
notes defining required fields, explanations of which data is required in which formats by which types of 
providers, and hyperlinks connecting fields to additional tables listing the corresponding NTIA-specified 
values and codes (for speed tiers, technology types, connection point facility types and capacities, 
county codes, end user types).  A brief description of how census block FIPS codes work was also taken 
from an internet source and distributed as needed to providers who had questions about how to report 
this information. 

BB Service by Census Block  
As requested by the NTIA mapping and planning team, all census block data is included with 2000 
census block geometry.  Technical assistance was often needed by providers to correctly report served 
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areas by either the 15-digit FIPS codes or in some way by which e-NC staff could derive the appropriate 
FIPS codes. 
 
BB Service Road Segment  
The reporting and mapping of data by street segment presented significant challenges to accurate 
interpretation of where broadband availability is and is not.  This is mainly attributed to the difficulty of 
standardization among the many data structures by which providers report street segments. 
 
BB Service Address  
A few address-level datasets were submitted to e-NC with the latitude/longitude coordinates already 
included, but most needed to be geocoded.  This was done using the NC Master Address file as the 
primary reference file, significantly increasing the accuracy of matching records.   Secondary sources for 
address records that did not find a match this way included street segment interpolation, ESRI data 
utilizing the 4-digit ZIP extension, and manual placement/digitizing based on a combination of reference 
data and online browser maps.  Upon completion of geocoding for each provider submitting address 
data, the address point features were overlain with a 2000 census block layer to add the census block 
FIPS code attribute, then all address feature points were loaded into the geodatabase feature class.  The 
geocoded shapefiles for each provider are kept with geocode match score and match reference type for 
every matched address, so the thoroughness of this data type could be tracked and/or improved with 
more time. 

BB Service Wireless  
Approximately seven small, fixed wireless providers have been able to share technical information about 
their transmitting towers, antennae, and frequencies, so that e-NC can produce for them a service 
coverage shapefile using the contracted services of the University of NC at Greensboro Center for 
Geographical Information Science.  An Excel template was developed with all the relevant information 
that can be filled in by providers with technical assistance in some cases, and the propagation model is 
field-calibrated to reflect actual ground conditions. 

BB Service Overview  
Records for overview containing subscriber-weighted nominal speeds of a given provider were generally 
joined to a template layer of county features, using the option to keep matching records only.  Then 
these matching features and their new attributes were exported as a new shapefile before being loaded 
into the collective overview feature class.  For providers with multiple technology types serving a given 
county in at least one instance, this information was single-field geocoded using the 5-digit county FIPS 
code, and then geocoded point features were spatially joined to the county polygon using “within” 
criteria. 

Some detail formatting performed as needed: 

• Add state FIPS code and any needed leading zeros onto county code for the new State+County 
FIPS code. Most providers list just the county code because this was the original NOFA request. 

• Change state abbreviation values from “37” to “NC”. 
• Change weighted speeds to appropriate units (kbps) and remove unit text. 
• Translate to county from weighted speeds reported by RSA/MSA. 
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BB Service - Critical Anchor Institutions  
Only anchor Institutions that could be geolocated were included. Only 17 CAIs were identified that could 
not be geocoded to a point feature.  CAIs were collected by contacting administrative offices of some 
CAI category types and receiving databases of information, as well as collecting from individual CAI 
locations for other types using survey emails and follow up phone calls as necessary.  There are 4,224 
CAI’s identified, located, and included in the geodatabase to date.  

Census Block data (tabular) 
• Fields standardized and transferred into Excel template 
• Geocoded to centroids of census blocks using 2000 Census Block layer in WGS1984 projection as 

reference file for “Address Locator”. 
• Spatial join of geocoded census block data points to polygon features 

 

Street Data 
Some datasets were submitted to e-NC by providers already in shapefile format, and others were 
reported in various tabular formats (text, Excel, CSV, etc.).  Of the tabular datasets, some included a 
Tigerline ID (“TLID”) field along with some or all other fields such as city, state, zip, and census block 
FIPS. 

• For datasets submitted tabular with TLID:   
o Max and Min address ranges were calculated from the FromRight, ToRight, FromLeft, 

ToLeft format used by most standard street segment reference files and incoming 
datasets 

o All data formatted into back-end Excel format, including converted speeds if reported at 
some other granularity. 

o Table geocoded to Tigerline 2009 street segment file using single-field and “TLID” 
values, with zero offset. 

o Geocoded point features converted to street segment geometry via spatial join using 
“contains” criteria, keeping matched records only. 

• For datasets submitted tabular without TLID: 
o Max and Min address ranges were calculated from the FromRight, ToRight, FromLeft, 

ToLeft format used by most standard street segment reference files and incoming 
datasets 

o All data formatted into back-end Excel format, including converted speeds if reported at 
some other granularity. 

o Table geocoded to Tigerline 2009 street segment file using false midpoint address and 
either ZIP5 or census block FIPS (whichever available) as address locator zone. 

o Geocoded point features converted to street segment geometry via spatial join using 
“contains” criteria, keeping matched records only. 

• For datasets submitted as shapefiles:  If/Then statements used to calculate “Max” and “Min” 
address range attributes required by the NTIA/FCC, converted from the FromRight, ToRight, 
FromLeft, ToLeft format used by most standard street segment reference files and incoming 
datasets: 

o To calculate “Min”: 
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Dim dFROMRIGHT As Double 
Dim dTORIGHT As Double 
Dim dFROMLEFT As Double 
Dim dTOLEFT As Double 
 
dFROMRIGHT = val([RFROMADD]) 
dTORIGHT = val([RTOADD]) 
dFROMLEFT = val([LFROMADD]) 
dTOLEFT = val([LTOADD]) 
 
 
Dim minright As Double 
If dFROMRIGHT = 0 And dTORIGHT = 0 Then 
    minright = 0 
ElseIf dFROMRIGHT = 0 Then 
   minright = dTORIGHT 
ElseIf dTORIGHT = 0 Then 
   minright = dFROMRIGHT 
Else 
   If dFROMRIGHT < dTORIGHT Then 
      minright = dFROMRIGHT 
   Else 
      minright = dTORIGHT 
   End If 
End If 
 
Dim minleft As Double 
If dFROMLEFT = 0 And dTOLEFT = 0 Then 
    minleft = 0 
ElseIf dFROMLEFT = 0 Then 
   minleft = dTOLEFT 
ElseIf dTOLEFT = 0 Then 
   minleft = dFROMLEFT 
Else 
   If dFROMLEFT < dTOLEFT Then 
      minleft = dFROMLEFT 
   Else 
      minleft = dTOLEFT 
   End If 
End If 
 
Dim min As String 
If minleft = 0 And minright = 0 Then 
    min = "0" 
ElseIf minleft = 0 Then 
   min = Str(minright) 
ElseIf minright = 0 Then 
    min = Str(minleft) 
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Else 
    If minleft < minright Then 
       min = Str(minleft) 
    Else 
       min = Str(minright) 
    End If 
End If 

 
o To calculate “Max”: 

Dim dFROMRIGHT As Double 
Dim dTORIGHT As Double 
Dim dFROMLEFT As Double 
Dim dTOLEFT As Double 
 
dFROMRIGHT = val([RFROMADD]) 
dTORIGHT = val([RTOADD]) 
dFROMLEFT = val([LFROMADD]) 
dTOLEFT = val([LTOADD]) 
 
 
Dim maxright as string 
If dFROMRIGHT > dTORIGHT then 
   maxright = dFROMRIGHT 
Else 
   maxright = dTORIGHT 
End if 
 
Dim maxleft as string 
If dFROMLEFT > dTOLEFT then 
   maxleft = dFROMLEFT 
Else 
   maxleft = dTOLEFT 
End if 
 
Dim max as string 
If maxleft > maxright then 
   max = maxleft 
Else 
   max = maxright 
End if 

 
 

Creating last mile and middle mile features 
• Formatted numeric fields in Excel as text since the short integer format in the data model for 

these fields will not accept values from the Excel import’s default general format. 
• ArcToolbox > Data Management Tools > Layers and Table Views > Create XY Event Layer 
• Zoom to Layer, verifying that all points are located inside NC boundaries 
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Provider-specific notes, functions  and corrections performed by e-NC 
 
Access/On Multimedia Inc. 

• This is a middle mile only provider 
• Provider confirmed no changes since last round so fall data was used 

AT&T 
• Converted subscriber weighted nom speed data from CBSA to county 
• Converted max advertised speed data from CBSA to county 
• Translated max advertised speeds from KBPS to NTIA codes 
• Applied converted speeds to appropriate availability records by county based on FIPS codes, by 

pasting the CBlock FIPS codes into speed columns and using Find/Replace functions in Excel (ex 
Find fields with 37001* and Replace with 7).  For data by street and CB. 

• Copied max advertised speeds into typical speed columns (for which data was not supplied by 
AT&T) 

• Parsed Street names from street types using Find/Replace functions in Excel 
• Calculated conversion of Left and Right To/From addresses for street segment data to NTIA’s 

required Max/Min values (using “min” and “max” formulas in Excel) 
• Checked data by CB for duplicates, none found. 

ATMC 
• Missing End User Category, Typical Speeds data on address data 
• Overlay of address points w/CB layer to get FIPS code field 
• Created new fields and used Calculate Geometry function in ArcMap to generate Lat and Long 

attributes 
• Substituted/duplicated max advertised speed values in typical speed fields for wireline and 

wireless address-level data. 
 

CenturyLink 
• Reprojected CB and street shapefiles and changed format of some fields for loading 
• Excluded 593 CB’s with speed codes outside the NTIA domain for ADSL (1, 2, and 9 for max 

down)  
• Used If/Then scripts to calculate min and max address fields from left and right max/min ranges 

in ArcMap field calculator 
• Created new fields of compatible type for TransTech and Provider_Type fields 

 
Comcast 

• Deleted records from fall as indicated in CB and Streets information 
• Mapped new CB’s and Streets 
• Used Overview data from Fall 2010 
• Low quality on streets (only a 61% match to tiger streets w/CB zone) 

 
Country Cablevision and Carolina Mountain Cable 

• Copied CB shapefile from Fall2010 
• Duplicated max advertised speeds into typical speed fields via Field Calculator 
• Added Provider Type field and populated with code 1 
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Covad/DIECA 
• Geocoded streets to Tigerline 2009 using false address created from integer midpoint of max 

and min, and 5 digit ZIP code as zone.  77% match (1640 out of 2138).  Zero offset from 
centerline for matched “addresses”. 

• Spatial join with Tigerline 2009 (one to one, keep common, contains). 1504 found matches. 
 
Electronic Solutions 
 Converted coordinates, added negative sign to longitude 
 Produced shapefile from data supplied in Tab D. Converted raw speeds to NTIA codes.  
 Put weighted speeds into correct units. 
 
Epproach 

• Copied Census blocks from Fall 2010 geodatabase 
• Merged census block polygons 
• Loaded into geodatabase and populated Unlicensed for spectrum field. 

 
Frontier 

• Used Spring 2010 Verizon data with legal agreement from both Verizon and Frontier. 
• Applied Max Advertised speeds from MSA to CB and Street Segment level based on FIPS codes 

and relevant counties. 
• Missing speed data: duplicated Max speeds for Typical which were not submitted.  Speeds were 

not reported for all CB’s and streets reported, and for these the lowest (except for 1 CB) values 
from Max speed data, NTIA code 5 for down and 3 for up, were applied.  

• Middle Mile: assumed “Owned” for Ownership field to substitute for missing information, as 
instructed by federal program office. 

• Verification: checked tabular CB data for duplicates, none found. 
• Streets:  were provided in text files without city, zip, or Tigerline ID, but did have CB FIPS.  

o Overlay to associate statewide Tigerline streets to corresponding CB FIPS codes 
o Creation of address locator for geocoding tabular street data as street segment 

midpoint features. 
o Modification of Address locator properties to remove default 20 ft. offset from street 

centerline reference features. 
o Tabular street data geocoded to points using a false address created by the midpoint 

integer of the min max address range and census block FIPS  
o Select by Location on Tigerline layer for features that intersect geocoded points, 

exported selection as new shapefile 
o Spatial join w/new selected streets shapefile and geocoded broadband data points, one-

to-one keeping matches only where segment lines CONTAIN geocoded midpoints 
w/broadband data 

 
Greenlight (City of Wilson) 

• Re-projected shapefiles into WGS84. 
• Added FRN2 field with leading zeroes, Lat, Long, and Provider type field (populated with code 1) 

to address attributes, and re-concatenated “Address” field. 
• Added/populated FRN w/leading zeroes, lat and long fields for middle and last mile 
• Attribute join to county template feature class for Overview 
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Level 3 
• 11 duplicate address records removed, 209 unique records remaining. 

 
Mediacom 

• Corrected fields in MidMile (provider name typo, ownership, positive longitude value) 
• Used address data from Fall 2010, which contained many duplicates 

o Exported fall addresses into new shapefile 
o Exported .dbf of shapefile into new Excel file 
o Removed 11,992 duplicates in Excel  

 Data > Remove Duplicates (went from 108,043 records to 96,051) 
o Created an Address locator using Fall Mediacom’s non-duplicate address points only 
o Re-geocoded new Excel table containing unique records. 
o Added short integer TransTech and Provider_Type fields and loaded into spring 

geodatabase 
o Excluded 286 address records that were PO Boxes only. 

 
Morris 

• Considerable cleanup and re-parsing to the provider sourced address-level data 
• Found 3 address records with speed values of 14, 15, and 50 in all 4 speed fields, changed these 

to “ZZ”.  Then went back and deleted these per NTIA instructions.  Will follow up with provider 
to learn what these values should be. 

North State 
• Emailed about missing FIPS digit and inserted (leading zero for tracts) upon their response. 
• Speeds were reported as Typical Up/Down only. Substituted these values into Max Ad Up/Down 

as well. 
• Duplicate CB records were given to us for each service tier.  Merged into CB shapefile after 

geocoding by: 
o Splitting into separate shapefiles by tech type (10, 30, and 50) 
o  one-to-one spatial join field merge rule taking the maximum value from duplicates’ 

speed fields. 
• Middle Mile, Last Mile: Added negative sign to longitude values 
• Last Mile point with longitude -70.97528 fell out of state boundaries and was changed to  

-79.97528 based on locations of all the other last mile locations. 
• Excluded 2 CB’s that only had 14 digits in FIPS code field and could not be geocoded to the 

correct area. 
 
Randolph Telephone and Randolph TMC 

• Data was reported all by street segment in a text file, with no CB number, TLID, or Zip code field. 
• Created false address from integer midpoint of address ranges concatenated with street name 
• Built Address Locator using NC Streetmap reference file with city name as Zone, removed 

default offset of output. 
• Geocoded street data false addresses, then spatially joined to line features 
• One-to-One spatial join of geocoded street data POINTS to 2000 CB, using merge rule of 

Maximum for max advertised and typical speed fields.  All tech types were 10.  Sorted resulting 
polygons by area and exported just the CB polygons < 2 mi.  These were loaded into the 
geodatabase with associated broadband attributes 
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• Clipped geocoded and joined street data POLYLINES by polygons created from merged CB’s 
OVER 2 square miles.  These were loaded into the geodatabase with associated broadband 
attributes. 

 
Sprint Nextel 

• Fixed topological errors 
• Merged polygons with like spectrum, transtech, and speeds. 

 
Star TMC 

• Excluded 106 census blocks (out of 1641) whose numbers did not find an exact match. 
 
Surry TMC and Piedmont TMC 

• Contacted for clarification and formatted mislabeled “street” information into address tab 
• Removed 7 duplicates from address data in Excel 

 
Skybest and Skyline 

• Duplicated Maximum advertised speeds into Typical speed fields which were not provided. 
• Ran skyline through address sorter 
• Geocoded address data 

 
Sky Catcher 

• Wireless Propagation study. 
• Created XY Event Layer to map Middle Mile information, deleted duplicate records. Remaining 

records loaded into geodatabase. 
 
Tele-media 

• Provider type of 1 assumed and populated. 
• Checked for duplicates CB’s in Excel, none found  

 
Time Warner Cable 

• CB and Streets: 
o Padded FRN w/two zeroes 
o Reprojected into WGS 1984 
o Added Provider Type field and coded as a “1” 
o Input Max Advertised speeds as Typical Speeds as well, since they were not provided. 

• Streets: created “AddyMax” and “AddyMin” fields and used If/Then statement to calculate 
values from LFrom, LTo, RFrom, and RTo fields 

 
T-Mobile 

• Reprojected shapefiles into WGS 1984. 
• Repair Geometry to fix some incomplete polygons 
• Executed spatial Union between coverage of HSPA Plus (higher speed) and the broader 3G 

coverage, then extracted (Data Export selected features) resulting 3G only features to 
distinquish max speeds here versus where HSPA Plus is also available. 

• Simplify Polygon tool to delete excess vertices and simplified features <0.125 square mile. 
• Loaded final features into geodatabase feature class and then attributed manually from 

information sent in a text file from T-Mobile. 
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Tri-County 

• Concatenated address information into single Address field in BackEnd template spreadsheet. 
• Duplicates removed by technology type (17 dsl, 3 wireless) 
• Lat/longs from provider with address data, so mapped using Create XY Event Layer in 

ArcToolbox 
• Sorted, selected, and exported by TransTech types 70 and 10, then one-to-one overlay of each 

shapefile with CB layer. Maximum merge rule used for speed information. 
• For Tech Type 10: Selected and exported resulting aggregated CB data for CB’s <2 mi.  These 

were loaded into the geodatabase with associated broadband data. 
• For Tech Type 70: created copy of resulting CB’s <2 shapefile and merged all features into one 

multi-part polygon.  This was loaded into the wireless feature class and manually assigned 
“Unlicensed” spectrum value. 

• Address feature layer was clipped using polygons created from merged CB’s OVER 2 miles, and 
those in the clip result were loaded into the geodatabase with associated broadband data. 
 

Verizon Wireless 
• Compared submitted shapefile with previously submitted shapefile, differences confirmed. 

 
Windstream (Windstream North Carolina, Windstream Concord Telephone, and Lexcom) 

• Sorted 2 Access tables by “DSL” field and deleted all records without a “Y” 
• Sorted 2 Access tables by census block size field, dividing up data by CB and streets 
• Copy pasted all relevant fields into Excel Template column by column, including number listed 

indicating company name and MSA/RSA name pasted into Max Advertised Download Speed 
field. 

• Used Find/Replace to populate appropriate Provider, DBA Names and FRN’s (sent in emails upon 
request) and Up/Down Max Advertised Speed info based on contents of cells w/direct 
relationship to this information. 

• Recalculated left/right, to/from street segment address ranges to max and min 
• Created false address using the integer midpoint of max and min concatenated with street name 

provided, then geocoded these “addresses” using Tigerline 2009 overlain with CB 2000 to use as 
Zone 

• Split Windstream NC and Windstream CT geocode results up into two tables, then one-to-one 
keep common spatial join w/Tigerline 2009 features using “contains” criteria. 

 

Post-processing Functions for Final Integration 

Census Block 
After Census Block data was loaded into the transfer geodatabase feature class, FIPS code fields were 
calculated using commands in the Field Calculator and contents of the FullFIPSID field.  The following 
calculation formulas were used: 
 
STATE FIPS = Left ([FULLFIPSID],2 ) 
COUNTYFIPS = Mid([FULLFIPSID],3,3) 
TRACT = Mid([FULLFIPSID],6,6) 
BLOCKID = Right ([FULLFIPSID],4) 
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• 1033 duplicate records (with same value for Provider Name, DBA Name, FRN, TransTech, and 

FullFIPS ID) were removed using a python script created for this purpose. 
 

Address Data 
• Exported all features into a shapefile, conducted one-to-one, keep all spatial join with CB 2000 

using “Is_Within” criteria to produce the associated 15-digit FIPS Code.  These features were 
then reloaded into a clean version of the Address feature class. 

• Reverse selection within state boundary used to then export (for record-keeping) and deletion 
of addresses outside North Carolina. 

• Sorted out, selected, and field calculated missing End User Category values to “ZZ” default value 
• Calculated geometry for missing Lat/long, for unmatched addresses changed to -9999 

 

Wireless 
• Duplication of multipart coverage polygons to reflect multiple spectrum ranges used, per 

NTIA/FCC instruction. 

• To remove “donut holes” in coverage shapefiles less than 0.125 square mile in area as instructed 
by the NTIA/FCC: 
- Separated feature classes into unique attribute records.  For each provider’s feature class… 

o Created a polygon feature class with one large polygon covering all of NC, called 
BACKGROUND 

o Performed a Union between BACKGROUND and the wireless feature class so that 
gap areas were then polygons. (1) 

o Dissolved with multi-part feature unchecked to explode the multipart features, but 
preserved the attribution. (2) 

o Selected areas that were both part of the original polygon and are less than 0.125 sq 
mi (3484800 sq ft) in area.  Dissolved the selection to remove donut holes; did not 
create multipart features.  (3) 

o Selected areas that are greater than 0.125 sq mi (3484800 sq ft) in area.  Exported 
selection to remove small islands.  (4) 

o Dissolved again, this time creating multipart features. 
- Joined each feature class to the original datasets to re-acquire the attribute information.   
- Used append to merge the provider files back into one feature class per provider. 

Overview 
• Field Calculated “Geographic Unit Type” field to CO, and “StateAbbr” field to NC. 
• Field Calculated missing Maximum Advertised Up and Down speed fields to “ZZ” “default” 

values. 
• Deleted records of information for wireless technology types. 
• Verified

 
 that all FRN’s were either 9999 or 10 digits with leading zeroes. 



15 
 

Last Mile 
• Field Calculated “Ownership” field to -9999, as we do not collect this field.  Calculated 

“StateAbbr” field to NC.  Then went back and calculated all “Ownership” field values to “0” for 
owned since the data model script does not accept the default values we were instructed to use. 

 

Middle Mile 
• Spatial join with census block layer to derive the 15-digit FIPS code, then reload features into 

middle mile feature class including the new values for populating the “FullFIPSID” field. 
• Replaced Null Elevation values with -9999 “default” value using Field Calculator. 
• Populated State Abbreviation column with “NC”. 

 

CAI 
• Parsed address information for address fields 
• Deleted “DMV Tag Office” in “Charlotte, NC” due to absence of street address information. Was 

geocoded incorrectly. 
• Deleted 526 records for which survey respondents report that they do subscribe to broadband 

but did not give speed information accepted by the NTIA’s script. 

Verification Implemented Prior to Spring Data Submission 
Data verification methods implemented by e-NC in time for submission at the federal level followed 
generally along the lines of quality control.  Methods most often used are outlined below.  Time 
constraints on existing staff did not allow for the execution of some less basic verification approaches 
that are in the planning/setup stages.   

Standardizing  
The files from datasets received from each provider, except for those few submitted in shapefile format, 
were manually transferred to a back end Excel-format template with field headers, to create a single-
file, standardized field structure for each provider’s data that could be used for quick reference and map 
feature creation.  This step also helped staff to ensure that all required components were either present 
or requested in follow up to the provider, and that the components were reported in the correct format. 

Lat/long coordinates 
Some information was submitted to e-NC with lat/long coordinates included for the location of point 
features.  This location information was checked during the mapping process, and values were corrected 
if the provider had made mistakes such as reversing the latitude with the longitude, or forgetting to 
include the negative sign for the longitude value.  In addition, e-NC followed up with providers on point 
features that showed up in the map outside the state and/or outside the provider’s reasonably expected 
service area.  Point features that mapped outside the state after follow up with providers, including 
those that mapped to zero degrees latitude and longitude due to an unknown location, were deleted 
from the geodatabase for submission at the federal level.  For fixed wireless data generated by 
propagation model from antenna specs, the latitude/longitude coordinates of the antenna locations 
reported by the provider to e-NC were verified by e-NC’s university GIS research contractor using high-
resolution orthoimagery.   
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Multiple FRNs 
In several instances, providers reported multiple FRN’s that increased in numerical increments of one for 
each record of data, and this was found to be a simple error when the providers were trying to paste 
their organization information down the rows applying to a list of broadband data records.  This was 
checked for and corrected after confirming that the lowest/first reported FRN was the correct one. 

Correct technology type codes 
Knowledge from our technical staff and online research was sometimes used to supplement data that e-
NC had relevant to a provider that was unresponsive or otherwise did not supply this specific piece of 
the information.  For example, a provider may have gaps in their transmission technology field and these 
were filled in when technical staff could confirm that the provider operates with only a single technology 
type.  Or the staff may know which technology type is used by a provider who simply left this field blank 
on all records. 

Subscriber-weighted nominal speeds  
Weighted nominal speed values were checked, and staff followed up with the provider if all values were 
the same for multiple counties, as this could result from either a single speed tier for a given 
transmission technology across counties, or in some cases providers were not following the formula 
provided and had manually entered the same value regardless of differences in subscriber numbers.  
When these cases were discovered, technical assistance was offered and a new subscriber-weighted 
nominal speed dataset created to reflect variation between counties. 

Wireless model fieldwork  
For fixed wireless provider data that was generated as coverage area output from models based on 
technology and environmental factors, the data was verified by “ground-truthing” with measurements 
of signal strengths at sample locations within a provider’s service area, observation of the influential 
ground conditions in each location, and comparison to the expected signal strengths at the same 
locations in the model.  Some calibration of the model was then performed so that the resulting 
polygons could more accurately reflect what would be found in real life. 

Check geometry  
After compiling all datasets into the geodatabase feature classes, the check geometry process in Arc 
Toolbox’s Data Management section was used on each feature class to identify and repair any geometry 
errors in the features. 

 



 
 
 
 
 
 
 
 

North Dakota Broadband Mapping  
Methodology Report 

 
 

Submitted To:  
Dirk Huggett 

IT Business Analyst 
Information Technology Department 

Enterprise Services Division       
State of North Dakota 

 
 
 
 

Submitted By:  
Fred Gifford 

Tetra Tech EC Inc. 
and 

Ken Wall 
GeoData Services Inc. 

March 24, 2011 



North Dakota Broadband Mapping 
March 24, 2011 Methodology Report 

 
Tetra Tech EC Inc.    3/24/2011 
 
  1 

Executive Summary 
 
The following report describes methods and issues related to the April 1, 2011 deliverables to 
NTIA for Broadband Mapping in North Dakota. This data submission is compliant with all 
guidance and specifications provided by NTIA as of March 24th, 2011. As per NTIA guidance 
we are using the Jan 13th, 2011 version of the Broadband data model and the March 14th, 2011 
version of the validation script.  
 
North Dakota has developed a very robust operational data model, components of which are 
described in this report, to support our broadband mapping efforts. We feel our operational 
model can support any reasonable modifications to NTIA requirements or the NSGIC data 
model. Since this deliverable format is derived from our operational data model, we anticipate 
some modifications will be required.  We are able to take best practices recommendations from 
the NTIA and incorporate those into the final deliverable without major modifications of our 
work flow and operating rules. 
 
Our mapping process starts with infrastructure points (central offices, remote terminals, wireless 
towers and antenna locations, middle mile and backhaul), cable franchise areas, and anchor 
institution addresses.  When providers have not supplied detailed information of their service 
areas that can be mapped at the census block level, coverage models are derived dynamically 
from this infrastructure based on geoprocessing techniques specific to each broadband 
technology. Examples of geoprocessing techniques include developing propagation models using 
the Longley-Rice model for wireless coverage and using infrastructure points in conjunction with 
the road network to predict the area served for DSL coverage.  
 
We have developed a system to quantify “validated” data for the purpose of determining what is 
suitable for delivery to NTIA.   The operational data model maintains reliability and validity 
codes, together with completeness checks to track which data elements are complete or still in 
process of refinement.  Infrastructure is compared to public data, independent measurements, and 
telecommunications provider submittals at varying levels of geography.  As more data is 
obtained from providers and systematically checked against infrastructure points, the reliability 
and validity progress from 1 (not validated or reliable) to 10 (validated and reliable).  
Completeness is primarily dependent on provider input, and can be supplemented in many 
instances with independent measurements. The process is iterative.   Five of the providers 
included in this data set submitted infrastructure data at the address level. The remainder have 
submitted at a coarser geographic scale, most often by census tract, small scale paper or digital 
map, or generalized town location.  Our validation methods provides the ability to use general 
information and iteratively cross check and improve the coverage models as more accurate data 
is obtained.  
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Reliability, Validity and Completeness  
 

Reliability codes apply to the source data points and polygons and assess the authority of the 
source we obtained the data from and the level or coarseness of the geography (address or town).  
Validity codes are determined from cross checks of data sources and the number of independent 
sources of verification.  These are as simple as comparing speed test locations against DSL 
modeled polygons, or as complex as geospatial analysis operations such as a kernel density 
function cluster analysis.  Completeness is determined by public sources, independent 
measurements or provider submittals and checks on the domain classes required for the final 
NTIA deliverables such as Technology of Transmission domains, Speed Test domains and 
serving facility and wireless spectrum facility types and categories.  The categories for these, and 
the subsequent records in our operational geodatabase tables grow and change as new data is 
obtained. We are maintaining these as feature level metadata tied to points and polygons 
maintained by analysts and technicians in a wiki table and coding them to the geodatabase.  In 
this way the unique situations that arise can be cataloged and maintained with some level of 
flexibility while contributing to the final indices in a controlled fashion.  

Reliability Codes 

The two factors incorporated in reliability codes include the level of geography that was used as 
a source or provided as a clarification of location and the authority of the source for the 
information. We are also considering clusters of point information from independent 
measurements and sources to be higher in reliability than individual point information. 

Generally, the coarser the source geography the lower the resultant score. Everything besides an 
address or street intersection, latitude/longitude location, or location provided in a georeferenced 
digital source is assigned a reliability score less than 5. This applies to source data coming (e.g. a 
central office located in a city instead of an address) and review comments on a previously 
mapped location (e.g. “That location is wrong, I know it is on the south side of town”). 

We have incorporated the reliability code into our last point of aggregation (LPA) and provider 
coverage geodatabase files, and into some of the publicly available data (PAD) geodatabases. 
We are also carrying a short text field (50 characters) with a descriptive rationale for the score. 
This will allow us to focus more on the lower scores that need to be confirmed, and ignore the 
high confidence data scored as 9’s and 10’s. 

Reliability Codes 

Code Description Detailed Description 

0 Not assigned • Not yet assigned  

1 Level 1 • Checked but unverified  

2 Level 2 • County  
• Presence by other coarse geography (e.g. administrative region)  
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3 Level 3 
• City  
• Census tracts  
• Cable Plus (area likely to have been annexed into an incorporated town or CDP)  

4 Level 4 
• Cable - incorporated  
• Zipcodes  
• Census blocks  

5 Level 5 
• GeoTel unverified  
• Confirmed by provider or anchor institution key advisor but to geography coarser 

than address or intersection  

6 Level 6 • Qwest/Midcontinent or other web site random testing check  
• Speed test from individual average residential  

7 Level 7 

• From anchor institution key advisor Webex  
• GeoTel verified address only with no 3rd party confirmation from public sources  

o Building unverified  
• Speed test from anchor institution  

8 Level 8 

• From provider  
• FCC ULS or ARS  
• Geotel verified address and possibly verified by 3rd party source (Google 

Streetview)  
o Another provider's sign is on building (usually Qwest)  

• Geotel possibly verified by 3rd party source (NAIP, Google Streetview)  
• From state authoritative public data source (e.g. DCN or SummitNet)  

o Address or building unverified  
• Speed test from cluster of average residential  

9 Level 9 

• From provider with authoritative confirmation  
• Geotel verified address and verified by 3rd party source (NAIP, Google Streetview) 

o Provider sign on building  
o Tower or dish visible  

• From provider or anchor institution check of our data * Root Wireless  
10 Level 10 • From 2+ authoritative confirmations  

 

Validity Codes 

We include validity codes in the last point of aggregation infrastructure data which drives 
creation of the DSL models.  We also include validity codes in each of the final technology of 
transmission deliverables for polygons and point feature classes.  The scales of validity vary by 
each major type and function. 

Infrastructure Validity Codes 

The purpose of this validity code is twofold: 

1. To determine which infrastructure points are turned into DSL model coverages  
2. To use as a reference in other coverage validity checks  
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Infrastructure Validity Codes 

Code Description  Detailed Description
0 Level 0 • Not yet assigned 
1 Level 1 • Not yet assigned 
2 Level 2 • Not yet assigned 

3 Level 3 • Checked against MT PSC Report or DSLReports at the town level  
• Checked against SummitNet anchor institution data  

4 Level 4 • Checked against two or more independent public sources at the town level  
• Checked against provider public data (e.g. Qwest ICONN) at the town level  

5 Level 5 • Not yet assigned 

6 Level 6 • Confirmation of DSL or cable from authoritative public data to broader geography 
than address not confirmed by provider  

7 Level 7 • Authoritative public data at address level (e.g. Geotel) not confirmed by provider  

8 Level 8 • Provider submission at the census tract level  
• Provider website independent address checks (Qwest, Verizon)  

9 Level 9 • Provider submission at the census block level  
10 Level 10 • Provider submission at the address level  
 

 

Final Technology of Transmission Validity Codes 

The purpose of this validity code is twofold: 

1.  To determine which elements are loaded in the spreadsheet provider submission 
packages in their review  

2. To determine which provider coverages are chosen for submittal with one of the  NTIA 
deliverables (April 15, June 24) 
 

Final Technology of Transmission Validity Codes 

Code Description Detailed Description 

0 
Not 
assigned • Not yet assigned  

1 Level 1 • Unassigned at this time 
2 Level 2 • Unassigned at this time 

3 Level 3 • Checked against MT PSC Report or DSLReports at the town level  
• Checked against SummitNet anchor institution data  

4 Level 4 • Checked against two or more independent public sources at the town level  
• Checked against provider public data (e.g. Qwest ICONN) at the town level  

5 Level 5 • Confirmation of DSL or cable from authoritative public data  

6 Level 6 • Provider website independent address checks (Qwest, Verizon)  
• Provider submission at the census tract level  
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7 Level 7 
• Provider submission at the census block level  
• Provider submission at the census block level confirmed by Speed test cluster OR 

RootWireless  
8 Level 8 • Provider submission at the address level  

9 Level 9 • Provider submission at the address level confirmed by Speed test cluster OR 
RootWireless  

10 Level 10 • Provider submission at the address level confirmed by Speed test cluster OR 
RootWireless  

 
 
 

Detailed Processing Steps 
 

BROADBAND COVERAGE (BB_SERVICE_CENSUSBLOCK AND 

BB_SERVICE_ROAD_SEGMENT) 

 
LOGICAL CONSISTENCY REPORT  
Data submitted by broadband providers was accepted as is when it was provided as a broadband 
coverage or at a census block level.  Provider coverage submitted at a coarser geographic scale 
was supplemented with public data, independent measurements and GIS modeling techniques.  
When independent measurements were available for typical broadband speeds and modeled 
location of infrastructure, some provider data was overridden or supplemented. 

COMPLETENESS REPORT  
All data was submitted by broadband providers was mapped in complete form, except where 
independent measurements were used to supplement provider submittals.  Several providers did 
not participate in the broadband mapping process, including some that were suspected to be 
providers. 

PROCESS DESCRIPTION  
Process final broadband coverage from provider submissions. 

Broadband providers that chose to submit coverage data did so in a wide variety of formats, 
levels of completeness, and at varying geographic scales including: narrative descriptions, analog 
and digital coverage maps, CAD files, GIS shapefiles and geodatabases, KMZ and KML files, 
FCC 477 reports, and data spreadsheets.  All data formats were accommodated and processed 
whenever possible.   

If data was submitted by a provider in a format that did not allow mapping at the census block 
level of geography, providers were sent standardized maps that included census blocks and a 
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data spreadsheet in an attempt to standardize the inputs and increase the geographic granularity 
of the provider data submission. 

Although each provider had individual characteristics and nuances in their data submissions, 
several data patterns can be described generalizing the provider submissions. 

FCC FORM 477 REPORT OR SIMILAR FORMAT: 

Broadband providers are required to submit FCC Form 477 reports twice a year to the FCC; 
recently 477 submissions have been done using a structured web site maintained by the FCC.  
The 477 reports require broadband providers to submit a list of census tracts with the number of 
subscribers based on maximum advertised downstream and upstream speed tiers.    Several 
providers submitted their actual FCC 477 report or a modified version in analog or digital 
format.   

HOW THEY WERE HANDLED:   

FCC Form 477 reports were entered into a standardized format that included the census tract ID 
code, maximum advertised downstream and upstream speed tier code, and number of subscribers 
if available.  Since the FCC 477 reports requires providers to submit data for all speed tiers 
within a census tract, only the highest maximum advertised speed for any given census tract was 
entered into the standardized spreadsheet in order to be compliant with the definition of 
broadband service.  The spreadsheets were then joined to a census tract feature class template 
that included the attribute fields from the NTIA schema.  The resulting feature class was a 
geographical representation of the FCC 477 report including the technology of transmission and 
speed information.  This feature class was used in conjunction with validated LPA data to run the 
DSL or Cable geoprocessing models respectively.  The resulting census block selection from the 
DSL or Cable models were added to a standardized review map and returned to the provider for 
confirmation.      When providers returned additional data at a finer level of geographic detail 
they were processed as census block or coverage provider data as described below.  For those 
that did not respond, the final submission was our best modeled estimates of their coverage at the 
census block level for DSL and/or Cable technologies.  Providers that submitted FCC 477 data 
for fiber to the end user or fixed wireless could not be mapped and were not included in the final 
broadband map unless they provided additional data. 

PROVIDERS SUBMITTING CENSUS BLOCK COVERAGE: 

Census blocks submitted by providers representing their broadband coverage area come in a 
wide range of formats including: analog and digital maps, CAD files, GIS shapefiles and 
geodatabases, tabular lists, and spreadsheets.    

HOW THEY WERE HANDLED: 

All census block submittals were loaded into a census block feature class template that included 
all of the attribute fields from the NTIA schema.  Census 2000 geography was used as required 
by NTIA.  Domain codes were entered in the appropriate attribute field for technology of 
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transmission, maximum advertised downstream speed, and maximum advertised upstream speed.  
If a provider did not identify the technology of transmission for any given census block or 
blocks, they were contacted by phone or email in order to obtain this information.  In instances 
where speed information was not included in the data submission providers were contacted and 
asked to supply this data; in cases where the provider refused to give either the downstream, 
upstream, or both speeds, the lowest domain code was entered in the applicable attribute field.  
Standardized confirmation maps were created for each provider by type of technology and sent 
to the provider for review. Once processing was completed for a provider’s census block 
submission, they were run through an ESRI geoprocessing model that performed several quality 
control-quality assurance tests and selected census blocks less than or equal to two square miles 
and road segments that intersected with census blocks greater than two square miles.   

PROVIDERS SUBMITTING COVERAGE DATA: 

Provider submitted coverage data were differentiated from the other types of geographic data 
submissions coarser than a census block since they represented the full and explicit range of 
broadband coverage.  Similar to the other types of data submissions, coverage data also came in 
a wide range for formats including: analog and digital maps, CAD files, GIS shapefiles and 
geodatabases.  Coverage data was submitted by several providers or was available on several 
providers’ websites.  

HOW THEY WERE HANDLED: 

All coverage data was loaded into a coverage template feature class schema that included all of 
the attribute fields from the NTIA schema.  The method of data loading was driven by the format 
in which it was received.  Providers who supplied GIS shapefiles or feature classes could 
generally be loaded into the coverage template feature class schema using the simple data loader 
while CAD data had to be exported to GIS format prior to being loaded into the coverage 
template.  Coverage data supplied as digital or analog maps required georectification and 
digitizing prior to loading into the coverage template feature class.  Domain codes were entered 
in the appropriate attribute field for technology of transmission, maximum advertised 
downstream speed, maximum advertised upstream speed, and spectrum.  If a provider did not 
identify the technology of transmission for any given coverage area, they were contacted by 
phone or email in order to obtain this information.  When speed information was not included in 
the data submission, providers were contacted and asked to supply this data; in cases where the 
provider refused to give either the downstream, upstream, or both speeds, the lowest domain 
code was entered in the applicable attribute field.  If a provider did not specify the type and 
spectrum used for fixed wireless the default values for unlicensed were used.  Standardized 
confirmation maps were created for each provider by type of technology and sent to the provider 
for review. Once processing was completed for a providers census block submission, they were 
run through an ESRI geoprocessing model that performed several quality control-quality 
assurance tests and selected census blocks less than or equal to two square miles whose centroid 
was within the coverage area and road segments that intersected with census blocks greater than 
two square miles were clipped to the coverage area. Providers who submitted customer locations 
typically fell into four categories.  Some were submitted as AutoCAD files where the points 
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could be transferred to the GIS, then spatially joined to the census blocks they were located 
within. Others submitted maps in image format that were georectified in the same manner as 
other images, then census blocks were selected by an operator viewing the customer point 
images underlying the census blocks.  When customer lists were submitted, they were loaded in 
a database and geocoded using ESRI Business Analyst USA Geocoding engine based on 
TeleAtlas road features.  The geocoded points were subsequently treated identically to customer 
locations submitted in GIS or CAD format, and spatially joined to the census block template file. 

OTHER LEVELS OF COARSE GEOGRAPHIC SUBMISSION: 

This category had a wide range of submissions.  The most common was as telephone exchange 
areas or equivalent, wire centers, zip codes, counties or general references to towns or cities.  
The problem with these submissions was that often a given polygon overlapped a census block 
or multiple blocks, and in most cases, they were much larger geographic entities than a census 
block.    

HOW THEY WERE HANDLED: 

Operational rules established early in the project did not allow provider coverage data that 
significantly over-represent provider coverage. Those providers that submitted coverage area by 
geographic features coarser than a census block that crossed county lines were not able to be 
processed.  No interpolated data was used to calculate this data, if the data was not submitted by 
a provider in a format capable of processing the data was not calculated for that provider.  Some 
providers who submitted broader geography initially that also were represented in the last point 
of aggregation infrastructure point file were sent estimated census block coverage maps and 
spreadsheets, and provided a second submission with finer level geography.  Providers 
submitting town locations for DSL or Cable were handled differently, and used as validation for 
central offices from the last point of aggregation table, and subsequently to run the DSL 
modeling routine or validate a cable or cable plus areas.  In instances where no infrastructure was 
identified with a reliable location (no verified street address or visual location), if it was a small 
town, typically smaller than 3 miles in width or length, then the DSL model was applied. 

Final processing was the same regardless of the source process to derive provider coverage to the 
census block level.  All technology of transmission types except fixed and mobile wireless was 
handled in a similar fashion. Outstanding questions remain to NTIA about fixed wireless, as to 
whether that technology fit in table 1(A) or in 1(B).  No answer has been forthcoming, so we 
chose to include those in table 1(B).  For DSL, Cable, Copper Wire and Fiber to the End User, 
the census block coverages were split into two categories, those less than 2 square miles, and 
those greater or equal to 2 square miles. 

Those less than 2 square miles in area were left intact as census blocks.  The census block 
coverage files greater than or equal to 2 square miles were intersected with the Tiger 2009 road 
files, splitting the Tiger road files at the census block boundary.  A subsequent spatial join 
allowed the transfer of the data attributes in the census blocks greater than or equal to 2 square 
miles to be transferred to the Tiger road segments intersecting the census block coverage.   
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Based on comments made by NTIA in several of the webinar sessions, the preference was to use 
2000 census topology and 2009 Tiger road files.  The final NTIA NSGIC  geodatabase that was 
recommended by NTIA as a preferred delivery format had parsed street attribute fields in the 
geodatabase schema.  The Tiger 2000 roads had parsed street segment database fields for 
address, prefix, suffix, etc.  The Tiger 2009 road data carried these as one field labeled 
"FULLNAME".  The state does not plan to geocode using Tiger 2009 files, so it was not 
practical to do the large amount of manual work to parse the FULLNAME address field into 
individual components.  

PROCESS DESCRIPTION  
Solicit census block level broadband coverage areas from providers who initially submitted more 
generalized geographic coverage. 

Several providers initially sent coverage at a broader level of geography than required, typically 
census tracts,  telephone exchange areas, or zip codes.  With public and commercial data on 
infrastructure, DSL and Cable models were prepared for each of these providers with best 
estimates of their coverage down to the finer granularity of a census block, along with the 
standardized spreadsheets with the details on each census block in the model.  A dynamic web 
based map service was also made available to assist them in identifying census blocks and tracts 
with a Google map backdrop.  Several providers subsequently used these tools and other analysis 
to submit more detailed coverage and data attributes in a second submittal. 

PROCESS DESCRIPTION  
Model Cable coverage (technology of transmission codes 40 & 41). 

An ESRI geoprocessing model was created to generate coverage areas for Cable  providers who 
did not submit census block or coverage data (i.e., census tract providers).   

The most authoritative GIS layer available from the state with incorporated areas and city 
boundaries was used as a surrogate to model cable broadband coverage.  Municipalities and 
towns were sporadic in their digital update of these maps, since annexations and other boundary 
modifications were ongoing and difficult to maintain in real time updates.  To compensate, likely 
areas contiguous to these city boundaries were added, labeled "Cable-Plus" in the operational 
data model.  These additional polygons were determined using operator interpretation, road 
density, structures points from Info USA in ESRI Business Analyst, and in some instances NAIP 
imagery.  In general areas were added that were immediately contiguous to existing city or town 
boundaries that represented likely areas where cable service existed. 

Cable broadband providers primarily work under the structure of franchise agreements with 
municipalities.  Phone calls were made to the largest cities in the state in order to obtain that 
respective city's cable franchise agreement. They were all either unknown or a text agreement 
without maps.   



North Dakota Broadband Mapping 
March 24, 2011 Methodology Report 

 
Tetra Tech EC Inc.    3/24/2011 
 
  10 

The full set of potential cable areas were then passed through validation sources to determine if 
cable was provided.  This included public sources, such as the Warren Communications Cable 
Fact book (http://www.warren-news.com/factbook.htm). 

The second and most authoritative form of validation was data received from cable providers at 
the census tract, block, or coverage level of geography.  A spatial join geoprocessing operation 
was performed on these datasets with the full set of potential cable coverage areas in order to 
further validate areas with cable coverage.  

The third source of validation came from the public speed test site maintained throughout the 
project.  Whenever user submitted speed tests identified cable modem broadband service near or 
adjacent to existing estimated cable areas, the cable-plus boundaries were expanded using the 
same method of digitizing outlined above. 

It was not possible to differentiate between technology of transmission codes 40 and 41 using 
this indirect mapping method.  The only authoritative way to determine this information was 
from data submitted by a provider.  In all cases where the provider did not indicate the type of 
cable modem technology being used, the code for Cable Modem-Other (41) was assumed. 

PROCESS DESCRIPTION  
Model DSL coverage (technology of transmission codes 10 & 20). 

An ESRI geoprocessing model was created to generate coverage areas for DSL providers who 
did not submit census block or coverage data (i.e., census tract providers).  This model is based 
on typical DSL technology which can provide service up to 18,000 feet from a central office or 
remote terminal, unless otherwise specified by a provider.  Since DSL lines are typically buried 
alongside roadways, underneath roadbeds, or strung on aerial telephone lines which tend to run 
alongside a road,  a GIS dataset of a state’s road network could be used as a surrogate to model 
DSL areas.  Commercial (GeoTel) and publicly available data sources representing last points of 
aggregation (LPA) for DSL were collected including central offices and remote terminals.  Each 
LPA was validated based on publicly available data, provider data, and independent 
measurements; LPAs were used in a DSL model only if they were supplied directly from a 
provider or could be verified by two or more sources.  The actual geoprocessing model used the 
validated central office and remote terminal locations to generate a raster cost surface based on 
all of the available roads radiating out 18,000 feet from each active LPA point.  The raster 
coverage was converted to a polygon feature class and a small back-buffer was applied to 
achieve the final DSL coverage polygon representing a provider’s maximum possible DSL 
coverage area.  The DSL coverage areas were then used to select intersecting census blocks and  

Remote terminals were provided or publicly available for only a small number of providers, 
therefore this method may tend to underestimate the full DSL coverage.   

It was not possible to differentiate between ADSL or SDSL based on the LPA data; the only 
authoritative way to determine this was from data submitted by a provider.  In all cases where the 
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provider did not indicate which type of DSL service was being provided, the technology code 
was assigned to 10 "Asymmetric xDSL". 

PROCESS DESCRIPTION  
Public broadband data research. 

Provider presence maps were developed for central office locations and incumbent local 
exchange carrier  locations for all assumed providers in the state.  These were identified through 
a commercial spatial database purchased from GeoTel Inc., and supplemented by other public 
data sources such as the State's Public Service Commission and DSLReports.com.   These were 
intended to be "talking maps" and general intelligence on where providers have infrastructure for 
subsequent phone and written communications with providers.  These maps were compared to 
counties served by provider in the state’s telecommunications association directory.  

Web site research, review of materials submitted to the state by providers, and public websites, 
such as the FCC were researched for each provider. 

PROCESS DESCRIPTION  
Solicit census block level broadband coverage areas from providers who initially submitted more 
generalized geographic coverage. 

Several providers initially sent coverage at a broader level of geography than required, typically 
census tracts,  telephone exchange areas, or zip codes.  With public and commercial data on 
infrastructure, DSL and Cable models were prepared for each of these providers with best 
estimates of their coverage down to the finer granularity of a census block, along with the 
standardized spreadsheets with the details on each census block in the model.  A dynamic web 
based map service was also made available to assist them in identifying census blocks and tracts 
with a Google map backdrop.  Several providers subsequently used these tools and other analysis 
to submit more detailed coverage and data attributes in a second submittal. 

COMMUNITY ANCHOR INSTITUTIONS (CAI) 
 
LOGICAL CONSISTENCY REPORT  
All institutions on the initial draft spreadsheets used for the first two submittals were geocoded 
using ESRI Business Analyst Desktop with the USA Geocoding engine using TeleAtlas 
premium road features.  This was judged to be the best available geocoding source for batch 
processing of addresses.  No commercial source is 100% accurate in a primarily rural state such 
as this with low population numbers compared to other states and no large cities or metropolitan 
statistical areas.  In every round of geocoding we used conservative matching criteria, and 
maintained and stored the type of match (building match, address match, or zip code match), 
along with a record of those not matching and not able to geocode. 
 
COMPLETENESS REPORT  
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All geocoding is dependent on accurate road locations and complete and accurate street segment 
attribution.  The GIS road layers available from the state were not judged as complete as the 
premium commercial sources.  The Tiger 2009 road files, while spatially comparable to the 
commercial sources, have a large percentage of null values in the database attribution and street 
segment address ranges necessary for accurate geocoding.  As in most parts of the country, 
geocoding is more accurate in urban settings than in rural routes.  Complicating the process in a 
rural state for anchor institutions are the situation where some anchor institutions, such as public 
safety anchors are often staffed by volunteer staff and a post office box is the only valid address, 
and the physical address is wherever the public safety equipment is parked or stored at any given 
point in time. 
 
PROCESS DESCRIPTION  
Acquire lists of community anchor institutions. 
 
Lists were obtained from the state and affiliated processional organizations for anchor 
institutions to be included in the broadband mapping in each of the community anchor institution 
community code categories.   These were sorted and cross referenced and an initial round of 
elimination of duplication was accomplished. 
PROCESS DATE 2010-06-15 
 
PROCESS DESCRIPTION  
Create and publish and process user speed test web site. 
 
Created a public facing web site allowing anchor institutions to complete a brief survey and run a 
speed test on their connection using the Ookla speed test.  The speed test site allowed a user to 
enter their location as an address on a simple Google map driven interface, and subsequently 
choose to move the location if it did not geocode to their satisfaction.  Users were asked to select 
their technology of transmission from a list, enter their provider as a free text field, complete an 
optional questionnaire, and run a standard speed test on their connection.  Behind the scenes, the 
date and time, and IP address of the user were captured.   
All speed tests were geocoded, and the IP address was looked up in batch mode in the WHOIS 
database returning one or two providers registered with WHOIS.   All speed tests registered 
between March 3, 2010 and February 14, 2011 were cleaned and analyzed against provider 
submissions and models. 
 
A final provider assignment was assigned by examining the WHOIS fields, and the provider 
submitted by users.   
 
There was considerable variation in the technology of transmission reported by users taking the 
speed tests.  A final connection field was created and in most cases, the user selection was 
carried into this field.  If a provider had only one confirmed technology of transmission, than all 
technologies listed by users were standardized to that, otherwise the user selection was carried.  
The state chose to not use the speed test data for an authoritative determination of the question if 
the institution subscribes to broadband service at the location.  This was due to variability in user 
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responses, the anonymity of the user submission and the lack of a practical mechanism for 
authoritative user identification.  In future maintenance updates, the intent is to use the speed 
tests for anchor institutions in aggregate generalized analysis. 
 
PROCESS DESCRIPTION  
Geocode addresses and attribute anchor institutions. 
 
 All institutions on the initial draft spreadsheet were geocoded using ESRI Business Analyst 
Desktop with the USA Geocoding engine using TeleAtlas premium road features.  This was 
judged to be the best available geocoding source for batch processing of addresses.  No 
commercial source is 100% accurate in a primarily rural state such as this with low population 
numbers compared to other states and no large cities or metropolitan statistical areas.   All 
geocoding is dependent on accurate road locations and complete and accurate street segment 
attribution.  The GIS road layers available from the state were not judged as complete as the 
premium commercial sources.  The Tiger 2009 road files, while spatially comparable to the 
commercial sources, have a large percentage of null values in the database attribution and street 
segment address ranges necessary for accurate geocoding.  As in most parts of the country, 
geocoding is more accurate in urban settings than in rural routes.  Complicating the process in a 
rural state for anchor institutions are the situation where some anchor institutions, such as public 
safety anchors are often staffed by volunteer staff and a post office box is the only valid address, 
and the physical address is wherever the public safety equipment is parked or stored at any given 
point in time. 
 
PROCESS DESCRIPTION  
Assign community anchor institution category codes. 
 
Category codes were assigned based on the original source list and from keywords in the name 
of the institution and independent research.  Technology of transmission and advertised speeds 
were obtained when possible, which initially was entirely based on the anchor institutions 
maintained by the state for consortiums providing state service contracts.  Two iterations were 
accomplished with these state maintained lists, and all available attributes were obtained with 
assistance of the state analysts. 
 
PROCESS DESCRIPTION  
Cross reference anchor institutions against public data, research data attribution and delete 
duplicates. 
 
After initial data collection, analysts worked on researching, calling and improving the addresses 
for those below an 80% match criteria.  Many on the 70 percent matching range were fairly 
accurately located.  The difference between a 70% and 80% match typically occurred when an 
address lacked a prefix or suffix cardinal direction on a street that had two cardinal directions 
(example 101 1st Street, on a street segment with 101 N. 1st Street and 101 S. 1st Street).  
Analysts were also able to obtain physical addresses for some lists supplied by the state with 
only a P.O. Box. 
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PROCESS DESCRIPTION  
Final geocode addresses with corrections. 
 
The lists with updated and corrected addresses were re-geocoded for the final mapping effort, 
and any anchor with any level of geocoding was included on the final map.  The operational 
database identifies the type of match, so future maintenance cycles can be prioritized and 
targeted to those matching only zip codes or with address changes. 
PROCESS DATE 2010-06-15 
 
PROCESS DESCRIPTION  
Overlay all remaining anchor institution points via spatial join on broadband coverages unioned 
and dissolved by concatenated provider/technology of transmission combinations. 
 
Geocoded anchor institutions were spatially joined to unioned and dissolved concatenated 
provider/.technology of transmission combination broadband coverages.  This provided some 
level of validation that an anchor at least was located within an area of available broadband 
coverage. 
 
PROCESS DESCRIPTION  
Populate technology of transmission, availability of broadband service, and maximum advertised 
download and upload speeds. 
 
From the results of the previous step some attribution of database attributes for attributes with 
null values was accomplished.  This step was rule based.  The attribute of whether an anchor 
institution subscribes to broadband service could only authoritatively be answered yes, if the 
information was provided by the state, or a confirmation from an anchor speed test could be 
matched.  Those anchors that were located within an area covered by a DSL, cable, other copper 
or fixed wireless were also assumed to have the ability to subscribe to broadband coverage and 
were also estimated to be subscribers.  Assigning the technology of transmission and the 
advertised speeds (which required identifying a provider for the anchor institution) was only 
possible on a subset of all coverage in those areas where only one provider/technology of 
transmission was present.  This allowed a few hundred more anchors to be identified, but 
typically only occurred in rural settings.  Most urban settings had multiple providers.  In addition 
many providers submitted multiple technology options, so identifying one provider/technology 
of transmission combination was not possible even if there was only one provider possible for 
the anchor institution. 
It is likely that in some instances in the rural settings and small towns an anchor institution may 
rely on mobile wireless broadband.  This is common in public safety mobile equipment such as 
vehicles, but likely less common in anchor facilities.  For the purpose of assigning attribution to 
anchor institutions with remaining null attributes, we took a conservative approach and did not 
overlay anchor institutions on mobile wireless coverages to assign attributes. 
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PROCESS DESCRIPTION  
Maximum advertised downstream and upstream speeds were not available or collected for any of 
the CAIs.   
 
A new domain value of “U” for Unknown was added to the data model for the current 
submission, and all values formerly coded as 0, were changed to “U”. 
PROCESS DATE 2011-03-01 
 
 
PROCESS DESCRIPTION  
A new optional attribute was requested by NTIA for the current submittal requesting knowledge 
about the presence or absence of WIFI at the CAI location.   
 
This was not researched and attributed by the state in the current submission.  All records were 
set to “Unknown” for the attribute, Public Wi-Fi. 
 
 
PROCESS DESCRIPTION  
A new optional attribute was requested by NTIA for the current submittal requesting a CAI 
unique identification number for K-12 schools, libraries and colleges and universities.   
 
The following steps were completed for this request: Added CAIID for the Library category 
using the NCESID from  http://nces.ed.gov/surveys/libraries/librarysearch/   ;  Added CAIID for 
the University, college, other post-secondary category using the IPEDS ID  from 
http://nces.ed.gov/collegenavigator/ ; Added CAIID for the School – K through 12 category for 
public schools using the NCES ID from   http://nces.ed.gov/ccd/schoolsearch/ ;  Added CAIID 
for the School – K through 12 category for private schools using the PSS_SCHOOL_ID from   
http://nces.ed.gov/surveys/pss/privateschoolsearch/ 
 

 
PROCESS DESCRIPTION  
A new optional attribute was requested by NTIA for the current submittal requesting a URL for 
each anchor institution.  
  
Assigned URLs to CAI records: for the University, college, other post-secondary category  
assigned the URL from http://nces.ed.gov/collegenavigator/; for the Library category added the 
URL from http://nces.ed.gov/surveys/libraries/librarysearch/    
 
 

 

WIRELESS SERVICE COVERAGE (BB_Service_Wireless ) 

http://nces.ed.gov/surveys/libraries/librarysearch/�
http://nces.ed.gov/collegenavigator/�
http://nces.ed.gov/ccd/schoolsearch/�
http://nces.ed.gov/surveys/pss/privateschoolsearch/�
http://nces.ed.gov/collegenavigator/�
http://nces.ed.gov/surveys/libraries/librarysearch/�
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LOGICAL CONSISTENCY REPORT  
Data submitted by broadband providers was accepted as is when it was provided as a broadband 
coverage or at a census block level.  Provider coverage submitted at a coarser geographic scale 
was supplemented with public data, independent measurements and GIS modeling techniques.  
When independent measurements were available for typical broadband speeds and modeled 
location of infrastructure, some provider data was overridden or supplemented. 
 
COMPLETENESS REPORT  
All data submitted by broadband providers was mapped in complete form, except where 
independent measurements were used to supplement provider submittals.  Several providers did 
not participate in the broadband mapping process, including some that were suspected to be 
providers. 
 
PROCESS DESCRIPTION  
Public broadband data research. 
 
Two forms of wireless coverage were provided in this table, fixed point to point wireless and 
mobile wireless.  Outstanding questions remain to NTIA about fixed wireless, as to whether that 
technology fit in table 1(A) or in 1(B).  No answer has been forthcoming, so we chose to apply 
those in table 1(B).   No public data was located on fixed wireless infrastructure points, except 
notification of availability on provider's web pages, and in some instances, specific towns, 
recreation or commercial locations where wireless service was provided.  No modeling was 
attempted on fixed wireless coverage.  All coverage came directly from providers or was mapped 
from locations provided on a provider web page.  We did not attempt any propagation modeling 
on fixed wireless, since that can be influenced by local structures and vegetation in the vicinity.  
A few providers did provide coverages that appeared to be derived from propagation modeling. 
Most of the public data research focused on mobile wireless providers using cellular service 
spectrums.  The Federal Communications Commission (FCC) Universal Licensing System 
(ULS) is the consolidated database and application filing system for most Wireless Radio 
Services. ULS supports electronic filing and provides public access to licensing information, 
weekly Public Notices, FCC rulemakings, processing utilities, a telecommunications glossary, 
and much more." The FCC ULS Advanced Licensing Search was queried for all FCC licenses 
filed in the state; a relational database was built from the results. Information from the database 
was extracted in order to perform the cellular tower propagation modeling for wireless 
broadband. 
The FCC ALS and ULS reporting systems were the source for most of the tower locations.  
Towers were required to be licensed when they meet specific published criteria.  These included 
some variables that could be modeled with GIS statewide, such as varying proximity to airports 
and heliports, combined with specific local level criteria not easily obtained or modeled 
statewide such as the grade construction within proximity of these, and any structure over 200 ft 
in height.  A number of cell towers providing broadband were likely not located in the FCC 
database.  None of the mobile wireless providers were willing to provide infrastructure such as 
tower locations and parameters, and the coverages provided were very generalized. 
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The mobile wireless coverage in the state is in transition.  There were currently no GSM mobile 
wireless providers meeting the NOFA criteria for being a provider.  There is some GSM 
infrastructure in the state maintained for wholesale arrangements and roaming users with GSM 
technology.   

 
PROCESS DESCRIPTION  
Create and publish user speed test web site. 
 
A public facing website was created in the spring of 2010 asking internet users in the state to 
complete a brief survey regarding their internet connection and run a speed test on their 
connection using the Ookla speed test.  The speed test site asked that a user enter their location 
as an address on a Google map interface.  If the address did not geocode to their satisfaction, the 
user could choose to move the place mark to their desired location.  Next, users were asked to 
select their technology of transmission from a list, enter their provider in a free form text field, 
complete an optional questionnaire, and run a standard speed test on their connection.  The date 
and time, and IP address of the user were captured during the speed test.   
 
All speed tests were geocoded, and the IP address was looked up in batch mode in the WHOIS 
database returning one or two providers registered with WHOIS.   All speed tests registered 
between March 3, 2010 and May 14, 2010 were cleaned and analyzed against provider 
submissions and models for the first and second data submissions.  For the current (third) 
submission, all the data between March 3, 2010 and February 21, 2011 was standardized and 
used.  
 
For the first two submissions a final provider assignment was assigned by examining the WHOIS 
fields, and the provider submitted by users.  Consistent rules were not always possible, but 
generally when two WHOIS records were returned, the second more specific WHOIS provider 
was selected. In some instances, where the WHOIS providers were backhaul or other and were 
not providers meeting the NOFA criteria, the user submitted provider designation was cleaned 
and standardized and assigned as the final provider 
There was considerable variation between the user reported technology of transmission (TOT) 
and the known technologies for any given provider.  Records were divided on unique provider/ 
TOT combinations for the first and second submissions, which limited the record count in many 
instances.  For the current submission the records were divided only by provider, not taking TOT 
into consideration.  
 
For the first two submissions, the speed test records were used in two ways for the final 
processing. 
 
1) As an independent measurement to validate the presence/absence of a provider coverage for 
DSL and/or Cable technologies. 
In the first submission a few providers were identified as DSL broadband providers based 
primarily on speed tests.  In these instances, DSL models were executed for both providers based 
on verified central office locations.  Some Speed tests with an identified technology of 
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transmission of Cable Modem were used to expand “likely” cable areas which were typically 
adjacent to incorporated and urban areas.  These “cable-plus” areas were created to supplement 
submissions from Cable Modem providers who did not provide detailed coverage or census 
blocks.  No new DSL providers or Cable providers were identified using speed tests in the 
current submission. 
 
2) As an independent measurement for typical upload and download speeds. 
Once data were cleaned and final provider and technology of transmission assigned, these fields 
were concatenated.  In the first two submissions, if the remaining records exceeded 10 for the 
combination of provider and technology, and the speed test was successfully completed (values > 
0) the average value and standard deviation of the download speed were calculated.  Any values 
exceeding 1 standard deviation were removed as outliers, and the mean of the remaining records 
within 1 standard deviation was calculated for the download and upload speed. This value was 
reported for each provider/technology of transmission record as the typical speeds for that 
provider.  In some instances the typical speed was lower than that required to meet the definition 
of broadband by NTIA, but that did not preclude the records from being included in the 
broadband map in the first two submissions as it did in the current submission. 
For the current submission, these procedures were modified and all records were re-run.  The 
steps of the current processing are provided below.  The primary procedural change was to drop 
the validation of the presence/absence of provider coverage for DSL and/or Cable technologies, 
since providers had been validated in the first two submissions and potential new providers 
identified through additional speed tests were determined to not meet the NOFA criteria for 
being considered a broadband provider.  The use of the speed test data for determining typical 
speeds was implemented with similar rules as the first two submissions with the exception of the 
use of the technology of transfer, and raising the minimum number of speed tests to 15, after 
removing outliers, to be used in typical speed calculations.  Procedurally, the process was also 
automated with a Python script to improve processing performance and minimize quality 
control/quality assurance testing.   
 
Typical upload and download speeds for all providers with less than 15 processed speed test 
records were coded as null values.  In addition, based on telephone communication with NTIA 
on March 9, 2011, all typical speeds less than minimum NOFA upload of download speed 
criteria were also ignored and reported as null.  Based on a related request in the same 
communication, the typical speeds greater than the advertised speeds were ignored and reported 
as null.  Subsequently on March 17, in the NTIA grantee webinar, the NTIA staff indicated that 
typical speeds would not be compared to advertised speeds.  This rule change was not received 
in time to implement in the workflow for the current submission, and will be implemented in the 
fourth submission in the fall, 2011.  We anticipate other significant modifications in the use of 
the speed test data for the next submission, since many of the records older than one year will not 
be used in future calculations. 
 
Processing steps for the current submission are provided below: 
1. Speed test records were imported into a SQL Server data file, adding fields Final Provider 

and IPGroup to the initial records. 
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2. IPGroup attribute was set by extracting the left three nodes of the IP Address of the speed 
test (e.g. 161.7.1.236 had 161.7.1) moved to the IPGroup attribute. 

3. An IPGroup to Final Provider cross reference table was created to determine the final 
provider from the unique three part IPGroup  

4. Each IPGroup was reviewed with the data in the who is 1 provider, who is 2 provider and 
then the user specified provider to determine the most authoritative final provider from the 
official list of providers.  None of the WHOIS or user submitted fields were absolutely 
authoritative in all instances, so expert opinion by technicians knowledgable of the providers 
was used in some instances to assign the IPGroups, and subsequently the  Final Provider 
attribute. 

5. Run a python script to remove outliers and calculate summary statistics for each Final 
Provider assignment.  The rationale for removing outliers was to mitigate the many variables 
that effect a typical speeed test, such as the time of day, others on the network, etc.  The 
script implemented the following work flow rules: 

a. Use all records for each unique FinalProv attribute value with D_kbps greater than 0 or  
U_kbps greater than 0 , then: 

b. Calculate a mean for the unique provider group for each D_kbps and U_kbps. 
c. Calculate a standard deviation for the unique provider group for each D_kbps and U_kbps.  

Each speed attribute was calculated independently of the other. 
d. Subtract the outliers (if any) higher or lower than one standard deviation from the mean. 
e. Calculate the median value of the remaining non-outliers for each provider D_kbps and 

U_kbps respectively. 
f. Create a summary table with the final calculated assignment of FinalProv, D_kbps and 

U_kbps. 
6. Post process the summary table in the following sub steps: 
a. Join the summary tables by provider for the upload and download speeds into one summary 

file including the number of records or frequencies for up and down speeds for each provider 
after removing the outliers, and the mean up and down speeds in kilobits per second for each 
provider. 

b. Select "FreqDown" < 15 AND "FreqUp" < 15 then delete the resulting selection set from the 
joined table.  The FreqDown/Up fields counted the number of speed test records for a 
provider after the outliers more or less than one standard deviation from the mean value were 
removed from consideration. 

c. Select "D2_kbps" <= 768 kbps AND "U2_kbps" <= 200 kbps. then delete the resulting 
selection set from the joined table.   

7. Import the remaining valid mean values for each provider into the appropriate broadband 
coverage feature classes. 

8. Select any typical speeds greater than advertised speeds either up or down, and make the 
resulting records null in the final broadband coverage feature classes (as per NTIA request 
3/9/2011). 

 
PROCESS DESCRIPTION  
Creation, processing and maintenance of last point of aggregation for infrastructure. 
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Any fixed or mobile wireless antenna or tower location submitted by a provider, or obtained 
from the FCC that was used in the final processing for wireless broadband coverage was 
maintained in the operational database for last point of aggregation, and subsequently transferred 
to Table 3 backhaul and middle mile points. 
 
PROCESS DESCRIPTION  
Solicit broadband coverage areas, infrastructure, advertised and typical speeds and components 
of subscriber weighted nominal speed from providers. 
 
Requests were made via email and phone calls to every broadband provider to provide coverage, 
technology of transmission, advertised and typical download and upload speed at the census 
block level. 
 
All data types were accepted as submittals and a large variety of data were submitted, including 
narrative descriptions, coverage maps as JPG or PDF images, CAD files, GIS shapefiles, KMZ 
and KML files, FCC form 477 reports , and data spreadsheets.     
 
Providers that submitted actual broadband coverage data or census block representation of 
coverage along with the components necessary to complete the data attribution were not 
contacted for a follow up.  The providers who did not submit data based on initial queries were 
sent a standardized spreadsheet to map their coverage and optionally infrastructure, and 
subsequently a final notice email. 
 
PROCESS DESCRIPTION  
Fixed Wireless.   
 
Providers submitted coverage data in a wide variety of formats, levels of completeness, and at 
varying geographic scales. All types of data was accommodated and processed whenever 
possible. An open structure process for submittals was allowed, accepting any data, and 
attempting to work with the provider when questions arose. If data was submitted by a provider 
in a format that did not allow a direct coverage to be mapped, such as a coarse level of 
geography such as a census tract, or county, feedback was provided to the providers in the form 
of standardized spreadsheets in an attempt to standardize the inputs, and increase the geographic 
granularity of the provider data submission. Although each provider had individual 
characteristics and nuances in their data submissions, some data patterns can be described 
generalizing the typical types of submissions. In general, for fixed wireless to be mapped it was 
necessary to receive data from a provider, since there were no public sources available on point 
to point wireless tower locations in public form, except as depicted on providers web pages in a 
few instances.  
 
FCC FORM 477 REPORT OR SIMILAR FORMAT:  
Geographically, these were lists of census tracts of coverage, accompanied by additional 
documentation on technology of transmission, speed tiers, and number of customers. Providers 
submit these twice a year to the FCC and recent submissions have been done using a structured 
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web site maintained by the FCC. A few providers submitted printouts that appeared to be from 
this web format and were typically complete and standardized. More providers submitted 
spreadsheets roughly in the F477 format, but with modified and generalized data.  
 
HOW THEY WERE HANDLED:  
If the providers identified specific coverage areas as census blocks, or direct coverage area, or as 
infrastructure tower locations, they were processed and mapped. Providers identifying census 
blocks were processed by dissolving the census blocks into single coverage polygons by speed 
tier. Providers identifying a direct coverage area were converted directly to GIS polygon files 
and attributed. Providers submitting tower locations were mapped as circular polygons centered 
on the tower with a radius averaging 10 miles measured as Euclidian (straight line) distance from 
the tower. Providers that specified variable radius were mapped as circles at the radius they 
submitted.  
 
PROVIDERS SUBMITTING CENSUS BLOCK COVERAGE:  
A few providers submitted coverage as census blocks, either through a tabular listing of census 
blocks or spreadsheet, or in map format. It was common that a provider where public data 
indicated multiple technologies of transmission only submitted some of the technologies of 
transmission.  
 
HOW THEY WERE HANDLED:  
These were loaded directly into the master Census 2000 block coverage by provider and 
attributed with available data submitted by the provider. In instances where some data attributes 
were missing, such as advertised or typical speed tiers, or subscriber data, the data attributes 
were left blank or null. Providers identifying census blocks were processed by dissolving the 
census blocks into single coverage polygons by speed tier. A visual inspection of independent 
speed test data overlaying the provider submitted block coverage was completed, but no action 
was taken to override a provider's submittal.  
 
PROVIDERS SUBMITTING ACTUAL COVERAGE MAPS:  
Coverage maps were submitted by several providers, or coverages were derived from public 
sources or from other indirect indicators of coverage such as customer point maps or tabular lists 
in text or spreadsheet format. These were differentiated from the other types of geographic 
submission coarser than a census block since they represented the full and explicit range of 
coverage.  
 
HOW THEY WERE HANDLED:  
Coverage maps were treated as explicit coverage and all census blocks intersecting any portion 
of a coverage were selected and attributed with the provider coverage by technology of 
transmission, and all related attributes were transferred to the census block representation. The 
method of creating the coverage varied by source. Providers who supplied broadband coverage 
as a GIS polygon or CAD feature were converted to polygons. Some providers, including non-
responsive providers who did not submit anything to the project, had published coverage maps of 
various forms on their web sites or submitted an image in jpg, tiff, pdf or other graphic format. 
These were geogeorectified to base map layers, typically roads, but sometimes other features 
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such as state or county boundaries or towns, and subsequently converted to polygon features. 
Then they were intersected and transferred to census block feature classes like the digital GIS 
submissions. Providers who submitted customer locations typically fell into four categories. 
Some were submitted as AutoCAD files where the points could be transferred to the GIS, then 
spatially joined to the census blocks they were located within. Others submitted maps in image 
format that were georectified in the same manner as other images, then census blocks were 
selected by an operator viewing the customer point images underlying the census blocks. When 
customer lists were submitted, they were loaded in a database and geocoded using ESRI 
Business Analyst USA Geocoding engine based on TeleAtlas road features. The geocoded points 
were subsequently treated identically to customer locations submitted in GIS or CAD format, 
and spatially joined to the census block template file. A visual inspection of independent speed 
test data overlaying the provider submitted block coverage was completed, but no action was 
taken to override a provider's submittal.  
 
OTHER LEVELS OF COARSE GEOGRAPHIC SUBMISSION:  
This category had a wide range of submissions. The most common was as telephone exchange 
areas or equivalent, wire centers, zip codes, counties or general references to towns or cities. The 
problem with these submissions was that often a given polygon overlapped a census block or 
multiple blocks, and in most cases, they were much larger geographic entities than a census 
block.  
 
HOW THEY WERE HANDLED:  

Our operating rules established early in the project did not allow final provider coverage to 
significantly over represent provider coverage. Those providers that submitted coverage area 
by coarse geographic features and did not specifically identify coverage as a coverage layer 
or census blocks were not able to be processed. No interpolated data was used to calculate 
these data, if the data was not provided by a provider in a format capable of processing; the 
data was not calculated for that provider. 
 

PROCESS DESCRIPTION  
Mobile Wireless Verizon. 
   
Where cell tower locations for specific providers could be consistently identified, propagation 
models of wireless coverage were developed for mobile wireless.  SoftWright's Terrain Analysis 
Package software with the Longley-Rice algorithm for model development was used to develop 
the models. The models were constrained in a 25 radius of the tower. Output grid size was .5 
kilometers. Areas that had coverage with signal strength above 40 dbu was classified as having 
broadband availability. All propagation data meeting the above criteria were merged into a single 
geodatabase. Non- contiguous areas of less than .5 kilometers were removed from the coverage 
to climate scatter that was deemed to be an artifact of data processing limitations.   Verizon 
Wireless was the only provider where this method was possible to apply. A mobile wireless 
coverage was not provided by Verizon for the June, 2010 submission.  In August, 2010 Verizon 
provided a coverage that used an estimated one-quarter mile raster resolution, and the digital 
elevation model TetraTech used for this analysis and propagation modeling was based on 30 
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meter resolution. As a result individual TetraTech's coverage for Verizon shows a slightly more 
spotty pattern where influenced by local topographic characteristics. Due to some missing or 
unidentifiable towers, we anticipate that coverage may exist in some areas that were not 
indicated as coverage. Feedback from Verizon is needed to resolve differences, and is scheduled 
for the 2011 updates.  As a result, in the September, 2010 update we submitted the actual 
coverage provided by Verizon, replacing the TetraTech model submitted in June.  Provider 
submittals did not differentiate download or upload speeds by tower location, only statewide. 
The typical upload and download speeds for Verizon were reported based on the mean upload 
and download point samples from several hundred thousand speed test samples, averaged 
statewide. Since tower identification numbers are rotated by providers, it was not possible, 
without provider data input, to validate 3G speed availability on a tower by tower basis. CDMA 
technology does allow a switch from 2G to 3G via software, so it is more likely that most if not 
all CDMA towers in the state can theoretically provide broadband coverage.  An adequate 
number of speed tests were received for Verizon wireless, but the RootWireless data was more 
robust and hundreds of thousands of sample points were available, so the public speed test 
submittals were not used for this provider. All mobile wireless coverage were processed as single 
coverage files. All polygons had the same data attributes carried in all polygons.  For the third 
submission, April 2011 Verizon submitted a new and slightly revised wireless coverage map that 
was used for the submittal.   
 
PROCESS DESCRIPTION  
Mobile Wireless Alltel.  
 
Alltel coverage was mapped using the digital coverage submitted by the provider for the first 
submittal, June 2010.  Alltel did not provide an updated coverage for the second and third 
submittal, September 2010 and April, 2011, so the original coverage has been carried forward in 
each subsequent submittal. The provider submitted mobile wireless coverage depicted a larger 
area than was indicated by the independent measurements from Rootwireless. Rootwireless 
drove several thousand miles on state and federal highways in the state and provided ongoing 
point samples from several handsets with speed tests every 2 min and signal strength every 10 
seconds during operation. Provider submittals did not differentiate download or upload speeds by 
tower location, only statewide. The typical upload and download speeds for Verizon were 
reported based on the mean upload and download point samples from several hundred thousand 
speed test samples, averaged statewide. Since tower identification numbers are rotated by 
providers, it was not possible, without provider data input, to validate 3G speed availability on a 
tower by tower basis. CDMA technology does allow a switch from 2G to 3G via software, so it 
is more likely that most if not all CDMA towers in the state can theoretically provide broadband 
coverage.  All mobile wireless coverage were processed as single coverage files. All polygons in 
the two mobile provider coverage in the state had the same data attributes carried in all polygons.   
 
PROCESS DESCRIPTION  
Quality assurance testing. A separate analyst checked each provider submission. Due to the 
variety of provider submissions, the analyst originally doing the work and the analyst checking 
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discussed the interpretations when the criteria were subject to interpretation. Coverage, 
technology of transmission, and speed tier were checked completely for each provider. 
 

SPEEDTEST DATA PROCESSING 
 
PROCESS DESCRIPTION  
Create and publish and process user speed test web site. 

A public facing website was created in the spring of 2010 asking internet users in the state to 
complete a brief survey regarding their internet connection and run a speed test on their 
connection using the Ookla speed test.  The speed test site asked that a user enter their location 
as an address on a Google map interface.  If the address did not geocode to their satisfaction, the 
user could choose to move the place mark to their desired location.  Next, users were asked to 
select their technology of transmission from a list, enter their provider in a free form text field, 
complete an optional questionnaire, and run a standard speed test on their connection.  The date 
and time, and IP address of the user were captured during the speed test.   

All speed tests were geocoded, and the IP address was looked up in batch mode in the WHOIS 
database returning one or two providers registered with WHOIS.   All speed tests registered 
between March 3, 2010 and May 14, 2010 were cleaned and analyzed against provider 
submissions and models for the first and second data submissions.  For the current (third) 
submission, all the data between March 3, 2010 and February 21, 2011 was standardized and 
used. 

For the first two submissions a final provider assignment was assigned by examining the WHOIS 
fields, and the provider submitted by users.  Consistent rules were not always possible, but 
generally when two WHOIS records were returned, the second more specific WHOIS provider 
was selected. In some instances, where the WHOIS providers were backhaul or other and were 
not providers meeting the NOFA criteria, the user submitted provider designation was cleaned 
and standardized and assigned as the final provider 

There was considerable variation between the user reported technology of transmission (TOT) 
and the known technologies for any given provider.  Records were divided on unique provider/ 
TOT combinations for the first and second submissions, which limited the record count in many 
instances.  For the current submission the records were divided only by provider, not taking TOT 
into consideration.  

For the first two submissions, the speed test records were used in two ways for the final 
processing. 

1) As an independent measurement to validate the presence/absence of a provider coverage for 
DSL and/or Cable technologies. 

In the first submission a few providers were identified as DSL broadband providers based 
primarily on speed tests.  In these instances, DSL models were executed for both providers based 
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on verified central office locations.  Some Speed tests with an identified technology of 
transmission of Cable Modem were used to expand “likely” cable areas which were typically 
adjacent to incorporated and urban areas.  These “cable-plus” areas were created to supplement 
submissions from Cable Modem providers who did not provide detailed coverage or census 
blocks.  No new DSL providers or Cable providers were identified using speed tests in the 
current submission. 

2) As an independent measurement for typical upload and download speeds. 

Once data were cleaned and final provider and technology of transmission assigned, these fields 
were concatenated.  In the first two submissions, if the remaining records exceeded 10 for the 
combination of provider and technology, and the speed test was successfully completed (values > 
0) the average value and standard deviation of the download speed were calculated.  Any values 
exceeding 1 standard deviation were removed as outliers, and the mean of the remaining records 
within 1 standard deviation was calculated for the download and upload speed. This value was 
reported for each provider/technology of transmission record as the typical speeds for that 
provider.  In some instances the typical speed was lower than that required to meet the definition 
of broadband by NTIA, but that did not preclude the records from being included in the 
broadband map in the first two submissions as it did in the current submission. 

For the current submission, these procedures were modified and all records were re-run.  The 
steps of the current processing are provided below.  The primary procedural change was to drop 
the validation of the presence/absence of provider coverage for DSL and/or Cable technologies, 
since providers had been validated in the first two submissions and potential new providers 
identified through additional speed tests were determined to not meet the NOFA criteria for 
being considered a broadband provider.  The use of the speed test data for determining typical 
speeds was implemented with similar rules as the first two submissions with the exception of the 
use of the technology of transfer, and raising the minimum number of speed tests to 15, after 
removing outliers, to be used in typical speed calculations.  Procedurally, the process was also 
automated with a Python script to improve processing performance and minimize quality 
control/quality assurance testing.   

Typical upload and download speeds for all providers with less than 15 processed speed test 
records were coded as null values.  In addition, based on telephone communication with NTIA 
on March 9, 2011, all typical speeds less than minimum NOFA upload of download speed 
criteria were also ignored and reported as null.  Based on a related request in the same 
communication, the typical speeds greater than the advertised speeds were ignored and reported 
as null.  Subsequently on March 17, in the NTIA grantee webinar, the NTIA staff indicated that 
typical speeds would not be compared to advertised speeds.  This rule change was not received 
in time to implement in the workflow for the current submission, and will be implemented in the 
fourth submission in the fall, 2011.  We anticipate other significant modifications in the use of 
the speed test data for the next submission, since many of the records older than one year will not 
be used in future calculations. 

Processing steps for the current submission are provided below: 
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1. Speed test records were imported into a SQL Server data file, adding fields Final Provider 
and IPGroup to the initial records. 

2. IPGroup attribute was set by extracting the left three nodes of the IP Address of the speed 
test (e.g. 161.7.1.236 had 161.7.1) moved to the IPGroup attribute. 

3. An IPGroup to Final Provider cross reference table was created to determine the final 
provider from the unique three part IPGroup  

4. Each IPGroup was reviewed with the data in the who is 1 provider, who is 2 provider and 
then the user specified provider to determine the most authoritative final provider from the 
official list of providers.  None of the WHOIS or user submitted fields were absolutely 
authoritative in all instances, so expert opinion by technicians knowledgable of the providers 
was used in some instances to assign the IPGroups, and subsequently the  Final Provider 
attribute. 

5. Run a python script to remove outliers and calculate summary statistics for each Final 
Provider assignment.  The rationale for removing outliers was to mitigate the many variables 
that effect a typical speeed test, such as the time of day, others on the network, etc.  The 
script implemented the following work flow rules: 

a. Use all records for each unique FinalProv attribute value with D_kbps greater 
than 0 or  U_kbps greater than 0 , then: 

b. Calculate a mean for the unique provider group for each D_kbps and U_kbps. 

c. Calculate a standard deviation for the unique provider group for each D_kbps and 
U_kbps.  Each speed attribute was calculated independently of the other. 

d. Subtract the outliers (if any) higher or lower than one standard deviation from the 
mean. 

e. Calculate the median value of the remaining non-outliers for each provider 
D_kbps and U_kbps respectively. 

f. Create a summary table with the final calculated assignment of FinalProv, D_kbps 
and U_kbps. 

6. Post process the summary table in the following sub steps: 

a. Join the summary tables by provider for the upload and download speeds into one 
summary file including the number of records or frequencies for up and down 
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speeds for each provider after removing the outliers, and the mean up and down 
speeds in kilobits per second for each provider. 

b. Select "FreqDown" < 15 AND "FreqUp" < 15 then delete the resulting selection 
set from the joined table.  The FreqDown/Up fields counted the number of speed 
test records for a provider after the outliers more or less than one standard 
deviation from the mean value were removed from consideration. 

c. Select "D2_kbps" <= 768 kbps AND "U2_kbps" <= 200 kbps. then delete the 
resulting selection set from the joined table.   

7. Import the remaining valid mean values for each provider into the appropriate broadband 
coverage feature classes. 

8. Select any typical speeds greater than advertised speeds either up or down, and make the 
resulting records null in the final broadband coverage feature classes (as per NTIA request 
3/9/2011). 

 
Quality Assurance Testing 

A separate analyst checked each provider submission.  Due to the variety of provider 
submissions, the analyst originally doing the work and the analyst checking discussed the 
interpretations when the criteria were subject to interpretation. 

Coverage, technology of transmission, and speed tier were checked completely for each 
provider.  

Many of the models and block, tract and coverage level processes were completed with ESRI 
Modelbuilder and Python scripts, and these methods were tested for quality assurance in the 
preliminary mapping stages and in the initial sample data submissions to NTIA. 

All providers who submitted geographic coverage coarser than a census block were provided a 
data checking package to assess for accuracy and completeness.  Any comments received from 
providers were processed. 

1. QA/QC Checks prior to Individual Data Processing (i.e., block or coverage geoprocessing 
model).  [Automated Modelbuilder tools and follow-up by an analyst] 

a. Check for inconsistencies within the Provider Name, DBA Name, FRN 
b. Check for duplicate census blocks or coverage areas 
c. Check the Provider Name, DBA Name, FRN against the “Official Provider 

Table” 
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2. For each provider after initial data processing is completed [Review by an analyst that did 
not process the original data] 

a. Review correspondence log 
i. Review recent correspondence, since previous NTIA submission 

ii. Note changes/additions/comments on coverage area, technologies, speeds, 
infrastructure, subscriber weighted nominal speeds (SWNS) 

b. Review wiki data processing page (current metadata)    
i. Note changes/additions/comments on coverage area, technologies, speeds, 

infrastructure, SWNS 
c. Review individual Provider Wiki page (historic metadata)     

i. Note changes/additions/comments on coverage area, technologies, speeds, 
infrastructure, SWNS 

d. Check Provider Data Folder 2011_03          
i. Review recent data submissions, since previous NTIA submission 

e. Check Working Data Folder 2011_03  
i. Review current update feature class geography 

ii. Review coverage with provider’s submissions 
iii. Review technology of transmissions (TOTs) with provider’s 

submissions      
iv. Review Max Adv Speeds: Down/Up with provider’s submissions        

 

3. For each provider after final data processing is completed [Review by an analyst that did not 
process the original data] 

a. Check PROVCOV_Master geodatabase:Provider Blocks feature class and/or 
Provider Coverage feature class 

i. Review geography 
ii. Review TOTS 

iii. Review Max Adv Speeds: Down/Up 
 

4. Check Infrastructure feature class [Review by an analyst that did not process the original 
data] 

a. Review recent submissions, since previous NTIA submission 
 

5. Check SWNS feature class [Review by an analyst that did not process the original data] 
a. Determine if provider submission is valid 

 
6. For each provider after speed tests are processed [Review by an analyst that did not process 

the original data] 
a. Check PROVCOV_Master geodatabase  for Typical Speeds: Down/Up        
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7. QA/QC Checks and Reports on the Final NTIA Deliverable [Automated Modelbuilder tools 
and follow-up by an analyst] 

a. Check the Provider Name, DBA Name, FRN against the “Official Provider 
Table” for each NTIA feature class (i.e., BB_Service_CensusBlock, 
BB_Service_RoadSegment, BB_Service_Wireless, etc.).   
NTIA_Provider_Name_DBA_FRN_Errors_Sample.xls, looks at each NTIA 
feature class (i.e., census blocks, road segments, wireless, etc…) and checks to 
see if there is an identical match in the “Official Provider Table.”  If an identical 
match does not exist for that Provider Name, DBA Name, FRN concatenation it is 
written to a geodatabase table along with the NTIA feature class where the “error” 
occurred.  When an “error” does occur it then has to be checked by an analyst and 
corrected if necessary. 

b. Change Detection Report – This geoprocessing model compares and reports any 
changes in the Census Block, Road Segment, and Wireless feature classes for the 
current and previous versions of the NTIA SBDD Transfer database. The user 
needs to supply the feature classes for each NTIA version as well as the name of 
the final change detection table.  NTIA_Change_Detection_Example.xls, 
compares and reports any changes (limited to Provider Name, DBA Name, FRN, 
TOT combinations) in the Census Block, Road Segment, and Wireless feature 
classes for the current and previous versions of the NTIA SBDD Transfer 
database.  If the final change detection table has no records, then no changes were 
detected between the two databases.  If a Provider Name, DBA Name, FRN, TOT 
combination does not have a “pair” in either direction (the current or previous 
NTIA database) then it is written to a geodatabase table along with the NTIA 
feature class and version where the “error” occurred.  This report does not change 
any data in either database but rather acts as a flag, requiring an analyst to check 
if the “error” is valid.   

c. Check for duplicate census blocks or road segments or wireless coverage areas. 
d. Check for duplicate anchor institution points. 

 
8. Review Final NTIA deliverables [Review by an analyst that did not process the original data] 

a. Review BB_ConnectionPoint_MiddleMile 
b. Review BB_Service_CAInstitutions 
c. Review BB_Service_Census Block 
d. Review BB_Service_Overview 
e. Review BB_Service_RoadSegment 
f. Review BB_Service_Wireless      

 

9. Run the NTIA Check submission tool and python tool to confirm that all possible records 
passed the NTIA data checks.  The only items that failed in the checking process were those 
where inconsistencies in the final NTIA NSGIC data model did not agree with the final 
documentation and rules established by NTIA and FCC in the final webinar and 
documentation presented March 17, 2011.  These exceptions were documented along with 
the submission. 
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1.0 Provider Outreach 

1.1 Mapping Participants 

Apex and the Nebraska Public Service Commission (NPSC) began the mapping project 
by collecting contact information for providers listed on the FCC’s 477 data base and 
from Nebraska certificated and rural local exchange carriers, communications providers 
(internet service providers, cellular, fixed, and mobile wireless) that had registered with 
the NPSC and other potential providers thought to be in the State of Nebraska.  The total 
number of potential internet service providers (ISPs) on the original combined list was 
283.  Using various research methods (telephone calls, web searches, crowd source) 159 
names were identified as either a subsidiary of an ISP already on the list or did not 
provide internet access service at that time.   

Non-disclosure agreements (NDAs) were sent to 124 potential ISPs. In reviewing the 
NDA information some ISPs determined that they did not meet the broadband speed 
qualification standard by the National Telecommunication and Information 
Administration (NTIA) or did not return the NDA.  Two ISPs refused to participate in the 
mapping program. The NE_DataPackage_2011_04_08.xls file in the 
NE_SBDD_2011_04_08 data submittal provides a current list of ISPs and their status. 
The NPSC staff and Apex are engaged in ongoing outreach activities to encouraging ISPs 
to participate and identify new ISPs.   

 

1.2 Non-disclosure Agreement (NDA) Process 

The NDA process was completed for most providers during the first quarter of 2010.   
Prior to that time, Apex developed a standard NDA to be used in this project.  Broadband 
providers were made aware of the NDA through a series of emails and reminder emails, 
workshops and individual calls to contact persons.   Most providers used the standard 
NDA.  However, a few of the providers requested minor changes in the standard NDA.  
Those changes were accepted whenever possible.  In a limited number of instances, 
several iterations of changes were negotiated. Providers and Apex were able to agree on 
the final NDA. 

NDAs will be executed with new ISPs as they are identified.  
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2.0 Data Collection 

2.1 Data Input  

2.1.1 First and Second Round  

In the first round a data input template in an Excel spreadsheet format was developed by 
Apex and given to ISPs for use in the data submission. The template was based on the 
appendix to the NTIA Notice of Funds Available (NOFA) as amended by the NOFA 
clarification. The template included the following worksheets associated with the State 
Broadband Data and Development (SBDD) Grant Program Data transfer deliverable:  

a. BB_Service_Address 

b. BB_ConnectionPoint_MiddleMile 

c. BB_Service_CensusBlock 

d. BB_Service_RoadSegment 

e. BB_Service_Wireless 

f. BB_Service_Wireless_Antenna 

g. BB_ConnectionPoint_LastMile 

h. BB_Service_Overview 

i. BB_Service_CAInstitutions 

The wireless worksheet included information requested by the NOFA and information 
required to generate the propagation patterns for wireless service areas. 

In the first round data collection, Apex experienced numerous occasions where 
Information Service Provider (ISPs) submitted data that was incorrect or insufficient.  

In the second round the NPSC, selected ISPs based on geographic coverage and 
willingness to work with the NPSC to improve the data collection process.  

These efforts included on-site meetings with the staff of the ISPs to explain in detail the 
overall mapping process, sharing of the specific data requirements of the NOFA, 
examining the results of the first round of data collection, and identifying issues that 
contributed to difficulties in data collection, submission, and presentation.  

 

2.1.2 Third Round  

After the one-on-one meetings with the selected ISPs in Round 2, the NPSC perceived a 
need for a more simplified, user-friendly, and standardized method for ISPs to provide 
the required data in the allowed Microsoft Excel format.  Consequently, the NPSC began 
development of a sophisticated, user friendly, method to allow ISPs the ability to provide 
broadband data in a standardized, validated format.  The DIM was implemented for the 
third round of data collection.   
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The DIM provides a uniform method of data entry; minimize the repetitive entry of 
company specific data, while performing real-time validation of submitted data. The DIM 
is a robust mechanism, developed in Microsoft Excel, on a Windows platform, with all 
supporting modules residing in a Visual Basic environment. 
 
The DIM provides for three operations; manual record input, with field verification, 
import of an entire dataset, with field verification and error logging, and export of a 
verified dataset to be submitted to the NPSC. 
 
To facilitate these operations, DIM users are guided through an interactive menu 
environment.  Initial menus allow for entry of Provider Name and DBA Name unique 
pairs based on a dropdown list of predefined entities.  The Federal Registration Number 
(FRN) associated with that unique pair is then populated as a function of the user’s 
entries.1  Finally, in order to enter the record input stage, an ISP must select the modality 
and ownership status of service for which broadband data is being provided.   
 

 
 

Specific data requirements, also as a function of the user’s selections, are then 
dynamically displayed and made available for entry.  The data entry structure is 
demonstrated below. 
 

Wireline / Cable Carriers 

Alternative I 
Required Tabs 

                                                 
1  The NPSC requires all ISPs have an FCC Federal Registration Number (FRN) to submit data, 
ensuring all data and DBAs are appropriately assigned.  The DIM allows the NPSC to manage this 
requirement as, absent the existence of a valid FRN, an ISP is unable to enter the data entry portion of the 
DIM.  The NPSC enacted this requirement to ensure knowledge of any new ISP entering the Nebraska 
market, prior to its providing broadband data. 
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BB_SERVICE_ADDRESS 
BB_SERVICE_OVERVIEW 
BB_CONNECTIONPOINT _MIDDLEMILE 

Optional Tabs 
BB_CONNECTIONPOINT_LASTMILE 
BB_SERVICE_CAINSTITUTION 

Alternative II 
Required Tabs 

BB_SERVICE_CENSUSBLOCK 
BB_SERVICE_ROADSEGMENT 
BB_SERVICE_OVERVIEW 
BB_CONNECTIONPOINT _MIDDLEMILE 

Optional Tabs 
BB_CONNECTIONPOINT_LASTMILE 
BB_SERVICE_CAINSTITUTION 

 

Wireless Carriers 

Required  
BB_SERVICE_WIRELESS 
BB_SERVICE_OVERVIEW 
BB_CONNECTIONPOINT _MIDDLEMILE 

Verification Required 
BB_WIRELESS_ANTENNA 

Optional 
BB_CONNECTIONPOINT_LASTMILE 
BB_SERVICE_CAINSTITUTION 

 
For each record in a worksheet, key fields are required to initiate and continue the data 
entry process.  Each field is validated upon entry to ensure consistency and compliance 
with NTIA data model requirements.2  Finally, once entry is complete, the ISP utilizes 
the DIM’s export function and provides said results for submittal to the NPSC. 
 
The data entry requirements inherent to the DIM’s underlying validation result in a more 
uniform dataset for mapping purposes, ensuring a more accurate mapping process and 
effective mapping product.  The project mapping vendor, California State University – 
Chico, found the use of the DIM in the third round of data collection created efficiencies 
not experienced in earlier rounds. 
 

                                                 
2  To further facilitate the process, each data tab is color coded to indicate those datasets which are 
mandatory versus voluntary, as well as available help for each field. 
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The DMI’s dynamic, forward-thinking, design gives the NPSC a priceless tool to utilize 
in its endeavors as it strives to provide an accurate picture of the landscape today, while 
maintaining focus in an ever-changing environment, on the visions of tomorrow. 

2.2 Engage ISP Participants  

2.2.1 Workshop 

NPSC and Apex conducted a workshop prior to Round 3 data collection to 
explain how to use the DIM. This workshop was conducted in Lincoln, Nebraska, 
on October 7, 2010. ISPs that could not attend were able to participate via web 
based Live Meeting© 

At the workshop NPSC discussed the data collection and mapping issues faced 
during the first two data submissions to the NTIA, the lessons learned, plans for 
the Third Round Data submission and how to use the data submission and review 
tools. Participants were provided a CD containing the DIM for use in collecting 
and submitting the next round of data to the Commission and the ESRI ArcReader 
tool for reviewing their data after processing and before submittal to the NTIA. 

2.2.2 Teleconferences 

The NPSC staff and Apex provide “help-desk” service to the broadband providers 
using both teleconferences and Live Meeting© sessions. During the calls, the 
NSPC staff and Apex gave in depth guidance to provider questions regarding the 
DIM, alternative data submission templates and other inquiries from the providers 
regarding the Nebraska and NTIA projects. In each of these sessions the ISP was 
walked through the process of loading data into the DIM and submitting the data 
to Apex using the SharePoint Portal. 

2.3 SharePoint Portal for Data and Map 

Apex uses a SharePoint portal to collect data and distribute information to broadband 
providers.  General information and announcements are available to all participating 
providers.  In addition, each provider is assigned a unique password protected folder.  
The provider submits confidential data into the folder.  Apex gathers the submitted data 
from the folders to begin the data processing procedures.  

2.4 Data Scrub using DataSlave 

The NTIA SBDD data model requirements and python script 
(SBDD_CheckSubmission.py Version 1.0) checks were implemented in DataSlave. The 
Python source code was examined and reverse engineered into the DataSlave. ISP data 
submission in the DIM format was processed in DataSlave and fall outs were addressed 
with the individual providers. For example, if the maximum advertised Down/Up speed 
was missing, the provider was asked to re-submit the data. 
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3.0 Community Anchor Institutions 

3.1 Community Anchor Institutions (CAI) 

The method used to collect data consisted of the NPSC sending emails and making 
telephone calls to specific groups that represent Community Anchor Institutions (CAI’s) 
in Nebraska such as: 
 

 Chief Information Officer for Nebraska 
 Nebraska Hospital Association 
 Nebraska Office of Rural Health 
 Nebraska Library Commission 
 Nebraska Information Technology Commission 
 Catholic Health Initiatives and Network Nebraska 

 
These entities provided information on the locations and contact information for 
hospitals, county health departments, libraries and schools including post-secondary 
institutions. Network Nebraska is tasked with implementing legislation designed to 
migrate the past distance learning environment to an IP based system which includes 
scheduling software. The NPSC is represented on the Network Nebraska steering 
committee known as the Collaborative Aggregation Partnership (CAP) and significant 
information on broadband service provided to schools was obtained from Network 
Nebraska data. ISP’s have also provided CAI broadband information.  
 
The NPSC is considering expanding the definition of CAI’s to include other entities 
based on public input that may qualify as anchor institutions.  Nebraska has 93 counties 
and the NPSC is considering engaging county Geographical Information System (GIS) or 
Information Techknowledge (IT) personnel to obtain further broadband information. 
 
The collection of CAI broadband information requires extensive time and effort to send 
initial emails, follow-up emails and place telephone calls. The following analysis is a 
summary of the classification of CAI’s contained in our data set: 
 

Nebraska Round 3 CAI Data Analysis  

1 - School - K through 12 1,487 
2 - Library 91 
3 - Medical/healthcare 147 
4 - Public safety 129 
5 - University, college, other post-secondary 162 
6 - Other community support - government 348 
7 - Other community support - nongovernmental 134 
TOTAL 2,498 
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4.0 Data Validation 

Four validation techniques were developed and implemented. First, a direct in-person 
survey was conducted by Edison Research (Appendix B). Second, Apex developed 
ProField Drive application to test the wireless signal coverage of major wireless 
broadband providers. Third, Apex conducted phone and mail survey of Nebraska 
residential customers. Finally Apex developed an online speed test, however as discussed 
below, this test was discontinued.  

4.1 Edison’s Sample Methodology Scope 

The sample methodology for the Nebraska broadband study conforms to principles of 
probability sampling. That is, each census block has a known, and measurable, 
probability of being selected. Likewise, each household within a census block has a 
known selection probability. The population consists of all households in Nebraska. The 
sample frame is a list of all census blocks with households (as reported by the 2000 
census) in Nebraska. For additional information on the sample methodology and survey 
refer to Appendix B. 
 

Stratum Sample Census 
Block 

Allocation 

Percent of 
Households

1 – Douglas County 75 27.3% 
2 – Cass, Lancaster, Sarpy counties   37 22.8% 
3 – Medium Rural/Urban Area  (17 counties) 97 24.7% 
4 – Rural West  (53 counties) 77 13.7% 
5 – Rural East  (18 counties)  57 11.1% 
6 – Thurston County (Indian Reservation)  7 0.3% 

 
 
The in-person survey was conducted in 597 Nebraska census blocks. The survey 
validated ISPs’ supplied information that Broadband service was available in 583 (98%) 
of the survey census blocks. In the remaining 14 (2%) of the census blocks Edison was 
unable to determine if the offered service qualified as a Broadband service per NTIA’s 
definition. 

Validation Methods Wireline Wireless 

ProField - Field Survey  x x 
Drive Test   x 
Phone and Mail Survey  x x 
Online Speed Test  x x 
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4.2 ProField Drive Test 

Apex used two Nebraska residents to perform the Spectrum Drive Test. The hardware 
used included a laptop with 3 nationwide ISP data cards. (AT&T, Verizon and Sprint) 
and customized ProField software.  The route was divided into two regions, Eastern and 
Western Nebraska. A total of over 3,000 road miles were covered during the drive test.  

The ProField application cycles through each ISP card and captured the RSSI value and 
recorded to the database. The data was continuously uploaded to the Database Server. A 
chart of East and West routes along with the validation charts are contained in Appendix 
C.  

The Spectrum drive test was conducted in 5,637 Nebraska census blocks. The drive test 
validated ISPs’ (AT&T, Verizon and Sprint) supplied information that Broadband service 
was available in 5,287 (94%) of the census blocks. In the remaining 350 census blocks 
Apex was unable to determine if the offered service qualified as a Broadband service per 
NTIA’s definition. 

4.3 Mail and Phone Survey 

Apex procured Nebraska resident data from US Data Corporation. Apex selected a 
random sample of residents. The sample was divided into two groups. The first group 
was called over a period of two weeks. The second group received the survey in the mail 
and was asked to complete the survey and return it in a pre-paid envelope. 
 
The sample was selected to complement the in-person Edison survey and the planning 
survey. Census blocks already sampled by the Edison survey and the planning survey 
were excluded from the mail and phone survey. 
 
Mail and phone survey questionnaire collected information that was similar to Edison’s 
in-person survey.  
 
The mail survey was sent to 3,003 Nebraska residents. A total of 506 residents responded 
to the survey, a response rate of 17%. Of the 506 residents, 445 had broadband service. 
The broadband customers resided in 433 unique census blocks. The responses indicated 
that 88% of the residential customers subscribed to a broadband service. The results 
validated ISPs’ submitted data for census blocks with broadband service.3  
 
The phone survey contacted 2,500 Nebraska residents in 293 unique census blocks. 
Broadband service was available in 63% of the census blocks. The results matched the 
ISPs’ submitted data for the respective census blocks.  
 

                                                 
3 A mail survey conducted by the Nebraska Planning group (consisting of the University of Nebraska – 
Lincoln, Nebraska Information and Technology Commission, and the Nebraska Department of Economic 
Development) in February/March 2010 had a response rate of 47% and identified similar broadband 
availability. The complete results of this survey were filed with the NTIA program office in the NPSC 
quarterly report on July 30, 2010.  



4-12 
 

4.4 Online Speed Test 

As a component of verification, the NPSC’s vendor, Apex, initially established an Online 
Speed Test, requesting consumers perform a test to record the speed of their broadband 
connection.  Data collected was to include geographical identifiers, upload and download 
speeds, and latency.  Preliminary review of the testing methodology was conducted by 
Apex. 

In addition to the online availability of the Apex speed test, the NPSC provided a 
disclaimer to participants noting, in part, the irregular variability inherent to measuring 
broadband speed availability at a given time, using a given hardware configuration.  
Further, the NPSC stated, while a speed test may give consumers information on relative 
speed, the test was not endorsed as a definitive testing method. 

Irrespective, subsequent to implementation, the NPSC began fielding numerous 
complaints regarding the testing results from consumers and industry representatives 
alike.  In an independent effort, the NPSC conducted a review of the testing methodology 
and determined the testing results to be inconsistent and unreliable.  Results deviated 
significantly when compared to those obtained utilizing Speedtest.net, owned and 
operated by Ookla, and displayed significant variation across platforms.  Further, the 
results obtained via the Apex Online Speed Test were not consistent with those reported 
by ISPs themselves. 

As such, the NPSC determined it necessary to remove access to the Online Speed Test, 
rather than risk losing the trust and confidence of consumers and the support of the 
industry.   
 
The NPSC is itself currently in the initial stages of developing a statistically sound 
methodology to employ the speed test results provided by the Federal Communication 
Commission (FCC) speed test results, obtained in cooperation with Ookla Net Metrics 
and M-Lab, in its verification processes going forward.  Expanding on this preexisting 
relationship increases the level of confidence in the data being collected and provides for 
a far greater sample size than could be collected by a single testing site. 
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5.0 Map Processing 

5.1 CSU – Chico (Appendix A) Map Processing 

Of the scrubbed ISP data to California State University (CSU), our sub-contractor for 
mapping, the following processing steps are involved in the mapping effort Apex 
transmits: 

1. Address Geocoding 

2. Census Block – less than two square mile 

3. Road Segment – Census block greater than two square mile 

4. Service Overview 

5. Middle Mile 

6. Wireless 

7. Wireless Propagation  

5.1.1 Address Geocoding (Figure 6-1) 

ISPs submit address data in tabular format using the DIM. Address records are 
geocoded to the street segment level using Nebraska road segment E911 reference 
data. Matched records are preserved as a geographic point layer.  

Records not meeting the minimum match requirements are selected and exported 
in tabular format. Non-matching records are run through a second geocoding 
process using a composite locator built on underlying TeleAtlas reference data.  

This secondary geocoding process produces match results at the street segment 
level, where possible. If no qualifying street segment is found, the locator will 
move to a secondary level of matching based on city/state. City/state matches are 
represented as a generalized center point of the geographic area considered to be 
included or related to any city, town, or community within the state. Street 
segment and city/state matches are preserved as a geographic point layer. The two 
geocoding match result layers are then merged to create a single geographic point 
layer representing all records within the submission that matched with confidence 
at any particular level.  
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Figure 6-1: Geocoding Process 

 

The attribute table of this layer is analyzed to produce a report of how many 
records were matched to each specific locator through both geocoding processes. 
The address point layer is then run through a spatial relation process against 
census block polygons in order to obtain the appropriate FIPS number for each 
address point location. All non-matching records are preserved in table format and 
returned to the provider for review.  

Optionally, Internet service providers may submit address data as longitude and 
latitude coordinate pairs in tabular format. Longitude and latitude coordinate pairs 
are plotted on the map and preserved as geographic point locations. This layer is 
then run through the same spatial relation process as the address data to obtain the 
appropriate FIPS number for each address point location. 

If a combination of address listings and longitude and latitude coordinate 
information is submitted, the data will be processed accordingly in respect to each 
data type and then combined upon output to create final address output layer. 

Addresses that fall in census blocks less than two square miles are removed from 
the Round 3 submission. 
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5.1.2 Address to Census Block Association (Figure 6-2) 

Final address result layers are run through a spatial relation process against census 
block polygons. The resulting output is a polygon format representing all census 
blocks in which each geographic address point resides. All broadband-specific 
attribution is propagated over to the census block polygons from the provider’s 
final address point layer. Census block polygons are then reviewed in regards to 
their geographic area.  

Only those census block polygons that are less than two square miles in size are 
preserved. All polygons that are greater than two square miles in size are 
removed. This process can result in duplicate stacked polygon in cases where 
multiple address points fell within the same census block polygon and have the 
same underlying characteristics in regards to broadband data attribution. Census 
block polygons are reviewed for duplicate records and filtered to preserve unique 
records only. 

Figure 6-2: Address to Census Block Association 

 



5-16 
 

 

5.1.3 Address to Street Segments Association (Figure 6-3) 

The final address result layer is divided into multiple layers specific to technology 
of transmission and speed characteristics. Each unique class of address is run 
through spatial relation processes along with a street segment line layer to obtain 
a unique identifier for the nearest segment to each individual address point. The 
resulting output is address point features containing the unique identifier of the 
closest street segment attributed in the address layer’s data table. A table join is 
executed, appending the broadband characteristics of the address data to the street 
segments. The appropriate street segments are called out and preserved.  

An erase operation is then run using the provider’s resulting census block polygon 
layer to remove any street segments that fall within service census blocks that are 
less than two square miles in area. All remaining street segments are preserved to 
represent service in areas where census blocks are greater than two square miles 
in area. 

Addresses which are submitted as latitude/longitude with no corresponding street 
address information and which are in census blocks greater than two square miles 
(representing no more than 5% of all address and latitude/longitude locations) 
were removed from the Round 3 submission because the latitude/longitude 
locations could not be verified by a unique address. These locations will be 
developed further in Round 4.  

 

Figure 6-3: Street Segments from Addresses 
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5.1.4 Census Block (Figure 6-4) 

Internet service providers submit address data in tabular format. A table join is 
done using census block centroid points to append longitude and latitude 
coordinates to each record in the submitted census block table. Output is a stand-
alone representing each census block submitted by the provider and now contains 
the longitude and latitude coordinates of a point within the relative census block. 
This information is used to plot coordinate pair events. The output is a point 
dataset representing each record submitted by the provider. This point layer is 
then run through a spatial relation process along with the census block polygons. 

Output is a polygon layer representing all submitted census block records for said 
provider. Census block polygons are reviewed for duplicate records and filtered to 
preserve unique records only. 

Figure 6-4: Census Block  
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5.1.5 Street Segment (Figure 6-5) 

ISPs submit street segment data by census block in tabular format. A spatial 
relation process is run using the submitted census block records to call out the 
specific census blocks in which a provider claims to have service. The appropriate 
street segments are called out via the census blocks reported and preserved. An 
erase operation is then run using the provider’s resulting census block polygon 
layer to remove any street segments that fall within service census blocks that are 
less than two square miles. All remaining street segments are preserved to 
represent service in areas where census blocks are greater than two square miles.  

 
Figure 6-5: Street Segments 
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5.1.6 Service Overview (Figure 6-6) 

ISPs submit county overview data in tabular format. A table join is done using 
county centroid points to append longitude and latitude coordinates to each record 
in the submitted census block table. Output is a standalone representing each 
county submitted by the provider and now contains the longitude and latitude 
coordinates of a point within the relative county. This information is used to plot 
coordinate pair events.  

The output is a point dataset representing each record submitted by the provider. 
This point layer is then run through a spatial relation process along with the 
county polygons. Output is a polygon layer representing all submitted county 
records for said provider. County polygons are reviewed for duplicate records and 
filtered to preserve unique records only. 

Figure 6-6: Service Overview 
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5.1.7 Middle Mile (Figure 6-7) 

ISPs submit middle mile data as longitude and latitude coordinate pairs in tabular 
format. Longitude and latitude coordinate pairs are plotted on the map and 
preserved as geographic point locations. The middle mile point layer is then run 
through a spatial relation process against census block polygons in order to obtain 
the appropriate FIPS number for each middle mile point location. 

 
Figure 6-7: Middle Mile 
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5.1.8 Wireless  

Data is submitted by the ISPs in ESRI Shape file or Geodatabase format, which 
will be imported in the Geodatabase. CSU verifies the underlying data and creates 
a draft ISP coverage map.  

5.1.9 Wireless Propagation 

Providers who offer wireless service but could not submit a shape file or 
geographic representation of their service area provide tabular antenna 
information. Wireless antenna parameters are used to model a service area, and 
shape files are created for each provider. The wireless propagation model is based 
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on the Longley-Rice, Irregular Terrain propagation model. Individual unit 
specifications are used to measure performance based on frequency, transmit 
power, receiver sensitivity, antenna gain and height. Signal coverage patterns are 
produced for each individual unit taking into account terrain and vegetation 
features that may hinder signal dispersion. 

Longley-Rice is a system for forecasting the attenuation of radio waves in the 
frequency range of 20 MHz to 20 GHz (or path lengths ranging from 1 km to 
2000 km) for a telecommunication link. In other words, this radio propagation 
model forecasts long-lasting median transmission loss across asymmetrical terrain 
relative to white-space transmission loss. 

5.2 Provider Verification 

During Rounds 2 and 3, broadband providers received static PDF maps which proved to 
be a less than adequate tool for the broadband providers to review the submitted data. .  
During Round 3, the project mapping partner produced a preliminary ESRI map file for 
each broadband provider. This changeover allowed the broadband providers to obtain a 
more focused and flexible mapping review product and therefore enhanced the 
confidence of the broadband providers in the mapping process.  Apex and the NPSC staff 
helped the provider community obtain ESRI ArcReader and gave assistance to the 
providers in using the ESRI ArcReaders.  The provider reviewed the map and either 
accepted the map or returned comments regarding any perceived inaccuracies.  Apex, the 
NPSC staff and the provider discussed the comments and, when necessary, made 
corrections to the preliminary maps.   

The use of the ArcReader maps revealed a problem with geocoding results. Too many 
locations were stacked at the centroid of a town or zip code rather than at the correct 
customer site. Apex and the NPSC staff engaged in a detailed analysis of this issue.  

At the same time, the NPSC staff worked with selected providers in a one-on-one labor-
intensive process comparing the submitted data tables to the preliminary maps.  For 
locations that appeared problematic, the providers were able to collect additional 
information to improve the data table.  In some instances, the additional information was 
acquired by driving past a customer location with GPS equipment to obtain the exact 
latitude and longitude of the customer. This improved data was entered into the data 
tables allowing CSU-Chico to revise the providers’ maps.   
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6.0 Nebraska Matching Fund 

6.1 E911 Data 

The NPSC’s implementation of enhanced wireless 911 throughout Nebraska required the 
arduous task of designing the framework to initiate, develop, and maintain the robust, and 
invaluable, GIS databases vital and necessary for the provision of enhanced wireless 911.  
These GIS databases are in a standard projection and include; street centerline, depicting 
all public roadways; railways; political boundaries, including city, township, and county; 
areas of interest, including parks, cemeteries, hazardous facilities, power plants and 
substations; water features; fire districts; ambulance districts; law enforcement districts; 
and emergency service boundaries.  
 
Nebraska GIS data for all 93 counties, 77,358 square miles, has been developed and is 
continually maintained; all through funding support provided by the Nebraska Wireless 
E911 Fund.  Nebraska data is housed within the NPSC’s secure on-line statewide GIS 
Data Repository. 
 
The NPSC utilized the data, developed through the Nebraska Wireless E911 Fund, to 
fulfill the matching requirements of the SBDD Grant Program. 
  
Further, during the validation phase of the second round of data collection, the NPSC 
identified broadband unique field enhancements, when applied in addition to the existing 
E911 data, resulted in significant geocoding improvements in many rural areas of 
Nebraska served by smaller ISPs.  The NPSC and the project mapping subcontractor 
worked extensively for several weeks to develop and implement these improvements 
prior to the third round of data collection.  Sample geocoding results analyzed subsequent 
to completion of all enhancements, indicated an average record resolution increase of just 
over 51% in those rural areas.  

 
The project mapping vendor, California State University – Chico, utilized the enhanced 
dataset to develop an Address Locator, unique to Nebraska, which is then used to 
geocode address data provided by ISPs and ultimately submit to the NTIA for the third 
round broadband data submission.   
 
The NPSC will continue to utilize the E911 data resources for address processing and 
geospatial verification throughout the term of the SBDD Grant Program. 
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Appendix - A Mapping Project Partners 

Apex CoVantage LLC  

Apex CoVantage is a private, employee-owned company that has helped businesses to 
develop and execute information and knowledge strategies for more than two decades. 
Apex was a pioneer in offshore knowledge-based solutions and now has more than 2,500 
employees in the US and abroad. Apex is known for developing and improving man-
machine processes that optimally combine human creativity with machine processing 
efficiency, introducing transformative solutions that lead to quantum gains in efficiency.  

Apex is recognized as one of the premier firms in its field, working for clients such as 
AT&T, Exelon, Baltimore Gas and Electric, Qwest, Silver Spring Networks, SMUD, 
Veridian Connections and more.  

California State University (CSU)-Chico 

The Geographical Information Center (GIC) at California State University, 
Chico was established in 1988 to introduce digital mapping and geographical 
information systems (GIS) technology to the Northern California region and to 
provide valuable on-the-job training and employment opportunities for our 
students.  The Center's mission is both academic and service oriented.  With 
numerous research opportunities available throughout California, the growth of 

the GIC has resulted in a renewed University commitment to strengthen ties to the 
Northern California region.   

The GIC employs between 10 and 20 individuals.  The staff includes professionals with 
extensive GIS training mentoring qualified graduates, student assistants and interns.  The 
center runs its own intranet and is connected to the multi-campus CSU-Net, giving it 
state-of-the-art networking capability. 
 
While the center’s primary area of expertise is GIS technology, the GIC also has 
experience in digital orthophoto development, global positioning system (GPS) 
applications, computer cartography, image processing and air photo interpretation.  
 
The GIC has the technical expertise to plan, develop, install, serve and maintain an 
agency’s GIS. It uses ESRI GIS software and can develop a customized ArcGIS training 
workshop to meet an agency’s needs.  Because it is affiliated with California State 
University, Chico, it can draw specialized expertise from the academic community.  The 
center’s contracts are primarily with federal, state and local agencies, but it also serves a 
variety of private sector clients.  Projects are equally split between urban and natural 
resource applications.  Contracts are administered through the California State 
University, Chico Research Foundation.   
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Edison Research 

Edison Research conducts market research and exit polling, providing strategic 
information for businesses and media organizations worldwide. 

With an expertise in both quantitative and qualitative research, Edison works with many 
established corporations looking to keep their edge or expand, as well as young 
companies just starting to develop their businesses. Edison offers expertise in telephone, 
Internet and in-person research as well as focus groups and dial testing. 

Edison Research has been the sole provider of exit poll information to the six major news 
organizations - ABC, CBS, CNN, FOX, NBC and the Associated Press - since 2003. 
Edison has conducted exit polls and collected precinct vote returns to project and analyze 
results for every major primary and the general election in 2004, 2006 and 2008. 

Edison is also the leading provider of consumer exit polling and has conducted face-to-
face research in almost every imaginable venue. Edison Research has conducted research 
at leisure locations (movie theaters, golf courses, health clubs, museums, cruise ships), 
transit locations (airports, subway stations, bus stations, truck stops, school buses, 
parking garages, gas stations), retail establishments (shopping malls, restaurants, stores), 
stadiums/arenas (concerts, sporting events), and many other locations including office 
buildings, conventions/conferences, and medical centers. Our network of more than 
10,000 experienced interviewers allows us to conduct research in almost any location. 

Another specialty for Edison is its work for radio stations throughout the world, 
conducting both strategic and music research for successful stations in North America, 
South America, Europe and Asia. Additionally, Edison conducts research for the U.S. 
Government's broadcasting ventures in the Middle East including "Radio Sawa" and 
"Radio Farda." This research is currently conducted weekly in Abu Dhabi, Egypt, Iraq, 
Jordan, Lebanon and Morocco. 
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Appendix - B  

Strata Sample Methodology 

An in person survey was conducted using personal digital assistants with customized 
software.  The sample included four households or community anchor institutions in each 
selected census block.  The initial phase included 1,400 in person’s interviews.   

Sample Design Overview 

The sample design was a stratified cluster sample. The first layer consisted of six 
strata that encompassed the entirety of Nebraska. The second layer of the design 
consisted of a sample of 350 census blocks. These census blocks were referred to 
as the primary sampling unit (PSU). The third layer of the design was the 
household/community anchor. These locations are known as the secondary 
sampling unit (SSU), or observation unit. 

Stratification 

Six strata encompassing all of Nebraska were created for this sample design. 
These strata were created based on the relative rural/urban nature of the area, the 
cultural makeup of the area and the geographic region of the state. All strata 
boundaries follow county boundary lines. 

 

These strata for Nebraska consist of: 

1. Stratum 1 – Douglas County 

2. Stratum 2 – Cass, Lancaster, Sarpy counties 

3. Stratum 3 – Medium Rural/Urban Area – (17 counties) 

4. Stratum 4 – Rural West – (53 counties) 

5. Stratum 5 – Rural East – (18 counties) 

6. Stratum 6 – Thurston County (Indian Reservation) 

 

Of the sample of 350 census blocks, each strata were allocated a portion of the 
sample. The allocation was an optimal allocation procedure based on the racial 
makeup of each stratum. This means that the strata with greater racial variability 
will be allocated more census blocks than strata with less variability. 
Consequently, heterogeneous strata had more census blocks and homogeneous 
strata had fewer census blocks. This resulted in a more efficient use of the sample 
placing the census blocks where they were most needed. Stratification sample 
allocation and household distribution: 

 



6-26 
 

Stratum Sample Census 
Block 

Allocation 

Percent of 
Households

1 – Douglas County 75 27.3% 
2 – Cass, Lancaster, Sarpy counties   37 22.8% 
3 – Medium Rural/Urban Area  (17 counties) 97 24.7% 
4 – Rural West  (53 counties) 77 13.7% 
5 – Rural East  (18 counties)  57 11.1% 
6 – Thurston County (Indian Reservation)  7 0.3% 

 

Primary Sampling Units – Census Blocks 

The primary sampling units was the census block. These census blocks were 
nested within a given stratum. Each census block had a known probability of 
selection based on the number of households that exist within that census block. 
Every census block was contained within a county. Nebraska has many small 
census blocks where the number of completed interviews from 
households/community anchors was less than four (4). In this situation the 
interviewer was instructed to begin sampling at the nearest neighboring census 
block contained within the census block group of the sampled census block. They 
continued interviewing until four interviews are obtained. By keeping the 
interviewer within the census block group this ensured that interviews obtained 
outside the original sampled block were still within the same county and 
consequently the same stratum. 

Secondary Sampling Units – Households/CAI 

Secondary sampling units, households/community anchors, were selected 
systematically within a census block. Community anchor locations were not 
specifically targeted. However, they were included if they fell within the 
systematic selection. The interviewer was given a random starting point within the 
census block. The interviewer proceeded to follow their assigned path and 
interviewing rate until four (4) completed interviews were obtained. 

Conclusion 

This sampling plan resulted in a statistically valid sample. This sampling plan 
consisted of an initial sample of size 350 (up to 425 in the final sample). This 
resulted in a final anticipated statewide margin of error of (+/- 5%). A total of 
1,400 households/community anchors were sampled. The results of this sample 
could be used for further estimation and extrapolation to other census blocks that 
were not part of the final sample. 
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Edison In-person Survey Questionnaire 

1. Enter census block number (DO  NOT READ): __ __ __ __ 
 
2. Code type of location (DO NOT READ) 
  

Household (Use "household")      1  SKIP TO Q.4  
  Commercial Business (Use "business")    2  
  Other location: ________________ (Use "location")  3  SKIP TO Q.4 
 
3.  What type of business is this? (RECORD EXACT RESPONSE) 

______________________ 
 
 Don’t Know/No Answer 9 
  
4. Does this (ANSWER FROM Q.2) have Internet access? (PROBE: IF UNSURE, ASK IF 

SOMEONE ELSE IS AVAILABLE) 
  
  Yes 1 CONTINUE 
  No 2 SKIP TO Q.10 
  Don’t Know/No one available 9 TERMINATE 
   
5. Which type of Internet access does this (ANSWER FROM Q.2) have? If you are not sure, 

let me know and I can describe the difference between the two. (READ LIST) 
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  Dial-up   1 CODE Q.6 AS “DIAL-UP” & SKIP  
      TO Q.10 
  Broadband   2  CODE Q.6 AS “BROADBAND” &  
      SKIP TO Q.8 
  Both (DO NOT READ)   3 CODE Q.6 AS “BOTH” & SKIP TO  
      Q.8 
  Don’t Know/No Answer (DO NOT READ) 9 CONTINUE 
 
6. Most people who access the Internet do so through dial-up or broadband. A dial-up 

connection is where your computer connects to the Internet using your telephone line.  
  

A broadband connection usually uses a cable modem provided by your cable company or a 
service called DSL.  Broadband connections access the Internet at much faster speeds than a 
dial-up connection, and allow you to always remain connected to the Internet. 

 
Which of these two types of Internet connections does this (ANSWER FROM Q.2) have-- a 
dial-up connection or a broadband connection?  

 
  Dial-up   1 SKIP TO Q.8 
  Broadband   2  SKIP TO Q.8 
  Both (VOLUNTEERED)   3 SKIP TO Q.8 
  Don’t Know/No Answer (DO NOT READ) 9 CONTINUE 
 
7. Is there anyone else who might know whether or not this (ANSWER FROM Q.2) accesses 

the Internet through dial-up or broadband? 
 
  Yes, available  1 ASK FOR THAT PERSON, GO BACK TO Q.5 
  Yes, not available 2 THANK AND TERMINATE 
  No 3 THANK AND TERMINATE 
  Don’t Know/No Answer 4 THANK AND TERMINATE 

 
8. Who is the broadband Internet provider for this (ANSWER FROM Q.2)? (READ LIST) 

(PROBE: IF UNSURE, ASK IF SOMEONE ELSE IS AVAILABLE) 
  
  Insert list of known service providers in the census block entered in Q.1  
  Other: __________________   98     
   
  Don’t Know/No Answer (DO NOT READ) 99     
 
9. Which type of broadband service does your Internet provider supply to this (ANSWER 

FROM Q.2)? (READ LIST) (PROBE: IF UNSURE, ASK IF SOMEONE ELSE IS 
AVAILABLE) 

 
  Cable   1  
  DSL   2   
  Other: ______________   3  
  Don’t Know/No Answer (DO NOT READ) 9  
  
10. Code gender (DO NOT READ)   
 
  Male 1 
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  Female 2 
 
11. Can you please tell me your age? (RECORD EXACT RESPONSE) ________ 
 
12. The last few questions are for classification purposes only. Which of the following best 

describes you? Are you…? 
 
  White 1 
  African-American 2 
  Asian 3 
  Or of some other background? 4  
  Refused/No Answer 9 
 
13. Are you of Hispanic or Latino descent? 
 
  Yes 1 
  No 2  
  Refused/No Answer 9  
 
IF Q.2 CODED "1", CONTINUE, OTHERWISE, SKIP TO NOTE ABOVE Q.17 
  
14. What is the highest level of education achieved by ANYONE in this household? (READ 

LIST) 
  
  High school or less                    1                       
  One to three years of college   2                           
  Four year college degree   3                               
  Some graduate credits   4                                            
  Advanced degree such as MA, MBA or PhD 5                
  Don’t Know/No Answer (DO NOT READ) 9            
 
15. Including yourself, how many adults age 18 or older live in this household?  
 (RECORD EXACT RESPONSE) _______ 
  
16. Is there anyone under the age of 18 living in this household? 
 
  Yes 1 
  No 2  
  Don’t Know/No Answer 9 
 
IF Q.6 CODED "1"/DIAL-UP, SKIP TO Q.18, OTHERWISE, CONTINUE 
 
17. The state of Nebraska would also like to know how fast the broadband connection is in this 

(ANSWER FROM Q.2). Login to the Nebraska speed test web site, enter the ID number 
located on this postcard (SHOW POSTCARD) and it will automatically log your speed. No 
identifying information is captured on the speed test web site. This would be a great help and 
we would appreciate the additional effort.  

 
 UNIQUE ID NUMBER IS GENERATED 
 
 Enter the ID number on to the postcard. Hand it to the respondent. (DO NOT READ) 
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18. In case my supervisor needs to verify that I completed this interview, may I please have your 

first name?  (RECORD EXACT RESPONSE) ______________________ 
 
 Don’t Know/No Answer 9 
 
19. And may I have your phone number or email address? It will ONLY be used if my supervisor 

wants to verify any of the information in this interview. (RECORD EXACT RESPONSE)  
 
  Phone number  (__ __ __) __ __ __ - __ __ __ __  
  E-mail address _____________@________.______ 
 
  Don’t Know/No Answer 9 
 
20. Thank you for your time and cooperation!  
 
21. Enter respondent’s address. (RECORD AFTER YOU HAVE COMPLETED THE 

INTERVIEW) 
 
  Address 1: _________________________________ 
  Address 2: _________________________________ 
  City, State, Zip: Insert city, state and zip code as determined by the census block entered in 
Q.1 
 

Mail Survey Questionnaire  

Your response is important!   Please fill out and promptly mail the Nebraska Broadband 
Mapping Survey. Results from these surveys will be used to map the availability of 
Broadband service for the ENTIRE STATE OF NEBRASKA. Without enough 
completed surveys, your community may not receive its fair share of government funding 
to support the build out of the Broadband network in Nebraska! 
 

 Please mark the appropriate answers to the survey questions below.  

1. Do you have Internet access at your home?  

   Yes (Continue)     No (Skip to Question 5)   

2. Which type of Internet access does your household have? (Mark all that apply) 

   Dial-up  (A dial-up connection is when you will not be able to receive a  
 telephone call using the same telephone line that connects your computer to the 
 Internet.)  

               Broadband  (A broadband connection usually uses a cable modem provided 
 by your cable company or a service called DSL.  Broadband connections access 
 the Internet at much faster speeds than a dial-up connection, and allow you to 
 always remain connected to the Internet.)                

    Don’t Know (Skip to Question 5) 
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3. Who is your broadband Internet provider?      

      _______________________________________ 

4.  Which type of broadband service does your Internet provider supply to your home? 
(Mark all that apply) 

      Cable       DSL 

    Satellite       Other: ________________________ (specify)  

 

5. Gender:           Male      Female   

6. Please provide your exact age:  ___________ 

7. Are you…? (Mark all that apply) 

   White     African-American     Asian        

   Other background   

 

8. Are you of Hispanic or Latino descent? 

    Yes       No 

 

9. What is the highest level of education achieved by anyone in this household? 

  High School or less 

   One to three years of college 

   Four year college degree 

   Some graduate credits 

   Advanced degree such as MA, MBA, or PhD 

 

10. Including you, how many adults age 18 or older live in this household?    
_________________   

 

11. Is there anyone under the age of 18 living in this household? 

      Yes      No    

 

The State of Nebraska would also like to know how fast your broadband connection is. 
Please go to the Nebraska Public Service Commission Web site at 
www.psc.nebraska.gov. Click on “Speed Test”, enter your address and it will 
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automatically log your speed. No identifying information is captured. This would be a 
great help and we would appreciate the additional effort. 

Thank you for your time and cooperation! 

 

Phone Survey Questionnaire 

Please use the script below for Nebraska Broadband Availability Mapping Survey. 

 1. Does your household have Internet access? 

1 _____    Yes    CONTINUE 

2 _____     No    SKIP TO Q.5 

9 _____     Don’t Know (DO NOT READ) SKIP TO Q.5 

 

2A. Which type of Internet access does your household have? If you are not sure, let 
 me know and I can describe the difference between the two. (READ LIST) 
 (PROBE: IF UNSURE, ASK IF SOMEONE ELSE MIGHT KNOW AND IS 
 AVAILABLE) 
 1 _____   Dial-up     SKIP TO Q.5 

2 _____   OR Broadband   SKIP TO Q.3 

3 _____   Both (DO NOT READ)  SKIP TO Q.3 

9 _____   Don’t Know (DO NOT READ) CONTINUE TO Q.2B 

 

2B. Most people who access the Internet do so through dial-up or broadband. A dial-
 up connection is when you will not be able to receive a telephone call using the 
 same telephone line that connects your computer to the Internet.  

 A broadband connection usually uses a cable modem provided by your cable 
 company or a service called DSL.  Broadband connections access the Internet at 
 much faster speeds than a dial-up connection, and allow you to always remain 
 connected to the Internet. 

 Which of these two types of Internet connections do you have -- a dial-up 
 connection or a broadband connection?  

1 _____   Dial-up     SKIP TO Q.5 

2 _____   OR Broadband 

3 _____   Both (DO NOT READ) 

 

3. Who is your broadband Internet provider? (PROBE: IF UNSURE, ASK IF 
 SOMEONE ELSE MIGHT  KNOW AND IS AVAILABLE) 
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  __________________ If it was left blank, leave the cell blank. 

   

 9______  Don’t Know/No Answer (DO NOT READ) 

 

 

4. Which type of broadband service does your Internet provider supply to your 
 home? (PROBE: IF  UNSURE, ASK IF SOMEONE ELSE MIGHT KNOW 
 AND IS AVAILABLE) (ACCEPT MULTIPLE RESPONSES) 

1 _____   Cable  

2 _____   DSL 

3 _____   Satellite  

4 _____   Other: _____________________________ (RECORD EXACT 
RESPONSE) 

 

5. Gender of the Resident answering the Survey (DO NOT READ, BUT USE 
 VOICE AND NAME TO RECORD GENDER) 
 

1 _____   Male  

2 _____   Female 

 

6. Can you please tell me your age? (RECORD EXACT RESPONSE) ________ 

   

 NA ______  No Answer (DO NOT READ)  

 

7. The last few questions are for classification purposes only.  Which of the 
 following bests describes you?  Are  you…? 

1 _____   White 

2 _____   African-American 

3 _____   Asian 

4 _____   Other background 

9 _____   No Answer (DO NOT READ) 
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8. Are you of Hispanic or Latino descent? 

1 _____   Yes 

2 _____    No 

9 _____    No Answer (DO NOT READ) 

 

9. What is the highest level of education achieved by anyone in this household? 
 (ACCEPT MULTIPLE RESPONSES) 

1 _____   High School or less 

2 _____   One to three years of college 

3 _____   Four year college degree 

4 _____   Some graduate credits 

5 _____   Advanced degree such as MA, MBA, or PhD 

 9 _____    No Answer (DO NOT READ) 

 

10. Including yourself, how many adults age 18 or older live in this household? 
 (RECORD EXACT RESPONSE) ________ 

 NA _____    No Answer (DO NOT READ)  

  

11. Is there anyone under the age of 18 living in this household? 

1 _____   Yes 

2 _____   No 

9 _____    No Answer (DO NOT READ) 

 

12. The State of Nebraska would also like to know how fast your broadband 
 connection is. Go to the Nebraska Public Service Commission Web site at 
 www.psc.nebraska.gov. Click on “Speed Test”, enter your address and it will 
 automatically log your speed. No identifying information is captured. This would 
 be a great help and NPSC would appreciate the additional effort.  

 

 Thank you for your time and cooperation! 
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Appendix - C Spectrum Drive Test 

ProField Drive Test  
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Results from Drive Test 

 
http://coverage.sprint.com/IMPACT.jsp?ECID=vanity:coverage 
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http://www.verizonwireless.com/wireless-coverage-area-map.shtml 
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http://www.wireless.att.com/coverageviewer/#?type=data 
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Appendix - D Access Database 

All information regarding Nebraska Broadband Project is available in an Access 
database. The database tracks the details such as ISP submission filings and 
contacts,  

 
 

The ISP details table contains information regarding FRN, Business Name & 
DBA.  It is possible to search the table by field  
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Add New ISP: 

            Click on add  button to generate the add 
formpopulate the form with ISP data and press the 
save  button. 

 

 

 

View ISP details: 

            Double click ISP details in list view or select 
the ISP from the list view and press view  button. 
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Edit ISP details: 

              To edit the ISP details, select the ISP from 
the list view and press view  button Edit the ISP 
form and press save  button.  

 

 

 

 

 

 

 

 

Delete ISP: 

To delete an ISP details, select ISP from the list view and press delete  button. 

 

NDA: 

To view the NDA details for an ISP select the ISP from the list view and press NDA 
button. Click on open  NDA button to view the NDA scanned document. 
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ISP Data:  

To get the ISP Broadband Data we need to select ISP from the list view and press ISP 
Data ,then Broadband Data form opened. Using this module we can Add, Edit & View 
ISP Broadband Data & Data Tracking details of each round of data.  

 

 

Add Broadband Data: 

Click on “Add ISP Data”  button. Broadband Data form will be opened. You 
need to fill the required fields and press save  button. 
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View Broadband Data: 

Double click ISP round data in list view or select the round data from the list view and 
press view  button. You can view all details as shown below.  

 

Edit Broadband Data: 

Select the round data which you want to edit from the list view and press  
button. Update the data and press save button. 
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Export Broadband Data: 

Click on the export  button to export ISP Broadband Data to excel. 

Add & Edit Data Tracking:  

The number of records in “Geo Database” submitted by the ISP will be updated in 
Data Tracking module for each round of data. Select the round from the list view 
and click on Data Tracking  button. The Data Tracking form will be opened. 
Update the values and press save button. 
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Notes: 

Add or view notes by selecting the ISP from the list view and press the Notes  button. 
Click the notes button you will get a message “Press Yes to add notes, No to view notes” 
as show below. 

 
If you press “Yes”, the Notes form will be displayed. Key in values and press the save 

button. 

 
If you press “No”, Notes form will be displayed. You can view all the notes by pressing 
navigation  buttons. 

 

Calling Module 

 ISSUES IN SUBMITTED DATA: - If we have any issues with the data we need 
to select this option and add the missing data details in the comments. So that 
when we generate the daily status thes comments will be displayed. 

 ISP COMMENTS: - If ISP’s give any comments we need to select this. 

 ACQUIRED BY: - If ISP acquired by any other ISP’s we need to add a note by 
select this. So that when we generate the daily status this comments will be 
displayed. 

For Exp: - Galaxy (FRN:0005921713) has been acquired by Zito Media (FRN 
0020111225) 
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 NOTES:-if you want to add any notes select this as a calling module 

 

Export to Excel 

To export the ISP details to Excel by press export  button. 

Click on the Contact details, to see the below contact details form.  It is also possible to 
search contact details by FRN, Business Name & DBA and press the search  button. 
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Add Contacts: 

Click on add contact button. The Contacts form will be opened.   

 
Click FRN button and the Find form will be opened. Select the FRN from the list and 
press Ok button as shown below. Key in First, Last name, etc and click save button. 

 

Edit Contacts: 

Select contact person from the list view and press edit  button. Update the data 
and press save button. 
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View Contacts: 

Double click contact person in list view or select the contact person and press view  
button. 

  

Delete Contacts: 

Select contact person whom you want to delete from the list view and press delete  
button. 

Export to Excel: 

You can even export the Contact details to excel by pressing export  button. 
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Notes: 

To add or view notes, select the contact person from the list view and press the 
Notes  button.  Clicking the notes button and the following message is shown 

 
If you press “Yes”, the Notes form will be displayed. Key in values and press the 

save button. 

 
If you press “No”, the Notes form will be displayed. You can view all the notes 

by pressing navigation  buttons. 

In access database main form there is a report option. Seven reports are available 
as shown below. Select ISP data round and click on the report name.  
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Appendix - E DataSlave 

DataSlave™ is an award winning Windows product designed to help you validate, de-
duplicate and transform your data. Quickly move data from in and out of your business 
applications.   

        Migrate data from one system to another 
   Import leads into your marketing system 

   Validate and correct key data. Includes comprehensive data 
transformation tools.  

DataSlave provides a graphical tool to import, validate, transform and export data.  
At all times the data can be reviewed in the data panel showing rows that pass validation and 
those that fail. 

Any column can be validated to check, for example, 

- The customer ID is in range  
- The Contact Name is valid 
- The Region is not missing 
- The ZIP code is of correct format 
- The Phone and Fax numbers are correctly formatted 

Data can be mapped onto the fields of your database, and where required, transformed. 
In this case the Contact Name is split into separate FirstName and LastName fields 

Validation of Feature Class in DataSlave 

a) BB_Service_Address. 

b) BB_ConnectionPoint_MiddleMile. 

c) BB_ConnectionPoint_LastMile. 

d) BB_Service_CAInstitutions. 

e) BB_Service_CensusBlock. 

f) BB_Service_RoadSegment. 

g) BB_Service_Overview. 

h) BB_Service_Wireless. 

i) BB_Wireless_Antenna 

Steps in DataSlave 

a) Go to “File” menu, click on “Open Map” and the “Open” dialog 
will be shown, open the file named “BB_Service_Address.dbm”, for 
validate “BB_Service_Address” tab data. The BB_Service_Address Map 
file was open as shown below. 
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b) Click on the “Address” button for select the file data file 

 
c) Then “File Location” dialog box will apprise as shown below. 
There  select the path of the address file  to be validated. Then press Next 
button.   

 
 

d) “Record Source” dialog box will apprise as shown below. Select 
the worksheet. Then press the Next button. 
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e) Preview dialog box will apprise as shown below. Then press the 
Finish button.  Once you click on the Finish button you will get the 
message box asking “Execute Valid Data?” as shown below, press the 
“No” button. 

 

 



6-53 
 

f) Click the double arrow button  on the toolbar to start validating 
all the Address Data files. 

g) A summary of the results of the validation will appear in the 
“Output” area at the bottom. Invalid records are written to a log file called 
“Address Data Invalid.log” in the ISP Data directory. Valid records are 
written to “Address Data Valid.csv”.  
h) If you want to see the validation rules for the 
“BB_Service_Address. dbm”, click on the “Validate Rules” button as 
shown below. 

 

i) See the validation rule for the “BB_Service_Address.dbm” as 
shown below. It is possible to “Add or Delete or Edit” any rules from here. 

 
j) To preview the validation status for each record, click on the 
“Preview” button. 
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k) To check if any record failed the validation checks, the application 
will mark error ( sign.) to the value as shown in the below snapshot.  

  



New Hampshire Broadband Mapping and Planning Program 
University of New Hampshire 
March 2011 Data Submission 

 

 
I.  Data Description 

In accordance with the effective NTIA guidance for Round 3 data submissions, the New 
Hampshire Broadband Mapping and Planning Program (NHBMPP) submitted the data set 
described below and associated documents to NTIA in March of 2011. 
 
NH_SBDD_2011_0401.gdb – file geodatabase containing feature classes for: 
 

Feature Class Number of 
Records 

BB_ConnectionPoint_LastMile 0  
BB_ConnectionPoint_MiddleMile 57  
BB_Service_Address 18 
BB_Service_CAInstitutions 3,376 
BB_Service_CensusBlock 62,432 
BB_Service_Overview 0  
BB_Service_RoadSegment 31,874 
BB_Service_Wireless 18  
State_Boundary 1 

 
In total, almost 95,000 individual data records on broadband availability were submitted by New 
Hampshire.  Collectively, these records describe availability as reported by 31 broadband 
providers in the state.  In addition, the NHBMPP submitted data on 3,376 community anchor 
institutions.   
 

 
II.  Provider Participation 

The NHBMPP has identified 49 broadband providers in the state.   As noted above, 31 of these 
providers actively participated in the program for the Spring, 2011 cycle.  The participating 
providers include: 
 

Provider Name Technology 
1.  Argent Communications Cable, Fixed Wireless 
2.  AT&T Mobility LLC Mobile Wireless 
3.  Freedom Ring Communications Middle Mile 
4.  Charter Ring Communications Cable 
5.  Comcast Cable 
6.  Covad Communications Company DSL, Middle Mile 
7.  Cyberpine Cooperative, Inc.* Fixed Wireless 
8.  Dunbarton Telephone Company, Inc. DSL 
9.  FairPoint Communications, Inc. DSL 
10.  G4 Middle Mile 
11.  Granite State Telephone DSL, Fiber 



12.  Level 3 Communications Fiber, Middle Mile 
13.  Lightower Fiber Networks Middle Mile 
14.  MetroCast Cable 
15.  Choice One of New Hampshire DSL, Middle Mile 
16.  Oxford Networks* Middle Mile 
17.  RadiusNorth Middle Mile 
18.  Sidera Networks, LLC Middle Mile 
19.  SkiSat* Cable 
20.  Sovernet Communications* DSL 
21.  Spectra Access* Middle Mile 
22.  Sprint Mobile Wireless 
23.  Tamworth Wireless Cooperative Fixed Wireless 
24.  TDS Telecom DSL, Fiber, Middle Mile 
25.  Time Warner Cable Cable 
26.  T-Mobile Mobile Wireless 

27.  Topsham Communications Fiber 

28.  U.S. Cellular* Mobile Wireless 
29.  Verizon Wireless Mobile Wireless 
30.  Wireless LINC of NH and VT Fixed Wireless 
31.  WiValley Fixed Wireless 

 
* Provider did not submit revised data for this round.  Data collected for the September, 2010 
submission was reported as still being effective. 
 
The 5 providers listed below submitted data that could not be fully processed for this round or 
indicated they would participate in future rounds.  Data that was not fully processed was either 
incomplete or was submitted to NHBMPP after the final date publicized for inclusion in this 
collection cycle: 
 

Provider Name 

1.  Bretton Woods Communications 
2.  Great Auk Wireless 
3.  IAMNOW.net 
4.  Qwest Communications 
5.  WaveComm 

 
The remaining 13 providers, listed below, remained unresponsive to multiple requests to 
participate in the NHBMPP: 
 

Provider Name 
1.  Akers Pond 8.  NCIA 
2.  Boston Telephone 9.  NHvt 
3.  Broadview Networks 10.  Russet Communications 
4.  CityVoice 11.  segTEL, inc. 
5.  Dixville Telephone Company 12.  telJet 



6.  DSCI 13.  Turnpike Technologies 
7.  The Granite Connection  

 
 

 
III.  Data Collection and Integration 

A. Primary Data Collection 
 

Primary data was collected directly from the service providers.  The NHBMPP first developed a 
set of guidance documents based on NTIA specifications, and distributed those to the individual 
providers.  Once the guidance was disseminated, NHBMPP staff followed up with providers via 
phone/email to encourage participation and address questions, as required.  Typically, multiple 
communications were required to ensure a complete data submission was received. 

Data Acquisition 

 

To support the data mapping and integration efforts, the following base data sets were acquired 
and/or retrieved from the NH GRANIT state GIS clearinghouse archives: 

Data Pre-Processing 

• State and town boundaries (based on 1:24,000 USGS DLG files); 

• 2001 Land Cover data set (derived from Landsat TM imagery); 

• 2000 TIGER Census Blocks;  

• 2009 Census MAF/TIGER Road Segments; and 

• 2009 USGS National Elevation Data set (NED). 

All required NTIA fields were added to the census block and road segment data sets.  In 
addition, the road segments were processed against the census blocks to populate two fields 
used internally – the left block ID and the right block ID associated with each road segment. 
 

The broadband availability data was processed and integrated using a suite of GIS tools and 
procedures, depending upon the format and content of the data submitted by the individual 
providers.  Generally, the processing involved executing one or more of the following steps: 

Data Processing and Integration 

 
• Scanning and georeferencing paper maps and using the digital products as a visual 

reference to select out corresponding features from the project base data sets; 
• Geocoding addresses using both an internal locator based on the TIGER road 

segments, and where required, the ESRI TA_BatchAddress_US subscription service;  
where NDAs were in place, geocoded points were used to identify the host census 
block (if < 2 sq. mi.), or the TIGER road segment in closest proximity (if the host 
census block was > 2 sq. mi.).  Related note(s): 
o In some cases, the selection of the TIGER road segment in closest proximity to 

the geocoded point yielded a pattern of disconnected road segments with 
broadband service. 

• Using GIS buffering tools to generate service areas around central office locations 



• Using ArcGIS Network Analyst to select road segments within a cumulative distance 
of 18,000 lineal feet from central office locations. The selected segments were 
subsequently used to identify adjacent census blocks <= 2 sq. mi. or used as features 
to quantify coverage along census blocks > 2 sq. mi.;  and/or 

• Using Cellular Expert ArcGIS extension to generate a signal prediction surface for 
wireless providers submitting antenna locations (and associated data).  Related 
note(s): 
o A -85 DB threshold was used to define service areas of fixed-wireless providers. 
o In processing the fixed-wireless polygon data, the NHBMPP eliminated exterior 

polygons,  e.g. those outside of the main coverage footprint, that were  < .125 
sq. mi.  Interior non-coverage polygons were not eliminated. 

 

The NHBMPP encountered a number of issues in processing the broadband data for the state.  
These include: 
 

Data Processing Issues 

• Most providers submitted data only on areas that are currently served, and not on 
areas that could be served following the NTIA guidance.  This contributed to the 
pattern of occasional disconnected rural road segments with broadband service. 

• Reliance on the TIGER road segments likely yielded overstated broadband coverage 
in rural areas.  A single rural customer address, when geocoded, could result in a long 
street segment being selected as part of a provider’s coverage area.   

• Most providers did not submit typical speed data.  As the volume of our speed test 
data set grows, we will explore using this information to estimate typical speeds. 

• In our experience, smaller wireless providers were frequently unable to deliver the 
full set of antenna parameters required for the signal propagation software.   Data 
was missing on exact antenna patterns (which in some instances was also 
unavailable from the antenna manufacturer), and/or on detailed power information 
specific to an antenna (e.g. power information provided on the host tower only).  In 
these situations, default values were used to run the software.  We believe this  
resulted in overstating coverage areas, and we will be working to refine our 
approach during the next submission period. 

• Elevation data submitted by middle mile providers was typically reported relative to 
sea level, not relative to grade. 

• Providers that are knowledgeable and experienced with the original 2009 NTIA NOFA 
and corresponding clarification documentation provided information appropriate to 
that data schema / model, and modifications to these in January 2011 resulted in 
additional follow-up required to achieve a complete data submission. 

 
 

B. Community Anchor Institutions 
 
Data was submitted for 3,376 Community Anchor Institutions (CAIs) in the state covering the full 
range of categories established by NTIA, as follows: 
 
 

 



Category Number of 
CAI’s 

Percent of 
Total 

1.  School – K through 12 654 19.4% 
2.  Library 602 17.8% 
3.  Medical/health care 743 22.0% 
4.  Public safety 544 16.1% 
5.  University, college, other post-secondary 55 1.6% 
6.  Other community support – government 728 21.6% 
7.  Other community support – non governmental 50 1.5% 
TOTAL 3,376 100.0% 

 
 

The data collection was largely accomplished by the nine regional planning commissions in New 
Hampshire, with the NHBMPP staff at the University responsible for developing initial guidance 
and for compiling the resulting regional data sets into a standardized statewide layer.  The 
primary steps in the data development process included: 
 

• Develop a master list of CAIs by category, relying on statewide lists (schools, libraries, 
health care facilities), existing GIS data sets (largely from local hazard mitigation 
plans), and local knowledge; 

• Map the location of each CAI, using existing GIS data sets, reference to aerial 
imagery, web research, and field data collection where necessary; 

• Contact each CAI by phone to collect the required broadband information; and 
• Verify data (see verification section below). 
 

 
IV.  Validation 

A.  Primary Data Collection 
 
Feedback/verification was primarily implemented in cases where the provider delivered non-
geographic data, e.g. address lists, named road segments/address ranges, lists of census 
blocks/tracts, or wireless tower locations.  In these cases, the NHBMPP returned maps (.pdf 
files) to the provider for their review and correction.  Where providers delivered addresses or 
road segments, the product returned was a geographically referenced version of the data that 
was submitted.  For wireless providers who delivered antenna locations and specifications, the 
program provided maps that displayed the modeled coverage area generated from the Cellular 
Expert signal propagation modeling software.  
 
The Spring, 2011 feedback loop with providers was considerably more robust than prior efforts, 
largely due to increased effort on the part of program staff to solicit feedback.  The process was 
successful in identifying several significant errors/omissions, e.g. in one instance, a provider 
omitted a large census tract from their original submission. 
 
The NHBMPP continued to develop a number of additional verification resources and 
procedures, as described below: 
 



• Speed test – The NHBMPP program has posted a customized speed test on the 
project web site (iwantbroadbandnh.org).  To date, approximately 2,400 records 
have been submitted.  We plan to explore ways to utilize this information to 
estimate typical speed.   

• Broadband survey – The NHBMPP website also hosts an online broadband survey, 
encouraging users to report their broadband access (or lack thereof) at the address 
level.  The address submitted is then geocoded, which delivers a means of verifying 
provider coverage data at specific locations.  (The survey is also linked to the speed 
test, so that users completing the form are asked to take the speed test as well.)  To 
date, 243 surveys have been completed.   

• Satellite dish survey – The NHBMPP has completed a drive-by inventory of satellite 
dishes in selected rural areas of the state, under the premise that a cluster of 
buildings with satellite broadband dishes signifies an area with no other broadband 
options available.   The data are now being processed, and will be utilized during the 
next submission. 

 
B.  Community Anchor Institutions 

The CAI data has been subjected to three rounds of verification.  An initial round of verification 
was completed in May, 2010 by re-interviewing a randomly selected subset of CAI contacts (20% 
of the entities within each of the 7 data categories).  In August/September of 2010, a 
subsequent and comprehensive verification was accomplished by generating a broadband 
profile sheet for each participating CAI, emailing that to each CAI contact for review, and 
modifying the CAI record based on any updates returned.  The latter process was repeated in 
December 2010/January 2011. Over 150 responses were received, and those updates were 
incorporated in the data set prior to the March submission. 
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Data Processing: Collection, Reception, Loading, Validation

This document presents a description of the process used by the New Jersey Office of Information Technology 

(OIT) and Telcordia Technologies to collect, receive, load, validate and verify broadband availability and usage data 

submitted to us by wireless and wireline service providers, CAIs, and other sources and organizations for the State 

of New Jersey.  Individual provider data reports attached hereto provide details on each provider’s submission and 

explain how the policies presented in this document were applied to the data. The CAI summary report, also 

attached, provides details on the CAI data processing.  This report also describes some of the complexities and 

challenges we have encountered to date in this project.

1 Structure of this Report

This methodology report consists of the following

o Section 2 summarizes our outreach efforts to collect data

! This section also describes some of the challenges in determining what service providers are in 

and out of scope for this work and what constitutes a reseller

o Section 3 provides an overview of our process for Service Provider Data Reception

o Section 4 provides an overview of our process for Service Provider Data Loading

o Section 5 provides an overview of our process for Data Validation

! This section includes a table of business rules and how they were implemented.

o Section 6 illustrates a few of our challenges in geocoding.

o Section 7 describes results from our limited longitudinal study of service provider plans for a couple of 

service providers.
o Appendix A: NJ Provider Data Reports   

! This appendix concatenates 30 files in Microsoft Word format, one file for each provider whose 

data was included in the submission.  Each report provides a narrative describing the steps 

involved in collecting, verifying, loading, and validating the provider data, including a log of the 

interactions with the provider.

o Appendix B:  CAI Processing Report

! This is a summary of the details of the CAI processing for this submission.

2 Data Outreach

2.1 Provider Data Outreach

Telcordia and OIT have contacted around 70 providers via email and telephone to determine their status with respect 
to this project.  Our interactions included questions such as:  Do they meet the NOFA definition of a current 

broadband facilities-based service provider in the state of New Jersey? Are they a reseller1?  Are they willing to 

participate in the program? OIT continues to negotiate NDAs with those providers who require them.  Providers are 

given instructions on data requirements, including how to submit via our custom-designed Web site found at

http://connectingnj.state.nj.us/. 

Most providers were willing to participate, although several expressed concerns about the burdens of the data 

collection process.  One provider – Hotwire Communications -- declined to devote any effort to submitting data; a 

second provider – Cogent Communications -- instructed Telcordia to retrieve information from the company’s web 

site. The large national providers clearly have processes in place to collect and submit data, while the small local 
providers require greater assistance.  Telcordia offers assistance where possible, allowing providers to submit 

whatever data they have available in any convenient format. This increases the complexity of the data collection and 

processing operations, but enables greater coverage of providers. As examples, some smaller wireline providers 

simply submitted a list of addresses where they offer service and some small cable operators submitted the names of 

the municipalities they cover.  

At the NTIA’s request, we re-contacted three satellite providers to determine if they had more specific data on their 

coverage:  Hughes, Starband and Wildblue. For the fall 2010 submission, these three satellite providers were not 

                                                       

1 We have been using a general, layman’s definition of a Reseller. 
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included, but they were added in this round.  Two additional non-satellite providers are also included in this round:  

Broadview and Xchange.

Our initial company list comes from FCC aggregate Form-477 data that we receive under the Form-477 sharing 

arrangement.  Two areas that need further investigation are the sufficiency of this data for identifying potential in-

scope service providers and related issues associated with resellers. Specifically:

o We would encourage the NTIA to develop a precise definition of a reseller as soon as possible and, ideally, 
by May 30. Clear guidelines on how to accurately identify resellers, and how to unambiguously determine 

which resellers are in-scope for this project, is important for the fall 2011 submission.  

o The NOFA definition of an in-scope service provider is complex and can be very difficult to apply.  Many 

times we have had rather lengthy discussions with potential providers as we parse the definition of 

facilities-based and the 7-10 day service provision window.

o Here is an interesting example:  Telcordia’s broadband service provider is Savvis 

Communications Corporation.  Savvis has an FRN number – 013780044 – but is not included on

the aggregate Form-477 data for New Jersey.  Because we were curious, we contacted Savvis 

through our account executive and inquired.  We received the following response on April 4 from 

their Counsel:  “The products and services we offer generally qualify as information services or 

non-common carrier services and are therefore not subject to federal regulation, including Form 

477 requirements." This anecdote raises a number of questions, including how the program scope 
aligns with Form-477 filers. 

o There are numerous sources of potential information on broadband service providers -- who may or may 

not meet the NOFA definition of facilities-based and the 7-10 day service provision interval. As just one 

example, the Broadband Internet Directory (http://broadband.theispguide.com/ ) is a consumer website that 

lists broadband offerings and plans.  Under the area code for Telcordia’s location in Piscataway, NJ, dozens 

of providers2 are listed, the majority of whom offer DSL options and are unfamiliar to us.

o Due to the combination of a potentially very large number of resellers and a lack of clarity on the definition 

of a reseller, we would argue that it is very important to develop clear goals and objectives around the 

inclusion of any providers that do not file Form-477 in this program. 

The table below lists the 30 providers whose data was included in this submission and identifies those providers who 
were new in this round.

Provider Name Data Verified and Submitted?

Advanza Telecom Inc yes

AT&T Mobility LLC yes

Broadview Network Holdings yes

Cavalier Telephone Mid-Atlantic LLC yes

CenturyTel, Inc. (CenturyLink) yes

Cogent Communications Inc. yes

Comcast Cable Communications, LLC yes

CSC Holdings (Cablevision) yes

DIECA Communications (Covad) yes

Global Online Electronic Services yes

Hometown Online yes

Hughes Network Systems yes (satellite,  new this round)

Leap Wireless (also Cricket) yes

Monmouth Telephone & Telegraph yes

Netlogic (Voxitas) yes

One Communications Corp yes

                                                       

2 Interestingly, Savvis is not one of them.
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RCN NY Communications yes

Service Electric Cable, Hunterdon yes

Service Electric Cable, Sparta yes

Sprint Nextel yes

StarBand Communications yes (satellite, new this round)

Time Warner Cable yes

T-Mobile yes

tw telecom holdings yes

Verizon yes

Verizon Wireless yes

Wave2Wave Communications yes

WildBlue Communications yes (satellite, new this round)

Xchange Telecom yes (new this round)

XO Communications yes

The table below lists providers who, based on initial screening and communications, were considered not in-scope 

for this program.  In some cases, they were determined to be resellers based on our own internal definition; in other 

cases, they had not yet begun to offer service in New Jersey.  These providers would be candidates for re-contact if 

and when we have a precise reseller definition and, importantly, clear scope and goals for inclusion of resellers in 

the program.

Company Name

Airespring, Inc.

American Telephone Company LLC

Atlantech Online, Inc.

Data Network Systems (DNS); Business Automation Technologies, Inc.

Eventis Telecom, Inc.

Global Crossing

Level 3 Communications; Wil Tel Communicationss;  Broadwing Communications; TelCove Operations

Lightower Fiber Networks

Magellan Hill Technologies, LLC

Meriplex Communications

Metropolitan Telecommunications Holding Company

NetCarrier Telecom, Inc.

New Edge Network

Tata Communications (America) Inc.

Telecom Professionals, Inc.

Telefonica USA, Inc.

Towerstream, Inc.

Transbeam

Vocal IP Networx Ltd

World Discount Telecommunications
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Zayo Group, LLC

2.2 CAI Data Outreach

Telcordia and OIT used a variety of means to collect Community Anchor institution data.  We collected reference 
data with lists of CAIs of various types in the state and we collected broadband data from individual institutions via 

our website and from aggregated sources. 

For each CAI category, the following table provides the number of records we obtained from the reference source, 

the number of broadband access records we obtained, the total number of records we submitted to the NTIA and the 

number of complete records, with verified address information and broadband access information.   

CAI Category Reference Records Broadband 

Records

Total Records 

Submitted

Complete Records 

Submitted

School K-12 (Public) 2601 549

(230 of these 

records require 

further processing 

and verification)

2601 158

School K-12 (Private)
1260

(NCES)
1260 71

Libraries

427

(IMLS)
89 427

87

(2 library web 
submissions were 

unmatched)

Medical/Healthcare 111

(NJHA)
5 111 5

Public Safety

343

(NJ 911 Comm.)
99 343

88

(11 PSAP web 

submissions were 

unmatched)

University
157

(NCES IPEDS)

38

(NJEdge)
157

37

(1 entry for was 

unmatched)

Other – State 

Government

2700

500

(Remaining data to 

be analyzed and 

verified for next 
submission)

500

Other – Local 

Government
0 45 45 45

Other – Non 

Government
0 8 8 8

Abbreviations and Acronyms

911 Comm New Jersey 9-1-1 Commission

IMLS Institute of Museum and Library Services

IPEDS Integrated Postsecondary Education Data System

NCES National Center for Education Statistics

NJHA New Jersey Hospital Association
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New Jersey has a strong tradition of home rule and, like many eastern states, a plethora of small governance entities 

– towns, townships, boroughs, cities, and other local municipalities.  Among the major challenges we face in 

collecting broadband CAI data in the state are the dearth of strong, state-level organizations that might compel 

members to provide data (as opposed to comparatively weaker coordinating bodies) and the lack of existing 

broadband data sources.  NJEdge’s data on the higher education institutions to which they provide service is one of 
the very few such resources in the state.  

NJ OIT executives worked through state-level contacts in public safety, education and libraries, etc., to encourage 

their constituencies to participate and submit data through the website.  While some groups were more responsive 

than others, many expressed concerns about placing additional burdens in a time of shrinking budgets and cutbacks. 

We encountered a few issues with collection, interpretation and processing of CAI data:

o Some institutions provide information on multiple connections to the internet, each with its own technology 

of transmission and maximum speeds.   These may represent separate redundant connections for a large 

institution that provides critical services or separate facilities for different classes of users (e.g., staff and 

clients).  Our policy has been to submit a single entry for each institution, using the highest available 

download speed, but this policy may be a candidate for refinement.
o Satellite institutions such as branch libraries or campus outreach centers can complicate the CAI picture.  

Our policy is to attempt to collect data for each separate geographic location as a separate CAI.  

o Sometimes multiple government offices are co-located in one geographic location; e.g., a large building or 

complex that may include county government offices, court, jail, and/or other government offices.  Here the 

challenge is not to incorrectly overstate broadband capability or understate the need for broadband services.

3 Service Provider Data Reception

Telcordia defined a process for handling provider data upon receipt.  The following steps describe that process:

These steps must be performed upon receipt of provider data.  These steps set up the file system and database for 

later processing, including both the initial assessment and load, and protect the confidentiality of the information.

1. Update the provider interaction log spreadsheet with the date of receipt and other metadata.

2. Copy the email or decrypt the uploaded files to individual directory on dedicated and secure server.

3. Test that the files can be opened, read, etc.  This may require using ESRI ArcCatalog to check a 
shapefile or file geodatabase.

4. Send an acknowledgement to the provider of receipt of readable submission, or request re-send as 

needed.

5. Create empty provider data report into the new folder, using the appropriate wireless or wireline 

template. 

6. Connect to the PostgreSQL database and instantiate a schema for the provider 

7. Import the NTIA transfer model tables to the new schema using ArcCatalog.  These are available in the 

“ntiamodel” schema.

8. Add triggers to the newly imported tables.  These triggers update columns with the user name and 

date/time for each insert and update.  

9. Perform an initial evaluation on the submitted data, evaluating the completeness of the submission and 
the validity and reasonableness of the included values.  Interact with provider to address any questions 

or issues.

4 Service Provider Data Loading

All providers are responding to the mandate to provide the different types of data that go into the various tables in 
the NTIA data transfer model. The provider data submissions vary in form, format and content and in the ease 

versus complexity of the processing and loading tasks.  

In general, the most straightforward data to process are shape files submitted by wireless providers.  Wireline 

providers who submit census block data are a step up in terms of complexity.  Some cable providers simply list the 

municipalities which they serve.  A number of smaller providers provide address lists corresponding to locations 

where they provide service.  These are much more challenging to process as we must first manipulate the address 

information and then geo-code the locations; these operations can be time consuming and subject to inaccuracies. 
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The service provider reports attached in Appendix A give the full details per provider on all steps taken to extract, 

transform, and load the contents of the provider tables into the NTIA tables.  Note that every NTIA table has a 

“shape” column where a geographic feature such as a point, line (e.g., road segment) or area (e.g., census block) 

must be submitted.

Here is a summary of some of our key policies and challenges:

o All non-disclosure agreements executed with providers prohibit us from disclosing customer addresses.  
Although some providers have not executed NDAs, we have chosen to treat all providers similarly.  We 

have chosen to obfuscate the address data by transforming it to census blocks or street segments.  This 

carries a slight risk of overstating coverage, but that seems more appropriate than simply dropping the data 

because it is sensitive.

o Speeds associated with address data from some providers represent the price plan chosen by the customer; 

they are definitely neither the max advertised speed nor the typical speed.  Our decision was to keep the 

maximum speeds encountered in the census block and report them in the maximum advertised fields and to 

report typical as null.  If customers’ selections in neighboring census blocks were vastly different, we 

would use the highest speed in a (subjectively defined) area as the maximum advertised speed.

o Maximum advertised speed, combined with the 7-10 availability requirement, results in vagaries in 

interpretation.  In particular, the concept of advertised speed is well suited for providers who offer services 

to extended areas, such as large telephone and cable television companies.  Its application is less clear for 
smaller providers who offer service to defined set of specific addresses.  They deliver services to those 

specific addresses, and could offer the same service to a new tenant within the time limit.  In some cases, 

they could increase the speed within that time period as well.  They could not easily deliver service to any 

neighboring location with a two-week period.  We have operationalized the notion of maximum advertised 

speed by determining the maximum speed a provider could offer on the facilities they have in place at 

customer locations, then reporting that speed for census blocks or street segments.  Please also see Section 

7 for some additional comments on advertised speeds.

o After initial poor results in geo-coding the customer address lists provided by some cable providers who 

had no geo-spatial capabilities, we identified an alternate approach that leveraged the franchise-nature of 

cable television service in the state.  We asked those cable TV providers to send us the list of municipalities 

that they are licensed to serve.  We build the submission by locating the municipality shapes and using 
those shapes to find all census blocks contained within them.   For large census blocks, we report all the 

TigerLine street segments that are contained within those blocks.

o For middle mile data, the exact definition of a connection point remains open to interpretation and requires 

further development.  We are not completely sure that all providers interpret middle mile in the same 

fashion and do not have a clear enough picture ourselves to provide appropriate guidance or validation.  

Despite this, we have submitted the middle mile information that we received.

5 Data Validation

Incoming data was subjected to a number of validation checks.  When incoming data failed a validation check, we 

first investigated our process to ensure that we were not inadvertently creating an issue.  If the problem was 

determined to be with the submitted data, we notified the provider concerned and recorded the interaction in the 

provider data report as provided in Appendix A.  Where possible, we impute missing data.  We attempted to perform 

some data validation using the FCC speed-test data, but had limited success due to the sparseness of the coverage of 
the speed-test data.  Here are a couple of observations:

o The use of 2000 census blocks caused some problems as we had some providers using 2009 Census 

Blocks.  We applied corrections and interpolation to this data to use it. 

o New Jersey placenames can be problematic.  We validate against data from the following sources: State of 

New Jersey geographic information (https://njgin.state.nj.us/NJ_NJGINExplorer/DataDownloads.jsp), the 

Federal Government placename information (http://geonames.usgs.gov/domestic/download_data.htm), and 

the US Postal Service data (available for a fee).

o A survey of 3100 New Jersey households was conducted in November and December by Rutgers 

University as Telcordia’s subcontractor under this program.  Householders who responded that they were 

broadband users were asked who their service provider was and this was compared against service provider 

serving areas.  95% of the responses aligned with service provider information.  In the remaining 63 cases,

the survey respondents reported being served by a provider whose coverage area did not appear to cover 
that location. We continue to investigate these cases as we expect some may be due to address inaccuracies 

or geo-coding errors, whereas others may identify areas for improvement in service provider coverage.
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We applied the business rules in the script supplied by the NTIA and other data-specific validations after the data 

were loaded into the tables.  These were applied as a check on both the data supplied by the providers and on the 

process we used for data collections, reception and loading.  The following tests were applied:

We checked uniqueness of the entries in each table, using the following definitions of uniqueness:

Layer Unique key Notes

Middle Mile frn, latitude, longitude

CAI anchorname, address, transtech

Census Block frn, fullfipsid, transtech

Street Segment frn, tlid, transtech Tlid is an internal column. 

Wireless frn,transtech, shape

We also performed the following additional validations:

Layer Validation Rules

Middle Mile
! Valid census block id within the state of New Jersey

! Shape should not be empty

! All check_submission rules

CAI
! Valid zip code

! Shape should not be empty 

! Transtech should not be NULL

! All check_submission rules

Census Block
! Valid census block id within the state of New Jersey 

! The area of a census block should be less than < 2 square Mile

! Shape should not be empty

! All check_submission rule

Street Segment
! Shape should not be empty

! Street segment is present in a census block >= 2 square miles

! All check_submission rule

Wireless
! Shape should not be empty

! All check_submission_rule

The table below is a version of the Business Rules provided by NTIA with highlighted the rows to illustrate the tests 

that were performed on the data prior to submission.

1. Rules for Service Address and Overview were not implemented because we did not use the tables.

2. Legend

Rule is implemented

Rule is NOT implemented

There are issues implementing and/or understanding the rule
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6 Some Examples of Geo-coding Challenges

Address geocoding, particularly in census blocks greater than 2 square miles, has been challenging due to the quality of 
provider data, to problems in processing non Tiger Line reference data, and to ambiguities and errors inherent in address 

resolution.   In the remainder of this section we provide some specific examples and pictures to illustrate these challenges.

6.1 Hometown Online

Hometown Online, a regional telephone company serving northern New Jersey, provided 6778 records of address data for the 

April submission which we geo-coded.  Hometown also told us that their service area covered three specific municipalities. 

The screenshot below shows geocoded data as dots and the three municipalities as red polygons.  As you can see, there are a 

couple of addresses geocoded to New York State as well as two addresses geocoded outside of the three municipalities.  
Time constraints did not permit us to cycle back to the provider to get clarification on these specific addresses, so they were 

omitted from the submission.
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6.2 Comcast

One of the more complex cases we have dealt with is when a wireline service provider provides road segment data in text 

format for large census blocks without Tiger Line ID (TLID). Since the data are in text, there are no shapes.  Comcast

provided 1308 such road segment data with designated large census blocks, but without TLIDs; each data item had a starting 
and ending address number for the left and right side.   We applied the following process:

a. Build addresses for geocoding from the line segment by selecting the first non-zero address number from the 

starting and ending address number of the left and right sides.

b. Geocode with the TIGER line: 807data items were successfully geocoded and 501 failed.  

c. Spatial join the geocoded addresses with 2000 Census blocks and compare the spatial-joined census blocks with 

the provided census blocks.

d. Among 807 addresses, 530 had matching large census blocks; 12 mapped to a different large census block; and 

265 mapped to small census blocks.

e. The overall success rate of this process is rather low – 530 correct matches out of 1308.

Given the low success rate, we worked with Comcast to obtain a list of municipalities they serve. They informed us, 

however, that in certain areas that approach would not produce an accurate picture of their coverage area.  Where we had 

municipalities, we mapped these municipalities to census blocks; and then identified the road segments in the large census 

blocks in those regions.  For the other areas of Comcast coverage, we used the small census blocks provided by Comcast, and 
omitted the street-segment data.  

Below is a map that illustrates cases where one of the endpoints of line segments mapped to small census blocks rather than 

to large census blocks.  The larger, sky blue dots indicate endpoints of street segments that mapped to small census blocks, 

indicated by the white background.  The smaller, black dots indicate endpoints of street segments that mapped to correctly to

large census blocks, which are shaded.  While it is possible that some segments with one endpoint in a small census block 

may touch the large census block, in the majority of the cases shown, such is not the case.
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6.3 Verizon 

Verizon provided line segment data for large census blocks with Tiger Line IDs.  While this situation is certainly easier than 
that of Comcast discussed in Section 6.2, there were six cases where the TLIDs provided by Verizon for large census blocks 

actually mapped to small census blocks.  In this case, we had adequate time to discuss with the provider and Verizon agreed 

that these line segments could be dropped.  

Below are pictures that illustrate a few of these anomalous cases.  In the examples, the street segment identified by Verizon is 

indicated as an aqua line, the blue-shaded area is the large census blocks and the white, unshaded areas represent the small 

census blocks.

Example 1:  TLID FIPSID Street

134097546 340057038015000A Cochise Cir

Example 2: TLID FIPSID Street

203769459 340297360021005A Main St
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Example 3: TLID FIPSID Street

98114892 340410318002013 Allow Mill Rd

7.  Limited Longitudinal Study of Service Provider Plans

We have been conducting a limited longitudinal study of wireline service provider plans.  We began with a random stratified 

sample of about 20 addresses in the state.  Each week we have gone to the websites of two major providers in the state –

Verizon and Comcast – and noted the specific plans offered.   This study, while clearly quite limited, has produced some 

intriguing findings regarding maximum advertised speeds, speed tiers, and change and evolution in service plans and pricing. 
Here are a few observations:

o Over the course of a year we have seen a shift in these providers from describing plans with a specific speed to 

describing them as either “up to” or with speed tiers.  For example, where a plan had been previously defined as 3.0 

Mbps upstream it may now be listed as 1.5 to 3 Mbps upstream.

o Most provider websites offer a wealth of information on what plans and speeds are offered on an address level as 

part of the consumer support and marketing.  In some sense, these sites provide very accurate information on 

maximum advertised speeds at an address level. However, these sites typically have restrictions that limit or 

preclude the use of automatic tools or methods to capture information from them.

o As expected, service offerings evolve with various bundling opportunities, special offers, discounts and other 

promotions.  These changes can be difficult to track due to the rapid rate of change and primarily impact 

affordability. 
o Of more interest to this program are changes that reflect infrastructure upgrades.  These are illustrated with, for 

example, the first introduction of FiOS, Verizon’s fiber-to-the-home service, at some of the monitored addresses.



Appendix A 

Broadband Provider Data Report 

Provider: Advanza 
Received: March 2011 
Submission date: April 2011 

This report presents details on processing of the broadband data for delivery to the 
National Telecommunications and Information Administration. 

Sections: 
1. NDA Status 
2. Submission Overview 
3. Submission File Details 
4. Data Validations and Results 
5. Data Transformation and Loading 
6. Clarification Questions and Provider Responses 
7. Notes and Open Issues 

Section 1: NDA Status 

Advanza states that NONE is required.   

Section 2: Submission Overview 

AVAILABILITY DATA – RECEIVED AUGUST, 2010 

ID 

Provider name 

“Doing business as” name 

FRN 

Holding Company Name 

Holding Company Number 

Advanza Telecom Inc 

Advanza 

0017029141 

Advanza Telecom, Inc. 

180002

FOR WIRELINE 

Filetypes 1 xlsx spreadsheet 

File size 
NJBB_0017029141_AddressLevelAvailability-20101231.xls file has 50 records 
representing 36 unique addresses 

Speeds 

Type 

Spatial Resolution 
(address, street seg, 
census block, 
RSA/MSA, 
zipcode,etc) 

Typical-upstream X address 

Typical-downstream X address 

Advertised-upstream X address 

All provided speeds have code 
4 (1.5 mbps � BW < 3.0 mbps) 
for all records, which would 
make sense if all service is T1 



Advertised-
downstream 

X 
address 

Subscriber-weighted-
up 

�
Not provided 

Subscriber-weighted-
down 

�
Not provided 

Technology 
Type 

Code 30 ( = Other Copper Wireline) given for all records  

End-user 
specification 

Values 2, 3 or 4 (Government, Small Business or Enterprises). 

Comments: 

INTERCONNECTION DATA – NO DATA PROVIDED 

ID 

File size 

Ownership 

Transport Type 

Data 
Rates/Capacity 

Location 

Comments: 

Section 3: Submission File Details 

Received one file by secure upload to the connectingnj web site, file subsequently 
updated and delivered via email 

Size  Name 
72,192 NJBB_0017029141_AddressLevelAvailability-20101231.xls 

The addresses in this file appear to be for individual customers (as opposed to 
addresses of multi-tenant buildings in a central business district).   

Section 4: Validations and Results 

All addresses were successfully geocoded using Arroyo flow 
Advanza_geocode_yahoo.arroyo invoking the Yahoo geocoder.. 

Section 5: Data Transformation and Loading 



The standard NDA prohibits us from submitting address-level data to the NTIA.  Instead, 
we discover the census block for each customer address, then report the census block 
shape drawn from Census Bureau TigerLine reference data. 

NTIA Table BB_Service_CensusBlock 

Loaded from the file mentioned above.  The following table explains the transformations 
that were applied to load the target table. 

Table Column Data Source / Transformation

PROVNAME Set to " Advanza Telecom Inc" 
DBANAME Not supplied; set same as PROVNAME 
PROVIDER_TYPE Set to 1 
FRN Set to "0017029141" 
STATEFIPS Set to “34” (NJ) 
COUNTYFIPS Populated from Census Block FIPS Code (first 3 digits) 
TRACT Populated from Census Block FIPS Code (next 6 digits) 
BLOCKID Populated from Census Block FIPS Code 
BLOCKSUBGROUP Set to null 
FULLFIPSID Populated from Census Block FIPS Code 
TRANSTECH As supplied in column Tehcnology of Transmission (sic) 
MAXADDOWN As supplied in column Maximum Advertised Downstream Speed
MAXADUP As supplied in column Maximum Advertised Upstream Speed 
TYPICDOWN Set to null 
TYPICUP Set to null 
SHAPE Copied from Census Bureau TigerLine 2000,  

as matched by spatial join on geocoded address 

Internal processing notes: 
1. Geocoded the addresses using an Arroyo flow and the Yahoo geocoder, leaving 

the result with address and lat, long data in an Excel spreadsheet. 
2. Imported the spreadsheed to a simple ESRI geodatabase table ("providerinput") 
3. Added point shapes corresponding to each Latitude,Longitude pair by creating a 

feature class from the table using ArcCatalog’s “Create Feature Class from XY 
Table” option ("providerinput_shape") 

4. Added a column containing the ID of the containing year 2000 census block 
using ArcCatalog's spatial join feature.  The newly created point shapes are 
joined against census block shapes from reference data 
("providerinput_shape_cb"). 

5. Discarded typical speeds since they were in all cases identical to maximum 
advertised speeds, not measured values. 

6. Copied contents to the target data model table with the transformations specified 
above.  Discarded 14 rows with duplicate census blocks. 

Section 6: Clarification Questions and Responses 



None required as part of initial review. 

Section 7: Notes and Open Issues 



Section 8: Overview Map of Submitted Data 

  



Broadband Provider Data Report 

Provider: ATT  
Received: March1, 2011 
Submission date: April, 2011 

This report presents details on processing of the broadband data for delivery to the 
National Telecommunications and Information Administration. 

Sections: 
8. NDA Status 
9. Submission Overview 
10. Submission File Details 
11. Data Validations and Results 
12. Data Transformation and Loading 
13. Clarification Questions and Provider Responses 
14. Notes and Open Issues 

Section 1: NDA Status 

Section 2: Submission Overview 

AVAILABILITY DATA 

ID 

AT&T Mobility LLC 

AT&T Mobility LLC 

FRN: 4979233 

PROVIDER NAME 

DBA NAME 

FRN 

FOR WIRELESS 

Filetypes 
1 shapefile corresponding to NJ terrestrial 3G 
mobile wireless coverage (type 80) 

Speeds 

Type 
Spatial Resolution (address, 
street seg, census block, 
RSA/MSA, zipcode) 

Upstream max 
adv 

yes (polygon) 

Downstream 
max adv 

yes (polygon) 

Upstream 
typical 

no 

Downstream 
typical 

no 

Subscriber-
weighted 

no 



Technology 
Type 

Spectrum : yes 3 (PCS) and 1(Cellular spectrum)

Comments:  

INTERCONNECTION DATA 

ID 

File size 

Ownership 

Transport Type 

Data 
Rates/Capacity 

Location 

Comments: no IC data provided. 

Quick loading results: 

Figure 1. Loading results 



Section 3: Submission File Details 

1 zip file containing 5 files by (EMAIL, SECURE UPLOAD): 

Size  Name 
1KB  NJ_EOY2010_ATT3GCov.dbf 
1KB  NJ_EOY2010_ATT3GCov.prj 
1KB  NJ_EOY2010_ATT3GCov.shx 
469KB NJ_EOY2010_ATT3GCov.shp 
9KB  ATT Mobility Response NJ December 2010.xlsx 

Section 4: Validations and Results 

(see above for initial load of shapefiles onto Arcmap) 

Section 5: Data Transformation and Loading 

Section 6: Clarification Questions and Responses 

1. no typical up or down speeds 
2. no subscriber weighted value 

Section 7: Notes and Open Issues 
  



Broadband Provider Data Report 

Provider: Broadview Networks, Inc. 
Received: September 2010 
Submission date: April 2011 

This report presents details on processing of the broadband data for delivery to the 
National Telecommunications and Information Administration. 

Sections: 
15. NDA Status 
16. Submission Overview 
17. Submission File Details 
18. Data Validations and Results 
19. Data Transformation and Loading 
20. Clarification Questions and Provider Responses 
21. Notes and Open Issues 

Section 1: NDA Status 

No NDA executed. 

Section 2: Submission Overview 

AVAILABILITY DATA 

ID 

Provider name 

“Doing business as” name 

FRN 

Broadview Networks Inc. 

Broadview Networks 

0003775285 

FOR WIRELINE 

Filetypes Excel spreadsheet 

File size 1,936 data rows 

Speeds 

Type Address level data 

Typical-upstream  Not provided 

Typical-downstream  Not provided 

Advertised-upstream Customer speed 
choice listed 

Advertised-
downstream 

Customer speed 
choice listed 

Subscriber-weighted-
nominal speed 

Not provided 

Instead of max advertised, each 
service address price plan is 
shown. 

Technology 
Type 

10 (ADSL), 20 (SDSL), 30 (Other Wireline) 



End-user 
specification 

Yes 

Comments: 

INTERCONNECTION DATA 

ID 

File size Excel spreadsheet with 31 rows 

Ownership Not provided 

Transport Type Code 2, copper 

Data 
Rates/Capacity 

Not provided 

Location Address provided 

Comments: 

Section 3: Submission File Details 

Received 2 files by secure upload: 

Size  Name 
514560 NJ Table 1 063010.xls 
24576  NJ Table 8 - Middle Mile & Backbone Interconnection Point 063010.xls 

Section 4: Validations and Results 

Table 1 has 1,936 service addresses (with abbreviated town names and many missing 
zip codes), the technology speed tiers in service at each address, and the count of 
connections.  Most records contain max advertised up/down speed codes, but over 100 
do not. Records have no typical up/down speed and no specification of subscriber-
weighted nominal speed.  Table 1 shows no provider name, no DBA name, and no 
FRN.  Geocoding succeeded for N of the addresses and failed for 628 addresses.  Most 
of the addresses that failed geocoding have no street component, just a city name. 

Table 8 has 33 middle-mile points, with addresses, CLLI codes, and the service facility 
type (all copper).  There is no specification of ownership or facility capacity.  Table 8 
lists provider name, DBA name, and FRN.  Geocoding succeeded for 32 of the 
addresses and failed for 1 ("Delsea Dr N & Focer St, Glassboro, NJ 08028, USA"). 

Section 5: Data Transformation and Loading 



NTIA Table BB_ConnectionPoint_MiddleMile 

Loaded from data supplied in the XLS sheet .  The following table explains the 
necessary transformations that were applied.  

Table 
Column 

Data Source / Transformation

PROVNAME Set to "Broadview Networks Inc." 
DBANAME Set to "Broadview Networks" 
FRN As supplied in column "FRN" 
OWNERSHIP Set to null, not supplied 
BHCAPACITY Set to null, not supplied 
BHTYPE As supplied in column "Serving Facility Type" 
LATITUDE Obtained by geocoding the address 
LONGITUDE Obtained by geocoding the address 
ELEVFEET Set to “0” (zero), not supplied 
STATEABBR Set to “NJ” 
FULLFIPSID ID of containing census block from Year 2000 Census Bureau 

TigerLine reference data  
SHAPE Point shape created using ESRI ArcDesktop 

Internal notes on processing: 
1. Geocoded the addresses to obtain Latitude, Longitude value pairs. 
2. Created an excel sheet and imported to a geodatabase table. 
3. Added a point shape corresponding to the Latitude, Longitude pair by creating a 

feature class from the table using ArcCatalog’s “Create Feature Class from XY 
Table” option. 

4. Added a column containing the ID of the containing Year 2000 Census Block via 
a spatial join of the points and the census block shapes from reference data. 

NTIA Table BB_Service_CensusBlock 

The standard NDA prohibits us from submitting address-level data to the NTIA.  So we 
do not populate the table BB_Service_Address with the availability data.  Instead, we 
discover the census block for each customer address, then report the census block 
shape drawn from Census Bureau TigerLine reference data. 

Loaded from supplied file of addresses after applying the corrections discussed below.  
The following table explains the transformations that were applied to load the target 
table. 

Table Column Data Source / Transformation

PROVNAME Set to "Broadview Networks Inc." 
DBANAME Set to "Broadview Networks" 
PROVIDER_TYPE Set to 1 



FRN Set to " 0003775285" 
STATEFIPS Set to “34” (NJ) 
COUNTYFIPS Populated from Census Block FIPS Code (first 3 digits) 
TRACT Populated from Census Block FIPS Code (next 6 digits)
BLOCKID Populated from Census Block FIPS Code 
BLOCKSUBGROUP Set to null 
FULLFIPSID Populated from Census Block FIPS Code 
TRANSTECH As supplied in column Technology 
MAXADDOWN As supplied in column Max Advertised Upstream 
MAXADUP As supplied in column Max Advertised Downstream 
TYPICDOWN Set to null 
TYPICUP As supplied in column Typical Upstreatm Speed (sic) 
SHAPE Copied from Census Bureau TigerLine 2000,  

as matched by spatial join on geocoded address 

Internal processing notes: 
7. Geocoded the addresses using the Google geocoder to obtain a Latitude, 

Longitude pair for each.. Addresses that yielded results with accuracy of 6 or 
below were excluded; only intersection (7) or rooftop (8) accuracy is acceptable.  
The list of addresses that failed geocoding is available. 

8. Created an Excel sheet and imported it to a geodatabase table. 
9. Added point shapes corresponding to each Latitude, Longitude pair by creating a 

feature class from the table using ArcCatalog’s “Create Feature Class from XY 
Table” option. 

10. Added a column containing the ID of the containing year 2000 census block via a 
spatial join of the point shapes and the census block shapes from reference data. 

11. Discarded 150 rows with no value for the maximum advertised download speed. 
12. Discarded 383 rows with duplicate census blocks. 
13. Loaded 1,377 census blocks. 

NTIA Table BB_Service_RoadSegment 

Loaded with street segments in census blocks larger than 2 square miles as gathered 
from Census Bureau TigerLine reference data.  The following table explains the 
transformations that were applied to load the target table. 

Table Column Data Source / Transformation

PROVNAME Set to "Broadview Networks Inc." 
DBANAME Set to "Broadview Networks" 
PROVIDER_TYPE Set to 1 
FRN Set to " 0003775285" 
ADDMIN From reference data 
ADDMAX From reference data 
PREDIR  Set to null, not available in reference data 
STREETNAME From reference data 



STREETTYPE Set to null, not available in reference data 
SUFFDIR Set to null, not available in reference data 
CITY From reference data 
STATECODE Set to "NJ" 
ZIP5 From reference data 
ZIP4 Set to null, not available in reference data 
TRANSTECH As supplied in column Technology 
MAXADDOWN As supplied in column Max Advertised Upstream 
MAXADUP As supplied in column Max Advertised Downstream
TYPICDOWN Set to null, not provided 
TYPICUP  Set to null, not provided 
SHAPE From reference data 
Internal processing notes: 

1. Discovered all street segments that touch census blocks larger than 2 square 
miles using the census block list discovered as discussed for table 
BB_Service_Censusblock above. 

2. Joined against reference data to discover street segment, for a total of 208 
entries. 

Section 6: Clarification Questions and Responses 

1. The values you provided for the max. advertised up/down speeds appear to be 
the price plan choices. Do you want us to use these as your Maximum 
Advertised values? 

2. Do you own or lease the facilities at the interconnection points you have listed? 
3. You provided  the service facility type for the middle-mile points but not the 

facility capacity. Would it be possible for you to provide this data. 
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Jarrod, 
   We have reviewed the data you submitted to the NJ Broadband Mapping program and have a few 
clarification questions: 
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Thanks for your participation in the program! 



John Wullert 
Manager – NJ BB Data Collection 
Telcordia Technologies 
732-699-2687 

Section 7: Notes and Open Issues 

  



Section 8: Overview Map of Submitted Data 

  



Broadband Provider Data Report 

Provider: Cablevision 
Received:  
Submission date:  

This report presents details on processing of the broadband data for delivery to the 
National Telecommunications and Information Administration. 

Sections: 
22. NDA Status 
23. Submission Overview 
24. Submission File Details 
25. Data Validations and Results 
26. Data Transformation and Loading 
27. Clarification Questions and Provider Responses 
28. Notes and Open Issues 

Section 1: NDA Status 

Executed with NJ OIT. 

Section 2: Submission Overview 

AVAILABILITY DATA 

ID 

Provider name 

“Doing business as” name 

FRN 

Holding company name 

Holding company number 

CSC HOLDINGS INC 

CABLEVISION / LIGHTPATH 

0003735909 

CSC Holdings, Inc. 

130370 

FOR WIRELINE 

Filetypes Shapefile with Census Block Year 2009 data 

File size Multiple tables and shapes, for cable modem and optical (Lightpath) technologies. 

Speeds 

Type 

Spatial Resolution 
(address, street seg, 
census block, 
RSA/MSA, 
zipcode,etc) 

Typical-upstream  Not provided 

Typical-downstream  Not provided 

Advertised-upstream Census block and 
street segment 

Advertised-  Census block and 



downstream street segment 

Subscriber-weighted-
up 

Not provided 

Subscriber-weighted-
down 

Not provided 

Technology 
Type 

40 (Cable Modem DOCSIS3.0), 41 (Cable Modem - Other), 50 (Optical carrier) 

End-user 
specification 

Yes. Address data provided in 2 shape files (for both cable and optical) with street 
segment ID. (a field is called TLID, which is assumed means Tiger Line ID). 

Comments: Street data is comprised solely of polylines in the shapefile  while the other files are polygons 
representing coverage. No subscriber weighted data found.

INTERCONNECTION DATA: PROVIDED AFTER REQUEST 

ID Data Interconnection Points Feb 2010.xls 

File size 17 KB, 5 records 

Ownership Leased 

Transport Type Fiber 

Data 
Rates/Capacity 

Greater than 1 gbps 

Location Provided addresses, only 1 is within NJ: 165 Halsey St, Newark NJ 

Comments: None. 

Figure 1. submitted data (quick load) 



Overview of submitted data 



Section 3: Submission File Details 

Received one (1) file by SECURE UPLOAD.  The zip archive contains six shapefiles: 
large census blocks (Cablevision and Lightpath), small census blocks (Cablevision and 
Lightpath), and one with roadsegments (Cablevision and Lightpath).  The data and 
shapes appear to use Year 2000 Census Bureau geometry.  The shapefiles use the XY 
Coordinate System GCS_North_American_1983. 

Size  Name 

Section 4: Validations and Results 

Feature class "CV_NJ_AR_AV_2009_TI_ST" 
This road segment table has 1 duplicate shape.  ).  The problematic TLID is 



64454033 (Reservoir Dr); the record IDs are 50 and 187. 

Feature class "LP_NJ_AR_AV_2009_TI_ST" 
This road segment table has 1 duplicate shape.  The problematic TLID is 

64454033 (Reservoir Dr); the record IDs are 1485 and 3663.   

Section 5: Data Transformation and Loading 

NTIA Table BB_ConnectionPoint_MiddleMile 

Loaded from data supplied in the XLS sheet .  Only one row describes a connection 
point in New Jersey.  The following table explains the transformations that were applied.  

Table 
Column 

Data Source / Transformation

PROVNAME Set to “CSC HOLDINGS INC” 
DBANAME Set to “CABLEVISION” 
FRN As supplied in column frn_name 
OWNERSHIP Set to code 1, leased 
BHCAPACITY Set to code 4; 1gbps falls in range 600mbps – 2.4gbps 
BHTYPE Set to code 1, fiber 
LATITUDE Obtained by geocoding the address 
LONGITUDE Obtained by geocoding the address 
ELEVFEET Set to “0” (zero) 
STATEABBR Set to “NJ” 
FULLFIPSID ID of containing census block from Year 2000 Census Bureau 

TigerLine reference data  
SHAPE Point shape created using ESRI ArcDesktop 

Internal notes on processing: 
5. Created an excel sheet and imported to a geodatabase table. 
6. Added point corresponding to the Latitude,Longitude pair by creating a feature 

class from the table using ArcCatalog’s “Create Feature Class from XY Table” 
option. 

7. Added a column containing the ID of the containing year 2000 census block via a 
spatial join of the points and the census block shapes from reference data. 

8. Reused the table created for the October 2010 submission. 

NTIA Table BB_Service_CensusBlock 

Loaded from the two supplied feature classes (shapefiles) with census blocks less than 
2 square miles.  The following table explains the transformations that were applied to 
load the target table. 



Table Column Data Source / Transformation

PROVNAME As supplied in column prvd_name 
DBANAME As supplied in column dba_name 
PROVIDER_TYPE Set to 1 
FRN As supplied in column frn_name 
STATEFIPS Set to “34” (NJ) 
COUNTYFIPS Populated from cb_fips (first 3 digits) 
TRACT Populated from cb_fips (next 6 digits)
BLOCKID Populated from cb_fips  
BLOCKSUBGROUP Set to null 
FULLFIPSID As supplied in column cb_fips 
TRANSTECH As supplied in column tech_trans 
MAXADDOWN As supplied in column MaxAdvDown 
MAXADUP As supplied in column MaxAdvUp 
TYPICDOWN Set to null, not supplied 
TYPICUP Set to null, not supplied 
SHAPE As supplied in column shape 

Internal processing notes: 
1. Import the features with XY Coordinate System " GCS_North_American_1983" 

via the following three-step process.  (A simple Import using ArcCatalog yields an 
incompatible tolerance value.) 

a. First, copy the data from the shapefile to the geodatabase using a 
geographic transformation “NAD_1983_to_WGS_1984_5”.  This yields a 
feature class with the required coordinate system but an incorrect 
tolerance value.  Names are "cb_nj_ar_av_lt_2mi" and 
"lp_nj_ar_av_lt_2mi".   

b. Second, create a new feature class with the same schema as the provided 
shapefile feature and the required coordinate reference system 
(GCS_WGS_1984) and tolerance (0.000000002 degrees).  Names are 
"cb_nj_ar_av_lt_2mi_tol" and "lp_nj_ar_av_lt_2mi_tol".   

c. Third, load the data into the newly created feature class to ensure perfect 
compatibility with the required coordinate reference system and tolerance.   

2. Ignored the column "tech_trans2" in the Cablevision feature class 

NTIA Table BB_Service_RoadSegment 

Loaded from the two supplied features with line segments.  The following table explains 
the transformations that were applied to load the target table. 

Table Column Data Source / Transformation

PROVNAME As supplied in column prvd_name 
DBANAME As supplied in column dba_name 
PROVIDER_TYPE Set to 1 



FRN As supplied in column frn_name 
ADDMIN Set to the least of the non-empty address numbers 
ADDMAX Set to the greatest of the non-empty address numbers
PREDIR  Set to null (no value supplied) 
STREETNAME As supplied (has all street components, not just name)
STREETTYPE Set to null (no value supplied) 
SUFFDIR Set to null (no value supplied) 
CITY Set to null (no value supplied) 
STATECODE Set to “NJ” 
ZIP5 Set to null (no value supplied) 
ZIP4 Set to null (no value supplied) 
TRANSTECH As supplied in column tech_trans 
MAXADDOWN As supplied in column max_ad_dwn 
MAXADUP As supplied in column max_ad_up 
TYPICDOWN Set to null (no value supplied) 
TYPICUP  Set to null (no value supplied) 
SHAPE As supplied 

Internal processing notes: 
1. Feature classes were imported exactly as discussed above for table 

BB_Service_CensusBlock. 
2. Ignored the column "tech_trans2" in the Cablevision feature class. 
3. Dropped 1,562 rows with empty street name, address min, address max values. 
4. One data column in the Cablevision and Lightpath feature classes is named "tlid" 

which I interpret as "Tiger Line ID".  I validated the data in the TLID column 
against Year 2009 Census Bureau reference data.  All are valid values.  (N.B. 
Although we are instructed to use Year 2000 Census geometry, this table has no 
data such as a Census block ID.  The shapes are all valid ESRI objects so in this 
case it seems perfectly acceptable to use data from the Year 2009 Census 
Bureau reference set.) 

5. ESRI validation reported that each input feature class has one duplicate (i.e., two 
rows with identical shapes.  The two duplicate records were dropped, one from 
each input feature class. 

6.  
�

  



Section 6: Clarification Questions and Responses 

1. No typical values supplied.  
2. No subscriber weighted data. 
3. no interconnection data. 
�
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We would appreciate your prompt response to these questions. 

John Wullert 
Manager – NJ BB Data Collection 
Telcordia Technologies 
732-699-2687
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Section 7: Notes and Open Issues 

Should we submit mixed-geometry street segments? 
  



Section 8: Overview Map of Submitted Data 

  



Connecting New Jersey - Broadband Provider Data Report 

Provider: Cavalier Telephone Mid-Atlantic LLC 
Submission date: April 2011 

This report presents details on processing broadband data for delivery to the National 
Telecommunications and Information Administration (NTIA).  This is a stub report, since 
data from the previous submission was reused unchanged.  The complete report from 
the previous submission begins on the next page.  Notable differences from the 
processing done on the previous submission are listed next. 

NTIA Table BB_Service_CensusBlock 

1. Column "reseller" was dropped. 
2. Set the new column "provider_type" to value 1 ("Broadband provider as 

described in the NOFA") 
3. Dropped non-measured typical up/down speed code values. 

NTIA Table BB_ConnectionPoint_MiddleMile 

1. No changes. 

Provider Interactions 
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Broadband Provider Data Report 

Provider: Cavalier Telephone Mid-Atlantic LLC 
Received: August 2010 
Submission date: August 2010 

This report presents details on processing of the broadband data for delivery to the 
National Telecommunications and Information Administration. 

Sections: 
29. NDA Status 
30. Submission Overview 
31. Submission File Details 
32. Data Validations and Results 
33. Data Transformation and Loading 
34. Clarification Questions and Provider Responses 
35. Notes and Open Issues 

Section 1: NDA Status 

It appears that the company executed an NDA with NJ OIT; the submitted data 
references an NDA. 

Section 2: Submission Overview 

AVAILABILITY DATA 

ID 

Provider name 

“Doing business as” name 

FRN 

Cavalier Telephone Mid-Atlantic LLC 

No DBA name (confirmed with 
company) 

0015-7991-33 

FOR WIRELINE 

Filetypes Excel (Cavalier NJ Broadband Response.xls) 

File size 52736 bytes; 122 records 

Speeds 

Type 

Spatial Resolution 
(address, street seg, 
census block, 
RSA/MSA, 
zipcode,etc) 

Typical-upstream  Address 

Typical-downstream  Address 

Advertised-upstream  Address 

Advertised-
downstream 

Address 

Typical up speeds 3,4; down 
5,6,7,7.  Adv up speed 4, down 
6.  Note typical speed code that 
is greater than the max 
advertised speed code 

Company clarified during 
October submission that the 7 
typical speed should be a 6. 



Subscriber-weighted-
up 

Not provided 

Subscriber-weighted-
down 

Not provided 

Technology 
Type 

Initial submission included Codes 1 and 3.  Provider clarified during October submission 
that these should be ADSL (1=10) and Other Copper Wireline (3-30). 

End-user 
specification 

Codes 1 (residential) and 3 (small business). 

Comments: 

INTERCONNECTION DATA 

ID 

File size 

Ownership 

Transport Type 

Data 
Rates/Capacity 

Location 

Comments:  

Section 3: Submission File Details 

Received 1 file by email. 

Size  Name 
52736  Cavalier NJ Broadband Response.xls 

The file contains 124 rows and 122 data records for broadband availability by address, 
and 18 rows of middle-mile connection points. 

Section 4: Validations and Results 

Some of the address records (13) are post office boxes, which are invalid for this 
purpose.   

Section 5: Data Transformation and Loading 

NTIA Table BB_ConnectionPoint_MiddleMile 



Loaded from supplied file “Cavalier NJ Broadband Response.xls”, tab “Middle Mile 
Interconnection”.  The following table explains the transformations that were applied.  

Table 
Column 

Data Source / Transformation

PROVNAME As supplied in column “Provider Name” 
DBANAME Not supplied; set same as PROVNAME 
FRN As supplied in column “FRN”, after removing hyphens 
OWNERSHIP As supplied in column “Ownership” 
BHCAPACITY As supplied in column “Serving Facility Capacity” 
BHTYPE As supplied in column “Serving Facility Type” 
LATITUDE Created by geocoding the supplied address 
LONGITUDE Created by geocoding the supplied address
ELEVFEET Set to “0” (zero) 
STATEABBR Set to “NJ” 
FULLFIPSID ID of containing census block from Year 2000 Census Bureau 

TigerLine reference data  
SHAPE Point shape created using ESRI ArcDesktop 

Internal notes on processing: 
9. Geocoded the addresses using the Google geocoder. 
10. Created an excel sheet and imported to a geodatabase table. 
11. Added point shapes corresponding to each Latitude,Longitude pair by creating a 

feature class from the table using ArcCatalog’s “Create Feature Class from XY 
Table” option. 

12. Added a column containing the ID of the containing year 2000 census block via a 
spatial join of the point shapes and the census block shapes from reference data. 

NTIA Table BB_Service_CensusBlock 

The standard NDA prohibits us from submitting address-level data to the NTIA.  So we 
do not populate the table BB_Service_Address with the availability data.  Instead, we 
discover the census block for each customer address, then report the census block 
shape drawn from Census Bureau TigerLine reference data. 

Loaded from supplied file “Cavalier NJ Broadband Response.xls”, tab “Wireline 
Address-Level” after applying the corrections discussed below.  The following table 
explains the transformations that were applied to load the target table. 

Table Column Data Source / Transformation

PROVNAME As supplied in column “Provider Name” 
DBANAME Not supplied; set same as PROVNAME 
PROVIDER_TYPE Set to 1 
FRN As supplied in column “FRN”, after removing hyphens 
STATEFIPS Set to “34” (NJ) 



COUNTYFIPS Populated from Census Block FIPS Code (first 3 digits) 
TRACT Populated from Census Block FIPS Code (next 6 digits)
BLOCKID Populated from Census Block FIPS Code 
BLOCKSUBGROUP Set to null 
FULLFIPSID Populated from Census Block FIPS Code 
TRANSTECH As supplied in column Technology 
MAXADDOWN As supplied in column Max Advertised Upstream 
MAXADUP As supplied in column Max Advertised Downstream 
TYPICDOWN Set to null 
TYPICUP Set to null 
SHAPE Copied from Census Bureau TigerLine 2000,  

as matched by spatial join on geocoded address 

Internal processing notes: 
14. Created a corrected spreadsheet based on response to questions, see next 

section. 
15. Geocoded the addresses using the Google geocoder to obtain a Latitude, 

Longitude pair for each.. Addresses that yielded results with accuracy of 6 or 
below were excluded; only intersection (7) or rooftop (8) accuracy is acceptable.  
The list of addresses that failed geocoding is available. 

16. Created an Excel sheet and imported it to a geodatabase table. 
17. Added point shapes corresponding to each Latitude, Longitude pair by creating a 

feature class from the table using ArcCatalog’s “Create Feature Class from XY 
Table” option. 

18. Added a column containing the ID of the containing year 2000 census block via a 
spatial join of the point shapes and the census block shapes from reference data. 

19. Discarded 173 rows with duplicate census blocks while preserving the greatest 
speed. 

The mechanized procedure for the three steps is described in file GeoExcel_proc.txt. 

Section 6: Clarification Questions and Responses 

1. What is the DBA name? 
2. The tech trans codes 1 and 3 are not valid.  Should technology of transmission 

code “1” really be “10” for ADSL?  And about code 3, is that really 30? 
3. Is the single record with a typical down speed of 7 a typo, possibly should be 6 to 

match the maximum advertised down speed? 
4. One record (1151 N BLACK HORSE PIKE WILLIAMSTOWN NJ) is missing the 

zip code, which we believe should be 08094. 
5. Thirteen records show an address that is a post office box.  This is not a service 

address and we cannot work with these records.  We need the service address 
instead of the billing address. 

Questions sent 8/24/2010, Response received 8/24/2010 
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Section 7: Notes and Open Issues 



Section 8: Overview Map of Submitted Data 

  



Broadband Provider Data Report 

Provider: CenturyTel DBA Century Link 
Received: March 2011 
Submission date: April 2011 

This report presents details on processing of the broadband data for delivery to the 
National Telecommunications and Information Administration. 

Sections: 
36. NDA Status 
37. Submission Overview 
38. Submission File Details 
39. Data Validations and Results 
40. Data Transformation and Loading 
41. Clarification Questions and Provider Responses 
42. Notes and Open Issues 
43. Overview Map of Submitted Data 

Section 1: NDA Status 

Century Link executed an NDA with NJ OIT; the data files refer to the NDA. 

Section 2: Submission Overview 

AVAILABILITY DATA 

ID 

Provider name 

“Doing business as” name 

FRN 

CenturyLink, Inc. (per email) 

Century Link 

0018626853 

FOR WIRELINE 

Filetypes Text and shapefiles

File size 

Speeds 

Type 
Spatial Resolution: 
county 

Typical-upstream Census block and 
street segment (w. 
TigerLine REF) 

Typical-downstream Census block and 
street segment (w. 
TigerLine REF) 

Advertised-upstream  Census block 

Advertised-
downstream 

Census block 

Subscriber-weighted-  Not provided 



up 

Subscriber-weighted-
down 

County; all numbers 
are around 5000. 

Technology 
Type 

10 (ADSL) 

End-user 
specification 

Not provided 

Comments: 

INTERCONNECTION DATA 

ID 

File size 

Ownership 

Transport Type 

Data 
Rates/Capacity 

Location 

Comments: Not provided this submission (while it was last time) 

Figure1. Quick load test results 



Section 3: Submission File Details 

Size (kb) Name 
2702  CTL_NJ_sub_wtd_speed.txt 
2219    NJ_BBavail.xls 
1485    ResultantBroadBandInfo-NJ_polyline.dbf 
1    ResultantBroadBandInfo-NJ_polyline.prj 
836   ResultantBroadBandInfo-NJ_polyline.shp 
35   ResultantBroadBandInfo-NJ_polyline.shx 
2043   ResultantBroadBandInfo-NJ_region.dbf 
1    ResultantBroadBandInfo-NJ_region.prj 
3488   ResultantBroadBandInfo-NJ_region.shp 
48    ResultantBroadBandInfo-NJ_region.shx 

Section 4: Validations and Results 

Initial check:  

The overview data indicates this provider serves five counties in New Jersey.  The 
county, state, and technology of transmission codes are valid.  However, we will not 
populate the BB_Service_Overview in the April 2011 submission, so do not need the 
subscriber weighted nominal speed. 

The large spreadsheet includes 10,476 rows with census block IDs.  Additional columns 
have advertised and typical speeds at the census-block level.  Some rows have road 
segment information (starting and ending addresses left and right); other rows have 
none. The spreadsheet seems to contain a mix of census block AND road segment 
information; the columns allow for both types of data in a row. 

PROVIDER 
DBA_NAME 
FRN 
CENSUS BLOCK 
ADVERTISED MAX DOWNLOAD SPEED TIER 
ADVERTISED MAX UPLOAD SPEED TIER 
ADVERTISED TYPICAL DOWNLOAD SPEED TIER 
ADVERTISED TYPICAL UPLOAD SPEED TIER 
TECHNOLOGY 

The shapefile has two feature classes: 

Feature class ResultantBroadBandInfo-NJ_region appears to provide coverage data for 
census blocks with an area less than or equal to 2 square miles.  It contains 6,113 
records.  All of the IDs shown in the shapefile correspond to valid Year 2000 Census 
Block IDs (although the column is named "2009") and all are smaller than 2 square 
miles. 



Feature class ResultantBroadBandInfo-NJ_polyline shows street segments, we guess 
for census blocks larger than 2 square miles.  It contains 4,362 records. The polyline 
data includes a field called TIGER_REF.  We attempted to validate this as a Tiger Line 
ID against Year 2000 and Year 2009 line-segment reference data records, but none 
were matched, so we do not know what the column contains.  We received an answer 
in response to email that the values are not TigerLine IDs. 

The address left-from, left-to, right-from, and right-to fields are problematic because 
they are defined as numeric (not text) which precludes address such as those found in 
parts of NYC such as “12-26”. The fields of this polyline data include: 
AREA_SQMI 
PROVIDER, DBA, FRN, ID, LOCATION 
CENSUS_BLOCK 
MAX_DOWNLOAD, MAX_UPLOAD, TYPICAL_DOWN, TYPICAL_UP 
TECHNOLOGY 
TIGER_REF 

The speed data gives cause for concern.  We see significantly different maximum 
advertised speeds in adjacent census blocks.  How is this possible?  Further, the typical 
and maximum advertised columns are *always* identical.  Maybe these data 
correspond to actual customer speed and price-plan choices rather than advertised 
speeds.   

We do not require BOTH the spreadsheet and the shapefile. 

Section 5: Data Transformation and Loading 

NTIA Table BB_ConnectionPoint_MiddleMile 

Loaded from Excel Spreadsheet “middlemile_NJ.txt” (1 row) that was supplied for the 
October 2010 submission.  The following table explains the transformations that were 
applied.  

Table 
Column 

Data Source / Transformation

PROVNAME Set to “CenturyLink, Inc.” per email 
DBANAME As supplied in column 1 "CenturyLink" 
FRN Set to "0018626853"

OWNERSHIP As supplied in column 3 
BHCAPACITY As supplied in column 4 
BHTYPE As supplied in column 5 
LATITUDE As supplied in column 6 
LONGITUDE As supplied in column 7 
ELEVFEET Set to “0” (zero) 
STATEABBR Set to “NJ” 



FULLFIPSID ID of containing census block from Year 2000 Census Bureau 
TigerLine reference data  

SHAPE Point shape created using ESRI ArcDesktop 

Internal notes on processing: 
13. Created an excel sheet and imported to a geodatabase table. 
14. Added point corresponding to the Latitude,Longitude pair by creating a feature 

class from the table using ArcCatalog’s “Create Feature Class from XY Table” 
option. 

15. Added a column containing the ID of the containing year 2000 census block via a 
spatial join of the points and the census block shapes from reference data. 

16. Source table was reused from the previous submission. 

NTIA Table BB_Service_CensusBlock 

Loaded from supplied shapefile feature “ResultantBroadBandInfo-NJ_region”.  The 
following table explains the transformations that were applied to load the target table. 

Table Column Data Source / Transformation

PROVNAME Set to “CenturyLink, Inc.” per email 
DBANAME As supplied in column “dba_name” 
PROVIDER_TYPE Set to 1 
FRN Set to "0018626853"

STATEFIPS Set to “34” (NJ) 
COUNTYFIPS Populated from 2009_Census_Block_FIPS_Code (1st 3 digits) 
TRACT Populated from 2009_Census_Block_FIPS_Code (next 6 digits)
BLOCKID Populated from Census_Block_FIPS_Code  

(next 4 digits; dropped 5th character if present) 
BLOCKSUBGROUP Set to null 
FULLFIPSID First 15 digits of 2009_Census_Block_FIPS_Code 

See discussion of Census blocks below. 
TRANSTECH As supplied in column Technology_of_Transmission 
MAXADDOWN As supplied 
MAXADUP As supplied 
TYPICDOWN Set to null 
TYPICUP Set to null 
SHAPE As supplied 

Internal notes on processing 
1. The supplied feature class uses XY coordinate system name 

GCS_North_American_1983.  The NTIA data model requires XY coordinate 
system GCS_WGS_1984.  To change the projection we applied the geographic 
transformation NAD_1983_To_WGS_1984_5 (per ESRI KB article 24159).   

2. We had to create a new feature class and reload the data so that the tolerance 
value matches the NTIA transfer model’s tolerance value exactly. 



3. The feature class "region" has 285 rows that duplicate existing census block IDs.  
We discarded these to avoid creating duplicate shapes in the table. 

4. Some records show max download speed code 2, which is not considered 
broadband.  We discarded 95 records with this value. 

NTIA Table BB_Service_RoadSegment 

Loaded from supplied shapefile feature “ResultantBroadBandInfo-NJ_polyline”.  The 
following table explains the transformations that were applied to load the target table. 

Table Column Data Source / Transformation

PROVNAME Set to “CenturyLink, Inc.” per email 
DBANAME As supplied in column “dba_name” 
PROVIDER_TYPE Set to 1 
FRN Set to "0018626853"

ADDMIN Set to the least of the non-empty address numbers 
ADDMAX Set to the greatest of the non-empty address numbers
PREDIR  Set to null (no value supplied) 
STREETNAME As supplied (has all street components, not just name)
STREETTYPE Set to null (no value supplied) 
SUFFDIR Set to null (no value supplied) 
CITY Set to null (no value supplied) 
STATECODE Set to “NJ” 
ZIP5 Set to null (no value supplied) 
ZIP4 Set to null (no value supplied) 
TRANSTECH As supplied 
MAXADDOWN As supplied 
MAXADUP As supplied 
TYPICDOWN Set to null 
TYPICUP  Set to null 
TKUD As supplied in column tiger_ref 
SHAPE As supplied 

Internal notes on processing: 
1. The supplied feature class uses XY coordinate system name 

GCS_North_American_1983.  The NTIA data model requires XY coordinate 
system GCS_WGS_1984.  To change the projection we applied the geographic 
transformation NAD_1983_To_WGS_1984_5 (per ESRI KB article 24159).   

2. We had to create a new feature class and reload the data so that the tolerance 
value matches the NTIA transfer model’s tolerance value exactly. 

3. We discarded 609 records with no street name (field empty). 
4. The county number and a column "tiger_ref" are supplied for each segment.  We 

checked for uniqueness using the county number and tiger_ref.  After discarding 
records with an empty street name, 2498 unique records were accepted and 
1255 duplicates were dropped.  However this is questionable.  As mentioned in 



validations, the tiger_ref column is not a TLID, so using it for validation might not 
be reasonable. 

5. Some records show max download speed code 2, which is not considered 
broadband.  We discarded 73 records with this value. 

  



Section 6: Questions 
1. subscriber weighted uplink speeds? 
2. we should assume interconnection data same as last submission? 
3. duplicate records in both shapefile features 
4. imputed maximum speeds 
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John:  Dave Bonsick asked me to respond to your questions about the CenturyLink BB data for 
NJ. 

1. I received our NJ middle-mile info this morning.  See attachment. 
2. Our data reports the top BB speed available in the census block – even if it is slower 

than our top speed promoted on our website, etc.   
3. Our provider name is “CenturyLink, Inc.” 

Let me know if you have any other questions or would like clarification.  Thanks. 
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That column was pulled from our MapInfo StreetPro Enhanced Address Layer data.  It is 
documented as being a cross reference to the Tiger data and several other states had 
requested the cross reference.  We have learned from other states that the reference is not 
good.  We’ve processed all states by pulling the same fields from the StreetPro data.  I was 
hoping that the info would be valid for some areas.  You can disregard that column. 
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Please note new e-mail address:  gerald.f.flurer@centurylink.com
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Does that mean that you’ll drop our coverage in the census blocks larger than 2 miles?    

If I understood a state mapper in one of our western states did with our road segment data was 
that they found the centroid of our segment and looked for a nearby centroid of their Tiger’09 
segments.  I think they used 1000 ft.  Not sure if 1000 ft is workable in NJ.  If you’d like to talk to 
them about how they did it, I’ll look for contact info.  Thanks. 
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Section 7: Notes and Open Issues 
  



Section 8: Overview Map of Submitted Data 

  



Broadband Provider Data Report 

Provider: Cogent Communications  
Received: August 2010 
Submission date: April 2011 

This report presents details on processing of the broadband data for delivery to the 
National Telecommunications and Information Administration. 

Sections: 
44. NDA Status 
45. Submission Overview 
46. Submission File Details 
47. Data Validations and Results 
48. Data Transformation and Loading 
49. Clarification Questions and Provider Responses 
50. Notes and Open Issues 

Section 1: NDA Status 

No NDA was executed.  All data were taken from the provider’s public web site, FCC 
filings and/or information supplied by the provider via email 

Section 2: Submission Overview 

MAPPING DATA - RECEIVED MARCH 1, 2011 

ID 

Provider name 

“Doing business as” name 

FRN 

Cogent Communications, Inc. 

Not provided 

0019898303 

FOR WIRELINE 

Filetypes Txt, xls, pdf, etc. Email and pointers to Web site 
and SEC filings 

File size Number of records, data elements List of 20 addresses where 
they offer service  

Speeds 

Type 
Spatial Resolution (address, 
street seg, census block, 
RSA/MSA, zipcode) 

Adver down Address 

Adver up Address 

Typical down Not provided 

Typica up Not provided 

Subscriber-
weighted 

Not provided 

 Provided building addresses.  
Adver down and up are 10/11, 
very fast. 



Technology 
Type 

DOCSIS, xDSL, fiber, etc. Fiber 

End-user 
specification 

Business, consumer, gov’t etc 

Comments: They offer service directly to businesses at the addresses they provided.  They are a reseller 
of broadband access to businesses at other locations. 

They had previously refused to provide data on Typical and Subscriber Weighted speeds. Inquired whether 
there was any change in their position on this  via email.

INTERCONNECTION DATA 

ID 

Provider name 

“Doing business as” name 

FRN 

File size Number of records, data elements 

Ownership Leased/owned 

Transport Type Fiber, wireless, copper 

Data 
Rates/Capacity 

Location Street address, lat/lon, elevation 

Comments: 

We had previously extracted data for Middle Mile sites, based on the assumption that Cogent’s Data 
Centers were interconnection points.  We were instructed by the provider that these sites did not meet the 
definition of Middle Mile sites and thus should be removed. 

DATA COMPLETENESS 

Data Validation/ 
Verification 

Section 3: Submission File Details 

Received one file by email on 13 Aug 2010: NJ State locations 100813 B.docx.  
Updated the address information via a query of "Service Locations" from provider's Web 
site 
(http://www.cogentco.com/?lang=en&option=com_content&view=article&id=40&action=
search).  Searched using: North America, United States, New Jersey. 

Section 4: Validations and Results 

Noted that 3 addresses have no street address, and one address did not have a valid 
zip code.  Used Internet search to determine zip code for that location and verified with 
Cogent. 

Confirmed provider reported data rates with their published information and SEC filings. 



The only other validation to be done is whether each address can be successfully 
geocoded.  See next section.  One address is not  

Section 5: Data Transformation and Loading 

The standard NDA prohibits us from submitting address-level data to the NTIA.  Instead, 
we discover the census block for each customer address, then report the census block 
shape drawn from Census Bureau TigerLine reference data. 

NTIA Table BB_Service_CensusBlock 

We copied the information to a spreadsheet.  The following table explains the 
transformations that were applied to load the target table. 

Table Column Data Source / Transformation

PROVNAME Set to “Cogent Communications, Inc.” 
DBANAME Same as PROVNAME 
PROVIDER_TYPE Set to 1 
FRN Set to “0019898303” 
STATEFIPS Set to “34” (NJ) 
COUNTYFIPS Populated from Census Block FIPS Code (first 3 digits) 
TRACT Populated from Census Block FIPS Code (next 6 digits) 
BLOCKID Populated from Census Block FIPS Code 
BLOCKSUBGROUP Set to null 
FULLFIPSID Populated from Census Block FIPS Code 
TRANSTECH Set to “50” 
MAXADDOWN Populated from column “Maximum Advertised Speed Down”
MAXADUP Populated from column “Maximum Advertised Speed Up 
TYPICDOWN Set to null 
TYPICUP Set to null 
SHAPE Copied from Census Bureau TigerLine 2000,  

as matched by spatial join on geocoded address 

Internal processing notes: 
17. Geocoded the addresses using the Google geocoder to obtain a Latitude, 

Longitude pair for each.. 
18. Created an excel sheet and imported it to a geodatabase table. 
19. Added point shapes corresponding to each Latitude, Longitude pair by creating a 

feature class from the table using ArcCatalog’s “Create Feature Class from XY 
Table” option. 

20. Added a column containing the ID of the containing year 2000 census block via a 
spatial join of the point shapes and the census block shapes from reference data. 

21. Discarded 8 rows with duplicate census blocks. 

The mechanized procedure for the geocoding step is described in file 
GeoExcel_proc.txt. 



Section 6: Clarification Questions and Responses 
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Ried, 
    The attached spreadsheet integrates the data you submitted to us last year with and the data we could 
obtain from your Web site and SEC filings.   We will use this data as the basis for the submission to the 
NTIA.   If you have any comments or corrections on the data, please let me know. 
   We did notice that the “Service Location” form on your Web site did not return a valid zip code for the 
5851 Westside Ave in North Bergen.  We assigned an zip code of 07047 based on a Google search. 
   Of the data requested by NTIA, we were not able to obtain data on Typical speeds and the Subscriber 
Weighted Nominal Speed.  You indicated last time that you were not prepared to offer this information.  If 
your position on this matter has changed, we would be happy to receive the data. 

Thanks for your cooperation 

John Wullert 
Manager – NJ BB Data Collection 
Telcordia Technologies 
732-699-2687 
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“We did notice that the “Service Location” form on your Web site did not return a valid zip code for the 
5851 Westside Ave in North Bergen.  We assigned an zip code of 07047 based on a Google search.”  
Seems reasonable; since zip codes are fairly irrelevant to Cogent’s business the zip code is not 
something that hits out A list of priorities in any database – nor is geocode. 

Section 7: Notes and Open Issues 

Section 8: Overview Map of Submitted Data 



  



Broadband Provider Data Report 

Provider: Comcast 
Received: March 2011 
Submission date: April 2011 

This report presents details on processing of the broadband data for delivery to the 
National Telecommunications and Information Administration. 

Sections: 
51. NDA Status 
52. Submission Overview 
53. Submission File Details 
54. Data Validations and Results 
55. Data Transformation and Loading 
56. Clarification Questions and Provider Responses 
57. Notes and Open Issues 

Section 1: NDA Status 

Section 2: Submission Overview 

AVAILABILITY DATA 

ID 

Provider name 

“Doing business as” name 

FRN 

COMCAST CABLE COMMUNICATIONS LLC 

COMCAST 

0004-4416-63 

FOR WIRELINE 

Filetypes 
Excel files w. Census Block Year 2009 data.  Street segment level and CB level availability 
tables for CB’s less than and greater than 2 sq. mi. 

File size see files 

Speeds 

Type 

Spatial Resolution 
(address, street seg, 
census block, 
RSA/MSA, 
zipcode,etc) 

Typical-upstream  Not provided 

Typical-downstream  Not provided 

Advertised-upstream  yes (CBSA/RSA level) 

Advertised-
downstream 

yes (CBSA/RSA level) 

Subscriber-weighted-
up 

no 



Subscriber-weighted-
down 

no. 

Technology 
Type 

40 (Cable Modem DOCSIS3.0) 

End-user 
specification 

Comcast provides availability at the Census Block and Street Segment level.  

Comments:  In a difference from October, the max DL speeds reported in the 7 RSA’s have mostly increased 
up to the ‘10’ level. 

In last submission, a xls file “34-cbsa_rsa-NJ.xlsx” providing avg down speeds was provided. Not this time. 

INTERCONNECTION DATA: PROVIDED AFTER REQUEST 

ID 

File size 

Ownership 

Transport Type 

Data 
Rates/Capacity 

Location 

Comments:  

Section 3: Submission File Details 

Received four (4) files by SECURE UPLOAD. 

Size  Name 
121KB 34-streets-NJ.xlsx 
2968KB  34-blocks-NJ.xlsx 
9KB  New Jersey Maximum Advertised Speeds 12 31 10.xlsx 
12KB  Broadband Mapping Data Information.doc 

Section 4: Validations and Results 

File 34-streets-NJ.xlsx contains 1,309 records.  No shape is provided, and no reference 
ID such as Tiger Line ID is provided either.  We cannot validate these segments against 
reference data, nor can we generate shapes for these segments. 

File 34-blocks-NJ.xlsx contains 68,604 records.  No shape is provided, but a Census 
Block ID is provided.  Every ID is 15 digits long, suggesting this is Year 2000 Census 
Bureau geometry.  We checked for duplicates and none were found.  All blocks passed 
validation against Year 2000 reference data. 



File "..Max Ad.." contains 7 records specifying the max advertised speed by CBSA/RSA.  
The max down speeds are 9 or 10; the max up speeds are all 7. 

File "Broadband .." is a cover letter that provides no data suitable for loading. 

Section 5: Data Transformation and Loading 

NTIA Table BB_Service_CensusBlock 

Loaded from supplied text file “NJ - Wireline Service By Census Block.txt”.  The 
following table explains the transformations that were applied to load the target table. 

Table Column Data Source / Transformation

PROVNAME As supplied in column “Provider_Name” 
DBANAME As supplied in column “DBA_NAme” 
PROVIDER_TYPE Set to 1 
FRN As supplied in column “FRN” 
STATEFIPS Set to “34” (NJ) 
COUNTYFIPS Populated from Census_Block_FIPS_Code (first 3 digits) 
TRACT Populated from Census_Block_FIPS_Code (next 6 digits)
BLOCKID Populated from Census_Block_FIPS_Code  

(next 4 digits; dropped 5th character if present) 
BLOCKSUBGROUP Set to null 
FULLFIPSID As supplied in column Census_Block_FIPS_Code 
TRANSTECH As supplied in column Technology_of_Transmission 
MAXADDOWN Set to “10” (see below) 
MAXADUP Set to “7” (see below) 
TYPICDOWN Set to null, not supplied 
TYPICUP Set to null, not supplied 
SHAPE Copied from Census Bureau TigerLine 2000,  

As matched by Census block 2000 ID 

Internal processing notes: 
20. Census Blocks: Comcast supplied Census 2000 block IDs (all are 15 characters).  

We referenced the Census Bureau TigerLine database for Year 2000 to extract 
and submit geographic features (i.e., shapes) for each census block based on 
the Census_Block_FIPS_Code. 

21. Speeds:  Data for maximum advertised down and up speeds were taken from file 
“New Jersey Maximum Advertised Speeds.xlsx”, where the same values are 
supplied for every MSA that Comcast serves. 

NTIA Table BB_Service_RoadSegment 

Loaded as discussed below.  The following table explains the transformations that were 



applied to load the target table. 

Table Column Data Source / Transformation

PROVNAME Set to “Comcast Cable Communications, LLC”
DBANAME Set to “Comcast” 
PROVIDER_TYPE Set to 1 
FRN Set to “0004441663” 
ADDMIN Set to the least of the non-empty address numbers for the line 

segment 
ADDMAX Set to the greatest of the non-empty address numbers for the line 

segment 
PREDIR  Set to null (no value supplied) 
STREETNAME As supplied (has all street components, not just name) 
STREETTYPE Set to null (no value supplied) 
SUFFDIR Set to null (no value supplied) 
CITY Set to null (no value supplied) 
STATECODE Set to “NJ” 
ZIP5 Set to value of zipl column for the line segment 
ZIP4 (no value supplied) 
TRANSTECH As supplied 
MAXADDOWN Set to 10 
MAXADUP Set to 7 
TYPICDOWN Set to null 
TYPICUP  Set to null 
SHAPE Copied from Census Bureau TigerLine 2000,  

As matched by County + Tiger Line ID 

As mentioned above, the Comcast submission of street segments could not be matched 
with the Census Bureau TigerLine database.  Instead we gathered a list of segments in 
large census blocks via two methods.  We loaded a total of 6,868 segments. 

First, for municipalities served in their entirety by Comcast, the following approach was 
used. 

1. Adjusted the Municipality names provided by Comcast with the following rules to 
enable matching with official New Jersey Municipality reference data 

a. Changed to upper case 
b. Performed the following string replacements on the Municipality field 

i. TOWNSHIP -> TWP 
ii. BOROUGH -> BORO (only when preceded by a space)
iii. MT. -> MOUNT 
iv. PT. -> POINT 
v. ORANGE CITY -> CITY OF ORANGE TWP (ORANGE at start of 

line) 
c. Removed any additional information in parentheses  (I.e., appended 

county name) 
2. Performed join between two data sources, using Municipality and County as keys 



3. Dropped four military bases that did not match any municipality 
4. Generated a file with Municipality, Type, County and Municipal Code 
5. Joined this information with the large census blocks for each municipality, and 

then joined that result with the street segments for each large census block.   
6. Loaded the resulting set of street segments and shapes after removing 

duplicates.  

Second, we had to use a different approach for certain municipalities.  Comcast 
indicated that for the following three municipalities, the approach of listing all street 
segments in a municipality would not be valid: 

• Mount Olive Twp., Morris County 
• Toms River (Dover Twp.), Ocean County 
• Berkeley Twp., Ocean County 

For these counties, we matched the segments provided by Comcast to the TigerLine 
segments.  Of the 23 segments in these municipalities, we were able to locate 20 street 
segments. 

Section 6: Clarification Questions and Responses 

1.  no typical values supplied (up or down) in any format (CB, etc.). This was an 
issue last submission as well when avg. downstream was provided for RSA/CBSA 
level only. 
2.  no subscriber weighted values supplied. 
3. street segment data does not provide geographic features (e.g., shape) nor keys 
to a reference DB. 
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Michael, 
   We have been reviewing the data your submitted to the NJ Broadband Mapping Program and have a 
few clarification questions. 
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Thanks for your participation in the program! 

John Wullert 
Manager – NJ BB Data Collection 
Telcordia Technologies 
732-699-2687 
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John— 

I verified that the list still applies, with the same assumptions as last year. 

Thanks— 
Michael 
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Section 8: Overview Map of Submitted Data 

  



Broadband Provider Data Report 

Provider: Dieca DBA Covad 
Received: Feb, 2011 
Submission date: April 2011 

This report presents details on processing of the broadband data for delivery to the 
National Telecommunications and Information Administration. 

Sections: 
58. NDA Status 
59. Submission Overview 
60. Submission File Details 
61. Data Validations and Results 
62. Data Transformation and Loading 
63. Clarification Questions and Provider Responses 
64. Notes and Open Issues 

Section 1: NDA Status 

No information provided. 

Section 2: Submission Overview 

AVAILABILITY DATA 

ID 

Provider name 

“Doing business as” name 

FRN 

DIECA Communications, Inc. 

Covad Communications Company 

0003753753 

FOR WIRELINE 

Filetypes 

File size 

Speeds 

Type 

Spatial Resolution 
(address, street seg, 
census block, 
RSA/MSA, 
zipcode,etc) 

Typical-upstream  Address & block 

Typical-downstream  Address & block 

Advertised-upstream  Address & block 

Advertised-
downstream 

Address & block 

Subscriber-weighted-
up 

county level 

Speeds are provided at address 
(line segment) and census 
block granularity. 



Subscriber-weighted-
down 

county level 

Technology 
Type 

10 (ADS), 20 (SDSL), 30 (other copper) 

End-user 
specification 

Not provided 

Comments: 

INTERCONNECTION DATA 

ID File **MiddleMileConnection*.txt 

File size 1kb 

Ownership 1 

Transport Type 

Data 
Rates/Capacity 

4, 5 

Location 5 locations 

Comments:Five (5) data rows provided 

Section 3: Submission File Details 

Received a zip file by SECURE UPLOAD (name disambiguated from previous 
submissions). 

Size (kb) Name 
610  DIECACommunicationsInc._NJ_CONFIDENTIAL3.zip 

The archive contains the following five (5) files: 

Size  Name 
109   NJBB_0003753753_AddressSegmentAvailability_DIECACommunicationsInc._CONFIDENTIAL.txt 
17924  NJBB_0003753753_CensusBlockAvailability_DIECACommunicationsInc._CONFIDENTIAL.txt 
3   NJBB_0003753753_CMAAdvertisedAvailability_DIECACommunicationsInc._CONFIDENTIAL.txt 
1  NJBB_0003753753_MiddleMileConnection_DIECACommunicationsInc._CONFIDENTIAL.txt 
3 NJBB_0003753753_SubscriberWeightedNominalSpeed_DIECACommunicationsInc._CONFIDENTIAL.txt

Section 4: Validations and Results 

File “..AddressSegmentAvailability..” (945 rows) 
Technologies: 30,20,10 (xDSL and other copper) 

Fields: 



Provider Name  
DBA Name  
FRN  
Census Block ID  
Street Name Street Segment ID (TLID)  
Technology of Transmission  
Maximum Advertised Downstream Speed  
Maximum Advertised Upstream Speed  
Typical Downstream Speed  
Typical Upstream Speed 

All TLID were validated against year 2000 Census Bureau reference data successfully, 
and all are in large census blocks. 

File “..CensusBlockAvailability..” (193,193 rows) 
Fields: 
Provider Name  
DBA Name  
FRN  
Census Block ID  
Technology of Transmission  
Maximum Advertised Downstream Speed  
Maximum Advertised Upstream Speed  
Typical Downstream Speed  
Typical Upstream Speed 

The input contains Year 2000 census block data, judging from the consistent length of 
15 digit block IDs.  Due to use of multiple technologies there are more rows here than 
the number of NJ census blocks (141,342).  No duplicates were received, all submitted 
IDs are valid according to Year 2000 reference data, and all are less than 2 square 
miles. 

File “..CMAAdvertisedAvailability..” 
Provides three technology codes (10, 20, 30), MSA codes, and max advertised up and 
down speed codes.  The max speed for a given technology is different for different 
MSAs.  We are unlikely to use this data since max speed codes are provided on a row-
by-row basis. 

File “..MiddleMileConnection..” 

5 rows, which is a significant change from the last submission, when only 2 rows were 
provided.  Viewing the data in ArcMap indicates that all points are in New Jersey. 



File “..SubscriberWeightedNominalSpeed..” 

All CMA IDs are valid, technology of transmission codes are valid, and speed codes 
are plausible.  We do not submit overview data in this round so will not use this input 
file. 

Section 5: Data Transformation and Loading 

NTIA Table BB_ConnectionPoint_MiddleMile 

Loaded from supplied file “..MiddleMileConnection..”.  The following table explains the 
transformations that were applied.  

Table 
Column 

Data Source / Transformation

PROVNAME As supplied in column Provider Name 
DBANAME As supplied in column DBA Name 
FRN As supplied in column FRN 
OWNERSHIP As supplied in column Ownership 
BHCAPACITY As supplied in column Serving Facility Capacity 
BHTYPE As supplied in column Service Facility Type 
LATITUDE As supplied in column Latitude 
LONGITUDE As supplied in column Longitude 
ELEVFEET As supplied in column Elevation 
STATEABBR Set to “NJ” 
FULLFIPSID ID of containing census block from Year 2000 Census Bureau 

TigerLine reference data  
SHAPE Point shape created using ESRI ArcDesktop 

Internal notes on processing: 
22. Created an excel sheet and imported to a geodatabase table. 
23. Added point corresponding to the Latitude, Longitude pair by creating a feature 

class from the table using ArcCatalog’s “Create Feature Class from XY Table” 
option.  Specify WGS84 for the coordinate system of the points (this is a guess). 

24. Added a column containing the ID of the containing year 2000 census block via a 
spatial join of the points and the census block shapes from reference data. 

NTIA Table BB_Service_CensusBlock 

Loaded from supplied file “..CensusBlockAvailability..”.  The following table explains the 
transformations that were applied to load the target table. 

Table Column Data Source / Transformation



PROVNAME As supplied in column Provider_Name 
DBANAME As supplied in column DBA_Name 
PROVIDER_TYPE Set to 1 
FRN As supplied in column FRN 
STATEFIPS Set to “34” (NJ) 
COUNTYFIPS Populated from Census_Block_ID (first 3 digits) 
TRACT Populated from Census_Block_ID (next 6 digits) 
BLOCKID Populated from Census_Block_ID 
BLOCKSUBGROUP Set to null 
FULLFIPSID As supplied in column Census_Block_ID 
TRANSTECH As supplied in column Technology_of_Transmission 
MAXADDOWN As supplied in column 

Maximum_Advertised_Downstream_Speed 
MAXADUP As supplied in column Maximum_Advertised_Upstream_Speed 
TYPICDOWN Set to null 
TYPICUP Set to null 
SHAPE As found in Census Bureau TigerLine year 2000 reference data 

Internal processing notes: 
3. We used Census Bureau reference data for Year 2000 to locate and submit 

geographic features (i.e., shapes) for each census block. 

NTIA Table BB_Service_RoadSegment 

Loaded from supplied File “..AddressSegmentAvailability..".  The following table 
explains the transformations that were applied to load the target table. 

Table Column Data Source / Transformation

PROVNAME As supplied in column Provider_Name 
DBANAME As supplied in column DBA_Name 
PROVIDER_TYPE Set to 1 
FRN As supplied in column FRN 
ADDMIN Set to the least of the non-empty address numbers from TigerLine 
ADDMAX Set to the greatest of the non-empty address numbers from 

TigerLine 
PREDIR  Set to null (no value supplied) 
STREETNAME As supplied (has all street components, not just name) 
STREETTYPE Set to null (no value supplied) 
SUFFDIR Set to null (no value supplied) 
CITY Set to null (no value supplied) 
STATECODE Set to “NJ” 
ZIP5 Set to zipl from TigerLine 
ZIP4 Set to null (no value supplied) 
TRANSTECH As supplied 



MAXADDOWN As supplied in column Maximum_Advertised_Downstream_Speed 
MAXADUP As supplied in column Maximum_Advertised_Upstream_Speed 
TYPICDOWN Set to null 
TYPICUP  Set to null 
SHAPE Road segment shape copied from Year 2000 Census Bureau 

TigerLine reference data, as matched by TLID 

Internal processing notes: 
1. Discarded 6 duplicate rows from the input based on compound key of county, 

TLID, and tech_transmission fields.  These occur because the segment touches 
different census blocks, but we cannot submit duplicate shapes. 

2. After join against Census Bureau reference data, 25 rows were discarded based 
on compound key of county, TLID, and tech_transmission fields.  This is again 
due to segments touching multiple census blocks. 

3. Total rows loaded is 938 

Section 6: Clarification Questions and Responses 

Section 7: Notes and Open Issues 



Section 8: Overview Map of Submitted Data 

  



Broadband Provider Data Report 

Provider: GOES Telecom 
Received: March 2011 
Submission date: April 2011 

This report presents details on processing of the broadband data for delivery to the 
National Telecommunications and Information Administration. 

Sections: 
65. NDA Status 
66. Submission Overview 
67. Submission File Details 
68. Data Validations and Results 
69. Data Transformation and Loading 
70. Clarification Questions and Provider Responses 
71. Notes and Open Issues 

Section 1: NDA Status 

None 

Section 2: Submission Overview 

AVAILABILITY DATA 

ID 

Provider name 

“Doing business as” name 

FRN 

Holding company name 

Holding company number 

GOES Telecom 

Not provided 

0011437746 

GOES 

130548 

FOR WIRELINE 

Filetypes 1 Excel  

File size worksheet 18432 bytes, approx 38 rows 

Speeds 

Type 

Spatial Resolution 
(address, street seg, 
census block, 
RSA/MSA, 
zipcode,etc) 

Typical-upstream  Not provided 

Typical-downstream  Not provided 

Advertised-upstream  Not provided 

Advertised-  Not provided 

Submitted 34 addresses with 
upload and download speeds 
(generally in kbps) for each 
address.   These are delivered 
speeds to customers.  We 
located advertised speeds on 
their Web site, and provider 
confirmed that those speeds 
were available at each location 
they served.  We will use the 
data from Web site as 



downstream 

Subscriber-weighted-
up 

Not provided 

Subscriber-weighted-
down 

Not provided 

advertised speeds.   

Note that for three addresses, 
submitted speeds as “10mpbh”.  
Need to ask them what that 
means.  We asked these 
questions last time, but did not 
receive a response in time to 
submit.  This time we received 
corrected data. 

Note also that some speeds are 
listed as having faster upload 
speeds than download speeds.  
Need to verify.  We asked these 
questions last time, but did not 
receive a response in time to 
submit.  This time we received 
corrected data. 

No typical or subscriber 
weighted speeds were 
provided. 

Technology 
Type 

10 (ADSL) and 70 (Terrestrial fixed wireless) 

End-user 
specification 

None 

Comments: Provided a list of 34 customers and the speeds they are subscribed to.  Most are 128K up, 512K 
down.

INTERCONNECTION DATA 

ID None provided 

File size 

Ownership 

Transport Type 

Data 
Rates/Capacity 

Location 

Comments: 

Section 3: Submission File Details 

Received 1 file by email, subsequently updated: 

Size  Name 
17920  20110302 Telcordia.xls 
17920  20110302 Telcordia_update.xls 



The file contains a list of addresses and max speeds; e.g., the “up-to” limit of their rate 
plan.  The addresses in this file appear to be for individual customers (as opposed to 
addresses of multi-tenant buildings in a central business district).   

Section 4: Validations and Results 

The addresses can be geocoded.   

For many ADSL subscribers, a download/upload rating of 512K/128K looks reasonable, 
but this is not a "broadband" service according to the NOFA definition.  We will discard 
records for slow services. 

Some ADSL subscribers have upload speeds that exceed download.  The last two 
entries have unknown speed ratings: 10mpbh up and 10mpbh down.  The updated 
submission corrected these problems. 

What spectrum is used by the fixed wireless service? 

Section 5: Data Transformation and Loading 

The standard NDA prohibits us from submitting address-level data to the NTIA.  Instead, 
we will discover the census block for each customer address, then report the census 
block shape drawn from Census Bureau TigerLine reference data. 

NTIA Table BB_Service_CensusBlock 

Loaded from supplied file “20110302 Telcordia_update.xls” (37 data rows, only 9 
broadband-speed rows).  The following table explains the transformations that were 
applied to load the target table. 

Table Column Data Source / Transformation

PROVNAME Set to “Global Online Electronic Services, Inc.” 
DBANAME Not supplied; set same as PROVNAME 
PROVIDER_TYPE Set to 1 
FRN Set to “0011437746”

STATEFIPS Set to “34” (NJ) 
COUNTYFIPS Populated from Census Block FIPS Code (first 3 digits) 
TRACT Populated from Census Block FIPS Code (next 6 digits)
BLOCKID Populated from Census Block FIPS Code 
BLOCKSUBGROUP Set to null 
FULLFIPSID Populated from Census Block FIPS Code 
TRANSTECH As supplied in column Technology Code 
MAXADDOWN Set to code 4 per email response to questions 
MAXADUP Set to code 3 per email response to questions 
TYPICDOWN Set to null, not provided 



TYPICUP Set to null, not provided 
SHAPE Copied from Census Bureau TigerLine 2000,  

as matched by spatial join on geocoded address 

Internal processing notes: 
22. Geocoded the addresses using the Google geocoder to obtain latitude, longitude 

value pairs. 
23. Created point shapes using ESRI from lat, long value pairs. 
24. Spatially joined the points with Census Bureau TigerLine Year 2000 reference 

data to find the containing census block.  This yielded census block attributes 
including the ID (aka FIPS code). 

25. Dropped duplicate census blocks (caused by two customers in the same census 
block). 

26. Loaded the resulting data into an SDE feature class.  Of 37 original records, 33 
were successfully geocoded, 9 have broadband speeds (rest are 128Kbps), and 
1 is a duplicate, leaving just 8. 

The mechanized procedure for the three steps is described in file GeoExcel_proc.txt. 

NTIA Table BB_Service_Wireless 

Loaded using shapes from reference data for the 2 unique records.  The following table 
explains the transformations that were applied. 

Table Column Data Source / Transformation

PROVNAME Set to “Global Online Electronic Services, Inc.” 
DBANAME Not supplied; set same as PROVNAME 
FRN Set to "0011437746" 
TRANSTECH Set to 70 as supplied in XLS sheet 
SPECTRUM Set to 6 
MAXADDOWN Set to 7 
MAXADUP Set to 7 
TYPICDOWN Set to null 
TYPICUP Set to null 
STATEABBR Set to “NJ” 
SHAPE Year 2000 Census Block shape obtained from reference data.

Internal processing notes: 
5. See above for discussion of geocoding addresses and finding the containing 

census block. 
6. Spectrum: Set to 6, Unlicensed 
7. Speeds: The fixed-wireless link is reported with 10Mbps in each direction 

(symmetric).  That corresponds to NOFA speed code 7. 

Section 6: Clarification Questions and Responses 
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John, 
The attached file has been has the corrected upload and download speeds..   
In answer to you 3rd questions, the customers pay for different speed plans. 
George 
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•  Direct
*
 $39.95/month 512K Downstream/128K Upstream plus 5 Email Boxes 

•  Express
*
 $49.95/month 768K Downstream/512K Upstream plus 5 Email Boxes  

•  Power* $59.95/month 1024K Downstream/384K Upstream plus 5 Email Boxes  
•  Select

*
 $79.95/month 1536K Downstream/512K Upstream plus 5 Email Boxes  

•  Performance
*
 $99.95/month 1536K Downstream/768K Upstream plus 5 Email Boxes 

John 
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Section 7: Notes and Open Issues 
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Broadband Provider Data Report 

Provider: Hometown Online 
Received: March 2011 
Submission date: April 2011 

This report presents details on processing of the broadband data for delivery to the 
National Telecommunications and Information Administration. 

Sections: 
72. NDA Status 
73. Submission Overview 
74. Submission File Details 
75. Data Validations and Results 
76. Data Transformation and Loading 
77. Clarification Questions and Provider Responses 
78. Notes and Open Issues 

Section 1: NDA Status 

No NDA in place. 

Section 2: Submission Overview 

AVAILABILITY DATA 

ID 

Provider name 

“Doing business as” name 

FRN 

Hometown Online Inc. 

Warwick Online  

0006-6512-44 

FOR WIRELINE 

Filetypes Text 

File size 1,761,280 bytes; 6,778 rows 

Speeds 

Type 

Spatial Resolution 
(address, street seg, 
census block, 
RSA/MSA, 
zipcode,etc) 

Typical-upstream  Not provided 

Typical-downstream  Not provided 

Advertised-upstream  Not provided 

Advertised-
downstream 

Not provided 

Subscriber-weighted-
up 

Not provided 

Provided list of customer 
locations with column “DSL 
speed avail”.  This is probably 
downstream speed, but need to 
verify with provider. 

Communications with provider 
and validation via their Web site 
resulted in clarification: Max 
advertised speeds are: 

Downstream: 15 Mbps 

Upstream: 800 Mbps. 

‘ 

Rows where the speed and 



Subscriber-weighted-
down 

Not provided DSL Qual columns are blank 
indicate no-service.  These 
should be dropped. 

Provider has column that 
indicates geo-spatial 
capabilities, but only one 
address in list appears to be 
geo-located on their map 

Technology 
Type 

DSL – not clear in each case whether it is Asymmetric or Symmetric 

End-user 
specification 

Not provided 

Comments: Address data with some indications of qualification for different data services.

INTERCONNECTION DATA 

ID 

File size 

Ownership 

Transport Type 

Data 
Rates/Capacity 

Location 

Comments:No connection-point data provided 

Section 3: Submission File Details 

Received one (1) file by EMAIL: 

Size  Name 
1,761,280 M4 STRUCTURES - NJ 3-10-11.xls 

The file contains 6778 rows of data.  Each row has a street address.  Of the 6778 rows, 
121 have no speed data.  The rest have an indication of maximum possible DSL speed.  
Some indicate 5Mbps, some indicate 15Mpbs and some indicate 25Mbps.  Also has 
information about TV qualification which we do not require. 

Section 4: Validations and Results 

All addresses were successfully geocoded using Arroyo flow 
Hometown_geocode_yahoo.arroyo invoking the Yahoo geocoder. 



Section 5: Data Transformation and Loading 

The standard NDA prohibits us from submitting address-level data to the NTIA.  Instead, 
we discover the census block for each customer address, and then report the census 
block shape drawn from Census Bureau TigerLine reference data. 

NTIA Table BB_Service_CensusBlock 

Loaded from the supplied file after geocoding.  The following table explains the 
transformations that were applied to load the target table. 

Table Column Data Source / Transformation

PROVNAME Set to “Hometown Online Inc.” 
DBANAME Set to “Warwick Online” 
PROVIDER_TYPE Set to 1 
FRN Set to “0006651244” 
STATEFIPS Set to “34” (NJ) 
COUNTYFIPS Populated from Census Block FIPS00 Code (first 3 digits) 
TRACT Populated from Census Block FIPS00 Code (next 6 digits)
BLOCKID Populated from Census Block FIPS00 Code 
BLOCKSUBGROUP Set to null 
FULLFIPSID Populated from Census Block FIPS00 Code 
TRANSTECH Set to code “10” (ADSL) 
MAXADDOWN Set to code “7” (range includes 15Mbps, per email) 
MAXADUP Set to code “3” (range includes 1Mbps, per email) 
TYPICDOWN Set to null, not supplied 
TYPICUP Set to null, not supplied 
SHAPE Copied from Census Bureau TigerLine 2000,  

as matched by spatial join on geocoded address point 

Internal processing notes: 
27. Geocoded the addresses using the Yahoo geocoder; all were geocoded 

successfully. 
28. Created an excel sheet and imported to a geodatabase table. 
29. PreLoaded the xls file (geocoded entries, joined with Census Blocks and 

exported into SDE).  
30. Added point shapes corresponding to each Latitude,Longitude pair by creating a 

feature class from the table using ArcCatalog’s “Create Feature Class from XY 
Table” option. 

31. Added a column containing the ID of the containing year 2000 census block via a 
spatial join of the point shapes and the census block shapes from reference data. 

32. Discarded 6,106 rows with duplicate census blocks, leaving 433 unique census 
blocks. 

33. Kept only blocks in the cities of Hardyston, Highland, Vernon, and West Milford 
(several variations like Twp and Township).  Discarded blocks that were 



geoloated in cities Hewitt, Hillsdale, Wantage Twp, etc. 

Section 6: Clarification Questions and Responses 

1. You provide DSL Speed Available on most of the rows in the submitted data.  In 
this data, 25 Mbps is the highest value.  Can we use this as the maximum 
advertised downstream speed?  Is this value potentially available at the other 
locations, even if the customer selected a lower speed tier? 

2. Assuming the answer to question 1 is yes, what is the maximum upstream speed 
that corresponds to the downstream speed of 25Mbps?  (Alternatively, what is 
the maximum advertised upstream speed?) 

3. Of the data submitted, 121 records do not include any speed data.  These 
records also have blanks in the DSL Qual column.  Does that mean that you do 
NOT offer DSL services to these addresses? (If so, we will drop these records 
from the submission.) 

4. Your data lists DSL as the technology used to deliver the broadband access.  Is 
this ADSL or SDSL?  Does that vary by location? 

5. The NTIA has repeatedly asked us to request typical speed data at the census 
block level.  Do you have this data available? 
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Scott, 
   We have reviewed the data you submitted to the NJ Broadband Mapping program and have a few 
clarification questions: 
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Thanks for you participation! 

John Wullert 



Manager – NJ BB Data Collection 
Telcordia Technologies 
732-699-2687 
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John  
  
See responses. 
  
Have a great day. 
  
Scott 

-----Original Message----- 
From: "NJ Broadband Data Collection" <ConnectingNJ@research.telcordia.com> 
Sent: Monday, March 14, 2011 11:40am 
To: s.sommerer@wvtc.com 
Cc: ConnectingNJ@research.telcordia.com 
Subject: Hometown NJ Broadband Data Clarification 

Scott,�
   We have reviewed the data you submitted to the NJ Broadband Mapping program and have a few 
clarification questions: 
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Scott, 



   A few additional clarifications on your answers 
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Thanks for your help. 

John Wullert 
Manager – NJ BB Data Collection 
Telcordia Technologies 
732-699-2687 

John  
  
See responses. 
  
Have a great day.. 
  
Scott 

-----Original Message----- 
From: "NJ Broadband Data Collection" <ConnectingNJ@research.telcordia.com> 
Sent: Monday, March 14, 2011 11:40am 
To: s.sommerer@wvtc.com 
Cc: ConnectingNJ@research.telcordia.com 
Subject: Hometown NJ Broadband Data Clarification 

Scott,�
   We have reviewed the data you submitted to the NJ Broadband Mapping program and have a few 
clarification questions: 
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From: "NJ Broadband Data Collection" <ConnectingNJ@research.telcordia.com> 
Sent: Wednesday, March 16, 2011 7:33am 
To: s.sommerer@wvtc.com 
Cc: ConnectingNJ@research.telcordia.com 
Subject: RE: Hometown NJ Broadband Data Clarification 

Scott,�
   A few additional cladrifications on your answers
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I am assuming these two should be reversed. 
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Thanks for your help. 

John Wullert 
Manager – NJ BB Data Collection 
Telcordia Technologies 
732-699-2687 
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John 
  
Upon further review:  I would like to change my response. 
  
  We do not advertise a downstream speed.  We do not advertise an upstream speed. 
  We just advertise "its fast" 
  
SDSL is offered in census track 3714. 
  
Have a great day. 
  
Scott 
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Scott, 
   On the wvtc.com Web site, I see multiple speed plans (2Mbps, 1Mbps and 512 kbps) as well as a 
reference “up to 15 Mbps in select areas”.  These speeds are not specifically identified as upstream or 



downstream, but seem likely to be referring to downstream rates.    These are the type of advertised 
speeds we are trying to collect and accurately reflect in the broadband map.   I don’t have any way to 
report a speed of “fast”, and I don’t want to have to leave your data out of our submission.  I propose that 
we use 15 Mbps as the maximum advertised downstream speed.  I’d still like to have a corresponding 
upstream speed.  Other DSL providers with 15 Mbps downstream provide a 1 Mbps upstream rate.  Is 
that an accurate value for your service? 

John 
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John 
  
You've got me.  It is on our website and I must have just spoken to the wrong person. 
  
Lets go with 15 Mbps as max advertised downstream and corresponding upstream is more like 800K 
rather than 1 Mbps. 
  
Have a great day. 
  
J. Scott Sommerer 

NOTE: These answers to questions from previous submission define the fields in the 
data file: 
�
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Scott, 
    We have performed our initial review of the data you submitted and we have several clarification 
questions and requests for additional information. 
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We would appreciate your prompt response to these questions. 

John Wullert 
Manager – NJ BB Data Collection 
Telcordia Technologies 
732-699-2687 
�
�

�����������������('��������������������������('���������
���	��?�������-�&���	����>�� !�!�������#��

����

����
���������������������������

����������&����5����C�����&��G���
��(��H�
�����	��?5��0.��/�����(
���������������)������
�

�
John 
  
1) regarding maximum download speed:   you asked "What are the maximum advertised downstream.... 
speeds..."

  My marketing manager tells me the maximum advertised downstream speed is15Mbps.  I will stick with 
that answer. 

2)  Regarding the rows in the table listing 25 Mbps.  This is the actual speed.  But it is not what we 
advertise. 

3) Regarding the corresponding upload speed for 2) above.. answer is 25 Mbps 

4)  Rows with no DSL entry means the structure is not Geo coded on our map.  This could mean that we 
do offer service there and we just have not built out to establish the speed.  But we just cannot give you 
the speed level for these locations.  So maybe you just obliterate them from the data. 

John, I hope and think that these four answers will get us good to go..  And you have established earlier 
that you will not publicize the availability of our video services.  So take it away my friend. 

J. Scott Sommerer 

Section 7: Notes and Open Issues 



Section 8: Overview Map of Submitted Data 

  



Broadband Provider Data Report 

Provider: HughesNet Communications Inc. 
Received: March 2011 
Submission date: April 2011 

This report presents details on processing of the broadband data for delivery to the 
National Telecommunications and Information Administration. 

Sections: 
79. NDA Status 
80. Submission Overview 
81. Submission File Details 
82. Data Validations and Results 
83. Data Transformation and Loading 
84. Clarification Questions and Provider Responses 
85. Notes and Open Issues 

Section 1: NDA Status 

NONE 

Section 2: Submission Overview 

AVAILABILITY DATA 

ID 

Provider name 

“Doing business as” name 

FRN 

Hughes Network Systems, LLC

HughesNet 

0017434911

FOR WIRELINE 

Filetypes 

File size 

Speeds 

Type 

Spatial Resolution 
(address, street seg, 
census block, 
RSA/MSA, 
zipcode,etc) 

Typical-upstream  Not provided 

Typical-downstream  Not provided 

Advertised-upstream  Provided 

Advertised-
downstream 

Provided 

Subscriber-weighted-
up 

Not provided 

Submitted Excel file containing 
a list of counties per state that 
are covered by their service.  
This included all 21 counties in 
New Jersey.  

Email message contained an 
image that listed their three 
consumer service plans and the 
associated upstream and 
downstream data rate. 

Max plan "Power 200" is 2Mbps 
down, 300Kbps up.  The 
corresponding speed range 
codes are 4 down, 2 up. 



Subscriber-weighted-
down 

Not provided 
Spectrum is 7, satellite. 

Technology 
Type 

Code 60 (Satellite) 

End-user 
specification 

Voice message indicated that the referenced plans are consumer-focused. 

Comments: 

INTERCONNECTION DATA: NONE 

ID 

File size 

Ownership 

Transport Type 

Data 
Rates/Capacity 

Location 

Comments: Not provided 

Section 3: Submission File Details 

Received an extraordinarily short email explaining their service offering, with a JPG 
image of the northeastern United States showing where they have subscribers.   

Section 4: Validations and Results 

No rows of data need to be validated. 

Section 5: Data Transformation and Loading 

NTIA Table BB_Service_Wireless 

Loaded county shapes from reference data for the State of New Jersey based on 
emailed statements that all counties are covered.  The following table explains the 
transformations that were applied. 

Table Column Data Source / Transformation

PROVNAME Set to "Hughes Network Systems, LLC" 
DBANAME Set to "HughesNet" 



FRN Set to 0017434911 
TRANSTECH Set to 60 
SPECTRUM Set to 7 per translation shown below 
MAXADDOWN Set to 4, see below. 
MAXADUP Set to 2”, see below. 
TYPICDOWN Not provided, set to null 
TYPICUP Not provided, set to null 
STATEABBR Set to “NJ” 
SHAPE County shape read from reference data.

Internal notes on processing: 
8. Spectrum: No statement was provided.  The NTIA data model has a single 

column for spectrum.  Satellite corresponds to NTIA “SPECTRUM USED” code 
value 7. 

9. Speeds: The maximum advertised speeds provided in the emailed brochure are 
as discussed above  For max adv speeds we encoded the submitted down 
speed as value 4 (range 1.5-3 Mbps) and encoded the submitted up speed as 
value 2 (range 200 Kbps -- 768 Kbps). 

Section 6: Clarification Questions and Responses 

��������������	�
���������������
����������

����
�����������������������������

���	��5��
�������������!B�� !������1�2��

���$���7�5����$�
�����

����
���������������������������

�����	��0.����������	�
���������������
�

�
Mark, 
   Thanks for the information.   Sorry I did not return your call – I just got back from a meeting. 

   One question – do you have information on typical speeds that are experienced by your customers on 
each of these plans? 

A side note – the NTIA is interested in finer-grained information than this, looking at specific factors that 
affect satellite coverage, such as terrain and building shadowing.  As I understand it, they will be 
contacting satellite providers at some point in the future to discuss appropriate techniques to model such 
effects. 

Thanks for you participation in the program. 

John Wullert 
Manager – NJ BB Data Collection 
Telcordia Technologies 
732-699-2687 
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Mark, 
   We need to report data to the NTIA using Provider Name, Doing-Business-As Name and FCC 
Registration number.  The information we retrieved from the FCC is: 

Provider Name:                Hughes Network Systems, LLC  
FRN:                                      00 17434911 

Are these correct?  Also, do you have another “doing-business-as” name? 

Thanks, 

John Wullert 
Manager – NJ BB Data Collection 
Telcordia Technologies 
732-699-2687 

Section 7: Notes and Open Issues 

  



Section 8: Overview Map of Submitted Data 

  



Broadband Provider Data Report 

Provider: Leap Cricket 
Received: March1, 2011 
Submission date: April, 2011 

This report presents details on processing of the broadband data for delivery to the 
National Telecommunications and Information Administration. 

Sections: 
86. NDA Status 
87. Submission Overview 
88. Submission File Details 
89. Data Validations and Results 
90. Data Transformation and Loading 
91. Clarification Questions and Provider Responses 
92. Notes and Open Issues 

Section 1: NDA Status 

Section 2: Submission Overview 

AVAILABILITY DATA 

ID 

PROVIDER NAME 

DBA NAME 

FRN  

Holding company name: 

Holding company number:  

Leap Wireless International, Inc. 

Cricket Communications, Inc. 

0002963528 

Leap Wireless International, Inc." 

130730 

FOR WIRELESS 

Filetypes 
1 Mapinfo file corresponding to NJ terrestrial 
mobile wireless coverage (type 80) 

Speeds 

Type 
Spatial Resolution (address, 
street seg, census block, 
RSA/MSA, zipcode) 

Upstream max 
adv 

yes (for entire shapefile) given 
in tier 

Downstream 
max adv 

yes (for entire shape) given in 
tier 

Upstream 
typical 

no. 

Downstream 
typical 

no. 



Subscriber-
weighted 

no. 

Technology 
Type 

Spectrum : yes 3 (PCS) and 4(AWS)

Comments:  

INTERCONNECTION DATA 

ID 

File size 

Ownership 

Transport Type 

Data 
Rates/Capacity 

Location 

Comments: no IC data provided. 

  



Quick loading results: 

Figure 1. Loading results 

  



Section 3: Submission File Details 

1 zip file containing 5 files by (EMAIL, SECURE UPLOAD): 

Size  Name 
1KB  NJ_Broadband_region.dbf 
1KB  NJ_Broadband_region.prj 
1KB  NJ_Broadband_region.shx 
1443KB NJ_Broadband_region.shp 
2KB  NJ_Broadband_region.TAB 

Section 4: Validations and Results 

The Mapinfo file contains a single row with a multipolygon shape (see above for preview 
picture).  The columns identify that the technology of transmission is wireless and that 
two different spectrum ranges are in use.  

Section 5: Data Transformation and Loading 

NTIA Table BB_Service_Wireless 

Loaded from the supplied Mapinfo file, with transformations as s 

Table Column Data Source / Transformation

PROVNAME As supplied in column provider_name 
DBANAME As supplied in column dba_name 
FRN Set to "130730" 
TRANSTECH As supplied in column technology_of_transmission
SPECTRUM Set to “4” per translation shown below 
MAXADDOWN As supplied in column downstream_speed. 
MAXADUP As supplied in column upstream_speed.. 
TYPICDOWN Not supplied, set to null 
TYPICUP Not supplied, set to null. 
STATEABBR Set to “NJ” 
SHAPE As supplied. 

Internal notes on processing: 
10. The supplied shape uses geographic coordinate system GCS_WGS_1984, same 

as that required by the NTIA data model.  First attempt at importing via this 
procedure failed with the error "Linestring or poly boundary is self-intersecting" 

a. Create new, empty feature class with expected XY Coordinate system, 
expected tolerance, and same schema. 

b. Loaded data to the new feature class from the supplied mapinfo file. 
11. Second attempt at importing worked: 

a. Import the supplied mapinfo file to ArcCatalog. 



b. Create new, empty feature class with expected XY Coordinate system, 
expected tolerance, and same schema. 

c. Load data to the new feature class from the newly imported feature class 
12. Spectrum: Leap provided “Y” value in the columns spectrum_pcs and 

spectrum_aws.  In the NTIA model the AWS spectrum is coded as value 4.  In a 
response to our query, Leap indicated that the different spectrum are in use in 
different places of their footprint.  Unfortunately we do not have the data. 

Section 6: Clarification Questions and Responses 

Provider does not provide: 
1. typical speeds 
2. susbscriber weighted averages 
3. interconnection data 

Provider provides 2 spectrum values for the coverage shape (PCS and AWS). Request 
separation of the shapes for these different technologies and check on speeds. 
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Doug, 
   We have reviewed the data you submitted to the NJ Broadband mapping program and have a few 
clarification questions: 

�� #
����	
������������
����	
����������������
��
����������������������������
��������


����
�����	�����
��
�����������������������������������

 � ����*�&��������
�������
������/
���������
�������������
�����������������������	�������

I�����	�J����������
�������������������	����	��	��������������
���		������������������

������

Thanks for your participation in the program. 

John Wullert 
Manager – NJ BB Data Collection 
Telcordia Technologies 
732-699-2687 
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John – please see Cricket’s response below.  Thanks, 
-Doug 
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Doug, 
   We have reviewed the data you submitted to the NJ Broadband mapping program and have a few 
clarification questions: 
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Thanks for your participation in the program. 
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Doug, 
   Can you provide us with separate shape files for the PCS and AWS?  I would offer to extract a shape 
for the counties, but I am sure your coverage areas do not line up exactly with the county boundaries.

Thanks, 
John 



Section 7: Notes and Open Issues 
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Broadband Provider Data Report 

Provider: Monmouth Telephone and Telegraph 
Received: March, 2011 
Submission date: April  2011 

This report presents details on processing of the broadband data for delivery to the 
National Telecommunications and Information Administration. 

Sections: 
93. NDA Status 
94. Submission Overview 
95. Submission File Details 
96. Data Validations and Results 
97. Data Transformation and Loading 
98. Clarification Questions and Provider Responses 
99. Notes and Open Issues 

Section 1: NDA Status 

Signed NDA is in place with NJ OIT. 

Section 2: Submission Overview 

AVAILABILITY DATA 

ID 

Provider name 

“Doing business as” name 

FRN 

Monmouth Telephone & Telegraph 

same 

0004325205 

FOR WIRELINE 

Filetypes Excel (NJBB_0004325205_AddressLevelAvailability.xls) 

File size 272896 bytes, 1071 records 

Speeds 

Type 

Spatial Resolution 
(address, street seg, 
census block, 
RSA/MSA, 
zipcode,etc) 

Typical-upstream  Address 

Typical-downstream  Address 

Advertised-upstream  Address 

Advertised-
downstream 

Address 

Subscriber-weighted-
up 

None provided 



Subscriber-weighted-
down 

Not provided 

Technology 
Type 

Code 30 – other copper line 

End-user 
specification 

Code 4 – Medium or Large Enterprise 

Comments: 

INTERCONNECTION DATA 

ID 

File size 

Ownership 

Transport Type 

Data 
Rates/Capacity 

Location 

Comments: No middle mile was provided at this time.  Monmouth gave the following explanation: 

Please note that Table 8, “Middle-mile and Backbone Interconnection Points Data”, is not included per 
instructions on page 11 of the  Data Submission Specifications” “Middle-mile and Backbone Interconnection 
Point information should focus on the connectivity at a point. That is, if a point at which network elements or 
segments are joined would not reasonably offer the possibility of technical connectivity with the network[s], it 
should not be reported”. 

Section 3: Submission File Details 

Received 1 zip file containing 3 .xls files and 1 .docx file: 

Size  Name 

272896 NJBB_0004325205_AddressLevelAvailability.xls

The file contains 1071 records.  Note that data file does not have a header row, but 
follows (largely) the ADDRESS DATA table from the NTIA “State Broadband Data and 
Development Grant Program” document. The columns and the corresponding headers 
are: 

A  - Provider Name 
C  - FRN 
D-L - Address 
M  - EndUserCat 
N  - TransTech 
O  - MaxAdvDown 



P  - MaxAdvUp 
Q  - TypicDown 
R  - TypicUp 

The FRN is missing leading zeros. Very few entries are provided in the  4 digit zip 
column (L), some do not have the required leading zeros. 
It was established (prior interactions) that the DBA is Monmouth Telephone & 
Telegraph. Certain addresses will need to be fixed for geocoding (also per prior 
interactions). 
Some records have speed tiers of 2 or less. 

  
27136  NJBB_0004325205_CMAAdvertisedAvailability.xls 

The file contains 13 records. Note that data file does not have a header row, but follows 
the CMA data submission template that we posted on the connectingnj web site. The 
columns and the corresponding headers are: 

A  - Provider Name 
C  - FRN 
D - CMA 
E  - TransTech 
F  - MaxAdvDown 
G  - MaxAdvUp 

27136  NJBB_0004325205_SubscriberWeightedNominalSpeed.xls 

The file contains 13 records. Note that data file does not have a header row, but follows 
the Subscriber-Weighted Nominal Speed data submission template that we posted on 
the connectingnj web site. The columns and the corresponding headers are: 

A  - Provider Name 
C  - FRN 
D - CMA 
E  - TransTech 
F  - SubsWeightedSpeed 

22016  Read Me.doc 

Section 4: Validations and Results 

Some of the addresses will be difficult or impossible to geo-locate due to format; e.g., 
179 Ave at the Common & 11, Shrewsbury, NJ. 



Section 5: Data Transformation and Loading 

The standard NDA prohibits us from submitting address-level data to the NTIA.  Instead, 
we will discover the census block for each customer address, then report the census 
block shape drawn from Census Bureau TigerLine reference data. 

NTIA Table BB_Service_CensusBlock 

Loaded from supplied Excel spreadsheet.  The following table explains the 
transformations that were applied to load the target table. 

Table Column Data Source / Transformation

PROVNAME Set to “Monmouth Telephone & Telegraph” 
DBANAME Set same as PROVNAME 
PROVIDER_TYPE Set to 1 
FRN Set to “0004325205” 
STATEFIPS Set to “34” (NJ) 
COUNTYFIPS Populated from Census Block FIPS Code (first 3 digits) 
TRACT Populated from Census Block FIPS Code (next 6 digits)
BLOCKID Populated from Census Block FIPS Code 
BLOCKSUBGROUP Set to null 
FULLFIPSID Populated from Census Block FIPS Code 
TRANSTECH As supplied in column TransTech 
MAXADDOWN As supplied in column MaxAdvDown 
MAXADUP As supplied in column MaxAdvUp 
TYPICDOWN Set to null 
TYPICUP Set to null 
SHAPE Copied from Census Bureau TigerLine 2000,  

as matched by spatial join on geocoded address 

Internal processing notes: 
34. Discarded 109 rows because the max adv down speed code was 1 or 2, which is 

not broadband according to the requirements of the NOFA 
35. Geocoded the addresses using the Google and Yahoo geocoders to obtain a 

Latitude, Longitude pair for each.. Addresses that yielded results with accuracy of 
6 or below were excluded; only intersection (7) or rooftop (8) accuracy is 
acceptable.  All addresses were geocoded; none failed. 

36. Created an Excel sheet and imported it to a geodatabase table. 
37. Added point shapes corresponding to each Latitude, Longitude pair by creating a 

feature class from the table using ArcCatalog’s “Create Feature Class from XY 
Table” option. 

38. Added a column containing the ID of the containing year 2000 census block via a 
spatial join of the point shapes and the census block shapes from reference data. 

39. Discarded 197 rows with duplicate census blocks while preserving the greatest 
speed.  These result from multiple customers in the same census block. 

40. Discarded 7 large census blocks (greater than 2 square miles). 



41. Final record count loaded is 757. 

The mechanized procedure for the three steps is described in file GeoExcel_proc.txt. 

Section 6: Clarification Questions and Responses 

1. Some records in the NJBB_0004325205_AddressLevelAvailability.xls file have 
maximum advertised download speed tiers of 2 or less.  If these values are the 
correct speeds, then they do not meet the NTIA definition of broadband. 
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Betty, 
    We have performed our initial review of your submission to the NJ Broadband mapping program and 
have a clarification question: 
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Thanks for your participation in the program! 

John Wullert 
Manager – NJ BB Data Collection 
Telcordia Technologies 
732-699-2687 
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Mr. Wullert:

  
Sorry for the delay of a reply.

  
Q: Several locations included in your list have downstream speed tiers of 2.  Can you just clarify which 
copper service you are using to deliver speeds less than 768 kbps?



A: T1

  
Q:  Can you provide us with the maximum advertised speed associated with your copper and fiber 
services?
A: 100Mb for Fiber and 1.5Mb for copper

  
Thank you 

Betty Booth 
Monmouth Telephone & Telegraph 

Section 7: Notes and Open Issues 
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Broadband Provider Data Report 

Provider: One Communications 
Received: March 2011 
Submission date: April 2011 

This report presents details on processing of the broadband data for delivery to the 
National Telecommunications and Information Administration. 

Sections: 
100. NDA Status 
101. Submission Overview 
102. Submission File Details 
103. Data Validations and Results 
104. Data Transformation and Loading 
105. Clarification Questions and Provider Responses
106. Notes and Open Issues 

Section 1: NDA Status 

Executed an NDA with NJ OIT. 

Section 2: Submission Overview 

AVAILABILITY DATA 

ID 

Provider name 

“Doing business as” name 

FRN 

Holding company name 

Holding company number 

One Communications 

None provided 

015-33-7702 

One Communications Corporation 

140069 

FOR WIRELINE 

Filetypes Excel (“Broadband Connections Data as of 12.31.10.xls”) 

File size 106,496 bytes (506 rows) 

Speeds 

Type 
Spatial Resolution: 
address

Typical-upstream  Not provided 

Typical-downstream  Not provided 

Advertised-upstream  Address Level* 

Advertised-
downstream 

Address Level * 

Subscriber-weighted-
up 

Not provided 

Provided table with addresses 
and speeds at each address.  
Speed columns are labeled 
“Maximum downstream speed” 
and “Maximum upstream 
speed” with values 1..8. 

We determined during last 
submission to use these values 
as advertised speeds 



Subscriber-weighted-
down 

Not provided 

Technology 
Type 

10 (ADSL), 20 (SDSL), 30 (Other copper) 

End-user 
specification 

All 3 (small business) 

Comments: 

INTERCONNECTION DATA 

ID Not provided 

File size 

Ownership 

Transport Type 

Data 
Rates/Capacity 

Location 

Comments: 

Section 3: Submission File Details 

Received 1 file by via email: 

Size  Name 
106,496 Broadband Connections Data as of 12.31.10.xls 

Many addresses in this file appear to be for individual customers; some may be 
addresses of multi-tenant buildings. 

Section 4: Validations and Results 

The codes in columns end user, tech trans, up speed, and down speed are generally 
valid.  However, several records have down-stream speed tiers of 1 or 2, which are not 
considered broadband.  We will inform the carrier and propose to drop these records. 

Section 5: Data Transformation and Loading 

The standard NDA prohibits us from submitting address-level data to the NTIA.  Instead, 
we will discover the census block for each customer address, then report the census 
block shape drawn from Census Bureau TigerLine reference data. 



NTIA Table BB_Service_CensusBlock 

Loaded from supplied file “One NJ Broadband Connections Data as of 12.31.10.xls”.  
The following table explains the transformations that were applied to load the target 
table. 

Table Column Data Source / Transformation

PROVNAME As supplied in column “Provider Name” 
DBANAME Not supplied; set same as PROVNAME 
PROVIDER_TYPE Set to 1 
FRN As supplied in column “FRN”, with leading zeroes added
STATEFIPS Set to “34” (NJ) 
COUNTYFIPS Populated from Census Block FIPS Code (first 3 digits) 
TRACT Populated from Census Block FIPS Code (next 6 digits) 
BLOCKID Populated from Census Block FIPS Code 
BLOCKSUBGROUP Set to null 
FULLFIPSID Populated from Census Block FIPS Code 
TRANSTECH As supplied in column Technology of Transmission 
MAXADDOWN Set to 7, the largest value found in submission 
MAXADUP Set to 7, the largest value found in submission 
TYPICDOWN Set to null, not provided 
TYPICUP Set to null, not provided 
SHAPE Copied from Census Bureau TigerLine 2000,  

as matched by spatial join on geocoded address 

Internal processing notes: 
25. Geocoded the addresses using the Google geocoder to obtain a Latitude, 

Longitude pair for each. 
26. Created an excel sheet and imported it to a geodatabase table. 
27. Added point shapes corresponding to each Latitude, Longitude pair by creating a 

feature class from the table using ArcCatalog’s “Create Feature Class from XY 
Table” option. 

28. Added a column containing the ID of the containing year 2000 census block via a 
spatial join of the point shapes and the census block shapes from reference data. 

29. Discarded 59 rows with duplicate census blocks, which is a common result when 
several customers are in the same area. 

30. Discarded 3 census blocks with an area larger than 2 square miles.  We did not 
discover road segments in these blocks to report them. 

The mechanized procedure for the geocoding step is described in file 
GeoExcel_proc.txt. 

Section 6: Clarification Questions and Responses 



1. You have several records that have downstream speed tiers of 1 or 2.  Note that 
NTIA does not consider these values to be broadband, so we will drop these 
records from the submission. 

2. The data you reported seems to be specific to customers.  Do you advertise or 
offer higher speeds to those customers over the existing facilities?   (Specifically, 
could these customers upgrade easily to a higher speed if needed?).  If so, what 
upload and download speeds are possible for these customers?  (If you have this 
information, we can use it as “maximum advertised” speeds and use the data you 
provided as “typical speeds”) 
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Jie, 
   We have reviewed your data and have identified a couple of issues that we would like to clarify: 
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We appreciate your prompt attention to these questions. 

John Wullert 
Manager – NJ BB Data Collection 
Telcordia Technologies 
732-699-2687 
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Hi John, 

To respond to your 2
nd

 bullet point, this is a question that has been raised by administrators of other 
states’ BB collection programs in the past as well and I have not been able to obtain the maximum 
advertised/available speeds information by geographical area internally from our engineering department 
despite several attempts.  I do think, in general, most of our customers can upgrade to a higher speed if 
needed and provided that it is achievable with the facilities that we have. 

Thanks, 



Jie 

Section 7: Notes and Open Issues 



Section 8: Overview Map of Submitted Data\ 

Broadband Provider Data Report 



Provider: Sidera Networks (formerly RCN) 
Received: March 2011 
Submission date: April 2011 

This report presents details on processing of the broadband data for delivery to the 
National Telecommunications and Information Administration. 

Sections: 
107. NDA Status 
108. Submission Overview 
109. Submission File Details 
110. Data Validations and Results 
111. Data Transformation and Loading 
112. Clarification Questions and Provider Responses
113. Notes and Open Issues 

Section 1: NDA Status 

Executed with NJ OIT. 

Section 2: Submission Overview 

AVAILABILITY DATA 

ID 

Provider name 

“Doing business as” name 

FRN 

Sidera Networks, LLC 

Sidera Networks 

0006-2544-03 

FOR WIRELINE 

Filetypes Text 

File size 30 rows 

Speeds 

Type 

Spatial Resolution 
(address, street seg, 
census block, 
RSA/MSA, 
zipcode,etc) 

Typical-upstream Not provided (despite 
the provider’s claim) 

Typical-downstream Not provided (despite 
the provider’s claim) 

Advertised-upstream  Address 

Advertised-
downstream 

Address 

Subscriber-weighted-  Not provided 



up 

Subscriber-weighted-
down 

Not provided 

Technology 
Type 

:9�I�����J�

End-user 
specification 

Category 4 (med or lg enterprise) 

Comments: 

INTERCONNECTION DATA 

ID Provided – see above 

File size 50 rows 

Ownership Leased 

Transport Type Fiber 

Data 
Rates/Capacity 

Will use the max. of 3 provided values (Ethernet, SONET, and/or Waves) 

Location 

Section 3: Submission File Details 

Received two (2) files by SECURE UPLOAD: 

Size  Name 

1805  NJ_Sidera_customer_data_20101231.txt 

Given the prior interactions, each row is established to contain an address, end-user 
category, technology code (50), max advertised down/up speeds and two additional 
columns:  ADVER_DOWNLOAD_SPEED and ADVER_UPLOAD_SPEED, which the 
provider claims (in their response) to be the typical down/up-load speed. We will NOT 
use data in these columns as the typical down/up-load speed data. 

34304  middle_mile_nj_3-1-2011.xls 

Contains 50 rows excluding headers.  Each row has an address, building type, 
statement of Ethernet, SONET, and/or Waves backhaul network speed, building 
ownership (all leased), and entrance (all fiber). 
We will use the max. of the three provided network speed values (Ethernet, SONET, 



and Waves) as the serving facility backhaul capacity value. 

Section 4: Validations and Results 

Customer address data: 30 rows were submitted, 26 could be geocoded, 4 could not.  
Middle mile data: 50 rows were submitted, 47 could be geocoded, 3 could not. For 
details see files res_failed.xls and res_mm_failed.xls. 

Section 5: Data Transformation and Loading 

Loaded from supplied file “middle_mile_nj_3-1-2011.xls”, tab “NJ_Sidera” (50 rows).  
The following table explains the transformations that were applied.  

Table 
Column 

Data Source / Transformation

PROVNAME Set to “Sidera Networks, LLC" 
DBANAME Set to “Sidera Networks” 
FRN Set to “0006254403” 
OWNERSHIP Set to 1 (leased) 
BHCAPACITY Set to 6 (10 Gbps or greater) 
BHTYPE Set to 1 (fiber) 
LATITUDE Created by geocoding the supplied address 
LONGITUDE Created by geocoding the supplied address
ELEVFEET Set to “0” (zero) 
STATEABBR Set to “NJ” 
FULLFIPSID ID of containing census block from Year 2000 Census Bureau 

TigerLine reference data  
SHAPE Point shape created using ESRI ArcDesktop 

Internal notes on processing: 
31. Geocoded the addresses using the Google geocoder. 
32. Created an excel sheet and imported to a geodatabase table. 
33. Added point shapes corresponding to each Latitude,Longitude pair by creating a 

feature class from the table using ArcCatalog’s “Create Feature Class from XY 
Table” option. 

34. Added a column containing the ID of the containing year 2000 census block via a 
spatial join of the point shapes and the census block shapes from reference data. 

NTIA Table BB_Service_CensusBlock 

Loaded from supplied file “RCN_NY_20100630_customer_data.txt” (20 rows).  The 
following table explains the transformations that were applied to load the target table. 



Table Column Data Source / Transformation

PROVNAME Set to “Sidera Networks, LLC" 
DBANAME Set to “Sidera Networks” 
PROVIDER_TYPE Set to 1 
FRN Set to “0006254403” 
STATEFIPS Set to “34” (NJ) 
COUNTYFIPS Populated from Census Block FIPS Code (first 3 digits) 
TRACT Populated from Census Block FIPS Code (next 6 digits)
BLOCKID Populated from Census Block FIPS Code 
BLOCKSUBGROUP Set to null 
FULLFIPSID Populated from Census Block FIPS Code 
TRANSTECH As supplied in column Technology_Code 
MAXADDOWN As supplied in column Max_Download_Speed 
MAXADUP As supplied in column Max_Download_Speed_1 
TYPICDOWN Set to null, not supplied 
TYPICUP Set to null, not supplied 
SHAPE Copied from Census Bureau TigerLine 2000,  

as matched by spatial join on geocoded address 

Internal processing notes: 
42. Geocoded the addresses using the Google geocoder to obtain a Latitude, 

Longitude pair for each. 
43. Created an Excel sheet and imported it to a geodatabase table. 
44. Added point shapes corresponding to each Latitude, Longitude pair by creating a 

feature class from the table using ArcCatalog’s “Create Feature Class from XY 
Table” option. 

45. Created a new feature class and loaded data to correct tolerance value. 
46. Added a column containing the ID of the containing year 2000 census block via a 

spatial join of the point shapes and the census block shapes from reference data. 
47. Discarded 15 rows with duplicate census blocks while preserving the greatest 

speed. 
48. Loaded 11 rows. 

Section 6: Clarification Questions and Responses

1. NTIA specifies four serving facility types (1=Fiber; 2=Copper;3=Hybrid Fiber 
Coax (HFC); 4=Wireless) for the middle-mile connection points data. You have 
provided 3 columns referring (we assume) to the serving facilities in you network. 
One of them is titled 'Waves'. Does that indicate the wireless facility ? 
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Rich, 
   We have reviewed the data you provided and have one clarifying question: 
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Thanks for your participation! 

John Wullert 
Manager – NJ BB Data Collection 
Telcordia Technologies 
732-699-2687 
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Hi John, 

We are a transport company, this is all Fiber (1) 

Thanks 

Rich 

Section 7: Notes and Open Issues 

  



Section 8: Overview Map of Submitted Data 

  



Connecting New Jersey - Broadband Provider Data Report 

Provider: Service Electric Cable TV of Hunterdon 
Submission date: April 2011 

This report presents details on processing broadband data for delivery to the National 
Telecommunications and Information Administration (NTIA).  This is a stub report, since 
data from the previous submission was reused unchanged.  The complete report from 
the previous submission begins on the next page.  Notable differences from the 
processing done on the previous submission are listed next. 

NTIA Table BB_Service_CensusBlock 

4. Dropped the column "reseller". 
5. Added the column "provider_type" and populated with value 1 ("Broadband 

provider as described in the NOFA") 

NTIA Table BB_Service_RoadSegment 

1. Dropped the column "reseller". 
2. Added the column "provider_type" and populated with value 1 ("Broadband 

provider as described in the NOFA") 

Provider Interactions 

Tim Himmelright of Service Electric called and spoke to John Wullert on 4 March 2011 
and confirmed that their data had not changed since the October data collection cycle 
and instructed us to use the previous data. 
  



Broadband Provider Data Report 

Provider: Service Electric Cable TV of Hunterdon 
Received: August 2010 
Submission date: October 2010 

This report presents details on processing of the broadband data for delivery to the 
National Telecommunications and Information Administration. 

Sections: 
114. NDA Status 
115. Submission Overview 
116. Submission File Details 
117. Data Validations and Results 
118. Data Transformation and Loading 
119. Clarification Questions and Provider Responses
120. Notes and Open Issues 

Section 1: NDA Status 

None. 

Section 2: Submission Overview 

AVAILABILITY DATA 

ID 

Provider name 

“Doing business as” name 

FRN 

Service Electric Cable TV of 
Hunterdon, Inc. 

DBA not provided 

0003760014 

FOR WIRELINE 

Filetypes Text (a letter, not structured data) 

File size 

Speeds 

Type 

Spatial Resolution 
(address, street seg, 
census block, 
RSA/MSA, 
zipcode,etc) 

Typical-upstream  Not provided 

Typical-downstream  Not provided 

Advertised-upstream  Municipality 

Advertised-
downstream 

Municipality 

Subscriber-weighted-  Not provided 

Advertised downstream speeds 
1.5, 3, 5, 7 and 10 mbps; up 
speed 800 kbps. 

Typical Speeds were confirmed 
prior to October submission to 
be 10-15% below advertised. 



up 

Subscriber-weighted-
down 

Not provided 

Technology 
Type 

Docsis 2.0 (use code 41) 

End-user 
specification 

Not provided 

Comments: 

INTERCONNECTION DATA 

ID None 

File size 

Ownership 

Transport Type 

Data 
Rates/Capacity 

Location 

Comments: 

Section 3: Submission File Details 

Received email for October submission with information on the municipalities served in 
entirety, the technology of transmission, and the speed tiers offered to customers.  
Confirmed that information via phone on March 4, 2011 

Section 4: Validations and Results 

The sole data to validate is their provided list of municipality names.  A sampling was all 
valid. 

Section 5: Data Transformation and Loading 

NTIA Table BB_Service_CensusBlock 

Loaded based on email received on August 23, 2010.  We submitted all census blocks 
in the named municipalities.  The following table explains the transformations that were 
applied to load the target table. 

Table Column Data Source / Transformation

PROVNAME Set to “Service Electric Cable TV of Hunterdon, Inc.” 



DBANAME Not supplied; set same as PROVNAME 
RESELLER Set to “N” 
FRN Set to “0003760014” 
STATEFIPS Set to “34” (NJ) 
COUNTYFIPS Populated from Census Block FIPS Code (first 3 digits) 
TRACT Populated from Census Block FIPS Code (next 6 digits)
BLOCKID Populated from Census Block FIPS Code 
BLOCKSUBGROUP Set to null 
FULLFIPSID Populated from Census Block FIPS Code 
TRANSTECH Set to 41 (Cable Modem – Other) per email Docsis-2.0 
MAXADDOWN Set to 7 (10Mbps) per email 
MAXADUP Set to 3 (800Kbps) per email 
TYPICDOWN Set to null, not provided 
TYPICUP Set to null, not provided 
SHAPE Copied from Census Bureau TigerLine 2000,  

as matched by spatial join on geocoded address 

Internal processing notes: 
49. Created a file with municipality names that match exactly names in the “name” 

column in the Year 2000 Census Bureau TigerLine database.  Primarily this 
meant changing “Boro” to “Borough”. 

50. Joined against reference data to discover census blocks. 

NTIA Table BB_Service_RoadSegment 

Loaded with street segments in census blocks larger than 2 square miles as listed in 
Census Bureau TigerLine reference data.  The following table explains the 
transformations that were applied to load the target table. 

Table Column Data Source / Transformation

PROVNAME Set to “Service Electric Cable TV of Hunterdon, Inc.” 
DBANAME Not supplied; set same as PROVNAME 
RESELLER Set to “N” 
FRN Set to “0003760014” 
ADDMIN From reference data 
ADDMAX From reference data 
PREDIR  From reference data 
STREETNAME From reference data 
STREETTYPE From reference data 
SUFFDIR From reference data 
CITY From reference data 
STATECODE From reference data 
ZIP5 From reference data 
ZIP4 From reference data 



TRANSTECH Set to 41 (Cable Modem – Other) per email Docsis-2.0
MAXADDOWN Set to 7 (10Mbps) per email 
MAXADUP Set to 3 (800Kbps) per email 
TYPICDOWN Set to null, not provided 
TYPICUP  Set to null, not provided 
SHAPE From reference data 

Section 6: Clarification Questions and Responses 

1. What is the FRN? 
2. Should we expect any middle-mile data? 

Interaction from August 2010: 
Tim, 
    We have been reviewing the data you submitted to 
the New Jersey Broadband mapping program.  Based on our 
initial review, we have some questions for you that 
will help us better understand the data and process it 
accurately. 

1. Could you please provide the FRN for your company? 
2. Is there any information you can provide about the 
typical speeds experienced by your customers, based on 
your network configurations, monitoring results or 
general experience?   
3. Do you have any middle mile locations to report?

We would appreciate your prompt attention to these 
questions.  If you need further clarification, please 
feel free to contact me. 

Thank you for your participation! 

John Wullert 
Manager – NJ BB Data Collection 
Telcordia Technologies 
732-699-2687 

Tim Himmel called John Wullert on 8/27/2010.  He 
answered the questions as followed: 

• He will have to check on the FRN.  He wasn’t quite 
sure what that meant. 

• He said that their typical speeds are generally 
10-15% below advertised (5.9 to 6.3 Mbps on a 7 
Mbps line).  (They are going to build out DOCSIS 3 
over the next six months to a year to address 
this.  With that, they may over-provision the 
lines (provide 12 Mbps for 10 Mbps line). 



• They do not have any middle mile sites.  They 
connect direct to PenTeleData, who provides 
Internet access for multiple cable operators. 

Tim Himmel called John Wullert on 8/31/2010 to report 
the FRN number.  The number he provided is:  FRN 0003-
7600-14 

������*���/�����(��������������������������'�������
���	��?�������������!��� !���:�",�2��

����

����
���������������������������
�����	��0����������������������
�4�-&��
�� !���

�

John,
  

Computing data rates are the same as our last report.  We have deployed high-speed 2-
way internet services in 100-percent of all 12 communities that we serve in New Jersey.
  

Our platform is still operating on DOCSIS 2.0.  However, we are testing DOCSIS 3.0 in 
two of our Pennsylvania franchises.  Once we work out the few small bugs we have 
encountered, we do plan to migrate our New Jersey properties to DOCSIS 3.0 as well.  I 
will keep you up to date on our progress.
  

Best Regards,
  

Timothy S. Himmelwright
Communications & Public Affairs
Service Electric Cable TV & Communications

Section 7: Notes and Open Issues 
  



Section 8: Overview Map of Submitted Data 

  



Broadband Provider Data Report 

Provider: Sprint 
Received: 23 February 2011 
Submission date: April 2011 

This report presents details on processing of the broadband data for delivery to the 
National Telecommunications and Information Administration. 

Sections: 
121. NDA Status 
122. Submission Overview 
123. Submission File Details 
124. Data Validations and Results 
125. Data Transformation and Loading 
126. Clarification Questions and Provider Responses
127. Notes and Open Issues 

Section 1: NDA Status 

Executed with NJ OIT. 

Section 2: Submission Overview 

AVAILABILITY DATA 

ID 

PROVIDER NAME 

DBA NAME 

FRN:  

Sprint Nextel Communications 

Sprint 

0003-77-45-93 

FOR WIRELESS 

Filetypes shapefile (2 polygons), text file 

Speeds 

Type 
Spatial Resolution (address, 
street seg, census block, 
RSA/MSA, zipcode) 

Upstream max 
adv 

yes (shapefiles for 2 spectrum 
types)  

Downstream 
max adv 

yes (shapefiles for 2 spectrum 
types) 

Upstream 
typical 

yes (shapefiles for 2 spectrum 
types) 

Downstream 
typical 

yes (shapefiles for 2 spectrum 
types) 

Subscriber-
weighted 

yes. County-level data for all 21 
counties (text file). 

Technology 2 spectrum types described: 3 (PCS) and 5 



Type (Broadband radio). Technology of transmission is 80 
(Terrestrial mobile wireless).  

Comments:  A somewhat cryptic note is provided saying: 

“The map is created using Sprint's 1XRTT coverage boundary as a proxy for service.  The 1XRTT 
coverage boundary is created by defining the area where the network provides a -98dbm or stronger 
signal strength.” 

INTERCONNECTION DATA 

ID 

File size 

Ownership 

Transport Type 

Data 
Rates/Capacity 

Location 

Comments:  Instructed to use middle mile data from previous submission 

Quick loading results: 

Figure 1. Loading results 



Section 3: Submission File Details 

First submission provided these 6 files by SECURE UPLOAD: 

Size  Name 
2KB  Confidential_Sprint_Pricing_NJ.txt 
2KB  Sprint_AreaAvailability_NJ_region.dbf  
1KB  Sprint_AreaAvailability_NJ_region.prj 
5208KB Sprint_AreaAvailability_NJ_region.shp  
1KB  Sprint_AreaAvailability_NJ_region.shx 
1KB  readme.txt 

Section 4: Validations and Results 

Sprint provided a shapefile with two polygons, one each for two data services.  Both 
appear to fall entirely in side New Jersey (see above for initial preview of shapefiles in 
Arcmap).  The slower service is spectrum 3 and rated max advertised down/up of 3/2.  
The faster service is spectrum 5 and rated max advertised down/up of 5/3. 

The "pricing" text file provides subscriber-weighted nominal speed for counties in New 
Jersey.  It does not distinguish between the two services.  We are not submitting 
overview data so will not use this data. 

The "readme" text file provides no data for loading. 

No middle-mile data was provided.  We received email directing us to reuse the middle-
mile data from the previous submission. 

Section 5: Data Transformation and Loading 

NTIA Table BB_ConnectionPoint_MiddleMile 

Loaded from the text file “Confidential_Middlemile_NJ.txt” supplied in October 2010.  
The following table explains the transformations that were applied.  

Table Column Data Source / Transformation

PROVNAME As supplied in column “providername” 
DBANAME As supplied  
FRN As supplied in column “frn”, after removing hyphens 
OWNERSHIP As supplied 
BHCAPACITY As supplied in column “servingfacilitycapacity” 
BHTYPE As supplied in column “servicefacilitytype” 



LATITUDE As supplied 
LONGITUDE As supplied 
ELEVFEET As supplied in column “elevation” (all zero) 
STATEABBR Set to “NJ” 
FULLFIPSID Year 2000 Census Bureau TigerLine reference data  
SHAPE Created via ArcMap “Add XY Data” feature for lat/long value pairs

Internal notes on processing: 
35. Created an excel sheet with the data and imported to a geodatabase table. 
36. Created a feature class from the table by creating a Point shape using ArcMap’s 

“Add XY Data” feature corresponding to each Latitude, Longitude pair. 
37. Added a column containing the ID of the containing year 2000 census block via a 

spatial join of the points and the census block shapes from reference data. 
38. The only data imputed was the state abbreviation. 
39. Reused the ESRI feature class created in the last round. 

NTIA Table BB_Service_Wireless 

Loaded from the supplied shapefile “Sprint_AreaAvailability_NJ_region.  The following 
table explains the transformations that were applied. 

Table Column Data Source / Transformation

PROVNAME As supplied in column “proname” 
DBANAME As supplied in column “dbaname” 
FRN As supplied in column “frn” after removing hyphens
TRANSTECH As supplied in column “techtrans” 
SPECTRUM Set to 3 or 5 per translation shown below 
MAXADDOWN As supplied in column “maxaddnsp” 
MAXADUP As supplied in column “maxadupsp” 
TYPICDOWN Set to null 
TYPICUP Set to null 
STATEABBR Set to “NJ” 
SHAPE As supplied. 

Internal notes on processing: 
13. The supplied shape uses geographic coordinate system name GCS_WGS_1984  

The NTIA data model requires the same coordinate system.  No geographic 
transformation was required, but the XY Tolerance values differ if the shapefile is 
imported trivially into the geodatabase.  Imported the table schema and the table 
data in two separate operations, thereby ensuring perfect compatibility with the 
NTIA data model. 

a. First attempt at import used these steps: create new feature class with 
appropriate XY coordinate system, tolerance, and columns; then load from 
original file.  This failed with an error message about intersecting 
geometry. 



b. Second attempt at import used these steps: import feature class 
unchanged, create new feature class with appropriate XY coordinate 
system, tolerance, and columns; then load from the feature class in the 
geodatabase.  This succeeded. 

14. Details on spectrum transformation: Sprint provided input columns: spectrum1, 
spectrum2, spectrum3, spectrum4, spectrum5, spectrum6, spectrum7.  Sprint put 
a "Y" in columns spectrum3 (representing range 1850-1915 MHz) and spectrum5 
(representing range 2496–2690 MHz).  The NTIA data model has a single 
column for spectrum.  The corresponding NTIA “SPECTRUM USED” coded 
values are 3 and 5. 

15. The only data imputed was the state abbreviation. 

Section 6: Clarification Questions and Responses 
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Jack, 
   We have reviewed the data you submitted to the NJ Broadband mapping program.  We had two 
clarification questions: 
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We appreciate your participation in the program and ask for your cooperation in responding in  a timely 
manner. 

Thanks! 

John Wullert 
Manager – NJ BB Data Collection 
Telcordia Technologies 
732-699-2687
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John,

You can use the previously supplied info regarding the middle-mile data. I am still working with network to 
get you an explanation for how they generate the 4G footprint…

Jack Delaney  
Manager, Systems Operations  
Legal Department  
Sprint Nextel  
Office: 913-315-9705  
Cell: 703-906-9533  
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John,

Please see below. This is the explanation I got from Clearwire regarding the 4G coverage. This is what 
they have submitted to NTIA previously.

Does this help? 

Thanks – sorry for the delay.

Jack Delaney  
Manager, Systems Operations  
Legal Department  
Sprint Nextel  
Office: 913-315-9705  
Cell: 703-906-9533
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Clearwire appreciates the opportunity to participate.  Attached are map files for Clearwire’s  WiMAX and 



Expedience Coverage in Oregon State.  Clearwire operates WiMAX service with respective speeds below 
in Portland and Salem.  All other markets in the attached file operate using expedience technology.  
Below are some particulars regarding our service that you might need per NTIA form. 
  
Provider Name: Clearwire Corporation

DBA: Clear (WiMAX markets), Clearwire (Expedience Markets) 
FRN: 0017775628 

�
Spectrum:  Clearwire operates its WiMAX and Expedience network’s using 2.5MHz spectrum (Spectrum 
5 on the NTIA’s list).   
  
WIMAX Speed:  Clearwire’s WiMAX network delivers average mobile download speeds of 3 to 6 mbps 
with bursts over 10 mbps.* Wimax up is 1 Mbps 
  
* Speed claims based on download speeds only. Actual performance may vary and is not guaranteed. 
CLEAR performance claim is based on average download user speeds achieved during tests performed 
on the CLEAR commercial network by CLEAR. Other carrier performance based on their advertised 
claims.

Expedience Speed:   Service is offered at Premium (1.5 Mbps down) and Premium Plus (2 
Mbps down). 256 kbps up for both premium and premium plus.

Average Speeds: Clearwire does not disclose speeds as stand-alone average only a range. 
  
FCC Classification:  Clearwire is classified as terrestrial mobile wireless-licensed spectrum.   
  
Middle Mile Request:  Non-response 

�

Section 7: Notes and Open Issues 
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Broadband Provider Data Report 

Provider: StarBand Communications Inc. 
Received: March 2011 
Submission date: March 2011 

This report presents details on processing of the broadband data for delivery to the 
National Telecommunications and Information Administration. 

Sections: 
128. NDA Status 
129. Submission Overview 
130. Submission File Details 
131. Data Validations and Results 
132. Data Transformation and Loading 
133. Clarification Questions and Provider Responses
134. Notes and Open Issues 

Section 1: NDA Status 

NONE 

Section 2: Submission Overview 

AVAILABILITY DATA 

ID 

Provider name 

“Doing business as” name 

FRN 

StarBand Communications Inc. 

Not provided 

0005087457 

FOR WIRELINE 

Filetypes 

File size 

Speeds 

Type 

Spatial Resolution 
(address, street seg, 
census block, 
RSA/MSA, 
zipcode,etc) 

Typical-upstream  Not provided 

Typical-downstream  Not provided 

Advertised-upstream   

Advertised-
downstream 

Subscriber-weighted-
up 

256Kbps 

Max advertised up is Code 2 
(256 Kbps), down is Code 3 
(1.5 Mbps) 



Subscriber-weighted-
down 

1.5Mbps 

Technology 
Type 

Code 60 (Satellite) 

End-user 
specification 

Not provided 

Comments: 

INTERCONNECTION DATA 

ID 

File size 

Ownership 

Transport Type 

Data 
Rates/Capacity 

Location 

Comments: Not provided 

Section 3: Submission File Details 

Received email explaining their service offering.  Satellite service is provided in all of 
New Jersey.  

On subscriber weighted values, they say: 
“Since we have only 1 service that meets the definition of broadband service, the 
weighted average is the same as the average for that service.  Upload speed is 256 
Kbps and download speed is 1.5Mbps.” 

Section 4: Validations and Results 

No rows of data need to be validated. 

Section 5: Data Transformation and Loading 

NTIA Table BB_Service_Wireless 

Loaded county shapes from reference data for counties in the State of New Jersey 



based on emailed statements that all counties are covered.  The following table explains 
the transformations that were applied. 

Table Column Data Source / Transformation

PROVNAME Set to "StarBand Communications Inc." 
DBANAME Set to "StarBand" 
FRN Set to 0005087457 
TRANSTECH Set to 60 
SPECTRUM Set to 7 per translation shown below 
MAXADDOWN Set to 4, see below. 
MAXADUP Set to 2, see below. 
TYPICDOWN Not provided, set to null 
TYPICUP Not provided, set to null 
STATEABBR Set to “NJ” 
SHAPE County shape read from reference data.

Internal notes on processing: 
16. Spectrum: No statement was provided.  The NTIA data model has a single 

column for spectrum.  Satellite corresponds to NTIA “SPECTRUM USED” code 
value 7. 

17. Speeds: The maximum advertised speeds provided in the emailed brochure are 
as discussed above  For max adv speeds we encoded the submitted down 
speed as value 4 (range 1.5-3 Mbps) and encoded the submitted up speed as 
value 2 (range 200 Kbps -- 768 Kbps). 

Section 6: Clarification Questions and Responses 

1. What is DBA name if different than provider name? 
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Lesley, 
   One quick clarification: we have your provider name as Starband Communications Inc.  Do you have 
any other “doing-business-as” name that we should include in the submission to the NTIA? 

John Wullert 
Manager – NJ BB Data Collection 
Telcordia Technologies 
732-699-2687 
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John, 

No, we do not.  StarBand is the provider of consumer broadband.  StarBand is a part of another 
company, Spacenet Inc., but Spacenet is not a provider of consumer broadband services. 

Please let me know if you have any further questions. 

Lesley 

Section 7: Notes and Open Issues 



Section 8: Overview Map of Submitted Data 

  



Broadband Provider Data Report 

Provider: Service Electric Cable TV of Sparta 
Received: March 2011 
Submission date: April 2011 

This report presents details on processing of the broadband data for delivery to the 
National Telecommunications and Information Administration. 

Sections: 
135. NDA Status 
136. Submission Overview 
137. Submission File Details 
138. Data Validations and Results 
139. Data Transformation and Loading 
140. Clarification Questions and Provider Responses
141. Notes and Open Issues 

Section 1: NDA Status 

No NDA executed. 

Section 2: Submission Overview 

AVAILABILITY DATA 

ID 

Provider name 

“Doing business as” name 

FRN 

Service Electric Cable TV of NJ Inc. 
Service Electric Broadband Cable 

0005007125 

FOR WIRELINE 

Filetypes Text 

File size 9728 bytes 

Speeds 

Type 

Spatial Resolution 
(address, street seg, 
census block, 
RSA/MSA, 
zipcode,etc) 

Typical-upstream  Not provided 

Typical-downstream  Not provided 

Advertised-upstream  Municipality 

Advertised-
downstream 

Municipality 

Subscriber-weighted-
up 

Municipality 



Subscriber-weighted-
down 

Municipality 

Technology 
Type 

Docsis 3.1 (will use code 40) 

End-user 
specification 

Not provided 

Comments: 

INTERCONNECTION DATA 

ID 

File size Several addresses provided 

Ownership Not provided 

Transport Type Fiber 

Data 
Rates/Capacity 

One says “Fiber 10 gbps”; others have no statement 

- �	���������������������	���)�������������	���

Location Address 

Comments: 

Section 3: Submission File Details 

Received one (1) file by EMAIL: 

Size  Name 
9728   Broadband data Information.xls 

Received a spreadsheet with information on the municipalities served in entirety, the 
technology of transmission, the modem speeds offered to customers, and some 
connection points.   

We will gather all the census blocks in the municipality based on the TigerLine 
reference data and report those shapes in the BB_service_censusblock table. 

Section 4: Validations and Results 

Municipality names were normalized to agree with Census Bureau reference data. 

In this submission the speeds appear to be provided in a straightforward fashion as 
Max.Down/MaxUp values, the ‘Combined’ value can probably be ignored. 



Section 5: Data Transformation and Loading 

NTIA Table BB_ConnectionPoint_MiddleMile 

Loaded from 8 rows in the supplied Excel spreadsheet.  The following table explains the 
transformations that were applied.  

Table 
Column 

Data Source / Transformation

PROVNAME Set to “Service Electric Cable TV of NJ Inc.” per email response 
DBANAME Set to “Service Electric Broadband Cable” per email response 
FRN Set to “0005007125” per email response 
OWNERSHIP Set to 0 to indicate owned per email 
BHCAPACITY Set to null, not provided 
BHTYPE Set to null, not provided 
LATITUDE Created by geocoding the supplied address 
LONGITUDE Created by geocoding the supplied address
ELEVFEET Set to “0” (zero) 
STATEABBR Set to “NJ” 
FULLFIPSID ID of containing census block from Year 2000 Census Bureau 

TigerLine reference data  
SHAPE Created using ESRI ArcDesktop 

Internal notes on processing: 
40. Created an excel sheet and imported to a geodatabase table. 
41. Added points corresponding to each Latitude,Longitude pair by creating a feature 

class from the table using ArcCatalog’s “Create Feature Class from XY Table” 
option. 

42. Added a column containing the ID of the containing year 2000 census block via a 
spatial join of the points and the census block shapes from reference data. 

NTIA Table BB_Service_CensusBlock 

Loaded based on the supplied file “Broadband data Information.xls”.  We submitted all 
census blocks less than 2 square miles in the named municipalities.  The following table 
explains the transformations that were applied to load the target table. 

Table Column Data Source / Transformation

PROVNAME Set to “Service Electric Cable TV of NJ Inc.” per email response
DBANAME Set to “Service Electric Broadband Cable” per email response 
PROVIDER_TYPE Set to 1 
FRN Set to “0005007125” per email response 
STATEFIPS Set to “34” (NJ) 
COUNTYFIPS Populated from Census Block FIPS Code (first 3 digits) 
TRACT Populated from Census Block FIPS Code (next 6 digits) 



BLOCKID Populated from Census Block FIPS Code 
BLOCKSUBGROUP Set to null 
FULLFIPSID Populated from Census Block FIPS Code 
TRANSTECH Set to 41 (Cable Modem – Other) per file 
MAXADDOWN Set to code 7 per max speed 30Mbps on web site 
MAXADUP Set to code 4 per max speed 2Mbps on web site 
TYPICDOWN Set to null, not provided 
TYPICUP Set to null, not provided 
SHAPE Copied from Census Bureau TigerLine 2000,  

as matched by spatial join on geocoded address 

Internal processing notes: 
51. Created a file with municipality names that match exactly names in the “name” 

column in the Year 2000 Census Bureau TigerLine database.  Primarily this 
meant changing “Boro” to “Borough”. 

52. Joined against reference data to discover census blocks, for a total of 4,135 
blocks. 

NTIA Table BB_Service_RoadSegment 

Loaded with street segments in census blocks larger than 2 square miles as gathered 
from Census Bureau TigerLine reference data.  The following table explains the 
transformations that were applied to load the target table. 

Table Column Data Source / Transformation

PROVNAME Set to “Service Electric Cable TV of NJ Inc.” per email response
DBANAME Set to “Service Electric Broadband Cable” per email response 
PROVIDER_TYPE Set to 1 
FRN Set to “0005007125” per email response 
ADDMIN From reference data 
ADDMAX From reference data 
PREDIR  Set to null, not available in reference data 
STREETNAME From reference data 
STREETTYPE Set to null, not available in reference data 
SUFFDIR Set to null, not available in reference data 
CITY From reference data 
STATECODE Set to "NJ" 
ZIP5 From reference data 
ZIP4 Set to null, not available in reference data 
TRANSTECH Set to 41 (Cable Modem – Other) per email Docsis-2.0 
MAXADDOWN Set to code 7 per max speed 30Mbps on web site 
MAXADUP Set to code 4 per max speed 2Mbps on web site 
TYPICDOWN Set to null, not provided 
TYPICUP  Set to null, not provided 
SHAPE From reference data 



Internal processing notes: 
3. Discovered all street segments that touch census blocks larger than 2 square 

miles using the census block list discovered as discussed for table 
BB_Service_Censusblock. 

4. Joined against reference data to discover street segment, for a total of 2,223 
entries. 

Section 6: Clarification Questions and Responses 
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Cherie, 
   We have reviewed the data you submitted to the NJ Broadband Data Mapping program and have a few 
clarification questions about the middle mile data you submitted: 
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We appreciate your participation in the program! 

John Wullert 
Manager – NJ BB Data Collection 
Telcordia Technologies 
732-699-2687 
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Hello John, 

I hope my answers clear up your questions: 

1. Further detail into interconnection links: 
1. 320 Sparta Ave, Sparta, NJ & 50 Esto Lane, Hamburg, NJ are interconnected via dual 

10Gbps circuits 
2. All other hubsites are connected via dual 1Gbps circuits 

2. We own all of the facilities used for data propagation. 



Thanks. 

�

Section 7: Notes and Open Issues 

  



Section 8: Overview Map of Submitted Data 

  



Broadband Provider Data Report 

Provider: Time Warner 
Received: February 2010 
Submission date:  April 2010 

This report presents details on processing of the broadband data for delivery to the 
National Telecommunications and Information Administration. 

Sections: 
142. NDA Status 
143. Submission Overview 
144. Submission File Details 
145. Data Validations and Results 
146. Data Transformation and Loading 
147. Clarification Questions and Provider Responses
148. Notes and Open Issues 

Section 1: NDA Status 

NDA established with NJ OIT. 

Section 2: Submission Overview 

AVAILABILITY DATA 

ID 

PROVIDER NAME 

DBA NAME 

FRN  

Holding company name 

Holding company number 

Time Warner Cable, LLC  

Time Warner Cable 

0013430244 

Time Warner Cable Inc. 

131352 

FOR WIRELINE 

Filetypes 
Time Warner supplied 1 .txt file, a pdf letter, 
and a shapefile showing coverage on FIPS 
census block level. 

Speeds 

Type 
Spatial Resolution (address, 
street seg, census block, 
RSA/MSA, zipcode) 

Upstream max 
adv 

yes (code 5). census block. 

Downstream 
max adv 

yes (code 9). census block 

Upstream 
typical 

not provided. 



Downstream 
typical 

not provided 

Subscriber-
weighted 

 yes – provided in 2 counties 
serviced in NJ for 2 cable 
technologies (40, 41) 

Technology 
Type 

40, 41  

Comments: ‘typical’ vals not found.  

INTERCONNECTION DATA: INSTRUCTED TO USE PREVIOUS DATA 

ID 

File size 

Ownership 

Transport Type 

Data 
Rates/Capacity 

Location 

Comments: not provided. 

  



Quick loading results:   501 polygons in shapefile, spanning 2 counties in NJ. 

Figure 1. Loading results 

Figure 2. Zoom in on provided data 
  



Section 3: Submission File Details 

Received 5 (key) files by (EMAIL, SECURE UPLOAD): 

Size  Name 
1KB  0013430244_blendedaverage_NJ_12312010.txt 
620KB TW_NEW_JERSEY_BLOCKS_LESS_THAN_2MI_JAN_2011.dbf 
1KB  TW_NEW_JERSEY_BLOCKS_LESS_THAN_2MI_JAN_2011.prj 
510KB TW_NEW_JERSEY_BLOCKS_LESS_THAN_2MI_JAN_2011.shp 
15KB  TW_NEW_JERSEY_BLOCKS_LESS_THAN_2MI_JAN_2011.shx 

Section 4: Validations and Results 

File " 0013430244_blendedaverage_NJ_12312010.txt" 

Contains name, DBA, FRN, county, state, technology of transmission (values 40 
and 41), and subscriber-weighted nominal speed.  As of this round we are not 
submitting overview data, so we will not use the SWNomSpeed values. 

Shape “TW_NEW_JERSEY_BLOCKS_LESS_THAN_2MI_JAN_2011” in the shapefile  
"0013430244_area_availability_NJ_12312010" (1,899 rows) 

See above for preview pictures.  Shapes use XY coordinate system 
GCS_North_American_1983.  Provides census-block shapes and associated speed 
data.  All census block IDs are length 15, suggesting they are Year 2000 Census 
geometry.  Only technology code 40 is present.  Maximum advertised speed codes are 
present, which is a change from the previous submission.  Typical speed codes are all 
zero like the previous submission; we will not submit typical speeds.  Has notably fewer 
rows than in the last submission, possibly because rows are not present for tech code 
41? 

NOT PRESENT - SEE PREVOUS DATA REPORTS 
• Middle-mile data - we will reuse data from the June 2010 submission per 

clarification email.�
• Typical upstream/downstream values not provided and will not be 

submitted. 

Section 5: Data Transformation and Loading 

NTIA Table BB_ConnectionPoint_MiddleMile 

Loaded from supplied file “0013430244_middlemile_NJ_06302009.txt” (19 rows, only 1 
in New Jersey), as received in June 2010.  The following table explains the 
transformations that were applied.  



Table 
Column 

Data Source / Transformation

PROVNAME Set to “Time Warner Cable LLC” (“LLC” was missing) 
DBANAME As supplied in column ”DBAName” 
FRN Set to “0013430244” 
OWNERSHIP As supplied in column ”Ownership” 
BHCAPACITY As supplied in column ”Serving Facility Capacity” 
BHTYPE As supplied in column ”Serving Facility Type” 
LATITUDE As supplied in column “Latitude” 
LONGITUDE As supplied in column “Longitude” 
ELEVFEET As supplied in column “Elevation” 
STATEABBR Set to “NJ” 
FULLFIPSID ID of containing census block from Year 2000 Census Bureau 

reference data  
SHAPE Point corresponding to Lat, Long created using ESRI ArcDesktop 

Internal processing notes from prior report: 
43. Created an excel sheet and imported to a geodatabase table. 
44. Added points corresponding to each Latitude,Longitude pair by creating a feature 

class from the table using ArcCatalog’s “Create Feature Class from XY Table” 
option. 

45. We dropped all locations outside the New Jersey state boundary, leaving just 
one.  In this row, the elevation value is 30, and we were told in June 2010 that 
the connection point is on the 7th floor of a building, so we did not change the 
value. 

46. Added a column with the ID of the containing Year 2000 Census block via a 
spatial join of the points and the census block shapes from reference data. 

NTIA Table BB_Service_CensusBlock 

Loaded from supplied shape file.  The following table explains the transformations that 
were applied to load the target table. 

Table Column Data Source / Transformation

PROVNAME Set to “Time Warner Cable LLC” (“LLC” was missing)
DBANAME As supplied in column ”DBAName” 
PROVIDER_TYPE Set to 1 
FRN Set to “0013430244” 
STATEFIPS Set to “34” 
COUNTYFIPS Populated from cb_fips (digits 3-5) 
TRACT Populated from cb_fips (next 6 digits) 
BLOCKID Populated from cb_fips  

(next 4 digits; dropped 5th character if present) 
BLOCKSUBGROUP Set to null 
FULLFIPSID As supplied in column cb_fips 



TRANSTECH As supplied in column tech_trans 
MAXADDOWN As supplied in column max_ad_dwn 
MAXADUP As supplied in column max_ad_up 
TYPICDOWN Not provided, set to null 
TYPICUP Not provided, set to null 
SHAPE As supplied 

Internal notes on processing 
1. Geographic coordinate system:  The supplied shape uses geographic coordinate 

system name GCS_North_American_1983.  The NTIA transmittal data model 
requires coordinate system GCS_WGS_1984.  To change the projection we 
applied the geographic transformation NAD_1983_To_WGS_1984_5 (per ESRI 
KB article 24159).  We also had to load the data into a second feature class such 
that the tolerance value matches the NTIA transmittal model’s value of 
0.000000002. 

2. Census Blocks: The submitted shapefile seems to use Census 2000 geometry, 
judging from the block IDs that are all 15 characters long.  All submitted block IDs 
are unique and were found in Year 2000 reference data. 

Section 6: Clarification Questions and Responses 
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Monique, 
   We have reviewed the data you submitted to the NJ Broadband data program and have a few 
questions: 
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Thanks for your participation in the program! 

John Wullert 
Manager – NJ BB Data Collection 
Telcordia Technologies 
732-699-2687 
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Hello John: 

Please see my clarifications below.  Let me know if you need anything else. 

Sincerely, 

Monique R. Crawford 
Regulatory Affairs 
Time Warner Cable 
13820 Sunrise Valley Dr. 
Herndon, VA 20171 

(703) 345-3175 Office 
(703) 554-5019 Mobile 
(704) 697-4933 E-fax 
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Monique, 
   We have reviewed the data you submitted to the NJ Broadband data program and have a few 
questions: 

�� &���
��	�����
�������'��
����	
�����������������
������	�$��	��������������������������

������	
��������������
�������
����������&�������������������		���	�����&�����'��
	���
��	�����

�������
������������������

�%�A������	�$��	������������������������.	�����
��������������������������	��
���������

 � �#
���
������������������	
�����������������������������	������������������������
��

�
���������&������������������
����������	��	�������
	�����������
���
Information regarding the typical speeds experienced by customers is not available.

Section 7: Notes and Open Issues 
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Broadband Provider Data Report 

Provider: T-Mobile 
Received: 23 February 2011 
Submission date: April 2011 

This report presents details on processing of the broadband data for delivery to the 
National Telecommunications and Information Administration. 

Sections: 
149. NDA Status 
150. Submission Overview 
151. Submission File Details 
152. Data Validations and Results 
153. Data Transformation and Loading 
154. Clarification Questions and Provider Responses
155. Notes and Open Issues 

Section 1: NDA Status 

Executed with NJ OIT. 

Section 2: Submission Overview 

AVAILABILITY DATA 

ID 

PROVIDER NAME 

DBA NAME 

FRN 

Holding company name 

Holding company number 

T-Mobile USA, Inc. 

T-Mobile 

0006945950 

T-Mobile USA 

130403 

FOR WIRELESS 

Filetypes 

T-mobile supplies .xls, .txt. and shapefiles 
(availability). They supply 2 sets of shape files: 
one for HSPA+ coverage and another for 3G 
coverage. 

Speeds 

Type 
Spatial Resolution (address, 
street seg, census block, 
RSA/MSA, zipcode) 

Upstream max 
adv 

yes (shapefiles for both 3G and 
4G) 

Downstream 
max adv 

yes (shapefiles for both 3G and 
4G) 

Upstream 
typical 

not found. 



Downstream 
typical 

not found. 

Subscriber-
weighted 

Provided as a table of vals 

in mbps (not kbps) correlated to 
20 FIPS codes (code 80)  

Technology 
Type 

Spectrum (Mhz, FCC code) Advanced Wireless Services spectrum 
(1710-1755 MHz; 2100-2155)

Comments: ‘typical’ vals not found.  

INTERCONNECTION DATA 

ID 

File size 10 rows 

Ownership Code 1 

Transport Type Type 1 

Data 
Rates/Capacity 

codes 4 and 5 

Location lat/lons given for all (either A or Z end is in NJ)

Comments: 

  



Quick loading results: 

Figure 1. Loading results 

Figure 2. T-Mobile Website (“data coverage”). 

  



Section 3: Submission File Details 

Received 13 file by (EMAIL, SECURE UPLOAD): 

Size  Name 
2152KB Area_availability.zip (contains below shape files) 
3KB  Area_availability.txt 
1KB  Middle_mile_NJ.txt 
10KB  Middle_mile_NJ.xls 
1KB  avg_speed_nj.xls 
1KB  NJ.dbf 
1KB  NJ.prj 
4617KB NJ.shp 
1KB  NJ.shx 
1KB  NJ_HSPA.dbf 
1KB  NJ_HSPA.prj 
2569KB NJ_HSPA.shp 
1KB  NJ_HSPA.shx 

Section 4: Validations and Results 

We validated the following data items in the original submission. 

Geospatial Data 
$ Received two shape files (one polygon each) with shapes within the state of New 

Jersey.  See above for initial load of shapefiles onto Arcmap.�

Middle Mile Data 
$ File middle_mile_nj.xls lists 10 connections, with 3 unique endpoints in New Jersey.  

Ownership, facility capacity, facility type codes are all valid 

Speed/Technology Data 
$ File area_availability.txt provides technology and spectrum codes that are within the 

valid set 
$ File avg_speed_nj.xls provides subscriber-weighted nominal speeds, which we will 

not be using for this round (no overview table required). 

Section 5: Data Transformation and Loading 

NTIA Table BB_ConnectionPoint_MiddleMile 

Loaded from supplied file “middle_mile_NJ.xlsx” (14 rows, 3 unique points).  The 
following table explains the transformations that were applied.  

Table Data Source / Transformation



Column

PROVNAME Set to “T-Mobile USA, Inc." 
DBANAME Set to "T-Mobile" 
FRN Set to “0006945950” 
OWNERSHIP As provided in column Ownership (value 1)l 
BHCAPACITY As provided in column Serving Facility Capacity 
BHTYPE As provided in column Serving Facility Type 
LATITUDE Created by geocoding the supplied address 
LONGITUDE Created by geocoding the supplied address
ELEVFEET Set to “0” (zero) 
STATEABBR As provided in column State 
FULLFIPSID ID of containing census block from Year 2000 Census Bureau 

TigerLine reference data  
SHAPE Created using ESRI ArcDesktop 

Internal notes on processing: 
47. Created an excel sheet with the original data and imported to a geodatabase 

table. 
48. Added points corresponding to each Latitude,Longitude pair by creating a feature 

class from the table using ArcCatalog’s “Create Feature Class from XY Table” 
option. 

49. Added a column containing the ID of the containing year 2000 census block via a 
spatial join of the points and the Year 2000 census block shapes from Tiger Line 
reference data. 

50. Reused the source table created in October 2010 by this process. 

NTIA Table BB_Service_Wireless 

Loaded from the supplied shapefiles “NJ” and “NJ_HSPA”.  The following table explains 
the transformations that were applied. 

Table Column Data Source / Transformation

PROVNAME Set to "T-Mobile USA, Inc." per area_availability_NJ.txt 
DBANAME Set to “T-Mobile" per area_availability_NJ.txt 
FRN Set to “0006945950” 
TRANSTECH Set to 80 per area_availability_NJ.txt 
SPECTRUM Set to “4” per translation shown below 
MAXADDOWN Set to 4 or 6 according to shapefile (technology), as specified in file 

area_availability_NJ.txt 
MAXADUP Set to 2 or 4 according to shapefile (technology), as specified in file 

area_availability_NJ.txt 
TYPICDOWN Set to null (not supplied) 
TYPICUP Set to null (not supplied) 
STATEABBR Set to "NJ” 
SHAPE As supplied. 



Internal notes on processing: 
18. The supplied shapes use geographic coordinate system name 

GCS_North_American_1983.  The NTIA data model requires coordinate system 
GCS_WGS_1984.  To change the projection we applied the ESRI geographic 
transformation NAD_1983_To_WGS_1984_5 (per ESRI KB article 24159).  We 
also had to load the data into a feature class such that the tolerance value 
matches the NTIA transmittal model.  

19. Spectrum: NOFA defines 7 spectrum columns.  T-Mobile provided a “Y” value in 
column 4 (Advanced Wireless Services, ranges 1710-1755 MHz; 2100-2155) in 
file area-availability_NJ.txt, so we coded the value as '4'. 

20.  

Section 6: Clarification Questions and Responses 

1. Submitted shapes bear some - but not exact - resemblance to the “data coverage 
maps” on tmobile.com (see Figure 2). While the Web maps are not guaranteed to be 
completely precise it may be worth asking about the differences. E.g., the no coverage 
region in the Web map seems to be smaller than what we find on the submitted 
shapefiles.  

2. No upstream/downstream ‘typical speeds’ found. 
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Jeni, 
   We have reviewed the data you submitted to the NJ Broadband mapping program and have a few 
clarification questions: 
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Thanks for your participation in the program. 

John Wullert 
Manager – NJ BB Data Collection 
Telcordia Technologies 
732-699-2687 
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Hi John,  

Thanks for the email.  Please see my responses below in red.  Please let me know if you have further 
questions. 

Thanks, 
Jeni 
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Jeni, 
   We have reviewed the data you submitted to the NJ Broadband mapping program and have a few 
clarification questions: 
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Section 7: Notes and Open Issues 

  



Section 8: Overview Map of Submitted Data 

  



Broadband Provider Data Report 

Provider: tw telecom of new jersey l.p. 
Received: March, 2011 
Submission date: March 2011 

This report presents details on processing of the broadband data for delivery to the 
National Telecommunications and Information Administration. 

Sections: 
156. NDA Status 
157. Submission Overview 
158. Submission File Details 
159. Data Validations and Results 
160. Data Transformation and Loading 
161. Clarification Questions and Provider Responses
162. Notes and Open Issues 

Section 1: NDA Status 

NONE 

Section 2: Submission Overview 

AVAILABILITY DATA 

ID 

Provider name 

“Doing business as” name 

FRN 

Holding company name 

Holding company number 

tw telecom of new jersey l.p. 
Not provided

0004351417 

tw telecom inc. 

160153 

FOR WIRELINE 

Filetypes Text 

File size 3419 bytes, 35 records 

Speeds 

Type 

Spatial Resolution 
(address, street seg, 
census block, 
RSA/MSA, 
zipcode,etc) 

Typical-upstream  Not provided 

Typical-downstream  Not provided 

Advertised-upstream  Address; values 2..11 

Advertised-
downstream 

Address; values 2..11 



Subscriber-weighted-
up 

Not provided 

Subscriber-weighted-
down 

Not provided 

Technology 
Type 

30 (Other copper) and 50 (fiber) 

End-user 
specification 

4  (medium – large enterprise) 

Comments: 

INTERCONNECTION DATA 

ID 

File size 

Ownership 

Transport Type 

Data 
Rates/Capacity 

Location 

Comments: None provided 

Section 3: Submission File Details 

Received 1 file by secure upload: 

Size  Name 
3419  NJBB_0004351417_AddressLevelAvailability.txt 

The file has 35 records.  All are addresses; no apartment/suite/unit numbers are 
provided.  Some addresses are repeated, sometimes with different speed numbers, 
suggesting that these entries are customer service addresses.  Several are the 
addresses of multi-tenant buildings.   

Section 4: Validations and Results 

All addresses could be geocoded.  All coded values in the tech trans and speed 
columns are valid.

Section 5: Data Transformation and Loading 

The standard NDA prohibits us from submitting address-level data to the NTIA.  Instead, 



we discover the census block for each customer address, then report the census block 
shape drawn from Census Bureau TigerLine reference data. 

NTIA Table BB_Service_CensusBlock 

Loaded from supplied file “NJBB_0004351417_AddressLevelAvailability.txt”.  The 
following table explains the transformations that were applied to load the target table. 

Table Column Data Source / Transformation

PROVNAME As supplied in column “Provider Name” 
DBANAME Not supplied; set same as PROVNAME 
PROVIDER_TYPE Set to 1 
FRN As supplied in column “FRN”, with leading zeroes 
STATEFIPS Set to “34” (NJ) 
COUNTYFIPS Populated from Census Block FIPS Code (first 3 digits) 
TRACT Populated from Census Block FIPS Code (next 6 digits) 
BLOCKID Populated from Census Block FIPS Code 
BLOCKSUBGROUP Set to null 
FULLFIPSID Populated from Census Block FIPS Code 
TRANSTECH As supplied in column Technology of Transmission 
MAXADDOWN For technology 30: Set to 7, the max val in MaxAdDown 

For technology 50: Set to 11, the max val in MaxAdDown
MAXADUP For technology 30: Set to 7, the max val in MaxAdDown 

For technology 50: Set to 11, the max val in MaxAdDown
TYPICDOWN Set to null, not provided 
TYPICUP Set to null, not provided 
SHAPE Copied from Census Bureau TigerLine 2000,  

as matched by spatial join on geocoded address 

Internal processing notes: 
51. Geocoded the addresses using the Google geocoder to obtain a Latitude, 

Longitude pair for each.. 
52. Created an excel sheet and imported it to a geodatabase table. 
53. Added point shapes corresponding to each Latitude, Longitude pair by creating a 

feature class from the table using ArcCatalog’s “Create Feature Class from XY 
Table” option. 

54. Added a column containing the ID of the containing year 2000 census block via a 
spatial join of the point shapes and the census block shapes from reference data. 

55. Discarded 11 rows with duplicate census blocks, which means multiple 
customers are present in the same census block. 

The mechanized procedure for the three steps is described in file GeoExcel_proc.txt. 

Section 6: Clarification Questions and Responses 



1. Based on the prior interactions with the provider, the following was assumed: 
  DBNAME   - not supplied; set same as PROVNAME 
  address level data - need to obfuscate 
 middle mile  - none 
  typical speeds - not provided 
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Tammy, 
   We have reviewed the data you submitted to the NJ Broadband data Mapping program and have two 
clarification questions: 
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Thanks for your participation in the program. 

John Wullert 
Manager – NJ BB Data Collection 
Telcordia Technologies 
732-699-2687 
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Section 7: Notes and Open Issues 



Section 8: Overview Map of Submitted Data 

  



Broadband Provider Data Report 

Provider: Verizon 
Received: September, 2010 
Submission date: October 2010 

This report presents details on processing of the broadband data for delivery to the 
National Telecommunications and Information Administration. 

Sections: 
163. NDA Status 
164. Submission Overview 
165. Submission File Details 
166. Data Validations and Results 
167. Data Transformation and Loading 
168. Clarification Questions and Provider Responses
169. Notes and Open Issues 

Section 1: NDA Status 

Verizon executed an NDA with NJ OIT. 

Section 2: Submission Overview 

AVAILABILITY DATA 

ID 

Provider name 

“Doing business as” name 

FRN 

Must choose one of 7 

DBA name(s) not provided 

Must choose one of 7 

FOR WIRELINE 

Filetypes Text and excel 

File size See below 

Speeds 

Type 

Spatial Resolution 
(address, street seg, 
census block, 
RSA/MSA, 
zipcode,etc) 

Typical-upstream  Not provided 

Typical-downstream  Not provided 

Advertised-upstream  County (code 7) 

Advertised-
downstream 

County (code 9) 

Subscriber-weighted-
up 

Not provided 



Subscriber-weighted-
down 

County 

Technology 
Type 

DSL (10) and FTTP (50) 

End-user 
specification 

Not provided (no availability data by address, so not needed) 

Comments: Cover letter lists several business entities.  Data file columns for provider, DBA name, FRN are 
always blank.

INTERCONNECTION DATA 

ID 

File size Excel file, 11 riwsm see below 

Ownership Not provided 

Transport Type Not provided 

Data 
Rates/Capacity 

Not provided 

Location Address 

Comments: 

Section 3: Submission File Details 

Received these files by CD-ROM (forwarded by NJ OIT, arrived 2 September 2010): 

Directory 1_Broadband Service Availability Data by Census Block: 

Size  Name 
584    NJ - Advertised Speed by County.txt 
5618170  NJ - Wireline Service By Census Block.txt 
136288  NJ - Wireline Service By Street Segment.txt

Directory 2_Residential Broadband Service Pricing and Speed Characteristic: 
Size  Name 
2294   NJ - Pricing.txt 

Directory 3_Middle Mile Data: 
Size  Name 
24064   NJ - POP List (as of 6-30-10).xls 

Section 4: Validations and Results 

We validated the following data items in the original submission. 



File “NJ - Advertised Speed by County.txt” (21 rows) 

Lists these columns (* indicates no data):  Provider Name*, DBA Name*, FRN*, ID, 
County FIPS Code, County Name, Maximum Advertised Downstream Speed, Maximum 
Advertised Upstream Speed.  

County codes are valid.  Speed codes are valid; every county is listed at 9 (down) and 7 
(up). 

File “NJ - Wireline Service By Census Block.txt” (158,653 rows)  

Lists these columns (* indicates no data): ProviderName*, DBAName*, FRN*, ID, 2009 
Census Block FIPS Code, 2009 Census Block Square Miles, Technology of 
Transmission. 

All block IDs were matched against Year 2009 Census Bureau TigerLine reference 
data.  Two technology codes are present, 10 and 50, both are valid. 

File “NJ - Wireline Service By Street Segment.txt” (1,775 rows) 

Lists these columns (* indicates no data): Provider Name*, DBA Name*, FRN*, ID, 
Census Block FIPS Code, Census Block Square Milage, TLID, Street Name, FRADDL, 
TOADDL,  FRADDR, TOADDR, Technology of Transmission. 

All block IDs were matched against Year 2009 Census Bureau TigerLine reference data 
for blocks 2 sq mi or larger.  All TigerLine IDs were matched against the same reference 
data source.  Note that the input set contains 19 records that are duplicates when 
checked by county (characters 2..5 of Census Block FIPS Code) TLID and TechTrans; 
the census blocks are different for the records.  To avoid duplicates in the target table, 
these records were discarded. 

File “NJ - Pricing.txt” (43 rows) 

This file provides subscriber-weighted nominal speeds.  The columns are not labeled 
but appear to be as follows (* indicates no data in any row): Provider_Name, DBA 
Name*, FRN, County ID (based on odd numbers 1..41), State, Technology of 
Transmission, Unlabeled*, Subscriber Weighted Nominal Speed.  

The county IDs are valid, the state ID (“34”) is valid, and the technology of transmission 
codes 10, 20, and 50 are all valid.  The Subscriber Weighted Nominal Speed values are 
plausible for the specified technology of transmission codes; e.g., DSL speeds are 
about 4,000.  However, every FIOS speed is shown at 25,000 or higher.  Given the 
availability of FIOS/FTTP plans at download speeds of less than 25Mbps, it seems 
unlikely that not a single customer uses one of those plans and/or that so many 
customers use a 50Mbps plan that the average is brought up so high. 



File “NJ - POP List (as of 6-30-10).xls” (11 rows) 

Column names: Address, City, State, Zip. 

We geocoded the addresses to obtain latitude, longitude value pairs.  All addresses 
were found.  However, Verizon did not supply needed information on the elevation, 
ownership, serving facility capacity, and service facility type of these addresses.  In 
June 2010 Verizon indicated they had no intention of supplying this information. 

Section 5: Data Transformation and Loading 

NTIA Table BB_ConnectionPoint_MiddleMile 

Loaded from supplied Excel Spreadsheet “NJ - POP List.xls” (11 rows).  The following 
table explains the transformations that were applied.  

Table 
Column 

Data Source / Transformation

PROVNAME Set to “Verizon Online LLC”” 
DBANAME Set to “Verizon” 
FRN Set to “0012254363” 
OWNERSHIP Set to null 
BHCAPACITY Set to null 
BHTYPE Set to null 
LATITUDE Created by geocoding the supplied address 
LONGITUDE Created by geocoding the supplied address
ELEVFEET Set to “0” (zero) 
STATEABBR Set to “NJ” 
FULLFIPSID ID of containing census block from Year 2000 Census Bureau 

TigerLine reference data  
SHAPE Created using ESRI ArcDesktop 

Internal notes on processing: 
56. Created an excel sheet and imported to a geodatabase table. 
57. Added points corresponding to each Latitude,Longitude pair by creating a feature 

class from the table using ArcCatalog’s “Create Feature Class from XY Table” 
option. 

58. Added a column containing the ID of the containing year 2000 census block via a 
spatial join of the points and the census block shapes from reference data. 

NTIA  Table BB_Service_CensusBlock 

Loaded from supplied text file “NJ - Wireline Service By Census Block.txt” (158,653 
rows).  The following table explains the transformations that were applied to load the 



target table. 

Table Column Data Source / Transformation

PROVNAME Set to “Verizon Online LLC” 
DBANAME Set to “Verizon” 
RESELLER Set to “N” 
FRN Set to “0012254363” 
STATEFIPS Set to “34” (NJ) 
COUNTYFIPS Populated from 2009_Census_Block_FIPS_Code (1st 3 digits) 
TRACT Populated from 2009_Census_Block_FIPS_Code (next 6 digits)
BLOCKID Populated from Census_Block_FIPS_Code  

(next 4 digits; dropped 5th character if present) 
BLOCKSUBGROUP Set to null 
FULLFIPSID First 15 digits of 2009_Census_Block_FIPS_Code 

See discussion of Census blocks below. 
TRANSTECH As supplied in column Technology_of_Transmission 
MAXADDOWN Set to 6 or 9, see below. 
MAXADUP Set to 3 or 7; see below 
TYPICDOWN Set to null 
TYPICUP Set to null 
SHAPE Copied from Census Bureau TigerLine 2000,  

As matched by Census block 2000 ID 

Internal processing notes: 
3. Census Blocks: Verizon supplied Census 2009 block IDs (15 or 16 characters). 

The NTIA directed us to supply data using Census 2000 blocks for the October 
2010 data submissions, including the shapes.  We transformed the data as 
follows.  The vast majority of 2000 versus 2009 blocks are identical; most of the 
blocks newly added in the Census 2009 data were formed by splitting Census 
2000 bocks into smaller pieces. We show service available in a Census 2000 
block if any Census 2009 block that has the Census 2000 block ID as a proper 
prefix has service available.  Of the original data, 141,002 rows required no 
changes; 17,651 rows have Census 2009 blocks with IDs that are a proper prefix 
of 2000 blocks IDs; no other cases were found.   Altering the rows with Census 
2009 block information meant discarding 7,335 duplicate rows (i.e., split blocks). 
Some of the resulting year-2000 blocks are large.  We cannot report large blocks 
in this table.  Instead, we reported the same availability by street segment for all 
streets in those large blocks by joining against the Census Bureau Tiger Line 
2009 data set. 

4. Speeds: We imputed max advertised up and down speeds based on the 
technology of transmission, the contents of the File “NJ - Advertised Speed by 
County.txt”, and information on the Verizon web site.  Mad adv down for tech 
code 10 (DSL) is speed code 6, and max adv down for tech code 50 (FIOS) is 
speed code 9.  Max adv up for tech code 10 (DSL) is speed code 3, and max adv 
up for tech code 50 (FIOS) is speed code 7.   



NTIA Table BB_Service_Overview 

Loaded from the supplied file “NJ - Pricing.txt” (43 rows).  The following table explains 
the transformations that were applied to load the target table. 

Table Column Data Source / Transformation

PROVNAME Set to “Verizon Online LLC” 
DBANAME Set to “Verizon” 
FRN Set to “0012254363” 
GEOUNITTYPE  Set to “CO” (county) per NTIA requirement 
STATECOUNTYFIPS As supplied in column Census Block County ID; 

padded with leading zeros to length 3 and prefixed with “34” 
TRANSTECH As supplied in column Technology_of_Transmission 
MAXADDOWN Set to 6 or 9, see below. 
MAXADUP Set to 3 or 7; see below 
ARPU Set to null 
SWNOMSPEED As supplied in column Subscriber_Weighted_Nominal_Speed 
STATEABBR Set to “NJ” 
SHAPE Copied from Year 2000 Census Bureau TigerLine reference 

data, as matched by StateCountyFIPS 

Internal notes on processing 
1. Speeds: : We imputed max advertised up and down speeds based on the 

technology of transmission, the contents of the File “NJ - Advertised Speed by 
County.txt”, and information on the Verizon web site.  Max adv up for tech code 
10 (DSL) is speed code 3, and max adv up for tech code 50 (FIOS) is speed 
code 7.  Mad adv down for tech code 10 (DSL) is speed code 7, and max adv 
down for tech code 50 (FIOS) is speed code 9. 

NTIA Table BB_Service_RoadSegment 

Loaded from supplied text file “NJ - Wireline Service By Street Segment.txt” (1,775 
rows).  The following table explains the transformations that were applied to load the 
target table. 

Table Column Data Source / Transformation

PROVNAME Set to “Verizon Online LLC” 
DBANAME Set to “Verizon” 
RESELLER Set to “N” 
FRN Set to “0012254363” 
ADDMIN Set to the least of the non-empty address numbers 
ADDMAX Set to the greatest of the non-empty address numbers
PREDIR  Set to null (no value supplied) 
STREETNAME As supplied (has all street components, not just name)
STREETTYPE Set to null (no value supplied) 
SUFFDIR Set to null (no value supplied) 



CITY Set to null (no value supplied) 
STATECODE Set to “NJ” 
ZIP5 (no value supplied) 
ZIP4 (no value supplied) 
TRANSTECH As supplied 
MAXADDOWN Set to 6 or 9, see below. 
MAXADUP Set to 3 or 7; see below 
TYPICDOWN (no value supplied) 
TYPICUP  (no value supplied) 
SHAPE Copied from Census Bureau TigerLine 2009,  

As matched by County + Tiger Line ID 

Internal notes on processing: 

1. We discarded 6 input rows that associate line segments with incorrect census 
blocks.  This mistaken associations are  

TLID  CBID 
134039790 340057038015000A 
134097546 340057038015000A 
60466031  340270444019024C 
203769459 340297360021005A 
65273600  340312568031000A 
98114892  340410318002013 
See the appendix to this document for full details.  

2. All but one row were supplemented with a line-segment shape from the Census 
Bureau’s TigerLine data set. 

3. Speeds: : We imputed max advertised up and down speeds based on the 
technology of transmission, the contents of the File “NJ - Advertised Speed by 
County.txt”, and information on the Verizon web site.  Max adv up for tech code 
10 (DSL) is speed code 3, and max adv up for tech code 50 (FIOS) is speed 
code 7.  Mad adv down for tech code 10 (DSL) is speed code 7, and max adv 
down for tech code 50 (FIOS) is speed code 9. 

4. Some entries originate from streets within large blocks that we found when 
changing from Year 2009 to Year 2000 Census Block geography, see discussion 
of table BB_Service_Censusblock above. 

Section 6: Clarification Questions and Responses 

1. Most data file rows have no entry for provider name, DBA name, and FRN.  The 
cover letter includes a list of seven Verizon business units, showing their provider 
names, FRNs, and (some) DBA names.  We propose to submit the same 
information as in June 2010: provider name is “Verizon Online LLC”, DBA name 
is “Verizon”, and FRN is 0012254363. 



2. The NTIA has repeatedly urged us to request and transmit to them speed data at 
the census block and line segment level.  The latest submission from Verizon 
provides maximum advertised speeds at the county level, which was a very 
welcome change compared to the previous submission where speed data was 
shown at the CMA level, however the numbers are the same for all counties.  
The latest submission does not provide typical speeds at any geographic 
resolution.  Please consider providing this information. 

3. We were very glad to see TigerLine ID data in the street segment data file.  It 
would be a great help if the street addresses were provided with the components 
split into the fields expected by the NTIA, which are PREDIR, STREETNAME., 
STREETTYPE, and SUFFDIR.  We would also like to receive CITY, ZIP5, and 
ZIP4 for each row. 

Section 7: Notes and Open Issues 

  



Section 8: Overview Map of Submitted Data 

  



Broadband Provider Data Report 

Provider: Voxitas 
Received: March 2011 
Submission date: April 2011 

This report presents details on processing of the broadband data for delivery to the 
National Telecommunications and Information Administration. 

Sections: 
170. NDA Status 
171. Submission Overview 
172. Submission File Details 
173. Data Validations and Results 
174. Data Transformation and Loading 
175. Clarification Questions and Provider Responses
176. Notes and Open Issues 

Section 1: NDA Status 

Executed. 

Section 2: Submission Overview 

AVAILABILITY DATA 

ID 

Provider name 

“Doing business as” name 

FRN 

Holding company name 

Holding company number 

Netlogic, Inc. 
Voxitas

0006825954 

Netlogic, Inc. 

130896 

FOR WIRELINE 

Filetypes CSV file 

File size 389 bytes, 4 data rows 

Speeds 

Type 

Spatial Resolution 
(address, street seg, 
census block, 
RSA/MSA, 
zipcode,etc) 

Typical-upstream  Not provided 

Typical-downstream  Not provided 

Advertised-upstream  Not provided 

Advertised-
downstream 

Not provided 

Address rows with provisioned 
speed entries were provided. 



Subscriber-weighted-
up 

Not provided 

Subscriber-weighted-
down 

Not provided 

Technology 
Type 

Not provided; confirmed to be copper (prior interactions). Will use  - other (“DS1”) 

End-user 
specification 

Not provided 

Comments: 

INTERCONNECTION DATA 

ID 

File size 

Ownership 

Transport Type 

Data 
Rates/Capacity 

Location 

Comments: Not provided 

Section 3: Submission File Details 

Received 1 file by secure upload. 

Size  Name 
389   NJBroadband.csv 

The file has 4 (four) rows of data, no column names provided.  All have provider’s info, 
customer names and addresses and also speeds. Provider agreed (prior interactions) 
for the address level data to be submitted to the NTIA. All entries describe DS1 service 
(established through prior interactions).  Speeds listed are the provisioned speeds, not 
typical or advertised. No coded representations of data such as end user type, 
technology of transmission, etc. are provided. 

Section 4: Validations and Results 

No codes etc. were provided; the only possible validations are to check the addresses, 
and all four appear valid (actually, only two different addresses are provided). 



Section 5: Data Transformation and Loading 

The standard NDA prohibits us from submitting address-level data to the NTIA.  Instead, 
we discover the census block for each customer address, then report the census block 
shape drawn from Year 2000 Census Bureau reference data. 

NTIA Table BB_Service_CensusBlock 

Loaded from supplied file “NJ Broadband.csv”.  The following table explains the 
transformations that were applied to load the target table. 

Table Column Data Source / Transformation

PROVNAME Set to “Netlogic, Inc.” 
DBANAME Set to “Voxitas” 
RESELLER Set to “N” 
FRN Set to “0006825954” 
STATEFIPS Set to “34” (NJ) 
COUNTYFIPS Populated from Census Block FIPS Code (first 3 digits) 
TRACT Populated from Census Block FIPS Code (next 6 digits)
BLOCKID Populated from Census Block FIPS Code 
BLOCKSUBGROUP Set to null 
FULLFIPSID Populated from Census Block FIPS Code 
TRANSTECH Set to “30” 
MAXADDOWN Set to 3 per input 
MAXADUP Set to 3 per input 
TYPICDOWN Set to null, not provided 
TYPICUP Set to null, not provided 
SHAPE Copied from Census Bureau TigerLine 2000,  

as matched by spatial join on geocoded address 

Internal processing notes: 
59. Geocoded the addresses using the Google geocoder. 
60. Created an excel sheet and imported to a geodatabase table. 
61. Added point shapes corresponding to each Latitude,Longitude pair by creating a 

feature class from the table using ArcCatalog’s “Create Feature Class from XY 
Table” option. 

62. Added a column containing the ID of the containing year 2000 census block via a 
spatial join of the point shapes and the census block shapes from reference data. 

63. Discarded NN rows with duplicate census blocks.

The mechanized procedure for the geocoding steps is described in file 
GeoExcel_proc.txt. 

Section 6: Clarification Questions and Responses 



1. Since no column names were included, based on the data itself and prior 
interactions with the provider, we interpret the columns (1 – 17) to be: 
- Provider Name 
- DBA 
- FRN 
- End User Address (columns 4 – 11) 
- User Category 
- Technology of Transmission 
- Max. Adv. Down Speed 
- Max. Adv. Up Speed 
- Typ. Down Speed 
- Typ. Up Speed 

We probably do not need to confirm that.  

Section 7: Notes and Open Issues 



Section 8: Overview Map of Submitted Data 

  



Broadband Provider Data Report 

Provider: Verizon Wireless 
Received: January, 2011 
Submission date: April 2011 

This report presents details on processing of the broadband data for delivery to the 
National Telecommunications and Information Administration. 

Sections: 
177. NDA Status 
178. Submission Overview 
179. Submission File Details 
180. Data Validations and Results 
181. Data Transformation and Loading 
182. Clarification Questions and Provider Responses
183. Notes and Open Issues 

Section 1: NDA Status 

NDA was executed. 

Section 2: Submission Overview 

AVAILABILITY DATA 

ID 

Provider name 

“Doing business as” name 

FRN 

Holding company name 

Holding company number 

Cellco Partnership 

Verizon Wireless 

0003290673 

Verizon Communications Inc. 

131425 

FOR WIRELESS 

Filetypes 
shapefile collection: shp/dbf/prj/shx, mdb, 
gdb, imagefile etc. 

Supplied 2 shapfiles (zip archive) with 119 
and 13 rows.  Shapefiles use projection 
GCS_WGS_1984.. 

Speeds 

Type 
Spatial Resolution (address, 
street seg, census block, 
RSA/MSA, zipcode) 

Upstream max 
adv 

1.8 mbps 

Downstream 
max adv 

3.1 mbps 

Upstream 
typical 

500k-800kbps 

Downstream 600kpbs-1.4mbps 

Provided speeds apply to the first set of 
polygons. 

Ranges provided instead of single values. 
Lower end of the Down Typical range is 
OUTSIDE of the Broadband speed definition 
(will use upper end values for the time 



typical 

Subscriber-
weighted 

Not provided 

being).

Speeds 

Type 
Spatial Resolution (address, 
street seg, census block, 
RSA/MSA, zipcode) 

Upstream max 
adv 

1.8 mbps * 10 times 

Downstream 
max adv 

3.1 mbps * 10 times 

Upstream 
typical 

2mbps -5mbps 

Downstream 
typical 

5mbps -12mbps 

Subscriber-
weighted 

Not provided 

Provided speeds apply to the second set of 
polygons. 

Ranges provided instead of single values. 
Lower end of the Down Typical range is 
OUTSIDE of the Broadband speed definition 
(will use upper end values for the time 
being).

Technology 
Type 

Spectrum (Mhz, FCC code) Code 80 [ Cellular (824-849Mhz, 869-894 
Mhz); PCS 1850-1990 Mhz; AWS (1710-
1755Mhz, 2110-2155Mhz); 700 (757-
758Mhz, 776-779Mhz, 787-788Mhz, 805-
806Mhz) ] 

One of the provided Spectrum 1  ranges is 
869-894 Mhz, which is not within ranges 
defined for that spectrum 

The shapefile is named “EVDO_NJ” 
suggesting that the availability is only for 
EVDO.  Verizon Wireless documents on the 
web suggest the company uses spectrum 
850 MHz and 1900 MHz for their EVDO. 

Comments: 

INTERCONNECTION DATA 

ID 

File size 

Ownership 

Transport Type 

Data 
Rates/Capacity 

Location 

Comments: 



Section 3: Submission File Details 

All data was supplied by email. 

Received overview file " Broadband Verizon Wireless' wireless broadband statistics.doc" 
with spectrum and speed information. 

Received 2 shapefiles with the following contents.  The EVDO_NJ shape has 119 
polygons, and the VZW_LTE_NJ shape has 13 polygons.

Size  Name 
42091  EVDO_NJ.dbf 
145  EVDO_NJ.prj 
720796 EVDO_NJ.shp 
13156  EVDO_NJ.shp.xml 
1052  EVDO_NJ.shx 

Size  Name 
2358  VZW_LTE_NJ.dbf 
145  VZW_LTE _NJ.prj 
144312 VZW_LTE _NJ.shp 
51461  VZW_LTE _NJ.shp.xml 
204  VZW_LTE _NJ.shx 

No cover letter was included.  We reused information provided in the June 2010 cover 
letter (stored as Broadband Verizon Wireless' wireless broadband statistics.doc) 

Section 4: Validations and Results 

We validated the following data items in the original submission. 

Geospatial Data:  Verizon Wireless provided two shape file with polygons.   

Shape file EVDO_NJ:  The total shape apparently covers the entire state of New 
Jersey.  Some differences are visible along the water body edges.  There are duplicate 
shapes in this shapefile. 

Shape file VZW_LTE_NJ:  The shape covers portions of central-Northern New 
Jersey; the NJ Turnpike appears to be covered for its entire length. 

Middle-mile Data (e.g., interconnection points) was NOT provided. 



Overview Data (e.g., Cellular Market Area, Subscriber-Weighted Nominal Speed) was 
NOT provided. 

Section 5: Data Transformation and Loading 

NTIA Table BB_Service_Wireless 

Loaded from the supplied shapefiles.  The following table explains the transformations 
that were applied. 

Table Column Data Source / Transformation

PROVNAME As supplied in Word document 
DBANAME As supplied in Word document 
FRN Set to "0003290673" 
TRANSTECH Set to 80 per Word document 
SPECTRUM EVDO_NJ: Set to “3” per translation shown below

VZW_LTE_NJ: Set to "2" 
MAXADDOWN EVDO_NJ: Set to “5”, see below. 

VZW_LTE_NJ: Set to "6" per email clarification 
MAXADUP EVDO_NJ: Set to “4”, see below. 

VZW_LTE_NJ: Set to "5" per email clarification 
TYPICDOWN Set to null 
TYPICUP Set to null 
STATEABBR Set to “NJ” 
SHAPE As supplied. 

Internal notes on processing: 
21. The supplied shape uses geographic coordinate system name GCS_WGS_1984  

The NTIA data model requires the same coordinate system.  No geographic 
transformation was required, but the XY Tolerance values differ if the shapefile is 
imported trivially into the geodatabase.  Imported the table schema and the table 
data in two separate operations, thereby ensuring perfect compatibility with the 
NTIA data model. 

22. We identified duplicate shapes in the EVDO feature class using the ESRI "Find 
Identical" feature, and removed them using the ESRI "Delete Identical" feature.  
That tool removed 23 rows of data.  We found no duplicate shapes in the LTE 
feature class. 

23. Spectrum:  
a. EVDO_NJ:  Verizon Wireless provided a statement in their cover letter 

about their licensed spectrum.  Searching on the web indicates that EV-
DO uses frequencies 850MHz and 1900Mhz.  The NTIA data model has a 
single column for spectrum.  No mapping is provided for frequency 
850MHz.  Frequency 1900MHz corresponds to NTIA “SPECTRUM USED” 
code value 3. 

b. VZW_LTE_NJ: Verizon wireless web site advertises "nationwide 



contiguous 700 Mhz 4G spectrum.  The NTIA coding table provides value 
2 for 700Mhz spectrum. 

24. Speeds:  
a. EVDO_NJ:  The maximum advertised speeds provided in the cover letter 

are 3.1Mbps down and 1.8Mbps up.  The typical speeds are provided as 
ranges:  600K to 1.4Mbps down and 500Kbps-800Kpbs up.  For max adv 
speeds we encoded the submitted 3.1Mbps down speed as value 5 (range 
3-6Mbps) and encoded the submitted 1.8Mbps up speed as value 4 
(range 1.5-3Mbps).  For typical speeds we encoded the down speed as 3 
(range 768Kbps-1.5Mbps) and the up speed as 2 (range 200-768Kbps). 

b. VZW_LTE_NU: The supplied Word document suggests speeds are "10 
times EVDO".  Per email clarification (see end of document) we will use 
downstream speed code 6 and upstream speed code 5. 

25. The only data imputed was the state abbreviation. 

Section 6: Clarification Questions and Responses 

There are duplicate shapes in EVDO. Shapes with the same area and length are likely 
duplicate. 

The document states " With Verizon 4G LTE, customers will experience speeds up to 10 times faster 
than with Verizon's 3G. "  

Since 3G's Max Advertised Down is 3.1 Mbps and Max Advertised Up is1.8 Mbps, is it OK to translate to 
31 Mbps and 18 Mbps.  
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Francis, 
    We have reviewed the NJ Broadband access data submitted by Verizon Wireless and have identified a 
few issues that we need some clarification on.    
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If you need further information or clarification on these questions, please contact me.  We appreciate your 
prompt attention. 



John Wullert 
Manager – NJ BB Data Collection 
Telcordia Technologies 
732-699-2687 
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John 

1.  We reported that we’re licensed by the FCC to operate on 4 spectrum bands – 3 to provide our 3G 
wireless broadband service and 1 (700Mhz) for 4G LTE.  As to our 3G service we make no distinction 
between the service coverage area for each of the spectrum bands.  It would b appropriate to remove the 
duplicates. 
2.  Here’s what we tell the public about 4G speeds on our website:  “Verizon’s 4G LTE network delivers 
an average throughput of 5-12 megabytes per second (Mbps) downlink and 2-5 Mbps uplink.” 

Hope this helps.  If you’d like to speak please e-mail me or call me on my mobile. 
Fran 
�
Fran Malnati

Executive Director - Regulatory Matters
Mobile: 201-819-6262

Verizon Wireless

Legal & External Affairs Department
One Verizon Way, VC52S490
Basking Ridge, NJ 07920-1097  
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Fran, 
   Thanks for the quick response.   
   Your advertised rates span the boundaries that define the NTIA tiers.  I propose that we will use the 
tiers that include the mid-point of your advertised ranges.  Based on that, we would use tier 6  for 
downstream (Greater than or equal to 6 mbps and less than 10 mbps) and tier 5 for upstream (Greater 
than or equal to 3 mbps and less than 6 mbps).  That seems to maximize the overlap.  Is that acceptable 
to you? 

John Wullert 
Manager – NJ BB Data Collection 
Telcordia Technologies 
732-699-2687 
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Sure, not an exact science and we hope to continue to improve.  Fran 

Section 7: Notes and Open Issues 
  



Section 8: Overview Map of Submitted Data 

  



Broadband Provider Data Report 

Provider: Wave2Wave Communications, Inc. 
Received: March, 2011 
Submission date: March, 2011 

This report presents details on processing of the broadband data for delivery to the 
National Telecommunications and Information Administration. 

Sections: 
184. NDA Status 
185. Submission Overview 
186. Submission File Details 
187. Data Validations and Results 
188. Data Transformation and Loading 
189. Clarification Questions and Provider Responses
190. Notes and Open Issues 

Section 1: NDA Status 

NDA executed with NJ OIT. 

Section 2: Submission Overview 

AVAILABILITY DATA 

ID 

Provider name 

“Doing business as” name 

FRN 

Wave2Wave Communications, Inc. 

Wave2Wave Communications 

0015329394 

FOR WIRELINE 

Filetypes XLS 

File size 229 rows 

Speeds 

Type 

Spatial Resolution 
(address, street seg, 
census block, 
RSA/MSA, 
zipcode,etc) 

Typical-upstream  Address 

Typical-downstream  Address 

Advertised-upstream  Address 

Advertised-
downstream 

Address 

Subscriber-weighted-  Not provided 



up 

Subscriber-weighted-
down 

Not provided 

Technology 
Type 

30 (other copper - probably Ethernet) and 70 (Terrestrial Fixed Wireless) 

End-user 
specification 

Codes 3 and 4 

Comments: 

INTERCONNECTION DATA 

ID None provided 

File size 

Ownership 

Transport Type 

Data 
Rates/Capacity 

Location 

Comments: 

Section 3: Submission File Details 

Received 1 file by SECURE UPLOAD: 

Size  Name 

76800  NJBB_0015329394_AddressLevelAvailability_03.08.2011.xls 

Section 4: Validations and Results 

The submitted file has 229 rows with street addresses, tech transmission, max adv 
speeds, and typical speeds.  The codes look reasonable, but the high variety in 
maximum advertised speeds should be corrected.  Of the original rows, 223 could be 
geocoded successfully and 6 could not.  The input address set yielded 163 unique 
census blocks. 

Section 5: Data Transformation and Loading 

NTIA Table BB_Service_CensusBlock 



Loaded from supplied XLS file.  The following table explains the transformations that 
were applied to load the target table. 

Table Column Data Source / Transformation

PROVNAME As supplied in column “ProvName” 
DBANAME As supplied in column “DBAName” 
PROVIDER_TYPE Set to 1 
FRN As supplied in column “FRN” 
STATEFIPS Set to “34” (NJ) 
COUNTYFIPS Populated from Census Block FIPS Code (first 3 digits) 
TRACT Populated from Census Block FIPS Code (next 6 digits)
BLOCKID Populated from Census Block FIPS Code 
BLOCKSUBGROUP Set to null 
FULLFIPSID Populated from Census Block FIPS Code 
TRANSTECH As supplied in column TransTech 
MAXADDOWN As supplied in column MaxAdvDown 
MAXADUP As supplied in column MaxAdvUp 
TYPICDOWN Set to null 
TYPICUP Set to null 
SHAPE Copied from Census Bureau 2000 reference data,  

as matched by spatial join on geocoded address 

Internal processing notes: 
53. Geocoded the addresses using the Google geocoder. 
54. Created an excel sheet and imported to a geodatabase table. 
55. Added point shapes corresponding to each Latitude,Longitude pair by creating a 

feature class from the table using ArcCatalog’s “Create Feature Class from XY 
Table” option. 

56. Added a column containing the ID of the containing year 2000 census via a 
spatial join of the point shapes and the census block shapes from reference data. 

57. Copied the Census Block shape from reference data. 
58. Discarded 60 rows with duplicate census blocks, leaving 63 for technology 30. 

NTIA Table BB_Service_Wireless 

Loaded using census block shapes from reference data for the records with 
transmission technology 70.  The following table explains the transformations that were 
applied. 

Table Column Data Source / Transformation

PROVNAME As supplied in column “ProvName” 
DBANAME As supplied in column “DBAName” 
FRN As supplied in column “FRN” 
TRANSTECH As supplied 



SPECTRUM Set to 6, Unlicensed  
MAXADDOWN Set to 10, the largest value submitted for this tech 
MAXADUP Set to 10, the largest value submitted for this tech 
TYPICDOWN Set to null 
TYPICUP Set to null 
STATEABBR Set to “NJ” 
SHAPE Year 2000 Census Block shape obtained from reference data.

Internal processing notes: 
26. See above for discussion of geocoding addresses and finding the containing 

census block. 
27. Spectrum: Imputed the code for unlicensed spectrum. 

Section 6: Clarification Questions and Responses 

. 

Section 7: Notes and Open Issues 

  



Section 8: Overview Map of Submitted Data 

  



Broadband Provider Data Report 

Provider: WildBlue Communications Inc. 
Received: March 2011 
Submission date: April 2011 

This report presents details on processing of the broadband data for delivery to the 
National Telecommunications and Information Administration. 

Sections: 
191. NDA Status 
192. Submission Overview 
193. Submission File Details 
194. Data Validations and Results 
195. Data Transformation and Loading 
196. Clarification Questions and Provider Responses
197. Notes and Open Issues 

Section 1: NDA Status 

NONE 

Section 2: Submission Overview 

AVAILABILITY DATA 

ID 

Provider name 

“Doing business as” name 

FRN 

WildBlue Communications, Inc. 

WildBlue 

0007843766  

FOR WIRELESS 

Filetypes text file, shape file 

File size 

Speeds 

Type 

Spatial Resolution 
(address, street seg, 
census block, 
RSA/MSA, 
zipcode,etc) 

Typical-upstream  Not provided (‘0’) 

Typical-downstream  Not provided (‘0’) 

Advertised-upstream  yes. Entire state. 

Advertised-
downstream 

yes. Entire state 

Subscriber-weighted-
up 

Not provided? 

Submitted shape file describing 
the entire state of NJ with 
attributes for  



Subscriber-weighted-
down 

By county 

Technology 
Type 

Code 60 (Satellite) 

End-user 
specification 

Voice message indicated that the referenced plans are consumer-focused. 

Comments:  From the provider’s input package: 

“The subscriber-weighted nominal speed information has been calculated using only the service tiers 

that meet the NTIA definition of broadband speed, and is based on subscriber data for active 

subscribers as of March 17, 2011 

WildBlue notes that of the possible ‘Spectrum Used’ options provided, none listed Ka-Band as an 

option for Satellite Providers.  WildBlue uses Ka-Band spectrum (uplink in the 29.5 – 30 gigahertz 

band and downlink in the 19.7 – 20.2 gigahertz band). WildBlue has not provided Typical Upstream 

Speed and Typical Downstream Speed values. WildBlue does not track speeds on a state-by-state 

basis, but instead primarily monitors overall network speeds. WildBlue has begun the process of 

recording more granular data relating to the speeds normally experienced by subscribers on a spot-

beam basis. WildBlue believes that it will be able to provide this data in the coming months. 

The map and supporting data are for one singular service area polygon that equals the entire State of 

New Jersey. The WildBlue service data values provided do not vary across any county or region 

within the state; therefore, there is only one service area polygon, namely the entire State of New 

Jersey

INTERCONNECTION DATA: NONE 

ID 

File size 

Ownership 

Transport Type 

Data 
Rates/Capacity 

Location 

Comments: Not provided 



Figure 1. The shape submitted by the provider (the entire state of NJ) 

Section 3: Submission File Details 

Size (kb) Name 
2  WildBlue_Subscriber_Weighted_Nominal_speed_By_County_NJ.txt 
1  WildBlue_Availability_0007843766_NJ_region.shx 
1  WildBlue_Availability_0007843766_NJ_region.dbf 
1  WildBlue_Availability_0007843766_NJ_region.prj 
19  WildBlue_Availability_0007843766_NJ_region.shp 

Section 4: Validations and Results 

Section 5: Data Transformation and Loading 

Loaded county shapes from reference data for counties in the State of New Jersey 
based on emailed statements that all counties are covered.  The following table explains 
the transformations that were applied. 

Table Column Data Source / Transformation

PROVNAME Set to "WildBlue Communications, Inc." 
DBANAME Set to "WildBlue" 
FRN Set to 0007843766 
TRANSTECH Set to 60 
SPECTRUM Set to 7 per translation shown below 



MAXADDOWN Set to 4, see below. 
MAXADUP Set to 2, see below. 
TYPICDOWN Not provided, set to null 
TYPICUP Not provided, set to null 
STATEABBR Set to “NJ” 
SHAPE County shape read from reference data.

Internal notes on processing: 
28. Spectrum: No statement was provided.  The NTIA data model has a single 

column for spectrum.  Satellite corresponds to NTIA “SPECTRUM USED” code 
value 7. 

29. Speeds: The maximum advertised speeds provided in the emailed brochure are 
as discussed above  For max adv speeds we encoded the submitted down 
speed as value 4 (range 1.5-3 Mbps) and encoded the submitted up speed as 
value 2 (range 200 Kbps -- 768 Kbps). 

30. Did not use the supplied shapefile because it was faster to copy over reference 
data that's already in the right XY coordinate system and tolerance value. 

Section 6: Clarification Questions and Responses 

1. coverage info not supplied at resolution finer than entire state 

Section 7: Notes and Open Issues 



Section 8: Overview Map of Submitted Data 

  



Broadband Provider Data Report 

Provider: Xchange Telecom 
Received: March 2011 
Submission date: April 2011 

This report presents details on processing of the broadband data for delivery to the 
National Telecommunications and Information Administration. 

Sections: 
198. NDA Status 
199. Submission Overview 
200. Submission File Details 
201. Data Validations and Results 
202. Data Transformation and Loading 
203. Clarification Questions and Provider Responses
204. Notes and Open Issues 

Section 1: NDA Status 

None so far 

Section 2: Submission Overview 

AVAILABILITY DATA 

ID 

Provider name 

“Doing business as” name 

FRN 

Xchange Telecom Corp 

Xchange Telecom 

0006831713 

FOR WIRELINE 

Filetypes 

File size 

Speeds 

Type 

Spatial Resolution 
(address, street seg, 
census block, 
RSA/MSA, 
zipcode,etc) 

Typical-upstream   

Typical-downstream   

Advertised-upstream  2 Mbps (code 4) 

Advertised-
downstream 

10 Mbps (code 7) 

Subscriber-weighted-
nominal speed 

Information provided via email 
exchange (see below).   

Provider originally indicated that 
their coverage was limited to 
the area supported by a single 
central office.  In further 
exchanges, the provider 
indicated that their coverage is 
limited to city of Lakewood and 
that they cover the entire city 
limits. 



Technology 
Type 

ADSL (code 10) 

End-user 
specification 

In response to inquiry, provider reported residential and small business. 

Comments: 

INTERCONNECTION DATA 

ID 

File size 

Ownership 

Transport Type 

Data 
Rates/Capacity 

Location 

Comments: 

Section 3: Submission File Details 

Received no file submission, only statements by email. 

Section 4: Validations and Results 

No data was submitted, so no validation was required. 

Section 5: Data Transformation and Loading 

NTIA Table BB_Service_CensusBlock 

Loaded based on the emailed statement of service to all of Lakewood Township, Ocean 
county, New Jersey.  We submitted all census blocks less than 2 square miles in this 
municipality.  The following table explains the transformations that were applied to load 
the target table. 

Table Column Data Source / Transformation

PROVNAME Set to “Xchange Telecom Corp” per email response 
DBANAME Set to “Xchange Telecom” 
PROVIDER_TYPE Set to 1 
FRN Set to “0006831713” per email response 
STATEFIPS Set to “34” (NJ) 
COUNTYFIPS Populated from Census Block FIPS Code (first 3 digits) 
TRACT Populated from Census Block FIPS Code (next 6 digits)



BLOCKID Populated from Census Block FIPS Code 
BLOCKSUBGROUP Set to null 
FULLFIPSID Populated from Census Block FIPS Code 
TRANSTECH Set to 10 (ADSL) per email 
MAXADDOWN Set to code 7 per email 
MAXADUP Set to code 4 per email 
TYPICDOWN Set to null, not provided 
TYPICUP Set to null, not provided 
SHAPE Copied from Census Bureau TigerLine 2000 

Internal processing notes: 
59. Created a file with a municipality name that matches exactly the “name” column 

in the Year 2000 Census Bureau TigerLine database. 
60. Joined against reference data to discover census blocks, for a total of 681 

blocks. 
61. All of the census blocks discovered for Lakewood Township are smaller than 2 

square miles, so no road segments were loaded. 

Section 6: Clarification Questions and Responses 
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Duvid, 
   We can work with that information as far as geography and mapping into Census blocks.  What we 
would need then is information on your speeds and middle-mile interconnection points.  In terms of 
speeds, we are requesting the maximum upstream and downstream speeds you advertise in Lakewood, 
and the typical upstream and speeds experienced by your customers.  For middle-mile interconnection 
points, we are requesting the address, and the technology and bandwidth you have available and 
whether you own or lease the trunks. 

   There is also a small amount of general information we need.  Specifically, we need you official 
company name, and other names you do business as and your FCC FRN number. 

Thanks for your participation in the program! 

John Wullert 
Manager – NJ BB Data Collection 
Telcordia Technologies 
732-699-2687 
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John, 
We are a UNE-L company, we lease the loop from Verizon and provide broadband for the end user on 
the leased circuits. I believe we do cover the whole city of Lakewood. 

Duvid Rottenberg 
Xchange Telecom, Corp. 
drottenberg@xchangetele.com
(646) 722-7258 
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Duvid, 
   I received the note that you sent to Shelley Bates regarding the questions you have about submitting 
your broadband availability data.  Rather than attempting to answer your question, let me first ask another 
question that will help determine if you are required to report data at this time.  We are currently only 
collecting data from “facilities-based” providers.  NTIA definition is: 

An entity is a ‘‘facilities-based’’ provider of broadband service connections to end user locations if any of 
the following conditions are met: (1) It owns the portion of the physical facility that terminates at the end 
user location; (2) it obtains unbundled network elements (UNEs), special access lines, or other leased 
facilities that terminate at the end user location and provisions/equips them as broadband; or (3) it 
provisions/equips a broadband wireless channel to the end user location over licensed or unlicensed. 

If you fit the definition, then we would be looking to collect data from you.  In that case, we need to come 
up with a method of determining your coverage area.  We do not have a clean way of mapping from COs 
to census blocks.  We do have a couple options: 
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Let me know how I can help you in determining an approach. 

John Wullert 
Manager – NJ BB Data Collection 
Telcordia Technologies 
732-699-2687 
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Hi Shelley, 

I am working on providing the data you requested from Michael. Our broadband service is currently 
available for all customers served by the LKWDNJLKDS5 CO, I'm not sure how to map that into  census 
tracts. I have tried setting up an account at http://connectingnj.state.nj.us but I got an error stating that 
Xchange Telecom is not a recognized provider. 

Thank You, 
Duvid Rottenberg 
Xchange Telecom, Corp. 
drottenberg@xchangetele.com
(646) 722-7258 
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Duvid, 
   I received the note that you sent to Shelley Bates regarding the questions you have about submitting 
your broadband availability data.  Rather than attempting to answer your question, let me first ask another 
question that will help determine if you are required to report data at this time.  We are currently only 
collecting data from “facilities-based” providers.  NTIA definition is: 

An entity is a ‘‘facilities-based’’ provider of broadband service connections to end user locations if any of 
the following conditions are met: (1) It owns the portion of the physical facility that terminates at the end 
user location; (2) it obtains unbundled network elements (UNEs), special access lines, or other leased 
facilities that terminate at the end user location and provisions/equips them as broadband; or (3) it 
provisions/equips a broadband wireless channel to the end user location over licensed or unlicensed. 

If you fit the definition, then we would be looking to collect data from you.  In that case, we need to come 
up with a method of determining your coverage area.  We do not have a clean way of mapping from COs 
to census blocks.  We do have a couple options: 
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Let me know how I can help you in determining an approach. 

John Wullert 
Manager – NJ BB Data Collection 
Telcordia Technologies 
732-699-2687 
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John, 
We are a UNE-L company, we lease the loop from Verizon and provide broadband for the end user on 
the leased circuits. I believe we do cover the whole city of Lakewood. 

Duvid Rottenberg 
Xchange Telecom, Corp. 
drottenberg@xchangetele.com
(646) 722-7258 
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Duvid, 
   We can work with that information as far as geography and mapping into Census blocks.  What we 
would need then is information on your speeds and middle-mile interconnection points.  In terms of 
speeds, we are requesting the maximum upstream and downstream speeds you advertise in Lakewood, 
and the typical upstream and speeds experienced by your customers.  For middle-mile interconnection 
points, we are requesting the address, and the technology and bandwidth you have available and 
whether you own or lease the trunks. 

   There is also a small amount of general information we need.  Specifically, we need you official 
company name, and other names you do business as and your FCC FRN number. 

Thanks for your participation in the program! 

John Wullert 
Manager – NJ BB Data Collection 
Telcordia Technologies 
732-699-2687 
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Duvid, 
   I am sending this again to request data from you on the types of service you advertise.  I attempted to 
gain this information from your Web site, but was unable to get any information on the plans you offer.  
Could please send me information on the maximum upstream and downstream speeds you advertise in 
Lakewood?  If you have information on the typical upstream and speeds experienced by your customers, 
that would be useful as well. 
   Please feel free to call me if you have any questions. 



John Wullert 
Manager – NJ BB Data Collection 
Telcordia Technologies 
732-699-2687 
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2 Mbps Upstream and 10 Mbps downstream.  

Duvid Rottenberg 
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Thanks for this. 

One other question – do you serve both residential and business customers? 

John 
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Yes we do. 

Duvid Rottenberg 
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Duvid, 
   We need to report data using Provider Name, Doing-Business-As Name and FCC Registration number.  
The information we retrieved from the FCC is: 



Provider Name:                XCHANGE TELECOM CORP.    
FRN:                                      0006831713 

Are these correct?  Also, do you have another “doing-business-as” name? 

Thanks, 

John Wullert 
Manager – NJ BB Data Collection 
Telcordia Technologies 
732-699-2687 

Section 7: Notes and Open Issues 

  



Section 8: Overview Map of Submitted Data 

  



Connecting New Jersey - Broadband Provider Data Report 

Provider: XO Communications 
Submission date: April 2011 

This report presents details on processing broadband data for delivery to the National 
Telecommunications and Information Administration (NTIA).  This is a stub report, since 
data from the previous submission was reused unchanged.  The complete report from 
the previous submission begins on the next page.  Notable differences from the 
processing done on the previous submission are listed next. 

NTIA Table BB_Service_CensusBlock 

6. Column "reseller" was dropped. 
7. Set the new column "provider_type" to value 1 ("Broadband provider as 

described in the NOFA") 
8. Set the max advertised speed code values (down and up) to 9, which is the 

maximum value among all records provided to us. 
9. Dropped non-measured typical up/down speed code values. 

Provider Interactions 
�
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Hi John, 

I don’t have any new data to report.  

Thanks, 
Sharon Adams 
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Sharon, 
   Are you saying that we can use the data you submitted last time (that it reflects your network 
capabilities as of 12/31/2011)? 

John Wullert 
Manager – NJ BB Data Collection 
Telcordia Technologies 



732-699-2687 
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Yes, the previous data can be used again. 

Thanks, 
Sharon Adams 
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Sharon, 
   We have performed our initial review of your data and have a clarification question:  
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John Wullert 
Manager – NJ BB Data Collection 
Telcordia Technologies 
732-699-2687 

  



Broadband Provider Data Report 

Provider: XO Communications 
Received: August, 2010 
Submission date: October 2010 

This report presents details on processing of the broadband data for delivery to the 
National Telecommunications and Information Administration. 

Sections: 
205. NDA Status 
206. Submission Overview 
207. Submission File Details 
208. Data Validations and Results 
209. Data Transformation and Loading 
210. Clarification Questions and Provider Responses
211. Notes and Open Issues 

Section 1: NDA Status 

Executed. 

Section 2: Submission Overview 

AVAILABILITY DATA 

ID 

Provider name 

“Doing business as” name 

FRN 

XO Communications, LLC 
Provided, but looks weird 
0006275945 

FOR WIRELINE 

Filetypes 

File size 

Speeds 

Type 

Spatial Resolution 
(address, street seg, 
census block, 
RSA/MSA, 
zipcode,etc) 

Typical-upstream  census block 

Typical-downstream  census block 

Advertised-upstream  census block 

Advertised-
downstream 

census block 

Subscriber-weighted-
up 

Not provided 



Subscriber-weighted-
down 

Not provided 

Technology 
Type 

Entered codes 1, 2, and 3, which are not valid NOFA TechTrans codes. 

End-user 
specification 

Business (444 entries), Residence (5 entries) 

Comments: 

INTERCONNECTION DATA 

ID 

File size 

Ownership 

Transport Type 

Data 
Rates/Capacity 

Location 

Comments: Not provided 

Section 3: Submission File Details 

Received 1 file by SECURE UPLOAD. 

Size  Name 
41358  NJBroadbandData63009.xlsx 

Section 4: Validations and Results 

The spreadsheet provides census block IDs and associated max adv and typical 
speeds. The last two rows of the sheet are different from the 447 data rows proceeding 
them, and one of those last two is in New York.  The DBA name looks unusual and the 
technology of transmission codes are not valid.  After receiving clarification by email we 
created a corrected spreadsheet based on the original submission as follows: 

1. Dropped the last two rows that have addresses instead of provider name, DBA 
name, etc. 

2. Changed DBA Name entries to “XOCSI” 
3. Changed technology of transmission codes: 1 to 10, 2 to 20, and 3 to 30. 

Section 5: Data Transformation and Loading 



NTIA  Table BB_Service_CensusBlock 

Loaded from the supplied spreadsheet.  The following table explains the 
transformations that were applied to load the target table. 

Table Column Data Source / Transformation

PROVNAME As supplied in column “Provider Name” 
DBANAME As supplied in column “DBA Name” 
RESELLER Set to “N” 
FRN As supplied in column “FRN”, after adding leading zeros
STATEFIPS Set to “34” (NJ) 
COUNTYFIPS Populated from column census_block (1st 3 digits) 
TRACT Populated from column census_block (next 6 digits) 
BLOCKID Populated from column census_block 

(last 4 digits) 
BLOCKSUBGROUP Set to null 
FULLFIPSID As supplied in column census_block 
TRANSTECH As supplied in column Tech Code 
MAXADDOWN As supplied in column MaxDownload 
MAXADUP As supplied in column MaxUpload 
TYPICDOWN As supplied in column TypDownload 
TYPICUP As supplied in column TypUpload 
SHAPE Copied from Census Bureau TigerLine 2000,  

As matched by Census block ID 

Internal processing notes: 
1. No duplicate census blocks were found. 

Section 6: Clarification Questions and Responses 

1. The file name suggests the data are from June 30, 2009.  We need data from 
June 30, 2010 for this submission. 

2. The DBA name is provided as “XO Communications Services, Inc. (Affiliated 
Entity)” which seems unusually lengthy for a DBA name.  Should it be reported 
simply “XO” or “XO Communications”? 

3. The technology codes 1, 2, and 3 are not known to us.  Do you mean 10 (ADSL), 
20 (SDSL), and 30 (Other Copper)?  Please refer to the NOFA technical 
appendix for valid technology of transmission codes (page numbered 32558, 
physical page 14): 
����0�������������������������� 99;�1,P2��������������*61�P9;9>9@����

4. The typical and maximum down speeds always match, and the typical and 
maximum up speeds always match each other also.  We are expecting typical 
user speeds and maximum *advertised* speeds.  It seems unlikely that you have 
so many different maximum advertised speeds.  Did you report the provisioned 
speeds here?  Please clarify. 



5. Some rows show speed code 9 (Greater than or equal to 50 mbps and less than 
100 mbps), which seems more likely to be a fiber technology than copper.  
Please recheck, or help us understand what copper technology supports this 
speed over a long distance. 

6. We believe you have submitted Census Block 2000 codes to us, because every 
entry is length 15; none are length 16.  Please confirm. 

7. The last two rows of the submission are different from the 447 data rows 
proceeding them, and one is in New York.  We will discard these rows: 

437 PARK AVE PLAINFIELD NJ 07060 Business
1401 MAIN ST PORT JEFFERSON NY 11777 Business

8. We received no connection point (middle-mile) data.  Will you submit that? 
9. We did not receive data on subscriber weighted nominal speeds, separated by 

county.  Will you submit that? 
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John, 

I am rechecking the data for question 5 and will provide the answer in the morning. 

Sharon 

      We have been reviewing the data you submitted to the New Jersey Broadband mapping program.  
Based on our initial review, we have some questions for you that will help us better understand the data 
and process it accurately. 

1.            The file name suggests the data are from June 30, 2009.  We need data from June 30, 2010 for 
this submission.  Can you confirm that this data is actually for 2010? Provided June 30, 2010 data 

2.            The DBA name is provided as  “XO Communications Services, Inc. (Affiliated Entity)” which 
seems unusually lengthy for a DBA name.  Should it be reported simply “XO” or “XO Communications”? It 
can be shortened to XOCSI.

3.            The technology codes 1, 2, and 3 are not known to us.  Do you mean 10 (ADSL), 20 (SDSL), 
and 30 (Other Copper)?  Please refer to the NOFA technical appendix for valid technology of 
transmission codes (page numbered 32558, physical page 14): 10, 20 and 30 would be the correct 
codes for 1, 2, and 3 respectively.  
http://www.ntia.doc.gov/frnotices/2009/FR_BroadbandMappingNOFA_090708.pdf 
4.            The typical and maximum down speeds always match, and the typical and maximum up speeds 
always match each other also.  We are expecting typical user speeds and maximum *advertised* 
speeds.  It seems unlikely that you have so many different maximum advertised speeds.  Did you report 
the provisioned speeds here?  Please clarify.  XO does not have advertised speeds for these 
services, so I populated those fields with the same data.

5.            Some rows show speed code 9 (Greater than or equal to 50 mbps and less than 100 mbps).  
We would like to clarify – does this represent T3 links over copper?  
6.            We believe you have submitted Census Block 2000 codes to us, because every entry is length 
15; none are length 16.  Please confirm.  I did submit data from the 2000 codes.



We would appreciate your prompt attention to these questions.  If you need further clarification, please 
feel free to contact me. 

Thank you for your participation! 

John Wullert 
Manager – NJ BB Data Collection 
Telcordia Technologies 
732-699-2687 

Section 7: Notes and Open Issues 
  



Section 8: Overview Map of Submitted Data 



APPENDIX B:

Community Anchor Institution Processing

Summary

For each category of community anchor institution, we generally sought data from two types of sources.  

One source was a reference source that provided a more-or-less current list of institutions with name, 

address and ID number (where applicable).  This reference source was expected to be nearly complete, 

representing all the institutions of the specified type in the state.  Reference sources are listed where 

available in the table below.  For some CAI categories, we had no reference list, e.g., for local 

government and non-governmental organizations.

The second type of source provided the broadband information.  In most cases, the broadband 

information was supplied individually by the institutions via our Web site.  In two cases, the broadband 

information was provided in aggregate:  

! In the case of Higher Education, we obtained broadband access information from NJEdge, an 

organization that provides broadband service to institutions.

! In the case of State Government, we obtained a list of broadband circuits provided to the state 

by Verizon.

For each CAI category, the following table provides the number of records we obtained from the 

reference source, the number of broadband access records we obtained, the total number of records we 

submitted to the NTIA and the number of complete records, with verified address information and 

broadband access information.   

CAI Category Reference 

Records

Broadband 

Records

Total Records 

Submitted

Complete Records 

Submitted

School K-12 (Public) 2601 549

(230 of these 

records require 

further processing 

and verification)

2601 158

School K-12 

(Private) 1260

(NCES)
1260 71

Libraries

427

(IMLS)
89 427

87

(2 library web 

submissions were 

unmatched)

Medical/Healthcare 111

(NJHA)
5 111 5

Public Safety

343

(NJ 911 Comm.)
99 343

88

(11 PSAP web 

submissions were 

unmatched)

University 157 38 157 37



CAI Category Reference 

Records

Broadband 

Records

Total Records 

Submitted

Complete Records 

Submitted

(NCES IPEDS) (NJEdge) (1 entry for was 

unmatched)

Other – State 

Government

2700

500

(Remaining data 

to be analyzed 

and verified for 

next submission)

500

Other – Local 

Government
0 45 45 45

Other – Non 

Government
0 8 8 8

Total Submitted 5452 999

Abbreviations and Acronyms

911 Comm New Jersey 9-1-1 Commission

IMLS Institute of Museum and Library Services

IPEDS Integrated Postsecondary Education Data System

NCES National Center for Education Statistics

NJHA New Jersey Hospital Association

Detailed Processing

The following sections contain detailed descriptions of the data we received and the processing steps 

we applied to the data in order to generate the NTIA submission.

Local Government and Non-Government Organizations

1. Accepted data submitted by 45 local government and 8 non-governmental organizations via 

specially designed Web site.  Data collected included:

i. Community Anchor Institution Category 

ii. Community Anchor Institution Name  (System, Branch)

iii. CAI ID information: NCES School ID, NCES IPEDS ID, FSCSKEY, FSCS_SEQ 

iv. Address: Street, City, State, Zip,County 

v. Contact info: Name, Phone, Email, Web address 

vi. Wi-Fi access

vii. Broadband info: Provider, Technology, Upstream and Downstream speeds

viii. Comment

2. Generated Latitude and Longitude via geo-coding using Yahoo geocoder API.

a. Ensured no errors were present, that at least on entry was returned and that quality 

metric was over 75.



State Government

1. Obtained a listing of 2700 connections provided by the primary broadband service provider to 

the state.  List of connections included the following data:

a. Service address 

i. This field included an indication of the office or department being served and an 

extremely abbreviated version of the address

ii. e.g.: “(SPNL)STATE OF NJ-TLS 19 LANDIS AV, UP DRFLD T”

b. Speed (single value, 1.5 to 1000 Mbps)

c. Technology (ATM, Ethernet, Frame Relay, PRI, Point-to-Point

2. Manually interpreted the address field, using Web mapping tools (e.g., Google Maps), to get 

corresponding addresses that could be geo-coded

a. This is a time consuming process and thus we were only able to complete this operation 

for 500 of the addresses

3. Generated Latitude and Longitude via geo-coding using Yahoo geocoder API.

a. Ensured no errors were present, that at least on entry was returned and that quality 

metric was over 75.

Hospitals

1. Obtained a listing of 111 hospitals from NJ Hospital Association.  List of connections included the 

following data:

a. Facility Name

b. Address: Street, City, State, Zip

2. Generated Latitude and Longitude via geo-coding using Yahoo geocoder API.

a. Ensured no errors were present, that at least on entry was returned and that quality 

metric was over 75.

3. Merged NJHA data with data collected from 5 hospitals via our hosted Web site to merge 

address and ID information with speed and Wi-Fi availability information.

a. Performed exact match between NJHA and submitted data on institution name

i. Facilitated matching by Converting names to upper case, removing certain 

common words (THE, HOSPITAL, MEDICAL, CENTER, SYSTEM, HEALTHCARE), 

removing double spaces and trimming leading and trailing spaces.

Higher Education

1. Obtained the following data from the named sources

a. List of higher education institutions from National Center for Education Statistics IPEDS 

Data Center.  Table included information on 157 institutions with the following fields:

i. Institution Name

ii. Address: Street, City, County, State, ZIP

iii. IPEDS ID

iv. Latitude

v. Longitude



b. List of members of NJEdge.  Table included information on 48 institutions, most of which 

(38) were state, community or private institutions of higher learning.  Information from 

NJEdge included:

i. Institution Name

ii. Address

iii. Technology Type

iv. Upstream and downstream speeds

2. Merged IPEDS and NJEdge data to match institution data with broadband access information

a. Performed exact match on institution name

i. Facilitated matching by Converting library names to upper case and trimming 

excess spaces

b. Of those NJEdge data entries that did not match, used approximate matching based on 

institution name

i. Preprocess prior to approximate match involved

1. Removing strings COLLEGE, UNIVERSITY, NEW JERSEY

2. Removing any punctuation

ii. Matched using Levenshtein Distance metric with threshold of 4.

c. Reviewed unmatched NJEdge data manually and identified one additional match.

3. Successfully merged data from 37 of 38 NJEdge institutions into IPEDS data for total of 157 

institutions

a. Note that remaining NJEDGE institution (Fairleigh Dickenson) has different address than 

either of the campuses in the IPEDS data.

Libraries

2. Obtained the following data from the named sources 

a. Obtained the file “Public Libraries Survey Fiscal Year 2008” from 

http://harvester.census.gov/imls/data/pls/index.asp.

i. Extracted 427 records for the state of New Jersey

ii. Used the following data items:

1. FSCSKEY

2. FSCS_SEQ

3. LIBNAME

4. ADDRESS

5. CITY

6. ZIP

7. LATITUDE

8. LONGITUDE

b. Data submitted by 89 library organizations via specially designed Web site.  Data 

collected included same fields listed above for Local Governmental organizations

3. Merged library survey data with data collected from libraries via our hosted Web site to merge 

address and ID information with speed and Wi-Fi availability information.

a. Performed exact match between survey and submitted data on library name



i. Facilitated matching by Converting library names to upper case, cutting 

submitted names to fixed-field length of survey data (60 characters) and 

trimming excess spaces

b. For those submitted data entries that did not match, performed an approximate match 

based on library name

i. Preprocess prior to approximate match involved

1. Removing strings “P.L.”, “FREE”, “PUBLIC”, “LIBRARY”, TOWNSHIP, 

TSWP, PUB, LIB, THE, SYSTEM

2. Removing any punctuation

3. Converting “NO”/”SO” at start of line to NORTH and SOUTH respectively

ii. Matched using Levenshtein Distance metric with threshold of 3.

c. Successfully matched all but two submitted entries

i. Manual comparison showed that those libraries were not present in the survey

data.

Private K-12 Schools

1. Obtained the following data from the named sources:

a. List of private K-12 education institutions from National Center for Education Statistics 

Private School Universe Survey.  Table included information on 1260 institutions with 

the following fields:

i. Name

ii. Address: Street, City, State, ZIP

iii. NCES_ID

b. Data submitted by schools via specially designed Web site.  Data collected included 

same fields listed above for Local Governmental organizations.  Total number of Public 

and Private schools submitting information was 549.

2. Merged NCES private school with data collected from private schools via our hosted Web site to 

merge address and ID information with speed information.

a. Performed exact match between NCES and submitted data on institution name

i. Facilitated matching by:

1. Converting library names to upper case

2. Removing string “, NJ”

3. Converting string SAINT to ST

b. For those submitted data entries that did not match NCES data, performed an 

approximate match based on institution name

i. Preprocess prior to approximate match involved

1. Replacing string SCHOO or SCHO with SCHOOL

2. Replacing string “HIGH SCHOOL” with HS and string “ELEMENTARY” with 

ELEM

3. Removing strings SCHOOL, THE, REGIONAL, HIGH and ACADEMY

4. Trimming excess spaces

ii. Matched using Levenshtein Distance metric with threshold of 3.



c. Successfully merged data from 71 submitted private school into 1260 NCES institutions

i. Manual comparison resulted in matching of two additional institutions

ii. Remaining institutions were ambiguous or not present in the NCES data.

3. Generated Latitude and Longitude via geo-coding using Yahoo geocoder API.

a. Ensured no errors were present, that at least on entry was returned and that quality 

metric was over 75.

Public K-12 Schools

1. Obtained the following data from the named sources: 

a. List of public K-12 education institutions from National Center for Education Statistics 

Private School Universe Survey.  Table included information on 2601 institutions with 

the following fields:

i. Name

ii. Address: Street, City, State, ZIP

iii. NCES_ID

iv. Latitude, Longitude

b. Data submitted by schools via specially designed Web site.  This was entries in the 

school category that did not match any of the NCES private schools.  Total number of 

Public and Private schools submitting information was 549.

2. Merged NCES private school with data collected from private schools via our hosted Web site to 

merge address and ID information with speed information.

a. Performed exact match between NCES and submitted data on institution name and zip 

code

i. Facilitated matching by:

1. Removing SCHOOL and all truncated versions of the word from the ends 

of any string

2. Performing the following conversions

a. “SENIOR HIGH” and HIGH to HS 

b. “MIDDLE”, “M S”, “MID” and “MIDD” to MS

c. “ELEMENTARY” to ELEM

d. CHARTER to CS

e. BOROUGH to BORO

f. AVENUE to AVE

g. TOWNSHIP to TWP

h. STREET to ST

3. Removing the strings REGIONAL, “ REG” and ACADEMY

4. Removing punctuation and double spaces

5. Trimming any leading or trailing spaces

b. For those submitted data entries that did not match NCES data, performed an 

approximate match based on concatenation of institution name and zip code

i. Preprocess prior to approximate match involved

1. Removing the following phrases



a. “BOARD OF EDUCATION” and all truncated versions

b. BOE

c. DISTRICT and all truncated versions

d. PRIMARY, INTERMEDIATE, ELEM, MS, HS, SR, JR

e. # or any digits

f. PUBLIC

2. Trimming excess spaces

ii. Matched using Levenshtein Distance metric with threshold of 2.

c. For those submitted entities that did not match NCES data in either prior stage, 

performed manual comparison.

d. Successfully merged data from 158 submitted entries into 1260 NCES institutions

i. Remaining institutions were ambiguous or not present in the NCES data.

ii. One particular issue was information submitted for a district that did not 

correspond to a specific school

3. Generated Latitude and Longitude via geo-coding using Yahoo geocoder API.

a. Ensured no errors were present, that at least on entry was returned and that quality 

metric was over 75.

Public Safety Organizations

1. Obtained the following data from the named sources: 

a. List of local and state public safety organizations obtained from NJ State 911 

Commission.  Table included information on 343 institutions with the following fields:

i. Name

ii. Address: Street, City, State, ZIP, County

iii. NCES_ID

b. Data submitted by 104 public safety organizations via specially designed Web site.  Data 

collected included same fields listed above for Local Governmental organizations

2. Merged 911 Commission data with PSAP data collected from via our hosted Web site (99 

entries) to merge address and ID information with speed information.

a. Performed exact match between 911 and submitted data on institution name

i. Facilitated matching by:

1. Converting names to upper case

2. Removing the Strings DEPARTMENT, DEPT, TOWNSHIP, TWP

3. Removing punctuation

4. Replacing string PD with POLICE and string BOROUGH with BORO

b. Performed manual merging to integrate submitted records that were not matched.

i. Successfully merged 88 submitted PSAP entries with 911 Commission data.

3. Generated Latitude and Longitude via geo-coding using Yahoo geocoder API.

a. Ensured no errors were present, that at least on entry was returned and that quality 

metric was over 75.
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New Mexico State Broadband Data and Development Program 

Methodology: April 1, 2011 

 

Introduction 

The State of New Mexico (hereafter, NM or State), through its agents Earth Data Analysis Center (EDAC) 
at The University of New Mexico and NM Department of Information Technology (DoIT), submitted the 
April 1, 2011 New Mexico Broadband (NMBB) Program data package, in compliance with the National 
Telecommunications and Information Administration (NTIA) State Broadband Data and Development 
Program (SBDD). 
 

Data Submittal Description 

The NMBB April 1, 2011 data submission included: 
 Data Transmittal Memo (PDF). This document described NMBB data submittal components, 

state-restricted data fields, and contact information. 
 Provider Data Request Template (XLS). The data-request spreadsheet contained an overview 

and upload instructions in addition to eight worksheets for different types of service, subscriber 
speed, and community anchor institutions. 

 FCC-prepared Data Package Spreadsheet (XLS). The data-package spreadsheet consisted of three 
worksheets for overview and checklist, record count, and provider table. 

 NTIA-compliant Geodatabase with FGDC-compliant Metadata (GDB). The NMBB geodatabase 
was created to NTIA standards and included metadata for the database layers. 

 Check Submission Receipt (TXT). This document listed pass/fail for received data-submission 
layer and field entries. 

All files were zipped together and submitted as NM_SBDD_20110401 (ZIP). 
 

SBDD Geodatabase Layer Number of Records: April 1, 2011 
BB_Service_Address 0* 
BB_Service_Road_Segment 9942 
BB_Service_CensusBlock 126123 
BB_Service_CAInstitutions 2595 
BB_Service_Wireless 4166 
BB_Service_Overview 115 
BB_ConnectionPoint_LastMile 0* 
BB_ConnectionPoint_MiddleMile 409 

 
* Due to restrictions in the Non-disclosure Agreement (NDA) with New Mexico Internet Service 
Providers (ISPs), New Mexico cannot populate the Service Address and Last-Mile feature classes in the 
NMBB Geodatabase. 
 

Provider Participation 

The NMBB Program requested broadband data from seventy NM Internet Service Providers (ISPs) in 
February 2011. A total of forty-two different ISPs provided data to the NMBB Program, representing 
thirty-seven companies. Two companies provided statewide satellite data and these data were not 
submitted to NTIA. Eight providers did not submit new data for the April 2011 submittal, and two 
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companies (Cyber Mesa Computer Systems Incorporated and Higher-Speed Internet, LLC) were reluctant 
to further participate in the program. One company (Kit Carson Telecom) provided a data set but it was 
not usable and could not be processed for submission. Six ISPs confirmed that they currently do not 
provide broadband services in New Mexico. 
 

Internet Service Providers Number: April 1, 2011 
Contacted 70 
Responded: Provided Data 42* 
Responded: Will Provide Data 4** 
Responded: Will not Participate 2 
Responded: Not Broadband Provider 6*** 
Did Not Respond 21 

 
* 5 ISPs of 42 provided data as 2 distinct companies/subsidiaries; 1 ISP would not provide data but 
directed NMBB to data on their Web site. 
** 1 ISP submitted an unusable data set for processing. 
*** These ISPs are not broadband providers. 
 
In the Participating Providers table, below, an asterisk (*) indicates a statewide satellite-service provider. 
 

Participating New Mexico Internet Service Providers: NTIA Data Submittal, April 1, 2011 
360networks (USA) Inc. PVT Networks 
Agavue Broadband LLC Qwest Corporation 
AT&T Mobility LLC Sacred Wind Communications, Inc. 
Baca Valley Telephone Company, Inc. Sierra Communications 

  (a subsidiary of Baca Valley Telephone) 
Baja Broadband Southwestern Wireless 
Cable ONE Sprint 
Comcast Suddenlink Communications 
Cricket Communications, Inc. T-Mobile 
Cyber Mesa Telecom Time Warner Cable 
Dell Telephone Cooperative, Inc. Tularosa Communications, Inc. 
DIECA Communications, Inc. 
  (Covad Communications Company) 

TW Telecom of New Mexico, LLC 

ENMR Plateau Telecommunications US Cable 
Frontier Navajo Communications 
  (Navajo Communications Company, Inc.) 

Valley TeleCom Group  
  (Copper Valley Telephone, Inc.) 

Higher-Speed Internet, LLC Valley TeleCom Group  
  (Valley Telephone Cooperative, Inc.) 

La Jicarita Rural Telephone Cooperative Verizon Wireless 
Leaco Rural Telephone Cooperative Windstream Communications SouthWest 
Level 3 Communications, LLC WNM Communications 
MATI Networks (Mescalero Apache Telecom, Inc.) Yucca Telecom (Roosevelt County Rural Telephone 

  Cooperative, Inc.) 
Penasco Valley Telecommunications Yucca Telecom 

  (Yucca Telecommunication Systems, Inc.) 
Plateau Telecommunications, Inc. Spacenet, Inc. (StarBand Communications, Inc.)* 
PTCI (Panhandle Telephone Cooperative, Inc.) WildBlue Communications,  Inc.* 
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Workflow Processing Scheme 

New Mexico acknowledges the importance of understanding data reliability and integrity as the Provider 
data are processed for NTIA submittal. The NMBB Data Workflow and Processing Scheme include four 
broad stages: 

1. Obtain – Acquire raw Provider data. 
2. Validate – Check for internal data consistency and for consistency with external data sources. 
3. Process – Develop Geographic Information System (GIS) data and update NTIA Geodatabase. 
4. Report – Submit the final Geodatabase to NTIA. 

 
These stages and their relationships are depicted in the diagram below, and are discussed in the 
following sections. The April 1, 2011 Data Workflow and Processing Scheme, V3.0 reflects modifications 
to the procedures submitted for the September 30, 2010 Scheme, V2.0. 
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Figure 1 New Mexico Broadband Workflow and Processing Scheme 
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Data Collection 

Provider Engagement 

The NM Department of Information Technology established contact with each New Mexico Broadband 
Provider and negotiated a signed NDA with the State and with EDAC, if required. 
 

Data Request 

EDAC sent an e-mail requesting broadband data to seventy NM Internet Service Providers (ISPs) in 
February 2011 and a reminder e-mail in March. In addition to an NMBB Program overview and formal 
request for data, the message included a Web link for the NM Broadband Data Request Form (MS Excel 
Worksheet); this form included instructions for completing the eight data worksheets and for securely 
uploading Provider data to the EDAC Secure FTP site. 
 

Data Receipt 

EDAC created a Secure File Transfer Protocol (SFTP) site for broadband data upload, and created an 
account on the site for each NM Provider. Each Provider was assigned a unique username and 
password; this account information is stored in the NMBB SFTP Account Management form. 
 
Provider data arrive in numerous formats, including NMBB or Provider spreadsheets, shapefiles, CAD 
files, and text files. These data are downloaded from the SFTP site to the EDAC network. 
 

Provider and Data Tracking 

EDAC creates or updates the specific Provider record in a Provider Data Processing Tracking Form. 
Throughout the data process, each Tracking Form step is recorded with analyst initials and date of task 
completion. Steps include: 

 Record Provider name information and the assigned 2-digit Primary Key (PKey). 
 Record the Holding Company Name, DBA Name, FRN (if available), and whether Community 

Anchor Institutions data are provided. 
 Record type of files submitted; date of data submission and the initials of the receiving GIS 

analyst; and how data were submitted (e.g., FTP or physical medium). 
 

Provider Database 

EDAC evaluates the uploaded Provider data for consistency with the NTIA data model and creates 
database-format tables. 
 

Data Validation 

Data Assessment 

EDAC assesses the submitted data for completeness according to the National Broadband Map Data 
Transfer Model V1.0.2: 

 Identify fields (names, types); 
 Fill in missing data, if possible; and 
 Check field codes, and standardize the values where appropriate. 
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Data Export 

If the data are incomplete, based upon the above assessment steps, EDAC performs the If required 
steps, below; otherwise, EDAC proceeds with data validation. Changes and assumptions are 
documented. 
If required: 

 Return data in standardized format to the Provider for completion. 
 Receive modified data back from Provider. 
 Re-import data. 

 

Data Validation 

EDAC performs the final data validation for each Provider’s data set: all missing data filled in; all field 
codes checked and standardized where appropriate. 
 

Data Processing 

GIS Data 

EDAC creates and verifies Provider-specific GIS data, using ArcGIS 10 software and third-party data sets: 
 New Mexico Road Centerline (NM RCL) data files. 
 NM Telephone Exchange Boundaries 911. 
 U.S. Census TIGER/Line shapefiles. 
 TomTom MultiNet Road shapefiles. 
 ESRI Road shapefiles. 
 ESRI Cable Boundaries data file. 

 
Ancillary consistency checks include comparison with other data sources that are available through the 
New Mexico geospatial clearinghouse – Resource Geographic Information System (RGIS; 
http://rgis.unm.edu). 
 
EDAC processes the GIS data according to the National Broadband Map Data Transfer Model V1.0.2. 
 
Middle Mile Points 

 ISPs provide the geographic coordinates for Middle Mile points. Those points are exported as 
shapefiles and a spatial join is performed against Census Blocks to obtain FULLFIPSID. 

 Data sets are further processed by adding required fields based on the NTIA Data Model. 
 
Census Blocks 

 If an ISP provides the Census Block IDs, then those tables are spatially joined with the Census 
Data and the blocks are extracted. Then, the Census Blocks (Area < 2 sq mi) are extracted. 

 If the ISP provides address-specific data, those addresses are geocoded against the New Mexico 
Road Centerline (NM RCL) address locator. Unmatched addresses are processed against third-
party data sets, such as the TomTom MultiNet Road data, which were purchased by the State as 
a part of the NMBB project, and ESRI Road data. All of those matched records are appended 
together to obtain a single address data set. The address points are aggregated spatially to the 
Census Blocks, and the Census Blocks (Area < 2 sq mi) are extracted. 

 If an ISP provides shapefiles of Census Blocks, EDAC verifies those to make sure they are less 
than 2 sq. mi. in area. 
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 If an ISP provides their telephone exchange boundaries instead of addresses, then those 
boundaries are verified with the NM Telephone Exchange Boundaries 911 data set, and Census 
Blocks (Area < 2 sq mi) that lie within those boundaries are extracted. If an ISP provides the 
CO/RT locations, then a buffer of 1800 ft is drawn, and the Census Blocks (Area < 2 sq mi) that 
intersect with the buffer area are extracted. 

 If an ISP provides service areas instead of addresses for Cable, then the service areas are verified 
with the ESRI Cable Boundaries data file. Census Blocks (Area < 2 sq mi) that lie within the 
boundaries are extracted. 

 Data sets are further processed by adding required fields based on the NTIA Data Model. 
 
Road Segments 

 If an ISP provides address-specific data, EDAC geocodes those points (using a process similar to 
that explained above in Census Blocks). The address points are aggregated spatially to Census 
Blocks, and the blocks with area greater than 2 sq mi (Area > 2 sq mi) are extracted. NM RCL 
roads within those Census Blocks are exported, and the geocoded address points are spatially 
joined with adjacent road segments within a distance of 25 ft. The road segments with joined 
address points are selected and exported. 

 If an ISP provides road segment data with address ranges, any one of the address range values 
(TO/ FROM) for the road is taken and the data are geocoded. Or, the address file is joined with 
the NM RCL roads, based on Street Name, City, and Postal Code and the matched records are 
extracted. 

 If an ISP provides Tiger/Line roads data, those roads are extracted from the U.S. Census 
Tiger/Line shapefile by joining them based on the TLID (Tiger/Line ID). NM RCL road data that 
match the Tiger/Line roads are exported.  

 If an ISP provides Telephone Exchange Boundaries or CO/RT locations or Cable service area 
boundaries, road segments for these data sets are not processed due to uncertainty about the 
NMBB procedures for these cases. NM DoIT and EDAC will request clarification from NTIA. 

 Data sets are further processed by adding required fields based on the NTIA Data Model. 
 

Community Anchor Institutions 

 EDAC created an Anchor Geodatabase that has data on all the Community Anchor Institutions, 
such as Schools, Libraries, Health Care, Higher Education, Public Safety Facilities, and 
Government Agencies throughout the State of New Mexico. These data were obtained from 
different sources, including the Public Schools Facilities Authority (PSFA), New Mexico State 
Library, Homeland Security Information Program (HSIP), and NM Resource Geographic 
Information System Program (RGIS). 

 The Anchor Geodatabase is further processed to meet the NTIA requirements. NCES IDs for 
schools, IPEDS IDs for higher education, and IMLS IDs for libraries are obtained from the 
respective Web sites and are joined with records in the geodatabase.  

 Broadband data provided by the ISPs are also included in the geodatabase. 
 
Wireless 

 If an ISP has multiple spectrums, the provided polygon is duplicated for each spectrum and then 
appended together to obtain a single shapefile with stacked geometry.  

 If an ISP provides tower location (address or coordinates) and transmit radius instead of 
shapefiles, those locations are mapped and a buffer is drawn with the transmit radius.  

 Data sets are further processed by adding required fields based on the NTIA Data Model. 
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Overview 

 If an ISP provides the Subscriber Weighted Nominal (SWNOM) Speed of respective technology 
types for the counties it serves, those values are joined with the County boundary file from the 
U.S. Census Tiger/Line shapefiles.  

 If an ISP provides the technology of transmission, number of subscribers, and the maximum 
advertised speed for the Counties it serves, the SWNOM Speed is calculated and the values are 
joined with the County boundaries shapefile. 

 These county files from each ISP are appended together to obtain a statewide stacked 
geometry. Data are further processed by adding required fields based on the NTIA Data Model. 

 

GIS Data Verification, Updates, and Edits 

Processed data are developed as Provider-specific spreadsheet and GeoPDF products. As the first step in 
New Mexico’s Provider feedback loop, EDAC places each Provider’s products on the SFTP site and 
requests that Providers verify accuracy and identify needed edits and corrections. Ten (10) ISPs 
responded to the verification request in the April 1, 2011 data submission cycle. 
 
GIS data are updated and edited, based on Provider feedback, and modified data products (spreadsheet 
and GeoPDF) are delivered to the Provider through the SFTP site for final verification and to complete 
the feedback loop. 
 

NTIA Geodatabase Preparation 

EDAC produces a final “clean” GIS data set from the processed and Provider-specific, versioned feature 
data sets, and then prepares the NTIA Geodatabase from these finalized GIS data. Crowd sourced data 
were not used for preparation or validation. 
 

NTIA Geodatabase Validation 

EDAC validates the geodatabase by performing the validation checks provided below and by running the 
geodatabase through the SBDD_CheckSubmission tool. EDAC then assigns Quality Assurance/Quality 
Control (QA/QC) values. 

 Repair Geometry. 
 Validate Topology. 
 Check Provider identification fields by Frequency tool and Summarize tool.  
 Check for Null values in Transmission Technology codes, PROVIDER_TYPE, FULLFIPSID, 

STATEFIPS, COUNTYFIPS, TRACT, BLOCKID fields. 
 Check Maximum advertised and typical down/upload speed fields for null values and for valid 

domain values. MAXADDOWN/TYPDOWN < MAXADUP/TYPUP; MAXADDOWN < ‘0’ OR 
MAXADDOWN > ‘9’. 

 Check for SPECTRUM values <1 and >10. 
  

NMBB Report and Submittal 

Finalized NTIA Geodatabase and Metadata 

EDAC finalizes the Geodatabase per NTIA standards (National Broadband Map Data Transfer Model 
V1.0.2) and creates the associated metadata. 
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NMBB Program Manager 

The NMBB Program Manager receives the finalized Geodatabase through the SFTP site and approves the 
files for submittal to NTIA. 
 
EDAC completes and delivers all files to the NMBB Program Manager, as required by the Program. Files 
include correspondence logs with NM Providers, documentation for Web mapping activities, and the 
Provider-specific Data Processing Tracking Form. 
 

NTIA Submittal 

The Geodatabase and required files (data transmittal memorandum, Provider data request template 
[not a required file], data package spreadsheet, and check-submission receipt) are uploaded, using the 
FCC/ NTIA SFTP site. 
 

NMBB Map Layers 

EDAC creates GIS map layers from the Geodatabase and publishes them to the New Mexico Broadband 
Program Mapping site, www.nmbbmapping.org/mapping/. 
 

Response: NTIA Submission Summary 

NM DoIT and EDAC developed a document template to respond to the NTIA Submission Summary, both 
to address NTIA-identified issues or gaps and to request clarification and additional information. New 
Mexico responds within one week of receiving NTIA’s Submission Summary. 
 

NMBB System Security 

System Security 

The NM Broadband Server is a fully patched Windows Server 2008. The server is protected by Symantec 
Endpoint Protection and a double firewall. 
 
The first layer of firewall protection is a Cisco hardware firewall that protects the Server from any 
intrusion from outside the EDAC network. This firewall only allows connections on Ports 80 and 22. 

 Port 80 allows Web browsing. 
 Port 22 allows Secure FTP. SFTP service is fully encrypted with SHA1 stored passwords. 

 
The Windows software firewall is configured to allow access on Ports 80, 22, 443, and 3389. 

 Port 443 gives EDAC developers the ability to configure ArcGIS Server from within the EDAC 
network. 

 Port 3389 gives EDAC system administrators the ability to configure the base Windows server 
from within the EDAC network. 

 

Server Connections 

Connect to the Server from the outside: 
 HTTP: No authentication (simple Web browsing). 
 SFTP: Authentication required and fully encrypted. 

 
Connect to the Server from within the EDAC network: 

 HTTPS: Authentication required and fully encrypted. 
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 RDP: Authentication required and fully encrypted. 
 SMB: Port 445, Windows file-share port. 

 
Virtual Machine and Networked Drive Clones and Back-ups 

The NMBB Virtual Machine (VM) is a dedicated server. 
 
Back-up: Development Server (not published) 

 Daily: A differential back-up to a tape server is performed; the tape server is connected to a tape 
library. 

 Friday/Weekend: A full back-up of the networked drive is performed to the tape server. [Web 
Application (copy), Database (copy), and Data Deliverables (copy)] 

 
Clone: Virtual Machine (published) 

 Daily: A new clone is created each morning by deleting the “old” version and recreating the 
clone. Each clone is a complete copy of the currently running VM. 

 Friday/Weekend: A complete clone of the VM is copied to an external hard drive and handed off 
to an EDAC manager for off-site storage. [Web Application, SFTP Site, Database, NMBB Server 
Software, and Data Deliverables] A permanent storage facility is being negotiated (with the High 
Performance Computing Center). 

 

Physical Security 

NM Broadband Server physical security is accomplished through: 
 Controlled-environment floor space in a locked, code-protected room for system servers, and 
 An uninterrupted power supply (UPS). 

 

Lessons Learned 

Provider Feedback Loop 

EDAC identified and implemented several measures for more effective data collection. These included: 

 Developing and formalizing an interaction process between data providers and EDAC. This helps 
to get both data and feedback from the ISPs during data collection, processing, and NMBB-
feedback-to-Provider processes. This also may help to obtain data from ISPs that are not 
interested in participating in the NMBB Program. 

 Modifying the data request template, based on the updated NTIA data model. The template will 
be reviewed for each round of data collection, prior to requesting data from ISPs. 

 Setting deadlines for receiving data from ISPs because processing requires time depends on the 
type of data received. Also, this allows EDAC time to submit feedback maps to ISPs for their 
verification and to update the data according to changes in NTIA data models. 

 

Data Validation and Processing 

EDAC also addressed issues regarding data validation and processing. These included: 

 Updating data validation procedures to meet the requirements of the data model. 

 Learning to create and update metadata in ArcGIS 10, since editing metadata is different in 
ArcGIS 9.3. 

 Researching and learning the propagation models for processing Satellite and Wireless data that 
are received from New Mexico Providers.  
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NMBB Server (VM) Clones 

Initially, the NMBB Virtual Machine was cloned to an external hard drive every Friday morning. This 
schedule was modified to include a daily clone, as described above, to eliminate dependence upon the 
external drive (for example, to mitigate the potential loss from a damaged hard drive). Also, further 
analysis of the VM clone schedule led to encrypting the clone on the external hard drive. 
 

NMBB Web Map 

The New Mexico Broadband Map (www.nmbbmapping.org/mapping/) is developed as part of the NMBB 
Program for the State of New Mexico. This Web map displays all of the processed ISP broadband data 
that are submitted to NTIA for the National Broadband Map, and the processed statewide satellite-
service data. 
 
Figure 2, below, is a screen-capture image of the New Mexico Broadband Map showing DSL, Cable, 
Fiber, and Fixed Wireless broadband-coverage layers on the Streets base map. Satellite and Mobile 
Wireless layers are not displayed. Tools include: layer selection; base map selection; dynamic legend; 
slider-bar and custom zoom; drag-and-drop and directional pan; full, previous, and next extent; identify; 
find address; scale bar; and print map. Additionally, a feedback tool, help (online user guide), program 
information, and New Mexico’s disclaimer are provided. 
 

 
Figure 2 NMBB Program: New Mexico Broadband Map, www.nmbbmapping.org/mapping/ 
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Table of Abbreviations and Acronyms 

API Application Programming Interface 

BB broadband 

CAD Computer-aided Design 

CO/RT Central Office/Rural Terminal 

DBA Doing Business As 

DoIT [NM] Department of Information Technology 

DSL Digital Subscriber Line 

EDAC [UNM] Earth Data Analysis Center 

FCC Federal Communications Commission 

FGDC Federal Geographic Data Committee 

FRN FCC Registration Number 

ft foot 

FTP File Transfer Protocol 

GDB, gdb Geodatabase; Geodatabase file extension 

GIS Geographic Information Systems 

HSIP Homeland Security Information Program 

HTTP Hypertext Transfer Protocol 

HTTPS Hypertext Transfer Protocol Secure 

ID [unique] identifier 

IE [Microsoft] Internet Explorer 

ISP Internet Service Provider 

NDA Non-Disclosure Agreement 

NM New Mexico, State of New Mexico 

NMBB New Mexico Broadband Program 

NM DoIT New Mexico Department of Information Technology 

NM RCL New Mexico Road Centerlines 

NOFA Notice of Funding Availability 

NTIA National Telecommunications and Information Administration 

PDF, pdf [Adobe] Portable Document Format and file extension 

QA/QC Quality Assurance/Quality Control 

RDP Remote Desktop Protocol 
SBDD State Broadband Data and Development Program 

SFTP Secure File Transfer Protocol 

SHA1, sha1 Secure Hash Algorithm 1 

SMB Server Message Block 

sq mi square mile(s) 

SWNOM Subscriber Weighted Nominal [Speed] 

TIGER [U.S. Census] Topologically Integrated Geographic Encoding and Referencing (system) 

TXT, txt Text file extension 

UNM The University of New Mexico 

UNM EDAC The University of New Mexico Earth Data Analysis Center 

UPS uninterrupted power supply 

VM Virtual Machine 

Web World Wide Web 

XLS, xls Microsoft Excel file extension 

ZIP, zip Zipped file extension 
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NEVADA COVER LETTER 

 
April 1, 2011 
 
Ms. Anne W. Neville 
SBDD Grant Program Director 
National Telecommunications and Information Administration 
U.S. Department of Commerce 
1401 Constitution Avenue, NW Room 4716 
Washington, DC 20230 
 
Dear Ms. Neville: 
 
It is with highest regard that the collective stakeholders of Connect Nevada offer congratulations to 
the U.S. Department of Commerce’s National Telecommunications & Information Administration 
(NTIA) on the recent release of the National Broadband Map.  This extraordinary milestone 
demonstrates the intense and joint effort of the NTIA, FCC, state governments, industry, and non-
profits like Connected Nation and will serve as a key tool for the American public and policymakers 
resulting in smarter investments and targeted state and local broadband policies and programs.  We 
are proud of the role that Connect Nevada has played in creating such a powerful tool that will 
surely benefit not just Nevadans, but consumers and businesses nationwide. 
 
Therefore, Connected Nation, as the State Broadband Designated Entity, in partnership with the 
Nevada Governor’s Office and Nevada Broadband Task Force, is pleased to present this submittal 
of the state of Nevada’s State Broadband Data and Development (SBDD) Grant Program, known 
as Connect Nevada. 
 
These artifacts should be found to be compliant with the April 1, 2011, deadline for the semi-annual 
data update and in accordance with the terms of the July 1, 2009, Notice of Funds Availability 
(NOFA) and all subsequent clarifications pertaining to delivery of State-Level Mapping of 
Broadband Service Availability.  This packet includes: 
 
Inventory of Deliverables, Connect Nevada: April 1, 2011 
 
NOFA Requirement Data Transfer Model Data Description 
Appendix A:  1(a)(i) BB_Service_CensusBlock Broadband Service Availability of 

Facilities-Based Providers in 
Census Blocks of No Greater 
Than Two Square Miles in Area 

Appendix A:   1(a)(ii) BB_Service_RoadSegment Broadband Service Availability of 
Facilities-Based Providers by Road 
Segment in Census Blocks Larger 
in Area Than Two Square Miles 
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Appendix A:   1(b) BB_Service_Wireless Broadband Service Availability of 
Wireless Services Not Provided to 
a Specific Address 

Appendix A:   3(b) BB_ConnectionPoint_MiddleMile Broadband Service Infrastructure 
Middle-Mile and Backbone 
Interconnection Points 

Appendix A:   4 BB_Service_CAInstitutions  Community Anchor Institutions-
Listing 

Appendix A:   4 n/a Community Anchor Institutions-
Narratives 

VII.A.1(a) n/a Accuracy and Verification Report 
n/a DataPackage.xlsx Worksheets of Contact 

Information, Data Dictionary, and 
Provider Summary Table 

n/a n/a Broadband Provider Roster and 
Participation Status 

 
In addition, this data update submission should be found to be compliant with the additional 
program requirements instituted by the National Telecommunications and Information 
Administration since the time of the October 2010 SBDD data submission for the Connect Nevada 
program.  Specifically, these new requirements are: 

 
SBDD Data Transfer Model 
The submission of the broadband dataset for April 1, 2011, is contained within the SBDD 
Data Transfer Model as released on the Grantee Workspace on January 14, 2011. All efforts 
have been made to comply with formatting, domain, and metadata requirements to include 
as much information on each provider as possible.  
 
Additional Submission Guidance 
This submission also includes the updated DataPackage spreadsheet with enhanced provider 
listings as well as satisfactory outputs from the SBDD_Check toolbox to ensure fewer 
unexpected values with the submitted broadband datasets prior to federal processing for the 
National Broadband Map update. 

 
It is therefore with great pleasure that the Connect Nevada program submits this April 2011 semi-
annual data update under the State Broadband Data and Development Grant Program.  We will 
continue to implement the joint purposes of the Recovery Act and the Broadband Data 
Improvement Act (BDIA) by gathering comprehensive and accurate state-level broadband mapping 
data, developing state-level broadband maps, aiding in the development and maintenance of the 
National Broadband Map, and undertaking statewide initiatives for broadband planning. 
 
Broadband Service Availability – Provider Outreach and Verification 
 
This data update submission under the SBDD includes the participation of approximately 94.55% of 
the Nevada provider community, or 52 of 55 total providers.  Of the 52 participating providers, 22 
supplied an update to their network or coverage area(s), while 29 have reported no change. The 
remaining provider previously supplied data but was non-responsive in the April 2011 update effort; 
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therefore its previous dataset is being put forward as part of this compilation. A complete roster by 
provider depicting participation status and contact record is contained herein.  The remaining three 
providers are currently in some form of progress toward data submission but were not able to either 
submit or verify coverage areas at the time of this submission.    
 
As the aforementioned roster and attached methodology documentation will attest, it is the 
collective opinion of the Connect Nevada principals that all commercially reasonable efforts were 
made to account for 100% of the known Nevada broadband provider community, pursuant to this 
semi-annual data update submission. 
 
Connect Nevada has also continued to perform broadband verification activities through several 
means. In addition to confirmation of service area(s) by each provider, Connect Nevada conducts 
field validation efforts; between the October 2010 and this April 2011 data submission 27 (49.09%) 
providers have been validated through field verification activities. Additional details on verification 
activities are contained within the Field Validation Narrative. 
  
At the program’s inception, Connect Nevada launched a website to create awareness about the 
initiative. Connectnv.org continues to serve a prominent role in the outreach and data collection 
effort.  This program asset provides a way for the general public to participate in the process by 
offering interactive tools for users to test their connection speed, submit broadband inquiries, or 
contact a program representative.   
 
As an indicator of stakeholder penetration, the Connect Nevada website encountered 1,306 unique 
visits during this reporting period (3,516 total to date for the life of the grant awarded on December 
20, 2009).  Additionally, this pronounced Web activity netted 3 broadband inquiries over this same 
reporting period (24 grant inception to date).  The website also provides the BroadbandStat 
application, which allows the consumer to confirm or dispute the coverage represented on the 
broadband inventory map. These consumer-initiated actions are facilitated through the Connect 
Nevada website and the Connect Nevada Interactive Mapping Tool (BroadbandStat) that offer the 
citizens the vehicles to provide information regarding availability in their respective service area, 
either in affirmation or contest of the reported data represented in the Connect Nevada mapping 
artifacts.  Since the initial data collection and release of corresponding maps, feedback in the form of 
broadband inquiries has allowed Connected Nation to identify additional areas that are in need of 
field validation, which is scheduled as soon as possible.  
 
Community Anchor Institutions 
 
Connect Nevada has established an ongoing mechanism for gathering data on the location and 
broadband connectivity of Community Anchor Institutions (CAI), in accordance with the data 
requirements of the SBDD NOFA Technical Appendix.   
 
In conjunction with the Nevada Broadband Task Force, outreach was conducted during this data 
update reporting period by Connect Nevada to continue identification of existing, centralized 
sources for CAI connectivity data.  Outreach was coordinated to distribute the CAI survey to 
institutions throughout the state through multiple methods including a customized online survey 
available on the Connect Nevada website.  Connect Nevada continues to work in close coordination 
with statewide associations such as the Nevada System of Higher Education, Nevada State 
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Superintendent, Nevada State Library and Archives, and Nevada Rural Hospital Partners to promote 
the importance of broadband connectivity at anchor institutions and participation in this data 
collection process.   
 
While we continue to document institutions and the related addresses, the connectivity data 
collected in most categories remains incomplete at this time.  Connect Nevada will be implementing 
a number of new processes to increase participation including launching a CAI newsletter to 
connect communities across the state, increasing industry-specific planning to target new community 
contacts, and revising the CAI portion of our website to increase visibility and content.  
Additionally, Connect Nevada will continue working closely with members of the Nevada 
Broadband Task Force to reach CAI associated with their respective sectors.  From our work in 
Connect Nevada, as well as other states, we recognize the great value of this data to future 
collaboration efforts within the state and its value to the recently released National Broadband Map.  
We plan to continue to bring best practices to the Connect Nevada efforts, along with an investment 
of both human and technical resources required, to reach our goal of increasing the data that is 
secured and reported as part of this process. 
 
In acquiring both broadband availability and CAI data within the state of Nevada, Connected 
Nation has previously engaged all federally recognized tribal lands in the area covered by the 
Connect Nevada SBDD grant and reported that outreach as part of past submissions.  Throughout 
the next reporting period Connect Nevada plans to engage directly with these tribal communities 
and will also conduct affirmative outreach with Native American tribal organizations that are active 
within the area.  Connect Nevada understands the connectivity challenges facing these tribes, and we 
have identified a need to include their data as part of our upcoming submissions. 
 
 
The Connect Nevada program exists to improve data on the deployment and adoption of 
broadband services and to assist in the extension of broadband technology across all regions of the 
great state of Nevada, as well as the United States through contribution to the National Broadband 
Map.  We look forward to the continuing work ahead. 
 
Respectfully submitted, 
 
 
 
 
Thomas W. Ferree 
Chief Operating Officer 
Connected Nation, Inc. 

dclark
Cueball
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DATA ACQUISITION:  NEVADA COMMUNITY ANCHOR INSTITUTIONS  

In this third reporting period of the SBDD, Connect Nevada, working in close coordination with 
the Nevada Broadband Task Force, has established an ongoing mechanism for gathering data on the 
location and broadband connectivity of Community Anchor Institutions (CAI), in accordance with 
the data requirements of the SBDD NOFA Technical Appendix.  During this reporting period 
Connect Nevada has continued to focus efforts on conducting outreach and raising awareness of 
this important project. 
 
Connect Nevada has continued to identify and process CAI data obtained through an ongoing 
statewide outreach campaign.  Physical address information continues to be augmented through 
manual sourcing and geocoded by Connect Nevada through ESRI ArcGIS software. 
 
Connect Nevada continues to utilize a customized online survey hosted through SurveyMonkey, 
with a landing page on the Connect Nevada website that was developed during the first reporting 
period.  This survey, in combination with a customized data gathering spreadsheet, was distributed 
to a targeted list of CAI throughout the state.  Connect Nevada will continue to use these data 
gathering tools for future targeted outreach efforts throughout the coming months leading up to the 
next reporting period.  These materials are customized to fit the CAI categories as defined in the 
SBDD NOFA.   
 
The survey can be accessed at this link using the following password: 
http://connectnv.org/mapping/Community_Anchor_Institution_Data_Collection.php 
Password:  CAI_NV_6549 
 
Connect Nevada has worked diligently during this reporting period to conduct research as part of an 
ongoing process to identify existing, centralized sources for CAI connectivity data.  To date no 
centralized sources of connectivity data have been located in the state, but we continue outreach to 
sources that may have possession of this data. 
 
In tandem with these efforts to identify existing data, Connect Nevada continues to identify key CAI 
contacts among all CAI categories in an effort to distribute and promote the online survey and raise 
awareness of the importance of CAI broadband connectivity.  
 
In Nevada we are working with the state Superintendent of Public Instruction, Nevada Hospital 
Association, Nevada System of Higher Education, and the Nevada State Library and Archives.  
Survey responses have been slow during the last reporting period but each of these organizations is 
willing to work with us to identify new survey respondents and to continue distribution of 
information about our project. 
  
Connect Nevada has an ongoing mission to educate CAI throughout the state on the importance of 
participating in the project.  Participation by these institutions will raise awareness about the 
importance of broadband connectivity and the need to report the requested data for inclusion on the 
National Broadband Map.  To assist with our data collection efforts, Connect Nevada is developing 
a CAI newsletter to be distributed quarterly beginning in April 2011.  The newsletter will highlight a 
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CAI in Nevada, encourage institutions to share their data, and highlight the National Broadband 
Map. 
 
The greatest challenge with collecting this data continues to be the difficulty in securing CAI 
broadband connectivity data.  Connect Nevada will continue its ongoing work with the Nevada 
Broadband Task Force and key organization contacts in an effort to raise awareness of this project 
among CAI.  An update on our current data collection efforts and an overview of our data will be 
provided to the Nevada Broadband Task Force within the next two months.  Several members of 
the Task Force have already expressed interest in elevating their role with data collection, and 
individualized spreadsheets will be created for these members to assist with this process. 
 
A CAI summary of all processed and submitted data is provided below: 
 

CAI Type Total 
Physical 
Address Lat/Long

Technology 
of 

Transmission
Download 

Speed 
Upload 
Speed

K-12 Schools 871 871 871 133 133 130
Libraries 90 90 89 24 22 22
Healthcare 73 73 73 25 32 32
Public Safety 103 103 103 3 3 3
Higher Ed Institutions 59 59 59 43 43 43
Other Government 695 695 695 45 46 46
Other Non-Government 1,304 1,304 1,272 2 2 2
Total 3,195 3,195 3,162 275 281 278

 
 
SBDD DATA SUBMISSION METHODOLOGY 

The submission of the broadband dataset for April 1, 2011, is contained within the SBDD Data 
Transfer Model and additional components as released on the Grantee Workspace on January 14, 
2011. Connected Nation has reviewed all literature that relates to the release and use of this data 
transfer model and recognizes that it does not replace or dictate how data is stored, processed, or 
displayed for the state or territory, as it is meant primarily as a means to transfer the broadband data 
from all states and territories and populate the National Broadband Map in a seamless fashion. 
Guidance from the Technical Mapping Guide, as released on the Grantee Workspace on March 24, 
2011, was also followed to ensure the completeness and validity of the submission through 
completion steps and checklists, completing the DataPackage spreadsheet, uploading broadband 
datasets into the Data Transfer Model, and checking the dataset using the SBDD_CheckSubmission 
receipt process.  
 
In addition to the narratives and methodologies contained herein, as well as the DataPackage.xls 
containing contact information, the data dictionary, and a provider summary table, the following 
feature classes are submitted within the SBDD Data Transfer Model for the state of Nevada. 



                                                                              Connect Nevada – Narratives and Methodologies 
 

 
April 1, 2011                                                                                                                                                  9 

   

Inventory of Deliverables, Connect Nevada: April 1, 2011 
 
NOFA Requirement Data Transfer Model Data Description 
Appendix A:  1(a)(i) BB_Service_CensusBlock Broadband Service Availability of 

Facilities-Based Providers in 
Census Blocks of No Greater 
Than Two Square Miles in Area. 

Appendix A:   1(a)(ii) BB_Service_RoadSegment Broadband Service Availability of 
Facilities-Based Providers by Road 
Segment in Census Blocks Larger 
in Area Than Two Square Miles. 

Appendix A:   1(b) BB_Service_Wireless Broadband Service Availability of 
Wireless Services Not Provided to 
a Specific Address. 

Appendix A:   3(b) BB_ConnectionPoint_MiddleMile Broadband Service Infrastructure 
Middle-Mile and Backbone 
Interconnection Points. 

Appendix A:   4 BB_Service_CAInstitutions  Community Anchor Institutions-
Listing. 

 
The provider data collected by Connected Nation on behalf of the state of Nevada have been 
formatted per the given specifications and uploaded into the appropriate feature classes of the 
SBDD Data Transfer Model. Wireline availability is contained within census blocks and road 
segments, wireless availability is contained as polygons of coverage areas, and middle-mile 
connections and community anchor institutions are contained as point data. All speed data is 
contained at the census block, road segment, or wireless polygon level of availability. All efforts have 
been made to comply with formatting, domain, and metadata requirements to include as much 
information as possible.  
 
Connected Nation has continued outreach to satellite providers on their availability, technology, and 
speed information, but it is not included in this submission dataset.  Additional information is 
necessary to be able to show where service satisfactorily exists in the state, rather than submitting 
the entire boundary of the state as the serviceable area.  Analysis information distributed and 
discussed with the satellite providers, as well as any additional guidance from the Program Office on 
the desired analysis for satellite-serviceable areas, will be implemented for the October 2011 data 
submission.  
 
 
NEVADA FIELD VALIDATION NARRATIVE 

Connected Nation focused a portion of its time on specific validation processes such as: 
 

• conducting random spectrum analysis studies throughout the state using an Avcom PSA-37-
XP spectrum analyzer; 

• conducting mobile speed tests throughout the state using an iPhone, Android (or other 
smart phone) as well as provider-specific aircards (Sprint 3G/4G, Clearwire et al); 
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• identifying pre-selected, provider-submitted wireless transmit tower sites and cross-
referencing data about that tower against the Federal Communications Commission (FCC) 
databases such as Antenna Structure Registration and/or the Universal Licensing System; 

• cross-referencing Federal Registration Number data against available FCC Form 477 data as 
well as the FCC COmmission REgistration System (CORES); 

• validating provider submitted data (for example: latitude/longitude) using a handheld 
Garmin eTrex Summit GPS unit or GPS enabled software such as Microsoft Streets and 
Trips; 

• locating physical wire-line attributes (such as remote terminals, CATV plant, etc.) and 
comparing them against provider submitted data; and 

• conducting on-net and off-net speed tests using the FCC portal at 
http://www.broadband.gov/qualitytest/about/ or using the Ookla Net Metrics enabled 
speed test utility located on each of Connected Nation’s state specific websites. 

 
Additionally, Connected Nation cross-referenced numerous public documents in order to ensure 
that all known broadband providers were located and contacted.  This included searching 
membership logs from the trade associations (WISPA, WCAI, PCIA, etc.), the Cable Television Fact 
Book, Public Utility Commission records, Public Service Commission records, Chamber of 
Commerce, etc. 
 
To date Connected Nation’s staff conducted on-site validation tests in Nevada on the following 
providers:  A&J Hardy Enterprises d.b.a. Comnet Computer Services and Peak Internet Services, 
Arizona Nevada Tower Corporation, AT&T, Baja Broadband LLC, CalNeva Broadband LLC, CC 
Communications, Charter Communications, Clearwire Corporation, Cox Communications, Great 
Basin Internet Services, High Speed Networks – Mound House LLC, Highlands Wireless Inc., Hot 
Spot Broadband Inc., KeyOn Wireless, Leap Wireless d.b.a. Cricket License Company LLC, Moapa 
Valley Telephone Company, Nextweb (Covad), Oasis Online Inc., Performance Computing 
Internet, Reliance Connects d.b.a. Rio Virgin Telephone & Cablevision, Satview Broadband Ltd., 
Schatnet Internet LLC, Sprint, United Cable Management, Vegas Wi-Fi Communications LLC, 
Verizon Wireless, and Yonder Media. 
 
During this reporting period, Connected Nation conducted 48 additional on-site validation tests 
with A&J Hardy Enterprises d.b.a. Comnet Computer Services and Peak Internet Services, AT&T, 
Baja Broadband LLC, Clearwire Corporation, Cox Communications, KeyOn Wireless, Leap 
Wireless d.b.a. Cricket License Company LLC, Moapa Valley Telephone Company, Nextweb 
(Covad), Reliance Connects d.b.a. Rio Virgin Telephone & Cablevision, Sprint, and Vegas Wi-Fi 
Communications LLC, and Verizon Wireless. 
 
From program initiation through this reporting period, Connected Nation has completed in-the-
field validation testing against 27 companies (out of a universe of 54 viable providers) totaling 
49.09% within the state of Nevada.   
 
 
ACCURACY AND VERIFICATION:  METHODOLOGY - PROVIDER VALIDATION 

Broadband providers maintain their service area data in many different formats, all in varying levels 
of complexity and granularity. In order to ensure that the data required by the NTIA is standardized 
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across all providers and that it is as accurate as possible, Connected Nation translates and formats 
the data that providers are able to supply into a GIS shapefile and produces maps for the provider to 
review.  The resulting map(s) and review process allow for providers to see their service area in a 
geographic format – for some providers, this is the first time they have seen maps of their 
broadband service area. Having the mapped service area allows providers to quickly identify any 
issues that appear in the data representation, whether the issue is in the data translation into a GIS 
format or from the original data collection and submission. Often data is provided from various 
sources and through the review and revision process, local engineers who operate the networks and 
work in the field are able to ensure that the tabular data that has been submitted is accurate and 
represents the real-world network extent. Any issues in how the service area is represented on the 
map(s) are remedied by Connected Nation, whether they are additions, removal of service, or any 
other revisions. Revised maps of service area representations are sent to the provider for review and 
approval; Connected Nation will revise data and return maps as many times as necessary until the 
provider is in agreement that the map represents their service area as accurately as possible. Once 
the review process has been completed and final approval of the data is provided, the data is deemed 
ready for NTIA submission. 
 
Once the data collection has been aggregated a statewide level, static maps of statewide and county-
level availability are produced and made publicly available. In addition, consumers can visit the 
interactive online tool, BroadbandStat, to create customized views of broadband service areas and 
analyze corresponding demographic information. Leveraging broadband service data on various 
platforms allows for public users, providers, and other stakeholders to review, scrutinize, and 
provide feedback on the represented data. This feedback becomes a validation method in itself as 
consumers submit inquiries to Connected Nation either affirming where service is not available or 
identifying areas where broadband service is shown on the map, but in actuality is not available. This 
allows for a follow-up to providers regarding revisions to the data as it is represented; it also allows 
for Connected Nation to identify locations where on-site visits may be necessary to complete field 
validation of available services. Public feedback on all forms of mapping products serves as a 
localized validation method for provider-supplied information and allows Connected Nation to 
resolve inaccuracies as they are identified to ensure that only the highest quality information is 
provided to stakeholders. 
 
Estimates derived from provider-validated data indicate that approximately 1.08% of Nevada 
households do not have terrestrial fixed broadband service available, and approximately 0.23%1 of 
Nevada households have neither mobile nor fixed broadband service available.2   
 
Within rural areas of the state, results derived from provider-validated data indicate that 
approximately 7.66% of rural Nevada households do not have terrestrial fixed broadband service 

                                                 
1 In accordance with NTIA’s definition of available broadband service as specified in the SBDD NOFA, this estimate 

includes both terrestrial fixed and mobile broadband service, if the service offers download speeds of at least 768 Kbps 
and upload speeds greater than 200 Kbps. 

2 Due to the nature of the SBDD data collection methodology as defined by the NTIA and based on both census 
block geographic units and street segment data, the estimates of broadband availability derived from provider-validated 
data may include an overstatement of the actual number of households with broadband availability.  Under the census 
block-based data collection method, a provider will typically report broadband availability for an entire census block 
whether its network is present across the whole or only a subset of that census block.  This potential overestimation at 
the census block level can be amplified as the data is aggregated across the entire state. 
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available, and approximately 1.69%3 of rural Nevada households have neither mobile nor fixed 
broadband service available.4   
 
 
WIRELESS METHODOLOGY 

 
Broadband Service Availability in Provider’s Service Area 

Wireless Services Not Provided to a Specific Address 
 
Data solicited from a fixed wireless provider to create propagation models include, but are not 
limited to: 

1. The name of the structure 
2. Whether the transmitting device is operational or proposed 
3. The maximum advertised downstream speed, the maximum advertised upstream speed 
4. The typical downstream speed, the typical upstream speed (peak periods for both) 
5. The frequency range of spectrum being used (as prescribed by NTIA) 
6. The primary population center(s) being served (for geopolitical boundary reference) 
7. The physical address of the transmit site (in the event latitude/longitude is unavailable from 

the provider this allows a quick reference point for geocoding) 
8. Latitude in either Degrees, Minutes and Seconds and/or in Decimal Degrees (typically 

received as NAD 27 or NAD 83)  
9. Longitude in either Degrees, Minutes and Seconds and/or in Decimal Degrees (typically 

received as NAD 27 or NAD 83)  
10. Antenna pattern (e.g. omni-directional, 180°, 120°, 90°, etc.) 
11. Azimuth of antenna (e.g. 360° with magnetic declination if known) 
12. Approximate transmit radius (in feet, miles, or kilometers) 
13. Polarity of transmit antenna (Vertical or Horizontal) 
14. Transmit antenna gain (in dBi) 
15. Line loss (applicable only to providers using coax, heliax, waveguide or other forms of 

cabling – excludes power-over-Ethernet devices) 
16. Mechanical and/or Electrical beam tilt (if applicable) 
17. Equipment Manufacturer (allows easy cross-reference against manufacturer’s specification 

sheet) 
18. Power output of the transmitting device (if unknown, FCC standards or manufacturer 

specifications are applied) 
19. AMSL at base of tower site 
20. Antenna centerline AGL (height of antenna above ground level measured at the centerline 

of the actual antenna) 
21. Foliage factors (Evergreens/Deciduous and percent of ground cover) 

                                                 
3 See footnote 1. 
4 See footnote 2. 
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22. Ground Clutter (primarily used in rural areas to account for foliage and in metropolitan areas 
to account for types and heights of buildings if known)   

23. Average gain of receive antenna 
24. Receive antenna is estimated at height above average terrain (HAAT) of 6.2 meters/20 feet 
25. Federal Registration Numbers (if applicable) which may allow opportunities to cross-

reference and/or obtain additional data from the Federal Communications Commission 
Universal Licensing System and the COmmission REgistration System 

 
Propagation modeling is an empirical mathematical formulation for the characterization of radio 
wave propagation as a function of frequency, distance, and other conditions. Propagation 
software(s) typically use the Irregular Terrain Model (also known as Longley-Rice) of radio 
propagation for frequencies between 20 MHz and 20 GHz. This model is based on electromagnetic 
theory and statistical analyses of the combination of terrain features and radio measurements, then 
predicting the median attenuation of a radio signal as a function of distance and the variability of the 
signal in time and in space.  For metropolitan areas, the software can typically be adjusted to use the 
Okumura-Hata model which accounts for predicting the behavior of cellular transmissions in areas 
where buildings are the primary obstructions. The resulting product from either model depicts a 
graphical illustration of the theoretical propagation characteristics of a selected frequency range 
based on defined variables (receiver sensitivity of the home/mobile device, foliage factor, and digital 
elevation terrain input). 
 
 
BROADBAND INQUIRIES METHODOLOGY 

Connected Nation collects consumer feedback in the form of broadband inquiries. These inquiries 
represent any type of communication received from the public regarding broadband service. Once 
broadband inquiries are received across the state, this information is overlaid with the broadband 
availability information which was collected through the SBDD program.  This allows for a real-
world comparison of the broadband landscape to the information received from broadband 
inquiries.  Broadband inquiries are able to provide three types of information:  1) Residents who do 
not have broadband but want it.  2)  Residents who have broadband but want a different provider.  
3)  Residents who do not have broadband, but the broadband inventory maps indicate that they do. 
 
Through the collection of broadband inquiries, a visual demand for broadband is presented.  This 
visualization allows Connected Nation the ability to validate broadband availability maps for 
accuracy.  If residents within a region state that they are without broadband, but the broadband 
inventory maps show otherwise, this allows Connected Nation to approach the providers within that 
area in an effort to trim down their coverage to more accurately represent real-world availability on 
the ground.  On the other hand, if there is a region in the territory in which broadband is not 
available, the broadband inquiries allow providers close to that region to see where they can 
successfully expand their broadband networks, leading to a high return on investment.  In short, the 
higher number of inquiries leads to a higher level of certainty in regard to the broadband availability 
maps.  Since the initial data collection and release of corresponding maps, feedback in the form of 
broadband inquiries has allowed Connected Nation to identify additional areas that are in need of 
field validation, which are scheduled as soon as possible. Additional information on field validation 
can be found in the Field Validation Narrative. 
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The broadband inquiry process has been implemented in each of the Connected Nation state 
programs with successful results. Altogether Connected Nation has received over 16,000 broadband 
inquiries since 2007, allowing the state programs to evaluate each inquiry for broadband demand and 
data verification.  These inquiries are continuously examined against current broadband availability, 
updated every six months, to determine if previously unserved households have been expanded to 
and can now receive broadband at their residence. This database of broadband inquiries has also 
allowed the Connected Nation state programs to aggregate demand in concentrated areas to show 
providers the exact locations where the population has made it clear that they would purchase 
broadband if it was made available to them. Providers in the states have responded to this process 
and have expanded to areas knowing that their investment will be worthwhile. Data verification 
methods have also proven successful, as the state programs have been able to show those inquiries 
that indicate the broadband service areas are misrepresented on the map to providers, who then 
verify where service cannot reach in regard to that residence(s). The broadband coverage in these 
states has been altered to create a more accurate map based on the inquiries submitted by the public. 
 
During this reporting period, the Connect Nevada project has received a total of 3 inquiries (24 
grant inception to date).  As more inquiries are submitted to Connect Nevada, a more thorough 
validation of the broadband landscape can be performed, while also allowing providers to see which 
areas have a high demand for broadband adoption. 
 
 
BROADBANDSTAT METHODOLOGY  

BroadbandStat is an online, interactive mapping tool for viewing, analyzing, and validating 
broadband data. Developed through a partnership with ESRI, the market leader in geographic 
information system (GIS) software, BroadbandStat is a multi-functional, user-friendly way for local 
leaders, policymakers, consumers, and technology providers to devise a plan for the expansion and 
adoption of broadband.  
 
First and foremost, BroadbandStat allows consumers to locate their residence and identify providers 
that offer broadband Internet service to that location. The interactive platform allows for users to 
build and evaluate broadband expansion scenarios using a wealth of data, including education and 
population demographics, broadband availability, and research about the barriers to adoption.  
 
New functionality in BroadbandStat allows the consumers to provide feedback on the broadband 
data displayed on the interactive map.  Through the collection of this feedback, a visual demand for 
broadband is presented.  This visualization allows the Connected Nation state programs the ability 
to validate the broadband availability for accuracy.  If residents within a region state they are without 
broadband, but the interactive map shows otherwise, this allows Connected Nation to approach the 
providers within that area in an effort to trim down their coverage to more accurately represent real-
world availability on the ground.   
 
The Connect Nevada project launched BroadbandStat on June 3, 2010, and has received a total of 
1,054 visits to date, of which 480 occurred this reporting period. 
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SPEED TEST METHODOLOGY 

The 81 speed tests that are represented in the Connect Nevada Speed Test Report during this 
reporting period (272 grant inception to date) are the result of a partnership between Connected 
Nation and Ookla Net Metrics. Utilizing this relationship increases the level of confidence in the 
data being collected and provides for a far greater sample size than could be collected by a single 
testing site. 
 
Ookla owns and operates Speedtest.net, as well as develops and deploys speed tests, such as the 
Connect Nevada speed test website, for partners around the world. This network of sites that is 
developed and run on its testing technology provides Ookla with a vast dataset that, due to the 
variability of geographic information collected across the varying speed test sites, is geocoded 
utilizing Geo-IP technology. This technology allows for tests to be geocoded to points of 
aggregation, typically larger nodes across provider networks.  While there are hundreds of thousands 
of tests that have been conducted, the level of aggregation is only sufficient for county-level detail 
due to the test results being located at these larger nodes and not at an absolute location for each 
speed test. 
 
In an effort to validate broadband data from the Connect Nevada project, speed test information is 
collected throughout the state.  Speed tests provide speed information on the path taken through all 
networks (a provider’s network as well as additional networks) a local machine must connect to in 
order to reach the host test.  The benefit of this collection of speed information is two-tiered.  First, 
it allows for a comprehensive dataset of speeds, while also providing Connect Nevada with the 
information on where broadband services are available.  Second, unlike theoretical speed 
information which was received through the data collection process, the use of speed tests provide 
real-world information on the speeds that currently exist within the state of Nevada.   
 



Complete 66
Non-Responsive/Refused 0
In Progress 8

Count of Datasets by Viable Status 74
Total Unique Providers Represented 55

Provider Name Platform Status

NDA 
Execution 

Date Notes
Arizona Nevada Tower Corporation Fixed Wireless Data Added to Statewide Inventory 3/8/2010
Arizona Nevada Tower Corporation Fixed Wireless Data Added to Statewide Inventory 3/8/2010
AT&T Inc. ILEC/CLEC Data Added to Statewide Inventory 12/16/2009
AT&T Inc. Mobile Wireless Data Added to Statewide Inventory 12/16/2009
CC Communications Fiber Data Added to Statewide Inventory 6/11/2010
Cellco Partnership Mobile Wireless Data Added to Statewide Inventory 12/14/2009
CenturyLink ILEC/CLEC Data Added to Statewide Inventory 12/4/2009
Charter Communications Inc. Cable Data Added to Statewide Inventory 12/15/2009
Citizens Telecommunications Company of NeILEC/CLEC Data Added to Statewide Inventory 1/22/2010
Clearwire Corporation Mobile Wireless Data Added to Statewide Inventory 3/3/2010
Clearwire Corporation Fixed Wireless Data Added to Statewide Inventory 3/3/2010
High Desert Internet Services Fixed Wireless Data Added to Statewide Inventory
Hot Spot Broadband, Inc. Fixed Wireless Data Added to Statewide Inventory
InfoWest, Inc. Fixed Wireless Data Added to Statewide Inventory
LasVegas.Net LLC Fixed Wireless Data Added to Statewide Inventory
Leap Wireless International, Inc. Mobile Wireless Data Added to Statewide Inventory 4/6/2010
Performance Computing Internet Fixed Wireless Data Added to Statewide Inventory 3/19/2010
Schatnet Internet LLC Fixed Wireless Data Added to Statewide Inventory
Sprint Nextel Corporation Mobile Wireless Data Added to Statewide Inventory 1/14/2010
T-Mobile USA, Inc. Mobile Wireless Data Added to Statewide Inventory 1/8/2010
Vegas Wifi Communications LLC Fixed Wireless Data Added to Statewide Inventory 4/7/2010
CenturyLink Backhaul Backhaul Provider Only Processing Complete 12/4/2009
Cogent Communications, Inc. Backhaul Backhaul Provider Only Processing Complete
DIECA Communications, Inc. Backhaul Backhaul Provider Only Processing Complete 1/19/2010
Level 3 Communications, LLC Backhaul Backhaul Provider Only Processing Complete 12/14/2009
T-Mobile USA, Inc. Backhaul Backhaul Provider Only Processing Complete 1/8/2010
Zayo Bandwidth, LLC Backhaul Backhaul Provider Only Processing Complete
360networks Backhaul No Update to Provide 1/19/2010
Baja Broadband LLC Cable No Update to Provide 2/22/2010
Beehive Telephone Co., Inc. NV ILEC/CLEC No Update to Provide 4/5/2010
Beehive Telephone Co., Inc. NV Fixed Wireless No Update to Provide 4/5/2010
CalNeva Broadband, LLC Cable No Update to Provide 4/8/2010
CC Communications ILEC/CLEC No Update to Provide 6/11/2010
Cellco Partnership Backhaul No Update to Provide 12/14/2009
Cheetah Wireless Technologies, Inc. Fixed Wireless No Update to Provide
Citizens Telecommunications Company of NeBackhaul No Update to Provide 1/22/2010
Cox Communications Las Vegas, Inc Cable No Update to Provide 2/3/2010
Cox Communications Las Vegas, Inc Backhaul No Update to Provide 2/3/2010
DIECA Communications, Inc. Fixed Wireless No Update to Provide 1/19/2010
ETAN Industries Cable No Update to Provide
Filer Mutual Telephone Company ILEC/CLEC No Update to Provide 2/9/2010
Great Basin Internet Services, Inc. Fixed Wireless No Update to Provide 4/6/2010
High Speed Networks-Mound House, LLC Fixed Wireless No Update to Provide
Highlands Wireless Inc. Fixed Wireless No Update to Provide
KeyOn Communications, Inc. Fixed Wireless No Update to Provide 10/15/2009
Lincoln County Telephone System ILEC/CLEC No Update to Provide 3/5/2010
Lincoln County Telephone System Fiber No Update to Provide 3/5/2010
Moapa Valley Telephone ILEC/CLEC No Update to Provide 2/22/2010
Moapa Valley Telephone Fiber No Update to Provide 2/22/2010
Mt. Wheeler Power ILEC/CLEC No Update to Provide 4/5/2010
Mt. Wheeler Power Fixed Wireless No Update to Provide 4/5/2010
Oasis Online, Inc. Fixed Wireless No Update to Provide
Oregon-Idaho Telephone Company ILEC/CLEC No Update to Provide 2/25/2010
Qwest Communications Company, LLC Backhaul No Update to Provide 1/4/2010
Rio Virgin Telephone Co ILEC/CLEC No Update to Provide
Rio Virgin Telephone Co Fiber No Update to Provide
Rural Telephone Company ILEC/CLEC No Update to Provide 3/23/2010
Satview Broadband LTD Cable No Update to Provide 1/11/2010
Sprint Nextel Corporation Backhaul No Update to Provide 1/14/2010
tw telecom of nevada, llc Backhaul No Update to Provide 4/27/2010
United Cable Management, Inc. Cable No Update to Provide 4/13/2010
Vegas Wifi Communications LLC Backhaul No Update to Provide 4/7/2010
Wells Rural Electric Company Fixed Wireless No Update to Provide 3/1/2010
XO Communications, LLC Backhaul No Update to Provide 6/2/2010
Yonder Media Fixed Wireless No Update to Provide

Nevada System of Higher Education Backhaul No Update Provided - Use Last Submission Data
ACI, Inc. Solicited Initial Data
Air-Internet.com, Inc. Solicited Initial Data
Avant Wireless Solicited Initial Data

Broadband Provider Log



DIECA Communications, Inc. ILEC/CLEC Other 1/19/2010

[FEB-18-11 Wes Kerr] Provider doesn't offer 
residential DSL, and the last mile data will not be 
included in the data submission.

DISH Network Corporation Satellite Other 1/27/2010

[MAR-09-11 Jess Cary] Satellite data will not be 
submitted due to additional information being 
necessary to show where service is available in 
the state, rather than submitting the entire state 
boundary as serviceable area.

Hughes Network Systems, LLC Satellite Other 2/5/2010

[MAR-09-11 Jess Cary] Satellite data will not be 
submitted due to additional information being 
necessary to show where service is available in 
the state, rather than submitting the entire state 
boundary as serviceable area.

Oregon-Idaho Telephone Company Fiber Other 2/25/2010

[MAR-09-11 Jess Cary] FTTH data is not 
available and will not be included in the April 
2011 submission.

WildBlue Communications, Inc. Satellite Other 1/8/2010

[MAR-09-2011 Jess Cary] Satellite data will not 
be submitted due to additional information being 
necessary to show where service is available in 
the state, rather than submitting the entire state 
boundary as serviceable area.

Great Basin Internet Services, Inc. ILEC/CLEC General Reseller - Non-NTIA 4/6/2010
LasVegas.Net LLC ILEC/CLEC General Reseller - Non-NTIA
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Executive Summary 
 
The Broadband Mapping Team at the New York State Office of Cyber Security is pleased to submit our Round 
3 data for the SBDD Program.  Our goals for Round 3 were to:  1) obtain the required data elements from all 
known facilities‐based providers of broadband service to end users in the State of New York, and 2) improve 
the quality of the delivered data through greater emphasis on geospatial verification procedures and the use 
of additional sources of information in the data verification processes.  We believe we have met those goals.   
 
Going into this round of data collection, we had concerns that providers’ interest may have waned and that it 
could be difficult to retain the current participants. Through hard work and continued emphasis on building 
partnerships, we retained all but one previous participant and gained six new participants.  Our Round 3 data 
includes data from 100% of known facilities‐based (wireline) end user providers and all significant wireless 
service providers in NYS. We have one small fixed wireless provider who participated in the previous round of 
data collection who indicated that they did not have the resources to continue with the program.  We will 
seek a solution to bring this provider back in for future rounds. 
 
Overall, we are extremely pleased with the net gain for Round 3 participation! 
 
Although we did not target broadband resellers for Round 3, our delivery includes data from six providers 
who do not own their own facilities.  We anticipate expanding the range of program participants to include 
more of these resellers in future rounds of data collection. Guidance from the NTIA program office and 
information sharing from within the SBDD Grantee community will be helpful in guiding these future data 
collection and mapping efforts. 
 
Another future goal is to identify and work with more fixed wireless providers. Our experience thus far has 
shown fixed wireless providers to be mostly small, relatively new companies targeting geographic areas 
where un‐served pockets left by wire‐line or cellular wireless companies exist. We believe mapping these 
provider’s serviceable areas is a very important component required to fine tune NYS’s served and un‐served 
boundaries.   
 
Expanding our data verification methods was another area of focus during this round. Just prior to our Round 
2 data delivery, we launched a speed test website and the state broadband map. Both now provide crowd‐
sourced data that were used for verification of the Round 3 provider supplied data. Details of those and other 
verification procedures are provided in the Verification section below. 
 
Our speed test activities and the state broadband map both initially created concerns for some members of 
our provider community. We took great pains to address all those concerns first through informational 
webinars and then via in‐person meetings with individual providers and the NYS Telco and Cable association 
leadership. We are happy to report that not only were the concerns satisfactorily addressed, but our 
relationships with the providers and associations were strengthened in the process. 



 
The remainder of this paper describes our methodology for populating the data transfer model and 
performing data verification; and provides a summary of our data collection results and goals for Round 4. 
 

 

Provider Participation Summary Tables: 
 

82  Total Participating Providers 

69  Wireline Providers 

14  Wireless Providers (2 are both Wireless & Wireline) 

1  Provider is middle‐mile only 

39  Providers submitted Middle Mile Data 

 
 

Technology Type 

Wireline 
Census 
Block 

Provider 
Count 

Wireline 
Service 

Availability 
by Census 
Block 

Wireline 
Street 

Segment 
Provider 
Count 

Wireline 
Service 

Availability 
by Street 
Segment 

Wireless 
Provider 
Count 

Wireless 
Services 

by 
Shapefile 

Middle 
Mile 

Provider 
Count 

Middle 
Mile 
Points 

Asymmetric xDSL  44  280,976  36  34,205 0  0  25  1,439

Symmetric xDSL  6  62,947  3  176 0  0  0  0

Other Copper Wireline  7  85,730  5  282 0  0  3  131

Cable Modem ‐ DOCSIS 3.0  7  168,469  5  6,778 0  0  0  0

Cable Modem ‐ Other  13  158,933  12  39,451 0  0  2  8

Optical Carrier/Fiber to the End User  21  109,969  15  2,846 0  0  6  576

Terrestrial Fixed Wireless ‐ Unlicensed  0  0  0  0 7  9  0  0

Terrestrial Fixed Wireless ‐ Licensed  0  0  0  0 1  1  0  0

Terrestrial Mobile Wireless  0  0  0  0 6  20  2  13

Other (middle‐mile only)  0  0  0  0 0  0  1  2

TOTAL SUBMISSION  98  867,024  76  83,738 14  30  39  2,169
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Populating the Data Transfer Model:  
 
For Round 3, we continued to receive new data from providers in various formats: 

1. Hard copy/.pdf maps:  digitized/georeferenced maps, aggregated availability to the census block 
and street segment level 

2. Address locations of availability:  geocoded addresses and aggregated to the census block and 
street segment level 

3. Census block keys and street segment IDs (Excel worksheets, text files, and shapefiles): where 
necessary, converted all census blocks to Census 2000 geography and converted TIGERLine streets 
to New York State street segment geometry 

4. Shapefiles of wireless coverage areas: added appropriate attribute information where necessary 
5. Kml files – some fixed wireless and cellular providers supplied coverage area via kml; added 

appropriate attribute information where necessary 

All (non‐ESRI) data were converted to ESRI shapefile format with availability aggregated to the census block 
and street segment level and with provider attributes added (i.e. Provider Name, DBA Name, Technology, 
Speeds, etc.). Data from the individual shapefiles were loaded into the data transfer model.  
 
Some providers actively report no changes from the previous round. Other (small area) providers were sent 
maps of their reported Round 2 availability and asked to confirm that there were no changes. In both of these 
“no change” situations, previously delivered Round 2 data was loaded in the data transfer model. All data 
were then verified. 
 
The following fields were added to capture NYS specific information: 

1. BBConnectionPoint_MiddleMile 
a. Provider Code – internal use 

2. BB_Service_CensusBlock 
a. Suffix_Cont – additional field used in street address 
b. Verification – tracks verification results connected with speed test data 
c. Provider Code –internal use 

3. BB_Service_RoadSegment 
a. NYS ID – ID code for each street segment 
b. Suffix_Cont – extra field used in street address 
c. Verification – tracks verification results in connection with speed test data 
d. Provider Code –internal use 

4. BB_Service_Wireless 
a. Provider Code –internal use 

 
The following domains were extended to allow for plausible and verified attribute values supplied by 
providers: 
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1. Other Copper Wireline Down (30) – code 9  
Other Copper Wireline Up (30) – code 9 

2. Cable Modem – DOCSIS 3.0 Down (40) – code 10 
Cable Modem – DOCSIS 3.0 Up (40) – code 10 

3. Cable Modem – Other  Down (41) – code 10 
Cable Modem – Other  Up (41) – code 10 

4. Terrestrial Mobile Wireless Down (80) –  code 7 
Terrestrial Mobile Wireless Up (80) – code 7 

5. SPECTRUM USED – code 10 ‐ Other 

 
 

Verification: 
 
Automated verification was accomplished via the following methods: 

1. Business rules built into the data transfer model (catching problems on the way in) 
2. Repeatedly running the NTIA supplied Python script 
3. ESRI ‘Check Geometry’ and ‘Fix Geometry’ tools 

Non‐automated verification methods ranged from the very simple to complex, multi‐step procedures. They 
were: 

1. Clipping all data to the NYS boundary file 
 

2. Checking for Duplicate: The NTIA Python Script checks for multiple speeds reported by provider & 
technology on each census block and street segment ID, but it does not check for total duplicate 
records. In order to check for total duplicate records, we performed the following verification steps: 

a. Created a text column in the street segment and census block feature classes and used the 
field calculator to concatenate FRN, TRANSTECH, and FULLFIPSID /Street Segment ID on each 
record. 

b. Summarized the concatenated field to find any records where the COUNT was greater than 1 
(indicating a total duplicate record). 

c. Related those >1 COUNT records back to the geodatabase feature class and deleted 
duplicates. 
 

3. Additional geometry checks: The Select Layer by Location tool in ArcGIS was used to check the 
vertical alignment and area designation of all census blocks loaded in the geodatabase. The 
parameters of the tool were set to select census blocks in the geodatabase that ‘are identical to’ a 
base layer of Census Blocks (2000 vintage) consisting of only ≤ 2 square mile blocks. All census blocks 
in the geodatabase that vertically aligned with the base layer were selected. The same process was 
performed on the street segment feature class using a base layer of streets in census blocks greater 
than 2 square miles. 
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4. Provider verification:  For providers with significant changes from the previous round, we created 
review maps showing Round 3 availability aggregated to census blocks and street segments. These 
providers were given at least five days to respond and initiate any changes or corrections. Changes 
were made based on provider feedback. Changes were documented for future reference. 
 

5. Use of crowd‐sourced data: 
a. NYS Speed Test data points and attributes were used to verify provider reported availability. 

The NYS speed test website includes a data collection form which requests: 
i. Street address at which the test was taken 
ii. Service provider 
iii. Service technology 

After satellite provider records and sub‐broadband speed records were removed, 4741 
records were successfully geocoded and used for verification. Three levels of verification 
were established for points that fell within areas of reported service availability. They are: 
 

Code 1 = Provider and technology matched 
Code 2 = Provider matched but technology unknown 
Code 3 = Provider matched but technology is mismatched 

 
Each census block and street segment availability record involved with this verification 
activity was assigned one of the above codes. We consider the assignment of these 
verification codes as the start of our work on the leading practice of establishing record level 
confidence scale. Further work is planned to create a flexible and informative scale that can 
be expanded as new data sources and activities are added to our verification workflows. 

b. FCC speed test records were used to verify provider reported availability. FCC speed test 
records lack provider and technology information but we were able to successfully establish 
the provider via a publically available IP Address search engine (the APNIC Whois Database). 
Those records were then used to verify provider reported availability in the same manner as 
was used with the NYS speed test points. Because the technology was not known, the highest 
verification code assigned was 2 (Provider matched but technology unknown). Here is a 
statistical summary: 

   Number  Percentage 

Total Number  of FCC Wireline Speed Test Points   59098 N/A 

Total Number / Percentage Successfully Geo‐coded  30685 / 59098 52% 

Total Number / Percentage Successfully IP Searched  21766 / 30685 71% 

 

c. NYS Broadband Map feedback:  After receiving an email through the “Is This Correct” link on 
the NYS broadband map, the details were logged in a tracking spreadsheet and investigated 
on our map. The address, census block, or street segment was then further investigated in 
ArcMap using provider submitted data to confirm reported availability. If the availability from 
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the provider submitted data was confirmed, the next step was to use the provider’s own 
website to determine availability.  
 
If available, the public responder’s address was used along with address point datasets from 
New York State and Navteq. In a census block or street segment, addresses were identified at 
both ends of the bounding features. These addresses were entered into an availability search 
on the provider’s website and the results were logged. In Frontier’s case, the address points 
were used to perform a reverse lookup and identify phone numbers at those addresses. The 
phone number was then entered on Frontier’s site.  
 
If an address within the block or segment was identified by the provider’s site as potentially 
served, that block or segment retained that provider’s coverage on our map. If no addresses 
within the block or segment were identified as potentially served, we removed coverage for 
that provider from our map. In all cases, the results were reported back to the originator. 
 
Here are summary statistics for this feedback activity: 

• 45 email responses from NYS map 

• 37 Blocks, 14 Street Segments questioned 

• 9 reported locations were verified as having coverage through our process  

• No data interpretation/integration errors uncovered: all information that was questioned 
by public was originally reported by providers 

• 40 Blocks or Segments had coverage removed after our investigation 

• 1 report of no Fairpoint Communication coverage actually resulted in that person getting 
broadband at their home after Fairpoint’s CEO requested they contact him 

  
6. Verizon NY (wire‐line) specific scrubbing:  Verizon New York submitted data in TIGER/Line street 

segments 2009 and Census Blocks 2009 as text delimited files.  

Street segments in the original data were highly fragmented and discontinuous in census blocks 
greater than 2 square miles. An infill process was used to select segments 500 meters or less that fell 
in between the reported street segments (see image below). Addresses from a sampling of the new 
street segments were checked through Verizon’s website and broadband availability was verified. 
These segments were added to Verizon’s availability and assigned the max advertised speed 
attributes of the nearest street segment. Street segments that fell outside Verizon’s exchange 
boundary, or fell on a block discontinuous with any other reported blocks were sampled and checked 
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for availability through Verizon’s website and subsequently deleted. 

 

Census blocks were converted to 2000 vintage and reapportioned based on the Census 2000 block area 
distinction. This posed a challenge since there is not a one‐to‐one area relationship between 2009 and 
2000 blocks. To overcome this discrepancy and maintain accuracy, census blocks that were ≤ 2 square 
miles in the Census 2009 vintage but over 2 square miles in the Census 2000 vintage were assigned street 
segments in the portion of the block that corresponded to the smaller 2009 block. Census blocks that 
were greater than two square miles in the Census 2009 vintage but ≤ 2 square miles in the 2000 vintage 
were assigned the smaller 2000 block. Another issue occurred where 314 Census blocks reported by 
Verizon fell outside their exchange boundary. Addresses sampled in these blocks were checked for 
availability through Verizon’s website. Through this process, it was verified that there is no Verizon 
service in these blocks, and the 314 census blocks were deleted. 

 

Round 4 Focus: 

While increasing the level of participation and improving the completeness and quality of the overall data will 
continue to be one of our overarching goals, there are some very specific improvement areas that the NYS 
Broadband Mapping Team will focus on during Round 4. They are: 
 

1. Further attribution and enhanced spatial accuracy of our Community Anchor Institution (CAI) data: To 
date, collection of the broadband service attributes for our CAIs remains one of our activities in need 
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2. Identifying and working with more fixed wireless providers: We believe we have yet to identify some 

existing providers and new companies will be starting up to fill small pockets of underserved or un‐
served areas. A number of these small companies that we have contacted thus far have explained 
that they have very limited human and technical resources and, in many cases, are not able to 
generate any map‐able data on their own. Some have had a consultant generate a propagation 
model (one time) and that model is now outdated. We intend to work with these providers in order 
to come up with a solution where we can assist them in mapping their serviceable areas and provide 
updates as they expand. 

 
3. Adding verification methods: We intend to pursue the use of additional crowd sourced, commercial, 

and public data source and the aggregated FCC supplied 477 data. 
 

4. Migration to 2010 Census data layers: This will involve the realignment of new Census geography to 
NYS basemap layers and migrating the previous round’s data to Census blocks that have entirely new 
id numbers. 
 

5. Improvements to the NYS Broadband Map and increasing the number of ‘visits’: We see our state 
map as an area where we can provide value to our provider partners. We have already met with 
some providers to discuss displaying multiple ‘speed package’ offerings. Time Warner Cable has 
agreed to work with us to pilot that enhancement. We are also in discussions with CTG in order to 
have them perform outreach work to increase the visits to the site and specifically encourage visitors 
to provide feedback regarding the accuracy of the availability data. We already have a detailed 
verification workflow in place to effectively utilize this data (discussed above in Verification section). 
 

6. Further development of a project plan for our address point development work: We are already using 
address points for geocoding service delivery addresses and for verification work. For Round 4, we 
envision our use of address points for verification to increase and for their use in enhancing our 
ability to estimate household availability, underserved areas and uninhabited lands. Needs 
assessment discussions are already underway with E911 and key government agency stakeholders. 
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OHIO COVER LETTER 

 
April 1, 2011 
 
Ms. Anne W. Neville 
SBDD Grant Program Director 
National Telecommunications and Information Administration 
U.S. Department of Commerce 
1401 Constitution Avenue, NW Room 4716 
Washington, DC 20230 
 
Dear Ms. Neville: 
 
It is with highest regard that the collective stakeholders of Connect Ohio offer congratulations to 
the U.S. Department of Commerce’s National Telecommunications & Information Administration 
(NTIA) on the recent release of the National Broadband Map.  This extraordinary milestone 
demonstrates the intense and joint effort of the NTIA, FCC, state governments, industry, and non-
profits like Connected Nation and will serve as a key tool for the American public and policymakers 
resulting in smarter investments and targeted state and local broadband policies and programs.  We 
are proud of the role that Connect Ohio has played in creating such a powerful tool that will surely 
benefit not just Ohioans, but consumers and businesses nationwide. 
 
Therefore, as the State Broadband Designated Entity, in partnership with the Ohio Department of 
Administrative Services, Office of Information Technology, Connect Ohio, a dedicated program of 
Connected Nation, is pleased to present this submittal of the state of Ohio’s State Broadband Data 
and Development (SBDD) Grant Program required data. 

 
These artifacts should be found to be compliant with the April 1, 2011, deadline for the semi-annual 
data update and in accordance with the terms of the July 1, 2009, Notice of Funds Availability 
(NOFA) and all subsequent clarifications pertaining to delivery of State-Level Mapping of 
Broadband Service Availability.  This packet includes: 
 
Inventory of Deliverables, Connect Ohio: April 1, 2011 
 
NOFA Requirement Data Transfer Model Data Description 
Appendix A:  1(a)(i) BB_Service_CensusBlock Broadband Service Availability of 

Facilities-Based Providers in 
Census Blocks of No Greater 
Than Two Square Miles in Area 

Appendix A:   1(a)(ii) BB_Service_RoadSegment Broadband Service Availability of 
Facilities-Based Providers by Road 
Segment in Census Blocks Larger 
in Area Than Two Square Miles 
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Appendix A:   1(b) BB_Service_Wireless Broadband Service Availability of 
Wireless Services Not Provided to 
a Specific Address 

Appendix A:   3(b) BB_ConnectionPoint_MiddleMile Broadband Service Infrastructure 
Middle-Mile and Backbone 
Interconnection Points 

Appendix A:   4 BB_Service_CAInstitutions  Community Anchor Institutions-
Listing 

Appendix A:   4 n/a Community Anchor Institutions-
Narratives 

VII.A.1(a) n/a Accuracy and Verification Report 
n/a DataPackage.xlsx Worksheets of Contact 

Information, Data Dictionary, and 
Provider Summary Table 

n/a n/a Broadband Provider Roster and 
Participation Status 

 
In addition, this data update submission should be found to be compliant with the additional 
program requirements instituted by the National Telecommunications and Information 
Administration since the time of the October 2010 SBDD data submission for the Connect Ohio 
program.  Specifically, these new requirements are: 

 
SBDD Data Transfer Model 
The submission of the broadband dataset for April 1, 2011, is contained within the SBDD 
Data Transfer Model as released on the Grantee Workspace on January 14, 2011. All efforts 
have been made to comply with formatting, domain, and metadata requirements to include 
as much information on each provider as possible.  
 
Additional Submission Guidance 
This submission also includes the updated DataPackage spreadsheet with enhanced provider 
listings as well as satisfactory outputs from the SBDD_Check toolbox to ensure fewer 
unexpected values with the submitted broadband datasets prior to federal processing for the 
National Broadband Map update. 

 
It is therefore with great pleasure that the Connect Ohio program submits this April 2011 semi-
annual data update under the State Broadband Data and Development Grant Program.  We will 
continue to implement the joint purposes of the Recovery Act and the Broadband Data 
Improvement Act (BDIA) by gathering comprehensive and accurate state-level broadband mapping 
data, developing state-level broadband maps, aiding in the development and maintenance of the  
National Broadband Map, and undertaking statewide initiatives for broadband planning. 
 
Broadband Service Availability — Provider Outreach and Verification 
 
This data update submission under the SBDD includes the participation of approximately 83.97% of 
the Ohio provider community, or 110 of 131 total providers.  Of the 110 participating providers, 37 
supplied an update to their network or coverage area(s), while 64 have reported no change. The 
remaining 9 represent providers who previously supplied data but were non-responsive in the April 
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2011 update effort or could not verify coverage areas at the time of this submission; therefore their 
previous dataset is being put forward as part of this compilation. A complete roster by provider 
depicting participation status and contact record is contained herein.  Of the 21 providers that are 
not represented in the attached datasets, 11 have either refused to participate in the voluntary 
program or have remained unresponsive to the numerous attempts at contact by Connect Ohio. The 
remaining 10 providers are currently in some form of progress toward data submission but were not 
able to either submit or verify coverage areas at the time of this submission.    
 
As the aforementioned roster and attached methodology documentation will attest, it is the 
collective opinion of the Connect Ohio principals that all commercially reasonable efforts were 
made to account for 100% of the known Ohio broadband provider community, pursuant to this 
semi-annual data update submission. 
 
Connect Ohio has also continued to perform broadband verification activities through several 
means. In addition to confirmation of service area(s) by each provider, Connect Ohio conducts field 
validation efforts.  To date, 38 (29.01%) providers have been validated through field verification 
activities. Additional details on verification activities are contained within the Field Validation 
Narrative. 
  
At the program’s inception, Connect Ohio launched a website to create awareness about the 
initiative. Connectohio.org continues to serve a prominent role in the outreach and data collection 
effort.  This program asset provides a way for the general public to participate in the process by 
offering interactive tools for users to test their connection speed, submit broadband inquiries, or 
contact a program representative.   
 
As an indicator of stakeholder penetration, the Connect Ohio website encountered 19,490 unique 
visits during this reporting period (65,810 total to date for the life of the grant awarded on 
December 20, 2009).  Additionally, this pronounced Web activity netted 305 broadband inquiries 
over this same reporting period (989 grant inception to date).  The website also provides the 
BroadbandStat application, which allows the consumer to confirm or dispute the coverage 
represented on the broadband inventory map. These consumer-initiated actions are facilitated 
through the Connect Ohio website and the Connect Ohio Interactive Mapping Tool 
(BroadbandStat) that offer citizens the vehicles to provide information regarding availability in their 
respective service area, either in affirmation or contest of the reported data represented in the 
Connect Ohio mapping artifacts.  Since the initial data collection and release of corresponding maps, 
feedback in the form of broadband inquiries has allowed Connect Ohio to identify additional areas 
that are in need of field validation, which is scheduled as soon as possible.  
 
Community Anchor Institutions  
 
Connect Ohio has established an ongoing mechanism for gathering data on the location and 
broadband connectivity of Community Anchor Institutions (CAI), in accordance with the data 
requirements of the SBDD NOFA Technical Appendix.   
 
In conjunction with the state of Ohio, outreach was conducted during this data update reporting 
period by Connect Ohio to continue identification of existing, centralized sources for CAI 
connectivity data.  Outreach was coordinated to distribute the CAI survey to institutions throughout 
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the state through multiple methods including a customized online survey available on the Connect 
Ohio website.  Connect Ohio continues to identify opportunities to work with associations in the 
state such as the Ohio Geographically Referenced Information Program and the Ohio Public 
Library Information Network to promote the importance of broadband connectivity at anchor 
institutions and participation in this data collection process.   
 
While we continue to document institutions and the related addresses, the connectivity data 
collected in most categories remains incomplete at this time.  Connect Ohio will be implementing a 
number of new processes to increase participation including launching a CAI newsletter to connect 
communities across the state, increasing industry-specific planning to target new community 
contacts, and revising the CAI portion of our website to increase visibility and content.  From our 
work in Connect Ohio, as well as other states, we recognize the great value of this data to future 
collaboration efforts within the state and its value to the recently released National Broadband Map.  
We plan to continue to bring best practices to the Connect Ohio efforts, along with an investment 
of both human and technical resources required to reach our goal of increasing the data that is 
secured and reported as part of this process. 
 
 
The Connect Ohio program exists to improve data on the deployment and adoption of broadband 
services and to assist in the extension of broadband technology across all regions of the great state 
of Ohio, as well as the United States through contribution to the National Broadband Map.  We 
look forward to the continuing work ahead. 
 
Respectfully submitted, 
 
 
 
Thomas W. Ferree 
Chief Operating Officer 
Connected Nation, Inc. 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 

dclark
Cueball
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DATA ACQUISITION:  OHIO COMMUNITY ANCHOR INSTITUTIONS  

In this third reporting period of the SBDD, Connect Ohio, working in close coordination with the 
state of Ohio, has established an ongoing mechanism for gathering data on the location and 
broadband connectivity of Community Anchor Institutions (CAI), in accordance with the data 
requirements of the SBDD NOFA Technical Appendix.  During this reporting period Connect 
Ohio has continued to focus efforts on conducting outreach and raising awareness of this important 
project. 
 
Connect Ohio has continued to identify and process CAI data obtained through an ongoing 
statewide outreach campaign.  Physical address information continues to be augmented through 
manual sourcing and geocoded by Connect Ohio through ESRI ArcGIS software. 
 
Connect Ohio continues to utilize a customized online survey hosted through SurveyMonkey, with a 
link on the Connect Ohio website that was developed during the first reporting period.  This survey, 
in combination with a customized data gathering spreadsheet, was distributed to a targeted list of 
CAI throughout the state.  Connect Ohio will continue to use these data gathering tools for future 
targeted outreach efforts throughout the coming months leading up to the next reporting period.  
These materials are customized to fit the CAI categories as defined in the SBDD NOFA.   
 
The survey can be accessed at this link using the following password: 
http://www.surveymonkey.com/s_pass.aspx?sm=ROpanKoKAJTZw4y2qnty0g%3d%3d 
Password:  CAI_OH_3210 
 
Connect Ohio has worked diligently during this reporting period to conduct research as part of an 
ongoing process to identify existing, centralized sources for CAI connectivity data.  In the last 
reporting period Connect Ohio reported a statewide geocoded CAI database for approximately 
22,000 institutions.  Outreach continues to identify broadband connectivity data for these 
institutions. 
 
In tandem with these efforts to identify existing data, Connect Ohio continues to identify key CAI 
contacts among all CAI categories in an effort to distribute and promote the online survey and raise 
awareness of the importance of CAI broadband connectivity.  
 
Collecting CAI connectivity data continues to be challenging in the state but Connect Ohio will be 
leveraging the relationships that have been developed through the Every Citizen Online program to 
specifically target libraries and higher education institutions in the coming months.   
  
Connect Ohio has an ongoing mission to educate CAI throughout the state on the importance of 
participating in the project.  Participation by these institutions will raise awareness about the 
importance of broadband connectivity and the need to report the requested data for inclusion on the 
National Broadband Map.  To assist with our data collection efforts, Connect Ohio is developing a 
CAI newsletter to be distributed quarterly beginning in April 2011.  The newsletter will highlight a 
CAI in Ohio, encourage institutions to share their data, and highlight the National Broadband Map. 
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The greatest challenge with collecting this data continues to be the difficulty in securing CAI 
broadband connectivity data.  Connect Ohio will continue its ongoing work with the state of Ohio, 
existing Connect Ohio staff, and key organization contacts in an effort to raise awareness of this 
project among CAI.  
 
A CAI summary of all processed and submitted data is provided below: 
 

CAI Type Total 
Physical 
Address Lat/Long

Technology 
of 

Transmission
Download 

Speed 
Upload 
Speed 

K-12 Schools 8,703 8,703 8,703 11 7 5
Libraries 759 759 758 687 588 7
Healthcare 1,959 1,959 1,959 5 5 5
Public Safety 4,157 4,157 4,157 6 4 4
Higher Ed Institutions 609 609 609 12 7 7
Other Government 319 319 319 13 7 7
Other Non-Government 3,626 3,626 3,626 28 19 14
Total 20,132 20,132 20,131 762 637 49
 
 
SBDD DATA SUBMISSION METHODOLOGY 

The submission of the broadband dataset for April 1, 2011, is contained within the SBDD Data 
Transfer Model and additional components as released on the Grantee Workspace on January 14, 
2011. Connected Nation has reviewed all literature that relates to the release and use of this data 
transfer model and recognizes that it does not replace or dictate how data is stored, processed, or 
displayed for the state or territory, as it is meant primarily as a means to transfer the broadband data 
from all states and territories and populate the National Broadband Map in a seamless fashion. 
Guidance from the Technical Mapping Guide, as released on the Grantee Workspace on March 24, 
2011, was also followed to ensure the completeness and validity of the submission through 
completion steps and checklists, completing the DataPackage spreadsheet, uploading broadband 
datasets into the Data Transfer Model, and checking the dataset using the SBDD_CheckSubmission 
receipt process.  
 
In addition to the narratives and methodologies contained herein, as well as the DataPackage.xls 
containing contact information, the data dictionary, and a provider summary table, the following 
feature classes are submitted within the SBDD Data Transfer Model for the state of Ohio. 
 
Inventory of Deliverables, Connect Ohio: April 1, 2011 
 
NOFA Requirement Data Transfer Model Data Description 
Appendix A:  1(a)(i) BB_Service_CensusBlock Broadband Service Availability of 

Facilities-Based Providers in 
Census Blocks of No Greater 
Than Two Square Miles in Area. 
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Appendix A:   1(a)(ii) BB_Service_RoadSegment Broadband Service Availability of 
Facilities-Based Providers by Road 
Segment in Census Blocks Larger 
in Area Than Two Square Miles. 

Appendix A:   1(b) BB_Service_Wireless Broadband Service Availability of 
Wireless Services Not Provided to 
a Specific Address. 

Appendix A:   3(b) BB_ConnectionPoint_MiddleMile Broadband Service Infrastructure 
Middle-Mile and Backbone 
Interconnection Points. 

Appendix A:   4 BB_Service_CAInstitutions  Community Anchor Institutions-
Listing. 

 
The provider data collected by Connected Nation on behalf of the state of Ohio have been 
formatted per the given specifications and uploaded into the appropriate feature classes of the 
SBDD Data Transfer Model. Wireline availability is contained within census blocks and road 
segments, wireless availability is contained as polygons of coverage areas, and middle-mile 
connections and community anchor institutions are contained as point data. All speed data is 
contained at the census block, road segment, or wireless polygon level of availability. All efforts have 
been made to comply with formatting, domain, and metadata requirements to include as much 
information as possible.  
 
Connected Nation has continued outreach to satellite providers on their availability, technology, and 
speed information, but it is not included in this submission dataset.  Additional information is 
necessary to be able to show where service satisfactorily exists in the state, rather than submitting 
the entire boundary of the state as the serviceable area.  Analysis information distributed and 
discussed with the satellite providers, as well as any additional guidance from the Program Office on 
the desired analysis for satellite-serviceable areas, will be implemented for the October 2011 data 
submission.  
 
 
OHIO FIELD VALIDATION NARRATIVE 

Connected Nation focused a portion of its time on specific validation processes such as: 
 

• conducting random spectrum analysis studies throughout the state using an Avcom PSA-37-
XP spectrum analyzer; 

• conducting mobile speed tests throughout the state using an iPhone, Android (or other 
smart phone) as well as provider-specific aircards (Sprint 3G/4G, Clearwire et al); 

• identifying pre-selected, provider-submitted wireless transmit tower sites and cross-
referencing data about that tower against the Federal Communications Commission (FCC) 
databases such as Antenna Structure Registration and/or the Universal Licensing System; 

• cross-referencing Federal Registration Number data against available FCC Form 477 data as 
well as the FCC COmmission REgistration System (CORES); 

• validating provider submitted data (for example: latitude/longitude) using a handheld 
Garmin eTrex Summit GPS unit or GPS enabled software such as Microsoft Streets and 
Trips; 
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• locating physical wire-line attributes (such as remote terminals, CATV plant, etc.) and 
comparing them against provider submitted data; and 

• conducting on-net and off-net speed tests using the FCC portal at 
http://www.broadband.gov/qualitytest/about/ or using the Ookla Net Metrics enabled 
speed test utility located on each of Connected Nation’s state specific websites. 

 
Additionally, Connected Nation cross-referenced numerous public documents in order to ensure 
that all known broadband providers were located and contacted.  This included searching 
membership logs from the trade associations (WISPA, WCAI, PCIA, etc.), the Cable Television Fact 
Book, Public Utility Commission records, Public Service Commission records, Chamber of 
Commerce, etc. 
 
To date Connected Nation’s staff conducted on-site validation tests in Ohio on the following 
providers:  Altius Broadband, Amplex Internet, AT&T, Avolve, Buckeye Cablevision Inc., Cavalier 
Telephone, Celerity Networks, CenturyLink, Cincinnati Bell Telephone Company LLC, CityNet 
Fiber, Clearwire Corporation, Computers4U, ConnectLink, Country Connections, Dark Horse 
Wireless, Databit Solutions, Frontier Communications d.b.a. Citizen’s Communications, GMN 
Wireless, g Wireless Inc., Intelliwave, J-B Nets LLC, Just Micro Digital Services Inc., Level 3 
Communications, LightSpeed Technologies, MetaLINK, Mikulski Communications LLC, New Era 
Broadband LLC, New Knoxville Telephone, R.A.A. Services, Sciotowireless, Southern Ohio 
Communication Services Inc., StratusWave, Talk America Inc., Telephone Service Company, Time 
Warner Cable Inc., Verizon Communications, W.A.T.C.H. TV, and Wilkshire Wireless. 
 
During this reporting period, Connected Nation conducted 124 additional on-site validation tests  
with Amplex Internet, AT&T, Avolve, Celerity Networks, CenturyLink, Cincinnati Bell Telephone 
Company LLC, CityNet Fiber, Clearwire Corporation, Country Connections, Dark Horse Wireless, 
Databit Solutions, GMN Wireless, Intelliwave, J-B Nets LLC, New Knoxville Telephone, Telephone 
Service Company, Time Warner Cable Inc., Verizon Communications, and Wilkshire Wireless. 
 
From program initiation through this reporting period, Connected Nation has completed in-the-
field validation testing against 38 companies (out of a universe of 131 viable providers) totaling 
29.01% within the state of Ohio.   
 
 
ACCURACY AND VERIFICATION:  METHODOLOGY - PROVIDER VALIDATION 

Broadband providers maintain their service area data in many different formats, all in varying levels 
of complexity and granularity. In order to ensure that the data required by the NTIA is standardized 
across all providers and that it is as accurate as possible, Connected Nation translates and formats 
the data that providers are able to supply into a GIS shapefile and produces maps for the provider to 
review.  The resulting map(s) and review process allow for providers to see their service area in a 
geographic format – for some providers, this is the first time they have seen maps of their 
broadband service area. Having the mapped service area allows providers to quickly identify any 
issues that appear in the data representation, whether the issue is in the data translation into a GIS 
format or from the original data collection and submission. Often data is provided from various 
sources and through the review and revision process, local engineers who operate the networks and 
work in the field are able to ensure that the tabular data that has been submitted is accurate and 
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represents the real-world network extent. Any issues in how the service area is represented on the 
map(s) are remedied by Connected Nation, whether they are additions, removal of service, or any 
other revisions. Revised maps of service area representations are sent to the provider for review and 
approval; Connected Nation will revise data and return maps as many times as necessary until the 
provider is in agreement that the map represents their service area as accurately as possible. Once 
the review process has been completed and final approval of the data is provided, the data is deemed 
ready for NTIA submission. 
 
Once the data collection has been aggregated at a statewide level, static maps of statewide and 
county-level availability are produced and made publicly available. In addition, consumers can visit 
the interactive online tool, BroadbandStat, to create customized views of broadband service areas 
and analyze corresponding demographic information. Leveraging broadband service data on various 
platforms allows for public users, providers, and other stakeholders to review, scrutinize, and 
provide feedback on the represented data. This feedback becomes a validation method in itself as 
consumers submit inquiries to Connected Nation either affirming where service is not available or 
identifying areas where broadband service is shown on the map, but in actuality is not available. This 
allows for a follow-up to providers regarding revisions to the data as it is represented; it also allows 
for Connected Nation to identify locations where on-site visits may be necessary to complete field 
validation of available services. Public feedback on all forms of mapping products serves as a 
localized validation method for provider-supplied information and allows Connected Nation to 
resolve inaccuracies as they are identified to ensure that only the highest quality information is 
provided to stakeholders. 
 
Estimates derived from provider-validated data indicate that approximately 1.74% of Ohio 
households do not have terrestrial fixed broadband service available, and approximately 0.48%1 of 
Ohio households have neither mobile nor fixed broadband service available.2   
 
Within rural areas of the state, results derived from provider-validated data indicate that 
approximately 3.81% of rural Ohio households do not have terrestrial fixed broadband service 
available, and approximately 1.04%3 of rural Ohio households have neither mobile nor fixed 
broadband service available.4   

                                                            
1 In accordance with NTIA’s definition of available broadband service as specified in the SBDD NOFA, this estimate 

includes both terrestrial fixed and mobile broadband service, if the service offers download speeds of at least 768 Kbps 
and upload speeds greater than 200 Kbps. 

2 Due to the nature of the SBDD data collection methodology as defined by the NTIA and based on both census 
block geographic units and street segment data, the estimates of broadband availability derived from provider-validated 
data may include an overstatement of the actual number of households with broadband availability.  Under the census 
block-based data collection method, a provider will typically report broadband availability for an entire census block 
whether its network is present across the whole or only a subset of that census block.  This potential overestimation at 
the census block level can be amplified as the data is aggregated across the entire state. 

3 See footnote 1. 
4 See footnote 2. 
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WIRELESS METHODOLOGY 

 
Broadband Service Availability in Provider’s Service Area 

Wireless Services Not Provided to a Specific Address 
 
Data solicited from a fixed wireless provider to create propagation models include, but are not 
limited to: 
 

1. The name of the structure 
2. Whether the transmitting device is operational or proposed 
3. The maximum advertised downstream speed, the maximum advertised upstream speed 
4. The typical downstream speed, the typical upstream speed (peak periods for both) 
5. The frequency range of spectrum being used (as prescribed by NTIA) 
6. The primary population center(s) being served (for geopolitical boundary reference) 
7. The physical address of the transmit site (in the event latitude/longitude is unavailable from 

the provider this allows a quick reference point for geocoding) 
8. Latitude in either Degrees, Minutes and Seconds and/or in Decimal Degrees (typically 

received as NAD 27 or NAD 83)  
9. Longitude in either Degrees, Minutes and Seconds and/or in Decimal Degrees (typically 

received as NAD 27 or NAD 83)  
10. Antenna pattern (e.g. omni-directional, 180°, 120°, 90°, etc.) 
11. Azimuth of antenna (e.g. 360° with magnetic declination if known) 
12. Approximate transmit radius (in feet, miles, or kilometers) 
13. Polarity of transmit antenna (Vertical or Horizontal) 
14. Transmit antenna gain (in dBi) 
15. Line loss (applicable only to providers using coax, heliax, waveguide or other forms of 

cabling – excludes power-over-Ethernet devices) 
16. Mechanical and/or Electrical beam tilt (if applicable) 
17. Equipment Manufacturer (allows easy cross-reference against manufacturer’s specification 

sheet) 
18. Power output of the transmitting device (if unknown, FCC standards or manufacturer 

specifications are applied) 
19. AMSL at base of tower site 
20. Antenna centerline AGL (height of antenna above ground level measured at the centerline 

of the actual antenna) 
21. Foliage factors (Evergreens/Deciduous and percent of ground cover) 
22. Ground Clutter (primarily used in rural areas to account for foliage and in metropolitan areas 

to account for types and heights of buildings if known)   
23. Average gain of receive antenna 
24. Receive antenna is estimated at height above average terrain (HAAT) of 6.2 meters/20 feet 



                                                                                          Connect Ohio – Narratives and Methodologies 
 

 

 
April 1, 2011   13 
 

25. Federal Registration Numbers (if applicable) which may allow opportunities to cross-
reference and/or obtain additional data from the Federal Communications Commission 
Universal Licensing System and the COmmission REgistration System 

 
Propagation modeling is an empirical mathematical formulation for the characterization of radio 
wave propagation as a function of frequency, distance, and other conditions. Propagation 
software(s) typically use the Irregular Terrain Model (also known as Longley-Rice) of radio 
propagation for frequencies between 20 MHz and 20 GHz. This model is based on electromagnetic 
theory and statistical analyses of the combination of terrain features and radio measurements, then 
predicting the median attenuation of a radio signal as a function of distance and the variability of the 
signal in time and in space.  For metropolitan areas, the software can typically be adjusted to use the 
Okumura-Hata model which accounts for predicting the behavior of cellular transmissions in areas 
where buildings are the primary obstructions. The resulting product from either model depicts a 
graphical illustration of the theoretical propagation characteristics of a selected frequency range 
based on defined variables (receiver sensitivity of the home/mobile device, foliage factor, and digital 
elevation terrain input). 
 
 
BROADBAND INQUIRIES METHODOLOGY 

Connected Nation collects consumer feedback in the form of broadband inquiries. These inquiries 
represent any type of communication received from the public regarding broadband service. Once 
broadband inquiries are received across the state, this information is overlaid with the broadband 
availability information which was collected through the SBDD program.  This allows for a real-
world comparison of the broadband landscape to the information received from broadband 
inquiries.  Broadband inquiries are able to provide three types of information:  1) Residents who do 
not have broadband but want it.  2)  Residents who have broadband but want a different provider.  
3)  Residents who do not have broadband, but the broadband inventory maps indicate that they do. 
 
Through the collection of broadband inquiries, a visual demand for broadband is presented.  This 
visualization allows Connected Nation the ability to validate broadband availability maps for 
accuracy.  If residents within a region state that they are without broadband, but the broadband 
inventory maps show otherwise, this allows Connected Nation to approach the providers within that 
area in an effort to trim down their coverage to more accurately represent real-world availability on 
the ground.  On the other hand, if there is a region in the territory in which broadband is not 
available, the broadband inquiries allow providers close to that region to see where they can 
successfully expand their broadband networks, leading to a high return on investment.  In short, the 
higher number of inquiries leads to a higher level of certainty in regard to the broadband availability 
maps.  Since the initial data collection and release of corresponding maps, feedback in the form of 
broadband inquiries has allowed Connected Nation to identify additional areas that are in need of 
field validation, which are scheduled as soon as possible. Additional information on field validation 
can be found in the Field Validation Narrative. 
 
The broadband inquiry process has been implemented in each of the Connected Nation state 
programs with successful results. Altogether Connected Nation has received over 16,000 broadband 
inquiries since 2007, allowing the state programs to evaluate each inquiry for broadband demand and 
data verification.  These inquiries are continuously examined against current broadband availability, 



                                                                                          Connect Ohio – Narratives and Methodologies 
 

 

 
April 1, 2011   14 
 

updated every six months, to determine if previously unserved households have been expanded to 
and can now receive broadband at their residence. This database of broadband inquiries has also 
allowed the Connected Nation state programs to aggregate demand in concentrated areas to show 
providers the exact locations where the population has made it clear that they would purchase 
broadband if it was made available to them. Providers in the states have responded to this process 
and have expanded to areas knowing that their investment will be worthwhile. Data verification 
methods have also proven successful, as the state programs have been able to show those inquiries 
that indicate the broadband service areas are misrepresented on the map to providers, who then 
verify where service cannot reach in regard to that residence(s). The broadband coverage in these 
states has been altered to create a more accurate map based on the inquiries submitted by the public. 
 
During this reporting period, the Connect Ohio project has received a total of 305 inquiries (989 
grant inception to date).  As more inquiries are submitted to Connect Ohio, a more thorough 
validation of the broadband landscape can be performed, while also allowing providers to see which 
areas have a high demand for broadband adoption. 

 

BROADBANDSTAT METHODOLOGY  

BroadbandStat is an online, interactive mapping tool for viewing, analyzing, and validating 
broadband data. Developed through a partnership with ESRI, the market leader in geographic 
information system (GIS) software, BroadbandStat is a multi-functional, user-friendly way for local 
leaders, policymakers, consumers, and technology providers to devise a plan for the expansion and 
adoption of broadband.  
 
First and foremost, BroadbandStat allows consumers to locate their residence and identify providers 
that offer broadband Internet service to that location. The interactive platform allows for users to 
build and evaluate broadband expansion scenarios using a wealth of data, including education and 
population demographics, broadband availability, and research about the barriers to adoption.  
 
New functionality in BroadbandStat allows the consumer to provide feedback on the broadband 
data displayed on the interactive map.  Through the collection of this feedback, a visual demand for 
broadband is presented.  This visualization allows the Connected Nation state programs the ability 
to validate the broadband availability for accuracy.  If residents within a region state they are without 
broadband, but the interactive map shows otherwise, this allows Connected Nation to approach the 
providers within that area in an effort to trim down their coverage to more accurately represent real-
world availability on the ground.   
 
The Connect Ohio project launched BroadbandStat on February 24, 2010, and has received a total 
of 5,528 visits to date, of which 2,200 occurred this reporting period. 
 
 
SPEED TEST METHODOLOGY 

The 2,211speed tests that are represented in the Connect Ohio Speed Test Report during this 
reporting period (4,999 grant inception to date) are the result of a partnership between Connected 
Nation and Ookla Net Metrics. Utilizing this relationship increases the level of confidence in the 
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data being collected and provides for a far greater sample size than could be collected by a single 
testing site. 
 
Ookla owns and operates Speedtest.net, as well as develops and deploys speed tests, such as the 
Connect Ohio speed test website, for partners around the world. This network of sites that is 
developed and run on its testing technology provides Ookla with a vast dataset that, due to the 
variability of geographic information collected across the varying speed test sites, is geocoded 
utilizing Geo-IP technology. This technology allows for tests to be geocoded to points of 
aggregation, typically larger nodes across provider networks.  While there are hundreds of thousands 
of tests that have been conducted, the level of aggregation is only sufficient for county-level detail 
due to the test results being located at these larger nodes and not at an absolute location for each 
speed test. 
 
In an effort to validate broadband data from the Connect Ohio project, speed test information is 
collected throughout the state.  Speed tests provide speed information on the path taken through all 
networks (a provider’s network as well as additional networks) a local machine must connect to in 
order to reach the host test.  The benefit of this collection of speed information is two-tiered.  First, 
it allows for a comprehensive dataset of speeds, while also providing Connect Ohio with the 
information on where broadband services are available.  Second, unlike theoretical speed 
information which was received through the data collection process, the use of speed tests provide 
real-world information on the speeds that currently exist within the state of Ohio.   
 
 



Complete 153
Non-Responsive/Refused 11
In Progress 15

Count of Datasets by Viable Status 179
Total Unique Providers Represented 131

Provider Name Platform Status

NDA 
Execution 

Date Notes
Amplex Internet Fixed Wireless Data Added to Statewide Inventory 3/26/2010
AT&T Inc. ILEC/CLEC Data Added to Statewide Inventory 12/16/2009
AT&T Inc. Mobile Wireless Data Added to Statewide Inventory 12/16/2009
Avolve, Inc. Fixed Wireless Data Added to Statewide Inventory 2/17/2011
Buckeye Cablevision, Inc. Cable Data Added to Statewide Inventory 2/8/2010
CenturyLink ILEC/CLEC Data Added to Statewide Inventory 12/4/2009
Cequel Communications Cable Data Added to Statewide Inventory 12/15/2009
Cincinnati Bell Telephone Company LLC Mobile Wireless Data Added to Statewide Inventory 3/16/2010
Cincinnati Bell Telephone Company LLC Fiber Data Added to Statewide Inventory 3/16/2010
Cincinnati Communications BPL Data Added to Statewide Inventory 1/6/2011
Clearwire Corporation Fixed Wireless Data Added to Statewide Inventory 3/3/2010
Clearwire Corporation Mobile Wireless Data Added to Statewide Inventory 3/3/2010
Comcast Cable Communications, LLC Cable Data Added to Statewide Inventory 12/7/2009
Computers 4 U Fixed Wireless Data Added to Statewide Inventory
Country Connections LLC Fixed Wireless Data Added to Statewide Inventory 2/15/2010
DataBit Solutions Fixed Wireless Data Added to Statewide Inventory
Erie County Cablevision, Inc. Cable Data Added to Statewide Inventory 2/8/2010
Frontier Communications Corporation ILEC/CLEC Data Added to Statewide Inventory 1/22/2010
Hometown Cable Company Fiber Data Added to Statewide Inventory 4/15/2010
Intelliwave, LLC Fixed Wireless Data Added to Statewide Inventory
JB-Nets, LLC Fixed Wireless Data Added to Statewide Inventory 4/5/2010
Leap Wireless International, Inc. Mobile Wireless Data Added to Statewide Inventory 4/6/2010
Massillon Cable TV, Inc. Cable Data Added to Statewide Inventory 2/9/2010
MetaLINK Technologies, Inc. Fixed Wireless Data Added to Statewide Inventory 3/22/2010
New Knoxville Telephone Company Fixed Wireless Data Added to Statewide Inventory 3/12/2010
Sprint Nextel Corporation Mobile Wireless Data Added to Statewide Inventory 1/14/2010
T-Mobile USA, Inc. Mobile Wireless Data Added to Statewide Inventory 1/8/2010
TDS Telecommunications Corporation ILEC/CLEC Data Added to Statewide Inventory 1/27/2010
Time Warner Cable LLC. Cable Data Added to Statewide Inventory 12/21/2009
Vaughnsville Telephone Company, Inc ILEC/CLEC Data Added to Statewide Inventory 12/22/2009
Verizon Communications, Inc. Mobile Wireless Data Added to Statewide Inventory 12/14/2009
Cincinnati Communications Backhaul Backhaul Provider Only Processing Complete 1/6/2011
Citynet, LLC Backhaul Backhaul Provider Only Processing Complete 4/5/2010
Cogent Communications, Inc. Backhaul Backhaul Provider Only Processing Complete
Com Net, Inc Backhaul Backhaul Provider Only Processing Complete
Covad Communications Backhaul Backhaul Provider Only Processing Complete 1/19/2010
Level 3 Communications, LLC Backhaul Backhaul Provider Only Processing Complete 12/14/2009
One Community Backhaul Backhaul Provider Only Processing Complete 4/14/2010
T-Mobile USA, Inc. Backhaul Backhaul Provider Only Processing Complete 1/8/2010
US Signal Company, LLC Backhaul Backhaul Provider Only Processing Complete 6/17/2010
YES Learning and Computer Center Inc Backhaul Backhaul Provider Only Processing Complete 4/24/2010
Zayo Group, LLC Backhaul Backhaul Provider Only Processing Complete

Farmers Mutual Telephone Company Fixed Wireless
Approval for Update Not Received - Use Last 
Submission Data 12/22/2009

McLeodUSA Telecommunications Services, Inc. ILEC/CLEC Provider Approval Solicited
One Community Fixed Wireless Provider Approval Solicited 4/14/2010
OmniCity Fixed Wireless Partial Data Received
Bascom Mutual Telephone Company ILEC/CLEC Provider Gathering Data 3/22/2010
Untangled Technology Fixed Wireless Provider Gathering Data 5/24/2010
Armstrong Utilities, Inc. Cable No Update to Provide 3/11/2010
Arthur Mutual Telephone Company ILEC/CLEC No Update to Provide 12/22/2009
AT&T Inc. Backhaul No Update to Provide 12/16/2009
Ayersville Telephone Company ILEC/CLEC No Update to Provide 3/22/2010
Bascom Mutual Telephone Company Cable No Update to Provide 3/22/2010
Bascom Mutual Telephone Company Fiber No Update to Provide 3/22/2010
Bascom Mutual Telephone Company Fixed Wireless No Update to Provide 3/22/2010
Bascom Mutual Telephone Company Backhaul No Update to Provide 3/22/2010
Benton Ridge Telephone Company ILEC/CLEC No Update to Provide 4/13/2010
Benton Ridge Telephone Company Fixed Wireless No Update to Provide 4/13/2010
BluSky Wireless Fixed Wireless No Update to Provide 2/24/2010
Bryan Municipal Utilities Cable No Update to Provide
Bryan Municipal Utilities Fiber No Update to Provide
Buckland Telephone Co. Fiber No Update to Provide 4/10/2010
Buckland Telephone Co. ILEC/CLEC No Update to Provide 4/10/2010
Cable Co-op Cable No Update to Provide 4/9/2010
CenturyLink Backhaul No Update to Provide 12/4/2009
Champaign Telephone Company Fiber No Update to Provide
Champaign Telephone Company Fixed Wireless No Update to Provide
Champaign Telephone Company ILEC/CLEC No Update to Provide
Cincinnati Bell Telephone Company LLC Cable No Update to Provide 3/16/2010
Cincinnati Bell Telephone Company LLC ILEC/CLEC No Update to Provide 3/16/2010
City of Wadsworth Cable Cable No Update to Provide 7/19/2010

Broadband Provider Log



Conneaut Telephone Company Cable No Update to Provide 12/22/2009
Conneaut Telephone Company ILEC/CLEC No Update to Provide 12/22/2009
Cox Communications, Inc Cable No Update to Provide 1/29/2010
Cox Communications, Inc Backhaul No Update to Provide 1/29/2010
Coyote Wireless Broadband LLC Fixed Wireless No Update to Provide 4/19/2010
Dark Horse Networks Fixed Wireless No Update to Provide 3/15/2010
Doylestown Telephone Company Fiber No Update to Provide 4/14/2010
Doylestown Telephone Company Cable No Update to Provide 4/14/2010
Doylestown Telephone Company ILEC/CLEC No Update to Provide 4/14/2010
East Cleveland Cable TV Cable No Update to Provide 4/13/2010
FairPoint Communications, Inc. ILEC/CLEC No Update to Provide 12/22/2009
Farmers Mutual Telephone Company ILEC/CLEC No Update to Provide 12/22/2009
Fort Jennings Telephone Company Fiber No Update to Provide 4/2/2010
Fort Jennings Telephone Company ILEC/CLEC No Update to Provide 4/2/2010
g wireless, Inc. Fixed Wireless No Update to Provide 3/15/2010
Gateway Telecom LLC Fixed Wireless No Update to Provide 3/22/2010
Glandorf Telephone Company, Inc. Cable No Update to Provide 3/9/2010
Glandorf Telephone Company, Inc. ILEC/CLEC No Update to Provide 3/9/2010
GMN Wireless Broadband Fixed Wireless No Update to Provide 3/15/2010
Horizon Telcom, Inc. Fiber No Update to Provide 3/27/2010
Horizon Telcom, Inc. ILEC/CLEC No Update to Provide 3/27/2010
Jefferson County Cable, Inc. Cable No Update to Provide 2/1/2010
Kalida Telephone Company, Inc. ILEC/CLEC No Update to Provide 3/8/2010
KeyOn Communications, Inc. Fixed Wireless No Update to Provide 10/15/2009
LightSpeed Technologies Fixed Wireless No Update to Provide 2/9/2010
Mango Bay Internet Fixed Wireless No Update to Provide 2/23/2010
McClure Telephone Company Fiber No Update to Provide 4/5/2010
McClure Telephone Company ILEC/CLEC No Update to Provide 4/5/2010
Mechcom Dot Net Fixed Wireless No Update to Provide 4/22/2010
Mediacom Indiana LLC Cable No Update to Provide 1/12/2010
Middle Point Home Telephone Company ILEC/CLEC No Update to Provide 1/19/2010
Mikulski Communications LLC Fixed Wireless No Update to Provide 4/13/2010
Minford Telephone Company ILEC/CLEC No Update to Provide 3/3/2010
New Era Broadband, LLC Fixed Wireless No Update to Provide 7/12/2010
New Knoxville Telephone Company Backhaul No Update to Provide 3/12/2010
New Knoxville Telephone Company Cable No Update to Provide 3/12/2010
New Knoxville Telephone Company ILEC/CLEC No Update to Provide 3/12/2010
New Knoxville Telephone Company Fiber No Update to Provide 3/12/2010
North Coast Wireless Communications Fixed Wireless No Update to Provide 4/14/2010
North West Net, Inc. Fixed Wireless No Update to Provide 4/6/2010
Nova Telephone Company ILEC/CLEC No Update to Provide 4/5/2010

nTelos, Inc. ILEC/CLEC No Update to Provide
[JAN-25-2011 Jeff Beebe] Fibernet of Ohio was 
purchased by nTelos.com.

One Communications Corporation Backhaul No Update to Provide 3/18/2010
Ottoville Mutual Telephone Company Backhaul No Update to Provide 12/22/2009
Ottoville Mutual Telephone Company ILEC/CLEC No Update to Provide 12/22/2009
Qwest Communications Company, LLC Backhaul No Update to Provide 1/4/2010
R.A.A. Services Fixed Wireless No Update to Provide 3/12/2010
Redbird Internet Services Fixed Wireless No Update to Provide 3/22/2010
Ridgeville Telephone Company ILEC/CLEC No Update to Provide 3/12/2010
Rtec Communications, Inc. Fiber No Update to Provide 4/13/2010
Rtec Communications, Inc. Cable No Update to Provide 4/13/2010
S. Bryer Cable TV Corp. Cable No Update to Provide 8/16/2010
SAA Bright.net Fixed Wireless No Update to Provide 3/23/2010
Sciotowireless Fixed Wireless No Update to Provide 3/22/2010
Sherwood Mutual Telephone Association ILEC/CLEC No Update to Provide 3/25/2010
Slane Telecom Fixed Wireless No Update to Provide 4/9/2010
Southern Ohio Communication Services Inc. Fixed Wireless No Update to Provide 4/20/2010
Sprint Nextel Corporation Backhaul No Update to Provide 1/14/2010
Sycamore Telephone Company Backhaul No Update to Provide 12/22/2009
Sycamore Telephone Company ILEC/CLEC No Update to Provide 12/22/2009
Talk America Inc. ILEC/CLEC No Update to Provide
Talk America Inc. Backhaul No Update to Provide
TDS Telecommunications Corporation Backhaul No Update to Provide 1/27/2010
Telephone Service Company Cable No Update to Provide 4/6/2010
Telephone Service Company Fiber No Update to Provide 4/6/2010
Telephone Service Company ILEC/CLEC No Update to Provide 4/6/2010
The City of Dover Backhaul No Update to Provide 4/9/2010
tw telecom of ohio, llc Backhaul No Update to Provide 4/21/2010
Wabash Mutual Telephone Company Fiber No Update to Provide 3/30/2010
Wabash Mutual Telephone Company Fixed Wireless No Update to Provide 3/30/2010
Wabash Mutual Telephone Company ILEC/CLEC No Update to Provide 3/30/2010
Waldron Communication Company Backhaul No Update to Provide 3/19/2010
Waldron Communication Company Fixed Wireless No Update to Provide 3/19/2010
Wilkshire Communications, Inc. Fixed Wireless No Update to Provide 3/16/2010
XO Communications, LLC Backhaul No Update to Provide 2/12/2010

Access Ohio Valley, Inc. Backhaul No Update Provided - Use Last Submission Data 3/2/2010

Access Ohio Valley, Inc. Fixed Wireless No Update Provided - Use Last Submission Data 3/2/2010

Frontier Communications Corporation Backhaul No Update Provided - Use Last Submission Data 1/22/2010

Jenco Speed Web Fixed Wireless No Update Provided - Use Last Submission Data 4/28/2010

King Office Service, Inc. Fixed Wireless No Update Provided - Use Last Submission Data 4/9/2010

Nelsonville TV Cable Cable No Update Provided - Use Last Submission Data 4/7/2010



NexGenAccess Inc. Fixed Wireless No Update Provided - Use Last Submission Data 4/16/2010

Skymax Broadband Fixed Wireless No Update Provided - Use Last Submission Data 2/11/2010

Verizon Communications, Inc. Backhaul No Update Provided - Use Last Submission Data 12/14/2009

WaveLinc Fixed Wireless No Update Provided - Use Last Submission Data

Windstream Communications ILEC/CLEC No Update Provided - Use Last Submission Data 1/28/2010

Windstream Communications Backhaul No Update Provided - Use Last Submission Data 1/28/2010
Connect Link, Inc. Fixed Wireless Solicited Initial Data 3/15/2010
First Communications, LLC Fiber Solicited Initial Data
Insight Communications of Central, Ohio, LLC Cable Solicited Initial Data
Reliance Globalcom Services, Inc. Backhaul Solicited Initial Data
UDatanet Fixed Wireless Solicited Initial Data

Advanced Computer Connections Fixed Wireless Refused to Participate

[JAN-25-11 Chip Spann] Jeff Beebe spoke to a 
provider representative who stated they are not 
interested in participating. They are focusing on 
their business-to-business segment and have no 
intentions to do anything with residential now or 
in the future.

Bellaire Television Cable Co. Inc. Cable Refused to Participate

[FEB-10-11 Chip Spann] Jeff Beebe received an 
e-mail from a provider representative and was 
notified that they are not interested in 
participating at this time.

GLW Broadband Cable Refused to Participate

[FEB-18-11 Chip Spann] Provider representative 
and stated that they do not wish to participate in 
our mapping program.

Hocking Internet Technologies, Ltd Fixed Wireless Refused to Participate 8/12/2010

[FEB-14-11 Heather Delany] Provider 
representative indicated they are not interested 
in providing data at this time.  Once county is 
80% covered will participate.  Heather to follow-
up.

Just Micro Digital Services, Inc. Fixed Wireless Refused to Participate 4/13/2010

[JAN-26-11 Chip Spann] Chip received back-to-
back e-mails stating, "Maybe you didn't get the 
memo. We don't do Connected Nation.  Done 
with that. Sorry, pal. Well, not really sorry." That 
message was followed by, "Hey, please remove 
all mapping of our network, by the way.  We 
don't care about it."

Practical Support, Ltd. Fixed Wireless Refused to Participate

[JAN-19-11 Chip Spann]  Jeff Beebe spoke with 
a provider representative at Practical Support 
and it was stated they do not wish to participate.

Safe-t.net Fixed Wireless Refused to Participate

[FEB-17-11 Heather Delany] spoke with a 
provider representative.  They would like to work 
with us, but are not sharing data at this time as 
they are the only wireless service provider in the 
area and feel their data could easily be picked 
out and access points identified for this reason.  
Refused to participate at this time.

WideOpenWest Ohio, LLC Cable Refused to Participate

[MAR-11-10 Terry Holmes] Received voice 
message from company executive, "I spoke with 
my counterparts and we will not share 
information as requested by CN, so you will not 
be receiving information from WOW."  
Subsequent attempts to contact this provider 
have resulted in no response.

Linked Communications, LLC Fixed Wireless Non-Responsive to Multiple Attempts

In addition to multiple contact attempts between 
January 16, 2010 and August 2, 2010, four 
attempts were made during this submission 
period.

Windjammer Communications, LLC Cable Non-Responsive to Multiple Attempts 11/16/2009

In addition to multiple contact attempts between 
October 27, 2009 and August 11, 2010, five 
attempts were made during this submission 
period.

Wireless Intranet Fixed Wireless Non-Responsive to Multiple Attempts

In addition to multiple contact attempts between 
March 10, 2010 and August 4, 2010, five 
attempts were made during this submission 
period.

Covad Communications ILEC/CLEC Other 1/19/2010

[FEB-18-11 Wes Kerr] Provider doesn't offer 
residential DSL, and the last mile data will not be 
included in the data submission.

DISH Network Corporation Satellite Other 1/27/2010

[MAR-09-11 Amanda Bentley] Satellite data will 
not be submitted due to additional information 
being necessary to show where service is 
available in the state, rather than submitting the 
entire state boundary as serviceable area.

Global Crossing Telecommunications, Inc. Backhaul Other

[FEB-17-11 Wes Kerr] Received word from a 
provider representative that they still have a 
Network Security agreement with several 
Federal agencies and cannot provide data at this 
time.



Hughes Network Systems, LLC Satellite Other 2/5/2010

[MAR-09-11 Amanda Bentley] Satellite data will 
not be submitted due to additional information 
being necessary to show where service is 
available in the state, rather than submitting the 
entire state boundary as serviceable area.

WildBlue Communications, Inc. Satellite Other 1/8/2010

[MAR-09-11 Amanda Bentley] Satellite data will 
not be submitted due to additional information 
being necessary to show where service is 
available in the state, rather than submitting the 
entire state boundary as serviceable area.
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1  Introduction 
 
 
This report is submitted along with the third data submission for the 
Oklahoma Broadband Mapping Project.  This submission includes all data 
collected so far per the requirements of the National Telecommunications 
and Information Administration (NTIA) State Broadband Data and 
Development Grant Program (Docket No. 0660-ZA29) Notice of Funds 
Availability (NOFA) and formal and informal Clarifications to it.  
Specifically, it includes broadband data collected from broadband 
providers and Community Anchor Institutions data compiled from various 
sources for the State of WA.  The State of Oklahoma has retained a 
mapping contractor, primed by The Sanborn Map Company for doing all 
work related to the Mapping Grant for this project.   
 
This document is a supplement to the two previous reports submitted with 
data submissions 1 and 2 on May 1, 2010 and October 1, 2010 
respectively.  Therefore, it builds on the document provided with those 
submissions.  Rather than repeat the contents of the previous report, this 
document makes incremental updates on various topics.  For this reason, 
it may be worthwhile to refer to the previous documents, if needed, for 
more details. 
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1 Overall Project Status 
 

1.1 DATA COLLECTION 

 
This section details data collection related to NTIA deliverables which 
include broadband data and community anchor institution data.   

1.1.1 Broadband Data 

 
For submission 3, Sanborn started data collection on January 10th 2011 
by sending out data update requests and technical data specifications 
after NTIA did a Webinar announcing final changes for Submission 3.   
These were sent to a large list of companies which were compiled from 
FCC 477 list (dated December, 2009) and from a list provided by the 
Oklahoma UTC.   The technical document highlighted the changes from 
Submission 1 to Submission 2 and requested incremental data only 
where possible.  Sanborn also uploaded the final data for each provider in 
NTIA format to the Sanborn Provider Portal.  The providers were 
encouraged to use the provider portal and update their information on it.  
Providers are participating through the use of the provider portal and are 
getting used to the process. 

 
Although we sent the technical specifications to all the providers (more 
than those on the FCC 477 list and many that were non-providers earlier 
including resellers and non-valid providers), we followed up actively with 
the providers on the 477 list or those who were already participating, and 
public providers such as PUDs (public utility districts) who were of 
strategic interest to the State of Oklahoma.  This is because most 
providers outside of the FCC list were found to be non-providers of 
broadband.   
 
During this round of the data update, many providers who had refused to 
participate in the program earlier expressed an eagerness to participate.  
This validates the importance of the program, not only for the purposes of 
the government, but also for the providers themselves.   
 
In our solicitation for data updates, we told providers that if we didn’t hear 
from them by a certain date, we would default to using their data from 
Submission 2.  However, we still contacted them after the due date a few 
times but eventually used Submission 2 data if they did not respond. 

 
As with the second submission, we followed the following protocols: 
 

1. We did not collect data from resellers  
2. We have not collected data from satellite providers – we are in the 

process of formulating a strategy to map coverage from satellite 
providers and anticipate that we will have some coverage for 
satellite providers in our next delivery to NTIA (Submission 4, due 
to NTIA on October 1, 2011). 
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1) Three satellite providers have been identified in Oklahoma 
– Hughes, Starband, and Wildblue.   

3. Affiliates, subsidiaries etc. have been counted as providers.  
Please note that data for these entities may or may not be 
reported as a separate FRN if they share the same FRN as their 
parent company.   

4. We have not undertaken any propagation analysis for wireless 
providers who did not already have their own propagation maps. 
We are considering doing that for the next submission. 

 
This submission process went smoother than previous submissions. 
There were a few minor issues that need to be resolved from previous 
submissions.   
 

1) Spectrum:  Larger providers are still not willing to provide 
separate polygons for different spectrums.   

2) Communication with providers:  It would help with data 
collection if NTIA/FCC held an open forum with the 
providers for changes that are being proposed for that data 
collection.  This should happen before States start data 
collection and also providing all change information on an 
NTIA website to the providers so that they are not 
questioning the credibility of the request from States. 

3) Information from NTIA:  It would be very helpful to have 
information on changes in data model, requirements and 
specifications before the data collection is started.  Ideally, 
in order to meet the next deadline of October 1 (for data 
good as of June 30, 2011), we would need to send out a 
data request to providers in the July 1-3 timeframe and 
giving them 3-4 weeks for preparing data and submitting it 
to us (given the holidays and the summer, it is important to 
give providers sufficient time to assimilate all data).  
Therefore, NTIA would need to get all changes finalized by 
June 30th so that we can hit the road immediately after 
that.  This lead time allows us to provide more desirable 
time spans to the providers, and for us and the states to do 
the right amount of validation. As the process becomes 
smoother for everyone, we anticipate that this will happen 
more regularly in the future. 

1.1.2 Community Anchor Institutions Data 

 
The community anchor institutions data continues to be crowd-sourced 
through the online data gathering application created by the Sanborn 
Team. The State of Oklahoma is doing the PR around this data collection 
and contacting the relevant agencies to request them to fill in data.  This 
has been a slow process and we are getting to a point of diminishing 
returns with this effort.  The numbers of community anchor institutions 
that have responded so far is provided below: 
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Category Name Total 

Total with 
Broadband  
Information in 
Submission 3 

1 School - K through 12 1959 103

2 Library 209 66

3 Medical/healthcare 441 0

4 Public Safety 1793 8

5 University, college, other post-secondary 79 16

6 Other community support - government 489 18

7 
Other community support - 
nongovernmental 15 1

 

 
 
Community Anchor Institution: Crowd sourcing Portal 
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1.2 DATA PROCESSING 

1.2.1 General Overview 

In general, the submission 3 processes followed the same basic 
approach that was used in Submission 1 (s1) and Submission 2 (s2). As 
mentioned before, the submission 1 and 2 process documentation was 
included with those submissions and may be worth looking at for details if 
needed.  The following sections outline the modifications made to the 
initial processing in order to meet the submission 3 requirements as 
defined by NTIA. 
 
In summary they can be divided into the following three categories: 
 
• Process Modifications 
• Reference Data Modifications 
• NTIA Submission Data Model Schema Changes 

1.2.2 Submission 3:  Process Modifications  

Based on NTIA feedback and information provided in NTIA webinar 
sessions, the submission 3 data processing workflow was changed 
minimally to support the new NTIA submission requirements: 
 
1. All census blocks are mapped based on 2000 census blocks.  Any 

data submitted in 2009 format was converted to 2000 for 
submission.  During processing a ‘hybrid’ census dataset (2000 
IDs with 2009 line work) was used to take advantage of the 
improved 2009 line work.  Prior to submission to NTIA, all features 
were mapped back to the 2000 census blocks.  The Reference 
Data section below contains additional details. 

2. For consistent representation the state road reference data used 
was 2009 Census Tiger Line IDs (TLIDs).  Other data sources 
(non-TLID features, or 2000 TLID features) were mapped to 2009 
TLID features. 

3. Overview was removed completely from submission data due to 
the fact that all maximum advertised up/down speeds are being 
reported in blocks, roads, and wireless features. 

4. Due to our NDA restrictions, address points and last mile points 
will not be submitted to NTIA.  As mentioned before, Qwest 
requested that their address points be submitted to NTIA for 
blocks greater than 2 square miles.  However, they could not 
provide the end user category and hence this data was not 
submitted but reprocessed data (address points reprocessed to 
street segments) are being submitted. 

5. Some providers did not submit middle mile elevation.  Wherever 
possible, we went back to providers to obtain their middle mile 
elevation information. 

6. Terrestrial Mobile Wireless and Terrestrial Fixed Wireless 
(licensed and unlicensed) were treated as wireless coverage and 
were delivered as a shape.  In cases where a provider served the 
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same technology and spectrum with different speeds, overlapping 
areas were removed and the higher speed was assigned. 

7. The submission 3 Provider data model is currently based on the 
NTIA data model as of 1/13/2011.   

 

1.2.3 Submission 3: Reference Data modifications 

This section describes the reference data used in submission 3.   
 
BLOCK REFERENCE 
For s3, a hybrid block dataset (2000 IDs with 2009 line work) was used to 

take advantage of the improved 2009 geometry.  The data was set 
up as follows: 

• 2009 BlockID suffix is dropped and the blocks are dissolved (by 
Block ID) to produce data with 2000 BlockIDs and 2009 shape 
geometry 

• Block size (AREA) is calculated combining the 2000 land area 
(ALAND) and water area (AWATER) 

• AREA is converted from square meters to square miles to 
calculate square mileage (SMI). 

• If the SMI of a block is less than or equal to 2, then the less than 
or equal to 2 square mile indicator (LE2SMI) is set to true. 

 
ROAD REFERENCE 
To take advantage of the 2009 geometry improvements, 2009 Tiger Line 

IDs (TLID) were used for data processing in s3.   Any non-2009 
TLID (i.e. 2000 TLID or other) submitted by providers were 
mapped to the 2009 reference data.  The data was set up as 
follows: 

• The GT2SMI (Greater Than 2 Square Mile) indicator is set to True 
when: 

o The 2009 road segment is completely within a hybrid block that is 
NOT less than 2 square miles 

• Only minimum and maximum address ranges and a single zip 
code for each road segment is maintained.   

 
OVERVIEW REFERENCE 
This dataset was dropped completely for this submission. 
 

1.2.3.1  Reference data sources 
 
The following data sources were used as reference data sources for 
submission 3: 
 
BLOCK REFERENCE DATA:  2009 CENSUS BLOCKS 
No changes from previous submission. 
 
ROAD REFERENCE DATA:  2000 CENSUS TIGER LINES 
No census 2000 TIGER line data were used for this submission.  
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ROAD REFERENCE DATA:  2009 CENSUS TIGER LINES 
No changes from previous submission 
 
OVERVIEW REFERENCE DATA:  2009 CENSUS COUNTIES 
This data has not been included in Submission 3 
 

1.2.4 Submission 3: NTIA Submission Data Model 
Schema Changes 

 
The data model released on January 13, 2011 contained the following 
changes from the s2 data model: 

 

• A new field was added to several feature classes called Provider 

Type 

o Provider Type is “Short Integer” and has domain values of 

1, 2, or 3 (1=Broadband Provider, 2=Reseller, 3=other) 

o Most providers are calculated to be “1” (Broadband 

Provider).  In some cases (e.g. State of Oklahoma Public 

Utility Districts or PUDs), the ProviderType is considered 

“Other” (value = 3) 

• In the CAI feature class, the field BBService has been modified: 

o In S2, if the information was not known, the field was left 

blank (null) 

o In S3, if we do not have the information, NULL values must 

be changed to code u (for Unknown) – nulls are not 

allowed. 

 

• Three new fields have been added to the CAI feature class.  

Wherever possible, these values have been populated in the CAI 

data.  

o Public Wifi (Y, N, or U) 

o URL 

o CAIID  

 

1.3 Data Validation 

 
Sanborn has continued to perform the same validation on the data as the 
previous two submissions and listed below (details in previous reports).  
Some minor updates to the validation process are discussed below. 
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1) QC of the data at various steps  

2) Spatial checks against public and commercial datasets 

a. For WA, we continued to use the following datasets for 

validation: 

i. Exchange Boundaries:  for DSL boundaries 

ii. MediaPrints:  for Cable boundaries 

iii. Speedtest.net data 

3) Verification by providers 

a. In this Submission, along with the standard verification by 

providers using the Provider Portal, we also identified for 

providers issues that they needed to focus on regarding the 

findings of our validation team.  This was done by sending 

them a letter that identified issues using screenshots and 

explaining to them what the error was and then asking them to 

go fix those errors using the secure provider portal.  A sample 

of a letter is provided in Appendix A in this document.  This 

helps by making this process a little more targeted for the 

providers and allows them to hone into issues. 

4) Speedtest data collection and other data collection for verification  

a. We continue to use speedtest data and community anchor 

data crowdsourced for validation purposes. 

5) Planning workshops and local validation 

a. During this submission, local validation was undertaken by an 

independent group, the Center for Spatial Analysis at the 

University of Oklahoma (OU).  OU performed an independent 

survey gathering data points from CAI’s and the GIS 

community for the State of Oklahoma.  Within Sanborn’s 

validation process, OU’s points were compared against 

provider’s data. Those data points found in question were 

taken back to the providers for correction. OU is continuing to 

gather data and this process will be performed throughout 

Submission 4.  

1.3.1 Data Validation Conclusions 

 
We continue to believe that we do not have sufficient information to alter 
provider data and we have been careful not to do so unless there are 
obvious errors such as incorrect block numbers, or unidentifiable street 
segments, etc. 
Data validation involves working with providers to improve the data and 
we are dealing with issues as they arise.  This activity continues to be a 
challenging activity.  There is no complete truth sometimes and different 
pieces of evidence are collected and pieced together to point 
discrepancies that are explored in more detail.  Commercial datasets are 
of limited value and often self-reported by the companies and subject to 
the same errors that we get from providers directly, and sometimes 
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exaggerated by the fact that there are different vintages and resolution 
and hence the comparison is not easy.   Speed test locations are also 
sometimes incorrect and similar issues exist with all crowd-sourced data.  
 
There is no absolute truth exists and that data validation cannot change 
data arbitrarily based on only one evidence or two.  Hence it takes a long 
period of time to fully address a reported issue. 
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2 Appendices  

2.1 Sanborn QC_Validation Letter 

 
 
March 9, 2011 
 
 
Broadband Mapping Services 
State of Oklahoma 
 
 
Re: QC and Validation of Provider Data 
 
 
Dear Provider: 
 
As part of the Broadband Program, the Sanborn Map Co. is performing a QC and validation of the data 
received from you by comparing your data to publicly and commercially available broadband datasets. This 
includes exchange boundaries for DSL, MediaPrints for Cable and Fiber and others as deemed necessary.  We 
are also using Speedtest.net data for some speed validations.   
 
If you are receiving this notification, it is because we have found certain issues that need your assistance. 
Screen shots of the issues are provided below along with a table denoting the issue found. We would 
appreciate it if you would please review these issues quickly and go to the provider portal and note the 
correction that needs to be made since we need to finalize your data to be submitted to NTIA.  
 
If you need any further clarification after reviewing the issue, please contact Bridget Marcotte at (503) 228-
8708 x 306. Please note: if we do not receive a response from you with what correction needs to be made, 
Sanborn reserves the right to change the data if needed.  
 
Thank you very much for your assistance providing answers on the issues noted below.  
 
Sincerely, 
The Sanborn Broadband Mapping Team  
 
 

QC and Validation Issue(s) Encountered 
 
Please make all corrections on the provider portal link provided below. For confidentially, your login 
and passwords were sent during the last submission, in another email. 
 
http://beta.appgeo.com/OklahomaBroadbandProviderPortal/ 

 
Issue found: 

Issue Category Description/Screen Shot 
Part of the data is 
extending outside Media 
Prints boundaries 

 

Part of the data is  
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extending outside of 
Telephone Exchange 
boundaries 
Spatial Outliers - data 
which is off by itself and 
not consistent with 
other data spatially  

 
Areas within the red circles are examples of spatial 
outliers in your data 

Independent Validation 
point showing there is 
NO service in this area 

Block Numbers Affected: 

Middle mile has 
missing/invalid 
elevation 

 

Invalid Max Advertised 
Speeds 
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1 Overview 
The following describes the Data Gathering, Data Integration, Data Validation and Verification and Quality Control 

processes utilized to create the Broadband Mapping Project’s April 1
st

, 2011 data submission.   

 

To support various levels of technical and program knowledge, this white paper supplies both a high level 

summary and a detailed process review. 

 

2 High Level Review 

2.1 Data Gathering - Providers 

Broadband Service Area, Middle Mile Aggregation Points and Broadband Service Overview 

The collection of Broadband Service areas, Middle Mile Aggregation points and Broadband Service Overview 

information is handled through the following Provider Outreach Process: 

 

 Build and Maintain an Inventory of Broadband Providers through research and State inputs. 

 Update Provider Material that describes the data requirements and logistics for data transfer. 

 Update NDA for use in project, where applicable 

 Maintain multiple protocols for the provider to submit data, including SFTP technology when desired.   

 Conduct one-on-one informational discussions with each provider to communicate the following: 

o Requirements of this project 

o Broadband data required to support the product data model 

o Submission protocols available 

o Capability to validate how the supplied data is aggregated 

 

 Download/receive Provider Data 

 Establish a repeatable process with Provider. Maintain Provider communication, transaction and data 

handling records throughout the project (dates contacted, data received, etc.)  
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2.2 Data Gathering - Community Anchor Institution (CAI) 

The collection of CAI information is handled through the following CAI Collection Process: 

 Collect and maintain inventory of CAIs through Data Mining, research, and State inputs. 

 Maintain web-based CAI portal for institutions to add or confirm attribution, location and enter 

broadband-specific information. 

 Upload web-based data to Core Database for standardization. 

 Perform internal cleansing, such as removing duplicate records, identifying gaps in broadband attribution 
and verifying category.  

 Geocode CAI locations.  

 Translate Core Database data to deliverable ready format.  

 Continue engagement with non-responsive institutions. 

 

2.3 Data Integration Process 

 

The data integration and processing mechanisms currently utilized allow for multiple types of inputs and results in 

a standardized output that meets the NTIA deliverable requirements. This process is flexible to support data model 

changes and project requested enhancements.  

 

 Receive inputs from Providers via submission protocols, upload into Sourcing Database and catalog with 

provider information.  

 Review Provider supplied data for completeness and for potential discrepancies that require resolution 

prior to processing and flag as necessary. 

 Categorize input into data type category (addresses, block lists, paper maps, etc.). 

 Standardize input based on data type within Staging Database. 

 Create Compact Polygons (CP)—(internal methodology for generating area based feature for coverage in 

Staging Database). 

 Apply broadband attribution to CP, Apply metadata to CP 

 Perform quality analysis of the CP against the source supplied to identify any completeness or accuracy 

issues.   

 Request additional information from the provider if elements of coverage are missing or contain 

discrepancies.  This is a second manual quality check to ensure data is complete.   Following completion of 

CP creation, process steps within Data Validation & Verification occur 

o Process coverage area to build the required NTIA data model layers  

 

 Process CAI data input into internal standardized format, as mentioned above under CAI Create Product 

Deliverable based on NTIA and State-level requirements. 

 Following the creation of the product, process steps within Data Validation & Verification occur 
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2.4 Data Validation & Verification 

 

To ensure the data collected and processed is as accurate and comprehensive as possible, provider validation and 

internal verification activities are utilized. Following the initial mapping of providers’ coverage area and 

serviceability claims, additional reviews are performed using the following methods:  

 

 Third-Party Data Verification: Visually and programmatically compare the coverage against third-party 

data.  

Pitney Bowes and American Roamer data are used in cases where a coverage area is questionable.  All 

anomalies identified during this analysis are reviewed with the providers. 

 

 Broadband Provider Validation – Provider Portal Application:  Providers are trained on and requested to 

use a secure interactive web application to review their current coverage area(s) and supporting 

broadband attribution and validate their data or submit change requests to update their data. 

 

All provider change requests go through the Data Integration Process and a review with the provider to 

complete validation. 

 

 Confidence Values:  All Verification, Validation, and manual quality review results are tracked by provider 

/ technology type and stored and maintained within a “Validation” table.  A confidence value is assigned, 

based on internal assessments of the collected information, to highlight the provider coverage areas 

and/or attributions that would benefit from further investigation and/or enhancements. 

 

2.5 Quality Control 

Following collection, processing and analysis of the provider and CAI data, the product is checked manually and 

algorithmically against the NTIA data model.  Some of the items included within these checks are as follows:   

 Format Correctness 

 Table & Field Structure  

 Valid Values 

o Including default values, where applicable 

 Geographic Extent and Topology Errors 

 

Prior to data submission, another quality control script supplied by NTIA is run.  This script, 

SBDD_CheckSubmission.py, creates an output in text form that is required to be submitted along with the final 

deliverable.  All errors must come up clean, unless otherwise specified from NTIA. 

Exceptions to the script as noted by NTIA on the SBDD Workspace on 03/25/11 at the following link: 
https://sbdd-granteeworkspace.pbworks.com/w/page/38218329/CheckSubmissionExceptions  

- Longitude values for States outside the lower 48 (any table) 

https://sbdd-granteeworkspace.pbworks.com/w/page/38218329/CheckSubmissionExceptions


            

7 

- CAI results for Transtech, MaxAdUp, MaxAdDown if BBService is ‘No’ or ‘Unknown’  

- Overview MaxAdDown, MaxAdUp if 100% of record level data has MaxAdDown or MaxAdUp 

populated 



            

8 

 

3 Detailed Process Review 
Below is a detailed review of the data collection, integration and quality control points along the broadband data 

gathering and mapping process. 

 

Diagram of overall process: 

 
 

3.1 Provider Outreach 

For the April 2011 data submission, an e-mail notification was sent to all providers with supporting deliverable 

dates.  The Provider Portal web application was released and training webinars held so providers could use this 

application to submit changes to and/or validate their current coverage area(s). 

 

Data was also collected from the providers via e-mail and SFTP, depending on their comfort level to submit data in 

time for the April 1
st

 deadline. 

 

In support the data collection effort, providers that did not timely respond to the outreach were contacted by 

phone. 
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3.2 Outreach Materials 

The original provider packet sent via email to the providers included the following documents and files: 

1) Letter from the State inviting them to participate in the program 

2) Copy of the non-disclosure agreement (NDA) 

3) Copy of the Mapping NOFA from the NTIA 

4) Copy of the NOFA Clarification from the NTIA 

5) Broadband service address example file in CSV format 

6) Word document describing service address example file 

7) Broadband service block example file in CSV format 

8) Word document describing service block example file 

9) Broadband service street example file in CSV format 

10) Word document describing service street example file 

11) Broadband subscriber example file in CSV format 

12) Word document describing subscriber example file 

13) Broadband wireless coverage area sample shapefile 

14) Word document describing wireless coverage area sample shapefile 

15) Instructions for downloading, installing, and using the WinSCP secure FTP application 

 

3.3 Outreach Process 

The provider outreach process is comprised of the following general steps: 

1) Send the provider package and introduction letter to the main point of contact for the provider 

2) Follow up with email and call to verify that the main point of contact is correct. 

3) If necessary, discuss the NDA further and resolve any redlines. 

4) Once the correct primary contact is established, set up a call, if necessary, to learn more about the 

provider’s offerings and direct them to the appropriate outreach materials. 

5) If providers are unable to be contacted (non-responsive) or indicate that they are not interested in 

participating (non-cooperative) mark them as such on the provider tracking sheet. These providers will be 

escalated to the state for further action. 

6) As the providers are collecting the required data, provide instruction on downloading, installing, and using 

the WinSCP secure FTP application, if required. 

7) Arrange with the providers to transfer the data in whatever way they are comfortable. Some providers 

will find regular email acceptable. Others will want to use the secure FTP application. 

8) After data is received and reviewed, it may be necessary to contact a provider for clarification or to 

address incomplete data sets. In the interest of building and maintaining relationships, care is given not to 

push the provider but to work with it to obtain accurate data in the best possible format. 
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3.4 Data Collection 

3.4.1 Data Transfer Procedures 

There are three primary ways data is collected from providers. These are: 

1) Secure FTP using the WinSCP application 

2) Regular email 

3) Mail 

 

3.4.2 Initial Data Review and Quality Assurance 

The initial data review and quality assurance process consists of the following general steps: 

1) Access the data from the secure FTP site or email 

a. If emailed, place copy of original data set in the appropriate provider folder on the secure FTP 

site 

2) Place copy of raw data on local computer in a working directory. 

3) Review data and determine course of action based on type of data received. 

4) Ensure data is complete and contact provider to address any gaps. 

Note: The goal is to get as many providers as possible to provide subscriber address data in the correct format. 

Obviously, this will not be possible with all providers so we will continue to have to process various types of 

provider-supplied data. 
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3.5 Data Ingestion 

3.5.1 Data Ingestion Overview 

The following outlines the process steps taken based on the type of input supplied by the data provider: 

Point Data 

 Subscriber location 

 DSLAM location 

 Central Office location 

 Broadcast Tower location 

Linear Information 

 TIGER street segments 

Polygonal Information 

 Census Blocks 

 Coverage Area 

Overall, the process is geared toward taking the provider data supplied and creating polygon shapes to append to 

the bb_cov feature class. The bb_cov feature class is the interim data set that is then processed using the 

makeDeliverable.py Python scrip to create the MapConnect data layers that will be delivered to the state and, 

ultimately, to the NTIA.  Following are the detailed instructions used in this process.  

 

3.5.2 Point Data 

3.5.2.1 Subscriber Location – Address Data 

In the event that the data provider supplies subscriber address data the following actions occur: 

1) First, convert the address data to a clean Excel spreadsheet in an appropriate address data format. 

a) Usually, this has the following columns: street address (number, pre-directional, pre-modifier, street 

name, street type, post-directional, and post-modifier concatenated together), city, state, ZIP. 

2) Configure the ArcGIS geocoding tool to use the TIGER 2009 streets dataset 

a) In ArcCatalog, create a new Address Locater by right-clicking in the white space of the appropriate 

directory and selecting New>Address Locater from the dropdown menu. 

b) Select “US Streets with Zone” and press OK. 

i) Note: It is likely that multiple Address Locators will have to set up to handle the variety of 

provider address data received. 

c) Navigate to the TIGER Streets 2009 file and press OK. 

d) Fill in the dialog box as seen below: 
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e) Click OK. 

3) Open up ArcMap, and add the Excel spreadsheet with the address information. 

4) Right-click on the Excel spreadsheet and select Geocode Addresses from the dropdown menu. 

5) Select the appropriate address locator by clicking Add…. then OK. 
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6) Fill out the Geocode Addresses dialog box as shown below: 

 

 
 

7) Geocode the list in batch mode using the geocode service set up in Step 2 above, accepting all the default 

parameters. 

8) Review results. 
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9) Adjust geocoding parameters accordingly and repeat batch to resolve issues. 

10) Manually geocode unmatched addresses until target hit rate achieved, generally 90%. 

11) Visually inspect the data as seen below: 
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12) Follow the steps detailed in Subscriber Location – GIS Data below 

 

3.5.2.2 Subscriber Location – XY Data 

If the provider supplies a list of subscriber data with accompanying XY data such as latitude and longitude, the 

steps are as follows: 

1) Refine the format in Excel so that the data can easily be opened using ArcMap. 

a. Remove all font color, highlighting, cell colors and borders, clean up column headers and make 

sure there are no merged cells. 

b. Make sure that XY locations are in decimal degrees. 

i. To convert from degrees, minutes, seconds (39º 26’ 45.67”) to decimal degrees us the 

following formula: DD + (MM/60) + (SS.SSS/3600). 

ii. Note: if XY locations from some other coordinate system are provided, you can use 

those in the process below but you must know what the coordinate system is. 

2) Open up the Excel worksheet in ArcMap. 

3) From the menu bar, select Tools>Add XY Data… 
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4) Supply the appropriate fields for the X and Y coordinates, choose the appropriate coordinate system and 

press OK. 

5) Results are an event layer, not a true spatial layer. Export the data by right-clicking the event layer and 

selecting Data>Export Data… from the dropdown menu. 

6) Follow the steps detailed in Subscriber Location – GIS Data below. 

 

3.5.2.3 Subscriber Location – GIS Data 

If the provider supplies subscriber location in GIS format, the only process step is to load that data into the 

appropriate data schema and it will be ready for processing. 

1) First, load the data into the Point Address database schema (please see Appendix D for an example of the 

Point Address database schema.) using an empty feature class in that schema. 

2) In ArcCatalog, right-click on the empty feature class and select Load from the dropdown menu. 

3) Navigate to the provider address GIS data set and then map the attribute fields accordingly, as seen in 

general below: 
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4) Once you have successfully loaded the provider address data into the temporary database with the 

correct schema, you will now append that data to the overall Point Address database. 

5) In ArcToolbox, use the Append command (Data Management Tools>General> Append) to add the 

features into the overall Point Address database, as seen in general below: 
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6) Since the data is already in the Point Address database schema, there is no n need to alter the Field Map 

in the Append tool. 

7) After appending, calculate metadata reflecting geometry source and representation values. 

8) Break provider-specific points into separate county feature classes and perform the following steps per 

county feature class: 

a. Within ArcGIS 

i. Summarize download and upload speeds [first,last] to determine all speeds available for 

county. 

1. This will save as a DBF table. Keep track of location for future reference. 

ii. Buffer county address point featureclass to 150’.     

1. During buffer command, dissolve on “ad_down”; ”ad_up”; ”provider”; “dba”; 

“frn”; “tt”; ‘all metadata fields’; “stctyfips”.    Save as…. 

county_fastestdown_fastestup.  

2. (Example using Qwest data: boulder_40128_20128, where boulder=county;  

40128=ad_down; 20128=ad_up) 

3. Note: these attribute fields are specific to the Point Address database. 

iii. Select the features that represent the lowest speeds 

b. Using XtoolsPro (http://www.xtoolspro.com/)  

i. In the XTools Pro toolbar, select XTools Pro>Layer Operations>Erase Features 

ii. Use the same feature class for Input and Overlay 

iii. Check Use selected features on the Input feature, as seen below. 

http://www.xtoolspro.com/
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iv. Repeat and erase slowest speeds one speed at a time.  Saving each new feature class as 

the next slowest speed, using the same naming convention as above. A general example 

is seen below: 

 

 
 

c. Within ArcGIS 

i. Edit/delete speeds from the attribution table of each feature class, so each remaining 

feature class has only one speed value. 

ii. Merge individual speed feature classes together using the Merge command in 

ArcToolbox (Data Management Tools>General>Merge). The dialog box is seen below:  
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iii. Merge individual county feature classes together using the Merge command in 

ArcToolbox (Data Management Tools>General>Merge).  

iv. Since the county files are all in the same schema, do NOT alter the Field Map portion of 

the command interface. 

v. When all the county files are merged together into one dataset, use the Append 

command in ArcToolbox (Data Management Tools>General>Append) to add the 

features to the bb_cov interim data set. Use the Field Map portion of the Append tool to 

map the appropriate field values to their corresponding fields in the bb_cov feature 

class. 

 

3.5.2.4 DSLAM or Central Office Location – Address Data 

In the event that the provider supplies DSLAM (digital subscriber line access multiplexer) or Central Office address 

data please follow the steps below: 

1) Follow the process for geocoding points in Subscriber Location – Address Data, above. 

2) Follow the steps detailed in DSLAM or Central Office Location – GIS Data below. 

 

3.5.2.5 DSLAM or Central Office Location – XY Data 

In the event that the provider supplies DSLAM (digital subscriber line access multiplexer) or Central Office XY data 

please follow the steps below: 

1) Follow the process for creating points from XY data  in Subscriber Location – XY Data, above. 

2) Follow the steps detailed in DSLAM or Central Office Location – GIS Data below. 

 

3.5.2.6 DSLAM or Central Office Location – GIS Data 

In the event that the provider supplies DSLAM (digital subscriber line access multiplexer) or Central Office GIS data 

please follow the steps below: 

1) Buffer the DSLAM/Central Office points feature class 

a) Add the point feature class to ArcMap 

b) Open up ArcToolbox and go to Analysis Tools>Proximity>Buffer 

c) Set the buffer distance to 5 miles 

d) Set the dissolve type to ALL 

e) Name the output feature class 

f) Typical Buffer tool is seen below: 
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g) Press OK 

2) Use the resulting buffer feature class to clip the TIGER street layer (as described earlier): 

a) Add TIGER street layer to ArcMap 

b) Open up ArcToolbox and go to Analysis Tools>Extract>Clip 

c) Complete the dialog box as seen below: 

 

 
 

d) Press OK. 



            

22 

3) Using ArcCatalog and within the file geodatabase: 

a) Right Click and create a new Feature Dataset  

i) For the Feature Dataset settings: 

(1) Name the feature dataset accordingly 

(2) Select horizontal coordinate system by importing the coordinate system associated with the 

clipped TIGER street layer by selecting Import and navigating to the location of that feature class 

(3) No vertical coordinate system needed 

(4) Leave all x,y,z,m values at default. 

(5) Press Finish 

4) Import previously created street feature class into new Feature Dataset 

5) Right-click Feature Dataset and create new Network Dataset – accept all default setting for the Network 

Dataset 

a) Note: the Network Analyst extension must be turned on 

6) In ArcMap Turn on the Network Analyst Toolbar by going to View>Toolbars>Network Analyst 

7) Add the Network Dataset created in Step 5 to ArcMap 

8) Using Network Analyst Toolbar drop down – create “New Service Area” 

9) Open up the Network Analyst Window by selecting the  button. 

 

 
 

10) Right click Facilities layer, select Load Locations, and navigate to the DSLAM/Central Office facilities feature 

class. 
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11) Press OK. 

12) Click the Service Area Properties button  

13)  For the following tabs change the following properties: 

a) “Polygon Generation” tab  

i) Select “Merge by break value”  

ii) Also disable the Trim Polygons option 

b) “Analysis Settings” tab – using and converting the specified DSLAM buffer distance from feet to meters – 

input buffer distance value in meters into the “Default Breaks” location 

i) Generally, 18,000 feet (5486 meters) from DSLAM or Central Office location is used as the buffer 

distance 
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c) Click OK. 

14) On the Network Analyst Toolbar click the “Solve” button  to create service area polygons. 

15) Right-click on the created service are polygon in the layer list, and select Data>Export Data from the dropdown 

list. 

16) Export to a feature class in the file geodatabase you created earlier 

17) In ArcCatalog, create an empty feature class with the schema of the bb_cov feature class and load the feature 

class created in Step 16 into it. 

a) Right-click on the empty feature class, select Load>Load data from the dropdown menu and navigate to 

the location of the service area feature class 

b) Press the Add button, hit Next 

c) Accept the defaults and hit Next 

d) Do NOT attempt to map any fields, as seen below: 
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e) Press Next, then Next again, then Finish. 

18) In ArcToolBox, go to Data Management Tools>General>Append 

19) Append the formerly empty feature class to bb_cov, completing the dialog box as seen below: 

 

 
 

20) Leave the Schema Type as TEST 
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21) Press OK. 

22) In ArcMap, open up bb_cov for editing and manually input associated attribution. 

 

3.5.2.7 Broadcast Tower Location – Address Data 

In the event that the provider supplies wireless broadcast tower location address data please follow the steps 

below: 

1) Follow the process for geocoding points in Subscriber Location – Address Data, above. 

2) Follow the steps detailed in Broadcast Tower Location – GIS Data below. 

 

3.5.2.8 Broadcast Tower Location – XY Data 

In the event that the provider supplies wireless broadcast tower location XY data please follow the steps below: 

1) Follow the process for creating points from XY data  in Subscriber Location – XY Data, above. 

2) Follow the steps detailed in Broadcast Tower Location – GIS Data below. 

 

3.5.2.8.1 Broadcast Tower Location – GIS Data 

In the event that the provider supplies wireless broadcast tower location GIS data please follow the steps below: 

1) Download the required software (Radio Mobile) from the website: 

http://www.cplus.org/rmw/english1.html  

2) Install the software according to the standard directions, found here: 

http://www.cplus.org/rmw/download/download.php?S=1  

3) Open up the application 

4) Load the broadcast tower location and elevation information by selecting File>Unit properties. The 

following dialog box appears: 

 

http://www.cplus.org/rmw/english1.html
http://www.cplus.org/rmw/download/download.php?S=1
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5) Add in the information for all the towers supplied by the WISP data provider, including the elevation. If 

provider does not supply elevation, this information can be obtained from Google Earth. 

a. I f available, use the Import button to import a Google Earth KML of the tower locations. 

6) Go to the National Map Seamless Server (http://seamless.usgs.gov/) and download elevation data 

sufficient to contain the tower locations. 

a. At least the 1/3” NED data is needed. Select this by clicking the Download button in the upper 

right of the web site and checking the box nect to 1/3 “ NED. 

b. Zoom to the area of interest and use the Download tools: 

 
to define the area to download. 

c. Click the Modify Data Request button to request the data in BIL_16INT format, not ESRI GRID, as 

seen below: 

 

http://seamless.usgs.gov/
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d. Download the data and unzip it. 

7) Select File>Map Properties to define the map 

8) Enter in a latitude and longitude in the center of the tower locations 

9) Set the size (in pixels) and the size (in kilometers) of the map 

10) Set the directory path leading to the BIL elevation data just downloaded 

11) The dialog box is seen below: 

 
 

12) Hit Extract. 
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13) The elevation data is render as a hill shade, as seen below: 

 

 
 

14) Select File>Network properties from the main menu 

15) Create a new network and enter in the frequency range under the Parameters tab, as seen below: 
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16) Leave all the other values as they appear, and select the Systems tab 

17) Create enough systems to cover all the varieties of equipment in the provider network. This will include 

the antenna type, height, and line loss, as seen below: 
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18) Now click on the Membership tab, and assign the individual towers to their respective systems, providing 

the azimuth for non-omnidirectional antennas, as seen below: 
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19) Press OK. 

20) Select Tools>Radio Coverage>Combined Cartesian from the main menu 

21) Complete the dialog box as seen below, providing the Maximum Range from the highest tower beam 

radius supplied by the provider. 

22) Set the Pixel Size at 5 (experiment depending on the area covered to get the right level of granularity) as 

seen below: 
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23) Set the signal range to draw to S-Unit and type 5 in the From (>=) box. 

24) Press Draw. 

 

 
 

25) Save the resulting image as a TIF by selecting File>Save Picture as. 

26) Open ArcMap and load the BIL elevation data you used in Radio Mobile. 

27) Load the TIF image you created and georeference it using the corners of the BIL data. 

a. The corners of the data can be seen in the TIF image. 
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28) Follow the georeferencing directions from the Coverage Area – PDF/JPG/Other Image Format section 

below. 

29) Use the Georeferencing Toolbar to Update the Georeferencing for the TIF data set. 

30) In ArcToolbox, select Data Transformations>From Raster>Raster to Polygon and input the georeferenced 

TIF you just created as seen below: 

 

 

31) Open the resulting polygon feature class up for editing using the Editing toolbar in ArcMap and clean up 

as necessary. 

32) In ArcCatalog, create an empty feature class with the schema of the bb_cov feature class and load the 

feature class created above into it. 

a. Right-click on the empty feature class, select Load>Load data from the dropdown menu and 

navigate to the location of the service area feature class 

b. Press the Add button, hit Next 

c. Accept the defaults and hit Next 

d. Do NOT attempt to map any fields, as seen below: 

 

 
 

e. Press Next, then Next again, then Finish. 

33) In ArcToolBox, go to Data Management Tools>General>Append 

34) Append the formerly empty feature class to bb_cov, completing the dialog box as seen below: 
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35)  Leave the Schema Type as TEST 

36) Press OK. 

37) In ArcMap, open up bb_cov for editing and manually input associated attribution. 

 

3.5.3 Linear Data 

3.5.3.1 TIGER Street Segments – List, Spreadsheet, or GIS Data 

In the event that the provider supplies TIGER street segments in list or spreadsheet format please follow the steps 

below: 

1) Join TIGER road segments  to 2000 census blocks feature class using one of two methods based on how 

the data is provided: 

a) If the TIGER data is provided with a Census Block ID, then join the segments to the Census Block 

geometry based on that ID 

i) Load both data sets into ArcMap 

ii) In the layer list, right-click on the 2000 census block feature class and select Joins and 

Relates>Join 

iii) In the dialog box, select the TIGER road segments data and the proper attribute fields for joining, 

as seen below: 
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iv) Press OK 

b) If the data provided is a list containing TLIDs,  then join to the TIGER line data using the TLID, and use 

a spatial join to associate the TIGER segment with the coterminous block based on the block ID 

i) Load both data sets into ArcMap 

ii) In the layer list, right-click on the 2000 census block feature class and select Joins and 

Relates>Join 

iii) Select “Join data from another layer based on spatial location” from the dropdown menu 

iv) Complete the dialog box as seen below and press OK. 
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2) Export joined records into a temporary feature class. 

3) If joined Census Block geometry is confined to one specific area then dissolve blocks into one record.  If 

joined Census Block geometry is distributed throughout a particular state then dissolve sub-selections of 

census blocks for each county. 

a) Use the County FIPS code to dissolve by county. 

b) In ArcToolbox, select Data Management Tools>Generalization>Dissolve 

c) Complete the Dissolve dialog box as seen below: 
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d) Press OK. 

4) For each dissolved region, open up the feature class for editing using the Editing tool in ArcMap and 

remove unnecessary slivers and other small holes.  For general guidance on editing features in ArcMap, 

see http://webhelp.esri.com/arcgisdesktop/9.3/pdf/Editing_Tutorial.pdf  

5) In ArcCatalog, create an empty feature class with the schema of the bb_cov feature class and load the 

feature class created above into it. 

a) Right-click on the empty feature class, select Load>Load data from the dropdown menu and navigate 

to the location of the service area feature class 

b) Press the Add button, hit Next 

c) Accept the defaults and hit Next 

d) Do NOT attempt to map any fields, as seen below: 

 

http://webhelp.esri.com/arcgisdesktop/9.3/pdf/Editing_Tutorial.pdf
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a) Press Next, then Next again, then Finish. 

6) In ArcToolBox, go to Data Management Tools>General>Append 

7) Append the formerly empty feature class to bb_cov, completing the dialog box as seen below: 

 

 
 

8)  Leave the Schema Type as TEST 
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9) Press OK. 

10) In ArcMap, open up bb_cov for editing and manually input associated attribution if necessary. 

 

3.5.4 Polygonal Data 

3.5.4.1 Coverage Area – PDF/JPG/Other Image Format 

In the event that the provider supplies coverage area data in some image format such as PDF or JPG format please 

follow the steps below: 

1) If in PDF format, open in Adobe Acrobat and Save As… JPG format. 

2) Open up the JPG image in ArcMap. 

3) Add the required basemap vector data for georeferencing. 

a) This will generally be either the CDOT data or TIGER data 

4) Change the coordinate system of the data frame to the desired end coordinate system 

5) Zoom to the general location of the JPG map image 

a) This is the location based on the vector data, not the JPG image itself. For example, if you know that 

the JPG image represents an area around the town of Limon, zoom to the town of Limon in your 

vector data. 

6) Open up the Georeferencing toolbar by selecting View>Toolbars>Georeferencing from the main menu bar. 

7) Using the Georeferencing toolbar, select Fit to Display, results seen below: 

 

 
 

8) Use the Control Point button  to add control points to the map 

9) Use common points in the base data set and the JPG image 

a) For example, find major street intersections, county/city boundaries, etc. 

b) Try to distribute the points more or less in the four corners on the image for the best transformation 

10) Click on the location on the image first, then click on the corresponding location on the vector data base 

map, as in the image below: 
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11) After placing each control point, the image transformation will update automatically.  

12) Repeat until satisfied with the transformation. 

a) Note: The transformation may take up to four points, although sometimes only two are necessary. 

13) When satisfied with the transformation, select Update Georeferencing from the Georeferencing toolbar 

dropdown. 

a) This will create a “world” file (.jgw in the case of JPGs) in the same directory as the image file. 

14) In ArcCatalog, create a new polygon shapefile with the appropriate data schema for a provider coverage 

area, which can be found in Appendix D. 

15) Add the shapefile to ArcMap. 

16) Using the Editor Toolbar, select Start Editing. Set the Task: to “Create New Feature.” 

17) Use the Sketch Tool  to digitize a new coverage polygon using the coverage area outline from the 

georeferenced JPG and add the required attributes manually. 

18) Repeat the above steps for all subscriber speed coverage areas provided. 

19) Follow the steps detailed in Coverage Area – GIS Data below. 

 

3.5.4.2 Coverage Area – KML/KMZ 

In the event that the provider supplies coverage area data in Google Earth KML or KMZ format please follow the 

steps below: 

1) Use a KML to SHP converter to translate file into an ESRI format 

2) http://arcscripts.esri.com/details.asp?dbid=15603  

http://arcscripts.esri.com/details.asp?dbid=15603
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3) Download the script and follow the provided instructions for installing it in ArcToolbox. 

4) Double-click on the script in ArcToolbox and navigate to the location of the KML file, as seen below: 

 

 

5) Add the new shapefile to ArcMap. Repeat for all KML files provided. 

6) Follow the steps detailed in Coverage Area – GIS Data below. 

 

3.5.4.3 Coverage Area – CAD Data 

In the event that the provider supplies coverage area data in GIS format please follow the steps below: 

1) Transform the CAD dataset into an ESRI format 

2) http://webhelp.esri.com/arcgisdesktop/9.2/index.cfm?TopicName=Transforming_CAD_datasets 

3) It may be necessary to contact the provider first to determine the coordinate system of the CAD data. 

4) If the CAD data is not in a standard coordinate system, it may be necessary to use ArcMap to 

georeference the CAD data to a known coordinate system first. 

a) To do so, follow the instructions provided above in “Coverage Area – PDF/JPG/Other Image Format.” 

5) In ArcCatalog, create a new polygon shapefile with the appropriate data schema for a provider coverage 

area, which can be found in Appendix D. 

6) Add the shapefile to ArcMap. 

7) Using the Editor Toolbar, select Start Editing. Set the Task: to “Create New Feature.” 

8) Use the Sketch Tool  to digitize a new coverage polygon using the coverage area outline from the 

georeferenced CAD file and add the required attributes manually. 

9) Follow the steps detailed in Coverage Area – GIS Data below. 

 

3.5.4.4 Coverage Area – GIS Data 

In the event that the provider supplies coverage area data in GIS format please follow the steps below: 

1) In ArcCatalog, create an empty feature class with the schema of the bb_cov feature class and load the GIS 

feature class either created above or supplied by the provider into it. 

http://webhelp.esri.com/arcgisdesktop/9.2/index.cfm?TopicName=Transforming_CAD_datasets
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a) Right-click on the empty feature class, select Load>Load Data from the dropdown menu and navigate 

to the location of the service area feature class 

b) Press the Add button, hit Next 

c) Accept the defaults and hit Next 

d) Do NOT attempt to map any fields, as seen below: 

 

 
 

e) Press Next, then Next again, then Finish. 

2) In ArcToolBox, go to Data Management Tools>General>Append 

3) Append the formerly empty feature class to bb_cov, completing the dialog box as seen below: 
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4) Leave the Schema Type as TEST 

5) Press OK. 

6) In ArcMap, open up bb_cov for editing and manually input associated attribution, if necessary. 

 

3.5.4.5 Compact Polygon From Subscriber Points  

 Geo-code address list using latest state “Composite Locator”  

 

 Verify that your geo-coded file has only one TT (Technology Type).  If not export individual geo-coded 

layers for each Technology Type. 

 

 For each TT check for differences in speed values or speed tiers and create separate layers for each speed 

value/tier. 

 

 Clean your geo-coding results - remove any points that geo-code to accuracy levels below ZIP+4 (ZIP 

centroids, carrier route centroids, etc).  Also, verify that outliers with acceptable accuracy levels are 

legitimate, i.e. fall in correct City and Zip.   

 

 Perform spatial join between county polygons (using stcnyfips field) and the cleaned geo-coded subscriber 

points, in order to carry the county name and stcnty fips. 

 

 Summarize the number of subscribers by county and use the subscriber counts by county to populate the 

Rate Tier table. 

 

 Un-join the county data from the geo-code subscribers list. 
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 Create Compact Polygon using cleaned geo-coded layer or sub-selection of using – XtoolsPro – 

ConvexHull-DetailedHull option.  A sub-selection of geo-coded points will be used in areas where more 

than one polygon will need to be created for one provider’s service area.   

 

 Evaluate output Hull carefully – looking for areas that should not be covered by hull polygon.   

 

o If it is determined that an area or areas should not be represented in coverage area, manually 

reshape hull polygon until coverage area is adequate.   

 

o When not obvious and as a general rule, manually resolve compact polygon when the distance 

between the subscriber points used to define the outer boundary of the compact polygon 

exceeds 5 miles .  When reshaping the hull polygon, snap to the outermost geo-coded points.  

See figure 2 and 3 for an example. 

 

FIGURE 2- Compact Hull: Manual Resolution Required            

 
 



            

46 

FIGURE 3a- Compact Hull: Manual Resolution Required           FIGURE 3b- Compact Hull: After Manual Resolution        

                       
 

 To attribute the compact polygon - Perform a “Spatial Join” where your Target Feature Class is the 

compact polygon and the Join Feature Class is your geo-coded point layer.  Export compact hull with 

joined attributes and name file appropriately.   

 

 Append attributed compact polygon to BroadBand TT template Feature Class and if required manually 

input any provider attribution that may not have carried over in the append process. 

 

 Intersect compact polygon with county boundaries to create unique records by county and use the state-

county-fips field to populate “stcty_fips” field.  Also use the county name field to populate the 

“BBCov_Name” field.   

 

o Exceptions is where a provider’s coverage is distributed throughout more than one area of any 

given county where the “BBcov_Name” should be populated using an appropriate city or other 

logical name based on geographical location.  

 

 Export/Load into appropriate BB TT model Dataset. 

 

3.5.4.6 Census Blocks – List or Spreadsheet 

In the event that the provider supplies census block data in a list or spreadsheet, please follow the steps below: 
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1) Ensure block polygons supplied by the provider are 2000 currency 

2) If other currency, convert to 2000 currency before proceeding 

a. To do this, remove the trailing letter (a, b, etc.) from the block ID 

b. You will now have two blocks that equate to one block in the 2000 block geometry 

c. Delete duplicate block IDs, retaining the higher service tier in each case 

3) Prepare the block list in clean Excel format, removing all Excel-only formatting, merged cells, colors, 

borders, etc. 

4) Import the spreadsheet into ArcMap. 

5) Right-click on the 2000 census block feature class in the layer list in ArcMap and select  Joins and 

Relates>Join from the drop down menu. Join the census block list to the 2000 census blocks feature class 

using the block ID and export joined records in a new feature class. The Join dialog box and process can be 

seen above in the TIGER Street Segments – List, Spreadsheet, or GIS Data section. 

6)  Follow the steps in Census Blocks – GIS Data below. 

 

3.5.4.7 Census Blocks – GIS Data 

In the event that the provider supplies census block GIS data please follow the steps below: 

 

1) Ensure that the blocks supplied by the provider are in the required data schema and are complete as far 

as require attribution. 

a. If not, manually enter the required attribution or contact the provider to fill gaps. 

2) If census block geometry is distributed throughout more than one county then select Data Management 

Tools>Generalization>Dissolve in ArcToolbox and dissolve based on County/Provider/TT/Speed Tier so 

that unique records are created for each unique combination. 

a. The dissolve dialog box can be seen above in the TIGER Street Segments – List, Spreadsheet, or 

GIS Data section. 

 

 
Figure 1: Undissolved census block polygons 



            

48 

 

 
Figure 2: Census block polygons dissolved by county 

 

 

2) For each dissolved region use the Editing toolbar in ArcMap to remove unnecessary slivers and other 

small holes.   

3) In ArcToolbox, select Data Management Tools>General>Merge and merge the processed polygons 

together into single layer. 

4) The merged census blocks will need to have the subscriber’s “frn” field added and populated. 

5) In ArcCatalog, create an empty feature class with the schema of the bb_cov feature class and load the GIS 

feature class either created above or supplied by the provider into it. 

a. Right-click on the empty feature class, select Load>Load Data from the dropdown menu and 

navigate to the location of the service area feature class 

b. Press the Add button, hit Next 

c. Accept the defaults and hit Next 

d. Do NOT attempt to map any fields, as seen below: 
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e. Press Next, then Next again, then Finish. 

6) In ArcToolBox, go to Data Management Tools>General>Append 

7) Append the formerly empty feature class to bb_cov, completing the dialog box as seen below: 

 

 
 

8) Leave the Schema Type as TEST 
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9) Press OK. 

10) In ArcMap, open up bb_cov for editing and manually input associated attribution, if necessary. 

 

3.6 Metadata Transactions 

Following any updates or changes completed within the file geodatabase (fGDB) stored on the GIS-Analysts staging 

environment, the GIS-Analyst runs transactions to compare that fGDB with the one stored on the Core server to 

ensure metadata on all changes are recorded. 

 

Below outlines the steps taken to run transactions on the updated Core database: 

  

1. Open a command line window and run generateTransactions.py  

a. Usage: generateTransactions.py  [Core fGDB] [Staging Environment fGDB]  

 

b. Example of command line:  

 

<path>generateTransactions.py <path>ST_BB_POLY_SRV_AREAS.gdb <path>ST_BB_POLY_SRV_AREAS.gdb  

 

2. Below is an example of the output screen that will be displayed: 

 

 
 

 

3. After process has completed, results can be found in the ST_BB_POLY_SRV_AREAS_HIST.gdb  
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a. The transactions scripts records changes at a feature level. 

b. Below is a screen shot supporting the directory structure of the historical fGDB. 

 

 

 
 

 

c. Attribution associated with each added/removed/changed features is tracked, including the 

following additional columns appended to the end of each: 

i. Commit_by 

1. Records the GIS-Analyst that committed the changes to the historical fGDB. 

 

ii. Commit_date 

1. Records the date and time stamp that the changes were committed. 

 

iii. Trans_type 

1. This field reflects the type of change recorded. 

2. Categorized by: 

a.  Adds/Change/Deletes 

 

iv. New_values 
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1. Records the new values when a change was completed on a feature.  Example:  

Name or speed change 

 

d. MD_Process is also transferred from the edited fGDB to the historical fGDB, which states the 

actions completed by the GIS-Analyst. 
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3.7 Data Processing 

3.7.1 Data Processing Overview 

The following items outline the actions required to process the service provider data further to meet the NTIA 

requirements. 

 Weighted Nominal Speed 

 Middle Mile 

 Broadband Coverage Template 

 

3.7.2 Weighted Nominal Speed 

The weighted nominal speed is populated one of the following two ways: 

3.7.2.1 Subscriber Data Supplied by Provider 

Where the data provider supplies subscriber speed information, the following formula from the NOFA is used: 

(speed tier-1 in kbps × no. of tier-1 subscribers) + (speed tier-2 in kbps × no. of tier-2 subscribers) + (etc.) 

Total average monthly subscribers 

 

 

Data is initially broken up in the following order: 

1) Stcty_fips 

2) Transmission technology type 

3) Subscriber tiers 

 

3.7.2.2 Value Supplied by Provider 

Some providers will supply their weighted nominal speed.  In these cases, the data supplied will be populated 

instead of using the NOFA formula. 

These obtained or calculated values are used to update the service overview layer. This can be done manually or 

by creating a table with the provider’s FRN and average weighted speed and joining it to the service overview table 

in ArcMap. To Join, right-click on the layer to join to and select Joins and Relates>Join from the dropdown menu. 

Then navigate to the table to join to and select the join fields from the drop down list. Then open up the source 

table (the table in ArcMap) and right-click on the header of the Average Weighted Speed field and select Calculate 

Field from the drop down menu. Use the value of the average weighted speed from the joined table. 

 

3.7.3 Middle Mile 

Middle mile information is generally provided in spreadsheet or text file format. The process is to take what is 

supplied by the provider and translate it into the required data schema.  

1) If the data is supplied with address information, follow the process outlined above in Subscriber Location 

– Address Data.  

2) If the data is supplied with associated XY coordinates, follow the process outlined above in Subscriber 

Location – XY Data.  
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3) Once the data is in GIS format, use the Append (Data Management Tools>General>Append) command in 

ArcToolbox to append the data to the overall middle mile dataset. 

4) Set the schema type to NO_TEST and use the Field Map to map the attribute fields from the source to the 

target dataset. 

3.7.4 Broadband Coverage Template 

Below is the description of the fields within the BB_Cov layer, which is the interim data set that is used to create 

the final product deliverable. 

 

Name Alias Description 

objectid OBJECTID Internal Object ID 

shape SHAPE Internal Shape storage 

prov_id PROVIDER_ID Unique numeric identifier for each provider 

prov_name PROVIDER_NAME Unique name for each provider 

dba_name DOING_BUSINESS_AS An alternative "Doing-Business-As" name for the provider 

frn 
FCC_REGISTRATION_NUMBE

R 
Provider FCC Registration Number 

bbcov_name BBCOV_NAME BroadMap Broadband Coverage name 

trans_code TRANSMISSION_CODE 
Unique code for the transmission technology type described by 

this layer 

trans_name TRANSMISSION_NAME Name for the transmissions technology type 

trans_desc TRANSMISSION_DESC Description for the transmissions technology type 

spect_code SPECTRUM_CODE Unique code for the spectrum [WIRELESS ONLY] 

spect_name SPECTRUM_NAME Name for the spectrum [WIRELESS ONLY] 

spect_desc SPECTRUM_DESC Description for the spectrum [WIRELESS ONLY] 

mad_dwn_t MAX_AD_DOWN_TIER 
Maximum advertised downstream speed available within given 

area (speed tier) 

mad_up_t MAX_AD_UP_TIER 
Maximum advertised upstream speed available within given 

area (speed tier) 

typ_dwn_t TYPICAL_DOWN_TIER 
Typical downstream speed available within given area (speed 

tier) 

typ_up_t TYPICAL_UP_TIER Typical upstream speed available within given area (speed tier) 

mad_dwn_k MAX_AD_DOWN_KBPS 
Maximum advertised downstream speed available within given 

area (kbps) 

mad_up_k MAX_AD_UP_KBPS 
Maximum advertised upstream speed available within given 

area (kbps) 

typ_dwn_k TYPICAL_DOWN_KBPS Typical downstream speed available within given area (kbps) 
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Name Alias Description 

typ_up_k TYPICAL_UP_KBPS Typical upstream speed available within given area (kbps) 

subs SUBSCRIBERS 
Total average monthly subscribers for this provider for this 

technology for this coverage polygon 

md_geom MD_GEOMETRY 
Metadata: Comma separated list of source id's from which the 

polygon extent was produced 

md_exists MD_EXISTS 
Metadata: Comma separated list of source id's used in 

understanding and editing the provider data for this polygon 

md_who MD_WHO 
Metadata: Name of the editor who last edited this feature at 

the time in md_when 

md_when MD_WHEN Metadata: Date/timethat this feature was last edited 

md_process MD_PROCESS 
Metadata: Comma separated list of processed used to create 

and/or modify this layer 

stcty_fips STATE_COUNTY_FIPS State/County FIPS code 

rec_id RECORD_ID 

Compound Key formed from 

STCTY_FIPS+"|"+Provider_ID+"|"+Trans_Code+"|"+BBCov_Nam

e 

st_area ST_AREA(SHAPE) Area in square decimal degrees  

st_length ST_LENGTH(SHAPE) Length in decimal degrees  

Provider_Typ

e 
Type of Provider 

Has Subtype (1:Broadband provider as described in the 

NOFA,2:Reseller,3:Unknown), default value = 1  (New 04/11 

Model) 

 

3.7.5 Verification and Validation 

3.7.5.1 Provider Validation – Provider Portal/PDF Map Review 

Following the collection and aggregation of provider data, the aggregated data is validated by the provider to 

ensure it is an accurate representation of their coverage area and supporting broadband information. 

This validation is completed through the Provider Portal web application, which is a secure interactive map that 

displays the provider’s coverage areas and allows the provider to validate, submit feedback or request changes.  If 

changes are requested, then the features on the portal are updated and an automatic request is sent to the 

provider to complete the validation process. 

 

 Providers that did not use the Provider Portal are asked to validate a PDF map displaying their coverage area(s).  

This is accomplished via e-mail notification.   
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3.7.5.2 Provider Verification – 3rd Party Source Review 

After the provider has validated its coverage areas, a 3
rd

 party source comparison and analysis is performed.  

Where anomalies or discrepancies are identified, a ‘SCAN’ point is dropped and descriptive comments are applied 

to be reviewed later with the provider. 

 

During the provider review, the map is displayed along with the ‘SCAN’ points and potential refinement is 

completed based on input from the Provider. 

 

3
rd

 Party Sources Utilized 

3
rd

 Party Source Name Source Type Verification Type 

InfoUSA Consumer and Business 
Listings 

Community Anchor Institutions 
Can also be used for demographic information supporting 
the State websites 

Pitney Bowes (PBBI) Exchange Info Plus 
(Central Office Locations) 

Exchange datasets are used to verify the following 
Transmission Technologies (TT): 
Asymmetric xDSL (10), Symmetric xDSL (20), Other Copper 
Wireline (30), and Optical Carrier/Fiber to the End User 
(50). 
 

Media Prints Cable Boundaries Used to verify the following TT: 
Cable Modem—DOCSIS 3.0 (40) and Cable Modem—Other 
(41) 

American Roamer  Wireless Coverage 
Patterns (EVDO, GPRS, 
WISP, HSPA) 

Used to verify the following TT: 
Terrestrial Fixed Wireless—Unlicensed (70), Terrestrial 
Fixed Wireless—Licensed (71) and Terrestrial Mobile 
Wireless (80) 

ComSearch Wireless Spectrum 
Holdings and Tower Data 

Used to verify the following TT: 
Terrestrial Fixed Wireless—Unlicensed (70), Terrestrial 
Fixed Wireless—Licensed (71) and Terrestrial Mobile 
Wireless (80) 
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3.7.5.3 Assigning Confidence Values 

All findings and results from the above-mentioned validation and verification activities, plus internal peer quality 

reviews are captured and tracked in a Validation table and form the basis of the confidence value assigned  for 

each provider and then each technology.   

 

The confidence values are as follows:  
0     = Coverage area has not been reviewed 
10   = Extremely Low.   Single Source QC.   
20   = Very Low.  Needs Additional Validation\Verification 
30   = Low.   Even with Validation\Verification, Coverage is still suspect. 
40   = Acceptable, confirm with State prior to shipment.    
50   = Meets requirements to be included in shipment. 
60   = Moderate.  Meets NTIA/State’s standards, representative of Technology Type (TT) 
70   = High.   Accurate representation of coverage based upon TT. 
80   = Very High.  Multiple validation\verification with most 3

rd
 party sources 

90   = Extremely High. Multiple validation\verification sources 
100 = Perfect.  Multiple validation\verification sources, with complete alignment with sources and ground 
truth verification activities 

 

This Validation table is maintained as updates or changes occur for each provider, down to technology type, with 

the overall goal to improve the confidence values and overall map representation. 

 

Example of the Validation table: 
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3.7.6 Community Anchor Institution (CAI) Data 

3.7.6.1 Data Collection 

The CAI data was initially collected from the State to create the baseline inventory.  All location information and 

broadband coverage data supplied was also ingested into the data deliverable. 

Additional collection of CAI information was done via data mining and/or webscraping to build out the inventory 

further.  For example:  Collection of additional CAIs and location information. 

 

The state-agency-provided CAI inventory was comprehensive but the challenge is collecting broadband related 

data; service provider(s), technology and speed data for each CAI.  Availability of the CAI portal has not significantly 

increase submission of this data.  Additional promotion to CAIs to utilize the CAI portal will be needed to increase 

this data for subsequent deliverables. 

 

3.7.6.2 Institution Data 

Institution data is obtained from a variety of sources and almost always provided in Excel spreadsheet format. The 

general process for incorporating this data is below: 

1) If the data is provided in Excel or some similar format: 

a. Clean and standardize the Excel spreadsheet, removing any cell formats, merged cells, etc. 

b. Standardize the address format as defined in the staging CAI database 

c. If the spreadsheet includes X and Y values, such as latitude and longitude, use the Add XY Data 

tool in ArcMap to create a spatial data layer. 

d. If there are only addresses, then follow the geocoding steps outlined above to create spatial data 

points for each of the institutions. 

i. Institutions that do not geocode based on the TIGER 2009 data set will have to be 

manually located using Google Maps, Google Earth, or some other information source. 

2) If the CAI source data is in GIS format, add the Latitude and Longitude fields and use the Calculate 

Geometry tool to populate them, using the WGS 84 coordinate system. 

3) Using ArcCatalog, load the new data into the staging CAI database. 

4) This database is ready for the makeDeliverable.py script to process the information into the final state 

and NTIA deliverables. 
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3.7.6.3 Community Anchor Institution (CAI) Portal Updates 

A web application has been released to allow for further data collection and validation of anchor institution 

location information, broadband coverage, and speed test data. 

 

Information collected from the CAI Portal is then ingested into the overall inventory and will later be compared 

against the provider coverage areas mapped for any potential discrepancies. 
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3.8 Product Extract 

3.8.1 Python Scripts 

The following sections make use of Python scripts. In general, to use a Python scrip, you must have Python 

installed on your computer. To download the latest version of Python, go to http://www.python.org/download/ 

and download the latest stable version. As of August 2010, this was version 2.7. Once this is installed, the general 

way to run a script is to type the following at a command prompt: C:\Python27\python.exe C:\<location of script>. 

Many of the scripts provided have environment variables that must be set before they can be run.  

 

The python code for BroadMap’s product extract has been incorporated into a Hudson CI System, which is detailed 

in the Process Operation and Monitoring section of this document.  This was a process improvement activity so all 

processes can be monitored, controlled and contain historical tracking on each process. 

 

3.8.2 Product Extract Process 

Note: specific Python scripts are called out in red font in the sections below. 

The MapConnect product extract process, makeDeliverable.py, uses the BB_Cov and BROADMAP_POINTS interim 

data sets to create the following layers according to the current specifications: 

 BB_Service_Road_Segment 

- This layer contains all broadband services associated with specific street segments for census 2000 

blocks larger in area than two square miles 

 BB_ServiceCensusBlock 

- Contains all broadband services associated with census blocks of no greater than two square miles. 

 BB_Service_Wireless 

- This layer contains all wireless services not associated with specific addresses. 

 BB_ServiceOverview 

- This layer contains subscriber-weighted nominal speed for each provider's service area at a county 

level and is meant to act as a summarized view.  

 BB_ConnectionPoint_MiddleMile 

-   This layer contains middle-mile and backbone interconnection points 

 BB_Service_CAInstitutions 

- Broadband Service at Community Anchor Institutions (CAI) 

 Community Anchor Institutions consist of schools, libraries, medical and healthcare providers, 

public safety entities, community colleges and other institutions of higher education, and other 

community support organizations and entities. 

 

Due to a NTIA model change for the October 2010 data deliverable, an addition to this code was created to 

support both models in the case a comparison is later desired or a request is made to revert back to the original 

model.  This script name is bdia2ntia.py and creates the following layers in addition to the layers mentioned above, 

rolled up to NATL_Broadband_Map. 

 

http://www.python.org/download/
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 BB_ConnectionPoint_LastMile 

-   This layer contains last mile infrastructure points, which is only populated if data cannot be provided 

at a more granular level. 

 BB_Service_Address 

- Represents broadband availability for service address points.  Address Point availability refers to 

those individual addresses at which each facilities-based provider of broadband service can provide 

broadband services of minimal characteristics within 7 - 10 business days. 

 State_Boundary 

- State boundary supporting topological validation of point feature classes. 

 NATL_Broadband_Topology 

- Supports basic topology quality checking.  Example:  No CAI’s or Middle Mile points outside of the 

state boundary 

 

The following process flow provides a view of how the Core fGDB is extrapolated to the NTIA final deliverable via 

the makeDeliverable.py script.  Following that, the bdia2ntia.py script is run, which limits what’s placed in the final 

layers based on the NTIA modeling standards. 

 

The product scripts and supporting extract were originally created separately per request, in case data model 

comparisons were to be completed.  

 

3.8.3 Product Statistics 

Following the completion of a product extract, the product statistics script (BDIA_ReleaseNotesStats.py) extracts 

the following information supporting that product deliverable. 

 Provider Statistics 

- Collects all provider information, listing by Provider Name 

- Provides output of FRN 

- Counts the number of features supported within the following layers: 

 Census Block 

 Street Segment 

 Max Upstream 

 Wireless Services 

 Infrastructure Points 

- These updates were made to support the Data Package required to accompany every NTIA product 

deliverable. 

 Community Anchor Institution (CAI) Statistics 

- Breaks CAI down to the 8 categories 

 1:  School: K through 12 

 2:  Library 

 3:  Medical/Healthcare 

 4:  Public Safety 

 5:  University/College 
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 6:  Other Government 

 7:  Other Community non-government 

 None:  Unknown Category 

 In cases where this occurs, further investigation is completed prior to product shipment to 

ensure all CAI’s are categorized accurately 

- Reports out the following counts 

 Total CAIs within that category 

 Total CAIs that contain partial BB coverage  

 Contains any of the following information for given CAI: 

 BB Subscriber, Transmission Technology, Speed Down Speed Up 

 Total CAIs that contain full BB coverage 

 Contains all of the above-mentioned BB information for given CAI. 

The output of this script is two CSV files: AnchorInstitutions.csv and Providers.csv. These files can then be 

inspected to ensure that there are the expected number of CAIs and providers for every release. 

 

3.9 Quality Assurance  

Quality assurance is supported manually and algorithmically on the interim data, BB_Cov file geodatabase, and on 

the final product. For scheduled product releases, a test product extract and subsequent manual and algorithmic 

QC run is completed along with a release review.  The product specifications, project status reports, previous 

product release notes are used as references throughout this review. 

The following parameters are tested using the methodology listed below each: 

 Product Deliverable Format  

- Correct names and format of data deliverables 

 BDIA_QC_SUITES (please see below for details) 

- Correct Projections/Datum 

 Manual interaction with product 

- Metadata Present and Correct 

 Manual interaction with product 

 Table Structure 

- All required tables included 

 BDIA_QC_SUITES 

- Extraneous tables identified 

 BDIA_QC_SUITES 

 Field Structure 

- All fields included 

 BDIA_QC_SUITES 

- Extraneous fields identified 

 BDIA_QC_SUITES 

- Correct field names, types and widths 



            

63 

 BDIA_QC_SUITES 

 Field Domains 

- Values in all tables are constrained to the specified values specified 

 This action is accomplished via BDIA_QC_SUITES and manual review of the product 

 This tends to identify project completeness issues as fields with a null value are identified. 

 Geometric Representation 

- Identify if all layers have the correct geometric representation 

 Manual review of the BB_ServiceOverview layer 

 Dependent on NTIA and client requirements 

 Geographic Extent 

- Product includes the necessary Geography associated with Product? 

 Manual Review - ArcGIS 

- Is there extraneous geography included in Product? 

 Manual Review - ArcGIS 

 Completeness 

- Products contain the expected amount of data? 

 Manual review of product stats relative to weekly State reports and defined expectations. 

 Accuracy 

- Product meets the stated accuracy requirements for the deliverable? 

 Sampling procedure to manually review source material to resulting product 

 Provider Validation 

 Verification using 3
rd

 Party Data 

 Verification against reality, where applicable 

 Data Regression 

- Any unexplainable data loss or change? 

 This action is accomplished by comparing results within product statistics script 

(BDIA_ReleaseNotesStats.py) from previous releases, as well as manual review of the product 

 Confidentiality 

- Any unauthorized confidential information included in the delivery? 

 Review of NDAs and delivery expectations 

 Prior Issues Resolved  

- Have expected internal issues been resolved? 

 Manual review of data against previous product release notes 

- Have agreed upon customer issues been resolved? 

 Manual review of data against previous product release notes, status report and client feedback 

 Delivery Medium 

- Has the product medium been verified? 

 Manual review 

- All files present 

 Manual review of SFTP site to ensure all files are copied correctly, including file/directory size 

- Correct location 
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 Manual review – confirmation of SFTP link, username and password 

 

3.9.1 QC Suite 

The BDIA_QC_SUITES consists of four main types of scripts supporting the overall QC process. These scripts are all 

run in concert and are called from the test_runner script and the test_BDIAProductGDB script. 

 

3.9.1.1 Configuration  

These scripts establish the configuration for the test_BDIAProductGDB script which is the core of the QC Suite.  

- update_test_config 

- active_config 

- config_PROCESS01_automated 

- config_PROCESS01_manual 

- set_active_config 

3.9.1.2 Libraries 

These scripts provide additional functionality that is called from with the test_BDIAProductGDB script.  

- bb_unittest_fixture 

- bbcov_structure 

- BC_XmlWriter 

- file_folder 

- search_and_replace 

- unittst_fixture 

- validate_BB_DB 

- validate_BB_GDB 

- xmlrunner_gui 

3.9.1.3 QC Suite 

This is the core script for performing automated QA/QC on the interim and final data deliverables. 

- test_BDIAProductGDB 

3.9.1.4 Other  

These scripts perform other functions detailed below: 

- test_runner – this is the main script that runs all the other QC scripts and imports all the necessary scripts 

and libraries 

- which_build – this determines the current build and passes information to the configuration scripts 

 

3.10 Process Operation and Monitoring 

Product Extract, makeDeliverable.py and bdia2ntia.py, is run within BroadMap using a platform called Hudson that 

has been enhanced to support BDIA product extraction, process monitoring, as well as product validation.  The 

same platform can be planned for implementation for the State, if desired. 
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Below are examples of the product create, product validation, product statistics and monitoring processes which 

are managed within the BroadMap Hudson CI-System.  All of the above-mentioned python scripts, with the 

exception of metadata transactions script, are run via this system. 

 

3.10.1 BDIA Product Create 

 

Below is an example of the main page where the type of product build can be selected. 

 

 
 

Selecting based on the type of process that will be initiated. 

 

   
 

The Console Output can be reviewed to see the progress of product create.  Following the completion of each 

product creation process, an e-mail notification is automatically sent to the team.   
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All processes run via the BroadMap Hudson CI-System are stored for historical reporting.  Each process can be 

reviewed, including the Console Output and Build Artifacts from that run. 

 

 
 

3.10.2 Product Validation and Statistics 

 

Once the product creation process is complete, Product Validation and Statistics are then initiated.  These support 

the BDIA_ReleaseNotesStats.py script and the BDIA_QC_SUITES scripts detailed above. 

All statistics and reports are stored for historical review with the capability to place violation criticality on each 

quality control check allowing the identification of errors due to project status/completeness verses project 

correctness.  Example:  Typical Speeds populated. 
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Below is an example of the report provided based on various control points running over a specified time period: 

 
 

Similar to the Product Create process, all results from the process are maintained:  

 
 

Results are then reviewed manually to ensure no errors reported are critical or in violation of the NTIA data model 

or project completion statements.  Any errors of concern are communicated ahead of product delivery and 

included within the product release notes. 

Further detail on the Hudson CI System environment can be found by navigating to the following link: 

http://wiki.hudson-ci.org/display/HUDSON/Meet+Hudson 

 

http://wiki.hudson-ci.org/display/HUDSON/Meet+Hudson
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3.11 Product Extract Data Delivery 

Product delivery for MapConnect Broadband is handled two ways, depending on client requirements: 

1) State Submittal 

a) Data is submitted via SFTP site 

b) Product Release Notes and QC Test Report accompanies the delivery 

2) NTIA Submittal 

a) Directions for using the NTIA State Broadband Data file submission tool 

b) Go to the following WWW web site: https://esupport.fcc.gov/statedata  

c) Enter your username and password as provided to you from the NTIA program administrator. 

 

 
 

d) Click in Upload a file field 

e) Browse to local file for submission using the ‘Browse’ button.  Select file then select ATTACH FILE. 

 

https://esupport.fcc.gov/statedata
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f) Logout / Receipt using the Logout button in the Top Right of the screen 

g) A receipt of submission is emailed to username e-mail address 
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Introduction 
The following sections of this document provide an overview of the process used for the SBDD Broadband 

Mapping data development for the Commonwealth of Pennsylvania. The following narrative is depicted in 

Appendix A, Commonwealth of Pennsylvania SBDD Process Workflow, and Appendix B, State Broadband Data 

Validation Workflow, included at the end of this document. 

Broadband Provider Outreach 
The following outreach procedure provides the framework for communicating with Broadband Service Providers 

(providers). The primary goals of the outreach approach documented herein are to:  

 Promote provider understanding and acceptance of the Broadband Mapping process, results, and benefits 

 Clarify NTIA Broadband Mapping requirements 

 Facilitate data confidentiality agreements as required 

 Minimize the submittal of invalid data 

 Enhance provider understanding of the semi-annual update process   

 Work with providers to evaluate submittal options to facilitate data submittals  

Data Submission Guidelines 
Guidelines for the providers’ submission of Broadband Mapping Data are documented in the “Data Submission 

Guidelines”. These Guidelines define technical requirements, submission specifications, and coordination and 

documentation activities. 

Pennsylvania Broadband Providers Website 
A URL was deployed (http://www.bakergis.com/PABroadbandProvider/) to communicate and distribute NTIA 

NOFA requirements to providers along with outreach and data submittal materials including: 

 NTIA NOFA and subsequent clarification 

 Outreach letters to providers 

 Draft Non-Disclosure/Data Sharing Agreement 

 Quick Start Guides 

 Data Submission Guidelines 

 Data Transmittal Letter 

 Broadband Data Submittal Templates 

 Census TIGER Data 

 Data Submittal Assistance Contact Information 

Outreach Delivery Vehicles 
 A State Broadband Mapping Initiative Call for Data letter from the Commonwealth of Pennsylvania 

Department of Community and Economic Development (DCED) was emailed to all providers in the 

Commonwealth. This initial provider contact letter described the program and the role of Michael Baker Jr., 

Inc. (Baker) acting on behalf of the DCED for Broadband Data Collection and Mapping. 

http://www.bakergis.com/PABroadbandProvider/
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 Baker distributed a follow-up letter to all providers describing the data submittal requirements and material 

and help available to aid with the data submittals. 

 Submittal assistance was provided to providers that needed help with data submittals. 

 Presentations were conducted with various broadband provider associations to present the data submittal 

requirements and answer questions. 

 Email communication and electronic transfer of data was encouraged to facilitate a faster delivery of data 

and information. 

 A URL was deployed and promoted to distribute outreach material and information concerning the 

Broadband Mapping Project. 

 A secure FTP URL was provided for submittal of broadband data by providers. 

Broadband Outreach Tracker Application 

The Tracker application (Figure 1) was utilized to collect all correspondence with providers and feedback on the 

effectiveness of the outreach activities by tracking items such as:  

 The number and content of incoming e-mails and letters submitted from the providers 

 The number and source of comments, questions, and suggestions made by providers 

 The number and source of comments, questions, and suggestions made by attendees at provider meetings 

and conference calls 

 Provider contact information and data submittal status. 
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Figure 1 Broadband Outreach Tracker 

Provider Submittal Validation 
When a data submittal is received from a broadband service provider, it is updated in the Broadband Outreach 

Tracker and run through an initial validation process to assure that it meets the submittal guidelines.  

Validation Checklist 
The following items are part of this initial data validation process: 

 Verify provider’s transmittal letter requested in Data Submission Guideline with is complete and 

matches submitted data 

 Verify the file naming conventions 

 Verify each file is machine readable 

 Verify data is in the correct GIS or Tabular format/file type 

 Verify each field is populated and no empty or NULL values are present for mandatory fields 

 Verify all ID (record number points) are unique within the submittal 

 Verify all attribute data is formatted according to the submittal guidelines 

 Verify topology for all geospatial submissions 

 Verify Metadata for all submissions 

 Verify the required contact information is included 

 Verify adherence to Data Submittal Guidelines (see http://www.bakergis.com/PABroadbandProvider/ to 
access Data Submittal Guidelines) 
Broadband Service Availability (at least one) 

 Individual Street Addresses (Sec 3.1 & 4.1) 

http://www.bakergis.com/PABroadbandProvider/
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 Census Blocks < 2 sq mi (Sec 3.3 & 4.3) 

 Street Segments for Census Blocks > 2 sq mi (Sec 3.2 & 4.2) 

 Service Overview (Sec 3.4 & 4.4) 

 Polygonal Boundary Area(s) (Sec 3.8 & 4.8) 

Middle-mile Points (Sec 3.5 & 4.5) 

Community Anchor Institutions (Sec 3.7 & 4.7) 

Last Mile Connection Points (Sec 3.6 & 4.6) 

WISP Antennas (Sec 4.9) 

Data Usability Determination 
The validation results are evaluated by the outreach and aggregation persons to determine the usability of the 

data. If the data meets the submission specifications, it is forwarded on for data aggregation. If it is determined 

to be unusable, it is returned to the provider for resolution. If the data can be manipulated to get it into a usable 

format, it is manipulated as required, and then forwarded on for data aggregation. 

SBDD Data Development 
Data from the providers may be submitted in various formats as defined in the Data Submittal Guidelines, or in 

some cases unspecified formats may be accepted to help facilitate provider participation. Depending on the 

format of the submitted data, it is processed through one of the following processes to upgrade it to the NTIA 

SDBB data standards. 

Spatial Data  
After validation and any required manipulation of any spatial data submitted by the providers, it is 

georeferenced and simply loaded into the appropriate NTIA geodatabase feature class.  

Address Data Geocoding 
If not already in the standard address point template, the provider tabular address data is first loaded into that 

template. The data is then exported to a geodatabase table using the ArcGIS Conversion Tools. ArcGIS geocoding 

tools are then utilized geospatially locate the address points for the tabular records. Interactive address 

rematching is performed against two additional street centerline datasets as needed to increase geocoding 

matching results. The NTIA deliverable is the geocoded address point geodatabase table. The geocoded address 

points are also subsequently aggregated to the census block or road segment feature class for public web map 

display. 

Census Block Aggregation 
If not already in the standard census block template, the provider tabular census block data is first loaded into 

that template. The data is then exported to a geodatabase table using the ArcGIS Conversion Tools. The provider 

tabular census block records are then joined to the geodatabase 2000 U.S. Census Block. This join is performed 

as many times as necessary for multiple Trans Tech values for each Provider/Census Block combination. The 

NTIA deliverable is the census block geodatabase table.  



 Commonwealth of Pennsylvania 
SBDD Broadband Mapping Project 

DATA DEVELOPMENT & VALIDATION METHODOLOGIES 
 

 
 
 7 

If the list of census blocks contains blocks > 2 sq. miles then these blocks are used to select all the 2000 U.S. 

Census TIGER centerlines that intersect those blocks.  The Census Block record data is aggregated to each Road 

Segment within the Census Block.  This process is performed as many times as necessary for multiple Trans Tech 

values for each Provider/Census Block combination. 

Road Segment Aggregation 
If not already in the standard road segment template, the provider road segment data is first loaded into that 

template. The data is then exported to a geodatabase table using the ArcGIS Conversion Tools. If the provider 

submittal included graphic centerline segments, these are migrated into the delivery geodatabase along with 

the linked attribute records. If the provider submittal was tabular road segment records only, they are then 

joined to the geodatabase 2000 U.S. Census TIGER centerline feature class. This join is performed as many times 

as necessary for multiple Trans Tech values for each Provider/Road Segment combination. The NTIA deliverable 

is the road segment geodatabase table.  

If the provider road segment data lie within census blocks <= 2 sq. miles then the road segment data is 

aggregated to the census block.  This process is performed as many times as necessary for multiple Trans Tech 

values for each Provider/Road Segment combination. The NTIA deliverable is the road segment geodatabase 

table. 

Overview Data Aggregation 
Provider Service Availability Areas submitted for entire county areas are loaded into the NTIA geodatabase 

Overview table. If not already in the standard template, the provider data is first loaded into that template. The 

data is then exported to a geodatabase table using the ArcGIS Conversion Tools. The provider overview records 

are then joined to the geodatabase 2000 U.S. Census County feature class. This join is performed as many times 

as necessary for multiple Trans Tech values for each Provider/County Area combination. 

Polygonal Boundary Aggregation/Integration 
Providers submitting polygonal service area data are handled in two ways. Wireline Provider data is aggregated 

to the census block feature class for areas where census blocks <= 2 sq. mi., or road segment feature class for 

areas where census blocks > 2 sq. mi. Wireless Provider Service Availability Areas submitted by polygonal area 

are simply loaded into the NTIA geodatabase Poly_Bndry feature class.  

Wireline Provider 

The polygonal data is georeferenced and loaded into the Poly_Bndry feature class. The polygon is then 

attributed, manually if necessary. Depending on the area, census blocks < or => 2 sq. mi., a selection set of either 

census blocks or road segments that intersect the polygon boundary is created. The attributed polygon 

boundary is then joined with census blocks or road segments table to attribute accordingly. This join is 

performed as many times as necessary for multiple Trans Tech values for each Provider/County Area 

combination.  The NTIA deliverable is the census block or road segment geodatabase table. 
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Wireless Provider 

The polygonal data is georeferenced and loaded into the Poly_Bndry feature class. The polygon is then 

attributed, manually if necessary. Multiple Poly_Bndry records are created for multiple Trans Tech values for 

each provider. The NTIA deliverable is the polygon boundary geodatabase table. 

Middle/Last Mile Data Integration 
If not already in the standard template, the data is first loaded into that template. The data is then exported to a 

geodatabase table using the ArcGIS Conversion Tools. The point features are geo-located utilizing the lat/long 

information provided.  The NTIA deliverable is the middle or last mile geodatabase table. 

Community Anchor Institution Integration 
Providers supplied some Community Anchor Institution (CAI) data with the data submittals. But the majority of 

the data was collected from existing GIS Layers maintained by the Commonwealth of Pennsylvania, outreaching 

to CAIs through state agencies and their contacts, and having CAIs complete an online survey at 

http://www.bakerbb.com/pa_institution_survey/.  

Provider CAIs 

If not already in the standard template, the data is first loaded into that template. The data is then exported to a 

geodatabase table using the ArcGIS Conversion Tools. The point features are geo-located utilizing the lat/long 

information provided. Address data is used to geocode locations only when lat/long data is not provided. 

Commonwealth CAIs 

CAI shapefiles were provided through the Commonwealth’s other geospatial efforts. The shapefiles were then 

exported to the NTIA geodatabase CAI feature class. Various sources for obtaining broadband information for 

the CAIs were utilized. Various state agencies provided some of the information, i.e. Pennsylvania Department 

of Education (PDE) provided tabular broadband information for schools, PDE provided tabular broadband 

information for libraries, Pennsylvania State Police provided tabular broadband information for their facilities. A 

CAI data survey website was also deployed and the URL distributed by various state agencies to the CAI 

contacts. Data from all of these sources were then aggregated into the CAI geodatabase table for the NTIA 

deliverable. 

Provider Validation 
After data development, service availability maps are generated and submitted to the providers to validate their 

mapping results.  This provides a “sign off” on the interpretation of the submitted data and extends the 

outreach efforts by providing a visual representation of the data to be delivered to the State and the NTIA. 

Types of Provider Maps 
Provider maps generally consist of the following types. 

Outreach Maps 

Often, providers will send data which does not contain all the information needed for a NTIA compliant dataset.  

In such cases, as an aid to the outreach communication, it may be necessary to produce a map to help the 

http://www.bakerbb.com/pa_institution_survey/
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provider locate their service area or verify data they have provided.  These maps may take many forms, but 

generally are of two types: 

 General Location Maps – these maps are often produced when the provider does not have a list of address 

or other standard submittal data and needs help defining their service area.  A typical map will show 

counties, major roads, and towns of the general area the provider has stated as their service area.  The 

intent of the map is to give the provider a way to markup or delineate their service area.  If a provider has 

not provided required attribute information such as Technology of Transmission, Speed Data, etc. then it 

may be necessary to add a visual clue to this data like an information stamp on the map that they can easily 

fill out.  If the provider sends the map back with a service area boundary, this can then be digitized and sent 

back to the provider for verification. 

 Verification of Provider Supplied Boundaries – these maps are produced when the provider has sent service 

area boundary information which is confusing or otherwise unclear.  Often these are produced when 

providers send CAD maps, hand drawn maps that need digitization, or lists of zip codes or counties served.  

A typical map will place the interpreted boundary over a location map so the provider can verify the service 

area.  As with the General Location Map, information stamps or other visual clues may be placed on the 

map. 

Initial Verification Maps 

Once the provider data has been processed and the census block and road segment feature classes created, an 

Initial Verification Map (Figure 2) is produced to give the provider a visual representation of their service area by 

census block.  These maps enable the provider to verify their service area and make changes if necessary.  Initial 

Verification Maps are produced using a set of standards and produced at the highest resolution necessary to 

convey the map information to the provider.  Initial Verification Maps are also produced for Wireless Polygon 

areas. 

Detailed Verification Maps 

Providers who have questions about their service areas may request additional information to help clarify issues.  

In these cases, it may be necessary to create a Detailed Verification Map to highlight the areas in question.  

Detailed Verification Maps provide the same information as Initial Verification Maps only at a higher resolution.  

Several maps may be needed to accurately portray an area in question. 

Revised Maps 

Revised maps take two forms: 

 Initial or Detailed Verification Maps which have been annotated or marked-up by the provider 

 Outreach produced Initial or Detailed Verification Maps incorporating provider changes 
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Figure 2  Provider Map 

Data Validation 
A critical component of the project is the validation of the data submitted by the broadband service providers. 

Data from various sources, as described in more detail in the following sections, is utilized to develop a level of 

confidence in the data received from the broadband providers.  

Validation Data Set Collection and Development 
This validation process employs data sets developed or acquired from different sources as described in the 

following sections.  

Provider Feedback Loop:  Maps of completed provider service areas and data are furnished back to the 

providers for confirmation of the processed/aggregated information. Feedback is integrated into the each 

provider’s dataset.  
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Telogical Systems Wireline Market Intelligence Data:  This commercially available dataset was developed using a 

methodology that incorporates deep web crawling and additional means, including direct mail harvesting and 

advertising collaterals (including door to door) to gather cable and telecommunication provider information. 

This dataset is used as a validation source for wireline provider service area coverage, Technology of 

Transmission, and Speed. 

American Roamer Wireless Market Intelligence Data:  This commercially available dataset is used as an 

independent source to verify information submitted by providers of wireless broadband service. This dataset is 

used as a validation source for wireless provider service area coverage. 

Prior Commonwealth Broadband Mapping Dataset:  Under the requirements of the Commonwealth’s Act 183 of 

2004 legislation, broadband coverage data was previously collected by the Commonwealth. These datasets are 

used as a validation source for provider service area coverage and Technology of Transmission. 

FCC Speed Test: The FCC speed test data includes the IP addresses for each specific speed test conducted. This IP 

address is queried against a web search engine to determine the provider assigned to that address and is used 

as a validation source for the provider service coverage and typical speeds. 

Fixed Wireless Line of Sight Analysis: Utilizing the existing PAMAP LiDAR for topography generation and 

determining tower/antennae heights, line of sight analysis is performed to determine areas of reported fixed 

wireless broadband coverage that is questionable.  

Field Data Acquisition: Broadband technicians visited a sampling of census block locations to gather broadband 

data to be used for validation. The following criteria were taken into account when developing the census block 

sampling dataset: 

 urban vs. rural census block characteristic 

 censes block grouping 

 land vs. water census block characteristic 

The overarching mission of the Federal broadband stimulus program is to expand Broadband service to areas 

that are currently unserved and underserved. Also, the market intelligence validation sources typically represent 

some rural, but more urban areas. Thus, our field data collection efforts were targeted more towards the rural 

areas; split 90% rural, 10% urban.   

Additionally, a study by Penn State University (Glasmeier 2002) notes that a large number of census block 

groups typically fit within any given cable or telephone company service areas. Therefore, our field sample was 

also based on selection of one census block per block group and a land mass greater than 50% to avoid field 

visiting areas covered mostly by water.  There are a total of 10,387 block groups in PA. Using a statistical sample 

size calculator based upon the number of block groups in the state and +/- 4% margin of error at a 95% 

confidence level, the sample size is 568 census block locations statewide.  The procedure for selecting the 

calculated field verification census blocks is provided below.  

1. Select one census block per census block group 
a. Convert the census block groups polygon to label points. 
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b. Select the census block polygon by doing a spatial selection using census block groups label 
points. 

2. Select from the current selection where the census block land mass is 50% or greater and the block is 
rural. 

3. Export the selected blocks to a new shapefile. This reset the FID for the next step. 
4. Select every 2nd, 3rd, 4th, or so on to get the desired number of blocks. Query used to select: 

MOD(“FID”,2) = 0. This will select every other record. 

The planned census block field locations are shown in Figure 3. 

 

Figure 3  Planned Field Verification Census Block Locations 

For each census block in the sample set, broadband technicians collected data using Panasonic Toughbook 

computers, loaded with MapPoint mapping software, and a customized Microsoft Access data collection form 

with the ability to automatically import GPS coordinates. The sample census blocks were pre-loaded and directly 

accessible from MapPoint.  Two types of data collection were conducted (infrastructure observation and 

wireless speed testing) and the results were recorded and linked to the corresponding field location coordinates 

within the designated sample census block.  The information collected by the field broadband technicians 

includes: 

Wireline: 

 GPS coordinates 

 circuit infrastructure feeding the area (copper, fiber, cable) 
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 local distribution hut equipment inspection, where allowed/possible 

 witness access circuit speed tests, where allowed/possible 

 facility elevation (measurement relative to grade), where allowed/possible 

 distance from DSLAM measurement where applicable and determine access speed capability with an 

accuracy within 500ft using mapping software 

 collect site pictures 

Wireless: 

 GPS coordinates 

 internet speed test 

The map in Figure 4 shows the locations (blue points) of the census block field surveys that were performed.  

 

Figure 4  Completed Field Verification Locations 

For the 568 census blocks that were visited, 2821 individual wired/wireless data elements were recorded and 

3666 pictures were taken at those locations. This field collected dataset is used as a validation source primarily 

for wireline and wireless technology of transmission, middle mile, and wireless speed. 
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Provider Data Validation Process 

Provider Feedback Loop: Feedback received from the providers is visually inspected and integrated directly in 

the mapping GIS database. 

Service Area Validation Data: The Telogical wireline service area data is tabular and contains a separate record 

for each provider/technology of transmission combination with an associated census block or TIGER road 

segment, depending on the whether the size of the census block area (=/< or > 2 sq. mi.). This data is exported 

into an ArcGIS data format. The American Roamer wireless service area data is already in and ArcGIS data 

format.  The validation data is then joined to the provider service area data by census block or TIGER road 

segment ID. Any database records in the provider or validation tables that cannot be joined are output to a 

separate layer that indicates the areas of discrepancy between the two datasets. The joined tables are then 

queried to detect any speed discrepancies which are also output to a separate discrepancy layer. 

Field Validation Data: The field data are also collected in tabular database format, and represent a specific 

lat/long spatial location for each record.  This data is also exported into an ArcGIS data format, joined to the 

provider data, queried to validate pertinent attribution. Again, records not joined and/or with detected 

attribution discrepancies are output to separate GIS layers. 

Topology: The ArcGIS Validate Topology Tool is used to flag any topology issues in the broadband data. Flagged 

issues are reviewed to identify false positives and update true errors as required.  

SBDD Check Submission: The NTIA-provided SBDD Check Submission tool is utilized to validate that the 

deliverable broadband data is consistent with the business logic rules set forth by the NTIA and a passing receipt 

is provided with the data submittal to NTIA. 

Stakeholder Feedback:  The state broadband mapping website includes a feedback function. Comments received 

from stakeholders such as the regional Economic Development Districts and the public are reviewed and used to 

validate the provider data submissions. 

Validation and Confidence Level Reporting 

To facilitate validation and confidence level reporting, 

Baker deployed a validation application called Statistical 

Evaluation and Assessment System (SEAS), shown in 

Figure 5, which automatically compares the multiple 

independent validation datasets against the broadband 

service provider supplied information.  The SEAS 

application uses statistical methodologies to report the 

confidence level in the spatial and attribute accuracy of 

the information.  Appendix B shows the validation 

workflow. 

 

 Figure 5  SEAS 
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The SEAS comparison is a three-part validation process: 

1. Comparison of the collected validation source against the aggregated broadband provider data. 

2. Match percentage calculation for each provider reported in the DataPackage.xls, “Provider Table” tab, 

“Comments” column. 

3. Confidence score calculation displayed on the state broadband website. 

After completing all validation data source collections, SEAS is used to automatically compare the multiple 

validation datasets against the aggregated broadband data which came from the providers. Through the SEAS 

accumulation table, it produces a match percentage per broadband service record based upon the number of 

matches that record has against each validation source. The matched percentage for each record is the result of 

the total count of the matched validations for the record divided by the total validation source being compared 

against the record.  Validation confidence rating/score is assigned on a scale of 1 to 5 based upon the 

percentage of validation source matches as per the following score results: 

o 1 Star   = 0% - 19% Match 

o 2 Stars = 20% - 39% Match 

o 3 Stars = 40% - 59% Match 

o 4 Stars = 60% = 79% Match 

o 5 Stars = 80% - 100% Match 

o “No Analytics” = No validation source available for that provider 

The Commonwealth’s public broadband mapping website (www.broadbandinpa.com) is updated with the 

confidence level results at the record level based upon the queried geographic location and the following shows 

an example of this representation. 

 
Provider Name Transmission 

Technology 

Max Download 

Speed 

Max Upload Speed  Confidence Score 

AT&T Mobility Mobile Wireless Greater than or e… Greater than or e… 
 

Verizon Asymmetric xDSL Greater than or e… Greater than or e… NO ANALYTICS 

Comcast Cable Modem – 

Other 

Greater than or e… Greater than or e… 
 

  

The matched percentage for the records for each provider are summarized and then divided by the total count 

of the records to create the final matched percentage for the specific provider. These percentages are included 

in DataPackage.xls on the Provider Table tab in the Comments column.

http://www.broadbandinpa.com/
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Appendix A: 
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PUERTO RICO COVER LETTER 

 
April 1, 2011 
 
Ms. Anne W. Neville 
SBDD Grant Program Director 
National Telecommunications and Information Administration 
U.S. Department of Commerce 
1401 Constitution Avenue, NW Room 4716 
Washington, DC 20230 
 
Dear Ms. Neville: 
 
It is with highest regard that the collective stakeholders of Connect Puerto Rico offer 
congratulations to the U.S. Department of Commerce’s National Telecommunications & 
Information Administration (NTIA) on the recent release of the National Broadband Map.  This 
extraordinary milestone demonstrates the intense and joint effort of the NTIA, FCC, state 
governments, industry, and non-profits like Connected Nation and will serve as a key tool for the 
American public and policymakers resulting in smarter investments and targeted state and local 
broadband policies and programs.  We are proud of the role that Connect Puerto Rico has played in 
creating such a powerful tool that will surely benefit not just Puerto Ricans, but consumers and 
businesses nationwide. 
 
Therefore, as the Designated Entity, the Puerto Rico Office of the Chief Information Officer 
(OCIO), in partnership with Connected Nation, is pleased to present this submittal of the 
Commonwealth of Puerto Rico’s State Broadband Data and Development (SBDD) Grant Program, 
known as Connect Puerto Rico. 
 
These artifacts should be found to be compliant with the April 1, 2011, deadline for the semi-annual 
data update and in accordance with the terms of the July 1, 2009, Notice of Funds Availability 
(NOFA) and all subsequent clarifications pertaining to delivery of State-Level Mapping of 
Broadband Service Availability.  This packet includes: 
 
Inventory of Deliverables, Connect Puerto Rico: April 1, 2011 
 
NOFA Requirement Data Transfer Model Data Description 
Appendix A:  1(a)(i) BB_Service_CensusBlock Broadband Service Availability of 

Facilities-Based Providers in 
Census Blocks of No Greater 
Than Two Square Miles in Area 

Appendix A:   1(a)(ii) BB_Service_RoadSegment Broadband Service Availability of 
Facilities-Based Providers by Road 
Segment in Census Blocks Larger 
in Area Than Two Square Miles 
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Appendix A:   1(b) BB_Service_Wireless Broadband Service Availability of 
Wireless Services Not Provided to 
a Specific Address 

Appendix A:   3(b) BB_ConnectionPoint_MiddleMile Broadband Service Infrastructure 
Middle-Mile and Backbone 
Interconnection Points 

Appendix A:   4 BB_Service_CAInstitutions  Community Anchor Institutions-
Listing 

Appendix A:   4 n/a Community Anchor Institutions-
Narratives 

VII.A.1(a) n/a Accuracy and Verification Report 
n/a DataPackage.xlsx Worksheets of Contact 

Information, Data Dictionary, and 
Provider Summary Table 

n/a n/a Broadband Provider Roster and 
Participation Status 

 
In addition, this data update submission should be found to be compliant with the additional 
program requirements instituted by the National Telecommunications and Information 
Administration since the time of the October 2010 SBDD data submission for the Connect Puerto 
Rico program.  Specifically, these new requirements are: 

 
SBDD Data Transfer Model 
The submission of the broadband dataset for April 1, 2011, is contained within the SBDD 
Data Transfer Model as released on the Grantee Workspace on January 14, 2011. All efforts 
have been made to comply with formatting, domain, and metadata requirements to include 
as much information on each provider as possible.  
 
Additional Submission Guidance 
This submission also includes the updated DataPackage spreadsheet with enhanced provider 
listings as well as satisfactory outputs from the SBDD_Check toolbox to ensure fewer 
unexpected values with the submitted broadband datasets prior to federal processing for the 
National Broadband Map update. 

 
It is therefore with great pleasure that the Connect Puerto Rico program submits this April 2011 
semi-annual data update under the State Broadband Data and Development Grant Program.  We 
will continue to implement the joint purposes of the Recovery Act and the Broadband Data 
Improvement Act (BDIA) by gathering comprehensive and accurate territory-level broadband 
mapping data, developing territory-level broadband maps, aiding in the development and 
maintenance of the National Broadband Map, and undertaking territory-wide initiatives for 
broadband planning. 
 
Broadband Service Availability — Provider Outreach and Verification 
 
This data update submission under the SBDD includes the participation of approximately 68.42% of 
the Puerto Rico provider community, or 13 of 19 total providers.  Of the 13 participating providers, 
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6 supplied an update to their network or coverage area(s), while 6 have reported no change. The 
remaining provider previously supplied data but was non-responsive in the April 2011 update effort; 
therefore its previous dataset is being put forward as part of this compilation.  A complete roster by 
provider depicting participation status and contact record is contained herein.  Of the 6 providers 
that are not represented in the attached datasets, one has remained unresponsive to the numerous 
attempts at contact by Connect Puerto Rico. The remaining 5 providers are currently in some form 
of progress toward data submission but were not able to either submit or verify coverage areas at the 
time of this submission.  While the broadband provider OneLink has continued to be non-
responsive to requests for data and information on its network, an estimated service area is 
submitted in this dataset based on publicly available information and field validation efforts. 
Additional information on the methodology used to create and revise the OneLink service area is 
available in the Field Validation narrative.  
 
As the aforementioned roster and attached methodology documentation will attest, it is the 
collective opinion of the Connect Puerto Rico principals that all commercially reasonable efforts 
were made to account for 100% of the known Puerto Rico broadband provider community, 
pursuant to this semi-annual data update submission. 
 
Connect Puerto Rico has also continued to perform broadband verification activities through several 
means. In addition to confirmation of service area(s) by each provider, Connect Puerto Rico 
conducts field validation efforts.  To date, 11 (57.89%) providers have been validated through field 
verification activities. Additional details on verification activities are contained within the Field 
Validation Narrative. 
  
At the program’s inception, Connect Puerto Rico launched a website to create awareness about the 
initiative. Connectpr.org continues to serve a prominent role in the outreach and data collection 
effort.  This program asset provides a way for the general public to participate in the process by 
offering interactive tools for users to test their connection speed, submit broadband inquiries, or 
contact a program representative.   
 
As an indicator of stakeholder penetration, the Connect Puerto Rico website encountered 1,846 
unique visits during this reporting period, which includes 1,086 visits to the English website and 760 
visits to the Spanish website (3,659 total to date for the life of the grant awarded on December 20, 
2009, which includes 2,695 to the English website and 964 to the Spanish website).  Additionally, 
this pronounced Web activity netted 16 broadband inquiries over this same reporting period (24 
grant inception to date).  The website also provides the BroadbandStat application, which allows the 
consumer to confirm or dispute the coverage represented on the broadband inventory map. These 
consumer initiated actions are facilitated through the Connect Puerto Rico website and the Connect 
Puerto Rico Interactive Mapping Tool (BroadbandStat) that offer the citizens the vehicles to provide 
information regarding availability in their respective service area, either in affirmation or contest of 
the reported data represented in the Connect Puerto Rico mapping artifacts.  Since the initial data 
collection and release of corresponding maps, feedback in the form of broadband inquiries has 
allowed Connected Nation to identify additional areas that are in need of field validation, which is 
scheduled as soon as possible.  
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Community Anchor Institutions  
 
Connect Puerto Rico has established an ongoing mechanism for gathering data on the location and 
broadband connectivity of Community Anchor Institutions (CAI), in accordance with the data 
requirements of the SBDD NOFA Technical Appendix.   
 
In conjunction with the Commonwealth of Puerto Rico, outreach was conducted during this data 
update reporting period by Connect Puerto Rico to continue identification of existing, centralized 
sources for CAI connectivity data.  Working with the Puerto Rico Office of the Chief Information 
Officer (OCIO), Connect Puerto was able to secure data from the territory from a variety of CAIs 
and process this data for inclusion in the upcoming submission.  Outreach was coordinated to 
distribute both an English and Spanish language CAI survey to institutions throughout the territory 
through multiple methods including a customized online survey available on the Connect Puerto 
Rico website.  Connect Puerto Rico continues to work in close coordination with territory-wide 
associations such as the Consejo General de Educación, Consejo de Educación de Puerto Rico, and 
Departamento de Salud - OIAT to promote the importance of broadband connectivity at anchor 
institutions and participation in this data collection process.   
 
While we continue to document institutions and the related addresses, the connectivity data 
collected in most categories remains incomplete at this time.  Connect Puerto Rico will be 
implementing a number of new processes to increase participation including launching a CAI 
newsletter to connect communities across the territory, increasing industry-specific planning to 
target new community contacts, and revising the CAI portion of our website to increase visibility 
and content.  Additionally, Connect Puerto Rico will continue working closely with the OCIO to 
reach CAI associated with their respective sectors.  From our work in Connect Puerto Rico, as well 
as other states, we recognize the great value of this data to future collaboration efforts within the 
territory and its value to the recently released National Broadband Map.  We plan to continue to 
bring best practices to the Connect Puerto Rico efforts, along with an investment of both human 
and technical resources required to reach our goal of increasing the data that is secured and reported 
as part of this process. 
 
The Connect Puerto Rico program exists to improve data on the deployment and adoption of 
broadband services and to assist in the extension of broadband technology across all regions of the 
great Commonwealth of Puerto Rico, as well as the United States through contribution to the 
National Broadband Map.  We look forward to the continuing work ahead. 
 
Respectfully submitted, 
 
 
Thomas W. Ferree 
Chief Operating Officer 
Connected Nation, Inc. 
 
cc:  Juan Eugenio Rodriguez de Hostos, CIO 
      Government of Puerto Rico 

dclark
Cueball
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DATA ACQUISITION:  PUERTO RICO COMMUNITY ANCHOR INSTITUTIONS  

In this third reporting period of the SBDD, Connect Puerto Rico, working in close coordination 
with the Puerto Rico Office of the Chief Information Officer (OCIO), has established an ongoing 
mechanism for gathering data on the location and broadband connectivity of Community Anchor 
Institutions (CAI), in accordance with the data requirements of the SBDD NOFA Technical 
Appendix.  During this reporting period Connect Puerto Rico has continued to focus efforts on 
conducting outreach and raising awareness of this important project. 
 
Connect Puerto Rico has continued to identify and process CAI data obtained through an ongoing 
territory-wide outreach campaign.  Physical address information continues to be augmented through 
manual sourcing and geocoded by Connect Puerto Rico through ESRI ArcGIS software.  One of 
the challenges that we face in Puerto Rico is the use of a non-standard addressing system.  
Discussions are ongoing with the OCIO and internal staff to address this issue and report data to 
NTIA that has not been processed and reported in this submission. 
 
Connect Puerto Rico continues to utilize a customized online survey hosted through SurveyMonkey 
in both English and Spanish, with a landing page on the Connect Puerto Rico website that was 
developed during the first reporting period.  This survey, in combination with a customized data 
gathering spreadsheet, was distributed to a targeted list of CAI throughout the territory.  Connect 
Puerto Rico will continue to use these data gathering tools for future targeted outreach efforts 
throughout the coming months leading up to the next reporting period.  These materials are 
customized to fit the CAI categories as defined in the SBDD NOFA.   
 
The survey can be accessed at this link in both English and Spanish using the following password: 
 
English Survey 
http://en.connectpr.org/mapping/Community_Anchor_Institution_Data_Collection.php 
 
Spanish Survey 
http://es.connectpr.org/mapa/recopilacion_de_datos__de_instituciones_comunitarias_ancla.php  
 
Password:  CAI_PR_2158 
 
Connect Puerto Rico, OCIO, and OCIO consultants CSA Group, have worked closely together 
during this reporting period to conduct research as part of an ongoing process to identify existing, 
centralized sources for CAI connectivity data.  Centralized CAI broadband connectivity data was 
received during this reporting period from the OCIO and has been included in this submission.  We 
will continue to identify data sources that may have this type of data and include it in upcoming 
submissions as the data is made available. 
 
In tandem with these efforts to identify existing data, Connect Puerto Rico continues to identify key 
CAI contacts among all CAI categories in an effort to distribute and promote the online survey and 
raise awareness of the importance of CAI broadband connectivity.  



   
                                                                                             Connect Puerto Rico – Narratives and Methodologies 

 
 

April 1, 2011                                                                                                                                                  8 
  

Coordination with organizations such as Consejo General de Educación, Consejo de Educación de 
Puerto Rico, and Departamento de Salud – OIAT are very important to the success of this data 
collection effort, and we will continue to work closely with these and other agencies to gather 
connectivity data within Puerto Rico. 
  
Connect Puerto Rico has an ongoing mission to educate CAI throughout the territory on the 
importance of participating in the project.  Participation by these institutions will raise awareness 
about the importance of broadband connectivity and the need to report the requested data for 
inclusion on the National Broadband Map.  To assist with our data collection efforts, Connect 
Puerto Rico is developing an English and Spanish language CAI newsletter to be distributed 
quarterly beginning in April 2011.  The newsletter will highlight a CAI in Puerto Rico, encourage 
institutions to share their data, and highlight the National Broadband Map. 
 
The greatest challenge with collecting this data continues to be the difficulty in securing CAI 
broadband connectivity data. Connect Puerto Rico will continue its ongoing work with OCIO, the 
CSA group, and key organization contacts in an effort to raise awareness of this project among CAI 
and overcome the challenges of geocoding, identifying, and securing CAI data within Puerto Rico. 
 
A CAI summary of all processed and submitted data is provided below: 
 

CAI Type Total 
Physical 
Address Lat/Long

Technology 
of 

Transmission
Download 

Speed 
Upload 
Speed

K-12 Schools 1,998 1,998 1,689 1,504 1 1
Libraries 154 154 153 3 2 2
Healthcare 621 620 139 0 0 0
Public Safety 308 307 277 24 14 14
Higher Ed Institutions 553 553 88 21 16 16
Other Government 6 6 1 0 0 0
Other Non-Government 1,508 1,448 980 8 5 5
Total 5,148 5,086 3,327 1,560 38 38

 
 
SBDD DATA SUBMISSION METHODOLOGY 

The submission of the broadband dataset for April 1, 2011, is contained within the SBDD Data 
Transfer Model and additional components as released on the Grantee Workspace on January 14, 
2011. Connected Nation has reviewed all literature that relates to the release and use of this data 
transfer model and recognizes that it does not replace or dictate how data is stored, processed, or 
displayed for the state or territory, as it is meant primarily as a means to transfer the broadband data 
from all states and territories and populate the National Broadband Map in a seamless fashion. 
Guidance from the Technical Mapping Guide, as released on the Grantee Workspace on March 24, 
2011, was also followed to ensure the completeness and validity of the submission through 
completion steps and checklists, completing the DataPackage spreadsheet, uploading broadband 
datasets into the Data Transfer Model, and checking the dataset using the SBDD_CheckSubmission 
receipt process.  
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In addition to the narratives and methodologies contained herein, as well as the DataPackage.xls 
containing contact information, the data dictionary, and a provider summary table, the following 
feature classes are submitted within the SBDD Data Transfer Model for the Commonwealth of 
Puerto Rico. 
 
Inventory of Deliverables, Connect Puerto Rico:  April 1, 2011 
 
NOFA Requirement Data Transfer Model Data Description 
Appendix A:  1(a)(i) BB_Service_CensusBlock Broadband Service Availability of 

Facilities-Based Providers in 
Census Blocks of No Greater 
Than Two Square Miles in Area. 

Appendix A:   1(a)(ii) BB_Service_RoadSegment Broadband Service Availability of 
Facilities-Based Providers by Road 
Segment in Census Blocks Larger 
in Area Than Two Square Miles. 

Appendix A:   1(b) BB_Service_Wireless Broadband Service Availability of 
Wireless Services Not Provided to 
a Specific Address. 

Appendix A:   3(b) BB_ConnectionPoint_MiddleMile Broadband Service Infrastructure 
Middle-Mile and Backbone 
Interconnection Points. 

Appendix A:   4 BB_Service_CAInstitutions  Community Anchor Institutions-
Listing. 

 
The provider data collected by Connected Nation on behalf of the Commonwealth of Puerto Rico 
have been formatted per the given specifications and uploaded into the appropriate feature classes 
of the SBDD Data Transfer Model. Wireline availability is contained within census blocks and road 
segments, wireless availability is contained as polygons of coverage areas, and middle-mile 
connections and community anchor institutions are contained as point data. All speed data is 
contained at the census block, road segment, or wireless polygon level of availability. All efforts have 
been made to comply with formatting, domain, and metadata requirements to include as much 
information as possible.  
 
Connected Nation has continued outreach to satellite providers on their availability, technology, and 
speed information, but it is not included in this submission dataset.  Additional information is 
necessary to be able to show where service satisfactorily exists in the commonwealth rather than 
submitting the entire boundary of the island as the serviceable area.  Analysis information distributed 
and discussed with the satellite providers, as well as any additional guidance from the Program 
Office on the desired analysis for satellite-serviceable areas, will be implemented for the October 
2011 data submission.  
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PUERTO RICO FIELD VALIDATION NARRATIVE 

Connected Nation focused a portion of its time on specific validation processes such as: 
 

• conducting random spectrum analysis studies throughout the territory using an Avcom PSA-
37-XP spectrum analyzer; 

• conducting mobile speed tests throughout the territory using an iPhone, Android (or other 
smart phone) as well as provider-specific aircards (Sprint 3G/4G, Clearwire et al); 

• identifying pre-selected, provider-submitted wireless transmit tower sites and cross-
referencing data about that tower against the Federal Communications Commission (FCC) 
databases such as Antenna Structure Registration and/or the Universal Licensing System; 

• cross-referencing Federal Registration Number data against available FCC Form 477 data as 
well as the FCC COmmission REgistration System (CORES); 

• validating provider submitted data (for example: latitude/longitude) using a handheld 
Garmin eTrex Summit GPS unit or GPS enabled software such as Microsoft Streets and 
Trips; 

• locating physical wire-line attributes (such as remote terminals, CATV plant, etc.) and 
comparing them against provider submitted data; and 

• conducting on-net and off-net speed tests using the FCC portal at 
http://www.broadband.gov/qualitytest/about/ or using the Ookla Net Metrics enabled 
speed test utility located on each of Connected Nation’s state specific websites. 

 
Additionally, Connected Nation cross-referenced numerous public documents in order to ensure 
that all known broadband providers were located and contacted.  This included searching 
membership logs from the trade associations (WISPA, WCAI, PCIA, etc.), the Cable Television Fact 
Book, Public Utility Commission records, Public Service Commission records, Chamber of 
Commerce, etc. 
 
To date Connected Nation’s staff conducted on-site validation tests in Puerto Rico on the following 
providers:  Aeronet Wireless, AT&T, Critical Hub Networks, Data@ccess, Liberty Cablevision of 
Puerto Rico, Neptuno Media, San Juan Cable LLC d.b.a. OneLink, Puerto Rico Telephone 
Company, Sprint, T-Mobile, and Worldnet. 
 
During this reporting period, Connected Nation conducted 81 additional on-site validation tests 
with Aeronet Wireless, AT&T, Critical Hub Networks, Neptuno Media, San Juan Cable LLC d.b.a. 
OneLink, Puerto Rico Telephone Company, and Sprint. 
 
From program initiation through this reporting period, Connected Nation has completed in-the-
field validation testing against 11 companies (out of a universe of 19 viable providers) totaling 
57.89% on the island of Puerto Rico.   
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DATA SUBMISSION OF NON-PARTICIPATING PROVIDER  

As part of its ongoing broadband mapping efforts, Connected Nation has developed a series of 
processes with the goal of submitting mapping data to NTIA for every known and qualifying 
broadband provider, regardless of whether the provider has chosen to support and participate in the 
SBDD mapping initiative. 
 
The following narrative will discuss the recent data collection activities related to San Juan Cable, 
LLC (d.b.a. OneLink), a cable television and cable modem provider in the San Juan, Puerto Rico 
area, explaining how and where CN obtained publicly available data and the “on-the-ground” 
validation techniques that support the underlying data.   
 
Background 
CN staff members attended meetings in Puerto Rico from September 21-25, 2009, for a series of 
one-on-one provider meetings, which had been scheduled by Maria Pou, Special Assistant to the 
OCIO, to discuss the SBDD grant program.  OneLink was scheduled to attend a meeting on 
September 24 at 10:00 a.m.; however, no one from their organization arrived (nor did they notify 
Maria of their intent to cancel). Outreach efforts conducted from September 2009 through 
September 2010 failed to motivate San Juan Cable, LLC into either responding or participating in 
the mapping initiative. 
 
The Issue 
San Juan Cable, LLC, by its lack of actions, indicated its unwillingness to participate in the island-
wide mapping initiative. This surfaced as a problem during the first two stages of mapping and the 
lack of data for this provider will continue to threaten to skew future research and planning activities 
under the direction of the OCIO. 
 
Identification of Provider’s Legal Name, d.b.a., and FRN 
CN began building a file based on anecdotal information and, as time progressed, enriched the file 
with information obtained through the public domain.  For example, CN received information from 
the Junta Reglamentadora de Telecomunicaciones de Puerto Rico (“JRT”) indicating that territory 
once operated by Adelphia was the same territory now operated by OneLink.  A search for a Federal 
Registration Number (“FRN”) on the FCC COmmission REgistration System (“CORES”) system 
did not yield results.  It was later discovered that the entity of record with the JRT was, in fact, San 
Juan Cable, LLC.  A new search on the FCC CORES site yielded an FRN of 0013778857 and 
additional contact data.  This was later confirmed when NTIA provided CN with a submission 
summary comparison against FCC Form 477 filers (see graphic below). 
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Identification of Provider’s Coverage Area 
Connected Nation extracted the municipio boundaries from OneLink’s publicly available website 
(see first illustration below) and used the company’s published boundaries to create a GIS shapefile 
(see second illustration below) of the greatest advertised extent of OneLink’s service area. 
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These polygons were then compared against the only shred of data supplied by OneLink during the 
course of attempted communication (see comparative illustration below).  The purple-shaded area 
was the CN coverage polygon extracted from OneLink’s website, and the red outlines illustrate the 
franchisee boundaries submitted by OneLink. 
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Using this combined coverage polygon as the basis for further investigation, Connected Nation set 
out on an exploratory “drive test” to determine where cable plant existed and estimate where cable 
modem likely existed in the greater San Juan area.  During the period of February 7-11, 2011, 
Connected Nation deployed five staff members (all highly trained, former telecommunications 
operators) to conduct a thorough analysis of OneLink’s “alleged” coverage area.  
 
Testing Techniques  
Specific quadrants were assigned to each of the 
validation teams on a daily basis.  The goal was 
to drive through each of the areas and 
determine the existence (or lack thereof) of 
CATV plant – whether fiber or coaxial. 
 
Test points were pre-selected and entered into 
Microsoft Streets & Trips, which also created a 
GPS-enabled “trace route” of each day’s drive 
testing activities. 
 

 
As cable plant was identified, markers were 
placed within Streets & Trips pinpointing the 
areas where service was likely to exist. 
 
Connected Nation staff members then 
proceeded to stop at points along the way and 
conducted random interviews with residents 
within the area querying the actual availability of 
cable modem service. 
 
 

Based on the lack of visible or traceable cable 
plant, polygons were created in ArcGIS 
Explorer to specify the population areas where 
the Connected Nation staff believed coverage 
gaps existed. 
 
The illustration on the right represents one 
such “gap area” identified during the drive test. 
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Visual identification of physical CATV 
plant was relatively easy and 
straightforward. The Connected Nation 
team members, many of whom were 
former CATV operators, found very 
little difficulty in identifying aerial 
(above ground) CATV plant or in 
locating plant that traveled below the 
earth’s surface (underground plant) 
based simply on looking for specific 
cable routes. 
 
 
 
The image to the left below demonstrates that the Connected Nation team could, in fact, locate 
aerial plant while the image to the right below demonstrates where CATV plant moved from an 
aerial design to an underground design.  In the picture to the right, the CATV plant moves from a 
pole to an area where underground vaults or above-ground pedestals could be easily traced and 
identified. 

 
  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
At the conclusion of this week-long exercise, Connected Nation had driven through several hundred 
miles of the OneLink franchise area, located above ground and underground plant, visited with and 
surveyed numerous local residents, obtained collateral material from OneLink’s local offices (to 
determine maximum advertised connection speeds), and created a polygon that illustrates the 
identified and likely coverage area of OneLink.  
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Results and Submission for April 2011 
As a result of the collection of publicly available information and the on-the-ground validation 
efforts, Connected Nation is submitting on behalf of the Commonwealth of Puerto Rico, the cable 
modem broadband service area of OneLink. Without provider participation and support of the 
SBDD mapping initiative, CN has proceeded with developing a relevant and feasible methodology 
for collecting and validating the service area of a currently non-participating broadband provider. 
The image below shows the exact results of the validation efforts in terms of the revisions made to 
the advertised cable broadband availability in the San Juan area. Polygons in red demonstrate areas 
where the CN staff reasonably believes “gaps” exist in the franchise area. The remaining purple-
shaded areas are included, along with full attributes, in the Puerto Rico broadband data submission 
for the April 1, 2011, deliverable to NTIA for the SBDD grant program. 
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Sample OneLink Cable Modem Collateral Material 
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ACCURACY AND VERIFICATION:  METHODOLOGY - PROVIDER VALIDATION 

Broadband providers maintain their service area data in many different formats, all in varying levels 
of complexity and granularity. In order to ensure that the data required by the NTIA is standardized 
across all providers and that it is as accurate as possible, Connected Nation translates and formats 
the data that providers are able to supply into a GIS shapefile and produces maps for the provider to 
review.  The resulting map(s) and review process allow for providers to see their service area in a 
geographic format – for some providers, this is the first time they have seen maps of their 
broadband service area. Having the mapped service area allows providers to quickly identify any 
issues that appear in the data representation, whether the issue is in the data translation into a GIS 
format or from the original data collection and submission. Often data is provided from various 
sources and through the review and revision process, local engineers who operate the networks and 
work in the field are able to ensure that the tabular data that has been submitted is accurate and 
represents the real-world network extent. Any issues in how the service area is represented on the 
map(s) are remedied by Connected Nation, whether they are additions, removal of service, or any 
other revisions. Revised maps of service area representations are sent to the provider for review and 
approval; Connected Nation will revise data and return maps as many times as necessary until the 
provider is in agreement that the map represents their service area as accurately as possible. Once 
the review process has been completed and final approval of the data is provided, the data is deemed 
ready for NTIA submission. 
 
Once the data collection has been aggregated to an island-wide level, static maps of island-wide and 
municipality-level availability are produced and made publicly available. In addition, consumers can 
visit the interactive online tool, BroadbandStat, to create customized views of broadband service 
areas and analyze corresponding demographic information. Leveraging broadband service data on 
various platforms allows for public users, providers, and other stakeholders to review, scrutinize, 
and provide feedback on the represented data. This feedback becomes a validation method in itself 
as consumers submit inquiries to Connected Nation either affirming where service is not available or 
identifying areas where broadband service is shown on the map, but in actuality is not available. This 
allows for a follow-up to providers regarding revisions to the data as it is represented; it also allows 
for Connected Nation to identify locations where on-site visits may be necessary to complete field 
validation of available services. Public feedback on all forms of mapping products serves as a 
localized validation method for provider-supplied information and allows Connected Nation to 
resolve inaccuracies as they are identified to ensure that only the highest quality information is 
provided to stakeholders. 
 
Estimates derived from provider-validated data indicate that approximately 8.18% of Puerto Rico 
households do not have terrestrial fixed broadband service available, and approximately 0.89%1 of 
Puerto Rico households have neither mobile nor fixed broadband service available.2   

                                                 
1 In accordance with NTIA’s definition of available broadband service as specified in the SBDD NOFA, this estimate 

includes both terrestrial fixed and mobile broadband service, if the service offers download speeds of at least 768 Kbps 
and upload speeds greater than 200 Kbps. 

2 Due to the nature of the SBDD data collection methodology as defined by the NTIA and based on both census 
block geographic units and street segment data, the estimates of broadband availability derived from provider-validated 
data may include an overstatement of the actual number of households with broadband availability.  Under the census 
block-based data collection method, a provider will typically report broadband availability for an entire census block 
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Within rural areas of the commonwealth, results derived from provider-validated data indicate that 
approximately 12.68% of rural Puerto Rico households do not have terrestrial fixed broadband 
service available, and approximately 1.49%3 of rural Puerto Rico households have neither mobile nor 
fixed broadband service available.4   
 
 
WIRELESS METHODOLOGY 

 
Broadband Service Availability in Provider’s Service Area 

Wireless Services Not Provided to a Specific Address 
 
Data solicited from a fixed wireless provider to create propagation models include, but are not 
limited to: 

1. The name of the structure 
2. Whether the transmitting device is operational or proposed 
3. The maximum advertised downstream speed, the maximum advertised upstream speed 
4. The typical downstream speed, the typical upstream speed (peak periods for both) 
5. The frequency range of spectrum being used (as prescribed by NTIA) 
6. The primary population center(s) being served (for geopolitical boundary reference) 
7. The physical address of the transmit site (in the event latitude/longitude is unavailable from 

the provider this allows a quick reference point for geocoding) 
8. Latitude in either Degrees, Minutes and Seconds and/or in Decimal Degrees (typically 

received as NAD 27 or NAD 83)  
9. Longitude in either Degrees, Minutes and Seconds and/or in Decimal Degrees (typically 

received as NAD 27 or NAD 83)  
10. Antenna pattern (e.g. omni-directional, 180°, 120°, 90°, etc.) 
11. Azimuth of antenna (e.g 360° with magnetic declination if known) 
12. Approximate transmit radius (in feet, miles, or kilometers) 
13. Polarity of transmit antenna (Vertical or Horizontal) 
14. Transmit antenna gain (in dBi) 
15. Line loss (applicable only to providers using coax, heliax, waveguide or other forms of 

cabling – excludes power-over-Ethernet devices) 
16. Mechanical and/or Electrical beam tilt (if applicable) 
17. Equipment Manufacturer (allows easy cross-reference against manufacturer’s specification 

sheet) 
18. Power output of the transmitting device (if unknown, FCC standards or manufacturer 

specifications are applied) 

                                                                                                                                                             
whether its network is present across the whole or only a subset of that census block.  This potential overestimation at 
the census block level can be amplified as the data is aggregated across the entire state or territory. 

3 See footnote 1. 
4 See footnote 2. 
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19. AMSL at base of tower site 
20. Antenna centerline AGL (height of antenna above ground level measured at the centerline 

of the actual antenna) 
21. Foliage factors (Evergreens/Deciduous and percent of ground cover) 
22. Ground Clutter (primarily used in rural areas to account for foliage and in metropolitan areas 

to account for types and heights of buildings if known)   
23. Average gain of receive antenna 
24. Receive antenna is estimated at height above average terrain (HAAT) of 6.2 meters/20 feet 
25. Federal Registration Numbers (if applicable) which may allow opportunities to cross-

reference and/or obtain additional data from the Federal Communications Commission 
Universal Licensing System and the COmmission REgistration System 

 
Propagation modeling is an empirical mathematical formulation for the characterization of radio 
wave propagation as a function of frequency, distance, and other conditions. Propagation 
software(s) typically use the Irregular Terrain Model (also known as Longley-Rice) of radio 
propagation for frequencies between 20 MHz and 20 GHz. This model is based on electromagnetic 
theory and statistical analyses of the combination of terrain features and radio measurements, then 
predicting the median attenuation of a radio signal as a function of distance and the variability of the 
signal in time and in space.  For metropolitan areas, the software can typically be adjusted to use the 
Okumura-Hata model which accounts for predicting the behavior of cellular transmissions in areas 
where buildings are the primary obstructions. The resulting product from either model depicts a 
graphical illustration of the theoretical propagation characteristics of a selected frequency range 
based on defined variables (receiver sensitivity of the home/mobile device, foliage factor, and digital 
elevation terrain input). 
 
 
BROADBAND INQUIRIES METHODOLOGY 

Connected Nation collects consumer feedback in the form of broadband inquiries. These inquiries 
represent any type of communication received from the public regarding broadband service. Once 
broadband inquiries are received across the island, this information is overlaid with the broadband 
availability information which was collected through the SBDD program.  This allows for a real-
world comparison of the broadband landscape to the information received from broadband 
inquiries.  Broadband inquiries are able to provide three types of information:  1) Residents who do 
not have broadband but want it.  2)  Residents who have broadband but want a different provider.  
3)  Residents who do not have broadband, but the broadband inventory maps indicate that they do. 
 
Through the collection of broadband inquiries, a visual demand for broadband is presented.  This 
visualization allows Connected Nation the ability to validate broadband availability maps for 
accuracy.  If residents within a region state that they are without broadband, but the broadband 
inventory maps show otherwise, this allows Connected Nation to approach the providers within that 
area in an effort to trim down their coverage to more accurately represent real-world availability on 
the ground.  On the other hand, if there is a region in the territory in which broadband is not 
available, the broadband inquiries allow providers close to that region to see where they can 
successfully expand their broadband networks, leading to a high return on investment.  In short, the 
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higher number of inquiries leads to a higher level of certainty in regard to the broadband availability 
maps.  Since the initial data collection and release of corresponding maps, feedback in the form of 
broadband inquiries has allowed Connected Nation to identify additional areas that are in need of 
field validation, which are scheduled as soon as possible. Additional information on field validation 
can be found in the Field Validation Narrative. 
 
The broadband inquiry process has been implemented in each of the Connected Nation programs 
with successful results. Altogether Connected Nation has received over 16,000 broadband inquiries 
since 2007, allowing the programs to evaluate each inquiry for broadband demand and data 
verification.  These inquiries are continuously examined against current broadband availability, 
updated every six months, to determine if previously unserved households have been expanded to 
and can now receive broadband at their residence. This database of broadband inquiries has also 
allowed the Connected Nation programs to aggregate demand in concentrated areas to show 
providers the exact locations where the population has made it clear that they would purchase 
broadband if it was made available to them. Providers have responded to this process and have 
expanded to areas knowing that their investment will be worthwhile. Data verification methods have 
also proven successful, as the programs have been able to show those inquiries that indicate the 
broadband service areas are misrepresented on the map to providers, who then verify where service 
cannot reach in regard to that residence(s). The broadband coverage in these jurisdictions has been 
altered to create a more accurate map based on the inquiries submitted by the public. 
 
During this reporting period, the Connect Puerto Rico project has received a total of 16 inquiries (24 
grant inception to date).  As more inquiries are submitted to Connect Puerto Rico, a more thorough 
validation of the broadband landscape can be performed, while also allowing providers to see which 
areas have a high demand for broadband adoption. 
 
 
BROADBANDSTAT METHODOLOGY  

BroadbandStat is an online, interactive mapping tool for viewing, analyzing, and validating 
broadband data. Developed through a partnership with ESRI, the market leader in geographic 
information system (GIS) software, BroadbandStat is a multi-functional, user-friendly way for local 
leaders, policymakers, consumers, and technology providers to devise a plan for the expansion and 
adoption of broadband.  
 
First and foremost, BroadbandStat allows consumers to locate their residence and identify providers 
that offer broadband Internet service to that location. The interactive platform allows for users to 
build and evaluate broadband expansion scenarios using a wealth of data, including education and 
population demographics, broadband availability, and research about the barriers to adoption.  
 
New functionality in BroadbandStat allows the consumers to provide feedback on the broadband 
data displayed on the interactive map.  Through the collection of this feedback, a visual demand for 
broadband is presented.  This visualization allows the Connected Nation programs the ability to 
validate the broadband availability for accuracy.  If residents within a region state they are without 
broadband, but the interactive map shows otherwise, this allows Connected Nation to approach the 
providers within that area in an effort to trim down their coverage to more accurately represent real-
world availability on the ground.   
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The Connect Puerto Rico project launched BroadbandStat on September 17, 2010, and has received 
a total of 369 visits to date, of which 224 occurred this reporting period. 
 
 
SPEED TEST METHODOLOGY 

The 165 speed tests that are represented in the Connect Puerto Rico Speed Test Report during this 
reporting period (396 grant inception to date) are the result of a partnership between Connected 
Nation and Ookla Net Metrics. Utilizing this relationship increases the level of confidence in the 
data being collected and provides for a far greater sample size than could be collected by a single 
testing site. 
 
Ookla owns and operates Speedtest.net, as well as develops and deploys speed tests, such as the 
Connect Puerto Rico speed test website, for partners around the world. This network of sites that is 
developed and run on its testing technology provides Ookla with a vast dataset that, due to the 
variability of geographic information collected across the varying speed test sites, is geocoded 
utilizing Geo-IP technology. This technology allows for tests to be geocoded to points of 
aggregation, typically larger nodes across provider networks.  While there are hundreds of thousands 
of tests that have been conducted, the level of aggregation is only sufficient for municipality-level 
detail due to the test results being located at these larger nodes and not at an absolute location for 
each speed test. 
 
In an effort to validate broadband data from the Connect Puerto Rico project, speed test 
information is collected throughout the commonwealth.  Speed tests provide speed information on 
the path taken through all networks (a provider’s network as well as additional networks) a local 
machine must connect to in order to reach the host test.  The benefit of this collection of speed 
information is two-tiered.  First, it allows for a comprehensive dataset of speeds, while also 
providing Connect Puerto Rico with the information on where broadband services are available.  
Second, unlike theoretical speed information which was received through the data collection 
process, the use of speed tests provide real-world information on the speeds that currently exist 
within the Commonwealth of Puerto Rico.   
 
 
 
 
 
 
 
 
 
 



Complete 12
Non-Responsive/Refused 0
In Progress 13

Count of Datasets by Viable Status 25
Total Unique Providers Represented 19

Provider Name Platform Status
NDA Execution 

Date Notes
AT&T Inc. Mobile Wireless Data Added to Statewide Inventory 12/16/2009
T-Mobile USA, Inc. Mobile Wireless Data Added to Statewide Inventory 1/8/2010
Aeronet Wireless Broadband Corp. Backhaul Backhaul Provider Only Processing Complete
Critical Hub Networks Backhaul Backhaul Provider Only Processing Complete 9/30/2010
Neptuno Networks, Inc. Backhaul Backhaul Provider Only Processing Complete 4/29/2010
Claro ILEC/CLEC Partial Data Approved 4/23/2010
Critical Hub Networks Fixed Wireless Provider Approval Solicited 9/30/2010

Puerto Rico Cable Acquisition Company, Inc. Cable Provider Approval Solicited 9/27/2010
Aeronet Wireless Broadband Corp. Fixed Wireless Provider Gathering Data
Claro Mobile Wireless Provider Gathering Data 4/23/2010
Data@ccess Communications Backhaul No Update to Provide 9/29/2009
MCI Communications Services, Inc. Backhaul No Update to Provide 12/14/2011
PREPA Networks Corp Backhaul No Update to Provide 4/21/2010
Sprint Nextel Corporation Backhaul No Update to Provide 1/14/2010
Sprint Nextel Corporation Mobile Wireless No Update to Provide 1/14/2010
Worldnet Telecommunications inc. Backhaul No Update to Provide 4/19/2010
Liberty Global, Inc. Cable No Update Provided - Use Last Submission Data 10/19/2009
Ayustar Corp Fixed Wireless Solicited Initial Data 7/12/2010
INTECO Fixed Wireless Solicited Initial Data
INTECO Backhaul Solicited Initial Data
Orizon Wireless Corp Fixed Wireless Solicited Initial Data 1/28/2011
Telefonica International Holding, BV Backhaul Solicited Initial Data

Hughes Network Systems, LLC Satellite Other 2/5/2010

[MAR-09-11 Jess Cary] Satellite data will not be 
submitted due to additional information being necessary 
to show where service is available, rather than 
submitting the entire island boundary as serviceable 
area.

Onelink Communications Cable Other

[FEB-11-11 Chip Spann] Independent of provider 
participation (or in this case, the lack thereof) the 
engineering and technical services team has completed 
the drive testing, validation, data collection of the 
OneLink system.  Data was obtained from the provider's 
website, collateral material veryfying Max Advertised 
Speed was obtained at the local office, routes were 
charted, pictures taken and revisions to coverage 
polygon created.
[MAR-8-2011 Jess Cary] Data will be submitted for April 
2011.

T-Mobile USA, Inc. Backhaul Other 1/8/2010
[MAR-09-2011 Jess Cary] As of December 31, 2010, T-
Mobile offers no backhaul service in Puerto Rico.

Broadband Provider Log
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Section A: The Rhode Island Broadband Mapping Team Overview

In support of the national broadband initiatives being undertaken by President Obama
and the Federal Government through the American Recovery & Reinvestment Act of
2009 (Recovery Act), Public Law No. 111-5, and the Broadband Data Improvement Act
(BDIA), title I of Public Law No. 110-385, 122 Stat. 4096, the Rhode Island Economic
Development Corporation (RIEDC), as the entity assigned by Governor Donald Carcieri,
has filed to the United States Department of Commerce – National Telecommunications
and Information Administration (NTIA) a request for grant funds from the State
Broadband Data and Development Grant Program.

Project Description
EA Engineering, Science, and Technology, Inc. (EA), has been selected by RIEDC for the
through their Broadband Initiative for Rhode Island (BBRI) to provide a data
management and retrieval system for RIEDC. RIEDC and EA entered into a contractual
agreement on January 15, 2010 for a base period of 2 (two) years with 3 (three) option
years. The work assignment consists of negotiating non disclosure agreements (NDA)
with the State’s broadband providers, collecting provider broadband data, verifying data
submitted, combining and updating data collected, developing and implementing a
broadband website with mapping application, and reporting findings to RIEDC and the
NTIA.

This program will create a statewide broadband map which will be maintained for five
(5) years, that assesses broadband infrastructure in Rhode Island and distinguishes
between served, underserved and un-served communities as per the definition specified
by NTIA. The data will be made available to the public, with certain restrictions to
account for confidentiality of supplier information, through a state website and will also
be linked to a Federal Department of Commerce webpage. The goal of this project is to
meet the RIEDC’s broadband mapping needs and in doing so provide maps and
information that will be used to lend guidance and assistance in the planning of future
broadband infrastructure development, as well as provide numerous broadband options
to the end users.

The BBRI is a comprehensive effort aimed at producing a high level of detailed inventory
of broadband services provided to residential, government and business consumers
within the State of Rhode Island. The project is not only a Geographical Information
Systems (GIS) mission but a project that needs expertise in GIS, contracting and legal
issues, Quality Assurance/Quality Control (QAQC), and project management. In order
to acquire, collect, process, analyze and display the data that represents these services
it was necessary to combine the resources of several professional firms. Each team
member provides unique set of strengths and capabilities needed to create the system
that is in place. The team is made up of Rhode Island Economic Development
Corporation (RIEDC), EA Engineering (EA), University of Rhode Island (URI), Adler Pollock
& Sheehan P.C. (AP&S), Eastern Shore Regional GIS Cooperative (ESRGC), and Mapping
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& Planning Services (M&PS). The following paragraphs provide information on each
team member and their role the project.

The RIEDC is leading the project efforts for the State of Rhode Island (RI). Led by Mr.
Stuart Freiman, they oversee all facets of the project and teams involved. The RIEDC
coordinates schedules, communicates directly with the National Telecommunications
Information Agency (NTIA), reviews and approves all project deliverables, and ensure all
project deadlines are met. With their high visibility in the RI business community they
are instrumental in arranging meetings between broadband providers and BBRI Team
members. The relationship and communication RIEDC has with the State’s providers
was and continues to be instrumental in making the process of collecting and verifying
information from the providers as effortless as possible.

EA is the prime contractor selected to lead the State’s data collection, verification,
reporting, and mapping efforts. EA has been providing scientific and engineering
technical solutions to a wide range of government and industrial clients since 1973.
Serving IT and GIS solutions via the web has become a standard business solution for
EA’s clients. As the prime contractor EA works closely with the RIEDC on all phase of the
BBRI project. Included in the work EA has done to date, is the creation of the State’s
broadband website and mapping application (Digital Atlas). The website provides
information on the project, links to related sites, custom mapping capabilities, and user
speed test and feedback forms. The site can be viewed at the following address;
http://broadband.ri.gov/.

M&PS has been providing GIS consulting services in RI for over 20 years. For the RI
Broadband Mapping project, M&PS assisted in the development of a verification and
analysis process which is used to perform the QA/QC of the data prior to submitting to
the NTIA. Prior to each bi-annual NTIA submittal M&PS uses this process to review and
check the data. During this process MP&S checks for positional and attribute accuracy
of the data by using a random sampling methodology. The service MP&S provides
insures data going to the NTIA is of the highest accuracy and precision. Additional
M&PS provides data analysis and static maps displaying the data status at each delivery
date.

The GIS laboratory in the URI’s Department of Natural Resources is the center of
technical expertise in the GIS field for the State of RI. On this project URI manages all
GIS data report by EA to the RIEDC. They also serve as an additional tier of QA/QC on
the data that is collected and submitted to the NTIA. URI provides technical input to the
data processes and the types of maps and data to be displayed on the website.
Additionally, several data layers including Community Anchor Institute locations and
base map layers being used on the Digital Atlas are provided by URI.

The Eastern Shore Regional GIS Cooperative (ESRGC) is an organization that provides
technical support, training, and GIS services to local governments on the Eastern Shore
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of Maryland. In addition to supporting the BBRI project, ESRGC is leading the
broadband mapping efforts for the state of Maryland. For the BBRI project, the ESRGC’s
provides the project team technical advisor support. They provide guidance on the
project’s technical approach and peer review support based on knowledge gained from
their work in Maryland. ESRGC provided assistance in defining requirements for the
QA/QC process, database design, and data verification tasks. The ESRGC provides the
Team with a “lessons learned” from the Maryland Broadband project which guided the
BBRI Team around common mistakes made on broadband mapping projects.

AP&S is a local RI law firm providing legal advice and representation and has been
servicing RI residents and firms for 50 years. The role AP&S plays on this project is
providing the necessary legal advice and contracting that is necessary between the
RIEDC and the broadband providers. To date, AP&S has brokered the Non-Disclosure
Agreements (NDA’s) between the RIEDC and 16 broadband providers. These
agreements were imperative and had to be in place before any data was submitted by
the broadband providers. All provider broadband information that is made public is
based on what the NDAs state. AP&S became the State’s expert as to what information
was legal for the team to make available to the public and modeled the NDAs off of the
guidance provided in the NOFA.

Project Contacts

Contact Project Role Phone Email

Rhode Island Economic Development Corp (RIEDC)

Stuart Freiman RIEDC PM 401-278-9168 sfreiman@riedc.com

Shane White State GIS
Coordinator

401-222-6483 swhite@doa.ri.gov

University of Rhode
Island

URI

Greg Bonynge URI-EDC
Director/BBRI
Project Liaison

401-874-2180 greg@edc.uri.edu

EA Engineering, Science and Technology (EA)

Jon Brownstein, Ph.D. Principal In
Charge

410-771-7950 jbrownst@eaest.com

Lou Garcia, PMP Project Manager 410-771-7950 lgarcia@eaest.com

Jason Samus Senior Technical
Review

410-771-7950 jsamus@eaest.com

Brian Lesinski Senior Technical
Advisor

401-736-3440 blesinsk@eaest.com
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Joe DeLuca, GISP Technical Lead 410-771-7950 jdeluca@eaest.com

Chuck Murza Task Manager 410-771-7950 cmurza@eaest.com

Adler Pollock & Sheehan (APS)

Alan Shoer, Esq. Legal Team 401-274-7200 ashoer@apslaw.com

Kristen Sherman, Esq. Legal Team 401-274-7200 KSherman@apslaw.co
m

Mapping & Planning Services (M&PS)

Mary Hutchinson.,
GISP

Verification
Analyst

401-423-3841 mhutch@mappingplan
ning.com

Eastern Shore Regional GIS Cooperative (ESRGC)

Michael Scott, Ph.D.,
GISP

Senior Technical
Advisor

410-543-6083 msscott@salisbury.edu
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BROADBAND PROVIDER DATA VERIFICATION REPORT
RHODE ISLAND DATA SUBMITTAL #2

MARCH 31, 2011

General Findings:

 Rhode Island has extensive broadband coverage from 17 providers using nine different
transmission types. There is broadband coverage for the entire state.

 Broadband availability on a census block basis is summarized in the Figure below:

Broadband Availability Census Blocks % of Total

Unserved; census block has no access to broadband 6 <1

Underserved: One to Two broadband providers 8 <1

Competitive: Three to Four broadband providers 99 <1

Five to Nine broadband providers 12,786 61

Ten to Twelve broadband providers 8,124 39

Total 21,023 100
Note: Several of the Provider datasets do not show coverage of some census blocks in Rhode Island coastal waters (for example, the
satellite providers). This results in some over-reporting of the availability results at the low end, in particular, the unserved figures.
Broadband is defined as being wireline, wireless and satellite service for this table.

 A total of 17 broadband Providers submitted data; 11 wireline and 6 wireless. The
completeness of the attributes in the 17 providers’ datasets is summarized in the Figures below.
(Statistics for NTIA Delivery 1 are included for comparison purposes).

Completeness of Wireline Data :: 11 Providers
Del ivery 1 (grey) and Del ivery 2 (green)
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Completeness of Wireless Data :: 4 Providers
Del ivery 1 (grey) and Del ivery 2 (blue)
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Completeness of Satellite Data :: 2 Providers
Del ivery 1 (grey) and Del ivery 2 (orange)
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 Middle Mile data was provided by 7 broadband providers. There were a total of 39 facilities (13
owned and 26 leased).

 No Last Mile data was provided by any of the broadband providers.

 A total of 1,115 Community Anchor Institutions are identified. These were verified with
available Rhode Island Geographic Information System (RIGIS) datasets and 414 RIEDC and FCC
speed tests.
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 The RIEDC has collected 2,798 speed tests in 1,158 (5.5%) of the census blocks within the State.
These tests are for the period 3/23/10 to 3/14/11. There is a continued growth both in the
number and distribution of the RIEDC speed tests.

 A total 1,693 wireline speed tests from FCC are used for the verification. These tests are for the
period 3/11/10 to 12/29/10 and cover 871 (4%) of the census blocks within the State. Tests
were collected by OOKLA and MLAB.

 FCC tests for Mobile Applications (accessing Cellular and WiFi) are also used for the verification.
These 2,509 speed tests are recorded for the period 3/11/10 to 12/29/10 and cover 699 (3%) of
the census blocks within the State. These tests were all collected by OOKLA.

 The distribution of the three speed tests (RIEDC, FCC and FCC Mobile Applications) are similar
and follow population and household patterns across the State. The distribution of the speed
tests are shown in the Figures on the following page.

 Road Segment data (for census blocks greater than 2 sq miles) was provided by 1 provider.
Service Address data (for census blocks greater than 2 sq miles) was provided by 2 providers. A
total of 32 of the 36 census blocks greater than 2 sq. miles thus have road segment and/or
service address data.
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The Figures below show the distribution of speed tests used for verification purposes.

FCC Collected Speed Test - Mobile FCC Collected Speed Test - Wireline RIEDC Collected Speed Test

The Figures below display the wireline and wireless coverage areas reported in Rhode Island and the number of providers available per census
block.
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Rhode Island Broadband Coverage Map Number of Providers Available Per Census Block
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The Figures below display the availability of each technology types offered in Rhode Island.

Satellite Coverage Copper Wireline Coverage Cable Coverage
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The Figures below display the availability of each technology types offered in Rhode Island.

Fiber Optic Coverage Wireless Coverage DSL Coverage
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Provider Name: AT&T Mobility LLC
DBA: AT&T Mobility LLC

Data Characteristics
FRN: 0004979233
Type of Data Submitted: Wireless
Census Block Count (unique): 21,008
Provided Technology of Transmission: YES
Provided Spectrum Used: YES
Provided Max Advertised Download Speed: YES
Provided Max Advertised Upload Speed: YES
Provided Typical Download Speed: NO
Provided Typical Upload Speed: NO
Provided Middle Mile: NO
Provided Last Mile: NO

Maximum advertised down/upload speeds reported by provider:

Max Download Category Max Upload Category

4 3

Typical down/upload speeds reported by provider: Not provided

Number of technology of transmission types and spectrums reported by provider: 1, with 2 spectrums

Data Verification:

Counties served by provider and number of census blocks with service. A total of 21, 008 census blocks are
served.

County Census Blocks per County

Bristol 949

Kent 3,836

Newport 1,902

Providence 11,246

Washington 3,075

Greatest down/upload speed from Historical 1 speed tests: 9, 8
Greatest down/upload speed from RIEDC 2 speed tests: 7, 5
Greatest down/upload speed from FCC 3 speed tests: No speed tests were taken
Greatest down/upload speed from FCC 4 Mobile Application speed tests: 7, 3

Count of Historical speed tests: 1,010
Count of RIEDC speed tests: 5
Count of FCC speed tests: 0
Count of FCC Mobile Application speed tests: 26
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Speed tests outside of reported service area: 0

%/# of census blocks verified by RIEDC and FCC speed tests:

Confirmation of census blocks served 15

Census blocks served, not reported by provider 0

Total number of served census blocks reported by provider 21,008

% of served census blocks confirmed by speed test <1%

Middle mile facilities outside of reported service area: No middle mile facilities.

Footnotes:
1 Historical Date Range: 3/23/2009 to 3/22/2010
2 RIEDC Date Range: 3/23/2010 to 3/14/2011
3 FCC Date Range: 3/11/2010 to 12/29/10
4 FCC Mobile Application Date Range: 3/11/2010 to 12/29/10
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Provider Name: Broadview Networks, Inc.
DBA: Broadview Networks, Inc.

Data Characteristics
FRN: 0003775285
Type of Data Submitted: Census Blocks
Census Block Count (unique): 9,015
Provided Technology of Transmission: YES
Provided Max Advertised Download Speed: NO
Provided Max Advertised Upload Speed: NO
Provided Typical Download Speed: YES
Provided Typical Upload Speed: YES
Provided Middle Mile: YES
Provided Last Mile: NO
Provided Road Segments for census blocks greater than 2 sq miles: NO
Provided Address Points for census block greater than 2 sq miles: NO

Maximum advertised down/upload speeds reported by provider:

Technology Max Download Category Count Max Upload Category Count

10 N/A 8,974 N/A 8,974

20 N/A 3 N/A 3

30 N/A 106 N/A 106

Typical down/upload speeds reported by provider:

Technology Max Download Category Count Max Upload Category Count

10 4 3 4 3

20 4 1 4 1

30 5 10 5 10

Number of technology transmission types reported by provider: 3

Count of Middle Mile Facilities: 8

Data Verification:

Counties served by provider and number of census blocks with service. A total of 9,015 census blocks are
served.

County Census Block per County

Bristol 4

Kent 1,190

Newport 717

Providence 7,098

Washington 6
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Greatest down/upload speed from Historical 1 speed tests: 4, 4
Greatest down/upload speed from RIEDC 2 speed tests: 4, 4
Greatest down/upload speed from FCC 3 speed tests: 4, 4
Greatest down/upload speed from FCC Mobile Application speed tests: No speed tests were taken

Count of Historical speed tests: 64
Count of RIEDC 2 speed tests: 5
Count of FCC 3 speed tests: 2
Count of FCC Mobile Application 4 speed tests: 0

RIEDC and FCC speed tests outside of reported service area: 0

Middle mile facilities outside of reported service area: All are centrally located within the reported census
blocks.

%/# of census blocks verified by RIEDC & FCC speed tests:

Confirmation of census block served 7

Census blocks served, not reported by provider 0

Total number of served census blocks reported by provider 9,015

% of served census blocks confirmed by speed test <1%

Footnotes:
1 Historical Date Range: 3/23/2009 to 3/22/2010
2 RIEDC Date Range: 3/23/2010 to 3/14/2011
3 FCC Date Range: 3/11/2010 to 12/29/10
4 FCC Mobile Application Date Range: 3/11/2010 to 12/29/10
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Provider Name: Cellco Partnership
DBA: Verizon Wireless

Data Characteristics
FRN: 0003290673
Type of Data Submitted: Wireless
Census Block Count: 20,929
Provided Technology of Transmission: YES
Provided Spectrum Used: YES
Provided Max Advertised Download Speed: YES
Provided Max Advertised Upload Speed: YES
Provided Typical Download Speed: YES
Provided Typical Upload Speed: YES
Provided Middle Mile: NO
Provided Last Mile: NO

Maximum advertised down/upload speeds reported by provider:

Max Download Category Max Upload Category

5 4

Typical down/upload speeds reported by provider: 3, 3

Number of technology of transmission types and spectrums reported by provider: 1, with 3 spectrums

Data Verification:

Counties served by provider and number of census blocks with service. A total of 20,929 census blocks are
served.

County Census Blocks per County

Bristol 948

Kent 3,800

Newport 1,875

Providence 11,241

Washington 3,065

Greatest down/upload speed from Historical 1 speed tests: No speed tests were taken
Greatest down/upload speed from RIEDC 2 speed tests: 3, 2
Greatest down/upload speed from FCC 3 speed tests: 4,2 and 3, 3
Greatest down/upload speed from FCC Mobile Application 4 speed tests: 7,4 and 6,5

Count of Historical speed tests: 0
Count of RIEDC 2 speed tests: 6
Count of FCC 3 speed tests: 8
Count of FCC Mobile Applications 4 speed tests: 203
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RIEDC and FCC speed tests outside of reported service area: 0

%/# of census blocks verified by RIEDC and FCC speed tests:

Confirmation of census blocks served 25

Census blocks served, not reported by provider 0

Total number of served census blocks reported by provider 20,929

% of served census blocks confirmed by speed test <1%

Footnotes:
1 Historical Date Range: 3/23/2009 to 3/22/2010
2 RIEDC Date Range: 3/23/2010 to 3/14/2011
3 FCC Date Range: 3/11/2010 to 12/29/10
4 FCC Mobile Application Date Range: 3/11/2010 to 12/29/10
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Provider Name: Cogent Communication, Inc.
DBA: Cogent Communication

Data Characteristics
FRN: 0004654042
Type of Data Submitted: Census Blocks
Census Block Count (unique): 2
Provided Technology of Transmission: YES
Provided Max Advertised Download Speed: YES
Provided Max Advertised Upload Speed: YES
Provided Typical Download Speed: NO
Provided Typical Upload Speed: NO
Provided Middle Mile: YES
Provided Last Mile: NO
Provided Road Segments for census blocks greater than 2 sq miles: NO
Provided Address Points for census block greater than 2 sq miles: NO

Maximum down/upload speeds reported by provider:

Max Download Category Count Max Upload Category Count

11 2 11 2

Typical down/upload speeds reported by provider: Not Provided

Number of technology of transmission types reported by provider: 1

Count of Middle Mile Facilities: 2

Data Verification:

Counties served by provider and number of census blocks with service. A total of 2 census blocks are served.

County Census Blocks per County

Bristol 0

Kent 0

Newport 0

Providence 2

Washington 0

Greatest down/upload speed from Historical 1 speed tests: No speed tests were taken
Greatest down/upload speed from RIEDC 2 speed tests: No speed tests were taken
Greatest down/upload speed from FCC 3 speed tests: No speed tests were taken
Greatest down/upload speed from FCC Mobile Applications 4 speed tests: No speed tests were taken
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Count of Historical speed tests: 0
Count of RIEDC 2 Speed tests: 0
Count of FCC 3 speed tests: 0
Count of FCC Mobile Applications 4 speed tests: 0

RIEDC and FCC speed tests outside of reported service area: No speed tests were taken

Middle mile facilities outside of reported service area: All are located within the reported census blocks.

%/# of census blocks verified by RIEDC and FCC speed tests:

Confirmation of census block served 0

Census blocks served, not reported by provider 0

Total number of served census blocks reported by provider 2

% of served census blocks confirmed by speed test 0%

Footnotes:
1 Historical Date Range: 3/23/2009 to 3/22/2010
2 RIEDC Date Range: 3/23/2010 to 3/14/2011
3 FCC Date Range: 3/11/2010 to 12/29/10
4 FCC Mobile Application Date Range: 3/11/2010 to 12/29/10
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Provider Name: CoxCom, Inc.
DBA: Cox Communications, Inc.

Data Characteristics
FRN: 0001524461
Type of Data Submitted: Census Blocks, Address Points
Census Block Count (unique): 20,229
Service Address Point Count (unique): 3,887)
Provided Technology of Transmission: YES
Provided Max Advertised Download Speed: YES
Provided Max Advertised Upload Speed: YES
Provided Typical Download Speed: NO
Provided Typical Upload Speed: NO
Provided Middle Mile: YES
Provided Last Mile: NO
Provided Road Segments for census blocks greater than 2 sq miles: NO
Provided Address Points for census block greater than 2 sq miles: YES

Maximum advertised down/upload speeds reported by provider:

Data Type Max Download Category Max Upload Category Count

Census Blocks 9 5 20,229

Service Address Points 9 5 3,887

Typical down/upload speeds reported by provider: Not provided

Number of technology of transmission types reported by provider: 1

Count of Middle Mile Facilities: 1

Data Verification:

Counties served by provider and number of census blocks with service (including 31 census blocks with service
addresses). A total of 20,229 census blocks are served.

County Census Blocks per County

Bristol 910

Kent 3,745

Newport 1,739

Providence 10,958

Washington 2,877

Greatest down/upload speed from Historical 1 speed tests: 9, 9 and 10, 6
Greatest down/upload speed from RIEDC 2 speed tests: 11,5 and 9,9
Greatest down/upload speed from FCC 3 speed tests: 9, 5 and 5, 8
Greatest down/upload speed from FCC Mobile Applications 4 speed tests: 7, 6
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Count of Historical speed tests: 98,305
Count of RIEDC 2 speed tests: 1,541
Count of FCC 3 speed tests: 784
Count of FCC Mobile Applications 4 speed tests: 855

RIEDC and FCC speed tests outside of reported service area: 14 of 3,180 speed tests were recorded outside of
the coverage area reported by provider.

Middle mile facilities outside of reported service area: All are located within the reported census blocks.

%/# of census blocks verified by RIEDC and FCC speed tests:

Confirmation of census block served 1,364

Census blocks served, not reported by provider 12

Total number of served census blocks reported by provider 20,229

% of served census blocks confirmed by speed test 7%

Footnotes:
1 Historical Date Range: 3/23/2009 to 3/22/2010
2 RIEDC Date Range: 3/23/2010 to 3/14/2011
3 FCC Date Range: 3/11/2010 to 12/29/2010
4 FCC Mobile Application Date Range: 3/11/2010 to 12/29/2010
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Provider Name: DIECA Communications, Inc.
DBA: Covad Communications Company

Data Characteristics
FRN: 0003753753
Type of Data Submitted: Census Blocks
Census Block Count: (unique) 11,277
Provided Technology of Transmission: YES
Provided Max Advertised Download Speed: YES
Provided Max Advertised Upload Speed: YES
Provided Typical Download Speed: YES
Provided Typical Upload Speed: YES
Provided Middle Mile: NO
Provided Last Mile: NO
Provided Road Segments for census blocks greater than 2 sq miles: NO
Provided Address Points for census block greater than 2 sq miles: NO

Maximum advertised down/upload speeds reported by provider:

Technology Max Download Category Max Upload Category Count

10 6 3 3,267

20 5 4 1,578

30 5 5 6,007

Typical down/upload speeds reported by provider:

Technology Max Download Category Max Upload Category Count

10 6 3 5

20 4 4 1,568

30 5 5 6,003

Number of technology of transmission types reported by provider: 3

Count of Middle Mile Facilities: 1

Data Verification:

Counties served by provider and number of census blocks with service. A total of 11,277 census blocks are
served.

County Census Blocks per County

Bristol 745

Kent 2,767

Newport 1

Providence 7,764

Washington 0
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Greatest down/upload speed from Historical 1 speed tests: 9, 3
Greatest down/upload speed from RIEDC 2 speed tests: No speed tests were taken
Greatest down/upload speed from FCC 3 speed tests: No speed tests were taken
Greatest down/upload speed from FCC Mobile Applications 4 speed tests: No speed tests were taken

Count of Historical speed tests: 57
Count of RIEDC 2 speed tests: 0
Count of FCC 3 speed tests: 0
Count of FCC Mobile Applications 4 speed tests: 0

RIEDC and FCC speed tests outside of reported service area: No speed tests were taken

%/# of census blocks verified by RIEDC and FCC speed tests:

Confirmation of census block served 0

Census blocks served, not reported by provider 0

Total number of served census blocks reported by provider 11,277

% of served census blocks confirmed by speed test 0%

Footnotes:
1 Historical Date Range: 3/23/2009 to 3/22/2010
2 RIEDC Date Range: 3/23/2010 to 3/14/2011
3 FCC Date Range: 3/11/2010 to 12/29/2010
4 FCC Mobile Application Date Range: 3/11/2010 to 12/29/2010
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Provider Name: Fiber Technologies Networks, LLC.
DBA: FiberTech

Data Characteristics
FRN: 0006797849
Type of Data Submitted: Census Blocks
Census Block Count (unique): 3
Provided Technology of Transmission: YES
Provided Max Advertised Download Speed: YES
Provided Max Advertised Upload Speed: YES
Provided Typical Download Speed: NO
Provided Typical Upload Speed: NO
Provided Middle Mile: NO
Provided Last Mile: NO
Provided Road Segments for census blocks greater than 2 sq miles: NO
Provided Address Points for census block greater than 2 sq miles: NO

Maximum advertised down/upload speeds reported by provider:

Max Download Category Max Upload Category Count

7 7 2

Typical down/upload speeds reported by provider: Not provided

Number of technology of transmission types reported by provider: 1

Count of Middle Mile Facilities: 0

Data Verification:

Counties served by provider and number of census blocks with service. A total of 3 census blocks are served.

County Census Block s per County

Bristol 0

Kent 1

Newport 0

Providence 2

Washington 0

Greatest down/upload speed from Historical 1 speed tests: 7, 5
Greatest down/upload speed from RIEDC 2 speed tests: 7,4
Greatest down/upload speed from FCC 3 speed tests: No speed tests were taken
Greatest down/upload speed from FCC Mobile Applications 4 speed tests: No speed tests were taken
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Count of Historical speed tests: 3
Count of RIEDC 2 speed tests: 1
Count of FCC 3 speed tests: 0
Count of FCC Mobile Applications 4 speed tests: 0

RIEDC and FCC speed tests outside of reported service area: 0

%/# of census blocks verified by RIEDC and FCC speed tests:

Confirmation of census block served 1

Census blocks served, not reported by provider 0

Total number of served census blocks reported by provider 3

% of served census blocks confirmed by speed test 30%

Footnotes:
1 Historical Date Range: 3/23/2009 to 3/22/2010
2 RIEDC Date Range: 3/23/2010 to 3/14/2011
3 FCC Date Range: 3/11/2010 to 12/29/2010
4 FCC Mobile Application Date Range: 3/11/2010 to 12/29/2010
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Provider Name: Full Channel TV, Inc.
DBA: Full Channel

Data Characteristics
FRN: 0004973731
Type of Data Submitted: Census Blocks
Census Block Count (unique): 943
Provided Technology of Transmission: YES
Provided Max Advertised Download Speed: YES
Provided Max Advertised Upload Speed: YES
Provided Typical Download Speed: YES
Provided Typical Upload Speed: YES
Provided Middle Mile: YES
Provided Last Mile: NO
Provided Road Segments for census blocks greater than 2 sq miles: NO
Provided Address Points for census block greater than 2 sq miles: NO

Maximum advertised down/upload speeds reported by provider:

Max Download Category Max Upload Category Count

6 4 943

Typical down/upload speeds reported by provider: 6, 4

Number of technology of transmission types reported by provider: 1

Count of Middle Mile Facilities: 1

Data Verification:

Counties served by provider and number of census blocks with service. A total of 943 census blocks are
served.

County Census Blocks per County

Bristol 943

Kent 0

Newport 0

Providence 0

Washington 0

Greatest down/upload speed from Historical 1 speed tests: 10, 3 and 9, 9
Greatest down/upload speed from RIEDC 2010 2 speed tests: 6, 4
Greatest down/upload speed from FCC 2010 3 speed tests: 6, 4
Greatest down/upload speed from FCC 2010 4 Mobile Applications speed tests: 5, 4
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Count of Historical speed tests: 1,819
Count of RIEDC 2 speed tests: 7
Count of FCC 3 speed tests: 9
Count of FCC Mobile Applications 4 speed tests: 9

RIEDC and FCC speed tests outside of reported service area: 0

%/# of census blocks verified by RIEDC and FCC speed tests:

Confirmation of census block served 15

Census blocks served, not reported by provider 0

Total number of served census blocks reported by provider 943

% of served census blocks confirmed by speed test <1%

Footnotes:
1 Historical Date Range: 3/23/2009 to 3/22/2010
2 RIEDC Date Range: 3/23/2010 to 3/14/2011
3 FCC Date Range: 3/11/2010 to 12/29/2010
4 FCC Mobile Application Date Range: 3/11/2010 to 12/29/2010
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Provider Name: Hughes Network Systems, LLC
DBA: Hughes

Data Characteristics
FRN: 0009559881
Type of Data Submitted: Satellite
Census Block Count (unique): 20,983
Provided Technology of Transmission: YES
Provided Max Advertised Download Speed: YES
Provided Max Advertised Upload Speed: YES
Provided Typical Download Speed: YES
Provided Typical Upload Speed: YES

Maximum advertised down/upload speeds reported by provider:

Max Download Category Max Upload Category

5 2

Typical down/upload speeds reported by provider: 5, 1

Number of technology of transmission types reported by provider: 1

Data Verification:

Counties served by provider and number of census blocks with service. A total of 0,983census blocks are
served.

County Census Blocks per County

Bristol 945

Kent 3,834

Newport 1,890

Providence 11,243

Washington 3,071

Greatest down/upload speed from Historical 1 speed tests: No speed tests were taken
Greatest down/upload speed from RIEDC 2 speed tests: No speed tests were taken
Greatest down/upload speed from FCC 3 speed tests: No speed tests were taken
Greatest down/upload speed from FCC Mobile Application 4 speed tests: 3, 2

Count of Historical speed tests: 0
Count of RIEDC 2 speed tests: 0
Count of FCC 3 speed tests: 0
Count of FCC Mobile Applications 4 speed tests: 2

RIEDC and FCC speed tests outside of reported service area: 0
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%/# of census blocks verified by RIEDC and FCC speed tests:

Confirmation of census block served 2

Census blocks served, not reported by provider 0

Total number of served census blocks reported by provider 23,198

% of served census blocks confirmed by speed test <1%

Footnotes:
5 Historical Date Range: 3/23/2009 to 3/22/2010
6 RIEDC Date Range: 3/23/2010 to 3/14/2011
7 FCC Date Range: 3/11/2010 to 12/29/2010
8 FCC Mobile Application Date Range: 3/11/2010 to 12/29/2010
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Provider Name: Level 3 Communications, LLC
DBA: Broadwing

Data Characteristics
FRN: 0003723822
Type of Data Submitted: Census Blocks
Census Block Count (unique): 2
Provided Technology of Transmission: YES
Provided Max Advertised Download Speed: YES
Provided Max Advertised Upload Speed: YES
Provided Typical Download Speed: YES
Provided Typical Upload Speed: YES
Provided Typical Download Speed: YES
Provided Middle Mile: YES
Provided Last Mile: NO
Provided Road Segments for census blocks greater than 2 sq miles: NO
Provided Address Points for census block greater than 2 sq miles: NO

Maximum advertised down/upload speeds reported by provider:

Max Download Category Count Max Upload Category Count

11 3 11 3

Typical down/upload speeds reported by provider: 11, 11

Number of technology of transmission types reported by provider: 1

Count of Middle Mile Facilities: 8

Data Verification:

Counties served by provider and number of census blocks with service. A total of 2 census blocks are served.

County Census Block s per County

Bristol 0

Kent 0

Newport 0

Providence 2

Washington 0

Greatest down/upload speed from Historical 1 speed tests: 4, 4
Greatest down/upload speed from RIEDC 2 speed tests: 4, 4
Greatest down/upload speed from FCC 3 speed tests: 7,5
Greatest down/upload speed from FCC Mobile Applications 4 speed tests: No speed tests were taken
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Count of Historical speed tests: 30
Count of RIEDC 2 speed tests: 4
Count of FCC 3 speed tests: 1
Count of FCC Mobile Applications 4 speed tests: 0

RIEDC and FCC speed tests outside of reported service area:
5 of 5 speed tests were recorded outside the coverage area reported by provider

Middle mile facilities outside of reported service area: None of the 8 facilities reported are located within the
reported service areas. The closest is within 995 ft, the furthest is 30 miles.

%/# of census blocks verified by RIEDC and FCC speed tests:

Footnotes:
1 Historical Date Range: 3/23/2009 to 3/22/2010
2 RIEDC Date Range: 3/23/2010 to 3/14/2011
3 FCC Date Range: 3/11/2010 to 12/29/2010
4 FCC Mobile App Date Range: 3/11/2010 to 12/29/2010

Confirmation of census blocks served 0

Census blocks served, not reported by provider 4

Total number of served census blocks reported by provider 3

% of served census blocks confirmed by speed test 0%
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Provider Name: Light Tower Fiber, LLC
DBA: Light Tower Fiber Networks

Data Characteristics
FRN: 00017625567
Type of Data Submitted: Census Blocks
Census Block Count (unique): 74
Provided Technology of Transmission: YES
Provided Max Advertised Download Speed: YES
Provided Max Advertised Upload Speed: YES
Provided Typical Download Speed: YES
Provided Typical Upload Speed: YES
Provided Middle Mile: NO
Provided Last Mile: NO
Provided Road Segments for census blocks greater than 2 sq miles: NO
Provided Address Points for census block greater than 2 sq miles: NO

Maximum advertised down/upload speeds reported by provider:

Max Download Category Max Upload Category Count

11 11 74

Typical down/upload speeds reported by provider: 11, 11

Number of technology of transmission types reported by provider: 1

Count of Middle Mile Facilities: 0

Data Verification:

Counties served by provider and number of census blocks with service. A total of 74 census blocks are served.

County Census Blocks per County

Bristol 0

Kent 3

Newport 0

Providence 71

Washington 0

Greatest down/upload speed from Historical 1 speed tests: No speed tests were taken
Greatest down/upload speed from RIEDC 2 speed tests: No speed tests were taken
Greatest down/upload speed from FCC 3 speed tests: No speed tests were taken
Greatest down/upload speed from FCC Mobile Applications 4 speed tests: No speed tests were taken
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Count of Historical speed tests: 0
Count of RIEDC 2 speed tests: 0
Count of FCC 3 speed tests: 0
Count of FCC Mobile Application 4 speed tests: 0

RIEDC and FCC speed tests outside of reported service area: No speed tests were taken

%/# of census blocks verified by RIEDC and FCC speed tests:

Confirmation of census block served 0

Census blocks served, not reported by provider 0

Total number of served census blocks reported by provider 74

% of served census blocks confirmed by speed test 0%

Footnotes:
1 Historical Date Range: 3/23/2009 to 3/22/2010
2 RIEDC Date Range: 3/23/2010 to 3/14/2011
3 FCC Date Range: 3/11/2010 to 12/29/2010
4 FCC Mobile App Date Range: 3/11/2010 to 12/29/2010
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Provider Name: MegaPath, Inc.
DBA: MegaPath

Note: Information in this report includes numbers reported by MegaPath (FRN# 0018105601), DSL.net (FRN#
0015321136), and DSLnet Communications (FRN# 0004324851) as they are all owned by MegaPath, Inc.

Data Characteristics
FRN: 0018105601
Type of Data Submitted: Census Blocks
Census Block Count: 20
Provided Technology of Transmission: YES
Provided Max Advertised Download Speed: YES
Provided Max Advertised Upload Speed: YES
Provided Typical Download Speed: NO
Provided Typical Upload Speed: NO
Provided Middle Mile: NO
Provided Last Mile: NO
Provided Road Segments for census blocks greater than 2 sq miles: NO
Provided Address Points for census block greater than 2 sq miles: NO

Maximum advertised down/upload speeds reported by provider:

Technology Max Download Category Max Upload Category Count

10 4 3 1

20 4 4 4

30 4 4 2

40 5 2 3

Typical down/upload speeds reported by provider: Typical speeds were not reported by MegaPath

Number of technology of transmission types reported by provider: 4

Count of Middle Mile Facilities: 0

Data Verification:

Counties served by provider and number of census blocks with service. A total of 20 census blocks are served:

County Census Block per County

Bristol 0

Kent 1

Newport 3

Providence 16

Washington 0
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Greatest down/upload speed from Historical 1 speed test: No speed tests were taken
Greatest down/upload speed from RIEDC 2 speed test: No speed tests were taken
Greatest down/upload speed from FCC 3 speed test: No speed tests were taken
Greatest down/upload speed from FCC Mobile Applications 4 speed test: 4,4

Count of Historical speed tests: 0
Count of RIEDC 2 speed tests: 0
Count of FCC 3 speed tests: 0
Count of FCC Mobile Applications 4 speed test: 8

RIEDC and FCC speed tests outside of reported service area: 8 of 8 speed tests were reported outside the
coverage area reported by provider.

%/# of census blocks verified by RIEDC and FCC speed tests:

Confirmation of census block served 0

Census blocks served, not reported by provider 6

Total number of served census blocks reported by provider 20

% of served census blocks confirmed by speed test 0%

Footnotes:
1 Historical Date Range: 3/23/2009 to 3/22/2010
2 RIEDC Date Range: 3/23/2010 to 3/14/2011
3 FCC Date Range: 3/11/2010 to 12/29/2010
4 FCC Mobile Application Date Range: 3/11/2010 to 12/29/2010
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Provider Name: One Communications Corp.
DBA: One Communications

Data Characteristics
FRN: 0015337702
Type of Data Submitted: Census Blocks, Address Points
Census Block Count (unique): 515
Service Address Points (unique): 941
Provided Technology of Transmission: YES
Provided Max Advertised Download Speed: YES
Provided Max Advertised Upload Speed: YES
Provided Typical Download Speed: NO
Provided Typical Upload Speed: NO
Provided Middle Mile: YES
Provided Last Mile: NO
Provided Road Segments for census blocks greater than 2 sq miles: NO
Provided Address Points for census blocks greater than 2 sq miles: YES

Maximum advertised down/upload speeds reported by provider:

Technology Max Download Category Max Upload Category Count

0 5 4 1

0 4 6 2

10 8 8 1

20 8 3 2

20 3 8 1

Typical down/upload speeds reported by provider: Not provided for any of the transmission types

Number of technology of transmission types reported by provider: 3

Total count of Middle Mile facilities: 17

Data Verification:

Counties served by provider and number of census blocks with service. A total of 515 census blocks are
served.

County Census Block per County

Bristol 16

Kent 41

Newport 30

Providence 397

Washington 31
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Greatest down/upload speed from Historical 1 speed tests: 5, 5
Greatest down/upload speed from RIEDC 2 speed tests: 8, 8
Greatest down/upload speed from FCC 3 speed tests: 3, 2
Greatest down/upload speed from FCC Mobile Applications 4 speed tests: 3, 2

Count of Historical speed tests: 889
Count of RIEDC 2 speed tests: 38
Count of FCC 3 speed tests: 3
Count of FCC Mobile Application 4 speed tests: 3

Speed tests outside of reported service area: 4 of 44 speed tests were reported outside the coverage area
reported by the provider.

Middle mile facilities outside of reported service area: All facilities are in the general area of served areas.

%/# of census blocks verified by RIEDC and FCC speed tests:

Confirmation of census block served 24

Census blocks served, not reported by provider 4

Total number of served census blocks reported by provider 515

% of served census blocks confirmed by speed test <1%

Footnotes:
1 Historical Date Range: 3/23/2009 to 3/22/2010
2 RIEDC Date Range: 3/23/2010 to 3/14/2011
3 FCC Date Range: 3/11/2010 to 12/29/2010
4 FCC Mobile Application Date Range: 3/11/2010 to 12/29/2010
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Provider Name: Sprint Nextel Corporation
DBA: Sprint

Data Characteristics
FRN: 0003774593
Type of Data Submitted: Wireless
Census Block Count (unique): 20,115
Provided Technology of Transmission: YES
Provided Spectrum Used: YES
Provided Max Advertised Download Speed: YES
Provided Max Advertised Upload Speed: YES
Provided Typical Download Speed: YES
Provided Typical Upload Speed: YES
Provided Middle Mile: NO
Provided Last Mile: NO

Maximum advertised down/upload speeds reported by provider:

Max Download Category Max Upload Category

3 2

Typical down/upload speeds reported by provider: 5, 3

Number of technology of transmission types reported by provider: 1, with 2 spectrums

Data Verification:

Counties served by provider and number of census blocks with service. A total of 20,115 census blocks are
served.

County Census Blocks per County

Bristol 949

Kent 3,695

Newport 1,792

Providence 10,915

Washington 2,764

Greatest down/upload speed from Historical 1 speed tests: 6, 3
Greatest down/upload speed from RIEDC 2 speed tests: 5, 3
Greatest down/upload speed from FCC 3 speed tests: 7, 6
Greatest down/upload speed from FCC Mobile Applications 4 speed tests: 5, 3

Count of Historical speed tests: 10
Count of RIEDC 2 speed tests: 19
Count of FCC 3 speed tests: 5
Count of FCC Mobile Applications 4 speed tests: 146
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RIEDC and FCC speed tests outside of reported service area: 0

%/# of census blocks verified by RIEDC and FCC speed tests:

Confirmation of census blocks served 44

Census blocks served, not reported by provider 0

Total number of served census blocks reported by provider 20,115

% of served census blocks confirmed by speed test <1%

Footnotes:
1 Historical Date Range: 3/23/2009 to 3/22/2010
2 RIEDC Date Range: 3/23/2010 to 3/14/2011
3 FCC Date Range: 3/11/2010 to 12/29/2010
4 FCC Mobile Application Date Range: 3/11/2010 to 12/29/2010
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Provider Name: T-Mobile USA, Inc.
DBA: T-Mobile

Data Characteristics
FRN: 0006945950
Type of Data Submitted: Wireless
Census Block Count (unique): 19,679
Provided Technology of Transmission: YES
Provided Spectrum Used: YES
Provided Max Advertised Download Speed: YES
Provided Max Advertised Upload Speed: YES
Provided Typical Download Speed: NO
Provided Typical Upload Speed: NO
Provided Middle Mile: YES
Provided Last Mile: NO

Maximum advertised down/upload speeds reported by provider:

Technology Max Download Category Max Upload Category

80 6 4

Typical down/upload speeds reported by provider: Not provided

Number of technology of transmission types reported by provider: 1, with 1 spectrum

Total count of Middle Mile facilities: 2

Data Verification:

Counties served by provider and number of census blocks with service. A total of 19,679 census blocks are
served.

County Census Blocks per County

Bristol 943

Kent 3,630

Newport 1,800

Providence 10749

Washington 2,557

Greatest down/upload speed from Historical 1 speed tests: No speed tests were taken
Greatest down/upload speed from RIEDC 2 speed tests: No speed tests were taken
Greatest down/upload speed from FCC 3 speed tests: No speed tests were taken
Greatest down/upload speed from FCC Mobile Applications 4 speed tests: 4, 3

Count of Historical speed tests: 0
Count of RIEDC 2010 2 speed tests: 0
Count of FCC 2010 3 speed tests: 0
Count of FCC 2010 Mobile Applications 4 speed tests: 25
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RIEDC and FCC speed tests outside of reported service area: 0.

Middle mile facilities outside of reported service area: The two facilities are within the reported service area,
though are located within 280 ft of each other.

%/# of census blocks verified by RIEDC and FCC speed tests:

Confirmation of census blocks served 17

Census blocks served, not reported by provider 0

Total number of served census blocks reported by provider 19,679

% of served census blocks confirmed by speed test <1%

Footnotes:
1 Historical Date Range: 3/23/2009 to 3/22/2010
2 RIEDC Date Range: 3/23/2010 to 3/14/2011
3 FCC Date Range: 3/11/2010 to 12/29/2010
4 FCC Mobile Application Date Range: 3/11/2010 to 12/29/2010
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Provider Name: Verizon New England Inc.
DBA: Verizon

Data Characteristics
FRN: 0003628971
Type of Data Submitted: Census Blocks, Road Segments
Census Block Count (unique): 17,846
Road Segment Count (unique): 906
Provided Technology of Transmission: YES
Provided Max Advertised Download Speed: NO
Provided Max Advertised Upload Speed: NO
Provided Typical Download Speed: NO
Provided Typical Upload Speed: NO
Provided Middle Mile: NO
Provided Last Mile: NO
Provided Road Segments for census blocks greater than 2 sq miles: YES
Provided Address Points for census blocks greater than 2 sq miles: NO

Maximum advertised down/upload speeds reported by provider:

Technology Max Download Category Max Upload Category Count

10 NULL NULL 14,809

50 NULL NULL 13,609

Typical down/upload speeds reported by provider: Not provided

Number of technology of transmission types reported by provider: 2

Count of middle mile facilities: 0

Data Verification:

Counties served by provider and number of census blocks with service (inc. 32 census blocks for road segment
service data). A total of 17,846 census blocks are served.

County Census Blocks per County

Bristol 826

Kent 3,368

Newport 1,460

Providence 9,877

Washington 2,315

Greatest down/upload speed from Historical 1 speed tests: 10, 7 and 9, 8
Greatest down/upload speed from RIEDC 2010 2 speed tests: 9, 6 and 8, 8
Greatest down/upload speed from FCC 2010 3 speed tests: 9, 4
Greatest down/upload speed from FCC 2010 4 Mobile Application speed tests: 7, 7
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Count of Historical speed tests: 44,322
Count of RIEDC 2 speed tests: 730
Count of FCC 3 speed tests: 327
Count of FCC Mobile Application 4 speed tests: 578

RIEDC and FCC speed tests outside of reported service area: 0

%/# of census blocks verified by RIEDC and FCC speed tests:

Confirmation of census block served 635

Census blocks served, not reported by provider 0

Total number of served census blocks reported by provider 17,846

% of served census blocks confirmed by speed test 4%

Footnotes:
1 Historical Date Range: 3/23/2009 to 3/22/2010
2 RIEDC Date Range: 3/23/2010 to 3/14/2011
3 FCC Date Range: 3/11/2010 to 12/29/2010
4 FCC Mobile Application Date Range: 3/11/2010 to 12/29/2010
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Provider Name: Wild Blue Communications, Inc.
DBA: Wild Blue Communications, Inc.

Data Characteristics
FRN: 0007843766
Type of Data Submitted: Satellite
Census Block Count (unique): 20,992
Provided Technology of Transmission: YES
Provided Spectrum Used: YES
Provided Max Advertised Download Speed: YES
Provided Max Advertised Upload Speed: YES
Provided Typical Download Speed: NO
Provided Typical Upload Speed: NO

Maximum advertised down/upload speeds reported by provider:

Max Download Category Max Upload Category

4 2

Typical down/upload speeds reported by provider: Not provided

Number of technology of transmission types reported by provider: 1, and 1 spectrum

Data Verification:

Counties served by provider and number of census blocks with service. A total of 20,992 census blocks are
served.

County Census Blocks per County

Bristol 948

Kent 3,834

Newport 1,898

Providence 11,237

Washington 3,075

Greatest down/upload speed from Historical 1 speed tests: 4, 1
Greatest down/upload speed from RIEDC 2 speed tests: No speed tests were taken
Greatest down/upload speed from FCC 3 speed tests: No speed tests were taken
Greatest down/upload speed from FCC Mobile Application 4 speed tests: No speed tests were taken

Count of Historical speed tests: 0
Count of RIEDC 2 speed tests: 0
Count of FCC 3 speed tests: 0
Count of FCC Mobile Application 4 speed tests: 0

RIEDC and FCC speed tests outside of reported service area: 0
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%/# of census blocks verified by RIEDC and FCC speed tests:

Confirmation of census block served 0

Census blocks served, not reported by provider 0

Total number of served census blocks reported by provider 20,992

% of served census blocks confirmed by speed test 0%

Footnotes:
5 Historical Date Range: 3/23/2009 to 3/22/2010
6 RIEDC Date Range: 3/23/2010 to 3/14/2011
7 FCC Date Range: 3/11/2010 to 12/29/2010
8 FCC Mobile Application Date Range: 3/11/2010 to 12/29/2010
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Community Anchor Institutions: All categories

Data Characteristics
Type of Data Submitted: Point
Feature Count: 1,115
Provided Technology of Transmission: YES, INCOMPLETE (640 of 1,115)
Provided Advertised Downstream Speed: YES, INCOMPLETE (643 of 1,115)
Provided Advertised Upstream Speed: YES, INCOMPLETE (1,085of 1,115)
Provided Street Address: YES, COMPLETE
Provide Public Wifi: YES, COMPLETE
Provided URL: NO
Provided CAIID: YES, INCOMPLETE (759 of 1,115)

Count of Community Anchor Institutions by category:

Maximum advertised down/upstream speeds reported by institutions:

CAI Category Max Downstream Category Count Max Upstream Category Count

1 11 1 6 1

2 9 1 9 1

3 10 4 10 4

4 11 1 11 1

5 10 1 10 1

6 7 5 4 5

7 5 1 <Null> 1

Number of technology of transmission types reported by provider: 8

Data Verification:
Greatest down/upload speed from Historical speed test: 10, 10
Greatest down/upload speed from RIEDC 1 speed test: 5, 5
Greatest down/upload speed from FCC 2 speed test: 8, 8
Greatest down/upload speed from FCC Mobile Applications 3 speed tests: 7, 5

Count of RIEDC speed tests: 294
Count of FCC speed tests: 51
Count of FCC Mobile Applications speed tests: 69

CAI Category Count of Features

1 – School K through Grade 12 654

2 - Library 92

3 – Medical/healthcare 55

4 – Public safety 242

5 – Univ., college, other post-secondary 24

6 – Other govt support - govt 44

7 – Other govt support - nongovt 4
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Footnotes:
1 RIEDC Date Range: 3/23/2010 to 3/14/2011

2 FCC Date Range: 3/11/2010 to 12/29/2010

3 FCC Mobile Application Date Range: 3/11/2010 to 12/29/2010
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Section C: Data Processes and Submission Overview

Submission Summary
The Broadband Rhode Island Mapping Team
Technology, Inc. (EA) in its role as primary technical lead for the
Mapping project, contacted 39
data from 17 providers. An overall summary of the data submission

39 potential facilities-based broadband service providers were contacted
13 BSPs did not respond
5 BSPs responded but did not provide data
17 BSPs responded and provided data

Of those that provided data:

13 provided only census block information
2 provided census blocks and addresses
1 provided census blocks and road segments
6 provided wireless coverage areas

In addition, 7 of the 17 responsive BSPs provided middle mile infrastructure points

Rhode Island Broadband Mapping Data Processes
Data Received From Providers
offers service in the State of Rhode Island
broadband service providers with
RIEDC. Once all of the available data is received from a provider it is reviewed and archived in
its native format. While the same data is requested from each provider the information often
comes in different formats and with missing attribute data.
data set the provider is contacted to see if the missing information is available.

Data Evaluated & Processed –

through geocoding to the RI E911 data or by
(2010 census block data will be used starting with the fall 2011 data submittal). The
data is then formatted so that the database can easily be entered in the RI
geodatabase. Speeds reported below broadband levels are removed from the data set and
archived. Data that is located
the address or street segment feature classes. All remaining data is loaded into the census
block feature class. The data is loaded using E
geodatabase stores the most recent broadband information. D
geodatabase and formated as needed to be used for the State’s web map and for biannual NTIA
submittals. Data is pulled from the
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: Data Processes and Submission Overview

Rhode Island Mapping Team (BBRI) Team, led by EA Engineering, Science &
in its role as primary technical lead for the Rhode Island

39 facilities-based broadband service providers
providers. An overall summary of the data submission is described

based broadband service providers were contacted

BSPs responded but did not provide data
BSPs responded and provided data

provided only census block information
provided census blocks and addresses
provided census blocks and road segments
provided wireless coverage areas

responsive BSPs provided middle mile infrastructure points

Rhode Island Broadband Mapping Data Processes
Data Received From Providers – The process begins by receiving data from each provider that

Rhode Island (RI). Broadband data is currently
broadband service providers within the State who have signed Non-Disclosure Agreements with

Once all of the available data is received from a provider it is reviewed and archived in
While the same data is requested from each provider the information often

nt formats and with missing attribute data. If attributes are missing
is contacted to see if the missing information is available.

– The EA project team first gives the data spatial attributes
through geocoding to the RI E911 data or by joining the data to the 2000 census block data.
(2010 census block data will be used starting with the fall 2011 data submittal). The

is then formatted so that the database can easily be entered in the RI
Speeds reported below broadband levels are removed from the data set and

located in census blocks great than 2 square miles is
the address or street segment feature classes. All remaining data is loaded into the census

The data is loaded using ESRI tools and software. The
geodatabase stores the most recent broadband information. Data is extracted from the

as needed to be used for the State’s web map and for biannual NTIA
submittals. Data is pulled from the analysis database, formatted to meet the web and NTIA
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Engineering, Science &
Rhode Island Broadband

based broadband service providers (BSPs) and received
described below:

responsive BSPs provided middle mile infrastructure points

The process begins by receiving data from each provider that
currently received from 17

Disclosure Agreements with
Once all of the available data is received from a provider it is reviewed and archived in

While the same data is requested from each provider the information often
If attributes are missing from the

is contacted to see if the missing information is available.

gives the data spatial attributes
the data to the 2000 census block data.

(2010 census block data will be used starting with the fall 2011 data submittal). The attribute
is then formatted so that the database can easily be entered in the RI Broadband

Speeds reported below broadband levels are removed from the data set and
s loaded into either

the address or street segment feature classes. All remaining data is loaded into the census
The data analysis

ata is extracted from the
as needed to be used for the State’s web map and for biannual NTIA

formatted to meet the web and NTIA
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formatting requirements, and loaded into
mapping database using automate

 Community Anchor Institute
and populated into the
using 3rd party datasets in order to create the most comprehensive
RI. In order to collect the broadband data for the CAIs
down approach. The agencies that oversaw a large number of CAIs such as RINET and
OSHEAN were contacted regarding the data collection. CAIs that still had missing
attribute data after contacting the
email. Once contacted, the CAIs
walked the user through a
broadband data. At the end of the survey the user was directed to take a s
order to help with the data collection and verification process.

Data Verification – Once the data is loaded into the geodatabase
begin. This process is comprised of several steps to ensure that the actual fa
provided to the public match the provider’s

 Compared to Available Datasets

o Speed test – Using Ookla’s speed test application,
test data for the state of RI since March 2010. A breakdown of speed test
collected by EA broken out by
both the FCC speed test collected for RI and the speed test collected on the RI
broadband website to get a better v
providers are offering the public. The speed tests are geocoded and mapped by
provider. (FCC speed test providers are identified by the
Each provider’s speed test data is compared to
Discrepancies are
gives a reason for the discrepancy or instructs us to modify their coverage area
to match the speed test
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, and loaded into either the NTIA transfer database or the web
using automated FME tools.

Community Anchor Institute (CAI) Data: The initial list of CAIs were
and populated into the BBRI database. This data was then compared to

sets in order to create the most comprehensive
. In order to collect the broadband data for the CAIs, the BBRI Team utilized a top

down approach. The agencies that oversaw a large number of CAIs such as RINET and
OSHEAN were contacted regarding the data collection. CAIs that still had missing

after contacting these agencies were contact directly
. Once contacted, the CAIs were directed to an online survey. The online survey

walked the user through a short questionnaire that collected the required CAI
broadband data. At the end of the survey the user was directed to take a s
order to help with the data collection and verification process.

Once the data is loaded into the geodatabase the verification process can
his process is comprised of several steps to ensure that the actual fa
to the public match the provider’s data being reported.

Compared to Available Datasets -

Using Ookla’s speed test application, EA has been collecting speed
the state of RI since March 2010. A breakdown of speed test

collected by EA broken out by month can be found in the table below.
both the FCC speed test collected for RI and the speed test collected on the RI
broadband website to get a better view of the actual speeds and coverage area
providers are offering the public. The speed tests are geocoded and mapped by

(FCC speed test providers are identified by the speed
s speed test data is compared to their stated cov

Discrepancies are noted and reported back to the provider. The provider either
gives a reason for the discrepancy or instructs us to modify their coverage area

speed test data.
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either the NTIA transfer database or the web

ere received from URI
. This data was then compared to and updated

sets in order to create the most comprehensive CAI list available for
Team utilized a top

down approach. The agencies that oversaw a large number of CAIs such as RINET and
OSHEAN were contacted regarding the data collection. CAIs that still had missing

directly via phone and
directed to an online survey. The online survey

short questionnaire that collected the required CAI
broadband data. At the end of the survey the user was directed to take a speed test in

the verification process can
his process is comprised of several steps to ensure that the actual facilities and services

been collecting speed
the state of RI since March 2010. A breakdown of speed test

month can be found in the table below. EA uses
both the FCC speed test collected for RI and the speed test collected on the RI

iew of the actual speeds and coverage area
providers are offering the public. The speed tests are geocoded and mapped by

speed test’s IP address)
their stated coverage area.

noted and reported back to the provider. The provider either
gives a reason for the discrepancy or instructs us to modify their coverage area
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o User feedback
broadband mapping website.
basis. Changes
similar to the speed test data update proces

o Best practices for final data quality checks include the review and comparison
3rd party datasets
from the providers.
providers, perform spatial analysis and comparisons on the data, and to give a
better understanding of our confidence in the data. Since FCC data
out by census trac
order to perform a full data comparison.

 Spatial Analysis of Coverage Area
set. The analysis checks for small areas in populated
surrounded by coverage
data are reviewed and reported to the provider if we feel they have a high probability of
actually being covered by the providers’ broadband service

 3rd Party Verification –
independent review and provide a report on the status of each
reports summarize the data collected and provide a second review of the verification
steps listed above.

Data Analysis – In addition to the data verification steps
provider’s data and static broadband coverage maps are created for
used to analyze existing data availability and plan for future broadband development and
outreach projects.
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feedback - user feedback information is captured by both the
broadband mapping website. This information is reviewed on a case by case
basis. Changes are made as needed to the data and reported to the provider,
similar to the speed test data update process.

Best practices for final data quality checks include the review and comparison
3rd party datasets (such as the FCC’s 477 data) with the information
from the providers. The FCC’s data is used to check for previously unknown

form spatial analysis and comparisons on the data, and to give a
better understanding of our confidence in the data. Since FCC data
out by census tract the provider’s data must be converted to the trac
order to perform a full data comparison.

Spatial Analysis of Coverage Area– Spatial Analysis is performed on each provider’s data
set. The analysis checks for small areas in populated sections of the state
surrounded by coverage areas but do not show coverage. These “d
data are reviewed and reported to the provider if we feel they have a high probability of

being covered by the providers’ broadband services.

– A 3rd party Mapping & Planning Services (M
independent review and provide a report on the status of each provider’s
reports summarize the data collected and provide a second review of the verification

In addition to the data verification steps, a complete summary of each
provider’s data and static broadband coverage maps are created for RIEDC

ting data availability and plan for future broadband development and
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both the FCC and RI’s
This information is reviewed on a case by case

reported to the provider,

Best practices for final data quality checks include the review and comparison to
information received

The FCC’s data is used to check for previously unknown
form spatial analysis and comparisons on the data, and to give a

better understanding of our confidence in the data. Since FCC data is broken
data must be converted to the tract level in

Spatial Analysis is performed on each provider’s data
sections of the state that are

donut holes” in the
data are reviewed and reported to the provider if we feel they have a high probability of

(M&PS) is used to do an
provider’s data. These

reports summarize the data collected and provide a second review of the verification

a complete summary of each
RIEDC. These maps are

ting data availability and plan for future broadband development and
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Future Verification Processes To Be Implemented
utilized for our Spring 2011 submission:

 Street Survey - As part of the expanding need to verify broadband coverage within
street survey pilot project
physical survey will verify the validity of broadband physical facilities
within these towns. EA will perform the survey via field discernment a
collection utilizing GPS equipment and industry knowledge.
within rights of way will be
provider and location can be determined without any digging or use
underground location equipment. This pilot project will be completed
2011. The additional services (deliverables) to be added for Wireline Coverage
Verification Survey are as follows:

a) A dataset delivered consisting of ac
plant, i.e. poles, nodes, hubs, etc. and carrier presence by service type (DSL,
Coaxial Cable, Fiber, etc.)

b) Data analysis to consist of test procured data results vs. provider data
submitted displayed in
within RI geodatabase

Geodatabase Checks– Once the data is
submittal to the NTIA. This process is comprised of several steps to ensure that the
in the geodatabase is as accurate and complete and possible.

 Visual Checks - These visual checks inspect the data to ensure completeness, accuracy,
and engineering logic. The visual inspection process employs random sampling
techniques to validate feature placement and attribution. The random sampling is
performed in accordance with ANSI standards for attribute inspection.

 Automated Checks – These checks are performed on 100% of the data. ESRI’s
Production Line Tool Set (PLTS)
automated check of the data. PLTS check for both schema and logical errors in the
data. The following checks

o Geodatabase Format. Verify that the geodatabase name and feature classes ar
correct per the corresponding RIEDC data model and NOFA requirements.

o Coordinate System Errors. Check for proper projection definition.
o Validity Checks. Verify the attribution fields in the tables and field values fall

within the domain specified in t
o Duplicate Item Values. Verify the uniqueness of attribute values within a user

specified item (such as Feature IDs).
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Future Verification Processes To Be Implemented – The following verification processes
utilized for our Spring 2011 submission:

As part of the expanding need to verify broadband coverage within
street survey pilot project will be performed within a limited set of selected
physical survey will verify the validity of broadband physical facilities

owns. EA will perform the survey via field discernment a
collection utilizing GPS equipment and industry knowledge. Only above ground facilities

will be captured. Buried facility data will only be collected if a
provider and location can be determined without any digging or use
underground location equipment. This pilot project will be completed

The additional services (deliverables) to be added for Wireline Coverage
Verification Survey are as follows:

ataset delivered consisting of actual location (X-Y coordinates) of physical
plant, i.e. poles, nodes, hubs, etc. and carrier presence by service type (DSL,
Coaxial Cable, Fiber, etc.)
Data analysis to consist of test procured data results vs. provider data

displayed in comparative reports, maps, and a
within RI geodatabase.

Once the data is processed and verified the database is checked prior to
This process is comprised of several steps to ensure that the

in the geodatabase is as accurate and complete and possible.

These visual checks inspect the data to ensure completeness, accuracy,
and engineering logic. The visual inspection process employs random sampling

validate feature placement and attribution. The random sampling is
performed in accordance with ANSI standards for attribute inspection.

These checks are performed on 100% of the data. ESRI’s
Production Line Tool Set (PLTS) and the NTIA’s QC toolbox are utilized
automated check of the data. PLTS check for both schema and logical errors in the

hecks are performed on the data.

Geodatabase Format. Verify that the geodatabase name and feature classes ar
correct per the corresponding RIEDC data model and NOFA requirements.
Coordinate System Errors. Check for proper projection definition.
Validity Checks. Verify the attribution fields in the tables and field values fall
within the domain specified in the geodatabase.
Duplicate Item Values. Verify the uniqueness of attribute values within a user
specified item (such as Feature IDs).
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The following verification processes were

As part of the expanding need to verify broadband coverage within RI, a
a limited set of selected towns. The

physical survey will verify the validity of broadband physical facilities coverage presence
owns. EA will perform the survey via field discernment and location

above ground facilities
Buried facility data will only be collected if a

provider and location can be determined without any digging or use of specialized
underground location equipment. This pilot project will be completed in the spring of

The additional services (deliverables) to be added for Wireline Coverage

Y coordinates) of physical
plant, i.e. poles, nodes, hubs, etc. and carrier presence by service type (DSL,

Data analysis to consist of test procured data results vs. provider data
, and a new data layer

processed and verified the database is checked prior to
This process is comprised of several steps to ensure that the information

These visual checks inspect the data to ensure completeness, accuracy,
and engineering logic. The visual inspection process employs random sampling

validate feature placement and attribution. The random sampling is
performed in accordance with ANSI standards for attribute inspection.

These checks are performed on 100% of the data. ESRI’s
utilized for the

automated check of the data. PLTS check for both schema and logical errors in the

Geodatabase Format. Verify that the geodatabase name and feature classes are
correct per the corresponding RIEDC data model and NOFA requirements.
Coordinate System Errors. Check for proper projection definition.
Validity Checks. Verify the attribution fields in the tables and field values fall

Duplicate Item Values. Verify the uniqueness of attribute values within a user-
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o Invalid Item Values. Check for invalid codes using discrete values and ranges
defined in the appropriate domain tables.

o Spatial Logic Checks. Checks the geodatabase to validate minimum size
polygons, minimum length lines, and dangles in line feature classes.

 If the geodatabase has passed all tests listed above, and has met the acceptance criteria,
the dataset is considere
NTIA. If the geodatabase fails any test and does not meet acceptance criteria, the data
is considered failed and will be returned with error reports to the data processing team
for correction. Additional follow
issue(s). Once edits are completed or exceptions are documented, the geodatabase will
be returned to the QC team for an additional sequence of all QC procedures. This
process will be repeated unti
been documented.
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Invalid Item Values. Check for invalid codes using discrete values and ranges
defined in the appropriate domain tables.
Spatial Logic Checks. Checks the geodatabase to validate minimum size
polygons, minimum length lines, and dangles in line feature classes.

If the geodatabase has passed all tests listed above, and has met the acceptance criteria,
the dataset is considered passed and can be processed for delivery to RIEDC

atabase fails any test and does not meet acceptance criteria, the data
and will be returned with error reports to the data processing team

dditional follow-up with the providers may be necessary to correct the
Once edits are completed or exceptions are documented, the geodatabase will

be returned to the QC team for an additional sequence of all QC procedures. This
repeated until all tests have received a pass status or exceptions have
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Invalid Item Values. Check for invalid codes using discrete values and ranges

Spatial Logic Checks. Checks the geodatabase to validate minimum size
polygons, minimum length lines, and dangles in line feature classes.

If the geodatabase has passed all tests listed above, and has met the acceptance criteria,
and can be processed for delivery to RIEDC and the

atabase fails any test and does not meet acceptance criteria, the data
and will be returned with error reports to the data processing team

up with the providers may be necessary to correct the
Once edits are completed or exceptions are documented, the geodatabase will

be returned to the QC team for an additional sequence of all QC procedures. This
or exceptions have
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Section D: Rhode Island’s Current Broadband Mapping Issues

This section lists the issues the
mitigation efforts against. These issues are being reviewed by the
with other States and the NTIA. Recommended solutions to each issue have been or will be
presented to the NTIA when they are available.

1. No last mile information was provided by any provi
The NTIA has recently stated that a provider is defined as a company
broadband service and owns the last mile of infrastructure
other providers that own middle mile
resellers of broadband. Since the state of RI has received no last mile information
should all broadband providers in RI be labeled as resellers or unknown?

2. Currently the NTIA requires data at the address or str
that are greater than 2 square miles in diameter.
work for all states. However, in the north east region and RI in particular, the
Team feels that the size standard for reporting at the address and street segment level
should be smaller due to the higher density levels of population. The
currently looking into a size standard that would better fit RI.

3. Wireline location data was provided by one or more providers for the state of RI. The
current data transfer model only allows for middle mile data to be transferred as point
geometry. Therefore,
data transfer model. Similarly,
metropolitan statistical area
Per the NTIA’s instructions, if no pric
should not be included
transfer model has no method of storing or transferring this information
NTIA want this information
adding new feature classes to the transfer model.

4. One or more providers have submitted coverage areas that were not consistent with
previous submittals. The
QA/QC processes and
Team’s comments the
updated and accurate

5. The NTIA’s National Broadband Map analyzes data based on population information
while the RI Broadband Map analyzes data based on geography.
both analysis processes
coverage become apparent. This issue has been identified by providers and the public.
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: Rhode Island’s Current Broadband Mapping Issues

the issues the BBRI Team has encountered and is currently
These issues are being reviewed by the BBRI Team in conjunction

with other States and the NTIA. Recommended solutions to each issue have been or will be
presented to the NTIA when they are available.

ile information was provided by any providers or resellers
The NTIA has recently stated that a provider is defined as a company
broadband service and owns the last mile of infrastructure from which it is provided
other providers that own middle mile, but not last mile infrastructure
resellers of broadband. Since the state of RI has received no last mile information
should all broadband providers in RI be labeled as resellers or unknown?

Currently the NTIA requires data at the address or street segment level for census blocks
that are greater than 2 square miles in diameter. This is a model that was developed to

. However, in the north east region and RI in particular, the
Team feels that the size standard for reporting at the address and street segment level
should be smaller due to the higher density levels of population. The
currently looking into a size standard that would better fit RI.

n data was provided by one or more providers for the state of RI. The
current data transfer model only allows for middle mile data to be transferred as point

, we have no way to transfer this data to the NTIA in the current
sfer model. Similarly, broadband data was provided at the county and

metropolitan statistical area levels but did not include providers pricing information.
Per the NTIA’s instructions, if no pricing information is included the

t be included in the Service Overview feature class. Therefor
transfer model has no method of storing or transferring this information
NTIA want this information, the BBRI Team can transfer it in ESRI shapefile format or by

ng new feature classes to the transfer model.

One or more providers have submitted coverage areas that were not consistent with
The BBRI Team was able to identify the error through

QA/QC processes and we reported it back to the providers. After reviewing the
Team’s comments the providers determined their errors and were

accurate coverage information.

The NTIA’s National Broadband Map analyzes data based on population information
he RI Broadband Map analyzes data based on geography. When the

processes are compared at the county or state level,
become apparent. This issue has been identified by providers and the public.
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currently developing
Team in conjunction

with other States and the NTIA. Recommended solutions to each issue have been or will be

or resellers for the state of RI.
The NTIA has recently stated that a provider is defined as a company that provides

from which it is provided. All
not last mile infrastructure, are actually

resellers of broadband. Since the state of RI has received no last mile information
should all broadband providers in RI be labeled as resellers or unknown?

eet segment level for census blocks
that was developed to

. However, in the north east region and RI in particular, the BBRI
Team feels that the size standard for reporting at the address and street segment level
should be smaller due to the higher density levels of population. The BBRI Team is

n data was provided by one or more providers for the state of RI. The
current data transfer model only allows for middle mile data to be transferred as point

we have no way to transfer this data to the NTIA in the current
broadband data was provided at the county and

levels but did not include providers pricing information.
s included then these datasets

in the Service Overview feature class. Therefore the current
transfer model has no method of storing or transferring this information. Should the

shapefile format or by

One or more providers have submitted coverage areas that were not consistent with
Team was able to identify the error through our existing

to the providers. After reviewing the BBRI
providers determined their errors and were able to submit

The NTIA’s National Broadband Map analyzes data based on population information
When the results of

differences in
become apparent. This issue has been identified by providers and the public.
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The BBRI Team is looking into ways of standardizing the two processes in order to create
more consistency.

6. Speed tests are currently being extensively utilized by the
good at showing that coverage is available in a given area,
reported vary widely from one test to the next
are taken at the same
results taken from this test
speeds. Additionally speed test information has not been provided by the NTIA or FCC
since January 7, 2011.

7. The NTIA continues to require data to be submitted in
data is now over 10 years old an
exist in RI. The BBRI Team is recommending that the NTIA switch to 2010 census data.

R h o d e I s l a n d B r o a d b a n d M a p p i n g P r o g r a m

55

Team is looking into ways of standardizing the two processes in order to create

currently being extensively utilized by the BBRI team
good at showing that coverage is available in a given area, but the actual s

vary widely from one test to the next. The speeds are inconsistent even
location within minutes of one another. Therefore the

results taken from this test cannot be used to verify or populate provider’s typical
speeds. Additionally speed test information has not been provided by the NTIA or FCC
since January 7, 2011.

The NTIA continues to require data to be submitted in 2000 census block format. This
data is now over 10 years old and doesn’t accurately display the current conditions

Team is recommending that the NTIA switch to 2010 census data.
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Team is looking into ways of standardizing the two processes in order to create

team. The tests are very
but the actual speeds

. The speeds are inconsistent even if they
another. Therefore the speed

ulate provider’s typical
speeds. Additionally speed test information has not been provided by the NTIA or FCC

2000 census block format. This
d doesn’t accurately display the current conditions that

Team is recommending that the NTIA switch to 2010 census data.
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SOUTH CAROLINA COVER LETTER 

 
April 1, 2011 
 
Ms. Anne W. Neville 
SBDD Grant Program Director 
National Telecommunications and Information Administration 
U.S. Department of Commerce 
1401 Constitution Avenue, NW Room 4716 
Washington, DC 20230 
 
Dear Ms. Neville: 
 
It is with highest regard that the collective stakeholders of Connect South Carolina offer 
congratulations to the U.S. Department of Commerce’s National Telecommunications & 
Information Administration (NTIA) on the recent release of the National Broadband Map.  This 
extraordinary milestone demonstrates the intense and joint effort of the NTIA, FCC, state 
governments, industry, and non-profits like Connected Nation and will serve as a key tool for the 
American public and policymakers resulting in smarter investments and targeted state and local 
broadband policies and programs.  We are proud of the role that Connect South Carolina has played 
in creating such a powerful tool that will surely benefit not just South Carolinians, but consumers 
and businesses nationwide. 
 
Therefore, Connected Nation as the State Broadband Designated Entity, in cooperation with South 
Carolina’s broadband provider community and state based partners, is pleased to present this 
submittal of the state of South Carolina’s State Broadband Data and Development (SBDD) Grant 
Program, known as Connect South Carolina.  

 
These artifacts should be found to be compliant with the April 1, 2011, deadline for the semi-annual 
data update and in accordance with the terms of the July 1, 2009, Notice of Funds Availability 
(NOFA) and all subsequent clarifications pertaining to delivery of State-Level Mapping of 
Broadband Service Availability.  This packet includes: 
 
Inventory of Deliverables, Connect South Carolina: April 1, 2011 
 
NOFA Requirement Data Transfer Model Data Description 
Appendix A:  1(a)(i) BB_Service_CensusBlock Broadband Service Availability of 

Facilities-Based Providers in 
Census Blocks of No Greater 
Than Two Square Miles in Area 

Appendix A:   1(a)(ii) BB_Service_RoadSegment Broadband Service Availability of 
Facilities-Based Providers by Road 
Segment in Census Blocks Larger 
in Area Than Two Square Miles 
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Appendix A:   1(b) BB_Service_Wireless Broadband Service Availability of 
Wireless Services Not Provided to 
a Specific Address 

Appendix A:   3(b) BB_ConnectionPoint_MiddleMile Broadband Service Infrastructure 
Middle-Mile and Backbone 
Interconnection Points 

Appendix A:   4 BB_Service_CAInstitutions  Community Anchor Institutions-
Listing 

Appendix A:   4 n/a Community Anchor Institutions-
Narratives 

VII.A.1(a) n/a Accuracy and Verification Report 
n/a DataPackage.xlsx Worksheets of Contact 

Information, Data Dictionary, and 
Provider Summary Table 

n/a n/a Broadband Provider Roster and 
Participation Status 

 
In addition, this data update submission should be found to be compliant with the additional 
program requirements instituted by the National Telecommunications and Information 
Administration since the time of the October 2010 SBDD data submission for the Connect South 
Carolina program.  Specifically, these new requirements are: 

 
SBDD Data Transfer Model 
The submission of the broadband dataset for April 1, 2011, is contained within the SBDD 
Data Transfer Model as released on the Grantee Workspace on January 14, 2011. All efforts 
have been made to comply with formatting, domain, and metadata requirements to include 
as much information on each provider as possible.  
 
Additional Submission Guidance 
This submission also includes the updated DataPackage spreadsheet with enhanced provider 
listings as well as satisfactory outputs from the SBDD_Check toolbox to ensure fewer 
unexpected values with the submitted broadband datasets prior to federal processing for the 
National Broadband Map update. 

 
It is therefore with great pleasure that the Connect South Carolina program submits this April 2011 
semi-annual data update under the State Broadband Data and Development Grant Program.  We 
will continue to implement the joint purposes of the Recovery Act and the Broadband Data 
Improvement Act (BDIA) by gathering comprehensive and accurate state-level broadband mapping 
data, developing state-level broadband maps, aiding in the development and maintenance of the  
National Broadband Map, and undertaking statewide initiatives for broadband planning. 
 
Broadband Service Availability — Provider Outreach and Verification 
 
This data update submission under the SBDD includes the participation of 84% of the South 
Carolina provider community, or 42 of 50 total providers.  Of the 42 participating providers, 21 
supplied an update to their network or coverage area(s), while 18 have reported no change. The 
remaining 3 represent providers who previously supplied data but were non-responsive in the April 
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2011 update effort or could not verify coverage areas at the time of this submission; therefore their 
previous dataset is being put forward as part of this compilation. A complete roster by provider 
depicting participation status and contact record is contained herein.  Of the 8 providers that are not 
represented in the attached datasets, 4 have either refused to participate in the voluntary program or 
have remained unresponsive to the numerous attempts at contact by Connect South Carolina. The 
remaining 4 providers are currently in some form of progress toward data submission but were not 
able to either submit or verify coverage areas at the time of this submission.    
 
As the aforementioned roster and attached methodology documentation will attest, it is the 
collective opinion of the Connect South Carolina principals that all commercially reasonable efforts 
were made to account for 100% of the known South Carolina broadband provider community, 
pursuant to this semi-annual data update submission. 
 
Connect South Carolina has also continued to perform broadband verification activities through 
several means. In addition to confirmation of service area(s) by each provider, Connect South 
Carolina conducts field validation efforts.  To date, 20 (40%) providers have been validated through 
field verification activities. Additional details on verification activities are contained within the Field 
Validation Narrative. 
  
At the program’s inception, Connect South Carolina launched a website to create awareness about 
the initiative. Connectsc.org continues to serve a prominent role in the outreach and data collection 
effort.  This program asset provides a way for the general public to participate in the process by 
offering interactive tools for users to test their connection speed, submit broadband inquiries, or 
contact a program representative.   
 
As an indicator of stakeholder penetration, the Connect South Carolina website encountered 3,436 
unique visits during this reporting period (6,325 total to date for the life of the grant awarded on 
December 20, 2009).  Additionally, this pronounced Web activity netted 36 broadband inquiries 
over this same reporting period (72 grant inception to date).  The website also provides the 
BroadbandStat application, which allows the consumer to confirm or dispute the coverage 
represented on the broadband inventory map. These consumer-initiated actions are facilitated 
through the Connect South Carolina website and the Connect South Carolina Interactive Mapping 
Tool (BroadbandStat) that offer the citizens the vehicles to provide information regarding 
availability in their respective service area, either in affirmation or contest of the reported data 
represented in the Connect South Carolina mapping artifacts.  Since the initial data collection and 
release of corresponding maps, feedback in the form of broadband inquiries has allowed Connected 
Nation to identify additional areas that are in need of field validation, which is scheduled as soon as 
possible.  
 
Community Anchor Institutions  
 
Connect South Carolina has established an ongoing mechanism for gathering data on the location 
and broadband connectivity of Community Anchor Institutions (CAI), in accordance with the data 
requirements of the SBDD NOFA Technical Appendix.   
 
In conjunction with the state of South Carolina, outreach was conducted during this data update 
reporting period by Connect South Carolina to continue identification of existing, centralized 
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sources for CAI connectivity data.  Outreach was coordinated to distribute the CAI survey to 
institutions throughout the state through multiple methods including a customized online survey 
available on the Connect South Carolina website.  Connect South Carolina continues to work 
diligently in the state to identify statewide entities such as the South Carolina Association of 
Counties, the State Library of South Carolina, and the South Carolina Department of State 
Information Technology to promote the importance of broadband connectivity at anchor 
institutions and participation in this data collection process.   
 
While we continue to document institutions and the related addresses, the connectivity data 
collected in most categories remains incomplete at this time.  Connect South Carolina will be 
implementing a number of new processes to increase participation including launching a CAI 
newsletter to connect communities across the state, increasing industry-specific planning to target 
new community contacts, and revising the CAI portion of our website to increase visibility and 
content.  From our work in South Carolina, as well as other states, we recognize the great value of 
this data to future collaboration efforts within the state and its value to the recently released 
National Broadband Map.  We plan to continue to bring best practices to the Connect South 
Carolina efforts, along with an investment of both human and technical resources required to reach 
our goal of increasing the data that is secured and reported as part of this process. 
 
In acquiring both broadband availability and CAI data within the state of South Carolina, Connected 
Nation has previously engaged all federally recognized tribal lands in the area covered by the 
Connect South Carolina SBDD grant and reported that outreach as part of past submissions.  
Throughout the next reporting period Connect South Carolina plans to engage directly with these 
tribal communities and will also conduct affirmative outreach with Native American tribal 
organizations that are active within the area.  Connect South Carolina understands the connectivity 
challenges facing these tribes, and we have identified a need to include their data as part of our 
upcoming submissions. 
 
 
The Connect South Carolina program exists to improve data on the deployment and adoption of 
broadband services and to assist in the extension of broadband technology across all regions of the 
great state of South Carolina, as well as the United States through contribution to the National 
Broadband Map.  We look forward to the continuing work ahead. 
 
Respectfully submitted, 
 
 
 
 
Thomas W. Ferree 
Chief Operating Officer 
Connected Nation, Inc. 
 
 

dclark
Cueball



                                                                          Connect South Carolina – Narratives and Methodologies 
 

 

 
April 1, 2011   7 
 

	
DATA ACQUISITION:  SOUTH CAROLINA COMMUNITY ANCHOR INSTITUTIONS  

In this third reporting period of the SBDD, Connect South Carolina, working in close coordination 
with the state of South Carolina, has established an ongoing mechanism for gathering data on the 
location and broadband connectivity of Community Anchor Institutions (CAI), in accordance with 
the data requirements of the SBDD NOFA Technical Appendix.  During this reporting period 
Connect South Carolina has continued to focus efforts on conducting outreach and raising 
awareness of this important project. 
 
Connect South Carolina has continued to identify and process CAI data obtained through an 
ongoing statewide outreach campaign.  Physical address information continues to be augmented 
through manual sourcing and geocoded by Connect South Carolina through ESRI ArcGIS software. 
 
Connect South Carolina continues to utilize a customized online survey hosted through 
SurveyMonkey, with a landing page on the Connect South Carolina website that was developed 
during the first reporting period.  This survey, in combination with a customized data gathering 
spreadsheet, was distributed to a targeted list of CAI throughout the state.  Connect South Carolina 
will continue to use these data gathering tools for future targeted outreach efforts throughout the 
coming months leading up to the next reporting period.  These materials are customized to fit the 
CAI categories as defined in the SBDD NOFA.   
 
The survey can be accessed at this link using the following password: 
http://connectsc.org/mapping_&_research/Community_Anchor_Institution_Data_Collection.php 
Password:  CAI_SC_3266 
 
Connect South Carolina has worked diligently during this reporting period to conduct research as 
part of an ongoing process to identify existing, centralized sources for CAI connectivity data.  The 
South Carolina Division of State Information Technology operates a statewide broadband network 
for CAI throughout the state serving schools, hospitals, and libraries.  Relevant data from this 
network is currently being extracted from the state database and Connect South Carolina will be 
reporting this data in the next reporting submission.  Additionally, we are investigating potential 
sources for public safety sector data in the state and identifying how we can secure this data for the 
next reporting submission. 
 
In tandem with these efforts to identify existing data, Connect South Carolina continues to identify 
key CAI contacts among all CAI categories in an effort to distribute and promote the online survey 
and raise awareness of the importance of CAI broadband connectivity.  The process to form 
partnerships with these key contacts has been slow to develop in South Carolina, but ongoing 
efforts are being made to introduce the CAI project to these contacts and ask for their assistance.  
Connect South Carolina expects to see a large increase in survey results in the coming months 
leading up to the next reporting period across all CAI categories. 
  
Connect South Carolina has an ongoing mission to educate CAI throughout the state on the 
importance of participating in the project.  Participation by these institutions will raise awareness 
about the importance of broadband connectivity and the need to report the requested data for 
inclusion on the National Broadband Map.  To assist with our data collection efforts, Connect South 
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Carolina is developing a CAI newsletter to be distributed quarterly beginning in April 2011.  The 
newsletter will highlight a CAI in South Carolina, encourage institutions to share their data, and 
highlight the National Broadband Map.   
 
The greatest challenge with collecting this data continues to be the difficulty in securing CAI 
broadband connectivity data.  Connect South Carolina will continue its ongoing work with the state 
of South Carolina and key organizations such as the South Carolina Division of State Information 
Technology in an effort to raise awareness of this project among CAI.   
 
A CAI summary of all processed and submitted data is provided below: 
 

CAI Type Total 
Physical 
Address Lat/Long

Technology 
of 

Transmission
Download 

Speed 
Upload 
Speed 

K-12 Schools 1,537 1,537 1,537 5 5 5
Libraries 191 191 191 15 15 16
Healthcare 115 115 115 0 0 0
Public Safety 446 446 446 7 7 6
Higher Ed Institutions 71 71 71 9 9 9
Other Government 50 50 50 43 39 39
Other Non-Government 1 1 1 1 1 1
Total 2,411 2,411 2,411 80 76 76
 
 
SBDD DATA SUBMISSION METHODOLOGY 

The submission of the broadband dataset for April 1, 2011, is contained within the SBDD Data 
Transfer Model and additional components as released on the Grantee Workspace on January 14, 
2011. Connected Nation has reviewed all literature that relates to the release and use of this data 
transfer model and recognizes that it does not replace or dictate how data is stored, processed, or 
displayed for the state or territory, as it is meant primarily as a means to transfer the broadband data 
from all states and territories and populate the National Broadband Map in a seamless fashion. 
Guidance from the Technical Mapping Guide, as released on the Grantee Workspace on March 24, 
2011, was also followed to ensure the completeness and validity of the submission through 
completion steps and checklists, completing the DataPackage spreadsheet, uploading broadband 
datasets into the Data Transfer Model, and checking the dataset using the SBDD_CheckSubmission 
receipt process.  
 
In addition to the narratives and methodologies contained herein, as well as the DataPackage.xls 
containing contact information, the data dictionary, and a provider summary table, the following 
feature classes are submitted within the SBDD Data Transfer Model for the state of South Carolina. 
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Inventory of Deliverables, Connect South Carolina: April 1, 2011 
 
NOFA Requirement Data Transfer Model Data Description 
Appendix A:  1(a)(i) BB_Service_CensusBlock Broadband Service Availability of 

Facilities-Based Providers in 
Census Blocks of No Greater 
Than Two Square Miles in Area. 

Appendix A:   1(a)(ii) BB_Service_RoadSegment Broadband Service Availability of 
Facilities-Based Providers by Road 
Segment in Census Blocks Larger 
in Area Than Two Square Miles. 

Appendix A:   1(b) BB_Service_Wireless Broadband Service Availability of 
Wireless Services Not Provided to 
a Specific Address. 

Appendix A:   3(b) BB_ConnectionPoint_MiddleMile Broadband Service Infrastructure 
Middle-Mile and Backbone 
Interconnection Points. 

Appendix A:   4 BB_Service_CAInstitutions  Community Anchor Institutions-
Listing. 

 
The provider data collected by Connected Nation on behalf of the state of South Carolina have been 
formatted per the given specifications and uploaded into the appropriate feature classes of the 
SBDD Data Transfer Model. Wireline availability is contained within Census Blocks and road 
segments, wireless availability is contained as polygons of coverage areas, and middle-mile 
connections and community anchor institutions are contained as point data. All speed data is 
contained at the census block, road segment, or wireless polygon level of availability. All efforts have 
been made to comply with formatting, domain, and metadata requirements to include as much 
information as possible.  
 
Connected Nation has continued outreach to satellite providers on their availability, technology, and 
speed information, but it is not included in this submission dataset.  Additional information is 
necessary to be able to show where service satisfactorily exists in the state, rather than submitting 
the entire boundary of the state as the serviceable area.  Analysis information distributed and 
discussed with the satellite providers, as well as any additional guidance from the Program Office on 
the desired analysis for satellite-serviceable areas, will be implemented for the October 2011 data 
submission.  
 
 
SOUTH CAROLINA FIELD VALIDATION NARRATIVE 

Connected Nation focused a portion of its time on specific validation processes such as: 
 

• conducting random spectrum analysis studies throughout the state using an Avcom PSA-37-
XP spectrum analyzer; 

• conducting mobile speed tests throughout the state using an iPhone, Android (or other 
smart phone) as well as provider-specific aircards (Sprint 3G/4G, Clearwire et al); 
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• identifying pre-selected, provider-submitted wireless transmit tower sites and cross-
referencing data about that tower against the Federal Communications Commission (FCC) 
databases such as Antenna Structure Registration and/or the Universal Licensing System; 

• cross-referencing Federal Registration Number data against available FCC Form 477 data as 
well as the FCC COmmission REgistration System (CORES); 

• validating provider submitted data (for example: latitude/longitude) using a handheld 
Garmin eTrex Summit GPS unit or GPS enabled software such as Microsoft Streets and 
Trips; 

• locating physical wire-line attributes (such as remote terminals, CATV plant, etc.) and 
comparing them against provider submitted data; and 

• conducting on-net and off-net speed tests using the FCC portal at 
http://www.broadband.gov/qualitytest/about/ or using the Ookla Net Metrics enabled 
speed test utility located on each of Connected Nation’s state specific websites. 

 
Additionally, Connected Nation cross-referenced numerous public documents in order to ensure 
that all known broadband providers were located and contacted.  This included searching 
membership logs from the trade associations (WISPA, WCAI, PCIA, etc.), the Cable Television Fact 
Book, Public Utility Commission records, Public Service Commission records, Chamber of 
Commerce, etc. 
 
To date Connected Nation’s staff conducted on-site validation tests in South Carolina on the 
following providers:  Almega Cable, AT&T, Atlantic Broadband, Chester Telephone Company, 
Clearwire Corporation, Comporium Communications, Electronics Service Company of Hamlet 
LLC, Fairfield Communications, Farmers Telephone Cooperative Inc., FTC Communications, 
Home Telephone Company Inc., NTInet Inc., PBT Communications, Pee Dee Net, Pee Dee 
Online, Sprint, Time Warner Cable Inc., T-Mobile, tw telecom, and Verizon South Inc. 
 
During this reporting period, Connected Nation conducted 14 additional on-site validation tests 
with AT&T, Clearwire, Sprint, T-Mobile, and Verizon. 
 
From program initiation through this reporting period, Connected Nation has completed in-the-
field validation testing against 20 companies (out of a universe of 50 viable providers) totaling 40% 
within the state of South Carolina.   
 
 
ACCURACY AND VERIFICATION:  METHODOLOGY - PROVIDER VALIDATION 

Broadband providers maintain their service area data in many different formats, all in varying levels 
of complexity and granularity. In order to ensure that the data required by the NTIA is standardized 
across all providers and that it is as accurate as possible, Connected Nation translates and formats 
the data that providers are able to supply into a GIS shapefile and produces maps for the provider to 
review.  The resulting map(s) and review process allow for providers to see their service area in a 
geographic format – for some providers, this is the first time they have seen maps of their 
broadband service area. Having the mapped service area allows providers to quickly identify any 
issues that appear in the data representation, whether the issue is in the data translation into a GIS 
format or from the original data collection and submission. Often data is provided from various 
sources and through the review and revision process, local engineers who operate the networks and 
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work in the field are able to ensure that the tabular data that has been submitted is accurate and 
represents the real-world network extent. Any issues in how the service area is represented on the 
map(s) are remedied by Connected Nation, whether they are additions, removal of service, or any 
other revisions. Revised maps of service area representations are sent to the provider for review and 
approval; Connected Nation will revise data and return maps as many times as necessary until the 
provider is in agreement that the map represents their service area as accurately as possible. Once 
the review process has been completed and final approval of the data is provided, the data is deemed 
ready for NTIA submission. 
 
Once the data collection has been aggregated a statewide level, static maps of statewide and county-
level availability are produced and made publicly available. In addition, consumers can visit the 
interactive online tool, BroadbandStat, to create customized views of broadband service areas and 
analyze corresponding demographic information. Leveraging broadband service data on various 
platforms allows for public users, providers, and other stakeholders to review, scrutinize, and 
provide feedback on the represented data. This feedback becomes a validation method in itself as 
consumers submit inquiries to Connected Nation either affirming where service is not available or 
identifying areas where broadband service is shown on the map, but in actuality is not available. This 
allows for a follow-up to providers regarding revisions to the data as it is represented; it also allows 
for Connected Nation to identify locations where on-site visits may be necessary to complete field 
validation of available services. Public feedback on all forms of mapping products serves as a 
localized validation method for provider-supplied information and allows Connected Nation to 
resolve inaccuracies as they are identified to ensure that only the highest quality information is 
provided to stakeholders. 
 
Estimates derived from provider-validated data indicate that approximately 4.23% of South Carolina 
households do not have terrestrial fixed broadband service available, and approximately 0.35%1 of 
South Carolina households have neither mobile nor fixed broadband service available.2   
 
Within rural areas of the state, results derived from provider-validated data indicate that 
approximately 5.8% of rural South Carolina households do not have terrestrial fixed broadband 
service available, and approximately 0.49%3 of rural South Carolina households have neither mobile 
nor fixed broadband service available.4   
 

                                                            
1 In accordance with NTIA’s definition of available broadband service as specified in the SBDD NOFA, this estimate 

includes both terrestrial fixed and mobile broadband service, if the service offers download speeds of at least 768 Kbps 
and upload speeds greater than 200 Kbps. 

2 Due to the nature of the SBDD data collection methodology as defined by the NTIA and based on both census 
block geographic units and street segment data, the estimates of broadband availability derived from provider-validated 
data may include an overstatement of the actual number of households with broadband availability.  Under the census 
block-based data collection method, a provider will typically report broadband availability for an entire census block 
whether its network is present across the whole or only a subset of that census block.  This potential overestimation at 
the census block level can be amplified as the data is aggregated across the entire state. 

3 See footnote 1. 
4 See footnote 2. 
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WIRELESS METHODOLOGY 

 
Broadband Service Availability in Provider’s Service Area 

Wireless Services Not Provided to a Specific Address 
 
Data solicited from a fixed wireless provider to create propagation models include, but are not 
limited to: 

1. The name of the structure 
2. Whether the transmitting device is operational or proposed 
3. The maximum advertised downstream speed, the maximum advertised upstream speed 
4. The typical downstream speed, the typical upstream speed (peak periods for both) 
5. The frequency range of spectrum being used (as prescribed by NTIA) 
6. The primary population center(s) being served (for geopolitical boundary reference) 
7. The physical address of the transmit site (in the event latitude/longitude is unavailable from 

the provider this allows a quick reference point for geocoding) 
8. Latitude in either Degrees, Minutes and Seconds and/or in Decimal Degrees (typically 

received as NAD 27 or NAD 83)  
9. Longitude in either Degrees, Minutes and Seconds and/or in Decimal Degrees (typically 

received as NAD 27 or NAD 83)  
10. Antenna pattern (e.g. omni-directional, 180°, 120°, 90°, etc.) 
11. Azimuth of antenna (e.g 360° with magnetic declination if known) 
12. Approximate transmit radius (in feet, miles, or kilometers) 
13. Polarity of transmit antenna (Vertical or Horizontal) 
14. Transmit antenna gain (in dBi) 
15. Line loss (applicable only to providers using coax, heliax, waveguide or other forms of 

cabling – excludes power-over-Ethernet devices) 
16. Mechanical and/or Electrical beam tilt (if applicable) 
17. Equipment Manufacturer (allows easy cross-reference against manufacturer’s specification 

sheet) 
18. Power output of the transmitting device (if unknown, FCC standards or manufacturer 

specifications are applied) 
19. AMSL at base of tower site 
20. Antenna centerline AGL (height of antenna above ground level measured at the centerline 

of the actual antenna) 
21. Foliage factors (Evergreens/Deciduous and percent of ground cover) 
22. Ground Clutter (primarily used in rural areas to account for foliage and in metropolitan areas 

to account for types and heights of buildings if known)   
23. Average gain of receive antenna 
24. Receive antenna is estimated at height above average terrain (HAAT) of 6.2 meters/20 feet 
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25. Federal Registration Numbers (if applicable) which may allow opportunities to cross-
reference and/or obtain additional data from the Federal Communications Commission 
Universal Licensing System and the COmmission REgistration System 

 
Propagation modeling is an empirical mathematical formulation for the characterization of radio 
wave propagation as a function of frequency, distance, and other conditions. Propagation 
software(s) typically use the Irregular Terrain Model (also known as Longley-Rice) of radio 
propagation for frequencies between 20 MHz and 20 GHz. This model is based on electromagnetic 
theory and statistical analyses of the combination of terrain features and radio measurements, then 
predicting the median attenuation of a radio signal as a function of distance and the variability of the 
signal in time and in space.  For metropolitan areas, the software can typically be adjusted to use the 
Okumura-Hata model which accounts for predicting the behavior of cellular transmissions in areas 
where buildings are the primary obstructions. The resulting product from either model depicts a 
graphical illustration of the theoretical propagation characteristics of a selected frequency range 
based on defined variables (receiver sensitivity of the home/mobile device, foliage factor, and digital 
elevation terrain input). 
 
 
BROADBAND INQUIRIES METHODOLOGY 

Connected Nation collects consumer feedback in the form of broadband inquiries. These inquiries 
represent any type of communication received from the public regarding broadband service. Once 
broadband inquiries are received across the state, this information is overlaid with the broadband 
availability information which was collected through the SBDD program.  This allows for a real-
world comparison of the broadband landscape to the information received from broadband 
inquiries.  Broadband inquiries are able to provide three types of information:  1) Residents who do 
not have broadband but want it.  2)  Residents who have broadband but want a different provider.  
3)  Residents who do not have broadband, but the broadband inventory maps indicate that they do. 
 
Through the collection of broadband inquiries, a visual demand for broadband is presented.  This 
visualization allows Connected Nation the ability to validate broadband availability maps for 
accuracy.  If residents within a region state that they are without broadband, but the broadband 
inventory maps show otherwise, this allows Connected Nation to approach the providers within that 
area in an effort to trim down their coverage to more accurately represent real-world availability on 
the ground.  On the other hand, if there is a region in the territory in which broadband is not 
available, the broadband inquiries allow providers close to that region to see where they can 
successfully expand their broadband networks, leading to a high return on investment.  In short, the 
higher number of inquiries leads to a higher level of certainty in regard to the broadband availability 
maps.  Since the initial data collection and release of corresponding maps, feedback in the form of 
broadband inquiries has allowed Connected Nation to identify additional areas that are in need of 
field validation, which are scheduled as soon as possible. Additional information on field validation 
can be found in the Field Validation Narrative. 
 
The broadband inquiry process has been implemented in each of the Connected Nation state 
programs with successful results. Altogether Connected Nation has received over 16,000 broadband 
inquiries since 2007, allowing the state programs to evaluate each inquiry for broadband demand and 
data verification.  These inquiries are continuously examined against current broadband availability, 
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updated every six months, to determine if previously unserved households have been expanded to 
and can now receive broadband at their residence. This database of broadband inquiries has also 
allowed  the Connected Nation state programs to aggregate demand in concentrated areas to show 
providers the exact locations where the population has made it clear that they would purchase 
broadband if it was made available to them. Providers in the states have responded to this process 
and have expanded to areas knowing that their investment will be worthwhile. Data verification 
methods have also proven successful, as the state programs have been able to show those inquiries 
that indicate the broadband service areas are misrepresented on the map to providers, who then 
verify where service cannot reach in regard to that residence(s). The broadband coverage in these 
states has been altered to create a more accurate map based on the inquiries submitted by the public. 
 
During this reporting period, the Connect South Carolina project has received a total of 36 inquiries 
(72 grant inception to date).  As more inquiries are submitted to Connect South Carolina, a more 
thorough validation of the broadband landscape can be performed, while also allowing providers to 
see which areas have a high demand for broadband adoption. 
 
 
BROADBANDSTAT METHODOLOGY  

BroadbandStat is an online, interactive mapping tool for viewing, analyzing, and validating 
broadband data. Developed through a partnership with ESRI, the market leader in geographic 
information system (GIS) software, BroadbandStat is a multi-functional, user-friendly way for local 
leaders, policymakers, consumers, and technology providers to devise a plan for the expansion and 
adoption of broadband.  
 
First and foremost, BroadbandStat allows consumers to locate their residence and identify providers 
that offer broadband Internet service to that location. The interactive platform allows for users to 
build and evaluate broadband expansion scenarios using a wealth of data, including education and 
population demographics, broadband availability, and research about the barriers to adoption.  
 
New functionality in BroadbandStat allows the consumers to provide feedback on the broadband 
data displayed on the interactive map.  Through the collection of this feedback, a visual demand for 
broadband is presented.  This visualization allows the Connected Nation state programs the ability 
to validate the broadband availability for accuracy.  If residents within a region state they are without 
broadband, but the interactive map shows otherwise, this allows Connected Nation to approach the 
providers within that area in an effort to trim down their coverage to more accurately represent real-
world availability on the ground.   
 
The Connect South Carolina project launched BroadbandStat on May 21, 2010, and has received a 
total of 2,580 visits to date, of which 2,566 occurred this reporting period. 
 
 
SPEED TEST METHODOLOGY 

The 126 speed tests that are represented in the Connect South Carolina Speed Test Report during 
this reporting period (319 grant inception to date) are the result of a partnership between Connected 
Nation and Ookla Net Metrics. Utilizing this relationship increases the level of confidence in the 
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data being collected and provides for a far greater sample size than could be collected by a single 
testing site. 
 
Ookla owns and operates Speedtest.net, as well as develops and deploys speed tests, such as the 
Connect South Carolina speed test website, for partners around the world. This network of sites that 
is developed and run on its testing technology provides Ookla with a vast dataset that, due to the 
variability of geographic information collected across the varying speed test sites, is geocoded 
utilizing Geo-IP technology. This technology allows for tests to be geocoded to points of 
aggregation, typically larger nodes across provider networks.  While there are hundreds of thousands 
of tests that have been conducted, the level of aggregation is only sufficient for county-level detail 
due to the test results being located at these larger nodes and not at an absolute location for each 
speed test. 
 
In an effort to validate broadband data from the Connect South Carolina project, speed test 
information is collected throughout the state.  Speed tests provide speed information on the path 
taken through all networks (a provider’s network as well as additional networks) a local machine 
must connect to in order to reach the host test.  The benefit of this collection of speed information 
is two-tiered.  First, it allows for a comprehensive dataset of speeds, while also providing Connect 
South Carolina with the information on where broadband services are available.  Second, unlike 
theoretical speed information which was received through the data collection process, the use of 
speed tests provide real-world information on the speeds that currently exist within the state of 
South Carolina.   
 
 
 
 
 



Complete 95
Non-Responsive/Refused 6
In Progress 12

Count of Datasets by Viable Status 113
Total Unique Providers Represented 50

Provider Name Platform Status

NDA 
Execution 

Date Notes
AT&T Inc. ILEC/CLEC Data Added to Statewide Inventory 12/16/2009
AT&T Inc. Mobile Wireless Data Added to Statewide Inventory 12/16/2009
CenturyLink ILEC/CLEC Data Added to Statewide Inventory 12/4/2009
Charter Communications Cable Data Added to Statewide Inventory 12/15/2009
Clearwire Corporation Mobile Wireless Data Added to Statewide Inventory
Comcast Cable Communications, LLC Cable Data Added to Statewide Inventory 12/7/2009
Farmers Telephone Cooperative, Inc. ILEC/CLEC Data Added to Statewide Inventory 1/22/2010
Farmers Telephone Cooperative, Inc. Fiber Data Added to Statewide Inventory 1/22/2010
Farmers Telephone Cooperative, Inc. Mobile Wireless Data Added to Statewide Inventory 1/22/2010
Farmers Telephone Cooperative, Inc. ILEC/CLEC Data Added to Statewide Inventory 1/22/2010
Frontier Communications Corporation ILEC/CLEC Data Added to Statewide Inventory 1/22/2010
Home Telephone Company, Inc. Cable Data Added to Statewide Inventory 1/22/2010
Horry Telephone Cooperative, Inc. ILEC/CLEC Data Added to Statewide Inventory 1/22/2010
Horry Telephone Cooperative, Inc. Fiber Data Added to Statewide Inventory 1/22/2010
Horry Telephone Cooperative, Inc. Cable Data Added to Statewide Inventory 1/22/2010
Horry Telephone Cooperative, Inc. Mobile Wireless Data Added to Statewide Inventory 1/22/2010
Leap Wireless International, Inc. Mobile Wireless Data Added to Statewide Inventory 4/6/2010
Northland Communications Cable Data Added to Statewide Inventory
Skyrunner, Inc. Fixed Wireless Data Added to Statewide Inventory
Sprint Nextel Corporation Mobile Wireless Data Added to Statewide Inventory 1/14/2010
T-Mobile USA, Inc. Mobile Wireless Data Added to Statewide Inventory 1/8/2010
TDS Telecommunications Corporation ILEC/CLEC Data Added to Statewide Inventory 1/27/2010
Time Warner Cable LLC. Cable Data Added to Statewide Inventory 12/21/2009
United States Cellular Corporation Mobile Wireless Data Added to Statewide Inventory 2/15/2011
Verizon South Inc. Mobile Wireless Data Added to Statewide Inventory 12/14/2009
West Carolina Communications, LLC Fiber Data Added to Statewide Inventory 1/22/2010
Comporium Communications Backhaul Backhaul Provider Only Processing Complete 1/25/2010
Comporium Communications Backhaul Backhaul Provider Only Processing Complete 1/25/2010
Comporium Communications Backhaul Backhaul Provider Only Processing Complete 1/25/2010
Horry Telephone Cooperative, Inc. Backhaul Backhaul Provider Only Processing Complete 1/22/2010
Level 3 Communications, LLC Backhaul Backhaul Provider Only Processing Complete 12/14/2009
TDS Telecommunications Corporation Backhaul Backhaul Provider Only Processing Complete 1/27/2010

Comporium Communications ILEC/CLEC
Approval for Update Not Received - Use Last 
Submission Data 1/25/2010

Comporium Communications ILEC/CLEC
Approval for Update Not Received - Use Last 
Submission Data 1/25/2010

Comporium Communications ILEC/CLEC
Approval for Update Not Received - Use Last 
Submission Data 1/25/2010

Family View CableVision Cable Partial Data Received
AT&T Inc. Backhaul No Update to Provide 12/16/2009
Atlantic Broadband Cable No Update to Provide 2/3/2010
CenturyLink Backhaul No Update to Provide 12/4/2009
Chesnee Communications Cable No Update to Provide 1/25/2010
Chesnee Communications ILEC/CLEC No Update to Provide 1/25/2010
Chester Telephone Company ILEC/CLEC No Update to Provide 1/25/2010
Chester Telephone Company Backhaul No Update to Provide 1/25/2010
Comporium Communications Cable No Update to Provide 1/25/2010
Comporium Communications Fiber No Update to Provide 1/25/2010
Comporium Communications Fixed Wireless No Update to Provide 1/25/2010
Comporium Communications Mobile Wireless No Update to Provide 1/25/2010
Comporium Communications ILEC/CLEC No Update to Provide 1/25/2010
Comporium Communications Cable No Update to Provide 1/25/2010
Comporium Communications Cable No Update to Provide 1/25/2010
Comporium Communications Cable No Update to Provide 1/25/2010
Comporium Communications Fiber No Update to Provide 1/25/2010
Comporium Communications Fiber No Update to Provide 1/25/2010
Comporium Communications Fiber No Update to Provide 1/25/2010
Comporium Communications Cable No Update to Provide 1/25/2010
DeltaCom, Inc. Backhaul No Update to Provide 2/16/2010
Electronics Service Company of Hamlet, LLC Fixed Wireless No Update to Provide 3/24/2010
Fairfield Communications Cable No Update to Provide 1/25/2010
Fairfield Communications Fiber No Update to Provide 1/25/2010
Fairfield Communications Backhaul No Update to Provide 1/25/2010
Farmers Telephone Cooperative, Inc. Backhaul No Update to Provide 1/22/2010
Farmers Telephone Cooperative, Inc. Backhaul No Update to Provide 1/22/2010
Hargray Communications Group, Inc. Cable No Update to Provide 1/25/2010
Hargray Communications Group, Inc. Fiber No Update to Provide 1/25/2010
Hargray Communications Group, Inc. ILEC/CLEC No Update to Provide 1/25/2010
Hargray Communications Group, Inc. Backhaul No Update to Provide 1/25/2010
Hargray Communications Group, Inc. Cable No Update to Provide 1/25/2010
Hargray Communications Group, Inc. ILEC/CLEC No Update to Provide 1/25/2010
Hargray Communications Group, Inc. Backhaul No Update to Provide 1/25/2010
Hargray Communications Group, Inc. Backhaul No Update to Provide 1/25/2010

Broadband Provider Log



Home Telephone Company, Inc. ILEC/CLEC No Update to Provide 1/22/2010
Home Telephone Company, Inc. Fiber No Update to Provide 1/22/2010
Home Telephone Company, Inc. Backhaul No Update to Provide 1/22/2010
Home Telephone Company, Inc. Cable No Update to Provide 1/22/2010
Home Telephone Company, Inc. Fiber No Update to Provide 1/22/2010
Home Telephone Company, Inc. Backhaul No Update to Provide 1/22/2010
NTInet, Inc Fixed Wireless No Update to Provide 2/9/2010
Palmetto Rural Telephone Cooperative ILEC/CLEC No Update to Provide 1/22/2010
Palmetto Rural Telephone Cooperative ILEC/CLEC No Update to Provide 1/22/2010
Pee Dee Net Fixed Wireless No Update to Provide 2/23/2010
Pee Dee Online Fixed Wireless No Update to Provide 2/24/2010
Piedmont Rural Telephone Cooperative ILEC/CLEC No Update to Provide 1/28/2010
Piedmont Rural Telephone Cooperative Mobile Wireless No Update to Provide 1/28/2010
Sandhill Telephone Cooperative, Inc. ILEC/CLEC No Update to Provide 1/25/2010
Sandhill Telephone Cooperative, Inc. Backhaul No Update to Provide 1/25/2010
Southern Coastal Cable Cable No Update to Provide 6/30/2010
Sprint Nextel Corporation Backhaul No Update to Provide 1/14/2010
tw telecom of south carolina, llc Backhaul No Update to Provide 4/26/2010
Verizon South Inc. Backhaul No Update to Provide 12/14/2009
West Carolina Communications, LLC ILEC/CLEC No Update to Provide 1/22/2010
West Carolina Communications, LLC Backhaul No Update to Provide 1/22/2010
West Carolina Communications, LLC ILEC/CLEC No Update to Provide 1/22/2010

Advanced Technology Group Backhaul
No Update Provided - Use Last Submission 
Data 1/14/2010

MetroCast Communications Cable
No Update Provided - Use Last Submission 
Data

Windstream Communications ILEC/CLEC
No Update Provided - Use Last Submission 
Data 1/20/2010

Windstream Communications Backhaul
No Update Provided - Use Last Submission 
Data 1/20/2010

Aero Networks, LLC Solicited Initial Data 11/22/2010
Countrywide Wireless Solicited Initial Data

Birch Communications, Inc. Backhaul Refused to Participate

[JAN-11-11 Jill Lindgren] Provider has chosen 
not to participate.  The main concern was more 
with the fact he does not want to divulge the 
information publicly on his speeds or coverage 
area.

Birch Communications, Inc. ILEC/CLEC Refused to Participate

[JAN-11-11 Jill Lindgren] Provider has chosen 
not to participate.  The main concern was more 
with the fact he does not want to divulge the 
information publicly on his speeds or coverage 
area.

MainStreet Wireless Refused to Participate

[FEB-01-11 Jill Lindgren] Received e-mail from 
provider that they are not interested in 
participating.

Knology of South Carolina, Inc. Cable Non-Responsive to Multiple Attempts

In addition to multiple contact attempts made 
between August 18, 2009 and August 24, 2010, 
six attempts were made during this submission 
period.

Knology of South Carolina, Inc. Backhaul Non-Responsive to Multiple Attempts

In addition to multiple contact attempts made 
between August 18, 2009 and August 24, 2010, 
six attempts were made during this submission 
period.

US LEC of South Carolina Backhaul Non-Responsive to Multiple Attempts
Five contact attempts were made between 
August 31, 2010 and February 22, 2011.

DISH Network Corporation Satellite Other 1/27/2010

[MAR-09-11 Matthew Brunt] Satellite data will 
not be submitted due to additional information 
being necessary to show where service is 
available in the state, rather than submitting the 
entire state boundary as serviceable area.

Global Crossing Telecommunications, Inc Backhaul Other

[FEB-17-11 Wes Kerr] Received word from a 
Provider Representative that they still have a 
Network Security agreement with several 
Federal agencies and cannot provide data at 
this time.

Hargray Communications Group, Inc. Fiber Other 1/25/2010

[MAR-09-11 Matthew Brunt] Although recorded 
below, we never received fiber coverage for 
Hargray, Inc.  Only received fiber for Bluffton 
Telephone Company.

Hargray Communications Group, Inc. Fiber Other 1/25/2010

[MAR-09-11 Matthew Brunt] We never actually 
received fiber coverage for Hargray Telephone 
Company.  Only received fiber for Bluffton 
Telephone Company.

Home Telephone Company, Inc. ILEC/CLEC Other 1/22/2010

[MAR-07-11 Matthew Brunt] CLEC DSL data 
was never received and does not appear to 
have ever been in service.

Hughes Network Systems, LLC Satellite Other 2/5/2010

[MAR-09-11 Matthew Brunt] Satellite data will 
not be submitted due to additional information 
being necessary to show where service is 
available in the state, rather than submitting the 
entire state boundary as serviceable area.

Time Warner Cable LLC. Backhaul Other 12/21/2009

[MAR-04-11 Matthew Brunt]  Previous middle 
mile data submission for South Carolina did not 
include any middle mile points within the state.  
Provider status adjusted accordingly.

West Carolina Communications, LLC Backhaul Other 1/22/2010 [MAR-23-11 Dawn Clark] This subsidiary does 



WildBlue Communications, Inc. Satellite Other 1/8/2010

[MAR-09-11 Matthew Brunt] Satellite data will 
not be submitted due to additional information 
being necessary to show where service is 
available in the state, rather than submitting the 
entire state boundary as serviceable area.

Horry Telephone Cooperative, Inc. Fiber Inactive - No Longer in Business 1/22/2010

[FEB-03-11 Daryl Coffey] The provider states 
that HTC Communications no longer exists, and 
all services should now list the cooperative as 
the provider; sent notes to GIS

Horry Telephone Cooperative, Inc. Mobile Wireless Inactive - No Longer in Business 1/22/2010

[FEB-03-11 Daryl Coffey] The provider states 
that HTC Communications no longer exists, and 
all services should now list the cooperative as 
the provider

Horry Telephone Cooperative, Inc. Backhaul Inactive - No Longer in Business 1/22/2010

[FEB-03-11 Daryl Coffey] The provider states 
that HTC Communications no longer exists, and 
all services should now list the cooperative as 
the provider

Horry Telephone Cooperative, Inc. ILEC/CLEC Inactive - No Longer in Business 1/22/2010

[FEB-03-11 Daryl Coffey] The provider states 
that HTC Communications no longer exists, and 
all services should now list the cooperative as 
the provider

Horry Telephone Cooperative, Inc. Cable Inactive - No Longer in Business 1/22/2010

[FEB-03-11 Daryl Coffey] The provider states 
that HTC Communications no longer exists, and 
all services should now list the cooperative as 
the provider
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1 Overview 
The following describes the Data Gathering, Data Integration, Data Validation and Verification and Quality Control 

processes utilized to create the Broadband Mapping Project’s April 1
st

, 2011 data submission.   

 

To support various levels of technical and program knowledge, this white paper supplies both a high level 

summary and a detailed process review. 

 

2 High Level Review 

2.1 Data Gathering - Providers 

Broadband Service Area, Middle Mile Aggregation Points and Broadband Service Overview 

The collection of Broadband Service areas, Middle Mile Aggregation points and Broadband Service Overview 

information is handled through the following Provider Outreach Process: 

 

 Build and Maintain an Inventory of Broadband Providers through research and State inputs. 

 Update Provider Material that describes the data requirements and logistics for data transfer. 

 Update NDA for use in project, where applicable 

 Maintain multiple protocols for the provider to submit data, including SFTP technology when desired.   

 Conduct one-on-one informational discussions with each provider to communicate the following: 

o Requirements of this project 

o Broadband data required to support the product data model 

o Submission protocols available 

o Capability to validate how the supplied data is aggregated 

 

 Download/receive Provider Data 

 Establish a repeatable process with Provider. Maintain Provider communication, transaction and data 

handling records throughout the project (dates contacted, data received, etc.)  
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2.2 Data Gathering - Community Anchor Institution (CAI) 

The collection of CAI information is handled through the following CAI Collection Process: 

 Collect and maintain inventory of CAIs through Data Mining, research, and State inputs. 

 Maintain web-based CAI portal for institutions to add or confirm attribution, location and enter 

broadband-specific information. 

 Upload web-based data to Core Database for standardization. 

 Perform internal cleansing, such as removing duplicate records, identifying gaps in broadband attribution 
and verifying category.  

 Geocode CAI locations.  

 Translate Core Database data to deliverable ready format.  

 Continue engagement with non-responsive institutions. 

 

2.3 Data Integration Process 

 

The data integration and processing mechanisms currently utilized allow for multiple types of inputs and results in 

a standardized output that meets the NTIA deliverable requirements. This process is flexible to support data model 

changes and project requested enhancements.  

 

 Receive inputs from Providers via submission protocols, upload into Sourcing Database and catalog with 

provider information.  

 Review Provider supplied data for completeness and for potential discrepancies that require resolution 

prior to processing and flag as necessary. 

 Categorize input into data type category (addresses, block lists, paper maps, etc.). 

 Standardize input based on data type within Staging Database. 

 Create Compact Polygons (CP)—(internal methodology for generating area based feature for coverage in 

Staging Database). 

 Apply broadband attribution to CP, Apply metadata to CP 

 Perform quality analysis of the CP against the source supplied to identify any completeness or accuracy 

issues.   

 Request additional information from the provider if elements of coverage are missing or contain 

discrepancies.  This is a second manual quality check to ensure data is complete.   Following completion of 

CP creation, process steps within Data Validation & Verification occur 

o Process coverage area to build the required NTIA data model layers  

 

 Process CAI data input into internal standardized format, as mentioned above under CAI Create Product 

Deliverable based on NTIA and State-level requirements. 

 Following the creation of the product, process steps within Data Validation & Verification occur 
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2.4 Data Validation & Verification 

 

To ensure the data collected and processed is accurate and comprehensive, a holistic approach has been 

developed to further validate and verify the data. Following the initial mapping of providers’ coverage area and 

serviceability claims, the project team uses the following methods:  

 

 Third-Party Data Verification: Visually and programmatically compare the coverage against third-party 

data.  

Pitney Bowes and American Roamer data are used in cases where a coverage area is questionable.  All 

anomalies identified during this analysis are reviewed with the providers. 

 

 Broadband Provider Validation – Provider Portal Application:  Providers were trained on and requested 

to use a secure interactive web application to review their current coverage area(s) and supporting 

broadband attribution and validate their data or submit change requests to update their data. 

 

All provider change requests go through the Data Integration Process and a review with the provider to 

complete validation. 

 

 Confidence Values:  All Verification, Validation, and manual quality reviews are tracked by provider and 

then by technology type, which is then stored and maintained within a “Validation” table.  A confidence 

value is assigned based on the collected information to highlight provider coverage areas that require 

further investigation and enhancements. 

 

2.5 Quality Control 

Following collection, processing and analysis of the provider and CAI data, the product is checked manually and 

algorithmically against the NTIA data model.  Some of the items included within these checks are as follows:   

 Format Correctness 

 Table & Field Structure  

 Valid Values 

o Including default values, where applicable 

 Geographic Extent and Topology Errors 

 

Prior to data submission, another quality control script supplied by NTIA is run.  This script, 

SBDD_CheckSubmission.py, creates an output in text form that is required to be submitted along with the final 

deliverable.  All errors must come up clean, unless otherwise specified from NTIA. 



            

7 

Exceptions to the script as noted by NTIA on the SBDD Workspace on 03/25/11 at the following link: 
https://sbdd-granteeworkspace.pbworks.com/w/page/38218329/CheckSubmissionExceptions  

- Longitude values for States outside the lower 48 (any table) 

- CAI results for Transtech, MaxAdUp, MaxAdDown if BBService is ‘No’ or ‘Unknown’  

- Overview MaxAdDown, MaxAdUp if 100% of record level data has MaxAdDown or MaxAdUp 

populated 

https://sbdd-granteeworkspace.pbworks.com/w/page/38218329/CheckSubmissionExceptions
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3 Detailed Process Review 
Below is a detailed review of the data collection, integration and quality control points along the broadband data 

gathering and mapping process. 

 

Diagram of overall process: 

 
 

3.1 Provider Outreach 

For the April 2011 data submission, an e-mail notification was sent to all providers with supporting deliverable 

dates.  The Provider Portal web application was released and training webinars held so providers could use this 

application to submit changes to and/or validate their current coverage area(s). 

 

Data was also collected from the providers via e-mail and SFTP, depending on their comfort level to submit data in 

time for the April 1
st

 deadline. 
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In support the data collection effort, providers that did not timely respond to the outreach were contacted by 

phone. 

 

3.2 Outreach Materials 

The original provider packet sent via email to the providers included the following documents and files: 

1) Letter from the State inviting them to participate in the program 

2) Copy of the non-disclosure agreement (NDA) 

3) Copy of the Mapping NOFA from the NTIA 

4) Copy of the NOFA Clarification from the NTIA 

5) Broadband service address example file in CSV format 

6) Word document describing service address example file 

7) Broadband service block example file in CSV format 

8) Word document describing service block example file 

9) Broadband service street example file in CSV format 

10) Word document describing service street example file 

11) Broadband subscriber example file in CSV format 

12) Word document describing subscriber example file 

13) Broadband wireless coverage area sample shapefile 

14) Word document describing wireless coverage area sample shapefile 

15) Instructions for downloading, installing, and using the WinSCP secure FTP application 

 

3.3 Outreach Process 

The provider outreach process is comprised of the following general steps: 

1) Send the provider package and introduction letter to the main point of contact for the provider 

2) Follow up with email and call to verify that the main point of contact is correct. 

3) If necessary, discuss the NDA further and resolve any redlines. 

4) Once the correct primary contact is established, set up a call, if necessary, to learn more about the 

provider’s offerings and direct them to the appropriate outreach materials. 

5) If providers are unable to be contacted (non-responsive) or indicate that they are not interested in 

participating (non-cooperative) mark them as such on the provider tracking sheet. These providers will be 

escalated to the state for further action. 

6) As the providers are collecting the required data, provide instruction on downloading, installing, and using 

the WinSCP secure FTP application, if required. 

7) Arrange with the providers to transfer the data in whatever way they are comfortable. Some providers 

will find regular email acceptable. Others will want to use the secure FTP application. 

8) After data is received and reviewed, it may be necessary to contact a provider for clarification or to 

address incomplete data sets. In the interest of building and maintaining relationships, care is given not to 

push the provider but to work with it to obtain accurate data in the best possible format. 
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3.4 Data Collection 

3.4.1 Data Transfer Procedures 

There are three primary ways data is collected from providers. These are: 

1) Secure FTP using the WinSCP application 

2) Regular email 

3) Mail 

 

3.4.2 Initial Data Review and Quality Assurance 

The initial data review and quality assurance process consists of the following general steps: 

1) Access the data from the secure FTP site or email 

a. If emailed, place copy of original data set in the appropriate provider folder on the secure FTP 

site 

2) Place copy of raw data on local computer in a working directory. 

3) Review data and determine course of action based on type of data received. 

4) Ensure data is complete and contact provider to address any gaps. 

Note: The goal is to get as many providers as possible to provide subscriber address data in the correct format. 

Obviously, this will not be possible with all providers so we will continue to have to process various types of 

provider-supplied data. 
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3.5 Data Ingestion 

3.5.1 Data Ingestion Overview 

The following outlines the process steps taken based on the type of input supplied by the data provider: 

Point Data 

 Subscriber location 

 DSLAM location 

 Central Office location 

 Broadcast Tower location 

Linear Information 

 TIGER street segments 

Polygonal Information 

 Census Blocks 

 Coverage Area 

Overall, the process is geared toward taking the provider data supplied and creating polygon shapes to append to 

the bb_cov feature class. The bb_cov feature class is the interim data set that is then processed using the 

makeDeliverable.py Python scrip to create the MapConnect data layers that will be delivered to the state and, 

ultimately, to the NTIA.  Following are the detailed instructions used in this process.  

 

3.5.2 Point Data 

3.5.2.1 Subscriber Location – Address Data 

In the event that the data provider supplies subscriber address data the following actions occur: 

1) First, convert the address data to a clean Excel spreadsheet in an appropriate address data format. 

a) Usually, this has the following columns: street address (number, pre-directional, pre-modifier, street 

name, street type, post-directional, and post-modifier concatenated together), city, state, ZIP. 

2) Configure the ArcGIS geocoding tool to use the TIGER 2009 streets dataset 

a) In ArcCatalog, create a new Address Locater by right-clicking in the white space of the appropriate 

directory and selecting New>Address Locater from the dropdown menu. 

b) Select “US Streets with Zone” and press OK. 

i) Note: It is likely that multiple Address Locators will have to set up to handle the variety of 

provider address data received. 

c) Navigate to the TIGER Streets 2009 file and press OK. 

d) Fill in the dialog box as seen below: 
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e) Click OK. 

3) Open up ArcMap, and add the Excel spreadsheet with the address information. 

4) Right-click on the Excel spreadsheet and select Geocode Addresses from the dropdown menu. 

5) Select the appropriate address locator by clicking Add…. then OK. 
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6) Fill out the Geocode Addresses dialog box as shown below: 

 

 
 

7) Geocode the list in batch mode using the geocode service set up in Step 2 above, accepting all the default 

parameters. 

8) Review results. 
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9) Adjust geocoding parameters accordingly and repeat batch to resolve issues. 

10) Manually geocode unmatched addresses until target hit rate achieved, generally 90%. 

11) Visually inspect the data as seen below: 
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12) Follow the steps detailed in Subscriber Location – GIS Data below 

 

3.5.2.2 Subscriber Location – XY Data 

If the provider supplies a list of subscriber data with accompanying XY data such as latitude and longitude, the 

steps are as follows: 

1) Refine the format in Excel so that the data can easily be opened using ArcMap. 

a. Remove all font color, highlighting, cell colors and borders, clean up column headers and make 

sure there are no merged cells. 

b. Make sure that XY locations are in decimal degrees. 

i. To convert from degrees, minutes, seconds (39º 26’ 45.67”) to decimal degrees us the 

following formula: DD + (MM/60) + (SS.SSS/3600). 

ii. Note: if XY locations from some other coordinate system are provided, you can use 

those in the process below but you must know what the coordinate system is. 

2) Open up the Excel worksheet in ArcMap. 

3) From the menu bar, select Tools>Add XY Data… 
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4) Supply the appropriate fields for the X and Y coordinates, choose the appropriate coordinate system and 

press OK. 

5) Results are an event layer, not a true spatial layer. Export the data by right-clicking the event layer and 

selecting Data>Export Data… from the dropdown menu. 

6) Follow the steps detailed in Subscriber Location – GIS Data below. 

 

3.5.2.3 Subscriber Location – GIS Data 

If the provider supplies subscriber location in GIS format, the only process step is to load that data into the 

appropriate data schema and it will be ready for processing. 

1) First, load the data into the Point Address database schema (please see Appendix D for an example of the 

Point Address database schema.) using an empty feature class in that schema. 

2) In ArcCatalog, right-click on the empty feature class and select Load from the dropdown menu. 

3) Navigate to the provider address GIS data set and then map the attribute fields accordingly, as seen in 

general below: 
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4) Once you have successfully loaded the provider address data into the temporary database with the 

correct schema, you will now append that data to the overall Point Address database. 

5) In ArcToolbox, use the Append command (Data Management Tools>General> Append) to add the 

features into the overall Point Address database, as seen in general below: 
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6) Since the data is already in the Point Address database schema, there is no n need to alter the Field Map 

in the Append tool. 

7) After appending, calculate metadata reflecting geometry source and representation values. 

8) Break provider-specific points into separate county feature classes and perform the following steps per 

county feature class: 

a. Within ArcGIS 

i. Summarize download and upload speeds [first,last] to determine all speeds available for 

county. 

1. This will save as a DBF table. Keep track of location for future reference. 

ii. Buffer county address point featureclass to 150’.     

1. During buffer command, dissolve on “ad_down”; ”ad_up”; ”provider”; “dba”; 

“frn”; “tt”; ‘all metadata fields’; “stctyfips”.    Save as…. 

county_fastestdown_fastestup.  

2. (Example using Qwest data: boulder_40128_20128, where boulder=county;  

40128=ad_down; 20128=ad_up) 

3. Note: these attribute fields are specific to the Point Address database. 

iii. Select the features that represent the lowest speeds 

b. Using XtoolsPro (http://www.xtoolspro.com/)  

i. In the XTools Pro toolbar, select XTools Pro>Layer Operations>Erase Features 

ii. Use the same feature class for Input and Overlay 

iii. Check Use selected features on the Input feature, as seen below. 

http://www.xtoolspro.com/
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iv. Repeat and erase slowest speeds one speed at a time.  Saving each new feature class as 

the next slowest speed, using the same naming convention as above. A general example 

is seen below: 

 

 
 

c. Within ArcGIS 

i. Edit/delete speeds from the attribution table of each feature class, so each remaining 

feature class has only one speed value. 

ii. Merge individual speed feature classes together using the Merge command in 

ArcToolbox (Data Management Tools>General>Merge). The dialog box is seen below:  
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iii. Merge individual county feature classes together using the Merge command in 

ArcToolbox (Data Management Tools>General>Merge).  

iv. Since the county files are all in the same schema, do NOT alter the Field Map portion of 

the command interface. 

v. When all the county files are merged together into one dataset, use the Append 

command in ArcToolbox (Data Management Tools>General>Append) to add the 

features to the bb_cov interim data set. Use the Field Map portion of the Append tool to 

map the appropriate field values to their corresponding fields in the bb_cov feature 

class. 

 

3.5.2.4 DSLAM or Central Office Location – Address Data 

In the event that the provider supplies DSLAM (digital subscriber line access multiplexer) or Central Office address 

data please follow the steps below: 

1) Follow the process for geocoding points in Subscriber Location – Address Data, above. 

2) Follow the steps detailed in DSLAM or Central Office Location – GIS Data below. 

 

3.5.2.5 DSLAM or Central Office Location – XY Data 

In the event that the provider supplies DSLAM (digital subscriber line access multiplexer) or Central Office XY data 

please follow the steps below: 

1) Follow the process for creating points from XY data  in Subscriber Location – XY Data, above. 

2) Follow the steps detailed in DSLAM or Central Office Location – GIS Data below. 
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3.5.2.6 DSLAM or Central Office Location – GIS Data 

In the event that the provider supplies DSLAM (digital subscriber line access multiplexer) or Central Office GIS data 

please follow the steps below: 

1) Buffer the DSLAM/Central Office points feature class 

a) Add the point feature class to ArcMap 

b) Open up ArcToolbox and go to Analysis Tools>Proximity>Buffer 

c) Set the buffer distance to 5 miles 

d) Set the dissolve type to ALL 

e) Name the output feature class 

f) Typical Buffer tool is seen below: 

 

 
 

g) Press OK 

2) Use the resulting buffer feature class to clip the TIGER street layer (as described earlier): 

a) Add TIGER street layer to ArcMap 

b) Open up ArcToolbox and go to Analysis Tools>Extract>Clip 

c) Complete the dialog box as seen below: 
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d) Press OK. 

3) Using ArcCatalog and within the file geodatabase: 

a) Right Click and create a new Feature Dataset  

i) For the Feature Dataset settings: 

(1) Name the feature dataset accordingly 

(2) Select horizontal coordinate system by importing the coordinate system associated with the 

clipped TIGER street layer by selecting Import and navigating to the location of that feature class 

(3) No vertical coordinate system needed 

(4) Leave all x,y,z,m values at default. 

(5) Press Finish 

4) Import previously created street feature class into new Feature Dataset 

5) Right-click Feature Dataset and create new Network Dataset – accept all default setting for the Network 

Dataset 

a) Note: the Network Analyst extension must be turned on 

6) In ArcMap Turn on the Network Analyst Toolbar by going to View>Toolbars>Network Analyst 

7) Add the Network Dataset created in Step 5 to ArcMap 

8) Using Network Analyst Toolbar drop down – create “New Service Area” 

9) Open up the Network Analyst Window by selecting the  button. 
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10) Right click Facilities layer, select Load Locations, and navigate to the DSLAM/Central Office facilities feature 

class. 

 
 

11) Press OK. 

12) Click the Service Area Properties button  

13)  For the following tabs change the following properties: 

a) “Polygon Generation” tab  

i) Select “Merge by break value”  

ii) Also disable the Trim Polygons option 

b) “Analysis Settings” tab – using and converting the specified DSLAM buffer distance from feet to meters – 

input buffer distance value in meters into the “Default Breaks” location 
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i) Generally, 18,000 feet (5486 meters) from DSLAM or Central Office location is used as the buffer 

distance 

 
 

c) Click OK. 

14) On the Network Analyst Toolbar click the “Solve” button  to create service area polygons. 

15) Right-click on the created service are polygon in the layer list, and select Data>Export Data from the dropdown 

list. 

16) Export to a feature class in the file geodatabase you created earlier 

17) In ArcCatalog, create an empty feature class with the schema of the bb_cov feature class and load the feature 

class created in Step 16 into it. 

a) Right-click on the empty feature class, select Load>Load data from the dropdown menu and navigate to 

the location of the service area feature class 

b) Press the Add button, hit Next 

c) Accept the defaults and hit Next 

d) Do NOT attempt to map any fields, as seen below: 
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e) Press Next, then Next again, then Finish. 

18) In ArcToolBox, go to Data Management Tools>General>Append 

19) Append the formerly empty feature class to bb_cov, completing the dialog box as seen below: 
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20) Leave the Schema Type as TEST 

21) Press OK. 

22) In ArcMap, open up bb_cov for editing and manually input associated attribution. 

 

3.5.2.7 Broadcast Tower Location – Address Data 

In the event that the provider supplies wireless broadcast tower location address data please follow the steps 

below: 

1) Follow the process for geocoding points in Subscriber Location – Address Data, above. 

2) Follow the steps detailed in Broadcast Tower Location – GIS Data below. 

 

3.5.2.8 Broadcast Tower Location – XY Data 

In the event that the provider supplies wireless broadcast tower location XY data please follow the steps below: 

1) Follow the process for creating points from XY data  in Subscriber Location – XY Data, above. 

2) Follow the steps detailed in Broadcast Tower Location – GIS Data below. 

 

3.5.2.8.1 Broadcast Tower Location – GIS Data 

In the event that the provider supplies wireless broadcast tower location GIS data please follow the steps below: 

1) Download the required software (Radio Mobile) from the website: 

http://www.cplus.org/rmw/english1.html  

2) Install the software according to the standard directions, found here: 

http://www.cplus.org/rmw/download/download.php?S=1  

3) Open up the application 

4) Load the broadcast tower location and elevation information by selecting File>Unit properties. The 

following dialog box appears: 

 

http://www.cplus.org/rmw/english1.html
http://www.cplus.org/rmw/download/download.php?S=1
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5) Add in the information for all the towers supplied by the WISP data provider, including the elevation. If 

provider does not supply elevation, this information can be obtained from Google Earth. 

a. I f available, use the Import button to import a Google Earth KML of the tower locations. 

6) Go to the National Map Seamless Server (http://seamless.usgs.gov/) and download elevation data 

sufficient to contain the tower locations. 

a. At least the 1/3” NED data is needed. Select this by clicking the Download button in the upper 

right of the web site and checking the box nect to 1/3 “ NED. 

b. Zoom to the area of interest and use the Download tools: 

 
to define the area to download. 

c. Click the Modify Data Request button to request the data in BIL_16INT format, not ESRI GRID, as 

seen below: 

 

http://seamless.usgs.gov/
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d. Download the data and unzip it. 

7) Select File>Map Properties to define the map 

8) Enter in a latitude and longitude in the center of the tower locations 

9) Set the size (in pixels) and the size (in kilometers) of the map 

10) Set the directory path leading to the BIL elevation data just downloaded 

11) The dialog box is seen below: 
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12) Hit Extract. 

13) The elevation data is render as a hill shade, as seen below: 

 

 
 

14) Select File>Network properties from the main menu 

15) Create a new network and enter in the frequency range under the Parameters tab, as seen below: 
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16) Leave all the other values as they appear, and select the Systems tab 

17) Create enough systems to cover all the varieties of equipment in the provider network. This will include 

the antenna type, height, and line loss, as seen below: 
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18) Now click on the Membership tab, and assign the individual towers to their respective systems, providing 

the azimuth for non-omnidirectional antennas, as seen below: 
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19) Press OK. 

20) Select Tools>Radio Coverage>Combined Cartesian from the main menu 

21) Complete the dialog box as seen below, providing the Maximum Range from the highest tower beam 

radius supplied by the provider. 

22) Set the Pixel Size at 5 (experiment depending on the area covered to get the right level of granularity) as 

seen below: 
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23) Set the signal range to draw to S-Unit and type 5 in the From (>=) box. 

24) Press Draw. 

 

 
 

25) Save the resulting image as a TIF by selecting File>Save Picture as. 

26) Open ArcMap and load the BIL elevation data you used in Radio Mobile. 

27) Load the TIF image you created and georeference it using the corners of the BIL data. 
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a. The corners of the data can be seen in the TIF image. 

28) Follow the georeferencing directions from the Coverage Area – PDF/JPG/Other Image Format section 

below. 

29) Use the Georeferencing Toolbar to Update the Georeferencing for the TIF data set. 

30) In ArcToolbox, select Data Transformations>From Raster>Raster to Polygon and input the georeferenced 

TIF you just created as seen below: 

 

 

31) Open the resulting polygon feature class up for editing using the Editing toolbar in ArcMap and clean up 

as necessary. 

32) In ArcCatalog, create an empty feature class with the schema of the bb_cov feature class and load the 

feature class created above into it. 

a. Right-click on the empty feature class, select Load>Load data from the dropdown menu and 

navigate to the location of the service area feature class 

b. Press the Add button, hit Next 

c. Accept the defaults and hit Next 

d. Do NOT attempt to map any fields, as seen below: 

 

 
 

e. Press Next, then Next again, then Finish. 

33) In ArcToolBox, go to Data Management Tools>General>Append 

34) Append the formerly empty feature class to bb_cov, completing the dialog box as seen below: 
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35)  Leave the Schema Type as TEST 

36) Press OK. 

37) In ArcMap, open up bb_cov for editing and manually input associated attribution. 

 

3.5.3 Linear Data 

3.5.3.1 TIGER Street Segments – List, Spreadsheet, or GIS Data 

In the event that the provider supplies TIGER street segments in list or spreadsheet format please follow the steps 

below: 

1) Join TIGER road segments  to 2000 census blocks feature class using one of two methods based on how 

the data is provided: 

a) If the TIGER data is provided with a Census Block ID, then join the segments to the Census Block 

geometry based on that ID 

i) Load both data sets into ArcMap 

ii) In the layer list, right-click on the 2000 census block feature class and select Joins and 

Relates>Join 

iii) In the dialog box, select the TIGER road segments data and the proper attribute fields for joining, 

as seen below: 
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iv) Press OK 

b) If the data provided is a list containing TLIDs,  then join to the TIGER line data using the TLID, and use 

a spatial join to associate the TIGER segment with the coterminous block based on the block ID 

i) Load both data sets into ArcMap 

ii) In the layer list, right-click on the 2000 census block feature class and select Joins and 

Relates>Join 

iii) Select “Join data from another layer based on spatial location” from the dropdown menu 

iv) Complete the dialog box as seen below and press OK. 
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2) Export joined records into a temporary feature class. 

3) If joined Census Block geometry is confined to one specific area then dissolve blocks into one record.  If 

joined Census Block geometry is distributed throughout a particular state then dissolve sub-selections of 

census blocks for each county. 

a) Use the County FIPS code to dissolve by county. 

b) In ArcToolbox, select Data Management Tools>Generalization>Dissolve 

c) Complete the Dissolve dialog box as seen below: 
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d) Press OK. 

4) For each dissolved region, open up the feature class for editing using the Editing tool in ArcMap and 

remove unnecessary slivers and other small holes.  For general guidance on editing features in ArcMap, 

see http://webhelp.esri.com/arcgisdesktop/9.3/pdf/Editing_Tutorial.pdf  

5) In ArcCatalog, create an empty feature class with the schema of the bb_cov feature class and load the 

feature class created above into it. 

a) Right-click on the empty feature class, select Load>Load data from the dropdown menu and navigate 

to the location of the service area feature class 

b) Press the Add button, hit Next 

c) Accept the defaults and hit Next 

d) Do NOT attempt to map any fields, as seen below: 

 

http://webhelp.esri.com/arcgisdesktop/9.3/pdf/Editing_Tutorial.pdf
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a) Press Next, then Next again, then Finish. 

6) In ArcToolBox, go to Data Management Tools>General>Append 

7) Append the formerly empty feature class to bb_cov, completing the dialog box as seen below: 
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8)  Leave the Schema Type as TEST 

9) Press OK. 

10) In ArcMap, open up bb_cov for editing and manually input associated attribution if necessary. 

 

3.5.4 Polygonal Data 

3.5.4.1 Coverage Area – PDF/JPG/Other Image Format 

In the event that the provider supplies coverage area data in some image format such as PDF or JPG format please 

follow the steps below: 

1) If in PDF format, open in Adobe Acrobat and Save As… JPG format. 

2) Open up the JPG image in ArcMap. 

3) Add the required basemap vector data for georeferencing. 

a) This will generally be either the CDOT data or TIGER data 

4) Change the coordinate system of the data frame to the desired end coordinate system 

5) Zoom to the general location of the JPG map image 

a) This is the location based on the vector data, not the JPG image itself. For example, if you know that 

the JPG image represents an area around the town of Limon, zoom to the town of Limon in your 

vector data. 

6) Open up the Georeferencing toolbar by selecting View>Toolbars>Georeferencing from the main menu bar. 

7) Using the Georeferencing toolbar, select Fit to Display, results seen below: 

 

 
 

8) Use the Control Point button  to add control points to the map 

9) Use common points in the base data set and the JPG image 

a) For example, find major street intersections, county/city boundaries, etc. 

b) Try to distribute the points more or less in the four corners on the image for the best transformation 
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10) Click on the location on the image first, then click on the corresponding location on the vector data base 

map, as in the image below: 

 

 
 

11) After placing each control point, the image transformation will update automatically.  

12) Repeat until satisfied with the transformation. 

a) Note: The transformation may take up to four points, although sometimes only two are necessary. 

13) When satisfied with the transformation, select Update Georeferencing from the Georeferencing toolbar 

dropdown. 

a) This will create a “world” file (.jgw in the case of JPGs) in the same directory as the image file. 

14) In ArcCatalog, create a new polygon shapefile with the appropriate data schema for a provider coverage 

area, which can be found in Appendix D. 

15) Add the shapefile to ArcMap. 

16) Using the Editor Toolbar, select Start Editing. Set the Task: to “Create New Feature.” 

17) Use the Sketch Tool  to digitize a new coverage polygon using the coverage area outline from the 

georeferenced JPG and add the required attributes manually. 

18) Repeat the above steps for all subscriber speed coverage areas provided. 

19) Follow the steps detailed in Coverage Area – GIS Data below. 
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3.5.4.2 Coverage Area – KML/KMZ 

In the event that the provider supplies coverage area data in Google Earth KML or KMZ format please follow the 

steps below: 

1) Use a KML to SHP converter to translate file into an ESRI format 

2) http://arcscripts.esri.com/details.asp?dbid=15603  

3) Download the script and follow the provided instructions for installing it in ArcToolbox. 

4) Double-click on the script in ArcToolbox and navigate to the location of the KML file, as seen below: 

 

 

5) Add the new shapefile to ArcMap. Repeat for all KML files provided. 

6) Follow the steps detailed in Coverage Area – GIS Data below. 

 

3.5.4.3 Coverage Area – CAD Data 

In the event that the provider supplies coverage area data in GIS format please follow the steps below: 

1) Transform the CAD dataset into an ESRI format 

2) http://webhelp.esri.com/arcgisdesktop/9.2/index.cfm?TopicName=Transforming_CAD_datasets 

3) It may be necessary to contact the provider first to determine the coordinate system of the CAD data. 

4) If the CAD data is not in a standard coordinate system, it may be necessary to use ArcMap to 

georeference the CAD data to a known coordinate system first. 

a) To do so, follow the instructions provided above in “Coverage Area – PDF/JPG/Other Image Format.” 

5) In ArcCatalog, create a new polygon shapefile with the appropriate data schema for a provider coverage 

area, which can be found in Appendix D. 

6) Add the shapefile to ArcMap. 

7) Using the Editor Toolbar, select Start Editing. Set the Task: to “Create New Feature.” 

8) Use the Sketch Tool  to digitize a new coverage polygon using the coverage area outline from the 

georeferenced CAD file and add the required attributes manually. 

9) Follow the steps detailed in Coverage Area – GIS Data below. 

http://arcscripts.esri.com/details.asp?dbid=15603
http://webhelp.esri.com/arcgisdesktop/9.2/index.cfm?TopicName=Transforming_CAD_datasets
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3.5.4.4 Coverage Area – GIS Data 

In the event that the provider supplies coverage area data in GIS format please follow the steps below: 

1) In ArcCatalog, create an empty feature class with the schema of the bb_cov feature class and load the GIS 

feature class either created above or supplied by the provider into it. 

a) Right-click on the empty feature class, select Load>Load Data from the dropdown menu and navigate 

to the location of the service area feature class 

b) Press the Add button, hit Next 

c) Accept the defaults and hit Next 

d) Do NOT attempt to map any fields, as seen below: 

 

 
 

e) Press Next, then Next again, then Finish. 

2) In ArcToolBox, go to Data Management Tools>General>Append 

3) Append the formerly empty feature class to bb_cov, completing the dialog box as seen below: 
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4) Leave the Schema Type as TEST 

5) Press OK. 

6) In ArcMap, open up bb_cov for editing and manually input associated attribution, if necessary. 

 

3.5.4.5 Compact Polygon From Subscriber Points  

 Geo-code address list using latest state “Composite Locator”  

 

 Verify that your geo-coded file has only one TT (Technology Type).  If not export individual geo-coded 

layers for each Technology Type. 

 

 For each TT check for differences in speed values or speed tiers and create separate layers for each speed 

value/tier. 

 

 Clean your geo-coding results - remove any points that geo-code to accuracy levels below ZIP+4 (ZIP 

centroids, carrier route centroids, etc).  Also, verify that outliers with acceptable accuracy levels are 

legitimate, i.e. fall in correct City and Zip.   

 

 Perform spatial join between county polygons (using stcnyfips field) and the cleaned geo-coded subscriber 

points, in order to carry the county name and stcnty fips. 

 

 Summarize the number of subscribers by county and use the subscriber counts by county to populate the 

Rate Tier table. 
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 Un-join the county data from the geo-code subscribers list. 

 

 Create Compact Polygon using cleaned geo-coded layer or sub-selection of using – XtoolsPro – 

ConvexHull-DetailedHull option.  A sub-selection of geo-coded points will be used in areas where more 

than one polygon will need to be created for one provider’s service area.   

 

 Evaluate output Hull carefully – looking for areas that should not be covered by hull polygon.   

 

o If it is determined that an area or areas should not be represented in coverage area, manually 

reshape hull polygon until coverage area is adequate.   

 

o When not obvious and as a general rule, manually resolve compact polygon when the distance 

between the subscriber points used to define the outer boundary of the compact polygon 

exceeds 5 miles .  When reshaping the hull polygon, snap to the outermost geo-coded points.  

See figure 2 and 3 for an example. 

 

FIGURE 2- Compact Hull: Manual Resolution Required            
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FIGURE 3a- Compact Hull: Manual Resolution Required           FIGURE 3b- Compact Hull: After Manual Resolution        

                       
 

 To attribute the compact polygon - Perform a “Spatial Join” where your Target Feature Class is the 

compact polygon and the Join Feature Class is your geo-coded point layer.  Export compact hull with 

joined attributes and name file appropriately.   

 

 Append attributed compact polygon to BroadBand TT template Feature Class and if required manually 

input any provider attribution that may not have carried over in the append process. 

 

 Intersect compact polygon with county boundaries to create unique records by county and use the state-

county-fips field to populate “stcty_fips” field.  Also use the county name field to populate the 

“BBCov_Name” field.   

 

o Exceptions is where a provider’s coverage is distributed throughout more than one area of any 

given county where the “BBcov_Name” should be populated using an appropriate city or other 

logical name based on geographical location.  

 

 Export/Load into appropriate BB TT model Dataset. 
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3.5.4.6 Census Blocks – List or Spreadsheet 

In the event that the provider supplies census block data in a list or spreadsheet, please follow the steps below: 

1) Ensure block polygons supplied by the provider are 2000 currency 

2) If other currency, convert to 2000 currency before proceeding 

a. To do this, remove the trailing letter (a, b, etc.) from the block ID 

b. You will now have two blocks that equate to one block in the 2000 block geometry 

c. Delete duplicate block IDs, retaining the higher service tier in each case 

3) Prepare the block list in clean Excel format, removing all Excel-only formatting, merged cells, colors, 

borders, etc. 

4) Import the spreadsheet into ArcMap. 

5) Right-click on the 2000 census block feature class in the layer list in ArcMap and select  Joins and 

Relates>Join from the drop down menu. Join the census block list to the 2000 census blocks feature class 

using the block ID and export joined records in a new feature class. The Join dialog box and process can be 

seen above in the TIGER Street Segments – List, Spreadsheet, or GIS Data section. 

6)  Follow the steps in Census Blocks – GIS Data below. 

 

3.5.4.7 Census Blocks – GIS Data 

In the event that the provider supplies census block GIS data please follow the steps below: 

 

1) Ensure that the blocks supplied by the provider are in the required data schema and are complete as far 

as require attribution. 

a. If not, manually enter the required attribution or contact the provider to fill gaps. 

2) If census block geometry is distributed throughout more than one county then select Data Management 

Tools>Generalization>Dissolve in ArcToolbox and dissolve based on County/Provider/TT/Speed Tier so 

that unique records are created for each unique combination. 

a. The dissolve dialog box can be seen above in the TIGER Street Segments – List, Spreadsheet, or 

GIS Data section. 
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Figure 1: Undissolved census block polygons 

 

 
Figure 2: Census block polygons dissolved by county 

 

 

2) For each dissolved region use the Editing toolbar in ArcMap to remove unnecessary slivers and other 

small holes.   

3) In ArcToolbox, select Data Management Tools>General>Merge and merge the processed polygons 

together into single layer. 

4) The merged census blocks will need to have the subscriber’s “frn” field added and populated. 

5) In ArcCatalog, create an empty feature class with the schema of the bb_cov feature class and load the GIS 

feature class either created above or supplied by the provider into it. 
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a. Right-click on the empty feature class, select Load>Load Data from the dropdown menu and 

navigate to the location of the service area feature class 

b. Press the Add button, hit Next 

c. Accept the defaults and hit Next 

d. Do NOT attempt to map any fields, as seen below: 

 
 

e. Press Next, then Next again, then Finish. 

6) In ArcToolBox, go to Data Management Tools>General>Append 

7) Append the formerly empty feature class to bb_cov, completing the dialog box as seen below: 
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8) Leave the Schema Type as TEST 

9) Press OK. 

10) In ArcMap, open up bb_cov for editing and manually input associated attribution, if necessary. 

 

3.6 Metadata Transactions 

Following any updates or changes completed within the file geodatabase (fGDB) stored on the GIS-Analysts staging 

environment, the GIS-Analyst runs transactions to compare that fGDB with the one stored on the Core server to 

ensure metadata on all changes are recorded. 

 

Below outlines the steps taken to run transactions on the updated Core database: 

  

1. Open a command line window and run generateTransactions.py  

a. Usage: generateTransactions.py  [Core fGDB] [Staging Environment fGDB]  

 

b. Example of command line:  

 

<path>generateTransactions.py <path>ST_BB_POLY_SRV_AREAS.gdb <path>ST_BB_POLY_SRV_AREAS.gdb  

 

2. Below is an example of the output screen that will be displayed: 
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3. After process has completed, results can be found in the ST_BB_POLY_SRV_AREAS_HIST.gdb  

a. The transactions scripts records changes at a feature level. 

b. Below is a screen shot supporting the directory structure of the historical fGDB. 
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c. Attribution associated with each added/removed/changed features is tracked, including the 

following additional columns appended to the end of each: 

i. Commit_by 

1. Records the GIS-Analyst that committed the changes to the historical fGDB. 

 

ii. Commit_date 

1. Records the date and time stamp that the changes were committed. 

 

iii. Trans_type 

1. This field reflects the type of change recorded. 

2. Categorized by: 

a.  Adds/Change/Deletes 

 

iv. New_values 

1. Records the new values when a change was completed on a feature.  Example:  

Name or speed change 
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d. MD_Process is also transferred from the edited fGDB to the historical fGDB, which states the 

actions completed by the GIS-Analyst. 
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3.7 Data Processing 

3.7.1 Data Processing Overview 

The following items outline the actions required to process the service provider data further to meet the NTIA 

requirements. 

 Weighted Nominal Speed 

 Middle Mile 

 Broadband Coverage Template 

 

3.7.2 Weighted Nominal Speed 

The weighted nominal speed is populated one of the following two ways: 

3.7.2.1 Subscriber Data Supplied by Provider 

Where we are supplied with subscriber speed information by the data provider, we use the following formula from 

the NOFA: 

(speed tier-1 in kbps × no. of tier-1 subscribers) + (speed tier-2 in kbps × no. of tier-2 subscribers) + (etc.) 

Total average monthly subscribers 

 

 

Data is initially broken up in the following order: 

1) Stcty_fips 

2) Transmission technology type 

3) Subscriber tiers 

 

3.7.2.2 Value Supplied by Provider 

Some providers will supply their weighted nominal speed.  In these cases, the data supplied will be populated 

instead of using the NOFA formula. 

When these values have been obtained or calculated, they are used to update the service overview layer. This can 

be done manually or by creating a table with the provider’s FRN and average weighted speed and joining it to the 

service overview table in ArcMap. To Join, right-click on the layer you would like to join to and select Joins and 

Relates>Join… from the dropdown menu. Then navigate to the table you want to join and select the join fields 

from the drop down lists. Then open up the source table (the table in ArcMap) and right-click on the header of the 

Average Weighted Speed field and select Calculate Field from the drop down menu. Use the value of the average 

weighted speed from the joined table. 

3.7.3 Middle Mile 

Middle mile information is generally provided in spreadsheet or text file format. The process is to take what is 

supplied by the provider and translate it into the required data schema.  

1) If the data is supplied with address information, follow the process outlined above in Subscriber Location 

– Address Data.  
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2) If the data is supplied with associated XY coordinates, follow the process outlined above in Subscriber 

Location – XY Data.  

3) Once the data is in GIS format, use the Append (Data Management Tools>General>Append) command in 

ArcToolbox to append the data to the overall middle mile dataset. 

4) Set the schema type to NO_TEST and use the Field Map to map the attribute fields from the source to the 

target dataset. 

3.7.4 Broadband Coverage Template 

Below is the description of the fields within the BB_Cov layer, which is the interim data set that is used to create 

the final product deliverable. 

 

Name Alias Description 

objectid OBJECTID Internal Object ID 

shape SHAPE Internal Shape storage 

prov_id PROVIDER_ID Unique numeric identifier for each provider 

prov_name PROVIDER_NAME Unique name for each provider 

dba_name DOING_BUSINESS_AS An alternative "Doing-Business-As" name for the provider 

frn 
FCC_REGISTRATION_NUMBE

R 
Provider FCC Registration Number 

bbcov_name BBCOV_NAME BroadMap Broadband Coverage name 

trans_code TRANSMISSION_CODE 
Unique code for the transmission technology type described by 

this layer 

trans_name TRANSMISSION_NAME Name for the transmissions technology type 

trans_desc TRANSMISSION_DESC Description for the transmissions technology type 

spect_code SPECTRUM_CODE Unique code for the spectrum [WIRELESS ONLY] 

spect_name SPECTRUM_NAME Name for the spectrum [WIRELESS ONLY] 

spect_desc SPECTRUM_DESC Description for the spectrum [WIRELESS ONLY] 

mad_dwn_t MAX_AD_DOWN_TIER 
Maximum advertised downstream speed available within given 

area (speed tier) 

mad_up_t MAX_AD_UP_TIER 
Maximum advertised upstream speed available within given 

area (speed tier) 

typ_dwn_t TYPICAL_DOWN_TIER 
Typical downstream speed available within given area (speed 

tier) 

typ_up_t TYPICAL_UP_TIER Typical upstream speed available within given area (speed tier) 

mad_dwn_k MAX_AD_DOWN_KBPS 
Maximum advertised downstream speed available within given 

area (kbps) 
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Name Alias Description 

mad_up_k MAX_AD_UP_KBPS 
Maximum advertised upstream speed available within given 

area (kbps) 

typ_dwn_k TYPICAL_DOWN_KBPS Typical downstream speed available within given area (kbps) 

typ_up_k TYPICAL_UP_KBPS Typical upstream speed available within given area (kbps) 

subs SUBSCRIBERS 
Total average monthly subscribers for this provider for this 

technology for this coverage polygon 

md_geom MD_GEOMETRY 
Metadata: Comma separated list of source id's from which the 

polygon extent was produced 

md_exists MD_EXISTS 
Metadata: Comma separated list of source id's used in 

understanding and editing the provider data for this polygon 

md_who MD_WHO 
Metadata: Name of the editor who last edited this feature at 

the time in md_when 

md_when MD_WHEN Metadata: Date/timethat this feature was last edited 

md_process MD_PROCESS 
Metadata: Comma separated list of processed used to create 

and/or modify this layer 

stcty_fips STATE_COUNTY_FIPS State/County FIPS code 

rec_id RECORD_ID 

Compound Key formed from 

STCTY_FIPS+"|"+Provider_ID+"|"+Trans_Code+"|"+BBCov_Nam

e 

st_area ST_AREA(SHAPE) Area in square decimal degrees  

st_length ST_LENGTH(SHAPE) Length in decimal degrees  

Provider_Typ

e 
Type of Provider 

Has Subtype (1:Broadband provider as described in the 

NOFA,2:Reseller,3:Unknown), default value = 1  (New 04/11 

Model) 

 

3.7.5 Verification and Validation 

3.7.5.1 Provider Validation – Provider Portal/PDF Map Review 

Following the collection and aggregation of provider data, the data is then validated by the provider to ensure the 

data aggregated is an accurate representation of their coverage area and supporting broadband information. 

This is completed through the Provider Portal web application, which is a secure interactive map displaying their 

coverage areas and allows the user to validate, submit feedback or request changes.  If changes are requested, 

then the features on the portal are then updated and an automatic request is sent to the provider to complete the 

validation effort. 
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For some providers that did not use the Provider Portal, a PDF was sent displaying their coverage map and 

validation was then completed via e-mail notification.   

 

 

 

 

 

3.7.5.2 Provider Verification – 3rd Party Source Review 

Once the provider has validated their coverage areas, a 3
rd

 party source comparison and analysis is then 

performed.  Where anomalies or discrepancies are identified, a ‘SCAN’ point is dropped and descriptive comments 

applied so they can later be reviewed with the provider. 

 

During the provider review, the map is displayed along with the ‘SCAN’ points and potential refinement is 

completed based on input from the Provider. 

 

3
rd

 Party Sources Utilized 

3
rd

 Party Source Name Source Type Verification Type 

InfoUSA Consumer and Business 
Listings 

Community Anchor Institutions 
Can also be used for demographic information supporting 
the State websites 

Pitney Bowes (PBBI) Exchange Info Plus 
(Central Office Locations) 

Exchange datasets are used to verify the following 
Transmission Technologies (TT): 
Asymmetric xDSL (10), Symmetric xDSL (20), Other Copper 
Wireline (30), and Optical Carrier/Fiber to the End User 
(50). 
 

Media Prints Cable Boundaries Used to verify the following TT: 
Cable Modem—DOCSIS 3.0 (40) and Cable Modem—Other 
(41) 

American Roamer  Wireless Coverage 
Patterns (EVDO, GPRS, 
WISP, HSPA) 

Used to verify the following TT: 
Terrestrial Fixed Wireless—Unlicensed (70), Terrestrial 
Fixed Wireless—Licensed (71) and Terrestrial Mobile 
Wireless (80) 

ComSearch Wireless Spectrum 
Holdings and Tower Data 

Used to verify the following TT: 
Terrestrial Fixed Wireless—Unlicensed (70), Terrestrial 
Fixed Wireless—Licensed (71) and Terrestrial Mobile 
Wireless (80) 
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3.7.5.3 Assigning Confidence Values 

All efforts from the above-mentioned validation and verification activities, plus internal peer quality reviews are 

combined and tracked in a Validation table.  Based on the results of this analysis, a confidence value is assigned for 

each provider and then each technology.   

 

The confidence values are as follows:  
0     = Coverage area has not been reviewed 
10   = Extremely Low.   Single Source QC.   
20   = Very Low.  Needs Additional Validation\Verification 
30   = Low.   Even with Validation\Verification, Coverage is still suspect. 
40   = Acceptable, confirm with State prior to shipment.    
50   = Meets requirements to be included in shipment. 
60   = Moderate.  Meets NTIA/State’s standards, representative of Technology Type (TT) 
70   = High.   Accurate representation of coverage based upon TT. 
80   = Very High.  Multiple validation\verification with most 3

rd
 party sources 

90   = Extremely High. Multiple validation\verification sources 
100 = Perfect.  Multiple validation\verification sources, with complete alignment with sources and ground 
truth verification activities 

 

This Validation table is then maintained as updates or changes occur for each provider, down to technology type, 

with the overall goal to improve the confidence values and overall map representation. 

 

Example of the Validation table: 
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3.7.6 Community Anchor Institution (CAI) Data 

3.7.6.1 Data Collection 

The CAI data was initially collected from the State to create the baseline inventory.  All location information and 

broadband coverage data supplied was also ingested into the data deliverable. 

Additional collection of CAI information was done via data mining and/or webscraping to build out the inventory 

further.  For example:  Collection of additional CAIs, address and broadband data. 

 

The state-agency-provided CAI inventory was comprehensive but the challenge is collecting broadband related 

data; service provider(s), technology and speed data for each CAI.  Availability of the CAI portal has not significantly 

increase submission of this data.  Additional promotion to CAIs to utilize the CAI portal will be needed to increase 

this data for subsequent deliverables. 

 

3.7.6.2 Institution Data 

Institution data is obtained from a variety of sources and almost always provided in Excel spreadsheet format. The 

general process for incorporating this data is below: 

1) If the data is provided in Excel or some similar format: 
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a. Clean and standardize the Excel spreadsheet, removing any cell formats, merged cells, etc. 

b. Standardize the address format as defined in the staging CAI database 

c. If the spreadsheet includes X and Y values, such as latitude and longitude, use the Add XY Data 

tool in ArcMap to create a spatial data layer. 

d. If there are only addresses, then follow the geocoding steps outlined above to create spatial data 

points for each of the institutions. 

i. Institutions that do not geocode based on the TIGER 2009 data set will have to be 

manually located using Google Maps, Google Earth, or some other information source. 

2) If the CAI source data is in GIS format, add the Latitude and Longitude fields and use the Calculate 

Geometry tool to populate them, using the WGS 84 coordinate system. 

3) Using ArcCatalog, load the new data into the staging CAI database. 

4) This database is ready for the makeDeliverable.py script to process the information into the final state 

and NTIA deliverables. 

 

3.7.6.3 Community Anchor Institution (CAI) Portal Updates 

A web application has been released to allow for further data collection and validation of anchor institution 

location information, broadband coverage, and speed test data. 

 

Information collected from the CAI Portal is then ingested into the overall inventory and will later be compared 

against the provider coverage areas mapped for any potential discrepancies. 



            

61 

3.8 Product Extract 

3.8.1 Python Scripts 

The following sections make use of Python scripts. In general, to use a Python scrip, you must have Python 

installed on your computer. To download the latest version of Python, go to http://www.python.org/download/ 

and download the latest stable version. As of August 2010, this was version 2.7. Once this is installed, the general 

way to run a script is to type the following at a command prompt: C:\Python27\python.exe C:\<location of script>. 

Many of the scripts provided have environment variables that must be set before they can be run.  

 

The python code for BroadMap’s product extract has been incorporated into a Hudson CI System, which is detailed 

in the Process Operation and Monitoring section of this document.  This was a process improvement activity so all 

processes can be monitored, controlled and contain historical tracking on each process. 

 

3.8.2 Product Extract Process 

Note: specific Python scripts are called out in red font in the sections below. 

The MapConnect product extract process, makeDeliverable.py, uses the BB_Cov and BROADMAP_POINTS interim 

data sets to create the following layers according to the current specifications: 

 BB_Service_Road_Segment 

- This layer contains all broadband services associated with specific street segments for census 2000 

blocks larger in area than two square miles 

 BB_ServiceCensusBlock 

- Contains all broadband services associated with census blocks of no greater than two square miles. 

 BB_Service_Wireless 

- This layer contains all wireless services not associated with specific addresses. 

 BB_ServiceOverview 

- This layer contains subscriber-weighted nominal speed for each provider's service area at a county 

level and is meant to act as a summarized view.  

 BB_ConnectionPoint_MiddleMile 

-   This layer contains middle-mile and backbone interconnection points 

 BB_Service_CAInstitutions 

- Broadband Service at Community Anchor Institutions (CAI) 

 Community Anchor Institutions consist of schools, libraries, medical and healthcare providers, 

public safety entities, community colleges and other institutions of higher education, and other 

community support organizations and entities. 

 

Due to a NTIA model change for the October 2010 data deliverable, an addition to this code was created to 

support both models in the case a comparison is later desired or a request is made to revert back to the original 

model.  This script name is bdia2ntia.py and creates the following layers in addition to the layers mentioned above, 

rolled up to NATL_Broadband_Map. 

http://www.python.org/download/
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 BB_ConnectionPoint_LastMile 

-   This layer contains last mile infrastructure points, which is only populated if data cannot be provided 

at a more granular level. 

 BB_Service_Address 

- Represents broadband availability for service address points.  Address Point availability refers to 

those individual addresses at which each facilities-based provider of broadband service can provide 

broadband services of minimal characteristics within 7 - 10 business days. 

 State_Boundary 

- State boundary supporting topological validation of point feature classes. 

 NATL_Broadband_Topology 

- Supports basic topology quality checking.  Example:  No CAI’s or Middle Mile points outside of the 

state boundary 

 

The following process flow provides a view of how the Core fGDB is extrapolated to the NTIA final deliverable via 

the makeDeliverable.py script.  Following that, the bdia2ntia.py script is run, which limits what’s placed in the final 

layers based on the NTIA modeling standards. 

 

The product scripts and supporting extract were originally created separately per request, in case data model 

comparisons were to be completed.  

 

3.8.3 Product Statistics 

Following the completion of a product extract, the product statistics script (BDIA_ReleaseNotesStats.py) extracts 

the following information supporting that product deliverable. 

 Provider Statistics 

- Collects all provider information, listing by Provider Name 

- Provides output of FRN 

- Counts the number of features supported within the following layers: 

 Census Block 

 Street Segment 

 Max Upstream 

 Wireless Services 

 Infrastructure Points 

- These updates were made to support the Data Package required to accompany every NTIA product 

deliverable. 

 Community Anchor Institution (CAI) Statistics 

- Breaks CAI down to the 8 categories 

 1:  School: K through 12 

 2:  Library 
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 3:  Medical/Healthcare 

 4:  Public Safety 

 5:  University/College 

 6:  Other Government 

 7:  Other Community non-government 

 None:  Unknown Category 

 In cases where this occurs, further investigation is completed prior to product shipment to 

ensure all CAI’s are categorized accurately 

- Reports out the following counts 

 Total CAIs within that category 

 Total CAIs that contain partial BB coverage  

 Contains any of the following information for given CAI: 

 BB Subscriber, Transmission Technology, Speed Down Speed Up 

 Total CAIs that contain full BB coverage 

 Contains all of the above-mentioned BB information for given CAI. 

The output of this script is two CSV files: AnchorInstitutions.csv and Providers.csv. These files can then be 

inspected to ensure that there are the expected number of CAIs and providers for every release. 

 

3.9 Quality Assurance  

Quality assurance is supported manually and algorithmically on the interim data, BB_Cov file geodatabase, and on 

the final product. For scheduled product releases, a test product extract and subsequent manual and algorithmic 

QC run is completed along with a release review.  The product specifications, project status reports, previous 

product release notes are used as references throughout this review. 

The following parameters are tested using the methodology listed below each: 

 Product Deliverable Format  

- Correct names and format of data deliverables 

 BDIA_QC_SUITES (please see below for details) 

- Correct Projections/Datum 

 Manual interaction with product 

- Metadata Present and Correct 

 Manual interaction with product 

 Table Structure 

- All required tables included 

 BDIA_QC_SUITES 

- Extraneous tables identified 

 BDIA_QC_SUITES 

 Field Structure 

- All fields included 
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 BDIA_QC_SUITES 

- Extraneous fields identified 

 BDIA_QC_SUITES 

- Correct field names, types and widths 

 BDIA_QC_SUITES 

 Field Domains 

- Values in all tables are constrained to the specified values specified 

 This action is accomplished via BDIA_QC_SUITES and manual review of the product 

 This tends to identify project completeness issues as fields with a null value are identified. 

 Geometric Representation 

- Identify if all layers have the correct geometric representation 

 Manual review of the BB_ServiceOverview layer 

 Dependent on NTIA and client requirements 

 Geographic Extent 

- Product includes the necessary Geography associated with Product? 

 Manual Review - ArcGIS 

- Is there extraneous geography included in Product? 

 Manual Review - ArcGIS 

 Completeness 

- Products contain the expected amount of data? 

 Manual review of product stats relative to weekly State reports and defined expectations. 

 Accuracy 

- Product meets the stated accuracy requirements for the deliverable? 

 Sampling procedure to manually review source material to resulting product 

 Provider Validation 

 Verification using 3
rd

 Party Data 

 Verification against reality, where applicable 

 Data Regression 

- Any unexplainable data loss or change? 

 This action is accomplished by comparing results within product statistics script 

(BDIA_ReleaseNotesStats.py) from previous releases, as well as manual review of the product 

 Confidentiality 

- Any unauthorized confidential information included in the delivery? 

 Review of NDAs and delivery expectations 

 Prior Issues Resolved  

- Have expected internal issues been resolved? 

 Manual review of data against previous product release notes 

- Have agreed upon customer issues been resolved? 

 Manual review of data against previous product release notes, status report and client feedback 

 Delivery Medium 



            

65 

- Has the product medium been verified? 

 Manual review 

- All files present 

 Manual review of SFTP site to ensure all files are copied correctly, including file/directory size 

- Correct location 

 Manual review – confirmation of SFTP link, username and password 

 

3.9.1 QC Suite 

The BDIA_QC_SUITES consists of four main types of scripts supporting the overall QC process. These scripts are all 

run in concert and are called from the test_runner script and the test_BDIAProductGDB script. 

 

3.9.1.1 Configuration  

These scripts establish the configuration for the test_BDIAProductGDB script which is the core of the QC Suite.  

- update_test_config 

- active_config 

- config_PROCESS01_automated 

- config_PROCESS01_manual 

- set_active_config 

3.9.1.2 Libraries 

These scripts provide additional functionality that is called from with the test_BDIAProductGDB script.  

- bb_unittest_fixture 

- bbcov_structure 

- BC_XmlWriter 

- file_folder 

- search_and_replace 

- unittst_fixture 

- validate_BB_DB 

- validate_BB_GDB 

- xmlrunner_gui 

3.9.1.3 QC Suite 

This is the core script for performing automated QA/QC on the interim and final data deliverables. 

- test_BDIAProductGDB 

3.9.1.4 Other  

These scripts perform other functions detailed below: 

- test_runner – this is the main script that runs all the other QC scripts and imports all the necessary scripts 

and libraries 
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- which_build – this determines the current build and passes information to the configuration scripts 

 

3.10 Process Operation and Monitoring 

Product Extract, makeDeliverable.py and bdia2ntia.py, is run within BroadMap using a platform called Hudson that 

has been enhanced to support BDIA product extraction, process monitoring, as well as product validation.  The 

same platform can be planned for implementation for the State, if desired. 

 

Below are examples of the product create, product validation, product statistics and monitoring processes which 

are managed within the BroadMap Hudson CI-System.  All of the above-mentioned python scripts, with the 

exception of metadata transactions script, are run via this system. 

 

3.10.1 BDIA Product Create 

 

Below is an example of the main page where the type of product build can be selected. 

 

 
 

Selecting based on the type of process that will be initiated. 
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The Console Output can be reviewed to see the progress of product create.  Following the completion of each 

product creation process, an e-mail notification is automatically sent to the team.   

 

 
 

 

All processes run via the BroadMap Hudson CI-System are stored for historical reporting.  Each process can be 

reviewed, including the Console Output and Build Artifacts from that run. 

 

 
 

3.10.2 Product Validation and Statistics 

 

Once the product creation process is complete, Product Validation and Statistics are then initiated.  These support 

the BDIA_ReleaseNotesStats.py script and the BDIA_QC_SUITES scripts detailed above. 

All statistics and reports are stored for historical review with the capability to place violation criticality on each 

quality control check allowing the identification of errors due to project status/completeness verses project 

correctness.  Example:  Typical Speeds populated. 
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Below is an example of the report provided based on various control points running over a specified time period: 

 
 

Similar to the Product Create process, all results from the process are maintained:  

 
 

Results are then reviewed manually to ensure no errors reported are critical or in violation of the NTIA data model 

or project completion statements.  Any errors of concern are communicated ahead of product delivery and 

included within the product release notes. 

Further detail on the Hudson CI System environment can be found by navigating to the following link: 

http://wiki.hudson-ci.org/display/HUDSON/Meet+Hudson 

 

http://wiki.hudson-ci.org/display/HUDSON/Meet+Hudson
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3.11 Product Extract Data Delivery 

Product delivery for MapConnect Broadband is handled two ways, depending on client requirements: 

1) State Submittal 

a) Data is submitted via SFTP site 

b) Product Release Notes and QC Test Report accompanies the delivery 

2) NTIA Submittal 

a) Directions for using the NTIA State Broadband Data file submission tool 

b) Go to the following WWW web site: https://esupport.fcc.gov/statedata  

c) Enter your username and password as provided to you from the NTIA program administrator. 

 

 
 

d) Click in Upload a file field 

e) Browse to local file for submission using the ‘Browse’ button.  Select file then select ATTACH FILE. 

https://esupport.fcc.gov/statedata
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f) Logout / Receipt using the Logout button in the Top Right of the screen 

g) A receipt of submission is emailed to username e-mail address 
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TENNESSEE COVER LETTER 

 

April 1, 2011 
 
Ms. Anne W. Neville 
SBDD Grant Program Director 
National Telecommunications and Information Administration 
U.S. Department of Commerce 
1401 Constitution Avenue, NW Room 4716 
Washington, DC 20230 
 
Dear Ms. Neville: 
 
It is with highest regard that the collective stakeholders of Connected Tennessee offer 
congratulations to the U.S. Department of Commerce’s National Telecommunications & 
Information Administration (NTIA) on the recent release of the National Broadband Map.  This 
extraordinary milestone demonstrates the intense and joint effort of the NTIA, FCC, state 
governments, industry, and non-profits like Connected Nation, Connected Tennessee’s parent 
organization, and will serve as a key tool for the American public and policymakers resulting in 
smarter investments and targeted state and local broadband policies and programs.  We are proud of 
the role that Connected Tennessee has played in creating such a powerful tool that will surely 
benefit not just Tennesseans, but consumers and businesses nationwide. 
 
Therefore, Connected Tennessee, as the State Broadband Designated Entity, in partnership with the 
Department of Finance and Administration’s Office for Information Resources and Department of 
Economic and Community Development among other agencies, is pleased to present this submittal 
of the State of Tennessee’s State Broadband Data and Development (SBDD) Grant Program, 
known as Connected Tennessee. 

 
These artifacts should be found to be compliant with the April 1, 2011, deadline for the semi-annual 
data update and in accordance with the terms of the July 1, 2009, Notice of Funds Availability 
(NOFA) and all subsequent clarifications pertaining to delivery of State-Level Mapping of 
Broadband Service Availability.  This packet includes: 
 
Inventory of Deliverables, Connected Tennessee: April 1, 2011 
 
NOFA Requirement Data Transfer Model Data Description 
Appendix A:  1(a)(i) BB_Service_CensusBlock Broadband Service Availability of 

Facilities-Based Providers in 
Census Blocks of No Greater 
Than Two Square Miles in Area 

Appendix A:   1(a)(ii) BB_Service_RoadSegment Broadband Service Availability of 
Facilities-Based Providers by Road 
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Segment in Census Blocks Larger 
in Area Than Two Square Miles 

Appendix A:   1(b) BB_Service_Wireless Broadband Service Availability of 
Wireless Services Not Provided to 
a Specific Address 

Appendix A:   3(b) BB_ConnectionPoint_MiddleMile Broadband Service Infrastructure 
Middle-Mile and Backbone 
Interconnection Points 

Appendix A:   4 BB_Service_CAInstitutions  Community Anchor Institutions-
Listing 

Appendix A:   4 n/a Community Anchor Institutions-
Narratives 

VII.A.1(a) n/a Accuracy and Verification Report 
n/a DataPackage.xlsx Worksheets of Contact 

Information, Data Dictionary, and 
Provider Summary Table 

n/a n/a Broadband Provider Roster and 
Participation Status 

 
In addition, this data update submission should be found to be compliant with the additional 
program requirements instituted by the National Telecommunications and Information 
Administration since the time of the October 2010 SBDD data submission for the Connected 
Tennessee program.  Specifically, these new requirements are: 

 
SBDD Data Transfer Model 
The submission of the broadband dataset for April 1, 2011, is contained within the SBDD 
Data Transfer Model as released on the Grantee Workspace on January 14, 2011. All efforts 
have been made to comply with formatting, domain, and metadata requirements to include 
as much information on each provider as possible.  
 
Additional Submission Guidance 
This submission also includes the updated DataPackage spreadsheet with enhanced provider 
listings as well as satisfactory outputs from the SBDD_Check toolbox to ensure fewer 
unexpected values with the submitted broadband datasets prior to federal processing for the 
National Broadband Map update. 

 
It is therefore with great pleasure that the Connected Tennessee program submits this April 2011 
semi-annual data update under the State Broadband Data and Development Grant Program.  We 
will continue to implement the joint purposes of the Recovery Act and the Broadband Data 
Improvement Act (BDIA) by gathering comprehensive and accurate state-level broadband mapping 
data, developing state-level broadband maps, aiding in the development and maintenance of the  
National Broadband Map, and undertaking statewide initiatives for broadband planning. 
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Broadband Service Availability — Provider Outreach and Verification 
 
This data update submission under the SBDD includes the participation of approximately 86.67% of 
the Tennessee provider community, or 78 of 90 total providers.  Of the 78 participating providers, 
27 supplied an update to their network or coverage area(s), while 47 have reported no change. The 
remaining 4 represent providers who previously supplied data but were non-responsive in the April 
2011 update effort; therefore their previous dataset is being put forward as part of this compilation. 
A complete roster by provider depicting participation status and contact record is contained herein.  
Of the 12 providers that are not represented in the attached datasets, 7 have either refused to 
participate in the voluntary program or have remained unresponsive to the numerous attempts at 
contact by Connected Tennessee. The remaining 5 providers are currently in some form of progress 
toward data submission but were not able to either submit or verify coverage areas at the time of 
this submission.    
 
As the aforementioned roster and attached methodology documentation will attest, it is the 
collective opinion of the Connected Tennessee principals that all commercially reasonable efforts 
were made to account for 100% of the known Tennessee broadband provider community, pursuant 
to this semi-annual data update submission. 
 
Connected Tennessee has also continued to perform broadband verification activities through 
several means. In addition to confirmation of service area(s) by each provider, Connected Tennessee 
conducts field validation efforts.  To date, 30 (33.33%) providers have been validated through field 
verification activities. Additional details on verification activities are contained within the Field 
Validation Narrative. 
  
At the program’s inception, Connected Tennessee launched a website to create awareness about the 
initiative. Connectedtennessee.org continues to serve a prominent role in the outreach and data 
collection effort.  This program asset provides a way for the general public to participate in the 
process by offering interactive tools for users to test their connection speed, submit broadband 
inquiries, or contact a program representative.   
 
As an indicator of stakeholder penetration, the Connected Tennessee website encountered 6,241 
unique visits during this reporting period (27,071 total to date for the life of the grant awarded on 
December 20, 2009).  Additionally, this pronounced Web activity netted 380 broadband inquiries 
over this same reporting period (1,263 grant inception to date).  The website also provides the 
BroadbandStat application, which allows the consumer to confirm or dispute the coverage 
represented on the broadband inventory map. These consumer initiated actions are facilitated 
through the Connected Tennessee website and the Connected Tennessee Interactive Mapping Tool 
(BroadbandStat) that offer the citizens the vehicles to provide information regarding availability in 
their respective service area, either in affirmation or contest of the reported data represented in the 
Connected Tennessee mapping artifacts.  Since the initial data collection and release of 
corresponding maps, feedback in the form of broadband inquiries has allowed Connected Nation to 
identify additional areas that are in need of field validation, which is scheduled as soon as possible.  
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Community Anchor Institutions  
 
Connected Tennessee has established an ongoing mechanism for gathering data on the location and 
broadband connectivity of Community Anchor Institutions (CAI), in accordance with the data 
requirements of the SBDD NOFA Technical Appendix.   
 
In conjunction with the State of Tennessee, outreach was conducted during this data update 
reporting period by Connected Tennessee to continue identification of existing, centralized sources 
for CAI connectivity data.  During this reporting period Connected Tennessee secured data from 
the NetTN network.  NetTN provides broadband service to state agencies, local governments, 
institutions of higher education, K-12 schools, libraries, eHealth, 911, and non-profits throughout 
the State of Tennessee.  Additionally, outreach was coordinated to distribute the CAI survey to 
institutions throughout the state through multiple methods including a customized online survey 
available on the Connected Tennessee website.  During this reporting period Connected Tennessee 
has continued to utilize the contacts of statewide associations and partners to promote the 
importance of broadband connectivity at anchor institutions and participation in this data collection 
process.  Connected Tennessee will continue to build upon these relationships over the coming 
months to collect data and raise awareness of this project. 
 
While we continue to document institutions and the related addresses, the connectivity data 
collected in most categories remains incomplete at this time.  Connected Tennessee will be 
implementing a number of new processes to increase participation including launching a CAI 
newsletter to connect communities across the state, increasing industry-specific planning to target 
new community contacts, and revising the CAI portion of our website to increase visibility and 
content.  From our work in Tennessee, as well as other states, we recognize the great value of this 
data to future collaboration efforts within the state and its value to the recently released National 
Broadband Map.  We plan to continue to bring best practices to the Connected Tennessee efforts, 
along with an investment of both human and technical resources required to reach our goal of 
increasing the data that is secured and reported as part of this process. 
 
 
The Connected Tennessee program exists to improve data on the deployment and adoption of 
broadband services and to assist in the extension of broadband technology across all regions of the 
great State of Tennessee, as well as the United States through contribution to the National 
Broadband Map.  We look forward to the continuing work ahead. 
 
Respectfully submitted, 

 
 
 

Michael L. Ramage 
Executive Director 
Connected Tennessee 

 
 
Thomas W. Ferree 
Chief Operating Officer 
Connected Nation, Inc. 

 
 

dclark
Cueball
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DATA ACQUISITION:  TENNESSEE COMMUNITY ANCHOR INSTITUTIONS  

In this third reporting period of the SBDD, Connected Tennessee, working in close coordination 
with the State of Tennessee, has established an ongoing mechanism for gathering data on the 
location and broadband connectivity of Community Anchor Institutions (CAI), in accordance with 
the data requirements of the SBDD NOFA Technical Appendix.  During this reporting period 
Connected Tennessee has continued to focus efforts on conducting outreach and raising awareness 
of this important project. 
 
Connected Tennessee has continued to identify and process CAI data obtained through an ongoing 
statewide outreach campaign.  Physical address information continues to be augmented through 
manual sourcing and geocoded by Connected Tennessee through ESRI ArcGIS software. 
 
Connected Tennessee continues to utilize a customized online survey on the Connected Tennessee 
website that was developed during the first reporting period.  This survey, in combination with a 
customized data gathering spreadsheet, was distributed to a targeted list of CAI throughout the state.  
Connected Tennessee will continue to use these data gathering tools for future targeted outreach 
efforts throughout the coming months leading up to the next reporting period.  These materials are 
customized to fit the CAI categories as defined in the SBDD NOFA.   
 
The survey can be accessed at this link: 
http://www.connectedtennessee.org/broadband_landscape/community_anchor_institution_survey.
php 
 
Connected Tennessee has worked diligently during this reporting period to conduct research as part 
of an ongoing process to identify existing, centralized sources for CAI connectivity data.  Through 
our partnership with the State of Tennessee, an existing statewide CAI broadband network was 
identified and the data has been included in this reporting submission.  The NetTN network 
database includes over 1,800 complete connectivity data points for CAI in all sectors.  More 
information about this network can be found on the NetTN website, 
http://www.nettn.net/Home.aspx.  
 
In tandem with these efforts to identify existing data, Connected Tennessee continues to identify 
key CAI contacts among all CAI categories in an effort to distribute and promote the online survey 
and raise awareness of the importance of CAI broadband connectivity.  
  
Connected Tennessee has an ongoing mission to educate CAI throughout the state on the 
importance of participating in the project.  Participation by these institutions will raise awareness 
about the importance of broadband connectivity and the need to report the requested data for 
inclusion on the National Broadband Map.  To assist with our data collection efforts, Connected 
Tennessee is developing a CAI newsletter to be distributed quarterly beginning in April 2011.  The 
newsletter will highlight a CAI in Tennessee, encourage institutions to share their data, and highlight 
the National Broadband Map. 
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The greatest challenge with collecting this data continues to be the difficulty in securing CAI 
broadband connectivity data specifically for public safety and healthcare CAI.  Connected Tennessee 
will continue its ongoing work with the State of Tennessee and key organization contacts in an 
effort to raise awareness of this project among CAI.   
 
A CAI summary of all processed and submitted data is provided below: 
 

CAI Type Total 
Physical 
Address Lat/Long

Technology of 
Transmission 

Download 
Speed 

Upload 
Speed 

K-12 Schools 2,396 2,396 2,396 760 760 759 
Libraries 259 259 259 231 231 231 
Healthcare 825 825 825 113 112 112 
Public Safety 742 742 738 257 101 101 
Higher Ed Institutions 317 317 316 156 160 104 
Other Government 1,262 1,262 1,261 1,181 1,141 1,140 
Other Non-Government 164 164 163 72 69 69 
Total 5,965 5,965 5,958 2,770 2,574 2,516 

 
 
SBDD DATA SUBMISSION METHODOLOGY 

The submission of the broadband dataset for April 1, 2011, is contained within the SBDD Data 
Transfer Model and additional components as released on the Grantee Workspace on January 14, 
2011. Connected Nation has reviewed all literature that relates to the release and use of this data 
transfer model and recognizes that it does not replace or dictate how data is stored, processed, or 
displayed for the state or territory, as it is meant primarily as a means to transfer the broadband data 
from all states and territories and populate the National Broadband Map in a seamless fashion. 
Guidance from the Technical Mapping Guide, as released on the Grantee Workspace on March 24, 
2011, was also followed to ensure the completeness and validity of the submission through 
completion steps and checklists, completing the DataPackage spreadsheet, uploading broadband 
datasets into the Data Transfer Model, and checking the dataset using the SBDD_CheckSubmission 
receipt process.  
 
In addition to the narratives and methodologies contained herein, as well as the DataPackage.xls 
containing contact information, the data dictionary, and a provider summary table, the following 
feature classes are submitted within the SBDD Data Transfer Model for the State of Tennessee. 
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Inventory of Deliverables, Connected Tennessee: April 1, 2011 
 
NOFA Requirement Data Transfer Model Data Description 
Appendix A:  1(a)(i) BB_Service_CensusBlock Broadband Service Availability of 

Facilities-Based Providers in 
Census Blocks of No Greater 
Than Two Square Miles in Area. 

Appendix A:   1(a)(ii) BB_Service_RoadSegment Broadband Service Availability of 
Facilities-Based Providers by Road 
Segment in Census Blocks Larger 
in Area Than Two Square Miles. 

Appendix A:   1(b) BB_Service_Wireless Broadband Service Availability of 
Wireless Services Not Provided to 
a Specific Address. 

Appendix A:   3(b) BB_ConnectionPoint_MiddleMile Broadband Service Infrastructure 
Middle-Mile and Backbone 
Interconnection Points. 

Appendix A:   4 BB_Service_CAInstitutions  Community Anchor Institutions-
Listing. 

 
The provider data collected by Connected Nation on behalf of the State of Tennessee have been 
formatted per the given specifications and uploaded into the appropriate feature classes of the 
SBDD Data Transfer Model. Wireline availability is contained within census blocks and road 
segments, wireless availability is contained as polygons of coverage areas, and middle-mile 
connections and community anchor institutions are contained as point data. All speed data is 
contained at the census block, road segment, or wireless polygon level of availability. All efforts have 
been made to comply with formatting, domain, and metadata requirements to include as much 
information as possible.  
 
Connected Nation has continued outreach to satellite providers on their availability, technology, and 
speed information, but it is not included in this submission dataset.  Additional information is 
necessary to be able to show where service satisfactorily exists in the state, rather than submitting 
the entire boundary of the state as the serviceable area.  Analysis information distributed and 
discussed with the satellite providers, as well as any additional guidance from the Program Office on 
the desired analysis for satellite-serviceable areas, will be implemented for the October 2011 data 
submission.  
 
 
TENNESSEE FIELD VALIDATION NARRATIVE 

Connected Nation focused a portion of its time on specific validation processes such as: 
 

• conducting random spectrum analysis studies throughout the state using an Avcom PSA-37-
XP spectrum analyzer; 

• conducting mobile speed tests throughout the state using an iPhone, Android (or other 
smart phone) as well as provider-specific aircards (Sprint 3G/4G, Clearwire et al); 
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• identifying pre-selected, provider-submitted wireless transmit tower sites and cross-
referencing data about that tower against the Federal Communications Commission (FCC) 
databases such as Antenna Structure Registration and/or the Universal Licensing System; 

• cross-referencing Federal Registration Number data against available FCC Form 477 data as 
well as the FCC COmmission REgistration System (CORES); 

• validating provider submitted data (for example: latitude/longitude) using a handheld 
Garmin eTrex Summit GPS unit or GPS enabled software such as Microsoft Streets and 
Trips; 

• locating physical wire-line attributes (such as remote terminals, CATV plant, etc.) and 
comparing them against provider submitted data; and  

• conducting on-net and off-net speed tests using the FCC portal at 
http://www.broadband.gov/qualitytest/about/ or using the Ookla Net Metrics enabled 
speed test utility located on each of Connected Nation’s state specific websites. 

 
Additionally, Connected Nation cross-referenced numerous public documents in order to ensure 
that all known broadband providers were located and contacted.  This included searching 
membership logs from the trade associations (WISPA, WCAI, PCIA, etc.), the Cable Television Fact 
Book, Public Utility Commission records, Public Service Commission records, Chamber of 
Commerce, etc. 
 
To date Connected Nation’s staff conducted on-site validation tests in Tennessee on the following 
providers:  Ardmore Telephone Company Inc., AT&T, Beasley Wireless, Ben Lomand Rural 
Telephone Cooperative Inc., Big River, Cellular South Inc., Clearwire Corporation, Columbia Power 
& Water Systems, CRU Enterprises, DotSpot Wireless, ECSIS.Net, Frontier Communications 
Corporation, High Country Online, Jackson Energy Authority, Ken-Tenn Wireless LLC, Leap 
Wireless International Inc., Millington Telephone Company, NetEase, NewWave Communications, 
Planet Connect Internet, QuickRelay Wireless Communications, Sprint. TEC of Jackson Inc., T-
Mobile USA Inc., Trenton Cable TV Company, U.S. Cellular, UltraNet, Verizon Communications 
Inc. and Xpansion Networks. 
 
From program initiation through this reporting period, Connected Nation has completed in-the-
field validation testing against 30 companies (out of a universe of 90 viable providers) totaling 
33.33% within the State of Tennessee.   
 
 
ACCURACY AND VERIFICATION:  METHODOLOGY - PROVIDER VALIDATION 

Broadband providers maintain their service area data in many different formats, all in varying levels 
of complexity and granularity. In order to ensure that the data required by the NTIA is standardized 
across all providers and that it is as accurate as possible, Connected Nation translates and formats 
the data that providers are able to supply into a GIS shapefile and produces maps for the provider to 
review.  The resulting map(s) and review process allow for providers to see their service area in a 
geographic format – for some providers, this is the first time they have seen maps of their 
broadband service area. Having the mapped service area allows providers to quickly identify any 
issues that appear in the data representation, whether the issue is in the data translation into a GIS 
format or from the original data collection and submission. Often data is provided from various 



                                                                            Connected Tennessee – Narratives and Methodologies  
 

 
 

 
April 1, 2011   11 
 

sources and through the review and revision process, local engineers who operate the networks and 
work in the field are able to ensure that the tabular data that has been submitted is accurate and 
represents the real-world network extent. Any issues in how the service area is represented on the 
map(s) are remedied by Connected Nation, whether they are additions, removal of service, or any 
other revisions. Revised maps of service area representations are sent to the provider for review and 
approval; Connected Nation will revise data and return maps as many times as necessary until the 
provider is in agreement that the map represents their service area as accurately as possible. Once 
the review process has been completed and final approval of the data is provided, the data is deemed 
ready for NTIA submission. 
 
Once the data collection has been aggregated at a statewide level, static maps of statewide and 
county-level availability are produced and made publicly available. In addition, consumers can visit 
the interactive online tool, BroadbandStat, to create customized views of broadband service areas 
and analyze corresponding demographic information. Leveraging broadband service data on various 
platforms allows for public users, providers, and other stakeholders to review, scrutinize, and 
provide feedback on the represented data. This feedback becomes a validation method in itself as 
consumers submit inquiries to Connected Nation either affirming where service is not available or 
identifying areas where broadband service is shown on the map, but in actuality is not available. This 
allows for a follow-up to providers regarding revisions to the data as it is represented; it also allows 
for Connected Nation to identify locations where on-site visits may be necessary to complete field 
validation of available services. Public feedback on all forms of mapping products serves as a 
localized validation method for provider-supplied information and allows Connected Nation to 
resolve inaccuracies as they are identified to ensure that only the highest quality information is 
provided to stakeholders. 
 
Estimates derived from provider-validated data indicate that approximately 4.94% of Tennessee 
households do not have terrestrial fixed broadband service available, and approximately 0.42%1 of 
Tennessee households have neither mobile nor fixed broadband service available.2   
 
Within rural areas of the state, results derived from provider-validated data indicate that 
approximately 9.07% of rural Tennessee households do not have terrestrial fixed broadband service 
available, and approximately 0.83%3 of rural Tennessee households have neither mobile nor fixed 
broadband service available.4   

                                                            
1 In accordance with NTIA’s definition of available broadband service as specified in the SBDD NOFA, this estimate 

includes both terrestrial fixed and mobile broadband service, if the service offers download speeds of at least 768 Kbps 
and upload speeds greater than 200 Kbps. 

2 Due to the nature of the SBDD data collection methodology as defined by the NTIA and based on both census 
block geographic units and street segment data, the estimates of broadband availability derived from provider-validated 
data may include an overstatement of the actual number of households with broadband availability.  Under the census 
block-based data collection method, a provider will typically report broadband availability for an entire census block 
whether its network is present across the whole or only a subset of that census block.  This potential overestimation at 
the census block level can be amplified as the data is aggregated across the entire state. 

3 See footnote 1. 
4 See footnote 2. 
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WIRELESS METHODOLOGY 

 
Broadband Service Availability in Provider’s Service Area 

Wireless Services Not Provided to a Specific Address 
 
Data solicited from a fixed wireless provider to create propagation models include, but are not 
limited to: 

1. The name of the structure 
2. Whether the transmitting device is operational or proposed 
3. The maximum advertised downstream speed, the maximum advertised upstream speed 
4. The typical downstream speed, the typical upstream speed (peak periods for both) 
5. The frequency range of spectrum being used (as prescribed by NTIA) 
6. The primary population center(s) being served (for geopolitical boundary reference) 
7. The physical address of the transmit site (in the event latitude/longitude is unavailable from 

the provider this allows a quick reference point for geocoding) 
8. Latitude in either Degrees, Minutes and Seconds and/or in Decimal Degrees (typically 

received as NAD 27 or NAD 83)  
9. Longitude in either Degrees, Minutes and Seconds and/or in Decimal Degrees (typically 

received as NAD 27 or NAD 83)  
10. Antenna pattern (e.g. omni-directional, 180°, 120°, 90°, etc.) 
11. Azimuth of antenna (e.g. 360° with magnetic declination if known) 
12. Approximate transmit radius (in feet, miles, or kilometers) 
13. Polarity of transmit antenna (Vertical or Horizontal) 
14. Transmit antenna gain (in dBi) 
15. Line loss (applicable only to providers using coax, heliax, waveguide or other forms of 

cabling – excludes power-over-Ethernet devices) 
16. Mechanical and/or Electrical beam tilt (if applicable) 
17. Equipment Manufacturer (allows easy cross-reference against manufacturer’s specification 

sheet) 
18. Power output of the transmitting device (if unknown, FCC standards or manufacturer 

specifications are applied) 
19. AMSL at base of tower site 
20. Antenna centerline AGL (height of antenna above ground level measured at the centerline 

of the actual antenna) 
21. Foliage factors (Evergreens/Deciduous and percent of ground cover) 
22. Ground Clutter (primarily used in rural areas to account for foliage and in metropolitan areas 

to account for types and heights of buildings if known)   
23. Average gain of receive antenna 
24. Receive antenna is estimated at height above average terrain (HAAT) of 6.2 meters/20 feet 



                                                                            Connected Tennessee – Narratives and Methodologies  
 

 
 

 
April 1, 2011   13 
 

25. Federal Registration Numbers (if applicable) which may allow opportunities to cross-
reference and/or obtain additional data from the Federal Communications Commission 
Universal Licensing System and the COmmission REgistration System 

 
Propagation modeling is an empirical mathematical formulation for the characterization of radio 
wave propagation as a function of frequency, distance, and other conditions. Propagation 
software(s) typically use the Irregular Terrain Model (also known as Longley-Rice) of radio 
propagation for frequencies between 20 MHz and 20 GHz. This model is based on electromagnetic 
theory and statistical analyses of the combination of terrain features and radio measurements, then 
predicting the median attenuation of a radio signal as a function of distance and the variability of the 
signal in time and in space.  For metropolitan areas, the software can typically be adjusted to use the 
Okumura-Hata model which accounts for predicting the behavior of cellular transmissions in areas 
where buildings are the primary obstructions. The resulting product from either model depicts a 
graphical illustration of the theoretical propagation characteristics of a selected frequency range 
based on defined variables (receiver sensitivity of the home/mobile device, foliage factor, and digital 
elevation terrain input). 
 
 
BROADBAND INQUIRIES METHODOLOGY 

Connected Nation collects consumer feedback in the form of broadband inquiries. These inquiries 
represent any type of communication received from the public regarding broadband service. Once 
broadband inquiries are received across the state, this information is overlaid with the broadband 
availability information which was collected through the SBDD program.  This allows for a real-
world comparison of the broadband landscape to the information received from broadband 
inquiries.  Broadband inquiries are able to provide three types of information:  1) Residents who do 
not have broadband but want it.  2)  Residents who have broadband but want a different provider.  
3)  Residents who do not have broadband, but the broadband inventory maps indicate that they do. 
 
Through the collection of broadband inquiries, a visual demand for broadband is presented.  This 
visualization allows Connected Nation the ability to validate broadband availability maps for 
accuracy.  If residents within a region state that they are without broadband, but the broadband 
inventory maps show otherwise, this allows Connected Nation to approach the providers within that 
area in an effort to trim down their coverage to more accurately represent real-world availability on 
the ground.  On the other hand, if there is a region in the territory in which broadband is not 
available, the broadband inquiries allow providers close to that region to see where they can 
successfully expand their broadband networks, leading to a high return on investment.  In short, the 
higher number of inquiries leads to a higher level of certainty in regard to the broadband availability 
maps.  Since the initial data collection and release of corresponding maps, feedback in the form of 
broadband inquiries has allowed Connected Nation to identify additional areas that are in need of 
field validation, which are scheduled as soon as possible. Additional information on field validation 
can be found in the Field Validation Narrative. 
 
The broadband inquiry process has been implemented in each of the Connected Nation state 
programs with successful results. Altogether Connected Nation has received over 16,000 broadband 
inquiries since 2007, allowing the state programs to evaluate each inquiry for broadband demand and 
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data verification.  These inquiries are continuously examined against current broadband availability, 
updated every six months, to determine if previously unserved households have been expanded to 
and can now receive broadband at their residence. This database of broadband inquiries has also 
allowed the Connected Nation state programs to aggregate demand in concentrated areas to show 
providers the exact locations where the population has made it clear that they would purchase 
broadband if it was made available to them. Providers in the states have responded to this process 
and have expanded to areas knowing that their investment will be worthwhile. Data verification 
methods have also proven successful, as the state programs have been able to show those inquiries 
that indicate the broadband service areas are misrepresented on the map to providers, who then 
verify where service cannot reach in regard to that residence(s). The broadband coverage in these 
states has been altered to create a more accurate map based on the inquiries submitted by the public. 
 
During this reporting period, the Connected Tennessee project has received a total of 380 inquiries 
(1,263 grant inception to date).  As more inquiries are submitted to Connected Tennessee, a more 
thorough validation of the broadband landscape can be performed, while also allowing providers to 
see which areas have a high demand for broadband adoption. 

 

BROADBANDSTAT METHODOLOGY  

BroadbandStat is an online, interactive mapping tool for viewing, analyzing, and validating 
broadband data. Developed through a partnership with ESRI, the market leader in geographic 
information system (GIS) software, BroadbandStat is a multi-functional, user-friendly way for local 
leaders, policymakers, consumers, and technology providers to devise a plan for the expansion and 
adoption of broadband.  
 
First and foremost, BroadbandStat allows consumers to locate their residence and identify providers 
that offer broadband Internet service to that location. The interactive platform allows for users to 
build and evaluate broadband expansion scenarios using a wealth of data, including education and 
population demographics, broadband availability, and research about the barriers to adoption.  
 
New functionality in BroadbandStat allows the consumer to provide feedback on the broadband 
data displayed on the interactive map.  Through the collection of this feedback, a visual demand for 
broadband is presented.  This visualization allows the Connected Nation state programs the ability 
to validate the broadband availability for accuracy.  If residents within a region state they are without 
broadband, but the interactive map shows otherwise, this allows Connected Nation to approach the 
providers within that area in an effort to trim down their coverage to more accurately represent real-
world availability on the ground.   
 
The Connected Tennessee project launched BroadbandStat on February 10, 2010, and has received 
a total of 5,729 visits to date, of which 1,063 occurred this reporting period. 
 



                                                                            Connected Tennessee – Narratives and Methodologies  
 

 
 

 
April 1, 2011   15 
 

 
SPEED TEST METHODOLOGY 

The 2,269 speed tests that are represented in the Connected Tennessee Speed Test Report during 
this reporting period (7,149 grant inception to date) are the result of a partnership between 
Connected Nation and Ookla Net Metrics. Utilizing this relationship increases the level of 
confidence in the data being collected and provides for a far greater sample size than could be 
collected by a single testing site. 
 
Ookla owns and operates Speedtest.net, as well as develops and deploys speed tests, such as the 
Connected Tennessee speed test website, for partners around the world. This network of sites that is 
developed and run on its testing technology provides Ookla with a vast dataset that, due to the 
variability of geographic information collected across the varying speed test sites, is geocoded 
utilizing Geo-IP technology. This technology allows for tests to be geocoded to points of 
aggregation, typically larger nodes across provider networks.  While there are hundreds of thousands 
of tests that have been conducted, the level of aggregation is only sufficient for county-level detail 
due to the test results being located at these larger nodes and not at an absolute location for each 
speed test. 
 
In an effort to validate broadband data from the Connected Tennessee project, speed test 
information is collected throughout the state.  Speed tests provide speed information on the path 
taken through all networks (a provider’s network as well as additional networks) a local machine 
must connect to in order to reach the host test.  The benefit of this collection of speed information 
is two-tiered.  First, it allows for a comprehensive dataset of speeds, while also providing Connected 
Tennessee with the information on where broadband services are available.  Second, unlike 
theoretical speed information which was received through the data collection process, the use of 
speed tests provide real-world information on the speeds that currently exist within the State of 
Tennessee.   
 
 



Complete 92
Non-Responsive/Refused 10
In Progress 10

Count of Datasets by Viable Status 112
Total Unique Providers Represented 90

Provider Name Platform Status

NDA 
Execution 

Date Notes
Ardmore Telephone Company Inc ILEC/CLEC Data Added to Statewide Inventory 2/16/2010
AT&T Inc. ILEC/CLEC Data Added to Statewide Inventory 12/16/2009
AT&T Inc. Mobile Wireless Data Added to Statewide Inventory 12/16/2009
Ben Lomand Rural Telephone Coop., Inc. Fiber Data Added to Statewide Inventory 10/21/2009
Cable ONE Inc. Cable Data Added to Statewide Inventory 12/7/2009
CenturyLink ILEC/CLEC Data Added to Statewide Inventory 12/4/2009
Charter Communications Inc. Cable Data Added to Statewide Inventory 12/15/2009
Clearwire Corporation Mobile Wireless Data Added to Statewide Inventory 3/3/2010
Comcast Cable Communications, LLC Cable Data Added to Statewide Inventory 12/7/2009
ECSIS.NET Fixed Wireless Data Added to Statewide Inventory 10/29/2009
Electric Power Board for the City of Chattanooga Fiber Data Added to Statewide Inventory
Fayetteville Public Utilities Cable Data Added to Statewide Inventory
Frontier Communications Corporation ILEC/CLEC Data Added to Statewide Inventory 1/22/2010
Leap Wireless International, Inc. Mobile Wireless Data Added to Statewide Inventory 4/6/2010
MidSouth Satellite, LLC Fixed Wireless Data Added to Statewide Inventory 7/7/2010
Millington CATV, Inc. ILEC/CLEC Data Added to Statewide Inventory 10/19/2009
Millington CATV, Inc. Cable Data Added to Statewide Inventory 10/19/2009
Monster Broadband, Inc. Fixed Wireless Data Added to Statewide Inventory 11/6/2009
Planet Connect Internet Fixed Wireless Data Added to Statewide Inventory
Rural Tennessee Wireless Broadband (RTWB) Fixed Wireless Data Added to Statewide Inventory 2/15/2011
Sprint Nextel Corporation Mobile Wireless Data Added to Statewide Inventory 1/14/2010
T-Mobile USA, Inc. Mobile Wireless Data Added to Statewide Inventory 1/8/2010
TDS Telecommunications Corporation ILEC/CLEC Data Added to Statewide Inventory 1/27/2010
TDS Telecommunications Corporation Fiber Data Added to Statewide Inventory 1/27/2010
United States Cellular Corporation Mobile Wireless Data Added to Statewide Inventory 2/15/2011
Verizon Communications, Inc. Mobile Wireless Data Added to Statewide Inventory 12/14/2009

Zito Midwest LLC Cable Data Added to Statewide Inventory 2/17/2011
[JAN-19-11 Daryl Coffey] Zito Midwest 
purchased Galaxy Cable.

DIECA Communications, Inc. Backhaul Backhaul Provider Only Processing Complete 1/19/2010
Level 3 Communications, LLC Backhaul Backhaul Provider Only Processing Complete 12/14/2009
MidSouth Satellite, LLC Backhaul Backhaul Provider Only Processing Complete 7/7/2010
T-Mobile USA, Inc. Backhaul Backhaul Provider Only Processing Complete 1/8/2010
TDS Telecommunications Corporation Backhaul Backhaul Provider Only Processing Complete 1/27/2010
Zayo Group, LLC Backhaul Backhaul Provider Only Processing Complete
NTCH, Inc. Mobile Wireless Provider Gathering Data
TELE-PAGE Inc. Fixed Wireless Provider Gathering Data 1/26/2010
Access Cable Television, Inc. Cable No Update to Provide
AT&T Inc. Backhaul No Update to Provide 12/16/2009
Aurora Cable TV Cable No Update to Provide 3/12/2010
Beasley Wireless Fixed Wireless No Update to Provide 1/19/2010
Ben Lomand Rural Telephone Coop., Inc. ILEC/CLEC No Update to Provide 10/21/2009
Bledsoe Telephone Cooperative Inc ILEC/CLEC No Update to Provide 1/20/2010
BreezeAir.net Fixed Wireless No Update to Provide 8/17/2010
Bristol Tennessee Essential Services Fiber No Update to Provide 9/1/2010
Celina Cable Communications, Inc. Cable No Update to Provide 1/15/2010
Cellular South, Inc. Mobile Wireless No Update to Provide 4/12/2010
CenturyLink Backhaul No Update to Provide 12/4/2009
Columbia Power & Water Systems Cable No Update to Provide
CRU Enterprises, Inc. Fixed Wireless No Update to Provide 2/4/2010
DeKalb Telephone Cooperative, Inc. ILEC/CLEC No Update to Provide 2/24/2010
DeltaCom, Inc. Backhaul No Update to Provide 2/16/2010
ETC Communications, LLC Cable No Update to Provide 10/14/2009
High Country Online LLC Fixed Wireless No Update to Provide 3/4/2010
Highland Telephone Cooperative, Inc. ILEC/CLEC No Update to Provide 3/14/2010
iGiles/DotSpot.Net Fixed Wireless No Update to Provide 2/25/2010
Info-Ed Inc Fixed Wireless No Update to Provide 2/9/2010
InfoStructure Inc. Cable No Update to Provide 10/2/2009
Iris Networks Backhaul No Update to Provide 1/5/2010
Jackson Energy Authority Fiber No Update to Provide 3/17/2010
James Cable LLC Cable No Update to Provide 1/11/2010
Ken-Tenn Wireless, L.L.C. Fixed Wireless No Update to Provide 1/25/2010
Loretto Telephone Company, Inc. ILEC/CLEC No Update to Provide 3/16/2010
Mediacom Southeast LLC Cable No Update to Provide 1/12/2010
Morristown Utilities Commission Fiber No Update to Provide 3/25/2010
NetEase Fixed Wireless No Update to Provide 2/3/2010
NewWave Communications Cable No Update to Provide 10/13/2009
North Central Communications ILEC/CLEC No Update to Provide 2/5/2010
OnWav, Inc. Fixed Wireless No Update to Provide 3/15/2010
Pickwick Cablevision, Inc. Cable No Update to Provide
Pulaski Electric System Fiber No Update to Provide 12/30/2009
Skyline Telephone Membership Corporation ILEC/CLEC No Update to Provide 2/2/2010
Skyline Telephone Membership Corporation Backhaul No Update to Provide 2/2/2010

Broadband Provider Log



Softek, Inc. Fixed Wireless No Update to Provide 1/14/2010
Spirit Broadband Cable No Update to Provide 3/29/2010
Sprint Nextel Corporation Backhaul No Update to Provide 1/14/2010
Surfmore.Net, Inc. Fixed Wireless No Update to Provide 1/25/2010
TEC of Jackson, Inc ILEC/CLEC No Update to Provide 7/29/2010
TEC of Jackson, Inc ILEC/CLEC No Update to Provide 7/29/2010
TEC of Jackson, Inc ILEC/CLEC No Update to Provide 7/29/2010
TEC of Jackson, Inc Backhaul No Update to Provide 7/29/2010
TEC of Jackson, Inc Backhaul No Update to Provide 7/29/2010
TEC of Jackson, Inc Backhaul No Update to Provide 7/29/2010
Trenton TV Cable Company Cable No Update to Provide
Tullahoma Utilities Board Fiber No Update to Provide
tw telecom of tennessee, llc Backhaul No Update to Provide 3/31/2010
Twin Lakes Telephone Cooperative Corporation ILEC/CLEC No Update to Provide 1/14/2010
Ultranet High-Speed Internet Fixed Wireless No Update to Provide 2/23/2010
Wave2Wave Communications Inc. Backhaul No Update to Provide 4/28/2010
West Kentucky Rural Telephone Coop Corp Inc ILEC/CLEC No Update to Provide 1/7/2010
XO Communications, LLC Backhaul No Update to Provide 2/12/2010

Clarksville Department of Electricity Fiber No Update Provided - Use Last Submission Data

OrbWireless.net Fixed Wireless No Update Provided - Use Last Submission Data

QuickRelay Wireless Communications Fixed Wireless No Update Provided - Use Last Submission Data

United Telephone Company, Inc. - TN ILEC/CLEC No Update Provided - Use Last Submission Data 2/25/2010

Verizon Communications, Inc. Backhaul No Update Provided - Use Last Submission Data 12/14/2009
TNets Internet Fixed Wireless Solicited Initial Data
United Telephone Company, Inc. - TN Fiber Solicited Initial Data 2/25/2010
Wisper, LLC Fixed Wireless Solicited Initial Data 2/22/2011

ABG Wireless, LLC Fixed Wireless Refused to Participate

[FEB-14-11 Deanna Ward] Provider 
representative indicated that they did not want to 
participate.

Birch Communications, Inc. ILEC/CLEC Refused to Participate

[JAN-11-11 Jill Lindgren] Provider has chosen 
not to participate.  The main concern was more 
with the fact he does not want to divulge the 
information publicly on his speeds or coverage 
area.

Birch Communications, Inc. Backhaul Refused to Participate

[JAN-11-11 Jill Lindgren] Provider has chosen 
not to participate.  The main concern was more 
with the fact he does not want to divulge the 
information publicly on his speeds or coverage 
area.

TNWEB, LLC ILEC/CLEC Refused to Participate
[FEB-03-11 Deanna Ward] E-mail received from 
provider asking not to be contacted again.

TNWEB, LLC Fixed Wireless Refused to Participate
[FEB-03-11 Deanna Ward] E-mail received from 
provider asking not to be contacted again.

Trinity Communications LLC Cable Refused to Participate

[FEB-16-11 Alyson Sumerford] Contacted 
provider by phone and was told, "put so much 
time into this last year and provided no fruits for 
my business.  I have bigger things to worry about 
right now."

Endless Sphere Technology Fixed Wireless Non-Responsive to Multiple Attempts 2/17/2010

In addition to multiple contact attempts made 
between January 21, 2010 and September 1, 
2010, six attempts were made during this 
submission period.

Knology of Tennessee, Inc. Cable Non-Responsive to Multiple Attempts

In addition to multiple contact attempts made 
between August 18, 2009 and August 24, 2010, 
five attempts were made during this submission 
period.

Knology of Tennessee, Inc. Backhaul Non-Responsive to Multiple Attempts

In addition to multiple contact attempts made 
between August 18, 2009 and August 24, 2010, 
six attempts were made during this submission 
period.

US LEC of Tennessee Inc. Backhaul Non-Responsive to Multiple Attempts
Five contact attempts were made between 
August 31, 2010 and February 22, 2011.

DIECA Communications, Inc. ILEC/CLEC Other 1/19/2010

[FEB-18-11 Wes Kerr] Provider doesn't offer 
residential DSL, and the last mile data will not be 
included in the data submission.

DISH Network Corporation Satellite Other 1/27/2010

[MAR-09-11 Ashley Littell] Satellite data will not 
be submitted due to additional information being 
necessary to show where service is available in 
the state, rather than submitting the entire state 
boundary as serviceable area.

Global Crossing Telecommunications, Inc. Backhaul Other

[FEB-17-11 Wes Kerr] Received word from a 
provider representative that they still have a 
Network Security agreement with several 
Federal agencies and cannot provide data at this 
time.

Hughes Network Systems, LLC Satellite Other 2/5/2010

[MAR-09-11 Ashley Littell] Satellite data will not 
be submitted due to additional information being 
necessary to show where service is available in 
the state, rather than submitting the entire state 
boundary as serviceable area.



WildBlue Communications, Inc. Satellite Other 1/8/2010

[MAR-09-11 Ashley Littell] Satellite data will not 
be submitted due to additional information being 
necessary to show where service is available in 
the state, rather than submitting the entire state 
boundary as serviceable area.
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TEXAS COVER LETTER 

 
April 1, 2011 
 
Ms. Anne W. Neville 
SBDD Grant Program Director 
National Telecommunications and Information Administration 
U.S. Department of Commerce 
1401 Constitution Avenue, NW Room 4716 
Washington, DC 20230 
 
Dear Ms. Neville: 
 
The collective stakeholders of Connected Texas offer congratulations to the U.S. Department of 
Commerce’s National Telecommunications & Information Administration (NTIA) on the recent 
release of the National Broadband Map.  This extraordinary milestone demonstrates the intense and 
joint effort of the NTIA, FCC, state governments, industry, and non-profits like Connected Nation 
and will serve as a key tool for the American public and policymakers to achieve smarter 
investments and develop targeted state and local broadband policies and programs.  We are proud of 
the role that Connected Texas has played in creating such a powerful tool that will surely benefit not 
just Texans but consumers and businesses nationwide. 
 
Therefore, as the State Broadband Designated Entity, and in partnership with the state of Texas, 
please accept this submission from Connected Nation on behalf of the state of Texas’ State 
Broadband Data and Development (SBDD) Grant Program, known as Connected Texas. 

 
This submission should be found to be compliant with the April 1, 2011, deadline for the semi-
annual data update and in accordance with the terms of the July 1, 2009, Notice of Funds 
Availability (NOFA) and all subsequent clarifications pertaining to delivery of State-Level Mapping 
of Broadband Service Availability.  This packet includes: 
 
Inventory of Deliverables, Connected Texas: April 1, 2011 
 
NOFA Requirement Data Transfer Model Data Description 
Appendix A:  1(a)(i) BB_Service_CensusBlock Broadband Service Availability of 

Facilities-Based Providers in 
Census Blocks of No Greater 
Than Two Square Miles in Area 

Appendix A:   1(a)(ii) BB_Service_RoadSegment Broadband Service Availability of 
Facilities-Based Providers by Road 
Segment in Census Blocks Larger 
in Area Than Two Square Miles 



                                      Connected Texas – Narratives and Methodologies 
 

 

 
April 1, 2011  Page 4 
 

Appendix A:   1(b) BB_Service_Wireless Broadband Service Availability of 
Wireless Services Not Provided to 
a Specific Address 

Appendix A:   3(b) BB_ConnectionPoint_MiddleMile Broadband Service Infrastructure 
Middle-Mile and Backbone 
Interconnection Points 

Appendix A:   4 BB_Service_CAInstitutions  Community Anchor Institutions-
Listing 

Appendix A:   4 n/a Community Anchor Institutions-
Narratives 

VII.A.1(a) n/a Accuracy and Verification Report 

n/a DataPackage.xlsx Worksheets of Contact 
Information, Data Dictionary, and 
Provider Summary Table 

n/a n/a Broadband Provider Roster and 
Participation Status 

 
In addition, this data update submission should be found to be compliant with the additional 
program requirements instituted by the National Telecommunications and Information 
Administration since the time of the October 2010 SBDD data submission for the Connected Texas 
program.  Specifically, these new requirements are: 

 
SBDD Data Transfer Model 
The submission of the broadband dataset for April 1, 2011, is contained within the SBDD 
Data Transfer Model as released on the Grantee Workspace on January 14, 2011. All efforts 
have been made to comply with formatting, domain, and metadata requirements to include 
as much information on each provider as possible.  
 
Additional Submission Guidance 
This submission also includes the updated DataPackage spreadsheet with enhanced provider 
listings as well as satisfactory outputs from the SBDD_Check toolbox to ensure fewer 
unexpected values with the submitted broadband datasets prior to federal processing for the 
National Broadband Map update. 

 
The Connected Texas program is pleased to submit this April 2011 semi-annual data update under 
the State Broadband Data and Development Grant Program.  We will continue to implement the 
joint purposes of the Recovery Act and the Broadband Data Improvement Act (BDIA) by gathering 
comprehensive and accurate state-level broadband mapping data, developing state-level broadband 
maps, aiding in the development and maintenance of the  National Broadband Map, and 
undertaking statewide initiatives for broadband planning. 
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Broadband Service Availability — Provider Outreach and Verification 
 
This data update submission under the SBDD includes the participation of approximately 77.84% of 
the Texas provider community, or 144 of 185 total providers.  Of the 144 participating providers, 65 
supplied an update to their network or coverage area(s), while 74 have reported no change. The 
remaining 5 represent providers who previously supplied data but were non-responsive in the April 
2011 update effort or could not verify coverage areas at the time of this submission; therefore their 
previous dataset is being put forward as part of this compilation. A complete roster by provider 
depicting participation status and contact record is contained herein.  Of the 41 providers that are 
not represented in the attached datasets, 34 have either refused to participate in the voluntary 
program or have remained unresponsive to the numerous attempts at contact by Connected Texas. 
The remaining 7 providers are currently in some form of progress toward data submission but were 
not able to either submit or verify coverage areas at the time of this submission.    
 
As the Broadband Provider Roster and attached methodology documentation will attest, it is the 
collective opinion of the Connected Texas principals that all commercially reasonable efforts were 
made to account for 100% of the known Texas broadband provider community, pursuant to this 
semi-annual data update submission. 
 
Connected Texas has also continued to perform broadband verification activities through several 
means. In addition to confirmation of service area(s) by each provider, Connected Texas conducts 
field validation efforts.  To date, 103 (55.68%) providers have been validated through field 
verification activities. Additional details on verification activities are contained within the Field 
Validation Narrative. 
  
At the program’s inception, Connected Texas launched a website to create awareness about the 
initiative. Connectedtx.org continues to serve a prominent role in the outreach and data collection 
effort.  This program asset provides a way for the general public to participate in the process by 
offering interactive tools for users to test their connection speed, submit broadband inquiries, or 
contact a program representative.   
 
As an indicator of stakeholder penetration, the Connected Texas website encountered 5,155 unique 
visits during this reporting period, which includes 5,040 visits to the English website and 115 visits 
to the Spanish website (29,609 total to date for the life of the grant awarded on January 1, 2010, 
which includes 29,362 to the English website and 247 to the Spanish website).  Additionally, this 
pronounced Web activity netted 66 broadband inquiries over this same reporting period (429 grant 
inception to date).  The website also provides the BroadbandStat application, which allows the 
consumer to confirm or dispute the coverage represented on the broadband inventory map. These 
consumer initiated actions are facilitated through the Connected Texas website and the Connected 
Texas Interactive Mapping Tool (BroadbandStat) that offer the citizens the vehicles to provide 
information regarding availability in their respective service area, either in affirmation or contest of 
the reported data represented in the Connected Texas mapping artifacts.  Since the initial data 
collection and release of corresponding maps, feedback in the form of broadband inquiries has 
allowed Connected Nation to identify additional areas that are in need of field validation, which is 
scheduled as soon as possible.  
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Community Anchor Institutions  
 
Connected Texas has established an ongoing mechanism for gathering data on the location and 
broadband connectivity of Community Anchor Institutions (CAI), in accordance with the data 
requirements of the SBDD NOFA Technical Appendix.   
 
In conjunction with the Texas Department of Agriculture, outreach was conducted during this data 
update reporting period by Connected Texas to continue identification of existing, centralized 
sources for CAI connectivity data.  Outreach was coordinated to distribute the CAI survey to 
institutions throughout the state through multiple methods including a customized online survey 
available on the Connected Texas website.  Connected Texas also partnered this reporting period 
with the Texas Department of Agriculture’s Regional Field Team Staff to raise awareness in their 
communities about this initiative and distribute our survey.  Connected Texas continues to work in 
close coordination with statewide associations such as the Texas State Library and Archives 
Commission, Commission on State Emergency Communication, and Department of Information 
Resources to promote the importance of broadband connectivity at anchor institutions and 
participation in this data collection process.   
 
While we continue to document institutions and the related addresses, the connectivity data 
collected in most categories remains incomplete at this time.  Connected Texas will be implementing 
a number of new processes to increase participation including launching a CAI newsletter to 
connect communities across the state, increasing industry-specific planning to target new community 
contacts, and revising the CAI portion of our website to increase visibility and content.  
Additionally, Connected Texas will continue working closely with members of the Texas Broadband 
Task Force to reach CAI associated with their respective sectors.  From our work in Texas, as well 
as other states, we recognize the great value of this data to future collaboration efforts within the 
state and its value to the recently released National Broadband Map.  We plan to continue to bring 
best practices to the Connected Texas efforts, along with an investment of both human and 
technical resources required to reach our goal of increasing the data that is secured and reported as 
part of this process. 
 
In acquiring both broadband availability and CAI data within the state of Texas, Connected Nation 
has previously engaged all federally recognized tribal lands in the area covered by the Connected 
Texas SBDD grant and reported that outreach as part of past submissions.  Throughout the next 
reporting period Connected Texas plans to engage directly with these tribal communities and will 
also conduct affirmative outreach with Native American tribal organizations that are active within 
the area.  Connected Texas understands the connectivity challenges facing these tribes, and we have 
identified a need to include their data as part of our upcoming submissions. 
 
The Connected Texas program exists to improve data on the deployment and adoption of 
broadband services and to assist in the extension of broadband technology across all regions of the  
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great state of Texas, as well as the United States through contribution to the National Broadband 
Map.  We look forward to the continuing work ahead. 
 
Respectfully submitted, 
 
 
 
Thomas W. Ferree 
Chief Operating Officer 
Connected Nation, Inc. 
 
 

dclark
Cueball
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DATA ACQUISITION:  TEXAS COMMUNITY ANCHOR INSTITUTIONS  

In this third reporting period of the SBDD, Connected Texas, working in close coordination with 
the Texas Department of Agriculture, has established an ongoing mechanism for gathering data on 
the location and broadband connectivity of Community Anchor Institutions (CAI), in accordance 
with the data requirements of the SBDD NOFA Technical Appendix.  During this reporting period 
Connected Texas has continued to focus efforts on conducting outreach and raising awareness of 
this important project. 
 
Connected Texas has continued to identify and process CAI data obtained through an ongoing 
statewide outreach campaign.  Physical address information continues to be augmented through 
manual sourcing and geocoded by Connected Texas through ESRI ArcGIS software. 
 
Connected Texas continues to utilize a customized online survey hosted through SurveyMonkey, 
with a landing page on the Connected Texas website that was developed during the first reporting 
period.  This survey, in combination with a customized data gathering spreadsheet, was distributed 
to a targeted list of CAI throughout the state.  Connected Texas will continue to use these data 
gathering tools for future targeted outreach efforts throughout the coming months leading up to the 
next reporting period.  These materials are customized to fit the CAI categories as defined in the 
SBDD NOFA.   
 
The survey can be accessed at this link using the following password: 
http://connectedtx.org/mapping/Community_Anchor_Institution_Data_Collection.php 
Password:  CAI_TX_7933 
 
Connected Texas and the Texas Department of Agriculture have worked closely during this 
reporting period to conduct research as part of an ongoing process to identify existing, centralized 
sources for CAI connectivity data.  We have identified two sources of existing CAI connectivity data 
in the state.  The TEX-AN network is a state-managed network serving state agencies, some 
universities and schools, as well as a few counties and cities, and the Austin Metropolitan Network 
serves most state agencies within Austin.  Data from both of these networks is still being extracted 
by the Texas Department of Information Resources and Connected Texas will be reporting this data 
in the next reporting submission. 
 
In tandem with these efforts to identify existing data, Connected Texas continues to identify key 
CAI contacts among all CAI categories in an effort to distribute and promote the online survey and 
raise awareness of the importance of CAI broadband connectivity.  Key CAI contacts throughout 
the state are working with Connected Texas to distribute the survey, and work continues with the 
Texas Department of Agriculture’s Regional Development Teams to reach CAI within their regions. 
  
Connected Texas has an ongoing mission to educate CAI throughout the state on the importance of 
participating in the project.  Participation by these institutions will raise awareness about the 
importance of broadband connectivity and the need to report the requested data for inclusion on the 
National Broadband Map.  To assist with our data collection efforts, Connected Texas is developing 
a CAI newsletter to be distributed quarterly beginning in March 2011.  The newsletter will highlight 
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a CAI in Texas, encourage institutions to share their data, and highlight the National Broadband 
Map.  This newsletter will also be provided to the Regional Development Teams for distribution in 
their regions throughout the state. 
 
The greatest challenge with collecting this data continues to be the difficulty in securing CAI 
broadband connectivity data.  Connected Texas will continue its ongoing work with the Texas 
Department of Agriculture and key organization contacts in an effort to raise awareness of this 
project among CAI.  Additionally, the Texas Broadband Task Force will be briefed at an upcoming 
meeting on the CAI project and will be made aware of the challenges we have faced it the state with 
collecting this data.  The Task Force members will be provided information with how they can assist 
with outreach and promotion over the coming months. 
   
A CAI summary of all processed and submitted data is provided below: 
 

CAI Type Total 
Physical 
Address Lat/Long 

Technology 
of 

Transmission 
Download 

Speed 
Upload 
Speed 

K-12 Schools 10,604 10,600 10,600 74 67 68
Libraries 1,135 1,135 1,135 99 254 96
Healthcare 868 868 867 76 159 78
Public Safety 2,907 2,907 2,871 252 539 250
Higher Ed Institutions 419 419 419 81 83 30
Other Government 703 703 702 446 61 27
Other Non-Government 0 0 0 0 0 0
Total 16,636 16,632 16,594 1,028 1,163 549
 
 
SBDD DATA SUBMISSION METHODOLOGY 

The submission of the broadband dataset for April 1, 2011, is contained within the SBDD Data 
Transfer Model and additional components as released on the Grantee Workspace on January 14, 
2011. Connected Nation has reviewed all literature that relates to the release and use of this data 
transfer model and recognizes that it does not replace or dictate how data is stored, processed, or 
displayed for the state or territory, as it is meant primarily as a means to transfer the broadband data 
from all states and territories and populate the National Broadband Map in a seamless fashion. 
Guidance from the Technical Mapping Guide, as released on the Grantee Workspace on March 24, 
2011, was also followed to ensure the completeness and validity of the submission through 
completion steps and checklists, completing the DataPackage spreadsheet, uploading broadband 
datasets into the Data Transfer Model, and checking the dataset using the SBDD_CheckSubmission 
receipt process.  
 
In addition to the narratives and methodologies contained herein, as well as the DataPackage.xls 
containing contact information, the data dictionary, and a provider summary table, the following 
feature classes are submitted within the SBDD Data Transfer Model for the state of Texas. 
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Inventory of Deliverables, Connected Texas: April 1, 2011 
 
NOFA Requirement Data Transfer Model Data Description 
Appendix A:  1(a)(i) BB_Service_CensusBlock Broadband Service Availability of 

Facilities-Based Providers in 
Census Blocks of No Greater 
Than Two Square Miles in Area. 

Appendix A:   1(a)(ii) BB_Service_RoadSegment Broadband Service Availability of 
Facilities-Based Providers by Road 
Segment in Census Blocks Larger 
in Area Than Two Square Miles. 

Appendix A:   1(b) BB_Service_Wireless Broadband Service Availability of 
Wireless Services Not Provided to 
a Specific Address. 

Appendix A:   3(b) BB_ConnectionPoint_MiddleMile Broadband Service Infrastructure 
Middle-Mile and Backbone 
Interconnection Points. 

Appendix A:   4 BB_Service_CAInstitutions  Community Anchor Institutions-
Listing. 

 
The provider data collected by Connected Nation on behalf of the state of Texas have been 
formatted per the given specifications and uploaded into the appropriate feature classes of the 
SBDD Data Transfer Model. Wireline availability is contained within census blocks and road 
segments, wireless availability is contained as polygons of coverage areas, and middle-mile 
connections and community anchor institutions are contained as point data. All speed data is 
contained at the census block, road segment, or wireless polygon level of availability. All efforts have 
been made to comply with formatting, domain, and metadata requirements to include as much 
information as possible.  
 
Connected Nation has continued outreach to satellite providers on their availability, technology, and 
speed information, but it is not included in this submission dataset.  Additional information is 
necessary to be able to show where service satisfactorily exists in the state, rather than submitting 
the entire boundary of the state as the serviceable area.  Analysis information distributed and 
discussed with the satellite providers, as well as any additional guidance from the Program Office on 
the desired analysis for satellite-serviceable areas, will be implemented for the October 2011 data 
submission.  
 
 
TEXAS FIELD VALIDATION NARRATIVE 

Connected Nation focused a portion of their time on specific validation processes such as: 
 

• conducting random spectrum analysis studies throughout the state using an Avcom PSA-37-
XP spectrum analyzer; 

• conducting mobile speed tests throughout the state using an iPhone, Android (or other 
smart phone) as well as provider-specific aircards (Sprint 3G/4G, Clearwire et al); 
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• identifying pre-selected, provider-submitted wireless transmit tower sites and cross-
referencing data about that tower against the Federal Communications Commission (FCC) 
databases such as Antenna Structure Registration and/or the Universal Licensing System; 

• cross-referencing Federal Registration Number data against available FCC Form 477 data as 
well as the FCC COmmission REgistration System (CORES); 

• validating provider submitted data (for example: latitude/longitude) using a handheld 
Garmin eTrex Summit GPS unit or GPS enabled software such as Microsoft Streets and 
Trips; 

• locating physical wire-line attributes (such as remote terminals, CATV plant, etc.) and 
comparing them against provider submitted data; and 

• conducting on-net and off-net speed tests using the FCC portal at 
http://www.broadband.gov/qualitytest/about/ or using the Ookla Net Metrics enabled 
speed test utility located on each of Connected Nation’s state specific websites. 

 
Additionally, Connected Nation cross-referenced numerous public documents in order to ensure 
that all known broadband providers were located and contacted.  This included searching 
membership logs from the trade associations (WISPA, WCAI, PCIA, etc.), the Cable Television Fact 
Book, Public Utility Commission records, Public Service Commission records, Chamber of 
Commerce, etc. 
 
To date Connected Nation’s staff conducted on-site validation tests in Texas on the following 
providers:  Alenco Communications Inc., Allegiance Communications, AT&T, AwesomeNet Inc., 
Basin 2 Way Radio Inc., Basin Broadband, Big Bend Telephone, BordertoBorder, Broadband Data 
Services of Texas LLC, Broadcomm, Cable One Inc., Cameron Telephone Company LLC, Cap 
Rock Telephone Cooperative Inc., Central Texas Cable Partners Inc., Central Texas Telephone 
Cooperative Inc., CenturyLink, Cequel Communications, Clearwire Corporation, Coleman County 
Telephone Cooperative Inc., Colorado Valley Telephone Cooperative Inc., Comcast Cable 
Communications LLC, Community Telephone Company Inc., Consolidated Communications, 
Cumby Telephone Cooperative Inc., DC Texas.Net, Dell Telephone Cooperative Inc., Digitex.com, 
Dot11 Networks, East Texas DSL, Eastex Telephone Cooperative Inc., ECTISP, ELC Internet 
Services Inc., Electra Telephone Company, Element Networks LLC, eNet, ERF Wireless, ETAN 
Industries,  ETS Cablevision Company Inc., Ganado Telephone Company, GEUS, Gower 
Computer Support Inc., Grande Communications, Grayson CableRocket LLC, Greasy Bend 
Ventures Inc., GTEK Communications, Guadalupe Valley Communications Systems, GVEC.net, 
Hill Country Telephone Cooperative Inc., JAB Wireless Inc., KeyOn Communications Inc., La 
Ward Telephone Exchange Inc., Lake Livingston Telephone Company, Leap Wireless International 
Inc.,  Live Air Networks, Livingston Telephone Company Incorporated, Maverick Internet, 
McDonald Group, Mid-Plains Rural Telephone Cooperative Inc., NetWest Online Inc., Neu 
Ventures Inc., Nortex Communications, North Texas Broadband LLC, North Texas Cellular Inc., 
Northland Communications, NTS Communications, Panhandle Telephone Cooperative Inc., 
Partnership Broadband Inc., Phantom Wave, Poka Lambro Telephone Cooperative Inc.,  Presidio 
Community Wireless Network, Promptwireless LLP, Qwest Communications, RB3 LLC, 
Ridgewood Cable, Rioplex, Riveria Telephone Company Inc., Rock Solid Internet and Telephone, 
Santa Rosa Telephone Cooperative Inc., Smithville System, South Plains Telephone Cooperative 
Inc., Southeast Arkansas Telephone Cooperative Inc., Southwest Texas Telephone Company, Speed 



                                      Connected Texas – Narratives and Methodologies 
 

 

 
April 1, 2011  Page 12 
 

of Light Broadband Inc., Sprint, Stelera Wireless LLC, Surf-Side Net, Taylor Telephone 
Cooperative, Texas Broadband Inc., Texas CellNet, Texas Wireless Internet, Texhoma Wireless, 
Tier One Converged Networks Inc., Time Warner Cable Inc., TISD, T-Mobile USA Inc., Totelcom 
Communications LLC, tw telecom, Valley Telephone Cooperative Inc., Verizon Southwest Inc., 
Wes-Tex Telecommunications Ltd., Wharton County Electric Cooperative Inc., Windstream 
Communications, and XIT Telecommunications & Technology Ltd.  
 
During this reporting period, Connected Nation conducted 13 additional on-site validation tests 
with AT&T, Big Bend Telephone, BordertoBorder, Broadcomm, Presidio Community Wireless 
Network, Rioplex, Southeast Arkansas Telephone Cooperative Inc., and Valley Telephone 
Cooperative Inc. 
 
From program initiation through this reporting period, Connected Nation has completed in-the-
field validation testing against 103 companies (out of a universe of 185 viable providers) totaling 
55.68% within the state of Texas. 
 
 
ACCURACY AND VERIFICATION:  METHODOLOGY - PROVIDER VALIDATION 

Broadband providers maintain their service area data in many different formats, all in varying levels 
of complexity and granularity. In order to ensure that the data required by the NTIA is standardized 
across all providers and that it is as accurate as possible, Connected Nation translates and formats 
the data that providers are able to supply into a GIS shapefile and produces maps for the provider to 
review.  The resulting map(s) and review process allow for providers to see their service area in a 
geographic format – for some providers, this is the first time they have seen maps of their 
broadband service area. Having the mapped service area allows providers to quickly identify any 
issues that appear in the data representation, whether the issue is in the data translation into a GIS 
format or from the original data collection and submission. Often data is provided from various 
sources and through the review and revision process, local engineers who operate the networks and 
work in the field are able to ensure that the tabular data that has been submitted is accurate and 
represents the real-world network extent. Any issues in how the service area is represented on the 
map(s) are remedied by Connected Nation, whether they are additions, removal of service, or any 
other revisions. Revised maps of service area representations are sent to the provider for review and 
approval; Connected Nation will revise data and return maps as many times as necessary until the 
provider is in agreement that the map represents their service area as accurately as possible. Once 
the review process has been completed and final approval of the data is provided, the data is deemed 
ready for NTIA submission. 
 
Once the data collection has been aggregated a statewide level, static maps of statewide and county-
level availability are produced and made publicly available. In addition, consumers can visit the 
interactive online tool, BroadbandStat, to create customized views of broadband service areas and 
analyze corresponding demographic information. Leveraging broadband service data on various 
platforms allows for public users, providers, and other stakeholders to review, scrutinize, and 
provide feedback on the represented data. This feedback becomes a validation method in itself as 
consumers submit inquiries to Connected Nation either affirming where service is not available or 
identifying areas where broadband service is shown on the map, but in actuality is not available. This 
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allows for a follow-up to providers regarding revisions to the data as it is represented; it also allows 
for Connected Nation to identify locations where on-site visits may be necessary to complete field 
validation of available services. Public feedback on all forms of mapping products serves as a 
localized validation method for provider-supplied information and allows Connected Nation to 
resolve inaccuracies as they are identified to ensure that only the highest quality information is 
provided to stakeholders. 
 
Estimates derived from provider-validated data indicate that approximately 3.15% of Texas 
households do not have terrestrial fixed broadband service available, and approximately 0.3%1 of 
Texas households have neither mobile nor fixed broadband service available.2   
 
Within rural areas of the state, results derived from provider-validated data indicate that 
approximately 9.76% of rural Texas households do not have terrestrial fixed broadband service 
available, and approximately 0.96%3 of rural Texas households have neither mobile nor fixed 
broadband service available.4   
 
 
WIRELESS METHODOLOGY 

 
Broadband Service Availability in Provider’s Service Area 

Wireless Services Not Provided to a Specific Address 
 
Data solicited from a fixed wireless provider to create propagation models include, but are not 
limited to: 

1. The name of the structure 
2. Whether the transmitting device is operational or proposed 
3. The maximum advertised downstream speed, the maximum advertised upstream speed 
4. The typical downstream speed, the typical upstream speed (peak periods for both) 
5. The frequency range of spectrum being used (as prescribed by NTIA) 
6. The primary population center(s) being served (for geopolitical boundary reference) 
7. The physical address of the transmit site (in the event latitude/longitude is unavailable from 

the provider this allows a quick reference point for geocoding) 

                                                            
1 In accordance with NTIA’s definition of available broadband service as specified in the SBDD NOFA, this estimate 

includes both terrestrial fixed and mobile broadband service, if the service offers download speeds of at least 768 Kbps 
and upload speeds greater than 200 Kbps. 

2 Due to the nature of the SBDD data collection methodology as defined by the NTIA and based on both census 
block geographic units and street segment data, the estimates of broadband availability derived from provider-validated 
data may include an overstatement of the actual number of households with broadband availability.  Under the census 
block-based data collection method, a provider will typically report broadband availability for an entire census block 
whether its network is present across the whole or only a subset of that census block.  This potential overestimation at 
the census block level can be amplified as the data is aggregated across the entire state. 

3 See footnote 1. 
4 See footnote 2. 
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8. Latitude in either Degrees, Minutes and Seconds and/or in Decimal Degrees (typically 
received as NAD 27 or NAD 83)  

9. Longitude in either Degrees, Minutes and Seconds and/or in Decimal Degrees (typically 
received as NAD 27 or NAD 83)  

10. Antenna pattern (e.g. omni-directional, 180°, 120°, 90°, etc.) 
11. Azimuth of antenna (e.g. 360° with magnetic declination if known) 
12. Approximate transmit radius (in feet, miles, or kilometers) 
13. Polarity of transmit antenna (Vertical or Horizontal) 
14. Transmit antenna gain (in dBi) 
15. Line loss (applicable only to providers using coax, heliax, waveguide or other forms of 

cabling – excludes power-over-Ethernet devices) 
16. Mechanical and/or Electrical beam tilt (if applicable) 
17. Equipment Manufacturer (allows easy cross-reference against manufacturer’s specification 

sheet) 
18. Power output of the transmitting device (if unknown, FCC standards or manufacturer 

specifications are applied) 
19. AMSL at base of tower site 
20. Antenna centerline AGL (height of antenna above ground level measured at the centerline 

of the actual antenna) 
21. Foliage factors (Evergreens/Deciduous and percent of ground cover) 
22. Ground Clutter (primarily used in rural areas to account for foliage and in metropolitan areas 

to account for types and heights of buildings if known)   
23. Average gain of receive antenna 
24. Receive antenna is estimated at height above average terrain (HAAT) of 6.2 meters/20 feet. 
25. Federal Registration Numbers (if applicable) which may allow opportunities to cross-

reference and/or obtain additional data from the Federal Communications Commission 
Universal Licensing System and the COmmission REgistration System. 

 
Propagation modeling is an empirical mathematical formulation for the characterization of radio 
wave propagation as a function of frequency, distance, and other conditions. Propagation 
software(s) typically use the Irregular Terrain Model (also known as Longley-Rice) of radio 
propagation for frequencies between 20 MHz and 20 GHz. This model is based on electromagnetic 
theory and statistical analyses of the combination of terrain features and radio measurements, then 
predicting the median attenuation of a radio signal as a function of distance and the variability of the 
signal in time and in space.  For metropolitan areas, the software can typically be adjusted to use the 
Okumura-Hata model which accounts for predicting the behavior of cellular transmissions in areas 
where buildings are the primary obstructions. The resulting product from either model depicts a 
graphical illustration of the theoretical propagation characteristics of a selected frequency range 
based on defined variables (receiver sensitivity of the home/mobile device, foliage factor, and digital 
elevation terrain input). 
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BROADBAND INQUIRIES METHODOLOGY 

Connected Nation collects consumer feedback in the form of broadband inquiries. These inquiries 
represent any type of communication received from the public regarding broadband service. Once 
broadband inquiries are received across the state, this information is overlaid with the broadband 
availability information which was collected through the SBDD program.  This allows for a real-
world comparison of the broadband landscape to the information received from broadband 
inquiries.  Broadband inquiries are able to provide three types of information:  1) Residents who do 
not have broadband but want it.  2)  Residents who have broadband but want a different provider.  
3)  Residents who do not have broadband, but the broadband inventory maps indicate that they do. 
 
Through the collection of broadband inquiries, a visual demand for broadband is presented.  This 
visualization allows Connected Nation the ability to validate broadband availability maps for 
accuracy.  If residents within a region state that they are without broadband, but the broadband 
inventory maps show otherwise, this allows Connected Nation to approach the providers within that 
area in an effort to trim down their coverage to more accurately represent real-world availability on 
the ground.  On the other hand, if there is a region in the territory in which broadband is not 
available, the broadband inquiries allow providers close to that region to see where they can 
successfully expand their broadband networks, leading to a high return on investment.  In short, the 
higher number of inquiries leads to a higher level of certainty in regard to the broadband availability 
maps.  Since the initial data collection and release of corresponding maps, feedback in the form of 
broadband inquiries has allowed Connected Nation to identify additional areas that are in need of 
field validation, which are scheduled as soon as possible. Additional information on field validation 
can be found in the Field Validation Narrative. 
 
The broadband inquiry process has been implemented in each of the Connected Nation state 
programs with successful results. Altogether Connected Nation has received over 16,000 broadband 
inquiries since 2007, allowing the state programs to evaluate each inquiry for broadband demand and 
data verification.  These inquiries are continuously examined against current broadband availability, 
updated every six months, to determine if previously unserved households have been expanded to 
and can now receive broadband at their residence. This database of broadband inquiries has also 
allowed the Connected Nation state programs to aggregate demand in concentrated areas to show 
providers the exact locations where the population has made it clear that they would purchase 
broadband if it was made available to them. Providers in the states have responded to this process 
and have expanded to areas knowing that their investment will be worthwhile. Data verification 
methods have also proven successful, as the state programs have been able to show those inquiries 
that indicate the broadband service areas are misrepresented on the map to providers, who then 
verify where service cannot reach in regard to that residence(s). The broadband coverage in these 
states has been altered to create a more accurate map based on the inquiries submitted by the public. 
 
During this reporting period, the Connected Texas project has received a total of 66 inquiries (429 
grant inception to date).  As more inquiries are submitted to Connected Texas, a more thorough 
validation of the broadband landscape can be performed, while also allowing providers to see which 
areas have a high demand for broadband adoption. 
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BROADBANDSTAT METHODOLOGY  

BroadbandStat is an online, interactive mapping tool for viewing, analyzing, and validating 
broadband data. Developed through a partnership with ESRI, the market leader in geographic 
information system (GIS) software, BroadbandStat is a multi-functional, user-friendly way for local 
leaders, policymakers, consumers, and technology providers to devise a plan for the expansion and 
adoption of broadband.  
 
First and foremost, BroadbandStat allows consumers to locate their residence and identify providers 
that offer broadband Internet service to that location. The interactive platform allows for users to 
build and evaluate broadband expansion scenarios using a wealth of data, including education and 
population demographics, broadband availability, and research about the barriers to adoption.  
 
New functionality in BroadbandStat allows the consumer to provide feedback on the broadband 
data displayed on the interactive map.  Through the collection of this feedback, a visual demand for 
broadband is presented.  This visualization allows the Connected Nation state programs the ability 
to validate the broadband availability for accuracy.  If residents within a region state they are without 
broadband, but the interactive map shows otherwise, this allows Connected Nation to approach the 
providers within that area in an effort to trim down their coverage to more accurately represent real-
world availability on the ground.   
 
The Connected Texas project launched BroadbandStat on June 16, 2010, and has received a total of 
13,536 visits to date, of which 1,779 occurred this reporting period. 
 
 
SPEED TEST METHODOLOGY 

The 1,025 speed tests that are represented in the Connected Texas Speed Test Report during this 
reporting period (5,271 grant inception to date) are the result of a partnership between Connected 
Nation and Ookla Net Metrics. Utilizing this relationship increases the level of confidence in the 
data being collected and provides for a far greater sample size than could be collected by a single 
testing site. 
 
Ookla owns and operates Speedtest.net, as well as develops and deploys speed tests, such as the 
Connected Texas speed test website, for partners around the world. This network of sites that is 
developed and run on its testing technology provides Ookla with a vast dataset that, due to the 
variability of geographic information collected across the varying speed test sites, is geocoded 
utilizing Geo-IP technology. This technology allows for tests to be geocoded to points of 
aggregation, typically larger nodes across provider networks.  While there are hundreds of thousands 
of tests that have been conducted, the level of aggregation is only sufficient for county-level detail 
due to the test results being located at these larger nodes and not at an absolute location for each 
speed test. 
 
In an effort to validate broadband data from the Connected Texas project, speed test information is 
collected throughout the state.  Speed tests provide speed information on the path taken through all 
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networks (a provider’s network as well as additional networks) a local machine must connect to in 
order to reach the host test.  The benefit of this collection of speed information is two-tiered.  First, 
it allows for a comprehensive dataset of speeds, while also providing Connected Texas with the 
information on where broadband services are available.  Second, unlike theoretical speed 
information which was received through the data collection process, the use of speed tests provide 
real-world information on the speeds that currently exist within the state of Texas.   
 

	



Complete 233
Non-Responsive/Refused 37
In Progress 19

Count of Datasets by Status 289
Total Unique Providers Represented 185

Provider Name Platform Status

NDA 
Execution 

Date Notes
Alenco Communications, Inc. Fiber Data Added to Statewide Inventory 11/17/2009
AT&T Inc. ILEC/CLEC Data Added to Statewide Inventory 12/16/2009
AT&T Inc. Mobile Wireless Data Added to Statewide Inventory 12/16/2009
AwesomeNet, Inc. Fixed Wireless Data Added to Statewide Inventory
Basin 2 Way Radio, Inc. Fixed Wireless Data Added to Statewide Inventory 4/14/2010
C. T. Cube Fixed Wireless Data Added to Statewide Inventory 4/22/2010
Cable ONE Inc. Cable Data Added to Statewide Inventory 12/7/2009
Cap Rock Telephone Cooperative, Inc. Fixed Wireless Data Added to Statewide Inventory 3/4/2010
Celltex Networks, LLC Fixed Wireless Data Added to Statewide Inventory
CenturyLink ILEC/CLEC Data Added to Statewide Inventory 12/4/2009
Charter Communications Cable Data Added to Statewide Inventory 12/15/2009
Clearwire Corporation Fixed Wireless Data Added to Statewide Inventory 3/3/2010
Clearwire Corporation Mobile Wireless Data Added to Statewide Inventory 3/3/2010
Coleman County Telephone Cooperative, Inc. ILEC/CLEC Data Added to Statewide Inventory 3/10/2010
Comcast Cable Communications, LLC Cable Data Added to Statewide Inventory 12/7/2009
Community Telephone Company, Inc. ILEC/CLEC Data Added to Statewide Inventory 3/10/2010
Consolidated Communications ILEC/CLEC Data Added to Statewide Inventory 11/30/2009
CTX Unwired Fixed Wireless Data Added to Statewide Inventory 2/14/2011
Cumby Telephone Cooperative, Inc. Fiber Data Added to Statewide Inventory 3/5/2010
DCTexas.Net Fixed Wireless Data Added to Statewide Inventory 6/15/2010
Dot 10 Wireless Fixed Wireless Data Added to Statewide Inventory
Eastex Telephone Cooperative, Inc. ILEC/CLEC Data Added to Statewide Inventory
Eccentrix Technologies, LLC Fixed Wireless Data Added to Statewide Inventory 3/30/2010
Element Networks, LLC Fixed Wireless Data Added to Statewide Inventory 5/14/2010
ENMR Telephone Cooperative, Inc. Fiber Data Added to Statewide Inventory 4/22/2010
ERF Wireless Fixed Wireless Data Added to Statewide Inventory
Five Area Telephone Cooperative, Inc. ILEC/CLEC Data Added to Statewide Inventory 3/8/2010
Gower Computer Support, Inc. Fixed Wireless Data Added to Statewide Inventory 2/14/2011
GTEK Communications Fixed Wireless Data Added to Statewide Inventory 5/24/2010
Guadalupe Valley Communications Systems Fiber Data Added to Statewide Inventory 11/23/2009
Guadalupe Valley Communications Systems ILEC/CLEC Data Added to Statewide Inventory 11/23/2009
GVEC.net Fixed Wireless Data Added to Statewide Inventory 2/25/2010
Helmsco, Inc. Fixed Wireless Data Added to Statewide Inventory 2/15/2010
Hi Speed Wireless Fixed Wireless Data Added to Statewide Inventory 2/22/2011
IGN-LPG Enterprises L.L.C. Fixed Wireless Data Added to Statewide Inventory 2/17/2011
Industry Tel. Co. ILEC/CLEC Data Added to Statewide Inventory 11/6/2009
JAB Wireless, Inc. Fixed Wireless Data Added to Statewide Inventory 6/14/2010
Leap Wireless International, Inc. Mobile Wireless Data Added to Statewide Inventory 4/6/2010
Maverick Internet Fixed Wireless Data Added to Statewide Inventory 6/4/2010
Mid-Plains Rural Tel. Co-op. Inc. ILEC/CLEC Data Added to Statewide Inventory 3/5/2010
Mid-Plains Rural Tel. Co-op. Inc. Fiber Data Added to Statewide Inventory 3/5/2010
Millennium Telcom, LLC Fixed Wireless Data Added to Statewide Inventory 8/26/2010
Neu Ventures, Inc. Fixed Wireless Data Added to Statewide Inventory 6/17/2010
Nortex Communications Cable Data Added to Statewide Inventory 2/12/2010
Nortex Communications Fiber Data Added to Statewide Inventory 2/12/2010
Nortex Communications ILEC/CLEC Data Added to Statewide Inventory 2/12/2010
Nortex Communications Fixed Wireless Data Added to Statewide Inventory 2/12/2010
North Texas Cellular, Inc. ILEC/CLEC Data Added to Statewide Inventory 3/22/2010
Northland Communications Cable Data Added to Statewide Inventory 8/19/2010
Poka Lambro Telephone Cooperative, Inc. Fixed Wireless Data Added to Statewide Inventory 2/15/2010
Poka Lambro Telephone Cooperative, Inc. ILEC/CLEC Data Added to Statewide Inventory 2/15/2010
RB3, LLC Fixed Wireless Data Added to Statewide Inventory 10/23/2009
RB3, LLC Cable Data Added to Statewide Inventory 10/23/2009
Ridgewood Cable Fixed Wireless Data Added to Statewide Inventory
Rock Solid Internet & Telephone Fixed Wireless Data Added to Statewide Inventory 2/14/2011
South Plains Telephone Cooperative, Inc. Fiber Data Added to Statewide Inventory 3/15/2010
South Plains Telephone Cooperative, Inc. ILEC/CLEC Data Added to Statewide Inventory 3/15/2010
Speed of Light Broadband, Inc. Fixed Wireless Data Added to Statewide Inventory 11/3/2009
Sprint Nextel Corporation Mobile Wireless Data Added to Statewide Inventory 1/14/2010
Stelera Wireless, LLC Mobile Wireless Data Added to Statewide Inventory
T-Mobile USA, Inc. Mobile Wireless Data Added to Statewide Inventory 1/8/2010
Texas CellNet Fixed Wireless Data Added to Statewide Inventory 2/17/2011
TGN Cable Cable Data Added to Statewide Inventory 5/20/2010
Time Warner Cable LLC. Cable Data Added to Statewide Inventory 12/21/2009
United States Cellular Corporation Mobile Wireless Data Added to Statewide Inventory 2/15/2011
Verizon Southwest, Inc. ILEC/CLEC Data Added to Statewide Inventory 12/14/2009
Verizon Southwest, Inc. Fiber Data Added to Statewide Inventory 12/14/2009
Verizon Southwest, Inc. Mobile Wireless Data Added to Statewide Inventory 12/14/2009
WEHCo Video Cable Data Added to Statewide Inventory
Wharton County Electric Cooperative, Inc. Fixed Wireless Data Added to Statewide Inventory 4/15/2010
Windstream Communications ILEC/CLEC Data Added to Statewide Inventory 1/19/2010
XIT Telecommunications & Technology, Ltd. Fiber Data Added to Statewide Inventory 3/2/2010
XIT Telecommunications & Technology, Ltd. ILEC/CLEC Data Added to Statewide Inventory 3/2/2010

Zito Midwest, LLC Cable Data Added to Statewide Inventory 2/17/2011
[JAN-19-11 Daryl Coffey] Zito Midwest 
purchased Galaxy Cable.

Alenco Communications, Inc. Backhaul Backhaul Provider Only Processing Complete 11/17/2009

Broadband Provider Log



CenturyLink Backhaul Backhaul Provider Only Processing Complete 12/4/2009
Cogent Communications, Inc. Backhaul Backhaul Provider Only Processing Complete
Covad Communications Backhaul Backhaul Provider Only Processing Complete 1/19/2010
Level 3 Communications, LLC Backhaul Backhaul Provider Only Processing Complete 12/14/2009
Mid-Plains Rural Tel. Co-op. Inc. Backhaul Backhaul Provider Only Processing Complete 3/5/2010
South Plains Telephone Cooperative, Inc. Backhaul Backhaul Provider Only Processing Complete 3/15/2010
Sprint Nextel Corporation Backhaul Backhaul Provider Only Processing Complete 1/14/2010
T-Mobile USA, Inc. Backhaul Backhaul Provider Only Processing Complete 1/8/2010
Zayo Bandwidth, LLC Backhaul Backhaul Provider Only Processing Complete

Cequel Communications Cable
Approval for Update Not Received - Use Last 
Submission Data 12/15/2009

McleodUSA Telecommunications Services, Inc. ILEC/CLEC Provider Approval Solicited
C. T. Cube ILEC/CLEC Provider Gathering Data 4/22/2010
Consolidated Communications Fiber Provider Gathering Data 11/30/2009
Star-NET Online Systems Fixed Wireless Provider Gathering Data
360networks Backhaul No Update to Provide 1/19/2010
AirBand Communications, Inc. Backhaul No Update to Provide 3/29/2010
Aledo Broadband Fixed Wireless No Update to Provide 3/26/2010
Aledo Broadband Backhaul No Update to Provide 3/26/2010
Alenco Communications, Inc. ILEC/CLEC No Update to Provide 11/17/2009
Alenco Communications, Inc. Fixed Wireless No Update to Provide 11/17/2009
Allegiance Communications Cable No Update to Provide 2/4/2010
Argon Technologies Fixed Wireless No Update to Provide
AT&T Inc. Backhaul No Update to Provide 12/16/2009
Big Bend Telephone Company, Inc. Backhaul No Update to Provide 3/10/2010
Big Bend Telephone Company, Inc. Fiber No Update to Provide 3/10/2010
Big Bend Telephone Company, Inc. ILEC/CLEC No Update to Provide 3/10/2010
Blossom Telephone Company, Inc. ILEC/CLEC No Update to Provide 3/26/2010
Border to Border Communications, Inc. ILEC/CLEC No Update to Provide
Brazoria Telephone Company Cable No Update to Provide 6/17/2010
Brazoria Telephone Company ILEC/CLEC No Update to Provide 6/17/2010
Broadband Data Services of Texas, LLC Fixed Wireless No Update to Provide 4/29/2010
Broadcomm.US Fixed Wireless No Update to Provide 3/9/2011
Cameron Telephone Company, LLC Backhaul No Update to Provide 3/18/2010
Cameron Telephone Company, LLC ILEC/CLEC No Update to Provide 3/18/2010
Cap Rock Telephone Cooperative, Inc. Backhaul No Update to Provide 3/4/2010
Cap Rock Telephone Cooperative, Inc. Fiber No Update to Provide 3/4/2010
Cap Rock Telephone Cooperative, Inc. ILEC/CLEC No Update to Provide 3/4/2010
Central Texas Cable Partners, Inc. Cable No Update to Provide 2/22/2010
Central Texas Telephone Cooperative, Inc. ILEC/CLEC No Update to Provide 3/2/2010
Central Texas Telephone Cooperative, Inc. Fixed Wireless No Update to Provide 3/2/2010
Cequel Communications Backhaul No Update to Provide 12/15/2009
Charter Communications Backhaul No Update to Provide 12/15/2009
Coleman County Telephone Cooperative, Inc. Fixed Wireless No Update to Provide 3/10/2010
Colorado Valley Telephone Cooperative, Inc. ILEC/CLEC No Update to Provide 3/9/2010
Colorado Valley Telephone Cooperative, Inc. Fixed Wireless No Update to Provide 3/9/2010
Community Telephone Company, Inc. Backhaul No Update to Provide 3/10/2010
Connextions Telcom Fiber No Update to Provide 3/2/2011
Connextions Telcom ILEC/CLEC No Update to Provide 3/2/2011
Cumby Telephone Cooperative, Inc. ILEC/CLEC No Update to Provide 3/5/2010
Dell Telephone Cooperative, Inc. Backhaul No Update to Provide 4/6/2010
Dell Telephone Cooperative, Inc. Fiber No Update to Provide 4/6/2010
Dell Telephone Cooperative, Inc. Fixed Wireless No Update to Provide 4/6/2010
Dell Telephone Cooperative, Inc. ILEC/CLEC No Update to Provide 4/6/2010
Digitex.com Fixed Wireless No Update to Provide 5/25/2010
Digitex.com Backhaul No Update to Provide 5/25/2010
ECTISP Fixed Wireless No Update to Provide
ELC Internet Services, Inc. Fixed Wireless No Update to Provide 3/4/2011
Electra Telephone Company ILEC/CLEC No Update to Provide 11/24/2009
eNet Fixed Wireless No Update to Provide
ENMR Telephone Cooperative, Inc. Backhaul No Update to Provide 4/22/2010
ENMR Telephone Cooperative, Inc. ILEC/CLEC No Update to Provide 4/22/2010
ETAN Industries Cable No Update to Provide
ETS Cablevision Co., Inc. Cable No Update to Provide 10/30/2009
ETS Cablevision Co., Inc. Fiber No Update to Provide 10/30/2009
Farm to Market Broadband LP Fixed Wireless No Update to Provide 4/16/2010
Five Area Telephone Cooperative, Inc. Fiber No Update to Provide 3/8/2010
Ganado Telephone Company, Inc. ILEC/CLEC No Update to Provide 11/16/2009
GEUS Cable No Update to Provide
Gilmer Cable Television Company, Inc. Cable No Update to Provide 6/18/2010
Grande Communications Network LLC Cable No Update to Provide 3/31/2010
Grayson CableRocket, LLC Cable No Update to Provide 6/15/2010
Greasy Bend Ventures, Inc. Fixed Wireless No Update to Provide 8/16/2010
GTEK Communications Backhaul No Update to Provide 5/24/2010
Guadalupe Valley Communications Systems Cable No Update to Provide 11/23/2009
GVEC.net Backhaul No Update to Provide 2/25/2010
Hill Country Telephone Cooperative, Inc. Backhaul No Update to Provide 3/9/2011
Hill Country Telephone Cooperative, Inc. Fixed Wireless No Update to Provide 3/9/2011
Hill Country Telephone Cooperative, Inc. ILEC/CLEC No Update to Provide 3/9/2011
James Cable, LLC Cable No Update to Provide 1/11/2010
James Cable, LLC Fixed Wireless No Update to Provide 1/11/2010
KeyOn Communications, Inc. Fixed Wireless No Update to Provide 10/15/2009
La Ward Telephone Exchange, Inc. ILEC/CLEC No Update to Provide 11/16/2009
Lake Livingston Telephone Company ILEC/CLEC No Update to Provide 11/20/2009
Livingston Telephone Company Incorporated ILEC/CLEC No Update to Provide 2/25/2010
Livingston Telephone Company Incorporated Backhaul No Update to Provide 2/25/2010
Maverick Internet Backhaul No Update to Provide 6/4/2010
McDonald Group Cable No Update to Provide 3/5/2010
Millennium Telcom, LLC Cable No Update to Provide 8/26/2010
Millennium Telcom, LLC ILEC/CLEC No Update to Provide 8/26/2010
Millennium Telcom, LLC Fiber No Update to Provide 8/26/2010
NetWest Online, Inc. Fixed Wireless No Update to Provide 2/23/2010
Neu Ventures, Inc. Backhaul No Update to Provide 6/17/2010
Neu Ventures, Inc. Cable No Update to Provide 6/17/2010



Nextlink Wireless, Inc. Backhaul No Update to Provide 2/12/2010
Nortex Communications Backhaul No Update to Provide 2/12/2010
North Texas Broadband, LLC Cable No Update to Provide 3/1/2010
North Texas Telephone Company ILEC/CLEC No Update to Provide 11/30/2009
NTS Communications ILEC/CLEC No Update to Provide
NTS Communications Fiber No Update to Provide
Our-Town Internet Service Fixed Wireless No Update to Provide 3/31/2010
Panhandle Telephone Cooperative, Inc. ILEC/CLEC No Update to Provide 12/7/2009
Panhandle Telephone Cooperative, Inc. Cable No Update to Provide 12/7/2009
Panhandle Telephone Cooperative, Inc. Fixed Wireless No Update to Provide 12/7/2009
Peoples Communication, Inc. ILEC/CLEC No Update to Provide 3/4/2010
Peoples Communication, Inc. Backhaul No Update to Provide 3/4/2010
Poka Lambro Telephone Cooperative, Inc. Fiber No Update to Provide 2/15/2010
Poka Lambro Telephone Cooperative, Inc. Backhaul No Update to Provide 2/15/2010
Promptwireless, LLP Fixed Wireless No Update to Provide 4/27/2010
Pulsestream Internet Services Backhaul No Update to Provide
Rhino Communications Fixed Wireless No Update to Provide
Rioplex Wireless LTD Fixed Wireless No Update to Provide 3/3/2010
Riviera Telephone Company, Inc. Backhaul No Update to Provide 3/11/2010
Riviera Telephone Company, Inc. ILEC/CLEC No Update to Provide 3/11/2010
Santa Rosa Telephone Cooperative, Inc. Backhaul No Update to Provide 3/9/2010
Santa Rosa Telephone Cooperative, Inc. Fiber No Update to Provide 3/9/2010
Santa Rosa Telephone Cooperative, Inc. Fixed Wireless No Update to Provide 3/9/2010
Santa Rosa Telephone Cooperative, Inc. ILEC/CLEC No Update to Provide 3/9/2010
SmartBurst, LLC Fixed Wireless No Update to Provide 8/4/2010
Smithville System Fixed Wireless No Update to Provide 6/17/2010
Southwest Arkansas Telephone Cooperative, Inc. Backhaul No Update to Provide 1/19/2010
Southwest Arkansas Telephone Cooperative, Inc. ILEC/CLEC No Update to Provide 1/19/2010
Southwest Texas Telephone Company Fixed Wireless No Update to Provide 3/3/2010
Tatum Telephone Company ILEC/CLEC No Update to Provide 11/24/2009
Taylor Telephone Cooperative, Inc. Backhaul No Update to Provide 3/11/2010
Taylor Telephone Cooperative, Inc. Fiber No Update to Provide 3/11/2010
Taylor Telephone Cooperative, Inc. ILEC/CLEC No Update to Provide 3/11/2010
Texas Broadband, Inc. Fixed Wireless No Update to Provide 5/12/2010
Texas Wireless Internet Fixed Wireless No Update to Provide 5/14/2010
Texhoma Wireless Fixed Wireless No Update to Provide 3/8/2011
Tier One Converged Networks, Inc. Fixed Wireless No Update to Provide 3/24/2010
Time Warner Cable LLC. Backhaul No Update to Provide 12/21/2009
TISD Fixed Wireless No Update to Provide 4/19/2010
Totelcom Communications, LLC Fixed Wireless No Update to Provide 11/30/2009
Totelcom Communications, LLC ILEC/CLEC No Update to Provide 11/30/2009
tw telecom of texas, llc Backhaul No Update to Provide 3/10/2010
US Cable Corp. Cable No Update to Provide 5/20/2010
Valley Telephone Cooperative, Inc. Backhaul No Update to Provide 11/24/2009
Valley Telephone Cooperative, Inc. Fiber No Update to Provide 11/24/2009
Valley Telephone Cooperative, Inc. Fixed Wireless No Update to Provide 11/24/2009
Valley Telephone Cooperative, Inc. ILEC/CLEC No Update to Provide 11/24/2009
Verizon Southwest, Inc. Backhaul No Update to Provide 12/14/2009
Versalink Enterprises, LLC Cable No Update to Provide 5/11/2010
Wes-Tex Telecommunications, Ltd. Backhaul No Update to Provide 3/1/2010
Wes-Tex Telecommunications, Ltd. Fixed Wireless No Update to Provide 3/1/2010
Wes-Tex Telecommunications, Ltd. Cable No Update to Provide 3/1/2010
Wes-Tex Telecommunications, Ltd. ILEC/CLEC No Update to Provide 3/1/2010
West Texas Rural Telephone Cooperative, Inc. Cable No Update to Provide 3/31/2010
West Texas Rural Telephone Cooperative, Inc. Fiber No Update to Provide 3/31/2010
West Texas Rural Telephone Cooperative, Inc. Backhaul No Update to Provide 3/31/2010
West Texas Rural Telephone Cooperative, Inc. ILEC/CLEC No Update to Provide 3/31/2010
Wharton County Electric Cooperative, Inc. Backhaul No Update to Provide 4/15/2010
XO Communications, LLC Backhaul No Update to Provide 2/12/2010
Basin Broadband, Inc. Fixed Wireless No Update Provided - Use Last Submission Data 3/23/2010
CIT Broadband Fixed Wireless No Update Provided - Use Last Submission Data
East Texas DSL Fixed Wireless No Update Provided - Use Last Submission Data 5/25/2010
ETEX Communications, LP ILEC/CLEC No Update Provided - Use Last Submission Data 2/25/2010
ETEX Communications, LP Fiber No Update Provided - Use Last Submission Data 2/25/2010
ETEX Communications, LP Backhaul No Update Provided - Use Last Submission Data 2/25/2010
Southwest Texas Telephone Company ILEC/CLEC No Update Provided - Use Last Submission Data 3/3/2010
Southwest Texas Telephone Company Backhaul No Update Provided - Use Last Submission Data 3/3/2010
Windstream Communications Backhaul No Update Provided - Use Last Submission Data 1/19/2010
Phonoscope Enterprises Group, LLC Cable Solicited Initial Data 5/20/2010
Phonoscope Enterprises Group, LLC Backhaul Solicited Initial Data 5/20/2010
Presidio Community Wireless Network Fixed Wireless Solicited Initial Data
Reliance Globalcom Services, Inc. Backhaul Solicited Initial Data
Texas Communications Fixed Wireless Solicited Initial Data
Texas Communications ILEC/CLEC Solicited Initial Data

AMA TechTel Fixed Wireless Refused to Participate

[FEB-01-11 David Coffey] Representative stated 
they would not participate as long as the "big 
boys" were involved (ATT, Verizon, etc.).  I told 
him I would call him again in about six months to 
see if he had changed his mind.  He did thank 
me for calling and keeping them in mind.

Anvil Communications Fixed Wireless Refused to Participate

[JAN-14-11 Dwayne Goodman] Spoke directly to 
a company representative. He still refuses to 
participate saying that he doesn't need 
marketing help and doesn't feel there is a 
benefit.

Broadwaves Fixed Wireless Refused to Participate

[FEB-16-11 Daryl Coffey] Spoke with the 
provider who said "I don't care to be on 
there...right now, at least."

Buford Media Group Cable Refused to Participate

[JAN-19-11 Daryl Coffey] Sent an e-mail to which 
the provider responded saying "We are still not 
interested at this time."



Cybercom Corporation Fixed Wireless Refused to Participate

[JAN-05-11 David Coffey] Attempted to 
telephone representatives of the company to 
invite them to participate in the Texas broadband 
mapping initiative.  I spoke with an associate that 
stated that they were still not interested in 
participating with the initiative.

ELP Networks, Inc. Fixed Wireless Refused to Participate

[JAN-05-11 David Coffey] Spoke with owner who 
conveyed that he is contemplating selling his 
fixed wireless operations. He stated he would 
wait to send in documentation until he decided 
what he was going to do.  If he does not sell he 
would consider joining the program this fall. 
Right now he has no interest with participation.

Fiberlight, LLC Backhaul Refused to Participate 4/20/2010

[FEB-24-11 Dwayne Goodman] A company 
representative responded to the 2010 outreach 
process refusing to provide backhaul 
information; the company sees no reason to give 
up confidential information. The company has 
been non-responsive to the April 2011 
submission requests; therefore, it is assumed the 
refusal status still stands.

Gecko Inter.net Fixed Wireless Refused to Participate

[JAN-14-11 Dwayne Goodman] Spoke to a 
company representative indicating the 
management still does not have any interest to 
participate with the broadband mapping project.

Internet America Wireless Internet Access Fixed Wireless Refused to Participate

[JAN-14-11 Dwayne Goodman] A company 
representative has been non-responsive to 
voicemails and e-mails. Left voicemail indicating 
if a call is not returned, an assumption will be 
made that his position of "Refusal to Participate" 
still stands as noted for the October 2010 map 
release.

SOS Communications Fixed Wireless Refused to Participate

[JAN-24-11 David Coffey] Received an e-mail 
from SOS stating, "We do not want to 
participate. Don't bother us anymore."

Terral Telephone Company Fixed Wireless Refused to Participate

[FEB-16-11 David Coffey] Spoke with company 
representative who stated that she had spoken 
with her boss about submitting data and he 
declined at this time.  She stated that they were 
a very small organization and didn't have the 
time.  I told her we would work with her to gather 
the necessary information.  She stated that we 
would talk before the next updates and they 
would try to participate but for now they were 
declining to participate.  For this time period we 
will list the company as 'Refused to Participate.'

Twilight Communications Fixed Wireless Refused to Participate

[FEB-16-11 David Coffey] Spoke with company 
representative who stated that they were in the 
process of negotiating the possible sale of the 
company. He said he had filled in some of the 
data but was reluctant to submit anything due to 
the possible sale.  He stated that if he did not sell 
he would submit the data to us for the next 
update in October.  We will list him 'Refused to 
Participate' at this time.

Xanadoo, LLC Refused to Participate

[FEB-17-11 Wes Kerr] A provider representative 
sent a message that they will not be 
participating, as they have determined that they 
do not have the resources necessary.

281 Communications, Inc. Fixed Wireless Non-Responsive to Multiple Attempts

In addition to multiple contact attempts made 
between September 9, 2009 and September 20, 
2010, five attempts have been made during this 
submission period.

Bee Creek Communications Fixed Wireless Non-Responsive to Multiple Attempts 5/21/2010

In addition to multiple contact attempts made 
between September 9, 2009 and August 9, 
2010, four attempts have been made during this 
submission period.

Centrovision Cable Non-Responsive to Multiple Attempts

In addition to multiple contact attempts made 
between October 26, 2009 and August 6, 2010, 
six attempts have been made during this 
submission period.

Centrovision Fixed Wireless Non-Responsive to Multiple Attempts

In addition to multiple contact attempts made 
between October 26, 2009 and August 6, 2010, 
six attempts have been made during this 
submission period.

CKS Wireless, Inc. Fixed Wireless Non-Responsive to Multiple Attempts

In addition to multiple contact attempts made 
between February 10, 2010 and August 12, 
2010, four attempts were made during this 
submission period.

East Texas Broadband Fixed Wireless Non-Responsive to Multiple Attempts
Ten contact attempts were made between July 7, 
2010 and February 18, 2011.

East Texas Cable Co. Cable Non-Responsive to Multiple Attempts

In addition to multiple contacts made between 
January 22, 2010 and September 20, 2010, 
three attempts were made during this 
submission period.

East Texas Wifi Fixed Wireless Non-Responsive to Multiple Attempts
Ten contacts were made between July 7, 2010 
and February 18, 2011.



Hometown Computing Fixed Wireless Non-Responsive to Multiple Attempts

In addtion to multiple contact attempts made 
between September 10, 2009 and August 11, 
2010, six attempts were made during this 
submission period.

Indian Creek Internet Services Fixed Wireless Non-Responsive to Multiple Attempts

In addition to multiple contact attempts made 
between September 10, 2009 and August 13, 
2010, seven attempts were made during this 
submission period.

Liquid Stone Wireless Fixed Wireless Non-Responsive to Multiple Attempts

In addition to multiple contact attempts made 
between September 10, 2009 and August 12, 
2010, five attempts were made during this 
submission period.

LSCWeb.Com Fixed Wireless Non-Responsive to Multiple Attempts

In addition to multiple contact attempts made 
between September 10, 2009 and August 5, 
2010, four attempts were made during this 
submission period.

Medicine Park Telephone Company Backhaul Non-Responsive to Multiple Attempts

Two contact attempts were made between 
January 31, 2011 when the provider was 
identified and February 11, 2011.

Pathwayz Communications, Inc. ILEC/CLEC Non-Responsive to Multiple Attempts
Fourteen contact attempts were made between 
February 17, 2010 and January 13, 2011.

Pathwayz Communications, Inc. Fixed Wireless Non-Responsive to Multiple Attempts
Fourteen contact attempts were made between 
February 17, 2010 and January 13, 2011.

Sterling Cable Cable Non-Responsive to Multiple Attempts

In addition to multiple contact attempts made 
between September 10, 2009 and August 10, 
2010, six attempts were made during this 
submission period.

Sterling Cable Fixed Wireless Non-Responsive to Multiple Attempts

In addition to multiple contact attempts made 
between September 10, 2009 and August 10, 
2010, six attempts were made during this 
submission period.

Telecom Cable, LLC Cable Non-Responsive to Multiple Attempts
Eight contact attempts were made between 
October 27, 2009 and February 22, 2011.

TWIN Wireless, Inc. Fixed Wireless Non-Responsive to Multiple Attempts

In addition to multiple contact attempts made 
between September 10, 2009 and August 11, 
2010, 12 attempts were made during this 
submission period.

VRFuturenet Fixed Wireless Non-Responsive to Multiple Attempts

In addition to multiple contact attempts made 
between September 10, 2009 and August 11, 
2010, eleven attempts were made during this 
submission period.

Western Broadband Fixed Wireless Non-Responsive to Multiple Attempts

In addition to multiple contact attempts made 
between September 10, 2009 and August 10, 
2010, nine attempts were made during this 
submission period

WesTex Connect Internet Fixed Wireless Non-Responsive to Multiple Attempts

In addition to multiple contact attempts made 
between September 10, 2009 and August 4, 
2010, 10 attempts were made during this 
submission period.

Windjammer Communications, LLC Cable Non-Responsive to Multiple Attempts 11/16/2009

In addition to multiple contact attempts made 
between October 27, 2009 and August 11, 2010, 
six attempts were made during this submission 
period.

Zeecon/Wireless Internet, LLC Fixed Wireless Non-Responsive to Multiple Attempts

In addition to multiple contact attempts made 
between September 10, 2009 and August 10, 
2010, 10 attempts were made during this 
submission period.

Aledo Broadband ILEC/CLEC No Update to Provide 3/26/2010
[MAR-23-11 Dawn Clark]  Provider does not 
offer DSL.

Covad Communications ILEC/CLEC Other 1/19/2010

[FEB-18-11 Sarah Finne] Provider does not offer 
residential DSL.  They submitted business data, 
so we will only submit their backhaul data to 
NTIA.

Digital Passage Fixed Wireless Other

[FEB-27-11 Dwayne Goodman] Owner of Digital 
Passage acquired Urnet late year 2010. 
Previous owner of Urnet forwarded April 2011 
data submission requests to Digital Passage. On 
January 10, 2011 contacted Digital Passage 
owner directly to present the Connected Texas 
broadband inventory project and to receive 
approval of continued carriage of Urnet coverage 
within the state broadband inventory map.  
Skeptical comments were made during the initial 
conversation. Owner indicated he would review 
all material as time permits and make a decision 
of participation. Since that time frame the owner 
of Digital Passage has been non-responsive to 
voice mails and e-mails.

DISH Network Corporation Satellite Other 1/27/2010

[MAR-09-11 Sarah Finne] Satellite data will not 
be submitted due to additional information being 
necessary to show where service is available in 
the state, rather than submitting the entire state 
boundary as serviceable area.

Hughes Network Systems, LLC Satellite Other 2/5/2010

[MAR-09-11 Sarah Finne] Satellite data will not 
be submitted due to additional information being 
necessary to show where service is available in 
the state, rather than submitting the entire state 
boundary as serviceable area.



Pulsestream Internet Services Fixed Wireless Other

[JAN-01-11 Dawn Clark] This provider is 
selected as "Other" status because they do not 
provide fixed wireless residential service.  
However they do offer backhaul services so they 
are remaining "viable."

Rock Solid Internet & Telephone Backhaul Other 2/14/2011
[FEB-08-11 Sarah Finne] Backhaul record was 
added in error; provider does not offer.

Rock Solid Internet & Telephone ILEC/CLEC Other 2/14/2011
[MAR-23-11 Dawn Clark] Provider does not offer 
DSL.

Wes-Tex Telecommunications, Ltd. Fiber Other 3/1/2010
[MAR-31-11 Dawn Clark] Provider does not have 
fiber service.

WildBlue Communications, Inc. Satellite Other 1/8/2010

[MAR-09-11 Sarah Finne] Satellite data will not 
be submitted due to additional information being 
necessary to show where service is available in 
the state, rather than submitting the entire state 
boundary as serviceable area.



 
 
About the Utah Broadband Project’s Map & Data 
 
The Utah Broadband Project Interactive Map website is a joint project of the Utah 
Public Service Commission, Governor’s Office of Economic Development, and 
Department of Technology Services. 

The Utah Broadband  Interactive Map was developed and is hosted by the Utah 
Automated Geographic Reference Center (AGRC) utilizing data complied by the 
Project from broadband providers and public sources, including Utah’s State 
Geographic Information Database (SGID) which is utilized extensively for 
locating addresses, locating geographic places, and displaying background 
maps. 

Please report any problems with this web page, the Utah Broadband Interactive 
Map, or relating to broadband availability in Utah to broadband@utah.gov. 
This page contains the following sections: 

 Additional Utah Broadband Maps and Resources 
 Map Goals 
 Map Data Description 
 Map Data Validation 
 Map Data Verification 
 Map Disclaimer 
 Map and Data Update Log 
 
Additional Utah Broadband Maps and Resources 
In addition to the Utah Broadband Map interactive map website, additional 
broadband map products are available that depict availability, speed, and 
technology in Utah. At present these include maps of highest available 
speed, available technology, and community anchor institution maps that depict 
school, health center, government office, and emergency response station 
facilities and the internet access at these locations. 
 

http://utah.gov/broadband/map.html
mailto:broadband@utah.gov?subject=Report%20a%20Problem
http://blog.broadband.utah.gov/about/about-the-interactive-map/#AdditionalMaps
http://blog.broadband.utah.gov/about/about-the-interactive-map/#MapGoals
http://blog.broadband.utah.gov/about/about-the-interactive-map/#MapDataDescription
http://blog.broadband.utah.gov/about/about-the-interactive-map/#MapDataValidation
http://blog.broadband.utah.gov/about/about-the-interactive-map/#MapDataVerification
http://blog.broadband.utah.gov/about/about-the-interactive-map/#MapDisclaimer
http://utahbroadband.wordpress.com/?page_id=981
http://blog.broadband.utah.gov/about/about-the-interactive-map/mapresources/
http://blog.broadband.utah.gov/about/about-the-interactive-map/mapresources/
http://http/utahbroadband.files.wordpress.com/2011/02/maxspeedsummary_small1.
http://http/utahbroadband.files.wordpress.com/2011/02/maxspeedsummary_small1.
http://http/utahbroadband.files.wordpress.com/2011/02/technologysummary_small1.pdf


 
 
Map Goals 
The map attempts to provide consumers, community leaders, and broadband 
providers with a comprehensive map-based view of non-confidential data 
complied by the Utah Broadband Project. This information can be used to 
support: 
 Consumer and Business Decision Support: 

 What provider options and performance are available at a specified 
locations? 

 What locations is broadband service available from a provider of 
interest (a current provider, for example)? 

 Does the broadband map accurately reflect available services? 
 Community Leader Decision Support: 

 How does broadband service compare in an area of interest with 
other parts of the state? 

 Where are un- or under-served areas for which the expansion of 
broadband service or performance should be targeted? 

 Does the broadband map accurately reflect available services? 
 Broadband Providers Decision Support: 

 Where are opportunities to expand service and performance? 
 Does the broadband map accurately reflect available services? 
 

Map Data Description 
The Utah Broadband Project’s Fall 2010 submission to the NTIA/FCC State 
Broadband Data and Development (SBDD) program includes both confidential 
and non-confidential data relating to service availability and infrastructure for over 
40 broadband providers. Non-confidential data depicts broadband availability, 
speed, and technology for wireless service provision as service area polygons 
and, for wireline provision, as service areas and address points aggregated to a 
census block level in urban and rural settled areas and along road segments in 
rural and exurban areas where census blocks are greater than 2 square miles in 
size.  Additionally, provider-submitted middle and last mile infrastructure data and 
pre-aggregation address-level wireline service information were submitted to the 
SBDD program as confidential data. 
 



 

The locations of community anchor institutions, such as schools, libraries, 
government offices, health and human service provision locations, and public 
safety facilities were also collected and submitted. Where possible, speed and 
service technology are indicated, especially for those institutions that receive 
broadband service from the Utah Education Network, the State of Utah 
Department of Technology Services, or the Utah Telehealth Network and those 
organizations that report this information to the State Library. 

The State of Utah and its provider engagement contractor, International 
Research Council (of Mesa, Arizona) developed program communication 
packets, worked to develop NDAs where necessary, and provided engagement 
and technical assistance to providers regarding the submission guidelines and 
process. 

 Participating providers list 
 
Map Data Validation 
The Utah Broadband Project submission was in the data structure outlined in the 
National Broadband Map Data Transfer Model (NBMDTM)  v1.0.1. In order to 
submit data in this format, all provider data submissions were transformed to this 
data structure and loaded into an ESRI File Geodatabase. The project worked 
with provider data in many formats including customer and ‘buildings-passed’ 
addresses and address ranges in spreadsheet, text file, and geographic 
information system formats. Census blocks, pdf maps, computer assisted design 
(CAD) data files, and public-facing websites showing provider service areas were 
also translated into NBMDTM compliant formats. 
Aerial photography, address location services, census block geometry, and road 
segment geometry used for broadband service mapping and quality control of the 
data are from public domain resources in Utah’s State Geographic Information 
Database (SGID) maintained by the Utah Automated Geographic Reference 
Center and funded and supported by the State of Utah general fund, the Utah 
911 Committee, and partnering local, state and federal agencies. 

 

http://utahbroadband.wordpress.com/providers/providers/


 

Additionally, in cases where providers were only able to provide last-mile 
infrastructure locations, terrain modeling was used to generate wireless coverage 
data and network distance modeling was used to form DSL provision areas using 
the street network as a surrogate for the broadband delivery system’s wire 
network. 

Due to time constraints, validation work was somewhat limited to the work to 
translate provider data submissions into the NBMDTM and its list of coded values 
and other attribute specifications. In subsequent submissions, the Project will 
incorporate automated procedures developed by the FCC to ensure that project 
data conforms to the evolving NBMDTM. 

Map Data Verification 
Utah feels strongly the best verification resource is a continued relationship with 
participating providers and the display of availability and speed data through the 
state broadband interactive map.  Along these lines, Utah prepared provider 
feedback packages including a CD containing the providers NBMDTM 
transformed data, pdf overview maps of the providers service area by download 
speed, submission record counts, transformation process notes (including 
problem areas), and suggestions on how to improve the data quality and/or how 
to make subsequent submissions easier. 
Utah also compared data submitted to the American Roamer and Media Print 
Cable Boundaries data and to the Public Service Commission’s 
telecommunications territory boundaries. In preparation for the release of the 
Utah Broadband Map, project staff is holding interactive review sessions with 
providers to review service area data together via online meetings and a preview 
version of the map. These sessions are targeted to providers where further 
clarification is deemed necessary. 

Utah has also experimented with mapping and analysis of FCC speed test data 
and terrain analysis of statewide satellite coverage claims. 

 
 



 
 
Map Disclaimer 
Broadband service availability and characteristics are depicted as derived from 
data assembled by the Utah Broadband Project. Data sources include biannual 
broadband service provider submissions and publicly available sources. Data 
has been modified, where necessary, to meet broadband mapping standards set 
by the National Telecommunications and Information Administration (NTIA). 
Broadband service availability is displayed per NTIA specifications which include 
technology and speed categories and the aggregation of non-wireless service 
availability information to either U.S. Census blocks (where smaller than 2 sq. 
miles) or road segments. 

Speeds shown are the ‘maximum advertised’ for the geographic features 
depicted, and must exceed 0.768 Mbps download and 0.2 Mbps upload (NTIA 
broadband definition) to be included. Actual speeds may vary within and along 
census blocks and roads, due to the granularity and currency of the data, 
technological limitations, and service plan limitations. Users of the site are 
encouraged to inquire directly to providers for current service availability and 
speed. 

All information presented on the Utah’s interactive broadband map is for general 
reference purposes only and may contain errors and omissions. The State of 
Utah makes no warranty with respect to information available, express or implied, 
including but not limited to the fitness for use for a particular purpose. 

The Utah Broadband Project welcomes your comments (broadband@utah.gov). 
 

mailto:broadband@utah.gov
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NATIONAL BROADBAND MAPPING PROJECT 
SPRING 2011 SUBMISSION - VIRGINIA 
 
A summary of processing steps necessary to move broadband provider submission into the NTIA 
SBDD data model. 
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Summary of Virginia Submission 
 
The Virginia Center for Innovative Technology (CIT) was designated by the Governor as the 
primary point of contact for all Commonwealth of Virginia participation in the National 
Broadband Mapping Project.  The CIT assembled a team consisting of the Virginia Information 
Technology Agency’s (VITA) Virginia Geographic Information Network (VGIN) and the Virginia 
Tech Center for Geospatial Information Technology (CGIT) to review, process, normalize and 
submit the information outlined in the Notice of Funds Availability (NOFA) establishing the 
National Broadband Map. 
 
The spring 2011 submission is the third submission of data to the National Telecommunications 
and Information Administration (NTIA).  The submission includes data from 44 Broadband 
Service Providers (BSP) delivered in various formats ranging from GIS shape files to text files 
detailing broadband availability.   Of the 44 broadband providers included, 24 submitted 
updated service information for this submission.  To provide a complete snapshot of broadband 
availability in Virginia, the fall 2010 submission data was carried forward for the remaining 20 
broadband providers. 
 
A summary of the spring 2011 submission data includes: 
 

Census Blocks provided with availability information 190115 

Street Segments provided with availability information 100501 

Addresses provided with availability information 85481 

Wireless Broadband providers providing availability polygons 14 

Middle Mile Points provided 490 

 
A review of the 24 broadband providers providing updates in the VA Broadband mapping effort 
for the spring 2011 indicates: 
 

- 10 broadband providers provided only addresses 
- 19 broadband providers provided both census blocks and road segment ranges 
- 4 broadband providers provided only wireless information 
- 5 broadband providers provided only census blocks 
- 2 non-wireless broadband providers provided GIS data 

 
All broadband providers participating provided speed information for census block, road 
centerline segment, or addresses.   
 

VGIN Base Map Data 

 
VGIN maintains a series of statewide feature classes that were used to support the 
National Broadband Mapping Project.   
 
Address Points - VGIN maintains a statewide address point feature class that is updated 
quarterly using locality address submissions.  This statewide address point database is 
used to generate a Point Address Geocoding Service. 
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Road Centerlines (RCL) – VGIN maintains a statewide road centerline feature class that 
is updated quarterly using locality centerline submissions.  This road centerline database 
contains address range information when it is provided by the locality.  The RCL 
database is used to generate a Linear Geocoding Service. 
 
Navteq – VGIN maintains a subscription to the Navteq road centerline database in 
addition to the statewide road centerline database.  This subscription provides a third 
geocoding service available to the broadband mapping project. 
 
2000 Census Blocks – VGIN maintains a statewide inventory of 2000 Census geometry 
that is available to the broadband mapping project for location and presentation of 
broadband data. 
 

Broadband provider Data Location Processing 
 
All broadband provider processing was accomplished using VGIN statewide mapping 
initiatives as a basis.  Broadband providers reported data in one of four formats: 
Polygon service areas; Census Blocks Served; Addresses Served; and Road Segments 
Served.  Each of these reporting formats was handled differently. 
 
Wireless Service Area Polygon Reporting – Service Area Polygons were reported by 
Wireless Broadband providers and required little processing to be included in the NTIA 
SBDD data model.  Typical inclusion processes included attribute validation and use of 
the ESRI Simple Data Loader or Copy and Paste. 
 
Census Block Reporting – Broadband providers reporting broadband availability on a 
census block basis submitted it in list form a majority of the time.  These lists came in 
the form of spreadsheets and text files.  These lists were normalized into spreadsheets 
and the attributes joined to the VGIN 2000 Census Block feature class.  The resulting 
broadband provider specific staging database was validated for attributes and added to 
the NTIA SBDD data model. 
 
Point Address Reporting - Broadband providers reporting broadband availability in a 
service address basis submitted it in list form in a majority of cases.  These lists were 
submitted in the form of spreadsheets or text files.  Once converted to spreadsheets, 
the address lists were geocoded using VGINs three tiered geocoding process.  Addresses 
are first geocoded against the statewide address database.  Any service addresses that 
are not matched on the first pass are rerun using the statewide road centerline 
geocoder.  At this point, a majority of the addresses able to be located have been 
placed.  Any remaining service addresses are geocoded against the Navteq database as a 
final attempt to generate a location. 
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Road Segment Address Reporting – Broadband providers reporting broadband 
availability using a road segment basis submitted it in a list form in a majority of cases.  
These lists were normalized into a series of spreadsheets for that were either used in 
joining to census features or geocoded using the VGIN road centerline database.  Any 
broadband provider submitted road segment data that remained not located was rerun 
using the Navteq database to generate a final location. 

 
Broadband Provider Staging Databases 
 
To support the processing of broadband provider information separately, a broadband 
provider specific geodatabase was created.  This geodatabase was an empty shell of the 
NTIA SBDD Database to maintain all topological and attribute constraints and 
validations.  Each broadband provider’s data was processed completely independent of 
all other broadband providers, allowing broadband providers to move through the 
process at different rates.  This also allowed the correction of any data problems specific 
to broadband providers without affecting the entire submission database.  Once the 
broadband provider data was processed to a point that it fully conformed to the NTIA 
SBDD data model, it was included in the Virginia submission for quality control and 
subsequent delivery. 
 
Batch Calculation & Additional Processing 
 
For data reported as service addresses, several fields were required that could be 
calculated in batch. The FULLFIPSID was calculated to the address points by spatially 
joining points to the census blocks. Latitude and Longitude were calculated in 
ArcCatalog using the calculate geometry function. 
 
About half of the broadband providers who participated in the spring 2011 NTIA 
submittal provided Middle mile data.  Resultantly, the processing and aggregation of a 
middle mile data set was done outside of standard broadband provider data processing.   
 
Address Points, Road Centerlines, Census blocks, and Wireless Service polygons were 
processed as broadband provider data was received although middle mile information 
was a post processing step.  To create middle mile event data, the broadband providers 
that provided the information to CIT and VGIN generally included latitude and longitude 
of the facility and these values were used in ArcGIS with the add XY function.  After 
points were brought into ArcGIS, data was exported into a separate feature class and 
values were calculated based on information the broadband provider provided. 

 
Broadband Provider Specific Processing 
 
The following Broadband Providers submitted CIT data for the Spring 2011 NTIA 
submission. It is assumed that the participating Broadband providers provided entire 
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coverage data as opposed to updates only unless otherwise noted.  Included are the 
methods used in updating the Virginia Broadband map data: 
 
AT&T 
Provider Name: AT&T Mobility, LLC 
DBA Name: AT&T Mobility, LLC 
FRN: 0004979233 
 
AT&T provided CIT and VGIN Geospatial data in the form of a coverage area shape file.  
Inside the shape file was only one field which represented the U.S. State of the coverage 
area so in order to apply the NTIA specific information, additional documentation 
included by AT&T was used to update the attributes.  The GIS shape file was loaded into 
a staging Geodatabase feature class and fields were edited where pertinent.  This data 
was then loaded into the reporting database. 
 
Century Link 
Provider Name: AT&T Mobility, LLC 
DBA Name: AT&T Mobility, LLC 
FRN: 0004979233 
 
Century Link provided CIT and VGIN Geospatial data in the form of road centerlines and 
census blocks.  Middle mile and subscriber weighted speed were also included.  A new 
personal Geodatabase was created to represent the staging of this broadband provider 
for the spring 2011 release.  Inside of the staging database a road centerline feature 
class and census block polygon feature class were imported from the NTIA packaging 
data model.  In order to provide the Road Centerline data in Virginia’s geometry (VBMP 
RCL Quarter 1, 2011), the road lines provided by Century Link were used in a select by 
location analysis.  The Virginia Road Centerlines were selected if the Century Link 
provided lines were within 5 meters and then exported to a new feature class.  All 
values inside the Century Link roads were then spatially joined to the selected VA RCL 
and attributes were conflated and loaded to staging model feature class.  This iteration 
of the roads was loaded into the reporting database. 
 
Century Link also provided geospatial data in the form of census blocks less than two 
square miles.  These values were joined to the 2000 TIGER data by FULLFIPSID and 
output to new features in order to make sure the census geography provided to NTIA 
was sufficient.  Since the data associated to the blocks were named similarly to the NITA 
model data, they were loaded into a staging census block feature class then into the 
SBDD data model. 
 
Charter 
Provider Name: Charter Communications Inc. 
DBA Name: Charter Communications Inc. 
FRN: 0017179383 
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Charter provided CIT and VGIN Geospatial data in the form of road centerlines and 
census blocks.  A new personal Geodatabase was created to represent the staging of 
this broadband provider for the spring 2011 release.  Inside of the staging database a 
road centerline feature class and census block polygon feature class were imported 
from the NTIA packaging data model.  In order to provide the Road Centerline data in 
Virginia’s geometry (VBMP RCL Quarter 1, 2011), the centerline data provided by 
Charter were used in a select by location analysis.  The Virginia RCL was selected if the 
Charter GIS lines were within 5 meters and then exported to a new feature class.  All 
values inside the Charter roads were then spatially joined to the selected VA RCL and 
attributes were conflated and loaded to a staging model feature class.  This iteration of 
the roads was loaded into the reporting database. 
 
Charter also provided geospatial data in the form of census blocks less than two square 
miles.  These values were joined to the 2000 TIGER data by FULLFIPSID and output to 
new features in order to make sure the census geography provided to NTIA was 
sufficient.  Since the data associated to the blocks were named similarly to the NITA 
model data, they were loaded into a staging census block feature class then into the 
SBDD data model. 
 
Sprint 
Provider Name: Sprint Nextel Corporation 
DBA Name: Sprint 
FRN: 0003774593 
 
Sprint provided CIT and VGIN Geospatial data in the form of a coverage area shape file.    
Middle mile and subscriber weighted speed were also included.  Inside the shape file 
were two records but the shape file structure had all of the fields needed to load into 
the NTIA model therefore no additional information was needed.   The GIS shape file 
was loaded into the staging Geodatabase feature class and FRN information was 
scrubbed to match the NTIA number reporting format.  This data was then loaded into 
the reporting database.  
 
Verizon Wireless 
Provider Name: Verizon Wireless 
DBA Name: Verizon Wireless 
FRN: 0003290673 
 
Verizon Wireless provided CIT and VGIN Geospatial data in the form of two coverage 
area shape files; one representing EVDO statewide and another showing LTE in the 
Northern Virginia Region.  The EVDO was gridded into 883 individual polygons with the 
same speed so the data was exported into a staging feature class and was merged into a 
single polygon.  The LTE data showed a 4G core and 4G borders.  These were the same 
transmission technology and speed according to Verizon so the two “4G” polygons were 
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exported to a staging feature class and merged together.  These two newly created 
merged polygon feature classes with different spectrums were loaded into the staging 
Geodatabase feature class and FRN information was scrubbed to match the NTIA 
number reporting format.  This data was then loaded into the reporting database. 
 
Time Warner Cable 
Provider Name: Time Warner Cable 
DBA Name: Time Warner Cable 
FRN: 0013430244 
 
Time Warner Cable provided CIT and VGIN Geospatial data in the form of road 
centerlines and census blocks.  They also provided a text file for blended average speeds 
and based on the values it was assumed this was their pricing spreadsheet.   A new 
personal Geodatabase was created to represent the staging of this broadband provider.  
Inside of the staging database a road centerline feature class and census block polygon 
feature class were imported from the NTIA packaging data model.  In order to provide 
the Road Centerline data in Virginia’s geometry (VBMP RCL Quarter 1, 2011), the 
centerline data provided by Time Warner were used in a select by location analysis.  The 
Virginia RCL was selected if the Time Warner GIS lines were within 5 meters and then 
exported to a new feature class in the staging database.  Features did not need to be 
spatially joined since Time Warner did not provide Typical Up/Down data and their Max 
Advertised values were all the same for each segment.  Values were manually calculated 
in the staging feature class of selected roads.  This iteration of the roads was loaded into 
the reporting database. 
 
Time Warner also provided geospatial data in the form of census blocks less than two 
square miles.  These values were joined to the 2000 TIGER data by FULLFIPSID and 
output to new features in order to make sure the census geography provided to NTIA 
was sufficient.  Since the data associated to the blocks were named similarly to the NITA 
model data, they were loaded into a staging census block feature class then into the 
SBDD data model. 
 
Verizon Wireline 
Provider Name: Verizon Virginia, Inc. 
DBA Name: Verizon Virginia, Inc. 
FRN: 0002073203 
 
Verizon Wireline provided CIT and VGIN text files for census blocks, road segments, 
pricing, and speed availability by region.  A new personal Geodatabase was created to 
represent the staging of this broadband provider.   The text files were imported to excel 
files and then imported into ArcGIS to in order to keep a single working environment.  
The regional speed data was used in the creation of a boundary layer based on the 
census locality boundaries in Virginia and merged based on speeds across Virginia 
provided in the text data.   
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The road segment data that Verizon Wireline provided did have a TLID which 
represented the unique ID of Tiger Road Centerlines so the values were joined to Tiger 
data and output to a new feature class.   In order to provide the Road Centerline data in 
Virginia’s geometry (VBMP RCL Quarter 1, 2011), the joined & converted road centerline 
data provided by Verizon Wireline was used in a select by location analysis.  The Virginia 
RCL was selected if the extracted Verizon Wireline GIS lines were within 5 meters and 
then were exported to a new feature class in the staging database.  Features were 
spatially joined to the Verizon generated Tiger lines in order to apply Transmission 
Technology.  Verizon did not supply CIT & VGIN with Typical Downstream/Upstream 
values but did provide maximum advertised values in the speed text file which was 
converted to GIS polygons.  Select by locations were performed and road centerlines 
were calculated based on their location to the created boundary data. This iteration of 
the roads was loaded into the reporting database. 
 
Verizon Wireline also provided census blocks less than two square miles.  The 
spreadsheet they used supplied the full FIPS id to use in a join.  The original table had 
values which showed that this broadband provider is using newer census block 
geography than the requested NTIA data so the table was joined to the 2000 TIGER data 
by FULLFIPSID and all join match values were kept, all values not matched were left out 
based on ArcGIS join commands.  The joined block features were output to new a new 
feature class based on the associated TIGER 2000 data in order to make sure the census 
geography provided to NTIA was sufficient.  The census table provided by Verizon 
Wireless did not have Max Advertised speeds so the created boundary layer for speed 
was used in selecting areas which matched the advertised speed to the staging block 
feature class. After this data was checked in a staging census block feature class, it was 
then loaded into the SBDD data model. 
 
Cox 
Provider Name: CoxCom Inc. 
DBA Name: Cox Communications 
FRN: 0001524461 
 
Cox provided CIT and VGIN text file updates of advertised speed and subscriber 
weighted speed.  Addresses & road segments from the fall 2010 submittal were reused 
in conjunction with the updates.  A new personal Geodatabase was created to represent 
the staging of this broadband provider.   The text files were imported to excel files and 
then imported into ArcGIS to in order to keep a single working environment.  The 
regional speed data was used in the creation of a boundary layer based on cellular 
market area boundaries since speeds were reported by Cox in this format.  In the 
staging geodatabase, feature classes from the NTIA model were imported for Address 
Points, Road Centerlines, and Census Blocks. 
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The address level data spreadsheets from the fall 2010 were imported into the staging 
geodatabase and were geocoded based on the most recent VA address point geocoding 
service and were output to a new data set.   All unmatched or tied geocoded results 
were then exported to an additional table and re-geocoded based on the VA Road 
Centerline geocoding service.    The geocoded RCL point data was spatially joined to the 
first quarter of 2011 VA Road Centerline data in order to place features in a linear 
feature class.  Both address point and road centerline data were loaded to their staging 
feature class and then loaded to the SBDD data model. 
 
Cox also provided data from fall 2010 in the form of text files for census blocks less than 
two square miles which were processed for the fall 2010 submission.  Since the data 
associated to the blocks were named similarly to the NITA model data, they were loaded 
into a staging census block feature class and checked against current FRN information as 
well as the newly created speed feature class.  After these were checked for updates, 
they were then loaded into the SBDD data model. 
 
Level 3 
Provider Name: Level 3 Communications, LLC 
DBA Name: Level 3 Communications, LLC 
FRN: 0003723822 
 
Level 3 Communications provided CIT and VGIN text files of customer addresses.  A new 
personal Geodatabase was created to represent the staging of this broadband provider.   
The text files were imported to excel files and then imported into ArcGIS to in order to 
keep a single working environment.  The addresses were geocoded based on the most 
recent VA address point geocoding service and were output to a new data set.   All 
unmatched or tied geocoded results were then exported to an additional table and re-
geocoded based on the VA Road Centerline geocoding service.    The geocoded RCL 
points were spatially joined to the first quarter of 2011 VA Road Centerline data in order 
to place the point features in a linear feature class.  Both address point and road 
centerline data were loaded to their staging feature class and then loaded to the SBDD 
data model. 
 
Covad 
Provider Name: DIECA Communications, Inc. 
DBA Name: Covad Communications Company 
FRN: 0003753753 
 
Covad provided CIT and VGIN text files for census blocks, road segments, and speed 
availability by region.  A new personal Geodatabase was created to represent the 
staging of this broadband provider.   The text files were imported to excel files and then 
imported into ArcGIS to in order to keep a single working environment.  The regional 
speed data was used in the creation of a boundary layer based on the census locality 
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boundaries in Virginia and merged based on speeds across Virginia provided in the text 
data.   
 
Covad provided text files for census blocks less than two square miles.  The data 
provided used supplied the full FIPS id to use in a join so the table was joined to the 
2000 TIGER data by FULLFIPSID and all joined values were kept.  The joined block 
features were output to new a new feature class based on the associated TIGER 2000 
GIS data in order to make sure the census geography provided to NTIA met their 
requirements.  The census table provided by Covad did not have Max Advertised speeds 
so the created boundary layer for speed was used in selecting areas which matched the 
advertised speed to the staging block feature class. After this data was checked in a 
staging census block feature class, it was then loaded into the SBDD data model. 
 
The road segment data that Covad provided did have TLID to join to the tiger lines so 
the data was joined to Tiger GIS line data and output to a new feature class.   In order to 
provide the Road Centerline data in Virginia’s geometry (VBMP RCL Quarter 1, 2011), 
the joined & converted road centerline provided by Covad were used in a select by 
location analysis.  The Virginia RCL was selected if the Covad GIS lines were within 5 
meters and then exported to a new feature class in the staging database.  Features were 
spatially joined to Covad lines in order to attach Transmission of Technology and Typical 
speeds.  Select by locations were performed and Max Advertised values for road 
centerlines were calculated based on their location to the created boundary data. This 
iteration of the roads was loaded into the reporting database. 
 
Shentel 
Provider Name: Shentel Cable Company 
DBA Name: Shentel 
FRN: 0018024075 
 
Shentel provided CIT and VGIN a single excel file which included census blocks and road 
segments inside the same spreadsheet as well as a tab in this spreadsheet which 
showed advertised speed by region.    A new personal Geodatabase was created to 
represent the staging of this broadband provider.   Many of the roads Shentel included 
in the spreadsheet had TLID so these were exported into their own spreadsheet as well 
as their own Geodatabase table.  Another spreadsheet was created where only census 
block data was present in the initial spreadsheet and this was imported into ArcGIS as its 
own table.  Finally, all other roads that did not have a block associated to it were 
exported as their own spreadsheet and geodatabase table.    The regional speed data 
available in the Shentel spreadsheet was used in the creation of a boundary layer based 
on the census locality boundaries in Virginia and merged based on speeds across 
Virginia provided in the text data.   
 
The road segments that Shentel provided which had TLID were joined to the tiger lines 
and output to a new feature class.   In order to provide the Road Centerline data in 
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Virginia’s geometry (VBMP RCL Quarter 1, 2011), the joined & converted road centerline 
provided by Shentel were used in a select by location analysis.  The Virginia RCL were 
selected if the Shentel TLID GIS lines were within 5 meters and then exported to a new 
feature class in the staging database.  The speed polygon data was used in calculating 
maximum advertised values.  Output Virginia line features were spatially joined to 
Shentel lines in order to attach Transmission of Technology and Typical speeds.   This 
iteration of the roads was loaded into the reporting database. 
 
Road address ranges that were inside the original spreadsheet from Shentel that did not 
have TLID did have census block ID and street name.  The census block ID and Street 
name fields were concatenated to create a string to use in joining.  The census block 
values for these roads were joined to the census block GIS data and were output to a 
feature class in order to create a maximum potential area of interest boundary of 
segments.  The entire VA Road Centerline data from Quarter 1 of 2011 were clipped to 
these polygons.  The clipped RCL values then were spatially joined to the blocks in order 
to get full FIPS block ID attached to the road centerline.  Once these values were added 
to the clipped RCL data, the census block ID that was newly added to the roads were 
concatenated with the Street name.  This concatenation in the clipped RCL data was 
joined with the original concatenation of the table.  All GIS features that matched were 
kept and output to a separate feature class using the NTIA model structure.    The speed 
polygon data which was created originally was used in calculating maximum advertised 
values for these segments and once the values were calculated, this iteration of the 
roads was loaded into the reporting database. 
 
Shentel data which only had census blocks less than 2 square miles contained the full 
FIPS id and was used in joining to the 2000 TIGER data by FULLFIPSID. All joined values 
were kept.  The joined block features were output to new a new feature class based on 
the associated TIGER 2000 GIS data in order to make sure the census geography 
provided to NTIA met their requirements.  After this data was checked in a staging 
census block feature class, it was then loaded into the SBDD data model. 
 
NTELOS Wireline 
Provider Name: Various 
DBA Name: Various 
FRN: Various 
 
NTELOS provided CIT and VGIN text file updates addresses and census blocks, along with 
speed information by region.   A new personal Geodatabase was created to represent 
the staging of this broadband provider.   The text files for census blocks and speed were 
imported to excel files and then imported into ArcGIS in order to keep a single working 
environment.  Since the addresses were updates only, data from the spring/fall 
submission by NTELOS were merged in a separate excel file to create an “all address” 
spreadsheet.  This was imported to ArcGIS as a geodatabase table.   The regional speed 
data was used in the creation of a boundary layer based on locality boundaries since 
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speeds were reported by NTELOS in this format.  In the staging geodatabase, feature 
classes from the NTIA model were imported for Address Points, Road Centerlines, and 
Census Blocks. 
 
The combined address data was imported into the staging geodatabase for NTELOS 
wireline as a table and the values were geocoded based on the most recent VA address 
point geocoding service and were output to a new data set.   All unmatched or tied 
geocoded results were then exported to an additional table and re-geocoded based on 
the VA Road Centerline geocoding service.    The Road geocoding point data was 
spatially joined to the first quarter of 2011 VA Road Centerline data in order to place the 
resultant point features in a linear feature class.  Both address point and road centerline 
data were loaded to their staging feature class and then loaded to the SBDD data model. 
 
NTELOS data for census blocks less than 2 square miles contained the full FIPS id and 
were used in joining to the 2000 TIGER data by FULLFIPSID. All joined values were kept.  
The joined block features were output to new a new feature class based on the 
associated TIGER 2000 GIS data in order to make sure the census geography provided to 
NTIA met their requirements.  After this data was checked in a staging census block 
feature class, it was then loaded into the SBDD data model. 
 
T-Mobile 
Provider Name: T-Mobile USA, Inc. 
DBA Name: T-Mobile 
FRN: 0006945950 
 
T-Mobile provided CIT and VGIN Geospatial data in the form of two coverage area shape 
files as well as text files which described the data.  Inside the shape files was not enough 
information to decipher the NTIA specific information so the text data was used to 
populate the data.  The GIS shape file was loaded into a staging Geodatabase feature 
class and fields were edited where pertinent.  This data was then loaded into the 
reporting database. 
 
Cricket 
Provider Name: Leap Wireless International, Inc. 
DBA Name: Cricket Communications, Inc. 
FRN: 0002963528 
 
Cricket provided CIT and VGIN Geospatial data in the form of a coverage area shape file.  
Inside the shape file was one record and the shape file structure had all of the fields 
needed to load into the NTIA model therefore no additional information was needed.   
The GIS shape file was loaded into the staging Geodatabase feature class and FRN 
information was scrubbed to match the NTIA number reporting format.  This data was 
then loaded into the reporting database.  
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MGW Networks 
Provider Name: MGW Networks, LLC 
DBA Name: MGW Networks, LLC 
FRN: 0019225366 
 
MGW Networks provided CIT and VGIN an excel file of customer addresses.   A new 
personal Geodatabase was created to represent the staging of this broadband provider 
and the excel information was imported as a new Geodatabase table in order to keep a 
single working environment in ArcGIS.   The address data was geocoded based on the 
most recent VA address point geocoding service and were output to a new data set.   All 
unmatched or tied geocoded results were then exported to an additional geodatabase 
table and re-geocoded based on the VA Road Centerline geocoding service.    The Road 
geocoding point data was spatially joined to the first quarter of 2011 VA Road Centerline 
data in order to place point features to their related linear feature class.  Data was then 
joined and imported to a road centerline feature class which matched the NTIA model.  
Data was massaged and then loaded to the SBDD data model. 
 
Northern Neck WIFI 
Provider Name: Northern Neck Wireless Internet Services, LLC 
DBA Name: Northern Neck Wireless Internet Services, LLC 
FRN: 0017338054 
 
Northern Neck WIFI provided CIT and VGIN an excel file of customer addresses.   A new 
personal Geodatabase was created to represent the staging of this broadband provider 
and the excel information was imported as a new Geodatabase table in order to keep a 
single working environment in ArcGIS.   The address data was geocoded based on the 
most recent VA address point geocoding service and were output to a new data set.   All 
unmatched or tied geocoded results were then exported to an additional geodatabase 
table and re-geocoded based on the VA Road Centerline geocoding service.    The Road 
geocoding point data was spatially joined to the first quarter of 2011 VA Road Centerline 
data in order to place features in a linear feature class.  Data was then joined and 
imported to a road centerline feature class which matched the NTIA model.  Data was 
massaged and then loaded to the SBDD data model.  One challenge faced with Northern 
Neck WIFI was the fact that it is a wireless broadband provider and the only way to 
accurately report the data provided to VGIN was to placed it into Addresses Point as 
well as Road Centerline features.  Although there is spectrum information for this 
broadband provider, the current features did not allow it to be used at this point in 
time.  CIT/VGIN will work with broadband provider in future submissions to provide 
data in conformance with NTIA model. 
 
TDS Telecom 
Provider Name: Various 
DBA Name: TDS Telecom 
FRN: Various 
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TDS Telecom provided CIT and VGIN text files of customer addresses as well as middle 
mile and pricing information.   A new personal Geodatabase was created to represent 
the staging of this broadband provider and the text files were imported to excel and 
then imported as a new Geodatabase table in order to keep a single working 
environment in ArcGIS.   The address data was then geocoded based on the most recent 
VA address point geocoding service and was output to a new data set.   All unmatched 
or tied geocoded results were then exported to an additional geodatabase table and re-
geocoded based on the VA Road Centerline geocoding service.    The Road geocoding 
point data was spatially joined to the first quarter of 2011 VA Road Centerline data in 
order to place features in a linear feature class.  Data was then joined and imported to a 
road centerline feature class which matched the NTIA model.  Data was massaged and 
then loaded to the SBDD data model. 
 
Comcast 
Provider Name: Comcast Cable Communications, LLC 
DBA Name: Comcast 
FRN: 0004441663 
 
Comcast provided CIT and VGIN update text files for census blocks and addresses as well 
as speed based on region so for them to be usable in a GIS environment, they were 
converted to excel files.  A new personal Geodatabase was created to represent the 
staging of this broadband provider.   Comcast did not provide entire data sets so delta 
staging feature classes were created in the process.   All features were loaded into 
individual geodatabase tables and based on joins; exceptions were created in order to 
show all available coverage using census blocks and address ranges.  The regional speed 
data available in the Comcast text file spreadsheet was used in the creation of a 
boundary layer based on the census locality boundaries in Virginia and merged based on 
speeds across Virginia provided in the text data.   
 
The census block data less than 2 square miles which represented coverage areas by 
Comcast did contain the full FIPS id of each census block.  This information was used in 
joining to the 2000 TIGER data by FULLFIPSID. All joined values were kept and the joined 
block features were output to a new feature class based on the associated TIGER 2000 
GIS data in order to make sure the census geography provided to NTIA met the 
requirements. This data was imported into a staging feature class and to calculate Max 
Advertised Values, the speed regional polygon data was used in creating select by 
locations.   After this data was populated in the staging census block feature class, it was 
then loaded into the SBDD data model. 
 
Road address ranges that were provided by Comcast did not have TLID in them and 
therefore could not be used to create selections without some additional data 
manipulation.  Inside the original spreadsheet from Comcast, roads did have census 
block ID and street name.  The census block ID and Street name fields were 
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concatenated to create a string to use in joining.  The census block values for these 
roads were joined to the census block GIS data and were output to a feature class in 
order to create a maximum potential area of interest boundary for road segments.  The 
entire VA Road Centerline data from Quarter 1 of 2011 were clipped to these block 
polygons.  The clipped RCL values then were spatially joined to the blocks in order to get 
full FIPS block ID attached to the clipped road centerline based on area of interest for 
these select blocks.  Once the block values were added to the clipped RCL data, the 
census block ID that was added to the roads were concatenated with the street name.  
This concatenation in the clipped RCL data was joined with the original concatenation of 
the table.  All GIS features that matched were kept and output to a separate feature 
class using the NTIA model structure.    The speed polygon data which was created 
originally was used in calculating maximum advertised values for these segments and 
once the values were calculated, this iteration of the roads was loaded into the 
reporting database. 
 
MBC 
Provider Name: Mid-Atlantic Broadband Cooperative 
DBA Name: MBC 
FRN: 0019765304 
 
MBC provided CIT and VGIN GIS shape files of points where their addresses served were 
available as well as several other GIS shape file which did not pertain to the NTIA 
mapping initiative.  A new personal Geodatabase was created to represent the staging 
of this broadband provider and the address data was exported to a Geodatabase table 
in order to keep a single working environment in ArcGIS.   The address data was then 
geocoded based on the most recent VA address point geocoding service and was output 
to a new data set.   All unmatched or tied geocoded results were then exported to an 
additional geodatabase table and re-geocoded based on the VA Road Centerline 
geocoding service.    The Road geocoding point data was spatially joined to the first 
quarter of 2011 VA Road Centerline data in order to place the point features in a linear 
feature class.  Data was then joined and imported to a road centerline feature class 
which matched the NTIA model.  Data was massaged and then loaded to the SBDD data 
model. 
 

Participating Broadband Providers who did not submit updates 
 
The following broadband providers are participating in the SBDD program but did not 
indicate having updates for the spring 2011 submission.  The fall 2010 submission data 
for the broadband providers was included in the spring 201 reporting database.   
 

Broadband Provider FCC Registration Number 

Bugg’s Island Telecommunications 0002031698 

Burke’s Garden Telephone Company, Inc.   0004942819 
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Citizens Telephone Cooperative 0004381422 

Citizens Cablevision Inc. 0009485343 

Highland Telephone Cooperative 0004318846 

MetroCast 0018547471 

Nelson Cable  0000900287 

New Hope Telephone Cooperative 0002071579 

NextLink 0014286934 

NTELOS Wireless Various 

BVU OptiNet 0006823991 

Peoples Fairpoint 0002071116 

RoadStar Internet 0013445358 

Scott County Telephone Cooperative 0002069862 

The Wired Road 0020153854 

VMMicro 0018713800 

XO 0006275945 

 

Additional Broadband Provider data sets used in reporting data 
 
Community Anchor Institution information 
Virginia Tech held speed tests in order to get download and upload speeds for 
Community Anchor institutions.  NTIA requested that the data model not be changed so 
unfortunately speed data was not reported since VT had the typical upload and 
download speeds populated.  The requested attributes were advertised upload and 
download speeds; the broadband providers who provided service to the Anchor 
institutions in Virginia were unreported in many categories therefore advertised speeds 
were unavailable to report.   
 
Middle Mile 
If middle mile data was provided by the participating broadband provider, this was 
converted into a Geodatabase table in the providing broadband provider’s staging 
Geodatabase.  All appropriate fields were added in order to load data spatially.  This 
information was exported to an access database and then exported to comma delimited 
text for the non spatial middle mile reporting feature class. 
 
Pricing 
If nominal weighted subscriber speed was available from a broadband provider, the 
data was placed into an Access database which followed the format of requested text 
output information from NTIA.  It was then output to a requested tab delimited text file 
for the release.   
 
Speed based on CMA/MSA/RSA 
If speed was available by cellular market area or MSA/RSA and provided to CIT and 
VGIN, this information was placed into an Access database which followed the format of 
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requested text output information from NTIA.  It was then output to a requested tab 
delimited text file for the release.  This category of reporting was least provided by 
broadband providers. 
 

Validation and Quality Control 
 
The data included in the NTIA SBDD data model was quality controlled using the 
topology included in the model as well as the python script provided by NTIA.  The 
topology was validated using ESRI ArcGIS Topology validation tools and any errors were 
fixed using standard ESRI processing techniques. 
 
The attribution included in the Virginia submission was validated using the NTIA 
provided Python Script SBDD_CheckSubmission.py.  The script was run repeatedly 
against the data sets until all attribute errors were identified and corrected.  The script 
was altered by VGIN to limit each run to only one feature class to speed processing.  
Once each feature class was run successfully, the entire script was enabled and run in its 
entirety against the Virginia submission.  This final check ran without identifying any 
errors.   
 
The output of the final run is shown below: 
 
NOTES - RJO 
TRANS_TECH test failure in Address and Road_Segment is valid because of Wirless Vendor that submited Point and line 
data rather than polygon coverage areas. 
FAILED tests in CAI points are valid because of no Transmission Technology identified. 
 
* ----------------------------------------------------------------------------- 
* Data Submission Reciept 
* CheckSBDDSubmission.py 
* Created on: 3/23/2011 
* Created by: VA 
* State Broadband Data Development Program 
* NTIA / FCC 
* ----------------------------------------------------------------------------- 
 
******************************************************************************* 
*****                                                                     ***** 
*****                                                                     ***** 
*****                         Submission Reciept File                     ***** 
*****                     Check below for any FAILED Statements           ***** 
*****                                                                     ***** 
*****                                                                     ***** 
******************************************************************************* 
 
*Check Layer: LastMile 
      Geometry PASSED:  Layer has 0 records.  
      Field Check:     passed      LastMile_PROVNAME values are good  
      Field Check:     passed      LastMile_DBANAME values are good  
      Field Check:     passed      LastMile_FRN values are good  
      Field Check:     passed      LastMile_OWNERSHIP values are good  
      Field Check:     passed      LastMile_BHCAPACITY values are good  
      Field Check:     passed      LastMile_BHTYPE values are good  
      Field Check:     passed      LastMile_LATITUDE values are good  
      Field Check:     passed      LastMile_LONGITUDE values are good  
      Field Check:     passed      LastMile_ELEVFEET values are good  
      Field Check:     passed      LastMile_STATEABBR values are good  
      Field Check:     passed      LastMile_FULLFIPSID values are good  
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*Check Layer: MiddleMile 
      Geometry PASSED:  Layer has 490 records.  
      Field Check:     passed      MiddleMile_PROVNAME values are good  
      Field Check:     passed      MiddleMile_DBANAME values are good  
      Field Check:     passed      MiddleMile_FRN values are good  
      Field Check:     passed      MiddleMile_OWNERSHIP values are good  
      Field Check:     passed      MiddleMile_BHCAPACITY values are good  
      Field Check:     passed      MiddleMile_BHTYPE values are good  
      Field Check:     passed      MiddleMile_LATITUDE values are good  
      Field Check:     passed      MiddleMile_LONGITUDE values are good  
      Field Check:     passed      MiddleMile_ELEVFEET values are good  
      Field Check:     passed      MiddleMile_STATEABBR values are good  
      Field Check:     passed      MiddleMile_FULLFIPSID values are good  
 
*Check Layer: Address 
      Geometry PASSED:  Layer has 85481 records.  
      Field Check:     passed      Address_PROVNAME values are good  
      Field Check:     passed      Address_DBANAME values are good  
      Field Check:     passed      Address_FRN values are good  
      Field Check:     passed      Address_ADDRESS values are good  
      Field Check:     passed      Address_BLDGNBR values are good  
      Field Check:     passed      Address_STREETNAME values are good  
      Field Check:     passed      Address_CITY values are good  
      Field Check:     passed      Address_STATECODE values are good  
      Field Check:     passed      Address_ZIP5 values are good  
      Field Check:     passed      Address_LATITUDE values are good  
      Field Check:     passed      Address_LONGITUDE values are good  
      Field Check:     passed      Address_ENDUSERCAT values are good  
      Field Check:     FAILED      Address_TRANSTECH has UNEXPECTED VALUES  
      Field Check:     passed      Address_MAXADDOWN values are good  
      Field Check:     passed      Address_MAXADUP values are good  
      Field Check:     passed      Address_SpeedNotBB values are good  
      Field Check:     passed      Address_OneSpeedAndNotTheOther values are good  
      Field Check:     passed      Address_TYPICDOWN values are good  
      Field Check:     passed      Address_TYPICUP values are good  
      Field Check:     passed      Address_SpeedCheck values are good  
 
*Check Layer: CAInstitutions 
      Geometry PASSED:  Layer has 1684 records.  
      Field Check:     passed      CAInstitutions_ANCHORNAME values are good  
      Field Check:     passed      CAInstitutions_ADDRESS values are good  
      Field Check:     passed      CAInstitutions_BLDGNBR values are good  
      Field Check:     passed      CAInstitutions_STREETNAME values are good  
      Field Check:     passed      CAInstitutions_CITY values are good  
      Field Check:     passed      CAInstitutions_STATECODE values are good  
      Field Check:     passed      CAInstitutions_ZIP5 values are good  
      Field Check:     passed      CAInstitutions_CAICAT values are good  
      Field Check:     passed      CAInstitutions_BBSERVICE values are good  
      Field Check:     passed      CAInstitutions_DBANAME values are good  
      Field Check:     FAILED      CAInstitutions_TRANSTECH has UNEXPECTED VALUES  
      Field Check:     passed      CAInstitutions_MAXADDOWN values are good  
      Field Check:     passed      CAInstitutions_MAXADUP values are good  
      Field Check:     FAILED      CAInstitutions_SpeedNotBB has UNEXPECTED VALUES  
      Field Check:     passed      CAInstitutions_OneSpeedAndNotTheOther values are good  
      Field Check:     passed      CAInstitutions_FULLFIPSID values are good  
 
*Check Layer: CensusBlock 
      Geometry PASSED:  Layer has 190115 records.  
      Field Check:     passed      CensusBlock_PROVNAME values are good  
      Field Check:     passed      CensusBlock_DBANAME values are good  
      Field Check:     passed      CensusBlock_PROVIDER_TYPE values are good  
      Field Check:     passed      CensusBlock_FRN values are good  
      Field Check:     passed      CensusBlock_STATEFIPS values are good  
      Field Check:     passed      CensusBlock_COUNTYFIPS values are good  
      Field Check:     passed      CensusBlock_TRACT values are good  
      Field Check:     passed      CensusBlock_BLOCKID values are good  
      Field Check:     passed      CensusBlock_FULLFIPSID values are good  
      Field Check:     passed      CensusBlock_TRANSTECH values are good  
      Field Check:     passed      CensusBlock_MAXADDOWN values are good  
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      Field Check:     passed      CensusBlock_MAXADUP values are good  
      Field Check:     passed      CensusBlock_SpeedNotBB values are good  
      Field Check:     passed      CensusBlock_OneSpeedAndNotTheOther values are good  
      Field Check:     passed      CensusBlock_TYPICDOWN values are good  
      Field Check:     passed      CensusBlock_TYPICUP values are good  
      Field Check:     passed      CensusBlock_SpeedCheck values are good  
      Speed Tier Record Check PASSED  
 
*Check Layer: Overview 
      Geometry PASSED:  Layer has 0 records.  
      Field Check:     passed      Overview_PROVNAME values are good  
      Field Check:     passed      Overview_DBANAME values are good  
      Field Check:     passed      Overview_FRN values are good  
      Field Check:     passed      Overview_GEOUNITTYPE values are good  
      Field Check:     passed      Overview_STATECOUNTYFIPS values are good  
      Field Check:     passed      Overview_TRANSTECH values are good  
      Field Check:     passed      Overview_MAXADDOWN values are good  
      Field Check:     passed      Overview_MAXADUP values are good  
      Field Check:     passed      Overview_SpeedNotBB values are good  
      Field Check:     passed      Overview_OneSpeedAndNotTheOther values are good  
      Field Check:     passed      Overview_STATEABBR values are good  
      Field Check:     passed      Overview_SpeedCheck values are good  
 
*Check Layer: RoadSegment 
      Geometry PASSED:  Layer has 100501 records.  
      Field Check:     passed      RoadSegment_PROVNAME values are good  
      Field Check:     passed      RoadSegment_DBANAME values are good  
      Field Check:     passed      RoadSegment_PROVIDER_TYPE values are good  
      Field Check:     passed      RoadSegment_FRN values are good  
      Field Check:     passed      RoadSegment_ADDMIN values are good  
      Field Check:     passed      RoadSegment_ADDMAX values are good  
      Field Check:     passed      RoadSegment_STREETNAME values are good  
      Field Check:     passed      RoadSegment_CITY values are good  
      Field Check:     passed      RoadSegment_STATE values are good  
      Field Check:     passed      RoadSegment_ZIP5 values are good  
      Field Check:     FAILED      RoadSegment_TRANSTECH has UNEXPECTED VALUES  
      Field Check:     passed      RoadSegment_MAXADDOWN values are good  
      Field Check:     passed      RoadSegment_MAXADUP values are good  
      Field Check:     passed      RoadSegment_SpeedNotBB values are good  
      Field Check:     passed      RoadSegment_OneSpeedAndNotTheOther values are good  
      Field Check:     passed      RoadSegment_TYPICDOWN values are good  
      Field Check:     passed      RoadSegment_TYPICUP values are good  
      Field Check:     passed      RoadSegment_SpeedCheck values are good  
 
*Check Layer: Wireless 
      Geometry PASSED:  Layer has 14 records.  
      Field Check:     passed      Wireless_PROVNAME values are good  
      Field Check:     passed      Wireless_DBANAME values are good  
      Field Check:     passed      Wireless_FRN values are good  
      Field Check:     passed      Wireless_TRANSTECH values are good  
      Field Check:     passed      Wireless_MAXADDOWN values are good  
      Field Check:     passed      Wireless_MAXADUP values are good  
      Field Check:     passed      Wireless_SpeedNotBB values are good  
      Field Check:     passed      Wireless_OneSpeedAndNotTheOther values are good  
      Field Check:     passed      Wireless_TYPICDOWN values are good  
      Field Check:     passed      Wireless_TYPICUP values are good  
      Field Check:     passed      Wireless_STATEABBR values are good  
      Field Check:     passed      Wireless_SpeedCheck values are good 

 
During processing VGIN identified two issues with the NTIA provided Python script.  In order to 
complete the requirements of the submission, the script had to be altered slightly and those 
changes are detailed below. 
 

1. The Last Mile and Middle Mile feature class defines the attribute ELEVFEET to identify 
the elevation of the Last/Middle Mile point provided by the broadband providers.  If the 
SBDD data model, the default value is -9999.  The Python script contained a query string 
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“ELEVFEET Is Null OR ELEVFEET < 0” which was causing every record using the -9999 
default value to fail.  VGIN changed the query string to read "ELEVFEET Is Null OR 
(ELEVFEET < 0 and ELEVFEET <> -9999)" which allowed records using the default value 
to pass the validation check.  
 

2. Two Wireless broadband providers reported service territory using Points and Lines 
rather than Polygon features.  This cause the TTRANS_TYPE field to be populated with a 
value that did not pass the validation check for WIRELESS technology.  VGIN and CIT will 
work with these broadband providers in future submissions to deliver their information 
in a format that is compatible with the SBDD data model. 

 

Issues/Considerations 
Cellular Market Area reporting 
There were several cases where Cellular Market Area (CMA) coverage was used in reporting 
speed tiers.  A CMA shapefile was located online and loaded into SDE for processing.   The 
features used had CMA id number and CMA name and this information was spatial joined to 
blocks, streets, and addresses where pertinent. 
 
Several major providers submitted a census blocks less than two square miles and road segment 
ranges although left the upload and download speeds out.  The information for maximum 
advertised for up and download speed was provided in a separate spreadsheet and referenced 
speeds by cellular market area (CMA).  A CMA shapefile was downloaded and used potential 
census block information and this contained reference information to other spreadsheets.  The 
advertised download and upload speeds were provided by cellular market area. The road 
centerline information was then spatially joined to this updated table as well as the address 
points to get the speed information. 
 

Data version issues & future processing 
Several broadband providers reported blocks in 2008 geography so block FIPS id did not join 
from the provided block spreadsheet to the statewide block file.  Since these changes reported 
no results when joining, the column where block was reported was formatted to allow only the 
exact amount of characters for the block FIPS id to be equal from the provider to the feature 
selected.  This seemed to be the cause of why some blocks were reported in the less than two 
square mile feature class but their geometry was actually more than two from 2000. 
 
Broadband providers who reported address level data only did not have any additions or 
subtractions done to their reported data.  It was geocoded directly and results were loaded into 
the master data set wholesale so one thing that may be done or at least need to be looked at for 
the next submission is where these broadband providers report addresses that fall in blocks less 
than two square miles.  There may be many cases where these broadband providers actually 
need a block placed in the report instead of centerlines and points.   This may reduce the 
amount of total address points and road segments submitted as well as increase the individual 
coverage area for a broadband provider if we do leave out features that sit on top of these 
polygons.   
 
With further analysis of road name and address range data provided by broadband providers, 
many roads had null values for address range high and low as well as the street name.  This was 
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problematic when attempting to select by attributes since only data yielded results for segments 
where this information was populated. 
 
Also, further analysis of the data may show which centerline source broadband providers are 
using.  Geocoding data may be a step that is only needed for address data only in the future and 
not needed for ranges if the census data can be utilized for a geographic feature. 
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PREFACE  

This technical paper has been prepared by Stratum Broadband, LLC, as part of 
a consulting services engagement with the United States Virgin Islands 
Territory (USVI). The engagement covers support services provided to the 
USVI as part of a broadband mapping and planning project funded by the 
National Telecommunications Administration (NTIA) as part of the America 
Reinvestment and Recovery Act (ARRA) of 2009. 

Purpose 

This technical paper documents the process that has been used to collect and 
publish information regarding broadband availability in the Territory. 

Scope 

The State Broadband Data and Development Program (SBDD) follows 
guidelines for implementation as promulgated in the Notice of Funds 
Availability (NOFA) Docket No. 0660-ZA29. The Technical Appendix of the 
NOFA and the associated Clarification document provide a data model for 
reporting findings and definition for the data elements.  

The SBDD program seeks to document information regarding certain 
institutions in the Territory representing government, education, libraries, 
public safety, and healthcare. In addition to identifying these institutions, 
information profiling their existing utilization of broadband service is being 
collected. The collection and reporting process can be found in the 
Community Anchor Institutions (CAI) section. 

The SBDD program also seeks to document the general availability of 
broadband service throughout the Territory. The data is drawn directly from 
providers of broadband services within the Territory and from public sources. 
In addition to documenting advertised services, the SBDD Program seeks to 
validate the information collected using available means.  Lastly, the SBDD 
Program expects an effort will be made by the Territory to verify to what 
extent advertised services are actually reaching the consumer. 

Document Organization 

This document is organized into the following sections: 

Section 1, Background - This section provides some insight regarding the 
physical and political environment of the Territory that has some bearing on 
the strategy and tactics employed in carrying out the intent of the program. 
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Section 2, Community Anchor Institutions - This section describes the 
approach used to identify, qualify, collect, and document data regarding 
institutions classified as Anchor Institutions. 

Section 3, Service Providers - This section documents the process of 
identifying, qualifying, and collecting data from providers of broadband 
service to consumers in the Territory. 

Section 4, Verification - This section describes activities already undertaken 
or planned to verify the data reported for the project. 

 

Acronyms 

This document uses the following acronyms: 

ARRA America Reinvestment and Recovery Act 

FIPS Federal Information Processing Standards 

NTIA National Telecommunications Administration 

NOFA Notice of Funds Availability 

SBDD State Broadband Data and Development Program 

USVI United States Virgin Islands Territory 

UVI University of the Virgin Islands 

viNGN Virgin Islands Next Generation Network 

VIPFA Virgin Islands Public Finance Authority 

VIWAPA Virgin Islands Water and Power Authority 
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1. BACKGROUND 

This section provides some insight regarding the physical and political 
environment of the Territory that has some bearing on the strategy and tactics 
employed in carrying out the intent of the program. 

1.1. Geography 

The USVI is comprised of a group of islands some 70 miles east of San Juan, 
Puerto Rico. The Territory has a total population of about 108,000 residents. 
Most of the population resides on St. Thomas and St. Croix, the two largest 
islands. St. Croix is about 40 miles due south of St. Thomas. The third island 
of St. John is located 2 miles east of St. Thomas and is the site of a US 
National Park which occupies more than half of the land area on the island. A 
fourth island known as Water Island is located in the harbor of Charlotte 
Amalie on St. Thomas.  It is the smallest island with fewer than 600 residents. 
US Census Bureau record keeping overlays the three largest islands with the 
notion of county. The FIPS codes for USVI “counties” are: 

78010 – St. Croix 

78020 – St. John 

78030 – St. Thomas 

Water Island is included in FIPS 78030 (St. Thomas). The Territory 
government does not recognize or use the term county.  

1.2. Government 

The government of the USVI is made up of three branches: Executive, 
Legislative, and Judiciary. The Executive branch includes the Governor, Lt 
Governor and the Cabinet. The Cabinet is comprised of 26 department heads. 
The Territory is represented at the Federal level by an elected member of the 
US House of Representatives.  

The Department of Education operates thirty-four K-12 schools in the 
Territory. There is one four year university, the University of the Virgin 
Islands (UVI), with campuses on St. Thomas and St. Croix. 

There are full service hospitals on each of the two large islands and medical 
service facilities on St. John. 

While the head of government is on St. Thomas, many of the departments 
maintain administrative facilities on both St. Thomas and St. Croix due to the 
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physical separation of the Caribbean Sea between them. The government 
structure also includes organizational entities known as Authorities. These 
include the Public Finance Authority, Virgin Islands Next Generation 
Network, Virgin Islands Water and Power Authority, and the Virgin Islands 
Port Authority.  

1.2.1. Public Finance Authority – Office of Economi c 
Opportunity (VIPFA/OEO) 

The Public Finance Authority, Office of Economic Opportunity is the named 
awardee for the SBDD Program Grant. 

1.2.2. Virgin Islands Next Generation Network (viNG N) 

The Virgin Islands Next Generation Network is a public-private corporation 
established to construct and operate a Territory-wide wholesale fiber-optic 
network.  The Territory is the recipient of an ARRA BTOP grant intended to 
fund the construction of this network. 

The Public Finance Authority has delegated authority to manage fulfillment of 
the State Broadband Data and Development to viNGN.  

1.2.3. Virgin Islands Water and Power Authority (VI WAPA) 

Virgin Islands Water and Power Authority is the government operated water 
and electric power utility of the Virgin Islands.  It is a public private 
corporation which operates electric generation facilities and electric power 
distribution in the Territory. VIWAPA also operates water desalinization and 
distribution facilities. VIWAPA has contributed rights of way, underground 
conduit, and poles that will support deployment of the viNGN optical fiber 
wholesale broadband network.  

During the planning portion of the SBDD project, VIWAPA contributed 
Computer Aided Design (CAD) files of pole locations to the SBDD project.  

1.3. Special Conditions 

During the course of collection and validation of information, there were a 
few conditions that influenced the process.  

1.3.1. Geocoding Constraints 

The US Census Bureau Tiger Line records for Census 2000 data do not 
provide any street segment data for the USVI. Street names in the USVI are 
meaningful only within the context of historic land areas referred to as 
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“estates.” This land management structure is a carry-over from earlier 
governance of the islands by Denmark. The USVI became a US possession as 
the result of its purchase from the government of Denmark in 1917. Land 
parcel ownership records are currently maintained in this estate format. 

When interviewing service providers, we found that service location 
identification, which is typically based on street addressing, is virtually 
nonexistent in provider record keeping. Billing is almost exclusively directed 
to post office boxes. Where physical plant service locations are recorded, they 
are generally defined by reference to known landmarks.  

The Lt. Governor’s office includes a GIS organization which has been guiding 
a collaborative effort among all Territory departments to share available 
geodata in a common structure. The Virgin Islands Geospatial Information 
Council (VIGIC) is engaged with Federal agencies, such as the US Geological 
Survey, as well. There is currently a project underway to plan for conversion 
to geocoded street addressing system over the next two to four years.  

1.3.2. Internet Exchange Service Availability 

All terrestrial service providers rely on submarine cable based data services 
from Florida for telephone and broadband data services. The cables are 
operated by AT&T (St. Thomas) or Global Crossing (St. Croix).  

Communication services between the islands of St. Thomas and St. Croix is 
available by submarine cable service leased from AT&T in 45Mbps 
increments. Communication services between St. Thomas and St. John is 
available by submarine fiber cable operated by the VIWAPA.  

1.3.3. Non Terrestrial Service Providers 

Wireless mobile broadband service providers use licensed spectrum and 
operate radios in the Territory for 3G services. They merchandise end user 
equipment through local retails stores or authorized dealers. Except for local 
dealer advertising, services are advertised on national broadband sites 
including general coverage maps. The business operations for national 
providers are not located in the Territory. 

Ground station equipment for consumers is available from at least two 
satellite providers through dealers located on St. Thomas. These dealers will 
travel to the other islands to effect installation. 
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2. COMMUNITY ANCHOR INSTITUTIONS 

This section provides information regarding the collection and classification 
of data pertaining to Community Anchor Institutions (CAIs). 

2.1. Data Gathering 

CAIs are comprised of schools, libraries, medical and healthcare providers, 
public safety entities, institutions of higher education, and other community 
support organizations and entities. The NTIA has asked that these CAIs be 
categorized according to the codes shown in Table 2-1. 

Table 2-1 Community Anchor Institution Category Codes 

Category Code Category 

1 School – K through 12 

2 Library 

3 Medical/healthcare 

4 Public safety 

5 University, college, other post-secondary 

6 Other community support – government 

7 Other community support – nongovernmental 

 

While most CAIs fall into obvious classification, some decisions are required 
where the NOFA does not directly address certain situations. These 
exceptions for the USVI are summarized in Table 2-2. 
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Table 2-2  Community Anchor Institutions Categorization Decisions 

Categorization Exception Categorization Decision 
Adult Education geared toward GED-level 
learning 

Included with Code 1: Learning at the K-12 
level 

Private preschool programs that include 
Kindergarten 

Included with Code 1: Though main focus of 
institution is pre-K, a qualifying program is 
offered 

V.I. Department of Education administrative 
offices and facilities 

Included with Code 6: Since these facilities 
are not used for actual education of 
students, it seems they are community 
support – government 

Single private medical offices Not included: Individual medical offices do 
not seem to fall into the notion of community 
support 

Buildings housing many private medical 
offices 

Included with code 3: Most of these multi-
practice buildings have association with 
public healthcare facilities and house a 
significant number of healthcare providers. 

Other  community support – 
nongovernmental 

Included with code 7: It was decided to limit 
this category to established community, 
learning, and recreation centers, as well as 
nationally recognized youth clubs. 

Co-located CAI A certain number of CAIs are co-located in 
common municipal or other buildings. In 
these situations it was determined that co-
located CAI falling under a common 
department or authority would be considered 
a single CAI. In cases where the CAIs were 
of different departments of authorities, they 
would be considered separate CAIs. 

 
The bulk of the initial CAI list was generated from a Google Earth (kml) layer 
file obtained by Stratum Broadband from the engineering department of the 
VIWAPA. VIWAPA maintains a location-based list of most public and 
private institutions on the islands for planning and service purposes. Due to 
the size of the Territory, it was practical to supplement this list of potential 
CAIs with data culled from public sources, such as the local phone book and 
standard web searches. 

Data regarding broadband service at each identified CAI is being collected by 
Stratum Broadband and the newly created Virgin Islands Next Generation 
Network (viNGN), the USVI Territory grantee, through a CAI outreach 
program designed to benefit both the SBDD and the Broadband Technology 
Opportunities Program (BTOP). This program includes paper surveys 
distributed at meetings for the CAIs run by viNGN and the Territorial 
governor, online surveys at vingn.com, and personal contacts with information 
technology directors of the various institutions. As of April 1, 2011, a 
determination of broadband service subscription has been made at 
approximately 10% of the 324 CAI locations. It is projected that by October 1, 
2011, this number will be at 75% or higher. 
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2.2. Data Validation and Processing 

There are three main points of validation and processing for the CAI data: 
location, data format normalization, and broadband service subscription.  

2.2.1. Location 

Validation of CAI locations is made difficult in the Territory by the absence 
of a consistent addressing convention and by the unavailability of geocoding 
resources. These concerns are being addressed currently by a project under the 
direction of the Office of the Lieutenant Governor. This data will be used as it 
becomes available.  

In lieu of geocoding resources, a week-long program was undertaken by 
Stratum Broadband and VIWAPA to verify the location of each identified 
CAI. Latitude and longitude values were taken using a standard retail Garmin 
Zumo model 550 with WAAS enabled at a location as close to the building 
entrance as practical. As a result, all reported CAI locations have been 
visually confirmed by Stratum Broadband, and most GPS readings are within 
50 yards of the physical building entrance on the street side. 

All CAI locations were verified using ESRI ArcMap Topology tools to fall 
within the state boundaries. 

2.2.2. Data Format Normalization 

There are two main issues with normalizing the data formats for reporting to 
the NTIA. The first issue is with CAI naming conventions, and the second 
issue is with consistent street addressing. 

The NTIA has asked that the name of each CAI be unique. While this is 
satisfied in many cases by using the formal name of the CAI facility, there are 
a number of cases, particularly in the public safety and other community 
support – government categories, where formal facility names are not unique. 
For example, a government department may have an office on each of the 
three islands, each bearing only the name of the department. Table 2-3 
summarizes the general naming conventions used for each CAI category code.  
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Table 2-3  Community Anchor Institution Naming Conventions 

Code Category Naming Convention ([ ] denotes used as 
needed) 

1 School – K through 12 Formal name [- geographic name] 
2 Library Formal name 
3 Medical/healthcare Formal name [- geographic name] 
4 Public safety Formal name [- geographic name] 
5 University, college, other post-

secondary 
Formal name [- geographic name] 

6 Other community support – 
government 

Department [-facility name[- geographic name] 

7 Other community support – 
nongovernmental 

Formal name [- geographic name] 

 
The second data format normalization issue is due to the non-conventional 
and non-consistent addressing scheme used to identify street addresses in the 
USVI.  Where verifiable, the publicly advertised (by phone book and/or web 
site) address was used.  

There seems to be two main schemes for designating a street address. The 
collected street address data also showed combinations and variations of these 
two main schemes.  

1. Building Number, Street Name, City, State, ZIP code 

2. Parcel Number, Estate, Island, State, ZIP code 

Scheme 1 maps very closely with the addressing format requested by the 
NTIA and addresses conforming to this scheme required no further 
processing. 

For addresses not conforming to Scheme 1, the conversions shown in Table 
2-4 were used where applicable. 

Table 2-4  Non-conventional Address Mapping 

Non-conventional Address Part NTIA Address Field 
Parcel Number Building Number 
Estate STREET NAME 
Island CITY 

 
About 40% of the addresses have no obvious analog to the Building Number. 
In these cases the Building Number field was reported as “N/A.” 

2.2.3. Broadband Service Subscription 

To this point in time, there have been no attempts to validate broadband 
service subscription at the CAI locations. CAI representatives are reporting 
the speeds according to their contracts with the various providers. In cases 
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where a CAI may have more than one broadband connection, the higher speed 
connection is reported. It is hoped that a future activity will involve collecting 
of speed test data from a number of CAIs to validate a sampling of the 
reported speeds. 

2.3. Reporting Summary 

For the Spring 2011 NTIA reporting period, Stratum Broadband identified 
324 CAIs. Table 2-5 summarizes the breakdown by category. Subscription to 
broadband service has been identified in about 10% of the total number of 
CAIs. Of those whose broadband subscription status is known, 47% have 
internet access at qualifying speeds.  

Table 2-5  Community Anchor Institution Breakdown by Category 

Code Category Count % of Total 
1 School – K through 12 82 25 
2 Library 7 2 
3 Medical/healthcare 19 6 
4 Public safety 42 13 
5 University, college, other post-secondary 4 1 
6 Other community support – government 133 41 
7 Other community support – nongovernmental 37 11 
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3. SERVICE PROVIDERS 

This section describes the identification, collection, and processing of data 
related to broadband service providers operating in the USVI. 

3.1. Data Gathering 

The NOFA defines available broadband service in the following words: 

Broadband service is “available” to an end user at an address if a 
broadband service does, or could, within a typical service interval 
(7 to 10 business days) without an extraordinary commitment of 
resources, provision two-way data transmission to and from the 
Internet with advertised speeds of at least 768 kilobits per second 
(kbps) downstream and at least 200 kbps upstream to the end user 
at the address 

 
For practical purposes of classification, this statement was interpreted into a 
set of rules to determine what qualifies as broadband service in the USVI. An 
Internet service provider is considered to offer qualifying broadband service if 
the following requirements are met: 

 
1. Provider offers two-way data transmission to the Internet for end 

users in a geographical area within the USVI.  This rule was used to 
exclude two companies who provide internal network services targeted 
only to the hospitality industry and who, as part of their network 
services, resell internet connections from facility-based providers. 
They do not offer broadband service generally to end users in a 
geographic region. It is possible that this restriction may be altered in 
future reports to allow these companies to appear as resellers. 

 
2. Provider publicly advertises Internet service levels of at least 768 

kbps downstream and 200 kbps upstream. This rule was used to 
exclude all dial-up services and a number of Terrestrial Fixed Wireless 
and DSL service offerings. However, no wireless or DSL providers 
were excluded by this rule since all offer at least one service level 
meeting the minimum speed standards.  
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3. Provider must be able to provision the service to the end user 
within a typical service interval of 7-10 business days. This rule 
excluded a number of traditional copper wireline services, as well as a 
number of high bandwidth point-to-point business service offerings.  

 
While not used to determine broadband service qualification, the question was 
raised whether both residential and business offerings should be considered 
when determining the maximum advertised speeds. In general, the business 
offerings include speed tiers above those offered to residential customers with 
an often quite significant increase in pricing structure. The concern is that a 
resident or small business owner may view the National Broadband Map and 
see that 5 Mbps service is available at his location, but find out from the 
providers that one must be able and willing to pay a significant monthly fee 
($500-$1000) that is impractical for a typical household or small business. 
Conversely, if reported speeds were limited to residential offerings, the 
medium and large businesses would not find useful information on the 
National Broadband Map. Ultimately, since no clear language in the NOFA or 
various clarifications provided by the NTIA could be used to exclude a service 
level based on price or target market, it was decided to include the qualifying 
business offerings when determining the maximum advertised speed levels. 

In total eight providers, offering nine qualifying broadband services, were 
identified. The Table 3-1 shows a breakdown of qualifying services by 
transmission type. Of the eight identified providers, four are local providers 
operating mostly in the USVI. The remaining four are national cellular or 
satellite providers. 

Table 3-1  Qualifying Services by Transmission Type 

Code Transmission Type Qualifying 
Services 

10 Asymmetric xDSL 1 
60 Satellite 2 
70 Terrestrial Fixed Wireless - Unlicensed 1 
71 Terrestrial Fixed Wireless - Licensed 2 
80 Terrestrial Mobile Wireless 3 
 Total 9 

 

3.2. Data Collection 

Collection of service provider data has mostly been facilitated through 
leveraging of personal contacts with each of the providers. The relatively 
small number of providers in the USVI makes this approach feasible. Initial 
contacts among the local providers were made during stakeholder meetings 
convened by the Territorial Government in the early planning phases. 
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Subsequently, Stratum Broadband personnel have met with each provider to 
explain the purposes of the SBDD program, to detail the information required, 
and to address concerns of confidentiality of proprietary data. 

Before data could be collected from the local providers, Non-Disclosure 
Agreements (NDAs) were negotiated. One unique and common concern 
addressed in the NDA was that infrastructure information (last mile, middle 
mile, and backhaul) should only be known by Stratum Broadband and not be 
shared with the Territorial government agencies involved in the project. The 
issue being that of information in the hands of government officials becomes 
subject to requests for public data.  

The data collected for the national carriers was all done from public sources, 
such as web sites and FCC licensing data, as well as personal contact with 
local resellers of the service. No NDAs were negotiated with these national 
providers, nor has Stratum Broadband yet been able to identify suitable 
contacts within the national providers to confirm the data collected. No 
infrastructure data is known for these national providers. 

3.2.1. Infrastructure Data 

Each local provider agreed to share information with Stratum Broadband 
about the qualifying services under the established NDA. Spreadsheets 
detailing the required data were prepared and emailed to the appropriate 
contact for each provider. Completed spreadsheets, along with supporting 
information, were delivered to Stratum Broadband by email. Generally, more 
details about the network infrastructure were given to Stratum Broadband than 
the NDA permitted to be disclosed to the NTIA. Particularly, information 
detailing location, technology, or capacity of last mile and middle mile nodes 
were useful in adjudging the reasonableness of claimed availability areas, but 
were not reported in full. 

3.2.2. Broadband Availability Areas 

Each provider of qualifying service presents a unique situation regarding the 
designation of areas of availability. Stratum Broadband worked with each 
provider to collect the data necessary to present an acceptable representation 
of the actual area of availability. Table 3-2 summarizes the data collected 
from each provider for use in determining availability areas. 



SBDD METHODOLOGY PAPER 
 

 
 April 1, 2011 14  
 SBDD Methodology Paper  

The Virgin Islands Public Finance Authority 
 viNGN 

Table 3-2  Summary of Collected Availability Area Data 

Provider Service Type Source Type of Data 
AT&T Mobility Mobile Wireless web site GIF file from national 

coverage tool 
Broadband VI Fixed Wireless Google Earth 

file 
Hand-drawn polygon of area 
where no coverage, 
locations of access radios 

Choice 
Communications 

Fixed Wireless GeoTiff file Output of RF propagation 
tool 

Choice 
Communications 

Mobile Wireless web site GIF file from national 
coverage tool 

HughesNet Satellite email Experience of local reseller 
Innovative PowerNet Asymmetric 

xDSL 
spreadsheet Locations of DSLAM access 

nodes 
SmartNet Fixed Wireless spreadsheet Locations of access radios 
Sprint Mobile Mobile Wireless web site GIF file from national 

coverage tool 
StarBand Satellite email Experience of local reseller 

 

3.3. Data Validation and Processing 

3.3.1. Infrastructure Data 

In general, network infrastructure is difficult to validate and must be assumed 
to be truthfully reported. Stratum Broadband has made an effort to spot check 
some location claims of access and middle mile points through direct visual 
inspection of facilities, such as a wireline central office or radio antenna, and 
public records, such as FCC licensing records. Stratum Broadband has found 
no evidence that would make the reported infrastructure data come under 
suspicion. 

Spreadsheets containing the location data for the various provider 
infrastructure networks were imported into separate ESRI data layers as XY 
data for each provider. Locations serving end users were considered to be 
access nodes and are classified as “last mile.” Locations that aggregate data 
from two or more access nodes are classified as “middle mile.” Some middle 
mile points are also last mile points. 

This infrastructure data is mostly used to validate the reasonableness of 
broadband availability areas. However, some of the middle mile data, as 
permitted by the agreements with the providers, is reported to the NTIA 
during the semi-annual data submissions. In no case does a provider permit 
the reporting of last mile points or of middle mile backhaul capacity. In some 
instances, a provider may request that the locations of certain middle mile 
points be omitted. The reported data, therefore, is mostly just the geographic 
locations of a subset of the actual middle mile points and cannot be considered 
to be a full representation of the network infrastructure for any given provider. 
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Table 3-3 summarizes the number of middle mile points reported for each 
qualifying service. 

Table 3-3  Summary of Middle Mile Points by Service 

Provider Technology Count of Middle Mile  
Points Reported 

AT&T Mobility Mobile Wireless 0 
Broadband VI Fixed Wireless 18 
Choice Communications Fixed Wireless 2 
Choice Communications Mobile Wireless 0 
HughesNet Satellite 0 
Innovative PowerNet Asymmetric xDSL 6 
SmartNet Fixed Wireless 4 
Sprint Mobile Mobile Wireless 0 
StarBand Satellite 0 

 

3.3.2. Broadband Availability Area 

Due to the unique data made available by the providers to determine the area 
of availability, each qualifying service will be treated individually in this 
section. In all cases, service availability has been restricted to land areas, 
though it should be noted that all wireless services are, in fact, available in 
some portion of the waters surrounding the USVI. 

3.3.2.1. AT&T Mobility (Terrestrial Mobile Wireless) 

The sources for both coverage and spectrum are collected from public data 
available through the AT&T web site and the FCC Universal Licensing 
System. The coverage polygon was hand drawn by Stratum Broadband to 
approximate the advertised 3G coverage map available on the national AT&T 
wireless web site. The spectrum data is a best guess based on the spectrums 
owned by AT&T Mobility in the USVI matched against the specifications of 
the data-capable phones available through local AT&T Mobility resellers.  

The data here should be considered preliminary and is likely to be adjusted 
significantly by the Round 4 submission in October 2011. 

3.3.2.2. Broadband VI (Terrestrial Fixed Wireless) 

Broadband VI (BBVI) uses unlicensed spectrum and does not maintain RF 
propagation maps of coverage area. However, BBVI engineers have extensive 
practical knowledge of BBVI service availability. BBVI provided hand-
generated polygons representing where coverage is not available. These 
polygons were merged with a polygon layer representing the land area of the 
USVI. The result was a polygon with holes where BBVI has determined it 
does not serve. This polygon represented the claimed area of availability.  
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This polygon was visually compared to the location and direction of each 
BBVI access radio, as well as topological features of the islands, to judge the 
reasonableness of the claimed coverage. Small modifications were made 
manually to this polygon by Stratum Broadband in areas where topological 
features would likely block signal from known access tower locations.  

This data is likely a close representation of the internet service provided by 
BBVI.  

3.3.2.3. Choice Communications (Terrestrial Fixed Wireless) 

The source of this data feature was provided by Choice Communications 
(Choice) during the collection of data prior to the Round 1 submission in 
April, 2010. Choice has been unwilling to provide further data. Stratum 
Broadband has found no public evidence that the data has changed 
significantly since that time.  

The coverage polygon is the result of using standard ESRI tools to convert a 
rasterized TIFF file, generated by Choice using RF propagation tools, into an 
ESRI shapefile. The coverage polygon was smoothed to eliminate subparts of 
less than approximately one-eighth square miles. No special validation was 
done since the source data was used by internal Choice engineers to manage 
its network. The spectrum data was provided by Choice engineers.  

This data set should be considered to be highly accurate with the caveat that 
the data is aged.  

3.3.2.4. Choice Communications (Terrestrial Mobile Wireless) 

Choice began offering a "4G" mobile internet service in late Fall 2010. Choice 
declined to provide data concerning this service. All data is approximated 
from publicly available information. The coverage polygon was hand-drawn 
to approximate the coverage represented in a GIF image on the Choice web 
site. The spectrum data is a best guess based on the spectrums owned by 
Choice in the USVI.  

This data should be considered preliminary and approximate.  

3.3.2.5. HughesNet (Satellite) 

Coverage for this satellite provider has been approximated to encompass the 
entirety of the major land areas of the USVI. This decision was made based on 
the anecdotal information provided by the local reseller who believes service 
is available in all parts of the territories, despite the fact that quality of service 
does vary in certain areas. This data will be refined by the Round 4 
submission in October of 2011.  



SBDD METHODOLOGY PAPER 
 

 
 April 1, 2011 17  
 SBDD Methodology Paper  

The Virgin Islands Public Finance Authority 
 viNGN 

The data in this feature should be considered preliminary and approximate.  

3.3.2.6. Innovative PowerNet (Asymmetric xDSL) 

Innovative DSL service availability is reported at the census block level. Due 
to limited Road Segment data in the 2000 Census geographic data for the 
USVI, the availability of broadband in the six census blocks greater than two 
square miles is reported with the census block data. Additionally, only census 
blocks with land area greater than zero have been considered.  

The availability of DSL service from Innovative was derived by Stratum 
Broadband based on the locations of Innovative DSLAMs (access nodes). 
Working under the industry-accepted assumption that DSL service can 
reasonably be provisioned to end points less than approximately 12,000 line-
feet from a DSLAM, Stratum Broadband drew circular buffers, with radius of 
12,000 feet, around each. To further refine the actual areas of reasonable 
availability, Stratum Broadband manually made modifications to each circle 
where appropriate, based on data layers of roads and utility pole locations to 
better approximate points within a distance of 12,000 line feet from each 
DSLAM.  

Census blocks intersecting the derived coverage polygon were determined to 
have access to this DSL service. The resulting collection of census blocks was 
trimmed to exclude any census blocks having no land area. Census blocks 
with zero population were retained. 

This data is likely a close representation of the Internet service provided by 
Innovative.  

3.3.2.7. SmartNet (Terrestrial Fixed Wireless) 

SmartNet does not maintain RF propagation maps of coverage area. However, 
SmartNet engineers have provided hand-generated polygons representing 
where coverage is available. This claimed coverage area was compared to the 
location and direction of each SmartNet access radio, as well as to topological 
features of the islands, to judge the reasonableness of the claimed coverage. 
Small modifications were made by Stratum Broadband where it seemed 
appropriate. 

This data is likely a close representation of the internet service provided by 
SmartNet.  

3.3.2.8. Sprint Mobile (Terrestrial Mobile Wireless) 

The sources for both coverage and spectrum are collected from public data 
available through the Sprint Mobile web site and the FCC Universal Licensing 
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System. The coverage polygon was hand drawn by Stratum Broadband to 
approximate the advertised 3G coverage map available on the national Sprint 
Mobile wireless web site. The spectrum data is a best guess based on the 
spectrums owned by Sprint Mobile in the USVI matched against the 
specifications of the data-capable phones available through local Sprint 
Mobile resellers.  

The data here should be considered preliminary and is likely to be adjusted 
significantly by the Round 4 submission in October 2011. 

3.3.2.9. Starband Communications (Satellite) 

Coverage for this satellite provider has been approximated to encompass the 
major land areas of the USVI. This decision was made based on the anecdotal 
information provided by the local reseller who believes service is available in 
all parts of the territories, despite the fact that quality of service does vary in 
certain areas. This data will be refined by the Round 4 submission in October 
of 2011.  

The data in this feature should be considered preliminary and approximate. 

3.4. Reporting Summary 

As of December 31, 2010, eight broadband service providers were offering a 
total of nine different qualifying broadband services in the USVI. Table 3-4 
summarizes each service including the percent coverage of each service by 
land area, households, and population. 

Table 3-4  Summary of Qualifying Broadband Services 

Provider Technology Max 
Down* 

Max 
Up* 

%  
Land 
Area 

%  
Households 

%  
Population 

AT&T Mobility Mobile 
Wireless 

3 2 99.1 98.4 98.6 

Broadband VI 
Fixed 

Wireless 4 4 90.8 91.2 92.0 

Choice 
Communications 

Fixed 
Wireless 

3 2 51.8 54.5 56.3 

Choice 
Communications 

Mobile 
Wireless 

4 3 86.2 95.5 96.0 

HughesNet Satellite 5 3 99.8 98.8 98.9 
Innovative 
PowerNet 

Asymmetric 
xDSL 

3 2 91.4 99.2 99.2 

SmartNet Fixed 
Wireless 

4 3 62.0 85.4 87.1 

Sprint Mobile 
Mobile 

Wireless 3 2 69.8 89.1 90.1 

StarBand Satellite 3 2 99.8 98.8 98.9 
*  2 = 200 kbps – 768 kbps, 3 = 768 kbps – 1.5 Mbps, 4 = 1.5 Mbps – 3.0 Mbps, 5 = 3.0 Mbps – 6.0 Mbps 
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4. VERIFICATION 

This section describes activities already undertaken or planned to verify the 
data reported for the project. 

4.1. Community Anchor Institutions  

At the outset of the project, more than 90% of the 321 identified CAIs were 
visited to verify their existence, clarify naming, verify addressing (as 
available), and establish geo location (GPS collection of Latitude and 
Longitude coordinates).  The geo coordinates were plotted to verify 
reasonableness by observation. 

An on-going effort by viNGN and Stratum Broadband continues to reach out 
to CAIs by on-line survey and telephone as needed to collect and verify 
broadband service delivery technology type and performance. 

4.2. Service Providers 

Efforts have been made to ensure the inclusion of all eligible service providers 
in the collection and reporting. This has included searches of the FCC 
Universal Licensing System, web searches, media searches, such as Yellow 
Pages, and newspapers. 

A further source would be the use of data gathered from FCC Form 477 
submissions as authorized FCC Order 10-71. We anticipate completing 
service provider validation using this source during 2011. 

4.3. Speed Testing 

Speed testing, operated by the USVI as part of this program, will be used to 
document representative levels of broadband data rates wherever possible. 
Speed test information reported from outside services such as the FCC will be 
monitored and rationalized where possible to compliment project office 
results.  

4.3.1. FCC Sponsored 

The FCC is making some data available as part of an agreement with national 
services by OOKLA and MLabs. The expectation was that data would be 
shared at regular monthly intervals, but that has not been the experience so 
far. When attempting to use the data, we have found the process of 
determining the location of the originating request to be difficult and without 
enough location precision to be meaningful. 
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4.3.2. USVI Project Office Sponsored 

Our planned deployment of project office sponsored speed testing has been 
delayed a number of times while project office administrative issues are sorted 
out.  The planned implementation will provide for user-initiated speed testing 
to a common (not provider specific) point in an effort to normalize the user 
experience while also capturing user location to the nearest Census Tract or 
“Estate” boundary. This assumes user cooperation in selecting their 
geographic location on an interactive map before initiating the speed test. 

4.4. Surveys 

Surveys are being used to collect information directly from an end user, 
whether they are residents, businesses, or CAIs.  

4.4.1. Community Anchor Institutions 

The Office of the Governor has held a series of meetings with department 
heads of the government and other enterprises that make up the CAI database. 
These meetings provided an opportunity to present written survey forms to 
participants to solicit information regarding broadband service capabilities. 
This also provided an opportunity to solicit telephone contact information to 
the technical resource in each institution who would be responsible for the 
broadband service arrangements. Data collected in this exchange is being 
entered directly into a project geodatabase maintained for the project. 

The project office has also launched an on-line interactive survey with the 
expectation that new information will be derived. This will require some effort 
to guide CAI organizations to the survey site. 

4.4.2. Businesses 

The project office has launched an on-line interactive survey in hopes of 
collecting broadband service usage information directly from enterprises in 
the Territory. This will require some effort to guide enterprises in locating the 
on-line survey site. 

4.4.3. End Users 

The project office has launched an on-line interactive survey in hopes of 
collecting broadband service usage information directly from end users in the 
Territory. This will require some effort to guide visitors in locating the on-line 
survey site. 
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4.5. Performance Probe 

The plan for operating a performance probe has been available from the 
beginning of the project. Sorting out the details of funding and 
implementation has delayed the launch to date. A commercial software 
product is necessary to conduct this sort of verification.  

The technique requires the cooperation of testers willing to host a probe agent 
on their home computer system. The goal is to identify up to 200 users to 
participate in the program. User participation as a volunteer would be solicited 
while visiting the Territory Broadband Map site. Volunteers would be 
screened by the program office and selected by the geographic location of 
their system. This selection process is necessary to assure a suitable 
distribution across the geography of the Territory. The test results can be quite 
reliable assuming a participation sample of 200 end users. 

A central server manages the entire process of installing the probe client on 
the volunteer’s system. Other than accepting the client installer on to his 
system, no further user participation is required. The central server configures 
the client to initiate a test at regular intervals 24 hours a day and 7 days a 
week. The server at the central site is responsible for storing the results of 
each test along with the identity of the client. The results are collected in a 
proprietary database at the managing server.  Periodically, results are exported 
to relational database using a standard API provided by the probe system 
vendor. The individual results are analyzed and then aggregated to provide 
performance reporting.  

With this automated testing, we can establish the “busy hour” while also 
establishing “typical” speeds.  
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Project History: Vermont’s Broadband Mapping Initiative (BMI) is a collaborative broadband data 
collection and verification effort involving partners from the public, private and academic sectors 
participating as the Vermont Broadband Mapping Team.  The BMI is supported by grant funds provided 
under the National Telecommunications and Information Administration’s (NTIA) State Broadband Data 
and Development Program (SBDD). 
 
In November 2009 the Vermont Broadband Mapping Team (BMT) initiated the creation and 
development of a comprehensive and verified geographic inventory of broadband service availability in 
the State of Vermont. Landline and wireless services (fixed and mobile) were mapped using information 
from the providers and other sources. The broadband mapping information collected and verified through 
this effort is supporting the broadband development objectives identified in the RUS Broadband 
Initiatives Program (BIP) and NTIA’s Broadband Technology Opportunities Program (BTOP) in 
Vermont. Most importantly, the geographic inventory will further refine our understanding of the 
location of “unserved” and “underserved” areas in the state, thereby supporting targeted future 
investments in these areas. 
 
The BMT includes the following organizations: Vermont Department of Public Service, the Vermont 
Telecommunications Authority, the Center for Rural Studies at the University of Vermont, Vermont’s 
Enhanced 9-1-1 Board and the Vermont Center for Geographic Information.  The BMT is also supported 
by private sector contractors.  
 
Summary of Deliverables:  The BMT’s second broadband data submission (April 1st, 2011) includes 
broadband information as of December 31st

 

, 2011 (VT_Package_April1_2011_v1.zip).  The data 
complies with the NTIA NOFA requirements and SBDD data model (FGDB) specifications as of 
1/13/2011.  A detailed description of each dataset is available in the ./metadata folder included with the 
deliverable package. 

Data Development Methodology:   A variety of data source and data collection methods were used to 
identify the characteristics and geographic extent of broadband service in Vermont.  Here is a quick 
breakdown 
       

- Cable: Mapped to street/street-segment level 
- DSL: Mapped as polygons (usually Exchange areas) or address points (list of addresses submitted 

by provider). 
- Fiber Optic: Mapped as address points (list of address submitted by provider) 
- Fixed Wireless (WISP): Mapped as polygons (propagation maps prepared by independent 

contractor using data provided by WISPs) 
- Mobile Wireless: Mapped as polygons (data submitted by provider) 
- Satellite: Mapped as polygons (data submitted by provider).  Providers of satellite-based 

broadband services claimed that they covered the entire state. 
 
The cable, DSL, fiber optic, and fixed wireless (WISP) layers were “intersected” with Vermont’s E911 
address point layer to determine broadband availability at the address-level.  This information was then 
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intersected with Vermont’s 2000 Census Block layer to calculate availability at the block level.  The 
April 1st

 

, 2011 deliverable includes Census block-level data for Census Blocks less than or equal to 2 sq 
miles, and address level data for Census blocks greater than 2 sq miles. 

Mobile wireless and satellite-based broadband polygons were submitted by providers to VCGI.  They 
were formatted to match NTIA specification, but otherwise forwarded as-is. 
 
Vermont’s broadband providers submitted data which was used to populate a table listing maximum 
advertised and typical speeds by Metropolitan Statistical & Rural Service Areas (Cellular Market Areas).  
This information was used to populate the speed information contained in the submitted broadband, 
including speed information at the census block level.  In numerous cases providers did not submit 
typical speed information. 
 
The initial list of Community Anchor Institutions (CAIs) was derived from existing data sources 
including the VT Critical Facilities Database and Public Libraries Survey from the Institute of Museum 
and Library Services.  Community Anchor Institutions include schools, libraries, medical facilities, 
public safety facilities, universities and colleges, and other community facilities such as town 
halls/offices. An email and hard-copy mailing was sent to every institution in the list.  They were asked 
to fill out an online survey.  Follow-up emails and phone calls were made to increase the response rate.  
The data delivered to the NTIA includes all CAIs, but only includes broadband information for a subset.  
Additional broadband institutions will be added as their information becomes available. 
 
Data Review: No formal confidence interval for provider data submissions has been established.  
Vermont is waiting for clarification from the NTIA on this.  However, each provider submitted dataset is 
evaluated against a minimum standard or expectation of quality. If the data submission is identified by 
the VT Dept of Public Service as not credible based upon their experience, it is not included in the 
inventory. If a provider creates a data submission that cannot be parsed or, resolved, we contact the 
provider to try and work out a method of submission that can be used. There were some unusable 
submissions for the December 31st

 

, 2010 dataset.  In some cases this resulted in the provider not being 
represented in the data, in other cases it resulted in the use of their previous submission (June 30, 2010).  
These are documented in the DataPackage.xlsx file. 

Feedback Loops:  Each broadband provider that supplies broadband service data in some manner to the 
VT broadband data inventory is given the option to view a final version of their data submission as it will 
be represented in the NTIA delivery. However, very few providers have asked for a copy of the final 
version of their data submission for review. Some smaller providers have asked for, and received, a 
hardcopy map or digital map graphic (PDF) of their coverage area. All of the providers that requested to 
see what was being submitted to NTIA representing their coverage area received either a copy of the 
data, a hardcopy map or digital map graphic in accordance with their preference.  
 
Data Verification Methodology:  The BMT used the data from a phone survey conducted by the UVM 
Center for Rural Studies (CRS) to verify the broadband maps.  Respondents were asked to indicate 
whether they had broadband at their residence, and were asked to provide their address.  The addresses 
were geocoded (mapped to a lat/long coordinate), then used to evaluate the "accuracy" of the broadband 
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coverage data.  A summary of the findings will be available by April 15th

 

, 2011.  This information will be 
forwarded to the NTIA at that time.  

Conclusion:  Vermont’s Broadband Mapping Team is pleased to deliver a robust broadband availability 
inventory to the NTIA.  We are confident that it meets the specifications outlined in the NTIA SBDD 
NOFA.  The broadband data and maps will help Vermonters refine their understanding of “un-served” 
and “underserved” areas of the state, thereby supporting targeted future investments in these areas. 
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1  Introduction 
 
 
This report is submitted along with the third data submission for the 
Washington Broadband Mapping Project.  This submission includes all 
data collected so far per the requirements of the National 
Telecommunications and Information Administration (NTIA) State 
Broadband Data and Development Grant Program (Docket No. 0660-
ZA29) Notice of Funds Availability (NOFA) and formal and informal 
Clarifications to it.  Specifically, it includes broadband data collected from 
broadband providers and Community Anchor Institutions data compiled 
from various sources for the State of WA.  The State of Washington has 
retained a mapping contractor, primed by The Sanborn Map Company for 
doing all work related to the Mapping Grant for this project.   
 
This document is a supplement to the two previous reports submitted with 
data submissions 1 and 2 on May 1, 2010 and October 1, 2010 
respectively.  Therefore, it builds on the document provided with those 
submissions.  Rather than repeat the contents of the previous report, this 
document makes incremental updates on various topics.  For this reason, 
it may be worthwhile to refer to the previous documents, if needed, for 
more details. 
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1 Overall Project Status 
 

1.1 DATA COLLECTION 

 
This section details data collection related to NTIA deliverables which 
include broadband data and community anchor institution data.   

1.1.1 Broadband Data 

 
For submission 3, Sanborn started data collection on January 19th 2011 
by sending out data update requests and technical data specifications 
after NTIA did a Webinar announcing final changes for Submission 3.   
These were sent to a large list of companies which were compiled from 
FCC 477 list (dated December, 2009) and from a list provided by the 
Washington UTC.   The technical document highlighted the changes from 
Submission 1 to Submission 2 and requested incremental data only 
where possible.  Sanborn also uploaded the final data for each provider in 
NTIA format to the Sanborn Provider Portal.  The providers were 
encouraged to use the provider portal and update their information on it.  
Many providers participated through this process very effectively and 
most are getting used to this process. 

 
Although we sent the technical specifications to all the providers (more 
than those on the FCC 477 list and many that were non-providers earlier 
including resellers and non-valid providers), we followed up actively with 
the providers on the 477 list or those who were already participating, and 
public providers such as PUDs (public utility districts) who were of 
strategic interest to the State of Washington.  This is because most 
providers outside of the FCC list were found to be non-providers of 
broadband.   
 
During this round of the data update, many providers who had refused to 
participate in the program earlier expressed an eagerness to participate.  
This validates the importance of the program, not only for the purposes of 
the government, but also for the providers themselves.   
 
In our solicitation for data updates, we told providers that if we didn’t hear 
from them by a certain date, we would default to using their data from 
Submission 2.  However, we still contacted them after the due date a few 
times but eventually used Submission 2 data if they did not respond. 

 
 

As with the second submission, we followed the following protocols: 
 

1. We did not collect data from resellers  
2. We have not collected data from satellite providers – we are in the 

process of formulating a strategy to map coverage from satellite 
providers and anticipate that we will have some coverage for 
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satellite providers in our next delivery to NTIA (Submission 4, due 
to NTIA on October 1, 2011). 

1) Three satellite providers have been identified in 
Washington – Hughes, Starband, and Wildblue.   

3. Affiliates, subsidiaries etc. have been counted as providers.  
Please note that data for these entities may or may not be 
reported as a separate FRN if they share the same FRN as their 
parent company.   

4. We have not undertaken any propogation analysis for wireless 
providers who did not already have their own propagation maps. 
We are considering doing that for the next submission. 

5. On the directive from the State and based on the strategic 
interests of the State, we worked hard to get more Public Utility 
Districts (PUDs) in Washington to participate in the program.  As 
previously noted, PUDs are public entities at the County level that 
lay broadband infrastructure connecting to the end users (i.e. such 
as fiber to the homes) but are not allowed to sell directly to the 
customers.  Broadband service is provided by resellers using the 
infrastructure owned by the PUDs at speeds that the market is 
capable of bearing.  However, since our contract scope does not 
include collecting reseller data (in some cases there can be more 
than 20 resellers on a single PUD infrastructure), such areas 
would go unreported and consequently shown as unserved on the 
maps.  These are also rural areas and areas where other 
providers are not operating and hence it is critical for the State to 
map these providers’ service area.  For this reason, we collected 
the data from the PUD.  Furthermore, there is legislation in 
circulation in the Washington Legislature that could make PUDs 
serve directly to customers and hence it is important to identify 
their service area on the map.  Contrary to previous 
submission, in this submission, the NTIA data model allows 
such providers to be reported on the map through the use of 
domain code 3 (others) in the field documenting the Type of 
Provider.   We plan on putting PUDs on the WA State Interactive 
Broadband Map with a note that they would need to visit the PUD 
site to find out the list of resellers who can provider retail service 
to them.   

6. In Submission 2, we provided address level data for one provider 
(Qwest).  However, the data did not include information on end 
user category.  Therefore, in the Data Receipt package from 
NTIA, we were informed that the data was rejected.  In this 
submission, we checked with Qwest and they are unable to 
provide the End User Category for address points as this is not a 
piece of information that they track.  Therefore, for Submission 3, 
we decided to not submit the address level data for this provider.  
In both Submission 2 and Submission 3, we provide the street 
segments and census block data representing the address points. 
Therefore, this does not impact the service availability. 
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This submission process went smoother than previous submissions. 
There were a few minor issues that need to be resolved from previous 
submissions.   
 

1) Spectrum:  Larger providers are still not willing to provide 
separate polygons for different spectrums.   

2) Communication with providers:  It would help with data 
collection if NTIA/FCC held an open forum with the 
providers for changes that are being proposed for that data 
collection.  This should happen before States start data 
collection and also providing all change information on an 
NTIA website to the providers so that they are not 
questioning the credibility of the request from States. 

3) Information from NTIA:  It would be very helpful to have 
information on changes in data model, requirements and 
specifications before the data collection is started.  Ideally, 
in order to meet the next deadline of October 1 (for data 
good as of June 30, 2011), we would need to send out a 
data request to providers in the July 1-3 timeframe and 
giving them 3-4 weeks for preparing data and submitting it 
to us (given the holidays and the summer, it is important to 
give providers sufficient time to assimilate all data).  
Therefore, NTIA would need to get all changes finalized by 
June 30th so that we can hit the road immediately after 
that.  This lead time allows us to provide more desirable 
time spans to the providers, and for us and the states to do 
the right amount of validation. As the process becomes 
smoother for everyone, we anticipate that this will happen 
more regularly in the future. 

1.1.2 Community Anchor Institutions Data 

 
The community anchor institutions data continues to be crowd-sourced 
through the online data gathering application created by the Sanborn 
Team. The State of Washington is doing the PR around this data 
collection and contacting the relevant agencies to request them to fill in 
data.  This has been a slow process and we are getting to a point of 
diminishing returns with this effort.  The numbers of community anchor 
institutions that have responded so far is provided below: 
 

 

Category Name Total 

Total with 
Broadband  
Information in 
Submission 2 

1 School - K through 12 2295 1769

2 Library 350 350

3 Medical/healthcare 132 49

4 Public Safety 1707 104

5 University, college, other post-secondary 219 179
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6 Other community support - government 343 32

7 
Other community support - 
nongovernmental 344 

11
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1.2 DATA PROCESSING 

1.2.1 General Overview 

In general, the submission 3 processes followed the same basic 
approach that was used in Submission 1 (s1) and Submission 2 (s2). As 
mentioned before, the submission 1 and 2 process documentation was 
included with those submissions and may be worth looking at for details if 
needed.  The following sections outline the modifications made to the 
initial processing in order to meet the submission 3 requirements as 
defined by NTIA. 
 
In summary they can be divided into the following three categories: 
 
• Process Modifications 
• Reference Data Modifications 
• NTIA Submission Data Model Schema Changes 

1.2.2 Submission 3:  Process Modifications  

Based on NTIA feedback and information provided in NTIA webinar 
sessions, the submission 3 data processing workflow was changed 
minimally to support the new NTIA submission requirements: 
 
1. All census blocks are mapped based on 2000 census blocks.  Any 

data submitted in 2009 format was converted to 2000 for 
submission.  During processing a ‘hybrid’ census dataset (2000 
IDs with 2009 line work) was used to take advantage of the 
improved 2009 line work.  Prior to submission to NTIA, all features 
were mapped back to the 2000 census blocks.  The Reference 
Data section below contains additional details. 

2. For consistent representation the state road reference data used 
was 2009 Census Tiger Line IDs (TLIDs).  Other data sources 
(non-TLID features, or 2000 TLID features) were mapped to 2009 
TLID features. 

3. Overview was removed completely from submission data due to 
the fact that all maximum advertised up/down speeds are being 
reported in blocks, roads, and wireless features. 

4. Due to our NDA restrictions, address points and last mile points 
will not be submitted to NTIA.  As mentioned before, Qwest 
requested that their address points be submitted to NTIA for 
blocks greater than 2 square miles.  However, they could not 
provide the end user category and hence this data was not 
submitted but reprocessed data (address points reprocessed to 
street segments) are being submitted. 

5. Some providers did not submit middle mile elevation.  Wherever 
possible, we went back to providers to obtain their middle mile 
elevation information. 

6. Terrestrial Mobile Wireless and Terrestrial Fixed Wireless 
(licensed and unlicensed) were treated as wireless coverage and 
were delivered as a shape.  In cases where a provider served the 
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same technology and spectrum with different speeds, overlapping 
areas were removed and the higher speed was assigned. 

7. The submission 3 Provider data model is currently based on the 
NTIA data model as of 1/13/2011.   

 

1.2.3 Submission 3: Reference Data modifications 

This section describes the reference data used in submission 3.   
 
BLOCK REFERENCE 
For s3, a hybrid block dataset (2000 IDs with 2009 line work) was used to 

take advantage of the improved 2009 geometry.  The data was set 
up as follows: 

• 2009 BlockID suffix is dropped and the blocks are dissolved (by 
Block ID) to produce data with 2000 BlockIDs and 2009 shape 
geometry 

• Block size (AREA) is calculated combining the 2000 land area 
(ALAND) and water area (AWATER) 

• AREA is converted from square meters to square miles to 
calculate square mileage (SMI). 

• If the SMI of a block is less than or equal to 2, then the less than 
or equal to 2 square mile indicator (LE2SMI) is set to true. 

 
ROAD REFERENCE 
To take advantage of the 2009 geometry improvements, 2009 Tiger Line 

IDs (TLID) were used for data processing in s3.   Any non-2009 
TLID (i.e. 2000 TLID or other) submitted by providers were 
mapped to the 2009 reference data.  The data was set up as 
follows: 

• The GT2SMI (Greater Than 2 Square Mile) indicator is set to True 
when: 

o The 2009 road segment is completely within a hybrid block that is 
NOT less than 2 square miles 

• Only minimum and maximum address ranges and a single zip 
code for each road segment is maintained.   

 
OVERVIEW REFERENCE 
This dataset was dropped completely for this submission. 
 

1.2.3.1  Reference data sources 
 
The following data sources were used as reference data sources for 
submission 3: 
 
BLOCK REFERENCE DATA:  2009 CENSUS BLOCKS 
No changes from previous submission. 
 
ROAD REFERENCE DATA:  2000 CENSUS TIGER LINES 
No census 2000 TIGER line data were used for this submission.  
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ROAD REFERENCE DATA:  2009 CENSUS TIGER LINES 
No changes from previous submission 
 
OVERVIEW REFERENCE DATA:  2009 CENSUS COUNTIES 
This data has not been included in Submission 3 
 

1.2.4 Submission 3: NTIA Submission Data Model 
Schema Changes 

 
The data model released on January 13, 2011 contained the following 
changes from the s2 data model: 

 

• A new field was added to several feature classes called Provider 

Type 

o Provider Type is “Short Integer” and has domain values of 

1, 2, or 3 (1=Broadband Provider, 2=Reseller, 3=other) 

o Most providers are calculated to be “1” (Broadband 

Provider).  In some cases (e.g. State of Washington Public 

Utility Districts or PUDs), the ProviderType is considered 

“Other” (value = 3) 

• In the CAI feature class, the field BBService has been modified: 

o In S2, if the information was not known, the field was left 

blank (null) 

o In S3, if we do not have the information, NULL values must 

be changed to code u (for Unknown) – nulls are not 

allowed. 

 

• Three new fields have been added to the CAI feature class.  

Wherever possible, these values have been populated in the CAI 

data.  

o Public Wifi (Y, N, or U) 

o URL 

o CAIID  

1.3 Data Validation 

 
Sanborn has continued to perform the same validation on the data as the 
previous two submissions and listed below (details in previous reports).  
Some minor updates to the validation process are discussed below. 

1) QC of the data at various steps  

2) Spatial checks against public and commercial datasets 
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a. For WA, we continued to use the following datasets for 

validation: 

i. Exchange Boundaries:  for DSL boundaries 

ii. MediaPrints:  for Cable boundaries 

iii. Speedtest.net data 

3) Verification by providers 

a. In this Submission, along with the standard verification by 

providers using the Provider Portal, we also identified for 

providers issues that they needed to focus on regarding the 

findings of our validation team.  This was done by sending 

them a letter that identified issues using screenshots and 

explaining to them what the error was and then asking them to 

go fix those errors using the secure provider portal.  A sample 

of a letter is provided in Appendix A in this document.  This 

helps by making this process a little more targeted for the 

providers and allows them to hone into issues. 

4) Speedtest data collection and other data collection for verification  

a. We continue to use speedtest data and community anchor 

data crowdsourced for validation purposes. 

5) Planning workshops and local validation 

a. In this submission, we have tried very hard to incorporate and 

address feedback from planning workshops and local outreach 

conducted by State of Washington.  We talked with several 

providers which resulted either in a better explanation of their 

service area or in alteration of their service.  For example, 

feedback from DIS and other providers resulted in a serious 

change in service area for Cascade and in another instance, 

Charter provided some clarification on why their area is correct 

and we continue to work to resolve these issues.  This is going 

to be an ongoing activity in the next months to come. 

 

1.3.1 Data Validation Conclusions 

 
We continue to believe that we do not have sufficient information to alter 
provider data and we have been careful not to do so unless there are 
obvious errors such as incorrect block numbers, or unidentifiable street 
segments, etc. 
Data validation involves working with providers to improve the data and 
we are dealing with issues as they arise.  This activity continues to be a 
challenging activity.  There is no complete truth sometimes and different 
pieces of evidence are collected and pieced together to point 
discrepancies that are explored in more detail.  Commercial datasets are 
of limited value and often self-reported by the companies and subject to 
the same errors that we get from providers directly, and sometimes 
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exaggerated by the fact that there are different vintages and resolution 
and hence the comparison is not easy.   Speed test locations are also 
sometimes incorrect and similar issues exist with all crowd-sourced data.  
 
There is no absolute truth exists and that data validation cannot change 
data arbitrarily based on only one evidence or two.  Hence it takes a long 
period of time to fully address a reported issue. 
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2 Appendices  

2.1 Sanborn QC_Validation Letter 

 
 
March 9, 2011 
 
 
Broadband Mapping Services 
State of Washington 
 
 
Re: QC and Validation of Provider Data 
 
 
Dear Provider: 
 
As part of the Broadband Program, the Sanborn Map Co. is performing a QC and validation of the data 
received from you by comparing your data to publicly and commercially available broadband datasets. This 
includes exchange boundaries for DSL, MediaPrints for Cable and Fiber and others as deemed necessary.  We 
are also using Speedtest.net data for some speed validations.   
 
If you are receiving this notification, it is because we have found certain issues that need your assistance. 
Screen shots of the issues are provided below along with a table denoting the issue found. We would 
appreciate it if you would please review these issues quickly and go to the provider portal and note the 
correction that needs to be made since we need to finalize your data to be submitted to NTIA.  
 
If you need any further clarification after reviewing the issue, please contact Bridget Marcotte at (503) 228-
8708 x 306. Please note: if we do not receive a response from you with what correction needs to be made, 
Sanborn reserves the right to change the data if needed.  
 
Thank you very much for your assistance providing answers on the issues noted below.  
 
Sincerely, 
The Sanborn Broadband Mapping Team  
 
 

QC and Validation Issue(s) Encountered 
 
Please make all corrections on the provider portal link provided below. For confidentially, your login 
and passwords were sent during the last submission, in another email. 
 
http://beta.appgeo.com/WahingtonBroadbandProviderPortal/ 

 
Issue found: 

Issue Category Description/Screen Shot 
Part of the data is 
extending outside Media 
Prints boundaries 

 

Part of the data is  
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extending outside of 
Telephone Exchange 
boundaries 
Spatial Outliers - data 
which is off by itself and 
not consistent with 
other data spatially  

 
Areas within the red circles are examples of spatial 
outliers in your data 

Independent Validation 
point showing there is 
NO service in this area 

Block Numbers Affected: 

Middle mile has 
missing/invalid 
elevation 

 

Invalid Max Advertised 
Speeds 
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Overview 
 

The following documentation provides an overview of how the third required data set was collected and 

processed for the State Broadband Data and Development Program (SBDDP) in the states of Alabama, 

Idaho, Wisconsin, and Wyoming.   

Although we could separate this draft into state-specific deliverables, the majority of methodology 

remains intentionally consistent among the states.  As one important validation test is comparability 

across states, we find value in this cross-state approach.  This cross-state approach also helps the 

LinkAMERICA team focus on comparable outcomes across the four states, where appropriate.  Our 

intent is not to make the states look and be the same, rather it is to leverage economies of scope and 

scale among the business processes. 

As expected, this document rests heavily on the prior drafts, but has also been updated and expanded. 

Significant changes include additions covering: 

1. Trends in provider inputs  

2. Expansion in retrieval of WISP coverage  

3. Requested modifications based upon NTIA guidance 

a. Inclusion of satellite, changes to service overview table, FRN verification process 

4. Consumer Feedback, Crowd Sourcing and Social Media campaigns. 

5. Development and posting of a Technical Standards document. 

Treatment of the following subjects has been expanded: 

1. Community anchor institutions and survey methodology 

2. Verification and validation 

3. Data production methods 

As anticipated, the SBDD program continues to mature and evolve.  Technical leadership and strong 

guidance has been appreciated.  We continue to focus resources on establishing stable business 

processes to track submissions, verify received and processed data, test for temporal stability and 

provide reporting deliverables consistent with NTIA expectations. 

In our view,  the mapping deliverable reflects (1) a good faith effort, which results in a reasoned 

response to the NOFA, Technical Appendix A,  as well as supplementary program office guidance and 

modifications offered in phone calls, emails, and webinars, (2) a stable foundation for improvement and 

prioritization of both NTIA and state needs and interests , (3) a valid data processing model to support 

online mapping, consumer feedback, provider verification and reporting, and finally, (4) a valid use of 

the evolving data transfer model and its intrinsic validation methods.  More importantly, the resulting 

data and online coverage maps that follow from this work are providing good input and context for the 

Broadband planning teams working across the states we have the pleasure to serve. 
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We close this methodology document with two Appendices.   Appendix One describes Data Collection 

Challenges.  This section describes some of the open issues, challenges and questions we are exploring.  

Our hope is to receive clarification and counsel from NTIA in how best to confront some of these issues, 

which are likely common across states.  Appendix Two describes the confidentiality framework 

explained by NTIA.   

Purpose of This Manual 
This technical document was developed to provide transparency in our data production process.   

Our goal is to illustrate a thoughtful process designed to meet the intent of the submission.  Our hope is 

that we have developed a process that is reasonable, with respect to the data it deals with, as well as 

flexible enough to change with evolving NTIA requirements and lessons learned from the Broadband 

mapping community.  

Data Sources 

Developing the Provider List 

Provider lists for all states were developed at project inception from the following sources: 

 State lists of regulated telecommunications, cable and wireless service providers 

 State and national industry organizations (i.e. cable associations, wireless service provider 

organizations, telecommunications associations) 

 FCC Form 477 respondents 

 Independent web searches 

 Prior comparable mapping/research efforts 

 Interviews with key state staff members and important community influencers 

After the October 1, 2011 “Round 2” submission, we continued our research and added new providers 

to the program as discovered.  As one would expect in a dynamic marketplace, provider identification is 

an ongoing and important component of our work.  Mergers and acquisitions, the use of multiple 

regional DBAs, the lack of any universal identity management attribute, and the generally complex 

parent-subsidiary structure of many telecommunications companies, make provider identification and 

tracking very challenging.   

In early January 2011, we once again initiated an email and telephone outreach campaign to contact all 

known providers. This is an extremely time consuming process, but it is necessary to ensure that the list 

of contact persons remains current, and that providers are aware of data request changes and deadlines 

associated with each round.  Where necessary, we execute new NDAs with providers.  In “Round 3”, this 

effort continued on a daily basis until we reached our final data submission deadline on February 18, 

2011.   After February 18, we continued to work with providers who were not able to meet the deadline.  

In most cases were able to “crash” our process to accommodate this extra data, but late submissions 

continue to create inefficiencies and add costs to the overall program.  In Round 3 only providers who 
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responded in the last two weeks of March were excluded from the final dataset.  Data from those 

providers will be updated this summer and included in our Round 4 submission. 

Once again, as contact is made in each round, we verbally qualify each provider by asking a series of 

questions regarding the type of service and speeds offered.  If the provider does not meet the minimum 

specifications for a Broadband provider (as defined in the NOFA) we make a note of their status and 

remove them from the data submitted to NTIA.1  We continue to reach out to them in future rounds in 

the event that their service is upgraded or expanded. 

Provider Outreach 

To meet the program’s aggressive deadlines and participation goals, LinkAMERICA believes it is critical to 

maintain rapport with providers.  To do this, we continued to reach out to providers with regular project 

communications, including a program newsletter and links to the various state mapping websites.  As 

described above, individual e-mails and/or telephone calls were made to all providers explaining the 

status of the program and requesting their continued support in Round Three. We’ve also had the 

opportunity to support providers in their BTOP / BIP applications in certain cases. Through these 

collective outreach initiatives, and our engagement with various industry associations, we continue to 

enjoy a healthy and appropriate relationship with Broadband service providers. 

NDA 

To provide protection for all parties involved, LinkAMERICA continues to honor the terms of our NDA.  If 

providers did not execute the NDA in Round 1 or 2, they were giving an additional opportunity to do so 

in Round 3. New providers were of course also supplied with a copy of the NDA. 

To facilitate the execution of NDA’s, LinkAMERICA continues to use the DocuSign online document 

management solution.  This system allows providers to review and digitally sign the NDA in a legally 

binding manner, and has been instrumental in achieving rapid approval and execution of NDAs with the 

majority of providers.  In some cases, NDA’s were individually negotiated to address specific provider 

concerns.  In other cases, providers chose to submit data without executing an NDA. 

Provider Survey 

Since two prior rounds of data collection had been completed, the LinkAMERICA team had a solid base 

of coverage and speed information with which to begin Round 3.  This allowed us to provide two 

response options to providers.  The first was for them to review PDF check maps of their coverage and 

speed data – submitting only corrections and additions to the existing dataset.  The second was to allow 

submittal of completely new datasets, either in tabular form or in multiple other digital formats.  For 

those without sophisticated CAD or GIS systems, we continued to allow the submittal of 

printed/scanned maps and other written materials.    

                                                           
1
 As with other Grantees, we struggle with appropriate and consistent classification for service providers like 

Megapath, New Edge Networks, American Fiber.  These providers seem to resell and/or provision within their own 
network opportunistically.  In this submission we begin to bring them into the analysis as a provider type “other”.  
As the inclusion of this category isn’t our primary goal, we are working to process data as we can.  We are similarly 
categorizing and retaining reseller information.  Our datapackage.xls illustrates the categorization of non 
Broadband providers within our provider tracking  and verification systems. 
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Survey Methods 

Once again, we used a secure digital survey process (via our provider portal websites) to collect and 

display information for providers.   The Round 3 survey process was designed to accommodate both 

new and returning providers, and the different types of information they would be submitting.  The 

following is a summary of the process encountered by each group: 

New Providers:  New providers were routed directly to our standard survey where they were provided 

with templates for uploading data in tabular NTIA-compliant formats.   As in Rounds 1 & 2, if providers 

could not supply information in the requested format, alternatives were offered.  These alternatives 

included uploading service-area boundary maps, exchange area maps, CAD drawings or customer 

address lists.  From that information, the LinkAMERICA team developed a geographic representation of 

coverage and was able to build coverage features for each provider.    

Returning Providers:  While many Broadband providers submitted datasets in Rounds 1 & 2, many of 

those submissions did not contain 100% of the requested data.  To help identify gaps, and to make the 

Round 3 submission process as simple as possible, every Round 2 survey was reviewed for 

completeness, as well as accuracy and formatting compliance.  Notes were made regarding gaps, and 

specific instructions were developed for providers in Round 3.  These instructions not only explained 

what data was missing, but also provided directions on how to include that information in the Round 3 

submission.   

Check maps were also developed to show each provider how their service area would be displayed on 

the resulting interactive state map.  Generating these customized documents in each round is an 

extremely time consuming verification process, but it allows us to close many of the gaps that might 

have otherwise persisted. 

Follow Up 

After the release of the Round 3 survey in early January 2011, LinkAMERICA launched an extensive effort 

to encourage responses.  Every known provider was contacted at least twice by telephone or e-mail 

during the months of January and February.  The initial data submission deadline was set for February 

18, but, as previously noted, we continued to accept “straggler” submissions well into March.  

No Response Policy 

As mentioned above, every effort was made to contact each provider who appeared on our initial list.  

However, if no current information could be found on the company (i.e. no website, no valid phone 

number, no contact person identified) they were removed from the list of “known providers”.  We 

believe the vast majority of those we were unable to reach were small wireless providers who have 

simply ceased to exist2. 

                                                           
2
The complete list of known providers and important submission statistics are contained in the datapackage.xls 

file. 



SBDD Mapping Methodology Page 9 
 

Summary 

In summary, an intensive 45-60 day provider outreach and data collection process is initiated at the 

beginning of each round.  In Round 3, given the data vintage of December 31, 2010, we began this 

process immediately after the New Year.  The last submissions were accepted in mid-March, 2011.    

While we continue to successfully engage the majority of providers in each round, the amount of 

manpower required to solicit complete and timely responses should not be underestimated.  This 

process is one of the most costly and complex within the entire SBDD program.  

Third Party Data Used 
Beyond the data obtained from providers, we acquired the following commercial data products: 

 American Roamer, Coverage Right Advanced Services. This data served two purposes.  The first 

was to verify the provider list and help find Broadband service providers not on other lists.  The 

second was to verify the reasonableness of the Broadband service provider’s submission. 

 MapInfo ExchangeInfo, Professional.  This data was used in the verification of telephone 

Broadband provider data.  Where a public domain exchange boundary wasn’t available, the 

MapInfo boundary was used for coverage containment tests.  

 Media Prints Cable boundaries.  This data was used in the verification of Cable/HFC Broadband 

provider data.  It was used to research valid providers and discover if that provider was offering 

Internet service.  In very rough terms the contained boundaries were used to test the location of 

some provider data.  

 GeoResults Telecom Research Data.  This data was used to help estimate the Broadband 

services likely provided to certain classes of Community Anchor Institutions (CAI). 

We have included third party data sources, which touch on each of the three major technologies 

analyzed within the SBDD program.  Each of these data sources tie back to a public domain data source, 

which provides a cross-verification mechanism for the commercial data product. 

Although there are a large number of third party licensed data sources available, we remain 

conservative in our acquisition plans.  From our limited analysis we are concerned about the ability to 

cross-verify additional third party licensed sources against public domain data.  Further, we are unsure 

of how we may be able to integrate another data provider’s view of valid Broadband providers within 

the definitions used by the NOFA (eg. Are they using an FRN/DBA identity view or a marketing view?  

Can the provider supply in a 7-10 day window?  Are they facilities based or not?).  This leads us back to a 

statement we made in a ‘lessons learned’ Webinar (April 2010) about exploring a consortia to lower the 

cost of data acquisition and allow multiple entities to peer review the quality and methodologies behind 

licensed data products.3  

Beyond these commercial data sources, we used a number of public domain sources.  These included: 

                                                           
3
 We also suggested forming a technical standards committee and a consistent system for confidence reporting. 
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a. Geographic Data Files  

i. US Census TIGER data4 

b. Sources that helped isolate providers, identity management or provider service areas 

i. NECA Tariff 4 

ii. State produced exchange boundaries  

iii. Carrier produced wirecenter boundaries 

iv. FCC 477 provider filers 

v. FCC Coals reports (321/325) 

vi. FCC FRN API lookup tool 

vii. FCC/FAA Antenna Registration System 

viii. FCC FRN Lookup Tool (plain text search) 

ix. USAC High Cost FCC Filing Appendices 

c. Sources that helped isolate anchor institutions 

i. USAC Grant lookup tool 

ii. USAC High-Cost FCC Filing Appendices 

iii. HRSA data warehouse 

iv. NCES data lookup 

v. State managed lists of schools (K-12), post-secondary institutions and libraries 

List of museums,  conventions, and visitors bureaus from www.onlineatlas.us 

Finally, challenges exist when dealing with the inevitable conflicts between provider-submitted data and 

third party sources (public or commercial).  There is no guarantee third party sources are more accurate 

or timely than the providers’ own reports.   Indeed, some third party sources are based upon different 

standards than those specified in the NOFA, perhaps making them less reliable than information 

collected directly from providers.  At the very minimum, provider data has a lineage and temporal status 

that we can identify.  A concern we have with increasing use of third party data is that we have no way 

to verify its quality or development methodology.  In other words, we may hit a wall in which we can’t 

determine how the commercial source derived its coverage conclusion.  To us this means that third 

party data sources are beneficial, but represent a supplementary view, not an authoritative one, of the 

NOFA defined Broadband market. 

In short, we have chosen to use provider data as the baseline.  We will challenge provider reports when 

third party data shows major anomalies, or when a consistent volume of consumer feedback points to a 

potential error.   

As the program evolves it is also our intention to provide tools that allow end users to evaluate the 

accuracy of the data in their own way.  A confidence score or the presentation of multiple (and 

potentially competing) reports for the same location may be made available. This notion is discussed 

further in the “Validation” section below.   

                                                           
4
 Census data were derived from < http://www2.census.gov/cgi-bin/shapefiles2009/state-files?state=01>, Census 

2000 files.  Roads were derived from the county faces and edges file downloaded at the same location and tiled for 
a full state. 

http://www2.census.gov/cgi-bin/shapefiles2009/state-files?state=01
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Confidentiality and the Use of Licensed Materials 
As a mapping vendor, we are reliant upon the cooperation of Broadband service providers.  In large 

part, what underlies this cooperation is trust that we will not violate the proprietary and confidential 

nature of the data provided to us.   

We are thankful for the confidentiality clarification that NTIA shared with us (included as Appendix Two).  

We intend to use this as a guiding document to help us communicate with providers about what 

information NTIA considers to be confidential.  Our suggestion is that NTIA publish this, or something 

comparable, to ensure a consistent interpretation of the NOFA and how it guides NDAs. 

As some providers are non-responsive to requests for information, or lack resources necessary to put 

data into NTIA compliant formats, we have fallen back to the use of commercial data sources in several 

places.   

For instance, some mobile wireless providers were unable to submit coverage information to us.  In 

these circumstances we have generalized the American Roamer coverage.  For incumbent telephone 

providers we have used commercial wirecenter boundary products to filter Census Blocks that are 

clearly out of their exchange areas.  Finally, licensed data from Georesults were used to derive estimates 

of Broadband connectivity for hospitals within the Anchor Institution category.  The actual value from 

Georesults was not used, but our estimate is modeled from their input data.  We also use the name and 

address as provided by the State data provider, not Georesults.   

Public Engagement:   Crowd Sourcing, Surveys and Social Media 
Crowd sourcing (i.e., an intentional and carefully designed effort to tap into the collective intelligence of 

the public at large to expand our knowledge base) continues to be an important element of our data 

collection and validation process. In addition to the various opportunities, the public has to provide 

input via the online service coverage maps and the related ‘Broadband story’ process, our crowd 

sourcing efforts are grounded in a fairly traditional telephone survey approach, focused on the 

consumer market. In addition, we are currently advancing our crowd sourcing process to include certain 

initiatives centered in two social media outlets – Facebook and Twitter. These initiatives are summarized 

below. 

Consumer Surveys 
Working under contract for the state of Alabama in 2009, our initial consumer survey was performed 

before the NTIA SBDDP grant was in place. Subsequent consumer surveys funded by the SBDDP grant 

were hosted in 2010 for the states of Idaho, Wisconsin and Wyoming. These surveys will be repeated 

after two years to establish and evaluate trends. These primarily telephone based surveys include two 

distinct and carefully scripted tracks: one for internet users and one for non-users. The telephone survey 

approach allows us to reach the non-internet user group as well as the current internet user. A 

secondary online approach is also used to augment input from current internet users. For non-users, the 

surveys help determine why they don’t have or don’t use Broadband. For current Broadband users, the 

survey helps determine the nature of their Broadband access and how they use that connectivity in their 
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daily lives. In addition to our state-specific surveys a nation-wide survey was also hosted to provide a 

broader view of consumer views for comparison purposes. State-specific surveys are, where possible, 

framed to match the state’s regional Broadband planning structure (e.g., the consumer survey in 

Wyoming was designed to produce results relevant to the state’s seven Broadband planning regions). 

The resulting data is helpful on a number of fronts in the SBDDP’s mission to advance the access and 

adoption to Broadband. Survey data provides an important, albeit broad, gauge for assessing coverage 

information obtained by providers. For example, areas with widely available coverage (according to 

provider information), but lower consumer subscription levels (according to survey results), or perhaps 

where survey results suggest Broadband is not available, can be examined in more detail. Survey results 

are also very important to the Broadband planning (and capacity building) components of the SBDDP 

program in that they help inform and formulate Broadband advancement priorities. Survey results also 

help inform Broadband policy discussions on both the local and state levels. Finally, survey results 

provide important information to the service provider community regarding market demand and 

specific internet use in specific communities (i.e., regions).  

The 2010 surveys were launched in July 2010 with a test number of survey calls to confirm (and adjust as 

needed) the structure of the survey and the underlying survey process. The surveys were closed on 

November 30, 2010. Telephone surveys were completely random beginning with the acquisition of a list 

of state-specific, randomly selected landline telephone numbers (e.g., 80,000 random Wyoming 

residence telephone numbers were acquired as the foundation for the Wyoming survey). Mobile phones 

were not included in the initial surveys. Upon evaluation of the survey statistics, an auxiliary survey was 

executed to ensure younger groups (i.e., age 18 – 25) were adequately represented. This secondary step 

is required because of the continued migration (by younger markets) to non-landline based 

communications. This younger market (age 18 – 25) was surveyed by reaching out through social media 

outlets to encourage their participation in an online survey process. 

Survey statistics point to the complexity of the telephone-based survey process. Survey volume achieved 

statistical validity ranging from a 95% confidence level and a + 1.7% margin of error for the statewide 

data in Wisconsin to a 95% confidence level and a + 3% margin of error for Wyoming’s statewide data.  

Most regions in the 3 states have a 95% confidence level with a + 5% margin of error. 

Call volume and disposition is summarized in the chart below 
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TOTAL RECORDS CALLED & % OF STUDY 106,592 100% 22,144 100% 57,445    100% 27,004   100%

NO ANSWER 53,507   50% 11,974 54% 25,886    45% 15,647   58%

TOTAL DEAD NUMBERS 23,962   22% 4,529   20% 14,611    25% 4,822    18%

HARD REFUSALS 9,304    9% 1,728   8% 6,048     11% 1,528    6%

QUALIFIED REFUSAL 643       1% 101     0% 403        1% 139       1%

BUSY 3,652    3% 754     3% 1,903     3% 995       4%

ANSWERING MACHINE 6,385    6% 1,314   6% 3,388     6% 1,683    6%

NON-WORKING NUMBER 5,072    5% 943     4% 2,983     5% 1,147    4%

CLAIMS PREVIOUS INTERVIEW 113       0% 16       0% 68          0% 29        0%

NON-RESIDENTIAL 454       0% 104     0% 239        0% 110       0%

LANGUAGE BARRIER 1,003    1% 223     1% 562        1% 218       1%

OTHER PHONE PROBLEMS - FAX/MODEM 907       1% 205     1% 500        1% 202       1%

PORTED NUMBER 272       0% 68       0% 149        0% 54        0%

BREAK OFF - SCREENER 556       1% 103     0% 301        1% 153       1%

TERM Q3 - UNDER 18 122       0% 22       0% 65          0% 36        0%

99% 100% 99% 99%

TOTAL COMPLETES 5,758    5% 1,080   5% 3,420     6% 1,259    5%

AVG Completion Time (minutes) 16 15.8 15.4 16.1

BROADBAND MARKET RESEARCH - ID, WI, WY - FALL 2010

IDAHO WISCONSIN WYOMINGTOTAL

 

As noted above, the telephone survey process represented in the statistics above was augmented by 

providing online access to the survey. Participation in the online survey was promoted on all of our 

state-specific public web sites and selected social media. 

As a final relevant point with respect to the consumer survey process the length of the survey is 

noteworthy. By survey standards, this was a long survey. As noted above, the survey averaged sixteen 

minutes across the three states. While this clearly contributed to the number of survey call attempts 

that were required to reach the level of statistical validity, it was not insurmountable.  

Social Media 
The phenomenon of social media is widely documented and yet still emerging as an effective access 

point for public engagement. We continue to explore appropriate ways to use a variety of social media 

venues in our SBDDP efforts. All of our efforts are informed by and consistent with relevant state statues 

and guidelines. Different states have different perspectives on if and how the state will participate in the 

use of social media. Some state requirements are well defined and some are still being formed. Where 

appropriate, we use YouTube, LinkedIn, Facebook and Twitter to support our work. YouTube and 

LinkedIn postings are used to promote awareness. As noted above, we were able to promote additional 

input on the consumer surveys through a social media outreach program aimed at our younger market 

segments.  

In addition, we are currently engaged in two specific social media tests (in Alabama) to gauge how 

Facebook and Twitter can be used to drive public input on two important crowd sourced issues: online 

speed tests and input on map accuracy. Based on data obtained through our web site traffic monitoring 

process and readily available social media tracking processes, our most recent results are promising.  For 

example, with a fairly limited ‘following’ a single Facebook post aimed at driving traffic to the online 

speed test, had 282 impressions (i.e., the number of times the post was viewed), which contributed to 

an increase in 71 more visits to the Facebook page generally, and a volume of 60 hits (over a three day 
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period) on the web site page that hosts the speed test. Our normal volume of speed test page hits is in 

the neighborhood of 7 or 8 per day (vs. the average of 20 per day experienced during this test). 

Preliminary data suggests that about half these page hits resulted in a speed test being executed. 

Data Production Process 
To support our objective of transitioning the data development process to our State partners, we 

continue to model and document our data production process.   We find this to be a very beneficial step 

for two purposes.  

First, it helps us understand why (and if) a task is being done, and if it is being done efficiently.  Much of 

this program started so quickly that it was difficult to plan logical integration and hand off points among 

the various workgroups.  Further, we are currently in the process of consolidating much of the process 

data (check-ins, check-outs, metadata) and we can use this process model to efficiently plan a cohesive 

information architecture. 

Second, our process documentation and modeling helps explain why resources are being consumed in a 

particular way.  This helps our State partners plan for in-sourcing specific tasks as their time and 

budgetary constraints allow.  It also helps our LinkAMERICA team better plan and cross-train members 

to deal with the work surge that occurs 30-45 days prior to submission. 

Finally, documenting and modeling our process helps us take advantage of increasing specialization and 

proficiency with certain types of data and management responsibilities.   In this submission, we had 

identified data “czars” responsible for check-in and check-out of data.  That data czar helped to bridge 

the gap among receipt functions, provider feedback, production and DBA.  



SBDD Mapping Methodology Page 15 
 

 

Figure 1--SBDD Business Process Diagram 

 

Data Production Methods 
As raw data were received from the provider community, attention turned to normalizing the disparate 

submission formats5.  The team considered each submission with respect to the following criteria.  

These criteria are important because they perform the basis for our verification and quality assurance 

process.  In other words, we have to appropriately scale our data verification efforts to match the scale 

or ambiguity of the following: 

 Locational certainty 

 Speed certainty 

 Temporal certainty 

 Provider and network ownership certainty 

                                                           
5
 In line with NTIA Best Practices we continue to request and receive a large number of data input formats.  This 

ranges from tabular Block lists to hand drawn maps. 
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The team’s goal was NOT to quantify a particular degree of precision with respect to any of these 

criteria.  Rather, we are working to attribute the above “certainty attributes” to each submission, and 

will continue to implement quality assurance and verification mechanisms that are resource-appropriate 

for each. 

Deriving Broadband Coverage Information 
Broadband Coverage6 was normalized into four formats:  

1. Coverage in Census Blocks (2000) of 2.00 or less square miles 

2. Covered Street Segments (2000) in Census Blocks greater than 2 square miles7 

3. Address Level Coverage (point data) 

4. Wireless Service Areas (SHP file format) 

With each submission, the team went through a series of steps to normalize and categorize the data. 

Since data arrived in many different formats, and at many levels of granularity, the following 

normalization procedures were used:  

1. Determining the nature of service being provisioned (who is providing service and what 

technologies are in use) 

2. Planning an attack strategy for the submission –understanding the data and assigning team 

members to various tasks 

3. Geo-referencing the data; QA the georeferenced data  

4. Geoprocessing the geo-referenced response 

5. Segregating the submission into the correct NOFA-compliant submission formats. 

6. Apply appropriate source metadata8 

                                                           
6 Speed, Anchor institutions and Middle Mile facilities are discussed in later sections. 

7
 To help clarify issues relating to Census block area and vintages in use, our team published a technical paper to 

the Grantee workspace.  Because we were unsure if this standard should be implemented uniformly, this 
document was never distributed to the provider community. 
 
8
 When our team logs a submission into the staging database we record at least two attributes.  One records the 

method used to derive the coverage, the other records the method by which speed was attributed to that object.  
Other attributes carried to NTIA carry source meta values as well. 

https://sbdd-granteeworkspace.pbworks.com/w/file/33293657/Technical%20Reference%20Document%20Final.doc
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Figure 2-Broadband Coverage Process 

Impact of Program Change 

There were four important program changes that impacted how Broadband coverage was developed 

and submitted to NTIA in Round 3. 

The first was the development of a “provider match” submission metric whereby the grantee’s complete 

list of known providers in the state is compared against lists from third party sources.  The provider 

match specification was discussed on a webinar prior to the release of the national map.  Although, to 

this date, there has been no clarification on how this metric is established or exactly how it will be used.  

We have invested significant resources to support an internal process to compare our provider lists with 

several additional sources.  This has been manifest in at least three ways. 

Within our provider verification process we  work to derive a  state level match against third party data 

sources.  As discussed in the early pages of this manual, there is no guarantee that a third party data 

source is any more accurate than submitted data, nor does it necessarily reflect the provider ecosystem 

specified in the NOFA, Technical Appendix A.  We devote significant resources to matching our 

submitted data against three, third party data sources.  In many cases this becomes a judgment call 

trying to match provider names across systems.  It is a difficult and somewhat arbitrary process.  

Nonetheless we do believe it has value because it forces a re-examination of who we believe is an 

appropriate provider within a non-NOFA context. 

The use of a provider match system, as well as the webinar comments (3/17/11) directing grantees to 

estimate, wherever possible, non-participating providers have made us back away from one of our 

fundamental assumptions in data collection.  As discussed in the prior draft of this manual, we had 

developed a certain “hold-out” class of data when a provider’s data wasn’t of sufficient quality to verify, 
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or we were unable to put it into the data model (eg. address points submitted for a wireless).  In this 

submission, much of this hold-out data has been included.  In some cases this means we are using 

simple polygons to capture a wireless ISPs serving area.  Other times, if we are confident in the 

coverage, but can get little clarification on the submitted speeds or frequencies, we release the 

coverage and note in our internal metadata the source issues with the other attributes.   

Finally, we have used the new provider type classification of ‘other’ to bring some aspect of the 

provider’s data into our submission.  There still seems to be confusion on how to handle provider types 

where a provider offers multiple paths to receiving Broadband for typically business customers.  Rather 

than waiting for certainty on the answer, we bring the provider in and list them as Provider Type 

“other”.  Our sense is Provider Type “other” will continue to expand in the fourth submission as we pull 

in more providers who are facilities-based and reseller.   

Clearly one challenge is the data, but an equally significant challenge is appropriate messaging around 

this “other” provider type category.  We do not want to leave consumers with the impression that they 

can get a high capacity fiber or Microwave link despite the fact that the hospital next to them in the 

same Census block can get this service. 

The final set of changes was a second verification check against reported FRNs.  As NTIA is stressing the 

importance of this attribute, we increased its visibility in our Check Map process.  FRN is now listed on 

both the tabular verification report and the provider PDF map.  Beyond this increased visibility we had 

an analyst verify each FRN in our system against the FCC API9, as well as FCC textual search10.   Because 

the FRN is not an identity management tool, we are unsure if the FRNs we’ve included are those desired 

by NTIA, but we have at the very least, verified the existence of the FRN via the FCC system. 

Trends in Provider Supplied Data 

With this third submission we take note of three important trends.   

First, with larger providers, we are seeing an increase in data stability relative to earlier submissions.  In 

informal discussions, several providers have noted changes and stabilization in internal data processes.  

The firms have invested internal resources in stabilizing this data feed.   

We see this reflected in very stable counts of Census Blocks and road segments.  This does not mean 

that complex problems like segment identification or dispersion in data have been ‘fixed’.  It does mean 

that the format and methods to produce inputs for NTIA are increasingly stable. 

Second we note that several providers have been particularly concerned with an appropriate 

identification of Maximum Advertised speeds.  In some cases this involves identification of very small 

areas (sometimes below the level of a Census block) and appropriate assignment to technology of 

transmission and maximum advertised speed tiers.  In other cases, questions arise regarding maximum 

advertised speeds that could be sold based upon network design, but that are not generally “advertised” 

or otherwise stated to the general public.   

                                                           
9
 http://reboot.fcc.gov/developer/frn-conversions-api 

10
 https://fjallfoss.fcc.gov/coresWeb/simpleSearch.do 
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Third when comparing submission three results relative to submission two it is important to recall the 

inclusion of much new data within the Provider Type “other” category.  This change does not necessarily 

reflect a change in the size of the market, rather it reflects new data coming into the analysis and 

segregated into a distinct category.. 

Coverage Geoprocessing Methods 

The next section discusses how data were geo-referenced and geoprocessed given a particular 

submission format.   

In most cases, in Round 3 we were still not provided with street segment level information for Blocks 

greater than two square miles (large Blocks).  This necessitated subsidiary geoprocessing.  As stated 

before, our first goal was to derive block level coverage.  Then, for Blocks greater than 2.00 square 

miles, we moved to a segment gathering processing.  The segment process will be described in the last 

section.11  

Block Level Coverage Derivation Using Service Point Data 

A number of providers submitted point level customer data.   

In some cases the submissions themselves were not internally consistent.  For example, in the image 

below, unprojected points are shown, while the Census block polygon to which the points are supposed 

to “belong” is highlighted.  In this case, one of the following scenarios has occurred:  block attribution is 

wrong, the points are not in the location to which they are attributed, or different block shapes were 

used than what is assumed. 

 

                                                           
11

 As has been discussed previously, we note inconsistency in how providers are supplying information at the block 
and segment level.  Beyond the temporal differences, we see that providers are computing area differently, as well 
as including or excluding water areas.  This provides an inconsistent measure across providers for the 2.00 sq mile 
cut off.  Our preference would be to provide guidance to service providers within our states, but our concern is 
that we will inconsistently message this with grantees in other states.  We would appreciate consistent guidance 
from FCC/NTIA on this topic. 
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Figure 3-Internal inconsistency in submitted data 

In other circumstances, we found that inconsistent geocoding standards may produce misleading 

results.  The next image shows point level data, and the Blocks are colored based upon the counts of 

points intersecting Blocks.  The challenge this presents is that if geocoding was performed on a different 

dataset than the block boundaries (the road traces are not coincident with block boundaries) and/or 

geocoding was done without an offset, it becomes problematic to assign coverage to a Census block 

based upon only the point locations. 
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Figure 4-Block Coverage 

For this reason, we elected to use a 200-foot buffer to select Census Blocks that intersect our points.   

Block Level Coverage Derivation Using Customer Facing Plant Level Point Data 

In other circumstances, providers submitted point level plant data.  From what we could gather, these 

points tended to be customer-dedicated terminals.  Typically, these providers were high speed 

Broadband producers—which may somewhat strain the definition of Broadband as other providers 

supplying comparable services specifically disclaimed the ability to provide high-capacity Broadband 

services in the required 7-10 day interval.  In these plant point data submissions, we had similar 

concerns to the point level customer data, but two factors tended to make us use a more conservative 

intersection buffer.  First, we tended to have far fewer points to work from, so our concern was 

grabbing too many covered Blocks as the Blocks tended to be much smaller in these urban areas.  

Second, these plant points tended to be dedicated to distinct customers, but it was difficult to know 

which element of the customer’s campus to attach coverage to. 

In the case of the image below, given a small shift to the left, it would be easily possible to gather 1 to 3 

Census Blocks from this point.  Although orthoimagery is helpful in a circumstance such as this, it is still 

indeterminate – specifically in areas where the coverage is attributed.   

Thus, in the circumstance of plant level point data, we used a 100-foot intersection buffer. 
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Figure 5-Plant Point level data 

Coverage Derivation Using Linear Facilities Data 

A number of providers submitted facilities data.  We handled this data in different ways depending upon 

what we believed the facility data represented. 

Most telecommunications networks are divided into two components.  Feeder supplies higher capacity 

nodes (eg. DSLAMs, Fiber Nodes).  Distribution usually supplies customer premises (NIDs, Pedestals, 

Taps, ONTs).  Where we could discern what strand we were provided, we used different methods. 

The next image demonstrates a geo-referenced CAD image as given to us by a Broadband service 

provider.  Note the light and dark green shading.  We would infer that the lighter segments represent 

distribution and the dark green represents the feeder network. 

In the case of a combined strand map, we used a relatively tight buffer of 200 feet to gather covered 

Census Blocks.  Our intersection tolerance is based upon an assumption that our data likely represent a 

situation comparable to customer point level submission in that we have most of the network footprint 

captured. 
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Figure 6-Georeferenced CAD information supplied by Broadband provider 

 

In other circumstances, we were provided engineering information that we inferred to be feeder only.  

This inference was typically based upon the presence of fiber optic equipment only.  In these cases, we 

used a more generous 2,000 meter Census block intersection.  The 2,000 meter criteria was based upon 

an informal survey of population in proximity to the geo-referenced strand data, but it could be varied 

based upon a more complete survey. 

Coverage Derivation Using Covered Street Segment Data 

In some cases we were provided with covered street segment data.  Covered segments tended to come 

from two sources. 

In some circumstances, providers gave us CAD data, which was not drawn in a projected manner.  This is 

relatively common for older engineering data derived from hand drawn records.  This meant that our 

team had geo-registered the image into an approximate position.  In this case, the boundary streets 
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were selected, and an enclosing polygon was derived.  The intersection of this polygon and the Blocks 

within became the geoprocessing method to derive Blocks. 

 

Figure 7-Coverage derived from street segments 

In a second circumstance, street segment data was developed during coverage estimation.  Handling the 

estimated data is discussed below. 

Coverage Derivation Using Serving Area Point Submission Data 

In other cases we worked with a provider to derive service areas based upon point plant data.  In these 

cases we were given a primary serving node and an appropriate road length service boundary. There is 

an important distinction from the plant data discussed above. In this specific case, the data submitted 

was a node that served many locations--such as a Central Office or DSLAM.  This is contrasted with the 

earlier example in which the point represents a node serving only a few customers.   

When trying to derive coverage from Central Office or DSLAM nodes, the team used ESRI Network 

Analyst to derive covered road segments honoring these road engineering parameters. 
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The figure below shows street level coverage derived from Central Office and remote DSLAM point data.  

 

Figure 8-Coverage derived through road paths 

In response to Provider feedback we revised this process to include a larger variety of TIGER road types.  

In Round 1, unimproved roads were not used.  In Rounds 2 and 3 -- particularly to improve estimates in 

areas bordering parks and public lands -- a wider class of TIGER roads was used.12 

The segment level coverage is easily extendable to derivations of Census block level speed.  The figure 

below shows the attributions of block level speed based upon the Maximum Advertised Speed available 

from a DSLAM.  Although the methodology isn’t perfect, it does provide insight into the value of 

granular infrastructure data. 

                                                           
12

Only TIGER features of MTFCC type S1100 and S1200 were excluded from use. 
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Coverage Derivation Using Polygon/Polyline Serving Areas 

Broadband service providers sometimes submitted coverage in terms of served areas.  This was either in 

direct geospatial formats, CAD files, or paper maps.  The image below reflects a carrier’s service area.   

Within that service area, there are variations in technology of transmission and served speeds.  When 

polygons with speed data and technology of transmission were available, we used a spatial intersection 

to gather covered Census Blocks.  In many cases, using covered Census Blocks resulted in a loss of the 

speed variation (sometimes the speed variation was at a level below a Block and did not get picked up 

within a spatial query).. 

 

Figure 9-Coverage derived through serving area polygons 

Although we cannot directly solve the loss of speed granularity due to Block shapes, we honor a 

business rule wherein we always select Blocks from the highest speed areas first, and then allow the 

lower speeds to select from the remaining Blocks.  This is an arbitrary rule, but our feeling was that it 

should be a consistent selection, rather than an unordered selection. 

Street Segment Derivation, Large Blocks 

For those calculated Blocks greater than 2.00 square miles (large Blocks), we provided coverage in terms 

of covered street segments and corresponding geography.   

With respect to segments we had four sources of data: 

1. Covered large Blocks 

2. Tabular street segments and address ranges for large Blocks 
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3. Geographic segments either with street attributes or without. 

4. Service area boundaries 

A number of providers only provided a list of covered large Blocks without corresponding segment 

information beneath the block.  This provided the dichotomy of either selecting all segments in the 

block, or none.  Because we had little information from which to make the selection, we elected to be 

conservative and did NOT pass any covered segments to NTIA from this submission format.  Some 

Broadband providers submitted covered street names and street ranges.  In these cases we performed a 

manual analysis trying to link to specific segment names and address ranges within covered Blocks.  

Sometimes this was a simple process because a provider used a TIGER derived street database.  In other 

cases we could not determine the source of the provider’s street data.  Street and Address matching 

tended to yield a relatively good result (typically between 30% and 100% of possible segments in the 

Block), but was very time consuming.  Where yield rates were low, our result was a shredded segment 

coverage pattern, like the image shown 
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below.13

 

Figure 10-Blue road segments adjacent to peach covered small Blocks 

A number of providers submitted geographic objects. In this case, our manual process was directed 

toward a conflation of data sources.  The goal was to take provider submitted segments and put these 

segments in terms of our TIGER 2009 basemap.  Although there is a trade-off in the accuracy using non-

provider submitted segments, we felt it was more important to have a road set that would edgematch 

our Block features and remain consistent with the Block size standards we used for other providers.  This 

is important for the appearance of the online maps, as well as potential verification work where we are 

attempting to judge a feature based upon its attachment to a covered small Census block.  The figure 

below shows street segment input data. 

                                                           
13

 We continue to hear providers expressing concern that our request for either a geographic object or TIGER Line 
ID is beyond the scope of the NOFA clarification. Therefore, they cannot supply additional information to us. 
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Figure 11-Provider Submitted Street Segment Objects.  The segments don’t edge match the Blocks nor are they continuous. 

The figure following demonstrates the same area after the conflation process.  Blue segments are the 

conflated TIGER roads which will be passed to NTIA. 
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Figure 12-Provider submitted segments in gold, selected TIGER 2009 in blue—Conflation result; in many cases what was a 
continuous segment is made discontinuous because even with a distance buffer the TIGER segment doesn’t always intersect 
the provider segment 

 

The final segment process was used when we were supplied with a Broadband covered area polygon.  In 

this case, we found the segments within covered areas and eliminated those segments inside of Blocks 

less than or equal to 2.00 square miles. 

Because there was more control over the format of the inputs (we knew we had a boundary and were 

working with TIGER segments), this was an automated process that followed this general format: 

1. Select large covered Blocks by provider ID (from updated Large Block table) 
2. Select TIGER 2009 road segments (MTFCC like 'S%') that face (CB = CBLeft2000 or CB = 

CBRight2000) covered large Blocks for provider 
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4. Select segments as distinct records, max speed with corresponding technology, join in 
feature names, export selected records to temporary DBMS table  

5. Join TIGERroads feature class to temporary table on TLID 
6. Select covered segments (Python script)  
7. Select service area polygons for provider 
8. Clip selected facing segments with selected service area 
9. Export clipped segments to staging feature class, keyed by ProviderID 

In this figure, orange represents covered small Blocks; black lines are covered segments in large Census 

Blocks (light blue).  The service area boundary is shown in grey. Based upon feedback from providers, we 

have elected to clip segments at the end of a coverage boundary.14 

 

Figure 13-Output of the Segment Process 

Wireless Coverage Process 

In general, most providers of mobile Broadband submitted coverage information in a NOFA-compliant 

format.  Other than attributions for spectrum and speed, little was done to this coverage.15 

                                                           
14

 An outcome not discussed here is how to handle address ranges on segments.  As NTIA is asking for a Min and 
Max on the segment, deriving theses values for clipped segments is very problematic.  Also the prevalence of 
alphabetic characters in addresses makes the min/max selections very arbitrary.  We are grateful that addresses 
are nullable data elements. 
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In this submission LinkAMERICA made an aggressive effort to bring additional WISP coverage into the 

NTIA dataset.  For the most part, our outreach was with providers who were unable to supply 

sufficiently granular data in the past or those that could only submit wireless address points which is no 

longer a valid submission format. 

In Round 3 fixed wireless providers generally either supplied coverage information or infrastructure 

from which coverage estimates could be derived.  Many allowed us to use their tower locations, 

antenna heights and direction/spread of coverage to derive a line of sight coverage estimate.  In our 

experience, this is a conservative and reasonable derivation of coverage. 

Some wireless providers submitted RF studies.  When this was done, there was a request that the signal 

strength be removed from coverage data.  The request was honored.  

Other fixed providers were able to supply us with hand drawn maps or polygons/polylines drawn in 

Google Earth format.  In these cases we did our best to georeference and verify the coverage areas with 

the WISP. 

When we received coverage information in KML format, like the image below, we accepted the data as 

it was presented to us.   

 
                                                                                                                                                                                           
15

 Some polygon data did exceed the node count threshold.  In these cases, data was rasterized to 100m cells and 
then converted back to polygons.  The polygons were dissolved to multi-part geometry.  This addressed the node 
count concern. 
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As the image above shows, in some cases we have hand-drawn coverage, as well as infrastructure.  

Instead of estimating their coverage using a line of sight or RF study, we elected to stick with the 

provider’s supplied information.  Our decision was guided by two primary factors: 

 If the provider is advertising using this coverage they must have specific confidence in its 

accuracy. 

 If the provider can supply coverage, as well as infrastructure that reasonably supports the 

coverage, there is a very high likelihood in the accuracy of the information.   

The downside, of course, is the polygon shown on the map may not represent our notion of how 

wireless coverage should appear.  

In general we note several interesting trends in the wireless data.  First, we can be successful in 

increasing the amount of WISP coverage when we aggressively pursue WISPs.  This means we have to be 

willing to accept data on their terms and convey it into SBDD formats.  Some of our WISP submissions 

have taken over 12 hours to normalize into SBDD formats.  Second, we have to accept that some WISPs 

will not be able to supply FRNs.  There remains a minority of WISP providers who are not aware of the 

FCC FRN.  Third, there appears to be some variation on how the NOFA coverage definition is met.  In 

other words, there seems to be a disparity on the necessary strength (e.g. -80 dB, -98 db, -120 dB, etc) 

to provide the appropriate quality of service for data services.  Fourth, it was very difficult getting 

providers to identify spectra used for Broadband data services16.  We are unsure if this is a competitive 

concern, or if the same coverage pattern is yielded for multiple frequencies.  Typically, the spectra 

returned were those that a provider was licensed for.  At this point, we have no reliable way to locally 

determine what set of frequencies are used to provide Broadband data services in a local area.   

Service Address Point Process 

A handful of providers have requested that customer level, service address point data be submitted to 

NTIA.  In these circumstances we have done minimal processing to preserve the provider’s intent with 

this deliverable and not bias downstream NTIA use. 

Our verification included checks against commercial or Public Utility/Public Service Commission 

exchange boundary maps.  Points not contained within one mile of a boundary are not submitted to 

NTIA.    

We retain from the provider the provided latitude and longitude, as well as Census block.  For some 

coverage data, if a provider is unable to supply a longitude, latitude or Census block, we fill in these 

attributes.  In those circumstances where we do not have a Census block, but we do have a longitude 

                                                           
16 One provider responded by email, “This mapping program is to provide the coverage area for 

Broadband provided by a company. Not to keep a detailed account of every aspect of a companies (sic) 

network.” 
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and latitude, we accept the given longitude and latitude and use that as the basis for our Census block 

assignment. 

With point data we have tested for comparable geocoding success rates but do not overwrite provider 

information.  From this type of analysis we note the amount (usually little more than 10%) of addresses 

that seem to locate with less than street segment certainty.  Deriving a thematic representation of the 

points on speed also illustrates some of the locational certainty issues in this point level data.   

Coverage Estimation Process 

Although the derivation of Broadband coverage into Census Blocks, street segments, or wireless 

coverage files is, in itself, a bit of an estimation process, there was an explicit estimation process 

required in cases where a Broadband provider either refused to participate in our survey, or provided 

such a threadbare submission that no carrier-based coverage information could be gleaned.   

We typically resorted to three possible estimation paths. 

For Cable (HFC) providers who did not provide any coverage information, we fell back to Media Prints 

data.  Rather than using the entire Census Block group gathered by Media Prints, we used only those 

Census Designated Places carrying the same or similar names to the Media Prints p_com field.  Our 

reasoning was that Cable systems tend to be franchised on a municipal or at least administrative basis 

so the coverage will likely follow a governmental boundary.  As a general rule, cable infrastructure is not 

available in the public domain17 and what could be found was poor in quality and difficult to ascertain 

for validity.  

For DSL providers who did not provide any coverage information, we estimated road-based coverage 

from their Central Offices18.  We only used Central Offices that showed evidence of DSL or fiber-based 

services in the NECA 4 tariff.  Road-based engineering areas were derived via ESRI Network Analyst to 

18kft.  These segments/boundaries were clipped to commercial wirecenter boundary edges.   

For mobile Broadband providers who were non-responsive to our requests, we fell back to American 

Roamer coverage patterns.  We generalized the American Roamer coverage to ½ km in order to protect 

the licensed information. 

For fixed wireless providers who provided no coverage information, we relied on their public websites to 

scrape coverage maps.  When these maps were available, we georeferenced them and tried to use the 

outer polygon boundary to represent their serving area.  In other cases, when only a tower could be 

provided, we used a view shed analysis and estimated coverage at 10mi per tower19.  Because much 

wireless propagation is driven far below the Census Block and much engineering information isn’t 

                                                           
17

 The team tried to use data from the FCC Coals system and 321/325 fillings but this seemed to be a bit non-
uniform in quality. 
18

 Central Office location was derived from MapInfo ExchangeInfo Professional.  Wirecenter boundaries also came 
from this commercial product. 
19

 In some cases we had an approximate radius of coverage but no height.  In this case we used a 50’ height 
estimate and then clipped the coverage to the provided coverage range.  We also clipped wireless coverage to 
honor state boundaries but did not look for providers serving coverage with out of study state facilities. 
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known (frequency in use, polarization of the signal, coverage pattern of antenna(s), local terrain/land 

cover) this was the most complicated group to estimate.   

Speed 

Speed attributes are reported both at the block (typical) and higher levels (maximum advertised and 

subscriber weighted).  We note that in many cases, providers did not supply typical or subscriber-

weighted speeds.  In some cases, it appears--although we cannot verify--that their maximum advertised 

speeds were used to populate typical speed columns. 

We do have limited testing data on reported speeds, but we have been careful to not use our typical 

reported values with carrier-provided information.  If we do not have a speed value from a provider, we 

report an empty value.   

Several service providers claim they do not have data on typical speeds available, but estimate a 20% 

overhead factor between the advertised speed and what may be experienced by an end user. 

We continue to request advertised speed at the block level.  Nevertheless we appear to be getting 

speeds that do not vary over a large geographic area – leading us to believe that providers may still be 

submitting the maximum speed advertised in local media for the entire market.  For the most part, we 

have been unsuccessful in messaging that advertised speed should not correspond to a market area, but 

instead, the maximum speed, which can be provided to a household—what some may describe as a 

‘qualified speed.’20 

In circumstances where a provider supplies a range of speed attributes, we assign NTIA categories based 

upon the midpoint of the range. 

To support NTIA program office requests, we have also modified the structure of the Service Overview 

table.  Even if Maximum Advertised Speed is supplied at the market or county level, we push that speed 

down to the contained Blocks.  The only records that remain in this table, will be those wireline records 

with either a non NULL nominal weighted speed or ARPU value. 

Community Anchor Institutions 
In the first submission, the Community Anchor Institution (CAI) process was referred to in terms of a 

learning curve.  This continues to be an appropriate metaphor.  The mapping team continues to focus on 

data that will support and help inform policy makers and the SBDD planning process. 

In the first submission, the team gathered information on what data was available and what resources 

will be required to engage these categories of important institutions.  In the second submission we 

                                                           
20

 As an example of a response to our request for Block level advertised speeds, we received the following 
comment from one anonymous provider, “This is and of itself does not require anything new of us – just states the 
NTIA supports efforts focused on getting that information on the CB level.”  It would be helpful to have broader 
messaging so that providers understand this new direction.  
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continued to obtain additional connectivity information.  For the Spring 2011 collection, the team began 

a survey process to directly engage these important organizations.    

Our work with CAIs is guided by three principles. 

First, CAIs are important stakeholders within the planning process.  Our goal is to engage participants in 

regional planning that has strong ties into the CAI categories identified by NTIA.  This has a direct benefit 

of engaging an established stakeholder community.   It also allows Broadband planning to tie into 

existing organizational and planning networks.  In each of our states, key relationships with education, 

public safety, libraries, and economic development sectors are being identified and developed. 

Second, we believe that CAIs will likely be one of the primary beneficiaries of targeted Broadband 

funding.  Our belief stems from the sense that many of the benefits of Broadband will extend from these 

community ‘anchor points’.  In other words, it isn’t solely the existence of Broadband at a library that 

provides a benefit.  It is people using applications that work only on a Broadband network to upgrade 

their skills (e.g., online training) and gain access to online content (e.g., job postings, goods and 

services), etc.  The targeted use of a specific application--that can only take place with Broadband 

networks-- is what produces the priority benefit.  Put another way, there seems to be a realization that 

things are less about pure connectivity (for the sake of connectivity) than about connectivity in terms of 

an application (for the sake of the benefit obtained through the application). 

Third, we continue to use a rational and targeted approach to derive information.  This means we will 

utilize our planning teams for as much ground work as possible.  This also means that a goal of our CAI 

process is not an exhaustive Census of anything that could be a CAI; rather, it is the discovery, inventory 

and integration of Broadband planning activities into those CAIs that stand to produce the greatest 

synergies with the SBDD planning process.   

The above implies two significant points.  First, the team’s goal is to document community anchor 

institution connectivity within a broader context of regional and statewide planning objectives.  Second, 

if a particular category of CAI has an independent Broadband planning effort underway, we will 

encourage that organization to take the lead, and we will provide relevant expertise and support as 

warranted.  For example, in one of our states, the public safety community is already engaging in a 

mobile Broadband survey effort.  We have aligned our CAI data collection process with that effort and 

are sharing information and expertise (e.g., hosting a survey) to support their mission.  In another state 

we are attempting to glean connectivity information from a municipal government survey.  There may 

be some downside to this collaborative approach in that we may have to work with data spanning 

different times or we may not have all of the location-specific information we need, but this does 

prevent the same user from receiving multiple inquiries. 

Further, the team continues to rely on the notion of Internet Intensity Zones.  As the Broadband 

coverage information is developed, if we do not have definitive connectivity information from other 

sources (e.g. a phone survey, web survey, listing provided by a facility owner) in this study, those Anchor 

points that fall into an existing area of SBDD Broadband coverage will not be left out or submitted with 

NULL values.  Rather, the adjacent coverage area will be the first estimate of Broadband coverage for 
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the facility.  The use of an estimate allows the site to come into the analysis and learn a bit about the 

accessibility of that facility, but it also frees resources to examine those anchor points that are more 

dispersed and likely under/un-served.  The team will conduct targeted surveys to discover connectivity 

and, more importantly, applications in use at prioritized CAIs.21 

We close this section with a figure that we hope reinforces our CAI process. 

 

Figure 14-Anchor Institution Process 

  

Recall from our first submission analysis, in most cases, CAI points are clustered and on average less 

than 1 ¾ miles away from one another.  Relying on The First Law of Geography22, this likely means that 

the Broadband accessibility is very comparable for CAIs that are close together.  We believe this means 

Broadband accessibility may be less about connectivity than it is about the ability of a CAI to afford, 

successfully adopt and utilize Broadband to support its mission.  Therefore, an important part of where 

SBDD mapping and planning come together understands what Broadband is used for, potential barriers 

to adoption, and how it is an essential component in a planning region’s investment scenario. 

                                                           
21

 We track internally those features with Broadband connectivity defined via an estimate but within the current 
transfer data model we lack a mechanism to propagate that information to NTIA.  Appendix One expands upon our 
thoughts regarding a series of audit fields in the transfer database which would be helpful to inform downstream 
users regarding the source of data or use of estimates. 
22

 http://en.wikipedia.org/wiki/Tobler's_first_law_of_geography.  We are attaching connectivity based upon the 
highest speed wireline provider in that block.  This provides a ceiling for what can be obtained, although the CAI 
may not be purchasing this level of service based upon needs, budget, mission, etc.. 

http://en.wikipedia.org/wiki/Tobler's_first_law_of_geography
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Anchor Institution Survey 
During the third submission period we began a survey process to both verify received connectivity 

information and garner additional connectivity information from CAIs.  As with WISPS we wanted to 

aggressively target and improve this data section. 

The process began with the Round 2 CAI list.  Again, we prioritized schools, libraries and healthcare 

institutions.  A small team made outgoing phone calls to discover relevant contact names.  In Wisconsin, 

we were able to gather about 150 email addresses based upon 440 calls.  There were only 14 refusals. 

While one team worked on improving the contact list, a second team designed and developed a simple 

online survey system called CAVS (Community Anchor Verification Survey).   

 

Figure 15--CAVS Screen 
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Users were invited into the CAVS system by the receipt of a postcard with an organization specific code 

printed on the mailing label.  Beyond the questions shown above, there was a second page to the survey 

dealing with use of Broadband.  Those results are directed to the planning teams. 

The table below summarizes outgoing contact activities by state.  This includes both a post card as well 

as for some organizations in which we had contact information a follow up phone call. 

States 
Post 
Card  Calls 

WI* 2033 75 

ID 1059 259 

WY 345 30 

AL 1640 14 

 

 

As of 3/16, verification23 statistics were as follows: 

State Verified / Total Records Percent Verified 

AL 72/2137 3.3% 

ID 172/1596 10% 

WI24 1187/3945 30% 

WY 169/796 21% 

 

We are keeping the survey open after the Round 3 submission to NTIA and will continue to collect data.  

In Alabama we have also begun to use resources from the planning teams to make outgoing calls and 

better target the surveys. 

Clearly this survey was resource intensive but it did yield an increase in verified, rather than estimated, 

CAI data.  We are unsure if we can sustain it in the next submission, but is has proven to yield new 

information. 

Anchor Institution Trends 
At this point we have focused our CAI attention on schools and libraries, with respect to connectivity.  

We benefit from strong relationships throughout the education sector (K-12 and Post-Secondary).  We 

have also found excellent resources within State librarians in all States. 

                                                           
23

 We say a record is verified when it has been opened by the CAVS test user.  It means at least one field was 
modified. 
24

 In Wisconsin several large school districts supplied files with connectivity information; we performed a bulk 
update in these cases.  We attribute it to the survey as the survey triggered this response. 
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To supplement the education and library information we have formed organizational relationships with 

the major hospital associations within each state.  Our goal with this relationship is to cull information 

from their planning process.  We continue to formalize/advance this relationship.   

As in the prior submission, we are using public domain sources of information for public safety-category 

4.  The vast majority of these locations are estimated with respect to connectivity.  Our hope is that in 

subsequent submissions, we will reduce the size of this category and connectivity information specific to 

root nodes of the public safety network--such as County Emergency Operation Centers.25  At this point 

we have had minimal success gaining this information. 

Because we have a wide ranging population of CAIs in our data set we have a variety of Broadband 

services that don’t always fit NOFA parameters.  Services like PRI or T1 are classified into “other copper,” 

but the bandwidth is estimated based upon the number of channels purchased.  We also had difficulty 

obtaining both the upstream and downstream channel capacities.  In large part, we made the speeds 

symmetrical, but this is an assumption on our part.   

As a final verification step, we attempt to screen the CAI data for duplicate values.  Because many CAI 

are closely clustered together we perform the de-duplication based upon the ANCHORNAME within the 

ZIP code. 

Middle Mile 
Middle Mile information was collected directly from providers via survey or interview.  Middle Mile is a 

“chicken or egg” type of challenge in that it is possible to verify that the infrastructure exists, but 

extremely difficult to know what it is doing without engineering level assistance.  Although most 

providers submitted “something,” there was a significant variance in what that “something” 

represented.   

The purpose of this section is to record some of the comments and questions we have received about 

Middle Mile.  We hope this provides better context for our data submission. 

Within the NOFA, Middle Mile was defined as (a) a service provider’s network elements (or segments) 

or (b) between a service provider’s network and another provider’s network, including the Internet 

backbone. (Collectively, (a) and (b) are “middle-mile and backbone interconnection points.”)26 

Given the existence of the “or” in this definition, providers submitted a variety of information.  Based 

upon the NOFA example, several fixed wireless providers interpreted Middle Mile in terms of the 

connection points from their towers to their own serving backhaul location.  The topology was 

commonly Microwave from their distribution towers to their NOC.  The NOC and towers were listed as 

the Middle Mile points. This seems to be consistent with the first definition clause (a). 

                                                           
25

 Within the public safety category, it is also very difficult to derive precise locations as many CAI are addressed to 
PO boxes. 
26

 From http://broadbandusa.gov/files/BroadbandMappingNOFA(FederalRegisterVersion).pdf at 54, visited March 
28, 2010 

http://broadbandusa.gov/files/BroadbandMappingNOFA(FederalRegisterVersion).pdf
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Telephone, Mobile Wireless, and Cable providers tended to remain either silent on the question, or 

would provide a single location in which Internet peering occurred (clause b).  A number of participants 

explained that the question was quite ambiguous with data traffic moving back and forth over both TDM 

and IP networks--it was unclear where the distinction should be drawn.  As a general rule it seemed like 

many providers listed a single location where Internet Peering occurred. 

A number of providers refused to answer the question on grounds of confidentiality27.  Others would not 

disclose as their Middle Mile points are not owned--another company provides the physical and 

electronic connection to their network.  In other words, the entity providing Broadband is not the entity 

providing Middle Mile. 

Additionally, based upon the new Provider_Type classification of “other,” we have started to integrate 

points provided by Broadband service providers not meeting the NOFA definition.  This includes POP 

locations and aggregation points for public / private networks.28 Within a given submission there were 

two final attributes that tended to concern respondents.  First, speed should be measured in terms of 

only data capacity and what exactly is “data” (e.g., can/should you segregate out voice or video), and is 

the relevant capacity of the physical connection, channelized to a specific virtual circuit on their 

network.   

Finally, a number of other providers were unsure of the height above grade measure (is this their floor, 

the street outside, etc).  We seem to have a combination of height above or below grade, as well as 

heights above mean sea level (AMSL).   

To the extent possible in our timeframe, we verified the location of a sample of Middle Mile points.  

Where we could see infrastructure that appeared to be consistent in location with other provider 

infrastructure, we felt that the location was accurate.  In some cases, the point provided seems sensible 

(is on a road, near other equipment), but using imagery, we couldn’t find a place where this type of 

connection could occur.  This wouldn’t be unforeseen, in that Middle Mile connectivity likely takes place 

in a protected environment much smaller than a standard Central Office installation.  

Mobile Wireless Coverage 
We have received mobile wireless coverage from most mobile Broadband providers in each state.  At 

this point we have cleaned the geometry of the data and attributed it with spectra and FRN as required. 

Provider derived coverage has been reviewed against the commercial licensed product for consistency.  

To a limited extent we also use licensing locations and tower infrastructure to spot-check supplied 

                                                           
27  As received in email 9/30/10, “Due to security concerns and the risk of public disclosure of highly sensitive data, 

whether inadvertent or otherwise, ***REDACT***response to the Middle Mile and backbone interconnection 

request is limited to publicly available information available on {remainder not included}” 

 
28

 As discussed in our readme.txt file, a number of middle mile points were lost in validation due to their location in 
adjacent state.  This will cause a decrease in some providers relative to prior submission. 
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coverage.  This mode of verification remains complex, given the lack of facility-based information with 

mobile wireless. 

Verification 
Almost by definition, data verification is an ongoing and evolving process. Clearly, with each new data 

submission there will be a validation process at hand and at the same time, our team continues to 

expand and improve the efficiency and effectiveness our data verification routines. Consistent with the 

movement toward an fGDB export database and use of a data receipt script, much of our validation 

effort was spent in supporting the ETL processes into the required formats.  In future data submissions 

we will continue our work to stabilize and improve the business process that normalizes provider 

submissions into NOFA formats and expands in more depth on the confidence analysis within the data.  

Verification Standard 

 
Our overall verification standard is focused on the level at which we supply processed data to NTIA.  This 

means that the vast majority of our verification process will be focused on ascertaining coverage for 

Census block’s less than 2 square miles and covered road segments. 

We are learning that Verification has multiple dimensions. 

Provider verification is finding providers who supply Broadband and discriminate out providers not 

meeting Technical Appendix A’s definition of Broadband.  

Identity verification is taking the provider’s categorized in the first step and ensuring that the provider 

either has a valid FRN or is assigned a default FRN.  Identity verification is very complicated because of 

the Technical Appendix A’s mandate to record data at the FRN, Provider Name and DBA level.  Each of 

these attributes could be unique for a single provider going to market under different or the same 

names.  As a result, rolling up each provider into an identity collection that matches either the FCC data 

integration team or a third party Broadband provider’s data view, is very, very time intensive.  Identity 

verification is discussed in the earlier section-- Developing the Provider List. 

Coverage verification is a broad term, but in our definition it boils down to determining if Broadband 

coverage is in the right place.  For a given provider, the question is whether the coverage is assigned to 

appropriate Census Blocks, road segments or area features.  Coverage verification can be further broken 

out into two distinct classes: 

 Technology verification, which is determining if the provider is listed with a technology 

consistent with their marketing information.  It also involves a validation with supplied speeds.   

 Speed verification, which is determining if the speed supplied for that block, road segment, 

point area file or market area is consistent with the technology and the marketing information 

received. 

The final verification dimension is consumer feedback and crowd-source verification.  This is a dynamic 

set of steps we are beginning to implement.  One side of this is responding to consumer concerns.  The 



SBDD Mapping Methodology Page 44 
 

second is using the crowd sourced data to validate provider claims and, if appropriate, update the map 

and the underlying data. 

At this stage, our working hypothesis (confirmed by our experience) is that there will not be a single 

dispositive measure to indicate Broadband coverage availability in a Census block or along a segment.  

From prior work, and examining our current provider submissions, we believe that there is too much 

variation below the submitted record to make a single binary yes/no indication.  Rather, there will be a 

series of measures that combine to provide qualitative confidence (a classification scheme) in our 

indication of Broadband availability at the block, segment, or wireless polygon level. We believe such a 

qualitative confidence scheme is both relevant to and supportive of NTIA interests, as well as the 

interests of our end-user community – that is, the states and citizens we serve through this program. 

The intent of this section is to illustrate why we are moving toward a particular verification 

methodology.  Our team is learning as we go along, and will adjust and improve this thinking. But given 

our experience to date, this is where we are heading. As stated above: 

 First, coverage verification is at the level of data submitted to NTIA. 

 Second, coverage verification is enhanced when there is a secondary measure of availability 

(such as infrastructure presence or serving area boundaries) 

 Third, given the limited resources of this effort, the most important coverage verification 

process to implement is the erroneous dispersion of coverage.  These are the “islands” of 

coverage isolated by significant distance from other covered areas.  This is the opposite of the 

Internet Intensity Zone notion discussed in the Community Anchor Institution section.  In other 

words, Broadband Internet likely doesn’t exist far away from other areas with Broadband 

Internet access. 

Before explaining our overall verification thought process, we have several examples, which illustrate 

the complexity of coverage verification. 

The first example is taken from a gentleman who requested a map change in Alabama.  His home is near 

the yellow dot.  The darker grey Blocks are covered Census Blocks.  The black lines are covered road 

segments.  He cannot receive DSL from his incumbent provider, although his neighbors can.  The 

incumbent carrier does have at least one structure in that block from which Broadband services can be 

provided; unfortunately his home is not served.   
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Figure 16--Sub block variation 

Because the SBDD program requires the depiction of coverage at the block level, the above map has 

been correctly generated.  However, from the customer’s point of view, the map is inaccurate.  This 

requires us to explain that the maps are not intended to be a structure-level qualification, at which point 

some consumers question the value of the maps when seeking service information.  Of course, we also 

share this information with the incumbent carrier in the area so they are aware of a potential customer 

market. 

Beyond this type of one-off structure-level qualification, sometimes, as shown below, we have even 

larger gaps in provided coverage.  The image here shows an “outlier” block that could be an error, or it 

could indicate missing Blocks along a major road that should have been filled in.  In this figure, the 

outlier block is highlighted in turquoise. 
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Figure 17--Dispersion in Submitted Data 

 

In this particular case, we are faced with a different verification question.  Based upon the properties of 

the neighbors, we believe this block should likely be covered (coverage interpolation,) but supplied data 

from the incumbent says otherwise.  

The next example, at a somewhat larger scale, shows where an interpolation process requires some 

adjustment.  The figure below shows a town level.  There are some smaller Blocks that are likely covered 

by interpolation logic, but we also do not want to extend coverage beyond a franchise boundary as in 

the areas shown in a box on the bottom of the map. 
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Figure 18-Where do you stop interpolating? 

From what we can gather from some providers, the submitted data—data with consistently high 

degrees of dispersion or coverage holes—tends to come from geocoded billing records.  In this 

paradigm, this means where there are no customers; service is not identified on a map.  The 

interpolation verification question then takes on two dimensions. 

First, if a provider has no customers in an area, how can we know if they would be able to 

provide service in a 7-10 day interval? 

Second, if we use the properties of neighboring Blocks to interpolate coverage, when should we 

stop (e.g., at a franchise boundary, at a certain distance, etc.)? 

We continue to work with providers to get additional information to help us better understand and 

contend with this type of circumstance.  However, we have not been entirely successful at getting 

franchise boundaries that would address much of the issue. 

The final map shows this dispersion problem, but to an even larger degree.  This solitary large block is 

likely the result of a bad geocode, but we don’t know, given the data that has been submitted by the 

provider and the “single customer in a block standard” set by the NOFA clarification. 
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Figure 19-Dispersion in covered Blocks 

Due to the fact that this situation is quite obvious in display, this type of problem is one that we are 

more aggressively trying to resolve.  Where a single block has no neighbor offering comparable coverage 

and is a specified distance beyond an exchange boundary, our approach has been to filter these Blocks 

out.  As of now, this filter is limited to incumbent DSL providers because we have a good source of 

exchange boundaries.   

The exchange boundary dispersion verification method breaks down when examining smaller providers 

who are more likely to CLEC into neighboring territory. In the figure below, the black line represents the 

exchange boundary, while the continuity in the DSLAMs likely points to coverage extending along a road 

into another provider’s territory. 

 

Figure 20--DSL Coverage outside of exchange boundary 
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In sum, the variability in our source data continues to suggest that our dynamic verification process is 

relevant, appropriate and evolving in a manner consistent with the overall program.  And, as noted 

above, we believe the more meaningful outcome of our verification processes will likely be a series of 

qualitative indicators or expressed confidence levels.  Our concern, as with the development of any sort 

of classification process, is how rigid we should make this classification given the variation in our input 

data and the varied perceptions of service providers, map viewers and down-stream data consumers.   

Verification Work Process 

To support our dynamic multi-factor verification process, we have implemented the following steps. 

First, when data is received, an analyst reviews the submission and any immediate questions or 

concerns are sent back to the provider as quickly as possible.  We have found this gatekeeping step very 

helpful in making sure we understand the intent of the submission.   

Second, for all providers who submitted data to us in the second round, they received both a tabular 

data summary and a mapped output.  Prior to releasing the “check maps” to providers, we had a team 

of analysts visually inspect each provider’s coverage area.  The focus on this QC effort has been to 

identify and flag suspect Blocks.  After this in-house review, we solicited a second level of feedback from 

providers and received a number of requested changes and corrections used in the development of the 

April, 2011 Round 3 dataset. 

For those providers who submit only block or segment level coverage (i.e., in those cases where we have 

no infrastructure to test with) we test for coverage containment within known service boundaries.  The 

intent of this validation step is to remove Blocks that are obviously erroneous. 

As mentioned in the sections above, we have implemented a check on dispersed Blocks, but we have 

implemented less with respect to coverage interpolation (holes in coverage). We continue to work on a 

series of mechanical tools to assist with the inspection process but have run into challenges related to 

geographic basemap and timing. 

As our submissions have moved online, we have also begun to benefit from crowd source feedback.  In 

some cases this has helped us identify and fix errors in our underlying data. In other cases, as we have 

shared with NTIA, we have encountered some perceptual issues rooted in how the data are developed 

and modeled to comply with the NOFA.  Depiction of uniform coverage in small Census Blocks continues 

to be a challenge. Despite our best efforts to explain the full block coverage requirement, we continue 

to receive complaints that the coverage shown on the map is not accurate for a particular location 

within that block.  

Consumer and Provider Responses to Deliverables 
Here, we segue from internal verification to external verification.  We view responses to our work 

product as a form of validation and verification.  On the one hand, this gives us the opportunity to fix 

mistakes and then generate QA steps to make sure that the problem does not reoccur.  We also learn 

how to improve what we are doing or better explain what we are doing to a community not always 

familiar with the NOFA and program office framework.  On the other hand, listening and learning from 
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this feedback helps us better target our mapping deliverable to meet the needs of our external 

customers.  In this second case, external feedback not only provides feedback on perceived qualities (or 

lack of quality) in the data, it helps us to learn if we are developing data that is truly helpful to 

downstream users. 

At this point, our external deliverables take three forms: State Broadband Maps, data transfer to NTIA 

used for the National Broadband Map, and text format data requested by outside parties. 

Online Map Experiences 

Now that our State maps are online, we continue to harvest viewer feedback and comments.  Because 

an online map allows someone to zoom in far below the scale of the data, a large number of comments 

reflect sub-census block concerns. While important to the citizens reporting these issues and to our 

Broadband planning teams, this level of data is outside the scope of our core validation process, which 

as noted above, is focused on the level of data submitted to NTIA.  

There are several other themes that our team believes are important to share.  These comments are 

actually quite helpful because they also improve our data processes to better meet the needs of map 

viewers.  For example, we have invested significant time in harvesting more segments from provider 

data.  Because the appearance of segments is so important, we are putting time into ensuring a visually 

appropriate edge match between the roads we harvest and the Blocks/roads we will show online.  On a 

technical level, we also believe that a good segment process will help us understand more about 

dispersion in the data, and what is valid versus what is not valid. 

Perception of Unfair Treatment Across Technologies 

Several Broadband service providers have expressed strong concerns regarding how wireline services 

are displayed, as contrasted to how wireless coverage is displayed.  This is an artifact of the SBDD data 

model. As an example, consider the figure below. 
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Figure 21--Multi Network Coverage portrayal 

In this image, covered Census Blocks are light gold.  Covered road segments are a darker gold and 

wireless coverage is purple.  The concern seems to come down to how a wireline provider’s coverage is 

shown in the large Census Blocks (greater than 2.0 sq mi).  Wireline providers have expressed 

dissatisfaction because their coverage is only tied to road geography, which leads to a visual “hole” in 

their coverage map.  At the same time, they feel that it is unfair that the wireless provider’s coverage is 

shown to be uniform in the same area.  Put another way, if our maps show wireline in terms of Blocks 

and segments, why don’t our maps show wireless the same way? 

Perceptions of COLR Obligations 

Wireline providers have also expressed dissatisfaction because online maps limit the distance of 

coverage from a road segment.  In our current online maps we buffer a wireline carrier’s service 300’.  A 

number of providers have expressed that they are mandated to provide voice coverage (which 

Broadband will accompany) anywhere in the Exchange.  There seem to be many dimensions to this 

argument, but the basic concern comes down to not being able to accurately reflect the scope of their 

COLR obligation within the mixed block/segment view.  Their ability (or lack thereof) to actually 

provision such services for new users within a 7-10 day period adds yet another level of complexity 

when attempting to fairly portray their coverage capabilities. 
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Intentions of Coverage Mapping 

When a viewer of an online map clicks on the map (or zooms to an address), they are provided with a 

pop-up of service provider coverage in the area.  The critical question is this: what is the area to which 

that pop-up window responds to?  In the past, we reported back to the Census block, or buffered road 

segment intersected by the user click.  As far as the map was concerned, once we move off of that road, 

or out of that segment, we have a new area to examine.   

Our sense, given feedback received, is that our provider view should be a bit more tilted toward finding 

providers in a general area, rather than finding providers at a single-click location.  If the goal of the map 

is to get someone to call a provider for service, our bias should be to include all of the potential 

providers in the general area, rather than giving potential customers a method to self-disqualify.  That is, 

we want to cast a wider coverage net, rather than one too narrow.  The problem with this approach is 

that it will create a number of false positive Broadband reports.  As of this date we cannot determine if 

the claims of inaccurate coverage in online maps are due to the looser provider view standard or not.  

We keep this looser standard in place to minimize the likelihood of self-disqualifications. 

National Broadband Map Experiences 

When the National Broadband Map launched, our phones began to ring. 

Responding to a number of provider inquiries as well as emails from citizens provided some insights.  It 

also illustrated that we now bear a second dimension of external verification.  That is, we must be 

prepared to respond to people who are confused by apparent inconsistencies between the State and 

National Broadband Maps29.   

The case below, based upon a call we received, illustrates some interesting intersections between the 

State and NBM. 

In this example a Citizen called inquiring about the difference in results between the National 

Broadband Map and our State of Alabama map.  The issue in question was coverage at his home.  The 

Alabama map showed he had coverage at his home, but the National Broadband Map said he did not. 

In the image below, the green dot represents the geocoded location of his home.  Based upon imagery, 

the geocode is quite accurate.  The olive colored polygon represents a covered Census block less than or 

equal to 2.0 square miles.  The Census block shows coverage by a number of wireline providers. 

The geocoded point is about 170’ from this covered Census block. 

                                                           
29

 We have a similar concern regarding textual data extracts.  We may translate our SBDD submission into covered 
Census Blocks in a way that is different from NTIA.   
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Figure 22-NBM Covered Census block example 

In the next image, covered TIGER road segments are shown in green.  It is important to note how far the 

TIGER road centerlines are from the actual roads in the subdivision.  It appears the geocoded point is 

reflecting more recent and more accurate road centerlines, placing the green dot at the correct location. 

Since the SBDD data is submitted in terms of TIGER 2000 the road on our map shows up about 100-200 

ft away from where that road is located today.   
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As mentioned previously, however, our online maps buffer road segments to 300 feet on either side of 

the road centerline.  In this case then, our state map buffer is large enough to return valid service 

providers for this green dot.  The NBM, on the other hand, does not appear to buffer segments or the 

edges of census Blocks and will not return providers for this location.  Our intent in this example is not 

to criticize the national map; rather, it is to illustrate that we may inadvertently make trade-offs 

between false positives and false negatives, differently. 

This case illustrates several important tensions between the data as we present it to NTIA, map it 

ourselves and because of how it may be viewed within NBM context.  A lack of agreement on how to 

handle these inconsistencies in the source data and differences in mapping approaches may cause 

consumer confusion.  

The issues seem to come down to this 

a) How do you (or can you) handle the impact of time when roads move between TIGER versions 

or between TIGER and other road products?  In this case, online map road traces will not show 

up in the right area. 
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b) Given the inconsistencies between TIGER geometry used in submission and underlying 

roadbases used for geocoding online, how do you (or should you) insulate the viewer from the 

inconsistencies.  There appears to be a strong likelihood that TIGER judges a particular point to 

be in a larger than 2.00 sq mile Census block while that same location could be in a small block 

area in the online view. 

c) How much tolerance should be introduced when returning a list of valid providers?  Is it 

better to error on gathering too many providers or too few? 

d) Since the NBM gathers feedback based upon its representation of coverage, how can/how 

should this crowd sourced feedback influence data presented in a different manner elsewhere? 
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Appendix One  

Data Collection Challenges 
This section summarizes some of the challenges we have experienced with data collection and 

processing.  The team believes it is important to categorize these challenges as they help inform the 

geoprocessing and verification methods used.  It is also our hope that some of the more global issues 

can be discussed and decided within the Grantee community.  

We begin with several global issues and then continue toward more granular challenges. 

Global Data Collection Issues 

Census Block and Road Standards are not clear 

Most carriers submitting Census level information provided 2000 Blocks.  A few provided 2009 or 

alternative (TeleAtlas, possibly) Blocks. Especially with the need to derive segment geographies, we 

would prefer to message the providers a specific Census standard—but we’d like to be consistent with 

other Grantees so as to minimize work from the provider community.  As of now, that standard is 

Census 2000.  If NTIA anticipates using Census 2010 for Fall 2011 collection, it would be helpful to 

message that as soon as possible.    

Also there seem to be several methods by which providers are calculating the area.  So the distinction 

between at 2.00 square miles can be uniform, it would be ideal to articulate an operational area 

calculation definition as early as possible. 

Providers Not Wishing for Block Level Aggregation of Their Data 

Both ***REDACT*** have supplied address point level data.  Both carriers want NTIA to have the point 

level information, and they have asked CostQuest/LinkAMERICA not to aggregate their coverage to 

Blocks.  Other than a verification to make sure that point data were contained within, or fell within 1 

mile of exchange boundaries, the only other processing was normalization into NTIA formats. 

Broadband Providers not Meeting the NOFA  “Provider” Definition 

PBWorks appears to reflect a concern among a number of grantees about what a Broadband Provider is-

-and how that definition impacts mapping. 

If the 7-10 day provisioning rule is to be strictly enforced, it would seem to eliminate a number of 

prominent Broadband providers30.  Further, the need for clarification around a facilities-based provider, 

versus the reseller, has injected even more ambiguity into the mix.  Right now we are unclear on how 

                                                           
30

 By email ***REDACT*** informed us they could not provision in 7-10 days, but they also supply information on 
qualified locations to the address point level.  Therefore, we draw a distinction between an incumbent provider 
owning the facility--which terminates at a customer premise--who cannot turn up service at a qualified location, 
versus a provider not reporting any specific qualified locations in which they cannot turnup service in the 7-10 day 
window.  In the first case we have a sense of where service can be offered and verified.  In the second, we have no 
evidence that a service could exist there until a specific location becomes a customer. 
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strictly to interpret either of these important distinctions, but we are concerned that we are beginning 

to create an NTIA exclusion criteria that is going to confuse downstream consumers of the data.   

Again, we do not want to exclude a service provider, but we believe there needs to be further 

clarification around the 7-10 day ”rule,” the definition of a “reseller,” and better interpretation of 

facility-based providers, versus equipping UNEs, SpA or leased lines. 

We have used the Provider Type of ”Other” to classify a number of providers who offer Broadband 

services, but we do not offer them in a manner consistent with Technical Appendix A definitions. 

To What Extent Should We Begin “Classifying” the Data and Maps? 

The question immediately preceding gets to the intent of a Broadband Provider.  This question gets to 

the intent of the Data and Maps. 

Earlier in this document we discussed the question of what type of bias we should introduce to our 

online map messaging.  In an online environment, do we want to more likely create an overstatement of 

coverage for a provider than an understatement?   In other words, is the larger problem allowing a 

consumer to self-disqualify, versus calling a number of neighboring providers?  There is a related issue 

to this.  Clearly in our maps there is a lot of scatter in data that we believe should be more continuous.  

These are the islands of coverage from an incumbent provider31.  There are a number of processes that 

could be put in place to deal with this type of scatter, but without more information from the service 

provider-- essentially the last mile facilities-- it will be difficult to perform this clean up in an informed 

manner.  On the one hand, we can aesthetically clean the maps up and reduce the scatter, but we have 

little sub-block engineering information upon which to make this decision.  Right now our preference is 

to put out a somewhat aesthetically messier deliverable and work with providers to get better 

information to clean their submission.  If that isn’t forthcoming, we are limited in what can be done 

given the lack of facility level information.  In summary this yields two questions 

1. In our online maps should we error on overstating coverage to prevent consumer self-

disqualification? 

2. In our online maps should we work to clean up a lot of the scatter that we see without having 

facility-based evidence from which to remove it? 

Granular Data Collection Issus 

Non-Uniform Submission Standards  

It is clear among providers that there isn’t a consistent method used to derive Broadband coverage.  

Some providers appear to be using a geocoding approach and then point in polygon or point on segment 

process.  Others may be using GPS locations.  In some cases, it is difficult to infer what reference data 

                                                           
31

 For a provider who sells opportunistically (not within a franchise area) it becomes even more problematic to 
classify their coverage because the points are more related to the type of consumer purchasing the service than a 
bounded offering.  In a matter of speaking, the Provider_Type is more determined by the technology and/or 
location than a type of business.  The core intent of the NOFA and our grant application was centered around the 
7-10 day providers but we believe maintaining information on Provider Type “Other” and  “Reseller” is important 
to assist in validation and market segment analysis as resources are available. 
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was used to georeference plant (is it the carrier’s roadbase?).  This leads to uncertainty regarding the 

input data scale or accuracy of other base layers.  Although we may be trading off absolute accuracy, our 

standard has been to conflate data to TIGER 2000 Blocks and TIGER 2009 roads.  We perform our 

verification against this conflated data product. 

Temporal 

We are unsure of how well the data are temporally consistent.  Some providers gave us their best effort 

to control to December 31, 2010. We note that some providers were clear that the submission was as of 

extract date without any way to move back in time.  They have no means to control for time and cannot 

provide any audit support beyond when the data are released to us.  Some data-especially loop 

qualification data-may change from day to day. It will be very difficult to clarify why something was 

changed from a given point in time. 

Perceived Inaccuracy with Respect to Internal Standards 

The NOFA is clear on submitting a list of Blocks in which a provider delivers Broadband service.  This is a 

different objective than perfectly reflecting service territories.  If a firm’s accuracy standard is a 

reflection of their service area, then the data created under the NOFA will not meet their perception of 

accuracy.  This leads to two other issues:  First, using Census Blocks rather than serving area may 

overstate or understate a particular provider’s Broadband serving area.  This was a significant concern of 

***REDACT*** who specifically required us to submit only address-level qualification data.  The second 

issue this brings up is how or if, there should be some standard on how much of a Census Block needs to 

be covered to call it covered.    

Confidentiality  

Several providers have noted concerns with CPNI-related issues and have stated this as a reason for 

non-participation.  We have also heard expressions of comparable concern regarding identifiable 

responses to Anchor Institution information. 

Unclear on Definitions  

As discussed earlier, several providers claimed confusion on several key terms involved in Middle Mile.  

We note a consistent stream of questions around the interpretation of Maximum Advertised Speed.  

Some providers understand this to be the most common speed package bought within the mass market, 

while others view this as a speed that can be purchased for an additional cost above a mass market 

offering (eg. a Turbo option for an additional fee per month).  Others interpret this as the fastest speed 

that is available for that particular location--in terms of xDSL, a structure qualified speed, for example.   

Perception of Data Use 

There seems to be some hesitancy releasing speed information because no one is sure of how the 

information will be used, or what the speed is intended to reflect.  A number of providers have verbally 

indicated that typical speed will be about (on average) 80% of purchased speed due to overhead.  But 

there are many other factors (such as a user’s home network) that influence speeds measures.  

Providers are concerned about introducing statistics without a clear understanding of how those 

statistics are derived and will then be used.  Also, as advertised speed is pushed down to a block level, 

we sense more trepidation to report speed values.  This quickly begins to touch on parity across network 
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types (why is wireline down at the block when wireless is half the state, etc.).   Finally we are also noting 

a significant increase in speed reported to us.  This may be due to network upgrades or competitive 

concerns to match the theoretical network speed. 

Location Uncertainty In Source Data 

Within this document we have noted concerns about the impact of source data accuracy.  Our 

geoprocessing methodology provided what we believe is a relatively conservative tolerance to account 

for the scale issue in the source data, but we are unsure of how this may impact downstream users.  

Clearly, it also impacts the verification process because we can’t attempt to verify received data beyond 

a scale at which it was developed. 

Covered Segment Process 

Deriving those Broadband covered segments in Census Blocks greater than 2 square miles has proved to 

be a challenge.   Moving from a NOFA specified tabular deliverable to an anticipated geographic 

deliverable also increases the complexity of the effort.   

Change Management Process 

One thing that is becoming clear is that a change management process that is consistent between the 

data provider and NTIA is needed.  In this light, publication of the current data transfer model beyond 

the PBWorks community would also be helpful.  Many providers are designing their data extracts with 

the NOFA in mind and the NOFA structures have been supplemented in the current model. 

Finally, it would be helpful, as early in the next cycle as possible, to know what Census Block vintage we 

are expected to deliver to NTIA.  It would also be very helpful to maintain a stable geographic base for 

the next deliverable so that the basis of verification doesn’t change. 

Record Level Metadata 

It would be helpful to have one or two additional fields in each feature class transmitted to NTIA.  One 

User Defined field could be helpful as an expression of record level confidence.  The second field could 

be used as a Key between the transfer geodatabase and our systems.  Ideally, both fields could be large 

text fields (50 char) so the Grantee can use them to express a variety of attributes. 

Miscellaneous Data Collection Notes 

 We note the following important observations regarding our data submission: 

1. There are Middle Mile plant records for providers who are not present in the Census block, 

segment or wireless area feature classes.  This is due to classification as non-NOFA Broadband 

providers. 

2. In some cases, we have trimmed wireless coverage estimates to honor state boundaries. 

3. We believe some providers are trimming their coverage to honor license area boundaries. 

4. As a departure from past practice, where a provider submitted Middle Mile points out of state, 

we are no longer passing those points to NTIA as they fail the validation script.  We experienced 

validation errors for BroadbandServed=N records in the CAI table.  These records were 

attributed a Technology of Transfer=0.  This cleared validation. 
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5. In tables with mandatory Zip5 (Service Address), if the End_User_Zipcode was not available, we 

have inserted ‘00000’ 

6. We have a significant amount of VDSL, ADSL 2 and ADSL 2+ coverage categorized into the xADSL 

category. 

7. We have left in the data Middle Mile locations with above grade elevations that appear to be 

unreasonable, given review of orthoimagery.  This seems to be confusion between above grade 

request and above sea level readings. 

8. All fGDB have passed validation except in cases where attributed speeds did not agree with 

domains associated with technology of transmission (eg Upstream Speed of 2 with ADSL). 

9. We note a few providers who have speeds seemingly inconsistent with their technology of 

transmission.  This is either very low speeds with optical fiber, or very high speeds with non 

DOCSIS 3.0 systems. 
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Appendix Two 
This appendix contains the confidentiality clarification supplied in a series of emails between CostQuest and NTIA. 

Feature Class Metadata NOFA 
Confidential? 

Online Map Public 
Disclosure 

Exemption 

Last Mile Constraints on accessing and using the data Yes No No None 

  Access constraints: None      

  Use constraints:       

  This data is confidential as defined in the 
NOFA. 

     

            

Middle Mile  Constraints on accessing and using the data Yes No No None 

  Access constraints: None      

  Use constraints:       

  This data is confidential as defined in the 
NOFA. 

     

            

Service Address Constraints on accessing and using the data No No Yes   

  Access constraints: None      

  Use constraints:       

  There are no restrictions on distribution of 
the data by users.  

     

            

CAI Constraints on accessing and using the data No Yes Yes NO 
attributes 
on any 
record in 
this feature 
class are 
considered 
confidential 
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  Access constraints: None      

  Use constraints:       

  There are no restrictions on distribution of 
the data by users.  

     

            

Census Block Constraints on accessing and using the data No Yes Yes NO 
attributes 
on any 
record in 
this feature 
class are 
considered 
confidential 

  Access constraints: None      

  Use constraints:       

  There are no restrictions on distribution of 
the data by users. 

     

            

Service Overview Constraints on accessing and using the data No Yes Yes The only 
provider 
who may 
not show 
up this 
table is a 
provider 
who has 
provided 
only 
confidential 
data (last 
mile, 
Middle 
Mile, 



SBDD Mapping Methodology Page 63 
 

address 
point with 
provider 
name) 

  Access constraints: None      

  Use constraints:       

  There are no restrictions on distribution of 
the data by users. 

     

            

Road Segment Constraints on accessing and using the data No Yes Yes NO 
attributes 
on any 
record in 
this feature 
class are 
considered 
confidential 

  Access constraints: None.      

  Use constraints:       

  There are no restrictions on distribution of 
the data by users. 

     

            

Wireless Constraints on accessing and using the data No Yes Yes NO 
attributes 
on any 
record in 
this feature 
class are 
considered 
confidential 

  Access constraints: None      

  Use constraints:       
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  There are no restrictions on distribution of 
the data by users 
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Overview 

 
This documentation gives a summary of the data collection, normalization and verification processes 
used by the State of West Virginia for the April 2011 data submission to the National 
Telecommunication and Information Agency’s (NTIA) in accordance with the State Broadband Data 
Development (SBDD) program. 
 

Purpose 

This documentation was developed to illustrate the processes used during the data collection, 
normalization and verification processes.  The information within this document will provide a 
background to the development of the provider list and data request, and specific issues encountered 
by West Virginia with regard to data collection, normalization and validation.  
 

Data Sources 
 

Provider List 
The provider list for the third round of data collection was begun during the first round of data 
collection.  For this round, the list was regenerated to include any new providers within the state.  The 
list was created by contacting the West Virginia Cable Telecommunications Association, the West 
Virginia Public Services Commission and the West Virginia Broadband Deployment Council.  This 
information was compiled then compared to a list from the Federal Communiations Commission (FCC).  
Providers were then contacted using contact information provided by the FCC’s public information 
search web tool.  Providers who were contacted during the first round of data were contacted again 
through the same name and address.  If a provider contacted during the first round had given more 
detailed contact information for a specific individual, those individuals were contacted instead of the 
contact provided by the FCC. 

 

Provider Data Request 
Elements identified in the Notice of Funds Availability (NOFA) Technical Appendix were requested from 
providers.  If a provider was unable to fulfill such requirements, the West Virginia Geological and 
Economic Survey (WVGES) worked with those providers to gather the necessary data in an alternative 
approach.   
 

Data Gathering 

 
This component of the project was heavily reliant on working with service providers to obtain data.  
Providers were originally mailed the Data Request and then follow up phone calls and e-mails were 
made to remind providers of due dates.  After data was received, the data was normalized per NTIA 
standards and placed into the provided geodatabase.  We continued to operate under the same 
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assumption as used in the first round of data gathering.  We let the data “speak for itself” and did not 
make any grand assumptions or estimates in the interest of maintaining clean and accurate data.   
 

Coverage Information 
Data was derived and normalized into 4 formats in accordance with the data model: 
 - Census blocks (2000) of 2 or less square miles 
 -Street Segments (2000) of census blocks greater than 2 square miles 

-Address Level (geocoded point data) 
-Wireless Area (shapefile) 
 

The normalization procedures were as follows: 
 1. Determine service being provided – what technologies are being used to provide the service 

2. Understand data/determine how to process – determine which feature class in the 
geodatabase data belongs 

 3. Georeferencing/geocoding necessary data – georeferencing data for Wireless Area coverage  
 and other service area maps as well as geocoding address level data 
 4. Segregating data into NOFA compliant formats – completely filling in geodatabase fields as 

 well as making sure topology is correct 
 5. QA/QC – verification and validation of data 
 

Geocoding Issues 
The West Virginia Statewide Addressing and Mapping Board (SAMB) information is not yet completed 
across all of the counties in West Virginia, leaving areas within the State without complete or verified 
address information.  This led to low geocoding match rates of provider supplied information, especially 
in rural areas, throughout the data normalization workflows.   For some of these areas, additional 
broadband coverage processes were used to derive coverage estimates as described in the next section. 
 

Additional Data Processing Techniques  
Because of geocoding inconsistencies in certain areas of the State, some provider address information 
could not be mapped and other data processing techniques had to be implemented to create 
broadband coverage estimates.  In cases where Digital Subscriber Line Access Multiplexer (DSLAM) 
points were able to be provided as well, broadband coverage was mapped by loading the DSLAM points 
into ESRI’s Network Analyst.  For this processing, the West Virginia State Addressing and Mapping Board 
(SAMB) street centerlines were used as the source roads.  DSLAM points were loaded into the facilities 
point feature class of the service area template using a 1000 ft snapping tolerance to help locate points 
to nearest roadway. Any point still not connecting to the road network were viewed and manually linked 
to the road network.  Processing was run to create segment lines for each point and to create a detailed 
polygon area around each street segment area for each point.  A 15000 ft distance parameter was used 
and no impedances were placed on the streets.  
 
Once the process was run, the created segment lines and polygon areas were linked to the original 
DSLAM point attribute table and exported from the analyst dataset into standalone polygon and line 
feature classes.  These two feature classes were then clipped to the provided Wire Center Boundaries. 
These coverage areas were then used to select covered census blocks and street segments for the data 
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submission.  Final broadband coverage estimates were reviewed with the provider prior to final 
submission. 
 
Another unique processing issue occurred when providers submitted address-level fixed wireless data 
which would produce error through the new data model. As per discussion with NTIA, the unlicensed 
fixed wireless points were plotted, then buffered out to 800 feet.  A shapefile was created and moved to 
the Wireless feature class within the geodatabase. 

 

FRN Number Discrepancies 
Discrepancies between Round 2 and Round 3 data submissions were noticed concerning FCC 
Registration Numbers (FRN).  Effected providers were contacted directly to clear up these issues.  FRNs 
that were loaded into the database come from direct contact with providers. 
 

Community Anchor Institutions 

 
Data was collected and verified by the West Virginia Division of Homeland Security.  Existing datasets 
were used and modified to include the most recent broadband information, including upstream and 
downstream speeds.  Some information was collected through contacts at other state agencies, phone 
calls and e-mails.  The SAMB information website was used to verify locations.  Letters were sent to 
hospitals and nursing homes asking for their broadband information as well. 
 
Because of the change in domains in the geodatabase regarding the Broadband field allowing unknown 
values, there are fewer records for this round of data.  Records that did not have information in the 
Broadband field were deleted.  There were 2,355 Community Anchor Institutions in the Round 2 data 
submittal.  For this round, only 1,715 Community Anchors are being submitted. 

Validation and verification 

 
Throughout all of the data gathering and data preparation processes for each data submission the data 
verification has been continuous and has evolved based on the evolution of the data model.   The focus 
has been on getting complete data from all providers and assuring that all data can be processed into 
the required data model for submission.   Where providers did not submit data in acceptable formats for 
data normalization into NOFA formats or where they did not submit complete data or any data at all, 
there has been continued focus on working with the providers by the WVGES to continue to improve the 
source information being provided.    Data verification and validation is an on-going, long term  process 
that will continue to evolve throughout the broadband data development program.   With this third data 
submission being a much more complete broadband coverage across the State because of additional 
data supplied by providers, additional data verification methods, beyond what has been implemented to 
date,  will be evaluated to continue to refine the map, where applicable, prior to the next data 
submission in the fall of 2011.  
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Validation Processes 

Data validation begins within the data collection process to determine if the data submission by 
providers is formatted in a way that can be normalized into the NOFA formats required.  Where data is 
deemed incomplete or in non-conforming standards, the WVGES staff reached back out to providers, as 
necessary to improve the data submissions.  Over each round of data preparation the formats for the 
updates being collected has improved. 
 
Quality assurance and quality control has been a big focus of the data validation of the submittals to 
assure that the required data fields are populated properly,  that data fields are populated with values 
that follow the data model rules.    As the data model has evolved over each round of data submission 
these QA/QC checks have been modified to include the changes in fields, values, domains, etc that are 
being required for submission.    
 
Validation methods employed include the following: 
 

 Ensuring all applicable providers’ datasets are propagated forward to each round of data 

collection 

 Verifying that all required fields are populated with valid values, and default values are used 

when appropriate.  This includes: 

o Speeds valid for the technologies reported 

o Latitude/longitude coordinates fall within an acceptable range, given the state 

boundaries 

o The relationships between Maximum and Typical, and Downstream and Upstream 

speeds are valid 

o Service reported at the block level is done using blocks of the appropriate size (less than 

two square miles) 

o Speeds and technologies reported per provider are consistent between blocks and 

segments 

o Administrative information (Provider Name, DBA Name, FRN) is consistently reported 

per provider in each populated feature class. 

Outreach to Providers 
To further ensure the providers’ broadband footprints would be accurately represented in data 
submissions, “check maps” depicting each respective provider’s served small Census Blocks and 
segments located in large blocks were distributed back to providers.  Providers were requested to either 
approve their check maps as-is, or submit additional changes if their coverage was not accurately 
represented.  Any modifications received as a result of this effort were incorporated into the Round 3 
submission and these provider review ‘check maps’ will continue to be sent to providers during each 
subsequent data submission. 
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Figure 1 – Example of a portion of a provider check map 

The validation process for the April 1, 2011 submission also includes the use of the Python scripts for 
validation provided by NTIA.   

Third Party Datasets 
As data collections and data normalization processes progressed, additional validation was conducted 
using commercially available datasets.      The following commercially available datasets were used as a 
reference for the specific technologies that their data represented. 

 American Roamer datasets 

 TeleAtlas Exchange boundaries 

 Media Prints Cable boundaries 

These datasets were used primarily as a validation source for provider service coverage. 
 

State Broadband Interactive Map  

The State of West Virginia is preparing to release an interactive broadband mapping web site in April 
2011.  The web site will provide consumers the opportunity to review broadband availability across the 
State.  The web application will also have the functionality for consumers and citizens using the state 
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broadband map web application to submit comments and feedback.   The information gathered from 
that feedback will be reviewed as more potential source information for validation and determining 
confidence levels of the broadband coverage across the regions of the State.  By comparing comments 
supplied by consumers about broadband availability to the broadband coverage, trends could be 
recognized where potential inconsistencies in the existing broadband map could exist. This could 
delineate the need for further focused validation or verification in specific areas that could refine the 
broadband coverage information for future data submissions. 
 
West Virginia will also incorporate any feedback or statistics from any speed test results, potentially 
supplied in the future by the NTIA, to compare to the existing broadband coverage.   Again this could 
assist in determining if there are any trends or patterns in the information that could be an additional 
tool for prioritizing areas where more refined verification and validation might need to occur. 
 

Future Steps for Validation 

Future plans for data validation will include establishing confidence levels to assign to broadband 
coverage based on comparisons with other source information collected such as feedback from crowd 
sourcing results from state broadband map and national broadband map.  Confidence rankings will be 
used to prioritize any areas where additional verification techniques might be used such as consumer 
and business surveys.  
 
With the broadband map for the third data submission representing a much higher percentage of 
broadband coverage across the State because of additional data collected from providers, further 
validation of that data will also be reviewed at a regional level.   By working with regional planning and 
economic development councils to review the existing broadband mapping at a regional level, additional 
validation and verification of the information for the fall 2011 data submission will be undertaken on a 
regional basis. 
 
Also throughout the broadband data development program, as addressing information from the State 
Addressing and Mapping Board’s addressing datasets are continually updated, address point 
information from providers will continually be re-verified prior to each submission to NTIA to improve 
geocoding results and refine the broadband coverage areas.   
 
 

Providers 

 

Non-Responsive Providers 
Names of providers who were non responsive will be passed along to the WV GIS Coordinators Office to 
be contacted further.   
 
Atlantic Broadband LLC 
DBA: Atlantic Broadband, LLC 
FRN: 0009596883 
This provider was contacted 8 times.  Data was not provided by the April submittal date.  Further 
attempts at data gathering will be made in the next round of data collection. 
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Zayo Group, LLC 
DBA: Zayo Bandwidth Central, LLC 
FRN: 0009727512 
This provider was contacted 8 times.  Data was not provided by the April submittal date.  Further 
attempts at data gathering will be made in the next round of data collection. 
 
Skyweb, Inc 
DBA: SKYWEB Inc. 
FRN: 0018516799 
This provider was contacted 8 times.  Data was not provided in time to meet the April deadline. 
 
Helicon Cable Holdings, LLC 
DBA: Jet Broadband WV, LLC 
FRN: 0014413835 
Merged with another broadband provider. 

 

Satellite Providers 
Data requests sent to Satellite providers were met with the response of “We provide to the entire 
state.”  Attempts made at gathering more detailed data sets were unsuccessful for this round of data 
collection.  Further attempts will be made for the next round of data collection. 
 
Hughes Communications, Inc. 
DBA: HNS Licensuse Sub, LLC 
FRN: 0018483073 
Detailed data was not provided by the April submittal data.  Further attempts at data gathering will be 
made in the next round of data collection. 
 
StarBand Communications Inc. 
DBA: StarBand Communications Inc. 
FRN: 0005087457 
Detailed data was not provided by the April submittal data.  Further attempts at data gathering will be 
made in the next round of data collection. 
 
 
WildBlue Communications, Inc. 
DBA: WildBlue Communications, Inc. 
FRN: 0007843766 
Detailed data was not provided by the April submittal data.  Further attempts at data gathering will be 
made in the next round of data collection. 
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Providers that Submitted Data 

 

Provider Name DBA Name FRN 

Armstrong Holdings, Inc. 
Armstrong Telephone Company - 
Northern Division 0004311528 

Armstrong Holdings, Inc. Armstrong Telephone Company-WV 0004379731 

Armstrong Holdings, Inc. Armstrong Utilities, Inc. 0003765617 

AT&T Inc New Cingular Wireless Services, Inc. 0003766532 

Broadview Networks Holdings, Inc. Broadview Networks Holdings, Inc. 0010296853 

Cequel Communications, LLC Suddenlink Communications 0015784663 

Citizens Communications Company Frontier Communications Corporation 0003576352 

City of Philippi City of Phillipi 0001984244 

Comcast Corporation Comcast Cable Communications Inc. 0003768165 

Community Antenna Service, Inc. Community Antenna Service Inc. 0004966131 

Deutsche Telekom AG T-Mobile USA, Inc. 0006945950 

DSL.net, Inc. DSLnet Communications, LLC 0004324851 

Gateway Telecom, LLC Gateway Telecom LLC 0018536623 

Hardy Telecommunications, Inc. Hardy Telecommunications Inc 0002008043 

Hardy Telecommunications, Inc. Hardy Telecommunications,Inc CLEC 0013169313 

Hickory Tech Corporation Enventis Telecom Inc. 0008394322 

Inter Mountain Cable, Inc. Inter-Mountain Cable Inc 0001789080 

Inter Mountain Cable, Inc. Mikrotec CATV, LLC 0014471288 

JB-Nets JB-Nets 0016474868 

Leap Wireless International, Inc. Cricket Communications, Inc. 0002963528 

Level 3 Communications, LLC Level  3 Communications, LLC 0003723822 

Level 3 Communications, LLC Broadwing Communications, LLC 0008599706 

LightEdge Solutions, Inc LightEdge Solutions, Inc. 0015546443 

Metropolitan Telecommunications Holding 
Company 

Metropolitan Telecommunications 
Holding Company 0009806019 

Micrologic, Inc. Micrologic, Inc. 0018675256 

New Edge Holding Company New Edge Network, Inc. 0003720471 

NTELOS, Inc. NTELOS Communications Inc. 0004342762 

NTELOS, Inc. West Virginia PCS Alliance, L.C. 0002049328 

Otelco Inc. War Acquisition Corp 0018657858 

Qwest Communications International, Inc. Qwest Communications Company, LLC 0003605953 

Shenandoah Telecommunications 
Company Shentel Cable Company 0018024075 

Sprint Nextel Corporation Sprint Nextel Corporation 0003774593 

Spruce Knob Seneca Rocks Telephone, Inc. Spruce Knob Seneca Rocks Telephone, Inc. 0004337002 

TelAtlantic, Inc. West Side Telecommunications 0002009405 

TelAtlantic, Inc. Communications Plus, Inc. 0009281262 
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Time Warner Cable LLC Time Warner Cable LLC 0013430244 

TW Telecom inc. tw telecom holdings inc. 0014942668 

Verizon Communications Inc. Cellco Partnership 0018506568 

Verizon Communications Inc. Verizon Business Global LLC  0010856284 

Verizon Communications Inc. Verizon West Virginia Inc. 0002011278 

Visual Link Internet LLC Visual Link Internet LLC 0017645813 

 
Table 1 – Providers That Have Submitted Data for SBDD Program 
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Overview 
 

The following documentation provides an overview of how the third required data set was collected and 

processed for the State Broadband Data and Development Program (SBDDP) in the states of Alabama, 

Idaho, Wisconsin, and Wyoming.   

Although we could separate this draft into state-specific deliverables, the majority of methodology 

remains intentionally consistent among the states.  As one important validation test is comparability 

across states, we find value in this cross-state approach.  This cross-state approach also helps the 

LinkAMERICA team focus on comparable outcomes across the four states, where appropriate.  Our 

intent is not to make the states look and be the same, rather it is to leverage economies of scope and 

scale among the business processes. 

As expected, this document rests heavily on the prior drafts, but has also been updated and expanded. 

Significant changes include additions covering: 

1. Trends in provider inputs  

2. Expansion in retrieval of WISP coverage  

3. Requested modifications based upon NTIA guidance 

a. Inclusion of satellite, changes to service overview table, FRN verification process 

4. Consumer Feedback, Crowd Sourcing and Social Media campaigns. 

5. Development and posting of a Technical Standards document. 

Treatment of the following subjects has been expanded: 

1. Community anchor institutions and survey methodology 

2. Verification and validation 

3. Data production methods 

As anticipated, the SBDD program continues to mature and evolve.  Technical leadership and strong 

guidance has been appreciated.  We continue to focus resources on establishing stable business 

processes to track submissions, verify received and processed data, test for temporal stability and 

provide reporting deliverables consistent with NTIA expectations. 

In our view,  the mapping deliverable reflects (1) a good faith effort, which results in a reasoned 

response to the NOFA, Technical Appendix A,  as well as supplementary program office guidance and 

modifications offered in phone calls, emails, and webinars, (2) a stable foundation for improvement and 

prioritization of both NTIA and state needs and interests , (3) a valid data processing model to support 

online mapping, consumer feedback, provider verification and reporting, and finally, (4) a valid use of 

the evolving data transfer model and its intrinsic validation methods.  More importantly, the resulting 

data and online coverage maps that follow from this work are providing good input and context for the 

Broadband planning teams working across the states we have the pleasure to serve. 
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We close this methodology document with two Appendices.   Appendix One describes Data Collection 

Challenges.  This section describes some of the open issues, challenges and questions we are exploring.  

Our hope is to receive clarification and counsel from NTIA in how best to confront some of these issues, 

which are likely common across states.  Appendix Two describes the confidentiality framework 

explained by NTIA.   

Purpose of This Manual 
This technical document was developed to provide transparency in our data production process.   

Our goal is to illustrate a thoughtful process designed to meet the intent of the submission.  Our hope is 

that we have developed a process that is reasonable, with respect to the data it deals with, as well as 

flexible enough to change with evolving NTIA requirements and lessons learned from the Broadband 

mapping community.  

Data Sources 

Developing the Provider List 

Provider lists for all states were developed at project inception from the following sources: 

 State lists of regulated telecommunications, cable and wireless service providers 

 State and national industry organizations (i.e. cable associations, wireless service provider 

organizations, telecommunications associations) 

 FCC Form 477 respondents 

 Independent web searches 

 Prior comparable mapping/research efforts 

 Interviews with key state staff members and important community influencers 

After the October 1, 2011 “Round 2” submission, we continued our research and added new providers 

to the program as discovered.  As one would expect in a dynamic marketplace, provider identification is 

an ongoing and important component of our work.  Mergers and acquisitions, the use of multiple 

regional DBAs, the lack of any universal identity management attribute, and the generally complex 

parent-subsidiary structure of many telecommunications companies, make provider identification and 

tracking very challenging.   

In early January 2011, we once again initiated an email and telephone outreach campaign to contact all 

known providers. This is an extremely time consuming process, but it is necessary to ensure that the list 

of contact persons remains current, and that providers are aware of data request changes and deadlines 

associated with each round.  Where necessary, we execute new NDAs with providers.  In “Round 3”, this 

effort continued on a daily basis until we reached our final data submission deadline on February 18, 

2011.   After February 18, we continued to work with providers who were not able to meet the deadline.  

In most cases were able to “crash” our process to accommodate this extra data, but late submissions 

continue to create inefficiencies and add costs to the overall program.  In Round 3 only providers who 
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responded in the last two weeks of March were excluded from the final dataset.  Data from those 

providers will be updated this summer and included in our Round 4 submission. 

Once again, as contact is made in each round, we verbally qualify each provider by asking a series of 

questions regarding the type of service and speeds offered.  If the provider does not meet the minimum 

specifications for a Broadband provider (as defined in the NOFA) we make a note of their status and 

remove them from the data submitted to NTIA.1  We continue to reach out to them in future rounds in 

the event that their service is upgraded or expanded. 

Provider Outreach 

To meet the program’s aggressive deadlines and participation goals, LinkAMERICA believes it is critical to 

maintain rapport with providers.  To do this, we continued to reach out to providers with regular project 

communications, including a program newsletter and links to the various state mapping websites.  As 

described above, individual e-mails and/or telephone calls were made to all providers explaining the 

status of the program and requesting their continued support in Round Three. We’ve also had the 

opportunity to support providers in their BTOP / BIP applications in certain cases. Through these 

collective outreach initiatives, and our engagement with various industry associations, we continue to 

enjoy a healthy and appropriate relationship with Broadband service providers. 

NDA 

To provide protection for all parties involved, LinkAMERICA continues to honor the terms of our NDA.  If 

providers did not execute the NDA in Round 1 or 2, they were giving an additional opportunity to do so 

in Round 3. New providers were of course also supplied with a copy of the NDA. 

To facilitate the execution of NDA’s, LinkAMERICA continues to use the DocuSign online document 

management solution.  This system allows providers to review and digitally sign the NDA in a legally 

binding manner, and has been instrumental in achieving rapid approval and execution of NDAs with the 

majority of providers.  In some cases, NDA’s were individually negotiated to address specific provider 

concerns.  In other cases, providers chose to submit data without executing an NDA. 

Provider Survey 

Since two prior rounds of data collection had been completed, the LinkAMERICA team had a solid base 

of coverage and speed information with which to begin Round 3.  This allowed us to provide two 

response options to providers.  The first was for them to review PDF check maps of their coverage and 

speed data – submitting only corrections and additions to the existing dataset.  The second was to allow 

submittal of completely new datasets, either in tabular form or in multiple other digital formats.  For 

those without sophisticated CAD or GIS systems, we continued to allow the submittal of 

printed/scanned maps and other written materials.    

                                                           
1
 As with other Grantees, we struggle with appropriate and consistent classification for service providers like 

Megapath, New Edge Networks, American Fiber.  These providers seem to resell and/or provision within their own 
network opportunistically.  In this submission we begin to bring them into the analysis as a provider type “other”.  
As the inclusion of this category isn’t our primary goal, we are working to process data as we can.  We are similarly 
categorizing and retaining reseller information.  Our datapackage.xls illustrates the categorization of non 
Broadband providers within our provider tracking  and verification systems. 
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Survey Methods 

Once again, we used a secure digital survey process (via our provider portal websites) to collect and 

display information for providers.   The Round 3 survey process was designed to accommodate both 

new and returning providers, and the different types of information they would be submitting.  The 

following is a summary of the process encountered by each group: 

New Providers:  New providers were routed directly to our standard survey where they were provided 

with templates for uploading data in tabular NTIA-compliant formats.   As in Rounds 1 & 2, if providers 

could not supply information in the requested format, alternatives were offered.  These alternatives 

included uploading service-area boundary maps, exchange area maps, CAD drawings or customer 

address lists.  From that information, the LinkAMERICA team developed a geographic representation of 

coverage and was able to build coverage features for each provider.    

Returning Providers:  While many Broadband providers submitted datasets in Rounds 1 & 2, many of 

those submissions did not contain 100% of the requested data.  To help identify gaps, and to make the 

Round 3 submission process as simple as possible, every Round 2 survey was reviewed for 

completeness, as well as accuracy and formatting compliance.  Notes were made regarding gaps, and 

specific instructions were developed for providers in Round 3.  These instructions not only explained 

what data was missing, but also provided directions on how to include that information in the Round 3 

submission.   

Check maps were also developed to show each provider how their service area would be displayed on 

the resulting interactive state map.  Generating these customized documents in each round is an 

extremely time consuming verification process, but it allows us to close many of the gaps that might 

have otherwise persisted. 

Follow Up 

After the release of the Round 3 survey in early January 2011, LinkAMERICA launched an extensive effort 

to encourage responses.  Every known provider was contacted at least twice by telephone or e-mail 

during the months of January and February.  The initial data submission deadline was set for February 

18, but, as previously noted, we continued to accept “straggler” submissions well into March.  

No Response Policy 

As mentioned above, every effort was made to contact each provider who appeared on our initial list.  

However, if no current information could be found on the company (i.e. no website, no valid phone 

number, no contact person identified) they were removed from the list of “known providers”.  We 

believe the vast majority of those we were unable to reach were small wireless providers who have 

simply ceased to exist2. 

                                                           
2
The complete list of known providers and important submission statistics are contained in the datapackage.xls 

file. 
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Summary 

In summary, an intensive 45-60 day provider outreach and data collection process is initiated at the 

beginning of each round.  In Round 3, given the data vintage of December 31, 2010, we began this 

process immediately after the New Year.  The last submissions were accepted in mid-March, 2011.    

While we continue to successfully engage the majority of providers in each round, the amount of 

manpower required to solicit complete and timely responses should not be underestimated.  This 

process is one of the most costly and complex within the entire SBDD program.  

Third Party Data Used 
Beyond the data obtained from providers, we acquired the following commercial data products: 

 American Roamer, Coverage Right Advanced Services. This data served two purposes.  The first 

was to verify the provider list and help find Broadband service providers not on other lists.  The 

second was to verify the reasonableness of the Broadband service provider’s submission. 

 MapInfo ExchangeInfo, Professional.  This data was used in the verification of telephone 

Broadband provider data.  Where a public domain exchange boundary wasn’t available, the 

MapInfo boundary was used for coverage containment tests.  

 Media Prints Cable boundaries.  This data was used in the verification of Cable/HFC Broadband 

provider data.  It was used to research valid providers and discover if that provider was offering 

Internet service.  In very rough terms the contained boundaries were used to test the location of 

some provider data.  

 GeoResults Telecom Research Data.  This data was used to help estimate the Broadband 

services likely provided to certain classes of Community Anchor Institutions (CAI). 

We have included third party data sources, which touch on each of the three major technologies 

analyzed within the SBDD program.  Each of these data sources tie back to a public domain data source, 

which provides a cross-verification mechanism for the commercial data product. 

Although there are a large number of third party licensed data sources available, we remain 

conservative in our acquisition plans.  From our limited analysis we are concerned about the ability to 

cross-verify additional third party licensed sources against public domain data.  Further, we are unsure 

of how we may be able to integrate another data provider’s view of valid Broadband providers within 

the definitions used by the NOFA (eg. Are they using an FRN/DBA identity view or a marketing view?  

Can the provider supply in a 7-10 day window?  Are they facilities based or not?).  This leads us back to a 

statement we made in a ‘lessons learned’ Webinar (April 2010) about exploring a consortia to lower the 

cost of data acquisition and allow multiple entities to peer review the quality and methodologies behind 

licensed data products.3  

Beyond these commercial data sources, we used a number of public domain sources.  These included: 

                                                           
3
 We also suggested forming a technical standards committee and a consistent system for confidence reporting. 
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a. Geographic Data Files  

i. US Census TIGER data4 

b. Sources that helped isolate providers, identity management or provider service areas 

i. NECA Tariff 4 

ii. State produced exchange boundaries  

iii. Carrier produced wirecenter boundaries 

iv. FCC 477 provider filers 

v. FCC Coals reports (321/325) 

vi. FCC FRN API lookup tool 

vii. FCC/FAA Antenna Registration System 

viii. FCC FRN Lookup Tool (plain text search) 

ix. USAC High Cost FCC Filing Appendices 

c. Sources that helped isolate anchor institutions 

i. USAC Grant lookup tool 

ii. USAC High-Cost FCC Filing Appendices 

iii. HRSA data warehouse 

iv. NCES data lookup 

v. State managed lists of schools (K-12), post-secondary institutions and libraries 

List of museums,  conventions, and visitors bureaus from www.onlineatlas.us 

Finally, challenges exist when dealing with the inevitable conflicts between provider-submitted data and 

third party sources (public or commercial).  There is no guarantee third party sources are more accurate 

or timely than the providers’ own reports.   Indeed, some third party sources are based upon different 

standards than those specified in the NOFA, perhaps making them less reliable than information 

collected directly from providers.  At the very minimum, provider data has a lineage and temporal status 

that we can identify.  A concern we have with increasing use of third party data is that we have no way 

to verify its quality or development methodology.  In other words, we may hit a wall in which we can’t 

determine how the commercial source derived its coverage conclusion.  To us this means that third 

party data sources are beneficial, but represent a supplementary view, not an authoritative one, of the 

NOFA defined Broadband market. 

In short, we have chosen to use provider data as the baseline.  We will challenge provider reports when 

third party data shows major anomalies, or when a consistent volume of consumer feedback points to a 

potential error.   

As the program evolves it is also our intention to provide tools that allow end users to evaluate the 

accuracy of the data in their own way.  A confidence score or the presentation of multiple (and 

potentially competing) reports for the same location may be made available. This notion is discussed 

further in the “Validation” section below.   

                                                           
4
 Census data were derived from < http://www2.census.gov/cgi-bin/shapefiles2009/state-files?state=01>, Census 

2000 files.  Roads were derived from the county faces and edges file downloaded at the same location and tiled for 
a full state. 

http://www2.census.gov/cgi-bin/shapefiles2009/state-files?state=01
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Confidentiality and the Use of Licensed Materials 
As a mapping vendor, we are reliant upon the cooperation of Broadband service providers.  In large 

part, what underlies this cooperation is trust that we will not violate the proprietary and confidential 

nature of the data provided to us.   

We are thankful for the confidentiality clarification that NTIA shared with us (included as Appendix Two).  

We intend to use this as a guiding document to help us communicate with providers about what 

information NTIA considers to be confidential.  Our suggestion is that NTIA publish this, or something 

comparable, to ensure a consistent interpretation of the NOFA and how it guides NDAs. 

As some providers are non-responsive to requests for information, or lack resources necessary to put 

data into NTIA compliant formats, we have fallen back to the use of commercial data sources in several 

places.   

For instance, some mobile wireless providers were unable to submit coverage information to us.  In 

these circumstances we have generalized the American Roamer coverage.  For incumbent telephone 

providers we have used commercial wirecenter boundary products to filter Census Blocks that are 

clearly out of their exchange areas.  Finally, licensed data from Georesults were used to derive estimates 

of Broadband connectivity for hospitals within the Anchor Institution category.  The actual value from 

Georesults was not used, but our estimate is modeled from their input data.  We also use the name and 

address as provided by the State data provider, not Georesults.   

Public Engagement:   Crowd Sourcing, Surveys and Social Media 
Crowd sourcing (i.e., an intentional and carefully designed effort to tap into the collective intelligence of 

the public at large to expand our knowledge base) continues to be an important element of our data 

collection and validation process. In addition to the various opportunities, the public has to provide 

input via the online service coverage maps and the related ‘Broadband story’ process, our crowd 

sourcing efforts are grounded in a fairly traditional telephone survey approach, focused on the 

consumer market. In addition, we are currently advancing our crowd sourcing process to include certain 

initiatives centered in two social media outlets – Facebook and Twitter. These initiatives are summarized 

below. 

Consumer Surveys 
Working under contract for the state of Alabama in 2009, our initial consumer survey was performed 

before the NTIA SBDDP grant was in place. Subsequent consumer surveys funded by the SBDDP grant 

were hosted in 2010 for the states of Idaho, Wisconsin and Wyoming. These surveys will be repeated 

after two years to establish and evaluate trends. These primarily telephone based surveys include two 

distinct and carefully scripted tracks: one for internet users and one for non-users. The telephone survey 

approach allows us to reach the non-internet user group as well as the current internet user. A 

secondary online approach is also used to augment input from current internet users. For non-users, the 

surveys help determine why they don’t have or don’t use Broadband. For current Broadband users, the 

survey helps determine the nature of their Broadband access and how they use that connectivity in their 
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daily lives. In addition to our state-specific surveys a nation-wide survey was also hosted to provide a 

broader view of consumer views for comparison purposes. State-specific surveys are, where possible, 

framed to match the state’s regional Broadband planning structure (e.g., the consumer survey in 

Wyoming was designed to produce results relevant to the state’s seven Broadband planning regions). 

The resulting data is helpful on a number of fronts in the SBDDP’s mission to advance the access and 

adoption to Broadband. Survey data provides an important, albeit broad, gauge for assessing coverage 

information obtained by providers. For example, areas with widely available coverage (according to 

provider information), but lower consumer subscription levels (according to survey results), or perhaps 

where survey results suggest Broadband is not available, can be examined in more detail. Survey results 

are also very important to the Broadband planning (and capacity building) components of the SBDDP 

program in that they help inform and formulate Broadband advancement priorities. Survey results also 

help inform Broadband policy discussions on both the local and state levels. Finally, survey results 

provide important information to the service provider community regarding market demand and 

specific internet use in specific communities (i.e., regions).  

The 2010 surveys were launched in July 2010 with a test number of survey calls to confirm (and adjust as 

needed) the structure of the survey and the underlying survey process. The surveys were closed on 

November 30, 2010. Telephone surveys were completely random beginning with the acquisition of a list 

of state-specific, randomly selected landline telephone numbers (e.g., 80,000 random Wyoming 

residence telephone numbers were acquired as the foundation for the Wyoming survey). Mobile phones 

were not included in the initial surveys. Upon evaluation of the survey statistics, an auxiliary survey was 

executed to ensure younger groups (i.e., age 18 – 25) were adequately represented. This secondary step 

is required because of the continued migration (by younger markets) to non-landline based 

communications. This younger market (age 18 – 25) was surveyed by reaching out through social media 

outlets to encourage their participation in an online survey process. 

Survey statistics point to the complexity of the telephone-based survey process. Survey volume achieved 

statistical validity ranging from a 95% confidence level and a + 1.7% margin of error for the statewide 

data in Wisconsin to a 95% confidence level and a + 3% margin of error for Wyoming’s statewide data.  

Most regions in the 3 states have a 95% confidence level with a + 5% margin of error. 

Call volume and disposition is summarized in the chart below 
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TOTAL RECORDS CALLED & % OF STUDY 106,592 100% 22,144 100% 57,445    100% 27,004   100%

NO ANSWER 53,507   50% 11,974 54% 25,886    45% 15,647   58%

TOTAL DEAD NUMBERS 23,962   22% 4,529   20% 14,611    25% 4,822    18%

HARD REFUSALS 9,304    9% 1,728   8% 6,048     11% 1,528    6%

QUALIFIED REFUSAL 643       1% 101     0% 403        1% 139       1%

BUSY 3,652    3% 754     3% 1,903     3% 995       4%

ANSWERING MACHINE 6,385    6% 1,314   6% 3,388     6% 1,683    6%

NON-WORKING NUMBER 5,072    5% 943     4% 2,983     5% 1,147    4%

CLAIMS PREVIOUS INTERVIEW 113       0% 16       0% 68          0% 29        0%

NON-RESIDENTIAL 454       0% 104     0% 239        0% 110       0%

LANGUAGE BARRIER 1,003    1% 223     1% 562        1% 218       1%

OTHER PHONE PROBLEMS - FAX/MODEM 907       1% 205     1% 500        1% 202       1%

PORTED NUMBER 272       0% 68       0% 149        0% 54        0%

BREAK OFF - SCREENER 556       1% 103     0% 301        1% 153       1%

TERM Q3 - UNDER 18 122       0% 22       0% 65          0% 36        0%

99% 100% 99% 99%

TOTAL COMPLETES 5,758    5% 1,080   5% 3,420     6% 1,259    5%

AVG Completion Time (minutes) 16 15.8 15.4 16.1

BROADBAND MARKET RESEARCH - ID, WI, WY - FALL 2010

IDAHO WISCONSIN WYOMINGTOTAL

 

As noted above, the telephone survey process represented in the statistics above was augmented by 

providing online access to the survey. Participation in the online survey was promoted on all of our 

state-specific public web sites and selected social media. 

As a final relevant point with respect to the consumer survey process the length of the survey is 

noteworthy. By survey standards, this was a long survey. As noted above, the survey averaged sixteen 

minutes across the three states. While this clearly contributed to the number of survey call attempts 

that were required to reach the level of statistical validity, it was not insurmountable.  

Social Media 
The phenomenon of social media is widely documented and yet still emerging as an effective access 

point for public engagement. We continue to explore appropriate ways to use a variety of social media 

venues in our SBDDP efforts. All of our efforts are informed by and consistent with relevant state statues 

and guidelines. Different states have different perspectives on if and how the state will participate in the 

use of social media. Some state requirements are well defined and some are still being formed. Where 

appropriate, we use YouTube, LinkedIn, Facebook and Twitter to support our work. YouTube and 

LinkedIn postings are used to promote awareness. As noted above, we were able to promote additional 

input on the consumer surveys through a social media outreach program aimed at our younger market 

segments.  

In addition, we are currently engaged in two specific social media tests (in Alabama) to gauge how 

Facebook and Twitter can be used to drive public input on two important crowd sourced issues: online 

speed tests and input on map accuracy. Based on data obtained through our web site traffic monitoring 

process and readily available social media tracking processes, our most recent results are promising.  For 

example, with a fairly limited ‘following’ a single Facebook post aimed at driving traffic to the online 

speed test, had 282 impressions (i.e., the number of times the post was viewed), which contributed to 

an increase in 71 more visits to the Facebook page generally, and a volume of 60 hits (over a three day 
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period) on the web site page that hosts the speed test. Our normal volume of speed test page hits is in 

the neighborhood of 7 or 8 per day (vs. the average of 20 per day experienced during this test). 

Preliminary data suggests that about half these page hits resulted in a speed test being executed. 

Data Production Process 
To support our objective of transitioning the data development process to our State partners, we 

continue to model and document our data production process.   We find this to be a very beneficial step 

for two purposes.  

First, it helps us understand why (and if) a task is being done, and if it is being done efficiently.  Much of 

this program started so quickly that it was difficult to plan logical integration and hand off points among 

the various workgroups.  Further, we are currently in the process of consolidating much of the process 

data (check-ins, check-outs, metadata) and we can use this process model to efficiently plan a cohesive 

information architecture. 

Second, our process documentation and modeling helps explain why resources are being consumed in a 

particular way.  This helps our State partners plan for in-sourcing specific tasks as their time and 

budgetary constraints allow.  It also helps our LinkAMERICA team better plan and cross-train members 

to deal with the work surge that occurs 30-45 days prior to submission. 

Finally, documenting and modeling our process helps us take advantage of increasing specialization and 

proficiency with certain types of data and management responsibilities.   In this submission, we had 

identified data “czars” responsible for check-in and check-out of data.  That data czar helped to bridge 

the gap among receipt functions, provider feedback, production and DBA.  
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Figure 1--SBDD Business Process Diagram 

 

Data Production Methods 
As raw data were received from the provider community, attention turned to normalizing the disparate 

submission formats5.  The team considered each submission with respect to the following criteria.  

These criteria are important because they perform the basis for our verification and quality assurance 

process.  In other words, we have to appropriately scale our data verification efforts to match the scale 

or ambiguity of the following: 

 Locational certainty 

 Speed certainty 

 Temporal certainty 

 Provider and network ownership certainty 

                                                           
5
 In line with NTIA Best Practices we continue to request and receive a large number of data input formats.  This 

ranges from tabular Block lists to hand drawn maps. 
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The team’s goal was NOT to quantify a particular degree of precision with respect to any of these 

criteria.  Rather, we are working to attribute the above “certainty attributes” to each submission, and 

will continue to implement quality assurance and verification mechanisms that are resource-appropriate 

for each. 

Deriving Broadband Coverage Information 
Broadband Coverage6 was normalized into four formats:  

1. Coverage in Census Blocks (2000) of 2.00 or less square miles 

2. Covered Street Segments (2000) in Census Blocks greater than 2 square miles7 

3. Address Level Coverage (point data) 

4. Wireless Service Areas (SHP file format) 

With each submission, the team went through a series of steps to normalize and categorize the data. 

Since data arrived in many different formats, and at many levels of granularity, the following 

normalization procedures were used:  

1. Determining the nature of service being provisioned (who is providing service and what 

technologies are in use) 

2. Planning an attack strategy for the submission –understanding the data and assigning team 

members to various tasks 

3. Geo-referencing the data; QA the georeferenced data  

4. Geoprocessing the geo-referenced response 

5. Segregating the submission into the correct NOFA-compliant submission formats. 

6. Apply appropriate source metadata8 

                                                           
6 Speed, Anchor institutions and Middle Mile facilities are discussed in later sections. 

7
 To help clarify issues relating to Census block area and vintages in use, our team published a technical paper to 

the Grantee workspace.  Because we were unsure if this standard should be implemented uniformly, this 
document was never distributed to the provider community. 
 
8
 When our team logs a submission into the staging database we record at least two attributes.  One records the 

method used to derive the coverage, the other records the method by which speed was attributed to that object.  
Other attributes carried to NTIA carry source meta values as well. 

https://sbdd-granteeworkspace.pbworks.com/w/file/33293657/Technical%20Reference%20Document%20Final.doc
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Figure 2-Broadband Coverage Process 

Impact of Program Change 

There were four important program changes that impacted how Broadband coverage was developed 

and submitted to NTIA in Round 3. 

The first was the development of a “provider match” submission metric whereby the grantee’s complete 

list of known providers in the state is compared against lists from third party sources.  The provider 

match specification was discussed on a webinar prior to the release of the national map.  Although, to 

this date, there has been no clarification on how this metric is established or exactly how it will be used.  

We have invested significant resources to support an internal process to compare our provider lists with 

several additional sources.  This has been manifest in at least three ways. 

Within our provider verification process we  work to derive a  state level match against third party data 

sources.  As discussed in the early pages of this manual, there is no guarantee that a third party data 

source is any more accurate than submitted data, nor does it necessarily reflect the provider ecosystem 

specified in the NOFA, Technical Appendix A.  We devote significant resources to matching our 

submitted data against three, third party data sources.  In many cases this becomes a judgment call 

trying to match provider names across systems.  It is a difficult and somewhat arbitrary process.  

Nonetheless we do believe it has value because it forces a re-examination of who we believe is an 

appropriate provider within a non-NOFA context. 

The use of a provider match system, as well as the webinar comments (3/17/11) directing grantees to 

estimate, wherever possible, non-participating providers have made us back away from one of our 

fundamental assumptions in data collection.  As discussed in the prior draft of this manual, we had 

developed a certain “hold-out” class of data when a provider’s data wasn’t of sufficient quality to verify, 
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or we were unable to put it into the data model (eg. address points submitted for a wireless).  In this 

submission, much of this hold-out data has been included.  In some cases this means we are using 

simple polygons to capture a wireless ISPs serving area.  Other times, if we are confident in the 

coverage, but can get little clarification on the submitted speeds or frequencies, we release the 

coverage and note in our internal metadata the source issues with the other attributes.   

Finally, we have used the new provider type classification of ‘other’ to bring some aspect of the 

provider’s data into our submission.  There still seems to be confusion on how to handle provider types 

where a provider offers multiple paths to receiving Broadband for typically business customers.  Rather 

than waiting for certainty on the answer, we bring the provider in and list them as Provider Type 

“other”.  Our sense is Provider Type “other” will continue to expand in the fourth submission as we pull 

in more providers who are facilities-based and reseller.   

Clearly one challenge is the data, but an equally significant challenge is appropriate messaging around 

this “other” provider type category.  We do not want to leave consumers with the impression that they 

can get a high capacity fiber or Microwave link despite the fact that the hospital next to them in the 

same Census block can get this service. 

The final set of changes was a second verification check against reported FRNs.  As NTIA is stressing the 

importance of this attribute, we increased its visibility in our Check Map process.  FRN is now listed on 

both the tabular verification report and the provider PDF map.  Beyond this increased visibility we had 

an analyst verify each FRN in our system against the FCC API9, as well as FCC textual search10.   Because 

the FRN is not an identity management tool, we are unsure if the FRNs we’ve included are those desired 

by NTIA, but we have at the very least, verified the existence of the FRN via the FCC system. 

Trends in Provider Supplied Data 

With this third submission we take note of three important trends.   

First, with larger providers, we are seeing an increase in data stability relative to earlier submissions.  In 

informal discussions, several providers have noted changes and stabilization in internal data processes.  

The firms have invested internal resources in stabilizing this data feed.   

We see this reflected in very stable counts of Census Blocks and road segments.  This does not mean 

that complex problems like segment identification or dispersion in data have been ‘fixed’.  It does mean 

that the format and methods to produce inputs for NTIA are increasingly stable. 

Second we note that several providers have been particularly concerned with an appropriate 

identification of Maximum Advertised speeds.  In some cases this involves identification of very small 

areas (sometimes below the level of a Census block) and appropriate assignment to technology of 

transmission and maximum advertised speed tiers.  In other cases, questions arise regarding maximum 

advertised speeds that could be sold based upon network design, but that are not generally “advertised” 

or otherwise stated to the general public.   

                                                           
9
 http://reboot.fcc.gov/developer/frn-conversions-api 

10
 https://fjallfoss.fcc.gov/coresWeb/simpleSearch.do 
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Third when comparing submission three results relative to submission two it is important to recall the 

inclusion of much new data within the Provider Type “other” category.  This change does not necessarily 

reflect a change in the size of the market, rather it reflects new data coming into the analysis and 

segregated into a distinct category.. 

Coverage Geoprocessing Methods 

The next section discusses how data were geo-referenced and geoprocessed given a particular 

submission format.   

In most cases, in Round 3 we were still not provided with street segment level information for Blocks 

greater than two square miles (large Blocks).  This necessitated subsidiary geoprocessing.  As stated 

before, our first goal was to derive block level coverage.  Then, for Blocks greater than 2.00 square 

miles, we moved to a segment gathering processing.  The segment process will be described in the last 

section.11  

Block Level Coverage Derivation Using Service Point Data 

A number of providers submitted point level customer data.   

In some cases the submissions themselves were not internally consistent.  For example, in the image 

below, unprojected points are shown, while the Census block polygon to which the points are supposed 

to “belong” is highlighted.  In this case, one of the following scenarios has occurred:  block attribution is 

wrong, the points are not in the location to which they are attributed, or different block shapes were 

used than what is assumed. 

 

                                                           
11

 As has been discussed previously, we note inconsistency in how providers are supplying information at the block 
and segment level.  Beyond the temporal differences, we see that providers are computing area differently, as well 
as including or excluding water areas.  This provides an inconsistent measure across providers for the 2.00 sq mile 
cut off.  Our preference would be to provide guidance to service providers within our states, but our concern is 
that we will inconsistently message this with grantees in other states.  We would appreciate consistent guidance 
from FCC/NTIA on this topic. 
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Figure 3-Internal inconsistency in submitted data 

In other circumstances, we found that inconsistent geocoding standards may produce misleading 

results.  The next image shows point level data, and the Blocks are colored based upon the counts of 

points intersecting Blocks.  The challenge this presents is that if geocoding was performed on a different 

dataset than the block boundaries (the road traces are not coincident with block boundaries) and/or 

geocoding was done without an offset, it becomes problematic to assign coverage to a Census block 

based upon only the point locations. 
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Figure 4-Block Coverage 

For this reason, we elected to use a 200-foot buffer to select Census Blocks that intersect our points.   

Block Level Coverage Derivation Using Customer Facing Plant Level Point Data 

In other circumstances, providers submitted point level plant data.  From what we could gather, these 

points tended to be customer-dedicated terminals.  Typically, these providers were high speed 

Broadband producers—which may somewhat strain the definition of Broadband as other providers 

supplying comparable services specifically disclaimed the ability to provide high-capacity Broadband 

services in the required 7-10 day interval.  In these plant point data submissions, we had similar 

concerns to the point level customer data, but two factors tended to make us use a more conservative 

intersection buffer.  First, we tended to have far fewer points to work from, so our concern was 

grabbing too many covered Blocks as the Blocks tended to be much smaller in these urban areas.  

Second, these plant points tended to be dedicated to distinct customers, but it was difficult to know 

which element of the customer’s campus to attach coverage to. 

In the case of the image below, given a small shift to the left, it would be easily possible to gather 1 to 3 

Census Blocks from this point.  Although orthoimagery is helpful in a circumstance such as this, it is still 

indeterminate – specifically in areas where the coverage is attributed.   

Thus, in the circumstance of plant level point data, we used a 100-foot intersection buffer. 
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Figure 5-Plant Point level data 

Coverage Derivation Using Linear Facilities Data 

A number of providers submitted facilities data.  We handled this data in different ways depending upon 

what we believed the facility data represented. 

Most telecommunications networks are divided into two components.  Feeder supplies higher capacity 

nodes (eg. DSLAMs, Fiber Nodes).  Distribution usually supplies customer premises (NIDs, Pedestals, 

Taps, ONTs).  Where we could discern what strand we were provided, we used different methods. 

The next image demonstrates a geo-referenced CAD image as given to us by a Broadband service 

provider.  Note the light and dark green shading.  We would infer that the lighter segments represent 

distribution and the dark green represents the feeder network. 

In the case of a combined strand map, we used a relatively tight buffer of 200 feet to gather covered 

Census Blocks.  Our intersection tolerance is based upon an assumption that our data likely represent a 

situation comparable to customer point level submission in that we have most of the network footprint 

captured. 
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Figure 6-Georeferenced CAD information supplied by Broadband provider 

 

In other circumstances, we were provided engineering information that we inferred to be feeder only.  

This inference was typically based upon the presence of fiber optic equipment only.  In these cases, we 

used a more generous 2,000 meter Census block intersection.  The 2,000 meter criteria was based upon 

an informal survey of population in proximity to the geo-referenced strand data, but it could be varied 

based upon a more complete survey. 

Coverage Derivation Using Covered Street Segment Data 

In some cases we were provided with covered street segment data.  Covered segments tended to come 

from two sources. 

In some circumstances, providers gave us CAD data, which was not drawn in a projected manner.  This is 

relatively common for older engineering data derived from hand drawn records.  This meant that our 

team had geo-registered the image into an approximate position.  In this case, the boundary streets 
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were selected, and an enclosing polygon was derived.  The intersection of this polygon and the Blocks 

within became the geoprocessing method to derive Blocks. 

 

Figure 7-Coverage derived from street segments 

In a second circumstance, street segment data was developed during coverage estimation.  Handling the 

estimated data is discussed below. 

Coverage Derivation Using Serving Area Point Submission Data 

In other cases we worked with a provider to derive service areas based upon point plant data.  In these 

cases we were given a primary serving node and an appropriate road length service boundary. There is 

an important distinction from the plant data discussed above. In this specific case, the data submitted 

was a node that served many locations--such as a Central Office or DSLAM.  This is contrasted with the 

earlier example in which the point represents a node serving only a few customers.   

When trying to derive coverage from Central Office or DSLAM nodes, the team used ESRI Network 

Analyst to derive covered road segments honoring these road engineering parameters. 
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The figure below shows street level coverage derived from Central Office and remote DSLAM point data.  

 

Figure 8-Coverage derived through road paths 

In response to Provider feedback we revised this process to include a larger variety of TIGER road types.  

In Round 1, unimproved roads were not used.  In Rounds 2 and 3 -- particularly to improve estimates in 

areas bordering parks and public lands -- a wider class of TIGER roads was used.12 

The segment level coverage is easily extendable to derivations of Census block level speed.  The figure 

below shows the attributions of block level speed based upon the Maximum Advertised Speed available 

from a DSLAM.  Although the methodology isn’t perfect, it does provide insight into the value of 

granular infrastructure data. 

                                                           
12

Only TIGER features of MTFCC type S1100 and S1200 were excluded from use. 
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Coverage Derivation Using Polygon/Polyline Serving Areas 

Broadband service providers sometimes submitted coverage in terms of served areas.  This was either in 

direct geospatial formats, CAD files, or paper maps.  The image below reflects a carrier’s service area.   

Within that service area, there are variations in technology of transmission and served speeds.  When 

polygons with speed data and technology of transmission were available, we used a spatial intersection 

to gather covered Census Blocks.  In many cases, using covered Census Blocks resulted in a loss of the 

speed variation (sometimes the speed variation was at a level below a Block and did not get picked up 

within a spatial query).. 

 

Figure 9-Coverage derived through serving area polygons 

Although we cannot directly solve the loss of speed granularity due to Block shapes, we honor a 

business rule wherein we always select Blocks from the highest speed areas first, and then allow the 

lower speeds to select from the remaining Blocks.  This is an arbitrary rule, but our feeling was that it 

should be a consistent selection, rather than an unordered selection. 

Street Segment Derivation, Large Blocks 

For those calculated Blocks greater than 2.00 square miles (large Blocks), we provided coverage in terms 

of covered street segments and corresponding geography.   

With respect to segments we had four sources of data: 

1. Covered large Blocks 

2. Tabular street segments and address ranges for large Blocks 
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3. Geographic segments either with street attributes or without. 

4. Service area boundaries 

A number of providers only provided a list of covered large Blocks without corresponding segment 

information beneath the block.  This provided the dichotomy of either selecting all segments in the 

block, or none.  Because we had little information from which to make the selection, we elected to be 

conservative and did NOT pass any covered segments to NTIA from this submission format.  Some 

Broadband providers submitted covered street names and street ranges.  In these cases we performed a 

manual analysis trying to link to specific segment names and address ranges within covered Blocks.  

Sometimes this was a simple process because a provider used a TIGER derived street database.  In other 

cases we could not determine the source of the provider’s street data.  Street and Address matching 

tended to yield a relatively good result (typically between 30% and 100% of possible segments in the 

Block), but was very time consuming.  Where yield rates were low, our result was a shredded segment 

coverage pattern, like the image shown 
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below.13

 

Figure 10-Blue road segments adjacent to peach covered small Blocks 

A number of providers submitted geographic objects. In this case, our manual process was directed 

toward a conflation of data sources.  The goal was to take provider submitted segments and put these 

segments in terms of our TIGER 2009 basemap.  Although there is a trade-off in the accuracy using non-

provider submitted segments, we felt it was more important to have a road set that would edgematch 

our Block features and remain consistent with the Block size standards we used for other providers.  This 

is important for the appearance of the online maps, as well as potential verification work where we are 

attempting to judge a feature based upon its attachment to a covered small Census block.  The figure 

below shows street segment input data. 

                                                           
13

 We continue to hear providers expressing concern that our request for either a geographic object or TIGER Line 
ID is beyond the scope of the NOFA clarification. Therefore, they cannot supply additional information to us. 
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Figure 11-Provider Submitted Street Segment Objects.  The segments don’t edge match the Blocks nor are they continuous. 

The figure following demonstrates the same area after the conflation process.  Blue segments are the 

conflated TIGER roads which will be passed to NTIA. 
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Figure 12-Provider submitted segments in gold, selected TIGER 2009 in blue—Conflation result; in many cases what was a 
continuous segment is made discontinuous because even with a distance buffer the TIGER segment doesn’t always intersect 
the provider segment 

 

The final segment process was used when we were supplied with a Broadband covered area polygon.  In 

this case, we found the segments within covered areas and eliminated those segments inside of Blocks 

less than or equal to 2.00 square miles. 

Because there was more control over the format of the inputs (we knew we had a boundary and were 

working with TIGER segments), this was an automated process that followed this general format: 

1. Select large covered Blocks by provider ID (from updated Large Block table) 
2. Select TIGER 2009 road segments (MTFCC like 'S%') that face (CB = CBLeft2000 or CB = 

CBRight2000) covered large Blocks for provider 
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4. Select segments as distinct records, max speed with corresponding technology, join in 
feature names, export selected records to temporary DBMS table  

5. Join TIGERroads feature class to temporary table on TLID 
6. Select covered segments (Python script)  
7. Select service area polygons for provider 
8. Clip selected facing segments with selected service area 
9. Export clipped segments to staging feature class, keyed by ProviderID 

In this figure, orange represents covered small Blocks; black lines are covered segments in large Census 

Blocks (light blue).  The service area boundary is shown in grey. Based upon feedback from providers, we 

have elected to clip segments at the end of a coverage boundary.14 

 

Figure 13-Output of the Segment Process 

Wireless Coverage Process 

In general, most providers of mobile Broadband submitted coverage information in a NOFA-compliant 

format.  Other than attributions for spectrum and speed, little was done to this coverage.15 

                                                           
14

 An outcome not discussed here is how to handle address ranges on segments.  As NTIA is asking for a Min and 
Max on the segment, deriving theses values for clipped segments is very problematic.  Also the prevalence of 
alphabetic characters in addresses makes the min/max selections very arbitrary.  We are grateful that addresses 
are nullable data elements. 
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In this submission LinkAMERICA made an aggressive effort to bring additional WISP coverage into the 

NTIA dataset.  For the most part, our outreach was with providers who were unable to supply 

sufficiently granular data in the past or those that could only submit wireless address points which is no 

longer a valid submission format. 

In Round 3 fixed wireless providers generally either supplied coverage information or infrastructure 

from which coverage estimates could be derived.  Many allowed us to use their tower locations, 

antenna heights and direction/spread of coverage to derive a line of sight coverage estimate.  In our 

experience, this is a conservative and reasonable derivation of coverage. 

Some wireless providers submitted RF studies.  When this was done, there was a request that the signal 

strength be removed from coverage data.  The request was honored.  

Other fixed providers were able to supply us with hand drawn maps or polygons/polylines drawn in 

Google Earth format.  In these cases we did our best to georeference and verify the coverage areas with 

the WISP. 

When we received coverage information in KML format, like the image below, we accepted the data as 

it was presented to us.   

 
                                                                                                                                                                                           
15

 Some polygon data did exceed the node count threshold.  In these cases, data was rasterized to 100m cells and 
then converted back to polygons.  The polygons were dissolved to multi-part geometry.  This addressed the node 
count concern. 
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As the image above shows, in some cases we have hand-drawn coverage, as well as infrastructure.  

Instead of estimating their coverage using a line of sight or RF study, we elected to stick with the 

provider’s supplied information.  Our decision was guided by two primary factors: 

 If the provider is advertising using this coverage they must have specific confidence in its 

accuracy. 

 If the provider can supply coverage, as well as infrastructure that reasonably supports the 

coverage, there is a very high likelihood in the accuracy of the information.   

The downside, of course, is the polygon shown on the map may not represent our notion of how 

wireless coverage should appear.  

In general we note several interesting trends in the wireless data.  First, we can be successful in 

increasing the amount of WISP coverage when we aggressively pursue WISPs.  This means we have to be 

willing to accept data on their terms and convey it into SBDD formats.  Some of our WISP submissions 

have taken over 12 hours to normalize into SBDD formats.  Second, we have to accept that some WISPs 

will not be able to supply FRNs.  There remains a minority of WISP providers who are not aware of the 

FCC FRN.  Third, there appears to be some variation on how the NOFA coverage definition is met.  In 

other words, there seems to be a disparity on the necessary strength (e.g. -80 dB, -98 db, -120 dB, etc) 

to provide the appropriate quality of service for data services.  Fourth, it was very difficult getting 

providers to identify spectra used for Broadband data services16.  We are unsure if this is a competitive 

concern, or if the same coverage pattern is yielded for multiple frequencies.  Typically, the spectra 

returned were those that a provider was licensed for.  At this point, we have no reliable way to locally 

determine what set of frequencies are used to provide Broadband data services in a local area.   

Service Address Point Process 

A handful of providers have requested that customer level, service address point data be submitted to 

NTIA.  In these circumstances we have done minimal processing to preserve the provider’s intent with 

this deliverable and not bias downstream NTIA use. 

Our verification included checks against commercial or Public Utility/Public Service Commission 

exchange boundary maps.  Points not contained within one mile of a boundary are not submitted to 

NTIA.    

We retain from the provider the provided latitude and longitude, as well as Census block.  For some 

coverage data, if a provider is unable to supply a longitude, latitude or Census block, we fill in these 

attributes.  In those circumstances where we do not have a Census block, but we do have a longitude 

                                                           
16 One provider responded by email, “This mapping program is to provide the coverage area for 

Broadband provided by a company. Not to keep a detailed account of every aspect of a companies (sic) 

network.” 



SBDD Mapping Methodology Page 35 
 

and latitude, we accept the given longitude and latitude and use that as the basis for our Census block 

assignment. 

With point data we have tested for comparable geocoding success rates but do not overwrite provider 

information.  From this type of analysis we note the amount (usually little more than 10%) of addresses 

that seem to locate with less than street segment certainty.  Deriving a thematic representation of the 

points on speed also illustrates some of the locational certainty issues in this point level data.   

Coverage Estimation Process 

Although the derivation of Broadband coverage into Census Blocks, street segments, or wireless 

coverage files is, in itself, a bit of an estimation process, there was an explicit estimation process 

required in cases where a Broadband provider either refused to participate in our survey, or provided 

such a threadbare submission that no carrier-based coverage information could be gleaned.   

We typically resorted to three possible estimation paths. 

For Cable (HFC) providers who did not provide any coverage information, we fell back to Media Prints 

data.  Rather than using the entire Census Block group gathered by Media Prints, we used only those 

Census Designated Places carrying the same or similar names to the Media Prints p_com field.  Our 

reasoning was that Cable systems tend to be franchised on a municipal or at least administrative basis 

so the coverage will likely follow a governmental boundary.  As a general rule, cable infrastructure is not 

available in the public domain17 and what could be found was poor in quality and difficult to ascertain 

for validity.  

For DSL providers who did not provide any coverage information, we estimated road-based coverage 

from their Central Offices18.  We only used Central Offices that showed evidence of DSL or fiber-based 

services in the NECA 4 tariff.  Road-based engineering areas were derived via ESRI Network Analyst to 

18kft.  These segments/boundaries were clipped to commercial wirecenter boundary edges.   

For mobile Broadband providers who were non-responsive to our requests, we fell back to American 

Roamer coverage patterns.  We generalized the American Roamer coverage to ½ km in order to protect 

the licensed information. 

For fixed wireless providers who provided no coverage information, we relied on their public websites to 

scrape coverage maps.  When these maps were available, we georeferenced them and tried to use the 

outer polygon boundary to represent their serving area.  In other cases, when only a tower could be 

provided, we used a view shed analysis and estimated coverage at 10mi per tower19.  Because much 

wireless propagation is driven far below the Census Block and much engineering information isn’t 

                                                           
17

 The team tried to use data from the FCC Coals system and 321/325 fillings but this seemed to be a bit non-
uniform in quality. 
18

 Central Office location was derived from MapInfo ExchangeInfo Professional.  Wirecenter boundaries also came 
from this commercial product. 
19

 In some cases we had an approximate radius of coverage but no height.  In this case we used a 50’ height 
estimate and then clipped the coverage to the provided coverage range.  We also clipped wireless coverage to 
honor state boundaries but did not look for providers serving coverage with out of study state facilities. 
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known (frequency in use, polarization of the signal, coverage pattern of antenna(s), local terrain/land 

cover) this was the most complicated group to estimate.   

Speed 

Speed attributes are reported both at the block (typical) and higher levels (maximum advertised and 

subscriber weighted).  We note that in many cases, providers did not supply typical or subscriber-

weighted speeds.  In some cases, it appears--although we cannot verify--that their maximum advertised 

speeds were used to populate typical speed columns. 

We do have limited testing data on reported speeds, but we have been careful to not use our typical 

reported values with carrier-provided information.  If we do not have a speed value from a provider, we 

report an empty value.   

Several service providers claim they do not have data on typical speeds available, but estimate a 20% 

overhead factor between the advertised speed and what may be experienced by an end user. 

We continue to request advertised speed at the block level.  Nevertheless we appear to be getting 

speeds that do not vary over a large geographic area – leading us to believe that providers may still be 

submitting the maximum speed advertised in local media for the entire market.  For the most part, we 

have been unsuccessful in messaging that advertised speed should not correspond to a market area, but 

instead, the maximum speed, which can be provided to a household—what some may describe as a 

‘qualified speed.’20 

In circumstances where a provider supplies a range of speed attributes, we assign NTIA categories based 

upon the midpoint of the range. 

To support NTIA program office requests, we have also modified the structure of the Service Overview 

table.  Even if Maximum Advertised Speed is supplied at the market or county level, we push that speed 

down to the contained Blocks.  The only records that remain in this table, will be those wireline records 

with either a non NULL nominal weighted speed or ARPU value. 

Community Anchor Institutions 
In the first submission, the Community Anchor Institution (CAI) process was referred to in terms of a 

learning curve.  This continues to be an appropriate metaphor.  The mapping team continues to focus on 

data that will support and help inform policy makers and the SBDD planning process. 

In the first submission, the team gathered information on what data was available and what resources 

will be required to engage these categories of important institutions.  In the second submission we 

                                                           
20

 As an example of a response to our request for Block level advertised speeds, we received the following 
comment from one anonymous provider, “This is and of itself does not require anything new of us – just states the 
NTIA supports efforts focused on getting that information on the CB level.”  It would be helpful to have broader 
messaging so that providers understand this new direction.  
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continued to obtain additional connectivity information.  For the Spring 2011 collection, the team began 

a survey process to directly engage these important organizations.    

Our work with CAIs is guided by three principles. 

First, CAIs are important stakeholders within the planning process.  Our goal is to engage participants in 

regional planning that has strong ties into the CAI categories identified by NTIA.  This has a direct benefit 

of engaging an established stakeholder community.   It also allows Broadband planning to tie into 

existing organizational and planning networks.  In each of our states, key relationships with education, 

public safety, libraries, and economic development sectors are being identified and developed. 

Second, we believe that CAIs will likely be one of the primary beneficiaries of targeted Broadband 

funding.  Our belief stems from the sense that many of the benefits of Broadband will extend from these 

community ‘anchor points’.  In other words, it isn’t solely the existence of Broadband at a library that 

provides a benefit.  It is people using applications that work only on a Broadband network to upgrade 

their skills (e.g., online training) and gain access to online content (e.g., job postings, goods and 

services), etc.  The targeted use of a specific application--that can only take place with Broadband 

networks-- is what produces the priority benefit.  Put another way, there seems to be a realization that 

things are less about pure connectivity (for the sake of connectivity) than about connectivity in terms of 

an application (for the sake of the benefit obtained through the application). 

Third, we continue to use a rational and targeted approach to derive information.  This means we will 

utilize our planning teams for as much ground work as possible.  This also means that a goal of our CAI 

process is not an exhaustive Census of anything that could be a CAI; rather, it is the discovery, inventory 

and integration of Broadband planning activities into those CAIs that stand to produce the greatest 

synergies with the SBDD planning process.   

The above implies two significant points.  First, the team’s goal is to document community anchor 

institution connectivity within a broader context of regional and statewide planning objectives.  Second, 

if a particular category of CAI has an independent Broadband planning effort underway, we will 

encourage that organization to take the lead, and we will provide relevant expertise and support as 

warranted.  For example, in one of our states, the public safety community is already engaging in a 

mobile Broadband survey effort.  We have aligned our CAI data collection process with that effort and 

are sharing information and expertise (e.g., hosting a survey) to support their mission.  In another state 

we are attempting to glean connectivity information from a municipal government survey.  There may 

be some downside to this collaborative approach in that we may have to work with data spanning 

different times or we may not have all of the location-specific information we need, but this does 

prevent the same user from receiving multiple inquiries. 

Further, the team continues to rely on the notion of Internet Intensity Zones.  As the Broadband 

coverage information is developed, if we do not have definitive connectivity information from other 

sources (e.g. a phone survey, web survey, listing provided by a facility owner) in this study, those Anchor 

points that fall into an existing area of SBDD Broadband coverage will not be left out or submitted with 

NULL values.  Rather, the adjacent coverage area will be the first estimate of Broadband coverage for 
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the facility.  The use of an estimate allows the site to come into the analysis and learn a bit about the 

accessibility of that facility, but it also frees resources to examine those anchor points that are more 

dispersed and likely under/un-served.  The team will conduct targeted surveys to discover connectivity 

and, more importantly, applications in use at prioritized CAIs.21 

We close this section with a figure that we hope reinforces our CAI process. 

 

Figure 14-Anchor Institution Process 

  

Recall from our first submission analysis, in most cases, CAI points are clustered and on average less 

than 1 ¾ miles away from one another.  Relying on The First Law of Geography22, this likely means that 

the Broadband accessibility is very comparable for CAIs that are close together.  We believe this means 

Broadband accessibility may be less about connectivity than it is about the ability of a CAI to afford, 

successfully adopt and utilize Broadband to support its mission.  Therefore, an important part of where 

SBDD mapping and planning come together understands what Broadband is used for, potential barriers 

to adoption, and how it is an essential component in a planning region’s investment scenario. 

                                                           
21

 We track internally those features with Broadband connectivity defined via an estimate but within the current 
transfer data model we lack a mechanism to propagate that information to NTIA.  Appendix One expands upon our 
thoughts regarding a series of audit fields in the transfer database which would be helpful to inform downstream 
users regarding the source of data or use of estimates. 
22

 http://en.wikipedia.org/wiki/Tobler's_first_law_of_geography.  We are attaching connectivity based upon the 
highest speed wireline provider in that block.  This provides a ceiling for what can be obtained, although the CAI 
may not be purchasing this level of service based upon needs, budget, mission, etc.. 

http://en.wikipedia.org/wiki/Tobler's_first_law_of_geography
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Anchor Institution Survey 
During the third submission period we began a survey process to both verify received connectivity 

information and garner additional connectivity information from CAIs.  As with WISPS we wanted to 

aggressively target and improve this data section. 

The process began with the Round 2 CAI list.  Again, we prioritized schools, libraries and healthcare 

institutions.  A small team made outgoing phone calls to discover relevant contact names.  In Wisconsin, 

we were able to gather about 150 email addresses based upon 440 calls.  There were only 14 refusals. 

While one team worked on improving the contact list, a second team designed and developed a simple 

online survey system called CAVS (Community Anchor Verification Survey).   

 

Figure 15--CAVS Screen 
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Users were invited into the CAVS system by the receipt of a postcard with an organization specific code 

printed on the mailing label.  Beyond the questions shown above, there was a second page to the survey 

dealing with use of Broadband.  Those results are directed to the planning teams. 

The table below summarizes outgoing contact activities by state.  This includes both a post card as well 

as for some organizations in which we had contact information a follow up phone call. 

States 
Post 
Card  Calls 

WI* 2033 75 

ID 1059 259 

WY 345 30 

AL 1640 14 

 

 

As of 3/16, verification23 statistics were as follows: 

State Verified / Total Records Percent Verified 

AL 72/2137 3.3% 

ID 172/1596 10% 

WI24 1187/3945 30% 

WY 169/796 21% 

 

We are keeping the survey open after the Round 3 submission to NTIA and will continue to collect data.  

In Alabama we have also begun to use resources from the planning teams to make outgoing calls and 

better target the surveys. 

Clearly this survey was resource intensive but it did yield an increase in verified, rather than estimated, 

CAI data.  We are unsure if we can sustain it in the next submission, but is has proven to yield new 

information. 

Anchor Institution Trends 
At this point we have focused our CAI attention on schools and libraries, with respect to connectivity.  

We benefit from strong relationships throughout the education sector (K-12 and Post-Secondary).  We 

have also found excellent resources within State librarians in all States. 

                                                           
23

 We say a record is verified when it has been opened by the CAVS test user.  It means at least one field was 
modified. 
24

 In Wisconsin several large school districts supplied files with connectivity information; we performed a bulk 
update in these cases.  We attribute it to the survey as the survey triggered this response. 
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To supplement the education and library information we have formed organizational relationships with 

the major hospital associations within each state.  Our goal with this relationship is to cull information 

from their planning process.  We continue to formalize/advance this relationship.   

As in the prior submission, we are using public domain sources of information for public safety-category 

4.  The vast majority of these locations are estimated with respect to connectivity.  Our hope is that in 

subsequent submissions, we will reduce the size of this category and connectivity information specific to 

root nodes of the public safety network--such as County Emergency Operation Centers.25  At this point 

we have had minimal success gaining this information. 

Because we have a wide ranging population of CAIs in our data set we have a variety of Broadband 

services that don’t always fit NOFA parameters.  Services like PRI or T1 are classified into “other copper,” 

but the bandwidth is estimated based upon the number of channels purchased.  We also had difficulty 

obtaining both the upstream and downstream channel capacities.  In large part, we made the speeds 

symmetrical, but this is an assumption on our part.   

As a final verification step, we attempt to screen the CAI data for duplicate values.  Because many CAI 

are closely clustered together we perform the de-duplication based upon the ANCHORNAME within the 

ZIP code. 

Middle Mile 
Middle Mile information was collected directly from providers via survey or interview.  Middle Mile is a 

“chicken or egg” type of challenge in that it is possible to verify that the infrastructure exists, but 

extremely difficult to know what it is doing without engineering level assistance.  Although most 

providers submitted “something,” there was a significant variance in what that “something” 

represented.   

The purpose of this section is to record some of the comments and questions we have received about 

Middle Mile.  We hope this provides better context for our data submission. 

Within the NOFA, Middle Mile was defined as (a) a service provider’s network elements (or segments) 

or (b) between a service provider’s network and another provider’s network, including the Internet 

backbone. (Collectively, (a) and (b) are “middle-mile and backbone interconnection points.”)26 

Given the existence of the “or” in this definition, providers submitted a variety of information.  Based 

upon the NOFA example, several fixed wireless providers interpreted Middle Mile in terms of the 

connection points from their towers to their own serving backhaul location.  The topology was 

commonly Microwave from their distribution towers to their NOC.  The NOC and towers were listed as 

the Middle Mile points. This seems to be consistent with the first definition clause (a). 

                                                           
25

 Within the public safety category, it is also very difficult to derive precise locations as many CAI are addressed to 
PO boxes. 
26

 From http://broadbandusa.gov/files/BroadbandMappingNOFA(FederalRegisterVersion).pdf at 54, visited March 
28, 2010 

http://broadbandusa.gov/files/BroadbandMappingNOFA(FederalRegisterVersion).pdf
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Telephone, Mobile Wireless, and Cable providers tended to remain either silent on the question, or 

would provide a single location in which Internet peering occurred (clause b).  A number of participants 

explained that the question was quite ambiguous with data traffic moving back and forth over both TDM 

and IP networks--it was unclear where the distinction should be drawn.  As a general rule it seemed like 

many providers listed a single location where Internet Peering occurred. 

A number of providers refused to answer the question on grounds of confidentiality27.  Others would not 

disclose as their Middle Mile points are not owned--another company provides the physical and 

electronic connection to their network.  In other words, the entity providing Broadband is not the entity 

providing Middle Mile. 

Additionally, based upon the new Provider_Type classification of “other,” we have started to integrate 

points provided by Broadband service providers not meeting the NOFA definition.  This includes POP 

locations and aggregation points for public / private networks.28 Within a given submission there were 

two final attributes that tended to concern respondents.  First, speed should be measured in terms of 

only data capacity and what exactly is “data” (e.g., can/should you segregate out voice or video), and is 

the relevant capacity of the physical connection, channelized to a specific virtual circuit on their 

network.   

Finally, a number of other providers were unsure of the height above grade measure (is this their floor, 

the street outside, etc).  We seem to have a combination of height above or below grade, as well as 

heights above mean sea level (AMSL).   

To the extent possible in our timeframe, we verified the location of a sample of Middle Mile points.  

Where we could see infrastructure that appeared to be consistent in location with other provider 

infrastructure, we felt that the location was accurate.  In some cases, the point provided seems sensible 

(is on a road, near other equipment), but using imagery, we couldn’t find a place where this type of 

connection could occur.  This wouldn’t be unforeseen, in that Middle Mile connectivity likely takes place 

in a protected environment much smaller than a standard Central Office installation.  

Mobile Wireless Coverage 
We have received mobile wireless coverage from most mobile Broadband providers in each state.  At 

this point we have cleaned the geometry of the data and attributed it with spectra and FRN as required. 

Provider derived coverage has been reviewed against the commercial licensed product for consistency.  

To a limited extent we also use licensing locations and tower infrastructure to spot-check supplied 

                                                           
27  As received in email 9/30/10, “Due to security concerns and the risk of public disclosure of highly sensitive data, 

whether inadvertent or otherwise, ***REDACT***response to the Middle Mile and backbone interconnection 

request is limited to publicly available information available on {remainder not included}” 

 
28

 As discussed in our readme.txt file, a number of middle mile points were lost in validation due to their location in 
adjacent state.  This will cause a decrease in some providers relative to prior submission. 
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coverage.  This mode of verification remains complex, given the lack of facility-based information with 

mobile wireless. 

Verification 
Almost by definition, data verification is an ongoing and evolving process. Clearly, with each new data 

submission there will be a validation process at hand and at the same time, our team continues to 

expand and improve the efficiency and effectiveness our data verification routines. Consistent with the 

movement toward an fGDB export database and use of a data receipt script, much of our validation 

effort was spent in supporting the ETL processes into the required formats.  In future data submissions 

we will continue our work to stabilize and improve the business process that normalizes provider 

submissions into NOFA formats and expands in more depth on the confidence analysis within the data.  

Verification Standard 

 
Our overall verification standard is focused on the level at which we supply processed data to NTIA.  This 

means that the vast majority of our verification process will be focused on ascertaining coverage for 

Census block’s less than 2 square miles and covered road segments. 

We are learning that Verification has multiple dimensions. 

Provider verification is finding providers who supply Broadband and discriminate out providers not 

meeting Technical Appendix A’s definition of Broadband.  

Identity verification is taking the provider’s categorized in the first step and ensuring that the provider 

either has a valid FRN or is assigned a default FRN.  Identity verification is very complicated because of 

the Technical Appendix A’s mandate to record data at the FRN, Provider Name and DBA level.  Each of 

these attributes could be unique for a single provider going to market under different or the same 

names.  As a result, rolling up each provider into an identity collection that matches either the FCC data 

integration team or a third party Broadband provider’s data view, is very, very time intensive.  Identity 

verification is discussed in the earlier section-- Developing the Provider List. 

Coverage verification is a broad term, but in our definition it boils down to determining if Broadband 

coverage is in the right place.  For a given provider, the question is whether the coverage is assigned to 

appropriate Census Blocks, road segments or area features.  Coverage verification can be further broken 

out into two distinct classes: 

 Technology verification, which is determining if the provider is listed with a technology 

consistent with their marketing information.  It also involves a validation with supplied speeds.   

 Speed verification, which is determining if the speed supplied for that block, road segment, 

point area file or market area is consistent with the technology and the marketing information 

received. 

The final verification dimension is consumer feedback and crowd-source verification.  This is a dynamic 

set of steps we are beginning to implement.  One side of this is responding to consumer concerns.  The 
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second is using the crowd sourced data to validate provider claims and, if appropriate, update the map 

and the underlying data. 

At this stage, our working hypothesis (confirmed by our experience) is that there will not be a single 

dispositive measure to indicate Broadband coverage availability in a Census block or along a segment.  

From prior work, and examining our current provider submissions, we believe that there is too much 

variation below the submitted record to make a single binary yes/no indication.  Rather, there will be a 

series of measures that combine to provide qualitative confidence (a classification scheme) in our 

indication of Broadband availability at the block, segment, or wireless polygon level. We believe such a 

qualitative confidence scheme is both relevant to and supportive of NTIA interests, as well as the 

interests of our end-user community – that is, the states and citizens we serve through this program. 

The intent of this section is to illustrate why we are moving toward a particular verification 

methodology.  Our team is learning as we go along, and will adjust and improve this thinking. But given 

our experience to date, this is where we are heading. As stated above: 

 First, coverage verification is at the level of data submitted to NTIA. 

 Second, coverage verification is enhanced when there is a secondary measure of availability 

(such as infrastructure presence or serving area boundaries) 

 Third, given the limited resources of this effort, the most important coverage verification 

process to implement is the erroneous dispersion of coverage.  These are the “islands” of 

coverage isolated by significant distance from other covered areas.  This is the opposite of the 

Internet Intensity Zone notion discussed in the Community Anchor Institution section.  In other 

words, Broadband Internet likely doesn’t exist far away from other areas with Broadband 

Internet access. 

Before explaining our overall verification thought process, we have several examples, which illustrate 

the complexity of coverage verification. 

The first example is taken from a gentleman who requested a map change in Alabama.  His home is near 

the yellow dot.  The darker grey Blocks are covered Census Blocks.  The black lines are covered road 

segments.  He cannot receive DSL from his incumbent provider, although his neighbors can.  The 

incumbent carrier does have at least one structure in that block from which Broadband services can be 

provided; unfortunately his home is not served.   
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Figure 16--Sub block variation 

Because the SBDD program requires the depiction of coverage at the block level, the above map has 

been correctly generated.  However, from the customer’s point of view, the map is inaccurate.  This 

requires us to explain that the maps are not intended to be a structure-level qualification, at which point 

some consumers question the value of the maps when seeking service information.  Of course, we also 

share this information with the incumbent carrier in the area so they are aware of a potential customer 

market. 

Beyond this type of one-off structure-level qualification, sometimes, as shown below, we have even 

larger gaps in provided coverage.  The image here shows an “outlier” block that could be an error, or it 

could indicate missing Blocks along a major road that should have been filled in.  In this figure, the 

outlier block is highlighted in turquoise. 
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Figure 17--Dispersion in Submitted Data 

 

In this particular case, we are faced with a different verification question.  Based upon the properties of 

the neighbors, we believe this block should likely be covered (coverage interpolation,) but supplied data 

from the incumbent says otherwise.  

The next example, at a somewhat larger scale, shows where an interpolation process requires some 

adjustment.  The figure below shows a town level.  There are some smaller Blocks that are likely covered 

by interpolation logic, but we also do not want to extend coverage beyond a franchise boundary as in 

the areas shown in a box on the bottom of the map. 
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Figure 18-Where do you stop interpolating? 

From what we can gather from some providers, the submitted data—data with consistently high 

degrees of dispersion or coverage holes—tends to come from geocoded billing records.  In this 

paradigm, this means where there are no customers; service is not identified on a map.  The 

interpolation verification question then takes on two dimensions. 

First, if a provider has no customers in an area, how can we know if they would be able to 

provide service in a 7-10 day interval? 

Second, if we use the properties of neighboring Blocks to interpolate coverage, when should we 

stop (e.g., at a franchise boundary, at a certain distance, etc.)? 

We continue to work with providers to get additional information to help us better understand and 

contend with this type of circumstance.  However, we have not been entirely successful at getting 

franchise boundaries that would address much of the issue. 

The final map shows this dispersion problem, but to an even larger degree.  This solitary large block is 

likely the result of a bad geocode, but we don’t know, given the data that has been submitted by the 

provider and the “single customer in a block standard” set by the NOFA clarification. 
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Figure 19-Dispersion in covered Blocks 

Due to the fact that this situation is quite obvious in display, this type of problem is one that we are 

more aggressively trying to resolve.  Where a single block has no neighbor offering comparable coverage 

and is a specified distance beyond an exchange boundary, our approach has been to filter these Blocks 

out.  As of now, this filter is limited to incumbent DSL providers because we have a good source of 

exchange boundaries.   

The exchange boundary dispersion verification method breaks down when examining smaller providers 

who are more likely to CLEC into neighboring territory. In the figure below, the black line represents the 

exchange boundary, while the continuity in the DSLAMs likely points to coverage extending along a road 

into another provider’s territory. 

 

Figure 20--DSL Coverage outside of exchange boundary 
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In sum, the variability in our source data continues to suggest that our dynamic verification process is 

relevant, appropriate and evolving in a manner consistent with the overall program.  And, as noted 

above, we believe the more meaningful outcome of our verification processes will likely be a series of 

qualitative indicators or expressed confidence levels.  Our concern, as with the development of any sort 

of classification process, is how rigid we should make this classification given the variation in our input 

data and the varied perceptions of service providers, map viewers and down-stream data consumers.   

Verification Work Process 

To support our dynamic multi-factor verification process, we have implemented the following steps. 

First, when data is received, an analyst reviews the submission and any immediate questions or 

concerns are sent back to the provider as quickly as possible.  We have found this gatekeeping step very 

helpful in making sure we understand the intent of the submission.   

Second, for all providers who submitted data to us in the second round, they received both a tabular 

data summary and a mapped output.  Prior to releasing the “check maps” to providers, we had a team 

of analysts visually inspect each provider’s coverage area.  The focus on this QC effort has been to 

identify and flag suspect Blocks.  After this in-house review, we solicited a second level of feedback from 

providers and received a number of requested changes and corrections used in the development of the 

April, 2011 Round 3 dataset. 

For those providers who submit only block or segment level coverage (i.e., in those cases where we have 

no infrastructure to test with) we test for coverage containment within known service boundaries.  The 

intent of this validation step is to remove Blocks that are obviously erroneous. 

As mentioned in the sections above, we have implemented a check on dispersed Blocks, but we have 

implemented less with respect to coverage interpolation (holes in coverage). We continue to work on a 

series of mechanical tools to assist with the inspection process but have run into challenges related to 

geographic basemap and timing. 

As our submissions have moved online, we have also begun to benefit from crowd source feedback.  In 

some cases this has helped us identify and fix errors in our underlying data. In other cases, as we have 

shared with NTIA, we have encountered some perceptual issues rooted in how the data are developed 

and modeled to comply with the NOFA.  Depiction of uniform coverage in small Census Blocks continues 

to be a challenge. Despite our best efforts to explain the full block coverage requirement, we continue 

to receive complaints that the coverage shown on the map is not accurate for a particular location 

within that block.  

Consumer and Provider Responses to Deliverables 
Here, we segue from internal verification to external verification.  We view responses to our work 

product as a form of validation and verification.  On the one hand, this gives us the opportunity to fix 

mistakes and then generate QA steps to make sure that the problem does not reoccur.  We also learn 

how to improve what we are doing or better explain what we are doing to a community not always 

familiar with the NOFA and program office framework.  On the other hand, listening and learning from 
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this feedback helps us better target our mapping deliverable to meet the needs of our external 

customers.  In this second case, external feedback not only provides feedback on perceived qualities (or 

lack of quality) in the data, it helps us to learn if we are developing data that is truly helpful to 

downstream users. 

At this point, our external deliverables take three forms: State Broadband Maps, data transfer to NTIA 

used for the National Broadband Map, and text format data requested by outside parties. 

Online Map Experiences 

Now that our State maps are online, we continue to harvest viewer feedback and comments.  Because 

an online map allows someone to zoom in far below the scale of the data, a large number of comments 

reflect sub-census block concerns. While important to the citizens reporting these issues and to our 

Broadband planning teams, this level of data is outside the scope of our core validation process, which 

as noted above, is focused on the level of data submitted to NTIA.  

There are several other themes that our team believes are important to share.  These comments are 

actually quite helpful because they also improve our data processes to better meet the needs of map 

viewers.  For example, we have invested significant time in harvesting more segments from provider 

data.  Because the appearance of segments is so important, we are putting time into ensuring a visually 

appropriate edge match between the roads we harvest and the Blocks/roads we will show online.  On a 

technical level, we also believe that a good segment process will help us understand more about 

dispersion in the data, and what is valid versus what is not valid. 

Perception of Unfair Treatment Across Technologies 

Several Broadband service providers have expressed strong concerns regarding how wireline services 

are displayed, as contrasted to how wireless coverage is displayed.  This is an artifact of the SBDD data 

model. As an example, consider the figure below. 
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Figure 21--Multi Network Coverage portrayal 

In this image, covered Census Blocks are light gold.  Covered road segments are a darker gold and 

wireless coverage is purple.  The concern seems to come down to how a wireline provider’s coverage is 

shown in the large Census Blocks (greater than 2.0 sq mi).  Wireline providers have expressed 

dissatisfaction because their coverage is only tied to road geography, which leads to a visual “hole” in 

their coverage map.  At the same time, they feel that it is unfair that the wireless provider’s coverage is 

shown to be uniform in the same area.  Put another way, if our maps show wireline in terms of Blocks 

and segments, why don’t our maps show wireless the same way? 

Perceptions of COLR Obligations 

Wireline providers have also expressed dissatisfaction because online maps limit the distance of 

coverage from a road segment.  In our current online maps we buffer a wireline carrier’s service 300’.  A 

number of providers have expressed that they are mandated to provide voice coverage (which 

Broadband will accompany) anywhere in the Exchange.  There seem to be many dimensions to this 

argument, but the basic concern comes down to not being able to accurately reflect the scope of their 

COLR obligation within the mixed block/segment view.  Their ability (or lack thereof) to actually 

provision such services for new users within a 7-10 day period adds yet another level of complexity 

when attempting to fairly portray their coverage capabilities. 
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Intentions of Coverage Mapping 

When a viewer of an online map clicks on the map (or zooms to an address), they are provided with a 

pop-up of service provider coverage in the area.  The critical question is this: what is the area to which 

that pop-up window responds to?  In the past, we reported back to the Census block, or buffered road 

segment intersected by the user click.  As far as the map was concerned, once we move off of that road, 

or out of that segment, we have a new area to examine.   

Our sense, given feedback received, is that our provider view should be a bit more tilted toward finding 

providers in a general area, rather than finding providers at a single-click location.  If the goal of the map 

is to get someone to call a provider for service, our bias should be to include all of the potential 

providers in the general area, rather than giving potential customers a method to self-disqualify.  That is, 

we want to cast a wider coverage net, rather than one too narrow.  The problem with this approach is 

that it will create a number of false positive Broadband reports.  As of this date we cannot determine if 

the claims of inaccurate coverage in online maps are due to the looser provider view standard or not.  

We keep this looser standard in place to minimize the likelihood of self-disqualifications. 

National Broadband Map Experiences 

When the National Broadband Map launched, our phones began to ring. 

Responding to a number of provider inquiries as well as emails from citizens provided some insights.  It 

also illustrated that we now bear a second dimension of external verification.  That is, we must be 

prepared to respond to people who are confused by apparent inconsistencies between the State and 

National Broadband Maps29.   

The case below, based upon a call we received, illustrates some interesting intersections between the 

State and NBM. 

In this example a Citizen called inquiring about the difference in results between the National 

Broadband Map and our State of Alabama map.  The issue in question was coverage at his home.  The 

Alabama map showed he had coverage at his home, but the National Broadband Map said he did not. 

In the image below, the green dot represents the geocoded location of his home.  Based upon imagery, 

the geocode is quite accurate.  The olive colored polygon represents a covered Census block less than or 

equal to 2.0 square miles.  The Census block shows coverage by a number of wireline providers. 

The geocoded point is about 170’ from this covered Census block. 

                                                           
29

 We have a similar concern regarding textual data extracts.  We may translate our SBDD submission into covered 
Census Blocks in a way that is different from NTIA.   
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Figure 22-NBM Covered Census block example 

In the next image, covered TIGER road segments are shown in green.  It is important to note how far the 

TIGER road centerlines are from the actual roads in the subdivision.  It appears the geocoded point is 

reflecting more recent and more accurate road centerlines, placing the green dot at the correct location. 

Since the SBDD data is submitted in terms of TIGER 2000 the road on our map shows up about 100-200 

ft away from where that road is located today.   



SBDD Mapping Methodology Page 54 
 

 

As mentioned previously, however, our online maps buffer road segments to 300 feet on either side of 

the road centerline.  In this case then, our state map buffer is large enough to return valid service 

providers for this green dot.  The NBM, on the other hand, does not appear to buffer segments or the 

edges of census Blocks and will not return providers for this location.  Our intent in this example is not 

to criticize the national map; rather, it is to illustrate that we may inadvertently make trade-offs 

between false positives and false negatives, differently. 

This case illustrates several important tensions between the data as we present it to NTIA, map it 

ourselves and because of how it may be viewed within NBM context.  A lack of agreement on how to 

handle these inconsistencies in the source data and differences in mapping approaches may cause 

consumer confusion.  

The issues seem to come down to this 

a) How do you (or can you) handle the impact of time when roads move between TIGER versions 

or between TIGER and other road products?  In this case, online map road traces will not show 

up in the right area. 



SBDD Mapping Methodology Page 55 
 

b) Given the inconsistencies between TIGER geometry used in submission and underlying 

roadbases used for geocoding online, how do you (or should you) insulate the viewer from the 

inconsistencies.  There appears to be a strong likelihood that TIGER judges a particular point to 

be in a larger than 2.00 sq mile Census block while that same location could be in a small block 

area in the online view. 

c) How much tolerance should be introduced when returning a list of valid providers?  Is it 

better to error on gathering too many providers or too few? 

d) Since the NBM gathers feedback based upon its representation of coverage, how can/how 

should this crowd sourced feedback influence data presented in a different manner elsewhere? 
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Appendix One  

Data Collection Challenges 
This section summarizes some of the challenges we have experienced with data collection and 

processing.  The team believes it is important to categorize these challenges as they help inform the 

geoprocessing and verification methods used.  It is also our hope that some of the more global issues 

can be discussed and decided within the Grantee community.  

We begin with several global issues and then continue toward more granular challenges. 

Global Data Collection Issues 

Census Block and Road Standards are not clear 

Most carriers submitting Census level information provided 2000 Blocks.  A few provided 2009 or 

alternative (TeleAtlas, possibly) Blocks. Especially with the need to derive segment geographies, we 

would prefer to message the providers a specific Census standard—but we’d like to be consistent with 

other Grantees so as to minimize work from the provider community.  As of now, that standard is 

Census 2000.  If NTIA anticipates using Census 2010 for Fall 2011 collection, it would be helpful to 

message that as soon as possible.    

Also there seem to be several methods by which providers are calculating the area.  So the distinction 

between at 2.00 square miles can be uniform, it would be ideal to articulate an operational area 

calculation definition as early as possible. 

Providers Not Wishing for Block Level Aggregation of Their Data 

Both ***REDACT*** have supplied address point level data.  Both carriers want NTIA to have the point 

level information, and they have asked CostQuest/LinkAMERICA not to aggregate their coverage to 

Blocks.  Other than a verification to make sure that point data were contained within, or fell within 1 

mile of exchange boundaries, the only other processing was normalization into NTIA formats. 

Broadband Providers not Meeting the NOFA  “Provider” Definition 

PBWorks appears to reflect a concern among a number of grantees about what a Broadband Provider is-

-and how that definition impacts mapping. 

If the 7-10 day provisioning rule is to be strictly enforced, it would seem to eliminate a number of 

prominent Broadband providers30.  Further, the need for clarification around a facilities-based provider, 

versus the reseller, has injected even more ambiguity into the mix.  Right now we are unclear on how 

                                                           
30

 By email ***REDACT*** informed us they could not provision in 7-10 days, but they also supply information on 
qualified locations to the address point level.  Therefore, we draw a distinction between an incumbent provider 
owning the facility--which terminates at a customer premise--who cannot turn up service at a qualified location, 
versus a provider not reporting any specific qualified locations in which they cannot turnup service in the 7-10 day 
window.  In the first case we have a sense of where service can be offered and verified.  In the second, we have no 
evidence that a service could exist there until a specific location becomes a customer. 
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strictly to interpret either of these important distinctions, but we are concerned that we are beginning 

to create an NTIA exclusion criteria that is going to confuse downstream consumers of the data.   

Again, we do not want to exclude a service provider, but we believe there needs to be further 

clarification around the 7-10 day ”rule,” the definition of a “reseller,” and better interpretation of 

facility-based providers, versus equipping UNEs, SpA or leased lines. 

We have used the Provider Type of ”Other” to classify a number of providers who offer Broadband 

services, but we do not offer them in a manner consistent with Technical Appendix A definitions. 

To What Extent Should We Begin “Classifying” the Data and Maps? 

The question immediately preceding gets to the intent of a Broadband Provider.  This question gets to 

the intent of the Data and Maps. 

Earlier in this document we discussed the question of what type of bias we should introduce to our 

online map messaging.  In an online environment, do we want to more likely create an overstatement of 

coverage for a provider than an understatement?   In other words, is the larger problem allowing a 

consumer to self-disqualify, versus calling a number of neighboring providers?  There is a related issue 

to this.  Clearly in our maps there is a lot of scatter in data that we believe should be more continuous.  

These are the islands of coverage from an incumbent provider31.  There are a number of processes that 

could be put in place to deal with this type of scatter, but without more information from the service 

provider-- essentially the last mile facilities-- it will be difficult to perform this clean up in an informed 

manner.  On the one hand, we can aesthetically clean the maps up and reduce the scatter, but we have 

little sub-block engineering information upon which to make this decision.  Right now our preference is 

to put out a somewhat aesthetically messier deliverable and work with providers to get better 

information to clean their submission.  If that isn’t forthcoming, we are limited in what can be done 

given the lack of facility level information.  In summary this yields two questions 

1. In our online maps should we error on overstating coverage to prevent consumer self-

disqualification? 

2. In our online maps should we work to clean up a lot of the scatter that we see without having 

facility-based evidence from which to remove it? 

Granular Data Collection Issus 

Non-Uniform Submission Standards  

It is clear among providers that there isn’t a consistent method used to derive Broadband coverage.  

Some providers appear to be using a geocoding approach and then point in polygon or point on segment 

process.  Others may be using GPS locations.  In some cases, it is difficult to infer what reference data 

                                                           
31

 For a provider who sells opportunistically (not within a franchise area) it becomes even more problematic to 
classify their coverage because the points are more related to the type of consumer purchasing the service than a 
bounded offering.  In a matter of speaking, the Provider_Type is more determined by the technology and/or 
location than a type of business.  The core intent of the NOFA and our grant application was centered around the 
7-10 day providers but we believe maintaining information on Provider Type “Other” and  “Reseller” is important 
to assist in validation and market segment analysis as resources are available. 
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was used to georeference plant (is it the carrier’s roadbase?).  This leads to uncertainty regarding the 

input data scale or accuracy of other base layers.  Although we may be trading off absolute accuracy, our 

standard has been to conflate data to TIGER 2000 Blocks and TIGER 2009 roads.  We perform our 

verification against this conflated data product. 

Temporal 

We are unsure of how well the data are temporally consistent.  Some providers gave us their best effort 

to control to December 31, 2010. We note that some providers were clear that the submission was as of 

extract date without any way to move back in time.  They have no means to control for time and cannot 

provide any audit support beyond when the data are released to us.  Some data-especially loop 

qualification data-may change from day to day. It will be very difficult to clarify why something was 

changed from a given point in time. 

Perceived Inaccuracy with Respect to Internal Standards 

The NOFA is clear on submitting a list of Blocks in which a provider delivers Broadband service.  This is a 

different objective than perfectly reflecting service territories.  If a firm’s accuracy standard is a 

reflection of their service area, then the data created under the NOFA will not meet their perception of 

accuracy.  This leads to two other issues:  First, using Census Blocks rather than serving area may 

overstate or understate a particular provider’s Broadband serving area.  This was a significant concern of 

***REDACT*** who specifically required us to submit only address-level qualification data.  The second 

issue this brings up is how or if, there should be some standard on how much of a Census Block needs to 

be covered to call it covered.    

Confidentiality  

Several providers have noted concerns with CPNI-related issues and have stated this as a reason for 

non-participation.  We have also heard expressions of comparable concern regarding identifiable 

responses to Anchor Institution information. 

Unclear on Definitions  

As discussed earlier, several providers claimed confusion on several key terms involved in Middle Mile.  

We note a consistent stream of questions around the interpretation of Maximum Advertised Speed.  

Some providers understand this to be the most common speed package bought within the mass market, 

while others view this as a speed that can be purchased for an additional cost above a mass market 

offering (eg. a Turbo option for an additional fee per month).  Others interpret this as the fastest speed 

that is available for that particular location--in terms of xDSL, a structure qualified speed, for example.   

Perception of Data Use 

There seems to be some hesitancy releasing speed information because no one is sure of how the 

information will be used, or what the speed is intended to reflect.  A number of providers have verbally 

indicated that typical speed will be about (on average) 80% of purchased speed due to overhead.  But 

there are many other factors (such as a user’s home network) that influence speeds measures.  

Providers are concerned about introducing statistics without a clear understanding of how those 

statistics are derived and will then be used.  Also, as advertised speed is pushed down to a block level, 

we sense more trepidation to report speed values.  This quickly begins to touch on parity across network 
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types (why is wireline down at the block when wireless is half the state, etc.).   Finally we are also noting 

a significant increase in speed reported to us.  This may be due to network upgrades or competitive 

concerns to match the theoretical network speed. 

Location Uncertainty In Source Data 

Within this document we have noted concerns about the impact of source data accuracy.  Our 

geoprocessing methodology provided what we believe is a relatively conservative tolerance to account 

for the scale issue in the source data, but we are unsure of how this may impact downstream users.  

Clearly, it also impacts the verification process because we can’t attempt to verify received data beyond 

a scale at which it was developed. 

Covered Segment Process 

Deriving those Broadband covered segments in Census Blocks greater than 2 square miles has proved to 

be a challenge.   Moving from a NOFA specified tabular deliverable to an anticipated geographic 

deliverable also increases the complexity of the effort.   

Change Management Process 

One thing that is becoming clear is that a change management process that is consistent between the 

data provider and NTIA is needed.  In this light, publication of the current data transfer model beyond 

the PBWorks community would also be helpful.  Many providers are designing their data extracts with 

the NOFA in mind and the NOFA structures have been supplemented in the current model. 

Finally, it would be helpful, as early in the next cycle as possible, to know what Census Block vintage we 

are expected to deliver to NTIA.  It would also be very helpful to maintain a stable geographic base for 

the next deliverable so that the basis of verification doesn’t change. 

Record Level Metadata 

It would be helpful to have one or two additional fields in each feature class transmitted to NTIA.  One 

User Defined field could be helpful as an expression of record level confidence.  The second field could 

be used as a Key between the transfer geodatabase and our systems.  Ideally, both fields could be large 

text fields (50 char) so the Grantee can use them to express a variety of attributes. 

Miscellaneous Data Collection Notes 

 We note the following important observations regarding our data submission: 

1. There are Middle Mile plant records for providers who are not present in the Census block, 

segment or wireless area feature classes.  This is due to classification as non-NOFA Broadband 

providers. 

2. In some cases, we have trimmed wireless coverage estimates to honor state boundaries. 

3. We believe some providers are trimming their coverage to honor license area boundaries. 

4. As a departure from past practice, where a provider submitted Middle Mile points out of state, 

we are no longer passing those points to NTIA as they fail the validation script.  We experienced 

validation errors for BroadbandServed=N records in the CAI table.  These records were 

attributed a Technology of Transfer=0.  This cleared validation. 
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5. In tables with mandatory Zip5 (Service Address), if the End_User_Zipcode was not available, we 

have inserted ‘00000’ 

6. We have a significant amount of VDSL, ADSL 2 and ADSL 2+ coverage categorized into the xADSL 

category. 

7. We have left in the data Middle Mile locations with above grade elevations that appear to be 

unreasonable, given review of orthoimagery.  This seems to be confusion between above grade 

request and above sea level readings. 

8. All fGDB have passed validation except in cases where attributed speeds did not agree with 

domains associated with technology of transmission (eg Upstream Speed of 2 with ADSL). 

9. We note a few providers who have speeds seemingly inconsistent with their technology of 

transmission.  This is either very low speeds with optical fiber, or very high speeds with non 

DOCSIS 3.0 systems. 
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Appendix Two 
This appendix contains the confidentiality clarification supplied in a series of emails between CostQuest and NTIA. 

Feature Class Metadata NOFA 
Confidential? 

Online Map Public 
Disclosure 

Exemption 

Last Mile Constraints on accessing and using the data Yes No No None 

  Access constraints: None      

  Use constraints:       

  This data is confidential as defined in the 
NOFA. 

     

            

Middle Mile  Constraints on accessing and using the data Yes No No None 

  Access constraints: None      

  Use constraints:       

  This data is confidential as defined in the 
NOFA. 

     

            

Service Address Constraints on accessing and using the data No No Yes   

  Access constraints: None      

  Use constraints:       

  There are no restrictions on distribution of 
the data by users.  

     

            

CAI Constraints on accessing and using the data No Yes Yes NO 
attributes 
on any 
record in 
this feature 
class are 
considered 
confidential 
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  Access constraints: None      

  Use constraints:       

  There are no restrictions on distribution of 
the data by users.  

     

            

Census Block Constraints on accessing and using the data No Yes Yes NO 
attributes 
on any 
record in 
this feature 
class are 
considered 
confidential 

  Access constraints: None      

  Use constraints:       

  There are no restrictions on distribution of 
the data by users. 

     

            

Service Overview Constraints on accessing and using the data No Yes Yes The only 
provider 
who may 
not show 
up this 
table is a 
provider 
who has 
provided 
only 
confidential 
data (last 
mile, 
Middle 
Mile, 
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address 
point with 
provider 
name) 

  Access constraints: None      

  Use constraints:       

  There are no restrictions on distribution of 
the data by users. 

     

            

Road Segment Constraints on accessing and using the data No Yes Yes NO 
attributes 
on any 
record in 
this feature 
class are 
considered 
confidential 

  Access constraints: None.      

  Use constraints:       

  There are no restrictions on distribution of 
the data by users. 

     

            

Wireless Constraints on accessing and using the data No Yes Yes NO 
attributes 
on any 
record in 
this feature 
class are 
considered 
confidential 

  Access constraints: None      

  Use constraints:       
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  There are no restrictions on distribution of 
the data by users 
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